Documentation for Confluence 4.3
Contents

Confluence Documentation Home ................................................................. 16
Planning for Confluence 4 ............................................................................ 17
Confluence 4 Editor FAQ .............................................................................. 18
Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor 21
Confluence 4 Editor - What's Changed for Wiki Markup Users .................. 31
Quick Administrator Tips To Prepare for Confluence 4 .............................. 41
Trying Confluence 4 Yourself ........................................................................ 42
Giving Feedback on Confluence Releases .................................................... 42
Confluence 4 Editor - Customer Feedback .................................................. 43
Confluence Alternatives .............................................................................. 63
Feedback on Confluence Storage Format .................................................... 64
Specification - Confluence Advanced Editor ............................................... 97
Confluence 101 ............................................................................................. 101
Confluence User's Guide ............................................................................. 105
Getting Started with Confluence ................................................................. 105
About Confluence ......................................................................................... 106
Dashboard ..................................................................................................... 106
Page in View Mode ....................................................................................... 108
Confluence Glossary ..................................................................................... 110
Icons Used in Confluence ............................................................................ 115
Keyboard Shortcuts ....................................................................................... 116
Creating Content .......................................................................................... 121
Adding Pages ................................................................................................ 121
Adding Blog Posts ......................................................................................... 124
Using the Editor ............................................................................................. 125
Quick Reference Guide for the Confluence Editor ...................................... 129
Working with Text Effects ........................................................................... 141
Working with Links ....................................................................................... 143
Displaying Images ....................................................................................... 157
Working with Tables ...................................................................................... 161
Using Symbols, Emoticons and Special Characters .................................... 163
Using Autocomplete ...................................................................................... 165
Working with Page Layouts and Columns and Sections ............................ 169
Working with Macros .................................................................................... 173
Working with Drafts ...................................................................................... 303
Working with Templates ............................................................................... 308
Adding a Template ....................................................................................... 309
Creating a Page using a Template ............................................................... 314
Editing a template ........................................................................................ 316
Removing a Template ................................................................................... 317
Working with the Office Connector ............................................................... 317
Office Connector Prerequisites ................................................................... 318
Displaying Office Files in Confluence ......................................................... 320
Importing a Word Document into Confluence ............................................ 322
Editing an Office Document from Confluence .......................................... 326
Editing an Office Spreadsheet from Confluence ........................................ 330
Editing an Office Presentation from Confluence ....................................... 333
Installing the Firefox Add-On for the Office Connector ............................. 337
Importing Content Into Confluence ............................................................. 345
Importing Pages from Disk ......................................................................... 346
Sharing Content ............................................................................................ 347
Network Overview ....................................................................................... 347
Subscribing to a Network RSS Feed ........................................................... 350
Likes and Popular Content ......................................................................... 351
User Status Updates ..................................................................................... 352
Using Mentions ............................................................................................. 356
<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td>983</td>
</tr>
<tr>
<td>Viewing and Editing License Details</td>
<td>984</td>
</tr>
<tr>
<td>Reducing the User Count for your Confluence License</td>
<td>986</td>
</tr>
<tr>
<td>Cache Statistics</td>
<td>987</td>
</tr>
<tr>
<td>Confluence Data Directory Configuration</td>
<td>989</td>
</tr>
<tr>
<td>Content Index Administration</td>
<td>990</td>
</tr>
<tr>
<td>Finding Unused Spaces</td>
<td>993</td>
</tr>
<tr>
<td>Important Directories and Files</td>
<td>994</td>
</tr>
<tr>
<td>Confluence Home Directory</td>
<td>996</td>
</tr>
<tr>
<td>Confluence Installation Directory</td>
<td>998</td>
</tr>
<tr>
<td>Installing a Language Pack</td>
<td>998</td>
</tr>
<tr>
<td>Site Backup and Restore</td>
<td>100</td>
</tr>
<tr>
<td>Production Backup Strategy</td>
<td>100</td>
</tr>
<tr>
<td>Configuring Backups</td>
<td>100</td>
</tr>
<tr>
<td>User Submitted Backup &amp; Restore Scripts</td>
<td>100</td>
</tr>
<tr>
<td>Manually Backing Up the Site</td>
<td>100</td>
</tr>
<tr>
<td>Restoring a Site</td>
<td>100</td>
</tr>
<tr>
<td>Restoring a Space</td>
<td>100</td>
</tr>
<tr>
<td>Changing the version of a space backup</td>
<td>101</td>
</tr>
<tr>
<td>Restoring a Test Instance from Production</td>
<td>101</td>
</tr>
<tr>
<td>Restoring Data from other Backups</td>
<td>101</td>
</tr>
<tr>
<td>Retrieve file attachments from a backup</td>
<td>101</td>
</tr>
<tr>
<td>Troubleshooting failed XML site backups</td>
<td>101</td>
</tr>
<tr>
<td>Troubleshooting XML backups that fail on restore</td>
<td>101</td>
</tr>
<tr>
<td>Migrating from HSQLDB to MySQL</td>
<td>102</td>
</tr>
<tr>
<td>Rebuilding the Ancestor Table</td>
<td>102</td>
</tr>
<tr>
<td>Viewing System Information</td>
<td>102</td>
</tr>
<tr>
<td>Live Monitoring Using the JMX Interface</td>
<td>102</td>
</tr>
<tr>
<td>Tracking Customisations Made to your Confluence Installation</td>
<td>103</td>
</tr>
<tr>
<td>Viewing Site Statistics</td>
<td>103</td>
</tr>
<tr>
<td>Viewing System Properties</td>
<td>103</td>
</tr>
<tr>
<td>Installing Patched Class Files</td>
<td>103</td>
</tr>
<tr>
<td>Finding Your Confluence Support Entitlement Number (SEN)</td>
<td>103</td>
</tr>
<tr>
<td>Configuring Confluence</td>
<td>103</td>
</tr>
<tr>
<td>Site Configuration</td>
<td>103</td>
</tr>
<tr>
<td>Configuring the Site Home Page</td>
<td>103</td>
</tr>
<tr>
<td>Configuring the Administrator Contact Page</td>
<td>103</td>
</tr>
<tr>
<td>Editing the Site Title</td>
<td>103</td>
</tr>
<tr>
<td>Editing the Global Logo</td>
<td>103</td>
</tr>
<tr>
<td>Configuring the Server Base URL</td>
<td>103</td>
</tr>
<tr>
<td>Customising Default Space Content</td>
<td>103</td>
</tr>
<tr>
<td>Configuring the Destination of View Space Links</td>
<td>104</td>
</tr>
<tr>
<td>Editing the Site Welcome Message</td>
<td>104</td>
</tr>
<tr>
<td>Configuring the What's New Dialog</td>
<td>104</td>
</tr>
<tr>
<td>Configuring Encoding</td>
<td>104</td>
</tr>
<tr>
<td>Character encodings in Confluence</td>
<td>104</td>
</tr>
<tr>
<td>Troubleshooting Character Encodings</td>
<td>105</td>
</tr>
<tr>
<td>Configuring Mail</td>
<td>105</td>
</tr>
<tr>
<td>Configuring a Server for Outgoing Mail</td>
<td>105</td>
</tr>
<tr>
<td>Setting Up a Mail Session for the Confluence Distribution</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the Recommended Updates Email Notification</td>
<td>105</td>
</tr>
<tr>
<td>The Mail Queue</td>
<td>105</td>
</tr>
<tr>
<td>Optional Settings</td>
<td>105</td>
</tr>
<tr>
<td>Attachment Storage Configuration</td>
<td>106</td>
</tr>
<tr>
<td>Configuring a WebDAV client for Confluence</td>
<td>106</td>
</tr>
<tr>
<td>Configuring Quick Navigation</td>
<td>107</td>
</tr>
<tr>
<td>Enabling OpenSearch</td>
<td>107</td>
</tr>
<tr>
<td>Enabling the Did You Mean Feature</td>
<td>107</td>
</tr>
<tr>
<td>Enabling the Remote API</td>
<td>107</td>
</tr>
<tr>
<td>Enabling Threaded Comments</td>
<td>107</td>
</tr>
<tr>
<td>Enabling Trackback</td>
<td>107</td>
</tr>
<tr>
<td>Other Settings</td>
<td>107</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Configuring Attachment Size</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Character Encoding</td>
<td>107</td>
</tr>
<tr>
<td>Configuring HTTP Timeout Settings</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Indexing Language</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Number Formats</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Shortcut Links</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Time and Date Formats</td>
<td>107</td>
</tr>
<tr>
<td>Known Issues with Enterprise or Webhosting environments</td>
<td>108</td>
</tr>
<tr>
<td>Configuring System Properties</td>
<td>108</td>
</tr>
<tr>
<td>Recognised System Properties</td>
<td>109</td>
</tr>
<tr>
<td>Application Server Configuration</td>
<td>110</td>
</tr>
<tr>
<td>Application Server URL encoding</td>
<td>110</td>
</tr>
<tr>
<td>Managing Application Server Memory Settings</td>
<td>110</td>
</tr>
<tr>
<td>Switching to Apache Tomcat</td>
<td>110</td>
</tr>
<tr>
<td>Database Configuration</td>
<td>110</td>
</tr>
<tr>
<td>Known Issues For Supported Databases</td>
<td>110</td>
</tr>
<tr>
<td>Database Setup Guides</td>
<td>111</td>
</tr>
<tr>
<td>Creating Database Schema Manually</td>
<td>114</td>
</tr>
<tr>
<td>Migrate to Another Database</td>
<td>114</td>
</tr>
<tr>
<td>Troubleshooting the Embedded Database (HSQL DB)</td>
<td>114</td>
</tr>
<tr>
<td>Troubleshooting External Database Connections</td>
<td>114</td>
</tr>
<tr>
<td>Improving Database Performance</td>
<td>114</td>
</tr>
<tr>
<td>Surviving Database Connection Closures</td>
<td>115</td>
</tr>
<tr>
<td>Webserver Configuration</td>
<td>115</td>
</tr>
<tr>
<td>Configuring Web Proxy Support for Confluence</td>
<td>115</td>
</tr>
<tr>
<td>Running Confluence behind Apache</td>
<td>115</td>
</tr>
<tr>
<td>Starting Confluence Automatically on System Startup</td>
<td>116</td>
</tr>
<tr>
<td>Start Confluence Automatically on Linux</td>
<td>116</td>
</tr>
<tr>
<td>Start Confluence Automatically on Windows as a Service</td>
<td>117</td>
</tr>
<tr>
<td>Configuring a Large Confluence Installation</td>
<td>117</td>
</tr>
<tr>
<td>Configuring Logging</td>
<td>117</td>
</tr>
<tr>
<td>Troubleshooting SQL Exceptions</td>
<td>118</td>
</tr>
<tr>
<td>Registering External Gadgets</td>
<td>118</td>
</tr>
<tr>
<td>Configuring a URL Whitelist for Gadgets</td>
<td>118</td>
</tr>
<tr>
<td>Confluence Data Model</td>
<td>118</td>
</tr>
<tr>
<td>Confluence Clustering Overview</td>
<td>120</td>
</tr>
<tr>
<td>Technical Overview of Clustering in Confluence</td>
<td>120</td>
</tr>
<tr>
<td>Cluster safety mechanism</td>
<td>120</td>
</tr>
<tr>
<td>Changing Datasources Manually in a Cluster</td>
<td>120</td>
</tr>
<tr>
<td>Cluster Troubleshooting</td>
<td>121</td>
</tr>
<tr>
<td>Multicast Test</td>
<td>122</td>
</tr>
<tr>
<td>Clustering for Scalability vs Clustering for High Availability (HA)</td>
<td>122</td>
</tr>
<tr>
<td>Recommended network topology</td>
<td>122</td>
</tr>
<tr>
<td>Cluster Administration page</td>
<td>122</td>
</tr>
<tr>
<td>Cluster Checklist</td>
<td>122</td>
</tr>
<tr>
<td>Confluence Security</td>
<td>123</td>
</tr>
<tr>
<td>Confluence Community Security Advisory 2006-01-19</td>
<td>123</td>
</tr>
<tr>
<td>Confluence Security Advisory 2005-02-09</td>
<td>123</td>
</tr>
<tr>
<td>Confluence Security Advisory 2005-12-05</td>
<td>123</td>
</tr>
<tr>
<td>Confluence Security Advisory 2006-01-20</td>
<td>123</td>
</tr>
<tr>
<td>Confluence Security Advisory 2006-01-23</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2006-06-14</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2007-07-26</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2007-08-08</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2007-11-19</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2007-11-27</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2007-12-14</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2008-01-24</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2008-03-06</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2008-03-19</td>
<td>124</td>
</tr>
<tr>
<td>Confluence Security Advisory 2008-05-21</td>
<td>125</td>
</tr>
<tr>
<td>Confluence Security Advisory 2008-07-03</td>
<td>125</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Modifying Look and Feel (for themes)</td>
<td>136</td>
</tr>
<tr>
<td>Creating a Theme</td>
<td>137</td>
</tr>
<tr>
<td>Importing Data</td>
<td>137</td>
</tr>
<tr>
<td>Importing Content from Another Wiki</td>
<td>138</td>
</tr>
<tr>
<td>Performance Tuning</td>
<td>138</td>
</tr>
<tr>
<td>Cache Performance Tuning</td>
<td>138</td>
</tr>
<tr>
<td>Cache Performance Tuning for Specific Problems</td>
<td>139</td>
</tr>
<tr>
<td>Confluence Cache Schemes</td>
<td>139</td>
</tr>
<tr>
<td>Memory usage and requirements</td>
<td>139</td>
</tr>
<tr>
<td>Requesting Performance Support</td>
<td>139</td>
</tr>
<tr>
<td>Access Log Scripts</td>
<td>140</td>
</tr>
<tr>
<td>Troubleshooting Slow Performance Using Page Request Profiling</td>
<td>140</td>
</tr>
<tr>
<td>Compressing an HTTP Response within Confluence</td>
<td>140</td>
</tr>
<tr>
<td>Performance Testing Scripts</td>
<td>140</td>
</tr>
<tr>
<td>Garbage Collector Performance Issues</td>
<td>141</td>
</tr>
<tr>
<td>Operating Large or Mission-Critical Confluence Installations</td>
<td>142</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>142</td>
</tr>
<tr>
<td>Search</td>
<td>143</td>
</tr>
<tr>
<td>Setup Confluence To Index External Sites</td>
<td>143</td>
</tr>
<tr>
<td>Setup External Search Tool To Index Confluence</td>
<td>143</td>
</tr>
<tr>
<td>Working with Confluence Logs</td>
<td>143</td>
</tr>
<tr>
<td>log4j Logging Levels</td>
<td>143</td>
</tr>
<tr>
<td>Integrating Confluence with Other Applications</td>
<td>143</td>
</tr>
<tr>
<td>Configuring Application Links</td>
<td>143</td>
</tr>
<tr>
<td>Adding an Application Link</td>
<td>144</td>
</tr>
<tr>
<td>Configuring Authentication for an Application Link</td>
<td>144</td>
</tr>
<tr>
<td>Editing an Application Link</td>
<td>145</td>
</tr>
<tr>
<td>Making an Application Link the Primary Link</td>
<td>145</td>
</tr>
<tr>
<td>Relocating an Application Link</td>
<td>145</td>
</tr>
<tr>
<td>Upgrading an Application Link</td>
<td>145</td>
</tr>
<tr>
<td>Deleting an Application Link</td>
<td>145</td>
</tr>
<tr>
<td>Configuring Project Links across Applications</td>
<td>145</td>
</tr>
<tr>
<td>Confluence and JIRA</td>
<td>146</td>
</tr>
<tr>
<td>Installing Confluence and JIRA Together</td>
<td>146</td>
</tr>
<tr>
<td>Integrating JIRA and Confluence</td>
<td>146</td>
</tr>
<tr>
<td>Setting Up Trusted Communication between JIRA and Confluence</td>
<td>146</td>
</tr>
<tr>
<td>Confluence Installation and Upgrade Guide</td>
<td>147</td>
</tr>
<tr>
<td>System Requirements</td>
<td>147</td>
</tr>
<tr>
<td>Server Hardware Requirements Guide</td>
<td>147</td>
</tr>
<tr>
<td>Example Size and Hardware Specifications From Customer Survey</td>
<td>147</td>
</tr>
<tr>
<td>Confluence Installation Guide</td>
<td>148</td>
</tr>
<tr>
<td>Installing Confluence</td>
<td>148</td>
</tr>
<tr>
<td>Installing Confluence on Windows</td>
<td>148</td>
</tr>
<tr>
<td>Installing Confluence on Linux</td>
<td>148</td>
</tr>
<tr>
<td>Change listen port for Confluence</td>
<td>149</td>
</tr>
<tr>
<td>Installing the Confluence EAR-WAR Edition</td>
<td>149</td>
</tr>
<tr>
<td>Known Issues for Apache Tomcat</td>
<td>150</td>
</tr>
<tr>
<td>Installing Java for Confluence</td>
<td>150</td>
</tr>
<tr>
<td>Confluence Cluster Installation</td>
<td>150</td>
</tr>
<tr>
<td>Confluence Cluster Installation with Existing Data</td>
<td>150</td>
</tr>
<tr>
<td>Apache and Tomcat load balancing</td>
<td>151</td>
</tr>
<tr>
<td>Creating a Dedicated User Account on the Operating System to Run Confluence</td>
<td>151</td>
</tr>
<tr>
<td>Getting a Confluence License</td>
<td>151</td>
</tr>
<tr>
<td>Running Confluence in a Virtualised Environment</td>
<td>151</td>
</tr>
<tr>
<td>Confluence Setup Guide</td>
<td>151</td>
</tr>
<tr>
<td>External Database</td>
<td>152</td>
</tr>
<tr>
<td>Load Content for the Site</td>
<td>152</td>
</tr>
<tr>
<td>Restoring from Backup During Setup</td>
<td>153</td>
</tr>
<tr>
<td>Configuring JIRA Integration in the Setup Wizard</td>
<td>153</td>
</tr>
<tr>
<td>Upgrading Confluence</td>
<td>153</td>
</tr>
<tr>
<td>Upgrading Beyond Current Licensed Period</td>
<td>154</td>
</tr>
<tr>
<td>Confluence Post-Upgrade Checks</td>
<td>154</td>
</tr>
</tbody>
</table>
Confluence 2.9 Release Notes .............................................................. 205
Confluence 2.10.1 Release Notes ....................................................... 206
Confluence 2.10.2 Release Notes ....................................................... 207
Confluence 2.10.3 Release Notes ....................................................... 207
Confluence 2.10.4 Release Notes ....................................................... 208
Confluence 2.10 Release Notes .......................................................... 208
Release Notes 2.0 ......................................................................... 209
Release Notes 2.0.1 ....................................................................... 210
Release Notes 2.0.2 ....................................................................... 210
Release Notes 2.0.3 ....................................................................... 211
Release Notes 2.1 ........................................................................... 211
Release Notes 2.1.1 ....................................................................... 211
Release Notes 2.1.2 ....................................................................... 211
Release Notes 2.1.3 ....................................................................... 211
Release Notes 2.1.4 ....................................................................... 211
Release Notes 2.1.5 ....................................................................... 211
Release Notes 2.2 ........................................................................... 212
Release Notes 2.2.1 ....................................................................... 212
Release Notes 2.2.2 ....................................................................... 212
Release Notes 2.2.3 ....................................................................... 212
Release Notes 2.2.4 ....................................................................... 213
Release Notes 2.2.5 ....................................................................... 213
Release Notes 2.2.6a ..................................................................... 213
Release Notes 2.2.7 ....................................................................... 213
Release Notes 2.2.8 ....................................................................... 213
Release Notes 2.2.9 ....................................................................... 213
Release Notes 2.2.10 ..................................................................... 213
Release Notes 2.3 ........................................................................... 213
Release Notes 2.3.1 ....................................................................... 214
Release Notes 2.3.2 ....................................................................... 214
Release Notes 2.3.3 ....................................................................... 214
Release Notes 2.4 ........................................................................... 214
Release Notes 2.4.1 ....................................................................... 215
Release Notes 2.4.2 ....................................................................... 215
Release Notes 2.4.3 ....................................................................... 215
Release Notes 2.4.4 ....................................................................... 215
Release Notes 2.4.5 ....................................................................... 215
Release Notes 2.5 ........................................................................... 215
Release Notes 2.5.1 ....................................................................... 215
Release Notes 2.5.2 ....................................................................... 215
Release Notes 2.5.3 ....................................................................... 216
Release Notes 2.5.4 ....................................................................... 216
Release Notes 2.5.5 ....................................................................... 216
Release Notes 2.5.6 ....................................................................... 216
Release Notes 2.5.7 ....................................................................... 216
Release Notes 2.5.8 ....................................................................... 216
Confluence 1.x.x Releases ................................................................. 216
Release Notes 1.0 ........................................................................... 217
Release Notes 1.0.1 ....................................................................... 219
Release Notes 1.0.3 ....................................................................... 219
Release Notes 1.1 ........................................................................... 219
Release Notes 1.1.1 ....................................................................... 220
Release Notes 1.1.2 ....................................................................... 220
Release Notes 1.2 ........................................................................... 220
Release Notes 1.2.1 ....................................................................... 220
Release Notes 1.2.2 ....................................................................... 220
Release Notes 1.2.3 ....................................................................... 220
Release Notes 1.3 ........................................................................... 221
Release Notes 1.3.1 ....................................................................... 221
Release Notes 1.3.2 ....................................................................... 221
Release Notes 1.3.4 ....................................................................... 221
Release Notes 1.3.5 ....................................................................... 222
Confluence 4.3 Documentation

Release Notes 1.3.6 .............................................................. 222
Release Notes 1.4 .............................................................. 222
Release Notes 1.4.1 .............................................................. 222
Release Notes 1.4.2 .............................................................. 222
Release Notes 1.4.3 .............................................................. 222
Release Notes 1.4.4 .............................................................. 222

Confluence Development Releases ........................................... 223
Confluence 4.3-RC1 Release Notes ........................................... 223
Confluence 4.3-Beta1 Release Notes ......................................... 223
Confluence 4.3-m11 EAP Release Notes ..................................... 224
  Confluence 4.3 EAP only - JIRA Integration with Confluence Notifications .................................................. 225
Confluence 4.2-Beta3 Release Notes ......................................... 225
Confluence 4.2-Beta2 Release Notes ......................................... 225
Confluence 4.2-Beta1 Release Notes ......................................... 225
Confluence 4.1-rc1 Release Notes ............................................ 226
  Confluence 4.1-rc1 Upgrade Notes ........................................ 226
Confluence 4.1-m5 EAP Release Notes ....................................... 226
Confluence 4.0-beta2 ("Beta 2") Release Notes .............................................................. 227
Confluence 4.0-m36 EAP Release Notes ..................................... 228
Confluence 4.0-m29 EAP Release Notes ..................................... 229
Confluence 4.0-m27 EAP Release Notes ..................................... 229
Confluence 3.5-rc1 ("Release Candidate 1") Release Notes ............ 230
Confluence 3.5-beta3 ("Beta 3") Release Notes ......................... 230
Confluence 3.5-beta2 ("Beta 2") Release Notes .......................... 231
Confluence 3.5-beta1 ("Beta 1") Release Notes .......................... 231
Confluence 3.5-m4 ("Milestone 4") Release Notes ....................... 232
Confluence 3.5-m3 ("Milestone 3") Release Notes ....................... 232
Confluence 3.5-m2 ("Milestone 2") Release Notes ....................... 232
Confluence 3.5-m1 ("Milestone 1") Release Notes ....................... 233
Release Notes 3.4-beta1 ("Beta 1") ................................. 233
Release Notes 3.4-m4 ("Milestone 4") .................................... 234
Release Notes 3.4-m2 ("Milestone 2") .................................... 234
Release Notes 3.4-m1 ("Milestone 1") .................................... 235
Release Notes 3.3-beta3 ("Beta3") ........................................ 235
Release Notes 3.3-m3 ("Milestone 3") .................................... 236
Release Notes 3.3-m1 ("Milestone 1") .................................... 237
Confluence 3.2 Beta Release Notes ........................................ 237
Release Notes 3.2-m3 ("Milestone 3") .................................... 238
Release Notes 3.2-m4 ("Milestone 4") .................................... 239
Confluence 3.1 Release Candidate 1 Release Notes ..................... 240
Confluence 3.1 Beta 2 Release Notes ........................................ 240
Confluence 3.1 Beta 1 Release Notes ........................................ 241
Confluence 3.1 Newly Deprecated Code .................................. 242
Release Notes 3.1-m7 ("Milestone 7") .................................... 242
Release Notes 3.1-m6 ("Milestone 6") .................................... 242
Release Notes 3.1-m5 ("Milestone 5") .................................... 243
  Prototype REST API ...................................................... 243
Release Notes 3.1-m4 ("Milestone 4") .................................... 243
Release Notes 3.1-m3 ("Milestone 3") .................................... 244
  Confluence 3.1 Deprecated Code Cleanup ............................. 244
Release Notes 3.1-m1 ("Milestone 1") .................................... 245
Release Notes 3.0-rc1 ("Release Candidate 1") ....................... 245
Release Notes 3.0-beta2 ("Beta 2") ...................................... 246
Release Notes 3.0-m9 ("Milestone 9") .................................... 246
Release Notes 3.0-m8 ("Milestone 8") .................................... 246
Release Notes 3.0-m7 ("Milestone 7") .................................... 247
Release Notes 3.0-m6 ("Milestone 6") .................................... 247
Release Notes 3.0-m5 ("Milestone 5") .................................... 248
Release Notes 3.0-m4 ("Milestone 4") .................................... 248
Release Notes 3.0-m3 ("Milestone 3") .................................... 248
Release Notes 2.10-rc1 ("Release Candidate 1") ....................... 248
Release Notes 2.10-m8 ("Milestone 8") .................................... 249

Creative Commons Attribution 2.5 Australia License
Release Notes 2.10-m7 ("Milestone 7") ............................................. 249
Release Notes 2.10-m5 ("Milestone 5") ........................................ 249
Release Notes 2.10-m4 ("Milestone 4") ........................................ 249
Release Notes 2.10-m3 ("Milestone 3") ....................................... 250
Release Notes 2.10-m2 ("Milestone 2") ....................................... 250
Release Notes 2.10-m1 ("Milestone 1") ....................................... 250
Release Notes 2.9-rc1 ("Release Candidate 1") ............................... 250
Release Notes 2.9-m5 ("Milestone 5") ......................................... 251
Release Notes 2.9-m3 ("Milestone 3") ......................................... 251
Release Notes 2.9-m2 ("Milestone 2") ......................................... 251
Release Notes 2.8-m9 ("Milestone 9") ......................................... 251
Release Notes 2.8-m7 ("Milestone 7") ......................................... 251
Release Notes 2.8-m6 ("Milestone 6") ......................................... 251
Release Notes 2.8-m4 ("Milestone 4") ......................................... 252
Release Notes 2.8-m3 ("Milestone 3") ......................................... 252
Release Notes 2.8-m2 ("Milestone 2") ......................................... 252
Release Notes 2.7-rc1 ("Release Candidate 1") ............................... 252
Release Notes 2.7-m5 ("Milestone 5") ......................................... 252
Release Notes 2.7-m4 ("Milestone 4") ......................................... 252
Release Notes 2.7-m2 ("Milestone 2") ......................................... 252
Release Notes 2.6-dr1 ................................................................. 252

Including Cascading Stylesheets in Themes for Confluence 2.6 ............ 253
Release Notes 2.3-DR2 ............................................................... 253
Release Notes 2.3-DR1 ............................................................... 253
Release Notes 2.0-RC2 ............................................................... 253
Release Notes 2.0-RC1 ............................................................... 253
Release Notes 1.5-DR2 ............................................................... 253
Release Notes 1.5-DR1 ............................................................... 254
Release Notes 1.4-RC2 ............................................................... 254
Release Notes 1.4-DR7 ............................................................... 254
Release Notes 1.4-DR6 ............................................................... 254

Issues Resolved for 1.4-DR6 ......................................................... 255
Release Notes 1.4-DR4 ............................................................... 255
Release Notes 1.4-DR3 ............................................................... 255

1.4 Interface - Where Did Everything Go? ...................................... 255
Release Notes 1.4-DR2 ............................................................... 255
Release Notes 1.4-DR1 ............................................................... 257
Release Notes 1.3-final ............................................................... 258
Release Notes 1.3-DR4 ............................................................... 258
Release Notes 1.3-DR3 ............................................................... 258
Release Notes 1.3-DR2 ............................................................... 258
Release Notes 1.3-DR1 ............................................................... 258

Troubleshooting Problems and Requesting Technical Support ............... 258
Content Anonymiser for Data Backups ........................................... 259
Enabling Detailed SQL Logging ..................................................... 259
Generating a Heap Dump .......................................................... 259
Generating a Thread Dump ......................................................... 259
Generating a Thread Dump Externally .......................................... 259
Getting Java Crash Log File ....................................................... 260
Profiling using the YourKit Plugin ............................................... 260

Confluence Resources ............................................................... 260
Trying Confluence in a Demonstration Site or Demo Space ................. 260
Confluence Tutorial Videos ....................................................... 260
Local Confluence Documentation ................................................ 260
Confluence SharePoint Connector ............................................... 261
Support Policies ................................................................. 261

Bug Fixing Policy ................................................................. 261
How to Report a Security Issue .................................................. 261
New Features Policy .............................................................. 261
Patch Policy ................................................................. 261
Security Advisory Publishing Policy ........................................... 261
Security Patch Policy ............................................................ 261
Confluence Documentation Home

Welcome to the documentation for Atlassian Confluence. We are so glad you have joined us on the wiki!

Getting started

- About Confluence
- Adding a page
- More things to try

Resources

- Evaluator
- Administrator
- Developer
- Knowledge base
- Getting support

Customising Confluence

- Applying a theme to a space
- Editing the colour scheme
- Changing the logo
- Choosing your home page
- Importing templates
Planning for Confluence 4

Use this page as a one-stop-shop to help you prepare for Confluence 4 and its new editor. This page is useful to people moving to Confluence 4.0 or later, from Confluence 3.5 or earlier.

⚠️ **Note:** The Wiki Markup editor has been removed in Confluence 4 and replaced with a new XHTML-based editor. Please see [Why We Removed the Wiki Markup Editor in Confluence 4.0](https://confluence.atlassian.com/x/XMHi) for full details.

✅ **Download or trial** [Confluence 4](https://www.atlassian.com/software/confluence/download).

**Confluence 4 Guides**
For Administrators

We’ve been working hard to make your life easier upgrading to Confluence 4. Here are some resources to help:

- Confluence 4.0 Release Notes
- Quick Administrator Tips To Prepare for Confluence 4
- Confluence 4 Editor FAQ
- Migration from Wiki Markup to XHTML-Based Storage Format

For Plugin Developers

Plugin developers - check out the guides we’ve created for you to help you migrate your plugins to Confluence 4:

- Preparing for Confluence 4.0
- Plugin points for the editor in 4.0
- Plugin Development Upgrade FAQ for 4.0
- Watch a webinar on preparing plugins for 4.0
- Atlascamp 2010 - Confluence 4.0 Plugin Migration Talk
- Changes to the remote API in Confluence 4.0

For Users

To make the transition easier to Confluence 4, we’ve created some guides for you:

- Confluence 4 high-level feature tour
- Quick Reference Guide for the Confluence Editor
- What’s Changed for Wiki Markup Users
- What’s Changed for Users of the Old Rich Text Editor
- Confluence 4 Editor FAQ

Need help upgrading? Don’t forget Atlassian has a large list of partners that can help you with your upgrade.

Confluence 4 Editor FAQ

Confluence 4 introduces a new editor. This page contains answers to common questions, to help you with your move to Confluence 4.

Why is Atlassian introducing a new editor in 4.0?

The editor is the single most important feature in Confluence. Confluence 3.5 has two editors: the rich text editor and the wiki markup editor. Each has its strong points and weak points.

- The rich text editor in particular has problems in stability and consistency, because it has to convert all content from rich text to wiki markup before storing content on the database. This leads to the so-called ‘round-tripping’ problems, where the page looks different in display mode than when created in edit mode.
- Many people find the wiki markup editor hard to use, particularly for long pages and complex layouts. We often hear from customers that the number one barrier to wiki adoption in their organisation is that people have to learn wiki markup.

Many customers have given us great feedback on the shortcomings of the current editors and the things they would like to see in a Confluence editor. We are introducing a single new editor to replace both the wiki markup editor and the rich text editor. The new editor will help us to solve the problems mentioned above and will provide a stable platform on which we can build high-demand features in future releases.

What about features that were previously available only in wiki markup?
We have identified these features and will add support for as many as possible in the new editor. For example, the new editor will include superscript and subscript text formatting, which is currently not available in the Confluence 3.5 rich text editor.

**So you are basically eliminating the wiki markup editor and keeping the rich text editor?**

No. While the new editor is WYSIWYG like the current rich text editor, the new editor has a completely different architecture based on a new XHTML-based storage format, and is faster and significantly more reliable. Our goal is to incorporate the strengths of wiki markup with the richness and intuitiveness of the WYSIWYG editor to produce a rich, hybrid editing experience. In particular, we are introducing options that offer the speed of the old wiki markup editor, via new features such as autocomplete and shortcut keys.

**On this page:**

- Why is Atlassian introducing a new editor in 4.0?
- What about features that were previously available only in wiki markup?
- So you are basically eliminating the wiki markup editor and keeping the rich text editor?
- Will you be able to paste wiki markup into the new Confluence editor?
- Will Confluence 4.0 support the Office Connector, including 'Edit Page in Word' functionality?
- In Confluence 4.0, will you be able to merge and split table cells?
- When will the new editor appear in Confluence?
- What does the new editor look like?
- Will Confluence still have a wiki markup editor?
- What format will Confluence use to store its page content?
- Will you be able to edit the source XML code directly?
- Will there be a tool to convert existing content from wiki markup to the new format?
- Will there be any API changes?
- How many Confluence 3.x releases will you have before 4.0?
- Will the remote XML-RPC API still work in Confluence 4.0?
- Will the new editor be included in JIRA?
- Does the SharePoint Connector support Confluence 4.0?

**Will you be able to paste wiki markup into the new Confluence editor?**

There will be multiple ways to insert wiki markup in the new editor.

For those of you that have learned wiki markup and are used to the speed of wiki markup we are really excited to let you know that you will still be able to write wiki markup in the new editor. This wiki markup converts 'on the fly', providing one of the fastest editing experiences yet.

For those of you that have scripts that produce wiki markup, or often write wiki markup in meetings, the new Confluence 4.0 editor introduces an **Insert > Wiki markup** dialog which will let you paste wiki markup for a one-way conversion.

**Will Confluence 4.0 support the Office Connector, including 'Edit Page in Word' functionality?**

Most of the features of the Office Connector (the View File macros, Import from Word) already work in 4.0. However, the 'Edit in Word' feature will be removed in Confluence 4.0.

When speaking to customers about the use of the 'Edit in Word' functionality, the primary reason for using this feature was ‘familiarity’. Business users in organisations have found the 3.5 editor and wiki markup hard to learn.

In Confluence 4.0, we have greatly simplified the new editor user interface. With extensive usability testing, we are confident the new editor will be easier to learn and more reliable to use. We also have a large majority of customers who do not use the 'Edit in Word' functionality.
Please Note: We are referring to the "Edit Page in Word" functionally - not the "Edit Attachment in Word" functionality. Editing attachments in Word will still work fine, i.e. launching Word to edit Word documents that are stored in Confluence.

In Confluence 4.0, will you be able to merge and split table cells?
Yes, you will be able to merge and split table cells. This is a brand new feature in Confluence 4.0.

When will the new editor appear in Confluence?
The new editor is in Confluence 4.0 and later.

What does the new editor look like?
To see the new editor, you can download or trial Confluence 4, or watch a tutorial video.

Will Confluence still have a wiki markup editor?
No. The vision is incorporating the best parts of the wiki markup editor into the new editor to provide the best of both worlds.

What format will Confluence use to store its page content?
A new XHTML-based storage format. Up to now, Confluence has stored its content in the database as wiki markup. In Confluence 4.0 and later, the content will be stored as XML, with a significant proportion of XHTML-based elements.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Will you be able to edit the source XML code directly?
Confluence 4.0 will not have an edit source mode by default. More sophisticated macro placeholders, images and link handling in Confluence 4.0 entail a lot of custom XML which make the new storage format much more complex than standard HTML. Editing this storage format by hand could result in corrupt content and the loss of page data. Source editing will still be editable via the APIs and the WebDAV client. There is also a Confluence Source Editor plugin which allows users to edit the storage format of the page. (You need Confluence 4.1.5 or later to use the plugin.)

Will there be a tool to convert existing content from wiki markup to the new format?
Yes. Where possible, Confluence will automatically upgrade existing content into the new storage format. There will be some API changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to the new storage format.

Read the Plugin Development Upgrade FAQ for 4.0 or Planning for Confluence 4.0 to learn more about API changes.

Will there be any API changes?
Yes. There will be some API changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to the new storage format.

Read the Plugin Development Upgrade FAQ for 4.0 or Planning for Confluence 4.0 to learn more about API changes.
How many Confluence 3.x releases will you have before 4.0?

There will be no more 3.x releases before 4.0. Confluence 3.5 is our last 3.x release.

Will the remote XML-RPC API still work in Confluence 4.0?

We currently plan to keep the existing XML-RPC API but only allow write access which will automatically convert wiki markup to the new XML storage format. This will allow you to create new pages or update existing pages as usual. We can't allow read access, however, because we can only return XML, which will break the existing APIs contract of returning wiki markup. To cover those use cases and to have a fully XML capable API, we will introduce a new API available through a separate URL which will also have a new method to migrate wiki markup to the new storage format.

Developers should read Preparing for Confluence 4.0 to learn more about API changes.

Will the new editor be included in JIRA?

At the moment we don't have any plans to do this. However, we are open to this idea and would welcome any customer feedback in this area.

Does the SharePoint Connector support Confluence 4.0?

The SharePoint Connector 1.5 is compatible with Confluence 4.x.

Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor

This page is a quick-reference guide describing the changes to the editor in Confluence 4.0 and later, showing you how to perform your day-to-day tasks in the new editor. This guide is for people who regularly used the Rich Text Editor in earlier versions of Confluence.

How to Get Started Quickly

1. Try the commands and menus you know from the old Rich Text Editor. The new editor incorporates much of the existing functionality.

2. Learn the keyboard shortcuts. Click the help icon on the editor toolbar to see a list of keyboard shortcuts.

3. Undo the autocomplete and autoformat actions. To undo something that autocomplete or autoformat has done, press Backspace on your keyboard. Alternatively, press Ctrl+Z (Windows) or Cmd+Z (Mac).

On this page:

- How to Get Started Quickly
- Before and After Guide
  - Using the Editor
  - Adding Macros
  - Formatting Text
  - Adding Symbols and Emoticons
  - Linking text
  - Using bulleted and numbered lists
  - Using tables
  - Displaying images
  - Embedding multimedia files
- Functionality that is No Longer Available
Before and After Guide

Below are the most commonly used menu options from the old Rich Text Editor, and instructions on how to perform the same actions in the new editor.

**Using the Editor**

<table>
<thead>
<tr>
<th>What You Did Before</th>
<th>What to Do Now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic typing and editing:</strong> Typed your content directly into the editor window, using the toolbar buttons to insert other content.</td>
<td>Your experience should be much the same. Generally, the transition from using the Confluence 3.5 Rich Text Editor to the new Confluence 4 editor should be smooth. Try doing things the way you always did, and check the table below if you can’t find the feature you’re looking for.</td>
</tr>
</tbody>
</table>

**Adding Macros**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a macro to your page:</strong> Clicked ‘Insert / Edit Macro’.</td>
<td>Type ‘{‘ and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:</td>
</tr>
</tbody>
</table>

![Macro suggestions]

Alternatively, use **wiki markup entirely**. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `(blogposts:content=titles)`

ℹ️ You can still click ‘Insert’ > ‘Other Macros’.

**Formatting Text**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>

---

*Confluence 4.3 Documentation*

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
<table>
<thead>
<tr>
<th><strong>Making text bold, italic or underlined:</strong></th>
<th>No change.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected text and clicked the respective menu button.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Heading levels:</strong></th>
<th>No change.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected text and chose a heading level from the menu.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Left, centre and right alignment:</strong></th>
<th>Click the left, centre and right alignment buttons on the editor toolbar:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not available in previous versions of Confluence.</td>
<td><img src="image" alt="Alignment buttons" /></td>
</tr>
<tr>
<td>This can also be used to align images independently of text.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Indentation:</strong></th>
<th>No change. Click the left and right indentation buttons on the editor toolbar:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the left and right indentation buttons on the editor toolbar:</td>
<td><img src="image" alt="Indentation buttons" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Making text strikethrough, monospace, superscript or subscript:</strong></th>
<th>Click this button on the editor toolbar and select from the drop-down list. Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected text and clicked the respective menu button.</td>
<td><img src="image" alt="Formatting options" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Quoting text:</strong></th>
<th>No change: Use the <em>Quote</em> style – select <em>Quote</em> from the style dropdown menu or use the keyboard shortcut. Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected text and chose the <em>Quote</em> style from the drop-down menu.</td>
<td><img src="image" alt="Paragraph styles" /></td>
</tr>
</tbody>
</table>
## Changing text colour:
Selected text and chose a colour from the menu bar.

No change: Click the colour options on the editor toolbar. Example:

![Colour palette](image)

## Adding Symbols and Emoticons

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Smiley:**  Clicked 'Insert' > 'Emoticon' on the toolbar. 😊 | Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:  

: )  

ℹ️ You can still click 'Insert' > 'Emoticon' on the toolbar. |

| **Tick or check mark:**  Clicked 'Insert' > 'Emoticon' > ✅ | Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:  

( / )  

ℹ️ You can still click 'Insert' > 'Emoticon' > ✅ |

## Linking text

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
</table>

Linking to a Confluence page:
Clicked 'Insert' > 'Link' on the toolbar.

Type a square bracket '[' and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:

```
[ Modern Girl
```

Alternatively, use wiki markup entirely. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[Modern Girl|Modern Girl song lyrics]`

ℹ️ You can still click 'Link' on the toolbar.
### Linking text to a web page:
Selected the text and clicked 'Link' > 'Web Link' on the toolbar and typed the URL into the dialog box.

<table>
<thead>
<tr>
<th><img src="image" alt="Insert Web Link" /></th>
</tr>
</thead>
</table>

Type a square bracket `[` and select 'Insert Web Link', then paste the URL into the link dialog. Example:

```
[ Modern Girl ]
```

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** [Modern Girl](http://www.example.com/song)

⚠️ You can still use 'Link' > 'Web Link' on the toolbar.
| Linking to a page that does not yet exist: | Type a square bracket '[' and the name of the non-existent page, then select 'Insert Link to Create Page'. Example: |
| Not available in previous versions of Confluence. | [ Future of the modern girl ] |
| Alternatively, use wiki markup entirely. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser. | |
| • This works if you have 'Autoformatting' enabled in the editor settings in your user profile. | |
| • This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually. | |
| • Example: [Future of the Modern Girl] | |
| **Linking to a mailto link:** | **No change.** |
| Clicked 'Link' > 'Web Link' on the toolbar and typed mailto:username@example.com | You still click 'Link' > 'Web Link' on the toolbar and type mailto:username@example.com |
| **Linking to an anchor on a page:** | **No change.** |
| Clicked 'Link' > 'Web Link' on the toolbar and typed 'DestinationPage#AnchorName'. | You still click 'Link' > 'Web Link' on the toolbar and type 'DestinationPage#AnchorName'.
**Linking to an attachment:**
Clicked ‘Link’ > ‘Attachment’ on the toolbar.

Type a square bracket ‘[’ and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example:

```
[chos]
```

Alternatively, use **wiki markup entirely**. Type the link, including the alias (if required), the caret character ‘^’ and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** [^attachment name]

⚠️ You can still click ‘Link’ > ‘Attachment’ on the toolbar.

---

**Using bulleted and numbered lists**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding bullets:</strong></td>
<td>Type an asterisk ‘*’ followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:</td>
</tr>
<tr>
<td>Clicked ‘Unordered List’ on the toolbar.</td>
<td>My list:</td>
</tr>
<tr>
<td></td>
<td>⚫ bullet item</td>
</tr>
<tr>
<td></td>
<td>⚫ To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.</td>
</tr>
<tr>
<td></td>
<td>⚫ You can still click ‘Bullet List’ on the toolbar.</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/).
### Adding numbered items

Clicked ‘**Ordered List**’ on the toolbar.

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:

```
1. bullet item
```

- To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.
- You can still click ‘**Numbered List**’ on the toolbar.

### Adding line breaks in a numbered/bulleted list

Pressed **Shift+Enter**.

No change. You can still press **Shift+Enter**.

### Using tables

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a table:</strong></td>
<td>Type a series of pipe characters '</td>
</tr>
<tr>
<td>Clicked ‘<strong>Insert Table</strong>’ on the toolbar.</td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>You can still click ‘<strong>Insert</strong>’ &gt; ‘<strong>Table</strong>’ on the toolbar.</td>
</tr>
<tr>
<td><strong>Editing a table:</strong></td>
<td>No change, you can still use the toolbar table editing controls, with new features such as table merge and split.</td>
</tr>
<tr>
<td>Used the table buttons on the toolbar.</td>
<td></td>
</tr>
</tbody>
</table>

### Displaying images

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displayed an image attached to the page:</td>
<td>Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Typed/pasted the image name inside exclamation marks '!'. Example:</td>
<td>!NoMatterWhat.png!</td>
</tr>
</tbody>
</table>

Alternatively, use **wiki markup entirely**. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.
- **Example:** !NoMatterWhat.png|align=right!

<table>
<thead>
<tr>
<th>Displaying an image attached to another page:</th>
<th>Click 'Insert' &gt; 'Search' and type search terms to find the image in Confluence. Once found, click the image and it will be added to the page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicked 'Insert Image' &gt; 'From the Web' and inserted the URL of the image on the other page.</td>
<td></td>
</tr>
</tbody>
</table>

**Embedding multimedia files**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Embedding a video, movie or audio file into a page:
Clicked 'Insert' > 'Macro' > 'Multimedia Macro' and chose content from the browser.

Use the Multimedia macro. Type an exclamation mark ‘!’ and select 'Insert Other Media'. Example:

![Multimedia macro](image)

Or type ‘{’ and start typing the macro name 'Multimedia'. Example:

```
{Multimedia}
```

Functionality that is No Longer Available

This section contains a list of things you could do in in earlier versions of Confluence, but can no longer do in Confluence 4.

1. Edit a page in Microsoft Word. See FAQ entry.

RELATED TOPICS

Planning for Confluence 4

Confluence 4 Editor - What's Changed for Wiki Markup Users

This quick-reference guide is for people who regularly used the wiki markup editor in earlier versions of Confluence. It shows you how to use the new editor to do the things you have always done. And more.

The editor offers a number of options in the toolbar. But did you know...?

- You can use autocomplete and autoformatting shortcuts instead of the toolbar.
- The trigger characters for autocomplete and autoformatting are derived from wiki markup.
- You can add macros, links and images by typing the entire wiki markup element. As soon as you close the macro, link, or image, Confluence will convert it to rich text format and add it to the page.

Hints to get you started quickly

1. Type wiki markup into the editor. Confluence’s autocomplete and autoformat will convert the wiki markup as you type.
2. **Learn the keyboard shortcuts.** Click the help icon on the editor toolbar to see a list of keyboard shortcuts.

3. **Undo the autocomplete and autoformat actions.** To undo something that autocomplete or autoformat has done, press Ctrl+Z (Windows) or Cmd+Z (Mac).

---

**On this page:**

- **Hints to get you started quickly**
- **Before and after guide for wiki markup fans**
  - Using wiki markup
  - Adding macros
  - Formatting text
  - Adding symbols and emoticons
  - Linking text
  - Using bulleted and numbered lists
  - Using tables
  - Displaying images
  - Embedding multimedia files
- **Functionality that is no longer available**
- **New source editor plugin**

**Related pages:**

- **Keyboard Shortcuts**
- **Confluence Wiki Markup**
- **Using Autocomplete**

---

**Before and after guide for wiki markup fans**

Below are the most commonly used autocomplete and autoformatting triggers.

**Using wiki markup**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typing wiki markup:</strong> Typed text and wiki markup into the Wiki Markup Editor pane.</td>
<td>Start typing wiki markup – try it and see what happens!</td>
</tr>
</tbody>
</table>
Pasting wiki markup:
Pasted wiki markup into the Wiki Markup Editor pane.

Note: Confluence will convert the wiki markup to rich text as soon as you add it to your page. The wiki markup will not be available for editing after that. Example:

Click 'Insert' > 'Wiki Markup' on the editor toolbar.

Adding macros

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a macro to your page:</strong> Typed curly brackets, the macro name and parameters. Example:</td>
<td></td>
</tr>
<tr>
<td>(blog-posts)</td>
<td>Type '{' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:</td>
</tr>
<tr>
<td></td>
<td>{blog}</td>
</tr>
<tr>
<td>Alternatively, use <strong>wiki markup entirely.</strong> Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
</tr>
<tr>
<td></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
</tr>
<tr>
<td></td>
<td>• Example: (blogposts:content=titles)</td>
</tr>
</tbody>
</table>

Formatting text

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Bold text:</strong></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td></td>
</tr>
<tr>
<td>Typed an asterisk ‘*’, your text, then another asterisk in wiki markup. Example:</td>
<td></td>
</tr>
<tr>
<td><em>Surf's Up</em></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Heading levels:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed the heading level in wiki markup. Example:</td>
</tr>
<tr>
<td>h2. Midnight at the Lost and Found</td>
</tr>
</tbody>
</table>

| Confluence autoformat will convert the text to bold immediately. Example: |
| *Surf's Up* |

<table>
<thead>
<tr>
<th><strong>Underlining, italics, superscript, subscript:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed the wiki markup characters before and after your text.</td>
</tr>
</tbody>
</table>

| Autoformatting will convert it as you type. |

<table>
<thead>
<tr>
<th><strong>Left, centre and right alignment:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Not available in previous versions of Confluence.</em></td>
</tr>
</tbody>
</table>

| Click the left, centre and right alignment buttons on the editor toolbar: |
| ![Alignment buttons](image) |

| This can also be used to align images independently of text. |

<table>
<thead>
<tr>
<th><strong>Indentation:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Not available in previous versions of Confluence.</em></td>
</tr>
</tbody>
</table>

| Click the left and right indentation buttons on the editor toolbar: |
| ![Indentation buttons](image) |

<table>
<thead>
<tr>
<th><strong>Line break:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Started a new line with no empty line.</td>
</tr>
</tbody>
</table>

| Press **Shift + Enter** to force a line break without a paragraph break. This is a line break with no extra space. |
**Confluence 4.3 Documentation**

**Quotation:**
Typed the `quote` macro in wiki markup. Example:
```
{quote}Life is a lemon.{quote}
```

Use the *Quote* style – select 'Quote' from the style dropdown menu or use the keyboard shortcut. Example:

![Quote style in Confluence editor](image)

**Colour:**
Typed the `color` macro in wiki markup. Example:
```
{color:green}Bat out of Hell.{color}
```

Click the colour options on the editor toolbar. Example:

![Colour options in Confluence editor](image)

---

**Adding symbols and emoticons**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Smiley:**
Typed a colon and a round bracket. Example: :

<table>
<thead>
<tr>
<th>:</th>
</tr>
</thead>
</table>
| **Tick or check mark:**
Typed a forward slash in round brackets. Example: (/)

| (/) |

Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:

| :) |

Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:

| (/) |

---

**Linking text**
<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Linking to a Confluence page:**  
Typed the text and pasted the page name inside square brackets. Example:  
[Modern Girl|Modern Girl song lyrics] | Type a square bracket '[' and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:  
[Modern Girl|Modern Girl song lyrics]  
Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.  
- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.  
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.  
- Example: [Modern Girl|Modern Girl song lyrics] |
### Linking text to a web page:
Typed the text and pasted the link inside square brackets. Example:

```
[Modern Girl|http://www.example.com/song]
```

![Linking text to a web page](image)

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `[Modern Girl|http://www.example.com/song]`

### Linking to a page that does not yet exist:
Typed the name of the non-existent page inside square brackets. Example:

```
[Future of the Modern Girl]
```

![Linking to a page that does not yet exist](image)

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `[Future of the Modern Girl]`
### Linking to an attachment:
Typed `^` and the attachment name inside square brackets. Examples:

```
[^attachment name]
[Page Name^attachment name]
```

Type a square bracket `[^` and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example:

```
[^chocs]
```

Alternatively, use wiki markup entirely. Type the link, including the alias (if required), the caret character `^` and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
  - Example: `[^attachment name]`

### Linking to an anchor within a page:
Typed the page name with the anchor name appended. Example:

```
{anchor:index}
[Page Two#index]
```

To create the anchor: Add an anchor macro using wiki markup. Confluence will convert the macro to rich text format and add it to the page. For example, to create an anchor named 'index', type the following:

```
{anchor:index}
```

To create the link: Use wiki markup too. Type the link, including the alias (if required), the hash character `#` and the anchor name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
  - Example: `[Index#index]`

### Using bulleted and numbered lists

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>

---

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Adding bullets:
Typed an asterisk '*' in wiki markup. Example:

My list:
* Bad Attitude

Adding numbered items:
Typed a hash '#' in wiki markup. Example:

My list:
# A Time for Heroes

Adding line breaks in a numbered/bulleted list:
Started a new line. Typed a double slash for an empty line. Example:

///

Using tables

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a table:</strong></td>
<td>Type a series of pipe characters '</td>
</tr>
<tr>
<td>Typed pipe characters '</td>
<td>' in wiki markup. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Editing a table: | Learn the keyboard shortcuts for table editing. Click the help icon on the editor toolbar to see a list of shortcut keys. |
| Edited the text and shuffled the pipe characters around. | |

Displaying images

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>

Type an asterisk '*' followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:

My list:

- **bullet item**

To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:

My list:

1. **bullet item**

To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.

Press Shift + Enter.
**Displayed an image attached to the page:**
Typed/pasted the image name inside exclamation marks '!'. Example:

```
!NoMatterWhat.png!
```

Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:

![NoMatterWhat.png](image1.png)

Alternatively, use **wiki markup entirely**. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.
- **Example:** `!NoMatterWhat.png|align=right!`

**Displaying an image attached to another page:**
Typed/pasted the page name, a '^' and the image name inside exclamation marks. Example – to display an image that is attached to the page titled 'Home By Now':

```
!Home By Now^NoMatterWhat.png!
```

Exactly the same as when the image is attached to the same page, or use the new "Search" tab in "Insert" > "Image"

**Aligning images:**

```
!NoMatterWhat.png|align=right!
```

Click on the image and then:

Click the left, centre and right alignment buttons on the editor toolbar:

```
align-icons.png
```

This can also be used to align images independently of text.

### Embedding multimedia files

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/).
Embedding a video, movie or audio file into a page:
Used the wiki markup image format. Example: !HotPatootie.mov!

Use the Multimedia macro. Type an exclamation mark '!i' and select 'Insert Other Media'. Example:

Or type '{m}' and start typing the macro name 'Multimedia'. Example:

Functionality that is no longer available
This section contains a list of things you could do in in earlier versions of Confluence, but can no longer do in Confluence 4.

1. Edit a page in Microsoft Word. See FAQ entry.
2. Edit, copy or view the wiki markup source of a page. This is because content is no longer stored in wiki markup format.

New source editor plugin
The Confluence Source Editor plugin allows users to edit the XHTML-based storage format of the page. You need Confluence 4.1.5 or later to use the plugin.

Quick Administrator Tips To Prepare for Confluence 4
We've put together some quick tips on how Administrators can prepare for Confluence 4:

1. Stay Updated On The Latest Docs
Watch the Planning for Confluence 4 page. We will update that page with more resources as we make further progress - so make sure you stay updated!

2. Download, install and trial Confluence 4
We strongly encourage you to set aside some time to download and install the latest version of Confluence 4.x. You can be better prepared by conducting an upgrade of your data in a test environment to see how the upgrade
goes. Don't forget to get your internal users (especially the power users) to try Confluence 4. Ask them to go to their complex pages and see what they look like in the new editor and get feedback from them.

3. Give us feedback!

We really would love your feedback as you trial Confluence 4. We've made it really easy to do so. All you have to do is simply click the "Got Feedback" button you see in the Confluence toolbar:

![Click Me Button]

This feedback will go directly to the Confluence team.

⚠️ If you need support, please get in touch with our legendary support department at support.atlassian.com.

4. Upgrade your user macros - Now!

With the introduction of Confluence 4, all macros that are inserted in the editor will need to be entered using Macro Autocomplete, or through the Macro Browser. This includes User Macros too!

However, a problem with User Macros in the past was that the only way to insert them was if you knew what parameters were available - and that wasn't documented anywhere.

Now, if you are running Confluence 3.4 or higher, we introduced the ability for an Administrator to make their user macros visible in the Macro Browser and Macro Autocomplete. So the good news is you can prepare for that now, without having to wait for your Confluence 4 upgrade. How do you do this? You will need to define parameters for your user macros. All the documentation on how to do this can be found here. We've also created two examples to help you get started.

⚠️ Important: This is required to enable user macros in Confluence 4.

6. Test your plugins

Although not all plugins are compatible with Confluence 4 yet, you can still test a majority of your plugins in Confluence 4. We strongly recommend you try this and let Atlassian know if there are any issues. This is really important especially if you have custom plugins that you've built internally.

❓ How do I migrate my plugins to Confluence 4? All this information for plugin developers can be found from the Planning for Confluence 4 landing page.

**Trying Confluence 4 Yourself**

Confluence 4 is here! Try your own hosted or downloadable version, free for 30 days: Try Confluence.

RELATED TOPICS

Planning for Confluence 4

- Confluence 4 Editor FAQ
- Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor
- Confluence 4 Editor - What's Changed for Wiki Markup Users
- Quick Administrator Tips To Prepare for Confluence 4
- Trying Confluence 4 Yourself
- Giving Feedback on Confluence Releases
- Confluence 4 Editor - Customer Feedback
Giving Feedback on Confluence Releases

Atlassian is an open company, and we welcome customer feedback on releases of our products.

To provide your feedback, there are several ways you can get in touch with Atlassian:

1. Atlassian Answers

If you have a question like "How do I do (a given task) with Confluence now?", then Atlassian Answers is the best place to visit. There, our vibrant community of power users and developers quickly answer questions of all kinds and provide information on advanced tips and tricks.

2. The Atlassian Public JIRA

Atlassian collects and tracks customer feature requests and bug reports in our public instance of our issue tracker, jira.atlassian.com. There, you can request new product features or report bugs, as well as see all of the other feature requests and bug reports that customers have raised. If you agree with another point that’s been raised, you can vote on it to help it along. The Atlassian product managers read and maintain the issues in JIRA, so this is the best place to lodge your opinion about the product.

Confluence 4 Editor - Customer Feedback

FAQs

Commonly brought up comments which may be of use to others who are following this page

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is there a 'Confluence 4 for Wiki Markup users' guide available?</td>
<td>Yes, please see Confluence 4 Editor - What's Changed for Wiki Markup Users. If you have anything you'd like to see added to that page, please leave a comment there.</td>
</tr>
<tr>
<td>How can I edit the source / storage format of a page in Confluence or in</td>
<td>You can download the Source Editor, a free plugin maintained by Atlassian and available here.</td>
</tr>
<tr>
<td>an external editor.</td>
<td></td>
</tr>
<tr>
<td>I have a script that generates Wiki Markup, can I still insert it into</td>
<td>Yes. You can use the Insert Wiki Markup Dialog, just choose 'Insert' then 'Wiki Markup' or use the shortcut &quot;command/ctl + shift + D&quot;</td>
</tr>
<tr>
<td>a page?</td>
<td></td>
</tr>
<tr>
<td>I have a script that generates Wiki Markup and writes it to a Confluence</td>
<td>Yes. You can still send Wiki markup to the API which will convert it to the new source format and save. See this Answers discussion for more.</td>
</tr>
<tr>
<td>page using the API, can I still do this?</td>
<td></td>
</tr>
<tr>
<td>I have a script that consumed Wiki Markup from Confluence, do I need to</td>
<td>Yes. Wiki Markup is no longer available as an output from Confluence. Unfortunately this means you will need to re-write any scripts which consumed Wiki Markup from Confluence (often via the API as an example) to instead read the new XML based Storage Format.</td>
</tr>
<tr>
<td>re-write it?</td>
<td></td>
</tr>
<tr>
<td>I take notes in meetings etc offline in a text editor, formatted with</td>
<td>Take your notes as before then insert them into a page using the Insert Wiki Markup Dialog, just choose 'Insert' then 'Wiki Markup' or use the shortcut &quot;command(or ctrl)+shift+D&quot;</td>
</tr>
<tr>
<td>Wiki markup then add them to a page later, how can I do this now?</td>
<td></td>
</tr>
<tr>
<td>How can I move the cursor outside a Macro (eg: a {code} or {column}</td>
<td>You can just press the 'down' arrow until the cursor moves out of the macro and back onto the page.</td>
</tr>
<tr>
<td>macro) without using the mouse?</td>
<td></td>
</tr>
</tbody>
</table>
A macro I wrote that worked in 3.x no longer works for Confluence 4

See Upgrading and Migrating an Existing Confluence Macro to 4.0

Enter/Return gives me a new paragraph, how do I insert just a line break?

Press Shift+Enter

How can I quickly turn already entered text into a link?

You can highlight the string you want to convert, press [ and wait until the autocomplete menu appears then select from the available options to Search for a page with the title of that text, insert a web link with that text as the clickable link or to insert a link to create a page with that title.

A short "how-to" from Shannon Greywalker for doing unbalanced tables, tables within tables, etc. in the new 4.x editor.

Available here.

Why not make wiki-markup editor on top of XHTML storage? Just some engine, which would convert XHTML to wiki-markup and back on save.

Wiki markup can only represent a subset of what can be represented in XHTML. A wiki to XHTML conversion would be lossy meaning that when a 'wiki preferring' author made changes to the page of an 'xhtml preferring' author they would mangle (to some degree) the original author's page.

This is a reverse of the round-tripping bugs that used to be encountered when the storage was wiki but the editor was HTML.

One fairly typical example would be the case of merged table cells. Confluence Wiki markup cannot represent merged cells, whereas XHTML (and so therefore Confluence storage format) can.

I want to force something to stay as Wiki Markup on a page, not be converted.

You can use Bob Swift's Confluence Wiki Plugin, details here.

Is there a way to search across the instance for where a macro is used in a page?

You can do this with the use of the Confluence Macro Indexer plugin. Details on it's use are available here.

---

External Resources

Contributors to this page have kindly collated the following useful references which may assist anyone transitioning from Wiki Markup to the new Editor

- A short "how-to" from Shannon Greywalker for doing unbalanced tables, tables within tables, etc. in the new 4.x editor is available here.
- Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format by Graham Hannington are available here: Advanced Confluence Tips. These include information about:
  - Wikifier, a tool for converting Confluence XML to wiki markup, and for converting Confluence rich text to wiki markup.
  - A Greasemonkey script for The Wiki markup toolbar button which selects the page contents and opens it in the Insert Wiki Markup Dialog for editing.

---

Bugs / Improvement / New Feature Requests

If you have feedback on a bug, a task you now find harder or are unable to do in the new editor then please
leave a comment below and we'll incorporate it into this page (and remove the comment afterwards). Please note that these are usually only updated once completely fixed, we track progress separately on an internal queue.

### Resolved

**Click here to expand...**

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td><img src="Authenticate" alt="Authenticate to retrieve your issues" /> to retrieve your issues</td>
</tr>
</tbody>
</table>

### Open

Too add your issue, please raise a ticket in the CONF Project using the Component 'Editing' and specify the Affects Version. For bugs, please include your OS and Browser details.

**Click here to expand...**

Please note that while JIRA issues have been raised for all these comments, I don't want to set unreasonable expectations so just be aware that being in this list is not a guarantee of something being implemented. As always our Implementation of New Features Policy and Bug Fixing Policy apply.

<table>
<thead>
<tr>
<th>Bugs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
</tr>
<tr>
<td><img src="Authenticate" alt="Authenticate to retrieve your issues" /> to retrieve your issues</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Improvements/Feature Requests</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
</tr>
<tr>
<td><img src="Authenticate" alt="Authenticate to retrieve your issues" /> to retrieve your issues</td>
</tr>
</tbody>
</table>

**Require More Discussion**
## Customer Feedback

<table>
<thead>
<tr>
<th>Theme</th>
<th>From</th>
<th>Comment</th>
<th>Notes</th>
<th>Related Tickets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Removing HTML/CSS after Import/Paste</td>
<td><strong>Andreas Pfotenhauer</strong></td>
<td>...imported from a trac wiki, and the importer had left some strange inline css in place, setting some padding and margins, and i was not able to remove it using the new wonderful editor, so finally i edited the page directly in the database...</td>
<td><strong>Andreas, Matthias</strong>, I wondered whether you tried to select all content and use the ‘Clear Formatting’ option and how well that worked?</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Matthias Basler</strong></td>
<td>Finding bugs in the source code is difficult or impossible since one cannot see them in the WYSIWYG editor. (This includes invisible tags that should not be there, f.e. after copying content from a word document into the page)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Formatting          | Nils Andresen                        | If I have a table (or a note/warning) directly followed by a heading  
|                    |                                      | • previously I simply added a new line between them  
|                    |                                      | • now placing the cursor in the table and pressing enter does create a new line - but in the table  
|                    |                                      | • placing the cursor before the heading and pressing enter creates a new heading  
|                    |                                      | • so I’ll have to use the mouse to “undo” the heading - then start typing  
|                    | Nils                                  | for a quick workaround of sorts, you can use the  
|                    |                                      | Keyboard Shortcuts  
|                    |                                      | to remove (and apply) the heading so you don’t need to use the mouse when using your second approach.  
|                    |                                      | Do you think instead of maintaining the heading format on the line you create between the bottom of the table/macro and the heading we should instead default it to a plain paragraph? I’m not sure which seems the more natural myself, interested in your thoughts.  
| Anchor Links       | sanjay srikonda                      | Linking within the same page is a nightmare in 4.0. I have to press  
|                    |                                      | CTL+K to bring up the link window, yet, NOTHING in that window seems to work for linking within the same page. I have to create the same link 3-4 times before it “sticks” in my page.  
|                    | Sanjay                                | I’ll try and recreate this and raise a bug in JIRA for you.  

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Inserting Images</th>
<th>sanjay srikonda</th>
<th>Inserting graphics through the UI is buggy because sometimes it will insert a graphic just fine and the next graphic it will NOT show up or even show in my attached dialog. And, sometimes, thumbnails are not showing up for some inexplicable reason.</th>
<th>Sanjay as mentioned previously this definitely sounds like a bug, did you raise a support ticket?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working Offline</td>
<td>Peter Burkholder</td>
<td>Today I had to work on several significant planning pages while on a trip with no network access. With markup this can still be done, but in 4.x that is gone</td>
<td>Peter, interested in whether you were creating new pages or editing existing? How often do you need to do either? How did you do it 3.5? If you document in a text editor did you know you can use the Insert &gt; Wiki Markup dialog to put it straight into a page, would this work for you?</td>
</tr>
<tr>
<td>Anonymous x3</td>
<td></td>
<td>I often capture technical documentation in another editor before posting it to the wiki – this is in lieu of <strong>not documenting at all</strong>. What is broken is the ability to take these documents in wiki markup and work with it offline before reposting.</td>
<td>Is the problem here then that you need to be able to work offline?</td>
</tr>
<tr>
<td>Find &amp; Replace</td>
<td>Diego Ballve</td>
<td>Sometimes I used to copy a page away, do replacements on it using wiki syntax on text editor (say most of the page was good some paths and variables in the content had to be changed to reflect a different environment), then insert it back as new page. No can do now.</td>
<td>Diego, does the find/replace functionality in 4.1 solve your issue?</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Contribute without Access</td>
<td>Anonymous</td>
<td>Send a page by email in wiki-markup to a customer and they could update the documentation</td>
<td>Are you able to provide any additional details of the use case behind this? Interested in the scenario you have where the user can't be given access to edit directly, maybe security etc?</td>
</tr>
<tr>
<td></td>
<td>Matthias Basler</td>
<td>One point that became important for us just now is that up to now the wiki markup allowed to <strong>easily exchange content between wikis</strong>. Since confluence 4 there's no easy way any more to just copy the content or parts of a page to a text editor, send to someone else and have it inserted into another confluence wiki.</td>
<td>Matthias, interested in your use case as well and why it's not possible for you to just have access to the other Wiki if you need to contribute to it? If it's just an ad-hoc/one off thing, interested in how often you do this?</td>
</tr>
<tr>
<td>Copy page structures</td>
<td>Anonymous</td>
<td>Copy/paste of complex layout, even on a mobile device</td>
<td>What's the use case behind this? Not something copy page can do? Have you tried copying from the Editor or View Source page? How often do you do this on a mobile versus desktop?</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------</td>
<td>------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mixed Lists</td>
<td>sanjay srikonda</td>
<td>how do I make a bulleted/numbered list with either/or in between and then continue the numbering.</td>
<td>Sanjay, I think CON F-23899 will be the beginning of the solution to this also. The next step will be allowing bullets to be included after the delete is done. Do you think that interaction makes sense?</td>
</tr>
<tr>
<td>Behaviour of Enter</td>
<td>Nils Andresen</td>
<td>the &quot;enter insert new paragraph&quot;-feature makes me cranky</td>
<td>Nils is this in lists (like above) or other situations also? Did you know about Shift+Enter to get a new line instead of a paragraph? I've added this to the FAQ and will remove this entry shortly.</td>
</tr>
<tr>
<td>Updating User Macros</td>
<td>eddie connatser</td>
<td>I created my own Editable Table macro - which relies on saving its content by doing a form post with it's content as wiki-markup and html. The fact that wiki markup isn't processed in the new wiki editor breaks this macro.</td>
<td>Eddie, do the details on Upgrading and Migrating an Existing Confluence Macro to 4.0 help?</td>
</tr>
<tr>
<td>Section</td>
<td>Author</td>
<td>Description</td>
<td>Response</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Pasting text</td>
<td>Brad Newman</td>
<td>it takes several button clicks and creation of whitespace to try and paste text in cleanly or fix errors in formatting (e.g. copy plain text, paste it and have it show up as bold, press return to separate out some whitespace, paste again, etc.)</td>
<td>Brad, I'll take a minute later to see if I can recreate this. Do you have any other specific examples of whitespace problems?</td>
</tr>
<tr>
<td>Tutorials</td>
<td>Greg Whitfield</td>
<td>Can you do a comprehensive &quot;New Editor for Hardcore Wiki Markup Users&quot; tutorial/whitepaper/video, that explains how they would work around the limitations imposed by the removal of the wiki editor</td>
<td>Greg, can you let me know what limitations people are reporting? Have you read <a href="https://confluence.atlassian.com/doc/whats-changed-for-wiki-markup-users">Whats Changed for Wiki Markup Users</a>? Very interested in your feedback if that didn't give you what you were after.</td>
</tr>
<tr>
<td>Shortcuts Helper</td>
<td>Diego Ballve, Jean-Yves Avenard</td>
<td>Shortcuts? I'm sure they are there.. but what about some simple list as the wiki markup list? And please don't tell me to click this icon or that icon, that is not what I'm after. Consider a help bar in the right side of the editor, for instance. I can't remember all the keyboard shortcuts as there are so many of them</td>
<td>Diego, Jean-Yves have you seen the ? icon at the top right of the editor bar? Click this gives you all of the shortcuts. Does this help, or do you mean that there should be a permanently displayed list of these while editing at all times?</td>
</tr>
<tr>
<td>Bug when Linking</td>
<td>Anonymous</td>
<td>Create a link on one line, looks fine in editor but preview has the link extending to the rest of the text on the page</td>
<td>I'll try to recreate and document this in a bug ticket.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>Author</td>
<td>Description</td>
<td>Response</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Cursor Placement</td>
<td>Don Gamble</td>
<td>Experiencing issues with cursor placement / cursor not being present on the screen and also selection highlighting problems</td>
<td>JIRA issues to be created shortly.</td>
</tr>
<tr>
<td>Whitespace in Sections/Columns</td>
<td>Matthias Basler</td>
<td>Working with lots of sections/columns (i.e. we use them to position images and their captions) causes very clumsy nested macro blocks having lot of white space. This reduces the amount of visible content in the editor and makes the page appear very large (in the editor), which makes it hard to find the pieces to edit. Having a more compact appearance (similar to the tables!) would be preferable.</td>
<td></td>
</tr>
<tr>
<td>Cursor Placement</td>
<td>Eddie Fast</td>
<td>Cursor navigation doesn't behave as expected</td>
<td>Comments below. Eddie, I'll update this soon, thanks for getting back to me.</td>
</tr>
<tr>
<td>Paste Problems</td>
<td>Eddie Fast</td>
<td>Copy/paste doesn't work as expected</td>
<td>As above</td>
</tr>
<tr>
<td>Paste Problems</td>
<td>Eddie Fast</td>
<td>Pasting into a bulleted list causes the entire document to go bold</td>
<td>As above</td>
</tr>
<tr>
<td>Copy to/from JIRA</td>
<td>Alex (posted Anonymously)</td>
<td>Alex, I'd love to hear more details on your use case for this. Even before when both editors were using Wiki markup, it seems like a lot of manual work.</td>
<td></td>
</tr>
</tbody>
</table>
We do sometimes copy over parts of the text from JIRA to Confluence and back, and earlier the wiki markup mode allowed to keep text formatting fully same across both systems without any additional effort. Right now you can copy formatted text from JIRA to Confluence, if you highlight and copy it from the issue details page, not issue edit. However, this is not that handy, because you can't use Ctrl+A to actually highlight all the description text instantly. And obviously - there is no way now to copy formatted text parts from Confluence to JIRA.

Interested to know whether the new Remote Issue Links functionality that is coming in JIRA 5.0 would help you. You can see this working on jira.atlassian.com right now, eg: because I've referenced

`CONF-24038 - Authenticate` to see issue details on this page there is an automatic issue link created to point back to here (as well as the obvious link from here to the JIRA case). I find this handy as then say a spec will be written in Confluence and easily linked to the JIRA case.

Seems to me the goal for us should be that we allow Confluence and JIRA to integrate in such a way that more value is created by using them together, and you wouldn't feel the need to copy/paste descriptions between them, so very keen to hear if Remote Issue Links helps or if it doesn't, more details on your needs.
<table>
<thead>
<tr>
<th>From</th>
<th>Idea</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jean-Yves Avenard</td>
<td>It's just not possible to concentrate on the content and focus on the aspect later. Jean-Yves interested on more detail on this. Since you could just create text and format it later, I assume there is more to it than that.</td>
</tr>
<tr>
<td>Diego Ballve</td>
<td>Navigation is gone from the side when editor is on.. why? Diego, can you let me know what you mean by this one?</td>
</tr>
<tr>
<td>Anonymous</td>
<td>The new editor is nice, but is a pain. A lot of functionality is lost. A lot of productivity is lost. Love to get the details of the functionality and productivity</td>
</tr>
<tr>
<td>nicolas frank</td>
<td>still som bugs to fix, but I am sure it will progress through the next versions. Nicolas, if you have any specific bugs you'd like listed please let me know</td>
</tr>
<tr>
<td>Anonymous</td>
<td>I loved being able to focus entirely on the content and not to worry about the formatting. Does Wiki Markup Styler help with this? What is it that inhibits you from writing out your document then coming back through and formatting it afterwards?</td>
</tr>
</tbody>
</table>
Okay, as the WYSIWYG abilities are wider than wiki markup allows - let it be. But you can still provide a solution similar to one implemented in JIRA search. In there you have a search form for rather simple requests, and direct SQL edit for complicated requests. And if directly edited SQL is too complicated to show it as a form - it just tells you "search query is too complicated" and doesn't allow to switch back to form.

As earlier you have claimed that implementing XML-to-wiki transformation is easy - I see no problem to still allow wiki edit, but with XML format on backend and disallow wiki if something too complicated was created through WYSIWYG.

This can easily be added as a plugin, to solve your problem with complains on the core software.

This sounds like a very good idea, and I hope Atlassian will take the time to investigate it. By definition, people who still want to use wiki markup will not be using the most complex WYSIWYG-only formatting, so it should be possible to convert almost everything such users write back to markup.

Another suggestion would be to extend the Wiki Markup Styler plugin to do the same thing. Ideally, any content that can be converted back to markup, would be. And any complex elements that cannot be converted would just appear as they do in the normal WYSIWYG view. This would avoid the possibility of one complex piece of content causing a whole page to be marked as "too complicated to edit through wiki markup".

If Atlassian choose to do this, the other vital requirement (for me) is that we can copy the wiki markup from the editor. At the moment, the plugin displays markup elements on-screen, but if I try to copy them it just gives me the underlying text. In common with other commenters, sometimes I prefer to copy markup from a Confluence page into a text editor and edit it there, before pasting it back (either into a different page, or into another part of the same page).
<table>
<thead>
<tr>
<th>Todd Day</th>
<th>Keep wiki markup format by wrapping in a &quot;wiki markup&quot; macro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andrew Spina</td>
<td>----</td>
</tr>
</tbody>
</table>

Todd - Ability to wrap entire pages in the Wiki Markup macro and not have them auto-convert to storage format. Additionally:

- Macros that come from plugins I currently use in 3.5 continue to work the same way in the wiki code block. I'm willing to wait for the authors (Adapatvist, Customware, and the guy who wrote the LaTeX plugin) to upgrade their plugins for 4.0, but the end result must be that I can write in 4.0 wiki code blocks the same way I currently write in the 3.5 wiki editor.
- User macros I wrote for 3.5 need to also appear in the 4.0 wiki code blocks.
- When upgrading from 3.5 to 4.0, I want the upgrade process to wrap every page in a wiki markup block instead of converting it to the new XHTML format.
- Site and Space themes should be definable in terms of Wiki format.
- It would be nice if the wiki code blocks had a button on them that would convert to the new XHTML format if you pressed it. I understand this would be a one-time no-reversal operation, and that would be fine with me.

----

Andrew

- I haven't read through this post, but this page says to post requests here. I'm new to confluence (and like it a lot), but was wondering why wiki markup is translated into a wysiwyg format after entry. I was wondering if it made sense to allow people to make a container (like a new column) which would preserve wiki markup, but render it on the saved page as rich text? I know it's not as friendly to non-technical users, but it seems a bit closer to the middle ground. Just a thought...

- See related issue at CONF-23895 - Authenticate to see issue details
| Don Gamble                                      | Treat macros and all special editor objects (images, links, etc) the same - i.e. they would all have a frame.  
|                                               | Currently the new editor doesn't treat everything as equivalent. This results in issues with where the insertion point moves during editing, what is selected, what gets cut or pasted, etc. Treating everything special (i.e. macros, images, links - things with parameters and/or bodies) as a framed object allows everything to be treated as an object, just like a character of text. Providing the frame also now allows you to explicitly see what is inside and outside a special object and allows you to select the object. For example, there is currently no way to select a link. You can select text that is linked, you can select an image that is linked, but you can't select a link. Raised in CONF-24026. |
|                                               | Display the associated parameters of the object (macro, image, link, etc) as text in the header of the objects frame.  
|                                               | With macros and special objects now having a frame, the hidden parameters of a macro/special object can now be displayed. Entering edit mode should expose all of the hidden information that is not visible when the page is rendered. Currently entering edit mode results in still having to enter a deeper edit mode (i.e. the macro browser or the special popups) to see the true values to edit. An edit mode within an edit mode is a huge productive hit. Simply seeing how a page was created is not currently possible while in edit mode.  
|                                               | A guiding rule should be "While in edit mode the user will be able to inspect the page and see all the properties effecting how the page renders without needing to do any further activities." If this rule was true a majority of the productivity hit of the new editor would be resolved. To do this requires displaying the parameters of macros and special objects in their frame. Raised in CONF-24026. |
| **Don Gamble** | Allow the parameters in the frame to be edited as name value pairs and re-interpreted when focus leaves the frame.  

The final hit to productivity of the new editor is the need to enter a sub-edit mode (the macro editor or the special popups) when making a change to a parameter that is already applied to a macro or a link/image. Allowing the name value parameter pairs in the frame to be edited would allow rapid changes to be made with a few keystrokes with no loss of user focus caused by having to visit a dialog.  

Allowing new parameters to be added into the frame by just typing, for example "width" which is an obvious and easily remembered parameter on many macros, would allow common edits to occur quickly. Parameters that could not be parsed after the edit completes (i.e. after focus leaves the frame) could be handled by highlighting or in a similar way to how firebugs lets users change the parameters in the html editor window. Raised in [CONF-24026](https://jira.atlassian.com/browse/CONF-24026). |
| **Don Gamble & Eddie Fast** | The confluence editor should behave very similar to every other commonly used editor. At a high level, today's user's expectations of how an editor reacts is common across all editors. If the editor doesn't behave as commonly expected then the user's experience is compromised (some would say the editor is broken or unusable). I see these expectations as (please comment - do others agree?):  

1. The focus of all activity occurs at the insertion point or selection.  
2. Pressing backspace or delete, removes what is to the left/right of the insertion point or removes what is selected.  
3. Typing or pasting inserts the contents at the insertion point or replaces the selection and leaves the insertion point after what is selected.  
4. Moving left, right, up, down with the arrow keys or page up/down in a document, if the same key presses are reversed, should place the cursor back in exactly the same location as it was before the first key press.  
5. Holding the shift key while moving left, right, up, down should extend (or start a selection from the insertion point). Pressing the opposite key should reduce the selection. |

*Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).*
In general, the new editor doesn't respect these user expectations. This makes it slow, hard to use, and I would argue filled with special situations that while can each be individually explained as correct - as a whole make it wrong. An editor should be a simple experience - not complex.

Specifically with respect to what should happen when the insertion point is at the beginning of a macro, i.e. just inside the body. I would suggest:

- Pressing the backspace key should do something, currently it does nothing when just within the body.
- Pressing the left arrow moves to the outside of the macro (CORRECT), but starting at the same spot and pressing the left arrow, while holding the shift key, doesn't appear to do anything.
- Unfortunately, it is more complex (in Firefox at least) continuing to press the left arrow while holding shift results in first the insertion point disappearing, with nothing selected, then nothing on the next key press. After some number of key presses the insertion point reappears with no selection. Reversing, i.e. pressing the right arrow with shift held, results in the insertion point appearing, then a selection appearing, then an insertion point, etc. Nothing is obvious as you attempt to select across a macro.

Open company, no bullshit

A Message from Atlassian's Founders

Hi there,

Most of you already know why we removed the wiki markup editor in Confluence 4.0. We pride ourselves on being an open company, so it should be no surprise that we were really upset to learn that a few customers felt we had 'betrayed them' with this decision.

Firstly, to those people, we are genuinely sorry that you did not know about this change. We want you to know that we fully understood the enormity of this change for our existing customers - hence why we began communicating our plans over a year in advance in order to give everyone ample time to prepare. We started this process 15 months before shipping Confluence 4.0. During this period we made many public announcements about our intentions, collected tons of feedback throughout our Early Access Program, and built a comprehensive set of resources including:
• **June 2010** - At Summit 2010 we publicly announced our plans to consolidate the wiki markup and rich text editors into one single editor in Confluence 4.0

• **July 2010** - Released an FAQ about the changes we had planned. Over the year we received a lot of questions and updated the FAQ very frequently

• **December 2010** - Atlassian began using Confluence 4.0 in production internally and began gathering feedback from heavy wiki markup users

• **June 2011** - Released a comprehensive Early Access Program ("EAP") where customers could download 4.0 and provide feedback. We received and responded to over 250 pieces of feedback during the Early Access Program

• **June 2011** - Included with the EAP we released a comprehensive set of "change management" documentation including:
  - A comprehensive set of release notes describing every new feature and planned change in 4.0
  - A comprehensive planning guide for Administrators, End Users and Developers
  - A quick-guide to help administrators prepare

• **June - September 2011** - Frequently updated EAP releases where we collected customer feedback and responded with changes / fixes

• **September 2011** - Released Confluence 4.0 with a microsite to help users discover new features and a complete change guide to help avid wiki markup users learn to be efficient in the new editor

If you did not hear about the new editor via all of these communiques, we're sorry. We will endeavour to communicate even more in the future, especially should there be another such major update.

**Collective customer feedback drove this decision**

We listen to our customers – a lot. The number one reason we made the decision to remove the wiki markup editor was the collective feedback we’d been gathering since we first released Confluence in 2004.

We've always encouraged you to publicly tell us how we can improve our products and make them work better for your organisation. We can't think of another company that is as open as Atlassian and we're proud of that.

Looking at the feedback we received and the things we heard time and time again in countless customer interviews, it was clear as day that the dual editing experience – Wiki Markup and Rich Text – was the number one hindrance to Confluence adoption.

The endless cycle of round-tripping bugs made the editor unreliable and unusable for the majority of users, and the lack of advanced features like the ability to merge table cells was stopping you from seeing the full value of Confluence.

You told us these things, we listened, and replacing wiki markup was the most viable solution to giving you what customers collectively asked for, a kick-ass editing experience with more powerful editing features.

**Customers love the new editor**

Has it been all bad news? No - far from it. We've been thrilled with the overall response from customers so far. Here's a sample of the feedback we've been seeing about the new editor in Confluence 4 – there's much **much, much more**. I didn't have time to list all of the tweets, emails and "Contact the CEO" submissions we've received:
Yet... there are two sides to every story

Up front communication and listening to users aside, we’re not blind to the fact that there are customers who were completely happy with the wiki markup editor and don’t see the need for a change.

Don’t get us wrong, we do understand their point of view. They just want a wiki markup editor and we understand their frustration at our decision to replace it with a higher fidelity storage format.

We still believe we made the best decision based on the collective feedback we received from the majority of our customers over the years – but, being completely frank, wiki markup is not coming back. The new editor is our path going forward.

We’ve been listening to your feedback

Thanks to all of you who took the time to provide constructive feedback about the new editor. You’ve helped us highlight issues that we need to address. Our Confluence team has been working really hard to get the following features and fixes into your hands:

1. Find and Replace within the editor – shipped in Confluence 4.1
2. Wiki Markup Autoformatting for Macros, Links, and Images – shipped in Confluence 4.1.2
3. WYSIWYG Page Layouts – coming in Confluence 4.2
4. WYSIWYG Page Templates – on our short-term roadmap

We’re 110% committed to making the new editor an even more kick-ass, reliable editing experience. Truly the best editing experience in the world. We’ve made huge leaps in the last year - but we’re not done yet.

We have a team of passionate, dedicated developers working full time to improve the editor and address niggles that arise.

We’re building a source editor!

We’ve learned from your feedback that customers have a number of valid reasons for directly editing the source of a page:
1. **They feel locked-in** - Because people were no longer able to edit a text based version of their page directly, they felt they were locked into Confluence. While you could always still get your content out via the API or through WebDAV but people wanted to be able to see it directly. This was never our intention and we’re rectifying it in two ways as you will see below.

2. **They want to fix formatting niggles** - Unfortunately over the years we trained everyone on this - what do you do when you hit a bug in the RTE? Switch to wiki markup. This wasn't really acceptable then and definitely isn't now, but people have asked for it over and over.

3. **Content workflows** - We underestimated how many people copy the source of their page out of Confluence to work with it in other ways, whether it be updating content offline, sharing with others via email, or using a preferred text editor for things like bulk changing of link properties.

Since we realise how important source access is to you, we're currently working on a free "Advanced Editor" plugin that will allow your users to edit your page's source amongst other advanced user editing. We hope it will address the major issues that some users have identified, like the ability to search for and update URLs and the file names of embedded images.

You can check out and comment on the spec at [Specification - Confluence Advanced Editor](http://www.specification.com).

⚠️ The beta for this plugin is now available on the plugin exchange under the name [Confluence Source Editor](http://www.pluginexchange.com).

We welcome your feedback - please file issues in the JIRA project at [http://jira.atlassian.com/browse/SOURCE](http://jira.atlassian.com/browse/SOURCE).

**Storage Format**

Some people have questioned whether this is a vendor lock-in play. It is not. The new storage format is based on XHTML with extension tags for Confluence specific functions. We've begun documenting it here so you can see exactly what is happening under the covers - to use in your plugins, remote applications, scripts, integrations etc. I think you'll agree this is pretty "standard stuff" and able to be understood by those who need to script it.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

**Why didn't we do this in the first place?**

When we shipped Confluence 4.0 we decided to not offer a source editor for a number of reasons. First of all, the new XHTML-based storage format is more complex than wiki markup so it's not as readable to the average user. Secondly, we wanted to protect less technical users from breaking their pages by accidentally deleting a closing tag or entering invalid HTML. This is why we're proposing that the source editing plugin is only enabled for your advanced users - and the storage format is not meant for day-to-day human editing.

**Just try it.**

Seriously, I encourage you to give the new editor a go. Listening to your feedback we've seen that many of you have not yet tried the new editor. We spent a lot of time thinking about what most people use wiki markup for - why people love it - and we determined that it was speed. Speed to be able to create content without picking up your mouse. So we've built many features and made design decisions with this in mind.
If you haven't already, please give these editor features a try:

- **Autoformatting** of Wiki Markup
- **Autocomplete** for Links, Media, and Macros
- **Autoconvert** for Pasted Links

If you still feel that you just cannot live without wiki markup, there are many other wikis which have it as their lingua franca. We're happy to provide a list of [other wiki solutions](#), although I assure you none are as feature rich or flexible as Confluence.

**We won't stop listening**

As I mentioned, we'd love your feedback on the following:

- [Specification - Confluence Advanced Editor](#)
- [Documenting the Storage Format](#)

And as per the original purpose of this page, we'd love your feedback on the editor itself and how we can improve it for you. Thank you to everyone who has contributed constructively so far.

We see Confluence changing the way a company works and collaborates. That amazing change is why we come to work every day. Please help us make it a reality for you at your company.

- Mike Cannon-Brookes and Scott Farquhar

---

**Confluence Alternatives**

In September 2011 we [released Confluence 4.0](#). Underpinning the new functionality it included was a change to the way Confluence stored its pages, moving from wiki markup to a higher fidelity storage format. You can read more about this decision here – [Why We Removed the Wiki Markup Editor in Confluence 4.0](#).

For the overwhelming majority of customers, this was a huge, huge win. An end to the inherent problems of having two editors and the ability for us to deliver features people had long asked for. We did our best to make wiki markup gurus comfortable as well, with a number of features designed to make the new editor faster than wiki markup:

- **Autoformatting** of Wiki Markup
- **Autocomplete** for Links, Media, and Macros
- **Autoconvert** for Pasted Links

For a small number of users though, this never mattered – like users working within a small, purely technical team who don't:

- collaborate with other less technical teams like marketing, sales and product management
- require dedicated vendor support
- rely upon the various add-ons available on the Atlassian Plugin Exchange
- need a wiki that provides structure through page hierarchies
- require enterprise-grade security, permissions and native LDAP integration
- need deep JIRA integration

We hate losing customers – it upsets us. We still think we make the best enterprise wiki available today, but if wiki markup syntax is generally more useful to you than Confluence's extensive set of add-ons, structured
page hierarchies, robust security and permissions, JIRA integration, and an editor anyone can use, we genuinely think you should try an alternative.

In the spirit of being an open company, here's a list of the more popular wikis that provide a markup editor.

- MediaWiki
- TWiki / Foswiki

Wikipedia has a more exhaustive list here. Feel free to comment on this page if you know of other solutions.

**Feedback on Confluence Storage Format**

When upgrading from Confluence 3.x to Confluence 4.x, the underlying storage format for your content will be migrated from a wiki markup-based format to a new XHTML-based format. This page describes the new storage format, and provides an opportunity for people to discuss the storage format and related ideas.

**On this page:**

- [ Comments welcome ]
- [ Notes about the storage format ]
- [ Macros ]
- [ Headings ]
- [ Text effects ]
- [ Text breaks ]
- [ Lists ]
- [ Links ]
- [ Images ]
- [ Tables ]
- [ Page layouts ]
- [ Emoticons ]
- [ Resource identifiers ]
- [ Template variables ]
- [ Another page available for further discussion ]

Comments welcome

This page has attracted a lot of interest and a number of very valuable comments. Please have a read, to see the ideas that people have proposed.

**Notes about the storage format**

- You can view the Confluence storage format for a given page by choosing **Tools > View Storage Format**. This option is only available if one of the following is true:
  - You are a Confluence administrator.
  - Your Confluence site has the Confluence Source Editor plugin installed and you have permission to use the source editor.
- If you would like to edit the storage format for a page, your Confluence system administrator will need to install the Confluence Source Editor plugin.
- Clarification of terminology: If you choose **Tools > View Source**, you will see the format used within the editor panel, not the storage format of the page.
- We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

![Under consideration]

Provide an XSD - "an XSD could make on the fly validation for persons having an editor supporting it (e.g. Visual Studio), and since an XSD would be a way to validate your input. [CONF-24884 - Authenticate to see issue details]
### Macros

See [Confluence Storage Format for Macros](#).

### Headings

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 1</td>
<td>h1. Heading 1</td>
<td>&lt;h1&gt;H1&lt;/h1&gt;</td>
<td><strong>Heading 1</strong> Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 2</td>
<td>h2. Heading 2</td>
<td>&lt;h2&gt;H2&lt;/h2&gt;</td>
<td><strong>Heading 2</strong> Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 3</td>
<td>h3. Heading 3</td>
<td>&lt;h3&gt;H3&lt;/h3&gt;</td>
<td><strong>Heading 3</strong></td>
</tr>
</tbody>
</table>

Headings 4 to 6 are also available and follow the same pattern.

### Text effects

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>strong/bold</strong></td>
<td><em>strong</em></td>
<td><strong>strong</strong></td>
<td><code>&lt;strong&gt;</code> will also work but get converted to <code>&lt;strong&gt;</code> upon saving</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>emphasis</strong></td>
<td><em>emphasis</em></td>
<td><strong>emphasis</strong></td>
<td><code>&lt;em&gt;</code> will also work but get converted to <code>&lt;em&gt;</code> upon saving</td>
</tr>
<tr>
<td><strong>strikethrough</strong></td>
<td>--strikethrough--</td>
<td><strong>strikethrough</strong></td>
<td><code>&lt;s&gt;</code> and <code>&lt;del&gt;</code> will also work</td>
</tr>
<tr>
<td>Attribute</td>
<td>Markup</td>
<td>HTML</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>Underline</td>
<td><code>+underline+</code></td>
<td><code>&lt;u&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Superscript</td>
<td><code>^superscript^</code></td>
<td><code>&lt;sup&gt;</code></td>
<td></td>
</tr>
<tr>
<td>subscript</td>
<td><del>subscript</del></td>
<td>subscript</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>&lt;script&gt;</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>&lt;/script&gt;</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>monospace</th>
<th>{{monospaced}}</th>
<th>monospaced</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>&lt;code&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>monospaced</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>&lt;/code&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>
<pre>preformatted text</pre>
<table>
<thead>
<tr>
<th>block quotes</th>
<th>bq. block quote or {quote} block quote {quote}</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt; block quote &gt; &lt; p &gt; block quote &lt;/ p &gt; &lt; / block quote &gt;</td>
</tr>
<tr>
<td>text colour</td>
<td>{color:red} red text{color}</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------</td>
</tr>
</tbody>
</table>

```
<span style="color:rgb(255,0,0);">red text</span>
```
<table>
<thead>
<tr>
<th>small</th>
<th>n/a</th>
<th>small text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>&lt;small&gt;&lt;/small&gt;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>big</th>
<th>n/a</th>
<th>big text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>&lt;big&gt;&lt;/big&gt;</td>
</tr>
<tr>
<td>center-align</td>
<td>n/a</td>
<td>centered text</td>
</tr>
<tr>
<td>--------------</td>
<td>-----</td>
<td>---------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;p style=&quot;text-align: center;&quot;&gt;centered text&lt;/p&gt;</code></td>
</tr>
<tr>
<td>Format type</td>
<td>In Confluence 3.5 and earlier</td>
<td>In Confluence 4.0 and later</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>right-align</td>
<td>n/a</td>
<td>right aligned text</td>
</tr>
</tbody>
</table>
| New paragraph | Paragraph 1  
|              | (empty line)  
|              | Paragraph 2  
| Line break   | Line 1 \ Line 2  
| Horizontal rule | ----  
| — symbol     | ---  
| — symbol     | --  

## Lists

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unordered list – round bullets</td>
<td>* Round bullet list item</td>
<td>&lt;ul&gt; &lt;li&gt;round bullet list item&lt;/li&gt; &lt;/ul&gt;</td>
<td>• Round bullet list item</td>
</tr>
<tr>
<td>Unordered list – squarebullets</td>
<td>- Square bullet list item</td>
<td>• Square bullet list item</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;ul style=&quot;list-style-type:square;&quot;&gt;</td>
<td>&lt;/ul&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;li&gt;square bullet list item&lt;/li&gt;</td>
<td>&lt;/li&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/ul&gt;</td>
<td>&lt;/ul&gt;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ordered list (numbered list)</th>
<th># Ordered list item</th>
<th>1. Ordered list item</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt;ol&gt;</td>
<td>&lt;/ol&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;li&gt;numbered list item&lt;/li&gt;</td>
<td>&lt;/li&gt;</td>
</tr>
<tr>
<td></td>
<td>&lt;/ol&gt;</td>
<td>&lt;/ol&gt;</td>
</tr>
</tbody>
</table>

### Links

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to another Confluence page</td>
<td>[Link to another Confluence page</td>
<td>Page Title]</td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="">ac:link</a></td>
<td>&lt;ri:page ri:content-title=&quot;Page Title&quot; /&gt;</td>
<td><a href="">ac:plain-text-link-body</a> &lt;![CDATA[Link to another Confluence Page]]&gt; &lt;/ac:plain-text-link-body&gt;</td>
</tr>
<tr>
<td>Link to an attachment</td>
<td>[Link to an attachment]atlassian_logo.gif</td>
<td>Link to an attachment</td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------</td>
<td>-----------------------</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Link to an external site</th>
<th><a href="http://www.atlassian.com">Atlassian</a></th>
<th>Atlassian</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Anchor link</th>
<th><a href="#anchor">Anchor Link</a></th>
<th>Anchor Link</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| Link with an embedded image for the body | ![google.png|pagetitle#anchor] |
|-----------------------------------------|--------------------------------|
|                                         | <ac:link ac:anchor="Anchor Link"> |
|                                         |     <ac:link-body>               |
|                                         |     </ac:link-body>             |
|                                         | </ac:link>                      |

⚠️ For rich content like images, you need to use ac:link-body to wrap the contents.

A note about link bodies

All links received from the editor will be stored as plain text by default, unless they are detected to contain the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link bodies.
An example of different link bodies

```html
<ac:link>
  <!-- Any resource identifier -->
  <ri:page ri:content-title="Home" ri:space-key="SANDBOX" />
  <ac:link-body>Some <strong>Rich</strong> Text</ac:link-body>
</ac:link>

<ac:link>
  <!-- A link body isn't necessary. Auto-generated from the resource identifier for display. -->
  <ri:page ri:content-title="Plugin developer tutorial stuff" ri:space-key="TECHWRITING" />
  <ac:link-body><![CDATA[A plain <text> link body]]></ac:link-body>
</ac:link>

The markup tags permitted within the <ac:link-body> are <b>, <strong>, <em>, <i>, <code>, <tt>, <sub>, <sup>, <br> and <span>.

Images

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached image</td>
<td><img src="atlassian_logo.gif" alt="Atlassian logo" /></td>
<td><img src="atlassian_logo.gif" alt="Atlassian logo" /></td>
<td><img src="atlassian_logo.gif" alt="Atlassian logo" /></td>
</tr>
</tbody>
</table>
```
Confluence 4.3 Documentation

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
<tr>
<td>ac:thumbnail</td>
<td>Set to &quot;true&quot; to designate this image as a thumbnail.</td>
</tr>
<tr>
<td>ac:alt</td>
<td>alt text</td>
</tr>
<tr>
<td>ac:height</td>
<td>image height</td>
</tr>
<tr>
<td>ac:width</td>
<td>image width</td>
</tr>
<tr>
<td>ac:vspace</td>
<td>the white space on the top and bottom of an image</td>
</tr>
<tr>
<td>ac:hspace</td>
<td>the white space on the left and right of an image</td>
</tr>
</tbody>
</table>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
<tr>
<td>ac:thumbnail</td>
<td>Set to &quot;true&quot; to designate this image as a thumbnail.</td>
</tr>
<tr>
<td>ac:alt</td>
<td>alt text</td>
</tr>
<tr>
<td>ac:height</td>
<td>image height</td>
</tr>
<tr>
<td>ac:width</td>
<td>image width</td>
</tr>
<tr>
<td>ac:vspace</td>
<td>the white space on the top and bottom of an image</td>
</tr>
<tr>
<td>ac:hspace</td>
<td>the white space on the left and right of an image</td>
</tr>
</tbody>
</table>

Tables

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Two column, two row (top header row)

<table>
<thead>
<tr>
<th>Table Heading Cell 1</th>
<th>Table Heading Cell 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
</tr>
</tbody>
</table>

```html
<table>
  <tbody>
    <tr>
      <th>Table Heading Cell 1</th>
      <th>Table Heading Cell 2</th>
    </tr>
    <tr>
      <td>Normal Cell 1</td>
      <td>Normal Cell 2</td>
    </tr>
  </tbody>
</table>
```
Two column, three rows, 2nd and third with merged cells in first row

<table>
<thead>
<tr>
<th>Table Heading Cell 1</th>
<th>Table Heading Cell 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge Cell</td>
<td>Normal Cell 1</td>
</tr>
<tr>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
</tr>
</tbody>
</table>

```html
<table>
  <tbody>
    <tr>
      <th>Table Heading Cell 1</th>
      <th>Table Heading Cell 2</th>
    </tr>
    <tr>
      <td>Table Heading Cell 1</td>
      <td>Table Heading Cell 2</td>
    </tr>
    <tr>
      <td colspan="2" rowspan="2">Merged Cell</td>
      <td>NORMAL Cell 1</td>
    </tr>
    <tr>
      <td>NORMAL Cell 2</td>
    </tr>
  </tbody>
</table>
```
Page layouts

Confluence supports page layouts directly, as an alternative to macro-based layouts such as those using the section and column macros. This section documents the storage format XML created when these layouts are used in a page.

Notes:

- Page layouts were introduced in Confluence 4.2, and are not available in earlier versions of Confluence.
- The word (content) in the layouts below indicates where further XHTML or Confluence storage format block content would be entered, such as <p> or <table> tags.

<table>
<thead>
<tr>
<th>Layout Type</th>
<th>In Confluence 4.2 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two columns</td>
<td></td>
</tr>
</tbody>
</table>
Three columns

```
<div class="contentLayout"
data-atlassian-layout="{"name":"pagelayout-three-simple","columns":["","",""]}">
  <div class="columnLayout threeColumns">
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
</div>
```
Right sidebar with header and footer

```html
<div class="contentLayout"
    data-atlassian-layout=""{name:"pagelayout-two-right",columns:["large","aside"],header:true,footer:true}">
    <div class="header">
        <div class="innerCell">
            {content}
        </div>
    </div>
    <div class="columnLayout twoColumns">
        <div class="cell large">
            <div class="innerCell">
                {content}
            </div>
        </div>
        <div class="cell aside">
            <div class="innerCell">
                {content}
            </div>
        </div>
    </div>
    <div class="footer">
        <div class="innerCell">
            {content}
        </div>
    </div>
</div>
```
Three columns with header and footer

```html
<div class="contentLayout"
data-atlassian-layout="{"name":"pagelayout-three","columns":["","",""],"header":true,"footer":true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout threeColumns">
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
Emoticons

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emoticons</td>
<td>:)</td>
<td>&lt;ac:emoticon name=&quot;smile&quot; /&gt;</td>
<td>😊</td>
</tr>
</tbody>
</table>
:(

*: (ac:emojis
  ac:name="sad" )

:P

*: (ac:emojis
  ac:name="cheeky" )

:D

*: (ac:emojis
  ac:name="laugh" )

:)  

*: (ac:emojis
  ac:name="wink" )

(y)

*: (ac:emojis
  ac:name="thumbs-up" )

(n)

*: (ac:emojis
  ac:name="thumbs-down" )
## Resource identifiers

Resource identifiers are used to describe "links" or "references" to resources in the storage format. Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Resource identifier format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>&lt;ri:page ri:space-key=&quot;FOO&quot; ri:content-title=&quot;Test Page&quot;/&gt;</code></td>
</tr>
</tbody>
</table>

**Notes:**
- `ri:space-key:` *(optional)* denotes the space key. This can be omitted to create a relative reference.
- `ri:content-title:` *(required)* denotes the title of the page.
<table>
<thead>
<tr>
<th>Blog Post</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ri:blog-post ri:space-key=&quot;FOO&quot; ri:content-title=&quot;First Post&quot; ri:posting-day=&quot;2012/01/30&quot; /&gt;</td>
</tr>
</tbody>
</table>

Notes:
- **ri:space-key**: (optional) denotes the space key. This can be omitted to create a relative reference.
- **ri:content-title**: (required) denotes the title of the page.
- **ri:posting-day**: (required) denotes the posting day. The format is YYYY/MM/DD.

<table>
<thead>
<tr>
<th>Attachment</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ri:attachment ri:filename&gt; ... resource identifier for the container of the attachment ... &lt;/ri:attachment&gt;</td>
</tr>
</tbody>
</table>

Notes:
- **ri:filename**: (required) denotes the name of the attachment.
- The body of the `ri:attachment` element should be a resource identifier denoting the container of the attachment. This can be omitted to create a relative attachment reference (similar to [foo.png] in wiki markup).

Examples:

**Relative Attachment Reference**

```
<ri:attachment ri:filename="happy.gif" />
```

**Absolute Attachment Reference**

```
<ri:attachment ri:filename="happy.gif">
    <ri:page ri:space-key="TST" ri:content-title="Test Page"/>
</ri:attachment>
```
<table>
<thead>
<tr>
<th><strong>URL</strong></th>
<th><code>&lt;ri:url ri:value=&quot;http://example.org/sample.gif&quot;/&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes:</td>
<td>• <strong>ri:value</strong>: (required) denotes the actual URL value.</td>
</tr>
<tr>
<td><strong>Shortcut</strong></td>
<td><code>&lt;ri:shortcut ri:key=&quot;jira&quot; ri:parameter=&quot;ABC-123&quot;/&gt;</code></td>
</tr>
</tbody>
</table>
| Notes:  | • **ri:key**: (required) represents the key of the Confluence shortcut.  
• **ri:parameter**: (required) represents the parameter to pass into the Confluence shortcut.  
• The example above is equivalent to `[ABC-123@jira]` in wiki markup. |
| **User** | `<ri:user ri:username="fred"/>` |
| Notes:  | • **ri:username**: (required) denotes the name of the user. |
| **Space** | `<ri:space ri:space-key="TST"/>` |
| Notes:  | • **ri:space-key**: (required) denotes the key of the space. |
| **Content Entity** | `<ri:content-entity ri:content-id="123"/>` |
| Notes:  | • **ri:content-id**: (required) denotes the id of the content. |
### Template variables

This screenshot shows a simple template:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MyText</td>
<td>Single-line text</td>
<td></td>
</tr>
<tr>
<td>$MyMulti</td>
<td>Multi-line text</td>
<td>Size: 5 x 100</td>
</tr>
<tr>
<td>$MyList</td>
<td>List</td>
<td>List items: Apples, Pears, Peaches</td>
</tr>
</tbody>
</table>

The XML export produces the following code for the template:

```xml
<at:declarations>
  <at:string at:name="MyText" />
  <at:textarea at:columns="100" at:name="MyMulti" at:rows="5" />
  <at:list at:name="MyList">
    <at:option at:value="Apples">Apples</at:option>
    <at:option at:value="Pears">Pears</at:option>
    <at:option at:value="Peaches">Peaches</at:option>
  </at:list>
</at:declarations>

<p>This is Sarah's template</p>
<p>A single-line text variable: $MyText</p>
<p>A multi-line text variable: $MyMulti</p>
<p>A selection list: $MyList</p>

End of page.
```

---

Another page available for further discussion

A new page is available as a place to continue discussions: [Confluence 4 further discussion](#).
Please feel free to add your comments anywhere. We are not shutting down discussion on this page. We are supplying the new page to alleviate the problems caused by slow response on this page, due to the number of comments here.

**Specification - Confluence Advanced Editor**

1.0 for this plugin is now available (3/Apr) on the plugin exchange under the name [Confluence Source Editor](https://plugins.atlassian.com/). 

**Fixed:**

- Support for using the source editor in comments.

**Beta 2 included enhancements include support for:**

- Find and replace within the page
- Restricting access to the Source Editor to particular user groups.

We welcome your feedback - please file issues in the JIRA project at [https://jira.atlassian.com/browse/SOURCE](https://jira.atlassian.com/browse/SOURCE).

- This is a draft of the "Source Editor" specification for Confluence.
- Please see [Feedback on Confluence Storage Format](https://confluence.atlassian.com/display/CONFLUENCE/Feedback+on+Confluence+Storage+Format) for an overview of Confluence’s storage format.

**Background and strategic fit**

Up until now, we haven't allowed users to edit the underlying editor storage format (though this was easy for anyone to hack, using Firebug). As customers upgrade to Confluence 4.0, we're learning there are three main reasons people want source access:

1. **Customers Feel "Locked-in"**

With the switch from wiki markup to the new XHTML-based storage format, and because people were no longer able to edit a text-based version of their page directly, they felt they were locked into Confluence. While you could always still get your content out via the API or through WebDAV but people wanted to be able to see it directly.

2. **Fixing Formatting Niggles**

When a user hits an occasional bug, he or she wants a quick workaround. Over the years we trained everyone on this - what do you do when you hit a bug in the RTE? Switch to wiki markup. This wasn't really acceptable then and definitely isn't now, but some customers are asking for it... "give me access to the source so I can quickly fix something that's gone wrong."

3. **Offline content editing**

Some users want to copy the source of their page out of Confluence to work with it in other ways, whether it be updating content offline, sharing with others via email, or using a preferred text editor for things like bulk changing of link properties. Use cases include:

- Bulk edit link properties
- Bulk edit macro properties
- Confluence offline editing
- Editing via preferred editor (emacs, textmate, etc)

**Requirements**
<table>
<thead>
<tr>
<th>User Story Title</th>
<th>User Story Description</th>
<th>Priority Order</th>
<th>Implementation Notes</th>
<th>Status</th>
</tr>
</thead>
</table>
| Editor Niggles    | User can access source view from inside the Confluence editor.                          | 1: Must have   | • This is a short-term solution to working around around minor bugs. Long term we should be solving these problems.  
• This will edit the storage format source.                                                                                                                                                                                                                                                                                             | Beta 1  |
| Copy paste source | User can copy / paste source in full fidelity. Users should be able to:                | 1: Must have   | |                                                                                                                                                                                                                                                                                                                                                         | Beta 1  |
|                   | 1. Copy the entire content of a page  
2. Paste into a separate editor  
3. Manipulate it and  
4. Paste it back into the source view of the editor  
5. Save the page | | | |                                                                                                                                  |        |
| Edit link source  | User should be able to change link source from inside the editor                        | 1: Must have   | This would help with bulk change operations like changing URLs, or parts of URLs in links.                                                                                                                                                                                                                                                                                      | Beta 1  |
| Edit macro parameters | Users should be able to change macro parameters from inside the editor | 1: Must have   | Example macro storage format:                                                                                                                                                                                                                                                                                                                                                                   | Beta 1  |
|                   | <ac:macro ac:name="status">\langle ac:parameter ac:name ="colour">Green</ac:parameter></ac:macro> | | | |                                                                                                                                  |        |
| Validation | • The user should not be able to save any content that will break the page.  
• The editor should do validation to make sure only supported markup is being submitted. | 1: Must have | There should be at least some basic validation (e.g. that the xml is well formed). This validation is performed when applying the changes in the source editor and returning to the Rich Text Editor.  
Other markup, that is considered invalid, is either tolerated or stripped when saving the file (the content itself is not lost, just the markup tags). It would be desirable to validate this before save, but this may not be available in the first release.  
If a save does result in a bad rendering of a page, then reverting an edit via the history is an acceptable trade-off. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax highlighting</td>
<td>The markup should be formatted and indented so that the source is as easy as possible to visually parse and spot invalid markup.</td>
<td>2: Should have</td>
<td>Beta 1</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Priority</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search and replace</td>
<td>It should be possible to search and replace text in the source markup.</td>
<td>2</td>
<td>Should have some basic search and replace functionality. More sophisticated searching may be possible (e.g. the reg. ex) depending on the final editing framework used. See CONF-24200 - Authenticate to see issue details.</td>
</tr>
<tr>
<td>Group Permissions</td>
<td>Admin can specify which users / groups can have access to edit source.</td>
<td>3</td>
<td>Nice to have This is necessary so that only people who REALLY need access can get access.</td>
</tr>
</tbody>
</table>
**Validation**

User can see which markup he posts is invalid - editor should *refuse* bad mark-up

2: Should have

- The source editor does validation for malformed XML - so if you forget to open or close a tag, it will not let you post it and will move your cursor to where the error exists if that location is knowable.

- If you define a bad parameter in a macro, Confluence will ignore this parameter:

- If you erroneously put a macro or link parameter in a rich text field the tags get stripped

---

**UX**

- Expecting an icon to the left of help in the toolbar that will pop up a dialog when enabled for a user.

**Supportability**

- This will be implemented as a separate plugin that can be installed by a Confluence site administrator.
- The plugin will be maintained by Atlassian.

**Notes**

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We’re using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

**Confluence 101**

We are delighted that you have chosen Confluence. This guide will take you through installing Confluence and trying out the most relevant features.
Getting started

1. Installing Confluence

If you have not already got Confluence up and running, carry out the following steps:

For Windows: (click to expand)

1. Go to the Confluence download page.
2. Download the Confluence Windows Installer file for 32-bit or 64-bit Windows.
3. Run the installer, choose an installation directory, a home directory, and a port ('8090' will do). We recommend that, when prompted, you choose to install Confluence as a service.
4. Confluence will start automatically when the installer finishes. The installer will also add Windows ‘Start’ menu shortcuts which you can use to start and stop Confluence.
5. To access Confluence, go to your web browser and type this address: http://localhost:8090.
6. Follow the Setup Wizard. This will guide you through the process of setting up your Confluence server and creating an administrative user.

For more help on the technical procedures in this section, see the Confluence Installation Guide.

If you need assistance, please create a support ticket.

For Linux/Solaris: (click to expand)

Download the Confluence Linux Installer (.BIN) file from the Confluence download page, and follow the instructions. The Setup Wizard will guide you through the process of setting up your Confluence server and creating an administrative user.

If you need assistance, please create a support ticket.

2. Importing existing content

Why would I do this? (click to expand)

The best way to spur adoption is to get some content in Confluence. It is likely that you have existing documentation stored in another wiki or in static documents. Confluence makes it easy to import your existing content so that you do not have to re-invent the wheel or start from scratch.

How do I do this? (click to expand)

Refer to our documentation on Importing Content Into Confluence, for details on:

- Importing content from other Confluence sites
- Importing content from other wikis.
- Importing content from an Office document
- Importing web content
- Importing other non-wiki content

3. Adding users

Add people so that they can collaborate quickly.

Add users and/or enable anonymous access. Click here to expand...

1. Add or invite users — add user accounts for the people who will create the pages and blog posts in your Confluence site, or send people invitations to sign up themselves.
2. (Optional) Add users to groups — your users will be automatically added to the ‘confluence-users’ group. You can add them to other groups too.
3. (Optional) Set up public access — allow non-logged-in users to access your Confluence site. Note that
they will only be able to view content where the space permissions allow ‘Anonymous’ access.

4. Configuring mail

Confluence can send notifications based on user preferences, such as when people are watching the contributions to a particular space or page. To take advantage of this feature, you will first need to tell Confluence about your SMTP server.

Mastering the basics

Your users will need to access Confluence at http://<Confluence site name>:8090 (not http://localhost:8090).

5. Creating spaces, pages and blog posts

Your new Confluence site contains a 'Demonstration' space, which includes a tutorial. This will guide you through the basics of using the dashboard, creating a space, adding pages and publishing blog posts.

6. Searching Confluence

- Searching Confluence
- Advanced search
- Searching the content of attachments

7. Subscribing to updates

- Creating an RSS feed.
- Watching a page (or space) to be emailed whenever it is edited.
- Marking your favourite places so you can get to them quickly.

Customising Confluence

You need Confluence Administrator permissions to do the tasks in this section. see Global Permissions Overview.

8. Adding your own logo

Why would I do this? (click to expand)
If you replace the default Confluence logo with your organisation's logo, your Confluence site will immediately appear more familiar to visitors.

How do I do this? (click to expand)
See the following documentation:
- Changing the Confluence-wide 'global' logo
- Changing a space's logo

9. Changing Confluence’s colours

Why would I do this? (click to expand)
If you replace the default Confluence colours with your organisation's standard colours, your Confluence site will immediately appear more familiar to visitors.

How do I do this? (click to expand)
See the following documentation:
10. Choosing a different theme

Why would I do this? (click to expand)
Depending on what you are using Confluence for, you may want to alter the theme for an individual space or for the entire site. A theme determines the look and feel of the site, including colours, styles and page layouts. For example, for a space that contains documentation, you may prefer a theme that displays a table of contents on the left and allows you to configure a page header and footer.

How do I do this? (click to expand)
See the following documentation:
- Applying a theme to a site
- Applying a theme to a space

11. Using a page template

Why would I do this? (click to expand)
A page template is a form that is displayed when a user creates a page, so that the user can enter content in particular fields. A page template can be made available to your entire Confluence site or just to a particular space. For example, a human resources space might have a template called 'Leave Request', or an information technology space might have a template called 'Asset Configuration'.

How do I do this? (click to expand)
See the following documentation: Adding a template

12. Installing plugins

Why would I do this? (click to expand)
There are hundreds of new features and customisations available for Confluence as plugins. For example, many additions to Confluence's macros are available as plugins. Take a look at our most popular plugins.

How do I do this? (click to expand)
Confluence comes with a number of bundled plugins. You can install others via the Confluence administration screens.

Important next steps
You need Confluence Administrator permissions to do the tasks in this section. see Global Permissions Overview.

13. Connecting to an external database
Before using Confluence as a production system, you need to switch from the default HSQL database, which is provided for evaluation purposes only. Please see the documentation for details.

14. Backing up data
To back up your Confluence data, and establish processes for regular backups, please see the documentation.

We hope you have fun with Confluence
We're always happy to help. Feel free to contact us with any questions you have.
Confluence User's Guide

About this document
The Confluence user's guide begins with an overview of the key features of Confluence, and goes on to describe the use of Confluence as a knowledge management tool and a collaborative environment. If you still have a question that has not been answered, please ask us.

This guide assumes that your Confluence site uses the default theme. If your site's theme has been customised, then your site may look different and the menu items may appear in different locations from those in this guide.

For more documentation please visit Confluence Documentation Home.

Download
You can download the Confluence documentation in PDF, HTML and XML formats.

Confluence User's Guide

Getting Started with Confluence

Creating Content

Sharing Content

Managing Changes and Notifications and Tasks

Searching Confluence

Organising Content

Customising Confluence

Giving People Access to Content

Getting Started with Confluence

Getting to know Confluence

The dashboard
Page layout
Spaces in Confluence
Other users

Personalising Confluence

Changing your password
Updating your user profile
Creating your personal space
Choosing the home page you see when you log in
Customising the dashboard for yourself
Getting notifications about changes
About Confluence

Confluence is a wiki. You can use it to collaborate on writing and sharing content with your team. Your team can be as small or as big as you like. It could encompass the whole world. Your content can be as simple or as rich as you like. It can be just words, or you can add images, diagrams, activity streams, web service integration and more.

In a nutshell, a wiki is a piece of software that runs on a server. It publishes web pages that you can read via a web browser such as Mozilla Firefox, Google Chrome or Microsoft Internet Explorer. The thing that makes wiki pages different from other web pages is the edit button. Provided that you have the right permissions, you can edit the page, save your changes, and the updates will be visible to other people immediately.

Confluence provides extra functionality that transforms it into a social collaboration platform:

- Add a space for your team, then add page or comment on someone else's page.
- Share content by writing a blog post, sharing a link or calling someone's attention to a page via @mention s. Form a social network and tell people what you are doing via a status update.
- Add images, picture galleries, videos and more.

Related pages:
- Getting Started with Confluence
- Confluence Documentation Home

Dashboard

The dashboard is the front page of a Confluence site. It provides an overview of the site, gives access to all spaces that you have permission to view, and displays a few different lists of the most recently updated content.

You can go to the dashboard from anywhere in your site by clicking Dashboard at the top left of the page. (By default, the first link at the top left of the page is named 'Dashboard'. If your administrator has customised your site, the link may say something else. For example, 'Documentation'.)

Overview of the dashboard

The dashboard is divided into three sections:

- Welcome message: The information that appears in the top left section of the dashboard. Confluence Administrators can customise this message.
- Spaces, Pages, Network: Tabs displaying your favourite content and people, displayed in the lower left
section of the dashboard..

- **Spaces** displays the [spaces](#) you have marked as favourites, followed by all the spaces that you have permission to view.
- **Pages** displays the [pages](#) you have marked as favourites.
- **Network** displays the [users](#) that you are following (or who are following you).

- **Recent activity**: Tabs on the right-hand section of the dashboard, displaying recently-updated content that is **Popular**, in **All** spaces, in your **Favourite** spaces, updated by people in your **Network**, or classified by space **Categories**.
  - **Popular** displays content that has been recently created, liked or commented on. See [below](#) for more details.
  - **All Updates** displays updates from all spaces that you have permission to view.
  - **Favourite Spaces** displays updates from your [favourite](#) spaces.
  - **Network** displays the [users](#) that you are following (or who are following you).
  - **Space Categories** displays updates from spaces in the [category](#) you have selected from the list.

On this page:

- Overview of the dashboard
- More about popular content
- Notes

Related pages:

- Confluence Glossary
- Icons Used in Confluence
- Working with Spaces
- Confluence User's Guide

### Screenshot: The dashboard

![Dashboard](#)

### More about popular content

The 'Popular' tab on the dashboard displays recent activity of the following types:
• Pages, blog posts and comments that people have recently **liked**.
• Pages and blog posts that people have recently **commented** on, and threaded comments that people have recently replied to.
• Pages and blog posts that have recently been **created**.

'Recent' means any activity in the last seven days.

A **bold** link means that you have not yet visited the page.

The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. The most recent activity ranks higher than earlier activity.

**Notes**

• If you have the right permission, you can **add a new space** from the dashboard. Click **Add Space** at the top right of the dashboard, or on the ‘Spaces’ tab.
• By default, the dashboard is the home page for the Confluence site. However, you can set any other page in Confluence as your home page using your **user profile** settings.
• Administrators can **customise the global dashboard** that all users see.
• Users can **customise the dashboard** for themselves.
• There are quick **Add Page** and **Add Blog Post** buttons at the top right of the dashboard. If you have 'Confluence Administrator' or 'System Administrator' **permissions**, you will also see an **Add Users** button. If you have permission to create spaces, you will also see an **Add Space** button.
• Click **view change** beside a page name to see a comparison of the current and previous versions of the content.
• Are you looking for a way to build an **RSS feed**? Choose **Browse > Feed Builder**.
• Are you looking for a list of the **people** in your site? Choose **Browse > People Directory**.

**Page in View Mode**

The image below shows the menus and other controls on a typical Confluence page.

**Related pages:**

• [Using the Editor](#)
• [Overview of Spaces](#)
• [Overview of Pages](#)
• [Sharing Content](#)
• [Confluence User's Guide](#)
<table>
<thead>
<tr>
<th>Menu or option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byline</td>
<td>Shows the original author and the most recent editor of the page, and the date of the most recent edit.</td>
</tr>
<tr>
<td>Byline icons</td>
<td>A small padlock indicates page restrictions. A paperclip indicates that the page has attachments. Both icons are clickable, leading to the 'Page Information' and 'Attachments' pages, respectively.</td>
</tr>
<tr>
<td>Browse</td>
<td>Gives access to wiki content such as pages, blog posts, and the directories of people and spaces. If you are an administrator of the space or the site, the administration options appear here too.</td>
</tr>
<tr>
<td>User</td>
<td>After you have logged in, your name will appear at top right of the screen. When you choose your name, the user menu drops down with options to log out, access your user profile, or view your editing history, personal labels and page watches. You can also retrieve drafts of pages you are editing.</td>
</tr>
<tr>
<td>Notification-and-task dialog</td>
<td>View and respond to notifications collected from Confluence page watches, shares and mentions. Manage your personal tasks.</td>
</tr>
<tr>
<td>Search</td>
<td>Type into this box to see a list of matching pages. Select a page to go directly to it, or press Enter to see the full Confluence search.</td>
</tr>
<tr>
<td>Tools</td>
<td>Miscellaneous actions relating to the page.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the current page. (Shortcut: press e on your keyboard.)</td>
</tr>
<tr>
<td>Share</td>
<td>Email a link to the current page to another Confluence user or email address.</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Labels</td>
<td>View and edit labels (tags) attached to the current page. (Shortcut: press I on your keyboard.)</td>
</tr>
<tr>
<td>Add</td>
<td>Add things to a page, or add new a new page or blog post to the space.</td>
</tr>
<tr>
<td>Like</td>
<td>Choose this option to let people know that you like this page.</td>
</tr>
<tr>
<td>Add a comment</td>
<td>Click in the text box to begin writing a comment. (Shortcut: press m on your keyboard.)</td>
</tr>
</tbody>
</table>

**Confluence Glossary**

**Administration Console**

The Administration Console is the interface for the global administration of Confluence.

Only administrators can access the Administration Console.

**Administrators**

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

**CamelCase**

CamelCase is a form of markup commonly used in wikis where words compounded together LikeThis without spaces are used to create links.

In Confluence, Camelcasing can be turned on from the Administration Console.

**Change Comment**

A change comment is a short description entered during the edit of a page to record the changes being made in the edit.

**Child Pages**

Creating child pages is a means of hierarchically organising content in Confluence. A child page can only have one parent page.

**Comments**

A comment may be a remark, question, or any other additional information you wish to add to a page pertaining
to the topic the page covers. You can comment on any page or news item in Confluence.

**Confluence Administrators**

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the [overview of global permissions](#) for details of the functions which each level of administrator can perform.

**Custom Decorators**

Decorator files are used to define layouts in Confluence. They are vmd files and require knowledge of the language, Velocity, to edit.

**Dashboard**

The dashboard is the front page of a Confluence site. It provides an overview of the site, access to all spaces, and displays a list of the most recently updated content within them.

**Form Field Markup**

Form field markup is a specialised markup used when creating page templates in Confluence 4.2 and earlier. It is no longer needed, because the template editor offers form fields as an option in the editor toolbar.

**Global Administrators**

A global administrator is the same as a system administrator.

**Global Spaces**

Global spaces contain content on any theme or topic of your choice.

For more information about global spaces and personal spaces, see [Working with Spaces](#).

**Hover Profile**

The hover profile is the pop-up you see when the mouse pointer pauses over a Confluence user’s name. Use the hover profile to follow the user, visit their profile, and more.

**JIRA**

JIRA is Atlassian's award winning Issue tracking and project management application.

Visit Atlassian's website to learn more about JIRA.

**Labels**

Labels are user-defined tag words assigned to pages to categorise content in Confluence.
Macros

A macro is a command wrapped inside curly braces {...} used to perform programmatic functions and generate more complex content structures in Confluence.

Blog Posts

A blog post may be a journal entry, status report or any other timely information pertaining to a space.

Notifications

A notification is an email message sent to you updating you of changes to pages and spaces you choose to 'watch'.

Orphaned Pages

An orphaned page is a page without any incoming links.

Pages

Pages are the primary means of storing information in Confluence and are the building blocks of spaces.

Parent Page

A parent page is a page that has one or more child pages. It may itself be a child of another page.

People Directory

The People Directory contains a list of all users in your Confluence site. Each user's name links to their personal space.

Permalink

A permalink is the url used to link to specific content items like comments.

Personal Spaces

Personal spaces belong to particular users, and rather than being listed on the Dashboard, are available from the People Directory.

For more information about global spaces and personal spaces, see Working with Spaces.

RSS Feeds

An RSS feed is a format for delivering summaries of regularly changing web content. RSS is read by RSS newsreader programs.

You will need an RSS reader to subscribe to feeds within Confluence.

Confluence acts as an RSS reader for feeds from sites outside of Confluence.
**RSS Reader**

An RSS reader is a specialised RSS program (also called aggregator) that displays the contents of RSS feeds for you. To subscribe to RSS feeds within Confluence, you will need an RSS reader.

---

**Site Administrators**

The Confluence permission scheme allows two levels of administrator permissions:

- **System Administrator** – full administrative access to Confluence.
- **Confluence Administrator** – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

---

**System Administrators**

The Confluence permission scheme allows two levels of administrator permissions:

- **System Administrator** – full administrative access to Confluence.
- **Confluence Administrator** – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

---

**Space Administrators**

A space administrator is a user with the ‘Space Admin’ permission for the space. A user with this permission can perform a host of functions relating to the management of a space and has complete access to the space regardless of any other control settings or permissions.

Permissions for a space are only assigned and modified by space administrators.

---

**Spaces**

A space is an area within Confluence, containing your wiki pages. You can think of each space as a sub-site, or mini-site, each with its own home page.

There are two types of spaces: global spaces and personal spaces.

---

**Templates**

A template is a pre-defined page that can be used as a prototype when creating pages. Templates are useful for giving pages a common style or format.

---

**Themes**

Themes are pre-defined 'look and feel' styles which are configured from the administration menu and can be applied across Confluence or to a single space.

---

** Thumbnails**
As of Confluence 4.0, all images on the page that aren't links are displayed as thumbnails: when you click on an image the full-size image is displayed in a pop-up.

**Tiny links**

A tiny link is the shortened url of a page which is useful when sending links to the page, for example, via email.

**Trackback**

Trackback is a mechanism by which two sites can stay informed each time one site refers to the other by means of trackback 'pings'.

In Confluence, Trackback is enabled from the Administration Console.

**Trackback Autodiscovery**

Trackback autodiscovery is a block of code that can be placed in a web-page to describe where trackback pings should be sent for that page. You can read the technical specification for autodiscovery here.

When Trackback is enabled, Confluence uses Trackback Autodiscovery to ping pages that are linked to, and to advertise its own pages as being able to receive pings.

**Undefined Links**

An undefined link is a link to a page that has not yet been created. Clicking on the page link allows you create the page.

**User Profile**

Every user account in Confluence is linked to a profile that contains user related information and options to configuring user preferences.

**Watching a Page or Blog Post**

When you watch a page, you are sent an email notification whenever that page has been modified.

**Watching a Space**

When you watch a space, you are sent an email notification whenever content has been added or modified in that space.

**Wiki**

Pioneered by Ward Cunningham, and named after the Hawaiian word for 'quick', a wiki is a website that makes it easy for anyone to contribute pages, and link them together.

**Wiki Markup**

This is the markup used to write and edit page templates in Confluence.

**Related Topics**
Icons Used in Confluence

Take me back to Confluence User's Guide

Icons Used in Confluence

Confluence uses icons on various pages and screens, to provide quick links and indicators. This page lists the most frequently used icons and their meaning.

If you are looking for information about adding icons to your page, see Using Symbols, Emoticons and Special Characters.

### Related pages:
- Dashboard
- Confluence Glossary
- Using Symbols, Emoticons and Special Characters
- Confluence User's Guide

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗝️</td>
<td>Indicates that restrictions apply to the current page. Click to see the restrictions and edit them.</td>
</tr>
<tr>
<td>🔐</td>
<td>Indicates that there are attachments to the current page. Click to open the 'Attachments View'.</td>
</tr>
<tr>
<td>🧑‍💻</td>
<td>Go to the people directory.</td>
</tr>
<tr>
<td>😎</td>
<td>View a user profile.</td>
</tr>
<tr>
<td>📖</td>
<td>Go to a personal space.</td>
</tr>
<tr>
<td>🌍</td>
<td>Go to a global space.</td>
</tr>
<tr>
<td>🏡</td>
<td>View a space's homepage.</td>
</tr>
<tr>
<td>📝</td>
<td>View a page.</td>
</tr>
<tr>
<td>🎨</td>
<td>Add a page.</td>
</tr>
<tr>
<td>💻</td>
<td>Add a child page to the current page.</td>
</tr>
<tr>
<td>📝</td>
<td>View a blog post.</td>
</tr>
<tr>
<td>📧</td>
<td>This page has been edited since you last viewed it. Click to view the page.</td>
</tr>
<tr>
<td>🗻</td>
<td>View a comment.</td>
</tr>
<tr>
<td>📨</td>
<td>View a piece of archived mail that has been imported into Confluence.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

Confluence provides a number of keyboard shortcuts that you can use to speed up your editing and viewing. This page describes the keyboard shortcuts for the English language. The shortcut keys (letters of the alphabet) may be different in other languages.

Hint: Confluence can display a list of available keyboard shortcuts. There are a few ways to see this keyboard shortcuts dialog:

- Choose Browse > Keyboard Shortcuts.
- When viewing a page, press Shift+?
- In the editor, choose the question mark icon on the editor toolbar.

The keyboard shortcuts dialog shows the following information:

- **General** – global, page and blog post shortcuts.
- **Editor** – text editing and formatting shortcuts.
- **Editor Autoformatting** – wiki markup and autoformatting shortcuts.
Keyboard shortcuts

The first section below describes the keyboard shortcuts that are available on all Confluence screens. Subsequent sections describe the shortcuts specific to each type of screen.

Please note, for Safari on OSX please substitute 'control' for 'Cmd' in the shortcuts below.

### All screens

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Enable the quick search</td>
<td>/</td>
</tr>
</tbody>
</table>
| Ctrl+s  | • Submit (where a form is active).  
|         | • Editor -- save the Confluence page.  
|         | • Outside the editor -- save the browser page. | Cmd+s |
| g then d | Go to the dashboard | g then d |
| g then s | Browse the current space | g then s |
| ?       | Open the Keyboard Shortcut help | ?        |
| [       | Toggle the left-hand navigation bar, when the space is using the Documentation theme. | [       |

### Editor

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctr+0</td>
<td>Apply the paragraph style.</td>
<td>Cmd+0</td>
</tr>
<tr>
<td>Key Combination</td>
<td>Description</td>
<td>Equivalent Key</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Ctr+(1–6)</td>
<td>Apply a heading level (of the number chosen) to the current line.</td>
<td>Cmd+(1–6)</td>
</tr>
<tr>
<td>Ctr+7</td>
<td>Apply the preformatted style.</td>
<td>Cmd+7</td>
</tr>
<tr>
<td>Ctr+8</td>
<td>Apply the block quote style.</td>
<td>Cmd+8</td>
</tr>
<tr>
<td>Ctrl+Shift+a</td>
<td>Open the Macro Browser.</td>
<td>Cmd+Shift+a</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Make the selected text <strong>bold</strong>.</td>
<td>Cmd+b</td>
</tr>
<tr>
<td>Ctrl+Shift+b</td>
<td>Format text as a bulleted list.</td>
<td>Cmd+Shift+b</td>
</tr>
<tr>
<td>Ctrl+Shift+d</td>
<td>Insert wiki markup. (Opens the Wiki Markup dialog.)</td>
<td>Cmd+Shift+d</td>
</tr>
<tr>
<td>Ctrl+Shift+e</td>
<td>Preview the page you are editing.</td>
<td>Cmd+Shift+e</td>
</tr>
<tr>
<td>Ctrl+Shift+f</td>
<td>Toggle full screen mode.</td>
<td>Cmd+Shift+f</td>
</tr>
<tr>
<td>Ctr+i</td>
<td>Make the selected text <em>italic</em>.</td>
<td>Cmd+i</td>
</tr>
<tr>
<td>Ctrl+Shift+j</td>
<td>Insert a JIRA issue. (Opens the Insert JIRA Issue dialog.)</td>
<td>Cmd+Shift+j</td>
</tr>
<tr>
<td>Ctrl+k</td>
<td>Insert a link. (Opens the Insert Link dialog.)</td>
<td>Cmd+k</td>
</tr>
<tr>
<td>Ctrl+Shift+k</td>
<td>See a list of suggested pages or other locations to link to from your page.</td>
<td>Cmd+Shift+k</td>
</tr>
<tr>
<td>Ctrl+m</td>
<td>Insert an image. (Opens the Insert Image dialog.)</td>
<td>Cmd+m</td>
</tr>
<tr>
<td>Ctrl+Shift+m</td>
<td>See a list of suggested images, documents and other files to embed in your page.</td>
<td>Cmd+Shift+m</td>
</tr>
<tr>
<td>Ctrl+Shift+n</td>
<td>Format text as a numbered list.</td>
<td>Cmd+Shift+n</td>
</tr>
<tr>
<td>Ctrl+s</td>
<td>Save the page you are editing.</td>
<td>Cmd+s</td>
</tr>
<tr>
<td>Ctrl+Shift+s</td>
<td>Format text with a strike through.</td>
<td>Cmd+Shift+s</td>
</tr>
<tr>
<td>Ctrl+u</td>
<td>Make the selected text <em>underlined</em>.</td>
<td>Cmd+u</td>
</tr>
<tr>
<td>Ctrl+y</td>
<td>Revert an action that was undone.</td>
<td>Cmd+y</td>
</tr>
</tbody>
</table>
Ctrl+z | Undo the most recent action. | Cmd+z
---|---|---
Tab | Indent current line (only in bulleted lists and numbered lists). | Tab
Shift+Tab | 'Outdent' current line (only in bulleted lists and numbered lists). | Shift+Tab
Shift+Enter | Force a line break without a paragraph break. This is a line break with no extra space. | Shift+Enter
[ then ] | Start a list of tasks. [More about tasks...](http://example.com) | [ then ]

**Tables in the editor**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+c</td>
<td>Copy the current table row.</td>
<td>Cmd+Shift+c</td>
</tr>
<tr>
<td>Ctrl+Shift+i</td>
<td>Insert a table. (Opens the Insert Table dialog.)</td>
<td>Cmd+Shift+i</td>
</tr>
<tr>
<td>Ctrl+Shift+v</td>
<td>Paste the current table row.</td>
<td>Cmd+Shift+v</td>
</tr>
<tr>
<td>Ctrl+Shift+x</td>
<td>Cut the current table row.</td>
<td>Cmd+Shift+x</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Add a row above the current row.</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Add a row below the current row.</td>
<td>Alt+Down Arrow</td>
</tr>
</tbody>
</table>

**Autocomplete in the editor**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>[</td>
<td>See a list of suggested pages or other locations to link to from your page.</td>
</tr>
<tr>
<td>!</td>
<td>See a list of suggested images, multimedia files and documents to embed in your page.</td>
</tr>
<tr>
<td>{</td>
<td>See a list of suggestions as you begin typing a macro name.</td>
</tr>
<tr>
<td>@</td>
<td>See a list of suggested users to mention.</td>
</tr>
</tbody>
</table>

See more about using [autocomplete](http://example.com).

**View screen**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>Create a blog post.</td>
<td>b</td>
</tr>
<tr>
<td>Key</td>
<td>Action</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>c</td>
<td>Create a child page of your current page.</td>
<td></td>
</tr>
<tr>
<td>e</td>
<td>Edit a page or blog post, or return to Edit mode when previewing.</td>
<td></td>
</tr>
<tr>
<td>k</td>
<td>Open the Link To dialog.</td>
<td></td>
</tr>
<tr>
<td>l</td>
<td>Add or edit labels.</td>
<td></td>
</tr>
<tr>
<td>m</td>
<td>Add a comment to a page or blog post.</td>
<td></td>
</tr>
<tr>
<td>s</td>
<td>Share the current page</td>
<td></td>
</tr>
<tr>
<td>t</td>
<td>View attachments.</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>Return to page view (only if you are viewing page attachments).</td>
<td></td>
</tr>
<tr>
<td>w</td>
<td>Add or edit watchers.</td>
<td></td>
</tr>
</tbody>
</table>

**Workbox**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>g then n</td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td>j</td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td>k</td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td>n</td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
<tr>
<td>p</td>
<td>Move up to the previous notification for a particular page or blog post.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected notification.</td>
</tr>
<tr>
<td>u</td>
<td>Return to the notification list after opening a particular notification.</td>
</tr>
</tbody>
</table>

**Note:** The keyboard shortcuts are available for notifications only, not for tasks, inside the Confluence workbox.

See more about [managing notifications](#) and [tasks](#).

**Disabling and re-enabling keyboard shortcuts**

Keyboard shortcuts are enabled by default. You can disable general keyboard shortcuts. You cannot disable the editor keyboard shortcuts.

**To disable or re-enable general keyboard shortcuts:**

1. Choose **Browse > Keyboard Shortcuts** (or press the key combination Shift+?).
2. Choose the **General** tab.
3. Select or clear the **Enable General Shortcuts** check box as required.
Notes

- **Note about supported web browsers:** Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: [Supported Platforms](#).
- The keyboard shortcuts dialog also displays the trigger characters for the Confluence autocomplete feature. See [Using Autocomplete](#).
- Confluence keyboard shortcuts are consistent with [JIRA keyboard shortcuts](#).

Creating Content

You can create the following types of content in Confluence:

- [Pages](#)
- [Blog posts](#)
- [Comments](#)

For each of these, you **use the editor** to enter and format the text, and to embed content, or add links to other pages.

When you first create the page, you can choose a **template** that the page should be based on.

When you first save the page, you can choose where the page should be located.

You can also **import content into Confluence** from a variety of other sources.

Related pages

- [Organising Content](#)
- [Managing Users](#)

Take me back to the [Confluence User's Guide](#).

Adding Pages

The usual ways to add a page are described below.

Once you have created a page, you can:

- add content to it **using the editor**
- set the **page's location** in the Confluence site, even before you save the page.

You can always move the page to a different location in the page tree, or to a different space, after you have saved the page.

You may like to read about **writing blog posts**.

**A note about permissions:** To create a page, you need the 'Create Pages' permission for that space, which is assigned by a [space administrator](#) from the Space Administration screens. See [space permissions](#) or contact a space administrator for more information.

On this page:

- Adding a page from the dashboard
- Adding a page from any page in a space
- Adding a page using an undefined link
- Setting Page Location
- Importing an Office Document into One or More Confluence Pages
- Related Topics
Adding a page from the dashboard

You can add a page from the dashboard without having to browse to a specific space. Confluence adds the new page at the root of the space.

To add a new page from the dashboard:

1. Click Add Page at the top right of the dashboard.
2. Select the space where you want to add the page and choose a template on which to base the page content. For more details about using a template, see Creating a Page using a Template.
3. Click Next. Confluence opens the page in 'Edit' mode.

Screenshot: The Add Page dialog on the Confluence dashboard

Adding a page from any page in a space

By default, Confluence adds the new page as a child page of the current page.

To add a new page:

1. Go to any page in the space.
2. Choose Add > Page.

Note that you will only see the Add Page link if you have permission to create pages for the space. You can also create a page using a template.

Pages with large amounts of text content

One user reported having problems saving a page that contained approximately 700 kilobytes (700,000 characters) or more of text content. Refer to CONF-16467 for more information. Some browsers appear to be more susceptible to this issue than others. While it is highly unlikely that your page content will ever reach this size, if you work with large pages, structuring your content into separate pages will help to avoid this issue.

Adding a page using an undefined link

You may want to insert a link pointing to a Confluence page that does not yet exist, but which you intend to create later. This type of link is called an undefined link.

To add an undefined link for later creation of a page:

1. Edit the page in which the link should appear.
2. Type '[' to trigger autocomplete, and type the name of the undefined page. Alternatively, type the text first,
then select the text and type ‘¢’.
3. Choose Insert Link to Create Page.

When you save the page, Confluence colours the undefined link red. When someone clicks the link, the new page opens in edit mode. That person can then enter the page name, add content and save the page, as usual.

Setting Page Location

While you are editing a new page you can set the page's location to any space of your Confluence site.

To set the location for a new page:

1. While editing the page, click Location.
2. Use the tabs on the left of the ‘Set Page Location’ dialog to help you find the new space and parent page for your page, that is, the location where you want to move your page. The ‘Current location’ and ‘New location’ breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, select Reorder to see a list of sibling pages when you click Move.
4. Click Move.
5. If you are reordering the child pages, click in the list to set the new position for the page and click Reorder.

See also Moving a Page.

Screenshot: Setting page location for a new page

Importing an Office Document into One or More Confluence Pages

The Office Connector allows you to import a Word document into Confluence, optionally creating one or more new pages. See Importing a Word Document into Confluence.
Related Topics

Creating a Page using a Template  
Working with Drafts  
Linking Pages  
Page Restrictions  
Working with the Office Connector  
Moving a Page

Take me back to Confluence User's Guide

Adding Blog Posts

To add a blog post for a space, you require 'Create Blog' permission which is assigned by a space administrator. See Space permissions or contact a space administrator for more information.

From the Dashboard

You can add a blog post to any space from the Dashboard, without having to browse to that space.

To add a blog post from the Dashboard:

1. Click Add Blog Post at the top right of the Dashboard.
2. Select the space where you want to add the blog post.
3. Click Next. Confluence will open the Add Blog Post screen in edit mode.
4. Type your content as you would for any other page in Confluence.
5. Preview and click Save when you are finished.

From Any Page

You can add a blog post from any page (other than the Dashboard) in the space.

To add a blog post from any page:

1. Click Add near the top right of the page and choose Blog Post. Confluence will open the Add Blog Post screen in edit mode.
2. Type your content as you would for any other page in Confluence.
3. Preview and click Save when you are finished.

Notes

- Add labels if you want to categorise information this way.
- If you want to backdate your blog post, edit the date in Posting Date. You cannot set a date after today's. Also, you can only set the date when creating the blog post, not when editing it.
- You can view the blog for the current space by opening the Browse menu and selecting Blog. Your blog post should be listed.

Related Topics

Adding Pages  
Working with Blog Posts
**Using the Editor**

The Confluence editor is the tool that you will use to create and edit Confluence pages, blog posts and comments. You can enter content as you would in a Word document, apply formatting, and embed other content and files into the page.

Looking for a quick start? See the Quick Reference Guide for the Confluence Editor.

To begin an editing session, choose Edit at the top of a page (or press E on the keyboard).

**A note about permissions:** To edit a page, you need the ‘Add Pages’ permission for the space. See space permissions. Someone may also apply page restrictions that may prevent you from editing the page.

**An editing session**

You start an editing session whenever you:

- create a new page, blog post or page comment
- edit an existing page, blog post or comment (by pressing ‘E’ on the keyboard, or choosing Edit).

While in an editing session, you can also:

- Name, or rename, a page or blog post. Note that renaming has effects that you should consider.
- Add a comment describing the changes you made.
- Choose whether or not people watching the page get notified of the change you made
- Add labels to the page.

Confluence automatically saves drafts of your page as you work. If another user begins editing the same page as you, Confluence will display a message, and will try to merge the changes when you save your page.

Click **Cancel** (at the bottom of the page) if you want to end the session without saving any changes.

The session ends when you click **Save**.

When you create a new page you can choose the location where the page should be saved. You can also move a page after it has been saved, to make it a child page of a different page, or to move it to another space.

To see changes between different versions of the page, look at the **history** of the page.
On this page:

- An editing session
- The editor panel
- The toolbar
- Embedding content in the page
- Things to help you work faster
  - Autoformatting
  - Autocomplete
  - Autoconvert for pasted links
  - Drag-and-drop for external images and files
  - Drag-and-drop within the editor
  - Keyboard shortcuts
- Finding and replacing text

Related pages:

- Quick Reference Guide for the Confluence Editor
- Page in View Mode
- Working with Tables
- Working with Page Layouts and Columns and Sections
- Displaying Images
- Linking to Images
- Linking to Attachments
- Using Symbols, Emoticons and Special Characters
- Confluence User's Guide

The editor panel

Screenshot: The Confluence editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page title</td>
<td>Type the name of the page. This name is used in links to the page.</td>
</tr>
<tr>
<td>Page content</td>
<td>Add the words, images and other content that forms the content of the page.</td>
</tr>
</tbody>
</table>
Editor toolbar

Use these tools to format and colour content, create lists and tables, indent and align text, and insert other content into the page, such as symbols, links, images, multimedia files and macros. The toolbar also provides the find and replace option, and the help option.

Restrictions

Control who can view or edit the page. See Page Restrictions.

Attachments

View, and manage, the attached files on the page.

Labels

Add labels to a page, to categorise the page content.

Change comment

Type a comment that describes the changes you have made.

Notify watchers

Select this option to prompt Confluence to send an e-mail notification of your changes to people who are watching the page.

Preview

See how your changes will appear, without saving the page.

Save

Save the changes you have made to the page. (Keyboard shortcut: Ctrl+S).

Cancel

End the editing session, without saving any changes.

The toolbar

You can use the editor toolbar to:

- Apply paragraph styles and character formatting (such as bold, italics, superscript).
- Choose colour for text.
- Create numbered and bulleted lists.
- Set the indenting and alignment for text and images.
- Create links to other pages, attachments, anchors and external resources.
- Add tables, and add, remove, cut and paste rows and columns, highlight cells, rows and columns, and merge and split cells.
- Insert other content into the page, such as images, multimedia, attachments, symbols and wiki markup.
- Use macros to add other types of content, such as a list of JIRA issues or a table of contents.
- Add layouts and columns and sections to your page.
- Find and replace content within the page that you are editing.

Screenshot: The editor toolbar
Embedding content in the page

Choose Insert on the editor toolbar to include any of the following types of content into your page:

- An image.
- A link to another Confluence page or external URL, or a link to an attachment or image.
- An emoticon or symbol, or a horizontal line.
- A macro. Choose either a specific macro, or Other Macros, from the Insert menu.

Things to help you work faster

Autoformatting

You can type Confluence wiki markup directly into the editor to have Confluence auto-format your text as you type. To learn more, choose ? on the editor toolbar and choose the Editor Autoformatting tab. See also See the Quick Reference Guide for the Confluence Editor.

Autocomplete

When editing a page or blog post, you can enter a trigger character to show a list of suggested links, media files or macros to add to your page. This feature is called ‘autocomplete’ and provides you with a fast editing solution if you prefer to use key strokes rather than pointing and clicking with the mouse.

Quick summary of autocomplete:

<table>
<thead>
<tr>
<th>Type:</th>
<th>To see suggested:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[]</td>
<td>pages and blog posts</td>
</tr>
<tr>
<td>!</td>
<td>multimedia files</td>
</tr>
<tr>
<td>{}</td>
<td>macros</td>
</tr>
<tr>
<td>@</td>
<td>mentions</td>
</tr>
</tbody>
</table>

For details, see Using Autocomplete.

Autoconvert for pasted links

When you paste URLs into Confluence, the editor will analyse what you are pasting and automatically convert it into something that will display well in Confluence. Examples include:
• YouTube videos
• JIRA issue queries
• Google Maps
• Confluence pages, blog posts, comments, user statuses, user profiles.
• Shared screenshot links from Skitch
• And more.

Drag-and-drop for external images and files

You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post. Please refer to the following pages for more information:

• Using Drag-and-Drop in Confluence – Using Confluence’s drag-and-drop feature, including details about its requirements and configuration.
• Displaying Images – Embedding images onto a Confluence page or blog post.
• Embedding Multimedia Content – Embedding videos, audio files and other multimedia files onto a Confluence page or blog post.
• Displaying Office Files in Confluence – Embedding Office and PDF files onto a Confluence page or blog post.

Drag-and-drop within the editor

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

Note: For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 9. (Drag and drop in the editor does not work in Internet Explorer 8.)

Keyboard shortcuts

To see the keyboard shortcuts available, choose ? on the editor toolbar.

Finding and replacing text

Click the binoculars icon on the toolbar, or use the keyboard shortcut Ctrl+F (Windows) or Cmd+F (Mac OS).

Search matches are highlighted in yellow. You can step through the results one by one, replace the matching text strings one by one, or replace all matching strings at once. This find and replace feature works only within the current page.

Quick Reference Guide for the Confluence Editor

This page is a quick-reference guide to using the Confluence editor. The aim is to give you enough information about the editor’s features for you to experiment yourself, rather than describing every possible shortcut key, autocomplete feature or toolbar option.

This guide is for people who want to use the autocomplete, autoformatting and keyboard shortcuts provided by the editor. If you prefer to use the toolbar options, the editor itself should be mostly self-explanatory.

Introductory tips
1. **Jump in and start using the Confluence editor.** The editor toolbar contains the most important buttons you'll need for creating and editing content.

2. **Use the keyboard shortcuts.** For example, type these characters in the editor panel:
   - Type `[` (angle bracket) to insert a link.
   - Type `!` (exclamation mark) to insert an image or other media.
   - Type `{` (curly bracket) to insert a macro.
     These characters will trigger the autocomplete functionality, prompting you with a list of suggestions to finish off the entry. For more shortcuts, click the help icon on the editor toolbar.

3. **See how to undo the autocomplete and autoformatting actions.** To undo something that autocomplete or autoformatting has done, press **Ctrl+Z** (Windows) or **Cmd+Z** (Mac).

---

**On this page:**
- Introductory tips
- Seeing it in action
- Using the most common formats and features
  - Formatting text
  - Using symbols
  - Linking text
  - Using lists
  - Using tables
  - Using macros
  - Displaying images and multimedia

**Related pages:**
- Using Autocomplete
- Confluence 4.0 Editor - What's Changed for Wiki Markup Users

---

**Seeing it in action**

This short video shows the autoformatting and autocomplete features of the editor.

**See the video on YouTube**

This video shows how to add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.

**See the video on YouTube.**

**Using the most common formats and features**

Below is a list of the most commonly used editor features, and the related keyboard shortcuts.

**Formatting text**

<table>
<thead>
<tr>
<th>Formatting text</th>
<th>What to do</th>
<th>Windows keyboard shortcuts (For Mac OS X, replace 'Ctrl' with 'Cmd')</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading levels</td>
<td>Type the heading level and a full stop. Autoformat will convert the line to the appropriate heading immediately. You can continue typing your heading text immediately. Example: h2.</td>
<td>Ctrl + 1 to 6</td>
</tr>
<tr>
<td>Bold text</td>
<td>Type an asterisk ‘*’, your text, then another asterisk. Confluence autoformat will convert the text to bold immediately. Example: <em>Surf’s Up</em></td>
<td>Ctrl + b</td>
</tr>
<tr>
<td>Italic text</td>
<td>Type an underscore ‘_’, your text, then another underscore. Confluence autoformatting will convert the text to italics immediately. Example: <em>Surf’s Up</em></td>
<td>Ctrl + i</td>
</tr>
<tr>
<td>Underlined text</td>
<td>Type a plus sign ‘+’, your text, then another plus sign ‘+’. Confluence autoformatting will convert the text to underlined immediately. Example: +Surf’s Up+</td>
<td>Ctrl + u</td>
</tr>
</tbody>
</table>
| Monospace text | Type two curly braces ‘{’, your text, then another two curly braces ‘}’. Confluence autoformat will convert the text to monospace immediately. Example: {{Surf's Up}} | {{
| Left, centre and right alignment | Click the left, centre and right alignment buttons on the editor toolbar: ![Alignment Buttons](image) ![Alignment Buttons](image) ![Alignment Buttons](image) | None |

This can also be used to align images independently of text.
<table>
<thead>
<tr>
<th>Indentation</th>
<th>Click the left and right indentation buttons on the editor toolbar:</th>
<th>Tab (right), Shift + Tab (left)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line break</td>
<td>Press Shift + Enter to force a line break without a paragraph break. This is a line break with no extra space.</td>
<td>Shift + Enter</td>
</tr>
<tr>
<td>Quotation</td>
<td>Use the Quote style – select 'Quote' from the style dropdown menu or use the keyboard shortcut. Example:</td>
<td>Ctrl + 8</td>
</tr>
<tr>
<td>Colour</td>
<td>Click the colour options on the editor toolbar. Example:</td>
<td>None</td>
</tr>
</tbody>
</table>

**Using symbols**

<table>
<thead>
<tr>
<th>Adding symbols and emoticons</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tick or check mark</td>
<td>Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:</td>
<td>( + / + )</td>
</tr>
<tr>
<td></td>
<td>(/)</td>
<td></td>
</tr>
<tr>
<td>Smiley</td>
<td>Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>: )</td>
<td>: + )</td>
<td></td>
</tr>
</tbody>
</table>

### Linking text

<table>
<thead>
<tr>
<th>Linking text</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking to a Confluence page</td>
<td>Type a square bracket '[' and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:</td>
<td>[</td>
</tr>
</tbody>
</table>

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [Modern Girl|Modern Girl song lyrics]
<table>
<thead>
<tr>
<th>Linking text to a web page</th>
<th>Type a square bracket <code>[</code> and select <strong>Insert Web Link</strong>, then paste the URL into the link dialog. Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image" alt="Link suggestions dialog" /></td>
</tr>
<tr>
<td></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
</tr>
<tr>
<td></td>
<td>• This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.</td>
</tr>
<tr>
<td></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
</tr>
<tr>
<td></td>
<td>• Example: [Modern Girl</td>
</tr>
<tr>
<td>Linking to a page that does not yet exist</td>
<td>Type a square bracket ‘[‘ and the name of the non-existent page, then select 'Insert Link to Create Page'. Example:</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Link suggestions" /></td>
</tr>
<tr>
<td></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
</tr>
<tr>
<td></td>
<td>- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.</td>
</tr>
<tr>
<td></td>
<td>- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
</tr>
<tr>
<td></td>
<td>- Example: [Future of the Modern Girl]</td>
</tr>
</tbody>
</table>
Linking to an attachment

Type a square bracket '[' and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example:

```
[chocs]
```

Alternatively, use wiki markup entirely. Type the link, including the alias (if required), the caret character ^ and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[^attachment name]`
### Linking to an anchor

**To create the anchor:** Add an anchor macro using wiki markup. Confluence will convert the macro to rich text format and add it to the page. For example, to create an anchor named 'index', type the following: `{anchor:index}

**To create the link:** Use [wiki markup](https://confluence-docs.atlassian.com/display/DOC/Linking+to+an+anchor) too. Type the link, including the alias (if required), the hash character `#` and the anchor name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[Index|#index]

### Using lists

<table>
<thead>
<tr>
<th>Using lists</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a bullet list</strong></td>
<td>Type an asterisk <code>*</code> followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:</td>
<td>Ctrl + Shift + b</td>
</tr>
<tr>
<td></td>
<td>My list:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• bullet item</td>
<td></td>
</tr>
</tbody>
</table>

ℹ️ To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.
## Adding a numbered list

<table>
<thead>
<tr>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type a hash or pound '#' followed by a space. Autoformat will convert the</td>
<td>Ctrl + Shift + n</td>
</tr>
<tr>
<td>line to a numbered list. You can continue typing your text immediately.</td>
<td></td>
</tr>
<tr>
<td>Example:</td>
<td></td>
</tr>
<tr>
<td>My list:</td>
<td></td>
</tr>
<tr>
<td>1. <strong>bullet item</strong></td>
<td></td>
</tr>
</tbody>
</table>

ℹ️ To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.

## Using tables

<table>
<thead>
<tr>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type a series of pipe characters '</td>
<td>' then press Enter. Autoformat will</td>
</tr>
<tr>
<td>convert the pipes to a table. Example – to create a table with three</td>
<td></td>
</tr>
<tr>
<td>columns:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Using macros

<table>
<thead>
<tr>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding a macro to your page.

Type '{' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:

```
{ blog
```

Alternatively, use **wiki markup entirely**. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `{blogposts:content=titles}

---

**Displaying images and multimedia**

<table>
<thead>
<tr>
<th>Displaying images</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display an image attached to the page</td>
<td>Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="NoMatterWhat.png" /></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="NoMatterWhat.png" /></td>
<td>• This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="NoMatterWhere.png" /></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="NoMatchingPages.PNG" /></td>
<td>• Example: <img src="image" alt="NoMatterWhat.png" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open Image Pages.png" /></td>
<td><img src="image" alt="InsertOther Media" /></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Displaying an image attached to another page" /></td>
<td><strong>Exactly the same as when the image is attached to the same page.</strong></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Embedding multimedia files" /></td>
<td><strong>What to type</strong></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Keyboard shortcut (Windows)" /></td>
<td><strong>Keyboard shortcut (Windows)</strong></td>
<td></td>
</tr>
</tbody>
</table>
Embedding a video, movie or audio file into a page

Type an exclamation mark '!' and select 'Insert Other Media'. Example:

![Media suggestions](image)

Or type '{' and start typing the macro name 'Multimedia'. Example:

```
{ mul
```

**Working with Text Effects**

The Confluence editor supports most text effects available in standard text editing applications.

**Applying paragraph styles**

Choose a paragraph style from the editor toolbar, or click in the paragraph and use one of the keyboard shortcuts Ctrl+(0–8).

Screenshot: Choosing paragraph styles from the editor toolbar
Applying character formats

To apply a character format, select the text and click one of the editor toolbar buttons, or use a keyboard shortcut. Some formats are available from the 'More' menu.

Screenshot: Text formatting buttons on the editor toolbar

<table>
<thead>
<tr>
<th>Format</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Italics</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Underline</td>
<td>Ctrl+U</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Subscript</td>
<td>none</td>
</tr>
</tbody>
</table>
Applying colours to text

To apply a colour to text, select the text and click the ‘Colour’ button. Choose the colour using the ‘More colours’ button.

Screenshot: Picking colours from the editor toolbar

Aligning text

You can align text to the left, right or centre of a content block. Select the text and click the appropriate alignment option on the editor toolbar.

Screenshot: Left, centre and right alignment options on the editor toolbar

Indenting text

You can move text to the left or right by a predefined sequence of indentations. Confluence determines the size of the indentation. Select the text and click the left or right indentation option on the editor toolbar.

Screenshot: Left and right indentation options on the editor toolbar

Working with Links

By adding a link on a Confluence page, you can link to content anywhere within the Confluence site or on another web site.

You can add links to the following types of content:

- Pages in the same space, in another space, or outside Confluence (webpages).
- Blog posts.
- Pages that haven't yet been created, but for which you require a placeholder on the current page.
- Attachments, such as images and multimedia files.
You can also link from an image, or use a link to begin composing a new email message.

You create all these kinds of links using the 'Insert Link' dialog that is available in the editor (click Link in the menu bar while editing the page). You can also create links using autocomplete as a shorthand way of creating the most common types of links.

You can edit and remove links while editing the page, using the link properties panel that appears when you click on a link in the editor:

Notes

- Links in Confluence will not break even when you rename pages or move them between spaces on your site. Confluence will rename the links, provided you have inserted them as relative links, not as full URLs.
- Looking for a link type not shown above? You might find a plugin can help you.

Linking to Pages
This page describes how to create a link in your Confluence page to another page.

You can create links on your page to:

- Other pages in the Confluence site.
- Webpages outside of Confluence.
- Anchors or headings, on the same page or other pages.

You can also create a link to a non-existent Confluence page.

You can use the following methods to create links:

- Autocomplete - to link to Confluence pages or a non-existent page.
- The 'Insert Link' dialog - to link to Confluence pages and webpages.
- Cutting and pasting a link from your browser - to link to Confluence pages and webpages.
On this page:

- Linking to Confluence Pages
  - Adding a Link using Autocomplete
  - Adding a Link using the Insert Link Dialog
  - Copying and Pasting a Link from your Web Browser
- Linking to Webpages
- Linking to an Anchor or Heading
- Linking to an Undefined Confluence Page
- Linking using a Shortcut Link
- Related Topics

Linking to Confluence Pages

Adding a Link using Autocomplete

You can use autocomplete to create a link to any page in the Confluence site, if you know the name of the page you want to link to.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Adding a Link using the Insert Link Dialog

To create a new link using the 'Insert Link' dialog:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Choose one of the tabs on the left to help you find the page or other location that you want to link to:
   - Search—Use this option to link to a page or file in Confluence.
     - Start typing the page name into the text box. Confluence will suggest options as you type.
     - If necessary, limit the search to the current space.
     - Select your link destination from the autocomplete results, or click Search and select the link destination from the search results.
   - Recently Viewed—Use this option to link to a page in Confluence.
     - Select your link destination from recently-visited pages.
4. Enter link text that will be displayed on the page if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
5. Click Insert.

Copying and Pasting a Link from your Web Browser

To paste a link from your web browser:

1. In your web browser, select and copy the title of a Confluence page.
2. Edit your Confluence page and paste the title where you want the link to appear.

Linking to Webpages

Use the 'Insert Link' dialog to link to an external web page.

To create a link to a webpage:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click Web Link and enter or paste the web address into the URL text box.
4. Enter link text that will be displayed on the page if required. If you have not highlighted text in the page,
and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
5. Click **Insert**.

You can also simply copy and paste a link to a webpage into your Confluence page, as described above.

### Linking to an Anchor or Heading

You can link to an anchor or heading that is on the same page, on another page in the same space, or on a page in another space of the same Confluence site.

**To link to an anchor or heading:**

1. Click **Link** in the toolbar, or press **Ctrl+K**, while editing the page.
2. Click **Advanced** and enter the anchor name (or heading) into the **Link** box, using the following syntax:

<table>
<thead>
<tr>
<th>Anchor or heading location</th>
<th>Link syntax for anchor</th>
<th>Link syntax for heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same page</td>
<td>#anchornname</td>
<td>#headingname</td>
</tr>
<tr>
<td>Different page</td>
<td>pagename#anchornname</td>
<td>pagename#headingname</td>
</tr>
<tr>
<td>Page in another space</td>
<td>spacekey:pagename#anchornname</td>
<td>spacekey:pagename#headingname</td>
</tr>
</tbody>
</table>

For more information about link syntax, see [Confluence Wiki Markup](#).
3. Enter link text that will be displayed on the page, if required. If you leave the **Link Text** box empty, the link will display the destination page name or URL.
4. Click **Insert**.
   - Note that when linking to a heading, **headingname** is case-sensitive and must be entered without spaces
   - Note that when linking to an anchor, **anchornname** is case-sensitive, and **pagename** must be entered with spaces as in the title.

See [Working with Anchors](#) for more information.

### Linking using a Shortcut Link

If you have configured shortcut links on your Confluence site, then you can link to an external site using a shortcut link that looks like this: `CONF-17025@jira`. Our Confluence site (where this documentation is housed)
is configured to allow shortcut links to our JIRA site, using the shortcut @jira. So the shortcut link CONF-17025 @jira produces this link.

To add a shortcut link using the 'Insert Link' dialog:

1. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
2. Click Advanced and enter or paste the shortcut link into the Link box. Shortcut links are case-insensitive.
3. Enter link text that will be displayed on the page, if required. If you leave the Link Text box empty, the link will display the destination page name or URL.
4. Click Insert.

You can also type ‘[’ and choose Insert Web Link > Advanced to enter a shortcut link.

See Configuring Shortcut Links for more details.

Related Topics

Working with Links
Trackback
Linking to Confluence Pages from Outside Confluence

Take me back to Confluence User's Guide

Linking to Images

This page describes how to insert a link on your Confluence page that points to an image. Linking to an image is a way to have text on a page that, when clicked, takes the user to that image.

Quick guide to linking to an image

1. Click Link on the editor toolbar.
2. Select one of these options:
   • Search – Search for and link to any image or file attached to any page in your Confluence site.
   • Attachments – Link to an image or file attached to the current Confluence page.

The rest of this page gives more details of the above procedure and additional options.

On this page:

- Adding a Link with the Link Browser
- Adding a Link using Autocomplete

Related pages:

- Linking to Attachments
- Displaying Images

Adding a Link with the Link Browser

To link to an image that is attached to the current page:

1. Edit the page where you want to insert the link.
2. Click Link on the toolbar.
3. Choose the Attachments tab in the left-hand panel. You will see a list of all files attached to the page. Now you can:
   • Select an image that is already attached to the page.
   • Attach a new image to the page by clicking Browse and uploading your file.
4. Enter the Link Text. These are the words that will appear as the hyperlink on the page.
5. Click Insert.
To link to an image that is attached to any Confluence page:

1. Edit the page where you want to insert the link.
2. Click **Link** on the toolbar.
3. Select the **Search** option in the left-hand panel.
4. Start typing the name of the image. Confluence will suggest image files. If the image does not appear in the list, click **Search**.
5. Click the image name in the autocomplete results or the search results.
6. Click **Insert**.

**Screenshot: The link browser, showing autocomplete in the 'Search' option**

Adding a Link using Autocomplete

You can use the autocomplete functionality to link to an image attached to any Confluence page.

You can type [ to see a list of suggested links. For details, see **Using Autocomplete**.

Linking from an Image

This page describes how to create a link from an image on one page to another page or URL. When the user clicks the image, they will be redirected to the linked page or other resource.

**To create a link from an image:**

1. Display the image on the page. The image can either be attached to the page or available on another page. See **Displaying Images**.
2. Create the link by clicking on the image and then clicking **Link** in the properties panel. Specify the link target using the 'Insert Link' dialog. See **Linking to Pages**.

You can edit the link by clicking on the image, when editing the page, and clicking **Edit Link** in the properties panel.
Related Topics

- Working with Links
- Working with Attachments
- Displaying Images

Take me back to Confluence User's Guide

Linking to Attachments
This page describes how to add a text link pointing to a file attached to your Confluence page. When a reader clicks the link, the file is displayed in the browser.

- Quick guide to linking to an attachment
  1. Click Link on the editor toolbar.
  2. Select one of these options:
     - Search – to search for and link to any image or file attached to any page in your Confluence site.
     - Recently Viewed – to link to a recently visited page.
     - Attachments – to link to an image or file attached to the current Confluence page.
     - Web Link – to link to any webpage.

On this page:
- Adding a Link using Autocomplete
- Adding a Link using the Link Browser

Related pages:
- Linking to Images

Adding a Link using Autocomplete

You can use autocomplete to add a text link to a file or image attached to any Confluence page.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Adding a Link using the Link Browser

The 'link browser' is the 'Insert Link' or 'Edit Link' dialog that appears when you click Link in the editor toolbar.

To link to a file or image that is attached to the current page:
  1. Edit the page where you want to insert the link.
2. Click **Link** in the editor toolbar, and then the **Attachments** tab. You will see a list of all files attached to the page. Now you can do one of the following:
   - Click on the file that you want to link to, if it is already attached to the page.
   - Attach a new file to the page by clicking **Browse** and uploading your file.
3. Enter the **Link Text**. These are the words that will appear as the hyperlink on the page.
4. Click **Insert** to add the link.

**To link to a file or image that is attached to any Confluence page:**

1. Edit the page where you want to insert the link.
2. Click **Link** in the editor toolbar, and then the **Search** tab.
3. Start typing the name of the file or image. Confluence will offer a list of matching file names. If the file does not appear, click **Search** to find pages that contain the search text.
4. Click the required file in the list or the search results.
5. Enter the **Link Text**. These are the words that will appear as the hyperlink on the page.
6. Click **Insert** to add the link.

**Screenshot: The link browser, showing autocomplete in the 'Search' option**

---

**Linking to Blog Posts**

You can link to blog posts in similar ways to how you [link to pages](#). Only two methods are described on this page.

You can also use the Blog Posts macro to display a [dynamic list of blog posts](#) on your page.

---

ℹ️ **You must create the blog post first**

Linking to a blog post that has not been created yet will not result in a link. Blog posts are very tightly bound to the time at which they were created, so it makes no sense to link to them before they exist.
Linking to a Blog Post using Autocomplete

1. You need to know the title of the blog post.

You can use autocomplete to create a link to any blog post in the Confluence site, if you know the name of the post you want to link to.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Linking to a Blog Post using its URL

1. You need to know the absolute path to the blog post.

To create a link to a blog post using the 'Insert Link' dialog:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click Web Link and enter or paste the absolute path to the blog post into the URL text box.
4. Enter link text that will be displayed on the page if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
5. Click Insert.

Related Topics

Working with Blog Posts
Working with Links
Blog Posts Macro

Take me back to Confluence User's Guide

Linking to Personal Spaces and User Profiles

This page describes how to add a link to a user's personal space or user profile from within another Confluence page.

You can link to a user's personal space (or user profile) easily if you know their username.

If the user does not have a personal space, then the link will go to their user profile.

Linking to a User's Personal Space using Autocomplete

You can use autocomplete to create a link to a user's personal space in the Confluence site. Trigger autocomplete and start typing their name.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Linking to a User's Personal Space using the Insert Link Dialog

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click the Search tab on the left.
4. Start typing the user's name into the search field. Confluence will suggest options as you type.
5. Select the user from the autocomplete results.
6. Enter link text that will be displayed on the page, if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
7. Click Insert.

Related Topics

User Profile Overview
Setting Up your Personal Space
Working with Links

Take me back to Confluence User's Guide

Working with Anchors

The Anchor macro allows you to link to specific parts of a page. Anchor links can be especially useful when navigating between sections of a long document or when you want to link to a segment of a page and not to the page as a whole.

Anchors are invisible to the reader when the page is rendered.

There are two steps to using an anchor:

1. Create the anchor for the content.
2. Create the link to the anchor.

On this page:

- Creating an Anchor
- Parameters
- Linking to an Anchor or Heading
- Notes

Related pages:

- Working with Links
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Creating an Anchor

You use the Anchor macro to create an anchor for content that you want to be able to link to.

To add the Anchor macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Linking to an Anchor or Heading

You can link to an anchor or heading that is on the same page, on another page in the same space, or on a page in another space of the same Confluence site.

To link to an anchor or heading:

1. Click **Link** in the toolbar, or press **Ctrl+K**, while editing the page.
2. Click **Advanced** and enter the anchor name (or heading) into the **Link** box, using the following syntax:

<table>
<thead>
<tr>
<th>Anchor or heading location</th>
<th>Link syntax for anchor</th>
<th>Link syntax for heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same page</td>
<td>#anchorname</td>
<td>#headingname</td>
</tr>
<tr>
<td>Different page</td>
<td>pagename#anchorname</td>
<td>pagename#headingname</td>
</tr>
<tr>
<td>Page in another space</td>
<td>spacekey:pagename#anchorname</td>
<td>spacekey:pagename#headingname</td>
</tr>
</tbody>
</table>

For more information about link syntax, see [Confluence Wiki Markup](https://confluence.atlassian.com/pages-linking.html).

3. Enter link text that will be displayed on the page, if required. If you leave the **Link Text** box empty, the link will display the destination page name or URL.

4. Click **Insert**.

- Note that when linking to a heading, **headingname** is case-sensitive and must be entered without spaces.
- Note that when linking to an anchor, **anchorname** is case-sensitive, and **pagename** must be entered with spaces as in the title.

Notes

- If you are adding an anchor to the site welcome message, it can only be linked to from another page. Internal-only links will not render.
- Page titles and links to other spaces can be combined with anchors and attachments, but you can't use attachments and anchors in the same link.

Using a Link to Create a New Email Message

This page describes how to insert a link that, when clicked, launches the default email client.

💡 You can provide your own text to use as the link text instead of the 'mailto' tag.

To insert a link that creates a new email message:

1. Edit the page on which you want to insert the link.
2. Choose **Insert > Link** and select the **Web Link** tab.
3. Enter an email address, such as 'jsmith@nonexistent.corp.com'.
4. Enter your own link text, if required.
5. Click **Save**.

Related Topics
Working with Links

Take me back to Confluence User's Guide

Linking to Confluence Pages from Outside Confluence

Sometimes you may want to link to a Confluence page from outside of Confluence, such as from another website or from within an email. In this case, you should consider using a link to a ‘permanent’ URL (also called a ‘permalink’), in case the name of the Confluence page changes.

If you are linking to a page from another page in the same Confluence site, it is better to use an internal wiki link rather than a permalink. Confluence can keep track of internal links and will let you know if the link is broken, such as when someone removes the linked page. See Linking to Pages. Internal wiki links are automatically updated if the page is renamed. This only works for page links that use the relative link syntax, for example [Renaming a Page].

To link to a page’s permanent URL:

1. Choose **Tools > Link to this Page**.
2. Copy the **Tiny Link** and paste it into your email or external web page. This will create a link to the latest version of your Confluence page.

Related Topics

Linking to Pages
Working with Links

Take me back to Confluence User's Guide

Inserting JIRA Issues

If your Confluence site is connected to a JIRA site using an application link, you can easily insert individual issues from this JIRA site directly into text on your Confluence page using the 'Insert JIRA Issue' dialog. Each issue inserted onto the page is linked to the issue in JIRA itself.

Using the 'Insert JIRA Issue' dialog, you can also:

- Create a new issue on the JIRA site and insert the issue onto your page.
- Insert a table of JIRA issues onto your page based on the results of a search (using JIRA Query Language (JQL) syntax).

If your Confluence site is not connected to any JIRA site via an application link, this feature will not be available. However, you can still list JIRA issues on a page or blog post using the JIRA issues macro.

On this page:

- Inserting a JIRA Issue from a List of Recently Viewed Issues
- Creating a New JIRA Issue and Inserting it
- Searching for JIRA Issues and Inserting them
- Notes
- Related Topics
Quick guide to inserting JIRA issues

- Choose Insert > JIRA Issue from the editor toolbar.
- To insert a single issue, use either:
  - Recently Viewed — Insert an issue onto your page from a list of issues you have recently viewed on the JIRA server.
  - Create New Issue — Create a new issue on the JIRA server and insert it into your page.
  - Search — Use JQL syntax to narrow down a list of issues, from which you can select one to insert onto a page.
- To insert a table of issues:
  - Click Search on the 'Insert JIRA Issues' dialog, use JQL syntax to narrow down a list of issues and choose to insert the list onto a page.

If Confluence is connected to more than one JIRA server, ensure that you choose the appropriate JIRA server before using this dialog to select, create or search for issues.

Inserting a JIRA Issue from a List of Recently Viewed Issues

To insert a JIRA issue onto a page from a list of recently viewed issues on a JIRA site:

1. Choose Insert > JIRA Issue from the editor toolbar.
2. Go to the Recently Viewed tab of the 'Insert JIRA Issue' dialog.
3. If necessary, select a JIRA server from the list. See the notes below regarding OAuth outgoing authentication.
4. Select an issue from your list of recently viewed JIRA issues on the JIRA site. The number of items in the list is defined in JIRA.

Creating a New JIRA Issue and Inserting it

This feature works best with JIRA issue types whose mandatory field requirements have not been altered. With the exception of a JIRA issue's 'Component/s' or 'Fix Version/s' fields, you cannot use this dialog to add an issue whose issue type has customised mandatory field requirements upon issue creation.

To create a new JIRA issue on a JIRA site and insert this issue onto a page:

1. Go to the Create New Issue tab of the 'Insert JIRA Issue' dialog.
2. Complete the dialog:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>The available JIRA servers. See the notes below regarding OAuth outgoing authentication.</td>
</tr>
<tr>
<td>Project</td>
<td>The project on the selected JIRA server to which the new issue will be added.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>The type of issue to log in this project.</td>
</tr>
<tr>
<td>Summary</td>
<td>A one-line summary for the issue.</td>
</tr>
<tr>
<td>Component/s</td>
<td>Choose one or more components which apply to this issue.</td>
</tr>
<tr>
<td>Version/s</td>
<td>Choose one or more versions in which the issue will be addressed.</td>
</tr>
</tbody>
</table>
To search a JIRA site for a subset of issues matching a JQL query and insert one or more of these issues:

1. Choose **Insert > JIRA Issue** from the editor toolbar.
2. Go to the **Search** tab of the 'Insert JIRA Issue' dialog.
3. Enter a **JQL query**.
4. If necessary, select the JIRA server whose issues you want to insert.
5. Click **Search** to find the issues on the JIRA server which match your JQL query. The first 20 issues retrieved by your JQL query are displayed.
   - To insert a single issue, select the issue from your list and click **Insert**.
   - To insert the full list of issues, select the **Insert all query results as a table** check box before clicking **Insert**.

Notes

The issues from a JIRA site which you can access in the 'Insert JIRA Issues' dialog depends on the application link's **outgoing authentication** used by Confluence to communicate with that JIRA site. While you can always access publicly visible issues:

- If 'Trusted Applications' outgoing authentication is used — you can also view issues restricted to an account on JIRA whose user name matches your user name in Confluence.
- If 'OAuth' outgoing authentication is used, you may need to click **Login & Approve** at this point to gain access to the JIRA server and restricted issues. You can also view issues restricted to the user account that you 'Login & Approve' (to the JIRA site) on the 'Insert JIRA Issues' dialog.
- If 'Basic Access' outgoing authentication is used — you can also view issues restricted to the user account configured for the JIRA site's 'outgoing authentication'.

Related Topics

**JIRA Issues Macro**

**Trackback**

Trackback is a mechanism by which two sites can stay informed each time one site refers to the other by means of trackback 'pings'.

In Confluence, Trackback is enabled by a [site administrator](Administration Console) from the Administration Console. When Trackback is enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a Trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery, and when Trackback is enabled can receive trackback pings sent by other sites.

To see who has sent a Trackback ping to a Confluence page:

1. Go to the page.
2. Choose **Tools > Info** to go to the 'Information' view for the page.

Any Trackback pings the page has received will be listed under the page's **Incoming Links**.
Confluence incoming trackback pings only work with referenced pages that are public (anonymously viewable)

See more information about the Information View.

Related Topics

Enabling Trackback
Managing External Referrers
Linking to Pages
Working with Links

Take me back to Confluence User's Guide

Displaying Images

You can display an image on a Confluence page in the following cases:

- The image is attached to the page.
- The image is attached to another page of the same Confluence site, even if in another space.
- The image is on a remote web page.

Once the image is displayed on the page, you can:

- Move the image to a new position on the page simply by cutting and pasting.
- Change how the image appears on the page.
- Link from an image to another page.

Displaying an image attached to the page

There are several methods for attaching image files to a page.

Once you have attached an image to a page, there are different methods for choosing where on the page the image should appear:

Using the 'Insert Image' dialog

Once an image is attached to the page, you can edit the page to choose where the image should appear.

On this page:

- Displaying an image attached to the page
- Displaying an image attached to a different page
- Displaying an image from a remote web page
- Controlling the image appearance
- Setting other image attributes
- Displaying a gallery of images
- Image file formats

Related pages:

- Linking from an Image
- Linking to Images
- Working with Attachments
- Choosing a Profile Picture
- Confluence User's Guide

To position an attached image on the page:

1. While editing the page, position the cursor where you want to place the image.
2. Choose **Insert > Image** and choose the **Attached Images** tab.
3. Select the required image and choose **Insert** (or just double-click the image).

**Using autocomplete**

Once an image is attached to the page, you can use autocomplete while editing the page to choose where the image should appear.

**To position an attached image on the page:**

1. While editing the page, position the cursor where you want to place the image.
2. Trigger the autocomplete function by typing ‘!’.
3. Choose the image from the list that appears.

**Using drag-and-drop**

Depending on the browser you are using, you can attach and position an image in one step. While you are editing a page, simply drag-and-drop an image file on to the page. The image is attached to the page and is placed at the current cursor position.

**Displaying an image attached to a different page**

You can display an image that is attached to a different page of the same Confluence site, as long as you know the name of the image. This approach can make it easier to manage your images by allowing you to keep them all in the same place.

**To display an image attached to a different page:**

1. While editing the page, position the cursor where you want to place the image.
2. Choose **Insert > Image** and choose the **Search** tab.
3. Type in the name of the image.
4. Choose whether to search the current space or **All Spaces** and choose **Search**.
5. Select the required image from the search results and choose **Insert**.

Alternatively, you can simply cut and paste the image from another page.

**Displaying an image from a remote web page**

You can display an image from a remote web page on your Confluence page, without needing to attach it to your page. You need to know the URL for the image, not for the web page it appears on. Note that you should have permission to use that image on your page.

**To display an image located on a web page:**

1. While editing the page, position the cursor where you want to place the image.
2. Choose **Insert > Image** and choose **From the Web**.
3. Type in the URL for the image. An example is: `http://www.atlassian.com/software/confluence/images/icon_customerslove_big.png`
4. Choose **Preview** to check that the URL and image are correct.
5. Choose **Insert**.

Alternatively, you can simply cut and paste the image from a web page.

**Controlling the image appearance**

When editing the page, click the image to show the image properties panel. The panel allows you to set the display size for the image and choose whether the image has a border. See also **Linking from an Image**.

**To set the size of the image, do one of the following:**
• Choose one of the size 'preset' buttons (the image width in pixels is displayed to the left).
• Choose the image size text and enter a new image width in pixels (you can specify a size between 16px and 900px).

Note that images are displayed as thumbnails.

**To add a border to the image:**
• Choose **Border** in the image properties panel.

**To add a hyperlink to the image:**
• Choose **Link** in the image properties panel. For more detail, see [Linking from an Image](#).

**To align an image:**
• Select the image and choose the paragraph alignment buttons on the editor toolbars.
• If you choose the left or right alignment, the text will wrap around the image. The text does not wrap for centre alignment.

**To add border effects to an image:**
• Choose **Effects** in the image properties panel and make a choice.

**To add a caption to an image:**
• Choose **Effects** in the image properties panel and choose the **Instant Camera** image effect.
• Save the page.
• Choose **Tools > Attachments** to go to the 'Attachments' view of the page.
• Choose **Properties** next to the image file.
• Add a comment to the attachment. The text in your comment will appear as the image caption.

**Note:** You will need to re-do the comment each time you upload a new version of the image.

*Screenshot: The image properties panel beneath an image*
Setting other image attributes

Certain attributes such as alt-text, title and other HTML parameters can still be set by using the Insert > Wiki Markup function from the editor toolbar, then using the syntax described in Confluence Wiki Markup.
Displaying a gallery of images

See the Gallery Macro.

Image file formats

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:

- gif
- jpeg
- png
- bmp (depending on browser support)

Working with Tables

Confluence pages can include multi-row and multi-column tables. You can highlight cells, rows and columns in different colours. When viewing the page, people can sort the table by clicking the column headers.

Inserting a table

To create a table:

1. While editing the page, place your cursor at the point where you want to insert the table.
2. Choose Table on the toolbar.
3. A dropdown menu will appear, showing a table with a variable number of rows and columns. Click in a cell to set the number of columns and rows for your table.

On this page:

- Inserting a table
- What you can do with your table in the editor
- Sorting the table in view mode

Related pages:

- Working with Page Layouts and Columns and Sections
- Using the Editor
- Confluence User's Guide

What you can do with your table in the editor

While editing a page, place your cursor inside a table to see the following table operations appear in the toolbar.

<table>
<thead>
<tr>
<th>Table operation</th>
<th>Toolbar button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert an empty row above the current one.</td>
<td>✞</td>
</tr>
<tr>
<td>Insert an empty row below the current one.</td>
<td>✓</td>
</tr>
<tr>
<td>Remove the current row.</td>
<td>✗</td>
</tr>
<tr>
<td>Cut the current row and copy it to the clipboard.</td>
<td>✓</td>
</tr>
</tbody>
</table>
Copy the current row to the clipboard.

Paste the row from the clipboard to the current row.

Insert an empty column to the left of the current one.

Insert an empty column to the right of the current one.

Remove the current column.

Merge the selected cells.

Split the selected merged cells.

Highlight the current row. You can choose a colour from the dropdown arrow next to the three highlight options.

Highlight the current column. You can choose a colour from the dropdown arrow next to the three highlight options.

Highlight the current cell. You can choose a colour from the dropdown arrow next to the three highlight options.

Remove the table.

**Sorting the table in view mode**

When readers view a table on a page, they can sort the table by clicking the sort icons in the header row.

*Screenshot: A colourful, sortable table*
Using Symbols, Emoticons and Special Characters

You can add various symbols and special characters to Confluence pages. You can also use them in other places that display content, such as blog posts, comments, the dashboard welcome message and the configuration panels offered by the Documentation theme.

**Inserting symbols and special characters**

To add a symbol to your page:

1. Edit the page.
2. Choose **Insert > Symbol**. This will display the 'Insert Custom Character' window.
3. Choose a symbol to insert it.

**On this page:**

- Inserting symbols and special characters
- Inserting emoticons
- Preventing emoticons from appearing

**Related pages:**

- Icons Used in Confluence
- Quick Reference Guide for the Confluence Editor
- Confluence Wiki Markup
- Confluence User's Guide

*Screenshot: Available symbols*
Inserting emoticons

There are two ways to add an emoticon, or smiley, to your page.

By choosing an emoticon from those available:
1. Choose Insert > Emoticon.
2. Choose an emoticon to insert it.

By typing a character combination:
You can insert emoticons by typing commonly-used character combinations. For example, the following code appears as an emoticon when the page is rendered.

```
;)
```

The above example creates this emoticon: 😊

This table shows the emoticons (and other icons) available in Confluence, and the character combinations that create them:
Preventing emoticons from appearing

To undo the conversion of a character combination into an emoticon, press Ctrl+Z (Windows) or Cmd+Z (Mac).

The Confluence knowledge base has an article on disabling emoticons.

Using Autocomplete

When using the Confluence editor, you can type a trigger character or press a keyboard shortcut to see a list of suggested links, files or macros to add to your page, or to mention another user (and automatically notify them of this).

Summary of autocomplete

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Trigger character</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a link on your page</td>
<td>[</td>
<td>Ctrl+Shift+K</td>
<td>See a list of suggested pages or other locations to link to from your page. More...</td>
</tr>
<tr>
<td>Display an image, video, audio file or document on your page</td>
<td>!</td>
<td>Ctrl+Shift+M</td>
<td>See a list of suggested images, multimedia files and documents to embed in your page. More...</td>
</tr>
<tr>
<td>Add a macro on your page</td>
<td>{</td>
<td>None</td>
<td>See a list of suggestions as you begin typing a macro name. More...</td>
</tr>
<tr>
<td>Notify another user by email that you have mentioned them on your page</td>
<td>@</td>
<td>None</td>
<td>See a list of suggested users to mention. More...</td>
</tr>
</tbody>
</table>

On this page:

- Summary of autocomplete
- Using autocomplete for links
- Using autocomplete for images, videos, audio files and documents
- Using autocomplete for macros
- Using autocomplete for mentions
- Cancelling autocomplete
- Enabling and disabling autocomplete
- Ignoring autocomplete

Related pages:

- Working with Links
- Using Images
- Working with Macros
- Keyboard Shortcuts
- User Profile Overview
- Confluence User's Guide

Using autocomplete for links
Type ‘[’, or press Ctrl+Shift+K, to see a list of suggested pages or other locations to link to from your page. You can link to pages, user profiles, images, documents and other file attachments.

**To autocomplete a link:**

1. Edit the page.
2. Click where you want to insert a link and do one of the following:
   - Type ‘[’ and then the first few characters of the page title, user's name, image name or file name.
   - Type the first few characters of the page title, user's name, image name or file name (or select relevant text) and then press Ctrl+Shift+K.
3. Click the relevant link from the list of suggestions.

If the item you need is not in the list, either:

- Choose **Search for 'xxx'** to continue looking for the page within Confluence, or
- Choose **Insert Web Link** to insert a link to an external web page using the link browser.

**Screenshot: Autocomplete for a link**

![Autocomplete for a link](image)

**Using autocomplete for images, videos, audio files and documents**

You can use the autocomplete as a fast way of embedding images, videos, audio files and documents into your page. Type an exclamation mark or press Ctrl+Shift+M to see a list of suggested images, multimedia files and documents to display on your page. You can use autocomplete to embed the following file types:

- Images – any format that Confluence supports. See [Displaying Images](#).
- Videos, audio files and all multimedia formats that Confluence supports. See [Embedding Multimedia Content](#).
- Office documents supported by the [Confluence Office Connector](#): Word, Excel and PowerPoint.
- PDF files.

*Autocomplete works most efficiently for files that are already attached to the Confluence page. See [Attaching Files to a Page](#).*
To embed an image, video, audio file or document:

1. Edit the page.
2. Click where you want to insert the image, video, audio file or document and do one of the following:
   - Type ‘!’ and then the first few characters of the image, file or document name.
   - Type the first few characters of the name of the image, file or document (or select relevant text) and then press Ctrl+Shift+M.
3. Choose the relevant file from the list of suggestions.

If the item you need is not in the list, either:

- Choose Open Image Browser to find images and documents using the image browser, or
- Choose Insert Other Media to embed videos, audio and other multimedia files using the macro browser. Insert the ‘Multimedia’ macro to display your multimedia file.

### Screenshot: Autocomplete for an image or document

![Autocomplete for an image or document](image.png)

**Using autocomplete for macros**

Type ‘{’ to see a list of suggested macros to add to your page.

Autocomplete provides access to all available macros in your Confluence site, including any user macros that your administrator has added and made visible to all.

ℹ️ You need to know the name of macro. Autocomplete for macros will only match the name of the macro, not the description.

**To autocomplete a macro using ‘{’:**

1. Edit the page.
2. Click where you want to insert the macro.
3. Type ‘{’ and then the first few characters of the macro name.
4. Choose the relevant macro from the list of suggestions.
5. Configure the macro by completing the form fields as prompted.

If the macro you need is not in the list, select Open Macro Browser in the list of suggestions to continue looking for the macro in the macro browser. See Working with Macros.
Using autocomplete for mentions

You can use autocomplete to automatically notify another Confluence user that you have mentioned them in a page, blog post, or comment. Type '@' and part of the person's name, to see a list of suggested users.

**Note:** Use the person's full name. Autocomplete will recognise users' full names only, not their usernames.

**To mention someone using '@':**
1. Edit the page.
2. Click where you want to insert a mention and type '@' and then the first few characters of the user's full name.
3. Choose the user's name from the list of suggestions.

Cancelling autocomplete

The autocomplete starts automatically when you press the trigger characters. You may want to close the autocomplete menu or escape from autocomplete once it has started.

There are a few different ways to stop the autocomplete once it has started:

- Press the escape key, 'Esc', on your keyboard.
- Click somewhere else in the editor panel.
Press an arrow key to move out of the autocomplete area.
For the link autocomplete only: enter a right-hand square bracket, like this: ]

**Enabling and disabling autocomplete**

You can turn off the triggering of autocomplete by the '[' and ']' characters. This will prevent the autocomplete from starting automatically when you press one of the trigger characters. You can also turn it back on again.

Notes:
- This setting does not affect the keyboard shortcuts for autocomplete (Ctrl+Shift+K and Ctrl+Shift+M).
- Even if the trigger characters are disabled, you can still use the keyboard shortcuts for autocomplete.
- This setting affects only you. Other people using Confluence can enable or disable the setting on their user profiles independently.
- Note that autocomplete is enabled by default.

**To enable or disable the autocomplete trigger characters:**

1. Go to your name (the 'User' menu) at the top of the page and choose Settings.
2. Choose Editor under 'Your Settings' in the left-hand panel.
3. Click Edit.
4. Either:
   - Disable autocompletion by selecting Disable Autocomplete.
   - Enable autocompletion by clearing Disable Autocomplete.
5. Click Submit.

**Screenshot: User Settings for the Editor**

![User Settings for the Editor]

**Ignoring autocomplete**

You can add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.

More information about mouse-free macros, links and images:
- [Quick Reference Guide for the Confluence Editor](#)
- [Video](#)

**Working with Page Layouts and Columns and Sections**

When you want to add structure to the information on your page, it is often useful to split the information into columns. By 'column', we mean a vertical block of content. You may want more than one column across the width of the page.

You may also want to use a common structure on a number of pages, so that readers know where to find the information within each page. In addition to columns, sections are useful here. By 'section', we mean an area of...
the page. A section may contain one or more columns.

Confluence provides the following ways of creating columns and sections on a page:

- Page layouts offer a set of predefined columns and sections.
- The Section and Column macros allow more flexibility. You can set the width of the columns, and put the sections and columns in any part of the page.

### On this page:
- [Using page layouts](#)
- [Using the Section and Column macros](#)

### Related pages:
- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)
- [Using the Editor](#)
- [Working with Macros](#)
- [Working with Tables](#)

### Using page layouts

The Confluence editor offers a set of predefined page layouts. Each layout provides one or more columns. Some layouts also provide a horizontal block at the top and bottom of the page. The layout that you select determines the position of the sections and columns on the page, as well as the relative width of the columns. The page's content is confined within the borders of the layout. You cannot add content above or below the sections and columns provided by the layout.

#### To choose a page layout:

1. While editing the page, click the page layout icon. A dropdown list appears, showing icons that illustrate the available layouts.
2. Select a layout.

**Screenshot: Choosing a page layout**

If your page already has content on it, Confluence will put the existing content into the left-hand column of the new layout. If the page was using a different layout, Confluence will put the content into the appropriate sections and columns of the new layout.
Notes about page layouts

- **Very wide tables.** The width of each column is set to a percentage of the page width. The icons in the dropdown menu indicate the relative widths for each layout. In most cases, Confluence will adapt the width of the columns to fit the width of the page. If a column includes a large table, the content may not fit into the width of the page. You will see a horizontal scroll bar when viewing the page.

- **Mixing and matching.** You can put Section and Column macros inside page layouts. You can also put tables inside page layouts.

**Using the Section and Column macros**

You can use the Section and Column macros to add a set of columns to the page. The Section macro defines an area that will contain the columns. You can have as many sections as you like. Within each section, you can have as many columns as you like.

**To add a section and some columns to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find the **Section** macro, select it and insert it onto the page.
3. Choose **Insert > Other Macros** again.
4. Find and insert the **Column** macro.
5. Add your content to the column.
6. Insert as many columns as you like within the section.

**Screenshot: A section and two columns in the editor**
Macro parameters

Parameters are options that you can set to control the content or format of the macro output.

**Parameters of the Section macro**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Border</td>
<td>false</td>
<td>Select this option to draw a border around the section and columns. <strong>Note:</strong> Without a Column macro, the border will not be displayed correctly.</td>
</tr>
</tbody>
</table>

**Parameters of the Column macro**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Width</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>Specify the width of the column, in pixels (for example, 400px) or as a percentage of the available width (for example, 50%).</td>
</tr>
</tbody>
</table>

Notes about sections and columns

- All content within your section must be enclosed within a Column macro, otherwise the section layout will not work as expected.
- You can put tables inside columns.
- PDF exports do not handle page layouts. See this issue report:
Working with Macros

Using a macro, you can add extra functionality or include dynamic content on a page. For example, the Attachments macro will list a page's attachments in the page itself, so that readers do not have to visit the Attachments tab.

On this page:
- Adding a Macro to your Page
- Macros Shipped with your Confluence Installation
- Information about Other Macros
- Writing your own Macros
- Code examples
- Related Topics

Adding a Macro to your Page

Including Macros with the Macro Browser

To add a macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Macro Parameters

Many macros allow you to include optional parameters to control the macro's output.

With the Attachments Macro, for instance, you have two optional parameters allowing you to:

- Specify the file formats of the attachments displayed.
- Choose whether or not you want old versions of the attachments displayed.

Macro Placeholders

Macro placeholders are displayed in the editor where you have added a macro to the page.

When editing a page, you can:

- Double-click a macro placeholder (or click the placeholder and choose Edit) to open the macro dialog window, where you can edit the macro's parameters.
- Select a macro placeholder to cut, copy and paste the macro.

Macros Shipped with your Confluence Installation

When you download your Confluence installation file, many macros are shipped with the download. Below is a list of the macros currently shipped with Confluence. Click a macro name for details of the usage, including optional parameters and examples.

Anchor Macro

Allows you to link to a specific part of a page.
**Attachments Macro**
Displays a list of attachments on a given page.

**Blog Posts Macro**
Lists the most recent news items in the space.

**Change-History Macro**
Displays a history of updates made to a page.

**Chart Macro**
Displays a chart based on tabular data.

**Cheese Macro**
Displays the words "I like cheese!"

**Children Display Macro**
Displays the children and descendants of the current page.

**Code Block Macro**
Displays code in your document with the appropriate syntax highlighting.

**Column Macro**
Used with the Section macro to define columns on a page. See Working with page layouts and columns and sections.

**Content by Label Macro**
Displays a list of content associated with specific labels.

**Content by User Macro**
Displays a list of the content items that have been created by a specified Confluence user.

**Contributors Macro**
Displays a list of Confluence users who have made a contribution of some type to a page.

**Contributors Summary Macro**
Displays a table of contribution-based statistics for a set of pages.

**Create Space Button Macro**
Renders a create space button linked to the create space page.

**Detailssummary Macro**
Presents a tabulated summary of selected metadata, which has been embedded using the Metadata Macro on any page or blog post in the current Confluence space.

**Excerpt Include Macro**

Allows you to display an excerpt from another page within the current page.

**Excerpt Macro**

Define a part of a page as the page's 'excerpt' which can then be displayed in another page.

**Expand Macro**

Displays an expandable/collapsible section of text.

**Favourite Pages Macro**

Displays a list of your favourite pages.

**Gadget Macro**

Allows you to add Confluence gadgets to pages or blog posts.

**Gallery Macro**

Forms a thumbnail gallery of all images attached to a page.

**Global Reports Macro**

Renders a list of links to global reports within a table.

**HTML Include Macro**

Includes the content of an external HTML file into a Confluence page.

**HTML Macro**

Renders your specified HTML code within the current page.

**IM Presence Macro**

Displays graphically when a contact is online.

**Include Page Macro**

Inserts the contents of the specified page into the current one.

**Info Macro**

Displays a block of text in a blue highlight box.

**JIRA Issues Macro**

Displays a list of JIRA issues in a page.
JIRA Macro
Displays one or more JIRA issues on your Confluence page.

JUnit Report Macro
Display a summary of JUnit test results.

Labels List Macro
Displays a hyperlinked alphabetical index of all labels within the current space.

LiveSearch Macro
Add a dynamic search box to a wiki page.

Lorem Ipsum Macro
Display a few paragraphs of pseudo-Latin text.

Metadata Macro
Allows you to embed metadata into pages and blog posts for presentation with the DetailsSummary Macro.

Multimedia Macro
Displays videos, animations and more, sourced from a file attached to a Confluence page and displayed on your page.

Navigation Map Macro
Renders the list of pages associated with a specified label as a navigable map.

Network Macro
Displays a list of Network activity for users in your Confluence site.

NoFormat Macro
Displays a block of text in monospace font.

Note Macro
Displays a block of text in a yellow highlight box.

Page Index Macro
Creates a hyperlinked alphabetical index of all page titles within the current space.

Page Tree Macro
Displays a dynamic, hierarchical list of pages starting from a specified parent (root) page.

Page Tree Search Macro
Adds a search box to your Confluence page and searches a hierarchy of pages starting from a specified parent (root) page.

**Panel Macro**

Displays a block of text within a fully customisable panel.

**Popular Labels Macro**

Displays the most popular labels used throughout your Confluence site or within a space.

**Profile Picture Macro**

Displays a user's profile picture on a page.

**Recently Updated Dashboard Macro**

Displays a list of the most recently changed content within Confluence and is intended for use on the Confluence dashboard.

**Recently Updated Macro**

Displays a list of recently changed content (pages, news items, comments, etc).

**Recently Used Labels Macro**

Lists labels most recently used in a specified scope (global, space, or personal)

**Related Labels Macro**

Lists labels frequently appearing on the same pages as the current page's labels.

**RSS Feed Macro**

Displays the contents of an RSS feed.

**Search Results Macro**

Searches Confluence, and includes the results in the page.

**Section Macro**

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

**Space Attachments Macro**

Displays a list of attachments belonging to the current space.

**Space Details Macro**

Includes the summary of a Confluence space in the page.

**Space Jump Macro**

 Allows you to link from a page in one space to a page with the same name in another space, without knowing
the name of the page when you create the link.

**Spaces List Macro**

Displays a list of all spaces visible to the user.

**Status Macro**

Displays a coloured lozenge, useful for reporting project status.

**Table of Contents Macro**

Displays a table of contents from your page headings.

**Table of Content Zone Macro**

Displays a table of contents from a defined page 'zone'.

**Tasklist Macro**

Displays a dynamic task list which can be modified in 'view' mode.

**Tip Macro**

Displays a block of text in a green highlight box.

**User List Macro**

Displays a list of Confluence users, from an optional group.

**User Profile Macro**

Displays a short summary of any Confluence user's profile on your Confluence page or blog.

**User Status List Macro**

Displays a history of any Confluence user's status updates on your Confluence page or blog.

**View File Macro**

Embeds an Office document or PDF file into your Confluence page.

**Warning Macro**

Displays a block of text in a red highlight box.

**Widget Connector Macro**

Displays videos, slide shows, twitter chats, documents and more, sourced from other web sites and displayed on your Confluence page.

**Information about Other Macros**

Other macros are available as **plugins** or as **user macros**, and can be installed by your Confluence administrator. Macros that may be of interest are also available from [Adaptavist](http://www.adaptavist.com), [CustomWare](http://customware.nu) and the [Confluence SharePoint connector](http://www.confluencesharepoint.com).
Writing your own Macros

To learn how to write your own macro, take a look at the following documentation:

- User macros are simple template-like macros that allow you to create simple formatting macros using the Confluence web interface. Read more about Writing User Macros.
- The Confluence Plugin Guide tells you how to develop a plugin for Confluence.

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Related Topics

Atlassian Plugin Exchange
Installing Plugins and Macros

Take me back to the Confluence User’s Guide.

Anchor Macro

ℹ️ The Anchor Macro is documented in Working with Anchors.

Attachments Macro

See Displaying a List of Attachments.

Blog Posts Macro

The Blog Posts macro allows you to display blog posts on a Confluence page. Clicking on a title takes you to the blog post.

Using the Blog Posts Macro

To add the Blog Posts macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Type to Display</td>
<td>titles</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>titles</strong> — Display only the title of each blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>excerpts</strong> — Display a short excerpt from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post.</td>
</tr>
<tr>
<td>Time Frame</td>
<td>no limit</td>
<td>Specify how far back in time Confluence should look for the blog posts to be displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>m</strong> — Minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>h</strong> — Hours, so '12h' displays blog posts created in the last twelve hours.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>d</strong> — Days, so '7d' displays blog posts created in the last seven days.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>w</strong> — Weeks</td>
</tr>
</tbody>
</table>
| **Restrict to these Labels** | None | Filter the results by label. The macro will display only the blog posts which are tagged with the label(s) you specify here.

You can specify one or more label values, separated by a comma or a space.

- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `-badpage` you will get only content which is not labelled with 'badpage'.
- To indicate that the results **must** match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `+superpage,+goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |

| **Restrict to these Authors** | None | Filter the results by author. The macro will display only the blog posts which are written by the author(s) you specify here.

You can specify one or more authors, separated by a comma. |
| Restrict to these Spaces | @self, i.e. the space which contains the page on which the macro is coded | This parameter allows you to filter content by space. The macro will display only the pages which belong to the space(s) you specify here. You can specify one or more space keys, separated by a comma or a space.  
- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.  
- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.) Special values:  
- @self — The current space.  
- @personal — All personal spaces.  
- @global — All global spaces.  
- @favorite — The spaces you have marked as favourite.  
- @favourite — The same as @favorite above.  
- @all — All spaces in your Confluence site.  
- * — The same as @all above. When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com. |
<table>
<thead>
<tr>
<th>Maximum Number of Blog Posts</th>
<th>15</th>
<th>Specify the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort By</td>
<td>creation</td>
<td>Specify how the results should be sorted. If this parameter is not specified, the sort order defaults to descending order (newest first) based on the creation date. Values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• title — Sort alphabetically by title.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• creation — Sort by the date on which the content was added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• modified — Sort by the date on which the content was last updated.</td>
</tr>
<tr>
<td>Reverse Sort</td>
<td>false</td>
<td>Select to change the sort from descending to ascending order (oldest first). Use this parameter in conjunction with the Sort By parameter. This parameter is ignored if the Sort By parameter is not specified.</td>
</tr>
</tbody>
</table>

**Change-History Macro**

The Change-History macro shows the history of updates made to a page: version number, author, date and comment. It displays the information inline.

**Screenshot: The Change-History macro in Confluence**

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Version (v. 3)</td>
<td>Apr 01, 2009 16:55</td>
<td>Conf Admin</td>
</tr>
<tr>
<td>v. 2</td>
<td>Apr 01, 2009 13:09</td>
<td>Conf Admin</td>
</tr>
<tr>
<td>v. 1</td>
<td>Apr 01, 2009 11:03</td>
<td>Conf Admin</td>
</tr>
</tbody>
</table>

**Related pages:**
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

**To add the Change-History macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of
suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Note: There are no parameters for this macro.

Chart Macro
The Chart macro allows you to display a chart based on tabular data. When you add the macro to a page, you:

- supply the data to be charted by the macro as a table in the placeholder of the macro.
- edit the macro parameters in the Macro Browser to configure the format of the chart.

Screenshot 1: A table of data in the Chart macro placeholder

<table>
<thead>
<tr>
<th>Weeks</th>
<th>Issues Burndown</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/07/2011</td>
<td>81</td>
</tr>
<tr>
<td>11/07/2011</td>
<td>68</td>
</tr>
<tr>
<td>18/07/2011</td>
<td>67</td>
</tr>
<tr>
<td>25/07/2011</td>
<td>66</td>
</tr>
<tr>
<td>01/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>08/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>15/08/2011</td>
<td>64</td>
</tr>
<tr>
<td>22/08/2011</td>
<td>44</td>
</tr>
<tr>
<td>29/08/2011</td>
<td>24</td>
</tr>
<tr>
<td>05/09/2011</td>
<td>0</td>
</tr>
</tbody>
</table>

Screenshot 2: The resulting chart
On this page:

- Using the Chart Macro
- Parameters
- Examples
  - Pie Chart
  - Bar Chart
  - 3D Bar Chart
  - Time Series Chart
  - XY Line Chart
  - XY Area Chart
  - Area Charts

Related pages:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Working with Macros
- Confluence User's Guide

Using the Chart Macro

To add the Chart macro to a page:

1. Edit the page and use autocomplete to add the Chart macro. (Type '{chart}'.)
2. Enter your chart data as one or more tables in the body of the macro placeholder. (See the screenshot above.)
3. Click the macro placeholder and choose Edit.
4. Select a chart type using the Type parameter (see below).
5. Choose other parameter settings in the macro browser, as described below.
6. Click Refresh in the 'Preview' area, to check that the chart appears as you expect.
7. Click Save to add the chart to your page.
8. Click Save again when you are ready to save the page.

Parameters

Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification Parameters | Colour Parameters | Axis Parameters | Pie Chart Parameters | Attachment Parameters

Chart Type Parameters

These parameters determine the type of chart to display and the way the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>pie</td>
<td>The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based (see the <strong>Time Series</strong> parameter).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Standard</strong> — pie, bar, line, area</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>XY Plots</strong> — xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Other</strong> — gantt (<a href="#">beta</a>)</td>
</tr>
<tr>
<td>Display Orientation</td>
<td>vertical</td>
<td>Applies to area, bar and line charts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>vertical</strong> — y-axis is vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>horizontal</strong> — x-axis is vertical</td>
</tr>
<tr>
<td>Show in 3D</td>
<td>false</td>
<td>Applies to area, bar and line charts.</td>
</tr>
<tr>
<td>Stacked Values</td>
<td>false</td>
<td>Applies to area and bar charts.</td>
</tr>
<tr>
<td>Show shapes</td>
<td>true</td>
<td>Applies to line charts. Shapes are shown at each data point.</td>
</tr>
<tr>
<td>Opacity</td>
<td></td>
<td>• 75 percent for 3D charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 50 percent for non-stacked area charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 100 percent for all other charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A percentage value between 0 (transparent) and 100 (opaque) that determines how opaque the foreground areas and bars are.</td>
</tr>
</tbody>
</table>

**Display Control Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>Height</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>Display rendered data</td>
<td>false</td>
<td>Sets whether to display the rendered body of the macro (usually the data tables). By default, the chart data table isn't rendered.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>before</strong> — the data are displayed before the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>after</strong> — the data are displayed after the chart.</td>
</tr>
</tbody>
</table>
Image format | png | The image format to be used for the chart.

| | | - png
| | | - jpg

**Title and Label Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Title</td>
<td>none</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>Chart Subtitle</td>
<td>none</td>
<td>A subtitle for the chart, using a smaller font than for <strong>Title</strong>.</td>
</tr>
<tr>
<td>Horizontal-axis Label</td>
<td>none</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>Vertical-axis Label</td>
<td>none</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td>Show a legend or key.</td>
</tr>
</tbody>
</table>

**Data Specification Parameters**

The data for the chart is taken from tables found when the macro body is rendered. These options control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. Additional conversion options can be specified using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>all first level tables</td>
<td>Comma separated list of table ids and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>Columns</td>
<td>all columns</td>
<td>Comma separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the (html) title attribute for the column in the header row.</td>
</tr>
</tbody>
</table>
| Content Orientation | horizontal | - **vertical** — data table columns will be interpreted as series.
<p>| | | - <strong>horizontal</strong> — data table rows will be interpreted as series. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Series</td>
<td>false</td>
<td>• true — the x values in an XY plot will be treated as time series data and so will be converted according to date formats.</td>
</tr>
<tr>
<td>Date format</td>
<td>Confluence language defined date formats</td>
<td>For time series data, the date format allows for additional customization of the conversion of data to date values. If a Date format is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See simple date format.</td>
</tr>
<tr>
<td>Time Period</td>
<td>Day</td>
<td>The time period for time series data. Defines the granularity of how the data is interpreted. Valid values are: Millisecond, Second, Minute, Hour, Day, Week, Month, Quarter, Year.</td>
</tr>
<tr>
<td>Language</td>
<td>none</td>
<td>Use in combination with the Country parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Valid values are 2 character ISO 639-1 alpha-2 codes.</td>
</tr>
<tr>
<td>Country</td>
<td>none</td>
<td>Use in combination with the Language parameter to form a locale. Valid values are 2 character ISO 3166 codes.</td>
</tr>
<tr>
<td>Forgive</td>
<td>true</td>
<td>• true — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats. • false — enforce strict data format. Data format errors will cause the chart to not be produced.</td>
</tr>
</tbody>
</table>

### Colour Parameters

Colours are specified using hexadecimal notation or HTML colour names.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Colour</td>
<td>White</td>
<td>Background of the chart.</td>
</tr>
<tr>
<td>Border Colour</td>
<td>no border</td>
<td>Border around the chart.</td>
</tr>
</tbody>
</table>
### Colours

Comma-separated list of colours used to customise category, sections, and series colours.

### Axis Parameters

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range Minimum Value</td>
<td>none</td>
<td>Range axis lower bound.</td>
</tr>
<tr>
<td>Range Maximum Value</td>
<td>none</td>
<td>Range axis upper bound.</td>
</tr>
<tr>
<td>Range Axis Tick Unit</td>
<td>none</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>Range Axis Label Angle</td>
<td>none</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>Domain Axis Lower Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the <code>Date format</code> parameter.</td>
</tr>
<tr>
<td>Domain Axis Upper Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the <code>Date format</code> parameter.</td>
</tr>
<tr>
<td>Domain Axis Tick Unit</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the <code>Time Period</code> parameter. The <code>Time Period</code> unit can be overridden by specifying a trailing character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds), u (milliseconds).</td>
</tr>
<tr>
<td>Domain Axis Label Angle</td>
<td>none</td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
</tr>
</tbody>
</table>
### Category Label Position

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Label Position</td>
<td>none</td>
<td>Placement of the axis label text for categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- up45 — 45 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- up90 — 90 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- down45 — 45 degrees going downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- down90 — 90 degrees going downward</td>
</tr>
</tbody>
</table>

### Date Tick Mark Position

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Tick Mark Position</td>
<td>start</td>
<td>Placement of the date tick mark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- start — tick mark is at the start of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- middle — tick mark is in the middle of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- end — tick mark is at the end of the date period.</td>
</tr>
</tbody>
</table>

### Pie Chart Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pie Section Label</td>
<td>Show only the pie section key value</td>
<td>Format for how pie section labels are displayed. The format uses a string with special replacement variables:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- %0% is replaced by the pie section key.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- %1% is replaced by the pie section numeric value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- %2% is replaced by the pie section percent value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example 1: &quot;%0% = %1%&quot; would display something like &quot;Independent = 20&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example 2: &quot;%0% (%2%)&quot; would display something like &quot;Independent (20%)&quot;</td>
</tr>
<tr>
<td>Pie Section Explode</td>
<td>No exploded sections</td>
<td>Comma separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher.</td>
</tr>
</tbody>
</table>

### Attachment Parameters

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent...
access re-use the attachment. This can be useful especially when combined with the Cache Pluginto improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>none</td>
<td>The name and location with which the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- ^attachmentName.png — the chart is saved as an attachment to the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- page^attachmentName.png — the chart is saved as an attachment to the page name provided.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- space:page^attachmentName.png — the chart is saved as an attachment to the page name provided in the space indicated.</td>
</tr>
<tr>
<td>Attachment Version</td>
<td>new</td>
<td>Defines the versioning mechanism for saved charts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- new — creates new version of the attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- replace — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorized to remove attachments for the page specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- keep — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.</td>
</tr>
<tr>
<td>Attachment Comment</td>
<td>none</td>
<td>Comment used for a saved chart attachment.</td>
</tr>
<tr>
<td>Thumbnail</td>
<td>false</td>
<td>• true — the chart image attachment will be shown as a thumbnail.</td>
</tr>
</tbody>
</table>

**Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification Parameters**
**Pie Chart**

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>pie</td>
<td></td>
</tr>
<tr>
<td><strong>Chart Title</strong></td>
<td>Fish Sold 2011</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td><strong>Content Orientation</strong></td>
<td>vertical</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herring</td>
<td>9,500</td>
</tr>
<tr>
<td>Salmon</td>
<td>2,900</td>
</tr>
<tr>
<td>Tuna</td>
<td>1,500</td>
</tr>
</tbody>
</table>

**Bar Chart**

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>bar</td>
<td></td>
</tr>
<tr>
<td><strong>Chart Title</strong></td>
<td>Fish Sold</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2010</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herring</td>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<td>Salmon</td>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<td>Tuna</td>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>
### 3D Bar Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>bar</td>
<td></td>
</tr>
<tr>
<td>Show in 3D</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Opacity</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>2009</th>
<th>2010</th>
<th>2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>12.4</td>
<td>31.8</td>
<td>41.1</td>
</tr>
<tr>
<td>Expense</td>
<td>43.6</td>
<td>41.8</td>
<td>31.1</td>
</tr>
</tbody>
</table>

### Time Series Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Tables in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Time Series</td>
<td></td>
</tr>
<tr>
<td>Date Format</td>
<td>MM/yyyy</td>
<td></td>
</tr>
<tr>
<td>Time Period</td>
<td>Month</td>
<td></td>
</tr>
<tr>
<td>Data Orientation</td>
<td>vertical</td>
<td></td>
</tr>
<tr>
<td>Range Axis Lower Bound</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Month</th>
<th>Revenue</th>
<th>Month</th>
<th>Expenses</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1/2011</td>
<td>31.8</td>
<td>1/2011</td>
<td>41.1</td>
</tr>
<tr>
<td></td>
<td>2/2011</td>
<td>41.8</td>
<td>2/2011</td>
<td>43.8</td>
</tr>
<tr>
<td></td>
<td>3/2011</td>
<td>51.3</td>
<td>3/2011</td>
<td>45.3</td>
</tr>
<tr>
<td></td>
<td>4/2011</td>
<td>33.8</td>
<td>4/2011</td>
<td>45.0</td>
</tr>
<tr>
<td></td>
<td>5/2011</td>
<td>27.6</td>
<td>5/2011</td>
<td>44.6</td>
</tr>
<tr>
<td></td>
<td>6/2011</td>
<td>49.8</td>
<td>6/2011</td>
<td>43.8</td>
</tr>
<tr>
<td></td>
<td>7/2011</td>
<td>51.8</td>
<td>7/2011</td>
<td>51.8</td>
</tr>
<tr>
<td></td>
<td>8/2011</td>
<td>77.3</td>
<td>8/2011</td>
<td>52.3</td>
</tr>
<tr>
<td></td>
<td>9/2011</td>
<td>73.8</td>
<td>9/2011</td>
<td>53.8</td>
</tr>
<tr>
<td></td>
<td>10/2011</td>
<td>97.6</td>
<td>10/2011</td>
<td>55.6</td>
</tr>
</tbody>
</table>
### XY Line Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>xyLine</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Revenue</th>
<th>Expense</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>12.4</td>
<td>12.9</td>
</tr>
<tr>
<td></td>
<td>31.8</td>
<td>41.8</td>
</tr>
<tr>
<td></td>
<td>41.1</td>
<td>31.1</td>
</tr>
</tbody>
</table>

### XY Area Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>xyArea</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Revenue</th>
<th>Expense</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>12.4</td>
<td>12.9</td>
</tr>
<tr>
<td></td>
<td>31.8</td>
<td>41.8</td>
</tr>
<tr>
<td></td>
<td>41.1</td>
<td>31.1</td>
</tr>
</tbody>
</table>
### Area Charts

**Example 1**

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>area</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Opacity</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong></td>
<td><strong>Data Table in Macro Placeholder</strong></td>
</tr>
<tr>
<td></td>
<td>area</td>
<td><strong>Satisfaction</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Very satisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Satisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Dissatisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Very dissatisfied</strong></td>
</tr>
</tbody>
</table>

**Example 2**

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>area</td>
<td></td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>Stacked Values</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Type</strong></td>
<td><strong>Data Table in Macro Placeholder</strong></td>
</tr>
<tr>
<td></td>
<td>area</td>
<td><strong>Satisfaction</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Very satisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Satisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Dissatisfied</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Very dissatisfied</strong></td>
</tr>
</tbody>
</table>
Cheese Macro
The Cheese macro simply displays the words "I like cheese!" You can use this macro to test the Confluence macro functionality.

To add the Cheese macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Note: There are no parameters for this macro.

Related pages:
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- How to Make Gorgonzola Cheese
- Confluence User's Guide

Children Display Macro
Use the Children Display macro to list the child pages of a page and the further descendants (children’s children). By default, the macro displays links to the child pages as in the screenshot below. People viewing the page will see only the links for pages that they have permission to view.

Screenshot: The Children Display macro in Confluence
Using the Children Display macro

To add the Children Display macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Example

This list of child pages is generated by a Children Display macro on this page:

- Child Page 1
- Child Page 2

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

On this page:

- Using the Children Display macro
- Example
- Parameters

Related pages:

- Working with Page Families
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide
<table>
<thead>
<tr>
<th>Configuration</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Descendants</td>
<td>false</td>
<td>Choose whether to display all the parent page's descendants. If true shows the complete tree of pages underneath the parent page, regardless of Depth of Descendants.</td>
</tr>
<tr>
<td>Parent Page</td>
<td>current</td>
<td>Specify the page to display children for, from either the current space or a different space. Enter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>/</code> — to list the top-level pages of the current space, i.e. those without parents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>pagename</code> — to list the children of the specified page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>spacekey:</code> — to list the top-level pages of the specified space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>spacekey:pagename</code> — to list the children of the specified page in the specified space.</td>
</tr>
<tr>
<td>Number of Children</td>
<td>none</td>
<td>Restrict the number of child pages that are displayed at the top level.</td>
</tr>
<tr>
<td>Depth of Descendants</td>
<td>none</td>
<td>Enter a number to specify the depth of descendants to display. This setting has no effect of Show Descendants is enabled.</td>
</tr>
<tr>
<td>Heading Style</td>
<td>none</td>
<td>Choose the style used to display descendants.</td>
</tr>
<tr>
<td>Include Excerpts</td>
<td>false</td>
<td>Display excerpts for the child pages, if they exist.</td>
</tr>
<tr>
<td>Sort Children By</td>
<td>Manual if manually ordered, otherwise alphabetical</td>
<td>Optional. Choose:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>creation</code> — to sort by content creation date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>title</code> — to sort alphabetically on title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>modified</code> — to sort of last modification date.</td>
</tr>
<tr>
<td>Reverse Sort</td>
<td>false</td>
<td>Use with the Sort Children By parameter. When set, the sort order changes from ascending to descending.</td>
</tr>
</tbody>
</table>

**Child Page 1**

- Grandchild
Child Page 2

This page is used to test the {children} macro.

Related Topics

Children Display Macro

Code Block Macro

The Code Block macro allows you to display source code in your document with the appropriate syntax highlighting. The code block displays on the page as shown below:

```java
public static void main(String[] args) {
    System.out.println("Hello World!");
}
```

On this page:

- Using the Code Block Macro
- Parameters

Related pages:

- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Using the Code Block Macro

To add the Code Block macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

You can now type the code block directly into the macro placeholder in the editor. Note that any white space contained in the placeholder is not manipulated in any way by the Code Block macro. This is to provide the writer with flexibility over code indentation.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Syntax highlighting</strong></th>
<th>java</th>
<th>Specifies the language (or environment) for syntax highlighting. The default language is Java but you can choose from one of the following languages/environments:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• actionscript3&lt;br&gt;• bash&lt;br&gt;• csharp (C#)&lt;br&gt;• coldfusion&lt;br&gt;• cpp (C++)&lt;br&gt;• css&lt;br&gt;• delphi&lt;br&gt;• diff&lt;br&gt;• erlang&lt;br&gt;• groovy&lt;br&gt;• html/xml&lt;br&gt;• java&lt;br&gt;• javafx&lt;br&gt;• javascript&lt;br&gt;• none (no syntax highlighting)&lt;br&gt;• perl&lt;br&gt;• php&lt;br&gt;• powershell&lt;br&gt;• python&lt;br&gt;• ruby&lt;br&gt;• scala&lt;br&gt;• sql&lt;br&gt;• vb</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>none</td>
<td>Adds a title to the code block. If specified, the title will be displayed in a header row at the top of the code block.</td>
</tr>
<tr>
<td><strong>Collapsible</strong></td>
<td>false</td>
<td>If selected, the code macro’s content will be collapsed upon visiting or refreshing the Confluence page. Clicking the <strong>expand</strong> and <strong>source</strong> link allows you to view this content. If false, the code macro’s content is always displayed in full.</td>
</tr>
<tr>
<td><strong>Show line numbers</strong></td>
<td>false</td>
<td>If selected, line numbers will be shown to the left of the lines of code.</td>
</tr>
<tr>
<td><strong>First line number</strong></td>
<td>1</td>
<td>When <strong>Show line numbers</strong> is selected, this value defines the number of the first line of code.</td>
</tr>
</tbody>
</table>
| Theme   | Default | Specifies the colour scheme used for displaying your code block. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. However, you can also choose from one of the following other popular themes:  
|         |         | • Django  
|         |         | • Emacs  
|         |         | • FadeToGrey  
|         |         | • Midnight  
|         |         | • RDark  
|         |         | • Eclipse  
|         |         | • Confluence |

### Column Macro

**Used with the Section macro to define columns on a page.** See [Working with page layouts and columns and sections](#).

### Content by Label Macro

The Content by Label macro displays links to pages, blog posts and attachments that have been tagged with specific labels.

**A working example**

Below is a working example of the Content by Label macro, displaying content with the label 'LDAP'.

No content found for label(s) LDAP.

---

**On this page:**

- A working example
- Using the Content by Label Macro
- Parameters

**Related pages:**

- Related Labels Macro
- Navigation Map Macro
- Recently Used Labels Macro
- Working with Confluence Labels
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

---

**Using the Content by Label Macro**

**To add the Content by Label macro to a page:**
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label(s)</td>
<td>None</td>
<td>Filter by label(s). The macro will display only the content tagged with the label(s) specified here. See also the Operator parameter below. This parameter is required. Specify one or more labels, separated by a comma or a single space. • To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of -badpage you will get only content which is not labelled with 'badpage'. • To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of +superpage,+goodpage you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
<tr>
<td>Author(s)</td>
<td>None</td>
<td>Filter by author. The macro will display only the content created or updated by the author(s) specified here. Specify one or more authors, separated by a comma.</td>
</tr>
</tbody>
</table>
| **Include this Content Type Only** | all | Filter by content type. The macro will display only the content of the type specified here.

Specify one or more content types, separated by a comma or a space.

To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of -blogpost you will get pages and all other content except for blog posts.

Available values:
- page – [Pages](#)
- blogpost or news – [Blog posts](#), also known as news items.
- attachment – [Attachments](#)

<p>| <strong>Show Labels for Each Page</strong> | true | Show or hide labels in the results. |
| <strong>Show Space Name for Each Page</strong> | true | Show or hide spaces in the results. |
| <strong>List Title</strong> | None | Add a title or heading to the list. |
| <strong>Maximum Number of Pages</strong> | 15 | Limit the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied. |
| <strong>Display Excerpts</strong> | false | Include excerpts from each page listed. Note that you must have defined excerpts on each of those pages, by adding the excerpt macro to the page. Only the first few lines of the excerpt for each page are displayed. |</p>
<table>
<thead>
<tr>
<th>Restrict to these Spaces</th>
<th>@all</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter by space. The macro will display only the content which belongs to the space(s) specified here.</td>
<td></td>
</tr>
<tr>
<td>Specify one or more space keys, separated by a comma or a space.</td>
<td></td>
</tr>
<tr>
<td>• To exclude content in a specific space, put a minus sign (−) immediately in front of that space key. For example: If you specify a space key of −BADSPACE you will get only content which is not in the BADSPACE.</td>
<td></td>
</tr>
<tr>
<td>• To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)</td>
<td></td>
</tr>
<tr>
<td>Special values:</td>
<td></td>
</tr>
<tr>
<td>• @self — The current space.</td>
<td></td>
</tr>
<tr>
<td>• @personal — All personal spaces.</td>
<td></td>
</tr>
<tr>
<td>• @global — All global spaces.</td>
<td></td>
</tr>
<tr>
<td>• @favorite — The spaces you have marked as favourite.</td>
<td></td>
</tr>
<tr>
<td>• @favourite — The same as @favorite above.</td>
<td></td>
</tr>
<tr>
<td>• @all — All spaces in your Confluence site.</td>
<td></td>
</tr>
<tr>
<td>• * — The same as @all above.</td>
<td></td>
</tr>
<tr>
<td>When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~<a href="mailto:jbloggs@example.com">jbloggs@example.com</a>.</td>
<td></td>
</tr>
</tbody>
</table>
| **Operator** | OR | The operator to apply when matching content against the labels specified in the **Label(s)** parameter:  
| | | • **OR** – Display content with *any* of the non-prefixed labels.  
| | | • **AND** – Display content with *all* of the specified non-prefixed labels.  
| | | Note that this parameter only modifies the behaviour of the **Label(s)** parameter and only affects label values without a plus (+) or minus (-) sign prefix.  
| **Sort By** | modified | Specify how the results should be sorted.  
| | | Values:  
| | | • **title** — Sort alphabetically by title.  
| | | • **creation** — Sort by the date on which the content was added.  
| | | • **modified** — Sort by the date on which the content was last updated.  
| | | Note: If this parameter is not specified, the sort order defaults to descending, based on the last modification date (latest first). To change the sort order from ascending to descending, use the **Reverse Sort** parameter.  
| **Reverse Sort** | false | Select **Reverse Sort** to change the sort from descending to ascending. Use this parameter in conjunction with the **Sort By** parameter. **Reverse Sort** is ignored if **Sort By** is not specified.  

**Content by User Macro**

The Content by User macro generates a tabulated list of the content items, throughout the Confluence installation, that have been created by a specified Confluence user. The list includes all current pages, comments and spaces created by the user. Each item in the table is linked to its corresponding page, page comment or space dashboard.

Note that items for page comments contain a link to the page, followed by a second link to the comment itself, with these separated by a greater-than sign (>).

**Using the Content by User macro**

**To add the Content by User macro to a page:**
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The Confluence username for a person who has created content.</td>
</tr>
</tbody>
</table>

**Contributors Macro**

The Contributors macro displays a list of Confluence users who have made a contribution of some type to a page. It can also be used to list watchers of the page.

The scope of this macro can be extended to include the immediate children or descendants of the specified page. The list of contributors can be based on people who have:

- authored or edited the page(s)
- contributed comments or added labels to the page(s), or
- are simply watching the page(s).

### On this page:

- [Using the Content by User macro](#)
- [Parameters](#)

### Related pages:

- [Contributors Summary Macro](#)
- [Working with Macros](#)
- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)
- [Confluence User's Guide](#)

---

**Screenshot:** Example list of Contributors
In this example, the Display Format parameter has been set to list.

Using the Contributors Macro

To add the Contributors macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Contribution Type| authors | Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:
- authors - includes people who created or have edited the page(s)
- comments - includes people who have added comments to the page(s)
- labels - includes people who have added labels to the page(s)
- watches - includes people who are watching the page(s).

You can specify one or more contribution types, separated by commas.
| **Sort By**                  | count | Specifies the criteria used to sort contributors. Sort criteria are:  
|                            |       | • **count** - sorts people based on the total number of contributions to the page(s)  
|                            |       | • **name** - sorts people into alphabetical order  
|                            |       | • **update** - sorts people based on the date of their last contribution to the page(s).  
| **Reverse Sort**           | false | Reverses the sort order of contributors in the list. Must be used in conjunction with the **Sort By** parameter.  
| **Maximum Number of Contributors** | no limit | Limits the number of contributors in the list. If a number is not specified, all contributors are included.  
| **Display Format**         | inline | Sets how the list of contributor’s names is formatted:  
|                            |       | • **inline** — a comma-separated list  
|                            |       | • **list** — a bullet list.  
| **Show Anonymous Contributions?** | false | Sets whether to include those who contributed anonymously to a page.  
| **Show Count?**            | false | Sets whether to show the number of times each person made a contribution of the specified **Contribution Type**.  
| **Show Last Contribution Time?** | false | Sets whether to show the last time each person made a contribution of the specified **Contribution Type**.  
| **Page Name**              | current | Specifies the page to use when generating the list of contributors. If **Page Name** and **Space(s)** are left blank, the current page is assumed.  
| **Label(s)**               | none | Filters the list of contributors to those who created the specified labels from a page. You can specify one or more labels, separated by commas.  

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Space(s)                      | current        | Specifies the space key of the Confluence space that contains the page set in **Page Name** or alternatively, specifies the spaces to search. Space keys are case-sensitive. This parameter also takes special values, including:  
  - @global — All **global** spaces.  
  - @personal — All **personal** spaces.  
  - @all — All spaces in your Confluence site.  
  You can specify one or more space keys or special values, separated by commas. If no **Page Name** and **Label(s)** are specified, all pages from the specified set of spaces are included. |
| Content Type                  | both pages and blog posts | Restricts the content type to use when generating the list of contributors:  
  - pages — pages  
  - blogposts — blog posts. |
| Blog Post Date                | none           | Specifies the publish date for a blog post. The date format required is: YYYY/MM/DD.                                                      |
| Include Page Hierarchy        | specified page only | Specifies additional pages to include when generating the list of contributors:  
  - children — just the child pages of the specified page  
  - descendants — all descendants of the specified page. |
| Show Selected Pages           | false          | Sets whether to show a list of the pages used to generate the list of contributors.                                                           |
| Custom "None Found" Message   | default message | Specifies the message to be used to override the default message that is displayed when no contributors are found.                           |
The Contributors Summary macro displays a table of contribution-based statistics for a set of pages. These statistics can be grouped according to individual pages or individual contributors.

The default scope for this macro is an individual page, but this can be extended to include the immediate children or descendants of a specified page. The statistics cover the following types of contributions:

- edits to the page(s)
- comments added to the page(s)
- labels added to the page(s)
- people watching the page(s)

A simple example of the Contributors Summary macro is shown in the screenshot below. It lists statistics for the number of times each contributor has edited, added comments and added labels to this page.

**Screenshot: Example Contributors Summary table of statistics**

<table>
<thead>
<tr>
<th>User</th>
<th>Edits</th>
<th>Comments</th>
<th>Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sarah Maddox</td>
<td>2</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Edwin Dawson</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Giles Gaskell</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rosie Jameson</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Andrew Lui</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Charles Miller</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Andrew Prentice</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

In this example, all default parameter settings are used. For more information about this macro's parameters, refer to the **Parameters** section below.

**Using the Contributors Summary Macro**

**To add the Contributors Summary macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group By</strong></td>
<td>contributors</td>
<td>Specifies the basis for grouping contribution-based statistics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- contributors — group by the people who have contributed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pages — group by the pages used to find contributors.</td>
</tr>
<tr>
<td><strong>Columns to Display</strong></td>
<td>edits, comments, labels</td>
<td>Sets the columns that should appear in the table. The statistics or type of information presented depends on the basis for grouping set with the <strong>Group By</strong> parameter. Statistics may be calculated for:</td>
</tr>
</tbody>
</table>
• edits — the number of times each contributor has edited the page(s) or the number of edits made to each page.
• edited — a list of the pages edited by each contributor or a list of contributors who have edited each page.
• comments — the number of times each contributor has added comments to the page(s) or the number of comments on each page.
• commented — a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
• labels — the number of times each contributor has added labels to the page(s) or the number of labels on each page.
• labeled — a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
• labellist — a list of labels either added by each contributor or on each page.
• watches — the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
• watching — a list of pages being watched by each contributor/person or a list of contributors/people watching each page.
• lastupdate — the last time each contributor made an update or when each page was last updated. Valid updates can include edit, comment or label modifications to a page.

One or more columns can be used.
| **Sort By** | edits | Sets the criterion used for sorting items in the table. The items sorted depend on the basis for grouping set with the **Group By** parameter. Sort criteria are:
|            |       | - **edits** — sorts items in the table based on the total number of edits made, either by a contributor or to a page.
|            |       | - **name** — sorts items in the table in alphabetical order, either by contributor or page name.
|            |       | - **editTime** — sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.
|            |       | - **update** — sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it.
| **Reverse Sort** | false | Reverses the sort order of items in the table, as specified using the **Sort By** parameter. (Used only in conjunction with the **Sort By** parameter.)
| **Maximum Number of Items** | no limit | Limits the number of contributors or pages in the table to the value specified. If no number is specified, all items are included.
| **Show Anonymous Contributions?** | false | Includes individuals who have made anonymous contributions to a page.
| **Show Zero Counts?** | false | Sets whether contributors or pages are included for which a calculated statistic is zero.
| **Page Name** | current | Sets the page for which to calculate the contribution-based statistics. If no values for **Page Name** and **Space(s)** are specified, the current page is assumed.
**Label(s)** | none | Restricts the contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas.
--- | --- | ---
**Space(s)** | current | Specifies the space key of the Confluence space which contains the specified page name or alternatively, specifies a scope of spaces to search. Space keys are case-sensitive.

This parameter also takes special values, including:
- `@global` — All global spaces.
- `@personal` — All personal spaces.
- `@all` — All spaces in your Confluence site.

You can specify one or more space keys or special values, separated by commas.

If no **Page Name** and **Label(s)** are specified, all pages from the specified set of spaces are included.

**Content Type** | both pages and blog posts | Restricts page types to either pages (pages) or blog posts (blog posts). If no value is specified in the Macro Browser, both pages and blog posts are included.
--- | --- | ---
**Blog Post Date** | none | Specifies the publish date for a blog post. The date format required is: YYYY/MM/DD.
--- | --- | ---
**Include Page Hierarchy** | specified page only | Includes either the immediate children or all descendants of the specified page. If no value is indicated in the Macro Browser, only the specified page is included.

**Create Space Button Macro**
The Create Space Button macro renders a create space icon that links to the 'Create Space' page. The icon appears as rendered below.

*Screenshot: The Create Space Button in Confluence*
To display this icon, you require ‘Create Space’ permission which is assigned by a site administrator from the Administration Console. See Security or contact your site administrator for more information.

On this page:
- Using the Create Space Button Macro
- Parameters
- Related Topics

Using the Create Space Button Macro

To add the Create Space Button macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon Size</td>
<td>large</td>
<td>Specify whether to use large or small icon:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• large</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• small</td>
</tr>
</tbody>
</table>

Related Topics

Setting up a New Global Space
Working with Macros

Take me back to the Confluence User's Guide.

Detailssummary Macro

The Detailssummary macro presents a tabulated summary of metadata that has been embedded on any page or blog post in the current Confluence space using the Metadata Macro. The Detailssummary macro collects metadata from only those pages or blog posts that have had a particular page label added to them.

The left-most column of the summary shows the name of each page or blog post with the specified label that contains metadata. Each page or blog post is presented on a single row and is hyperlinked to its appropriate destination page.

Each subsequent column represents a unique field within the selected metadata. The value associated with each metadata field on a page or blog post is presented in the appropriate cell of the summary table. For example, the following Detailssummary macro shows the pages in the current space that have metadata embedded using the Metadata macro, and also the 'test' label.

<table>
<thead>
<tr>
<th>Author-Firstname</th>
<th>Author-Nickname</th>
<th>Is-Secret</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To add the Detailssummary macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata Label</td>
<td>none</td>
<td>Restricts the summary to the contents of Metadata macros on the pages in the current space that have this page label.</td>
</tr>
</tbody>
</table>

Another Metadata Macro Example

The following Metadata macro example generates the second line in the Detailssummary macro (above). Note that this current page requires the 'test' label for this to work.

<table>
<thead>
<tr>
<th>Author-Nickname</th>
<th>Strawberry Sundae</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author-Firstname</td>
<td>Fred</td>
</tr>
</tbody>
</table>

Related Topics

Working with Macros

Working with Confluence Labels

Take me back to the Confluence User's Guide.

Excerpt Include Macro

The Excerpt Include macro is used to display 'excerpted' (that is, a segment of) content from one page in another.

To use this macro, the excerpt must have been defined using the Excerpt macro and both pages must exist in the same space. Note that you can have more than one Excerpt Include macro on a page (although you can have only one Excerpt macro on a page).

The excerpt appears as shown below:
On this page:
- Using the Excerpt Include Macro
- Parameters
- Related Topics

**Excerpt Macro**
Define a part of a page as the page’s ‘excerpt’ which can then be displayed in another page.

For this example, we are taking content from a page called ‘Excerpt Macro’, where the Excerpt macro has already been placed. The title of the page is shown at the top of the panel and the content within the body of the macro placeholder is rendered in the panel.

**Using the Excerpt Include Macro**

To add the Excerpt Include macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**
Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Containing the Excerpt</td>
<td>none</td>
<td>Specifies the page that contains the excerpt to be displayed.</td>
</tr>
<tr>
<td>Remove Surrounding Panel</td>
<td>false</td>
<td>Controls whether the panel border around the excerpt and the page title should be hidden. By default, the panel is always shown.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Excerpt Macro
- Working with Macros

Take me back to the Confluence User's Guide.

**Excerpt Macro**
The Excerpt macro is used to mark a part of a page’s content for re-use. By itself, the Excerpt macro does not change the display of a page. However, defining an excerpt enables other macros, such as the Excerpt Include and Blog Posts macros, to display the marked content elsewhere.

You can only define one excerpt per page. In other words, you can only add the Excerpt macro once to a page.
Using the Excerpt Macro

To add the Excerpt macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

To add reusable content to the macro:

1. Add your content inside the Excerpt macro placeholder.
2. Click the macro placeholder to see the options panel, and select the option to Display on new line or to Display inline. The default is to display the content of the macro on a new line. If you choose the inline option, the content of the macro will form part of the same paragraph as the text preceding and following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.

Screenshot: The Excerpt macro placeholder and options panel

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Excerpted Content</td>
<td>false</td>
<td>Controls whether the page content contained in the Excerpt macro placeholder is displayed on the page.</td>
</tr>
</tbody>
</table>

Related Topics

Excerpt Include Macro
Working with Macros

Take me back to the Confluence User's Guide.

Expand Macro
The Expand macro displays an expandable/collapsible section of text on your page. Here is an example:

• Click here to expand...
This text is hidden until you expand the section.

Using the Expand Macro

To insert the Expand macro into a page using the macro browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Using the Expand Macro</td>
</tr>
<tr>
<td>• Parameters</td>
</tr>
<tr>
<td>• Notes</td>
</tr>
</tbody>
</table>

Related pages:

• Working with Macros
• Confluence Wiki Markup for Macros
• Confluence Storage Format for Macros
• Confluence User's Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Click here to expand...</td>
<td>Defines the text that appears next to the expand/collapse icon.</td>
</tr>
</tbody>
</table>

Notes

Text is expanded in PDF and HTML exports. When you export the page to PDF or HTML, the text between the macro tags is expanded so that readers can see it in the PDF and HTML versions of the page.

Favourite Pages Macro
Use the Favourite Pages macro to display a list of your favourite pages.

The output of the Favourite Pages macro appears as in the following screenshot.

Screenshot: The Favourite Pages Macro in Confluence

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
To insert the favourite pages macro into a page using the Macro Browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

**Related Topics**

Working with Favourites
Working with Macros

Take me back to the Confluence User's Guide.

**Gadget Macro**

Gadgets are small applications that can offer dynamic content. They are typically served from a web application server and can be re-used in many other web applications. In Confluence, use the Gadget macro to add gadgets to pages or blog posts.

Confluence comes bundled with a few of its own gadgets that you can add to your pages or blog posts. The Confluence gadgets are listed in Confluence Gadgets. However, you can access additional gadgets in this list if your Confluence Administrator has:

- Installed additional gadgets in Confluence (typically as a Confluence plugin) or
- Registered gadgets served from an external web application or website (such as those from a JIRA installation or iGoogle) via the Registering External Gadgets page.

Unlike other macros, the name of each gadget macro is unique and follows the convention "<gadget-name> macro", where <gadget-name> is the name supplied by the gadget itself.
On this page:

- Inserting Gadgets into a Confluence Page or Blog Post
- Editing Gadgets on a Confluence Page or Blog Post
- Standard gadget parameters
- Contents of a Gadget Macro

Related pages:

- The big list of Atlassian gadgets
- Confluence User's Guide

Inserting Gadgets into a Confluence Page or Blog Post

To add a gadget to a page:

1. Edit your page or blog post.
2. Choose Insert > Other Macros.
3. Click External Content to see a list of gadgets configured for use in your Confluence installation. (Some Confluence macros like the JIRA Issues, RSS Feed, Tasklist and Widget Connector macros also appear in this category because they can also access external content.)
4. Click the desired gadget to access its parameters and properties.
5. Click the parameters to your requirements.
6. Click Refresh to preview your changes.
7. Click Insert to add the gadget to the page.

Editing Gadgets on a Confluence Page or Blog Post

To edit an existing gadget on a page or blog post:

1. Edit your page or blog post.
2. Click the Gadget macro placeholder and choose Edit (or double-click the placeholder).
3. Set the gadget's parameters to your requirements.
4. Click Refresh to preview your changes.
5. Save the gadget.

Standard gadget parameters

Almost all gadgets allow you to set basic parameters (listed below), which appear on the right of the macro dialog. Each gadget may also have its own set of parameters, which appear on the left of the macro dialog.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Width | 450 pixels | Set the width of the gadget in pixels, using one of the following conventions:
- Width in pixels, using px or plain numbers. For example, 500px or 500
- A percentage of the page width, using %. For example, 50%
- Automatic resizing of the gadget to fit 100% of the page width: auto

Border | false | Places a thin grey border around the gadget.

Contents of a Gadget Macro

The body of a gadget macro contains 'parameter-like' content, which represents specific property settings that are particular to each gadget. Hence they are not documented here. Typically, this content would only be changed by customising the gadget’s default properties using the macro browser.

Gallery Macro

The Gallery macro displays a collection of thumbnail images in a table, based on the images attached to a Confluence page. When viewing the page, a user can click a thumbnail image to zoom into a screen-sized image and then view the images as a slide show.

Overview:

- The images shown in the gallery are taken from the files attached to the Confluence page. You can also specify a different page where the attachments are located. For information about attaching images to a page, see Attaching Files to a Page.
- The captions below the images are drawn from the comments on the attachments. For information about adding comments to attachments, see Attaching Files to a Page.
- By default, the gallery will include all the images attached to the page. You can also exclude or include images using parameters.
- You can sort your images into a particular order.
- You can specify a title for the gallery and also configure how many columns you want for the table in which your images are displayed.

On this page:
- Using the Gallery macro
- Parameters
- Image file formats

Related pages:
- Displaying Images
- Attaching Files to a Page
- Editing Attachment Properties
- Working with Macros
- Confluence User's Guide

Screenshot: The Gallery macro as it appears on a page
Using the Gallery macro

To insert the Gallery macro onto a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

The full list of parameters is shown in the following table. If the name of an attached file or page contains a comma, you can refer to it in the relevant parameters below by enclosing it in single or double quotes, for example "this,that.jpg", theother.png

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery Title</td>
<td>Nothing</td>
<td>Specify a title for your gallery.</td>
</tr>
<tr>
<td>Number of Columns</td>
<td>4</td>
<td>Specify the number of columns for your table.</td>
</tr>
<tr>
<td>Images to Exclude</td>
<td>No exclusions. Include all the pictures on the page.</td>
<td>The gallery will ignore any pictures specified. You can specify more than one picture, separated by commas. Note: The filename and filetype for this parameter are case-sensitive. For example, ’my picture.PNG’ will not be recognised as ’my picture.png’.</td>
</tr>
<tr>
<td><strong>Include these Images Only</strong></td>
<td>Include all the pictures on the page.</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Exclude Images with these Labels</strong></td>
<td>No exclusions. Include all the pictures on the page.</td>
<td></td>
</tr>
<tr>
<td><strong>Include Images with these Labels Only</strong></td>
<td>None. The images are not filtered by label.</td>
<td></td>
</tr>
<tr>
<td><strong>Use Images in these Pages</strong></td>
<td>If no page is specified, the gallery macro displays the images attached to the page on which the macro is used.</td>
<td></td>
</tr>
<tr>
<td><strong>Sort Images By</strong></td>
<td>None. The sort order is unspecified and therefore unpredictable.</td>
<td></td>
</tr>
<tr>
<td><strong>Reverse Sort</strong></td>
<td>Off. Sort order is ascending</td>
<td></td>
</tr>
</tbody>
</table>

**Image file formats**

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:...
Global Reports Macro

The Global Reports macro renders a list of links to global reports.

This includes a list of new or updated pages Managing Undefined Pages on the site and RSS feeds for new pages and blog posts.

The Global Reports macro appears as shown in the screenshot below.

Screenshot: The Global Reports macro in Confluence

Using the Global Reports Macro

To add the Global Reports macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width of Table</td>
<td>99%</td>
<td>Specifies the width of the table in which the links are displayed, as a percentage of the window width.</td>
</tr>
</tbody>
</table>

Related Topics

- Subscribing to RSS Feeds within Confluence
- Working with Macros
- HTML Include Macro

Take me back to the Confluence User's Guide.
The HTML Include macro allows you to include the contents of an external HTML file in a Confluence page.

⚠️ **CAUTION: Including unknown HTML inside a webpage is dangerous.**

HTML can contain active scripting components. This means that it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user's authentication cookie and give the attacker their Confluence login password.

Using the HTML Include Macro

**To insert the HTML Include macro into a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML Page's URL</td>
<td>None</td>
<td>The URL of the page to include.</td>
</tr>
</tbody>
</table>

**Troubleshooting**

- The HTML Include macro will only be available if it has been **enabled** by your Confluence administrator. Also, your Confluence Administrator can define a whitelist of trusted URLs. You will see an error message on the Confluence page if the included URL is not in the whitelist.
- You can only use the HTML Include macro for pages with absolute links. If you use the macro to include an HTML page that has relative links, navigating those links in the wiki results in a 'Page Not Found' error. See CONF-6567.

**Related Topics**

- HTML Macro
- Working with Macros
- Configuring a URL Whitelist for Macros

Take me back to **Confluence User's Guide**

**HTML Macro**

The HTML macro allows you to add HTML code to a Confluence page.

**Note:** The HTML macro will only be available if it has been **enabled** by your **System Administrator**.

**Using the HTML Macro**

**To add the HTML macro to a page:**
1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

Enter the HTML code into the body of the macro placeholder.

**Related Topics**
- [HTML Plugin](https://atlassian.com) (has better security than the HTML macro)
- [HTML Include Macro](https://example.com) (embeds remote HTML or pages)
- [Working with Macros](https://atlassian.com)
- [Enabling HTML macros](https://atlassian.com)

Take me back to [Confluence User's Guide](https://atlassian.com)

**IM Presence Macro**

The IM Presence macro indicates graphically when a contact is signed into an Instant Messaging (IM) service. The IM Presence macro appears as a small icon on the page, like this image: ![Online Now](https://example.com)

**Using the IM Presence Macro**

**To add the IM Presence macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID/Screen Name</td>
<td>Identify the user by their ID, account name or screen name.</td>
</tr>
<tr>
<td>Service</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>aim – AOL Instant Messenger</td>
<td></td>
</tr>
<tr>
<td>gtalk – Google Talk</td>
<td></td>
</tr>
<tr>
<td>icq – ICQ</td>
<td></td>
</tr>
<tr>
<td>jabber – Jabber</td>
<td></td>
</tr>
<tr>
<td>msn – MSN Instant Messenger</td>
<td></td>
</tr>
<tr>
<td>sametime – IBM Lotus Sametime</td>
<td></td>
</tr>
<tr>
<td>skype – Skype</td>
<td></td>
</tr>
<tr>
<td>skypeme – Skype</td>
<td></td>
</tr>
<tr>
<td>wildfire – Openfire Server</td>
<td></td>
</tr>
<tr>
<td>yahoo – Yahoo! Messenger</td>
<td></td>
</tr>
</tbody>
</table>

| Show User ID | Shows or hides the User ID of the contact. |

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Include Page Macro

You can use the Include Page macro to display the contents of one Confluence page or blog post in another page or blog post.

Using the Include Page Macro

To add the Include Page macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>


**Page to Include** | None | This is the name of the Confluence page or blog post that you want to include in the current page.
- If the page or blog post is located in another space, add the space key and a colon in front of the page name. For example, DOC:My page name.
- To include a blog post, specify the date as well as the title of the blog post. For example: 2010/12/01/My blog post.
- The space key is case sensitive.
- You can include pages from personal spaces using ~username as the space key, where 'username' is the person's username. For example, ~jsmith:My page name.

**Notes**
- If you want to include part of a page rather than the whole page, use the **Excerpt** and **Excerpt Include** macros.
- To display a page's contents, you need 'View' permission for that page. Similarly, people who view the page will need 'View' permissions for the embedded page as well as the page into which it is embedded. See [space permissions](#) or contact your Confluence space administrator for more information.
- If someone changes the name of the included page after you have added the macro to your page, the page name does **not** change automatically in the macro. You will need to change the page name manually in the macro parameters.
- If you want to embed an external page into a Confluence page, you need the [HTML Include Macro](#).

**Related Topics**

**Working with Macros**

Take me back to the [Confluence User's Guide](#).

**Sample Include Page**

Start of sample page content


End of sample page content

**Info Macro**

The Info macro allows you to highlight helpful information on a Confluence page. It creates a blue-coloured box surrounding your text, as shown below.
Using the Info Macro

To add the Info macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

On this page:

- Using the Info Macro
- Parameters

Related pages:

- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Information Icon</td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

JIRA Issues Macro

JIRA is the issue tracking and project management system supplied by Atlassian. The JIRA Issues macro allows you to display a list of issues from a JIRA site on a Confluence page.

You can list publicly accessible issues from any JIRA site, as well as issues restricted to your user account on a JIRA site, assuming:

- You are logged in to both the JIRA and Confluence sites, and
- Your usernames on both of these sites match.

You can also create, find and insert JIRA issues directly within text on a Confluence page or blog post. For more information, refer to Inserting JIRA Issues.

Screenshot: Example of JIRA issues shown on a Confluence page
Using the JIRA Issues Macro

To add the JIRA Issues macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Refer to the instructions below for details on obtaining the URL of the XML view of a search. An example URL is:

http://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project%3DCONF+AND%28summary%7E+jiraissues+OR+description%7E+jiraissues+OR+comment%7E+jiraissues%29&tempMax=10

Displaying a List of JIRA Issues from any Accessible JIRA Site
Step 1 — Obtain the URL of the Issue Filter

1. Log in to your JIRA system.
2. Go to the 'Issues' screen and create a new filter. Do not modify an existing filter.
3. Set up your search parameters and use 'View' to check the issues returned.
4. Once the filter is finished, go to the Filter's 'View' tab/section in the top-left area of the JIRA interface.
5. Copy the XML link. To do this, follow the appropriate step below:
   - If you are using JIRA 4.0.x or later, choose Views, right-click on XML, and choose Copy Link Location.
   - If you are using JIRA 3.13.x or earlier, locate the 'Current View' links section, right-click on XML, and choose Copy Link Location.

Step 2 — Embed the Issue Filter URL onto your Confluence Page

1. Log in to your Confluence system.
2. Edit the page where you wish to display the list of JIRA issues.
3. Add the JIRA Issues macro to the page, as described above.
4. Edit the macro, and paste the JIRA filter URL from your clipboard into the URL box.
5. Customise the macro output using the optional parameters. See below.
6. Save the Confluence page.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

The JIRA Issues macro allows the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th><strong>URL</strong></th>
<th>none</th>
<th>The URL of the XML view of your selected issues in the JIRA Issue Navigator. Note: If the URL in the URL parameter does not contain a <code>tempMax</code> argument, then the value of <code>tempMax</code> will default to 500. For JIRA 3.12 or earlier, the JIRA Issues macro will return a maximum of 500 issues. For JIRA 3.13 or later, the JIRA Issues macro will return a maximum of 500 issues per page.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>JIRA Field Columns to Display</strong></td>
<td>By default, the following columns are shown:</td>
<td>A list of JIRA column names, separated by semi-colons (;). Example columns are: key, summary, type, created, fixversion, updated, due, assignee, reporter, priority, status and resolution. You can include any columns recognised by your JIRA site, including custom columns. See the JIRA documentation for a list of names.</td>
</tr>
</tbody>
</table>
|  | - type  
|  | - key  
|  | - summary  
|  | - assignee  
|  | - reporter  
|  | - priority  
|  | - status  
|  | - resolution  
|  | - created  
|  | - updated  
|  | - due | |
| **Display Total Numbers Only** | false | When selected, the issue list will only show the number of issues in JIRA. The count will be linked to your JIRA site. |
| **Cache** | on | - **on** – the macro maintains a cache of the issues which result from the JIRA query.  
<p>|  |  | - <strong>off</strong> – the relevant part of the cache is cleared each time the macro is reloaded. |
| <strong>Anonymous Retrieval</strong> | false | When selected, JIRA will return only the issues which allow unrestricted viewing i.e. the issues which are visible to anonymous viewers, as determined by JIRA's viewing restrictions. Otherwise, the results depend on how your administrator has configured the communication between JIRA and Confluence. By default, Confluence will show only the JIRA issues which the user is authorised to view. See more details below. |</p>
<table>
<thead>
<tr>
<th>Width</th>
<th>100%</th>
<th>The width of the table displaying the JIRA issues. Can be indicated either as a percentage (%) or in pixels (px).</th>
</tr>
</thead>
</table>
| Height (pixel value only) | 480  | The height in pixels of the table displaying the JIRA issues. Note that this height specification is ignored in the following situations:  
  • If you set the **Render Mode** parameter (see below) to **static**.  
  • When the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. |
| Title               | JIRA Issues | You can customise the title text at the top of the JIRA issues table with this parameter. For instance, setting the title to 'Bugs-to-fix' will replace the default 'JIRA Issues' text. This can help provide more context to the list of issues displayed. |
| Render Mode         | **static** – when the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed.  
  **dynamic** – for all other formats.  
  • **dynamic**– dynamic issue display with the following features:  
    • Click the column headers to sort the output.  
    • Drag and drop the columns into a different order.  
    • Temporarily remove a column from the display.  
    • View a page of issues at a time, for faster response times.  
  • **static** – disables the dynamic display features. |

**Displaying Issues which have Restricted Viewing**

Maybe your JIRA instance is not visible to anonymous visitors — everyone has to log in before they can see JIRA issues. Or maybe some of the JIRA issues are restricted to viewing by certain users only. This section explains how to handle JIRA issues that have restricted viewing.

**Using Confluence-to-JIRA Trusted Communication (Recommended)**
For Confluence 2.7.0 and later and JIRA 3.12 and later, your administrator can set up trusted communication between Confluence and JIRA. The entire process is described in the Confluence Administrator’s Guide. Provided that your administrator has set up trusted communication, you don’t need to add any extra parameters. Confluence and JIRA will work out the security between them, ensuring that the user will see only the issues they are authorised to see. Read the section below if you want more detail.

**Remove the username and password from your macro markup code**

Prior to Confluence 2.7, you needed to include a username and password in the macro markup code if you wanted to display JIRA issues which had restricted viewing. Once your administrator has set up trusted communication between Confluence and JIRA, you no longer need to include a username and password in the markup code for your JIRA macros.

The following options are available for determining the issues which will be retrieved from JIRA and displayed on the Confluence page:

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Macro parameter</th>
<th>URL parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the JIRA issues which the logged-in user is authorised to see. And if the user is not logged in, display only issues which allow unrestricted viewing.</td>
<td>Do not specify any authentication parameters. In this case, the behaviour depends on the way your administrator has set up trusted communication between JIRA and Confluence. Here is a summary of the behaviour. If trusted communication is enabled, the authorisation will work seamlessly. When a logged-in user views your page, they will see only the JIRA issues they are allowed to see. And if they are not logged in, they will see only the issues which allow unrestricted viewing. If trusted communication is disabled, the Confluence page will show only the JIRA issues which allow unrestricted viewing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ensure that Confluence will display only the JIRA issues which allow unrestricted viewing.</td>
<td>anonymous</td>
<td>Regardless of who the user is (logged in or not), the Confluence page will show only anonymously-visible issues. Confluence will not attempt to set up a trusted communication link with JIRA in this case.</td>
<td></td>
</tr>
</tbody>
</table>
---|---|---|
| Use a pre-determined username and password to access the JIRA issues. | &os_username=MYUSERNAME&os_password=MYPASSWORD | Not recommended. Prior to Confluence 2.7, this was the only way of displaying issues with restricted viewing. For Confluence 2.7 and later, this method will still work. Confluence will not attempt to set up a trusted communication link with JIRA in this case. |

**Rendering HTML from JIRA**

Formatted fields from JIRA can be displayed in Confluence if you set up a Confluence-to-JIRA Trust as described above. Otherwise, such formatted fields will be escaped within the JIRA issues macro output. This is to prevent the possibility of malicious HTML being served by an untrusted JIRA server. The most likely field where you will notice this is in the description field.

So, for example, without the trust relationship, a description column that rendered in JIRA like this -

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is</td>
</tr>
<tr>
<td>• the description</td>
</tr>
<tr>
<td>• of my issue</td>
</tr>
</tbody>
</table>

- would actually appear in the JIRA issues macro like this -

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;p&gt;This is&lt;ul&gt;&lt;li&gt;the description&lt;/li&gt;&lt;/ul&gt;of my issue&lt;/li&gt;&lt;/ul&gt;&lt;/p&gt;</td>
</tr>
</tbody>
</table>

Configuring Confluence-to-JIRA Trust as described above will enable the field to be rendered as expected.

**Troubleshooting**

**HTTPS**

The JIRA Issues macro can access a JIRA instance running under SSL as long as the Confluence server is set to accept the JIRA SSL certificate. Refer to the Confluence Knowledge Base article for more information about problems connecting to SSL services.
And see also Troubleshooting Trusted Communication between JIRA and Confluence

JIRA Macro

See Inserting JIRA Issues.

JUnit Report Macro

The JUnit Report macro displays a summary of JUnit test results from a directory accessible by the Confluence server. JUnit is a unit testing framework which allows programmers to ensure that individual units of Java source code are functioning correctly.

The JUnit Report macro appears as shown in the screenshot below.

Screenshot: The JUnit Report macro in Confluence

<table>
<thead>
<tr>
<th>Test</th>
<th>Time</th>
<th>Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>MoneyTest</td>
<td>100%</td>
<td>00:03.391</td>
</tr>
<tr>
<td>testAdd</td>
<td>00:03.0</td>
<td>1 0 0</td>
</tr>
</tbody>
</table>

When generating reports from the JUnit Report macro, set the Apache Ant formatter to 'XML'.

Using the JUnit Report Macro

To add the JUnit Report macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

### URL of the test result XML file

| None |

URL of a particular test result XML file. Is overridden by the **Directory (URL) of your test result files** parameter if you use both.

Example, from a Confluence instance: `http://yourConfluenceInstance.com/download/attachments/<page id>/file.xml`

For Confluence installations without anonymous user access, you can specify logon credentials as part of this parameter in the form of URL parameters:

- **os_username** — The username of a Confluence user with permission to access to the JUnit test results.
- **os_password** — The password of the Confluence user specified in the `os_username` parameter.

### Directory (URL) of your test result files

| None |

URL of a directory containing your test result files. This must be a directory name and **not** the XML file itself. Overrides the **URL of the test result XML file** parameter if you use both.

Example, for a local drive: `file://C:/TEMP/`

Example, for a network drive: `http://*host*/*path*`

### Report Detail

| all |

Detail for the report. Can be **all**, **fixture**, **summary** or **failuresonly**.

### Debug

| None |

Shows the content of failures, as well as the error messages.

---

**Related Topics**

- [Working with Macros](#)
- [Confluence User's Guide](#)
- [Labels List Macro](#)

The Labels List macro displays a hyperlinked alphabetical index of all labels within the current space.

The label index generated consists of numerous cells, each beginning with one or more letters of the alphabet or
a number. Each label within the space is grouped alphanumerically into its appropriately headed cell.

Each label in the list links to a page that displays all the pages on which the label occurs within the current space.

**Screenshot: Labels List Macro segment**

Below are the 562 labels used in Confluence Docs 2.10 listed alphabetically. Click on a label to see its associated content.

Using the Labels List Macro

**To add the Labels List macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

This macro has no parameters.

**Related Topics**

**Working with Macros**

Take me back to the Confluence User's Guide.

**Livesearch Macro**
The Livesearch macro allows you to add a search box to a Confluence page. When users enter a search term into the search box, Confluence will dynamically display matching results as they type.

**Using the Livesearch Macro**

**To add the Livesearch macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>none</td>
<td>Uniquely identifies the Livesearch when there are multiple Livesearch macros in one page.</td>
</tr>
<tr>
<td>Restrict to this Space Key</td>
<td>all spaces</td>
<td>Specify a space key to limit the search to the given space. Case-sensitive.</td>
</tr>
</tbody>
</table>

**Related Topics**

- **Searching Confluence**
- **Search Results Macro**
- **Working with Macros**

**Loremipsum Macro**

The Loremipsum macro displays paragraphs of pseudo-Latin text ([more information](#)). You can use this macro to generate more-or-less meaningless text for demonstration purposes in pages showing a draft layout or arrangement of page elements. The text is deliberately non-meaningful so that it does not influence the viewer's perception of the page arrangement or design.

A basic example of the Loremipsum text:
Using the Loremipsum Macro

To add the Loremipsum macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Paragraphs</td>
<td>3</td>
<td>The amount of pseudo-Latin (space-filler) text to display.</td>
</tr>
</tbody>
</table>

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Metadata Macro

The Metadata macro allows you to embed metadata into pages and blog posts for presentation with the Details Summary Macro. Each metadata item consists of a field name and an associated value. When a Metadata macro is rendered on a page, each metadata item is presented as a table row, with the field name followed by its value, for example:

<table>
<thead>
<tr>
<th>Is-Secret</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author-Nickname</td>
<td>Banana Split</td>
</tr>
</tbody>
</table>

The metadata added to a page using the Metadata macro is 'tagged', or identified, by adding a label to the page. This allows the Details Summary macro to generate a summary based on Metadata macros from all pages that have each had the same page label added to them.

Using the Metadata Macro

1. Add the Metadata macro to a page:
   a. In the Confluence editor, choose Insert > Other Macros.
   b. Find and select the required macro.
**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

2. **Add metadata items as rows in a table inserted into the macro placeholder.**

   For example, the screenshot below shows a table, with rows containing metadata items, in the macro's placeholder.

   ![Metadata Table](image)

<table>
<thead>
<tr>
<th>Is-Secret</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author-Nickname</td>
<td>Banana Split</td>
</tr>
</tbody>
</table>

3. **Add a label to the page to 'tag' the page.**

   For example, the current page has a 'test' label. This label is used by the example Detailssummary macro on the [Detailssummary Macro](#) page.

**Parameters**

This macro has no parameters.

**Related Topics**

- [Working with Macros](#)
- [Working with Confluence Labels](#)

Take me back to the [Confluence User's Guide](#).

**Multimedia Macro**

See [Embedding Multimedia Content](#).

**Navigation Map Macro**

The Navigation Map macro displays the list of pages associated with a specified label as a navigation map.

A label must be specified for this macro.

**Using the Navigation Map Macro**

**To add the Navigation Map macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>none</td>
<td>Specify the label associated with the pages you want to show in the navigation map.</td>
</tr>
<tr>
<td>Map Title</td>
<td>none</td>
<td>Specify a title for the navigation map.</td>
</tr>
<tr>
<td>Number of Cells Per Row</td>
<td>5</td>
<td>Specify the number of cells in a row</td>
</tr>
<tr>
<td>Cell Width (Pixels)</td>
<td>90 px</td>
<td>Specify the cell width</td>
</tr>
<tr>
<td>Cell Height (Pixels)</td>
<td>60 px</td>
<td>Specify the cell height</td>
</tr>
<tr>
<td>Navigation Map Theme</td>
<td>Confluence</td>
<td>Define a theme for the navmap.</td>
</tr>
</tbody>
</table>

If you want to create your own navmap 'look and feel' (for example, one with rounded corners), you need to add a customised navmap macro theme file to the `WEB-INF/classes/templates/macros` directory. The file name convention to use is `navmap-mytheme.vm`. Use the name of your choice for the `mytheme` part of the file name, which is also the value you use for this parameter. Hence, if your theme was called `navmap-roundededges.vm`, use the value of `rounded edges` for this parameter.

### Related Topics

- [Related Labels Macro](#)
- [Content by Label Macro](#)
- [Recently Used Labels Macro](#)
- [Working with Confluence Labels](#)
- [Working with Macros](#)
Network Macro

The Network macro displays a list of Network activity on a Confluence page or blog post. You can specify the user whose network activity you wish to show. These interactions include the users that the specified user is following or users who are following the specified user. The Network macro shows each listed user by their profile picture. It also provides a choice of two themes and the ability to limit the number of users in the list.

Screenshot: Network macro

Using the Network macro

To add the Network macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type \ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Current user's username</td>
<td>The username of the Confluence user whose network interactions you wish to show. If no username is specified, then current user's (that is, your) network interactions are shown.</td>
</tr>
</tbody>
</table>
| **Mode** | **following** | Determines which users are listed, with respect to the specified user:
|          |              |   - **following** – those who the user is following.
|          |              |   - **followers** – those who are following the user.
| **Theme** | **full** | Determines how the user’s network is displayed:
|          |              |   - **full** – shows a large version of user’s profile pictures and, if the **following** mode is set, provides an entry field function to follow more users.
|          |              |   - **tiny** – shows only the small version of user’s profile pictures.
| **Maximum Results** | **No limit imposed up to a maximum of 30** | Restricts the number of users displayed. If the number of users exceeds the specified maximum, then a **Show All** link is provided. This link leads to the specified user’s **Network view**, showing the complete list of network interactions.

**Disabling the Network macro**

The Network macro is provided by the 'network' module in the 'Profile Macros' plugin. To remove the macro from your site, you can disable the module in the plugin. See [Disabling or Enabling a Plugin](#).

**Noformat Macro**

The Noformat macro displays a block of text in monospace font with no other formatting.

**Using the Noformat Macro**

To add the Noformat macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Enter the content that is to be unformatted into the body of the macro placeholder.
Parameters
Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Panel</td>
<td>False</td>
<td>Removes the panel around the content.</td>
</tr>
</tbody>
</table>

Related Topics

**Working with Macros**

Take me back to the [Confluence User's Guide](#).

**Note Macro**

The Note macro allows you to highlight a note on a Confluence page.

It creates a yellow-coloured box surrounding your text:

**Note Macro Example**

This text is rendered inside the Note macro.

Using the Note Macro

To add the Note macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Add the text of the note to the body of the macro placeholder.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>If specified, the title is displayed in bold next to the icon.</td>
</tr>
</tbody>
</table>

**Show Exclamation Mark Icon**

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>• <strong>true</strong> – displays the warning icon</td>
</tr>
<tr>
<td>false</td>
<td>• <strong>false</strong> – the icon is not displayed</td>
</tr>
</tbody>
</table>

Related Topics

**Working with Macros**
Page Index Macro

The Page Index macro creates a hyperlinked alphabetical index of all page titles within the current space.

The top section of the index contains a cell for each letter of the alphabet, with cells for numbers and symbols. Each cell indicates how many pages are in the corresponding list.

The lower section contains lists of page titles followed by the first few sentences of content on that page.

Each letter, number or symbol in the top section is hyperlinked to the corresponding cell in the lower section. Each page title in the lower section is hyperlinked to the page in the space.

Using the Page Index Macro

To add the Page Index macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

This macro accepts no parameters.

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Page Tree Macro

The Page Tree macro displays a dynamic, hierarchical list of pages starting from a specified parent (root) page. It can act as a table of contents or a list of related topics.

When viewing the page tree, your reader can click a link to view the relevant page. The page's current position is highlighted in the page tree.

Creating a navigation panel for your space

The Page Tree macro is used in the Confluence Documentation theme, to create a navigation panel showing a table of contents for your space. Read the instructions on Configuring the Documentation Theme.

Using the Page Tree Macro

To add the Page Tree macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Click Refresh in the Macro Browser to see the effect of changes to the macro parameters.

Macro Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| Root Page                        | The home page of the space                                                                 | Specify the parent page for the page tree. The tree will include all children of the given page, plus their children and grand-children etc. The tree will *not* include the root page itself. Specify the page title or a special value as follows:  
  • Your page title — to specify a page name for the parent or root of the tree. The tree will include all children and grand-children of the specified root. The tree will *not* include the specified root page itself.  
  • '@home' — will include all pages under the home page of the space (default).  
  • '@self' — will include all pages under the current page.  
  • '@parent' — will include all pages under the parent of the current page, including the current page.  
  • '@none' — will include all pages in the space, including orphaned pages and the home page. |
| Sort Pages By | position | Specify the order to display the pages in the tree. This sort order is for display purposes only. It does not permanently re-arrange the page order. The value may be one of the following:  
  • bitwise — sort alphabetically, for example: title1, title10, title2.  
  • creation — sort by date of creation.  
  • modified — sort by order of date last modified.  
  • natural — sort in 'natural' alphabetical order, for example: title1, title2, title10.  
  • position — sort by the default Confluence sorting rules. If your pages have been ordered manually, this sort will respect the defined order. Otherwise the pages will be displayed in the 'natural' alphabetical order, such as: title1, title2, title10. |
Include Excerpts in Page Tree  |  false  |  Select if you want the page tree to show excerpts from each page. The excerpts must be defined on each page by the Excerpt macro.

Reverse Order  |  false  |  Select to show the pages in reverse (descending) natural order. Must be used in combination with the Sort Pages By parameter.

Include Search Box above Page Tree  |  false  |  Select if you want to include a search box above the page tree. The search box allows your readers to search within the page tree for the specified value.

Show Expand/Collapse Links  |  false  |  Select if you want to display the 'expand all' and 'collapse all' links at the top of your page tree. Your readers can click these links to open or close all branches of the tree at once.

Start Depth  |  1  |  Enter any number greater than 0 to set how many levels of children the tree should show when it opens for the first time.

Related Topics

Page Tree Search Macro
Adding a Navigation Sidebar
Working with Macros

Take me back to the Confluence User's Guide.

Sample Page Tree

This page is a sample, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the Page Tree Macro.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>{pagetree:root=@parent</td>
<td>expandCollapseAll=false}</td>
</tr>
</tbody>
</table>

Another Sample Page Tree

We're using this page to demonstrate the Pagetree macro.
For more information, take a look at the main page on the [Page Tree Macro](https://confluence.atlassian.com/display/C43/Page+Tree+Macro).

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

**Sample Page Tree 2**

This is another sample page, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the [Page Tree Macro](https://confluence.atlassian.com/display/C43/Page+Tree+Macro).

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

**Page Tree Search Macro**

Using the Page Tree Search macro, you can add a search box to your Confluence page. When a viewer enters a search term, Confluence will search a hierarchy of pages starting from a specified parent (root) page and return the search results.

You can also add a search box as part of a dynamic page tree, which looks like a table of contents. See the [Page Tree macro](https://confluence.atlassian.com/display/C43/Page+Tree+Macro).

Using the Page Tree Search macro

**To add the Page Tree Search macro to a page:**

1. In the Confluence editor, choose [Insert > Other Macros](https://confluence.atlassian.com/display/C43/Insert+Other+Macros).
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](https://confluence.atlassian.com/display/C43/Using+Autocomplete).

**To edit an existing macro:** Click the macro placeholder and choose [Edit](https://confluence.atlassian.com/display/C43/Edit). A macro dialog window will open, where you can edit the parameters of the macro.

**Related pages:**

- [Page Tree Macro](https://confluence.atlassian.com/display/C43/Page+Tree+Macro)
- [Adding a Navigation Sidebar](https://confluence.atlassian.com/display/C43/Adding+a+Navigation+Sidebar)
- [Working with Macros](https://confluence.atlassian.com/display/C43/Working+with+Macros)
- [Confluence User's Guide](https://confluence.atlassian.com/display/C43/Confluence+User%27s+Guide)

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Name of Root Page

| None |

The name of the root page whose hierarchy of pages will be searched by this macro. If this not specified, the root page is the current page.

**Note:** Unlike the Page Tree macro, the Page Tree Search macro does not accept the special values that start with an @ sign, such as @home or @self.

---

**Panel Macro**

The Panel Macro allows you to display a block of text within a customisable panel, like a text box. Here is an example:

```
My Title
A formatted panel.
```

**Using the Panel Macro**

**To add the Panel macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:*** Type `}` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Title</td>
<td>none</td>
<td>The title of the panel. If specified, this title will be displayed in its own title row.</td>
</tr>
<tr>
<td>Border Style</td>
<td>solid</td>
<td>The style of the panel's border. Accepted values are <strong>solid</strong>, <strong>dash</strong>, and other valid CSS border styles.</td>
</tr>
<tr>
<td>Border Colour</td>
<td></td>
<td>The colour of the panel's border.</td>
</tr>
<tr>
<td>Border Pixel Width (Value Only)</td>
<td></td>
<td>The width of the panel's border (in pixels).</td>
</tr>
</tbody>
</table>
Background Colour | The background colour of the panel.
Title Background Colour | The background colour of the title row of the panel.
Title Text Colour | The colour of the text in the title row of the panel.

Colours can be specified HTML colour names or hexadecimal codes.

Notes

- You can use panels within columns and table cells.

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Popular Labels Macro

The Popular Labels macro displays the most popular labels used throughout your Confluence site or within a space.

Using the Popular Labels Macro

To add the Popular Labels macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Labels to Display</td>
<td>100</td>
<td>Specifies the total number of labels to display in the heatmap.</td>
</tr>
<tr>
<td>Restrict Labels to this Space Key</td>
<td>none</td>
<td>Restricts the list of popular labels to the specified space.</td>
</tr>
</tbody>
</table>
### Style of Labels

| list | list – displays the popular labels as a bulleted list, ordered by popularity (highest first). |
| heatmap | heatmap – displays the popular labels using different font sizes for each label depending on the label's popularity, ordered by label names. |

### Related Topics

- **Using Label Macros to Categorise Wiki Content**
- **Related Labels Macro**
- **User-contributed extension: Sortable Popular Labels**

Take me back to the [Confluence User's Guide](#).

### Profile Picture Macro

The Profile Picture macro displays a user's profile picture on a page.

- When viewing the page, mouse-over the picture to see the [Hover Profile](#) for the user.
- When editing the page, click on the picture and choose [View User Profile](#) to see the [profile](#) for the user.

![Profile Picture](#)

The Profile Picture macro is useful for such tasks as creating Team Pages that show all members of a project team.

**On this page:**
- [Using the Profile Picture Macro](#)
- [Parameters](#)
- [Related Topics](#)

#### Using the Profile Picture Macro

**To add the Profile Picture macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.
### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space(s)</td>
<td>The space which contains the page on which the macro is added</td>
<td>Filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here. You can specify one or more space keys, separated by commas. &quot;*&quot; means all spaces.</td>
</tr>
<tr>
<td>Include these Content Types Only</td>
<td>all types</td>
<td>Filter content by type. You can specify one or more types, separated by commas. Available types are: page, blogpost or news, spacedesc, attachment, comment, mail, userinfo.</td>
</tr>
</tbody>
</table>

### Related Topics

- **Working with Macros**

- Take me back to the [Confluence User’s Guide](#)

### Recently Updated Dashboard Macro

The Recently Updated Dashboard macro displays a list of the most recently changed content within Confluence. It is similar to the Recently Updated macro but is intended for use on the Confluence dashboard.

#### Using the Recently Updated Dashboard Macro

**To add the Recently Updated Dashboard macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.
| **Label(s)** | none | Filter content by label. The macro will display only the pages etc which are tagged with the label(s) you specify here. You can specify one or more labels, separated by commas. 

*Note:* If there are no pages matching any of the specified labels, then Confluence will ignore the labels and will list all recently updated pages, as well as showing a message, “These labels don't exist and were ignored: xxx “. This unexpected behaviour is noted in issue CONF-13860. Authenticate to see issue details |
| **User(s)** | all users | Filter by username of the user who updated the content. The macro will only display content created and updated by the user(s) you specify here. You can specify one or more usernames separated by commas. |
| **Width of Table** | 100% | Specify the width of the macro display, as a percentage of the window width. |
| **Show User Profile Pictures** | false | Select whether profile pictures of the users who updated the content are displayed. |

**Related Topics**

- Recently Updated Macro
- Viewing Recently Updated Content
- Working with Macros

Take me back to the Confluence User’s Guide.

### Recently Updated Macro

The Recently Updated macro displays a list of the most recently changed content within Confluence.

* Tip: The Recently Updated Dashboard macro is similar to this macro, but is intended for display on the Confluence dashboard.

#### Using the Recently Updated Macro

**To add the Recently Updated macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.
**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Author(s) by username</strong></td>
<td>None specified i.e. display all content</td>
<td>Filter the results by author. The macro will display only the pages etc which were last modified by the author(s) you specify here. You can specify one or more authors, separated by a comma or a space.</td>
</tr>
</tbody>
</table>
| Space(s)                                           | @self, i.e. the space which contains the page on which the macro is used | This parameter allows you to filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here. You can specify one or more space keys, separated by a comma or a space.  

- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.  

- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)  

Special values:  

- @self — The current space.  
- @personal — All personal spaces.  
- @global — All global spaces.  
- @favorite — The spaces you have marked as favourite.  
- @favourite — The same as @favorite above.  
- @all — All spaces in your Confluence site.  
- * — The same as @all above.  

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com. |
| **Label(s)** | None specified i.e. display all content | Filter the results by label. The macro will display only the pages etc which are tagged with the label(s) you specify here. You can specify one or more label values, separated by a comma or a space.  
- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `badpage` you will get only content which is not labelled with 'badpage'.  
- To indicate that the results **must** match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `superpage,goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |
| **Width of Table** | 100% | Specify the width of the macro display, as a percentage of the window width. |
| Include these Content Types Only | all types | This parameter allows you to filter content by content type. The macro will display only the content of the type you specify here. You can specify one or more types, separated by a comma or a space. To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of `-blogpost` you will get pages and all other content except for blog posts. Available values:  
* page — Pages.  
* blogpost or news — Blog posts, also known as news items.  
* comment — Comments on pages and blog posts.  
* attachment — Attachments.  
* status — Status updates made by other users. |
| Maximum Number of Results | 15 | Specify the maximum number of results to be displayed. If this parameter is omitted, then a maximum of 15 results are displayed. The theoretical maximum value that this parameter can accept is 2 to the power of 31, minus 1 (or 2147483647), though this has been limited to 200 in the code, for performance reasons. More details are [here](#). |
### theme

| 'concise' with the heading 'Recently Updated' |

Choose the appearance of this macro:

- **concise** — the default list, showing the names of pages which were updated or commented on, the users who made the page modifications and time when the modifications occurred.
- **social** — lists recent modifications in reverse chronological order, but groups them by user into short time segments. A 'sub' list appears within each user's time segment, showing the names of pages which they updated or commented on and time when these modifications occurred.
- **sidebar** — lists recent updates in reverse chronological order, showing the names of pages which were updated or commented on and time when the page modifications occurred. This theme does not show authorship.

### Show User Profile Pictures

| false |

Specify `showProfilePic=true` to display the profile pictures of the users who updated the content.

### Customising the wording

If you would like to change the wording displayed by the Recently Updated macro, please refer to the document on modifying the Confluence interface text.

### Related Topics

- Recently Updated Dashboard Macro
- Viewing Recently Updated Content
- Working with Macros

Take me back to the Confluence User's Guide.

### Recently Used Labels Macro

The Recently Used Labels macro displays a list of the labels that have been most recently added to a page, blog post or attachment. You can define the number of labels to be displayed and the scope (global spaces, your personal space, or the current space).

#### Using the Recently Used Labels Macro

**To add the Recently Used Labels macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### On this page:
- Using the Recently Used Labels Macro
- Parameters of this macro

### Related pages:
- Related Labels Macro
- Content by Label Macro
- Recently Used Labels Macro
- Working with Confluence Labels
- Working with Macros
- Confluence User's Guide

### Parameters of this macro

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Labels to Display</td>
<td>10</td>
<td>Specifies the total number of labels to display in the list.</td>
</tr>
</tbody>
</table>
| Scope for Retrieving Labels| global  | Specifies the scope of labels to be displayed in the list. Valid values include:
|                            |         | • global — covers all non-personal spaces in the Confluence installation.
|                            |         | • space — the current space.
|                            |         | • personal — your own personal space. |
| List Style                 | list    | • list – displays the list of labels horizontally.
|                            |         | • table – includes additional information such as the page to which the label was added and the user who added it. |
| Table Title                | none    | Adds a title to the top of the list in table style. Titles are only visible when the List Style parameter has been set to table. |

**Related Labels Macro**
The Related Labels macro lists all labels from every page which has one or more labels in common with the current page.

**Using the Related Labels Macro**

**To add the Related Labels macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to these Labels</td>
<td>none</td>
<td>Specify the labels for which you want to view related labels. For example, documentation, my:stuff.</td>
</tr>
</tbody>
</table>

**Related Topics**

- [Navigation Map Macro](#)
- [Content by Label Macro](#)
- [Recently Used Labels Macro](#)
- [Working with Confluence Labels](#)
- [Working with Macros](#)

Take me back to the [Confluence User's Guide](#).

**RSS Feed Macro**

The RSS Feed macro embeds an [RSS feed](#) on a page. It can display the contents of external feeds, or of internal feeds generated by Confluence. To display blog posts or to list recently updated pages in a space, use the [Feed Builder](#) to create an internal feed, then render it using this macro.

⚠️ **CAUTION:** Including unknown HTML inside a webpage is dangerous.

HTML inside an RSS feed can contain active scripting components. This means that it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user’s authentication cookie and give the attacker their Confluence login password.

The RSS Feed macro will only be available if it has been enabled by your Confluence administrator. Also, your Confluence administrator can define a [whitelist of trusted URLs](#). You will see an error message on the Confluence page, if the included URL is not in the whitelist.

⚠️ The information on this page does not apply to Confluence OnDemand.
Using the RSS Feed macro

To add the RSS Feed macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSS Feed URL</td>
<td>none</td>
<td>The URL of the RSS feed link you want to show.</td>
</tr>
<tr>
<td>Maximum Number of Entries</td>
<td>15</td>
<td>Limit the number of entries displayed.</td>
</tr>
<tr>
<td>Show Item Titles Only</td>
<td>false</td>
<td>Show only the titles of the news items, not the content.</td>
</tr>
<tr>
<td>Show Name/Title of RSS Feed</td>
<td>true</td>
<td>Hide the feeds title bar.</td>
</tr>
</tbody>
</table>

How up to date is the feed?

By default, the RSS Feed macro caches the feed results for 60 minutes before fetching the data again.

If you wish to change the default caching, use the Cache macro to define how often the RSS Feed macro fetches the feed updates. You will need to install the Cache plugin onto your Confluence site.

What happens to a page containing a disallowed URL?

Your Confluence Administrator can set up a whitelist of allowed URLs. If this is the case, you may see an error on the pages which contain the RSS Feed macro.

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence “could not access the content at the URL because it is not from an allowed source” and displays the offending URL. If the person viewing the page is a Confluence Administrator, they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:
Authentication

**Privatefeeds from external sites**

RSS feeds which require authentication cannot be accessed using the RSS Feed macro.

**Accessing internal HTTPS feeds**

This applies only to Confluence instances which have enabled HTTPS for all content. If your site is fully HTTPS, the RSS Feed macro cannot access internal feeds. To enable the RSS Feed macro to access internal feeds without affecting your HTTPS setup, enable local-only HTTP access:

1. Shut down Confluence.
2. Consult the [SSL guide](#) to enable HTTP access to Confluence. You'll want to ensure that you have an HTTP connector and an SSL connector, both commented in. This means that Confluence will be accessible via both HTTP and HTTPS. However, you should not have a redirect port, nor rules in web.xml to redirect all traffic.
3. Instead of using web.xml to redirect traffic, insert a firewall rule to redirect all HTTP requests not from the Confluence server to the equivalent HTTPS URL. This ensures that users will only be able to access Confluence via HTTPS, as intended. If you have still left HTTP access for attachments enabled (to avoid the IE download bug) you must selectively enable those URLs as well.
4. Modify your Confluence RSS Feed macro feed link to use the HTTP URL, and restart Confluence.

Enabling and disabling the RSS Feed macro

The RSS Feed macro is a module of the Confluence HTML Macros plugin.

**To enable or disable the RSS Feed macro:**

1. Enable the [Confluence HTML Macros](#) plugin by following the instructions in [Enabling HTML macros](#).
2. In the plugin module list of the HTML macros, find the [RSS](#) module and hover your cursor over it to enable or disable it.

Related Topics

- [Subscribing to RSS Feeds within Confluence](#)
- [Managing Changes and Notifications and Tasks](#)
- [Working with Macros](#)
- [Configuring a URL Whitelist for Macros](#)
- [Confluence User's Guide](#)

Search Results Macro
The Search Results macro searches your Confluence site based on search terms specified in the macro code, and displays the results on the wiki page.

**Using the Search Results Macro**

**To add the Search Results macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search Terms</strong></td>
<td>none</td>
<td>The search terms which this macro will use to generate its results. You can refine your search query by using operators such as 'AND' and 'OR'. For example: <code>my_query1 AND my_query2</code> For more information, take a look at the documentation on the <a href="#">Confluence search syntax</a>.</td>
</tr>
<tr>
<td><strong>Maximum Number of Results</strong></td>
<td>10</td>
<td>Set a limit to the number of search results displayed.</td>
</tr>
<tr>
<td><strong>Restrict to this Space Key</strong></td>
<td>all</td>
<td>Specify the key of the space you want to search in. Note that this is case-sensitive.</td>
</tr>
<tr>
<td><strong>Content Type</strong></td>
<td>all</td>
<td>Specify the content type. The content types are: <code>page</code>, <code>comment</code>, <code>blogpost</code>, <code>attachment</code>, <code>userinfo</code> (the content of user profiles only) and <code>spacedesc</code> (the content of space descriptions only).</td>
</tr>
</tbody>
</table>
| Last Modified | all | Specify a period of time in weeks, days, hours and/or minutes, to see the content modified within that time frame. For example:
- 2h 35m
- 3d 30m
These are the values you can use:
- w = weeks
- d = days
- h = hours
- m = minutes
If no time category is specified, Confluence assumes minutes. If you specify more than one time period (e.g. weeks and days), the periods must be separated by a space and they can come in any order. The time categories are not case sensitive e.g. ‘4d’ is the same as ‘4D’.

| Restrict to this Username | all | Specify the username of a Confluence user, to show only content created or updated by that user.

---

**Permissions**

When a user views the page containing the Search Results macro, the search results will show only pages and other content types for which the user has 'View' permission.

**Related Topics**

- [Livesearch Macro](#)
- [Searching Confluence](#)
- [Working with Macros](#)

Take me back to the Confluence User's Guide.

**Section Macro**

**Used with the Column macro to define columns on a page.** See [Working with page layouts and columns and sections](#).

**Space Attachments Macro**

See [Displaying a List of Attachments](#).

**Space Details Macro**

The Space Details macro renders the space's details in a table within the page.

[Using the Space Details Macro](#)
To add the Space Details macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width of Table</td>
<td>100%</td>
<td>The width of the space details table, specified as a percentage (%) of the page width.</td>
</tr>
</tbody>
</table>

Related Topics

Editing Space Details
Working with Macros

Take me back to the Confluence User's Guide.

Space Jump Macro

This page describes the Space Jump Macro, which is provided with the Documentation theme. You can use space jumping to link from a page in one space to a page with the same name in another space, without knowing the name of the page when you create the link.

The Space Jump macro inserts a link onto the page. When the reader clicks the link, they will jump to a page that has the same name in another space. You specify the space when you insert the Space Jump macro.

Example: We use the Space Jump macro to put a standard message at the top of our archive spaces, telling people that they’re reading an old version of the documentation and letting them jump quickly to the same page in the latest documentation. See the words ‘this page in the current documentation’ in the screenshot below.

Screenshot: One way of using the Space Jump macro

This documentation relates to an earlier version of Confluence. View this page in the current documentation or visit the current documentation home.

Configuring the Documentation Theme

Using the Space Jump Macro

To add the Space Jump macro to a page:
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>None</td>
<td>The space key that contains a page with the same page title that you want the link to jump to. Space keys are case-sensitive.</td>
</tr>
<tr>
<td>Alias</td>
<td>None</td>
<td>The text to display as the hyperlinked text. If you do not supply an alias, Confluence will display the page name.</td>
</tr>
</tbody>
</table>

**More Information**

**What happens if there is no page with the same name in the target space?**

For the space jump to work, the target space must contain a page with the same name as the page that renders the Space Jump macro. If the target space does not contain such a page, you will see a broken link. Confluence handles this in its usual manner: the link is coloured red. If you click the link, Confluence offers to create the page for you.

**Can I use the Space Jump macro in any space?**

Yes. You can use the Space Jump macro in any space, even if that space is not currently using the Documentation theme. Provided that the Documentation theme plugin and its components are installed and enabled on your Confluence site, the Space Jump macro is available in any space.

**Related Topics**

- Configuring the Documentation Theme
- Working with Macros

Take me back to the Confluence User's Guide.

**Spaces List Macro**

The Spaces List macro is used to display a list of spaces within a page, similar to the list of spaces seen on the dashboard.

**Using the Spaces List Macro**

**To add the Spaces List macro to a page:**
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scope of spaces</strong></td>
<td>no</td>
<td>all</td>
<td>Specify the view from which spaces are listed. Available options are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><em>all</em> – All spaces in the Confluence installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><em>category</em> – Spaces grouped according to space categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><em>favourite</em> – Spaces which you have added to your favourites list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><em>new</em> – New spaces which have been created within the last 7 days.</td>
</tr>
<tr>
<td><strong>Width of List</strong></td>
<td>no</td>
<td>100%</td>
<td>Specify the width of the table. The width of the spaces list table,</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>specified as a percentage (%).</td>
</tr>
</tbody>
</table>

### Related Topics

- [Working with Spaces](#)
- [Creating a Page](#)
- [Working with Macros](#)
- [Confluence User's Guide](#)

### Status Macro

The Status macro displays a coloured lozenge (a rounded box) that is useful for reporting project status. You can choose the colour of the lozenge and the text that appears inside the lozenge. The macro also displays its current status in the editor, and you can change the status directly in the editor.

**All good!**

**Screenshot:** Click on the Status macro lozenge to change the status.
Using the Status Macro

To add the Status macro to a page using the Macro Browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour</td>
<td>Grey</td>
<td>The colour of the lozenge and its border. The border will be a darker version of the same colour. The following colours are available: Grey, Red, Yellow and Green.</td>
</tr>
<tr>
<td>Title</td>
<td>The colour that you select.</td>
<td>The text that will appear inside the lozenge. If you do not specify any text, the title will be the colour of the lozenge, that is 'Grey', 'Red', 'Yellow' or 'Green'.</td>
</tr>
</tbody>
</table>

Related Topics

Working with Macros

Take me back to the Confluence User's Guide

Table of Contents Macro

The Table of Contents macro scans the headings of the current Confluence page to dynamically create a table of contents from your page headings. This helps readers navigate lengthy pages by summarising the content structure and providing links to headings. Headings are indented progressively.

Using the Table of Contents Macro
Hint: For quick access from the editor toolbar, choose Insert > Table of Contents.

To add the Table of Contents macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>list</td>
<td>• <strong>list</strong> — produces a typical list type TOC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>flat</strong> — produces a horizontal menu-type series of links.</td>
</tr>
<tr>
<td>Display Section Numbering</td>
<td>clear</td>
<td>Select the check box to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3.</td>
</tr>
</tbody>
</table>
| **List Style** | none | Select the style of bullet point for each list item. You can use any valid CSS style. For example:  
  * none — no list style is displayed  
  * circle — the list style is a circle  
  * disc — the list style is a filled circle. This is the typical bullet list, and is used for this example list.  
  * square — the list style is a square  
  * decimal — the list is numbered (1, 2, 3, 4, 5)  
  * lower-alpha — the list is lower-case, alphabetised (a, b, c, d, e)  
  * lower-roman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
  * upper-roman — the list style is upper roman numerals (I, II, III, IV, V, VI) |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heading Indent</strong></td>
<td></td>
<td>Sets the indent for a list according to CSS quantities. Entering 10px will successively indent heading groups by 10px. For example, level 1 headings will be indented 10px and level 2 headings will be indented an additional 10px.</td>
</tr>
</tbody>
</table>
| **Separator** | brackets | This parameter applies to flat lists only. You can enter any of the following values:  
  * brackets — Each item is enclosed by square brackets: [ ].  
  * braces — Each item is enclosed by braces: { }.  
  * parens — Each item is enclosed by parentheses: ( ).  
  * pipe — Each item is separated by a pipe:  
  * anything — Each item is separated by the value you enter. You can enter any text as a separator, for example "***". If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
<table>
<thead>
<tr>
<th>Minimum Heading Level</th>
<th>1</th>
<th>Select the highest heading level to start your TOC list. For example, entering 2 will include levels 2, and lower, headings, but will not include level 1 headings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Heading Level</td>
<td>7</td>
<td>Select the lowest heading level to include. For example, entering 2 will include levels 1 and 2, but will not include level 3 headings and below.</td>
</tr>
<tr>
<td>Include Headings</td>
<td></td>
<td>Filter headings to include according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td></td>
<td>Filter headings to exclude according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.</td>
</tr>
<tr>
<td>Printable</td>
<td>checked</td>
<td>By default, the TOC is set to print. If you clear the check box, the TOC will not be visible when you print the page.</td>
</tr>
<tr>
<td>CSS Class Name</td>
<td></td>
<td>If you have custom TOC styles in your CSS style sheet, use this parameter to output the TOC inside <code>&lt;div&gt;</code> tags with the specified class attribute.</td>
</tr>
</tbody>
</table>

**Examples**

The examples below are based on this table of contents:

1. **Places**
   1. Favourite Places
   2. Unknown Places
2. **Foods**
   1. Favourite Foods
   2. Unknown Foods
3. **Things**
   1. Favourite Things
   2. Unknown Things
Filtered Table of Contents

This example filters the headings to include those that contain 'Favourite', but excludes headings which end with 'Things'. The list is styled with Roman numerals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

The resulting table of contents is:

I. Favourite Places
II. Favourite Foods

Flat List

This example filters all headings to render a flat list of 'Unknowns' enclosed in square brackets (the default list style).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>flat</td>
</tr>
<tr>
<td>Maximum Heading Level</td>
<td>2</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Unknown.*</td>
</tr>
</tbody>
</table>

The resulting table of contents is:

[ Unknown Places ] [ Unknown Foods ] [ Unknown Things ]

Code examples

See:

- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)

Notes

- When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template – the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)

- Due to an outstanding issue in the Table of Contents macro ([CONF-10619](#)), the macro browser's Refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Contents macro occurs only after the page is saved.
• **Using HTML Heading Markup with the Table of Contents Macro**

The Table of Contents macro cannot handle HTML heading markup on its own. Hence, if you use the HT ML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Contents macro will not create a contents list out of these headings. (For more information about this issue, please refer to TOC-93.)

However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Contents macro will incorporate these headings into your contents list.

```html
<h2><a name="pagename-headingname"></a>Heading Name</h2>
```

The syntax for the anchor name is the page name and heading name separated by a hyphen, in which the page and heading names have all spaces removed and are converted to lowercase. If punctuation marks occur within a page or heading name, each mark should usually be converted to its URL escape code in the anchor name.

**Table of Content Zone Macro**

The Table of Content Zone macro enables you to mark out a 'page zone' from which to create a table of contents. Styling the headings as a flat list enables you to enclose the page text by top and bottom navigation bars similar to web navigation. When styled as a list, headings are indented progressively.

**On this page:**
- Using the Table of Content Zone Macro
- Parameters
- Examples
  - Filtered Table of Contents
  - Flat List
- Notes
- Related Topics

### Using the Table of Content Zone Macro

**To add the Table of Content Zone macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

**Example:**

```html
<h2><a name="pagename-headingname"></a>Heading Name</h2>
```
| **location** | both | Specifies where in the zone the output list is displayed: **top**, **bottom**, or **both**, which encloses the page zone content. |
| **Output Type** | list | Specifies the layout for the table of contents:  
  - **list** – produces a vertical list, typical of a TOC.  
  - **flat** – produces a horizontal menu-type series of links, for example: [Heading 1] [Heading 2] [Heading 3]. |
| **Display Section Numbering** | false | Select to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3. |
| **List Style** | none | Specifies the style of bullet point for each list item. You can use any valid CSS style. For example:  
  - **none** — no list style is displayed  
  - **circle** — the list style is a circle  
  - **disc** — the list style is a filled circle. This is the typical bullet list, and is the one we’re using for this example list  
  - **square** — the list style is a square  
  - **decimal** — the list is numbered (1, 2, 3, 4, 5)  
  - **lower-alpha** — the list is lower-case, alphabetised (a, b, c, d, e)  
  - **lower-roman** — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
  - **upper-roman** — the list style is upper roman numerals (I, II, III, IV, V, VI) |
| **Heading Indent** | | Sets the indent for a list output type, according to CSS quantities. Entering "10px" will successively indent list heading levels by 10px. For example, h1 headings will be indented 10px and h2 headings will be indented an additional 10px. |
| **Separator** | brackets | Only applies to the flat output type. Specifies the display style of the links. You can enter any of the following values:

- **brackets** — Each item is enclosed by square brackets: [ ].
- **braces** — Each item is enclosed by braces: { }.
- **parens** — Each item is enclosed by parentheses: ( ).
- **pipe** — Each item is separated by a pipe:
- **anything** — Each is separated by the value you enter. You can enter any text as a separator, for example "***". If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
| **Minimum Heading Level** | 1 | Select the largest heading level to start your TOC list. For example, 2 will list h2, h3, and h4 headings, but will not include h1 headings. |
| **Max Heading Level** | 7 | Select the smallest heading level to include in the TOC. For example, 2 will list h1 and h2, but will not include h3 and below. |
| **Include Headings** |  | Filter the included headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings. |
| **Exclude Headings** |  | Exclude headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings. |
| **Printable** | true | By default, the TOC is set to print. If you clear this parameter, the TOC will not be visible when you print the page. |
| **CSS Class Name** |  | If you have a custom TOC in your CSS style sheet, you can use this parameter to output the TOC with the specified "class" attribute. |
Examples

The examples are based on a page with the following headings:

1. Places
   1. Favourite Places
   2. Unknown Places
2. Foods
   1. Favourite Foods
   2. Unknown Foods
3. Things
   1. Favourite Things
   2. Unknown Things

Filtered Table of Contents

This example will filter all headings to include those that contain "Favourite", but will exclude any heading which ends with the word "Things". The list is styled with upper-case Roman numerals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>list</td>
</tr>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

Screenshot: Filtered TOC 'zone' headings

- Favourite Places
- Favourite Foods

Flat List

This example will filter all headings to render a flat list of "Unknowns" enclosed in square brackets.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>flat</td>
</tr>
<tr>
<td>Separator</td>
<td>brackets</td>
</tr>
<tr>
<td>Max Heading Level</td>
<td>2</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Unknown.*</td>
</tr>
</tbody>
</table>

Screenshot: Filtered TOC 'zone' headings displayed as a flat list

[ Unknown Places ] [ Unknown Foods ] [ Unknown Things ]
Notes

- Due to an outstanding issue in the Table of Content Zone macro (CONF-10619), the Macro Browser’s Refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Content Zone macro occurs only after the page is saved.
- Using HTML Heading Markup with the Table of Content Zone Macro — The Table of Content Zone macro cannot handle HTML heading markup on its own. Hence, if you used the HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Content Zone macro will not create a contents list out of these headings. (For more information on about this issue, please refer to TOC-93.)

However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Content Zone macro will incorporate these headings into your contents list.

```html
<h2><a name="pagename-headingname"></a>Heading Name</h2>
```

The syntax for the anchor name is usually the page name and heading name separated by a hyphen, in which the page and heading names have all spaces removed and are converted to lowercase. If punctuation marks occur within a page or heading name, each mark should usually be converted to its URL escape code in the anchor name.

Related Topics

- Table of Contents Macro
- Page Tree Macro
- Adding a Navigation Sidebar
- Working with Macros

Take me back to the Confluence User's Guide.

Tasklist Macro

The Tasklist macro allows you to create and update a list of tasks on the wiki page. Users viewing the page can modify the tasks without having to edit the page, provided they have the required permissions to modify the page.

You may also be interested in the lightweight task list that you can add directly onto your page, via the editor insert menu. This method also allows you to notify users that tasks have been assigned to them. See Managing Tasks in Confluence.

Using the Tasklist macro

To add the Tasklist macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>'Task List'</td>
<td>The name of the task list. This is displayed as the title above the list of tasks.</td>
</tr>
<tr>
<td>Width of List</td>
<td>530px</td>
<td>The width of the task list.</td>
</tr>
<tr>
<td>Enable Locking</td>
<td>clear</td>
<td>When selected, you can lock individual tasks so that they cannot be changed. See instructions below on editing the task list.</td>
</tr>
<tr>
<td>Prompt on Delete</td>
<td>clear</td>
<td>When selected, the user must confirm the deletion of a task in the list.</td>
</tr>
</tbody>
</table>

Editing the task list while viewing a page

While viewing a page, you can change the tasks in a task list as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a task</td>
<td>Type the task description in the box under the list title, and click Add.</td>
</tr>
<tr>
<td>Completing/uncompleting a task</td>
<td>Click the check box next to a task to mark the task as complete. The task name will become a lighter color and the progress bar will be updated. Clear the check box to mark the task as uncompleted. You can also click Uncheck all to mark all tasks as uncompleted.</td>
</tr>
</tbody>
</table>
## Editing a task
Move your cursor over the task and click the edit icon (pencil) that appears to the right of the task. The task name will become editable and the edit icon will be replaced with a save icon. Make your change and press the ‘Enter’ key to save or click the save icon.

## Deleting a task
Move your cursor over the task and click the delete icon (trash can) that appears to the right of the task.

## Viewing details of a task
Click the arrow icon to the left of the task name. The task details will open in an expanded view.

## Locking a task
Provided that the **Enable Locking** parameter has been selected, you can click the lock icon to prevent the task from being edited, deleted, or otherwise changed.

## Changing the priority
When the task details are visible, click the appropriate option — **High**, **Medium** or **Low**.

## Assigning the task
When the task details are visible, change the assignee of the task by typing in or searching for a username.

---

### Screenshot: Task List showing task details

**Planning a Holiday**

- [ ] Book tickets
- [ ] Check passport expiry
  - Priority: [ ] High  [ ] Medium  [ ] Low
  - Assigned To: smaddox
  - Created: Mar 26, 2008
- [ ] Apply for visa
- [ ] Buy suitcases

**Sort by:** Custom

### Sorting the tasks

There are two ways to sort the tasks in the list:

- Using the **Sort by** list.
- Using drag and drop.

**Select one of the sort options from the 'Sort by' list:**
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>This is the default option.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sort the list in order of the priority you have allocated to each task.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Sort the list in order of the dates upon which the tasks were created.</td>
</tr>
<tr>
<td>Completed</td>
<td>Move all completed tasks to the bottom or top of the list.</td>
</tr>
<tr>
<td>Name</td>
<td>Sort the list in order of the task names.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Sort the list in order of the usernames assigned to the tasks.</td>
</tr>
</tbody>
</table>

Once you have selected a sort option, use the icon beside the **Sort by** box to reverse the sort order.

**Dragging and dropping a task into a new position:**

Drag a task up or down the list using the ‘drag me’ handle to the right of the task name. Make sure the task is positioned to the left of the existing tasks. A space will open and you will be able to drop the task into its new position.

**Viewing the progress on tasks completed**

The bar at the top of the task list displays two different colours, indicating the percentage of tasks completed.

**Screenshot: Progress Bar on Task List**

![Planning a Holiday](image)

**Notes**

- It is not possible to add a due date to the task list. If you interested in this improvement request, you can comment on or vote for this issue: [CONF-7371 - Authenticate](CONF-7371) to see issue details.
- The Tasklist macro does not notify users that a task has been assigned to them. But you can do that using the lightweight task list accessible from the editor tool bar. See [Managing Tasks in Confluence](Managing%20Tasks%20in%20Confluence).
Tip Macro
Using the Tip macro, you can highlight a helpful tip on a Confluence page. The macro creates a green-coloured box surrounding your text as shown below.

This text is rendered inside the tip macro.

Using the Tip macro

To add the Tip macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

On this page:
- Using the Tip macro
- Parameters

Related pages:
- Working with Macros
- Info Macro
- Note Macro
- Warning Macro
- Panel Macro
- Styling Confluence with CSS
- Error Box Macro - Example of a User Macro
- Confluence User's Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the tip. If specified, it will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Tip Icon</td>
<td>true</td>
<td>If cleared, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

User List Macro

The User List macro displays a list of users registered in Confluence, based on their group membership. See also Configuring the User List Macro.
Using the User List Macro

To add the User List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group(s)</td>
<td>none</td>
<td>Specifies one or more groups whose Confluence users you want to list, using a comma-separated list of group names. To see all users registered in a Confluence installation, specify an asterisk ('*') for this parameter's value.</td>
</tr>
<tr>
<td>Display Online/Offline Users</td>
<td>none</td>
<td>Select to generate a list of online users. Clear to generate a list of offline users. In order to make this feature functional, a System Administrator needs to enable the User Log In Listener for your Confluence site.</td>
</tr>
</tbody>
</table>

**List of online users can be misleading**

When the **Display Online** parameter is used, Confluence uses a context listener to generate the list of online users. A context listener is a J2EE term for something that listens for events in the application server. We listen for session open and close events, so a user is 'online' if they have a session on the application server. Some application servers don't correctly despatch close events for sessions – in these cases, the list of online users may be misleading.

Related Topics

- Working with Macros
- Configuring the User List Macro in the Confluence Administrator's Guide
- Take me back to the Confluence User's Guide.

User Profile Macro
The User Profile macro displays a short summary of any Confluence user's profile on your Confluence page or blog. This is the same summary that appears in a Hover Profile, which appears whenever you mouse-over any user's name in the Confluence interface.

![Screenshot: Example of the User Profile Macro](image)

Using the User Profile Macro

To add the User Profile macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The username of the Confluence user whose profile summary you wish to show.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Working with Macros
- Take me back to the Confluence User's Guide.

User Status List Macro

The User Status List macro displays a history of any Confluence user’s status updates on your Confluence page or blog. This is the same history that appears in the user’s Status Updates view.

![Screenshot: Example output of the User Status List macro](image)
Using the User Status List Macro

To add the User Status List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The username of the Confluence user whose history of status updates you wish to show.</td>
</tr>
</tbody>
</table>

If you wish to list status updates made by more than just one user, you can use the Recently Updated macro with the following parameter-value combinations:

- Include these Content Types Only — status
- Author(s) by username — the user(s) whose status updates you want to include in the list. If you leave this field blank, the status updates of all users will be included.

Related Topics

Working with Macros
User Status Updates
Take me back to the [Confluence User's Guide](#).

**View File Macro**

The View File macro allows you to embed an Office or PDF document into your Confluence page. First attach the document to a wiki page and then use one of the View File macros to display the document's content.

When users view the page, they will see the content of the Office document. Users do not need to have Office installed in order to see the content of the Office document. If they do have Office installed, users will be able to open the document for editing in their Office application.

For a full list of Office Connector prerequisites and limitations, please refer to:

- [Office Connector Prerequisites](#)
- [Office Connector Limitations and Known Issue](#)

For an overview of all Office Connector features, please refer to [Working with the Office Connector](#).

**On this page:**

- Displaying an Office or PDF Document in Confluence
- Parameters for the Office and PDF Macros
- Editing a Word Document or Excel Spreadsheet
- Troubleshooting
- Related Topics

### Displaying an Office or PDF Document in Confluence

To display an Office or PDF document in a page, use one of the following View File macros in the macro browser:

- Office Excel
- Office Powerpoint
- Office Word
- PDF

To add one of the View File macros to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters for the Office and PDF Macros

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All View File macros</td>
<td>Page Name</td>
<td>The page which contains the macro</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------</td>
<td>----------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enter a page name, if you wish to display a document which is attached to another Confluence page.</td>
<td></td>
</tr>
<tr>
<td>File Name</td>
<td>none</td>
<td>The file name of the Office or PDF document to be displayed. The document must be attached to a page on your Confluence site.</td>
<td></td>
</tr>
<tr>
<td>Office Excel</td>
<td>Show Grid?</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select to show grid lines around each cell of the Excel spreadsheet. Clear to hide these grid lines.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Worksheet Name</td>
<td>Last worksheet viewed in the spreadsheet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last Row</td>
<td>Last row with content</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last Column</td>
<td>Last column with content</td>
<td></td>
</tr>
<tr>
<td>Office Powerpoint</td>
<td>Height</td>
<td>Specify the height of the display, in pixels (default) or as a percentage of the window's height.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slide Number</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the number of the slide that you want displayed on the Confluence page, where the first slide is numbered zero. Instead of a slide show, the page will display just the single slide, represented as a JPEG image.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Width</td>
<td>Specify the width of the display, in pixels (default) or as a percentage of the window's width.</td>
<td></td>
</tr>
</tbody>
</table>
Reducing the size of the spreadsheet

Use the **Last Column** and **Last Row** parameters to reduce the size of the spreadsheet displayed on the wiki page. This is especially useful to prevent the display from showing empty cells. This will also help to prevent 'out of memory' errors.

Presentation display options

By default, a presentation is displayed as a dynamic slide show, using Adobe Flash Player. However, you can use the **Slide Number** parameter to display just one of the slides as a static JPEG image.

Editing a Word Document or Excel Spreadsheet

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence by clicking the title bar of the document.

You will find detailed instructions in [Editing an Office Document from Confluence](#).

Troubleshooting

Problems? Please refer to our guide to the [Office Connector limitations and known issues](#).

Related Topics

- [Working with the Office Connector](#)
- [Working with Macros](#)

Take me back to the [Confluence User's Guide](#).

Warning Macro

The Warning macro allows you to highlight a warning note on a Confluence page.

It creates a red-coloured box surrounding your text as shown below.

Warning Macro Example

This text is rendered inside the warning macro.

Using the Warning Macro

**To add the Warning macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the warning note. If specified, will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Warning Icon</td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

Related Topics

**Working with Macros**

Take me back to the [Confluence User's Guide](#).

**Widget Connector Macro**

The Widget macro, or Widget Connector, allows you to embed certain multimedia content from other web sites into your Confluence page.

It supports the following content:

- Gadgets and other widgets: [Google Gadgets](#), [Widgetbox](#).
- Videos: [YouTube](#), [MySpace Video](#), [Yahoo Video](#), [Dailymotion](#), [Episodic](#), [Vimeo](#), [Metacafe](#), [blip.tv](#), [Viddler](#).
- Photos and images: [Flickr](#), [Skitch.com](#).
- Micro-blogging: [Twitter](#), [FriendFeed](#), [BackType](#).
- Documents and presentations: [SlideShare](#), [SlideRocket](#), [Scribd](#), presentations on [Google Docs](#).
- Calendars: [Google Calendar](#).
- Forms and online databases: [Wufoo HTML Form Builder](#), [Dabble DB](#).
- Support and customer satisfaction: [Get Satisfaction](#).

There are live examples of many of these on the [widget examples page](#). If you wish to extend the functionality of this plugin, please see [Extending the Widget Connector](#).

**On this page:**

- [Using the Widget Connector](#)
- [Parameters](#)
- [Live Example of Flickr Photos](#)
- [Live Example of Google Gadget](#)
- [More Examples of Macro Code](#)
- [Troubleshooting](#)
- [Related Topics](#)

**Using the Widget Connector**

**To add the Widget Connector to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**
Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site’s Widget URL</td>
<td>This is the URL provided by the external web site for embedding content from that web site onto another web page.</td>
</tr>
<tr>
<td>Pixel Height (Value Only)</td>
<td>Specify the height of the display, in pixels.</td>
</tr>
<tr>
<td>Pixel Width (Value Only)</td>
<td>Specify the width of the display, in pixels.</td>
</tr>
</tbody>
</table>

**Live Example of Flickr Photos**

This example displays all photos from Flickr with the tag ‘Atlassian’. It uses this URL: [http://www.flickr.com/photos/tags/atlassian/](http://www.flickr.com/photos/tags/atlassian/)

**Live Example of Google Gadget**


**More Examples of Macro Code**

**Google Gadgets**

You need to find the URL for the Google Gadget you want to display.

Here is one way to find a gadget's URL:

1. Go to the [Google Gadgets directory](http://www.google.com/ig/directory).
2. Find the gadget you want then click its name, such as 'Spider'.
3. The gadget's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![Example URL](http://www.google.com/ig/directory?synd=open&num=24&url=http://abowman.googlepages.com/spider.xml&output=html)

You can also use the URL of the 'add gadget' page. The page is called 'Add "gadgetx" to your iGoogle page':

1. There are a couple of ways to get to the 'add gadget' page:
   - Click a '+Google' button underneath the gadget when displayed on a page somewhere.
   - Or click 'Add Stuff' on your iGoogle page.
2. Copy the URL from your browser's address bar. The URL would look something like this one:

   ![Example URL](http://www.google.com/ig/add?synd=open&source=ggyp&moduleurl=abowman.googlepages.com/spider.xml)

**Widgetbox widgets**
You will need to find the URL for the Widgetbox widget you want to display.

Here is one way to find a widget's URL:

1. Ensure you are logged in to Widgetbox and that you are viewing the Widgetbox Gallery.
2. Find the widget you want then click its name, such as 'cyber-pet'.
3. The widget's summary page will open. Within the Get Widget section, click the Atlassian Confluence icon. The Widgetbox Add to Confluence dialog box appears, containing the URL required for the Add to Confluence Widget Macro.

   ![Widgetbox Add to Confluence dialog box](Image)

   If you cannot see this icon, click the more... link to reveal it.

4. In the Widgetbox Add to Confluence dialog box, click Copy.
5. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![URL](Image)

**YouTube**

You will need to find the URL for the YouTube video that you want to display.

To find a YouTube video's URL:

1. Go to YouTube and search for the video you want.
2. Click the title of the video, such as 'Wikis in Plain English'.
3. The video's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![URL](Image)

**MySpace Videos**

You will need to find the URL for the MySpace video that you want to display.

To find a MySpace video's URL:

1. Go to MySpace Video and search for the video you want.
2. Click the title of the video, such as 'Glacier Creek Confluence Time Lapse'.
3. The video's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this one:

   ![URL](Image)

**Yahoo Video**

You will need to find the URL for the Yahoo video that you want to display.
To find a Yahoo video's URL:

1. Go to [Yahoo Video](http://video.yahoo.com) and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

   http://video.yahoo.com/watch/423158/2424140

   If you are unable to obtain a unique URL from your browser’s address bar, click the envelope (Share) icon on the lower section of the video screen and copy the contents of the Link field.

**Dailymotion Video**

You will need to find the URL for the Dailymotion video that you want to display.

To find a Dailymotion video's URL:

1. Go to [Dailymotion](http://www.dailymotion.com) and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

   http://www.dailymotion.com/user/spacevidcast/video/x7zevj_spacevidcast-2009-promo-video_tech

   If you are unable to obtain a unique URL from your browser’s address bar, click Menu at the lower right section of the video screen, select URL & Embed Code and copy the contents of the Link field.

**Episodic**

You will need an [Episodic](http://app.episodic.com) user account if you want to create and distribute videos via Episodic.

To embed an Episodic video onto a Confluence page:

1. Find the video and copy the URL from the address bar of your browser. The URL looks something like this:

   http://app.episodic.com/shows/13/episodes/493

2. Paste the URL into the Web Site's Widget URL box in the Macro Browser.

**Vimeo**

You will need to find the URL for the Vimeo video that you want to display.

To find a Vimeo video's URL:

1. Go to [Vimeo](http://vimeo.com) and search for the video you want.
2. Click the title of the video, such as 'The Wiki Show - Allison the Russian High Kicker'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

http://www.vimeo.com/909808

**Metacafe**

You will need to find the URL for the Metacafe video that you want to display.

To find a Metacafe video's URL:

1. Go to [Metacafe](https://www.metacafe.com) and search for the video you want.
2. Click the title of the video, such as 'Wikis In Plain English (How To)'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

http://www.metacafe.com/watch/679493/wikis_in_plain_english_how_to/

**blip.tv**

You will need to find the URL for the blip.tv video that you want to display.

To find a blip.tv video's URL:

1. Go to [blip.tv](https://www.blip.tv) and search for the video you want.
2. Click the title of the video, such as 'River cruising on the Rhine'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

http://blip.tv/file/996864/

**Viddler**

You will need to find the URL for the Viddler video that you want to display.

To find a Viddler video's URL:

1. Go to [Viddler](https://www.viddler.com) and search for the video you want.
2. Click the title of the video.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

http://www.viddler.com/explore/Markus_Z/videos/1/

**Flickr**
You can embed a slide show of photos from Flickr by supplying a URL that specifies one of the following:

- Photos with a specific tag.
- Photos belonging to the photostream of a specific Flickr user.
- A set of photos as defined by the Flickr user.
- A user’s photostream starting at a specific photo.

If you want to do something else, we suggest that you try any Flickr URL. It should work.

Below are some examples of the Widget macro code for embedding Flickr images.

**Flickr Photos with a Specific Tag**

This URL displays a slide show of Flickr photos that are tagged with the word ‘Atlassian’ [http://www.flickr.com/photos/tags/atlassian/](http://www.flickr.com/photos/tags/atlassian/)

**Flickr Photos from a Specific User**

This URL displays a slide show of photos from the Flickr photostream of user ‘Atlassian’: [http://www.flickr.com/photos/atlassian/](http://www.flickr.com/photos/atlassian/)

**Flickr Photos from a Specific Set**

This URL displays a slide show of Flickr photos from the set ‘Melbourne Cup - November 2008’ created by user ‘Atlassian’: [http://www.flickr.com/photos/atlassian/sets/72157608657271078/](http://www.flickr.com/photos/atlassian/sets/72157608657271078/)

**A Specific Flickr Photo**

This URL displays a slide show of photos from the Flickr photostream of the user ‘Atlassian’, starting with a specific photo: [http://www.flickr.com/photos/atlassian/3003538919/](http://www.flickr.com/photos/atlassian/3003538919/)

**Skitch.com**

You will need to find the URL for the Skitch image that you want to display.

To embed a Skitch image onto a Confluence page:

1. Go to [Skitch.com](http://skitch.com/atlassian/411g/example-image).
2. Find the image and copy the URL from the address bar of your browser. The URL looks something like this:

   http://skitch.com/atlassian/411g/example-image

**Twitter**

Use a [Twitter](http://twitter.com/user) link in the Widget macro to display a dynamic list of the latest tweets sent by a user or matching a Twitter search.

To display the latest messages from a Twitter user, add the user’s Twitter link as the URL in the Widget macro.

http://twitter.com/username
This URL will display Mike Cannon-Brooke's Twitter messages: http://twitter.com/mcannonbrookes

To display the latest messages resulting from a Twitter search, add the Twitter search link as a URL in the Widget macro.

- Make sure you use the supported format of the search URL:

  http://search.twitter.com/search?q=my search term

  The following format is not supported:

  http://twitter.com/#search?q=my search term

  • The '#' tag is not supported (not even in its URL-encoded form %23).

This URL will display the most recent tweets containing the word 'AtlassianDragons': http://search.twitter.com/search?q=AtlassianDragons

**FriendFeed**

To display the latest messages from a FriendFeed user, add the user's FriendFeed link as the URL in the Widget macro. For example:

**BackType**

To display the latest blog or website comments from a BackType user, add the user's BackType widget link as the URL in the Widget macro. For example:

**SlideShare**

You will need to find the URL for the SlideShare presentation that you want to display.

To find a SlideShare presentation's URL:

1. Go to SlideShare and search for the presentation you want.
2. Click the title of the presentation, such as 'Using JIRA & Greenhopper for Agile Development'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   http://www.slideshare.net/jleyser/using-jira-greenhopper-for-agile-development-presentation

**SlideRocket**

You will need to find the URL for the SlideRocket presentation that you want to display.

To find a SlideRocket presentation's URL:
1. Log in to SlideRocket and go to your library of presentations.
2. Copy the ‘web link’ for the presentation you want to display. This will give you a URL that looks something like this one:

   http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

3. Paste the URL into the Widget macro code on your Confluence page.

**Scribd**

You will need to find the URL for the Scribd presentation that you want to display.

To find a Scribd presentation's URL:

1. Go to Scribd and search for the presentation you want.
2. Click the title of the presentation, such as 'My Sea Friends Coloring Book'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:


4. Paste the URL into the Widget macro code on your Confluence page.

**Google Docs Presentations**

You can embed presentations from Google Docs, but not other document types. You will need to find the URL for the Google Docs presentation that you want to display.

To find the URL of a Google Docs presentation:

1. Publish your presentation in Google Docs.
2. View your published document, then copy the URL from your browser's address bar. The URL will look something like this:

   http://docs.google.com/Presentation?docid=ddpqn8g5_0fx96zmmq6mm=en_GB

3. Paste the URL into the Widget macro code on your Confluence page.

**Google Calendar**

You can embed a Google Calendar into your page and to do this, you will need to add the URL for the Google Calendar that you want to display.

To find the URL for a Google Calendar:

1. Log in to Google Calendar.
2. In the calendar list on the left side of the page, ensure the appropriate calendar is selected, click the down-arrow button next to the calendar name and then select the Calendar settings option.
   (Alternatively, if available, click the Manage Calendars link at the bottom of the calendar list and then...
click the name of the appropriate calendar.)

3. In the Calendar Address section, click the HTML button. A pop-up message with your calendar's public URL appears.

4. Copy the URL from this pop-up message. The URL looks something like this:

   http://www.google.com/calendar/embed?src=somebody@example.com&ctz=Australia/Sydney

5. Paste the URL into the Widget macro code on your Confluence page.

### Wufoo HTML Form Builder

To display an HTML form built in the Wufoo HTML Form Builder, add the form's link as a URL to the Widget Macro. For example:

http://examples.wufoo.com/forms/contact-form/

### Dabble DB online database builder

To display a shared page built in Dabble DB, add the page's link as a URL to the Widget Macro. For example:

https://confluence-sample.dabbledb.com/page/confluence-sample/nSQqdgIg

> The Widget Macro supports shared Dabble DB view and form pages. You can insert a Dabble DB data entry form into a Confluence page. On the same page or another page, you can use a a Dabble DB view to display data submitted via the form.

### Get Satisfaction social support application

To display a feedback form for a Get Satisfaction community, add the community or company link as a URL to the Widget Macro. For example:

http://getsatisfaction.com/atlassian

#### Troubleshooting

If the URL given in the Widget Connector macro does not work, the macro displays an icon and the base URL.

For example, the following code:

http://example.com/invalid

will result in an image like the one below:
Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Widget Connector Examples

- Flickr
- Google Docs
- YouTube
- MySpace
- Vimeo
- BlipTV
- Viddler
- Skitch
- Twitter
- FriendFeed
- SlideShare
- SlideRocket
- Scribd
- Wufoo
- Error Message
- Related Content

Flickr

http://www.flickr.com/photos/tags/atlassian

http://www.flickr.com/photos/atlassian/

http://www.flickr.com/photos/atlassian/sets/72157608657271078/
Viddler

http://www.viddler.com/explore/Markus_Z/videos/1/

Skitch

http://skitch.com/jnolen/bbybm/skitch.com-jnolen

Twitter

http://twitter.com/mcannonbrookes

http://search.twitter.com/search?q=AtlassianDragons

FriendFeed

http://friendfeed.com/mynname

SlideShare

http://www.slideshare.net/jleyser/using-jira-greenhopper-for-agile-development-presentation

SlideRocket

http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Working with Drafts

A draft is a 'snapshot' of unsaved page content, which Confluence creates automatically at regular intervals while you are editing a page or blog post. This can minimise the loss of work if your Confluence site experiences a problem, since you can retrieve the page content from your last saved draft.

**How do drafts work in Confluence?**

At regular intervals, Confluence automatically saves a draft of the page you are editing. If a network failure or system error prevents you from saving your page, you can retrieve its last saved draft and continue working on the page from the last saved draft.

Drafts are created while you are adding and editing a page or blog post. Each new draft replaces the previously saved draft. By default, Confluence saves a draft of your page once every thirty seconds. However, a Confluence administrator can configure how often drafts are saved. In addition, whenever you edit a page and then move to another screen, Confluence will automatically save a draft.

When you edit the page again, Confluence will let you know that a version of the page you are editing was not saved and will give you the option to resume editing it.

Each time Confluence saves a draft, it displays a message and the time of the last save near the **Save** button on the edit screen.
On this page:
- How do drafts work in Confluence?
- Viewing drafts
- Viewing your unsaved changes

Related pages:
- Resuming the Editing of a Draft
- Configuring the Time Interval at which Drafts are Saved
- Concurrent Editing and Merging Changes
- Confluence User's Guide

More about drafts:
- A user only has access to the drafts of pages they have been working on and whose content has not yet been saved.
- A user cannot create a draft explicitly.
- A user's drafts are listed in the 'Drafts' tab of their profile.
- Once a user has resumed editing a draft, or chosen to discard it, the draft is removed from their drafts tab.

**Viewing drafts**

Your drafts are listed on the Drafts tab of your user profile.

**To see your drafts:**

Go to your name (the 'User' menu) at the top of the page and choose Drafts.

**Viewing your unsaved changes**

While editing a page or blog post, you can view any 'unsaved' changes you have made since the last automatically saved draft, by clicking view change (near the Save button).
Configuring the Time Interval at which Drafts are Saved

By default, Confluence saves a draft of your page once every thirty seconds. However, as described below, a Confluence administrator can configure how often drafts are saved.

As a Confluence administrator, you can set the time interval at which drafts are saved as follows:

1. Choose Browse > Confluence Admin.
2. Click General Configuration in the left-hand panel.
3. Edit the setting for Draft Save Interval.

Related Topics

**Working with Drafts**

**Resuming the Editing of a Draft**

**Concurrent Editing and Merging Changes**

Sometimes, two or more people may edit a page at the same time. When this happens, Confluence will do its best to ensure that nobody's changes are lost.

**How will I know if someone else is editing the same page as I am?**

If another user is editing the same page as you, Confluence will display a message above your edit screen letting you know who the other user is and when the last edit was made.

Screenshot: Notification of Simultaneous Page Editing

![This page is being edited by [User] (last edit less than a minute ago)](image)

**What happens if two of us are editing the same page and the other user saves before I do?**

If someone else has saved the page before you, when you click 'Save', Confluence will check if there are any conflicts between your changes and theirs. If there are no conflicting changes, Confluence will merge both the edits successfully. If there are any conflicts, Confluence will display them for you and give you the option to either 'Overwrite' the other user's changes, 'Merge your changes' manually, or 'Discard' them.

Screenshot: Notification of Page Editing Conflict

![The following error(s) occurred:
- You were editing an outdated version of this page. Another user has updated this page before you. Your changes against the now updated version is shown below. Please decide whether your changes should overwrite it or you wish to discard your changes.](image)

**Example Scenario**

For example, Alice and Bob both edit the same page at the same time.

If Alice clicks save before Bob, Bob is now effectively editing an out-of-date version of the page. When Bob clicks save, Confluence will examine his changes to see if any overlap with Alice's. If the changes do not overlap (i.e. Alice and Bob edited different parts of the page), Bob's changes will be merged with Alice's automatically.

If Bob's changes overlap with Alice's, Confluence will display an error message to Bob showing where Alice has changed the page, and giving Bob the options to overwrite Alice's changes with his own, to re-edit the document to incorporate Alice's work, or to cancel his own changes entirely.

Related Topics
Page History and Page Comparison Views
Viewing Page Information
Working with Drafts

Take me back to Confluence User's Guide.

Resuming the Editing of a Draft

If you have typed some content into a Confluence page or blog post, Confluence will save a draft of it, even if you were not able to successfully save the page or blog post, or add a title to it.

There are two ways to resume editing an unsaved page or blog post:

A. Using your drafts view. To resume editing a draft from this view:
   1. Go to your name (the ‘User’ menu) at the top of the page and choose Drafts.
   2. Click Resume Editing next to the appropriate draft to resume editing that draft.

   If you had not yet entered a page title, the draft will be listed with the title ‘Untitled’.

B. If you had created a new page or blog post but did not save it, then when you next add a page or blog post in that space, Confluence will ask you if you want to resume editing the page that was not saved. If you click resume editing, the draft and its unsaved content will be restored, allowing you to continue editing it.

Screenshot: Resume Editing

What happens if I am editing the draft of a page that has since been updated?

When this happens, Confluence will display a message informing you that you are editing an outdated page. If there are no conflicts between the two versions, Confluence will give you the option to Merge and Resume editing.

If there are any conflicts, Confluence will give you the option to View the Conflict or to Discard your changes.

Screenshot: Editing Conflict in Draft

Related Topics

Working with Drafts

Recording Change Comments

A ‘change comment’ is a short description that summarises the changes made to a page during an editing session. Change comments are a useful way of keeping track of the history of a page.

A change comment is not the same as a comment added to a page. Refer to Commenting on pages and blog posts for information about that type of comment.

Note that once a change comment has been added and the page has been saved, it is not possible to update or remove the change comment.
On this page:
- Entering a Change Comment
- Viewing a Change Comment
- Viewing a History of Change Comments
- Related Topics

Entering a Change Comment

You can enter change comments in the field located below the edit screen:

*Screenshot: Entering change comments*

Viewing a Change Comment

Once a comment has been added, it becomes visible in the view mode of the page, so that users are aware of the most recent changes made to a page. If a comment has been recorded, you will see a *show comment* link below the page title. Click the link to view the comment.

*Screenshot: The 'show comment' link*

The *hide comment* link allows you to hide the comment again, so that it does not distract you from the content of the page.

*Screenshot: The 'hide comment' link*

Viewing a History of Change Comments

The change comments for a page are recorded under the 'Recent Changes' section of the page's 'Info' view and in the page's 'History' view.

*Screenshot: History of change comments on Info view*
When you add a new page, you do not have to write the content from scratch. Instead, you can base your new page on a template. A template is a Confluence page with predefined content.

Some examples of where templates are useful:

- A software development project may have a template for use cases.
- A systems administration space may have a template for defining what information is kept about each server.

Global templates and space templates

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Confluence administrators can also import predefined templates.
Creating a template

You can write your template using the Confluence rich text editor. You can also add special variables to the page, if you want to include fields that the author will complete when adding the page. See Adding a Template for more information.

Using a template

Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

See Creating a Page using a Template for more information.

Useful plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

Extended template functionality:

- Scaffolding plugin
- Search the Atlassian Marketplace

Adding a Template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format.

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Adding a space template

Space templates are available in one space only.

To add a template for a space:
1. From any page in the space, choose **Browse > Templates**.
2. Choose **Add New Space Template**.

The 'Create Template' screen will appear. Add content as described below.

---

**On this page:**
- Adding a space template
- Adding a global template
- A template illustration
  - Using the template editor
  - The resulting form when the template contains variables
- Adding content to your template
  - Labels
  - Images and other attachments
  - Variables used as form fields
- Converting an existing page to a template
- Notes

**Related pages:**
- Creating a Page using a Template
- Working with Templates
- Working with Confluence Labels
- Working with Macros
- Using the Editor
- Confluence User's Guide

---

**Adding a global template**

Global templates are available in all spaces in your Confluence site.

**To add a global template:**

1. Choose **Browse > Confluence Admin**.
2. Enter your password if prompted.
3. Choose **Global Templates** in the left-hand panel.
4. Choose **Add New Global Template**.

The 'Create Template' screen will appear. Add content as described below.

---

**A template illustration**

Using the template editor

This illustration shows the template editor with an image, some text, styling, and variables.
The resulting form when the template contains variables

This screenshot shows the form displayed when someone creates a page based on the template containing the above variables. (See Creating a Page using a Template.)
Adding content to your template

Add a name for your template.

Enter text into the body of the template, and use the editor toolbar to apply styles, layout and formatting. You can add links and macros. In general, you can use the Confluence editor in the same way as on a page. In addition, you can add variables which will produce a form for data collection when someone adds a page based on the template.

Below are some points of special interest in templates.

Labels

Choose **Labels** to add one or more labels to the template. These labels will be included in all pages created using this template.

Images and other attachments

You cannot attach an image or other file to a template. Instead, attach the file to another page, and insert it into the body of the template.

For example:

- You can attach an image to a page and then choose **Insert > Image** to embed the image into the template.
- You can attach a PDF file to a page and then choose **Insert > Other Macros > PDF** to embed the PDF file into the template.
The image or other file type will be displayed on all pages created using this template. The file will not be attached to the pages, but will be referenced from the page that you first attached it to.

**Variables used as form fields**

You can add variables to your template, to act as form fields. When someone creates a page based on the template, Confluence will display a text entry box for each field. The user can enter data into each field, and the data is inserted onto the new page.

Every variable must have a unique name. If you add the same variable more than once in the same template, Confluence will make sure that they have the same value when the user saves the page. This is useful if you need the same information in more than one place in the page.

**To insert a variable into a template:**

1. Place your cursor on the template where you want the variable to appear.
2. Choose **$ Variables** from the editor toolbar.
3. Choose **Add New Variable**. Alternatively, you can choose the name of an existing variable if you want the same variable to appear more than once in the template.
4. Enter the variable name.
5. Press **Enter**. By default this will create a single-line text input field.
6. To change the variable type, click the variable placeholder. The variable's property panel will appear.

Choose one of the variable types: **Text**, **Multi-line Text**, or **List**. See [below](#) for a description of each type.

**Speeding up variable entry with autocomplete:** Type `$` and the variable name, then press Enter, to add a new variable or to select an existing variable from a list of suggestions. The suggestions are drawn from variables already defined in this template.

These are the types of variable available:

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Creates a single-line text input field.</td>
</tr>
</tbody>
</table>

*Screenshot: A template variable called $purpose and its property panel*

This tutorial helps you to $purpose.
**Multi-line text**

Creates a text box that allows more than one line of text.

By default, the text area is 5 rows depth and 100 characters wide. You can change the size by typing over the digits in the variable property panel.

*Screenshot: A multi-line variable and its property panel*

---

**List**

Creates a dropdown list.

You must specify the values that will appear in the dropdown list. The values:

- Must be separated by commas.
- Can include letters, numbers, special characters, and spaces.
- Cannot include commas (except as the list separation character).

*Screenshot: A list variable and its property panel*

---

**Converting an existing page to a template**

If you would like to convert an existing page to a template, you can copy the content from the page and paste it into the rich text editor pane in the template editor. There is no automated way of doing this.

Please note the section above about images and other attachments in templates.

**Notes**

- You cannot insert variables via the 'Insert wiki markup' option in the editor toolbar.
- Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.
- When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template – the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)
- The rich text editor for templates is available only in Confluence 4.3 and later. Please refer to the earlier documentation for a description of the wiki markup editor templates.

**Creating a Page using a Template**
You can create a page based on a global template (available to all spaces) or a space template (available only to that space). Before reading this page, make sure that someone has already created a template on your Confluence site.

**Information copied from the template to the page**

When you create a page based on a template, Confluence will copy the following content and information from the template to the new page:

- Labels
- Text and styles
- Layouts and formatting
- Macros
- Embedded images and other files. Note that you cannot attach an image or other file to a template. But if the template displays an image or file from another page, the new page will display that image or file too.

**Form fields displayed by the template**

If the template author included variables in the template, Confluence will display a form prompting you to supply values for the variables when you add the page. See screenshot below.

---

**On this page:**

- Information copied from the template to the page
- Form fields displayed by the template
- Using a template to create a page
- Notes

**Related pages:**

- Adding a Template
- Using the Editor
- Working with Confluence Labels
- Confluence User's Guide

---

**Using a template to create a page**

To create a page based on a template:

1. Do one of the following:
   - Go to the dashboard and click Add Page. Choose the space and the template you want to use.
   - Or go to any page in the space where you want to add a page. Choose Add > Page from template, then choose a template.
   - Or go to the space where you want to add a page, and choose Browse > Templates. Then choose Create page from template next to the template you want to use.
2. If the template contains variables, you will now see a form. Type the relevant information into the form fields, and choose Next.
3. Now you will see a new page based on the template. If you added information in the form fields, the page content will include that information.
4. Type a name for the page where you see 'New Page'.
5. Add more content or make any other changes required.
6. Choose Save.

Screenshot: Form showing template variables when creating a page from a template
Notes

Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

Editing a template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about changing an existing template.

Note: Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

In Confluence, there are two places to store your page templates:

- **Space templates:** These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates:** These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.
1. Go to a page in the space, and choose **Browse > Templates**. A list of templates for the space is displayed.
2. Choose **Edit** next to the template that you want to modify.
3. Make changes, or add new content, as you would when adding a template.
4. Choose **Save**.

**To edit a global template:**

1. Choose **Browse > Confluence Admin**.
2. Choose **Global Templates** in the left-hand navigation panel. A list of templates for the Confluence site is displayed.
3. Choose **Edit** next to the template that you want to modify.
4. Make changes, or add new content, as you would when adding a template.
5. Choose **Save**.

**Removing a Template**

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about deleting an existing template, at space level or at site (global) level.

Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. You can therefore remove the template without affecting any existing pages.

You need to be a **space administrator** to remove a space template, and you need **Confluence Administrator permissions** to remove a global template.

**Note:** Deleted templates cannot be restored.

1. Go to a page in the space, and choose **Browse > Templates**. A list of templates for the space is displayed.
2. Choose **Remove** next to the template that you want to delete.
3. Confirm the deletion when prompted.

**To remove a global template:**

1. Choose **Browse > Confluence Admin**.
2. Choose **Global Templates** in the left-hand navigation panel. A list of templates for the Confluence site is displayed.
3. Choose **Remove** next to the template that you want to delete.
4. Confirm the deletion when prompted.

**Working with the Office Connector**
The Office Connector is bundled with Confluence 2.10 and later. It allows you to:

- Import an Office document into Confluence format
- Attach an Office document to a Confluence page and display its content in Confluence, without converting the content.
- Edit the attached document in the Office application, directly from the Confluence page.

Please be aware that source code is currently not available for the Confluence Office Connector.

Table of Contents

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Related Topics

View File Macro
Configuring the Office Connector in the Confluence Administration Guide

Take me back to Confluence User's Guide

Office Connector Prerequisites

The page describes the software and setup you need to use the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

On this page:

- Overall Prerequisites
- Prerequisites for Viewing Office and PDF Files in Confluence
- Prerequisites for Importing Office Documents into Confluence
- Prerequisites for Editing Office Files Directly From Confluence
- Related Topics

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Overall Prerequisites

- Ensure that Java 5 (JDK 1.5) or higher is installed on your Confluence server.
- The WebDAV plugin must be enabled, because the Office Connector uses WebDAV to transfer information to and from Office documents. Note that the WebDAV plugin is bundled with Confluence, and can be enabled or disabled by the System Administrator. If necessary, refer to the instructions on enabling plugins and configuring the WebDAV options.
• Ensure that your Confluence server's base URL is set correctly. (Check it by going to the 'General Configuration' screen in the Confluence Administration Console, as described in [Configuring the Server Base URL](#).) When a user edits a wiki page in Word and then uploads the page back to the Confluence server, the base URL determines where the document will be saved. If the base URL is incorrect, the documents may be saved to a different Confluence server.

**Prerequisites for Viewing Office and PDF Files in Confluence**

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup described below.

**Browsers and Flash Player**

You can use any browser to view an Office file on a wiki page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office desktop application installed on your computer in order to view Office files in Confluence.

**File Types**

Confluence can display files compatible with Microsoft Office 97-2007, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

**Prerequisites for Importing Office Documents into Confluence**

- Document import can import Microsoft Word documents of the file types .doc and .docx. These must be valid Word 97-2007 format documents.

**Prerequisites for Editing Office Files Directly From Confluence**

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

**Browsers**

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in [Installing the Firefox Add-On for the Office Connector](#).
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

**Office editors**

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See [Installing the Firefox Add-On for the Office Connector](#).
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.
## Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Windows 7, Windows Vista, or Windows XP with Service Pack 2 or 3</td>
<td>• OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>• Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>• Mac OS X 10.5 and 10.6</td>
<td>• OpenOffice 2.x – 3.x</td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>• The “Edit in Word” feature is known to work in OpenOffice 3.2.0.</td>
<td></td>
</tr>
<tr>
<td>• Linux</td>
<td>• OpenOffice 2.x – 3.x</td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**

**Working with the Office Connector**

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

**Configuring the Office Connector** in the Confluence Administration Guide

Take me back to Confluence User's Guide

### Displaying Office Files in Confluence

Confluence can display Office files that are attached to a page. If you have an Office application installed, you will also be able to edit these Office files in your Office application.

These are two of the ways that Confluence can interact with Office files. For an overview of all Office Connector features, please refer to Working with the Office Connector.

ℹ️ Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.
Prerequisites

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup described below.

Browsers and Flash Player

You can use any browser to view an Office file on a wiki page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office desktop application installed on your computer in order to view Office files in Confluence.

File Types

Confluence can display files compatible with Microsoft Office 97-2007, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

Attaching and Displaying Office Files and PDF Files

There are two ways to do this in Confluence:

- Attach Office files to a page and display them in a Confluence page using the View File or Attachments macros.
- Attach an Office or PDF file to a page and embed its contents onto the page by simply dragging and dropping it into the editor window.

To attach and display Office files in Confluence using macros:

1. Attach the Office file(s) to a Confluence page:
   - View the Confluence page on which you want to display your document.
   - Choose Tools > Attachments.
   - Browse for your Office files and upload them to the Confluence page.
   - Refer to detailed instructions in Attaching Files to a Page.
2. Now you have two options for displaying the attached document:
   - You can embed the document into the Confluence page, using one of the Office Word, Office Excel, Office PowerPoint or View PDF macros. These macros can be found using the macro browser. Refer to the detailed instructions in the View File macro topic.
   - You can display a list of page attachments using the Attachments macro. People viewing the page will be able to click the View link to see the Office or PDF document in Confluence.

To attach and display an Office file on a Confluence page using 'drag and drop':

- Drag the Office file from your computer and drop it into the editor window. Only one file can be dragged and dropped at a time. The appropriate View File macro placeholder will appear in the position where you dragged the file. However, the contents of the file will be rendered in full when you preview, or save and...
view, the page.

Older browser versions require Google Gears to have been installed for you to use drag and drop. Refer to Using Drag-and-Drop in Confluence for information about setting up Google Gears.

**Viewing and Editing the Attached Office Files**

If an Office document is attached to a Confluence page, you can view the attached Office document from within Confluence. View the Office document in one of the following ways:

- Search for the Office document by file name, then click **View** next to the Office document on the Search results page. (See Searching Confluence.)
- View the list of attachments for a specific Confluence page, then click **View** next to the Office document on the Attachments page. (See Viewing Attachment Details.)
- View a list of attachments displayed on a page via the Attachments macro, then click **View** next to the Office document in the list of attachments. (See Displaying a List of Attachments.)
- View a Confluence page which has the Office document embedded in the page via the View File macro. (See View File Macro.)

Any Confluence user who has an Office application installed will also be able to launch their Office editor from within Confluence:

- Editing an Office Document from Confluence.
- Editing an Office Presentation from Confluence.
- Editing an Office Spreadsheet from Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the Office Connector limitations and known issues.

**Related Topics**

View File Macro
Working with the Office Connector

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Configuring the Office Connector in the Confluence Administration Guide

Take me back to the Confluence User's Guide.

**Importing a Word Document into Confluence**

The Office Connector in Confluence allows you to import a Word document into Confluence, so that the document's content is copied onto one or more Confluence pages.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

The simplest way to import a Word document is to import the entire content of the document into a single wiki page. By default, the content of the document will be created as a new wiki page.
More advanced options allow you to import the content into a new page, to split a single document into more than one wiki page, and to resolve conflicts in the titles of your pages.

These options are described below.

**Prerequisites**

Prerequisites for the Office Connector’s document import feature:

- Document import can import Microsoft Word documents of the file types `.doc` and `.docx`. These must be valid Word 97-2007 format documents.

For a full list of Office Connector prerequisites and limitations, please refer to:

- Office Connector Prerequisites
- Office Connector Limitations and Known Issues

---

**Importing a Word Document**

The simplest way to import a Word document is to import the entire content of the document into a single wiki page.

This method will replace any existing content on the wiki page.

To import a Word document onto a single wiki page:

1. Create a page in Confluence (see [Creating a Page](#)) or go to an existing page whose content you want replaced. View the page in view mode (not edit mode).
2. Choose **Tools > Import Word Document**.
3. Click **Browse** and find the Word document on your local drive or network.
4. Click the **Open** or **Upload** button provided by your browser. The path and file name of the document will now appear in the text box on the Office Connector import screen.
5. Click **Next** on the Office Connector import screen. The import document options screen will display.
6. The import document options are:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root page title</td>
<td>The title of the wiki page that will contain the information from your imported document.</td>
</tr>
<tr>
<td>Import as a new page in the current space</td>
<td>A new wiki page will be created with the page title specified above.</td>
</tr>
<tr>
<td>Replace <code>&lt;pagename&gt;</code></td>
<td>The contents of the existing page will be replaced.</td>
</tr>
<tr>
<td></td>
<td>The page will be renamed to the page title specified above.</td>
</tr>
<tr>
<td>Delete existing children of <code>&lt;pagename&gt;</code></td>
<td>The existing child pages of the page you are replacing will be deleted.</td>
</tr>
<tr>
<td>Rename imported pages if page name already exists</td>
<td>Assign new names to any new page which would otherwise have a duplicate name. The content of existing pages will remain unchanged.</td>
</tr>
<tr>
<td>Replace existing pages with imported pages of the same title</td>
<td>If imported pages have titles equal to existing pages, then the content of the Word document will overwrite the content on the existing page. Page history will be preserved.</td>
</tr>
<tr>
<td>Remove existing pages with the same title as imported pages</td>
<td>If imported pages have titles equal to existing pages, then the existing pages will be deleted. This will remove the page history as well as the content.</td>
</tr>
<tr>
<td>Split by heading</td>
<td>The content of the Word document will be split over multiple wiki pages. If you don't want to split your document into multiple wiki pages, leave the default Don't split option selected. For more information on splitting your document, please see below.</td>
</tr>
</tbody>
</table>

7. Click **Import**.

When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

**Screenshot: Empty page ready for import**

**Screenshot: Selecting Word document to import**
Splitting a Word Document into Multiple Wiki Pages

When importing a Word document, you can split a single document into more than one wiki page, based on the heading styles in the document.

By default, the page names will be the same as the heading text. This may result in a conflict, if a page already exists with the same title. You can instruct the importer how to handle such conflicts.

To import a Word document into multiple wiki pages:

1. Import a Word document as described above. On the import document options screen, choose how to split your document in the 'Split by heading' field:
   * 'Split by heading' — If you want to split the content under each heading in your document into separate child pages, select the desired heading level to split by. A preview of the page hierarchy that will be created by the split will be displayed under 'Document Outline'. Each bullet point in the 'Document Outline' represents a new page after import into Confluence.
2. Click 'Import' to import your document.
3. When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

Screenshot: Splitting a single Word document into multiple wiki pages

Editing an Office Document from Confluence

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a Word document from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

On this page:

- Prerequisites for Editing an Attached Office Document
- Editing an Office Document in your Office Application
- Troubleshooting
- Related Topics

Prerequisites for Editing an Attached Office Document

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.

- Note: No Chrome support. Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

Office editors
To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

### Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Windows 7,</td>
<td>• <strong>OpenOffice</strong> 2.x – 3.x, or</td>
<td>• Internet Explorer 8.x – 9.x, or</td>
</tr>
<tr>
<td>• Windows Vista, or</td>
<td>• Microsoft Office XP, 2003, 2007</td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td>• Windows XP with Service Pack</td>
<td>or 2010</td>
<td></td>
</tr>
<tr>
<td>2 or 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Mac OS X 10.5 and 10.6</td>
<td>• <strong>OpenOffice</strong> 2.x – 3.x</td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>• The &quot;Edit in Word&quot; feature is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>known to work in <strong>OpenOffice</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.2 .0.</td>
<td></td>
</tr>
<tr>
<td>• Linux</td>
<td>• <strong>OpenOffice</strong> 2.x – 3.x</td>
<td>• Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>• The only known supported</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Office editor for Linux is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OpenOffice. But in theory it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>should work with any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WebDAV-aware application.</td>
<td></td>
</tr>
</tbody>
</table>

### Editing an Office Document in your Office Application

To edit an Office document in your Office application:

1. There are two ways to do this:

   - **From an Office document embedded on a page:**
     a. Open a Confluence page with an Office document embedded on it.
     b. Move your mouse pointer to the top of the document embedded in the Confluence page, until the hidden title bar appears.
1. Click the title bar above the embedded document.

   - **From an Office document in a list of attachments:**
     - If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
       - View the list of attachments for a specific Confluence page, then click **Edit** next to the Office file on the Attachments page. (See Viewing Attachment Details.)
       - View a list of attachments displayed on a page via the Attachments macro, then click **Edit** next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

2. A window will pop up, asking you to confirm that you want to open this document.

   **Screenshot: Confirmation window in Firefox**
3. Click ‘OK’. Now you may be asked to log in to your Confluence server.

4. Enter your Confluence username and password, then click ‘OK’.

5. The Office document will open in your Office application.

6. Make the necessary changes, then save the document. It will be saved back into Confluence.

Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Related Topics

- **Working with the Office Connector**
  - Office Connector Prerequisites
  - Displaying Office Files in Confluence
  - Importing a Word Document into Confluence
  - Editing an Office Document from Confluence
  - Editing an Office Spreadsheet from Confluence
• Editing an Office Presentation from Confluence
• Installing the Firefox Add-On for the Office Connector

Configuring the Office Connector in the Confluence Administration Guide

Take me back to the Confluence User's Guide.

Editing an Office Spreadsheet from Confluence

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit an Excel spreadsheet from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

On this page:
• Prerequisites for Editing an Attached Office Spreadsheet
• Editing an Office Spreadsheet in your Office Application
• Troubleshooting
• Related Topics

Prerequisites for Editing an Attached Office Spreadsheet

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

Browsers

• If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
• Note: No Chrome support. Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

Office editors

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

• If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
• If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>System</th>
<th>Required Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
</tr>
<tr>
<td>Windows Vista</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
</tr>
<tr>
<td>Windows XP</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>Windows XP</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
</tr>
<tr>
<td>Mac OS X 10.5</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
</tr>
<tr>
<td>Mac OS X 10.6</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>Linux</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
</tr>
<tr>
<td>Mac OS X 10.5</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>Linux</td>
<td>Firefox – latest stable version</td>
</tr>
</tbody>
</table>

**Editing an Office Spreadsheet in your Office Application**

To edit an Office spreadsheet in your Office application:

1. There are two ways to do this:
   - **From an Office spreadsheet embedded on a page:**
     a. Open a Confluence page with an Office document embedded on it.
     b. Move your mouse pointer to the top of the spreadsheet embedded in the Confluence page, until the hidden title bar appears.

   *Screenshot: The title bar showing 'spreadsheet.xls' above an embedded Excel spreadsheet*

2. A window will pop up, asking you to confirm that you want to open this document.

   *Screenshot: Confirmation window in Firefox*
3. Click ‘OK’. Now you may be asked to log in to your Confluence server.

Screenshot: Logging in to Confluence
4. Enter your Confluence username and password, then click ‘OK’.
5. The Office spreadsheet will open in your Office application.
6. Make the necessary changes, then save the spreadsheet. It will be saved back into Confluence.

Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Related Topics

Working with the Office Connector

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Configuring the Office Connector in the Confluence Administration Guide

Take me back to the Confluence User’s Guide.

Editing an Office Presentation from Confluence

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a PowerPoint presentation from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

ℹ️ Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator.

On this page:

- Prerequisites for Editing an Attached Office Presentation
- Editing an Office Presentation in your Office Application
- Troubleshooting
- Related Topics

Prerequisites for Editing an Attached Office Presentation

The Office Connector allows you to edit Office files embedded in a wiki page or from the page’s attachments view.

To make use of these editing capabilities, you will need the setup described below.

Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.
Office editors

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7,</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>Windows Vista,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>with Service Pack 2 or 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mac OS X 10.5 and 10.6</td>
<td>OpenOffice 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>The “Edit in Word” feature is known to work in OpenOffice 3.2.0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td>OpenOffice 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Editing an Office Presentation in your Office Application

To edit an Office presentation in your Office application:

1. There are two ways to do this:

   - From an Office presentation embedded on a page:
     a. Open a Confluence page with an Office presentation embedded on it.
     b. Click the 'Edit' icon on the bottom frame of the slide show.
1. From an Office document in a list of attachments:
   - If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
     - View the list of attachments for a specific Confluence page, then click Edit next to the Office file on the Attachments page. (See Viewing Attachment Details.)
     - View a list of attachments displayed on a page via the Attachments macro, then click Edit next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

2. A window will pop up, asking you to confirm that you want to open this document.

Screenshot: Confirmation window in Firefox
3. Click ‘OK’. Now you may be asked to log in to your Confluence server.

4. Enter your Confluence username and password, then click ‘OK’.
5. The presentation will open in your Office application.
6. Make the necessary changes, then save the presentation. It will be saved back into Confluence.

Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Related Topics

Working with the Office Connector

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
Installing the Firefox Add-On for the Office Connector

If you are using Firefox as your browser, you will need to install an add-on into Firefox (the Firefox WebDAV Launcher) in order to use some features of the Office Connector. You will be prompted to install the add-on the first time you try to use a function which requires it.

For an overview of all Office Connector features, please refer to Working with the Office Connector.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

Installing the Firefox Add-On

You will be prompted to install the add-on the first time you try to use a function which requires it. The add-on is required for editing a wiki page in Office, or for editing an Office document which is displayed on a wiki page.

1. When you choose an option which requires the Firefox add-on, you will see a popup window like this one:

2. Click ‘OK’. Some browsers may now ask you to confirm the download with a message bar across the top of the page, beneath the browser’s address bar.

   - You may see a message like the yellow bar shown here:

   Click ‘Allow’.

   - Or you may see a similar message with an ‘Edit Options’ button like this:
• If you see the above message, click ‘Edit Options’. You will then see an ‘Allowed Sites’ window like this one:

This window lets you tell Firefox that your Confluence server is allowed to install add-ons into Firefox. The ‘Address of web site’ box should already contain the address of your Confluence server.
• Click the ‘Allow’ button to add your Confluence server to the list.
• Go back to your Confluence page and try to edit your Office document again, e.g. by clicking ‘Edit in Word’ again. Now you will see the option to install the add-on.

3. A ‘Software Installation’ window will appear, asking you to confirm the installation. The window will look something like the one below, but the URL will be the address of your own Confluence server:
4. Click 'Install Now'. The installation will happen and a window will pop up asking you to restart Firefox:

5. Make sure you have saved all your Confluence pages and any other work in your browser, then restart Firefox.
6. If Firefox asks you to confirm the restart, confirm it.
7. Firefox will close all the browser windows and will then start up again. You will see a window confirming that a new add-on has been installed, like this:
Configuring the Add-On

After you have installed the add-on into Firefox, you will need to configure it. Basically, you will associate a desktop application (editor) with each relevant file type. This tells the Office Connector which application to launch when it encounters a link to an editable file. The configuration is slightly different for each operating system, as described below.

**Configuring the Add-On in Windows**

The add-on can will automatically configure itself on Windows via the system registry. The first time you edit a new file type, the add-on will look up the default editor for that file type and make that the permanent setting.

If you want to override the registry settings, or if for some reason the automatic configuration is not working, you can configure the Firefox add-on manually.

1. In Firefox, go to the **Tools** menu and select **WebDAV Launcher Options**, as shown in this screenshot:
1. A 'WebDAV Launcher Options' window will appear, allowing you to associate a specific file type (file extension) with a desktop application (editor). The window looks like this one:

![WebDAV Launcher Options Window](image1)

2. In the 'File Extension' box, enter the extension for a particular file type. For example, you may want to associate the 'doc' file extension with Microsoft Word 2003 or earlier. To do this, you would type 'doc' in the File Extension text box.

3. If you use or have recently upgraded to Office 2007

   ![if you use or have recently upgraded to Office 2007](image2)

   In addition to the original Office 2003 file extensions (that is, 'doc', 'ppt' and 'xls'), you should additionally configure the WebDAV launcher to handle the new Office 2007-specific file extensions for Microsoft Word ('docx'), Microsoft Excel ('xlsx') and PowerPoint ('pptx').

   Screenshot: Configuring the WebDAV Launcher - adding the 'doc' file extension.
4. Enter the 'Application Path' — Use one of the following methods to specify the associated application for editing the given file type:

- Click the 'Auto' button to load the associated application from the Windows registry.
- Alternatively, you can click the 'Browse' button to find the application on your computer.
- Or you can manually type in the path to the application's executable file.

Screenshot: Configuring the WebDAV Launcher - adding the 'Application Path' for the 'doc' file extension.
5. Click the ‘Add’ button. The file extension association will be added to the list. For example, in the picture below you can see that the 'doc' extension has been associated with 'C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE'. This is the path to the Microsoft Word 2003 executable on a specific Windows machine.

Screenshot: Configuring the WebDAV Launcher - configuration of the ‘doc’ file extension complete.

### Configuring the Add-On in Mac OS X

The configuration procedure is similar to Windows, as shown above. Note that there is no ‘Auto’ button in Mac OS X.

### Configuring the Add-On in Linux

The only known supported Office editor for Linux is OpenOffice. (See Office Connector Prerequisites.)

There is no automatic configuration on Linux. You will need to associate each file type with your Office editor in Firefox. Note that there is no ‘Auto’ button in Linux.

The configuration procedure is similar to Windows, as shown above.

For both Ubuntu and OpenSUSE, the configuration will look something like this:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Application Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc</td>
<td>C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE</td>
</tr>
</tbody>
</table>
Security Risks

⚠️ Please be aware that there are security risks in installing this add-on to Firefox. Internet Explorer is exposed to the same risks, because it can directly open Office documents. By installing the add-in into Firefox, you are exposing Firefox to the same risks.

Summary of the risks:

- Office documents can contain macro viruses. Before opening an Office document, make sure that you trust the source of the document.
- There are known flaws in the Office file formats and Microsoft Office that an attacker can exploit to gain control of your machine. Microsoft has fixed the known exploits in the latest Service Packs for all Microsoft Office versions. But new exploitations may arise at any time. Again, be sure that you trust the source of a document before opening it.

The add-on tries to reduce the risk by supporting the following:

- **Same origin policy** — The add-on can only open documents from the same host that initiated the action.
- **Digital signature** — The add-on is digitally signed. When you install the add-on please verify that it is signed by **Benryan Software Inc.**

- **Prompt the user for confirmation** — You will always be warned before a file is opened. **Please read these warnings carefully before opening a file.** The warning tells you the complete URL of the file as well as the complete application path of the application opening the file.

Information about this Firefox Add-On

| Add-on name: | WebDAV Launcher |
Description: Adds the ability to launch a WebDAV URL directly in a WebDAV-aware client.

Latest version: See the WebDAV Launcher add-on page at Mozilla

Compatible with: All versions of Firefox, up to and including the latest stable version.

Author: Atlassian Pty Ltd

Related Topics

Working with the Office Connector

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Configuring the Office Connector in the Confluence Administration Guide

Take me back to the Confluence User's Guide.

Importing Content Into Confluence

This page describes how to get text, pages, images and other content into Confluence, by converting the content from another storage format and importing it into the Confluence wiki.

Importing Content from Other Confluence Sites

For content originating from other instances of Confluence:

- If the Confluence major versions are the same, export the space from the originating Confluence site and import it into the destination Confluence site.
- If the Confluence major versions are different, you can use an intermediate server to migrate versions.

Page history, attachments, and page content will be preserved and you will be able to do multiple pages at once. The drawbacks are that it may be inconvenient if the Confluence versions differ, and you cannot have a duplicate space key on the destination instance. (You cannot import a space with the same space key as a space that already exists.)

On this page:

- Importing Content from Other Confluence Sites
- Importing Content from Other Wikis
- Importing Content from an Office Document
- Importing Web Content
- Importing Other Non-Wiki Content
- Note about Plugin Support

Related pages:

- Working with the Office Connector
- Confluence User's Guide
Importing Content from Other Wikis

Check whether the Universal Wiki Converter can import the content. See Importing Content from Another Wiki.

Importing Content from an Office Document

The Office Connector in Confluence allows you to import an Office document into Confluence, so that the document's content is copied onto one or more Confluence pages. See Importing a Word Document into Confluence.

Importing Web Content

Here are some options for importing or displaying web content on a Confluence page:

- Use the Widget Connector Macro to display videos, slide shows, twitter chats, documents and more, sourced from other web sites and displayed on your Confluence page.
- Convert a HTML file to a Confluence page using the HTML To Confluence Converter plugin.
- Embed an external web page into Confluence with the HTML Include macro.
- Use HTML code in a page with the HTML macro.

Importing Other Non-Wiki Content

Importing non-wiki markup into Confluence requires a conversion process:

- Text with basic formatting can be pasted directly into the editor. This includes simple Word documents or web pages.
- Files such as Microsoft Excel documents can be imported using a content converter plugin.
- Confluence pages saved to disk can be imported from disk.
- Files can be uploaded in bulk using the Confluence WebDav Plugin.
- Full featured customisation is available using the Confluence remote APIs.

Note about Plugin Support

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

Importing Pages from Disk

Confluence allows you to import text files from a disk or a directory on the Confluence server, and convert them into Confluence pages. Each file will be imported as a Confluence page that has the same name as the file.

The information on this page does not apply to Confluence OnDemand.

The text file needs to contain Confluence wiki markup to be converted accurately into a Confluence page.
- You need to be logged in as a System Administrator to import text files.
- You can import pages from disk into global spaces, but not into personal spaces. Please see Working with Spaces for information about differences between global spaces and personal spaces.

To import text files:

1. Choose Browse > Space Admin.
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click Import pages from disk in the left panel under 'Import'.
3. Type the directory's path into the Import directory box.
4. Select **Trim file extensions** to remove file extensions from the page titles when converting the files to Confluence pages. Note that the Confluence pages will take their titles from the files' names (including their extensions). So to avoid having page titles with a suffix like '.txt', make sure you check this box.

5. Select **Overwrite existing pages** if you want to replace existing Confluence pages with the same page title.

6. Click **Import**.

**Screenshot: Importing text files**

<table>
<thead>
<tr>
<th>Import directory:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim file extensions:</td>
</tr>
<tr>
<td>Overwrite existing pages</td>
</tr>
</tbody>
</table>

**Related Topics**

Take me back to [Confluence User's Guide](#)

**Sharing Content**

Confluence provides a number of ways for you to notify other people about content that may be of interest to them:

- You can [share a page link](#) with them.
- You can [mention](#) a user when you write a page, blog post or comment. Mentioning a user automatically emails a notification to them about that content.
- You can [broadcast a message](#) that appears in Confluence activity streams.
- You can [like](#) a page, blog post or comment. The author will receive a notification. If enough people like the content, it will appear in the list of popular content on the dashboard and in the recommended updates email message.

Other users can also find out about changes to content in Confluence by [watching](#) pages and spaces.

You may also be interested in [exporting Confluence content](#) to other formats such as XML, HTML, Microsoft Word and PDF.

**Related pages:**

- Creating Content
- Managing Changes and Notifications and Tasks
- Organising Content
- Confluence User's Guide

**Network Overview**

The 'network' feature provides notifications on the activity of users that you choose to follow. This compares with Confluence’s other [content tracking](#) features, which provide notifications on specified types of content updates, made by any user.

The types of activities tracked by the network feature include:

- Additions or edits to [pages](#) or [blog posts](#)
- [Comments](#) added to a page or blog post or edits to existing comments
- Updates to a user's [User Status Updates](#)
- Updates to a user's [User Profile](#)
Accessing Your Network View

To see your network view:

- Go to the 'Network' view for your user profile. To do this:
  - Go to your name (the 'User' menu) at the top of the page and choose Network.
  - You can also access your 'Network' view by clicking More in the 'Network' section of your Profile Sidebar.

You can access another user's Network view using the Hover Profile or from their Profile Sidebar.

Screenshot: Example of the Network view

Following Another User

You can follow another user by using either the Hover Profile or your Network view.

To follow a user with the Hover Profile:

1. Open the user's Hover Profile popup. To do this:
   a. Log in to Confluence, if you have not already done so.
To follow a user from your Network view:

1. Go to the 'Network' view for your user profile. To do this:
   - Go to your name (the 'User' menu) at the top of the page and choose **Network**.
     - You can also access your 'Network' view by clicking **More** in the 'Network' section of your Profile Sidebar.
   2. In the 'Following' section, at the right of the page, type the first few characters of the name (or username) of the user you wish to follow.
   3. Choose the user from the list of suggestions.
   4. Click **Follow** in the popup.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just followed will appear within the 'Following' list on the right. Additionally, their tracked activities will start appearing in the 'Recent Activity' list on this page.

Stop Following a User

To stop following a user by using the Hover Profile:

1. Open the user's Hover Profile popup. To do this:
   - Log in to Confluence, if you have not already done so.
   - Move your mouse pointer over a user's linked name or profile picture. Wait until the hover profile popup appears.
   2. Click **Stop Following** in the popup.

You can also stop following a user by going to their Profile view.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just stopped following are removed from the 'Following' list on the right. Additionally, their tracked activities will stop appearing in the 'Recent Activity' list on this page.

Notes

Once you are following a user, you can see their activity in a number of ways:

- Your Network view: your Network view shows all the tracked activities that you have permission to view for all the users that you are following. In the same way, people who follow you will be able to see all your Confluence-based activities on their network views, provided they have permission to view the content. See below for instructions on accessing your network view.
- RSS feeds: you can subscribe to any Confluence user's network RSS feed and receive summaries on the activities of other users they are following in their network. See **Subscribing to a Network RSS Feed**.
- Email notifications: you can request email notifications of any activity in your network. See **Subscribing to Email Notifications of Updates to Confluence Content**.

Note that it is not possible to stop another user from following you. If you are interested in the ability to block followers, please watch **CONF-16285** for updates on the feature request.

Related Topics

- **Network Macro**
- **Subscribing to a Network RSS Feed**
- **Subscribing to Email Notifications of Updates to Confluence Content**

Take me back to the **Confluence User's Guide**.
Subscribing to a Network RSS Feed

You can create an RSS Feed from any user’s network view, allowing you to receive summaries on the activities of users they are following in their network. The types of activities tracked in these RSS feed summaries include:

- Additions or edits to pages or blog posts
- Comments added to a page or blog post or edits to existing comments
- Updates to a user’s User Status
- Updates to a user’s User Profile

To subscribe to a user's network RSS feed,

1. Locate the following icon, which is available from the top-right of:
   - The 'Recent activity of the users you are following’ section of your network page, or
   - The 'Activity of followed users’ section of another user's network page.
2. Copy and paste the icon's link into your RSS newsreader.
3. To have your newsreader log into Confluence, you can [add your username and password to the feed URL](http://confluence.atlassian.com/feeds/network.action?username=ggaskell&max=60&publicFeed=false&os_authType=basic&rssType=atom).

   Please note that if you do this, someone with access to your RSS newsreader configuration can read these Confluence authentication details.

Customising your Network RSS Feed

Currently, Confluence does not provide a user interface mechanism for customising your network RSS feed. However, you can modify the maximum number of results and type of content displayed in these feeds by directly editing the RSS feed link in your RSS newsreader.

To modify the maximum number of results displayed in your RSS feed,

1. Edit the RSS feed link in your RSS newsreader.
2. Change the value of the max parameter from its default value of 40 to a value of your choice.
   The following example shows this parameter-value combination highlighted in red:
   `http://confluence.atlassian.com/feeds/network.action?username=ggaskell&max=60&publicFeed=false&os_authType=basic&rssType=atom`
3. Save the modified link in your RSS newsreader.

To modify the type of content displayed in your RSS feed,

1. Edit the RSS feed link in your RSS newsreader.
2. Append the parameter `contentType` to the end of the link, followed by an equals sign (=) and then add the appropriate content type value of your choice:
   - USER_STATUS — restricts the RSS feed to user status updates.
   - PAGE — restricts the RSS feed to page additions or updates.
   - BLOG — restricts the RSS feed to blog post additions or updates.
   - ATTACHMENT — restricts the RSS feed to attachment additions or updates.
   - COMMENT — restricts the RSS feed to comment additions or updates.
   
   Content type values are case-sensitive and when editing the network RSS feed link, ensure that each parameter is separated from the other by an ampersand (&).
   The following example shows the content type parameter-value combination highlighted in red:
   `http://confluence.atlassian.com/feeds/network.action?username=ggaskell&max=40&publicFeed=false&os_authType=basic&rssType=atom&contentType=USER_STATUS`
3. Save the modified link in your RSS newsreader.
Filtering for more than one type of content (by adding multiple values to the `contentType` parameter) is not supported.

## RELATED TOPICS

- Network Overview
- Subscribing to RSS Feeds within Confluence

Take me back to the [Confluence User's Guide](#).

### Likes and Popular Content

Has someone written a good blog post or page on Confluence? Or has someone added a comment that you agree with? Click the **Like** button to let them know.

Confluence has like buttons on every page, blog post and comment. If enough people like a page or post, it will show on the dashboard’s ‘Popular’ tab. The information in the ‘Recommended Updates’ email message is based on the number of people who have liked the content.

#### Liking a page, blog post or comment

Click the **Like** button to let people know that you agree with or enjoy a page, blog post or comment. Click **Unlike** to remove your name from the list of people who like the content.

You can also see:

- Up to three names of people in your network who have most recently liked the content.
- A link showing the number of people who have liked the comment. For example, **19 people like this**. Click the link to see the names. At the top of the list are people in your network, sorted with the most recent likes first. Then follow other people, also sorted chronologically with the most recent first.

**On this page:**

- Liking a page, blog post or comment
- Effects of liking content
- Disabling the 'like' feature

**Related pages:**

- Dashboard
- Subscribing to Email Notifications of Updates to Confluence Content
- Network Overview

*Screenshot: The Like button at the bottom of a page and on comments*
Effects of liking content

When you like a page, blog post or comment:

- The author of the content receives a notification.
- People in your network receive a notification. They will receive the notification only if they do not already know about the content. Let's assume Arthur is in your network. Arthur will not receive a notification if:
  - Someone else in his network has already liked the content.
  - Arthur himself has already liked the content.
  - Arthur has already commented on it.
  - Arthur has already replied to the comment.
- If enough people like the content, it will appear on the 'Popular' tab of the dashboard.
- Similarly, if the content is popular enough it will appear in the 'Recommended Updates' summary sent out by email.

Disabling the 'like' feature

The functionality is provided by a plugin called the 'Confluence Like Plugin'. To remove the 'like' functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.

Note: It is not currently possible to disable this feature in Confluence OnDemand. We are tracking this issue here: CONF-25469 - Authenticate to see issue details.

User Status Updates

The 'user status' feature allows any Confluence user to broadcast a short message, which other users can see on various activity streams in Confluence. These short messages could include:

- A description about what you are working on.
- A question you may want answered quickly.
• A hyperlink that you share immediately with other users.
• Any other message you may want to share quickly with other users.

Your 'Status Updates' view shows a history of updates you have made to your status. Your current status message is shown on your:

• Profile view
• Profile sidebar
• Hover profile

On this page:

• Setting or updating your status
• Viewing your status updates
• Clearing your current status
• Deleting a status update
• More about user status updates
• Disabling status updates

Related pages:

• User Profile Overview
• User Status List Macro
• Confluence User's Guide

Setting or updating your status

To set or update your status:

1. Log in to Confluence, if you have not already done so.
2. Go to your name (the 'User' menu) at the top of the page and choose Update Status. The 'What are you working on' dialog will open.
3. Enter a short message (140 characters maximum) that describes your current status or what you are working on.
4. Click Update to publish your new or updated status to the activity streams (mentioned above), your personal space sidebar, your profile page and your status updates page.

Screenshot: User status window

Viewing your status updates

To view your status updates:

• Go to the 'Status Updates' view for your user profile. To do this:

  1. Go to your name (the 'User' menu) at the top of the page and choose Status Updates.
You can also view another user's status by going to their profile.

**Screenshot: Status updates view**

<table>
<thead>
<tr>
<th>Profile</th>
<th>Network</th>
<th>Status Updates</th>
<th>Labels</th>
<th>Watches</th>
<th>Drafts</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Your Status Updates</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot; Touching up the Community-based features.</td>
<td>Clear</td>
<td></td>
<td>Delete</td>
<td>5 minutes ago</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot; Now working on the Release Notes.</td>
<td>Delete</td>
<td></td>
<td></td>
<td>23 minutes ago</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot; Moving onto Networks</td>
<td>Delete</td>
<td></td>
<td></td>
<td>May 06</td>
</tr>
</tbody>
</table>

**Clearing your current status**

You can clear your current status message using your profile or your status updates view.

Clearing a message is not the same as deleting it. If you clear a message, it is still shown in your status updates view until it is deleted.

**Using your Profile view...**

To clear your current status using your profile view:

1. Go to **your name** (the 'User' menu) at the top of the page and choose **Profile**.
2. Click **Clear** in the status message at the top of the page.

**Screenshot: Clearing your current status message using your profile view**

<table>
<thead>
<tr>
<th>Profile</th>
<th>Network</th>
<th>Status Updates</th>
<th>Labels</th>
<th>Watches</th>
<th>Drafts</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Profile</strong></td>
<td>Details</td>
<td>Picture</td>
<td>Password</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Activity</strong></td>
<td>&quot; Touching up the Community-based features. &quot;</td>
<td>less than a minute ago</td>
<td>Clear</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>&quot; Now working on the Release Notes. &quot;</td>
<td>24 minutes ago</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td></td>
<td></td>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td>updated about 3 hours ago</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td></td>
<td></td>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td>updated about 4 hours ago</td>
<td></td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td></td>
<td></td>
<td><img src="image" alt="Confluence 3 performance release notes" /></td>
<td>commented about 8 hours ago</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Using your Status Updates view...**

To clear your current status using your status updates view:
1. Go to the 'Status Updates' view for your user profile. To do this:
   a. Go to your name (the 'User' menu) at the top of the page and choose Status Updates.
2. Click Clear in the status message at the top of the page.

Deleting a status update

To delete your current or a previous status message:

1. Go to the 'Status Updates' view for your user profile.
2. Click Delete next to the appropriate status message. Your status updates view will be refreshed and the message you deleted removed from the list.

More about user status updates

There are a number of activity streams in Confluence that show different types of status updates. These include:

- The 'Recently Updated' list on the Confluence Dashboard, which shows all status updates (when the All tab is selected).
- Your Network page, which shows the status updates of Confluence users you are following.
- The Network page of Confluence users who are following you, which shows your status updates.
- The Recently Updated and Recently Updated Dashboard macros, which shows all status updates (provided that these macros' space parameters have been set to '@all').
- Any Confluence user's 'Activity' section of their Profile Sidebar, which is available on all pages within their personal space and shows their status updates.

While activity streams show recent status updates, they may soon disappear from the end of the list as subsequent user activity items appear on these streams. However, you can view any Confluence user's current status message in the following areas:

- Their Hover Profile.
- The Profile section of their Profile Sidebar, which is available on all pages within their personal space.
- Their Profile page.

You can also view any Confluence user's entire history of User Status updates in their Status Updates page.

Disabling status updates

The functionality is provided by a plugin called 'User Status'. To remove the status updates functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.

You can also control which users can and cannot use status updates with the global permissions. By default,
users will not have permission to use this feature. See Global Permissions Overview.

**Using Mentions**

You can mention a person in a special way that prompts Confluence to send that person an email notification. This is called an @mention. It works on Confluence pages, blog posts and comments.

When you save the page, Confluence sends an email message to the user letting them know that they have been mentioned on that page (if they have permission to view the page) with a link to the relevant page.

**Note:** Use the person's full name. The user mention feature recognises the full name only, not the username.

There are two ways to mention someone:

- The quickest way is to start typing '@' and the person's name, then choose from the suggestions that Confluence offers. This is called autocomplete.
- Alternatively, you can choose Insert > User Mention from the editor toolbar.

Each of these methods is described in more detail below.

**Using autocomplete to mention someone**

**To mention someone using '@':**

1. Edit the page.
2. Click where you want to insert a mention and type '@' and then the first few characters of the user's full name.
3. Choose the user's name from the list of suggestions.

**Screenshot: Autocomplete for mentions**

![Autocomplete for mentions](image)

**On this page:**

- Using autocomplete to mention someone
- Accessing the user mention option in the editor toolbar
- Notes

**Related pages:**

- Using the Editor
- Using Autocomplete
- Keyboard Shortcuts
- Confluence User's Guide

**Accessing the user mention option in the editor toolbar**
To add a user mention via the editor toolbar:

1. Edit the page.
2. Choose Insert > User Mention. Confluence will add an ‘@’ sign to the page, and display a dropdown list of suggested users for you to choose from.
3. Start typing the person's name, to refine the list of suggestions.
4. Choose the person from the list of names.

Screenshot: The user mention option in the editor toolbar

Notes

- **Seeing your mentions in the Confluence workbox.** The Confluence workbox displays all notifications collected from page watches, shares and mentions. See Managing Notifications in Confluence.
- **Disabling the user mention feature.** The functionality is provided by a plugin called the 'Confluence Mentions Plugin'. To remove the user mention functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.
- **Mentioning groups.** It is not possible to mention a group and then have the email sent to the entire group. You can only mention individual users. There is a feature request to allow mentions for groups: CONF-23015 - Authenticate to see issue details

Emailing a Page

You can share a Confluence page or blog post by emailing a link to recipients of your choice. The recipients can be Confluence users or any email addresses.

To email a link to a Confluence page or blog post using the Share button:

1. Go to the page or blog post you wish to share.
2. Click Share at the top right of the page.
   Note: The Share button will not be visible if your Confluence administrator has not configured an outgoing mail server for your Confluence site. See Configuring a Server for Outgoing Mail.
3. Enter the name or username of a Confluence user or any email address. As you start typing a name or username, or when you have typed a valid email address, an autocomplete dropdown will appear.
4. Select the appropriate user or email address from the dropdown. You can add multiple recipients to the
list.
5. Enter an optional message into the Note box.
6. Click Share to send the link via email.

Related pages:
- Working with Pages
- Working with Blog Posts
- Confluence User's Guide

Screenshot: Sharing a page

To remove a recipient from the list, click the bin icon to the right of the recipient.

### Exporting Confluence Pages and Spaces to Other Formats

You can convert a part of, or the entire contents of a space to various formats, including Microsoft Word, HTML, PDF and XML. This is called 'exporting' the space.

**What would you like to do?**

- Exporting Confluence Pages and Spaces to HTML
- Exporting Confluence Pages and Spaces to PDF
- Exporting to a Word document
- Exporting Confluence Pages and Spaces to XML

**Related topics**

- Working with Spaces
- Confluence User's Guide

### Exporting Confluence Pages and Spaces to HTML

Confluence allows you to export part of, or the entire contents of, a space into a zipped archive of HTML files. This is useful if you want convert your space into a static website.

To use the space export functionality, you need 'Export Space' permission. See the guide to space permissions.
or contact a [space administrator](#) for more information.

To export pages to HTML:

1. Go to a page in the space and choose **Browse > Advanced**.
2. Click **HTML Export** in the left-hand panel. This option will only be visible if you have 'Export Space' permission.
3. Select the **Include Comments** check box if you want to include comments for the pages you are exporting.
4. Select the pages you want to export by selecting the check boxes in the tree view of pages displayed. By default, all pages are selected. You have the option to **Select All** or **Deselect All** pages.
   - If you select the check box of a page that contains one or more child or descendant pages, all of these child and descendant pages will also be selected. Similarly, if you clear the check box of such a page, all of its child and descendant pages will also be cleared. This provides a convenient method of exporting subtrees, for example, chapters or sections within a document.
5. Click **Export**. This will create a zipped archive of HTML files.
6. When the export process has finished, download the zipped archive as prompted and extract the files into a folder.

**Screenshot: Selecting pages to export**

![Export Space](#)

**Notes**

- Page attachments are placed in individual folders with names in the following format: `...\download\attachments\xxxxxx` where `xxxxxx` is the page ID of the page containing the attachments.
- By default, the 'Space Details' page is exported as `index.html` and displays the space's details as well as a list of all available pages within it.
- Blog posts are not included in the HTML export. See the feature request: [CONF-14684](#).

**Related Topics**

- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to XML
Exporting Confluence Pages and Spaces to PDF
This page explains how you can export individual Confluence pages, entire spaces or selections of pages into a single PDF file.

On this page:
- Exporting Single Pages
- Exporting Multiple Pages or the Entire Space
- Customising the Appearance of PDF Exports
- Notes
- Related Topics

Exporting Single Pages
You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page:

- Go to a page in the space and choose Tools > Export to PDF. Follow the prompts to export the page.

Note that the export of a single page to PDF applies any PDF stylesheet customisations, but does not apply any PDF layout customisations. To make your PDF layout customisations apply to a single page exported to PDF, use the ’multiple page’ method described below to export that single page only. See Customising Exports to PDF.

Comments on the page are not exported to the PDF file.

Exporting Multiple Pages or the Entire Space
Using Confluence's space export functionality, you can convert multiple pages or an entire space to PDF.

To use the space export functionality, you need ’Export Space' permission. See the guide to space permissions or contact a space administrator for more information.

To export a space or selected pages to PDF:

1. Go to a page in the space and choose Browse > Advanced.
2. Click PDF Export in the left-hand panel. This option will only be visible if you have the ’Export Space’ permission.
3. Select the pages you want to export.
   - You have the option to Select All or Deselect All pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
4. Click Export.
5. When the export process has finished, download and save the PDF file as prompted.
Customising the Appearance of PDF Exports

You can add a title page, a table of contents and customised headers and footers to the PDF output. For more advanced customisations, you can apply Cascading Style Sheet (CSS) modifications. These customisations are specific to each space. You need the ‘Space Administrator’ permission to be able to apply these customisations. For more information, see Customising Exports to PDF.

Notes

- Only image attachments that have been inserted into a page are included when exporting to PDF.
- To export a PDF containing international text, you need to install a Unicode font in Confluence.
- Blog posts are not included within the PDF export. If you like, you can vote for this feature request: CONF-5599.
- If you have ‘Space Administrator’ permissions, the link to customise the PDF Stylesheet is provided at the top of the page tree, as shown in the screenshot above.
- Confluence's PDF Export feature is designed to handle a wide variety of content. However, on rare occasions the PDF Export process may fail due to an unrecognised customisation. If that happens the PDF export screen will indicate the title of the page in which the problem occurred, to help you diagnose the cause of the failure.

Related Topics

- Customising Exports to PDF
- Advanced PDF Stylesheet Customisations
- Creating PDF in Another Language
- Exporting Confluence Pages and Spaces to HTML
- Exporting Confluence Pages and Spaces to XML

Take me back to the Confluence User's Guide.

Customising Exports to PDF

Confluence administrators and space administrators can customise the PDF exports for individual spaces.
Please take note of the following points:

- PDF customisations are unique to each space.
- Confluence's PDF customisations use a combination of HTML and CSS (Cascading Style Sheets).
- To achieve a particular requirement in the exported PDF file, you make changes in one or both of the following:
  - The PDF Layout, where HTML is used to define the structure of the exported content, including features such as the title page, headers and footers.
  - The PDF Stylesheet, where CSS is used to define the style of elements in the exported content, such as page size and margins, font, colour, and list numbering.

For further customisations, see the Advanced PDF Export Customisations page.

On this page:

- Customising the PDF Layout
  - Setting a global PDF layout
  - Setting the PDF layout at space level
- Customising the PDF Stylesheet
  - Setting a global PDF Stylesheet
  - Setting a space-level PDF stylesheet
- Example Customisations
  - Page Size
  - Page Orientation: Landscape or Portrait
  - Page Margins
  - Page Breaks
  - Title Page
  - Table of Contents
  - Headers and Footers
  - Page Numbering
  - Wrapping Long Words
  - General Formatting

Customising the PDF Layout

You can add your own HTML to customise the title page, page headers and page footers in the PDF output.

To customise the PDF Layout:

Setting a global PDF layout

1. Open the Confluence Admin screen.
2. Select Look and Feel > PDF Layout. The following screens allows you to enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.

Setting the PDF layout at space level

1. Choose Browse > Space Admin.
   *Note:* ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click PDF Layout in the ‘Look and Feel’ section of the left-hand panel.
3. Click Edit, and customise the HTML that generates the following areas in the exported PDF document:
   - PDF Space Export Title Page – title page.
   - PDF Space Export Header – page headers.
   - PDF Space Export Footer – page footers.
4. Enter your customisations into each text box as required. The PDF layout section accepts HTML code.
You can include inline CSS in the HTML too. Save your work.

Customising the PDF Stylesheet

You can adjust the appearance of the PDF pages by making CSS customisations in the PDF Stylesheet screen as required.

- To get started, you can download the default CSS rules of the PDF stylesheet: `confluencedefaultpdf.css`. Any rule defined in this file can be customised and added to the 'PDF Export Stylesheet' section.
- Your customisations override any default CSS rule.
- If no PDF customisations are defined in the PDF Stylesheet screen, the default CSS rules will be applied to your PDF exports. By default, the export does not include a title page, headers or footers.

To customise the PDF Stylesheet:

Setting a global PDF Stylesheet

1. Open the Confluence Admin screen.
2. Click Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code that will render content on each page.

Setting a space-level PDF stylesheet

1. Choose Browse > Space Admin. Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click PDF Stylesheet in the left-hand panel. The 'PDF Export Stylesheet' section appears, showing the current contents of your PDF stylesheet. It contains all CSS rule customisations applied to the pages in the space.
3. Click Edit and enter your customisations into the text box as required. The PDF stylesheet section accepts Cascading Style Sheets (CSS) rules. Save your work.

Example Customisations

This section provides examples of typical customisations that you can add. See also Advanced PDF Customisations.

Page Size

The default page size is based on the locale of your Confluence server. For example, if this server is located in the US then the default paper size of your PDF export will be US Letter (8.5 inches wide by 11 inches long). If the server is located in Australia, the default paper size will be A4 (210 mm wide by 297 mm long). More information about paper sizes can be found on Wikipedia.

To modify the page size to A4, edit the PDF Stylesheet to add a size property to the CSS `@page` rule, like this:

```css
@page
{
/*The A4 paper size is 210 mm wide by 297 mm long*/
size: 210mm 297mm;
}
```

Page Orientation: Landscape or Portrait

To change the page orientation of your PDF document, simply reverse the order of the values declared in the `@page` rule's size property. The first and second values of this property represent the width and height of the page, respectively.
For example, to generate PDF space exports in A4-sized landscape orientation, your @page rule might look like this:

```css
@page
{
/*A4-sized pages in landscape orientation are 297 mm wide by 210 mm long*/
size: 297mm 210mm;
}
```

**Page Margins**

To set all margins to 15 mm, with a paper size of A4, edit the CSS @page rule in the PDF Stylesheet, like this:

```css
@page
{
size: 210mm 297mm;
margin: 15mm;
}
```

To set the margins independently, edit the @page rule as follows:

```css
@page
{
margin-top: 2.54cm;
margin-bottom: 2.54cm;
margin-left: 1.27cm;
margin-right: 1.27cm;
}
```

To set margins to provide a gutter for binding a printed document, use the :left and :right pseudo-classes, as follows:
CSS - PDF Stylesheet

```css
@page :left
{
  margin-left: 4cm;
  margin-right: 3cm;
}

@page :right
{
  margin-left: 3cm;
  margin-right: 4cm;
}

@page :first
{
  margin-top: 10cm /* Top margin on first page 10cm */
}
```

Note the use of the `.first` pseudo-class in the example above to define distinct margins for a cover or title page.

**Page Breaks**

By default, Confluence pages are exported without page breaks, so that shorter pages will appear on the same PDF page.

To make each Confluence page appear on a separate page in the PDF file, add the following rule in the PDF Stylesheet:

CSS - PDF Stylesheet

```css
.pagetitle
{
  page-break-before: always;
}
```

**Title Page**

You can add a title page to your PDF document by adding HTML to the Title Page section of the PDF Layout screen. The following example creates the title page and adds a title:

**HTML - PDF Layout: Title Page Section**

```html
<div class="fsTitlePage">
  <img src="/download/attachments/590719/titlepage.png" /> 
  <div class="fsTitle">Planning for Confluence 4.0</div> 
</div>
```

Use CSS rules in the PDF Stylesheet to control the appearance of the title page and the title text:
Adding an Image to the Title Page

In the example above, the title page includes an image called 'titlepage.png', centred in the middle of the page. The "590719" in the src attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your title page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate src="" attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before /download/....

Table of Contents

By default, a table of contents will be generated after the title page, or at the beginning of the PDF document if no title page is defined in the PDF Layout. To see the default CSS rules applied to the table of contents, download the default CSS rules (confluencedefaultpdf.css) and examine the specific rules with toc in their name.

To make changes to the appearance of the table of contents, define CSS rules in the PDF Stylesheet.

Disabling the Table of Contents

To prevent the table of contents from being generated in your PDF document, add the div.toc rule to the PDF Stylesheet and set its display property to none:

```css
CSS - PDF Stylesheet

div.toc
{
    display: none;
}
```

Changing the Leader Character in the Table of Contents

The leader character is used to link a heading in the table of contents with its page number. By default, the...
leader character is the '.' (dot) character. Leader values of dotted, solid and space are allowed. You can also use a string, for example leader(" . . ").

To change the leader character to a solid line, modify the leader() value on the content property of the CSS rule as follows:

```css
span.toclead:before
{
  content: leader(solid);
}
```

Headers and Footers

You can add headers and footers to your PDF pages using the 'Header' and 'Footer' sections of the PDF Layout screen. By default, headers and footers only apply to a space export and not to exports of single pages (however, see Advanced PDF Export Customisations). The following example adds a simple copyright notice.

```html
Copyright © 2011, Atlassian Pty Ltd.
```

Page Numbering

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. PDF Layout HTML: In the Footer section (or the Header section), use an empty span element with a unique ID, for example pageNum, to act as a place holder for the page number.

   ```html
   <span id="pageNum"/>
   ```

2. PDF Stylesheet CSS: Create the following CSS selector rule for the empty span:

   ```css
   #pageNum:before
   {
   content: counter(page);
   }
   ```

   Analysing the above CSS selector rule in more detail:
   - The #pageNum rule selects the HTML element with the specified ID of "pageNum", which is the span element we created for the header or footer.
- The :before part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
- The counter(page) is a function that returns the current page number as its content.
- The content property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.

Wrapping Long Words

In order to break long words or words that are not separated by whitespace, add a selector to the PDF stylesheet containing the word-wrap property with a value of break-word:

CSS - PDF Stylesheet

```css
div {
  word-wrap: break-word;
}
```

General Formatting

You can use the stylesheet to customise the output of just about anything else that will influence the look and feel of the final document. This includes fonts, tables, line spacing, macros, etc. The export engine works directly from the HTML output produced by Confluence. Therefore, the first step in customising something is to find a selector for the HTML element produced by Confluence or the Confluence macro. Then add a CSS rule to the PDF stylesheet. Your customisation will appear in the PDF export.

Notes

- **Demotion of heading elements:** h1, h2, and so on. Due to the hierarchical manner in which a space is exported, Confluence will modify the heading elements to generate a uniform appearance for the entire space export. This means that headings will be demoted. This will affect the application of custom PDF Stylesheets. It is possible to calculate the amount by which a heading will be demoted in order to have the correct CSS styling applied. A heading will be demoted by the value of its depth in the export tree. A page at the first level will be demoted by 1 (all <h1> elements will become <h2> elements, and so on). A page at the second level will be demoted by 2, and so on.

- **Atlassian support for PDF customisation is limited.** We support the mechanism for customising the PDF layout with HTML and CSS, and we will help if the mechanism is broken or does not work as we say it should in our published examples. But, since custom HTML and CSS offer potentially limitless possibilities, Atlassian will not support issues that are caused by or related to PDF customisations.

Related Topics

**Advanced PDF Export Customisations**

This page provides information about 'advanced' PDF export customisations. These expand upon the regular customisations described in [Customising Exports to PDF](#)

⚠️ The information below is for advanced users. Customisations are not supported by Atlassian. Be aware that the advanced customisations described below require knowledge of certain parts of Confluence, and of CSS and HTML. This documentation is intended for advanced users. Some of the suggestions below are moderately complex, or irregular in nature. If you are having trouble understanding them we strongly suggest you ask an expert. We do not support any of the customisations described below. This means that the Atlassian support engineers will not be able to help you with these modifications.
Adding Headers and Footers to Single Page Exports

By default, custom headers and footers set up in the PDF Layout screen (see Customising Exports to PDF), only apply to space exports and not to exports of single pages. However, it is possible to add CSS rules to your PDF Stylesheet that produce headers and footers in single page exports as well as space exports.

For custom headers, define @top-left, @top-center and @top-right rules within your @page rule. These rules apply respectively to content that appears on the left-hand side, centre and right-hand side of your page's header area.

For custom footers, define @bottom-left, @bottom-center and @bottom-right rules within your @page rule.

For example, the following rules add a document title at the centre of the header and a page number at the centre of the footer:

```
CSS - PDF Stylesheet

@page {
    @top-center {
        content: "Document Title Goes Here";
        font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
        font-size: 8pt;
    }
    @bottom-center {
        content: "Page " counter(page);
        font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
        font-size: 8pt;
    }
    /* Any other page-specific rules */
}
```

Notes:

- The font-family and font-size properties ensure that the header and footer text is rendered in the same default font style used for the body text, based on the default CSS rules.
- It is not possible to use this method to insert images (stored as attachments within your Confluence instance) into the headers and footers of single page exports.
Adding Images to Headers and Footers

To insert an image into the header or footer, add HTML to the Header or Footer section of the PDF Layout screen.

The following example uses an HTML `img` element with `src` attribute to add an image to the left of the header. The `src` attribute refers to an image attached to a Confluence page. The image element is usually placed within a `div` element container.

```
<div style="margin-top:10mm">
  <img src="/download/attachments/12346/header-image.png"/>
</div>
```

In the example above, the header includes an image called 'header-image.png'. The "12346" in the `src` attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate `src` attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before `/download/`.

Notes:

- This example uses an inline CSS property `margin-top` in the `style` attribute to force the image away from the top of the page by 10mm. This comes in handy when your header image is large enough to touch or spill over the top of the page.
- Likewise, for footers, you can use the `margin-bottom:XXmm` property to force an image away from the bottom of the page by ‘XX’ mm.
- Very large images can spill over into the body of a page or alter the position of text or other elements used within a header or footer. In such situations, it is recommended that you reduce the size of the image and then attach it to your Confluence page again. If you prefer to keep the image size and want to move the content lower instead, you can do so by configuring the `margin-top` properties in the @page CSS rule.
- By default, a header or footer image is aligned to the left-hand side of the page. However, you can align this image to the centre or right-hand side of a page by adding either the `text-align:center` or `text-align:right` properties to your `style` attribute. For example, to align the header image to the right-hand side of the page, your `style` attribute would look similar to this: `style="margin-top:10mm; text-align:right"`.

Incorporating Other Fonts

By default, Confluence provides Times New Roman, Helvetica or Courier fonts for use in PDF exports. You can use your own fonts for PDF exports by declaring them in a `@font-face` CSS rule in your PDF Stylesheet.

The following CSS rule example shows how to declare the Consolas font and apply it to some elements for your PDF export:
The font path specified in the CSS must be the path to the font on the Confluence server.

Adding a Dynamic Title to the Title Page

When you export an arbitrary set of pages from Confluence, you may like to have a corresponding title added to the cover (or title) page automatically. This can be done (in a somewhat irregular way) by using the top level item from the default table of contents as the title. This method relies on having the exported pages structured as sub-pages of the top-level page. In other words, the pages to be exported should consist of a page (at the top-level) and all of its child pages. The result is that the title that appears on the cover page changes depending on the top-level page that is used for the export.

The CSS below moves, and styles, the top-level TOC item for use as the title on the cover page, and turns off the leader and page number normally associated with this item in the TOC.
Hiding Text from the PDF Output

This section describes a way to hide text from your PDF export. In other words, you can have text on the Confluence page that will not appear in the PDF export.

There are three steps:

1. Follow the instructions to define the NoPrint user macro.
2. Use the NoPrint macro to mark some text on a Confluence page.
3. Add the following CSS to your PDF stylesheet to make the PDF export recognise the NoPrint macro:

CSS - PDF Stylesheet

```css
.noprint
{
  display: none;
}
```

Indexing

To obtain an index at the end of the exported PDF file, consider using the Scroll Wiki PDF Exporter plugin that is produced by K15t Software GmbH.
Notes

If styling is not working as expected, it is useful to look at the intermediary HTML source to which the CSS is applied. This intermediary HTML is created whenever you create an HTML export that contains multiple pages, and is stored in the temp directory in Confluence's home directory. For example:

```
<confluence-home>/temp/htmlexport-20110308-154047-1/export-intermediate-154047-2.html
```

Related Topics

Customising Exports to PDF

Creating PDF in Another Language

To export a Confluence page written in a language other than English, you need to install the necessary font for that language. This means that you need to upload the font file to Confluence, as described below.

Uploading a Font File to Confluence

1. Find the appropriate font file:
   - **Windows users:** All font files in Windows are stored in a directory called:
     ```
     C:\WINDOWS\Fonts
     ```
   - **Unix users:** All font files in Unix are stored in:
     ```
     /usr/share/fonts
     ```
   - Microsoft True Type core fonts such as Verdana can be downloaded from this page: [http://corefonts.sourceforge.net/](http://corefonts.sourceforge.net/)
2. Copy the font file into a temporary folder, for example a folder on your desktop.
3. Go to the 'PDF Export Language Support' screen in the Confluence Administration Console and upload the file you copied in step 2.
4. Click **Install**.

Notes

- The only font files supported are true type fonts and true type collections. The accepted file extensions are *.ttf and *.ttc.
- We recommend that you use Unicode font Verdana for correct character encoding and exporting to PDF.
- If the font file size is bigger than your current attachment size limit, you won't be able to upload it. Please increase the attachment size limit temporarily and re-upload again. An improvement of the error messaging is tracked at [CONF-24706](https://jira.atlassian.com/browse/CONF-24706) - Authenticate to see issue details.

Related Topics

Exporting Confluence Pages and Spaces to PDF

Exporting to a Word document

Confluence allows you to export a single page into a Word document. This is useful for emailing content to people who do not have access to Confluence.
Exporting a page to Word

You will require ‘Export Pages’ permission to export a page to a Word document. By default, this will create a Word document with the same name as the Confluence page.

To export a page to a Word document:

Go to the page and choose Tools > Export to Word.

Useful plugins

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

This plugin provides extended functionality for exporting Confluence pages to Microsoft Word: Scroll Office.

Exporting Confluence Pages and Spaces to XML

Confluence allows you to export a part of, or the entire contents of, a space into a zipped archive of XML files.

This is useful if you want to make a backup of the space, export the space to another Confluence instance, or use the data from the space in another application. Please note that there are a few restrictions when Restoring a Space, and that huge spaces exported for backup-purposes may benefit from other means of backup. See Production Backup Strategy.

To export to XML, you will need ‘Export Space’ permission which is assigned by a space administrator. See Space Permissions or contact a space administrator for more information.

Site administrators can import a space from a zipped XML archive.

To export to XML:

1. Go to a page in the space and choose Browse > Advanced.
2. Click XML Export in the left-hand panel.
   This option will only be visible if you have ‘Export Space’ permission.
3. Select Include Comments if you want to include comments made on the pages you are exporting.
4. Select Backup Attachments if you want include the images and other files attached to the pages.
5. Select the pages you want to export. Select the relevant check boxes in the tree view of pages displayed.
   By default, all the pages are selected. If you select a page that has one or more child or descendant pages, all of these child and descendant pages will also be selected. Similarly, if you clear the check box of such a page, all of its child and descendant pages will also be cleared. This provides a convenient method of exporting subtrees, for example, chapters or sections within a document.
6. Click Export. This will create a zipped archive of XML files. When the export has finished, Confluence will offer you the option to download the zip file.

Screenshot: Exporting a space with administrator permissions
Notes

- If you are running Confluence behind Apache HTTP Server and are facing timeout errors, please consider creating the export directly from Tomcat, instead of going through Apache. This will speed up the process and prevent timeouts.
- If you have **Space Administrator** or **Confluence Administrator** permissions, you can export either **All pages** or those pages **Visible to you**. **All** exports all content in the space, including pages that are protected by page-level restrictions which will prevent you from viewing the pages themselves. This option is available only to space administrators and Confluence administrators. It allows you to make a complete and comprehensive export of a space for backup purposes. **Visible to you** exports only content you can see. This is the default option.

Related Topics

- Restoring a Space
- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to XML
- Working with Spaces
- Confluence User's Guide

Commenting on pages and blog posts

A comment is a remark, question, or any other additional information you wish to add to a page or blog post. Comments are a means by which a people can interact with each other on the site.

You can add a comment to any page or blog post, provided that you have the 'Add Comments' permission in the space. You can also show that you agree with or enjoyed someone else's comment, by liking it.

Comments are displayed at the bottom of the page, below the page content. Comments in Confluence are displayed in one of two views, configured globally by a **site administrator**:

- **Threaded** – This view shows the comments in a hierarchy of responses. Each subsequent reply to a comment is indented to indicate the relationships between the comments.
- **Flat** – This view displays all the comments in a single list and does not indicate the relationships between comments.
Adding a comment

You can add a new comment, on pages and blog posts in Confluence. If the Confluence site displays comments are in threaded view, you can respond to previous comments too.

To add a comment, you need the 'Add Comments' permission which is assigned by a space administrator. See Space permissions or contact a space administrator for more information.

To add a new comment:

1. Choose Add > Comment from the top of the page, or click in the box next to your profile picture below the last comment.
2. Type in your comment.
3. Click Preview to see how your comment will appear.
4. By default, Watch this page is ticked. This means that you will start receiving notifications about this page. Remove the tick if you do not want to watch the page.
5. Click Save.

To respond to a comment:

1. Click Reply located below the text of a comment.
2. Type in your response.
3. Click Save.

Editing a comment

To add a comment, you need the 'Add Comments' permission which is assigned by a space administrator. See Space permissions or contact a space administrator for more information. Space administrators can edit all comments within their space. The date on a comment always indicates the time the comment was last edited.

To edit a comment:

1. Go to the comment and click Edit.
2. Make changes to the comment just as if you were adding a comment.
3. Click Save when you are finished.

Deleting a comment

To delete a comment from a page, you need the 'Remove Comments' permission which is assigned by a space administrator. See Space permissions or contact a space administrator for more information.

- It is not possible to delete all comments for a page simultaneously.
• **Note:** Deleted comments cannot be restored.

**To delete a comment:**

1. Go to the page that contains the comment.
2. Click **Remove** at the bottom of the comments box. This is only displayed if you have permission to remove comments for this page.

**Notes**

- You can choose **Tools > Watch** to receive an email notification whenever anyone edits the page or adds a comment to the page.
- Your **profile picture** will appear next to each comment that you have added. (This is true if your space uses the Confluence Default theme.)
- On blog posts only, an ‘Author’ lozenge will appear on any comments made by the original author of the post.
- Comments are not auto-saved. See feature request: [CONF-12978 - Authenticate](#) to see issue details

**Linking to Comments**

You can add a link to a comment by making use of the PermaLink associated with each comment.

---

**On this page:**

- To link to a comment from within Confluence
- To link to a comment from outside Confluence
- Related Topics

---

**To link to a comment from within Confluence**

1. Right-click on the Permalink icon located at the lower right of the comments box.
2. Select **Copy Link Location** from the pop-up menu.
3. Edit the page from which you want to link to the comment.
4. Click **Link** in the toolbar, and select the **Web Link** tab.
5. Paste the PermaLink into the address field.
6. Provide link text if required.

**To link to a comment from outside Confluence**

1. Right-click on the Permalink icon located at the lower right of the comments box.
2. Select **Copy Link Location** from the pop-up menu.
3. Use this URL to link to the comment from your web page.

Alternately, click on the Permalink icon and copy the URL displayed in the address bar of your browser.

---

ℹ️ The older method of linking to comments (used in Confluence 3.5.x and older) using just the commentid has been removed. If you would like to see it reinstated, please [visit this JIRA issue](#).

**Related Topics**

- Commenting on pages and blog posts
- Working with Links

Take me back to [Confluence User's Guide](#)

---

*[Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.]*
Printing Confluence Pages

You can print one or more Confluence pages:

- To print a single page, use your browser's 'Print' option.
- Confluence allows you to export a single page, a part of a space, or an entire space into a single PDF file. See [Exporting Confluence Pages and Spaces to PDF](#).

Managing Changes and Notifications and Tasks

Confluence provides several ways in which you can watch for changes to single pages, entire spaces, and all spaces on the site. You can also follow the updates made by specific people. You can only track updates to content that you have permission to see.

Personal tasks appear in the task-and-notification dialog, and you can assign team tasks via a task list on a page.

Making yourself a watcher of pages or spaces

You can 'watch' a page, blog post or space that you have permission to view. Confluence will then send you an email notification whenever someone adds or updates content on, or adds a comment to, that page or space. See:

- [Watching a Page or Blog Post](#)
- [Watching a Space](#)

If you have space administrator permissions, you can [manage watchers of pages and spaces](#).

Requesting other notifications

You can configure Confluence to send you various digest reports via email. See [Subscribing to Email Notifications of Updates to Confluence Content](#).

On this page:

- [Making yourself a watcher of pages or spaces](#)
- [Requesting other notifications](#)
- [Tracking updates by specific people](#)
- [Managing your notifications and tasks](#)
- [Using Confluence RSS feeds](#)

Related pages:

- [Page History and Page Comparison Views](#)
- [Viewing Space Activity](#)
- [Contributors Macro](#)
- [Confluence User's Guide](#)
Tracking updates by specific people

You can also follow the activity of people who interest you (see Network Overview) and receive a notification when someone follows you (see Subscribing to Email Notifications of Updates to Confluence Content).

Managing your notifications and tasks

There are a few ways to manage notifications and tasks in Confluence:

- You can manage your email notification settings via the options in your user profile. See Subscribing to Email Notifications of Updates to Confluence Content.
- The Confluence workbox displays all notifications collected from Confluence page watches, shares and mentions. See Managing Notifications in Confluence.
- You can manage your personal tasks in the Confluence workbox, and also create a list of tasks on a page. See Managing Tasks in Confluence.

Using Confluence RSS feeds

You can build RSS feeds to monitor content changes in Confluence.

- Create a customised RSS feed using the RSS Feed Builder.
- Subscribe to one of the pre-specified feeds generated by Confluence.

Watching a Page or Blog Post

You can 'watch' a Confluence page, blog post or space. Confluence will then send you a notification by email whenever anyone updates the watched content.

You will receive email notifications for:

- Edits (unless the user clears the Notify watchers check box).
- Deletions.
- Attachments, including new versions or deletions of an existing attachment.
- Comments, including new comments, edits of existing comments or deletions of existing comments.

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called ‘autowatch’. You can control autowatch.

There is no daily digest for email notifications. You will receive an email notification every time someone makes a change.

You will not receive email notifications for content changes due to the output of a macro, because the page content itself has not been edited.

You need 'View' permission for the page, blog post or space to receive notifications.

On this page:

- Watching a Page or Blog Post
- Setting Autowatch and Other Notification Options
- Watching an Entire Space
- Watching for New Blog Posts
- Managing Watches from your User Profile
- Managing Watches from the Email Message
- Related Topics

Watching a Page or Blog Post

To start watching a page or blog post:
1. Go to the page or blog post.
2. Choose **Tools > Watch.**

**To stop watching a page or blog post:**

1. Go to the page or blog post.
2. Choose **Tools > Stop watching.**

**Setting Autowatch and Other Notification Options**

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can turn autowatch on or off, and set other notification options, in the email settings section of your user profile. See [Setting User Settings](#).

**Watching an Entire Space**

You can choose to watch all the pages and blog posts in a given space. See [Watching a Space](#).

**Watching for New Blog Posts**

You can choose to watch for:

- New blog posts in a given space. See [Watching a Space](#).
- All new blog posts in the Confluence site. See [Subscribing to Email Notifications of Updates to Confluence Content](#).

**Managing Watches from your User Profile**

The 'Watches' page in your user profile displays a list of all pages and spaces you are currently watching.

**To manage your watches:**

1. Go to the 'Watches' view for your user profile, as follows:
   - Go to your name (the 'user' menu) at the top of the page and choose **Watches.**
2. Click the envelope icon next any unwanted watches to turn them off.

**Managing Watches from the Email Message**

The email notifications that you receive from Confluence have some useful links at the bottom of the email message. The links in each message vary, depending on the context. In general, the links allow you to view the page online, reply to a comment, and so on. In particular with respect to setting your notification preferences, you will see one or more of the following links:

- **Stop watching page** – Click this link to stop watching the page that triggered the email notification.
- **Stop watching space** – Click this link to stop watching the space that triggered the email notification.
- **Stop following this user** – Click this link to stop following the user whose update triggered the email notification.
- **Manage Notifications** – Click this link to go to the email settings page in your user profile.

*Screenshot: Email notification footer showing links*
Related Topics

Watching a Space

Subscribing to Email Notifications of Updates to Confluence Content
Managing Changes and Notifications and Tasks
Updating Email Address

Take me back to Confluence User's Guide

Watching a Space

You can 'watch' a Confluence page, blog post or space. Confluence will then send you a notification by email whenever anyone updates the watched content.

You will receive email notifications for:

- Edits (unless the user clears the Notify watchers check box).
- Deletions.
- Attachments, including new versions or deletions of an existing attachment.
- Comments, including new comments, edits of existing comments or deletions of existing comments.

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can control autowatch.

There is no daily digest for email notifications. You will receive an email notification every time someone makes a change.

You will not receive email notifications for content changes due to the output of a macro, because the page content itself has not been edited.

You need 'View' permission for the page, blog post or space to receive notifications.

On this page:

- Watching an Entire Space
- Watching for New Blog Posts in a Space
- Watching all Spaces on the Site
- Managing Watches from your User Profile
- Managing Watches from the Email Message
- Related Topics

Watching an Entire Space

Watch a space if you want to receive notifications of updates to any content in the space.

To start watching a space:

1. Go to a page in the space and choose Browse > Advanced.
2. In the left-hand panel, click Start watching this space (or Start watching all content).

To stop watching a space:
1. Go to a page in the space and choose Browse > Advanced.
2. In the left-hand panel, click Stop watching this space.

Watching for New Blog Posts in a Space

You can choose to receive a notification whenever someone adds a blog post in the space. You will not receive notification of updates to or deletions of blog posts, nor of comments on the blog posts.

Hint: By default, the option is labelled Start watching space blogs. If you are already watching the entire space, the wording will change to Only watch space blogs. If you choose that option, you will no longer be watching the entire space.

To start watching for new blog posts in a space:
1. Go to a page in the space and choose Browse > Advanced.
2. In the left-hand panel, click Start watching space blogs (or Only watch space blogs).

To stop watching for new blog posts in a space:
1. Go to a page in the space and choose Browse > Advanced.
2. In the left-hand panel, click Stop watching space blogs.

Watching all Spaces on the Site

You can receive notifications about changes to the content of pages, blog posts and comments from across all spaces on a Confluence site.

To start watching for content changes across the whole site:
1. Go to your name (the 'User' menu) at the top of the page and choose Settings.
2. Click Email in the left-hand panel.
3. Click Edit and select Subscribe to daily updates.
4. Click Submit.

Managing Watches from your User Profile

The 'Watches' page in your user profile displays a list of all pages and spaces you are currently watching.

To manage your watches:
1. Go to the 'Watches' view for your user profile, as follows:
   - Go to your name (the 'user' menu) at the top of the page and choose Watches.
2. Click the envelope icon next any unwanted watches to turn them off.

Managing Watches from the Email Message

The email notifications that you receive from Confluence have some useful links at the bottom of the email message. The links in each message vary, depending on the context. In general, the links allow you to view the page online, reply to a comment, and so on. In particular with respect to setting your notification preferences, you will see one or more of the following links:

- Stop watching page – Click this link to stop watching the page that triggered the email notification.
- Stop watching space – Click this link to stop watching the space that triggered the email notification.
- **Stop following this user** – Click this link to stop following the user whose update triggered the email notification.
- **Manage Notifications** – Click this link to go to the email settings page in your user profile.

**Screenshot: Email notification footer showing links**

---

**Related Topics**

- Watching a Page or Blog Post
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- Updating Email Address

Take me back to [Confluence User's Guide](#)

**Managing Watchers**

If you are a space administrator for a space, you can manage the watchers for all pages and blog posts in that space. This means that you can:

- View a list of the watchers of a page/blog post.
- View a list of the watchers of the space for that page/blog post.
- Add users as watchers of the page/blog post.
- Remove existing watchers of the page/blog post.

ℹ️ *It is not possible to remove watchers of the space.*

**To manage your watchers for a page/blog post:**

1. Navigate to the page or blog post for which you want to manage the watchers. Note, you must be a space administrator for the space that the page is in.
2. Choose **Tools > Manage Watchers**. The 'Manage Watchers' screen will be displayed (see screenshot below). The left-hand column of the 'Manage Watchers' screen will contain the users watching the page/blog post, the right-hand column will contain the users watching the space.
   - To remove an existing page watcher, click the icon (trash can) next to the user's name.
   - To add a user as a watcher of the page, type in the box and choose the user's name from the list.
3. Click **Done** to save your changes.

**Screenshot: Managing Watchers**
Subscribing to Email Notifications of Updates to Confluence Content

You can 'watch' a page, blog post or space. Confluence will then send you a notification by email whenever anyone adds or updates content on that page or space. You can also subscribe to daily email reports and other notifications of various updates, as described below.

You will only receive notifications for content that you have permission to view. Users that have been disabled by an administrator will not receive email notifications.

Subscribing to email notifications

You can subscribe to the following email summary reports:

- A daily report of updates to all spaces that you have permission to view.
- An immediate report of all blog posts added or changed, in all spaces that you have permission to view.
- An immediate report of all updates made by the people you are following, in all spaces that you have permission to view.
- An immediate report when someone follows you.
- A daily or weekly report of recommended updates, in all spaces that you have permission to view.

To edit your email notification settings:

1. Go to your name (the 'User' menu) at the top of the page and choose Settings.
2. Click Email in the left-hand panel.
3. Click Edit.
Below is an explanation of all the email settings is explained below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Content</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Autowatch</strong></td>
<td>Option: Do you want Confluence to automatically add you as a watcher on each page or blog post that you add or update? If you are a watcher of a page or a post, you will receive notification of future changes.</td>
<td>• Pages and blog posts that you create, edit or comment on.</td>
<td>(Not applicable)</td>
</tr>
<tr>
<td><strong>Subscribe to daily updates</strong></td>
<td>Receive email reports showing changes to content in all spaces that you have permission to view.</td>
<td>• Pages and blog posts that are added, edited or deleted. • Comments on a page or blog post that are added, edited or deleted. • Updates by users who have changed their personal profile.</td>
<td>Daily</td>
</tr>
<tr>
<td><strong>Subscribe to all blog posts</strong></td>
<td>Receive email notifications for changes to blogs in your Confluence installation that you have permission to view.</td>
<td>• Blog posts added, edited or deleted.</td>
<td>Immediately</td>
</tr>
</tbody>
</table>
| **Subscribe to network** | Receive email notifications for changes to content by all users that you are following, which you have permission to view. | • Pages being added, edited or deleted.  
• Blog posts being added, edited or deleted.  
• Comments being added, edited or deleted.  
• Status updates by the user. | Immediately |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subscribe to new follower notifications</strong></td>
<td>Receive an email message when anyone chooses to follow you.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Notify on my actions** | **Option:** Do you want to receive email notifications for your own changes?  
Note: If you have not subscribed to any email notifications and are not watching any pages/spaces, then selecting 'Notify on my actions' will not do anything. | • All pages and spaces that you are watching.  
• This affects all subscriptions set. | (Not applicable) |
| **Show changed content** | **Option:** Do you want your notifications to include details of the changes made to the content?  
• If you do not select this option, your notifications will include the full content of the page.  
• If you do select this option, your notifications will include the full content of the page as well as a list of the differences between the current and previous versions of the page. See Page History and Page Comparison Views. | • Edits to pages and blog posts. | (Not applicable) |
| Subscribe to recommended updates | Receive an email message showing the top content that is relevant to you. How do you set the frequency of the mail message? A link in the email message allows you to choose daily or weekly notifications. How do you enable and disable the notification? You can turn off the notification by clicking a link in the email message. You can also turn the notification on or off by setting the ‘Subscribe to recommended updates’ option in your user profile. | Confluence chooses the content to display, based on:  
- Pages and blog posts that people have recently liked.  
- Pages and blog posts that people have recently commented on.  
- Pages and blog posts that have recently been created.  
‘Recent’ means any activity that occurred since the last recommended updates message was sent to you. The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. Content in your favourite spaces also ranks higher than content in other spaces. The recommended updates summary does not include any content that you created yourself, and it gives a lower ranking to content that you have participated in, for example by adding a comment or updating the page. If there is no activity to report, Confluence will not send the email message. | Daily (weekdays at 1pm) or weekly |

**Notes for administrators**  
- To enable Confluence to send email notifications, a System Administrator must configure an email server. See [Configuring a Server for Outgoing Mail](#).  
- Confluence Administrators can set the default options for the recommended updates notification. Choose...
Subscribing to RSS Feeds within Confluence

RSS feeds allow you to track updates to content within Confluence. You will need an RSS newsreader to subscribe to them.

On this page:
- Confluence RSS Feeds
- RSS Newsreaders
- Removing an RSS Feed
- Related Topics

Confluence RSS Feeds

You can create a customised RSS feed using the RSS Feed Builder or subscribe to one of the pre-specified feeds generated by Confluence.

What would you like to do?
- Create and subscribe to customised RSS feeds using the RSS Feed Builder — create a customised RSS feed (e.g. filter your feed using a label; specify the number of items and days to include in your feed; etc.)
- Subscribe to pre-specified RSS feeds — generate an RSS feed automatically in a minimal number of steps.
- Subscribe to a feed of any Confluence user's network to track the activities of users they are following in their network.

RSS Newsreaders

The following are some popular RSS newsreader programs for various operating systems. You can find a more comprehensive list on Google's open directory.

Windows
- SharpReader
- NewsGator
- Syndirella
- FeedDemon
- NewzCrawler

Mac OS X
- Safari
- NetNewsWire
- NewsFire
- Shrook

Multi-Platform
- NewsMonster (Runs in the Mozilla web browser)
- Radio Userland (Windows and MacOS)
- AmphetaDesk (Windows, Unix, Mac OS X)

Removing an RSS Feed
There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters included in the feed URL (address). For example, take a look at the following feed URL:

```
http://confluence.atlassian.com/createrssfeed.action?types=page&sort=modified&showContent=true...
```

The above feed URL will generate a list of pages ('types=page'), sorted by the modification date and showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS feed information stored on the database. For that reason, there is no need to remove anything.

Related Topics

Managing Changes and Notifications and Tasks
Working with RSS Feeds
RSS Feed Macro

Using pre-specified RSS feeds

If you want to customise your Confluence RSS feed (e.g. use a label to filter your feed), use the RSS Feed builder instead.

To subscribe to RSS feeds generated by Confluence, for a particular space:

1. Choose Browse > Advanced from the dropdown list. The 'Advanced' screen will appear.
2. Click on RSS Feeds in the left-hand column.
3. Copy and paste the link for one of the following feeds into your RSS newsreader:
   - Pages
   - News
   - Mail
   - Comments
   - Attachments
   - All content

To subscribe to RSS feeds generated by Confluence, for a particular page (where available):

1. Locate the following icon, which is available in the top-right corner of certain pages:
2. Copy and paste the icon's link into your RSS newsreader.

Related Topics

Using the RSS Feed Builder
Managing Changes and Notifications and Tasks
Working with RSS Feeds
RSS Feed Macro

Using the RSS Feed Builder
Using the RSS feed builder, you can create customised RSS feeds to subscribe to changes within Confluence.

Wondering what an RSS feed is? See more information about RSS Feeds.
Building an RSS Feed

Follow the steps below to build your feed, choosing the type of content and the time period you want to monitor.

To create a customised RSS feed:

1. Choose Browse > Feed Builder.
2. Select the content types you want in your feed. Check Mail if you want to know when the email archive is updated. (See the overview of mail archives in Confluence.)
3. Select one or more spaces from the list.
4. Click Advanced Options to set the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Name</td>
<td>The default name is based on the name of your Confluence installation, e.g. 'Extranet RSS Feed'</td>
</tr>
<tr>
<td>With these labels</td>
<td>Enter one or more labels separated by spaces or commas. Confluence returns all content (of the selected types) that matches one or more of the labels. See the hint below about using labels to customise your feeds.</td>
</tr>
<tr>
<td>Exclude these spaces</td>
<td>Exclude specific spaces from those already selected.</td>
</tr>
<tr>
<td>Sorted by</td>
<td>Sort content by either the date or creation or the date they were last updated.</td>
</tr>
<tr>
<td>Limit to</td>
<td>Specify the number of items returned in your feed.</td>
</tr>
<tr>
<td>Within the last</td>
<td>Specify how old items returned can be.</td>
</tr>
<tr>
<td>Include content for pages</td>
<td>Specify whether the entire page is displayed in the feed.</td>
</tr>
</tbody>
</table>

5. Click Create RSS Feed to create your feed.
6. Drag or copy the link into your RSS reader.

Tip: Try building separate feeds, one for pages only and one that includes comments as well. This allows you to monitor only pages if you are short of time, and to read the comments when you have more time.

Hint: Using Labels to Customise your Feed

You can use the RSS feed builder to track updates to labelled pages and comments on those pages. Here is an idea for customising your RSS feed by using your own personal label(s). This is useful if you want to track updates to specific pages or blog posts, and you do not want to deal with emails. You can use this method as an
alternative to watching pages.

- Build an RSS feed that returns pages, blog posts and comments labelled with a personal label, such as 'my:feed'.
- Each time you want to 'watch' a page, just label it with 'my:feed'.
- All updates and comments will automatically come through your RSS feed.

**Notes**

- **Removing an RSS feed**: You need only delete the RSS feed link built by the Confluence RSS feed builder to remove an RSS feed from your page. This is because the feed is dynamically generated using the parameters in the feed URL.

- **Feed authentication options**: Confluence can offer you the option of an anonymous feed or a feed that requires authentication.
  - An **anonymous** feed will show only the content that is visible to anonymous users. The feed URL does not contain the &os_authType parameter mentioned below. This feed is useful only if your Confluence site allows anonymous access. If a feed is anonymous, you only get anonymously-viewable content in the feed regardless of whether you are a Confluence user or not.
  - An **authenticated** feed requires you to log in to Confluence before you can retrieve the content. The feed URL contains the following parameter: &os_authType=basic.
  - The option to choose between an anonymous and an authenticated feed is currently not available on the feed builder screen. The feed builder offers only authenticated feeds. See [CONF-21601](#) for details and a workaround.

**Related Topics**

- [RSS Feeds FAQ](#)
- [Managing Changes and Notifications and Tasks](#)
- [Working with RSS Feeds](#)

Take me back to [Confluence User's Guide](#)

**Working with RSS Feeds**

An RSS feed is a format for delivering summaries of regularly changing web content. Subscribing to an RSS feed allows you to stay informed of the latest content from sites that you are interested in.

RSS isn't designed to be read in a regular web browser. Specialised RSS newsreader programs can check RSS files every so often, and tell you what's new on a site. Your reader may be on a website, an addon to your browser, part of your email program, or a stand-alone program.

Confluence works with RSS in two ways:

- Confluence generates its own RSS feeds for tracking updates to content within Confluence. You will need an RSS reader which can grab the RSS feeds from Confluence and display them for you.
- Confluence's [RSS macro](#) allows you to display the contents of RSS feeds on a Confluence page. The feeds may come from a Confluence feed generator or from external sites. In this way, Confluence can act as an RSS reader.

For a technical description of RSS, read [Mark Pilgrim's "What is RSS?" article](#) on XML.com.

**Related Topics**

- [Subscribing to RSS Feeds within Confluence](#)
- [Displaying content from RSS feeds on a Confluence page](#)
- [Managing Changes and Notifications and Tasks](#)

Take me back to [Confluence User's Guide](#)

**RSS Readers Compatibility**
Due to some users having problems with Confluence RSS Feeds, some research was done with several RSS Feed Readers. RSS Feeds have been created through the feed builder and tested on a Windows machine. For each feed reader they have been tested with both authentication and public access, checking for the visibility of content, icons and images. The results are in the tables below:

**Feeds with authentication**

<table>
<thead>
<tr>
<th>RSS Feed Reader</th>
<th>Content</th>
<th>Icons</th>
<th>Images</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>RssReader 1.0.880</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>• Shows the entire page (including the header panel &amp; view,edit tabs)</td>
</tr>
<tr>
<td>JetBrains Omea Reader 2.1.6</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>• Shows the changes between revisions in the nice red/green colours of Confluence</td>
</tr>
</tbody>
</table>
| IE 7.0                    | ❌       | ✓     | ✓      | • Content is all there however not all html is rendered correctly (for example .tag {font-style:italic;} is shown in the content as raw text)  
|                           |         |       |        | • Shows the changes between revisions, but without the red/green colours |
| Thunderbird 1.5.0.7       | ✓       | ✓     | ✓      | • Shows the entire page                                             |
| Bloglines                 | ✓       | ✓     | ✓      | • Simple online feed reader  
|                           |         |       |        | • Shows the changes between revisions, but with arrows               |
| Google Reader             | ✓       | ✓     | ✓      | • Simple online feed reader  
|                           |         |       |        | • Shows the entire page                                             |
| Yahoo                     | ❌       | ❌     | ❌      | • Error message: Invalid URL format                                |
Managing Notifications in Confluence

This page is about the notification-and-task dialog, known as the Confluence ‘workbox’, which drops down when you choose the icon in the Confluence page header.

Do you want to manage your notification email messages instead? See Subscribing to Email Notifications of Updates to Confluence Content.

Managing your notifications in the Confluence workbox

The workbox displays all notifications collected from Confluence page watches, shares and mentions. You can view your notifications and convert them to personal tasks. Use the inline actions to reply to comments, like a comment or page, or watch a page. Follow the links in a notification to open the relevant page or blog post.

The workbox displays your notifications and your personal tasks in separate tabs.

To manage your notifications:

1. Choose the notification-and-task icon in the Confluence page header.
   - You can use the keyboard shortcut: Type g then n. (When in the Confluence editor, click outside the editor pane before pressing the keyboard shortcut keys.)
   - The icon above shows that you have 3 unread notifications.

2. Choose the notifications icon:

3. Choose a notification from the list, to see the notification details. Now you can do the following:
   - Choose a link or Open to open the related page, blog post, or comment. The page will open in a new tab in your browser.
   - Choose Like or Unlike to let people know that you like, or have stopped liking, a page, blog post, or comment.
   - Choose Watch or Stop Watching to receive notifications, or stop receiving notifications, about a page or blog post.
   - Choose Reply to respond to a comment inline, within the workbox.
   - Choose the ‘add task’ icon to flag a notification as a task. The notification will remain in the notification list too.
Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

- Shares a page or blog post with you.
- Mentions you in a page, blog post or comment.
- Comments on a page or blog post that you are watching.
- Likes a page or blog post that you are watching.

The workbox does not show notifications triggered because you are watching a space. Only watches on pages and blog posts are relevant here.

Keyboard shortcuts
### Key

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>g</strong> then <strong>n</strong></td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td><strong>j</strong></td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td><strong>k</strong></td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td><strong>n</strong></td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
<tr>
<td><strong>p</strong></td>
<td>Move up to the previous notification for a particular page or blog post.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected notification.</td>
</tr>
<tr>
<td><strong>u</strong></td>
<td>Return to the notification list after opening a particular notification.</td>
</tr>
</tbody>
</table>

**Note:** The keyboard shortcuts are available for notifications only, not for tasks, inside the Confluence workbox.

### Managing notifications with Confluence mobile

You can view and respond to your notifications on your phone or other mobile device too. See [Using Confluence on a Mobile Device](#) for more about mobile platforms.

![Confluence Mobile](image)

**Notes**

- Read notifications are automatically deleted after 2 weeks.
- Unread notifications are automatically deleted after 4 weeks.
- You cannot delete your notifications yourself.

- The notification-and-task dialog is not available in clustered environments. The plugin will be installed and enabled, but it will detect that the site is in clustered mode and will not display the dialog.
- The notification-and-task dialog is provided by a set of plugins. To remove the personal notifications and tasks functionality from your site, you can disable the following plugins. See [Disabling or Enabling a Plugin](#) for instructions. Disabling these plugins will disable the entire notification-and-task dialog. It is not possible to disable only tasks or only notifications:
  - Notifications and Tasks - Common Plugin
  - Notifications and Tasks - Host Plugin
  - Notifications and Tasks - Confluence Provider Plugin
- If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin,
There is no option to disable the notification-and-task dialog for an individual user.

Managing Tasks in Confluence

You can manage your personal tasks in the notification-and-task dialog, known as the Confluence 'workbox', which drops down when you choose the icon 📝 in the Confluence page header.

You can also create a list of tasks on a page, and assign them to your colleagues via @mention. Changes made in the workbox are reflected in the task list on the page, and changes made on the page are reflected in the workbox too.

Creating personal tasks and having tasks assigned to you

There are a few ways that you and other people can assign tasks to you:

- You can add a personal task via the workbox.
- You can add a notification to your task list, via the notification workbox. This is useful if you want to get back to it later.
- Someone can assign you a task from a task list on a Confluence page.
- Other Confluence actions may create a task for you. For example, your Confluence site may be running a plugin that creates and assigns tasks.

Managing your personal tasks in the workbox

The workbox displays your notifications and your personal tasks in separate tabs. The task tab shows the tasks assigned to you. When you update a task that originated in a task list on a page, the update is reflected in the task list too.

Screenshot: Your personal tasks in the workbox
To manage your tasks:

1. Choose the notification-and-task icon in the Confluence page header.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside the editor pane before pressing the keyboard shortcut keys.)
   - The icon above shows that you have 3 unread notifications.

2. Choose the personal tasks icon:

3. To add a task and assign it to yourself, type the task summary in the text box and choose Add task.

4. To prioritise tasks, drag and drop them into your chosen order. (Click a task, hold down your mouse button to drag the task into position, then release the mouse button.)

5. To complete a task, or mark it as incomplete, choose the check box next to the task.

6. To add notes to a task and see further information (for example, a related page) choose the task item.
   The task details dialog will open.

Adding your notifications to your task list

You can flag a notification as a task. This is useful if you want to take action on the notification later.

To add a notification to your task list:

1. Choose the task and notification icon in the Confluence page header.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside the editor pane before pressing the keyboard shortcut keys.)
   - The icon above shows that you have 3 unread notifications.
2. Choose the notifications icon:

3. Choose the notification that you want to add to your task list. The notification details dialog will open.

4. Choose the 'add task' icon to add this notification to your tasks. The notification will remain in the notification list too.

See Managing Notifications in Confluence for a full description of notifications.

Creating task lists and managing tasks on a page

Task lists on a page are useful for assigning and managing tasks in a team.

To add a task list on a page:

1. Edit the page.

2. Choose the task-list icon in the editor toolbar, or press [ and then ] on your keyboard.

3. Type the description of the task.

4. If you want to assign a task to someone, type '@' and the person's name in the task description. (For more information about @mentions, see Using Mentions.) That person will receive a notification, and the task will appear in their personal task list in the workbox. If you @mention yourself, the task will appear in your personal task list.

5. To end the list, press Enter twice.

Managing tasks on a page:

- When viewing a page, you and other viewers can mark tasks as complete or incomplete. Updates to a task on the page will be transferred to the workbox too. (See above.)
- To be able to update a task list when in view mode, you need permission to edit the page:
  - You need the 'Create page' permission in the space. See Space Permissions Overview.
  - There must not be any page restrictions that prevent you from editing the page. See Page Restrictions.

What if the update fails?

This section describes what you should do if Confluence displays an error message saying that your change to a task list could not be saved. The cause is probably one of the following:

- Your session has expired. Resolution: Log in and update the task list again.
- You do not have permission to update the task list. **Resolution:** Check your permissions. You need 'Create page' permission in the space. Please check also that there are no page restrictions that prevent you from editing the page.
- The network is down. **Resolution:** Please try again when the network is available.

**Screenshot: A task list on a page**

Managing tasks with Confluence mobile

You can view and manage your tasks on your phone or other mobile device too. See [Using Confluence on a Mobile Device](#) for more about mobile platforms.

1. Open the flyout menu
2. Choose "Tasks"
3. Add a task
4. Select a task
5. Add notes or complete a task

**Notes**

- The notification-and-task dialog is not available in clustered environments. The plugin will be installed and enabled, but it will detect that the site is in clustered mode and will not display the dialog.
- The notification-and-task dialog is provided by a set of plugins. To remove the personal notifications and tasks functionality from your site, you can disable the following plugins. See [Disabling or Enabling a Plugin](#) for instructions. Disabling these plugins will disable the entire notification-and-task dialog. It is not possible to disable only tasks or only notifications:
  - Notifications and Tasks - Common Plugin
  - Notifications and Tasks - Host Plugin
  - Notifications and Tasks - Confluence Provider Plugin
- If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin,
Confluence Provider Plugin.

- There is no option to disable the notification-and-task dialog for an individual user.
- Completed tasks in the workbox are automatically deleted after 7 days.
- You cannot disable the functionality that provides task lists on a page.

**Searching Confluence**

Quick guide to searching in Confluence:

1. Use the search box at the top right of your Confluence screen. It offers you a quick navigation aid as well as a full site search.

   ![Search Box](image)

2. You can search Confluence directly from your browser's search box. Just add your Confluence site as a search provider using the dropdown menu in your browser's search box.

3. While editing a page or a blog post, you can find and replace text on the page. See [Using the Editor](#).

---

**Using the Quick Navigation Aid**

The quick navigation aid automatically offers a dropdown list of pages and other items, matched by title to your search query. You can select one of the offered items or ignore them altogether.

**To use the quick navigation aid:**

1. Start typing your query into the search box located at the top right-hand corner of every screen.
   Confluence matches titles as you type, showing a quickly-adjusting dropdown list of pages, blog posts, personal profiles, attachments and so on.
   🔄 Press the Enter key if you want to bypass the quick navigation aid and perform a full search, as described [below](#).
2. To see the space to which an item belongs, let your mouse pointer hover over the item in the dropdown list.
3. Use the up- and down-arrows on your keyboard to move up and down the list of matching titles and select an item.
4. Press the Enter key to open the selected item.
5. If you do not find what you are looking for, click **Search for** at the bottom of the list to do a full search.
   This has the same effect as pressing Enter immediately after typing your search query. The full search is described [below](#).

   **Screenshot:** The quick navigation aid showing titles matching the query 'con'
Here is more information about how the quick navigation feature works:

- Confluence will truncate any titles that are too long to be displayed.
- The matching items are grouped by content type so that you can quickly find the type you want. Confluence shows a maximum of 6 pages and/or blog posts, 2 attachments, 3 people and 2 spaces. If no matches are found in a particular category, then that category does not appear in the list.
- Items are ordered with the most recent updates first.
- When the matching item is a person's name, their profile picture appears next to their name in the list.
- The part of the title that is matched by the search query is highlighted in bold text.
- Your Confluence Administrator can enable or disable the quick navigation feature using the Confluence Administration Console.

Performing a Full Search

When you perform a full search, Confluence will search all content in all spaces (global and personal), mail, personal profiles, attachments and the space description. The results will appear on a new screen.

For the developers

The rendering of search results in Confluence is pluggable. If you are a developer, you may wish to write your own search result renderer to change how the search results are displayed. For more information, please refer to the following developer document: Writing a search result renderer.

To use the full search:

1. Type your query into the search box located at the top right-hand corner of every screen (or type it into the text box at the top of the Search screen).
2. Press the Enter key. (This means that you will ignore the dropdown list of titles offered by Confluence’s quick navigation aid, described above.)
3. The Search screen appears, as shown below. If any Confluence pages or items match your search query, the Search screen shows a list of the matching items.
4. Click an item’s title to open the Confluence page or other item.
On the left of the screen you will see a text block for each item that matched the search criteria, with the following information for each item:

- An icon representing the content type (user profile, space, page, blog post, etc). See [Icons Used in Confluence](#).
- The title or name of the content item.
- For attachments: The size and type of file, with a link to download or view the attachment where relevant. See information on [viewing Office attachments](#) below.
- For image files: A thumbnail of the image will display to the right of the file name.
- The most relevant few lines of content from within the item. Any words that match your search query are highlighted within the content.
- For personal profile items: The email address.
- The space to which the item belongs, displayed on the last line of the item's text block.
- The date when the content item was last modified.

You will see only search results which you have permission to view.

On the right of the screen are further options which allow you to tailor or filter your search results. See [below](#).

**Viewing Attached Office Documents**

When the search results include an attached Office document, you will see a View link as shown in the screen snippet below.

*Screenshot: Search results include an attached Office document with 'View' link*
Click the View link to view the content of the Office document within Confluence. If you have an Office application installed, you will also be able to launch your Office editor from within Confluence. See Displaying Office Files in Confluence and Working with the Office Connector.

Accepting 'Did you mean' Suggestions from Confluence

When you perform a full Confluence search, as described above, Confluence may offer you an alternative spelling of your search query. The alternative spelling will appear next to the words 'Did you mean', as shown in the example below.

To accept an alternative spelling suggestion:

1. Type your query into the search box.
2. Press the Enter key.
3. Confluence will analyse the wiki content, to determine whether an alternative spelling of your search query occurs more often in the wiki content. If this is the case, the words 'Did you mean' will appear on the screen, along with an alternative spelling for your search query.
4. If you want to try the alternative spelling, click the word showing the suggested spelling. In the example below, you would click confluence.

Screenshot: The Search screen with 'Did you mean' offering a corrected spelling
Here is more information about how the 'Did you mean' feature works:

- Confluence uses both a dictionary (bundled with Confluence) and words mined from the content on your system to work out the best alternative spellings of your search terms. Practically, this means that Confluence can provide spelling corrections for specialised jargon that may not appear in a standard dictionary. In general, when deciding between alternative spellings, Confluence will favour words that appear more often in your content.
- In some cases, the 'Did you mean' suggestion may appear even when there are Confluence pages, etc, which match your search query. In other cases, there will be no items which match your search criteria. In both cases, Confluence will offer a 'Did you mean' suggestion if there is a word which will help you find more relevant content.
- The 'Did you mean' feature may offer more than one suggestion.
- The 'Did you mean' suggestion may even offer an incorrect spelling. This would happen if the incorrect spelling occurs many times within your Confluence site. This is intentional, because the aim of the 'Did you mean' feature is to help you find content, not to correct your spelling.
- Your Confluence Administrator can enable or disable the 'Did you mean' feature using the Confluence Administration Console.

Filtering your Search Results

The Search screen, pictured above, appears when you do your first search. By default, Confluence will search all content across your Confluence site, including all spaces, mail archives, attachments and all other content types.

On the right of the screen are options which allow you to tailor or filter the search results.

Enter your filter criteria as described below, then click Filter.

- **Where** — Restrict your search results to a particular space, or to your favourite spaces, global spaces or personal spaces.
- **What** — Restrict your search results to a particular content type (pages, blog posts, mail, etc).
- **When** — Restrict your search results to content modified within a particular period of time (today, yesterday, within the last week or within the last month).
- **Who** — Restrict your search results to content last modified by a particular user. You can start typing the person's username or part of their name into the text box as follows:
  - Type the username (e.g. 'jsmith').
  - Or start typing the person's first name (e.g. 'john')
  - Or their last name (e.g. 'smith').
  - Or another part of their name, such as a middle name.
Confluence will offer you a list of possible matches. Use your mouse to select the person you want, then press the Enter key to filter the search results.
More information about the user-matching filter:

- The user-matching filter is **not** case sensitive. You can enter upper or lower case letters and will receive the same results.
- When looking for users to match the name you entered, Confluence divides a person's name into logical units corresponding to first name, middle name (one or more) and last name. It matches the letters of each unit in the name you entered against the letters of each unit in the user directory. For example, you can enter 'jo sm' to look for John Smith. The search is triggered after you have entered at least two letters.
- For each part of the name, you need to enter at least two letters. For example, if you enter just 'john s', the filter will look for users called 'john' and will ignore the 's'. Similarly, if you enter 'j smith' you will see everyone with the name 'smith' even if their first name does not start with a 'j'.
- You are not forced to use the auto-complete list. You can just type 'jsmith' or 'jo sm' and filter on that without choosing a match from the dropdown list. Confluence will warn you if there is more than one user corresponding to the name you have entered.

Click **Clear Filter** if you want to remove all your filters and perform the same search again but without the filter.

### Search Options When Using the Documentation Theme

When using the Documentation theme, the Confluence search offers a few options as described below.

#### Using the search box at the top right of the page:

- By default, the main Confluence search is configured to search the entire Confluence site.
  - You will see the words **Search Confluence** in the search box at top right of the page.
  - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
- A space administrator can configure the Documentation theme to restrict the search to the current space.
  - You will see the words **Search this space** in the search box at top right of the page.
  - The search will return results from the current space only.
  - You can override the search restriction. Enter `all:` and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for 'technical writing':

```
all: technical writing
```

#### Using the search box in the left-hand panel:

- By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are
children of the space's home page.

- If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

For screenshots and a full description, see Using the Documentation Theme.

**Advanced Search Syntax**

See Confluence Search Syntax for more ways to refine the text you enter into the search box.

Additionally, see Confluence Search Fields for special parameters you can use in the search box to search on various metadata.

**Browsing Related Labels**

Also on the right of the Search screen, Confluence will offer a list of labels which are related to your search query. See the screenshot above.

You can click a label to see all pages and blog posts tagged with that label. See Viewing Labels and Labelled Content.

**Searching the Content of Attachments**

When you search Confluence, by default the search will include the content of the following types of attachments:

- Word
- Text
- PowerPoint
- Excel
- PDF
- HTML

To search the content of other attachment types, you will need to use an attachment content extractor plugin. For more information, take a look at the following:

- Existing extractor plugins which you can install on your Confluence site.
- Guidelines on developing your own attachment content extractor plugin.

**Searching Confluence from your Browser's Search Box**

If you are using Firefox or Internet Explorer 7 or later, you can add your Confluence site as a search provider, using the dropdown menu next to the browser's search box.

The example below shows the 'Extranet' Confluence site offered for inclusion as a search engine in the browser's search box.

*Screenshot: Adding your Confluence site to your browser's search box*
Information about OpenSearch:

- Confluence supports the autodiscovery part of the OpenSearch standard, by supplying an OpenSearch description document. This is an XML file that describes the web interface provided by Confluence's search function.
- Any client applications that support OpenSearch will be able to add Confluence to their list of search engines.
- Your Confluence Administrator can enable or disable the Open Search feature using the Confluence Administration Console.

Related Topics

Confluence Search Syntax
Confluence Search Fields
Ranking of Search Results
Text Tokenisation and Filtering
Search Results Macro
Livesearch Macro
Page Tree Macro (includes an optional search box)
Viewing Labels and Labelled Content
Searching the People Directory

Take me back to the Confluence User's Guide.

Text Tokenisation and Filtering

When searching for content based on search terms entered by the user, Confluence splits the text of the content into tokens, and then filters and modifies those tokens according to the following rules.

Tokenisation

Confluence uses Lucene’s Standard Tokenizer. This splits the text into tokens as follows:

- Splits words at punctuation characters, removing punctuation. However, a dot that's not followed by white space is considered part of a token.
- Splits words at hyphens, unless there's a number in the token, in which case the whole token is interpreted as a product number and is not split.
- Recognises email addresses and internet host names as one token.

An example: The string 'foo-bar5' won't be split into 'foo' and 'bar5', so a search for 'bar5' or 'bar*' will not find any results.

Filtering
Confluence then:

- Removes "s" from the ends of words.
- Removes the dots from acronyms, e.g. I.B.M. becomes IBM.
- Converts everything to lower case.
- Removes common words like 'the' and 'or' are removed.
- Converts words to their stems. For example, 'fishing' and 'fishes' both become 'fish'.

Related Topics

Searching Confluence

Searching the People Directory

The people directory displays a list of people who use your Confluence site.

The people directory includes anybody who has logged into Confluence or who has had a user account created for them in Confluence. The people directory does not include users who can log into Confluence using external user management if they have never yet logged in.

Viewing the People Directory

Choose Browse > People Directory.

The Confluence administrator can hide the people directory. If it is hidden, you will not see the People Directory link in the Browse menu.

Screenshot: The People Directory

Searching for People

To search for a particular person, type their first name and/or last name into the search box and click Search.

- To search everyone who uses your Confluence site, click All People.
• To search just those people who have set up a personal space, click People with Personal Spaces.

**Following People’s Activities**

Confluence’s network features allow you to 'follow' (that is, keep track of) other people’s activities throughout a Confluence site. For more information, please refer to Network Overview. Using the hover profile feature, the people directory is a convenient area from which you can start following other people throughout your Confluence site.

• To start following another person’s activities, move your mouse over a user’s name or profile picture and in their hover profile popup, click Follow.
• To stop following another person’s activities, move your mouse over a user’s name or profile picture and in their hover profile popup, click Stop Following.

Once you start following another person, their activities will start appearing in your network view.

**People Directory provides hCard microformat**

The people directory uses the hCard microformat for simple integration with a variety of microformat-enabled tools. hCard is an open data format for representing people, companies, organisations, and places. Read more about microformats and hCard.

**Related Topics**

Setting Up your Personal Space
Editing your User Profile
Choosing a Profile Picture

Take me back to the Confluence User's Guide.

**Confluence Search Syntax**

Here’s how you can refine your search. Confluence will ignore common words like "the" unless you place your query within quotes.

**Exact phrase search**

To search for content that contains the exact phrase "chalk and cheese"

"chalk and cheese"

Confluence will ignore common words (stop words) like "and" above. This is the default list of stop words used by lucene. Please cast your vote towards this improvement request.

For eg:

1. Searching for "The One" returns all pages containing "One" because "The" is a stop word.
2. Searching for "Cheese One" would only return pages in which "One" appears as the first word (other than stop words) after "Cheese". So it would return "Cheese for One" or "Cheese to One" or "Cheese One". It would not match "One Cheese" or "Cheese Flamingo One"

**Or Search**

To search for content that contains one of the terms, "chalk" OR "cheese"
chalk OR cheese

Please note that the operator OR must be typed in capitals.

And Search
To search for content that contains both the terms "chalk" AND "cheese"

chalk AND cheese

Please note that the operator AND must be typed in capitals.

Not search
To search for content that contains "chalk" but NOT "cheese"

chalk NOT cheese

Please note that the operator NOT must be typed in capitals.

Excluded Term search
Similar to the NOT search, to search for content that contains "chalk" and "butter" but NOT "cheese"

chalk butter -cheese

Grouping Search
To search for content that MUST contain "chalk" but CAN contain either "cheese" or "butter" use the search:

(cheese OR butter) AND chalk

Title Search
To search for content with "chalk" in its title, where title is the field keyword.

title:chalk

Wild card searches
Single character
To search for "butter" or "batter" you can use the search:

`b?tt?r`

To search for "chicken" or "chickpea" you can use the search:

`chick*`

Wildcards can be used anywhere within a word, except at the very beginning.

For example:

`*chick`

is an invalid search term.

**Multiple characters**

To search for "chick" or "chickpea":

`c*c*`

You can also combine search characters to get the exact word. For example the search term below will return "chick" yet not "chickpea":

`c*c?`

---

**Case Sensitivity in wildcard searches**

Since the fix for [CONF-13846](#) Confluence is case sensitive for wildcard searches.

You should note that all the example searches given previously search across the default set of fields which are stored as lower case and therefore all searches of that style should be given lower case search terms (as shown in the examples).

However, if you were to search one of the case sensitive fields, such as 'content-name-untokenized' the case of your search term would need to match the document you are searching for.

**Proximity searches**

This search ensure that the two words specified must be within a certain number of words of each other to be included.
will return "Octagon blog post".

is an invalid search term.

Range search

Searches for names that fall alphabetically within the specified range.

\[\text{[adam TO ben]}\]

Note: You can't use the AND keyword inside this statement and that TO must be written in capitals to form a valid search.

Fuzzy search

This search looks for words spelled similarly.

To search for octagon, if unsure about spelling:

\[\text{octogan~}\]

will correctly return "octagon"

Combined search

You can also combine various search terms together:

\[\text{o?tag* AND past~ AND ("blog" AND "post")}\]

Search for macros

You can search Confluence content for anywhere a macro is used. To do this, just add macroName: to your search and append the macro name after the column. For example, search for all excerpt-include macros:

\[\text{macroName:excerpt-include*}\]

For more information about macroName and other search fields, see Confluence Search Fields.
Confluence Search Fields

Purpose of this document

This page is intended for developers and advanced users of Confluence. It gives an overview of the Apache Lucene search fields used in Confluence.

On this page:

- Searching for Content in Specific Fields
- Confluence Search Fields
  - Personal Information
  - Pages
  - Blog
  - Attachments
  - Mail Items
- Related Topics

Searching for Content in Specific Fields

Confluence data is stored in fields which can be specified in the search. To search a specific field, type the name of the field followed by a colon ':' and then the term you are looking for.

Examples:

```
title:"Some Title"
labelText:chalk
```

The field specification applies only to the term directly preceding the colon. For example, the query below will look for "Some" in the title field and will search for "Heading" in the default fields.

```
title:Some Heading
```

Confluence Search Fields

Below are the fields which can be searched, listed by content type.

Personal Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>---</td>
<td>--------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>fullName</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pages</th>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td></td>
<td>lastModifiers</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who last updated the page.</td>
</tr>
<tr>
<td></td>
<td>creatorName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who added the page.</td>
</tr>
</tbody>
</table>
### Macro Name

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>macroName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>The name of a macro used on the page</td>
</tr>
</tbody>
</table>

### Blog

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>lastModifiers</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who last updated the blog post.</td>
</tr>
<tr>
<td>creatorName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who created the blog post.</td>
</tr>
<tr>
<td>macroName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>The name of a macro used in the blog</td>
</tr>
</tbody>
</table>

### Attachments

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Indexed</td>
<td>Stored</td>
<td>Tokenised</td>
<td>Notes</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>--------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>messageid</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>inreplyto</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>recipients</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>
When you perform a search in Confluence, it is likely that there will be many pages or other content items that match your search terms. Confluence will rank the matching items by evaluating their relevance. This should mean that the items most relevant to you will appear at the top of the search results list, so that you can quickly select the item you need.

Below is an overview of the method Confluence uses to determine the relevance of the items returned by the search, i.e. to rank the search results.

**Philosophy behind the Ranking**

Confluence gives highest priority to personal information i.e. documents which take you to a user's profile when you click on them. Collaboration is a primary function of a wiki, so Confluence makes it easy to find people.

For example, if you search for 'John Smith', the first results you see will be for John Smith's user profile and personal space. There may also be other content (wiki pages, email messages, etc) which contain the words 'John Smith'. These other content types may even have 'John Smith' as the page title and repeated multiple times in the content, but they will still appear lower down in the list of search results.

Matching terms found in the title of a page, or in the title of any content type, are considered a strong match. So are matches found in labels, because when someone applies a label it means that they think the content is particularly relevant to the labelled term.
Matches found in the content body are of average importance. If the matched term appears more than once, the document will be given a proportionately higher ranking.

We also assume that information created recently is slightly more relevant than older information.

**Summary of the Ranking Method**

When displaying the results of a search, Confluence applies a weighting to each of the content items returned.

To determine the weighting:

1. For each content item, Confluence first applies three weightings based on the following:
   a. The content type of the item returned — user profile, page, blog post, attachment, etc. (More details below.)
   b. The type of field in which the search term was found — title, name, label, or content body. (More details below.)
   c. The age of the item returned. (More details below.)
2. Confluence then combines the three weightings to arrive at a single weighting for the content item.

The item with the heaviest weighting will appear at the top of the list of search results, and the other items will appear below in descending order of weighting.

**Weighting of Content Types**

<table>
<thead>
<tr>
<th>Content Type</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Profile</td>
<td>9</td>
</tr>
<tr>
<td>Page</td>
<td>8</td>
</tr>
<tr>
<td>Blog</td>
<td>7</td>
</tr>
<tr>
<td>Attachment</td>
<td>6</td>
</tr>
<tr>
<td>Comment</td>
<td>5</td>
</tr>
<tr>
<td>Mail</td>
<td>0.5</td>
</tr>
<tr>
<td>Space Description</td>
<td>0.4</td>
</tr>
</tbody>
</table>

**Simple example**

If the search returns 7 matching items, and each item is one of the above types, then the items will be presented in the above order on the results screen. (This example assumes that the search term is found in the same field in each item — see more about fields below.)

**Weighting of Fields**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>9</td>
</tr>
</tbody>
</table>
Note that 'content' above could be the content of a page, or the content of a comment, or the body of any other content type. See more about content types above.

**Simple example**

A match for a search term in the title of a document is 1.8 times (9/5) more important than a match in the content.

### Weighting Based on Age

This weighting is based on the age of the item returned in the search results. The age of the item is calculated from the creation date of the item. The age intervals are quite coarse-grained, as shown in the table below.

<table>
<thead>
<tr>
<th>When the Item was Created</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>1.5</td>
</tr>
<tr>
<td>Yesterday</td>
<td>1.3</td>
</tr>
<tr>
<td>Up to 1 week ago</td>
<td>1.25</td>
</tr>
<tr>
<td>Up to 1 month ago</td>
<td>1.2</td>
</tr>
<tr>
<td>Up to 3 months ago</td>
<td>1.15</td>
</tr>
<tr>
<td>Up to 6 months ago</td>
<td>1.10</td>
</tr>
<tr>
<td>Up to 1 year ago</td>
<td>1.05</td>
</tr>
<tr>
<td>Beyond a year</td>
<td>1</td>
</tr>
</tbody>
</table>

The weighting is fairly small, so will not have a large effect. When an item is more than a year old, the age weighting is just '1' i.e. it has no effect.

**Simple example**

- If two documents match in all other ways then the newer one will be presented first.
- If the two documents being compared are both older than a year then their relative age does not matter.

### Simplified Example

Let's assume you search for a single term.

Confluence finds a match in the title of an email message created today:
<table>
<thead>
<tr>
<th>Weighting for the content type (email)</th>
<th>0.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weighting for field (title)</td>
<td>9</td>
</tr>
<tr>
<td>Weighting for age (today)</td>
<td>1.5</td>
</tr>
<tr>
<td><strong>Total weighting</strong></td>
<td>6.75</td>
</tr>
</tbody>
</table>

Confluence also finds a match in the content of a comment created three weeks ago:

<table>
<thead>
<tr>
<th>Weighting for the content type (comment)</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weighting for field (content)</td>
<td>5</td>
</tr>
<tr>
<td>Weighting for age (up to 1 month ago)</td>
<td>1.2</td>
</tr>
<tr>
<td><strong>Total weighting</strong></td>
<td>30</td>
</tr>
</tbody>
</table>

**Result:** The comment (weighting 30) will be appear higher in the search results than the e-mail (6.75).

Confluence uses the [Apache Lucene](https://lucene.apache.org) search engine library. Lucene's score calculation has a number of additional terms, not mentioned in the above example. We have simplified above, for purposes of illustration. If you are interested, you can see more information in the [Lucene documentation](https://lucene.apache.org).

**Related Topics**

- Searching Confluence
- Confluence Search Syntax
- Confluence Search Fields
- Text Tokenisation and Filtering
- Search Results Macro
- Livesearch Macro
- Page Tree Macro (includes an optional search box)

Take me back to [Confluence Documentation Home](https://confluence.cloud/confluence)

**Organising Content**

Confluence provides a number of ways for organising and structuring content in the wiki:

- **Spaces** allow you to group content according to major categories.
- **Pages** are used for discrete topics, and can be structured into page trees to show the relation between them.
- **Favourites** are particular pages or spaces that have been bookmarked by a user, to make them easy to find again.
- **Labels** are user-defined tags that are added to related pages in order to categorise them in some way.
- **Attachments** to a page can include images, multimedia, Office and PDF files, and provide a way to include other forms of content in the wiki.
- **Email** can be collected and archived within each space individually, to manage all mail related to a project.
Working with Pages

Pages are the primary means of storing and sharing information in Confluence. Pages are contained within **spaces**.

- Use **spaces** to organise your wiki content into your primary logical groups. For example, you could have a space per team, per product, or per department.
- Use **pages** to organise your content into lower-level groups. For example, you could have a page for a particular team activity, or for a feature in a product, or for a chapter in a book. Add more child pages to contain lower-level details if necessary.

Things you can do with pages in Confluence:

- Create a new page from anywhere within the site.
- Write content using the editor.
- Rename a page.
- Copy an existing page.
- Organise pages hierarchically via parent-child relationships.
- Move pages while editing a page or while viewing the space’s Tree view.
- Navigate within and between spaces through flexible linking.
- Collaborate via comments on a page.
- Control access through page security restrictions.
- Monitor page updates and other activity through page notifications.
- View page history and link to older versions.
- Search page content, including attachments.
- Export pages to PDF, WORD, HTML or XML.
- Email page content.
- Like a page.

Moving a Page

This page describes how to move a page. You can move a page:

- to a different space, with a new parent
- to have a different parent page, within the same space
- to reorder sibling pages that are children of a common parent.

When you move a page, all of the page content such as attachments and comments will be moved with the page. Additionally, all child and descendant pages and their page content will also be moved.
You can also copy a page, and move an attachment.

On this page:
- Moving a Page to a Different Space
- Moving a Page within a Space
- Related Topics

Permissions

To move a page, you need the following permissions:

- 'Edit' permission on the page you are moving, and
- 'View' permission on the page's parent page. So if you are moving the page to a different parent, you need 'View' permission on the new parent.

To move a page into a different space, you will also need:

- 'Remove' permission on the space you are moving from, and
- 'Create' permission on the space you are moving to.

To move a page while keeping its page restrictions, you will also need:

- Space administrator permission on the space you are moving to. Alternatively, remove the page restrictions before performing the move.

Moving a Page to a Different Space

You can move a page, along with its child pages, to a different space. Any links to a moved page from the current space will automatically be renamed to point to the page in the new space.

To move a page to another space in your Confluence site:

1. Go to the page and choose Tools > Move.
2. Use the tabs on the left to help you find the new space and parent page for your page, that is, the location where you want to move your page. The 'Current location' and 'New location' breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, check Reorder to see a list of sibling pages when you click Move.
4. Click Move.
5. If you are reordering the child pages, click in the list to set the new position for the page and click Reorder.

Moving a Page within a Space

You can move a page to a different position in the page tree. This allows you to:

- Move a single page, or a family of pages, to have a different parent within the space.
- Reorder sibling pages that are children of a common parent.

Any links to the page are maintained. When a page that is itself a parent (that is, it has one or more child pages) is moved, the entire hierarchy of child pages of the moved page (including comments and attachments) is maintained.

To move a page using the space's 'Tree' view:

1. From any page, choose Browse > Pages.
2. Click Tree.
3. Find the page you want to move.
4. Drag the page up or down the tree.
5. While dragging the page, you see one of the following:
   - A thin line between existing pages — this indicates the potential new position for the page.
     Release the mouse button when the page is where you want it.
   - A wide highlight over one or more existing pages — this indicates that you can drop the page into a
     page family. Release the mouse button to add the page to the family. The page will appear either
     in alphabetical sequence or as the last page in the family, depending on the family's sequential
     order.

⚠️ The new position of the page is saved as soon as you release the mouse button.
💡 To cancel the move while still holding down the mouse button, press the 'Esc' key.

**Related Topics**

- Moving an Attachment
- Copying a Page
- Deleting a Page
- Sequential Order of Pages
- Overview of Pages

Take me back to the Confluence User's Guide.

**Copying a Page**

You can copy a page, to create a duplicate of the page content. You will need to rename the page, because a
page name must be unique within a space.

You need 'Create Pages' permission, which is assigned by a space administrator from the Space Administration
screens. See space permissions or contact a space administrator for more information.

**To copy a page:**

1. Go to a page in the space and choose **Tools > Copy**.
   Confluence will open a copy of the page in edit mode. By default, Confluence will name the page 'Copy of
   <<original page name>>'.
2. Rename the page and make any other changes required in the body of the page.
3. If you need to move the new page to a different space or a different parent, you can edit the **Location**.
   Refer to the instructions on moving a page.
4. Click **Save**.

**Notes**

- Copying a page will duplicate all of the original page's attachments and labels, but will not copy comments
  from the original page.
- This method of copying a page does not copy the child pages. Please add your vote to issue CONF-2814
  if you'd like to see this improvement.
- You can copy an entire space, including all pages in the space (parents and children) — refer to these
  instructions on copying a space.
- Consider using WebDAV to move or copy a page hierarchy from one space to another, provided that
  none of the page names already exist in the target space.
To rename a page:

1. Go to a page in the space, and click **Edit** at the top to view the page in ‘Edit’ mode.
2. Change the page title as required.
3. Click **Save**.

**Notes**

- Confluence will automatically update all internal links to point to your new page title. This only works for page links that use the relative link syntax, for example [Renaming a Page].
- In macros, page links will not be updated. You need to update these manually.
* Links from external sites will be broken, unless they use the page's permanent URL.

## Related Topics

- Linking Pages
- Working with Pages

Take me back to Confluence User's Guide

### Deleting a Page

To delete a page, you need the 'Remove Pages' permission. See Space Permissions or contact a space administrator for more information. If someone has applied page restrictions to the page, the restrictions may prevent you from deleting the page too.

#### To delete a page:

Go to the page and choose **Tools > Remove**. Confirm the action as prompted.

**Note:** The 'Remove' option will only appear if you have permission to remove this page.

#### Related pages:

- Restoring a Deleted Page
- Purging Deleted Pages
- Creating a Page
- Editing or Deleting a Page That Won't Render
- Confluence User's Guide

### Deleting a page and all its children

If the page you are deleting has any child pages, they will be moved to the root of the space. The child pages will not be deleted.

**Hint:** If you need to remove a parent page and a large number of child pages:

- Create a temporary new space.
- Move the parent page to the new space. The child pages will move too.
- Remove the space.

**Notes**

- When you delete a page, Confluence moves it to the trash. Space administrators can recover pages from the trash.
- Purge the trash to remove the page permanently.
- Attachments attached to a deleted page will remain in the database (allowing potential retrieval) until the trash is purged. When the trash is purged, all attachments on that page are permanently removed.

#### Purging Deleted Pages

When a user deletes a page from a Confluence space, the page is not permanently removed. Instead, Confluence places the deleted page into the 'Trash'. The page will remain in 'Trash' until a space administrator purges the page.

Purging deleted pages permanently clears them from 'Trash'.

You need to be a space administrator to purge deleted pages for a space.

#### To purge deleted pages:

1. Choose Browse > Space Admin.
1. Choose **Browse > Space Admin**.
   *Note: ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).*
2. Click **Trash** from the left panel. A list of deleted pages and emails for the space is displayed.
3. Click the **Purge** link beside a page or else click **Purge All** to permanently clear all deleted pages and news items.

   When the trash is purged, all attachments on purged pages are permanently removed as well.

**Related Topics**

- Deleting a Page
- Restoring a Deleted Page

**Take me back to** [Confluence User's Guide](#)

**Restoring a Deleted Page**

When you restore a page, you are retrieving it from ‘Trash’ to the root of the space where it existed before it was deleted.

You need to be a **space administrator** to restore deleted pages.

**To restore a deleted page:**

1. Choose **Browse > Space Admin**.
   *Note: ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).*
2. Click **Trash** from the left panel. A list of deleted pages and emails for the space is displayed.
3. Click **Restore** beside the page you want to restore.

**Note**

If a new page has already been created in that space with the same name as the deleted page, you will be given an option to rename the page before it is restored.

**Related Topics**

- Deleting a Page
- Purging Deleted Pages

**Take me back to** [Confluence User's Guide](#)

**Working with Page Families**

A ‘page family’ is simply the **parent** and **child** pages in a part of the page hierarchy.

**Things you can do with page families in Confluence:**

- **View a page’s family.**
- **View the hierarchy of all pages within a space.**
- **Move and re-order pages.**
- **Order the pages in a page family alphabetically.**

**Related Topics**

- Managing Orphaned Pages
Working with Pages
Working with Spaces

Take me back to Confluence User's Guide

Viewing a Page's Family

To view a page's family, go to the page and choose Tools > Info.

The page's parent and children, if any, are listed under 'Hierarchy'.

Screenshot : Viewing a page's family

<table>
<thead>
<tr>
<th>Hierarchy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Page</td>
</tr>
<tr>
<td>Home</td>
</tr>
<tr>
<td>Children (1)</td>
</tr>
</tbody>
</table>

Choose a Page
Move an attachment from one space to another
Move a family of pages from one space to another
Move a page from one space to another
Page Families

Notes

- If there are more than 10 children, only the first 10 will be shown by default. To view all the children, click Show all....
- If no parent is displayed for the page, either the page sits in the root directory of the space or its parent has been deleted.

Related Topics

Working with Page Families
View Hierarchy of all Pages within a Space
Managing Orphaned Pages

Take me back to Confluence User's Guide

Sequential Order of Pages

Confluence allows you to present your pages in any order (sequence) you choose. The position of a page is reflected in the following places:

- The Tree tab on the space's 'Pages' view
- Exporting pages to PDF, HTML and XML
- The Pagetree macro
- The Children macro

Alphabetical versus Manual Order

By default, Confluence will present your pages in alphabetical order. When you move a page to a different position, the order becomes manual for the affected page family.

When ordering pages alphabetically, Confluence actually applies a more sophisticated 'natural' order rather than a straight alphabetical order. The natural order handles numeric values correctly when doing string comparisons.

Now let's consider what happens when you add a page to a page family, by creating a new page or by moving or copying a page into the family:

- If the page family's order is alphabetical, the new page will appear in alphabetical order too.
- If the page family's order is manual, the new page will appear at the bottom of the list of pages in the
Changing the Page Order

You can change the order of the pages by moving pages within the page tree — see Moving a Page.

You can also change the order of a page-family from manual to alphabetical (see the 'Setting Page Order to Alphabetical' section on Setting a Page Family to Alphabetical Order).

Related Topics

Overview of Pages
Overview of Page Families
Moving a Page

Take me back to Confluence User's Guide

Setting a Page Family to Alphabetical Order

You can choose to display your Confluence pages in alphabetical or manual order. This page tells you how to set the pages within a family to alphabetical order. See Sequential Order of Pages.

On this page:
- About the Sequential Order of Pages
- Alphabetical versus Manual Order
- Changing the Page Order
- Setting Page Order to Alphabetical
- Related Topics

About the Sequential Order of Pages

Confluence allows you to present your pages in any order (sequence) you choose. The position of a page is reflected in the following places:
- The Tree tab on the space's 'Pages' view
- Exporting pages to PDF, HTML and XML
- The Pagetree macro
- The Children macro

Alphabetical versus Manual Order

By default, Confluence will present your pages in alphabetical order. When you move a page to a different position, the order becomes manual for the affected page family.

When ordering pages alphabetically, Confluence actually applies a more sophisticated 'natural' order rather than a straight alphabetical order. The natural order handles numeric values correctly when doing string comparisons.

Now let's consider what happens when you add a page to a page family, by creating a new page or by moving or copying a page into the family:
- If the page family's order is alphabetical, the new page will appear in alphabetical order too.
- If the page family's order is manual, the new page will appear at the bottom of the list of pages in the family.

Changing the Page Order

You can change the order of the pages by moving pages within the page tree — see Moving a Page.

You can also change the order of a page-family from manual to alphabetical (see the 'Setting Page Order to Alphabetical' section on Setting a Page Family to Alphabetical Order).
Setting Page Order to Alphabetical

If the pages in a page family have been ordered manually, you can reset the page order to alphabetical as described below.

A page family is a set of pages under a single parent page. In this section, when we say 'page family' we mean the immediate children of the parent page, not including the grand-children.

The screenshot below shows a family of pages in non-alphabetical order under the parent ‘Sample Page’. Notice the icon next to the parent ‘Sample Page’, giving you the option to order the pages alphabetically.

Screenshot: A family of pages in non-alphabetical order with 'Sort Alphabetically' icon

To set a page family to alphabetical order:

1. Go to a page in the space and choose Browse > Pages.
2. Go to the Tree tab.
3. Expand the branches of the tree to find the page family you want.
4. If the page family is in non-alphabetical (manual) order, the 'Sort Alphabetically' icon will appear next to the parent page as shown in the screenshot above. Click the icon.
5. The child pages will shuffle into alphabetical order and the icon will change to the 'Undo Sorting' icon as shown in the screenshot below.

Only the immediate children of the parent page will be affected. The grand-children will not be re-ordered. (If you want to re-order the grand-children, you need to click the 'Sort Alphabetically' icon next to the parent of those pages i.e. re-ordering happens for one node at a time.)

Screenshot: A family of pages in alphabetical order with 'Undo Sorting' icon
If you change your mind, you can click the 'Undo Sorting' icon to undo the alphabetical sort. This option is only available while you remain on the Tree tab and provided that you have not performed any other action on the page family. Once you move away from this screen or do something else with the page family, such as moving children in or out of the family, the undo option is no longer available.

Related Topics

Moving a Page
Overview of Pages
Overview of Page Families

Take me back to Confluence User's Guide

Viewing Hierarchy of Pages within a Space

The 'Tree' view of the 'List Pages' page displays the hierarchy of the pages within the space. It is a useful way of viewing all the parent-child relationships between pages in the space at once.

To see the tree view of pages within a space:

1. Choose Browse > Pages.
2. Click Tree.

Screenshot: Tree View

Related Topics

Moving a Page
Working with Pages

Take me back to Confluence User's Guide
Viewing Pages Alphabetically

Use this view when you are looking for a specific page in a space and you know its title.

To view the pages in your space alphabetically:

1. Choose Browse > Pages.
2. Choose Alphabetical.
3. Choose a letter to display all the pages beginning with that letter. Choosing a page link will take you to that page.

Notes

If you know the title of a page, you might find it faster using the Quick Search.

Related Topics

- Viewing Recently Updated pages
- Working with Pages
- Confluence User's Guide

Managing Orphaned Pages

An orphaned page is a page without any incoming links. What this means is that unless you know that this page exists, you are not likely to come across it in the space during the natural course of navigation.

When you are working in a large space with a number of pages, it is difficult to keep track of all of them. An orphaned page may be redundant or need to be referred to from another page. Confluence allows you to view all the orphaned pages in a space so you can "tidy up" the space by either deleting pages or by reorganising them.

To view the orphaned pages in a space:

1. Choose Browse Space > Advanced.
2. Click on Orphaned Pages in the left panel.

You can:

- delete an orphaned page by clicking on the 'trash' icon beside it.
- give an orphaned page a parent — see Moving a Page.

Screenshot: Managing Orphaned Pages

<table>
<thead>
<tr>
<th>Title (Space)</th>
<th>Creator</th>
<th>Created</th>
<th>Last Updated By</th>
<th>Updated</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.2.1 News</td>
<td>Anonymous</td>
<td>Sep 21, 2004</td>
<td>Anonymous</td>
<td>Nov 04, 2004</td>
<td></td>
</tr>
</tbody>
</table>
Managing Undefined Pages

In Confluence, you can create links to pages that you intend to create later. These are links to "undefined pages". This is useful because it allows you to create links first and enter content for those pages later.

For example, this link to new page is a link to a non-existent page, also called an undefined page. The link is shown in dark red. If someone clicks the link, Confluence will create a new page called 'link to new page'.

The 'Undefined Pages' view gives a consolidated report of all undefined pages so that you can manage your space better. The undefined page links are badged with this icon to remind you that those pages need to be created.

To view a list of the undefined links in a space:

1. Choose Browse > Advanced.
2. Choose Undefined Pages in the left-hand panel. This will display a list of all the undefined pages in the space.

You can click the link for an undefined page to create the page and add content to it.

Related Topics

- Managing Orphaned Pages
- Working with Pages
- Confluence User's Guide

Using the Documentation Theme

The Documentation theme is one of the themes bundled with Confluence. It provides an inbuilt table of contents for your wiki space, a configurable header and footer, and text styles suited to documentation. You can also configure it to restrict the search results to the current space, rather than searching the entire Confluence site.

This page tells you how to view pages in your Confluence space when your space uses the Documentation theme. For the full list of features and instructions on applying the theme to a space, see the guide to configuring the Documentation theme.

Quick guide to using the Documentation theme

- The left-hand panel contains a page tree. This is a table of contents that shows the pages in the space.
- Click the plus signs in the page tree to see the child pages.
- Drag the thick vertical bar to change the width of the panels.
- Show/hide the left-hand panel: Click the sidebar icon at top right, next to the search box, to remove the left-hand panel altogether. Click the icon again to restore the panel.
- Alternatively, press 'T' on your keyboard to show/hide the left-hand panel.
- Overriding a space-restricted search: If your theme is configured to restrict the search to the current space, you can enter 'all:' and your search term to search the entire site.

The rest of this page gives more details of the above guidelines.
Using the Documentation Theme

By default, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.

A space administrator can customise the Documentation theme as follows:

- Change the content in the left-hand panel and add a header and footer to the page. This means that your own pages may look different from the screenshot above.
- Restrict the search so that it will show results from the current space only, not from the entire Confluence site.

Here is a summary of the things you can do on a page that uses the Documentation theme:

- Click the plus signs to open and close the branches of the page tree (table of contents) in the left-hand panel.
- Drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel.
- Click the sidebar icon at top right, next to the search box, to remove the left-hand panel. This will remove the panel for you only. Other people will still see it.
- Click the sidebar icon again to restore the left-hand panel.
- Alternatively, press '[' on your keyboard to show/hide the left-hand panel.
- Use the scroll bars to scroll the left-hand and right-hand panels independently of each other.
- Search the content of the space or the site. See below.

Searching the Space or the Site

When using the Documentation theme, the Confluence search offers a few options as described below.

Using the search box at the top right of the page:

- By default, the main Confluence search is configured to search the entire Confluence site.
  - You will see the words ‘Search Confluence’ in the search box at top right of the page.
  - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
- A space administrator can configure the Documentation theme to restrict the search to the current space.
  - You will see the words ‘Search this space’ in the search box at top right of the page.
• The search will return results from the current space only.
• You can override the search restriction. Enter 'all:' and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for 'technical writing':

```
all: technical writing
```

Using the search box in the left-hand panel:

• By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are children of the space's home page.
• If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

Hints and Tips

Below are some hints that you may find useful when using the Documentation theme. Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the Atlassian documentation wiki, you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme's table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the 'Home' page. You can specify the home page in the space administration section.

Help, my pages do not appear in the Documentation theme table of contents

Cause 1: Your pages are not under the space’s home page. The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space’s home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:

• You can change the designated space home page in the space administration section.
• Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the 'Pages' section of the space 'Browse' screen. See Moving a Page.

Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled. If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.

**Viewing Page Information**

The 'Information View' for a page shows you various bits of useful information about the page.

**To see the Information View for a page:**

1. View the page.
2. Choose **Tools > Info** to go to the 'Information' view for the page.

The 'Information View' displays the following information:

1. **Page Details:** Title, author, date of creation, date of last modification and the tiny link of the page.
2. **Page Hierarchy:** Parent-child relationships of the page.
3. **Page Permissions:** Displays page-level security restrictions that apply to the page (if present).
4. **Recent Changes:** Links to the five most recent versions of the page along with the name of the editor and the date of modification.
5. **View page history:** A link to the page history, which displays all the versions of the page in reverse chronological order and allows you to compare versions or to restore a previous version.
6. **Hot Referrers:** The external website pages which send the most viewers to the page.

**Screenshot: A page’s Information View**

**Related Topics**

**Working with Pages**

Take me back to Confluence User's Guide

**Viewing Recently Visited Content**

Confluence keeps track of pages you have recently visited in Confluence. This history is available from the Recently Viewed screen. You can also use this screen to go back to Confluence pages you have recently visited.
To view the list of recently visited pages and go back to one of them:

1. Go to the 'Recently Viewed' content view. To do this:
   - Go to your name (the 'User' menu) at the top of the page and choose Recently Viewed.
2. Choose the title of the page you wish to revisit.

Screenshot: Recently viewed content

---

**Notes**

- The list of recently-viewed pages records up to the last 20 pages visited.
- The list is cleared when you log out of Confluence or your Confluence session terminates.

**Related Topics**

- Working with Pages
- Confluence User's Guide

**Page History and Page Comparison Views**

Confluence tracks histories of changes to pages by maintaining a version of the page each time it is modified. It is easy to view changes between different versions and to restore a previous version if required.

---

**Accessing the Page History View**

To view the history of a page:
• Go to the page and choose **Tools > Page History**.

You can click a version number to view that version. To get back to the page history view, click **View Page History**.

**Screenshot: Page History View**

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changed By</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT</td>
<td>Jul 07, 2009 11:33</td>
<td>Giles Gaskell [Atlassian Technical Writer]</td>
<td></td>
</tr>
<tr>
<td>v. 40</td>
<td>Jun 18, 2007 11:08</td>
<td>Rosie Jameson [Atlassian Technical Writer]</td>
<td>Restore this version</td>
</tr>
</tbody>
</table>

When you are viewing a specific version of the page, the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current version</td>
<td>View the latest version of the page.</td>
</tr>
<tr>
<td>Compare with Current</td>
<td>Compare the differences between the version of the page you are viewing and the current version.</td>
</tr>
<tr>
<td>Restore this Version</td>
<td>Restore the page version you are viewing to be the current version.</td>
</tr>
<tr>
<td>View Page History</td>
<td>Return to the list of page versions.</td>
</tr>
<tr>
<td>&lt;&lt; Previous or Next &gt;&gt;</td>
<td>View the previous or next page version, respectively.</td>
</tr>
</tbody>
</table>

**Viewing Changes in a Page History**

The page history view and **page information view** allow you to view recent changes made to a page or to compare the differences between any two versions of a page.

**Viewing Recent Changes**

To view recent changes made to a page:

1. Click **view change** at the top of the page below the page title. The page comparison view is displayed, showing the differences between the current version and the previous version.
   Or:
2. Choose **Tools > Info** to go to the ‘Information’ view for the page.
3. In the section titled ‘Recent Changes’ you will see the most recent versions of the page, along with the date of their modification and the name of the modifying author.
4. Click **view changes** beside the desired version. The page comparison view is displayed, showing the differences between the selected and previous versions.

**Comparing Two Different Versions of a Page**

To compare two different versions of a page:

1. Go to the page and choose **Tools > Page History**.
2. Select the versions you want to compare by selecting the check boxes beside them.
3. Click **Compare selected versions**. The page comparison view is displayed, showing the text differences between the selected versions.
Page Comparison View

The page comparison view shows the differences between selected page versions.

Key

On the page comparison view, the following key indicates the differences between the selected page versions:

<table>
<thead>
<tr>
<th>Highlight</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Added content</td>
</tr>
<tr>
<td>Red</td>
<td>Deleted content</td>
</tr>
<tr>
<td>Blue</td>
<td>Changed formatting</td>
</tr>
</tbody>
</table>

Screenshot: Comparing Changes

<table>
<thead>
<tr>
<th>Versions Compared</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="111 Edwin Dawson Aug 16, 2011" /></td>
<td><img src="#" alt="122 Paul Watson Aug 19, 2011" /></td>
</tr>
<tr>
<td><img src="#" alt="This line was added" /></td>
<td><img src="#" alt="This line was removed" /></td>
</tr>
<tr>
<td><img src="#" alt="Formatting was changed" /></td>
<td></td>
</tr>
</tbody>
</table>

Interactive views

When a page comparison view is first displayed, all large sections of unchanged text are hidden and reduced to an ellipsis . . .

You can view page changes between versions which are adjacent to your current page comparison view. Click the link containing:

- << to view the page comparison with the earlier adjacent version
- >> to view the page comparison with the more recent adjacent version.

For example, if your page comparison view is between v. 30 and v. 34 of a page, you can view changes between:

- v. 29 and v. 30 by clicking << Changes from 29 to 30
- v. 34 and v. 35 by clicking Changes from 34 to 35 >>

Other Page History View Features

You can also use the page history view to:

- View an older version of a page
- Restore an older version of a page
- View change comments

Related Topics

- Viewing Page Information
- Working with Pages
- Tracking Updates
Restoring an Older Version of a Page

To restore an older version of a page:

1. Go to the page and choose **Tools > Page History**.
2. Click **Restore this version** beside the version to restore.
3. Change the default comment if desired and click **OK**.

**Notes**

- All page history is retained. Restoring an older version creates a copy of that version. For example, in the screenshot below, if you selected v.39 and clicked **Restore this version**, a copy of v.39 would be created. This copy would be v.42 and would become the current version.
- You can click a version number's link to view the contents of that page version.
- Select the check boxes of two different versions and click **Compare selected versions** to view the changes made between them.
- If you are viewing a specific page version, you can restore that version of the page by clicking **Restore this Version** on that page.
- To get back to the page history view, click **View Page History**.

**Screenshot: Restoring an Older Version of a Page**

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changed By</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT</td>
<td>Jul 07, 2009</td>
<td>Gilas Gaskell [Atlassian Technical Writer]</td>
<td></td>
</tr>
<tr>
<td>v. 40</td>
<td>Jun 18, 2007</td>
<td>Rosie Jameson [Atlassian Technical Writer]</td>
<td>Restore this version</td>
</tr>
<tr>
<td>v. 39</td>
<td>Jun 18, 2007</td>
<td>Rosie Jameson [Atlassian Technical Writer]</td>
<td>Restore this version</td>
</tr>
</tbody>
</table>

**Related Topics**

- Page History and Page Comparison Views
- Working with Pages

Take me back to the [Confluence User's Guide](#).

Viewing an Older Version of a Page

Confluence keeps a *history of all page changes*. You can see what any of the previous versions of the page looked like, as well as link to them.

There are two ways that you can view an older version of a page.

- **Using the 'View Change' link** — this allows you to quickly check the most recent change to a page and the most recent version of the page, prior to the current version.
- **Using the Page History** — this allows you to look for a specific version of the page.

**On this page:**

- Viewing an Older Version of a Page using the 'View Change' Link
- Viewing an Older Version of a Page using the Page History
- Related Topics

Viewing an Older Version of a Page using the 'View Change' Link

To view an older version of a page using the 'View Change' link:
1. Go to the page and click **view change** (displayed under the page title).
2. Click the **Version ###** link in the top left-hand box to show the page content of the previous version.

**Notes**

- If you want to view an earlier version of the page, click the < link at the top left.
- If you want to send this page version to someone, simply copy and paste the URL from your browser. The link will look something like this: http://confluence.atlassian.com/pages/viewpage.action?pageId=12345.

**Viewing an Older Version of a Page using the Page History**

**To view an older version of a page using the page history:**

1. Go to the page and choose **Tools > Page History**. The 'Page History' view will open. Read more about viewing the page history on [Page History and Page Comparison Views](#).
2. Click a version number’s link to view the contents of that page version. The following header will display across the top of the old version of the page:

    ![Header of an older version of a page](image)

    **When you are viewing a specific version of the page, the following functions are available:**

    | Function               | Description                                      |
    |------------------------|--------------------------------------------------|
    | current version        | View the latest version of the page.             |
    | Compare with Current   | Compare the differences between the version of the page you are viewing and the current version. |
    | Restore this Version   | Restore the page version you are viewing to be the current version. |
    | View Page History      | Return to the list of page versions.            |
    | << Previous or Next >> | View the previous or next page version, respectively. |

If you want to send this page version to someone, simply copy and paste the URL from your browser. The link will look something like this: http://confluence.atlassian.com/pages/viewpage.action?pageId=12345.

**Related Topics**

- Page History and Page Comparison Views
- Restoring an Older Version of a Page
- Recording Change Comments

**Using a WebDAV Client to Work with Pages**

You can access Confluence content via a WebDAV client, such as 'My Network Places' in Microsoft Windows. Provided that you have permission, you will be able to read and write to spaces, pages and attachments in Confluence. You will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

Please refer to the page on [configuring and setting up a WebDAV client](#).
Working with Blog Posts

You can publish a blog post from any space in Confluence, provided you have permission. Blog posts may be announcements, journal entries, status reports, or any other timely information.

You can view the blog posts for a space by choosing Browse > Blog. Confluence catalogues the blog posts chronologically and allows you to browse blog posts for the space by navigating a calendar.

Creating and editing a blog post is just as easy as creating and editing any other page in Confluence. You can also let people know you care by liking a blog post.

Creating and editing a blog post is just as easy as creating and editing any other page in Confluence. You can also let people know you care by liking a blog post.

Related pages:
- Subscribing to RSS Feeds within Confluence
- Managing Changes and Notifications and Tasks
- Blog Posts Macro
- Sharing Content
- Confluence User's Guide

What would you like to do?

View blog posts
Add blog posts
Edit blog posts
Link to blog posts
Delete blog posts

Deleting Blog Posts

To delete blog posts, you require ‘Remove Blog’ permission which is assigned by a space administrator. See Space Permissions or contact a space administrator for more information.

To delete a blog post:

- Go to the blog post and choose Tools > Remove.
  - The Remove option is only displayed if you have permission to remove this blog post.

Handy Hint

Deleted blog posts are stored in the trash and can be recovered by a space administrator.

Related Topics

Viewing Blog Posts
Adding Blog Posts
Editing Blog Posts
Linking to Blog Posts

Take me back to Confluence User's Guide

Editing Blog Posts

To edit a blog post, you require the ‘Create Blog’ permission which is assigned by a space administrator. See Space Permissions or contact a space administrator for more information.

To edit a blog post:

1. Navigate to the space that has the blog post and choose Browse > Blog. A list of the most recent blog posts within the space is presented. A calendar allows you to browse earlier blog posts.
2. Locate the blog post and click Edit.
3. Make changes to the blog post.
4. *(optional)* Add a comment, in the text box below the editing pane, to describe your changes.
5. Preview your changes if desired, and click Save.

Editing a blog post is similar to editing any other page in Confluence. However, there are a few things to keep in mind:

- You cannot change the date of an existing blog post. You can only backdate when adding a blog post.
- You cannot move a blog post to another space.
- A blog post has no parent.

**Related Topics**

- Working with Blog Posts
- Adding Blog Posts
- Deleting Blog Posts
- Blog Posts Macro

Take me back to [Confluence User's Guide](#)

**Viewing Blog Posts**

To view the blog posts within a space:

- Navigate to the desired space, and select **Browse > Blog**.

A list of the most recent blog posts within the space will be displayed, along with the date of each post and the name of its author. The blog posts for the month will be shown in a panel, next to the list of the most recent blog posts. The panel will also contain links to the previous and next month (e.g. 'April 2010'), which you can use to browse blog posts from different months.

**Related topics**

- Blog Posts Macro
- Adding Blog Posts
- Linking to Blog Posts
- Confluence User's Guide
Working with Spaces

In Confluence, content is organised into spaces. There are two types of space:

- **Global** spaces are areas on your site into which you can group content items (pages, attachments, news, etc) based on any subject or topic of your choice. For example, you may want separate areas on your site for each team or project within your organisation.
- **Personal** spaces belong to specific users. They can be kept private, or opened up so the whole world can view and edit them, just like global spaces. These spaces are listed in the People Directory. They are not listed on the 'All' tab on the dashboard.

What is a Space?

A space is an area within Confluence, containing your wiki pages. You can think of each space as a sub-site, or mini-site, each with its own home page.

Each space:

- Has its own pages, blog posts, comments, RSS feeds and mail (mail applies to global spaces only).
- Has its own access control settings. You can set different levels of access for different spaces.
- Can be separately exported to PDF, HTML or XML.

There is no limit to the number of global spaces you can create in Confluence.

On this page:

- What is a Space?
- Viewing the spaces in a Confluence site
- Guidelines for dividing content into spaces and pages
- Example: Favourite spaces as shown on the dashboard
- Notes

Related pages:

- Setting up a New Global Space
- Setting Up your Personal Space
- Viewing All Confluence Spaces
- Archiving a Space
- Deleting a Space
- Viewing Space Activity
- Using Labels to Categorise Spaces
- Administering a Space
- Confluence User's Guide

Viewing the spaces in a Confluence site

Confluence displays a list of spaces in the following locations:

- The **dashboard** displays a list of all the spaces in the Confluence site that you have permission to see. You can make a space a favourite, or categorise the space, to get easy access to the content that is most relevant to you. See Customising your Personal Dashboard.
- The **space directory** displays a list of all the global and personal spaces in the Confluence site that you have permission to see. You can choose to see all spaces, the spaces you have marked as favourite, or the spaces in a given space category. You can further restrict the number of spaces displayed, by entering a word or words in the Filter box. Confluence will display only the spaces that have the matching words in the space name or description. See Viewing All Confluence Spaces.
- The **people directory** displays a list of all Confluence users, including those who have personal spaces. See Searching the People Directory.
Guidelines for dividing content into spaces and pages

To ensure maintainable and logical spaces, consider the following points when allocating your content to pages and spaces:

- Group the content by topic, subject, project or team.
- Evaluate permissions across the wiki content. If members require conflicting access, for example John must access content on topics A and B, while Jane must access content for topics B and C, then the topics should be separated into three spaces.

Useful notes about spaces and pages:

- Spaces cannot be nested. You cannot have parent and child spaces, but you can have parent and child pages within a space.
- Page permissions can prevent users from accessing a specific page, even though they have permission to access the space.
- Page permissions alone cannot keep the existence of a page secret. The page should be in a restricted space instead.
- Pages can be moved between spaces.
- You can group related spaces, using space categories.

Example: Favourite spaces as shown on the dashboard

The screenshot below shows the area of the Confluence dashboard that displays the spaces that you have marked as favourite:

![Spaces dashboard](Image)

Notes

A space key is a short, unique identifier for a space. For example, you might give your documentation space a key of "DOC". To find the key of an existing space, look at the Confluence URL for a page in the space. The standard Confluence URL has this format:

```
http://my.confluence.site.com/display/SPACEKEY/Page+Name
```
Viewing All Confluence Spaces

Quick guide to viewing spaces

- The **dashboard** displays a list of all the spaces in the Confluence site that you have permission to see. You can make a space a **favourite**, or **categorise the space**, to get easy access to the content that is most relevant to you. See [Customising your Personal Dashboard](#).

- The **space directory** displays a list of all the global and personal spaces in the Confluence site that you have permission to see. You can choose to see all spaces, the spaces you have marked as favourite, or the spaces in a given space category. You can further restrict the number of spaces displayed, by entering a word or words in the **Filter** box. Confluence will display only the spaces that have the matching words in the space name or description. See [Viewing All Confluence Spaces](#).

- The **people directory** displays a list of all Confluence users, including those who have personal spaces. See [Searching the People Directory](#).

On this page:

- Quick guide to viewing spaces
- Viewing spaces on the dashboard
- Viewing spaces in the space directory
- Viewing personal spaces in the people directory
- Notes

Related pages:

- [Working with Spaces](#)
- [Archiving a Space](#)
- [Confluence User's Guide](#)

**Viewing spaces on the dashboard**

The Confluence dashboard displays a list of spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your username's permissions.

The **Spaces** tab displays all the global spaces on the site that you have permission to view, and the spaces you have marked as your **favourites**.

**To see the spaces on the dashboard:**

1. Choose **Dashboard** at the top left of your Confluence screen.
2. Scroll down and choose the **Spaces** tab.

**Screenshot: Viewing spaces on the dashboard**
Viewing spaces in the space directory

The space directory displays a list of global and personal spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your username's permissions. The order of spaces is random.

Categorising the spaces: The spaces are displayed on a number of tabs, each showing a different set of spaces, as follows:

- **All Spaces** – Shows all the global and personal spaces on the site. The list excludes spaces that you do not have permission to view, and spaces that have been archived.
- **Global Spaces** – Excludes personal spaces.
- **Personal Spaces** – Shows only personal spaces.
- **Favourite Spaces** – Shows the spaces that you have marked as your favourites.
- **Various categories** – You will see a number of tabs showing spaces categorised by label. You can add any space category you like. See Using Labels to Categorise Spaces.
- **Archived Spaces** – Shows all the global and personal spaces on the site that have been archived, and that you have permission to view.

Filtering the list of spaces: To restrict the number of spaces displayed, enter a word or words in the Filter box. Confluence will display only the spaces that have the matching words in the space name or description.

To see the spaces in the space directory:

2. Click one of the tabs to see the spaces you want.
3. If you want to restrict the number of spaces shown, entering a word or words in the Filter box.

Screenshot: Viewing favourite spaces in the space directory
Viewing personal spaces in the people directory

The people directory displays a list of Confluence users, including those who have personal spaces. See Search the People Directory. It excludes spaces that have been archived.

To see the personal spaces in the people directory:

2. Choose People with Personal Spaces.

Notes

- If you do not log in, you will be treated as an 'anonymous user’. Confluence will display only those spaces that an anonymous user has permission to see.
- Permission to access a space is granted by a space administrator. See the overview of space permissions.
- You can use the Spaces List macro to display a list of spaces on a Confluence page.
Setting up a New Global Space

To set up a new global space, you need the 'Create Space' permission. 'Create Space' is one of the global permissions that can be assigned by a Confluence administrator.

To create a new global space:

1. Click Add Space located above the list of global spaces on the dashboard, or at the top right of the dashboard, or at the top right of the space directory. The 'Create Space' dialog appears.
2. Enter the following information about your new space:
   - **Space name**: A name for the space. Space names do not have to be unique.
   - **Space key**: A simple key to identify your space (A-Z, a-z, 0-9). This key is a shorthand name for the space, used when linking content between spaces, for web URLs and for reports. For example, a 'Development Space' might have a space key of ‘DEV’. The space key must be unique within the entire Confluence site.
   - **Make this space private**: A private space will be visible only to the person who created it. If you do not make it private, the space will have the default space permissions. The creator will have space administrator permissions on the new space, and can change the permissions at any time after creating the space.
3. Click Create. The home page for your new space is displayed. Note that the home page will automatically contain any default space content as defined by your Confluence administrator.

Next, you can choose a theme and start adding pages to your space.

Related pages:
- Working with Spaces
- Setting Up your Personal Space
- Editing Space Details
- Deleting a Space
- Confluence User's Guide

Screenshot: Adding a global space to Confluence

Create a space for your team or project:

- **Space name**: Chocolate
- **Space key**: CHOC
  - Used in the space's URL: http://localhost:8090/display/CHOC
  - Make this space private

Create Cancel

Notes

A space administrator can change the permissions at any time after creating the space.
Setting Up your Personal Space

Your personal space is a place where you can publish your own pages and blog posts. Once you have set up your personal space, Confluence users can reach it by clicking your name in the People Directory. You can get to it by clicking your name at the top of the page and choosing 'Personal Space'.

Creating your personal space

To set up your personal space, you need the 'Personal Space' permission which is assigned by a Confluence administrator. See Giving People Access to Content and Global Permissions Overview.

To create your personal space:

1. Click your name at the top of the page. (This is the 'user' menu.)
2. Choose Add Personal Space from the dropdown list. The 'Add your personal space' dialog will open.
3. Indicate whether your space should be private or not. A private space will be visible only to you. If you do not make it private, the space will have the default space permissions. Note that you can change these settings again later. You will have space administrator permissions on your space.
4. Click Create.
5. The home page of your new space will appear. Your home page will contain any default space content as defined by your Confluence administrator. You can change this content at any time.

On this page:

- Creating your personal space
- Adding and changing content in your space
- Changing the look and feel of your space
- Granting access to your space
- Watching updates made in your space

Related pages:

- Working with Spaces
- User Profile Overview
- Linking to Personal Spaces and User Profiles
- Confluence User's Guide

Adding and changing content in your space

Now you can start adding pages to your personal space. You may also want to upload your photo.
Changing the look and feel of your space

If you like, you can apply a different theme to your personal space, or modify its colour scheme.

Granting access to your space

When you created the space, you set the option to make your space private, or to allow other people to view and contribute content to your space. You can change the permissions on your space at any time.

Watching updates made in your space

By default, Confluence assigns you as a watcher of your space. This means that you will receive an email notification each time someone adds or updates content in your space. You can stop watching the space (see Watching a Space) and change your notification settings at any time.

Administering a Space

This page gives an overview of the administration functions available in global and personal spaces. You need to be a space administrator to perform space administration functions.

Administering a global space

To view the space administration menu:

1. Go to a page in the space you wish to manage.
2. Choose Browse > Space Admin.
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. Choose a link from the options available in the left-hand panel.

For global spaces, the options available are divided the following categories:

- **Space Operations**
  - Space Details – See Editing Space Details.
  - Space Labels – See Using Labels to Categorise Spaces.
  - Remove Space – See Deleting a Space.
  - Trash – See Purging Deleted Pages and Restoring a Deleted Page.
- **Security**
  - Permissions – See Assigning Space Permissions.
  - Restricted Pages – See Viewing Restricted Pages.
- **Mail**
  - Mail Accounts – See Archiving Mail Overview.
  - Mailbox Import – See Importing Mail.
- **Look and Feel**
  - Themes – See Applying a Theme to a Space.
  - Colour Scheme – See Editing a Space's Colour Scheme.
  - Layout – See Customising Space Layouts.
  - Stylesheet – See Styling Confluence with CSS.
  - PDF Layout – See Customising Exports to PDF.
  - PDF Stylesheet – See Customising Exports to PDF.
Administrating a personal space

To view the space administration menu:

1. Go to a page in the personal space that you wish to manage.
2. Choose Browse > Space Admin.
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. Choose a link from the options available in the left-hand panel.

For personal spaces, the options are divided into the following categories:

- **Space Operations**
  - Space Details – See Editing Space Details.
  - Space Labels – See Using Labels to Categorise Spaces.
  - Remove Space – See Deleting a Space.
  - Trash – See Purging Deleted Pages and Restoring a Deleted Page.

- **Security**
  - View or set space permissions
  - View restricted pages

- **Look and Feel**
  - Themes – See Applying a Theme to a Space.
  - Colour Scheme – See Editing a Space's Colour Scheme.
  - Layout – See Customising Space Layouts.
  - Stylesheet – See Styling Confluence with CSS.
  - PDF Layout – See Customising Exports to PDF.
  - PDF Stylesheet – See Customising Exports to PDF.

### Editing Space Details

You need to be a space administrator for the space, to edit the details of that space.

To edit the details of a space:

1. Go to a page in the space you wish to archive.
2. Choose Browse > Space Admin.
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. The 'Edit Space Details' screen appears. You can:
   - Change the name of the space.
   - Change the description of the space.
   - Change the status of the space from 'Current' to 'Archived' or back again. See Archiving a Space.
   - Select a new home page for the space. The home page is the default page to which users are directed when they click the link to the space from the Dashboard.  
     Note: If you set this field to blank (no selection) then the default home page will be the 'Pages' tab of the 'Browse Space' screen for that space.
4. Choose Save.

#### Related pages:

- Working with Spaces
- Archiving a Space
- Confluence User's Guide

### Notes

- You cannot edit the key or the space creator's name.
The **Edit Space Details** fields do not accept wiki markup. Any wiki markup entered in these fields will be displayed as plain text.

## Deleting a Space
Deleting a space permanently removes the space and all of its contents. You need to be the [space administrator](#) of a space to delete that space space.

**Note:** Deleting a space is permanent. Always create an XML backup of the space before proceeding. Once you have deleted the space, there is no way to restore it unless you have made an XML space backup.

### Related pages:
- [Working with Spaces](#)
- [Archiving a Space](#)
- [Copying or Renaming a Space](#)
- [Confluence User's Guide](#)

### To delete a space:
1. Go to a page in the space you wish to delete.
2. Choose **Browse > Space Admin.**
   - **Note:** 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the `confluence-administrators` group).
3. Choose **Remove Space** in the left-hand panel.
4. Choose **OK.**

**Notes**

There is a problem in some versions of Confluence, where space deletion does not work. See issue **CONF-26122** - [Authenticate](#) to see issue details. If you like, you can watch that issue to be informed of progress.

### Backing Up and Restoring a Space
Confluence can back up all the content, comments and attachments for a space. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) that define the content of the space, and optionally a folder containing the attachments in the space. To transfer this data to another Confluence site, you can upload the zip file.

#### Creating a space backup

See [Exporting Confluence Pages and Spaces to XML](#).

#### Restoring (importing) a space backup

See [Restoring a Space](#).

### Archiving a Space

You can archive a space, so that its content is less visible but still available on your Confluence site. You need to be a [space administrator](#) to archive a space. You can change a space's status from archived to current at any time.

#### The effect of archiving a space

If a space is archived:

- The pages and other content do not appear in the Confluence quick navigation aid, which drops down when you enter text in the search box.
- By default, the pages and other content do not appear in the Confluence search results. If a Confluence site contains any archived spaces, the search screen will provide an option to include them in the search
results.

- The space and its pages do not appear on the dashboard.
- Updates to the space's content do not appear in activity streams, such as the recent updates section of the dashboard.
- The space does not appear in space-selection dropdown menus. Similarly, its pages and other content do not appear in any dropdown menus in the Confluence user interface.
- In the space directory, the archived space will no longer appear in the general space lists. Archived spaces will appear on the 'archived spaces' tab. They will also appear on the category tabs, as determined by their labels.

These functions remain available for archived spaces:

- People can view the content as usual, by following a link or typing in a URL belonging to the archived space.
- People can edit the content as usual, as determined by the space permissions.
- RSS feeds, watches and notifications remain active.

---

On this page:

- The effect of archiving a space
- Archiving a space
- Notes

Related pages:

- Working with Spaces
- Deleting a Space
- Confluence User's Guide

---

Archiving a space

To archive a space:

1. Go to a page in the space you wish to archive.
2. Choose Browse > Space Admin.  
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. The 'Edit Space Details' screen appears. Select Archived in the Status dropdown menu.
4. Choose Save.

Notes

Archiving a space has no effect on search results of external search engines. For example, the space will still appear in Google search results.

Screenshot: An archived space
Viewing Space Activity

Note that the space activity information is disabled by default. See notes below.

If enabled, the space activity screen displays statistics on the activity in each space. These include:

- How many pages and blog posts have been viewed, added or updated over a given period.
- Which content is the most popular (most frequently viewed).
- Which content is the most active (most frequently edited).
- Which people are the most active contributors/editors of content.

To view the activity in a space:

1. Navigate to any page in the space and choose Browse > Space Admin.
2. Go to the Activity tab.

Confluence will show a graphic display of the number of pages and blog posts that have been viewed, added and edited, showing trends over a period of time. For example:
Activity for week starting 31 December 2006

Viewing

This graph shows how many times pages and blog posts have been viewed over the current time period.

Screenshot 1: Number of viewed pages and blog posts in a week

The top ten most popular and most active pages and/or blog posts will be listed, with a link to each.

Most popular content (Views)

1. Confluence Documentation Home (2262)
2. Set JAVA_HOME variable in Windows (1180)
3. Confluence Installation Guide (607)
4. Remote API Specification (467)
5. User Macros (436)
6. installing Confluence Standalone (385)
7. JIRA Issue Macro (370)
8. Administrators Guide (353)
9. Dynamic Tasklist Macro (335)
10. Frequently Asked Questions (320)

Screenshot 2: Popular content

Notes

- The Confluence Usage Stats plugin, which provides the 'Space Activity' screen, is known to cause performance problems on large installations. This plugin is disabled by default. A status report on the progress of the performance issues with this plugin is available in this issue: USGTRK-15.
- Your Confluence system administrator can enable the plugin, but please be aware of the possible impact upon your site's performance.
- The plugin is sometimes called 'Confluence Usage Tracking'.
- If your Confluence site is clustered, the space activity information will not be available.

Related Topics
Viewing Recently Updated Content

The 'Recently Updated' view is a useful way of keeping track of the changes being made in a space. It displays links to the most recently added or modified content within the space including pages, blog posts, mail messages and comments.

To view the recently updated content in a space:

1. Choose Browse > Pages.
2. Choose Recently Updated. A list of the most recently added or modified content in the space is displayed. Choose a link to open the corresponding document.

Related Topics

- Recently Updated Macro
- Viewing Pages Alphabetically
- Viewing Space Activity
- Confluence User’s Guide

Archiving Mail Overview

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

Confluence allows you to collect and archive mail within each space individually. This is a useful facility that allows you to archive all emails pertaining to a particular project on Confluence alongside it in the same space.

You can download mail from one or more pop-accounts. You can also import mail from mbox files either on your local system or on the Confluence server.

⚠️ The information on this page does not apply to Confluence OnDemand.

Choose Browse > Mail to see archived mail.

(If you are not a space administrator for the target space, contact your Confluence administrator to request Space Admin permission.)

From here, you can navigate mail easily and also use the Quick Search to search mail and the attachments it contains.

What would you like to do?

- Add a Mail Account
- Manage Mail accounts
- Import Mail
- View Mail
- Fetch Mail
- Delete Mail
- Restore Mail
The ability to archive mail applies only to global spaces, not personal spaces. Please see Working with Spaces for information about the differences between global spaces and personal spaces.

**Related Topics**

Take me back to the Confluence User's Guide.

**Adding a Mail Account**

**Confluence Mail Archiving is an optional feature.** This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

When you add a mail account, you are configuring Confluence to download mail from that account and archive the mail within the space. Since Confluence removes emails from an email account as it is added to the Mail Archive, Confluence must be set up to poll a clone email account rather than the actual account. For example, to archive the actual account sales@company.com to your Confluence Sales space, you must first create a clone account such as conf-sales@company.com that contains the same email content.

---

**Stage 1 - Creating A Clone Email Account**

1. Add a new email account on the mail server with the clone email address.
2. Copy all existing emails from the actual account to the clone account.
3. Set up the actual account to bcc sent emails to the clone account.
4. Set up the actual account to forward received emails to the clone account.

**Stage 2 - Archive Clone Account To Mail Archive**

1. If you are not a space administrator for the target space, contact your Confluence administrator to request Space Admin permission. You need to be a space administrator before you can add a mail account to the space.
2. Go to Browse > Mail.
3. Click on Mail Accounts under the heading 'Mail' in the left panel to show the list of existing mail accounts.
4. Click Add mail account located at the top of the page.
5. Enter configuration details for the account. The protocol may be POP/S or IMAP/S. Click Create when finished.

- **Account Name:** Enter a name for this account by which it will be known in Confluence.
- **Description:** Provide a description for this account (Optional).
- **Protocol:** Choose from POP, IMAP, POPS or IMAPS
- **Hostname:** Enter the account mail server host name.
- **Port:** The mail server's port number will be displayed by default. Do not edit this field.
- **Username:** Enter a username for this account.
- **Password:** The account's password.

**Important:** Configured accounts will have their mail downloaded and removed from the server, so make sure you are downloading from a clone account.

---

Note: The ability to import mail applies only to global spaces, so the 'Import' section does not appear in the 'Space Admin' tab for personal spaces. Please see Working with Spaces for information about the differences...
between global spaces and personal spaces.

Related Topics

Archiving Mail Overview
Managing Mail Accounts
Importing Mail
Viewing Mail
Fetching Mail
Deleting Mail
How Do I Check Which Spaces Have Email Accounts?
How Do I Disable Automatic Mail Polling?

Take me back to Confluence User's Guide

Deleting Mail

To delete mail for a space, you require 'Remove Mail' permission which is assigned by a space administrator from the Space Administration screens. See Space Permissions.

Only a space administrator can delete all email messages for the space simultaneously.

⚠️ The information on this page does not apply to Confluence OnDemand.

To delete mail for a space:

1. Go to Browse > Mail.
2. Go to the Mail tab. A list of messages in the space is displayed in reverse chronological order.
3. Delete an individual email by clicking the trash  icon beside it. Deleted mail is stored under Trash and can be restored by a space administrator from the Space Admin tab. If you are a space administrator, you can delete all email messages within a space at once by clicking on the Delete All link at the top of the mail view.

Notes

- Email messages deleted using the Delete All option cannot be restored.
- Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

Related Topics

- Restoring Mail
- Archiving Mail Overview
- Confluence User's Guide

Fetching Mail

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

Confluence fetches mail from the server once every 30 minutes.

You need to be a space administrator to manually retrieve new mail from mail accounts.
The information on this page does not apply to Confluence OnDemand.

To manually retrieve mail:

1. Go to Browse > Mail.
2. Go to the Mail tab. A list of messages for the space is displayed in reverse chronological order.
3. Click on the Fetch new mail link located above the list of messages. Any new messages will be displayed in order of most recent first.

Note

Once mail is fetched, it will be removed from the server.

Related Topics

Viewing Mail
Archiving Mail Overview
Deleting Mail
How Do I Disable Automatic Mail Polling?

Take me back to the Confluence User's Guide.

Importing Mail

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

Confluence allows you to import mail from mbox files located either on your local system or on the Confluence server and archive it within the space.

You need to be a space administrator to import mail for a space.

The information on this page does not apply to Confluence OnDemand.

To import mail from mbox files:

1. Go to Browse > Mail.
2. Click on Mail Import under the heading 'Mail' in the left panel.
   - To import from a Local system, click Browse to select the mbox file. Then click Import.
   - To import from the Server, enter the location of the mbox file on the server in the Server text field and click Import.

The ability to import mail applies only to global spaces, so the 'Import' section in the above screenshot does not appear in the 'Space Admin' tab for personal spaces. Please see Working with Spaces for information about the differences between global spaces and personal spaces.

Related Topics

Archiving Mail Overview
Adding a Mail Account
Importing Mail

Take me back to the Confluence User's Guide.

Managing Mail Accounts

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

You need to be a space administrator to manage mail accounts for a space.

The information on this page does not apply to Confluence OnDemand.

To manage mail accounts:

1. Go to Browse > Mail.
2. Click on Mail Accounts under the heading 'Mail' in the left panel. For each of the mail accounts listed, you can:
   - Edit: change the configuration settings for the mail account.
   - Remove: remove the account permanently.
   - Disable: temporarily disable the account.

Screenshot: Managing mail accounts

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Host</th>
<th>Status</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>conf-user archive</td>
<td>Archive of conf-user</td>
<td>mail.atlassian.com</td>
<td>OK</td>
<td>Edit</td>
</tr>
<tr>
<td>ou</td>
<td>ou</td>
<td>ou</td>
<td>DISABLED</td>
<td>Edit</td>
</tr>
</tbody>
</table>

Related Topics

Archiving Mail Overview
Adding a Mail Account
Importing Mail
Viewing Mail
Fetching Mail
Deleting Mail
Restoring Mail

Take me back to the Confluence User's Guide.

Restoring Mail

Deleted email messages are stored under 'Trash' and can be restored by a space administrator from the Space Administration screens.

You can only restore an email message from trash if it was deleted individually and not using the 'Remove All' operation.

To restore mail:

1. Navigate to any page in the space and choose Browse > Space Admin.
Choose Trash in the left-hand panel. A list of pages and email messages deleted from the space is displayed.

Choose Restore beside the email you want to restore.

To view the restored email message, choose Browse > Mail.

Notes

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

Related topics

- Viewing Mail
- Fetching Mail
- Deleting Mail
- Confluence User's Guide

Viewing Mail

Confluence Mail Archiving is an optional feature. This means that the Mail elements will not appear in the Confluence user interface by default. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, activate the plugin from Confluence Admin > Plugins > Show System Plugins > Confluence Mail Archiving Plugin.

In Confluence, each global space can be set up to archive mail.

To view mail messages archived within a particular space:

1. Navigate to any page in the space and choose Browse > Space Admin.
2. Click on the Mail tab. The mail is displayed in reverse chronological order with a default of 30 mails per page. You can move between pages by clicking the << Previous and Next >> links or by selecting a particular page number.
3. Click on a mail message to view its contents.

The information on this page does not apply to Confluence OnDemand.

If you are a space administrator, or have been given permission to delete mail messages, you can also delete emails from here.

Navigating Mail:

Find More These links links at the top of an email message let you search for other emails from the same author or on the same subject.

Attachments This link located below the email body allows you to view mail attachments. The link is only displayed if any attachments exist.

Entire Thread This link allows you to view the mail's thread, if one exists.

The 'Mail Operations' panel is located to the right of the mail view and displays links to:

- Entire Thread: View the thread that this mail belongs to. This option is only available when the mail belongs to a thread.
- Next By Date: Navigate to the next message.
- Previous By Date: Navigate to the previous message.
- Remove Mail: Remove the current mail from the space.
- Mail Archive: Go to the mail archive view for this space.
Related Topics

Archiving Mail Overview
Viewing Mail
Fetching Mail
Deleting Mail
How Do I Disable Automatic Mail Polling?

Take me back to the Confluence User's Guide.

Working with Confluence Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence.

For example, you could assign the label 'accounting' to all accounts-related pages on the site. You can then browse all pages with that label in a single space or across the site, or display a list of pages with that label. You can search based on the label, or use it to filter items when you subscribe to a Confluence RSS feed.

Because labels are user-defined, you can add any word that helps you identify the content in the site.

You can add or remove labels without affecting the page content.

Content labels

You can add labels to pages, blog posts and attachments. Any user with permission to view the page can also view its labels. See Adding Labels.
Space labels and space categories

You can also apply labels to spaces and use them to categorise your spaces. See Using Labels to Categorise Spaces.

Advantages of labels

Here are some of the advantages of using labels:

- Labels are user-defined which means that you decide what information is relevant to you and how you are going to label it.
- You can group pages and spaces without having to restructure the site.
- Labels are easy to add and edit, and do not affect the content of the page.
- You can add as many labels as you like to a page or space.

Using labels

- Adding Labels
- Using Labels to Categorise Spaces
- Removing Labels
- Using Label Macros to Categorise Wiki Content
- Viewing Labels and Labelled Content

Notes

Note: Personal labels are deprecated: Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

Adding Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content.

Labelling a page or blog post

Any user with permission to edit a page can add a label to a page.
To add a label to a page or blog post:

1. Go to the page. If the page already has labels, these will be listed at the bottom of the page, below the page content.
2. Click the edit icon 🖌 beside the list of labels, or press L on your keyboard.
3. Type in a new label. Existing labels are suggested as you type.
4. Click Add.

On this page:
- Labelling a page or blog post
- Labelling an attachment
- Notes

Related pages:
- Removing Labels
- Viewing Labels and Labelled Content
- Using Label Macros to Categorise Wiki Content
- Using Labels to Categorise Spaces
- Confluence User's Guide

Screenshot 1: Labels as they are displayed on a page

Screenshot 2: Adding a label to a page or blog post

Labelling an attachment

Any user who has permission to view or edit the page that contains the attachment can add a label to the attachment.

To add a label to an attachment:

1. Go to the page that contains the attachment. Choose Tools > Attachments.
2. Alternatively, go to the attachments view of the space:
   Go to a page in the space and choose Browse > Attachments.
3. You will see a list of attachments, with columns for attachment name and other details. If the attachment already has labels, these will be listed in the Labels column.
4. Click the edit icon 🖌 beside the list of labels.
5. Type in a new label. Existing labels are suggested as you type.
6. Click **Add**.

You can also add labels in a list of attachments displayed by the **Attachments macro**, by clicking the edit icon beside each label as described above.

**Screenshot 2: Adding a label to an attachment**

---

**Notes**

- **Note: Personal labels are deprecated**: Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the **Confluence 4.1 Upgrade Notes**. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.
- If you add a label to a template, that label will be copied to the page when someone adds a page based on that template. See **Adding a Template**.

**Using Labels to Categorise Spaces**

Confluence provides the following types of space label:

- **Space labels**. A space label can be used to group related spaces for display by the Content by Label macro, and for ranking search results. You use space labels in a similar way to global labels.
- **Space categories**. A 'space category' is a special type of space label that Confluence uses to group spaces in the space directory, and in the recent activity area of the dashboard. The rest of this page describes space categories.

Note that you can only set up space categories if you are a space administrator for that space, or you are a Confluence system administrator.

**Using Space Categories**

Here is an example of using space categories. Let's assume that you have one or more spaces that your Sales team may be interested in. You can use the category 'sales' to group those spaces together.

1. First add the 'sales' category to the relevant spaces, as described below.
2. Then, in the space directory, you can click the relevant tab to see only the spaces with the chosen label. See **Viewing All Confluence Spaces**.
3. And, you can see updated content in those spaces by choosing the 'sales' category under the Space Categories tab in the recent activity area of the dashboard. See **Customising your Personal Dashboard**.
Categorising a Space

When you categorise a space, you add a 'space category' to the space. A category cannot exist if there are no spaces labelled with that category.

To categorise a space:

1. Navigate to the space you wish to categorize.
2. Choose Browse > Space Admin.
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. Click Space Labels in the left-hand panel.
4. Under 'Space Categories', enter your category name and click Add.
   Alternatively, click a category in the list of 'Suggested Space Categories' displayed on the screen.

Removing a Space from a Category

Removing a space from a category is the same thing as removing the category from the space.

To remove a space from category:

1. Navigate to the space you wish to remove the category from.
2. Choose Browse > Space Admin.
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. Click Space Labels in the left-hand panel.
4. Click the x next to the space category.

Removing an Entire Space Category

To remove a whole space category from Confluence, just remove that category from all spaces, as described above. A category cannot exist if there are no spaces labelled with that category. The space category will disappear from the dashboard and space directory.

To remove an entire space category from Confluence:

2. Click the tab corresponding to the space category that you want to remove.
3. You will see a list of all spaces in that category. Click the spaces one by one, and remove the category from each space, as described above.
Removing Labels

Labels are key words or tags that you can add to pages, blog posts and attachments. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. You can see the existing labels, and the pages which contain the labels, by viewing labels and labelled content.

Removing labels in Confluence

To remove a label from a page or blog post:

1. Go to the page that contains the label. You will see the labels at the bottom of the page below the page content.
2. Choose the edit icon beside the list of labels, or press L on your keyboard.
3. In the 'Labels' dialog, choose the X next to a label to remove that label.
4. Choose Close.
To remove a label from an attachment:

1. Go to the page that contains the attachment. Choose **Tools > Attachments**.
2. Alternatively, go to the attachments view of the space:
   Go to a page in the space and choose **Browse > Attachments**.
3. You will see a list of attachments, with columns for the attachment name and other details. If the attachment already has labels, these will be listed in the **Labels** column.
4. Choose the edit icon beside the list of labels.
5. In the 'Labels' dialog, choose the **X** next to a label to remove that label.
6. Choose **Close**.

When you have removed the label from all content, the label will disappear from the labels view in the space too.

**Notes**

- **Deleted pages containing labels**: If you have deleted pages that contain a label, you may need to **purge** the deleted pages from the space's trash to ensure that the label disappears too.
- **Bulk removal of labels**: There is no way to remove a number of labels at once, via the Confluence user interface. Instead, we suggest that you use the **Confluence Command Line Interface**. See the 'removeLabels' action described in the **CLI documentation**. For an introduction to the CLI, see this blog post: **Confluence CLI for bulk actions like deleting or publishing pages**.

---

**Using Label Macros to Categorise Wiki Content**

Using labels, you can categorise pages and refer to content across multiple categories, pages and even spaces.

**Example**

For the purpose of this example, imagine we have a space with pages of content on various type of vehicles. Pages are shown in **bold** text, while the labels are in **blue**.

- **Cars** vehicle-type
  - Toyota Prius vehicle car
  - Honda Civic vehicle car
  - Porsche Carrera vehicle car

- **Motorbikes** vehicle-type
  - Harley Davidson Sportster vehicle motorbike
  - Suzuki GSX-R vehicle motorbike

This page hierarchy can then be categorised using labels, with pages referenced using the **Content by Label Macro**.

<table>
<thead>
<tr>
<th>If you want to list...</th>
<th>You would use this label:</th>
<th>These would be the pages that you would get:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle types</td>
<td>vehicle-type</td>
<td>Cars, Motorbikes</td>
</tr>
</tbody>
</table>
All vehicles

<table>
<thead>
<tr>
<th>vehicle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toyota Prius, Honda Civic, Porsche Carrera, Harley Davidson Sportster, Suzuki GSX-R</td>
</tr>
</tbody>
</table>

All cars

<table>
<thead>
<tr>
<th>car</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toyota Prius, Honda Civic, Porsche Carrera</td>
</tr>
</tbody>
</table>

Related pages:

- Working with Confluence Labels
- Working with Macros
- Confluence User's Guide

Label Macros

Navmap Macro

The Navigation Map Macro renders the list of pages associated with a specified label as a navigation map.

Related Labels Macro

The Related Labels Macro lists labels commonly associated with the current page's labels.

Content by Label Macro

The Content by Label Macro displays a list of content marked with specified labels.

Labels List Macro

The Labels List Macro lists all labels of a space, grouped alphabetically.

Recently Used Labels Macro

The Recently Used Labels Macro lists labels most recently used in a specified scope (global, space, or personal).

Popular Labels Macro

The Popular Labels Macro displays popular labels in a list or in a heatmap (also called a cloud).

Viewing Labels and Labelled Content

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. This page describes a few ways of viewing labels and labelled content. The focus of this page is global labels. You may also be interested in viewing personal labels.

Finding the labels view

If you see a label on a page, blog post or attachment, click it to go to the labels view. Global labels are visible to all users with 'view' permission on the page, and personal labels are visible only to the person who added them.

- Any page or blog post that has labels will have them listed together in a block at the bottom of the page.
- You will also see labels in the 'Attachments' view or in a listing of attachments provided by the Attachments macro. (See Displaying a List of Attachments.)

To find the labels view by clicking a label:

If you are in a page that has labels, click a label.
If it is a **personal** label (starts with 'my:') you will go to the personal labels page in your user profile. See [Viewing Personal Labels](#).

If it is a global label, you will go to the 'Labels' tab of the space. You will see all labels for that space.

**Screenshot 1: Labels as they are displayed on a page**

![Label example](image)

**To find the labels view from the menu:**

Go to a page in the space and choose **Browse > Labels**.

**On this page:**

- Finding the labels view
- Using the labels view
- Searching for labels
- Navigating pages by URL and label

**Related pages:**

- Viewing Personal Labels
- Searching Confluence
- Confluence User's Guide

**Using the labels view**

The labels view in a space offers the following options:

- **Popular Labels**: Click this option to see a list of the most frequently used labels in that space. From here, you can also view the most popular labels across the site. The bigger the font size, the more popular the label.

- **All Labels**: View all labels in the space. From this view, you can click on a link to view an alphabetical listing of all labels across the site. Clicking on a label will list all content in the space with that label. It will also display any related labels if they exist. **Related labels** are labels that frequently appear on pages together. For example, if pages labelled with 'sales' also tend to have the label 'marketing', these will be displayed as related labels.

- **See content from all spaces**: Expand the list of labels to include pages and other labelled content from all spaces.

**Screenshot 2: The labels view of the space**
Searching for labels

A quick way to find labelled content is to search for it. If there is a label matching your query, you will see it in the panel titled Browse Labels in the search results. Click the label to see all content in the site with that label.

Screenshot 3: Searching for labelled content

Advanced label searching

Use the 'labelText:' prefix to search specifically for page labels. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Navigating pages by URL and label

This section describes how to move around your Confluence pages by adding and subtracting labels from the list of labels that you want to match. You can search for matching labels by entering a URL. You can also add and subtract labels from the search.

To search labelled pages by typing a URL:

1. Open a new web browser window.
2. In the address bar of your web browser, type an URL such as:
   
   http://CONFLUENCE_HOSTNAME/label/foo+bar

3. Press Enter.

4. The 'View Labels' page will load, showing search results for pages with the labels 'foo' and 'bar'.

Adding a label to your results:

- Click a label from the Related Labels list (at the top left).
- A new page loads, showing pages that contain all of the labels selected so far. You can continue to add labels to the results in this way.

Subtracting a label from your search results:

Once two labels are in use, links to subtract a label from the search appear at the end of the labels list. These are easily identified because these links have a preceding minus sign, like this:

- education

Screenshot 4: Labels view with links for subtracting labels

Viewing Personal Labels

Any page that has labels (global or personal) will have them listed at the bottom of the page. Personal labels start with 'my:', and are only visible to the user that created them.
Note: Personal labels are deprecated: We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

To view your personal labels:

- If you are on a page that has personal labels, click one of those labels to get to the screen showing all your personal labels.
- Alternatively, visit the URL: `<your Confluence site>/users/viewmylabels.action`. For example: [http://confluence.atlassian.com/users/viewmylabels.action](http://confluence.atlassian.com/users/viewmylabels.action)

You will see a list of your personal labels along with the pages that contain the label, as shown in the screenshot below.

Related pages:
- Adding Labels
- Viewing Labels and Labelled Content
- Confluence User's Guide

Screenshot: Viewing personal labels

Working with Favourites

The Favourites feature provides a convenient way to quickly access specific pages or spaces that interest you, as soon as you log in to Confluence. Pages and spaces that you have added to your list of favourites are easily accessible from your Dashboard and from within your user profile area.

Related pages:
- Dashboard
- User Profile Overview
- Likes and Popular Content
- Confluence User's Guide

What do you want to do?

Adding Favourites
Viewing Favourites
Removing Favourites

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Adding Favourites

To add a page as a favourite:

1. Go to the page.
2. Choose Tools > Favourite.
   This will change to ⭐ Favourite (when you next open the Tools menu) to indicate that you have added this page as a favourite.

To add a global space as a favourite:

1. Go to the Dashboard.
2. Click the Spaces tab.
3. Click the star icon ⭐ located beside the space name in the list of global spaces.
   This will change to ⭐ to indicate that you have added this global space as a favourite.

To add a personal space as a favourite:

2. Click on a person's name or profile picture to view their personal space.
3. Go to a page in the space and choose Browse > Advanced.
4. Click on Add Space to Favourites in the left-hand panel.
   This will change to Remove Space from Favourites to indicate that you have added that person's personal space as a favourite.

Once you have added a personal space to your list of favourites, that personal space will be added to your list of favourite spaces, which can be accessed from the dashboard or your profile.

For more information about global spaces and personal spaces, see Working with Spaces.

Related Topics

Viewing Favourites

Searching the People Directory

Take me back to the Confluence User's Guide.

Removing Favourites

To remove a page as a favourite:

1. Go to the page.
2. Choose Tools > ⭐ Favourite.
   This will change to ⭐ Favourite to indicate that you have removed this page from your favourites.

To remove a global space as a favourite:

1. Go to the dashboard.
2. Click on the star icon ⭐ located beside the space in the list of spaces displayed.
   This will change to ⭐ to indicate that you have removed this global space as a favourite.

To remove a personal space as a favourite:

1. Go to the People Directory.
2. Click on a person's name or profile picture to view their personal space.
3. Go to a page in the space and choose Browse > Advanced.
4. Click on ⭐ Remove Space from Favourites in the left-hand panel. This will change to ⭐ Add Space to Favourites to indicate that you have removed that person’s personal space as a favourite.

Related Topics

Viewing Favourites
Spaces Cannot be Unmarked as Favourites

Take me back to the Confluence User’s Guide.

Viewing Favourites

Once you add a spaces or pages as favourites, you can see them on your dashboard or in your profile.

The Dashboard

On the left-hand side of the Dashboard, you can see:

- your favourite spaces in the Spaces tab.
- your most recently added favourite pages in the Pages tab.

Recently updated content in your favourite spaces will be listed on the Favourite Spaces tab at the top right of the dashboard.

Screenshot: Viewing your favourites on your dashboard

<table>
<thead>
<tr>
<th>Spaces</th>
<th>Pages</th>
<th>Network</th>
</tr>
</thead>
</table>

Favourite Spaces

- Angry Nerds
- Confluence
- Paul Watson
- Technical Writing

Global Spaces

Add Space

- Admin Space
- Angry Nerds
- Archive
- Atlassian Foundation

Your Profile

To view your favourites in your profile:

1. Log in to Confluence, if you have not already done so.
2. Go to your name (the 'User' menu) at the top of the page and choose Labels.
3. Click on favourite (under 'Your Labels') to see the list of your favourite spaces and pages.

Screenshot: Viewing your favourites in your profile
Related Topics

Adding Favourites  
Removing Favourites  
Working with Favourites

Working with Confluence Labels

Working with Attachments

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format. You can attach files to any page or blog post, provided you have permission to do so.

When a page you are viewing contains attachments, a small paperclip icon appears next to the page byline, under the page name. Clicking the paperclip will take you to the 'Attachments' view, where you will see the full list of attachments.

On this page:

- A quick guide to attachments
- Working with attachments
- Notes

Related pages:

- Configuring Attachment Size
- Configuring your Attachment Storage
- Confluence User’s Guide

A quick guide to attachments

Choose Tools > Attachments to view and attach files to a Confluence page. (See Attaching Files to a Page.) If you attach a file with the same name as an existing attachment, Confluence will create a new version of the existing attachment.

Once you have attached the relevant files, you can display attached images and multimedia content on the page. If the attachment is an Office document, use the View File macro to display the content of the document on the Confluence page. If you have an Office application installed, you will also be able to launch your Office editor from within Confluence. See Displaying Office Files in Confluence and Working with the Office Connector.
Your page can display a list of attachments – these may be the files that are attached to the page or to any page in the space. You can also display a link to an attachment. When a user clicks the link, the attachment will open, provided that the user has the software application needed to open the attachment.

You can label an attachment, and then use labels to categorise your content.

Working with attachments

- Using Drag-and-Drop in Confluence
- Attaching Files to a Page
- Attachment Versions
- Deleting an Attachment
- Displaying a List of Attachments
- Downloading Attachments
- Editing Attachment Properties
- Embedding Multimedia Content
- Embedding PowerPoint Presentations in a Page
- Moving an Attachment
- Viewing Attachment Details

Notes

If you want an attachment to be displayed on more than one page, you may wish to consider creating a special page to hold such attachments. This special page could be part of an ‘inclusions library’.

Using Drag-and-Drop in Confluence

This page describes the drag-and-drop functionality in Confluence, and the browser configurations needed to support that functionality.

Overview of the drag-and-drop features

Confluence supports these forms of drag-and-drop:

- **Drag-and-drop within the editor.** Working inside the editor panel, you can drag an image or a macro and drop it into a different location on the page.

- **Drag-and-drop for external images and files.** You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post.

Drag-and-drop within the editor

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

Requirements for internal drag-and-drop

For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 9. (Drag and drop in the editor does not work in Internet Explorer 8.)
Drag-and-drop for external images and files

You can drag files from your computer or file system onto your browser and attach them to your Confluence pages or blog posts. You can drag and drop:

- multiple files at once.
- image, multimedia and PDF files, and Office documents.

When you drag and drop files onto the different Confluence views, you get the following results:

<table>
<thead>
<tr>
<th>Confluence View</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Page</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Edit</td>
<td>Files are attached, and embedded at the cursor position</td>
</tr>
</tbody>
</table>

**Requirements for external drag-and-drop**

- Your browser must support the drag-and-drop functionality of HTML5.
- Some browsers, such as Internet Explorer 9, Firefox 3.5 and Safari 4 do not support the drag-and-drop functionality of HTML5. For these browsers, Confluence will attempt to use the drag-and-drop functionality provided by Google Gears.

  - The first time you try to drag and drop a file into one of these browsers, Confluence will prompt you to install Google Gears into your browser. Refer to the prompt below for more information. For more details on the installation requirements for Google Gears, refer to Google's own How to install instructions.
  - Please check the Google Gears website for the most up-to-date browser support details.

  - To check if Google Gears is already installed on your computer, refer to Google's own How to check if Gears is installed instructions.

**Note about supported web browsers:** Please ensure that you are using one of the web browsers...
supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

- Some older Confluence themes do not support Confluence’s drag-and-drop feature.

  - **Supported themes**: Confluence Default theme, Documentation theme, Easy Reader theme.
  - **Themes that are not supported**: Left Navigation theme, Clickr theme. You cannot drag and drop attachments into spaces that use these themes.

**Prompt to install Google Gears**

If you are using a browser that does not support the drag-and-drop feature, and Google Gears has not yet been installed:

- When you attempt to drag and drop a file into Confluence (but not the editor), you will see the following message:

  **Screenshot: Generic Confluence prompt to install Google Gears**

  ![Generic Confluence prompt to install Google Gears](image)

  Click **OK** to install Google Gears.

- When you attempt to drag and drop a file into the editor, you will be prompted with the following message:

  **Screenshot: Confluence prompt to install Google Gears**

  ![Confluence prompt to install Google Gears](image)

  **Note**: **Save any drafted content** before continuing with the installation of Google Gears. The installation process will replace your current Confluence page and you will need to restart your browser after the Google Gears installation has completed.

  Click **Proceed with Installation** to install Google Gears.
Initial use with Google Gears

When adding an attachment to a page or blog post in your Confluence site for the first time after Google Gears has been installed, you will be prompted to allow Google Gears to trust your Confluence site. If this warning message appears, choose *I trust this site. Allow it to use Gears* and then choose *Allow*.

*Screenshot: Google Gears security prompt*

![Gears Security Warning](image)

**Note:** Google Gears is not supported on Safari. See [CONF-20032](https://confluence.atlassian.com/doc/CONF-20032) for updates.

Disabling drag-and-drop for external files

- If you wish to disable the drag-and-drop feature, you can disable the entire *Confluence Drag and Drop Plugin*. See [Disabling or Enabling a Plugin](https://confluence.atlassian.com/doc/Disabling_or_Enabling_a_Plugin).
- You can also disable the drop zone that appears on the 'Attachments' view or the image dialog box, by disabling the *View Attachments Drop Zone* or *Image Dialog Drop Zone* modules of the above plugin. This will remove these drop zones while retaining Confluence's drag-and-drop functionality.

Attaching Files to a Page

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format. Read more in [Working with Attachments](https://confluence.atlassian.com/doc/Working_with_Attachments).

When you attach a file to a page, Confluence makes a copy of the file and stores it on the Confluence server. Page attachments in Confluence are managed using the 'Attachments' view of the page.

To attach a file, you need the 'Create Attachments' permission. See [Space Permissions](https://confluence.atlassian.com/doc/Space_Permissions).

When a page you are viewing contains attachments, a small paperclip icon ![paperclip](image) appears next to the page byline, under the page name. Clicking the paperclip will take you to the 'Attachments' view, where you will see the full list of attachments.
On this page:

- Attaching files
- Attachment versions
- Notes

Related pages:

- Working with Attachments
- Configuring Attachment Size
- Displaying Images
- Attachment Versions
- Deleting an Attachment
- Confluence User's Guide

**Attaching files**

This page describes the following ways of attaching files to a Confluence page:

- Drag and drop files on to a Confluence page.
- Browse to, and upload files from, your computer or network.

**To attach a file to a page using drag-and-drop:**

1. View the page to which you want to attach files.
2. Drag one or more files from your computer onto the page. The ‘Attach File(s)’ message box appears, indicating the upload status of the files being attached to your page.

You can drag and drop more than one file at a time onto a page. You cannot drag a folder of files onto a page.

Expand this section to see other ways to drag-and-drop a file on to a page...

You can also drag and drop files:

- directly onto the 'Attachments' view for the page.
- directly onto the editor view of the page.
- onto any tab of the 'Insert Link' or 'Insert Image' dialogs, which are available from the **Insert** menu while editing.

**To attach a file to a page from the computer's (or network's) file system:**

1. Choose **Tools > Attachments**.
2. Choose **Browse** and navigate to the file.
3. Select the file and click **Open**.
4. Add a descriptive comment for the file (optional).
5. Choose **Attach more files** if required.
6. Choose **Attach**.

You can attach than one file at a time. You cannot attach a folder of files.

Expand this section to see other ways to upload a file to a page...
You can also browse for, and upload, a file from:

- the 'Attachments' tab of the 'Insert Link' dialog. (While editing the page, choose Insert > Link.)
- the 'Attached Images' tab of the 'Insert Image' dialog. (While editing the page, choose Insert > Image.)

**Attachment versions**

If you upload a file with the same name as an existing attachment, Confluence will rename the old file and keep it as a previous version. Read more about Attachment Versions and Viewing Attachment Details.

**Notes**

- **Reusing attachments:** If you want to display the same file on more than one page, the best way is to put the attachment on a page (say, page A) and then use the Include Page Macro to include page A into page B, page C, and all the pages where you want the diagram, presentation, or other file. Alternatively, you can display an image that is attached to another page.
- **Updating the original file:** Any changes you make to the source file do not affect the copy that was uploaded to Confluence. To update the Confluence copy, you need to upload the new version of the file.

**Attachment Versions**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

When viewing a list of attachments, you can add a new version of an existing attachment by uploading an attachment with the same file name, as displayed on the attachment view. Existing files will be kept with the name 'Version x', where the value of 'x' increments with each upload of an attachment with the same file name.

To see all versions of an attachment: Choose the arrow next to an attachment name.

**Related pages:**

- Attaching Files to a Page
- Deleting an Attachment
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User's Guide

---

**Screenshot: Attachment versions**

---

**Notes**
You cannot revert to a previous version of an attachment. See feature request CONF-1943.

Confluence does not track the history of attachments in the same way as it does for pages. See feature request CONF-13943.

By default, attachments and their versions are stored in the `<confluence_home>/attachments` directory. (See Attachment Storage Configuration.)

There is no limit to the number of attachments or attachment versions, provided that there is enough disk space.

Deleting an Attachment

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

By default, when you remove an attachment, this will delete all versions of the attachment. To do that, you need the 'Remove Attachments' permission. See Space permissions.

If you want to delete a specific version of an attachment, you need to be a space administrator.

Related pages:
- Working with Attachments
- Displaying Images
- Confluence User's Guide

To delete all versions of an attachment:

1. Go to the page that contains the attachment.
3. Choose Remove next to the attachment you want to delete.
4. Choose Remove to confirm your action.

To delete a specific version of an attachment:

1. Go to the page that contains the attachment.
3. Choose the arrow on the left next to the attachment you want to manage. A list of attachment versions will appear.
4. Choose Remove next to the version you want to delete.
5. Choose Remove to confirm your action.

Screenshot: Attachments and attachment versions

Displaying a List of Attachments

An attachment is any file that is included with your page. Examples of attachments are screenshots,
photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can display a list of attachments on your page – these may be the files that are attached to the page or to any page in the space. Use the Attachments macro to show a list of the attachments on the current page. Use the Space Attachments macro to show a list of the attachments in the current space. Both these macros generate a table of attachments which is clickable.

**Using the macros**

**To add the Attachments or Space Attachments macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

---

**Parameters of the Attachments macro**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

---

**Related pages:**

- Attaching Files to a Page
- Working with Attachments
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide
| **Filename Patterns** | all | A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:
- To match a file suffix of ‘.jpg’, use `.*jpg` (not `.*.jpg`).
- To match file names ending in ‘.jpg’ or ‘.png’, use `.*jpg, .*png`.

Here is a [tutorial on regular expressions](#).

| **Attachment Labels** | (none) | A list of labels, used to filter the attachments to display. If you wish to enter more than one label, separate the labels with commas. Confluence will show only attachments that have **all** the labels specified. (The match is an **AND**, not an **OR**.) For information on labelling the attachments, see [Adding Labels](#).

| **Include Old Attachment Versions** | false | A value of **true** will include previous attachment versions in the list.

| **Sort By** | date | The sort order for attachments. Note that people viewing the page can change the sort order by clicking the column headings. Valid values are:
- **date** – sorts by reverse chronological order (newest first)
- **size** – sorts largest to smallest
- **name** – sorts alphabetically

| **Sort Order** | ascending | Used in combination with the **Sort By** parameter, to sort the attachments in ascending or descending order.

| **Allow Upload** | true | If selected, the list of attachments will include options allowing users to browse for, and attach, new files.
Page Title | (none) |
---|---|
Used to display attachments from another page. If you do not enter a page title, the macro will display the files attached to the current page.

**Viewing files and changing file properties from the Attachments macro**

The list of files displayed by the Attachments macro includes options for viewing the files and other actions, provided the user has the relevant permissions.

- If you have specified the 'Allow Upload' parameter, users will be able to upload attachments directly from the list.
- Users can remove attachments. Note that they can only remove the entire attachment, including all versions of the attachment. To remove a specific version of an attachment, they must go to the 'Attachments' view. See [Deleting an Attachment](#).
- Users can edit attachment properties and labels. If an attachment is an Office or PDF file, they will see the appropriate options for Office Connector files.

**Screenshot 1: The Attachments macro**

![Screenshot of the Attachments macro](image)

**Parameters of the Space Attachments macro**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>(none)</td>
<td>Selects the Confluence space to display all attachments for. If no space is specified, the current space will be used.</td>
</tr>
<tr>
<td>Attachment Labels</td>
<td>(none)</td>
<td>Filters the attachments to display, based on a list of labels. If you wish to enter more than one label, separate the labels with commas. For information on labelling the attachments, see <a href="#">Adding Labels</a>.</td>
</tr>
</tbody>
</table>
Show Filter Controls | true | Determines whether or not the filter panel is shown. The filter panel allows you to filter the list of attachments by file type (extension).

Screenshot 2: The Space Attachments macro

---

**Downloading Attachments**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

**To download a single attachment from a page:**

1. View the page.
2. Choose **Tools > Attachments**.
3. Right-click the link on the attachment name, and select **Save Link As**, **Save Target As** or a similar option provided by your browser. This will open a 'Save' dialog.
4. Select the location into which you want to download the file and choose **Save**.

**Related pages:**
- Attaching Files to a Page
- Working with Attachments
- Confluence User's Guide

**To download all the attachments from a page:**

1. View the page.
2. Choose **Tools > Attachments**.
3. Choose the **Download All** button at the end of the page to download a zipped file of all the page’s attachments.

**Notes**

- There is no permission that controls the downloading of attachments. See an article in our knowledge base about [disabling the download of attachments](mailto:).  
- Confluence does not supply an option to download all attachments from a space. See the closed feature request: [CONF-5669 - Authenticate](mailto:) to see issue details.
Editing Attachment Properties

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

To edit an attachment's properties, you need the 'Create Attachments' permission. See Space Permissions.

To edit the properties of an attachment:

1. View the page that contains the attachment.
2. Choose Tools > Attachments.
3. Choose Properties next to the attachment. The 'Properties' screen will appear.
4. Make your changes:
   - File Name — Rename or modify the name of the attachment.
   - New Comment — Update the existing comment or enter a new comment.
   - New Content Type — Change the content type of the attachment by entering a valid MIME type.
   - Page — Move the attachment to another page.
5. Choose Save.

Related pages:
- Attaching Files to a Page
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User's Guide

Embedding Multimedia Content

Using multimedia files you can display movies, animations and videos, and embed audio files on your Confluence page.

There are several methods for attaching files to a page. Once you have attached the multimedia file to a Confluence page, you then edit the page to set where the multimedia content should appear.

In the example below, we display a Flash file that is attached to this page.

Confluence supports the following multimedia formats:
1. Adobe Flash (.swf)
2. Apple QuickTime (.mov)
3. Windows Media (.wma, .wmv)
4. Real Media (.rm, .ram)
5. MP3 and MP4 files (.mp3, .mp4)
6. MPEG files (.mpeg, .mpg)
7. AVI files (.avi) You may need to enable an avi decoder within your browser.

**Displaying a multimedia file attached to the page**

Once you have attached a multimedia file to a page, there are different methods for choosing where on the page the multimedia content should appear:

**Inserting the Multimedia macro yourself**

You can add the Multimedia macro to the page yourself using the Macro Browser. This allows you to display a multimedia file that is attached to either the current page or to another page in the Confluence site.

**To insert the Multimedia macro on the page at the current cursor position:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).**

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Using autocomplete**

Once a multimedia file is attached to the page, you can use **autocomplete**, while editing the page, to choose where the multimedia content should appear.

**To position an attached multimedia file on the page using autocomplete:**

1. While editing the page, position the cursor where you want to place the multimedia content.
2. Trigger the autocomplete function by typing `!`.
3. Choose the multimedia file from the list that appears.
4. If necessary, click on the Multimedia macro placeholder and choose Edit to set various options such as the width, height or autoplay.

Using drag-and-drop

Depending on the browser you are using, you can attach and position a multimedia file in one step using drag-and-drop.

To attach and position multimedia content using drag-and-drop:

1. While you are editing a page, simply drag-and-drop the multimedia file on to the page. Confluence will attach the file to the page and insert the Multimedia macro at the current cursor position for you.
2. If necessary, click on the Multimedia macro placeholder and choose Edit to set various options such as the width, height or autoplay.

Multimedia macro parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Name</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached. If you are using the Macro Browser, just start typing the name of the page and then select it from the dropdown list that appears. The page can be in the same space or another space.</td>
</tr>
<tr>
<td>Attachment</td>
<td>None</td>
<td>File name of the multimedia file.</td>
</tr>
<tr>
<td>Width</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td>Width of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's width, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>Height</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td>Height of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's height, or any other value accepted by HTML.</td>
</tr>
</tbody>
</table>
Autoplay | False | If this option is checked (that is, if the parameter is set to 'true') then the video or audio file will start playing as soon as the page is loaded. If this option is not checked (set to 'false') then the file will not play until the user clicks the icon or image on the page. See the note about autoplay below.

Notes

- The multimedia file must be attached to a Confluence page. For security reasons, files located on remote servers are not permitted. See the Widget Connector for displaying live content from external sites.

- You will need the relevant multimedia plugin for your browser. Your browser (Firefox, Internet Explorer, Safari and others) needs a plugin to play the video or audio file on a Confluence page. For example, to play a Flash movie you need the Flash plugin. Many plugins are shipped with the major browsers by default. If a user does not have the required plugin installed and enabled in their browser, they will not be able to view the multimedia files on the page.

- Autoplay may not always work as expected. You can set autoplay on, so that your video or audio file should start playing as soon as the page is loaded into the browser. (See parameters.) However, this setting may not always work as expected. Confluence will send an instruction to the browser plugin that plays the multimedia file. Different browsers and different media plugins behave in different ways, and not all of them respect such instructions.

- Use the Office Connector to display Office documents. Take a look at the Office Connector for embedding Word documents, presentations and other Office documents onto your Confluence page.

- If you get the error, 'Unable to embed content of type application/octet-stream', this means the MIME type is not recognised.

- Advanced users can try styling via CSS. By default, each embedded object is wrapped in a div tag. If you wish to style the div and its contents, override the embeddedObject CSS class. Specifying an ID as a property also allows you to style different embedded objects differently. CSS class names in the format embeddedObject-ID are used.

Related Topics

Working with Macros
Widget Connector Macro
Working with the Office Connector
Working with Attachments

Take me back to Confluence User's Guide

Embedding PowerPoint Presentations in a Page

Below are some ideas on how your wiki page can include information from a Microsoft PowerPoint presentation.

On this page:
- Option 1 — Office Connector for Confluence
- Option 2 — Gallery or Slide Show of JPEG or PNG Images
- Option 3 — Convert PowerPoint to HTML
- Related Topics
**Option 1 — Office Connector for Confluence**

The Office Connector provides the most straightforward way to display PowerPoint slides.

**To attach and display a PowerPoint presentation in Confluence:**

1. Attach the presentation to a Confluence page:
   - View the Confluence page where you want to display your presentation.
   - Open the 'Tools' menu and select 'Attachments'.
   - Browse for your PowerPoint presentation and upload it to the Confluence page.
   - You will find detailed instructions in [Attaching Files to a Page](#).
2. Now you can display the document embedded into the Confluence page, using the View File macro. Refer to the detailed instructions for the [View File macro](#).

   ![The Office Connector is shipped with Confluence 2.10 and later. The Office Connector plugin is supported for Confluence versions 2.8.0 and later.](#)

**Option 2 — Gallery or Slide Show of JPEG or PNG Images**

1. Convert your PowerPoint pages into JPEG or PNG images, using 'save as' from PowerPoint (slide1.jpg, slide2.jpg...).
2. Upload the image files as attachments to your Confluence page. To upload in bulk, use the [WebDAV plugin](#).
3. Use the [Gallery macro](#) or the [Slideshow plugin](#) to render the images as a slide show in Confluence.

   ![Optionally, you could create a page template or a user macro that uses the Slideshow plugin, so that you do not have to code this into the wiki page each time you create a new show.](#)

**Option 3 — Convert PowerPoint to HTML**

You can convert the PowerPoint file to web page format and embed the page inside your Confluence document.

**If you accept page edits or comments from untrustworthy users, you should not attempt this process, due to a risk of malicious user attacks via the html-include macro.**

1. Review the risks associated with enabling the html-include macro [here](#).
2. If you decide to proceed, follow the instructions to enable embedded HTML pages using the macro.
3. Select an PowerPoint converter. There are at least two applications that can convert PPT to HTML:
   - [Producer for PowerPoint](#).
   - If you do not have the PowerPoint application on your machine, you can use the [Internet Assistant for PowerPoint](#) instead.
4. Download and install your chosen converter.
5. Follow the converter documentation to perform the HTML conversion. An Internet Assistant conversion guide can be found [here](#). The conversion process will create a small collection of HTML pages. Each slide will have its own page, plus an index page with buttons to let you switch between slide pages.
6. If you wish, you can test the HTML presentation now by loading the index page in your browser.
7. Place the HTML files into their own directory, named uniquely by the title of your presentation.
8. Find a suitable location to host these files within your web server. Confluence hosts all files within the `<my-install-directory>/confluence/distribution users is to go to <my-install-directory>/confluence/pages/powerpoint/<my-presentation-name>` containing index.html, slide01.html... or similar.
10. Edit or create the page where you wish to embed the PowerPoint presentation. Add the HTML Include macro pointing to the index page of your slides. Remember that URLs are case sensitive.
11. Save the page. The index page to your slides should now appear.

Related Topics

Working with the Office Connector
Working with Attachments

Take me back to Confluence User's Guide

Moving an Attachment

You can move an attachment from its current location to any page within the site.

To move an attachment, you need the following permissions:

- Edit page permission on the page where the attachment currently exists.
- Create attachment permission on the space into which you are moving the attachment.

Space permissions are assigned by a space administrator from the Space Administration screens. See Space permissions or contact a space administrator for more information.

To move an attachment:

1. Go to the page that contains the attachment.
2. Choose Tools > Attachments.
3. Click the Properties link beside the attachment. This will display a new screen, where you can edit the properties of an attachment.
4. Select the page where you want to move the attachment by either:
   - Entering the page's title into the Page field
   - Clicking the Choose a Page icon and using the 'Choose a Page' pop-up window to choose a page within the site.
5. Click OK.

Screenshot: Moving an attachment

Related Topics

Moving a Page

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Choose a Page

The 'Choose a Page' window allows you to locate a page in your Confluence site. The window appears when you are moving an attachment.

To choose a page:

1. Click the page picker icon to display the 'Choose a Page' window. You will see the following tabs:
   - **Search**: Allows you to search for your page in all Confluence spaces.
   - **History**: Displays a list of pages recently visited by you.
   - **Recently Modified**: Displays pages most recently modified by you.
   - **Referring Pages**: Displays a list of all pages that refer to the current page.

2. Select the required page from the list of pages in one of the tabs.

Related Topics

Moving an Attachment

Viewing Attachment Details

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can view attachment details in the following places:

- The list of attachments in a space — this will show all files attached to all pages in the space. See below.
- The list of attachments for a specific page. See below.
- A list of attachments created by a macro and displayed on a page. See Displaying a List of Attachments.

On this page:

- Viewing attachments in a space
- Viewing attachments on a page
- Attachment details

Related pages:

- Working with Attachments
- Displaying a List of Attachments
- Confluence User's Guide

Viewing attachments in a space

To view the attachments associated with a space:

1. Go to a page in the space and choose **Browse > Attachments**.
   
   You will see a list of all the attachments in the space, along with their details and the pages they are attached to.

2. To see only files of a particular type:
   - Type the last part of the file name in the **Filter By File Extension** box. For example, enter ‘.gif’ to see only image files of the GIF format.
   - Click **Filter**.

3. To see only files that have a particular label or labels:
   - Type the label or labels in the **Filter by Label** box. If you enter more than one label, separate the
labels with commas or spaces. Confluence will show only attachments that have **all** the labels specified. (The match is an AND, not an OR.)

- Click **Filter**.

**Screenshot 1: List of attachments for a space**

![List of attachments for a space](image)

**Viewing attachments on a page**

When a page you are viewing contains attachments, a small paperclip icon 📄 appears next to the page byline, under the page name. Clicking the paperclip will take you to the 'Attachments' view, where you will see the full list of attachments.

**To view the attachments associated with a page:**

1. Go to the page.
2. Choose **Tools > Attachments**. You will see a list of the attachments in the page along with their details.
3. To see all versions of an attachment, choose the arrow on the left of the attachment name.

The list of attachments includes options for viewing the files, and other actions, provided the user has the relevant permissions. If you have specified the 'Allow Upload' parameter, users will be able to **upload attachments** directly from the list too. Users can also **remove attachments** or **edit attachment properties** and **labels**. If an attachment is an Office or PDF file, you will see the appropriate options for **Office Connector** files.

**Screenshot 2: List of attachments for a page**

![List of attachments for a page](image)

**Attachment details**

Note that the page view shows a different subset of fields from the space view.

- **Name** is the name of the attached file.
• **Size** tells you how much space the attachment takes up. You can sort by size by clicking the column title.
• **Creator** is the person who attached the file. Clicking on the link takes you to the person's' user profile.
• **Creation Date** is the date the file was attached. You can sort by date by clicking the column title.
• **Labels** are keywords, or tags, that you can enter to categorise the attachments. See how to [add labels](#).
• **Last Mod. Date** (in the space view) is the date the file was last modified.
• **Attached To** (in the space view) tells you which page contains the attachment.
• **Comment** (in the page view) is a short description of the attachment.
• The **Properties** link (in the page view) lets you edit the attachment details. See how to [edit attachment properties](#).
• The **Remove** link (in the page view) lets you delete the attachment, or a specific version of the attachment.
• The **Edit in Office** link (in the page view) appears next to Office files only, and lets you edit that attachment.
• The **Attach File** option lets you add another attachment or another version of an existing attachment. See how to [upload attachments](#).

### Customising Confluence

You can customise or configure many aspects of Confluence:

- The **look and feel** of any Confluence space.
- **Personal aspects**, including your personal profile and homepage.
- Setting up your [user profile](#).
- **User access**, including permissions and page restrictions.
- Add-ons such as gadgets and macros.
- Customisations for specific uses of Confluence.

#### Related pages:

- Configuring Confluence
- Configuring Confluence Security
- Installing Plugins and Macros
- Confluence User's Guide

### Personal Customisations

There are several ways that you can customise the way that Confluence works for you, personally, including:

- Your [personal homepage](#)
- Your [personal dashboard](#)
- Your [personal profile](#)
- Your [email notifications](#)
- Your [RSS Feed settings](#)

#### Related Topics

[Customising Confluence](#)

### User Profile Overview

Each Confluence user has a User Profile area, where numerous account management features can be accessed.

#### Finding your User Profile

Go to your [name](#) (the 'User' menu) at the top of the page and choose [Profile](#).

The profile view is divided into tabs, each of which is described in a separate section below.
On this page:

- Finding your User Profile
- Profile
- Network
- Status Updates
- Labels
- Watches
- Drafts
- Settings

Screenshot: User profile

Profile

- View and edit your personal details, such as your name and email address details and optionally, your photograph and other personal information. Note that as a security precaution, in order to change your email address, you will be required to re-enter your password.
- Upload a profile picture (optional).
- Change your password.

Network

- View the recent activity of users that you are following via the Network view.
- Follow other users from this view.

The 'Administer User' link is visible to Confluence administrators only. The administrator can click this link to go directly to the user management screen in the Administration Console.
Status Updates
- View your history of status updates.

Labels
- View your personal labels.

Watches
- View a list of the pages and spaces you are currently watching.

Drafts
- Retrieve any pages you were in the process of editing. See Working with Drafts.

Settings
- Edit your General Settings (homepage, language and timezone).
- Subscribe to email notifications.
- View and revoke your OAuth access tokens.

Related Topics
Managing Changes and Notifications and Tasks
Setting Up your Personal Space

Take me back to the Confluence User's Guide.

Changing Password

To change your Confluence password:

1. Go to your name (the 'User' menu) at the top of the page and choose Profile.
2. On your Profile tab, click Password in the left-hand column.
3. Enter your current password and your new password in the form displayed.
4. Click Submit.

Related Topics
Viewing User Profile
Editing Your User Profile
Choosing a Profile Picture
Setting Up your Personal Space
Updating Email Address
Email Address Privacy

Take me back to the Confluence User's Guide.

Editing User Settings

You can set various Confluence preferences that affect your personal session:

- General preferences such as home page, language and time zone, as described below.
- Editor settings, as described below.
- Email settings for subscriptions to email reports. See Subscribing to Email Notifications of Updates to Confluence Content.
- OAuth access tokens that you have granted from your Confluence user account. See Viewing and Revoking OAuth Access Tokens.

General User Preferences

To edit your general user settings:

1. Go to your name (the 'User' menu) at the top of the page and choose Settings.
2. Click **Edit** and update the settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Homepage</td>
<td>Select the page that you would like to see whenever you log into Confluence.</td>
</tr>
<tr>
<td>Language</td>
<td>Select your language. See <a href="#">below</a>.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select your time zone.</td>
</tr>
<tr>
<td>Use Keyboard Shortcuts</td>
<td>Enable <a href="#">keyboard shortcuts</a>, other than for the editor.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**On this page:**
- [General User Preferences](#)
- [More about Language](#)
- [Editor Preferences](#)

**Related pages:**
- [Editing Your User Profile](#)
- [Choosing a Profile Picture](#)
- [Setting Up your Personal Space](#)
- [Email Address Privacy](#)
- [Using Autocomplete](#)
- [Confluence User's Guide](#)

**Screenshot: Editing your user profile settings**

More about Language

Setting your language preference in your user profile is described in the section above. This section gives more information about that setting and other settings that affect the language Confluence will use.

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from
highest to lowest:

- The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
- The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too.
- The language set in your browser.
  - Note that your Confluence administrator can disable this option by setting a system property.
  - The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list.
- The default language for your site, as defined by your Confluence site administrator.

Editor Preferences

You can set some options that determine the way the Confluence editor works. Note that these settings affect only you. Other people using Confluence can enable or disable the settings on their user profiles independently.

To change your editor preferences:

1. Go to your name (the ‘User’ menu) at the top of the page and choose Settings.
2. Click Editor under ‘Your Settings’ in the left-hand panel.
3. Click Edit.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Autocomplete</td>
<td>Select to disable autocompletion when you press one of the trigger characters.</td>
</tr>
<tr>
<td>Disable Autoformatting</td>
<td>Select to disable autoformatting when you type wiki markup in the editor. Click ? on the editor toolbar to learn more.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Screenshot: User settings for the editor

Editing Your User Profile

Your user profile contains basic information about you. If you do not have a personal space, your user profile will be displayed when anyone clicks your name in the People Directory.

To edit your user profile:
1. Go to your name (the 'User' menu) at the top of the page and choose Profile.
2. On your Profile view, click Edit in the Personal details section.
3. Enter details about yourself in the form displayed.
4. Click Save.

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>Your name as you would like it to appear in your profile.</td>
</tr>
<tr>
<td>Email</td>
<td>Your email address which will be used to send you mail notifications.</td>
</tr>
<tr>
<td>Phone</td>
<td>Your phone number.</td>
</tr>
<tr>
<td>IM</td>
<td>Your Instant Messenger (IM) details. To suit a variety of IM applications, this option accepts any string value. For example, you can enter IM details in the form of an email address, such as ' or a user ID, like '123456789'.</td>
</tr>
<tr>
<td>Website</td>
<td>Your website's URL.</td>
</tr>
<tr>
<td>Position</td>
<td>The title of your position within your organisation.</td>
</tr>
<tr>
<td>Department</td>
<td>The name of your department within your organisation.</td>
</tr>
<tr>
<td>Location</td>
<td>Your location. This could be a town, city, region or country.</td>
</tr>
<tr>
<td>About me</td>
<td>Information about yourself that other users can view (such as your professional information, hobbies, and other interests). You can use Confluence wiki markup in this field. Note that your Username cannot be changed.</td>
</tr>
</tbody>
</table>

Screenshot: Edit profile
Handy Hint

Confluence administrators can configure Confluence to mask email addresses (e.g. 'example at atlassian dot com'), protecting your email address from search engine spiders and the like.

Related Topics

- Viewing User Profile
- Choosing a Profile Picture
- Setting Up your Personal Space
- Email Address Privacy

Email Address Privacy

Confluence can mask the email addresses of users to protect them from mail spammers.

This is done by a Confluence administrator and is configured through the Administration Console. The Confluence administrator has three options for email address privacy:
- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Private**: only Confluence administrators can see the email addresses.

For more information on setting these options, which are configured using the Administration Console, refer to [User Email Visibility](#).

### Related Topics

- [Editing Your User Profile](#)
- [Viewing User Profile](#)
- [User Email Visibility](#)

Take me back to the [Confluence User's Guide](#).

### Updating Email Address

The email address you specify in your profile settings is used for your mail notifications and is also displayed in your profile description.

**To update your email address:**

1. Go to your name (the 'User' menu) at the top of the page and choose **Profile**.
2. Click **Edit** in the 'Personal' section.
3. In the **Email** field, specify your new email address which will be used when sending you mail notifications.
4. Click **Save**.

### Related Topics

- [Changing Password](#)
- [Editing Your User Profile](#)

Take me back to the [Confluence User's Guide](#).

### Choosing a Profile Picture

Your profile picture is used as the icon for your personal space, to represent you in the People Directory, and to illustrate your comments. It also appears in various other places next to your name, such as in the list of recent updates on the dashboard.

You can upload your own profile picture or use one of the images provided by Confluence. If you upload your own profile picture, you will have an opportunity to crop (trim) the picture.

**To choose a profile picture:**

1. Go to your name (the 'User' menu) at the top of the page and choose **Profile**.
2. Click **Picture** on the left.
3. Choose one of the following two options:
   - Upload a new picture: Click **Browse** to locate your picture, then click **Upload** to upload it from your computer or file server.
   - Or select one of the default icons provided.
4. Click **Set Profile Picture**.

*Screenshot: Choosing a profile picture*
If you upload a profile picture that is larger than 48x48 pixels, the 'Edit My Profile Picture' screen will appear. You can select part of the picture or the entire picture, to be used as the final image for your profile. Note that the size of the final image will always be scaled down to 48x48 pixels.

To edit your profile picture:

1. Click and drag the centre of the superimposed square to select the centre of the new image.
2. Click the corners of the square to resize the area for your new image.
3. Click **Save**.
4. The image from your selected area will be cropped, resized to 48x48 pixels and saved.

*Screenshot: Trimming a profile picture*
Deleting a Profile Picture

You can delete the profile picture images that you have uploaded to Confluence.

To delete a profile picture:

1. Go to your name (the 'User' menu) at the top of the page and choose Profile.
2. Click Picture on the left.
3. Locate and select the picture file you wish to delete, then click Delete.
   - Note that you can only delete images that you have uploaded to Confluence. The standard icons cannot be deleted.
4. Click Delete to confirm the action. The picture is permanently removed from the server.

Screenshot: Deleting a Profile Picture
Related Topics

Choosing a Profile Picture  
Editing Your User Profile  
Setting Up your Personal Space

Take me back to the Confluence User's Guide.

Viewing User Profile

A Confluence User's Profile view shows details about that person and lists their recent activity. If you are viewing your own Profile view, you can also update your profile picture and login password. If you are viewing another user's Profile view, you can add them to your Network of users you are following and if they have set up a Personal Space, you can add this to your list of Favourites.

To access your User Profile view:

- Go to your name (the 'User' menu) at the top of the page and choose Profile.

Screenshot: User Profile View
Updating your Profile

You can update the following aspects of your Profile from this view:

- **Information about yourself** - to modify these details, see Editing Your User Profile.
- **Your Profile picture** - to change your Profile picture or upload a new one, see Choosing a Profile Picture.
- **Your login password** - to change your login password, see Changing Password.

You can switch between your Profile, Profile picture update and login password update views by clicking the 'Details', 'Picture' and 'Password' links in the left-hand column, respectively.

Related Topics

Editing Your User Profile

Take me back to the Confluence User's Guide.

Viewing and Revoking OAuth Access Tokens

This page describes the purpose of OAuth access tokens which have been issued on behalf of your Confluence user account and provides instructions on how to revoke them.

On this page:

- OAuth Access Tokens
- Viewing your OAuth Access Tokens
  - OAuth Access Token Details
- Revoking your OAuth Access Tokens
OAuth Access Tokens

OAuth access tokens allow you to use a Confluence gadget on an external web application or website (also known as the 'consumer') and grant this gadget access to Confluence data which is restricted or privy to your Confluence user account.

OAuth access tokens will only appear in your user profile if the following conditions have been met:

1. Your Confluence Administrator has established an OAuth relationship between your Confluence site and the consumer. Confluence Administrators should refer to Configuring OAuth for more information about establishing these OAuth relationships.
2. You have accessed a Confluence gadget on the consumer and have conducted the following tasks:
   a. Logged in to your Confluence user account via the gadget and then,
   b. Clicked the 'Approve Access' button to allow the gadget access to data that is privy to your Confluence user account.

Confluence will then send the consumer an OAuth 'access token', which is specific to this gadget. You can view the details of this access token from your Confluence site's user account.

An OAuth access token acts as a type of 'key'. As long as the consumer is in possession of this access token, the Confluence gadget on the consumer will be able to access Confluence data that is both publicly available and privy to your Confluence user account. As a Confluence user, you can revoke this access token at any time. Furthermore, all access tokens expire after seven days. Once the access token is revoked or has expired, the Confluence gadget will only have access to publicly available Confluence data.

Viewing your OAuth Access Tokens

To view all of your Confluence user account's OAuth access tokens:

1. Go to your name (the 'User' menu) at the top of the page and choose Settings.
2. Click View OAuth Access Tokens. A view similar to screenshot below is displayed. Refer to OAuth Access Token Details below for information on interpreting this table.

If no access tokens have been set, then 'None specified' is shown.

Screenshot: Viewing your OAuth Access Tokens

<table>
<thead>
<tr>
<th>OAuth Access Tokens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
</tr>
</tbody>
</table>

Your list of OAuth access tokens is presented in a tabular format, with each access token presented in separate rows and each property of these tokens presented in a separate columns:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer</td>
<td>Consumer Description</td>
</tr>
</tbody>
</table>
### Consumer

The name of the Confluence gadget that was added on the consumer.

### Consumer Description

A description of this consumer application. This information would have been obtained from the consumer's own OAuth settings when an OAuth relationship was established between Confluence and that consumer.

If the consumer is another Atlassian application, this information is obtained from the Consumer Info tab's 'Description' field of the OAuth Administration settings. The application's administrator can customise this Consumer Info detail.

### Issued On

The date on which the OAuth access token was issued to the consumer by Confluence. This would have occurred immediately after you approved this gadget access to your Confluence data (privy to your Confluence user account).

### Expires On

The date when the OAuth access token expires. This is seven days after the 'Issued On' date. When this date is reached, the access token will be automatically removed from this list.

### Actions

The functionality for revoking the access token.

---

**Revoking your OAuth Access Tokens**

**To revoke one of your OAuth access tokens:**

1. View your Confluence user account's OAuth access tokens (described above).
2. Locate the Confluence gadget whose OAuth access token you wish to revoke and click Revoke OAuth Access Token next to it.
   The gadget's access token is revoked and the Confluence gadget on the consumer will only have access to publicly available Confluence data.

**Choosing your Homepage**

By default, all users are directed to the dashboard after logging in. However, you can choose to be redirected to the home page of any space on the Confluence site after logging in.

**To set the home page:**

1. Click on your name (the 'user' menu) at the top of the page and choose Settings.
2. Click Edit.
3. Use the Site Homepage list to select a space. Note that only the list of spaces to which you have 'view' access is displayed here. You will be directed to the home page of the selected space when you next log in.
4. Click Submit.

*Screenshot: General Preferences Settings*
Related Topics

User Profile Overview

Take me back to Confluence User's Guide

Customising your Personal Dashboard

You can customise the Confluence dashboard to provide access to the content on the site that is most relevant to you. The options described on this page will change your own personal dashboard, but will not affect the dashboard that other people see.

If you are a Confluence Administrator, you can change the global dashboard, as seen by all Confluence users. See the administrator's guide to customising the dashboard.

On this page:
- Displaying your Favourite Spaces
- Categorising your Spaces
- Displaying your Favourite Pages
- Related Topics

Displaying your Favourite Spaces

Mark some spaces as favourites. You can now click the Spaces tab on the dashboard to see a list of your favourite spaces. You can also click the Favourite Spaces tab at the top right of the dashboard to see recently updated content from just your favourite spaces.

Categorising your Spaces

To help keep Confluence spaces organised, you can label spaces with different space categories. See Using Labels to Categorise Spaces. Space categories are used to group related spaces.

For example, you might want to group spaces on your Confluence site by applying the following space categories to the relevant spaces:

- 'design' (for spaces relevant to a design team), and
- 'development' (for spaces relevant to a development team).

If a subset of these spaces is relevant to both teams, apply both the 'design' and 'development' categories to each of these spaces to make the spaces appear in both groups.

Once you have added space categories, you can click the Space Categories tab at the top right of the dashboard and select a category from the drop-down menu to display only spaces belonging to that category.

Displaying your Favourite Pages
Mark some pages as **favourites**. You can now click the **Pages** tab on the dashboard to see a list of your favourite pages.

**Screenshot: The dashboard, showing favourite pages and space categories**

Confluence combines powerful online authoring capabilities, deep Office integration and an extensive plugin catalogue to help people work better together and share information effortlessly. Get started by adding a new space to create content in. Add a few users to try out Confluence with you.

If you want to display a different message here, you can easily change the welcome message.

### Related Topics

- Working with Confluence Labels
- Working with Favourites
- Configuring the Site Home Page
- Customising the Dashboard

Take me back to the [Confluence User's Guide](#).

### Customising the Look and Feel of a Confluence Space

You can customise the 'look and feel' of a space on your Confluence site through options available in the **Space Administration** menu. By default, the look and feel of a space is based on global settings configured from the **Administration Console**.

You need to be a **space administrator** to change the look and feel of a space.

- **Applying a Theme to a Space**
- **Changing a Space's Logo**
- **Changing the Confluence Browser Icon, aka favicon**
- **Customising Space Layouts**
- **Editing a Space's Colour Scheme**
- **Styling Confluence with CSS**

**Related pages:**

- Design and Layout
- Working with Spaces
- Confluence User's Guide

### Applying a Theme to a Space

Themes allow you to personalise the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site and to individual spaces. Choose a specific theme if you want to add new functionality or...
Confluence comes with a selection of themes. In addition, a site administrator can install new themes as plugins via the Confluence Administration Console. Provided that the theme is installed into your Confluence site, any space administrator can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.

**To apply a theme to a space:**

1. Choose Browse > Space Admin.
   
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click Themes in the left-hand panel under 'Look and Feel'.
3. Select a theme option.
4. Click Confirm.

_Screenshot: Applying a theme_

**Related Topics**

Applying a Theme to a Site  
Editing a Space's Colour Scheme  
Customising the Look and Feel of a Confluence Space

Configuring the Documentation Theme  

The Documentation theme is one of the themes bundled with Confluence. (See availability below.) The theme is designed for spaces containing technical documentation, but you may find it useful for other types of content too. It provides an inbuilt table of contents for your wiki space, a configurable header and footer, and text styles suited to documentation. (See features below.)
Quick guide to applying and customising the Documentation theme

- Go to Space Admin and click Themes.
- Select Documentation Theme and click Confirm.
- If you want to customise the theme, click Configure theme.
  - Select or deselect the default page tree.
  - Select or deselect the space-restricted search.
  - Enter the text and wiki markup for your custom left-hand panel header and footer.
  - Click Save.

The rest of this page gives more details of the above procedure.

On this page:

- Applying the Documentation Theme to your Space
- Applying the Documentation Theme to your Site
- Customising the Documentation Theme
- Features of the Documentation Theme
- Availability of the Theme
- Hints and Tips
- Related Topics

Screenshot: A wiki page using the Documentation theme

Applying the Documentation Theme to your Space

You need space administrator permissions to apply a theme to a space.
Follow the steps below to apply the 'Documentation Theme' to your space. All pages in the space will start using the theme immediately.

**To apply a theme to a space:**

1. Choose **Browse > Space Admin.**  
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the `confluence-administrators` group).
2. Click **Themes** in the left-hand panel under 'Look and Feel'.
3. Select a theme option.
4. Click **Confirm**.

**Screenshot: Applying a theme**

[![Screenshot: Applying a theme](image-url)](image-url)

### Applying the Documentation Theme to your Site

If you have **site administrator** permissions, you can apply the theme at site level. It will then be the default theme for all spaces in the site. See the administrator's guide to [applying a theme](#).

### Customising the Documentation Theme

The theme works well without any customisation. If necessary, you can restrict the search to just one space, change the content of the left-hand navigation panel and add your own header and footer.

**To customise the Documentation theme:**

1. Choose **Browse > Space Admin.**  
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the `confluence-administrators` group).
2. Click **Themes** in the left-hand panel under the heading 'Look and Feel'.
3. If the space is not yet using the Documentation theme, apply the theme as described above.
4. Click **Configure theme** in the yellow area of the 'Current Theme' section at the top of the page. See **screenshot below**. The 'Documentation Theme Configuration' screen appears. See **screenshot below**.
5. Select or deselect the **Page Tree** check box. This determines whether your space will display the default
search box and table of contents (page tree) in the left-hand panel.

6. Select or deselect the **Limit search results to the current space** check box.
   - If you select the check box:
     - The Confluence search will look for matches only in the current space by default. Users can override this restriction when entering their search term. See [Using the Documentation Theme](#).
     - The default page tree in the left-hand panel will not include a search box.
   - If you do not select the check box:
     - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
     - The default page tree in the left-hand panel will include a search box, which restricts search results to the current space.

7. Enter text, images, macros and other wiki markup into any or all of the three text boxes.
   - You can use the `Include` or `Excerpt Include` to include re-usable content into your footer. See hint below.

   - 'Navigation' – This text box contains content for the left-hand panel.
     - If the **Page Tree** check box is selected, the navigation panel contains the default search box and page tree. Any content you enter into the ‘Navigation’ text box will appear above the page tree and search box.
     - You can include your own content *underneath* the page tree as well as above. See hint below.
   - In summary: Deselect the **Page Tree** check box. Insert your own page tree using the **Page Tree** macro, then add your own content under the macro.
   - 'Header' – This text box contains content for a page header that will appear above the page title on all pages in the space. See example screenshot below.
   - 'Footer' – This text box contains content for a page footer that will appear after the comments and above the site footer, on all pages in the space. See example screenshot below.

8. Click **Save**.

**Screenshot: The ‘Configure theme’ option**

```
Current Theme
The current theme controls the layout and colours of this space.

**Documentation Theme**
Featuring a page tree or a custom navigation, the documentation theme makes it easy to navigate through your Confluence site. The theme is optimised for Firefox, Safari and Internet Explorer 7+.  

**Configure theme** - further customise this theme’s options
```

**Screenshot: Customising the Documentation theme**
Customising the Theme at Site Level

If you have site administrator permissions, you can apply and customise the theme at site level. The customisation options are the same as the space level options, as described above.

Features of the Documentation Theme

Screenshot: A customised header, footer and left-hand panel
The above screenshot shows a wiki space with a customised left-hand panel, header and footer.

Here is a summary of the features that the Documentation theme provides:

- By default, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.
- The left-hand panel is fully customisable. You can choose to include or exclude the search box and page tree. You can enter your own text, images and wiki markup.
- People viewing the page can drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel. They can also remove the panel altogether, by clicking the sidebar icon at top right, next to the search box.
- The left-hand and right-hand panels scroll independently of each other.
- The page title is neatly above the page content, and not uncomfortably above the navigation panel as tends to happen when you insert the navigation panel yourself.
- Because the left-hand panel is part of the theme, it will be upgraded whenever Confluence is upgraded. There is no need to remove and then re-apply your customisations on each upgrade, as you would do if you added your own left-hand navigation bar.
- The theme also provides a customisable header and footer, which will appear at the top and bottom of every page.
- The text and heading styles are designed to enhance the content typically found in a documentation space.
- You can use the Space Jump macro to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link.
- You can limit the Confluence search results to the current space. If you choose this option, the
Confluence search will look for matches only in the current space by default. Users can override the restriction. See Using the Documentation Theme.

Availability of the Theme

Confluence Versions

The Documentation theme is bundled with Confluence 3.2 and later. If you have Confluence 3.1, your Confluence Administrator can download the theme from the Atlassian Plugin Exchange and install it as a plugin.

The theme is not available for versions of Confluence earlier than Confluence 3.1.

Hints and Tips

Below are some hints that you may find useful when using the Documentation theme. Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the Atlassian documentation wiki, you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme's table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the ‘Home’ page. You can specify the home page in the space administration section.

Help, my pages do not appear in the Documentation theme table of contents

Cause 1: Your pages are not under the space’s home page. The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space’s home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:

- You can change the designated space home page in the space administration section.
- Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the ‘Pages’ section of the space ‘Browse’ screen. See Moving a Page.

Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled. If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.
Hiding pages from the left-hand table of contents

You can 'hide' pages by putting them at the same level as or higher than the space home page.

Each space has a single page designated as the 'Home' page. You can specify the home page in the space administration section.

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space's home page.

If your documentation pages are at the same level as the space home page, they will not appear in the left-hand navigation bar. So you can 'hide' pages by putting them at the same level as or higher than the space home page. The pages will show up in the search results and people can see the content if they open the page, but the pages will not appear in the left-hand panel.

More detail: The theme uses the Pagetree macro to produce the table of contents. When entering the Pagetree macro, you can choose the top page in the page tree. The Documentation theme chooses the space home page as the top page.

Using reusable content in your header, footer or left-hand panel

You can use any text or wiki markup in your theme header, footer or left-hand panel. One useful hint is to use the Include or Excerpt Include to include re-usable content into your footer.

The screenshot above shows the theme customisation options, with examples of the macros used to include content from other pages. And the example screenshot also above shows the resulting header, footer and left-hand panel.

Adding content below the page tree in your left-hand panel

If you want to include your own content underneath the page tree, you can deselect the 'Page Tree' check box, add your own page tree using the Pagetree macro in the 'Navigation' text box, and then add your own content under the macro.

The screenshot above shows the theme customisation options, with the default page tree deselected and a custom page tree inserted, along with additional content in the left-hand panel. The example screenshot also above shows the resulting left-hand panel.

Adding underlines to your links

By default, the Documentation theme does not underline hyperlinks. If you prefer to have your links underlined, you can edit the CSS stylesheet for your space and add the following CSS code:

```
.wiki-content a:link, .wiki-content a:visited, .wiki-content a:active {
    text-decoration: underline;
}
```

To edit a space's CSS style sheets:
1. Choose **Browse > Space Admin**.
   
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the **confluence-administrators** group).

2. Click **Stylesheet** in the left-hand panel under the heading 'Look and Feel'.

3. Click **Edit**.

4. Paste your custom CSS into the text field.

5. Click **Save**. The new CSS will be visible on all content pages in the space.

Notes:

- You need **system administrator** permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to **Confluence Admin > Security Configuration** and choose **Custom Stylesheets for Spaces**.

### Jumping to the same page in another space

The **(spacejump)** macro is provided along with the Documentation theme. You can use space jumping to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link. When a reader is viewing a page and clicks the link provided by the macro, they will go to a page with the same name, but in the space specified in the macro. See [more about the Space Jump macro](https://confluence.atlassian.com/doc/using-the-spacejump-macro-1313738536.html).

### Hiding the left-hand panel completely

It's not possible to remove the left-hand panel entirely, using the user interface supplied by the theme. There is an improvement request here: [CONF-25923](https://confluence.atlassian.com/browse/CONF-25923) - **Authenticate** to see issue details. If you like, you can comment on and/or vote for that request. In the meantime, **Atlassian Answers** is a good place to ask the question and see if other people can help you with custom code to remove the panel.

**Related Topics**

- **Using the Documentation Theme**
- **Space Jump Macro**
- **Applying a Theme to a Space**
- **Applying a Theme to a Site**
- **Editing a Space's Colour Scheme**
- **Customising the Look and Feel of a Confluence Space**

Take me back to **Confluence User's Guide**

### Configuring the Easy Reader Theme

The Easy Reader theme is one of the themes bundled with Confluence. This is a fixed-width variation of the default Confluence theme. Its larger fonts, smooth gradient background and comfortable line length make it ideal for displaying and reading longer documents.

**Quick guide to applying the Easy Reader theme**

1. Choose **Space Admin > Themes**.
2. Select **Easy Reader Theme**.
3. Click **Confirm**.

The rest of this page gives more details of the above procedure.

**On this page:**

- **Applying the Easy Reader Theme to your Space**
- **Customising the Look and Feel of the Easy Reader Theme**
- **Hints and Tips**

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
You need space administrator permissions to apply a theme to a space.

Applying the Easy Reader Theme to your Space

Follow the steps below to apply the 'Easy Reader Theme' to your space. All pages in the space will start using the theme immediately.

To apply a theme to a space:

1. Choose Browse > Space Admin.
   
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click Themes in the left-hand panel under 'Look and Feel'.
3. Select a theme option.
4. Click Confirm.

Screenshot: Applying a theme
Applying the theme to your entire Confluence site

If you have site administrator permissions, you can apply the theme at site level. It will then be the default theme for all spaces in the site. See the administrator's guide to applying a theme.

Customising the Look and Feel of the Easy Reader Theme

You can customise the space CSS style sheets to change the colours, background image and other styles in the theme. See the guide to using CSS to customise the Easy Reader theme.

Hints and Tips

If a page has content that is very wide, it will either:

- cause a scroll bar to appear, or
- break out, i.e. the content will extend over the right-hand border of the page.

Related Topics

Applying a Theme to a Space
Applying a Theme to a Site
Customising the Look and Feel of a Confluence Space

Take me back to the Confluence User's Guide

Changing a Space's Logo

In Confluence, you can replace the default logo for a space with a logo of your own choice.

You need to be a space administrator to replace a space's logo.

The instructions below refer to global spaces. For your personal space, your profile picture is used as the space icon.
To change a space’s logo:

1. Choose **Browse > Space Admin.**  
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click **Change Space Logo** in the left panel under the heading 'Look and Feel'. See the screenshot below.
3. Use the browse option to locate the new logo and click **Upload**.

**Hint:** A space logo looks best if the height and width of the image are of the same or similar length. In other words, the area occupied by the image, including white space, should be square rather than rectangular.

**Screenshot: Changing a space’s logo**

---

**Change the logo for this space.**

- **Image**
  
  [Image]

  - **Upload Logo**
  - **Current**
    (default)

- **Image Data**
  
  - **H:** 30
  - **W:** 42
  - **GIF**

---

**Changing the Confluence Browser Icon, aka favicon**

- **Document status as of 26-Aug-2012**
  
  These changes work in Confluence 4.2.x however some may not be needed. We’re confirming which ones are redundant at the moment, however in the meantime please make all the changes listed below to ensure it works. Backing up the old files is strongly recommended.

The Confluence logo is displayed in the user’s browser to identify the Confluence browser tab. To use a custom image for your Confluence site:

1. Obtain or create an image in PNG file format. To maximise browser compatibility, it should be 32x32 pixels in size, 71x71 DPI (dots per inch) and have an 8 bit colour depth.
2. In your Confluence installation, find the `...\confluence\images\icons` directory.
3. Back up the file `favicon.png`.
4. Replace the `favicon.png` file with your custom PNG image.
   
   **You may also need to back up and replace the following images in your Confluence installation:**
   
   - `...\confluence\images\icons\favicon.ico`
   - `...\confluence\favicon.ico`
   - `...\confluence\images\logo\confluence_16.png` (Reduce this image to 16x16 pixels.)
   - `...\confluence\images\logo\confluence_16_white.png`
   - `...\confluence\images\logo\confluence_16_trans.png`
5. Restart your application server.

⚠️ The information on this page does not apply to Confluence OnDemand.

Users may need to clear their browser cache before they will see the new image.

ℹ️ Converting a PNG to an icon

To create an ICO out of your PNG image, you can use the freeware tool png2ico or the the online tool at http://converticon.com/.

Related Topics

Customising the Look and Feel of a Confluence Space

Customising Space Layouts

You can modify Confluence’s look and feel by editing the 'decorator' (layout) files. This page tells you how to customise the layout files for a space.

Confluence system administrators can also customise the layout of their entire Confluence site as a whole. For more information, please refer to Customising Site and Space Layouts. Site layout customisations modify the default layout of all spaces in the Confluence site. However, any space layout customisations will override the equivalent site customisations.

A note about permissions: To perform these customisations, you will require space administrator permissions for that space. For security reasons, you must also have Confluence system administrator permissions to modify any space layout throughout your Confluence site.

⚠️ If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with any customisations. For more information on updating your customisations, please refer to Upgrading Customised Site and Space Layouts.

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through ‘decorators’ that define a page’s layout and structure.

To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a very simple programming language called Velocity. Learn more about Velocity. Once you become familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, if you want to make changes to the header and the footer, you will need to modify these layouts.

- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but they allow you to alter the way the surrounding comments or attachments are shown.

- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.
Learn more about using decorators.

To edit a decorator file:

1. Choose Browse > Space Admin.
   
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).

2. Click the Layout link in the left-hand panel, under Look and Feel. You will see a list of the layouts for the space.
   
   (Layout is displayed only if you are a Confluence system administrator.)

   - Click View Default to view the vmd file.
   - Click Create Custom to edit the default vmd file. This will open up the vmd file in edit mode.

   Make changes and click Update.

   Screenshot: Edit Layouts Example

<table>
<thead>
<tr>
<th>Decorator</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Export Layout</td>
<td>&lt; default x</td>
</tr>
<tr>
<td>Page Export Layout</td>
<td>&lt; default x</td>
</tr>
</tbody>
</table>

   Click the thumbnail to see an example of a vmd file:

   Related Topics

   Customising the Look and Feel of a Confluence Space

   Applying a Theme to a Space

   Administrator’s Guide - Design and Layout

   Take me back to the Confluence User’s Guide.

   Editing a Space’s Colour Scheme

   Confluence allows you to customise the colour scheme of a space. By default, a space’s colour scheme is based on global settings configured from the Administration Console.

   You need to be a space administrator to edit a space’s colour scheme.

   To change the colour scheme for a space:

   1. Choose Browse > Space Admin.

   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).

   2. Click Colour Scheme in the left-hand panel under the heading Look and Feel.

   3. Click Select next to a colour scheme under Custom Colour Scheme (if not already selected).
4. Click the Edit link. This will bring up a new screen. See screenshot below.

5. Enter standard HTML/CSS2 colour codes, or use the colour-picker to choose a new colour from the palette provided. Any changes you make will immediately be reflected in this space.

The colour scheme applies to the following UI elements:

- **Top Bar** - the bar across the top of the page that contains the breadcrumbs
- **Tab Navigation Background** - the background colour of the tab navigation menus
- **Tab Navigation Text** - the text of the tab navigation menus
- **Breadcrumbs Text** - the breadcrumbs text in the top bar of the page
- **Space Name Text** - the text of the current space name located above the page title
- **Heading Text** - all heading tags throughout the space
- **Links** - all links throughout the space
- **Borders and Dividers** - table borders and dividing lines
- **Tab Navigation Background Highlight** - the background colour of the tab navigation menu when highlighted
- **Tab Navigation Text Highlight** - the text of the tab navigation menu when highlighted
- **Top Bar Menu Selected Background** - the background colour of the top bar drop down menu when selected
- **Top Bar Menu Item** - the text colour of the menu items in the top bar drop down menu
- **Page Menu Selected Background** - the background colour of the drop down page menu when selected
- **Page Menu Item Text** - the text of the menu items in the drop down page menu
- **Menu Item Selected Background** - the background colour of the menu item when selected (applies to both the top bar and page drop down menus)
- **Menu Item Selected Text** - the text colour of the menu item when selected (applies to both the top bar and page drop down menus)

Please note that some UI elements are specific to the default theme and may not take affect for other themes.

*Screenshot: Editing a space's colour scheme*
Handy Hint

If you mess things up, just click the **Reset** button and then try again.

**Related Topics**

- Customising the Look and Feel of a Confluence Space
- Styling Confluence with CSS

**Styling Confluence with CSS**

This page explains the facility for changing the look and feel of Confluence with CSS.

**On this page:**

- Introduction
- Considerations for Using Custom CSS
- Getting Started
- CSS Resources
- Related Pages

**Introduction**

Cascading Style Sheets (CSS) are an industry-standard way of styling a web page. The content of a page is rendered with HTML, and its look and feel is determined by CSS files. You can upload a CSS text file, or simply
type in a stylesheet, and apply it to a space or even a whole Confluence site.

Notes:
- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to Confluence Admin > Security Configuration and choose Custom Stylesheets for Spaces.

Creating CSS styles that work seamlessly across different browsers is a delicate task for basic web sites, and reasonably challenging when customising web applications like Confluence. It is important to test each change that you make and ensure it works as expected in all areas of Confluence – for example, on the Confluence dashboard as well as on regular pages.

In order to get you started, we have compiled this introduction, a basic styling tutorial and a more advanced tutorial.

Considerations for Using Custom CSS

CSS Knowledge is Required

If you are not familiar with CSS, see the links in the CSS Resources section below. You should spend some time to become confident with Cascading Style Sheets before you start editing your Confluence style sheets.

Security

Custom CSS can be used to inject scripts into a page, opening the risk of cross-site scripting (XSS) attacks. With this feature enabled, space administrators could upload styles that steal other users' login credentials, trick their browsers into performing actions on the wiki without their knowledge, or even obtain global administration privileges. As such, this feature is disabled by default. Confluence administrators should only enable custom CSS if they are comfortable with the risks listed in this paragraph.

Scaling

Each page needs to scale. Depending on the resolution of the user's screen, the content should render intelligently. Your designs needs to degrade gracefully. Try resizing each page that exists in Confluence. There are quite a few pages in the browse-space-section, like drafts, labels, page hierarchy, and so on. Your style has to work everywhere, not just in the first page you happen to be looking at.

Features Cannot Be Disabled

It is easy to turn off certain links, headers, or even menu items by simply setting their style to 'hidden'. This can help you to roll out Confluence to users that may not be very Wiki-savvy yet. The simpler the UI, the easier it may be for them to use. However, please remember that removing the link to a part of the application does not mean that the functionality is not available. Every user can still change their style from within their browsers, or access the URL directly. Don't rely on CSS to disable parts of Confluence.

Features Should Not Be Disabled

Users familiar with Confluence will expect to find the same controls that they are accustomed to. Removing buttons or controls from the interface is not advised as it may frustrate your users and cause them to circumvent your design by using direct URL access, as mentioned above.

Confluence Version Compatibility

Be aware of any plans to upgrade your Confluence instance. Future versions of Confluence may not be compatible with your custom CSS — this may cause your CSS to break, requiring maintenance when Confluence is upgraded. Ask your Confluence administrator for more information.
Test on Different Web Browsers

As a rule you should test your modifications on different web browsers. Internet Explorer, Firefox, Opera and Safari (on Mac OS X) are some of the more popular browsers.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

CSS Customisation is Not Supported

As creating custom CSS has potentially limitless possibilities, Atlassian will not support issues that are caused by or related to CSS customisation.

Getting Started

Editing the CSS

To edit a space's CSS style sheets:
1. Choose Browse > Space Admin. 
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Click Edit.
4. Paste your custom CSS into the text field.
5. Click Save. The new CSS will be visible on all content pages in the space.

Follow the Tutorial

Follow the examples in the Basic Styling Tutorial or the more advanced Styling Tabs in Confluence to get started.

CSS Resources

- W3C CSS Standards
- W3schools CSS Introduction
- Mozilla Developer Network
- W3resource.com

Related Pages

Basic Styling Tutorial
Styling Tabs in Confluence
Styling Fonts in Confluence
Including Cascading Stylesheets in Themes

Basic Styling Tutorial

This page contains instructions on how to get started with custom CSS styling in Confluence.

On this page:

- CSS Editing Quick-Start
- Tutorial: Changing the Header Background
- CSS Editing Tips
  - Begin With a Space Stylesheet
  - Use the Right Tools
  - Edit Simple Elements First
CSS Editing Quick-Start

To edit a space's CSS style sheets:
1. Choose **Browse > Space Admin**.  
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click **Stylesheet** in the left-hand panel under the heading 'Look and Feel'.
3. Click **Edit**.
4. Paste your custom CSS into the text field.
5. Click **Save**. The new CSS will be visible on all content pages in the space.

Tutorial: Changing the Header Background

The header is the menu area at the top of a default Confluence page where the Breadcrumb Links, Browse menu, User menu and the Quick Search box reside. In this example, we are going to change the background of the header to include a custom graphic.

1. Create a custom graphic. For this example, we created a custom header graphic of 1046 x 61 pixels.
2. Upload the custom graphic to a page in the space that you are customising.
3. Note the page ID of the page where you uploaded the new graphic. (in this example, the page ID was ‘658833839’).
4. Compose your custom CSS for the header. The example below loads the new graphic (called ‘header.png’) from a specific page (denoted by page ID ‘658833839’) in the same space.

```css
#header {
  background-image: url('..download/attachments/658833839/header.png');
  background-repeat: no-repeat;
}
```

5. Log in as the Space Administrator.
6. Open the Space Admin page.
7. Click **Stylesheet**.
8. Click **Edit** to change the code in the text field.
9. Paste your custom CSS into the text field.
10. Click **Save** and then reload the page (you may have to shift-reload). The background of the header will change.
11. The custom header will be visible on all content pages in the space. To revert your change, simple delete the custom code from the 'Stylesheet' page and click **Save**.

CSS Editing Tips

**Begin With a Space Stylesheet**

A space stylesheet is a good starting point for CSS customisation, as it already includes all of the elements that can be changed. When you work on the space stylesheet it styles all content pages in the space. Build and test it at space-level, before considering applying the new stylesheet to your entire site. Once you are satisfied with your space design, test it thoroughly until you are confident that it has no problems. Then, you can look into advanced customisation of the Confluence CSS such as adjusting the Search page, the Dashboard and other integral pages.

**Use the Right Tools**
As the Confluence CSS is reasonably sophisticated, web development applications will help you to understand how the page styles have been created. In particular, you will need to view the existing source for the pages you’re starting to work on. If you don’t already have some, tools such as the following free applications will allow you to do this.

1. **Firebug**
   Firebug, a plugin for the Firefox web browser, allows you to take a look at the style of each element on your page. This is very useful to see what styles are currently applied, for example styles applied to the header only.

2. **Web Developer**
   The Web Developer plugin for Firefox allows you to edit CSS inline and create new page designs.

3. **CSS Edit**
   CSS Edit is a stand-alone CSS editor for Macintosh that extracts all existing styles from a given page and allows you to overwrite these.

### Edit Simple Elements First

Begin by editing simple elements and checking that they work. By making changes, then checking that each one worked, you can easily isolate any CSS code that is causing problems. Be aware that some page elements are more suited to customisation than others. For example, adding a gradient to the toolbar is less likely to ‘break’ the page than changing the page width. Editing reasonably static elements such as background graphics will render more predictably than designs which attempt to completely change the user interface or the Javascript-powered drop-down menus (which we don’t recommend editing).

**Related Topics**

- Styling Confluence with CSS
- Styling Tabs in Confluence
- Including Cascading Stylesheets in Themes
- Styling Fonts in Confluence

Confluence provides the ability to adjust its visual style via Cascading Style Sheets (CSS). With this feature, it is very easy to change the look and feel of Confluence.

This tutorial shows you to change the fonts of a normal Confluence page. We will show how to change the font and font sizes with a few lines of CSS.

**Screenshot 1: Default Font in a Confluence Page**

**Screenshot 2: Custom Font in a Confluence Page**
At the bottom of this page you can find the code for the custom font. Simply copy and paste it into the Space Stylesheet form within the Space Administration section.

**Changing the fonts**

In order to customise the fonts in Confluence, you first need to set the body font to the font you want. Second, you may want to adjust the font size to account for the fact that different fonts have different relative sizes.

The relevant CSS is shown below, and can be configured in Space Admin > Stylesheets. These styles change Confluence’s font from its default of Helvetica/Arial – sans serif fonts – to Times/Times New Roman – serif fonts.

To adjust for the fact that Times is a bit smaller than Helvetica, we increase the font size to 14 pixels.

```css
body {
  font-family: Times, "Times New Roman", serif;
  font-size: 14px;
}
.wiki-content,
.wiki-content p,
.wiki-content table,
.wiki-content tr,
.wiki-content td,
.wiki-content th,
.wiki-content ol,
.wiki-content ul,
.wiki-content li {
  font-size: 14px;
}
```

The many styles which include 'wiki-content' are necessary to change the font-size for all the tags in the wiki content.

**Related Topics**

- [Basic Styling Tutorial](https://confluence.example.com/display/kb/BasicStylingTutorial)
- [Styling Tabs in Confluence](https://confluence.example.com/display/kb/StylingTabsinConfluence)
- [Including Cascading Stylesheets in Themes](https://confluence.example.com/display/kb/IncludingCascadingStylesheetsinThemes)

**Styling Tabs in Confluence**

Confluence provides the ability to adjust its visual style via Cascading Style Sheets (CSS). With this feature, it is very easy to change the look and feel of Confluence.
This tutorial shows you how to change the look and feel of Confluence. We will address the Confluence tabs in this tutorial and how we can change their look completely with a few lines of CSS.

Let's take a look at what we are trying to achieve. Notice the dark blue tabs in Screenshot 1? Our goal is to blend them into the background and change the text style as in Screenshot 2.

**Screenshot 1: Default Confluence Tabs in Admin Screen**

At the bottom of this page you can find the code for the custom tabs. Simply copy and paste it into the Space Stylesheet form within the Space Administration section. Let's discuss each selector in detail:

### Container Style

```css
#navigation, #tab-navigation{
    border-bottom: 1px solid #CCC;
    background-color: transparent;
    margin: 1em 0 2em -5px;
}
```

Let's start with the container around the tabs. We don't want a `background-color` for the tabs and the container, therefore we will set the color to be transparent. With the `border-bottom` attribute we will create a thin grey line at the bottom to separate the navigation from the rest of the page. Lastly we adjust the margins of the container to create some space around the tabs.

### Tab Style
Then we style each link within the tab. We set the font-weight to normal, to make the tabs less dominant and change the color to a dark grey. We also have to specify the border and background-color attributes explicitly to overwrite the default styles in Confluence. If we don’t specify the background color for example, the blue color of the default style will be applied.

**Hover Style**

```css
.tab-navigation .tab a:hover {
  font-weight: normal;
  color: #0088CC;
  background-color: transparent;
  border: none;
}
```

Now we want to specify the hover attributes of the links. Note that we have to overwrite the background-color and the border attributes again, otherwise the default styles will be applied. We also change the color of the text for the hover effect of the link.

**Currently Selected Element Style**

```css
ul.tab-navigation .current a:hover, ul.tab-navigation .current a {
  color:#000000;
  background-color: transparent;
  border:none;
}
```

The last selector we will need to customise is the element with the class current. Note that we use a more specific selector this time. The reason we are doing this is because these specific selectors are used in the default CSS stylesheet. If we were to use more general selectors, like we did above (ignoring the ul), the default style would still be applied since more specific selectors are rendered with a higher priority. We want to keep the general style of the other links but simply change the color of the text to black.

**Complete CSS Style**

Simply copy and paste the code below to change the look of the tabs in Confluence.
/* @group Tab Styles */

.tab-navigation .tab a {
  font-weight: normal;
  color: #999999;
  background-color: transparent;
  border: none;
}

.tab-navigation .tab a:hover {
  font-weight: normal;
  color: #0088CC;
  background-color: transparent;
  border: none;
}

#navigation, #tab-navigation{
  border-bottom-color:#CCC;
  margin: 1em 0 2em -10px;
  background-color: transparent;
}

ul.tab-navigation .current a:hover, ul.tab-navigation .current a {
  background-color: transparent;
  border:none;
  color:#000000;
}

/*@end*/

Related Topics

Basic Styling Tutorial
Styling Tabs in Confluence
Including Cascading Stylesheets in Themes

Using CSS to Customise the Easy Reader Theme

This page gives some hints on using the space CSS style sheets to customise the Easy Reader theme.

You can customise the Easy Reader theme using CSS at space or site level. A common modification is to change or remove the background image.

⚠️ CSS elements are specific to each theme

You will need to match your theme choice and custom CSS. If you want to use the CSS on this page, you will need to apply it to a space that is using the Easy Reader theme. If you apply the CSS at site level, then your entire site must use the Easy Reader theme.

Editing the CSS

To edit a space's CSS style sheets:
1. Choose Browse > Space Admin.
   Note: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click **Stylesheet** in the left-hand panel under the heading 'Look and Feel'.
3. Click **Edit**.
4. Paste your custom CSS into the text field.
5. Click **Save**. The new CSS will be visible on all content pages in the space.

### Simple CSS Customisations for Easy Reader Theme

#### To change the background image:

```css
body { background: #ccc url("path/to/your/background.gif") 50% 0 repeat-y; }
```

Remember to set an appropriate background colour to extend past the left and right edges of the image. In the example we use colour code `#ccc`. This colour should match the last pixel on the left and right of your background image.

- **Upload your background image as a page attachment**
  
  You can upload your background as a page attachment. Make sure that you restrict editing (but not viewing) of that page to yourself or the space/site administrators.

#### To replace the theme's gradient image with your choice of background colour:

```css
body { background: #ccc; }
```

#### To add a border to the left and right of the content area, using a specific colour (in the example we use colour code `#ccc`):

```css
#full-height-container { border-left: 1px solid #ccc; border-right: 1px solid #ccc; }
```

### Related Topics

- Configuring the Easy Reader Theme
- Styling Confluence with CSS

### Giving People Access to Content

Confluence gives you the choice to make the site as open or as closed as you wish. Here are some points to consider:

- As a tool for communication and collaboration, Confluence is at its best when all your users can participate fully.
- So it is advisable not to restrict users unless you have a good reason for doing so.
- Confluence keeps a history of all changes to pages and other content. So it is easy to see who has changed what, and to reverse any edits if required.

### Levels of permission
There are three levels of permissions in Confluence.

**Global permissions**

**Global permissions** are site-wide permissions, and are assigned by administrators. Confluence allows two levels of administrator permissions:

- **System Administrator** - Users with this permission can perform all the Confluence administrative functions.
- **Confluence Administrator** - Users with this permission can perform most of the Confluence administrative functions, but excluding those functions which could compromise the security of the Confluence system.

Users with 'System Administrator' or 'Confluence Administrator' permission can assign permissions to other users. For full details, please refer to the [overview of global permissions](#) in the *Administrator's Guide*.

**Space permissions**

The permission to create a new space or to administer one is granted by a *Confluence Administrator* from the global *Administration Console*.

Every space has its own independent set of permissions. These permissions determine the access settings for different users of the space. In order to assign these permissions to other users, a user must be a space administrator i.e. must have the 'Admin' permission for that space.

See [Users and Groups](#) to learn how these permissions are assigned.

**Note:** If you misconfigure a space so that nobody has access to administer it any more, someone in the 'confluence-administrators' group will need to fix the permissions for you.

**Page restrictions**

You can set [page-level restrictions](#), if you have the 'Restrict Pages' permission within the space concerned.

Page restrictions allow you to control who can view or edit individual pages. To set page restrictions, edit the page and use the page restriction options below the text-entry box.

---

**On this page:**

- **Levels of permission**
  - Global permissions
  - Space permissions
  - Page restrictions
- **More information**
  - How do space permissions and page restrictions work together?
  - How do space permissions and page restrictions affect links?

**Related pages:**

- Users and Groups
- Global Permissions Overview
- Space Permissions Overview
- Page Restrictions
- Configuring Confluence Security
- Confluence Security
- Confluence User's Guide

---

**More information**
How do space permissions and page restrictions work together?

Example: In the HR (Human Resources) space, everyone in the organisation has the ‘View’ space permission, but only the HR team has the ‘Pages --> Create’ space permission (i.e. the ability to create and edit pages in the space). A member of the HR team starts to create a new page called 'Annual Leave Policy'. Because the page is not yet finished, she sets the 'Viewing' page restriction so that only the HR team can view the page. When the page is finished, she will remove the 'Viewing' restriction so that everyone in the company can see the page.

How do space permissions and page restrictions affect links?

Space permissions and page restrictions affect how links between pages are displayed to a visitor:

- if the link points to a page in a space to which the visitor does not have 'View' space permission, the link will not be rendered at all.
- if the visitor has 'View' space permission, but page restrictions prohibit her from viewing the page, the link will be rendered but an 'Access Denied' message will be displayed when she clicks the link.
- if the visitor has 'View' space permission, and is not restricted from viewing the page, the link will display and behave as normal.

Links to attachments are also affected: If the visitor does not have permission to view the page to which the attachment is attached, the link will not be rendered.

Page Restrictions

Page restrictions allow you to control who can view or edit individual pages. You set the page restrictions using the Page Restrictions dialog, either directly by choosing Tools > Restrictions, or when editing a page.

For instructions on using the Page Restrictions dialog, refer to Setting a Page's Restrictions.

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed.

On this page:
- The Confluence Permissions and Page Restrictions Hierarchy
- Requirements for Setting Restrictions
- Page Security Rules
- Inherited Restrictions and Child Pages
- Example of Child Page Restrictions
- How to Open Part of a Space
- Related Topics

Screenshot: The Confluence Page Restrictions dialog
The Confluence Permissions and Page Restrictions Hierarchy

Permissions and page restrictions in Confluence work within a hierarchical manner. For example, users who can access and modify global permissions (for instance, Confluence Administrators) can define which users can access and modify space level permissions (that is, space administrators). Space administrators can then define which users have access to create and modify pages. These users in turn can then apply viewing and editing restrictions to a page. By inheritance, these restrictions will also be applied to any child or descendant pages which are then added to that page.

See the diagram below for an illustration.

*Diagram: Confluence Restrictions Hierarchy*
Requirements for Setting Restrictions

In order to set or modify page restrictions, you need to have both:

- 'Restrict Pages' permission in the space to which the page belongs (since page restrictions operate within the bounds of space permissions).
- Permission to edit the page itself. That is, if a user is prevented from editing a page through page restrictions, they are also prevented from changing the restrictions themselves.

Page Security Rules

Users can only view page or space content for which they (or a group they are in) have 'View' permission. Pages that a user does not have 'View' access to are referred to as 'inaccessible' pages. Visit Inaccessible Page to see how Confluence deals with pages a user cannot view:

- Anonymous users are directed to the login page.
- Logged-in users are shown a permissions error page.
It is not possible to conceal the existence of pages, though you can restrict 'View' access to page content. Users will still be able to find the page if they know its URL. But they will not be able to view the content if they don't have the correct permissions.

**Inherited Restrictions and Child Pages**

If a page has its 'View' restriction set, that restriction will be inherited by all its children (and their children, and so on). If a 'View' restriction is added to a page that has already inherited page restrictions from its parent, users must satisfy both restrictions in order to see the page.

'EEdit' restrictions are not inherited from the parent page, only from the space. In a space, the 'Add Pages' permission governs both the creation and the editing of pages. See [Space Permissions Overview](#).

**Example of Child Page Restrictions**

Consider the page 'Documents', with a child page 'Executive', which itself has a child page 'Payroll'. To begin with, anyone who can view the space to which these pages belong can see all three pages.

For security reasons, 'View' restrictions are set on the 'Executive' page, restricting it to the 'mycompany-management group'. At this point, anyone can still see the 'Documents' page, but you must be in the 'mycompany-management group' in order to view either 'Executive' or 'Payroll'.

Since 'Payroll' information is considered particularly private, the 'Payroll' page then has its page restrictions set to only allow members of the 'mycompany-financial' group to view it. At this point, anyone can see the 'Documents' page, only members of 'mycompany-management' can see 'Executive', and only users who are members of both the 'mycompany-management' and 'mycompany-financial' groups can view 'Payroll'.

**How to Open Part of a Space**

If designing a large site implementation with this strategy, consult [Page Restrictions](#) and [Performance Considerations](#).

Often there are cases for which a section of a space should be opened to a group or set of users (for this example, we'll call them group B), but the rest of the space should not be visible to your main users (for this example, we'll call them group A). In this case:

1. Add 'view' permission for both groups A and B in [space permissions](#).
2. Move the page to be opened to the root of the space. When browsing the pages in the space, your normal space home page and this page should both be at the root level.
3. Add a page restriction to allow Group A and B to see this page.
4. Add a page restriction to your main landing page for Group A, thereby excluding this set of pages from Group B.

You can repeat this with any page hierarchy.

**Administrators**

- Space administrators are responsible for the management of a space and its contents. They therefore have the ability to remove all restrictions from a page (as described in 'Viewing Restricted Pages'). This means that space administrators can view and edit all content in the space.
- Users who are members of the 'confluence-administrators' group ('super-users') cannot immediately see pages from which they are excluded by page restrictions. Also, to be able to edit the page, you will need to remove the restriction from it first – go to [Space Administration > Restricted Pages](#).
You cannot exclude yourself

As creator or editor of a page, you cannot use page restrictions to deny yourself access to the page. Confluence will automatically add your username into the list of users/groups allowed to view/edit the page. If you remove your username, Confluence will put it back again.

Related Topics

View a Page's Restrictions
Set a Page's Restrictions
View All Restricted Pages
Page Restrictions Performance Considerations

Working with Pages

Take me back to the Confluence User's Guide.

Setting a Page's Restrictions

Page restrictions control who may view or edit a specific page, within the bounds of the space permissions:

- View restrictions make the page invisible to everyone except the chosen users and groups.
- Edit restrictions prevent everyone except the chosen users and groups from editing the page.

You can restrict the page to as many users and groups as you like.

In order to set or modify page restrictions, you need to have the 'Restrict Pages' permission in the space to which the page belongs, as well as permission to edit the page itself.

Setting Page Restrictions

To set restrictions on a page:

1. Choose Tools > Restrictions. The Page Restrictions dialog opens. You can also click the padlock icon in the page's byline (if available), or click either Unrestricted or Restricted when editing the page.
2. Select the restriction option required.
3. Choose the users and groups who you want to be able to view or edit the page:
   - To choose just yourself, click Me.
   - To choose a particular user or group, type the user's username (or their full name), or the group name, into the Enter ... name box, and click Restrict. You can enter multiple user and group names, when separated by commas.
   - To search for a user or group (if you are unsure of the name), click Person... or Group... (You can read more about searching for users.)
4. Click Save.

Screenshot: The Confluence Page Restrictions dialog
Removing Page Restrictions

To remove restrictions on a page:

1. Choose Tools > Restrictions. The Page Restrictions dialog opens. You can also click the padlock icon in the page's byline (if available), or click either Unrestricted or Restricted when editing the page.
2. Click Remove restriction next to the appropriate users or groups.
3. Click Save.

You can both set and remove restrictions for different users or groups when using the Page Restrictions dialog.

Notes

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed.

View and edit restrictions apply to all users including space administrators. However, space administrators can remove any restriction on a page. See Viewing Restricted Pages.

Related Topics

- Space Permissions Overview
- Viewing a Page's Restrictions
- Viewing Restricted Pages
- Working with Pages

Take me back to the Confluence User's Guide.

Viewing a Page's Restrictions

Viewing page restrictions in View mode

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed. See Setting a Page's Restrictions for instructions on how to change these.

Viewing page restrictions in Edit mode

You can view a page's restrictions when editing the page. You can only edit the page if you have permissions to do so.
To view the restrictions that apply to a page:

- When editing the page, click **Restrictions**. See [Setting a Page's Restrictions](#) for instructions on how to change these.

**Related Topics**

- [Setting a Page's Restrictions](#)
- [Viewing Restricted Pages](#)
- [Working with Pages](#)

Take me back to the [Confluence User's Guide](#).

**Viewing Restricted Pages**

Restricted pages are pages that have ‘View’ or ‘Edit’ restrictions applied to them through **page-level restrictions**.

You need to be a **space administrator** to view the list of restricted pages in a space.

To view restricted pages:

1. Choose **Browse > Space Admin** for the space.
2. Click **Restricted Pages** in the left panel under ‘Security’. A list of all restricted pages in the space is displayed.
3. Click on the ‘lock’ icon to remove restrictions for the page.

Here’s an example:

![Restricted Pages](#)

**Related Topics**

- [Viewing a Page's Restrictions](#)
- [Setting a Page's Restrictions](#)
- [Working with Pages](#)

Take me back to the [Confluence User's Guide](#).
Site Administrators and their Permissions

All site administrative functions are performed from the Administration Console. You need ‘System Administrator’ or ‘Confluence Administrator’ permissions to access the Administration Console.

The Confluence permission scheme allows the following levels of site administrator permissions, with the most powerful at the top of the list:

- **Super user** – A ‘super user’ belongs to the `confluence-administrators` group, has full administrative access to Confluence, and can see all the content.
- **System Administrator** – A person with ‘System Administrator’ permission has full administrative access to Confluence.
- **Confluence Administrator** – A person with ‘Confluence Administrator’ permission has access to most of the Confluence administrative functions.

⚠️ Some functionality described on this page is restricted in Confluence OnDemand.

Please refer to the overview of global permissions for full details.

Related Topics

- Users and Groups
- Confluence User’s Guide

Contacting Confluence Administrators

If you receive an error message from Confluence, the error page may offer you a link to click in order to contact the administrators of the Confluence site.

When you click the link to contact the Confluence administrators, you will see an administrator contact page with the title ‘Contact Site Administrators’. By default, the administrator contact page looks like the screenshot below.

**Screenshot: The administrator contact screen**

The screen may look different

In certain configurations of Confluence, you will not be able to use the form shown in the screenshot above. Instead, you will see a message telling you about one of the following conditions:
• If your Confluence administrator has not configured a mail server for Confluence, this means that Confluence will not be able to send an email message to the administrators.
• If none of the Confluence administrators has an email address, Confluence will not be able to send an email message to them.
• If there are no Confluence administrators defined to Confluence, Confluence will not be able to send an email message to them.
• The Confluence administrator can disable the form and specify a different message to be displayed on the above screen instead of the default message and form. See the administrator’s guide.

Related Topics

Configuring the Administrator Contact Page

Space Administrators and their Permissions

A space administrator is a user with the ‘Space Admin’ permission for a space. This permission itself is assigned from the Space Administration screens by a space administrator.

Who is a space administrator?

The person who creates a space is automatically the administrator of that space. That person can then assign other space administrators as required.

Confluence administrators are not necessarily space administrators.

• A user who has the ‘Administer Confluence’ permission is not automatically a space administrator for a particular space. In order for them to be a space administrator, they must belong to a group which has space administration rights on the space, or their username must be specifically granted space administration rights on the space.
• Users who are members of the 'confluence-administrators' group do automatically have space administration permissions for all spaces.

Refer to the Administrator’s Guide for more details about Confluence administrator permissions.

What can a space administrator do?

A space administrator has permission to do anything in the space regardless of any other setting. Space administrators are responsible for the management of a space and its contents. Note that page permissions affect space administrators differently from other users.

Space administrators can:

• view all content in the space. If there are page permissions that restrict the viewing of a page to a single user, or to a group to which the space administrator doesn’t belong, a space administrator can still view the page by removing the restriction.
• edit all content on any page in the space.
• remove restrictions from any page in the space (using the Space Administration interface).
• manage the watchers for any page in the space (but not watchers of the space).
• grant themselves any other space permissions (e.g. permission to set restrictions on a particular page).

All space administration functions, with the exception of managing watchers, are performed from the 'Space Admin' tab (choose Browse > Space Admin). You need to be a space administrator to access the Space Administration screens.

Related Topics

Space Permissions Overview

Take me back to Confluence User's Guide
Space Permissions Overview
Every space has its own independent set of permissions. Space permissions can only be granted by a space administrator. A space administrator has permission to do anything in the space regardless of any other setting.

Permissions can be assigned to any group, to any individual user in the Confluence-User group, and to users in the Anonymous group.

These are the permissions that can be assigned at the space level:

- **View**: user can view this space's content, including the space's details, and its pages and news items (blog posts)
- **Pages**:
  - Add – user may create and edit pages in this space.
  - Export – user may export pages in this space.
  - Restrict – user may apply page-level restrictions.
  - Remove – user may remove pages in this space.
- **Blog**:
  - Add – user may add and edit blog posts in this space.
  - Remove – user may remove blog posts in this space.
- **Comments**:
  - Add – user may make comments in this space.
  - Remove – user may remove comments from this space.
- **Attachments**:
  - Add – user may add attachments in this space.
  - Remove – user may remove attachments from this space.
- **Mail**:
  - Remove – user may delete individual mail items.
- **Space**:
  - Export – user may export content from this space.
  - Admin – user has administrative permissions over this space.

Related pages:
- Space Administrators and their Permissions
- Users and Groups
- Assigning Space Permissions
- Page Restrictions
- Confluence User's Guide

Notes

**Warning**: If you deny all administrative access to a space by mistake, so that nobody has access to administer the space any more, you will need to ask someone in the confluence-administrators group to fix the permissions for you.

Assigning Space Permissions
You can assign space permissions to groups or to individual users. You need to be a space administrator to assign space permissions. In addition, Confluence administrators can set the default permissions that will be applied to new spaces as described below.

To access the permissions for a space:

1. Go to the ‘Space Permissions’ view. To do this:
   a. Go to a page in the space where you want to view or assign permissions.
   b. Choose Browse > Space Admin.
      (You will see the ‘Space Admin’ option only if you are a space administrator of the current space.)
c. Click **Permissions** in the 'Security' section of the left-hand panel.

2. Click **Edit Permissions**.

The 'Edit Space Permissions' screen appears. It has the following sections:

- Groups – a list of groups which already have permissions to access the site.
- Individual Users – a list of users who already have permissions to access the site.
- Anonymous Access – the space permissions granted to all anonymous users of the site.

**On this page:**

- Assigning space permissions to groups
- Assigning space permissions to users
- Assigning space permissions to anonymous users
- Setting default space permissions

**Related pages:**

- Space Permissions Overview
- Users and Groups
- Confluence User's Guide

**Screenshot: Editing space permissions**

Assigning space permissions to groups

- To assign a permission, check the box next to the relevant group.
- To deny a permission, uncheck the relevant box.
To add a new group to the list, type the group name into the text box in the 'Groups' section and click **Add**. The group will appear in the list of groups. You can then assign the permissions.

To search for a group:
- Click the **icon**.
- The **Group Search** window opens. Enter all or part of the group name. You can use an asterisk "*" as a wild card.
- Check the boxes to select the required group(s).
- Click **Select Groups**. The group name(s) will appear in the text box in the 'Groups' section.
- Click **Add**.

To bulk assign or revoke group member permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Click **Save All** to apply the changes.

**Assigning space permissions to users**

- To assign a permission, check the box next to the relevant user.
- To deny a permission, uncheck the relevant box.
- To add a new user to the list, type the username into the text box in the 'Individual Users' section and click **Add**. The user will appear in the list of users, with 'View' permission assigned. You can then add more permissions if necessary.
- To search for a user:
  - Click the **icon**.
  - The **User Search** window opens. You can read more about searching for users.
  - Check the boxes to select the required user(s).
  - Click **Select User(s)**. The username(s) will appear in the text box in the 'Individual Users' section.
  - Click **Add**.

To bulk assign or revoke individual user permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Click **Save All** to apply the changes.

**Assigning space permissions to anonymous users**

- To assign a permission, check the box for the required permission.
- To deny a permission, uncheck the relevant box.
- To bulk assign or revoke anonymous user permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Click **Save All** to apply the changes.

**Note**: You cannot grant space administration rights or page restriction rights to anonymous users.

**Setting default space permissions**

If you have **Confluence Administrator** permission, you can set the default permissions that will be applied to new spaces. The default permissions are configurable for groups only, not for individual users or anonymous users.

**To set the default space permissions:**

1. Choose **Browse > Confluence Admin**.
2. Choose **Space Permissions** in the left-hand column.
3. Choose **Edit Permissions**.

**Screenshot: Default space permissions**
Users and Groups

A 'user' is the account for an individual who accesses Confluence.

New users are created by a Confluence administrator via the Administration Console. See Searching For and Administering Users for more information.

A Confluence administrator can also group users together into user groups for more convenient administration. This means that any permissions you assign at the site, space and page levels can be assigned to a whole group. A user in one of these groups will automatically be granted all permissions granted to the group.

There are two special groups in Confluence:

- **Confluence-Administrators** - This is a 'super-group' and a user from this group has permission to do anything in the site regardless of any other setting.
- **Confluence-Users** - This is the default group into which all new users are assigned. Permissions you assign to this group will be assigned to all newly signed-up users of Confluence.

Anonymous Users

Confluence treats all users who do not log in when they access Confluence as being 'Anonymous'. Administrators can assign permissions to this group separately.

Overlapping group and user permissions

When a user is assigned more than one permission, the most powerful permission will prevail.

Further explanation:

- A user may be assigned a permission specifically to their username. They may also be assigned a permission by belonging to a group, or even several groups.
- The user will then be able to perform all functions assigned to them.
- So if a user is allowed to do something over and above what the group can do, the user will be able to do it. And if the group is allowed to do something over and above the specific permissions granted to the user, the user will still be able to do it.
Managing Confluence Users

Confluence User's Guide

Searching for Users

This page describes how to use the 'User Search' window, which appears when you click Choose Users or a user search icon on a Confluence page.

On this page:

- Accessing the User Search
- Using the Simple User Search
- Using the Advanced User Search
- Searching for Users in One or More Groups
- Selecting One or More Users
- Notes
- Related Topics

Accessing the User Search

To access the 'User Search' window:

1. Click the user search link or icon when you are performing one of the following actions:
   - When assigning space permissions, click the icon in the users section.
   - When adding members to a group, click the icon.
2. The simple 'User Search' window will appear, as shown below.

Using the Simple User Search

To search via the simple user search:

1. Select the User tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. If the Simple link is showing, click it. (If you see the Advanced link instead, then you're fine. The simple search is already active.)
3. The simple user search screen will appear, as shown below.
4. Type some information about the user into the 'Search' box. You can type all or part of their username, full name or email address.
5. Click Search.
6. Confluence will return a list of matching users. See below for instructions on selecting one or more users.

Screenshot: Simple user search

Using the Advanced User Search

To search via the advanced user search:

1. Select the Advanced tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. If the Advanced link is showing, click it. (If you see the Simple link instead, then you're fine. The advanced search is already active.)
3. The advanced user search screen will appear, as shown below.
4. Type some information about the user into the 'Search' box. You can type all or part of their username, full name or email address.
5. Click Search.
6. Confluence will return a list of matching users. See below for instructions on selecting one or more users.
The advanced user search allows you to specify the field in which your search term appears, i.e. username, full name or email address. You may find this useful if you need to limit the number of users appearing in the search results.

To search via the advanced user search:

1. Select the User tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. If the Advanced link is showing, click it. (If you see the Simple link instead, then you’re fine. The advanced search is already active.)
3. The advanced user search screen will appear, as shown below.
4. Complete one or more of the following fields:
   - **User Name** — Enter all or part of the person's username i.e. their login id, e.g. 'joe', or 'bloggs'.
   - **Full Name** — Enter all or part of the person's name, e.g. 'joe bloggs', or 'bloggs', or 'joe'.
   - **E-Mail** — Enter all or part of the person's email address, e.g. 'acme'
5. Click Search.
6. Confluence will return a list of matching users. See below for instructions on selecting one or more users.

Screenshot: Advanced user search

Searching for Users in One or More Groups

You can also list the users who appear in a particular group or in a set of groups.

To search for users in a particular group:

1. Select the Membership tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. The 'Group Membership' search screen will appear, as shown below.
3. Type all or part of a group name into the 'Search' box.
4. Click Search.
5. Confluence will return a list of users belonging to any groups which match your search term.
6. Now you can select one or more users, as described below.

Screenshot: Searching for users in a group
Selecting One or More Users

After searching for users and receiving a list of names from Confluence, as described above, you can now select the user(s) you need.

To select one or more users:

1. Click the box next to the username(s) to select or unselect one or more users. You can click Check All to select or unselect all users.
2. Click Select User(s).
3. The 'User Search' window will close and the selected users will appear on the screen which you were using before you accessed the user search.
Notes

- **Case sensitivity**: The search is not case sensitive. You can enter either upper- or lower-case text, and it will make no difference to the search results.
- **Wild cards**: The search allows the asterisk as a wild card, but you do not need to use it. The search results will be the same whether you use a wild card or not. The wildcard functionality remains available for compatibility with older versions of Confluence.
- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence **internal directory** and also connect to an **LDAP directory server**. In such cases, you can define the **directory order** to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#).

- **Crowd and the user search**: If you are using Atlassian's **Crowd** for user management, you will need [Crowd 1.5.1 or later](#) to use the ‘Simple’ option in the user search. If your version of Crowd does not support the simple user search, you will see only the ‘Advanced’ search form.

Related Topics

- Searching Confluence
- Setting a Page’s Restrictions
- Assigning Space Permissions
- Adding or Removing Users in Groups

Take me back to [Confluence User’s Guide](#).

Using Confluence on a Mobile Device

When you view a Confluence page on a mobile device, such as an iPhone or an iPad, Confluence will display an optimised version of the page. This is Confluence mobile.

On your phone or other supported mobile device, you can:

- View the Confluence dashboard, pages, blog posts, and user profiles.
- Add a comment to a page or blog post.
- Like a page, blog post or comment.
- Manage your personal tasks and notifications.

You cannot add or edit pages or blog posts, or edit existing comments, using the mobile interface.

See [Supported Platforms](#) for details of supported mobile devices.

The dashboard – the first thing you see

*Screenshot: The dashboard in Confluence mobile*
Choose a tab to see:

- Popular content – what people like in your wiki.
- Recent blogs – the latest blog posts.
- Network – updates by people in your network.

Tap the links to view the full content of a page, blog post or comment.

**Searching for content and people**

Tap the menu icon to open the menu panel on the left of the page. Then type text or a person's name in the Search box. The mobile interface offers the quick navigation search, which returns matches on page title only. (See Searching Confluence.) To use the full search, switch to desktop mode.

**Screenshot: The menu panel in Confluence mobile**

Viewing pages, blog posts and comments

Tap a link on the dashboard or on any other page. Confluence will display the linked page, blog post or comment.

You can:
- View the content, tap a link to move to another page, and interact with the page using the standard functionality supported by mobile browsers.
- Like or unlike a page, blog post or comment.
- Add a comment. Confluence mobile supports plain-text comments only.

*Screenshot: A page with a 'Like' button and a comment box*

### Chocolate

**By Sarah Maddox**

9 minutes ago

The food of technical writers everywhere.

![Like button](image)

Yum

![Save button](image)

### Viewing people's profiles

Search for a person's name, then view that person's user profile. Tap the options to phone, SMS or email a colleague directly from your mobile device.

*Screenshot: A user profile on Confluence mobile*

### Following up on notifications

You can view and respond to your notifications on your phone or other mobile device. Tap the menu icon

---

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
to open the menu panel on the left of the page. Choose Notifications, and tap a notification to see its details. You can reply, watch or like via the inline actions. Tap Open to open the page or blog post in a new page. For full details, see Managing Notifications in Confluence.

Screenshot: Notifications in Confluence mobile

Managing tasks

You can view and manage your tasks on your phone or other mobile device too. Tap the menu icon to open the menu panel on the left of the page. Choose Tasks, and tap the plus sign to add a new task. Tap a task to see its details. You can add notes, complete a task, and tap a link to open the related page. For full details, see Managing Tasks in Confluence.

Screenshot: Tasks in Confluence mobile
More things you may need to know

See Notes about Confluence Mobile.

Related pages

- Dashboard
- Supported Platforms
- Managing Notifications in Confluence
- Managing Tasks in Confluence
- Confluence User's Guide

Notes about Confluence Mobile

When you view a Confluence page on a mobile device, such as an iPhone or an iPad, Confluence will display an optimised version of the page. This is Confluence mobile.

For a summary of mobile features, see Using Confluence on a Mobile Device. Below are additional notes that you will find useful.

On this page:

- Some macros may not work
- You can swap from mobile to standard Confluence and back again
- Confluence chooses the mobile or desktop interface based on your device
- Administrators can disable Confluence mobile on your site
- Confluence mobile is a web interface, not a native app
- Related pages

Some macros may not work

Confluence macros are not yet fully supported in Confluence mobile. If you view a page that contains an unsupported macro, you will see a message inviting you to click through to the desktop version of the page.

Screenshot: Macro not rendered in Confluence mobile
You can swap from mobile to standard Confluence and back again

You can swap from the mobile view to the standard view of a page at any time. Choose the menu icon then choose **Switch to desktop version**.

*Screenshot: The menu panel in Confluence mobile*

You can also swap from the desktop view to the mobile view, if you are on a mobile device. Choose the option **Switch to Confluence Mobile** at the top of the window.

*Screenshot: Option to switch to Confluence mobile*

Confluence chooses the mobile or desktop interface based on your device

Confluence mobile supports iOS and Android devices. For specific versions, see [Supported Platforms](#).

**Administrators can disable Confluence mobile on your site**

The mobile functionality is provided by a plugin called the 'Confluence Mobile Plugin'. To remove the functionality from your site, you can disable the plugin. See [Disabling or Enabling a Plugin](#).

**Confluence mobile is a web interface, not a native app**

Atlassian does not supply a native mobile application that you can download and install onto your mobile device. Confluence mobile is a web-based user interface that the Confluence server displays when it detects a mobile client.
Related pages
- Using Confluence on a Mobile Device
- Dashboard
- Supported Platforms
- Confluence User's Guide

Advanced and Special Uses of Confluence
This section describes the more advanced features of Confluence, and gives guidelines on some specific uses of the wiki.

Confluence markup formats
The syntax and usage of Confluence wiki markup and the Confluence XHTML-based storage format – see Working with Confluence Markup.

Gadgets
How to add gadgets to a wiki page, or use Confluence gadgets on other sites – see Working with Confluence Gadgets.

Using Confluence for technical documentation
A technical communicator's guide to using Confluence – see Developing Technical Documentation on Confluence Wiki.

Setting up a knowledge base
A support engineer's guide to using Confluence as a knowledge base – see Developing a Knowledge Base on Confluence Wiki.

Setting up an intranet
A quick guide to setting up an intranet wiki – see Developing an Intranet on Confluence Wiki.

Working with Confluence Markup
This section describes two types of markup found in Confluence:

- **Confluence storage format.** Confluence stores the content of pages and blog posts in an XHTML-based format. Advanced users can view the storage format of a page and even edit it, provided their Confluence site is configured to allow that. See Confluence Storage Format for a description of the core elements of the storage format. For details of the elements used to define a macro, see Confluence Storage Format for Macros.

- **Wiki markup.** Confluence allows data entry via a shorthand code called wiki markup. Some parts of the Confluence administration interface also accept wiki markup for defining content. For a description of the wiki markup syntax, see Confluence Wiki Markup. For details of the wiki markup used to define Confluence macros, see Confluence Wiki Markup for Macros.

Related pages:
- Installing Plugins and Macros
- Working with Macros
- Confluence User's Guide
A request from the Atlassian technical writers about comments and feedback: When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we’ve missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks.

Confluence Storage Format

This page describes the XHTML-based format that Confluence uses to store the content of pages, page templates, blog posts and comments. This information is intended for advanced users who need to interpret and edit the underlying markup of a Confluence page.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Notes:

- You can view the Confluence storage format for a given page by choosing Tools > View Storage Format. This option is only available if one of the following is true:
  - You are a Confluence administrator.
  - Your Confluence site has the Confluence Source Editor plugin installed and you have permission to use the source editor.

- If you would like to edit the storage format for a page, your Confluence system administrator will need to install the Confluence Source Editor plugin.
- Clarification of terminology: If you choose Tools > View Source, you will see the format used within the editor panel, not the storage format of the page.

- A request from the Atlassian technical writers about comments and feedback: When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we’ve missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks.

On this page:

- Macros
- Headings
- Text effects
- Text breaks
- Lists
- Links
- Images
- Tables
- Page layouts
- Emoticons
- Resource identifiers
- Template variables

Related pages:

- Confluence Storage Format for Macros
- Feedback on Confluence Storage Format
- Working with Confluence Markup

Macros
### Headings

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 1</td>
<td>h1. Heading 1</td>
<td><code>&lt;h1&gt;H&lt;br eadin&lt;br g&lt;br 1&lt;/h1&gt;</code></td>
<td><strong>Heading 1</strong> Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 2</td>
<td>h2. Heading 2</td>
<td><code>&lt;h2&gt;H&lt;br eadin&lt;br g&lt;br 2&lt;/h2&gt;</code></td>
<td><strong>Heading 2</strong> Underlined in the Documentation Theme</td>
</tr>
<tr>
<td>Heading 3</td>
<td>h3. Heading 3</td>
<td><code>&lt;h3&gt;H&lt;br eadin&lt;br g&lt;br 3&lt;/h3&gt;</code></td>
<td><strong>Heading 3</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Headings 4 to 6 are also available and follow the same pattern</td>
</tr>
</tbody>
</table>

### Text effects

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>strong/bold</td>
<td><em>strong</em></td>
<td>strong</td>
<td><code>&lt;strong&gt;</code> will also work but get converted to <code>&lt;strong&gt;</code> upon saving</td>
</tr>
<tr>
<td>------------</td>
<td>---------</td>
<td>--------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>emphasis</td>
<td><em>emphasis</em></td>
<td>emphasis</td>
<td><code>&lt;em&gt;</code> will also work but get converted to <code>&lt;em&gt;</code> upon saving</td>
</tr>
<tr>
<td>strikethrough</td>
<td><code>&lt;del&gt;</code></td>
<td>strikethrough</td>
<td><code>&lt;s&gt;</code> and <code>&lt;del&gt;</code> will also work</td>
</tr>
<tr>
<td><strong>underline</strong></td>
<td>+underline+</td>
<td><strong>underline</strong></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>---------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>&lt;u&gt;underline&lt;/u&gt;</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>superscript</strong></th>
<th>^superscript^</th>
<th><strong>superscript</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>&lt;sup&gt;superscript&lt;/sup&gt;</code></td>
<td></td>
</tr>
<tr>
<td>subscript</td>
<td><del>subscript</del></td>
<td>subscript</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td><code>&lt;sub&gt;script&lt;/sub&gt;</code></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>monospace</th>
<th>{{monospaced}}</th>
<th>monospaced</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>&lt;code&gt;monospaced&lt;/code&gt;</code></td>
<td></td>
</tr>
<tr>
<td>preformatted</td>
<td>n/a</td>
<td>preformatted text</td>
</tr>
<tr>
<td>--------------</td>
<td>-----</td>
<td>-------------------</td>
</tr>
</tbody>
</table>

```xml
<pre>
preformatted text
</pre>
```
**block quotes**

```html
<blockquote>
  block quote
  or
  {quote}
</blockquote>

{quote}
```

```html
{quote}
```
<table>
<thead>
<tr>
<th>text colour</th>
<th>{color:red} red text{color}</th>
<th>red text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>&lt;span style=&quot;color:rgb(255,0,0);&quot;&gt;red text&lt;/span&gt;</code></td>
<td></td>
</tr>
<tr>
<td>small</td>
<td>n/a</td>
<td>small text</td>
</tr>
<tr>
<td>-------</td>
<td>-----</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;small&gt;</code> small text <code>&lt;/small&gt;</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>big</th>
<th>n/a</th>
<th>big text</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><code>&lt;big&gt;</code> big text <code>&lt;/big&gt;</code></td>
</tr>
<tr>
<td>right-align</td>
<td>n/a</td>
<td>right aligned text</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>&lt;p style=&quot;text-align: right;&quot;&gt;right aligned text&lt;/p&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Text breaks**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
## New paragraph

<table>
<thead>
<tr>
<th>Paragraph 1</th>
<th>Paragraph 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty line)</td>
<td></td>
</tr>
</tbody>
</table>

## Line break

<table>
<thead>
<tr>
<th>Line 1 \ Line 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
</tr>
<tr>
<td>&lt;br /&gt;Line 2</td>
</tr>
</tbody>
</table>

Note: Created in the editor using Shift + Return/Enter

## Horizontal rule

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>------</td>
</tr>
<tr>
<td>&lt;hr /&gt;</td>
</tr>
</tbody>
</table>

## — symbol

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>------</td>
</tr>
<tr>
<td>—</td>
</tr>
</tbody>
</table>

## – symbol

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>----</td>
</tr>
<tr>
<td>—</td>
</tr>
</tbody>
</table>

## Lists

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unordered list – round bullets</td>
<td>* Round bullet list item</td>
<td>&lt;ul&gt;&lt;li&gt;round bullet list item&lt;/li&gt;&lt;/ul&gt;</td>
<td>• Round bullet list item</td>
</tr>
</tbody>
</table>
### Unordered list – squarebullets

- Square bullet list item

```html
<ul style="list-style-type:square;">
  <li>square bullet list item</li>
</ul>
```

### Ordered list (numbered list)

# Ordered list item

```html
<ol>
  <li>numbered list item</li>
</ol>
```

## Links

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to another Confluence page</td>
<td>[Link to another Confluence page</td>
<td>Page Title]</td>
<td>[Link to another Confluence page]</td>
</tr>
</tbody>
</table>
A note about link bodies

All links received from the editor will be stored as plain text by default, unless they are detected to contain the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link bodies.

For rich content like images, you need to use ac:link-body to wrap the contents.

<table>
<thead>
<tr>
<th>Link with an embedded image for the body</th>
<th><img src="http://confluence.atlassian.com/images/logo/confluence_48_trans.png" alt="google.png" /></th>
</tr>
</thead>
</table>

For rich content like images, you need to use ac:link-body to wrap the contents.
An example of different link bodies

```xml
<ac:link>
  <!-- Any resource identifier -->
  <ri:page ri:content-title="Home" ri:space-key="SANDBOX" />
  <ac:link-body>Some <strong>Rich</strong> Text</ac:link-body>
</ac:link>

<ac:link>
  <ri:page ri:content-title="Plugin developer tutorial stuff" ri:space-key="TECHWRITING" />
  <ac:plain-text-link-body><![CDATA[A plain <text> link body]]></ac:plain-text-link-body>
</ac:link>

<ac:link>
  <ri:page ri:content-title="Plugin developer tutorial stuff" ri:space-key="TECHWRITING" />
  <!-- A link body isn't necessary. Auto-generated from the resource identifier for display. -->
</ac:link>
```

The markup tags permitted within the `<ac:link-body>` are `<b>`, `<strong>`, `<em>`, `<i>`, `<code>`, `<tt>`, `<sub>`, `<sup>`, `<br>` and `<span>`.

**Images**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached image</td>
<td><img src="attachment" alt="atlassian_log o.gif!" /></td>
<td><img src="attachment" alt="attachment" /></td>
<td><img src="attachment" alt="attachment" /></td>
</tr>
</tbody>
</table>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
<tr>
<td>ac:thumbnail</td>
<td>Set to &quot;true&quot; to designate this image as a thumbnail.</td>
</tr>
<tr>
<td>ac:alt</td>
<td>alt text</td>
</tr>
<tr>
<td>ac:height</td>
<td>image height</td>
</tr>
<tr>
<td>ac:width</td>
<td>image width</td>
</tr>
<tr>
<td>ac:vspace</td>
<td>the white space on the top and bottom of an image</td>
</tr>
<tr>
<td>ac:hspace</td>
<td>the white space on the left and right of an image</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Two column, two row (top header row)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Table Heading Cell 1</td>
<td>Table Heading Cell 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
<td></td>
</tr>
</tbody>
</table>

```
<table>
	<thead>
		<tr>
		<th>Table Heading Cell 1</th>
		<th>Table Heading Cell 2</th>
	</tr>
</thead>
<tbody>
	<tr>
		<td>Normal Cell 1</td>
		<td>Normal Cell 2</td>
	</tr>
</tbody>
</table>
```
Two column, three rows, 2nd and third with merged cells in first row

<table>
<thead>
<tr>
<th>Table Headings</th>
<th>Table Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge Cell</td>
<td>Normal Cell 1</td>
</tr>
<tr>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
</tr>
</tbody>
</table>

```html
<table>
  <tbody>
    <tr>
      <th>Table Heading Cell 1</th>
      <th>Table Heading Cell 2</th>
    </tr>
    <tr>
      <td rowspan="2">Merged Cell</td>
      <td>Normal Cell 1</td>
    </tr>
    <tr>
      <td>Normal Cell 2</td>
    </tr>
  </tbody>
</table>
```
**Page layouts**

Confluence supports page layouts directly, as an alternative to macro-based layouts such as those using the section and column macros. This section documents the storage format XML created when these layouts are used in a page.

**Notes:**

- Page layouts were introduced in Confluence 4.2, and are not available in earlier versions of Confluence.
- The word `{content}` in the layouts below indicates where further XHTML or Confluence storage format block content would be entered, such as `<p>` or `<table>` tags.

<table>
<thead>
<tr>
<th>Layout Type</th>
<th>In Confluence 4.2 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Two columns</strong></td>
<td></td>
</tr>
</tbody>
</table>

```xml
<div class="contentLayout" data-atlassian-layout="{"name":"pagelayout-two-simple","columns":[]}">
  <div class="columnLayout twoColumns">
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
</div>
```
Three columns

```html
<div class="contentLayout" data-atlassian-layout="{"name": "pagelayout-three-simple", "columns": ["", ""]}">
  <div class="columnLayout threeColumns">
    <div class="cell">
      <div class="innerCell">{content}</div>
    </div>
    <div class="cell">
      <div class="innerCell">{content}</div>
    </div>
    <div class="cell">
      <div class="innerCell">{content}</div>
    </div>
  </div>
</div>
```
Two columns with header and footer

```html
<div class="contentLayout"
    data-atlassian-layout="{"name":"pagelayout-two","columns":[$""],"header":true,"footer":true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout twoColumns">
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
Left sidebar with header and footer

```html
<div class="contentLayout"
data-atlassian-layout="{"name":"pagelayout-two-left","columns":["aside","large"],"header":true,"footer":true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout twoColumns">
    <div class="cell aside">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell large">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
<div class="contentLayout"
data-atlassian-layout="{"name":"pagelayout-two-right","columns":{"large","aside"},"header":true,"footer":true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout twoColumns">
    <div class="cell large">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell aside">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
Three columns with header and footer

```html
<div class="contentLayout"
    data-atlassian-layout="{"name":"pagelayout-three","columns":["","",""],"header":true,"footer":true}"
>
    <div class="header">
        <div class="innerCell">
            {content}
        </div>
    </div>

    <div class="columnLayout threeColumns">
        <div class="cell">
            <div class="innerCell">
                {content}
            </div>
        </div>
        <div class="cell">
            <div class="innerCell">
                {content}
            </div>
        </div>
        <div class="cell">
            <div class="innerCell">
                {content}
            </div>
        </div>
    </div>

    <div class="footer">
        <div class="innerCell">
            {content}
        </div>
    </div>
</div>
```
### Left and right sidebar with header and footer

```html
<div class="contentLayout"
data-atlassian-layout="{&quot;name&quot;:&quot;pagelayout-three-sidebars&quot;,&quot;columns&quot;:[&quot;sidebars&quot;,&quot;large&quot;,&quot;sidebars&quot;],&quot;header&quot;:true,&quot;footer&quot;:true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout threeColumns">
    <div class="cell sidebars">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell large">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell sidebars">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```

### Emoticons

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emoticons</td>
<td>:)</td>
<td>&lt;ac:emoticon ac:name=&quot;smile&quot; /&gt;</td>
<td>😊</td>
</tr>
</tbody>
</table>

---

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Emotion</th>
<th>Emoticon Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sad</td>
<td><code>&lt;ac:emoticon ac:name=&quot;sad&quot; /&gt;</code></td>
</tr>
<tr>
<td>Cheeky</td>
<td><code>&lt;ac:emoticon ac:name=&quot;cheeky&quot; /&gt;</code></td>
</tr>
<tr>
<td>Laugh</td>
<td><code>&lt;ac:emoticon ac:name=&quot;laugh&quot; /&gt;</code></td>
</tr>
<tr>
<td>Wink</td>
<td><code>&lt;ac:emoticon ac:name=&quot;wink&quot; /&gt;</code></td>
</tr>
<tr>
<td>Thumbs Up</td>
<td><code>&lt;ac:emoticon ac:name=&quot;thumbs-up&quot; /&gt;</code></td>
</tr>
<tr>
<td>Thumbs Down</td>
<td><code>&lt;ac:emoticon ac:name=&quot;thumbs-down&quot; /&gt;</code></td>
</tr>
</tbody>
</table>
Resource identifiers

Resource identifiers are used to describe "links" or "references" to resources in the storage format. Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

<table>
<thead>
<tr>
<th><strong>Resource</strong></th>
<th><strong>Resource identifier format</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>&lt;ri:page ri:space-key=&quot;FOO&quot; ri:content-title=&quot;Test Page&quot;/&gt;</code></td>
</tr>
</tbody>
</table>

**Notes:**
- `ri:space-key:` (optional) denotes the space key. This can be omitted to create a relative reference.
- `ri:content-title:` (required) denotes the title of the page.
### Blog Post

```xml
<ri:blog-post ri:space-key="FOO"
  ri:content-title="First Post"
  ri:posting-day="2012/01/30" />
```

**Notes:**
- `ri:space-key:` *(optional)* denotes the space key. This can be omitted to create a relative reference.
- `ri:content-title:` *(required)* denotes the title of the page.
- `ri:posting-day:` *(required)* denotes the posting day. The format is YYYY/MM/DD.

### Attachment

```xml
<ri:attachment ri:filename="...">
  ... resource identifier for the container of the attachment ...
</ri:attachment>
```

**Notes:**
- `ri:filename:` *(required)* denotes the name of the attachment.
- the body of the `ri:attachment` element should be a resource identifier denoting the container of the attachment. This can be omitted to create a relative attachment reference (similar to [foo.png] in wiki markup).

**Examples:**

#### Relative Attachment Reference

```xml
<ri:attachment ri:filename="happy.gif" />
```

#### Absolute Attachment Reference

```xml
<ri:attachment ri:filename="happy.gif">
  <ri:page ri:space-key="TST"
    ri:content-title="Test Page"/>
</ri:attachment>
```
<table>
<thead>
<tr>
<th>Table Title</th>
<th>Example Code</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td><code>&lt;ri:url ri:value=&quot;http://example.org/sample.gif&quot;/&gt;</code></td>
<td>- <strong>ri:value</strong>: (required) denotes the actual URL value.</td>
</tr>
</tbody>
</table>
| Shortcut    | `<ri:shortcut ri:key="jira" ri:parameter="ABC-123">` | - **ri:key**: (required) represents the key of the Confluence shortcut.  
  - **ri:parameter**: (required) represents the parameter to pass into the Confluence shortcut.  
  - The example above is equivalent to `[ABC-123@jira]` in wiki markup. |
| User        | `<ri:user ri:username="fred"/>` | - **ri:username**: (required) denotes the name of the user. |
| Space       | `<ri:space ri:space-key="TST"/>` | - **ri:space-key**: (required) denotes the key of the space. |
| Content Entity | `<ri:content-entity ri:content-id="123"/>` | - **ri:content-id**: (required) denotes the id of the content. |

**Template variables**
This screenshot shows a simple template:

A single-line text variable: $MyText
A multi-line text variable: $MyMulti
A selection list: $MyList

The template contains the following variables:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MyText</td>
<td>Single-line text</td>
<td></td>
</tr>
<tr>
<td>$MyMulti</td>
<td>Multi-line text</td>
<td>Size: 5 x 100</td>
</tr>
<tr>
<td>$MyList</td>
<td>List</td>
<td>List items: Apples, Pears, Peaches</td>
</tr>
</tbody>
</table>

The XML export produces the following code for the template:

```xml
<at:declarations>
  <at:string at:name="MyText" />
  <at:textarea at:columns="100" at:name="MyMulti" at:rows="5" />
  <at:list at:name="MyList">
    <at:option at:value="Apples">Apples</at:option>
    <at:option at:value="Pears">Pears</at:option>
    <at:option at:value="Peaches">Peaches</at:option>
  </at:list>
</at:declarations>
<p>This is Sarah's template</p>
<p>A single-line text variable: $MyText</p>
<p>A multi-line text variable: $MyMulti</p>
<p>A selection list: $MyList</p>
<p>End of page.</p>
```

Confluence Storage Format for Macros
This page is an extension of the page about the Confluence storage format. This page describes the XML used to define specific Confluence macros – those that are shipped with Confluence. For each macro, we define the macro name, parameter names, and accepted parameter values.

This information is intended for advanced users who need to interpret and edit the underlying markup for a Confluence page.

**Anchor macro**

Allows you to link to a specific part of a page.

**Macro name:** anchor

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The name of the anchor.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```xml
<ac:macro ac:name="anchor">
  <ac:default-parameter>here</ac:default-parameter>
</ac:macro>
```
On this page:
- Anchor macro
- Attachments macro
- Blog Posts macro
- Change-History macro
- Chart macro
- Cheese macro
- Children Display macro
- Code Block macro
- Column macro
- Content by Label macro
- Content by User macro
- Contributors macro
- Contributors Summary macro
- Expand macro
- Info macro
- Section macro
- Table of Contents macro
- Macro format notes
  - Macro bodies
  - Plain text bodies
- Other notes

Related pages:
- Confluence Storage Format
- Working with Confluence Markup
- Working with Macros
- Confluence User's Guide

**Attachments macro**

Displays a list of attachments on a given page.

**Macro name:** attachments

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>old</td>
<td>No</td>
<td>false</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false - Displays only the latest version of each attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true – Displays all versions of each attachment, including the old versions.</td>
</tr>
</tbody>
</table>
| **patterns** | No | (None) | A comma-separated list of regular expressions, used to filter the attachments by filename. Note that the parameter values must be regular expressions. For example:
  - To match a file suffix of 'jpg', use `.*jpg` (not `.*.jpg`).
  - To match file names ending in 'jpg' or 'png', use `.*jpg,.*png`.
  Here is a [tutorial on regular expressions](https://confluence-docs.atlassian.com/tutorials/regular-expressions). |
| **sortBy** | No | date | Available values:
  - date
  - size
  - name |
| **page** | No | The page on which the macro exists. | Page name, used to display attachments from another page. |
| **sortOrder** | No | The default sort order is determined by the sortBy type:
  - Reverse chronological for 'date'.
  - Largest to smallest for 'size'.
  - Alphabetical for 'name'. | Available values:
  - ascending
  - descending |
| **labels** | No | (None) | A comma-separated list of labels. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.) |
| **upload** | No | false | Determines whether the list of attachments will include options allowing users to browse for, and attach, new files. |
Blog Posts macro

Lists the most recent news items in the space.

**Macro name:** blog-posts

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>content</td>
<td>No</td>
<td>entire</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>entire</strong> – Display the whole content of each blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>excerpts</strong> – Display a short extract from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>titles</strong> – Display a list of blog posts, showing titles only.</td>
</tr>
<tr>
<td>spaces</td>
<td>No</td>
<td>@self</td>
<td>One or more space keys, separated by a comma or a space.</td>
</tr>
</tbody>
</table>
- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of `-BAD SPACE` you will get only content which is not in the BADSPACE.
- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of `+GOODSPACE` you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
<table>
<thead>
<tr>
<th><strong>Author</strong></th>
<th><strong>No</strong></th>
<th><strong>(None)</strong></th>
<th><strong>One or more usernames, separated by commas.</strong></th>
</tr>
</thead>
</table>
| **Time**   | **No** | **(None)** | **Available values:**
|            |        |            | • m — Minutes
|            |        |            | • h — Hours
|            |        |            | • d — Days
|            |        |            | • w — Weeks
|            |        |            | **For example,**
|            |        |            | • `time=12h` — Display blog posts created in the last twelve hours.
|            |        |            | • `time=7d` — Display blog posts created in the last seven days. |
| **Reverse**| **No** | **false**  | **A value of true changes the sort order.** |

When specifying a personal space, remember to use the tilde (`~`) sign in front of the username, such as `~jbloggs` or `~jbloggs@example.com`. 
<table>
<thead>
<tr>
<th>sort</th>
<th>No</th>
<th>creation</th>
<th>Available values:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>title</td>
<td>• title — Sort alphabetically by title.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>creation</td>
<td>• creation — Sort by the date on which the content was added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>modified</td>
<td>• modified — Sort by the date on which the content was last updated.</td>
</tr>
</tbody>
</table>

| max    | No                      | 15       | The maximum number of results to be displayed. |
| label  | No                      | (None)   | One or more label values, separated by a comma or a space. |
|        |                         |          | • To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of -badpage you will get only content which is not labelled with 'badpage'. |
|        |                         |          | • To indicate that the results **must** match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of +superpage,+goodpage you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |

**Example:**
Change-History macro

Displays a history of updates made to a page.

**Macro name:** change-history

**Macro body:** None.

**Parameters:** None

**Example:**

```xml
<ac:macro ac:name="change-history"/>
```

Chart macro

Displays a chart based on tabular data.

**Macro name:** chart

**Macro body:** Accepts rich text, consisting of tables that hold the chart's data.

This macro recognises a large number of parameters, listed here by type for convenience.

**Chart type parameters**

These parameters determine the type of chart to display and how the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| type              | No       | pie     | The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based. See the `timeSeries` parameter. Available values:  
|                   |          |         | • Standard charts – pie, bar, line, area  
|                   |          |         | • XY plots – xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries  
|                   |          |         | • Other charts – gantt (beta)                                                                   |
| orientation       | No       | vertical| The display orientation. Applies to area, bar and line charts. Available values:  
|                   |          |         | • vertical – y-axis is vertical  
|                   |          |         | • horizontal – x-axis is vertical                                                              |
| 3D                | No       | false   | Show in three dimensions. Applies to area, bar and line charts.                                  |
| stacked           | No       | false   | Stacked values. Applies to area and bar charts.                                                  |
| showShapes        | No       | true    | Applies to line charts. Shapes are shown at each data point.                                     |
| opacity           | No       |         | • 75 percent for 3D charts  
|                   |          |         | • 50 percent for non-stacked area charts  
<p>|                   |          |         | • 100 percent for all other charts                                                               |
|                   |          |         | A percentage value between 0 (transparent) and 100 (opaque) that determines how opaque the foreground areas and bars are. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>dataDisplay</td>
<td>No</td>
<td>false</td>
<td>Determines whether to display the body of the macro, consisting of the data table. By default, the chart data table is not displayed. Available values: • false – the data is not displayed. • true or after – the data is displayed after the chart. • before – the data is displayed before the chart.</td>
</tr>
<tr>
<td>imageFormat</td>
<td>No</td>
<td>png</td>
<td>The image format to be used for the chart. Available values: • png • jpg</td>
</tr>
</tbody>
</table>

**Chart title and label parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>subTitle</td>
<td>No</td>
<td>(None)</td>
<td>A subtitle for the chart.</td>
</tr>
<tr>
<td>xLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>yLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>legend</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show a legend (key) for the chart.</td>
</tr>
</tbody>
</table>

**Chart data parameters**

The data for the chart is taken from tables found in the macro body. The parameters below control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. You can specify additional conversion options using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>tables</td>
<td>No</td>
<td>All first level tables</td>
<td>You can supply a comma-separated list of table IDs and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>All columns</td>
<td>You can supply a comma-separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the HTML title attribute for the column in the header row.</td>
</tr>
</tbody>
</table>
| dataOrientation | No | horizontal | The content orientation. By default, the data tables will be interpreted as columns (horizontally) representing domain and x values. Available values:  

- **vertical** – data table columns will be interpreted as series.  
- **horizontal** – data tables rows will be interpreted as series. |
<p>| timeSeries | No | false | If 'true', the x values in an XY plot will be treated as time series data and so will be converted according date formats. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>dateFormat</code></td>
<td>No</td>
<td>Confluence language defined date formats</td>
<td>For time series data, the date format allows for additional customisation of the conversion of data to date values. If a <code>date Format</code> is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See simple date format.</td>
</tr>
<tr>
<td><code>timePeriod</code></td>
<td>No</td>
<td>day</td>
<td>The time period for time series data. Defines the granularity of how the data is interpreted. Available values: millisecond, second, minute, hour, day, week, month, quarter, year</td>
</tr>
<tr>
<td><code>language</code></td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the <code>country</code> parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Available values are the two-character ISO 639-1 alpha-2 codes.</td>
</tr>
<tr>
<td><code>country</code></td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the <code>language</code> parameter to form a locale. Valid values are the two-character ISO 3166 codes.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>forgive</td>
<td>No</td>
<td>true</td>
<td>Determines whether the macro will forgive (allow) some data formatting errors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false — the macro enforces strict data formatting. If there are data format errors, the chart will not be produced.</td>
</tr>
<tr>
<td>Chart colour parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Colours are specified using hexadecimal notation or HTML colour names.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>bgColor</td>
<td>No</td>
<td>White</td>
<td>Background colour of the chart.</td>
</tr>
<tr>
<td>borderColor</td>
<td>No</td>
<td>No border</td>
<td>Colour of the border around the chart.</td>
</tr>
<tr>
<td>colors</td>
<td>No</td>
<td></td>
<td>A comma-separated list of colours used to customise the colours of categories, sections, and series.</td>
</tr>
<tr>
<td>Chart axis parameters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more of these parameters.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>rangeAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Minimum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Maximum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>rangeAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>domainAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
<td></td>
</tr>
<tr>
<td>domainAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
<td></td>
</tr>
<tr>
<td>domainAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the <code>timePeriod</code> parameter. The <code>timePeriod</code> unit can be overridden by specifying a trailing character: <code>y</code> (years), <code>M</code> (months), <code>d</code> (days), <code>h</code> (hours), <code>m</code> (minutes), <code>s</code> (seconds), <code>ms</code> (milliseconds).</td>
<td></td>
</tr>
<tr>
<td>domainAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
<td></td>
</tr>
<tr>
<td>categoryLabelPosition</td>
<td>No</td>
<td>(None)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Placement of the axis label text for categories. Available values:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <code>up45</code> — 45 degrees going upward</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <code>up90</code> — 90 degrees going upward</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <code>down45</code> — 45 degrees going downward</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <code>down90</code> — 90 degrees going downward</td>
<td></td>
</tr>
</tbody>
</table>
### Pie chart Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| pieSectionLabel    | No       | Show only the pie section key value | Format of pie section labels. The format uses a string with special replacement variables:  
   • `%0%` is replaced by the pie section key.  
   • `%1%` is replaced by the pie section numeric value.  
   • `%2%` is replaced by the pie section percent value.  

**Example 1:** To display something like 'Independent = 20':

```
%0% = %1%
```

**Example 2:** To display something like 'Independent (20%)':

```
%0% (%2%)
```
pieSectionExplode | No | No exploded sections | A comma-separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher.

Chart attachment parameters

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access to re-use the attachment. This can be useful especially when combined with the Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachment</td>
<td>No</td>
<td>(None)</td>
<td>The name and location where the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified. Available syntax for this parameter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• ^attachmentName.png — the chart is saved as an attachment to the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• page name^attachmentName.png — the chart is saved as an attachment to the page name provided.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• spacekey:pageTitle^attachmentName.png — the chart is saved as an attachment to the page name provided in the space indicated.</td>
</tr>
</tbody>
</table>
| attachmentVersion | No       | new    | Defines the versioning mechanism for saved charts. Available values:  
|                   |          |        | - **new** — creates new version of the attachment.  
|                   |          |        | - **replace** — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorised to remove attachments for the page specified.  
|                   |          |        | - **keep** — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.  
| attachmentComment | No       | (None) | Comment used for a saved chart attachment.  
| thumbnail         | No       | false  | If true, the chart image attachment will be shown as a thumbnail (small, expandable) image.  

**Example:**

Below is a simple example of a pie chart. See more examples in [Storage Format Examples for Chart Macro](#).
<ac:macro ac:name="chart">
<ac:parameter ac:name="title">Fish Sold</ac:parameter>
<ac:parameter ac:name="type">pie</ac:parameter>
<ac:rich-text-body>
<table>
<tbody>
<tr>
<th><p>Fish Type</p></th>
<th><p>2004</p></th>
<th><p>2005</p></th>
</tr>
<tr>
<th><p>Herring</p></th>
<td><p>9,500</p></td>
<td><p>8,300</p></td>
</tr>
<tr>
<th><p>Salmon</p></th>
<td><p>2,900</p></td>
<td><p>4,200</p></td>
</tr>
<tr>
<th><p>Tuna</p></th>
<td><p>1,500</p></td>
<td><p>1,500</p></td>
</tr>
</tbody>
</table>
</ac:rich-text-body>
</ac:macro>

**Cheese macro**
Displays the words "I like cheese!"
Macro name: cheese

Macro body: None.

Parameters: None

Example:

```latex
<ac:macro ac:name="cheese"/>
```

Children Display macro

Displays the children and descendants of the current page.

Macro name: children

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the sort order in the list of child pages. Use this parameter in conjunction with the sort parameter described below. A value of true will change the sort order from ascending to descending.</td>
</tr>
</tbody>
</table>
| sort           | No       | Manual if the pages have been manually reordered, otherwise alphabetical by page title | Determines the sort order of the list of child pages. Available values:  
  - creation – Sort by the date on which the page was created.  
  - title – Sort alphabetically by page name.  
  - modified – Sort by the date on which the page was last updated. |
<p>| style          | No       | Bullet list | A heading style to be applied to the list of child pages. Available values: h1 (heading level 1) through to h6 (heading level 6). |</p>
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Default</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>The page that contains the macro. The name of the parent page. The macro will display the children of the specified page. To specify a page in a different space, use a space key followed by a colon. For example: MYSPACE:My page. If the value of this parameter is a forward slash (/) the macro will list the pages at the root of the current space. In other words, the pages without parents.</td>
</tr>
<tr>
<td>excerpt</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>first</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>depth</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>all</td>
<td>No</td>
<td>false</td>
</tr>
</tbody>
</table>

**Example:**

...
**Code Block macro**

Displays code in your document with the appropriate syntax highlighting.

**Macro name:** code

**Macro body:** Accepts plain text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Adds a title to the code macro box.</td>
</tr>
<tr>
<td>theme</td>
<td>No</td>
<td>Confluence</td>
<td>Specifies the colour scheme used for displaying your code. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. Available themes:</td>
</tr>
</tbody>
</table>

- Django
- Emacs
- FadeToGrey
- Midnight
- RDark
- Eclipse
- Confluence (same as default)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>linenumbers</td>
<td>No</td>
<td>If true, a line number will be shown to the left of each line of code. Numbering is incremented by 1. If false, no line numbers are shown.</td>
</tr>
</tbody>
</table>
| language    | java  | Specifies the language (or environment) for syntax highlighting. 
- (none) — that is, no syntax highlighting
- actionscript3
- bash
- csharp — that is, C#
- coldfusion
- cpp — that is, C++
- css
- delphi
- diff
- erlang
- groovy
- java
- javafx
- javascript
- perl
- php
- powershell
- python
- ruby
- scala
- sql
- vb — that is, Visual Basic
- html/xml |
| firstline   | 1     | When linenumbers is true, this value defines the number of the first line of code. |
| collapse    | false | If true, the code macro's content will be collapsed upon visiting or refreshing the Confluence page. Clicking the 'expand source' link allows you to view the content. If false, the code macro's content is always displayed in full. |
Example:

The following example shows all parameters and a body:

```xml
<ac:macro ac:name="code">
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:parameter ac:name="theme">FadeToGrey</ac:parameter>
  <ac:parameter ac:name="linenumbers">true</ac:parameter>
  <ac:parameter ac:name="language">html/xml</ac:parameter>
  <ac:parameter ac:name="firstline">0001</ac:parameter>
  <ac:parameter ac:name="collapse">true</ac:parameter>
  <ac:plain-text-body><![CDATA[<b>This is my code</b>]]></ac:plain-text-body>
</ac:macro>
```

Below are three examples of the Code Block macro with various optional parameters used.

<table>
<thead>
<tr>
<th>Description</th>
<th>Markup</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| Code block macro with a body and no optional parameters | `<ac:macro ac:name="code">
  <ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>` | this is my code |
| Code block macro with a body and the optional `language` parameter defined | `<ac:macro ac:name="code">
  <ac:parameter ac:name="language">html/xml</ac:parameter>
  <ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>` | this is my code |
Code block macro with a body and optional title, line numbers and language parameters defined

```xml
<ac:macro ac:name="code">
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:parameter ac:name="linenumbers">true</ac:parameter>
  <ac:parameter ac:name="language">html/xml</ac:parameter>
  <ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>
```

This is my title
this is my code

---

**Column macro**

Used with the Section macro to define columns on a page. See [Working with page layouts and columns and sections](#).

**Macro name:** column

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>The width of the column. Can be specified either in pixels (for example, 400px) or as a percentage of the available page width (for example, 50%).</td>
</tr>
</tbody>
</table>

**Example:**

```xml
<ac:macro ac:name="column">
  <ac:parameter ac:name="width">100px</ac:parameter>
  <ac:rich-text-body>
    <p>This is the content of <strong>column 1</strong>.</p>
  </ac:rich-text-body>
</ac:macro>
```

---

**Content by Label macro**
Displays a list of content associated with specific labels.

**Macro name:** contentbylabel

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| spaces         | No       | @all    | Filters the results by space. The macro will display only the pages and other content types which belong to the space(s) you specify here. You can specify one or more space keys, separated by a comma or a space.

- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADS PACE you will get only content which is not in the BADSPACE.

- To indicate that the results **must** come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOOD SPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
- **@self** — The current space.
- **@personal** — All personal spaces.
- **@global** — All global spaces.
- **@favorite** — The spaces you have marked as favourite.
- **@favourite** — The same as @favorite above.
- **@all** — All spaces in your Confluence site.
- **@** — The same as @all above.

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author</td>
<td>No</td>
<td>(None)</td>
<td>Filters the results by author. The macro will display only the pages and other content types which are written or updated by the author(s) you specify here. You can specify one or more authors, separated by a comma.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Adds a heading to the list.</td>
</tr>
<tr>
<td>showLabels</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the matching labels in the list of results.</td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Use this parameter in conjunction with the sort parameter. Set reverse=true to change the sort from ascending to descending. This parameter is ignored if the sort parameter is not specified.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **sort**  | No      | modified | Determines how the results are sorted. To change the sort order from ascending to descending, use the `reverse` parameter described above. If this parameter is not specified, the sort order defaults to descending order based on the last modification date. Values:  
  - **title** — Sort alphabetically by title.
  - **creation** — Sort by the date on which the content was added.
  - **modified** — Sort by the date on which the content was last updated. |
| **max**   | No      | 15    | Determines the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied. |
| **excerpt** | No      | false | If this parameter is set to `true`, the macro displays an excerpt from each page listed in the results. Note that you must define the excerpts on each of those pages, by adding the `Excerpt macro` to each page. If a particular page does not have an excerpt defined, then the Content by Label macro will not attempt to show an excerpt for that page. The Content by Label macro will show only the first few lines of the excerpt for each page. |
| labels     | Yes     | (None)   | Use this parameter to filter the results by label. The macro will display only the pages and other content types which are tagged with the label(s) you specify here. See also the `operator` parameter.

You can specify one or more label values, separated by a comma or a space.

- To exclude content which matches a given label, put a minus sign `-` immediately in front of that label value. For example: If you specify a label value of `-badpage` you will get only content which is not labelled with `badpage`.
- To indicate that the results must match a given label value, put a plus sign `+` immediately in front of that label value. For example: If you specify a label value of `+superpage,+goodpage` you will get only content which has at least two labels, being `superpage` and `goodpage`.

<p>| showSpace | No      | true     | Determines whether to display the spaces in the list of results. |</p>
<table>
<thead>
<tr>
<th>type</th>
<th>No</th>
<th>All</th>
</tr>
</thead>
</table>

Filters the results by content type. The macro will display only the content of the type you specify here.

You can specify one or more types, separated by a comma or a space.

To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of `-blogpost` you will get pages and all other content except for blog posts.

Available values:
- `page` — *pages*.
- `blogpost` or `news` — blog posts, also known as *news* items.
- `attachment` — *attachments*.
<table>
<thead>
<tr>
<th>operator</th>
<th>No</th>
<th>OR</th>
</tr>
</thead>
</table>
|          |    | The operator to apply to the supplied lists of labels. By default, a page with any of the non-prefixed labels (that is, labels without a plus (+) or minus (-) sign immediately preceding it) will be listed. If you specify a value of AND, only pages with all of the supplied non-prefixed labels will be listed.

Note that this parameter only modifies the behaviour of the 'Label(s)' parameter and only affects label values without a plus (+) or minus (-) sign prefix. To avoid confusion or unexpected results, we recommend that you do not use the operator parameter in conjunction with any label values prefixed with '+' or '-' signs.

Example:

```xml
<ac:macro ac:name="contentbylabel">
  <ac:parameter ac:name="spaces">@personal,@self</ac:parameter>
  <ac:parameter ac:name="author">admin,smaddox</ac:parameter>
  <ac:parameter ac:name="title">My labelled pages</ac:parameter>
  <ac:parameter ac:name="showLabels">false</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">creation</ac:parameter>
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
  <ac:parameter ac:name="showSpace">false</ac:parameter>
  <ac:parameter ac:name="type">page</ac:parameter>
  <ac:parameter ac:name="operator">AND</ac:parameter>
</ac:macro>
```

**Content by User macro**

Displays a list of the content items that have been created by a specified Confluence user.

**Macro name:** content-by-user

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The Confluence username for the person whose content you wish to display</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```html
<ac:macro ac:name="content-by-user">
  <ac:default-parameter>jsmith</ac:default-parameter>
</ac:macro>
```

**Contributors macro**

Displays a list of Confluence users who have made a contribution of some type to a page.

**Macro name:** contributors

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors displayed in the list.</td>
</tr>
<tr>
<td>spaces</td>
<td>No</td>
<td>Current space</td>
<td>Specifies the space key of the Confluence space to search. Space keys are case sensitive.</td>
</tr>
</tbody>
</table>

Special values:
- @global — All global spaces.
- @personal — All personal spaces.
- @all — All spaces in the Confluence site.

You can specify one or more space keys or special values, separated by commas.

If no page and labels are specified, all pages from the specified set of spaces are included.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the order of contributors in the list. Must be used in conjunction with the order parameter.</td>
</tr>
</tbody>
</table>
| scope     | No       | The specified page only | Specifies additional pages to include when generating the list of contributors. Available values:  
- children – only the child pages of the specified page.  
- descendants – all descendants of the specified page. |
| labels    | No       | (None) | Limits the list of contributors to those who created the specified labels on a page. You can specify one or more labels, separated by commas. |
| showPages | No       | false | If the value is true, the macro will display a list of the pages used to generate the list of contributors. |
| noneFoundMessage | No | "No contributors found for:" (and a summary of selected parameter values) | Any message given here will override the default message that is displayed when no contributors are found. |
| showCount | No       | false | Determines whether the macro will show the number of times each person made a contribution. |
| **contentType** | **No** | **Both pages and blog posts** | Restricts the content type that the macro will use when generating the list of contributors. Available values:  
- *pages* - pages  
- *blogposts* - blog posts. |
| **include** | **No** | **authors** | Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:  
- *authors* - includes people who created or have edited the page(s)  
- *comments* - includes people who have added comments to the page(s)  
- *labels* - includes people who have added labels to the page(s)  
- *watches* - includes people who are watching the page(s). You can specify one or more contribution types, separated by commas. |
| **mode** | **No** | **inline** | Determines how the list of contributors is formatted:  
- *inline* — a comma-separated list  
- *list* — a bullet list. |
| **showAnonymous** | **No** | **false** | Determines whether to include those who contributed anonymously to a page. |
| order | No | count | Specifies the criteria used to sort contributors. Sort criteria are:
|       |    |       | - **count** – sorts the names based on the total number of contributions to the page(s)
|       |    |       | - **name** – sorts the names into alphabetical order
|       |    |       | - **update** – sorts the names by the date of their last contribution to the page(s).

| page | No | The current page | Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed.

| showLastTime | No | false | Determines whether to show the last time each person made a contribution.

| publishDate | No | (None) | Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.

**Example:**

This example specifies a content type of blog posts:
Contributors Summary macro

Displays a table of contribution-based statistics for a set of pages.

**Macro name:** contributors-summary

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>

This example specifies a content type of pages:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors or pages displayed in the table.</td>
</tr>
</tbody>
</table>
| spaces      | No       | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
|             |          |         | - `@global` — All global spaces.  
|             |          |         | - `@personal` — All personal spaces.  
|             |          |         | - `@all` — All spaces in the Confluence site.  
|             |          |         | You can specify one or more space keys or special values, separated by commas.  
|             |          |         | If no page and labels are specified, all pages from the specified set of spaces are included. |
| reverse     | No       | false   | Reverses the order of items in the table. Must be used in conjunction with the order parameter. |
| showAnonymous | No   | false   | Determines whether to include those who contributed anonymously to a page. |
| scope       | No       | The specified page only | Specifies additional pages to include when generating the list of contributors.  
|             |          |         | Available values:  
|             |          |         | - `children` — only the child pages of the specified page.  
<p>|             |          |         | - <code>descendants</code> — all descendants of the specified page. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| **order** | No | **edits** | Sets the criterion used for sorting items in the table.  
Available values:  
- *edits* - sorts items in the table based on the total number of edits made, either by a contributor or to a page.  
- *name* - sorts items in the table in alphabetical order, either by contributor or page name.  
- *editTime* - sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.  
- *update* - sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it. |
| **page** | No | **The current page** | A page title. Specifies the page to use when generating the list of contributors. If *page* and *spaces* are left blank, the current page is assumed. |
| **labels** | No | **(None)** | Limits contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas. |
| **columns** | No | **edits, comments, labels** | Determines the columns that should appear in the table. The statistics or type of information presented depends on the *groupby* parameter. |
Available values:

- **edits** – the number of times each contributor has edited the page(s) or the number of edits made to each page.
- **edited** – a list of the pages edited by each contributor or a list of contributors who have edited each page.
- **comments** – the number of times each contributor has added comments to the page(s) or the number of comments on each page.
- **commented** – a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
- **labels** – the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- **labeled** – a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- **labellist** – a list of labels either added by each contributor or on each page.
- **watches** – the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
- **watching** – a list of pages being watched by each contributor/person or a list of contributors/people watching each page.
- **lastupdate** – the last time each contributor made an update or when each page was last updated. Valid updates can include edits, comments or label modifications to a page.

You can specify one or more columns, separated by commas.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>groupby</td>
<td>No</td>
<td>contributors</td>
<td>Specifies the basis for grouping contribution-based statistics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- contributors – group by the people who have contributed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- pages – group by the pages used to find the contributors.</td>
</tr>
<tr>
<td>contentType</td>
<td>No</td>
<td>Both pages and blog posts</td>
<td>Restricts the content type that the macro will use when generating the list of contributors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- pages – pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- blogposts – blog posts.</td>
</tr>
<tr>
<td>showZeroCounts</td>
<td>No</td>
<td>false</td>
<td>Determines whether contributors or pages are included for which the calculated statistic is zero.</td>
</tr>
<tr>
<td>publishDate</td>
<td>No</td>
<td>(None)</td>
<td>Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.</td>
</tr>
</tbody>
</table>
This example specifies a content type of blog posts:

```xml
<ac:macro ac:name="contributors-summary">
    <ac:parameter ac:name="limit">10</ac:parameter>
    <ac:parameter ac:name="spaces">ds,@personal</ac:parameter>
    <ac:parameter ac:name="reverse">true</ac:parameter>
    <ac:parameter ac:name="showAnonymous">true</ac:parameter>
    <ac:parameter ac:name="order">update</ac:parameter>
    <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
    <ac:parameter ac:name="columns">edits,comments,labels,lastupdate</ac:parameter>
    <ac:parameter ac:name="contentType">blogposts</ac:parameter>
    <ac:parameter ac:name="showZeroCounts">true</ac:parameter>
    <ac:parameter ac:name="publishDate">2012/06/07</ac:parameter>
</ac:macro>
```

This example specifies a content type of pages:

```xml
<ac:macro ac:name="contributors-summary">
    <ac:parameter ac:name="limit">10</ac:parameter>
    <ac:parameter ac:name="spaces">ds,@personal</ac:parameter>
    <ac:parameter ac:name="reverse">true</ac:parameter>
    <ac:parameter ac:name="showAnonymous">true</ac:parameter>
    <ac:parameter ac:name="scope">descendants</ac:parameter>
    <ac:parameter ac:name="order">update</ac:parameter>
    <ac:parameter ac:name="page">ds:Advanced Topics</ac:parameter>
    <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
    <ac:parameter ac:name="columns">edits,comments,labels,lastupdate</ac:parameter>
    <ac:parameter ac:name="contentType">pages</ac:parameter>
    <ac:parameter ac:name="showZeroCounts">true</ac:parameter>
</ac:macro>
```

**Expand macro**

Displays an expandable/collapsible section of text.

**Macro name:** expand

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>No</td>
<td>Click here to expand...</td>
<td>Text that will be displayed on the line that people can click to expand the hidden text.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**
Info macro

Displays a block of text in a blue highlight box.

Macro name: info

Macro body: Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the icon in the title bar of the information box.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
</tbody>
</table>

Example:

The following example shows all parameters and a body:

```xml
<ac:macro ac:name="info">
  <ac:parameter ac:name="icon">false</ac:parameter>
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:macro>
```

Below are some examples of the Info macro with various optional parameters used.

<table>
<thead>
<tr>
<th>Description</th>
<th>Markup</th>
<th>What you will get</th>
</tr>
</thead>
</table>

---

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| Info macro with a body defined and no optional parameters | `<ac:macro ac:name="info">  
  <ac:rich-text-body><p>This is <em>important</em> information.</p></ac:rich-text-body></ac:macro> | This is *important* information. |
|---------------------------------------------------------|-----------------------------------------------------------------|-------------------------------|
| Info macro with a body and an optional *Title* parameter defined | `<ac:macro ac:name="info">  
  `<ac:parameter ac:name="title">This is my title</ac:parameter>`  
  <ac:rich-text-body><p>This is <em>important</em> information.</p></ac:rich-text-body></ac:macro> | This is *important* information. |
|---------------------------------------------------------|-----------------------------------------------------------------|-------------------------------|
Info macro with a body and optional Title and Icon parameters defined

```
<ac:macro ac:name="info">
    <ac:parameter ac:name="icon">false</ac:parameter>
    <ac:parameter ac:name="title">This is my title</ac:parameter>
    <ac:rich-text-body>
        <p>
            <span>This is important information.</span>
        </p>
    </ac:rich-text-body>
</ac:macro>
```

**Section macro**

Used with the Column macro to define columns on a page. See [Working with page layouts and columns and sections](#).

**Macro name:** section

**Macro body:** Rich text, consisting of one or more Column macros.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>border</td>
<td>No</td>
<td>False</td>
<td>If the value is true, the columns in this section will have a dashed border.</td>
</tr>
</tbody>
</table>

**Example:**
**Table of Contents macro**

Displays a table of contents from your page headings.

**Macro name:** toc

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>printable</td>
<td>No</td>
<td>true</td>
<td>If you set this parameter to <code>false</code>, the table of contents will not be visible when you print the page.</td>
</tr>
<tr>
<td>style</td>
<td>No</td>
<td>none</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The style of bullet point for each list item. You can use any valid CSS style. For example:

- none – No list style is displayed.
- circle – The list style is a circle.
- disc – The list style is a filled circle. This is the typical bullet list, and is the one we are using in this example list.
- square — The list style is a square.
- decimal — The list is numbered (1, 2, 3, 4, 5).
- lower-alpha — The list style is lower case, alphabetised (a, b, c, d, e).
- lower-roman — The list style is lower-case roman numerals (i, ii, iii, iv, v, vi).
- upper-roman — The list style is upper-case roman numerals (I, II, III, IV, V, VI).

<table>
<thead>
<tr>
<th>maxLevel</th>
<th>No</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Maximum heading level. Use this parameter to select the highest heading level to include. For example, a value of 2 will list h1 and h2 levels, but will not include h3 and below.
| **indent** | No | (None) | This parameter applies to vertical lists only (type = list).

Use this parameter to indent the list items according to CSS quantities. For example, a value of 10px will successively indent list heading groups by 10 pixels. Level 1 headings will be indented 10px, and level 2 headings by an additional 10px, and so on. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>minLevel</strong></td>
<td>No</td>
<td>1</td>
<td>Minimum heading level. The heading level at which the table of contents will start. For example, a value of 2 will list h2, h3, and h4 headings, but will not include h1 headings.</td>
</tr>
<tr>
<td><strong>class</strong></td>
<td>No</td>
<td>(None)</td>
<td>A CSS class name. If you have a custom style sheet, you can use this parameter to output the table of contents with the specified class attribute.</td>
</tr>
</tbody>
</table>
| **exclude** | No | (None) | Specifies the headings to exclude by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will include only the headings that match the regular expression. Example: .*
\.[1/2]  
See Sun's Regex documentation for examples of constructing regular expression strings. |
| **type** | No | **list** | Defines the overall format of the table of contents.  
Available values:  
- list – displays the table of contents in a vertical list.  
- flat – displays a horizontal series of links. For example: [Heading 1] [Heading 2] [Heading 3]. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>outline</strong></td>
<td>No</td>
<td><strong>false</strong></td>
<td>A value of true will apply outline numbering to the headings as displayed in the table of contents. For example: 1.1, 1.2, 1.3.</td>
</tr>
</tbody>
</table>
| **separator** | No | **brackets** | This parameter applies to flat lists only (type = flat). Use this parameter to style the display of a flat list.  
Available values:  
- brackets – Each item is enclosed by square brackets: [ ].  
- braces – Each item is enclosed by braces: { }.  
- parens – Each item is enclosed by parentheses: ( ).  
- pipe – The items are separated by a pipe: |  
- anything – The items are separated by the value you enter. You can enter any text as a separator, for example ***. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
include | No | (None) | Specifies the headings to include by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will ignore any headings that do not match the regular expression. Example: \.* \.. [1//2] 

See Sun's Regex documentation for examples of constructing regular expression strings.

Example:

This example shows a list-type table of contents.

```xml
<ac:macro ac:name="toc">
  <ac:parameter ac:name="printable">true</ac:parameter>
  <ac:parameter ac:name="style">square</ac:parameter>
  <ac:parameter ac:name="maxLevel">2</ac:parameter>
  <ac:parameter ac:name="indent">5px</ac:parameter>
  <ac:parameter ac:name="minLevel">2</ac:parameter>
  <ac:parameter ac:name="class">bigpink</ac:parameter>
  <ac:parameter ac:name="exclude">[1//2]</ac:parameter>
  <ac:parameter ac:name="type">list</ac:parameter>
  <ac:parameter ac:name="outline">true</ac:parameter>
  <ac:parameter ac:name="include">.*</ac:parameter>
</ac:macro>
```

This example shows a flat table of contents.

```xml
<ac:macro ac:name="toc">
  <ac:parameter ac:name="printable">true</ac:parameter>
  <ac:parameter ac:name="maxLevel">2</ac:parameter>
  <ac:parameter ac:name="minLevel">2</ac:parameter>
  <ac:parameter ac:name="class">bigpink</ac:parameter>
  <ac:parameter ac:name="exclude">[1//2]</ac:parameter>
  <ac:parameter ac:name="type">flat</ac:parameter>
  <ac:parameter ac:name="outline">true</ac:parameter>
  <ac:parameter ac:name="separator">pipe</ac:parameter>
  <ac:parameter ac:name="include">.*</ac:parameter>
</ac:macro>
```

*Macro format notes*
Macro bodies

Some macros accept a body as well as parameters.

- The Info macro and Expand macro are examples of macros that accept a rich text body.
- The Code Block macro is a good example of a macro that accepts a plain text body.

Plain text bodies

The body of a plain text macro must be inside a CDATA block. So the following is not sufficient:

```html
<ac:plain-text-body>text</ac:plain-text-body>
```

The correct usage is:

```html
<ac:plain-text-body><![CDATA[text]]></ac:plain-text-body>
```

Other notes

- The 'Required' column indicates whether the parameter is required on data entry. If the parameter is not supplied, Confluence will insert default values as indicated in the 'Default' column.

  A request from the Atlassian technical writers about comments and feedback: When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we've missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks.

Confluence Storage Format Examples for Chart Macro

This page is an extension of Confluence Storage Format for Macros, which contains storage format examples for all Confluence macros. The Chart macro is a special case, because it offers so many options via parameters and chart types. This page offers additional examples for the Chart macro.

Pie chart

Here is a simple example of a pie chart.

Storage format
<ac:macro ac:name="chart">
  <ac:parameter ac:name="title">Fish Sold</ac:parameter>
  <ac:parameter ac:name="type">pie</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Fish Type</th>
          <th>2004</th>
          <th>2005</th>
        </tr>
        <tr>
          <td>Herring</td>
          <td>9,500</td>
          <td>8,300</td>
        </tr>
        <tr>
          <td>Salmon</td>
          <td>2,900</td>
          <td>4,200</td>
        </tr>
        <tr>
          <td>Tuna</td>
          <td>1,500</td>
          <td>1,500</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Fish Sold

2004 (1,500 - 50%)  2005 (1,500 - 50%)

Bar chart

Here is a simple example of a bar chart.

Storage format
<ac:macro ac:name="chart">
  <ac:parameter ac:name="title">Fish Sold</ac:parameter>
  <ac:parameter ac:name="type">bar</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Fish Type</th>
          <th>2004</th>
          <th>2005</th>
        </tr>
        <tr>
          <td>Herring</td>
          <td>9,500</td>
          <td>8,300</td>
        </tr>
        <tr>
          <td>Salmon</td>
          <td>2,900</td>
          <td>4,200</td>
        </tr>
        <tr>
          <td>Tuna</td>
          <td>1,500</td>
          <td>1,500</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Time series chart

Here is an example of a time series chart.

**Storage format**

```xml
<ac:macro ac:name="chart">
  <ac:parameter ac:name="timePeriod">Month</ac:parameter>
  <ac:parameter ac:name="dataOrientation">vertical</ac:parameter>
  <ac:parameter ac:name="rangeAxisLowerBound">0</ac:parameter>
  <ac:parameter ac:name="dateFormat">MM/yyyy</ac:parameter>
  <ac:parameter ac:name="type">timeSeries</ac:parameter>
  <ac:parameter ac:name="domainaxisrotateticklabel">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Month</th>
          <th>Revenue</th>
        </tr>
        <tr>
          <td><p>1/2005</p></td>
          <td><p>31.8</p></td>
        </tr>
        <tr>
          <td><p>2/2005</p></td>
          <td><p>41.8</p></td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>
```
<table>
<thead>
<tr>
<th>Month</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/2005</td>
<td>51.3</td>
</tr>
<tr>
<td>4/2005</td>
<td>33.8</td>
</tr>
<tr>
<td>5/2005</td>
<td>27.6</td>
</tr>
<tr>
<td>6/2005</td>
<td>49.8</td>
</tr>
<tr>
<td>7/2005</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2005</td>
<td>77.3</td>
</tr>
<tr>
<td>9/2005</td>
<td>73.8</td>
</tr>
<tr>
<td>10/2005</td>
<td>97.6</td>
</tr>
<tr>
<td>Month</td>
<td>Expenses</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>1/2005</td>
<td>41.1</td>
</tr>
<tr>
<td>2/2005</td>
<td>43.8</td>
</tr>
<tr>
<td>3/2005</td>
<td>45.3</td>
</tr>
<tr>
<td>4/2005</td>
<td>45.0</td>
</tr>
<tr>
<td>5/2005</td>
<td>45.7</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>44.6</td>
<td>6/2005</td>
</tr>
<tr>
<td>43.8</td>
<td>7/2005</td>
</tr>
<tr>
<td>51.8</td>
<td>8/2005</td>
</tr>
<tr>
<td>52.3</td>
<td>9/2005</td>
</tr>
<tr>
<td>53.8</td>
<td>10/2005</td>
</tr>
<tr>
<td>55.6</td>
<td>11/2005</td>
</tr>
<tr>
<td>61.2</td>
<td>12/2005</td>
</tr>
</tbody>
</table>
Here is an example of an XY line chart.

**Storage format**
<ac:macro ac:name="chart">
  <ac:parameter ac:name="type">xyline</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th></th>
          <th>12</th>
          <th>14</th>
          <th>23</th>
        </tr>
        <tr>
          <td>Revenue</td>
          <td>41.1</td>
          <td>31.8</td>
          <td>12.4</td>
        </tr>
        <tr>
          <td>Expense</td>
          <td>31.1</td>
          <td>41.8</td>
          <td>43.6</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Here is an example of an XY bar chart.

*Storage format*
<ac:macro ac:name="chart">
  <ac:parameter ac:name="opacity">60</ac:parameter>
  <ac:parameter ac:name="type">xybar</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th></th>
          <th>2005</th>
          <th>2006</th>
          <th>2007</th>
        </tr>
        <tr>
          <td>Revenue</td>
          <td>41.1</td>
          <td>31.8</td>
          <td>12.4</td>
        </tr>
        <tr>
          <td>Expense</td>
          <td>31.1</td>
          <td>41.8</td>
          <td>43.6</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Here is an example of an XY area chart.

Storage format
Resulting chart
Here are two examples of area charts.

**Storage format for area chart 1**

```xml
<ac:macro ac:name="chart">
   <ac:parameter ac:name="height">300</ac:parameter>
   <ac:parameter ac:name="legend">true</ac:parameter>
   <ac:parameter ac:name="width">300</ac:parameter>
   <ac:parameter ac:name="opacity">50</ac:parameter>
   <ac:parameter ac:name="type">area</ac:parameter>
   <ac:parameter ac:name="dataDisplay">true</ac:parameter>
   <ac:rich-text-body>
      <table>
         <tbody>
            <tr>
               <th>Satisfaction</th>
               <th>2002</th>
               <th>2003</th>
               <th>2004</th>
            </tr>
            <tr>
               <td>Very satisfied</td>
               <td>20</td>
               <td>23</td>
               <td>34</td>
            </tr>
         </tbody>
      </table>
   </ac:rich-text-body>
</ac:macro>
```
<table>
<thead>
<tr>
<th>Satisfied</th>
<th>40</th>
<th>34</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>
Resulting area chart 1

![Area Chart](image)

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Disatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>

Storage format for area chart 2

```xml
<ac:macro ac:name="chart">
    <ac:parameter ac:name="stacked">true</ac:parameter>
    <ac:parameter ac:name="height">300</ac:parameter>
    <ac:parameter ac:name="legend">true</ac:parameter>
    <ac:parameter ac:name="width">300</ac:parameter>
    <ac:parameter ac:name="type">area</ac:parameter>
    <ac:parameter ac:name="dataDisplay">true</ac:parameter>
    <ac:rich-text-body>
        <table>
            <tbody>
                <tr>
                    <th>Satisfaction</th>
                    <th>2002</th>
                    <th>2003</th>
                    <th>2004</th>
                </tr>
                <tr>
                    <td>Very satisfied</td>
                    <td>20</td>
                    <td>23</td>
                    <td>34</td>
                </tr>
                <tr>
                    <td>Satisfied</td>
                    <td>40</td>
                    <td>34</td>
                    <td>23</td>
                </tr>
                <tr>
                    <td>Disatisfied</td>
                    <td>25</td>
                    <td>26</td>
                    <td>25</td>
                </tr>
                <tr>
                    <td>Very dissatisfied</td>
                    <td>15</td>
                    <td>17</td>
                    <td>18</td>
                </tr>
            </tbody>
        </table>
    </ac:rich-text-body>
</ac:macro>
```
<tr>
  <td>
    &lt;p&gt;2004&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;Very satisfied&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;12&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;23&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;31&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;Satisfied&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;1&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;34&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;36&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;Disatisfied&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;4&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;6&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;22&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;Very disatisfied&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;2&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;7&lt;/p&gt;
  </td>
</tr>
<tr>
  <td>
    &lt;p&gt;12&lt;/p&gt;
  </td>
</tr>
</tbody>
Confluence Wiki Markup

This page describes the wiki markup used on some administration screens in Confluence. Another page describes the wiki markup for macros.

Wiki markup is useful when you want to do one of the following:

- Configure the [Documentation theme](#).
- Type wiki markup directly into the editor. Confluence will convert it to the rich text editor format as you type.
- Create links using the Advanced tab of the Links Browser.
- Insert a block of wiki markup into the Confluence editor. (Choose Insert > Wiki Markup.)

**Note:** You cannot edit content in wiki markup. Confluence does not store page content in wiki markup. Although you can enter wiki markup into the editor, Confluence will convert it to the rich text editor format immediately. You will not be able to edit the wiki markup after initial entry.

**A request from the Atlassian technical writers about comments and feedback:** When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we've missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled [Confluence 4 Editor - Customer Feedback](#), and its child pages. Our reason for this request: When a

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>12</td>
<td>23</td>
<td>31</td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
</tr>
</tbody>
</table>
page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks. 😊

On this page:

- Headings
- Lists
- Tables
- Text Effects
- Text Breaks
- Links
- Images
- Page Layouts
- Useful Information

Related pages:

- Confluence Wiki Markup for Macros
- Confluence User’s Guide

Headings

To format a line as a heading, type "hn." at the start of your line, where n can be a number from 1 to 6.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>h1. Biggest heading</td>
<td>Biggest heading</td>
</tr>
<tr>
<td>h3. Big heading</td>
<td>Big heading</td>
</tr>
<tr>
<td>h5. Small heading</td>
<td>Small heading</td>
</tr>
</tbody>
</table>

Lists

Wiki markup allows you to create bulleted or numbered lists, and is flexible enough to allow a combination of the two list types.

ℹ️ If you need to separate the text within lists using line breaks, make sure you do so using a double slash (/!). Empty lines may disrupt the list.

Simple lists

Use the hyphen (-) to create simple lists.
Make sure there is a space between the hyphen and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>- some</td>
<td>• some</td>
</tr>
<tr>
<td>- bullet</td>
<td>• bullet</td>
</tr>
<tr>
<td>- points</td>
<td>• points</td>
</tr>
</tbody>
</table>

Bulleted lists

Use the asterisk (*) to create bullets. For each subsequent level, add an extra asterisk.
Make sure there is a space between the asterisk and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>* some</td>
<td>• some</td>
</tr>
<tr>
<td>* bullet</td>
<td>• bullet</td>
</tr>
<tr>
<td>** indented</td>
<td>• indented</td>
</tr>
<tr>
<td>** bullets</td>
<td>• bullets</td>
</tr>
<tr>
<td>* points</td>
<td>• points</td>
</tr>
</tbody>
</table>

**Numbered lists**

Use the hash (#) to create numbered lists.
Make sure there is a space between the hash and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># a</td>
<td>1. a</td>
</tr>
<tr>
<td># numbered</td>
<td>2. numbered</td>
</tr>
<tr>
<td># list</td>
<td>3. list</td>
</tr>
</tbody>
</table>

A second level of hashes will produce a sub-list, such as the **alphabetical** sub-list shown below.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># Here's a sentence.</td>
<td>1. Here’s a sentence.</td>
</tr>
<tr>
<td>## This is a sub-list point.</td>
<td>a. This is a sub-list point.</td>
</tr>
<tr>
<td>## And a second sub-list point.</td>
<td>b. And a second sub-list point.</td>
</tr>
<tr>
<td># Here's another sentence.</td>
<td>2. Here’s another sentence.</td>
</tr>
</tbody>
</table>

You can use a third level of hashes to produce a sub-sub-list.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># Here's a sentence.</td>
<td>1. Here’s a sentence.</td>
</tr>
<tr>
<td>## This is a sub-list point.</td>
<td>a. This is a sub-list point.</td>
</tr>
<tr>
<td>### Third list level.</td>
<td>i. Third list level.</td>
</tr>
<tr>
<td>## Another point at the third level.</td>
<td>ii. Another point at the third level.</td>
</tr>
<tr>
<td>## And a second sub-list point.</td>
<td>b. And a second sub-list point.</td>
</tr>
<tr>
<td># Here's another sentence.</td>
<td>2. Here’s another sentence.</td>
</tr>
</tbody>
</table>

**Note:** In numbered lists as described above, the format of the ‘number’ displayed at each list level may be different, depending upon your browser and the style sheets installed on your Confluence instance. So in some
cases, you may see letters (A, B, C, etc; or a, b, c, etc) or Roman numerals (i, ii, iii, etc) at different list levels.

Mixed lists

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| # Here                | 1. Here
| #* is                |   • is
| #* an                |   • an
| # example             | 2. example
| #* of                |   • of
| #* a                 |   • a
| # mixed              | 3. mixed
| # list               | 4. list

Tables

You can create two types of tables.

Table Type 1

Allows you to create a simple table with an optional header row. You cannot set the width of the columns in this table.

Use double bars for a table heading row.

What you need to type:

<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
</tr>
</tbody>
</table>

What you will get:

<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
</tr>
</tbody>
</table>

You can also use a vertical header.

What you need to type:

<table>
<thead>
<tr>
<th>heading 1</th>
<th>col A1</th>
<th>col A2</th>
<th>col A3</th>
</tr>
</thead>
<tbody>
<tr>
<td>heading 2</td>
<td>col B1</td>
<td>col B2</td>
<td>col B3</td>
</tr>
</tbody>
</table>

What you will get:
### Table Type 2

This method allows you to specify the width of the columns in the table.

#### What you need to type

```
{section:border=true}
{column:width=30%}
Text for this column goes here. This is the smaller column with a width of only 30%.
{column}
{column:width=70%}
Text for this column goes here. This is the larger column with a width of 70%.
{section}
```

#### What you will get

| Text for this column goes here. This is the smaller column with a width of only 30%.
| Text for this column goes here. This is the larger column with a width of 70%.

For more details please see the Column Macro and the Section Macro.

### Advanced Formatting

#### Colour and Other Formatting

To add colour and other formatting to your tables, you can use the Panel Macro within columns. More table-formatting options may be available if your Confluence administrator has installed additional macros.

### Lists

Here’s an example of how to embed lists in a table:

#### What you need to type

```
||Heading 1||Heading 2||
|* Item 1|
|* Item 2|
|* Item 3|# Item 1|
|# Item 2|
|# Item 3|
```

#### What you will get

<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Text Effects

Use the markup shown in the examples below to format text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>strong</strong></td>
<td>strong</td>
</tr>
<tr>
<td><em>bold text</em></td>
<td>bold text</td>
</tr>
<tr>
<td><em>emphasis</em></td>
<td>emphasis</td>
</tr>
<tr>
<td><strong>italics</strong></td>
<td>italics</td>
</tr>
</tbody>
</table>
|                       | *Hint*: To italicise parts of a word, add braces (curly brackets) around the underscore. For example, Thing(_x_)
gives you this: Thingx |
| ??citation??          | citation          |
| -deleted-             | deleted           |
| +inserted+            | inserted          |
| Text with*superscript^ | Text with superscript |
|                       | *Hint*: There are two ways to make superscripts work, when used directly after another word or character: |
|                       | _Add a space before the superscript. For example, k_g/m^3^ gives you this: kg/m^3_ |
|                       | _Add braces (curly brackets) around the superscript markup. For example, kg/m(^3^) gives you this: kg/m^3_ |
| Text with~subscript~  | Text with subscript |
| {{monospaced}}       | monospaced        |

bq. Here's how you make a paragraph appear as a block quotation. Here's how you make a paragraph appear as a block quotation.
**Text Breaks**

**Paragraph Break**

In wiki markup, a paragraph is a continuous line of text ending in two carriage returns. This is equivalent to a continuous line of text followed by a blank line.

When rendered into HTML, the result is a line of text wrapped in a set of `<p></p>` tags.

**Line Break**

Confluence provides two options for forcing a line break within a paragraph of text:

- Implicitly, by entering a single carriage return at its end.
- Explicitly, by entering two consecutive backslashes: `\`

When rendered into HTML, the result is a paragraph of text that is split into separate lines by `<br>` tags, wherever a forced line break appears.

> For most purposes, explicit line breaks are not required because a single carriage return is enough.

The examples below show how to use explicit line breaks.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>here is some text</td>
<td>here is some text</td>
</tr>
<tr>
<td>\</td>
<td>divided</td>
</tr>
<tr>
<td>\</td>
<td>using line</td>
</tr>
<tr>
<td>\</td>
<td>breaks</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>This is a short list:</td>
<td>This is a short list:</td>
</tr>
<tr>
<td>* Point 1</td>
<td>* Point 1</td>
</tr>
<tr>
<td>Text to go with point 1</td>
<td>Text to go with point 1</td>
</tr>
<tr>
<td>* Point 2</td>
<td>* Point 2</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Text to go with point 2with a break</td>
<td>Text to go with point 2 with a break</td>
</tr>
</tbody>
</table>

If you wish to use multiple consecutive line breaks, each should be separated by a space character. For example, use this for two consecutive line breaks:

\ \ \ \ 

**Horizontal Rule**

Use four dashes (----) then press Enter, to create a horizontal rule. (It does not work if you press space.)

Make sure that the dashes are on a separate line from the rest of the text.
here is some text

---

divided by a horizontal rule

---

**Links**

You can use wiki markup to add hyperlinks to your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>[#anchor]</td>
<td>A link to an anchor on the same page.</td>
</tr>
<tr>
<td>[Confluence Wiki Markup^attachment.ext]</td>
<td>A link to a file attached to the page.</td>
</tr>
<tr>
<td>[pagetitle]</td>
<td>A link to a page.</td>
</tr>
<tr>
<td>[pagetitle#anchor]</td>
<td>A link to an anchor on another page.</td>
</tr>
<tr>
<td>[pagetitle^attachment.ext]</td>
<td>A link to a file attached to another page.</td>
</tr>
<tr>
<td>[spacekey:pagetitle]</td>
<td>A link to a page in another space.</td>
</tr>
<tr>
<td>[spacekey:pagetitle#anchor]</td>
<td>A link to an anchor on a page in another space.</td>
</tr>
<tr>
<td>[spacekey:pagetitle^attachment.ext]</td>
<td>A link to a file attached to a page in another space.</td>
</tr>
<tr>
<td>[/2004/01/12/blogposttitle]</td>
<td>A link to a blog post.</td>
</tr>
<tr>
<td>[spacekey:/2004/01/12/blogposttitle]</td>
<td>A link to a blog post in another space.</td>
</tr>
<tr>
<td>[/2004/01/12]</td>
<td>A link to a whole day's blog posts.</td>
</tr>
<tr>
<td>[spacekey:/2004/01/12]</td>
<td>A link to a whole day's blog posts in another space.</td>
</tr>
<tr>
<td>[spacekey:]</td>
<td>A link to the space homepage (or the space summary page of the space.</td>
</tr>
<tr>
<td>[~username]</td>
<td>A link to the user profile page of a particular user.</td>
</tr>
<tr>
<td>[phrase@shortcut]</td>
<td>A shortcut link to the specified shortcut site. Shortcuts are configured by the site administrator.</td>
</tr>
<tr>
<td>[<a href="mailto:legendaryservice@atlassian.com">mailto:legendaryservice@atlassian.com</a>]</td>
<td>A link to an email address.</td>
</tr>
<tr>
<td>[file://z:/file/on/network/share.txt]</td>
<td>A link to a file on your computer or on a network share that you have mapped to a drive. <em>This only works on Internet Explorer.</em></td>
</tr>
</tbody>
</table>
Note that Confluence treats headings as anchors, so you can link to headings using this pattern: [spacekey:pagename#headingname], where headingname is case-sensitive and must be entered without spaces.

For each of these link forms:

- You can prepend a link alias, so that alternate text is displayed on the page. Example: [link alias|pagetitle#anchor]
- You can append a link tip, which appears as a tooltip. Example: [pagetitle#anchor|link tip]

**Images**

You can display images from attached files or remote sources.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>!<a href="http://www.host.com/image.gif">http://www.host.com/image.gif</a>!</td>
<td>An image from a remote source is displayed on the page. Uses a fully qualified URL.</td>
</tr>
<tr>
<td>!attached-image.gif!</td>
<td>An image file attached to the page is displayed.</td>
</tr>
<tr>
<td>!pageTitle^image.gif!</td>
<td>An image file attached to a different page is displayed.</td>
</tr>
<tr>
<td>!spaceKey:pageTitle^image.gif!</td>
<td>An image file attached to a page in a different space is displayed.</td>
</tr>
<tr>
<td>!/2010/05/23/My Blog Post^image.gif!</td>
<td>An image file attached to a blog post is displayed.</td>
</tr>
<tr>
<td>!image.jpg^thumbnail!</td>
<td>The image is displayed as a thumbnail on the page (only works with images that are attached to the page). Users can click on the thumbnail to see the full-sized image. Thumbnails must be enabled by the site administrator for this to work.</td>
</tr>
<tr>
<td>!image.gif^align=right, vspace=4!</td>
<td>For any image, you can specify attributes of the HTML image tag as a comma separated list of name=value pairs.</td>
</tr>
</tbody>
</table>

Available HTML image tags include:

<table>
<thead>
<tr>
<th>Image tag</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>align</td>
<td>Available values are 'left', 'right', 'bottom', 'center', 'top'.</td>
</tr>
<tr>
<td>border</td>
<td>Specifies the width of the border (in pixels).</td>
</tr>
<tr>
<td>bordercolor</td>
<td>Use with the 'border' tag. Specify colours by name or hex value.</td>
</tr>
<tr>
<td>hspace</td>
<td>Specifies the amount of whitespace to be inserted to the left and right of the image (in pixels).</td>
</tr>
<tr>
<td><strong>vspace</strong></td>
<td>Specifies the amount of whitespace to be inserted above and below the image (in pixels).</td>
</tr>
<tr>
<td><strong>width</strong></td>
<td>Specifies the width of the image (in pixels). This will override the natural width of the image.</td>
</tr>
<tr>
<td><strong>height</strong></td>
<td>Specifies the height of the image (in pixels). This will override the natural height of the image.</td>
</tr>
<tr>
<td><strong>title</strong></td>
<td>Specifies alternate text for the image, which is displayed when the pointer hovers over the image.</td>
</tr>
<tr>
<td><strong>alt</strong></td>
<td>Specifies alternate text for the image. This text is retrievable via search, and contributes to accessibility of the page for text-only viewing.</td>
</tr>
</tbody>
</table>

**Page Layouts**

There is no wiki markup representation for page layouts.

**Useful Information**

- A **space key** is a short, unique identifier for a space. For example, you might give your documentation space a key of "DOC". To find the key of an existing space, look at the Confluence URL for a page in the space. The standard Confluence URL has this format:

  http://my.confluence.site.com/display/SPACEKEY/Page+Name

- If you would like to edit the XML source of a page, your Confluence system administrator will need to install the Confluence Source Editor plugin. See more about the Confluence Source Editor Confluence Storage Format.

- Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

**Confluence Wiki Markup for Macros**

- Work in progress
  
  We are adding the details for each macro in turn. They are not all here yet. See CONF-24972 - Authenticate to see issue details. In the meantime, please refer to the Confluence 3.5 macro documentation.

This page is an extension of Confluence Wiki Markup. It describes the wiki markup used to define specific Confluence macros – the macros that are shipped with Confluence. For each macro, we define the macro name, parameter names, and accepted parameter values.

Wiki markup is useful when you want to do one of the following:
- Configure the Documentation theme.
- Type wiki markup directly into the editor. Confluence will convert it to the rich text editor format as you type.
- Create links using the Advanced tab of the Links Browser.
• Insert a block of wiki markup into the Confluence editor. (Choose Insert > Wiki Markup.)

Note: You cannot edit content in wiki markup. Confluence does not store page content in wiki markup. Although you can enter wiki markup into the editor, Confluence will convert it to the rich text editor format immediately. You will not be able to edit the wiki markup after initial entry.

Anchor macro

Allows you to link to a specific part of a page.

Macro name: anchor

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The name of the anchor.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example:

{anchor:here}

On this page:

- Anchor macro
- Attachments macro
- Blog Posts macro
- Change-History macro
- Chart macro
- Cheese macro
- Children Display macro
- Code Block macro
- Column macro
- Content by Label macro
- Content by User macro
- Contributors macro
- Contributors Summary macro
- Expand macro
- Info macro
- Section macro
- Table of Contents macro
- Notes

Related pages:

- Confluence Wiki Markup
- Working with Confluence Markup
- Working with Macros
- Confluence User's Guide
**Attachments macro**

Displays a list of attachments on a given page.

**Macro name:** attachments

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>old</td>
<td>No</td>
<td>false</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false - Displays only the latest version of each attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true – Displays all versions of each attachment, including the old versions.</td>
</tr>
<tr>
<td>patterns</td>
<td>No</td>
<td>(None)</td>
<td>A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match a file suffix of 'jpg', use .'jpg (not *.jpg).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match file names ending in 'jpg' or 'png', use .*jpg,.*png</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Here is a tutorial on regular expressions.</td>
</tr>
<tr>
<td>sortBy</td>
<td>No</td>
<td>date</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• size</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• name</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page on which the macro exists.</td>
<td>Page name, used to display attachments from another page.</td>
</tr>
</tbody>
</table>
### sortOrder

| No |

The default sort order is determined by the `sortBy` type:
- Reverse chronological for 'date'.
- Largest to smallest for 'size'.
- Alphabetical for 'name'.

**Available values:**
- ascending
- descending

### labels

| No |

A comma-separated list of labels. Confluence will show only attachments that have **all** the labels specified. (The match is an AND, not an OR.)

### upload

| No |

Determines whether the list of attachments will include options allowing users to browse for, and attach, new files.

**Example:**

```plaintext
{attachments:old=false|patterns=.*png,.*jpg|sortby=name|page=My page about chocolate|sortorder=descending|labels=chocolate,cookies|upload=false}
```

---

**Blog Posts macro**

Lists the most recent news items in the space.

**Macro name:** blog-posts

**Macro body:** None.
<table>
<thead>
<tr>
<th>content</th>
<th>No</th>
<th>entire</th>
</tr>
</thead>
</table>

Available values:
- **entire** – Display the whole content of each blog post.
- **excerpts** – Display a short extract from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post.
- **titles** – Display a list of blog posts, showing titles only.

<table>
<thead>
<tr>
<th>spaces</th>
<th>No</th>
<th>@self</th>
</tr>
</thead>
</table>

One or more space keys, separated by a comma or a space.
To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.

To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>author</strong></td>
<td>No</td>
<td>(None)</td>
<td>One or more usernames, separated by commas.</td>
</tr>
</tbody>
</table>
| **time** | No | (None) | Available values:  
- **m** — Minutes  
- **h** — Hours  
- **d** — Days  
- **w** — Weeks  
For example,  
- **time=12h** — Display blog posts created in the last twelve hours.  
- **time=7d** — Display blog posts created in the last seven days. |
<p>| <strong>reverse</strong> | No | false | A value of <code>true</code> changes the sort order. |</p>
<table>
<thead>
<tr>
<th><strong>sort</strong></th>
<th><strong>No</strong></th>
<th><strong>creation</strong></th>
<th><strong>Available values:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>title</strong> — Sort alphabetically by title.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>creation</strong> — Sort by the date on which the content was added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>modified</strong> — Sort by the date on which the content was last updated.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>max</strong></th>
<th><strong>No</strong></th>
<th><strong>15</strong></th>
<th><strong>The maximum number of results to be displayed.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>label</strong></td>
<td><strong>No</strong></td>
<td><strong>(None)</strong></td>
<td><strong>One or more label values, separated by a comma or a space.</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of <code>badpage</code> you will get only content which is not labelled with 'badpage'.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To indicate that the results <strong>must</strong> match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of <code>superpage,goodpage</code> you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
</tbody>
</table>

**Example:**

```
{blog-posts:content=titles|spaces=@self,ds|author=jsmith|time=4w|reverse=true|sort=creation|max=10|label=chocolate,cookies}
```

*Change-History macro*
Displays a history of updates made to a page.

**Macro name:** change-history

**Macro body:** None.

**Parameters:** None

**Example:**

```
{change-history}
```

---

**Chart macro**

Displays a chart based on tabular data.

**Macro name:** chart

**Macro body:** Accepts rich text, consisting of tables that hold the chart’s data.

This macro recognises a large number of parameters, listed here by type for convenience.

**Chart type parameters**

These parameters determine the type of chart to display and how the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| type      | No       | pie     | The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based. See the `timeSeries` parameter. Available values:  
- *Standard charts* – pie, bar, line, area  
- *XY plots* – xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries  
- *Other charts* – gantt (beta) |

---
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| orientation | No       | vertical | The display orientation. Applies to area, bar and line charts.
|            |          |         | Available values:
|            |          |         | • vertical – y-axis is vertical
|            |          |         | • horizontal – x-axis is vertical |
| 3D         | No       | false   | Show in three dimensions. Applies to area, bar and line charts. |
| stacked    | No       | false   | Stacked values. Applies to area and bar charts. |
| showShapes | No       | true    | Applies to line charts. Shapes are shown at each data point. |
| opacity    | No       |         | A percentage value between 0 (transparent) and 100 (opaque) that determines how opaque the foreground areas and bars are. |

**Chart display parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>dataDisplay</td>
<td>No</td>
<td>false</td>
<td>Determines whether to display the body of the macro, consisting of the data table. By default, the chart data table is not displayed.</td>
</tr>
</tbody>
</table>
|            |          |         | Available values:
|            |          |         | • false – the data is not displayed. |
|            |          |         | • true or after – the data is displayed after the chart. |
|            |          |         | • before – the data is displayed before the chart. |
imageFormat | No | png | The image format to be used for the chart.

Available values:
- png
- jpg

Chart title and label parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>subTitle</td>
<td>No</td>
<td>(None)</td>
<td>A subtitle for the chart.</td>
</tr>
<tr>
<td>xLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>yLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>legend</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show a legend (key) for the chart.</td>
</tr>
</tbody>
</table>

Chart data parameters

The data for the chart is taken from tables found in the macro body. The parameters below control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. You can specify additional conversion options using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tables</td>
<td>No</td>
<td>All first level tables</td>
<td>You can supply a comma-separated list of table IDs and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td><strong>columns</strong></td>
<td>No</td>
<td>All columns</td>
<td>You can supply a comma-separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the HTML title attribute for the column in the header row.</td>
</tr>
</tbody>
</table>
| **dataOrientation** | No | horizontal | The content orientation. By default, the data tables will be interpreted as columns (horizontally) representing domain and x values. Available values:  
- **vertical** – data table columns will be interpreted as series.  
- **horizontal** – data tables rows will be interpreted as series. |
<p>| <strong>timeSeries</strong> | No | false | If 'true', the x values in an XY plot will be treated as time series data and so will be converted according date formats. |
| <strong>dateFormat</strong> | No | Confluence language defined date formats | For time series data, the date format allows for additional customisation of the conversion of data to date values. If a date format is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See <a href="#">simple date format</a>. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>timePeriod</td>
<td>No</td>
<td>day</td>
<td>The time period for time series data. Defines the granularity of how the data is interpreted. Available values: millisecond, second, minute, hour, day, week, month, quarter, year.</td>
</tr>
<tr>
<td>language</td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the country parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Available values are the two-character ISO 639-1 alpha-2 codes.</td>
</tr>
<tr>
<td>country</td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the language parameter to form a locale. Valid values are the two-character ISO 3166 codes.</td>
</tr>
</tbody>
</table>
| forgive     | No       | true    | Determines whether the macro will forgive (allow) some data formatting errors. Available values: 
- **true** — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats. 
- **false** — the macro enforces strict data formatting. If there are data format errors, the chart will not be produced. |

**Chart colour parameters**

Colours are specified using hexadecimal notation or HTML colour names.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bgColor</td>
<td>No</td>
<td>White</td>
<td>Background colour of the chart.</td>
</tr>
<tr>
<td>borderColor</td>
<td>No</td>
<td>No border</td>
<td>Colour of the border around the chart.</td>
</tr>
<tr>
<td>colors</td>
<td>No</td>
<td></td>
<td>A comma-separated list of colours used to customise the colours of categories, sections, and series.</td>
</tr>
</tbody>
</table>

**Chart axis parameters**

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rangeAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Minimum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Maximum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>rangeAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>domainAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the dateFormat parameter.</td>
</tr>
<tr>
<td>domainAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the dateFormat parameter.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>domainAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the <code>timePeriod</code> parameter. The <code>timePeriod</code> unit can be overridden by specifying a trailing character: <code>y</code> (years), <code>M</code> (months), <code>d</code> (days), <code>h</code> (hours), <code>m</code> (minutes), <code>s</code> (seconds), <code>ms</code> (milliseconds).</td>
</tr>
<tr>
<td>domainAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
</tr>
<tr>
<td>categoryLabelPosition</td>
<td>No</td>
<td>(None)</td>
<td>Placement of the axis label text for categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>up45</code> — 45 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>up90</code> — 90 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>down45</code> — 45 degrees going downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>down90</code> — 90 degrees going downward</td>
</tr>
<tr>
<td>dateTickMarkPosition</td>
<td>No</td>
<td><code>start</code></td>
<td>Placement of the date tick mark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>start</code> — tick mark is at the start of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>middle</code> — tick mark is in the middle of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>end</code> — tick mark is at the end of the date period.</td>
</tr>
</tbody>
</table>

**Pie chart Parameters**
### pieSectionLabel

<table>
<thead>
<tr>
<th></th>
<th>No</th>
<th>Show only the pie section key value</th>
</tr>
</thead>
</table>

Format of pie section labels. The format uses a string with special replacement variables:
- `%0%` is replaced by the pie section key.
- `%1%` is replaced by the pie section numeric value.
- `%2%` is replaced by the pie section percent value.

**Example 1:** To display something like 'Independent = 20':

```
%0% = %1%
```

**Example 2:** To display something like 'Independent (20%)':

```
%0% (%2%)
```

### pieSectionExplode

<table>
<thead>
<tr>
<th></th>
<th>No</th>
<th>No exploded sections</th>
<th>A comma-separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher.</th>
</tr>
</thead>
</table>

**Chart attachment parameters**

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access to re-use the attachment. This can be useful especially when combined with the Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>
| attachment              | No      | The name and location where the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified. Available syntax for this parameter:  
  - `^attachmentName.png` — the chart is saved as an attachment to the current page.  
  - `page name^attachmentName.png` — the chart is saved as an attachment to the page name provided.  
  - `spacekey:page name^attachmentName.png` — the chart is saved as an attachment to the page name provided in the space indicated. |
| attachmentVersion       | No      | Defines the the versioning mechanism for saved charts. Available values:  
  - `new` — creates new version of the attachment.  
  - `replace` — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorised to remove attachments for the page specified.  
  - `keep` — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated. |
| attachmentComment       | No      | Comment used for a saved chart attachment. (None) |
Example:

Below is a simple example of a pie chart. See more examples in Wiki Markup Examples for Chart Macro.

{chart:type=pie\title=Fish Sold}

<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2004</th>
<th>2005</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herring</td>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<td>Salmon</td>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<td>Tuna</td>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>

{chart}

Cheese macro

Displays the words "I like cheese!"

Macro name: cheese

Macro body: None.

Parameters: None

Example:

{cheese}

Children Display macro

Displays the children and descendants of the current page.

Macro name: children

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the sort order in the list of child pages. Use this parameter in conjunction with the sort parameter described below. A value of true will change the sort order from ascending to descending.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>sort</td>
<td>No</td>
<td>Manual if the pages have been manually reordered, otherwise alphabetical by page title. Determines the sort order of the list of child pages. Available values: - <code>creation</code> – Sort by the date on which the page was created. - <code>title</code> – Sort alphabetically by page name. - <code>modified</code> – Sort by the date on which the page was last updated.</td>
<td></td>
</tr>
<tr>
<td>style</td>
<td>No</td>
<td>Bullet list. A heading style to be applied to the list of child pages. Available values: <code>h1</code> (heading level 1) through to <code>h6</code> (heading level 6).</td>
<td></td>
</tr>
</tbody>
</table>
| page      | No      | The page that contains the macro. The name of the parent page. The macro will display the children of the specified page. To specify a page in a different space, use a space key followed by a colon. For example: `MYSPACE:My page`.
If the value of this parameter is a forward slash (`/`) the macro will list the pages at the root of the current space. In other words, the pages without parents. |
<p>| excerpt   | No      | false. If <code>true</code>, Confluence will display any excerpts that are defined on the child pages. The excerpts must be defined via an Excerpt macro. |</p>
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>first</td>
<td>No</td>
<td>(None)</td>
<td>The maximum number of child pages to be displayed (at the top level). For example, if the value of this parameter is 99, the macro will display the first 99 pages at the top level. It will also display their children, as determined by the depth and all parameters.</td>
</tr>
<tr>
<td>depth</td>
<td>No</td>
<td>(None)</td>
<td>The number of levels of child pages to display. For example, if the value is 2, the macro will display 2 levels of child pages.</td>
</tr>
<tr>
<td>all</td>
<td>No</td>
<td>false</td>
<td>If true, Confluence will display all levels of child pages. This setting will override the depth setting.</td>
</tr>
</tbody>
</table>

Example:

```
{children:reverse=true|sort=creation|style=h4|page=Home|excerpt=true|first=99|depth=2|all=true}
```

**Code Block macro**

Displays code in your document with the appropriate syntax highlighting.

**Macro name:** code

**Macro body:** Accepts plain text.
| theme     | No | Confluence | Specifies the colour scheme used for displaying your code. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. Available themes:
- Django
- Emacs
- FadeToGrey
- Midnight
- RDark
- Eclipse
- Confluence (same as default) |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>linenumbers</td>
<td>No</td>
<td>false</td>
<td>If true, a line number will be shown to the left of each line of code. Numbering is incremented by 1. If false, no line numbers are shown.</td>
</tr>
</tbody>
</table>
| language | No | java | Specifies the language (or environment) for syntax highlighting.  
|---|---|---|---|
| | | | - (none) — that is, no syntax highlighting  
| | | | - actionscript3  
| | | | - bash  
| | | | - csharp — that is, C#  
| | | | - coldfusion  
| | | | - cpp — that is, C++  
| | | | - css  
| | | | - delphi  
| | | | - diff  
| | | | - erlang  
| | | | - groovy  
| | | | - java  
| | | | - javafx  
| | | | - javascript  
| | | | - perl  
| | | | - php  
| | | | - powershell  
| | | | - python  
| | | | - ruby  
| | | | - scala  
| | | | - sql  
| | | | - vb — that is, Visual Basic  
| | | | - html/xml  
| firstline | No | 1 | When linenumbers is true, this value defines the number of the first line of code.  
| collapse | No | false | If true, the code macro’s content will be collapsed upon visiting or refreshing the Confluence page. Clicking the ‘expand source’ link allows you to view the content.  
| | | | If false, the code macro’s content is always displayed in full.  

Example:
Column macro

Used with the Section macro to define columns on a page. See Working with page layouts and columns and sections.

Macro name: column

Macro body: Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>The width of the column. Can be specified either in pixels (for example, 400px) or as a percentage of the available page width (for example, 50%).</td>
</tr>
</tbody>
</table>

Example:

```
{column:width=100px}
This is the content of *column 1*.
{column}
```

Content by Label macro

Displays a list of content associated with specific labels.

Macro name: contentbylabel

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaces</td>
<td>No</td>
<td>@all</td>
<td></td>
</tr>
</tbody>
</table>
Filters the results by space. The macro will display only the pages and other content types which belong to the space(s) you specify here.

You can specify one or more space keys, separated by a comma or a space.

- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.
- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@self</td>
<td></td>
<td>The current space.</td>
</tr>
<tr>
<td>@personal</td>
<td></td>
<td>All personal spaces.</td>
</tr>
<tr>
<td>@global</td>
<td></td>
<td>All global spaces.</td>
</tr>
<tr>
<td>@favorite</td>
<td></td>
<td>The spaces you have marked as favourite.</td>
</tr>
<tr>
<td>@favourite</td>
<td></td>
<td>The same as @favorite above.</td>
</tr>
<tr>
<td>@all</td>
<td></td>
<td>All spaces in your Confluence site.</td>
</tr>
<tr>
<td>*</td>
<td></td>
<td>The same as @all above.</td>
</tr>
</tbody>
</table>

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author</td>
<td>No</td>
<td>(None) Filters the results by author. The macro will display only the pages and other content types which are written or updated by the author(s) you specify here. You can specify one or more authors, separated by a comma.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None) Adds a heading to the list.</td>
</tr>
<tr>
<td>showLabels</td>
<td>No</td>
<td>true Determines whether to display the matching labels in the list of results.</td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>false Use this parameter in conjunction with the sort parameter. Set reverse=true to change the sort from ascending to descending. This parameter is ignored if the sort parameter is not specified.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Value</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| sort      | No       | modified | Determines how the results are sorted. To change the sort order from ascending to descending, use the reverse parameter described above. If this parameter is not specified, the sort order defaults to descending order based on the last modification date. Values:  
  - title — Sort alphabetically by title.  
  - creation — Sort by the date on which the content was added.  
  - modified — Sort by the date on which the content was last updated. |
<p>| max       | No       | 15    | Determines the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied. |
| excerpt   | No       | false | If this parameter is set to true, the macro displays an excerpt from each page listed in the results. Note that you must define the excerpts on each of those pages, by adding the Excerpt macro to each page. If a particular page does not have an excerpt defined, then the Content by Label macro will not attempt to show an excerpt for that page. The Content by Label macro will show only the first few lines of the excerpt for each page. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>labels</strong></td>
<td>Yes</td>
<td>(None) Use this parameter to filter the results by label. The macro will display only the pages and other content types which are tagged with the label(s) you specify here. See also the <code>operator</code> parameter. You can specify one or more label values, separated by a comma or a space. <strong>•</strong> To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of <code>-badpage</code> you will get only content which is not labelled with 'badpage'. <strong>•</strong> To indicate that the results <strong>must</strong> match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of <code>+superpage,+goodpage</code> you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
<tr>
<td><strong>showSpace</strong></td>
<td>No</td>
<td>true Determines whether to display the spaces in the list of results.</td>
</tr>
</tbody>
</table>
| type       | No | All | Filters the results by content type. The macro will display only the content of the type you specify here.

You can specify one or more types, separated by a comma or a space.

To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of `-blogpost` you will get pages and all other content except for blog posts.

Available values:
- `page` — pages.
- `blogpost` or `news` — blog posts, also known as news items.
- `attachment` — attachments. |
The operator to apply to the supplied lists of labels. By default, a page with any of the non-prefixed labels (that is, labels without a plus (+) or minus (-) sign immediately preceding it) will be listed. If you specify a value of AND, only pages with all of the supplied non-prefixed labels will be listed.

Note that this parameter only modifies the behaviour of the 'Label(s)' parameter and only affects label values without a plus (+) or minus (-) sign prefix. To avoid confusion or unexpected results, we recommend that you do not use the operator parameter in conjunction with any label values prefixed with '+' or '-' signs.

Example:

```
{contentbylabel:spaces=@personal,@self|author=admin,smaddox|title=My labelled pages|showLabels=false|reverse=true|sort=creation|max=10|excerpt=true|labels=chocolate,cake|showSpace=false|type=page|operator=AND}
```

**Content by User macro**

Displays a list of the content items that have been created by a specified Confluence user.

**Macro name:** content-by-user

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The Confluence username for the person whose content you wish to display</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example:
**Contributors macro**

Displays a list of Confluence users who have made a contribution of some type to a page.

**Macro name:** contributors

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors displayed in the list.</td>
</tr>
</tbody>
</table>
| spaces         | No       | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
- @global — All global spaces.  
- @personal — All personal spaces.  
- @all — All spaces in the Confluence site.  
You can specify one or more space keys or special values, separated by commas.  
If no page and labels are specified, all pages from the specified set of spaces are included. |
<p>| reverse        | No       | false   | Reverses the order of contributors in the list. Must be used in conjunction with the order parameter. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| scope           | No      | Specifies additional pages to include when generating the list of contributors. Available values:  
|                 |         | - children – only the child pages of the specified page.  
|                 |         | - descendants – all descendants of the specified page.  
| labels          | No      | Limits the list of contributors to those who created the specified labels on a page. You can specify one or more labels, separated by commas.  
| showPages       | No      | false  
| noneFoundMessage| No      | "No contributors found for:" (and a summary of selected parameter values)  
| showCount       | No      | false  
| contentType     | No      | Both pages and blog posts  
|                 |         | Restricts the content type that the macro will use when generating the list of contributors. Available values:  
|                 |         | - pages  
|                 |         | - blogposts – blog posts.  

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| include | No | authors | Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:
- **authors** - includes people who created or have edited the page(s)
- **comments** - includes people who have added comments to the page(s)
- **labels** - includes people who have added labels to the page(s)
- **watches** - includes people who are watching the page(s).
You can specify one or more contribution types, separated by commas. |
| mode | No | inline | Determines how the list of contributors is formatted:
- **inline** — a comma-separated list
- **list** — a bullet list. |
| showAnonymous | No | false | Determines whether to include those who contributed anonymously to a page. |
| order | No | count | Specifies the criteria used to sort contributors. Sort criteria are:
- **count** — sorts the names based on the total number of contributions to the page(s)
- **name** — sorts the names into alphabetical order
- **update** — sorts the names by the date of their last contribution to the page(s). |
<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>The current page</td>
<td>Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed.</td>
</tr>
<tr>
<td>showLastTime</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show the last time each person made a contribution.</td>
</tr>
<tr>
<td>publishDate</td>
<td>No</td>
<td>(None)</td>
<td>Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.</td>
</tr>
</tbody>
</table>

**Example:**

This example specifies a content type of blog posts:

```
{contributors:limit=10|spaces=ds,@personal|reverse=true|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=blogposts|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|showLastTime=true|publishDate=2012/06/30}
```

This example specifies a content type of pages:

```
{contributors:limit=10|spaces=ds,@personal|reverse=true|scope=descendants|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=pages|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|page=ds:Advanced Topics|showLastTime=true}
```

**Contributors Summary macro**

Displays a table of contribution-based statistics for a set of pages.

**Macro name:** contributors-summary

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors or pages displayed in the table.</td>
</tr>
</tbody>
</table>
| spaces    | No       | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
- `@global` — All global spaces.  
- `@personal` — All personal spaces.  
- `@all` — All spaces in the Confluence site. You can specify one or more space keys or special values, separated by commas. If no page and labels are specified, all pages from the specified set of spaces are included. |
| reverse   | No       | false         | Reverses the order of items in the table. Must be used in conjunction with the `order` parameter. |
| showAnonymous | No       | false         | Determines whether to include those who contributed anonymously to a page. |
| scope     | No       | The specified page only | Specifies additional pages to include when generating the list of contributors. Available values:  
- `children` — only the child pages of the specified page.  
- `descendants` — all descendants of the specified page. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| order     | No       | edits | Sets the criterion used for sorting items in the table. Available values:  
- **edit** - sorts items in the table based on the total number of edits made, either by a contributor or to a page.  
- **name** - sorts items in the table in alphabetical order, either by contributor or page name.  
- **editTime** - sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.  
- **update** - sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it. |
| page      | No       | The current page | A page title. Specifies the page to use when generating the list of contributors. If **page** and **spaces** are left blank, the current page is assumed. |
| labels    | No       | (None) | Limits contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas. |
| columns   | No       | edits, comments, labels | Determines the columns that should appear in the table. The statistics or type of information presented depends on the **groupby** parameter. |
Available values:

- **edits** – the number of times each contributor has edited the page(s) or the number of edits made to each page.
- **edited** – a list of the pages edited by each contributor or a list of contributors who have edited each page.
- **comments** – the number of times each contributor has added comments to the page(s) or the number of comments on each page.
- **commented** – a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
- **labels** – the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- **labeled** – a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- **labellist** – a list of labels either added by each contributor or on each page.
- **watches** – the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
**watching** – a list of pages being watched by each contributor/person or a list of contributors/people watching each page.

**lastupdate** – the last time each contributor made an update or when each page was last updated. Valid updates can include edits, comments or label modifications to a page.

You can specify one or more columns, separated by commas.

<table>
<thead>
<tr>
<th>groupby</th>
<th>No</th>
<th>contributors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the basis for grouping contribution-based statistics:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>contributors – group by the people who have contributed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pages – group by the pages used to find the contributors.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>contentType</th>
<th>No</th>
<th>Both pages and blog posts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restricts the content type that the macro will use when generating the list of contributors.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available values:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pages – pages</td>
<td></td>
<td></td>
</tr>
<tr>
<td>blogposts – blog posts</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>showZeroCounts</th>
<th>No</th>
<th>false</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determines whether contributors or pages are included for which the calculated statistic is zero.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>publishDate</th>
<th>No</th>
<th>(None)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**
This example specifies a content type of blog posts:

```
{contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|order=update|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupBy=pages|contentType=blogposts|showZeroCounts=true|publishDate=2012/06/07}
```

This example specifies a content type of pages:

```
{contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|scope=descendants|order=update|page=ds:Advanced Topics|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupBy=pages|contentType=pages|showZeroCounts=true}
```

**Expand macro**

Displays an expandable/collapsible section of text.

**Macro name:** expand

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>No</td>
<td>Click here to expand...</td>
<td>Text that will be displayed on the line that people can click to expand the hidden text.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```
{expand:This is my message}
This text is _hidden_ until you expand it.
{expand}
```

**Info macro**

Displays a block of text in a blue highlight box.

**Macro name:** info

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter name</td>
<td>Required</td>
<td>Default</td>
<td>Parameter description and accepted values</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>---------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>icon</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the icon in the title bar of the information box.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
</tbody>
</table>

Example:

```
{info:title=This is my title|icon=false}
This is _important_ information.
{info}
```

Section macro

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

Macro name: section

Macro body: Rich text, consisting of one or more Column macros.

Example:

```
{section:border=true}
{column:width=100px}
This is the content of *column 1*.
{column}
{column}
This is the content of *column 2*.
{column}
{section}
```

Table of Contents macro

Displays a table of contents from your page headings.

Macro name: toc

Macro body: None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>printable</td>
<td>No</td>
<td>true</td>
<td>If you set this parameter to false, the table of contents will not be visible when you print the page.</td>
</tr>
<tr>
<td>style</td>
<td>No</td>
<td>none</td>
<td>The style of bullet point for each list item. You can use any valid CSS style. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• none — No list style is displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• circle — The list style is a circle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• disc — The list style is a filled circle. This is the typical bullet list, and is the one we are using in this example list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• square — The list style is a square.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• decimal — The list is numbered (1, 2, 3, 4, 5).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• lower-alpha — The list style is lower case, alphabetised (a, b, c, d, e).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• lower-roman — The list style is lower-case roman numerals (i, ii, iii, iv, v, vi).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• upper-roman — The list style is upper-case roman numerals (I, II, III, IV, V, VI).</td>
</tr>
<tr>
<td>maxLevel</td>
<td>No</td>
<td>7</td>
<td>Maximum heading level. Use this parameter to select the highest heading level to include. For example, a value of 2 will list h1 and h2 levels, but will not include h3 and below.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>indent</td>
<td>No</td>
<td>(None)</td>
<td>This parameter applies to vertical lists only (<code>type = list</code>). Use this parameter to indent the list items according to CSS quantities. For example, a value of 10px will successively indent list heading groups by 10 pixels. Level 1 headings will be indented 10px, and level 2 headings by an additional 10px, and so on.</td>
</tr>
<tr>
<td>minLevel</td>
<td>No</td>
<td>1</td>
<td>Minimum heading level. The heading level at which the table of contents will start. For example, a value of 2 will list h2, h3, and h4 headings, but will not include h1 headings.</td>
</tr>
<tr>
<td>class</td>
<td>No</td>
<td>(None)</td>
<td>A CSS class name. If you have a custom style sheet, you can use this parameter to output the table of contents with the specified class attribute.</td>
</tr>
<tr>
<td>exclude</td>
<td>No</td>
<td>(None)</td>
<td>Specifies the headings to exclude by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will include only the headings that match the regular expression. Example: .*/.[1/2] See <a href="https://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html">Sun's Regex documentation</a> for examples of constructing regular expression strings.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **type**    | No       | list  | Defines the overall format of the table of contents. Available values:  
list – displays the table of contents in a vertical list.  
flat – displays a horizontal series of links. For example: [Heading 1] [Heading 2] [Heading 3]. |
| **outline** | No       | false | A value of true will apply outline numbering to the headings as displayed in the table of contents. For example: 1.1, 1.2, 1.3. |
| **separator** | No       | brackets | This parameter applies to flat lists only (type = flat). Use this parameter to style the display of a flat list. Available values:  
brackets – Each item is enclosed by square brackets: [ ].  
braces – Each item is enclosed by braces: { }.  
parens – Each item is enclosed by parentheses: ( ).  
pipe – The items are separated by a pipe: | anything – The items are separated by the value you enter. You can enter any text as a separator, for example ***. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |
**include**  
**No**  
(No)  
Specifies the headings to include by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will ignore any headings that do not match the regular expression. Example: .* \\.[1//2]  
See Sun's Regex documentation for examples of constructing regular expression strings.

**Example:**

This example shows a list-type table of contents.

```markdown
{toc:printable=true|style=square|maxLevel=2|indent=5px|minLevel=2|class=bigpink|exclude=[1//2]|type=list|outline=true|include=.*}
```

This example shows a flat table of contents.

```markdown
{toc:printable=true|maxLevel=2|minLevel=2|class=bigpink|exclude=[1//2]|type=flat|outline=true|separator=pipe|include=.*}
```

**Notes**

- The 'Required' column indicates whether the parameter is required on data entry. If the parameter is not supplied, Confluence will insert default values as indicated in the 'Default' column.
- Wiki markup is not case sensitive. For example, you can specify a parameter name of sortBy or sortby.
- For a few macros in wiki markup, the default parameter may be unnamed. The examples on this page show the macros concerned. In such cases, the unnamed parameter is always the first parameter specified.
- **A request from the Atlassian technical writers about comments and feedback:** We would like to distinguish between the documentation of the current solution (this page) and any discussion of the solution and possible changes to Confluence wiki markup and/or the XHTML-based storage format. If you have a suggestion for, or correction of, this documentation, please add your suggestion to this page. If you have feedback on the Confluence markup, storage format and related functionality, please add your suggestion to the page titled Confluence 4 Editor - Customer Feedback. Thanks😊

**Wiki Markup Examples for Chart Macro**

This page is an extension of Confluence Wiki Markup for Macros, which contains wiki markup examples for all Confluence macros. The Chart macro is a special case, because it offers so many options via parameters and chart types. This page offers additional examples for the Chart macro.

**Pie chart**
Here is a simple example of a pie chart.

Wiki markup

```
{chart:type=pie|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |
|| Salmon | 2,900 | 4,200 |
|| Tuna | 1,500 | 1,500 |
{chart}
```

Resulting chart

**Fish Sold**

- 2004 (1,500 - 50%)
- 2005 (1,500 - 50%)

Bar chart

Here is a simple example of a bar chart.

Wiki markup

```
{chart:type=bar|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |
|| Salmon | 2,900 | 4,200 |
|| Tuna | 1,500 | 1,500 |
{chart}
```

Resulting chart
Time series chart

Here is an example of a time series chart.

Wiki markup

```{chart:type=timeSeries|dateFormat=MM/yyyy|timePeriod=Month|
dataOrientation=vertical|rangeAxisLowerBound=0|domainaxisrotateticklabel=true}|| Month || Revenue ||
| 1/2005 | 31.8 |
| 2/2005 | 41.8 |
| 3/2005 | 51.3 |
| 4/2005 | 33.8 |
| 5/2005 | 27.6 |
| 6/2005 | 49.8 |
| 7/2005 | 51.8 |
| 8/2005 | 77.3 |
| 9/2005 | 73.8 |
| 10/2005 | 97.6 |
| 11/2005 | 101.2 |
| 12/2005 | 113.7 |

|| Month || Expenses ||
| 1/2005 | 41.1 |
| 2/2005 | 43.8 |
| 3/2005 | 45.3 |
| 4/2005 | 45.0 |
| 5/2005 | 44.6 |
| 6/2005 | 43.8 |
| 7/2005 | 51.8 |
| 8/2005 | 52.3 |
| 9/2005 | 53.8 |
| 10/2005 | 55.6 |
| 11/2005 | 61.2 |
| 12/2005 | 63.7 |
{chart}```

Resulting chart
Here is an example of an XY line chart.

Wiki markup

```
{chart:type=xyline}
<table>
<thead>
<tr>
<th></th>
<th></th>
<th>12</th>
<th>14</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
<td></td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
<td></td>
</tr>
</tbody>
</table>
{chart}
```

Resulting chart

Here is an example of an XY bar chart.

Wiki markup
Here is an example of an XY area chart.

Wiki markup

```wiki
{chart:type=xyarea}

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
</tr>
</tbody>
</table>
{chart}
```

Resulting chart
Here are two examples of area charts.

**Wiki markup for area chart 1**

```
{chart:type=area|dataDisplay=true|legend=true|width=300|height=300|opacity=50}
|| Satisfaction || 2002 || 2003 || 2004 ||
| Very satisfied | 20 | 23 | 34 |
| Satisfied | 40 | 34 | 23 |
| Disatisfied | 25 | 26 | 25 |
| Very disatisfied | 15 | 17 | 18 |
{chart}
```

**Resulting area chart 1**
Working with Confluence Gadgets

This section introduces the concept of gadgets in Confluence and provides an outline on how to use gadgets in Confluence and other web applications.

On this page:
Introduction to Gadgets in Confluence

A gadget is a small object (i.e. a piece of functionality) offering dynamic content that can be placed into the page of:

- An Atlassian application's website, such as a Confluence page or blog post or a JIRA 4.0+ dashboard.
- A third-party application's website, such as iGoogle or Gmail. (But see the limitations on using Confluence gadgets in other applications.)

Gadgets allow interactions between Confluence and other compatible websites. Confluence interacts with gadgets that support the OpenSocial specification.

For more information about Atlassian gadgets, please refer to the introduction to Atlassian gadgets and the big list of Atlassian gadgets.

Using Gadgets in Confluence

You can place any gadget that complies with the OpenSocial specification from an external source, such as iGoogle or other Atlassian applications such as JIRA 4.0+, onto a Confluence page or blog post. To add a gadget to a page, use the Confluence macro browser to add a Gadget macro.

See the page on adding JIRA gadgets to a Confluence page.

Adding Confluence Gadgets in Other Applications

You can add a Confluence gadget to a JIRA dashboard or another Confluence site. In principle, you can also put a Confluence gadget on any other OpenSocial-compliant website such as iGoogle or Gmail. See the limitations on using Confluence gadgets in other applications.

Adding a Confluence Gadget to JIRA

See Adding a Confluence Gadget to a JIRA Dashboard.

Adding a Confluence Gadget to Non-Atlassian Web Applications

For instructions on how to add Confluence gadgets in another compatible non-Atlassian web application or container, refer to Configuring Confluence Gadgets for Use in Other Applications.

Confluence Gadgets

The Confluence Gadgets topic explains the purpose of the 'Confluence Gadgets' window and provides information about the gadgets which are bundled with Confluence.

Related Topics

Gadget Macro
Configuring Confluence Gadgets for Use in Other Applications
Adding a Confluence Gadget to a JIRA Dashboard
Adding a Confluence Gadget to a JIRA Dashboard

JIRA 4.0 is the first major Atlassian application that can incorporate OpenSocial-compliant gadgets, such as Confluence gadgets onto its dashboard. This page explains how to add a Confluence gadget to the dashboard of a JIRA 4.0+ installation.

To add a Confluence gadget to a JIRA dashboard, complete the sections below in order.

On this page:

- Create an Application Link Between Confluence and JIRA
- Finding a Confluence Gadget's URL
- Adding a Confluence Gadget to a JIRA server's Gadgets Directory
- Adding a Confluence Gadget to the JIRA Dashboard
- Related Topics

Create an Application Link Between Confluence and JIRA

If your Confluence gadgets need to access user-restricted Confluence data, then your Confluence administrator must first establish an Application Link between your Confluence site and the JIRA site. For more information about configuring an Application Link between Confluence and other web applications, refer to Configuring OAuth Authentication for an Application Link.

If you only need to access anonymously accessible Confluence data, then you can proceed to Finding a Confluence Gadget's URL, below.

Finding a Confluence Gadget's URL

The Confluence gadget’s URL is the gadget’s XML specification file. These URLs look something like this:

```
http://example.com/my-gadget-location/my-gadget.xml
```

To find a Confluence gadget’s URL:

1. Choose Browse > Confluence Gadgets. The ‘Confluence Gadgets’ window will open. The ‘Confluence Gadgets’ window displays a list of available Confluence gadgets in your Confluence installation, as shown in the screenshot below. By default, Confluence only includes a few gadgets. However, if your Confluence administrator has installed more Confluence gadgets (typically as Confluence plugins), these will also appear in this list. If a scrollbar is available, use it to find the gadget you want.
2. After finding your gadget, use the Gadget URL link to copy the gadget's URL to your clipboard. Many operating systems and browsers allow you to do this by right-clicking the Gadget URL link and copying it using the context menu.

Screenshot: Finding a gadget's URL
Adding a Confluence Gadget to a JIRA server’s Gadgets Directory

To add a Confluence Gadget to the Gadgets Directory in JIRA:

1. Go to the dashboard by clicking Dashboard at the top left of the screen.
2. The dashboard will appear. Click Add Gadget.
3. The 'Add Gadget' screen appears, showing the list of gadgets in your directory. See screenshot 1 below. Click Add Gadget to Directory.
   - You will only see this button if you have administrator permissions for your dashboard.
4. The 'Add Gadget to Directory' screen appears. See screenshot 2 below. Paste the gadget URL (which you copied to your clipboard above) into the text box.
5. Click Add Gadget.
6. The gadget appears in your gadget directory. (It will be highlighted for a short time, so that you can see it easily.)

Screenshot 1: Gadget directory with 'Add Gadget to Directory' button

Screenshot 2: Add Gadget to Directory screen
In the procedure below, 'your Atlassian dashboard' and 'your Atlassian application' refers to the JIRA Dashboard and application, respectively.

You can add a gadget from the directory of gadgets that are available to your Atlassian application.

To add a gadget to your Atlassian dashboard,
1. Go to the dashboard by clicking the ‘Dashboard’ link or the ‘Home’ link at the top left of the screen.
2. The dashboard will appear, looking something like screenshot 1 below. Click ‘Add Gadget’.
3. The ‘Add Gadget’ screen will display a list of available gadgets in your gadget directory, as shown in screenshot 2 below. Find the gadget you want, using one or more of the following tools:
   - Use the scroll bar on the right to move up and down the list of gadgets.
   - Select a category in the left-hand panel to display only gadgets in that category.
   - Start typing a key word for your gadget in the ‘Search’ textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
4. When you have found the gadget you want, click the ‘Add it Now’ button to add the gadget to your dashboard.

Screenshot 1: An Atlassian dashboard
Adding a Gadget to the Directory of Available Gadgets

You need to have administrator privileges to add a gadget to the list of available gadgets. If you have permission to add gadgets to and remove gadgets from the directory itself, you will see the 'Add Gadget to Directory' and 'Remove' buttons on the 'Add Gadget' screen. Please refer to the Gadgets and Dashboards Administration Guide.

Related Topics

All Atlassian gadgets

Configuring Confluence Gadgets for Use in Other Applications

This page tells you how to add a Confluence gadget to another (external) application. The instructions and examples given in this topic focus on adding and using Confluence Gadgets in other web applications.

Atlassian support does not cover gadgets on external sites like iGoogle and Gmail

In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

Gadgets that display information from Atlassian applications, such as Confluence, should be able to run on iGoogle, Gmail and other web applications that provide OpenSocial containers. Below are specific instructions for iGoogle and Gmail. You can experiment by adding a Confluence gadget to other web sites and applications, such as a Ning community like The Content Wrangler.

On this page:

- Overview of Adding a Confluence Gadget to Another Web Application
- Finding a Confluence Gadget's URL
Overview of Adding a Confluence Gadget to Another Web Application

The exact procedure for adding a Confluence gadget depends on the application where you want to add the gadget. The basic steps are the same:

1. Find the Confluence gadget's URL, i.e. the URL for the gadget's XML specification file.
2. Ensure one of the following two mandatory (typically one-off) procedures have been conducted:
   - An OAuth relationship between Confluence (as the 'service provider') and the other web application (as the 'consumer') has been established. Refer to Configuring OAuth for more information about OAuth and instructions on establishing these relationships.
   - A Trusted Applications relationship between Confluence and JIRA has been established. Refer to Configuring Trusted Applications in the JIRA documentation for more information about establishing these relationships.
3. Follow the procedure provided by the external web application where you want to add the Confluence gadget.

Finding a Confluence Gadget's URL

The Confluence gadget's URL is the gadget's XML specification file. These URLs look something like this:

```
http://example.com/my-gadget-location/my-gadget.xml
```

To find a Confluence gadget's URL:

1. Choose Browse > Confluence Gadgets. The 'Confluence Gadgets' window will open. The 'Confluence Gadgets' window displays a list of available Confluence gadgets in your Confluence installation, as shown in the screenshot below. By default, Confluence only includes a few gadgets. However, if your Confluence administrator has installed more Confluence gadgets (typically as Confluence plugins), these will also appear in this list. If a scrollbar is available, use it to find the gadget you want.
2. After finding your gadget, use the Gadget URL link to copy the gadget's URL to your clipboard. Many operating systems and browsers allow you to do this by right-clicking the Gadget URL link and copying it using the context menu.

Screenshot: Finding a gadget's URL
Adding an Atlassian Gadget to iGoogle

You can customise your iGoogle home page by adding gadgets and moving them around on the page.

To add an Atlassian gadget to your iGoogle page:

1. First find the gadget's URL as described above.
2. Go to iGoogle and log in if you have a username and password.
3. Click Add stuff near the top right of the iGoogle page.
4. The Google gadget directory will appear, showing a list of available gadgets. Click Add feed or gadget in the right-hand panel.
5. A text box will open, as shown above. Enter or paste the gadget's URL from your clipboard into the textbox and click Add.
6. Go back to your iGoogle home page. The gadget will appear on your iGoogle page.

Adding an Atlassian Gadget to Gmail

You can add gadgets to the left-hand panel of your Gmail page.

To add an Atlassian gadget to your Gmail page:

1. First find the gadget's URL as described above.
2. Log in to Gmail.
3. Click Settings near the top right of the Gmail page. The Gmail settings page will appear.
4. Click the Labs tab. The Gmail Labs page will appear. This is a laboratory area or testing ground where Google allows you to use experimental features in Gmail.
5. Scroll down to find the feature called 'Add any gadget by URL'.
6. Select the Enable option, as shown here:
7. Click **Save Changes**.

8. A new **Gadgets** tab will appear on your 'Settings' page. Click the **Gadgets** tab. The 'Gadgets' page will appear, as shown in the screenshot below.

9. Enter or paste your gadget's URL into the **Add a gadget by its URL** box, then click **Add**.

10. The gadget will appear in the left-hand panel of your Gmail page, as shown in the screenshot below.

**Screenshot: Adding a gadget to Gmail**

![Image](https://via.placeholder.com/150)

---

**Limitations and Support**

⚠ **Atlassian support does not cover gadgets on external sites like iGoogle and Gmail**

In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

---

**Related Topics**

- The big list of Atlassian gadgets
Confluence Gadgets

This page describes the purpose of the 'Confluence Gadgets' dialog and how to access it, and provides information about the gadgets that are bundled with Confluence.

Gadgets:

- Interact with and provide access to data in your Confluence installation
- Can be used externally such as on a JIRA 4+ server's dashboard, a page or blog post of another Confluence server, or any compatible page on a web site that accepts gadgets, such as iGoogle. (But see the limitations on using Confluence gadgets in other applications.)

On this page:

- The Confluence Gadgets Dialog
- Confluence Gadgets
- Related Topics

The Confluence Gadgets Dialog

The 'Confluence Gadgets' dialog displays a list of all the Confluence gadgets available in your Confluence installation. The Confluence gadgets bundled with Confluence are described below. Any additional Confluence gadgets installed by your Confluence administrator (typically as Confluence plugins), will also appear in this list.

To access the Confluence Gadgets dialog:

- Choose Browse > Confluence Gadgets. The 'Confluence Gadgets' dialog will open.

Refer to Adding a Confluence Gadget to a JIRA Dashboard or Configuring Confluence Gadgets for Use in Other Applications for more information on adding Confluence gadgets to external applications. A Confluence gadget can also be used within the same Confluence installation, by adding it to a page or blog post using the gadget macro.

Screenshot: The Confluence Gadgets dialog
**Confluence Gadgets**

This following table lists the gadgets which are bundled with Confluence. Click the name of the gadget for more information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Confluence Page Gadget</strong></td>
<td>The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.</td>
</tr>
<tr>
<td><strong>Activity Stream Gadget</strong></td>
<td>The activity stream gadget is similar to the recently updated macro and shows a list of the most recently changed content within your Confluence site.</td>
</tr>
<tr>
<td><strong>Confluence News Gadget</strong></td>
<td>The Confluence news gadget is an example of a 'news feed' gadget that shows a list of recent Confluence Product Blogs and events at Atlassian.</td>
</tr>
<tr>
<td><strong>Confluence Quicknav Gadget</strong></td>
<td>The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Adding a Confluence Gadget to a JIRA Dashboard
- Configuring Confluence Gadgets for Use in Other Applications
- Gadget Macro
- The big list of Atlassian gadgets

**Activity Stream Gadget**

The activity stream gadget is similar to the **recently updated macro** and shows a list of the most recently changed content within your Confluence site.

For instructions on how to use Confluence gadgets in your applications, please see [Confluence Gadgets](#).

In addition to showing a list of most recently changed content, the activity stream gadget also provides the following features:

- The ability to add comments to pages and blog posts, by clicking the 'add comment' icon at the top-right of an added or edited page or blog post in the activity stream.
- The ability to reply to a comment by clicking the 'add comment' icon at the top-right of a comment in the activity stream.
- Activities are grouped by separate date.
- An RSS feed link to its content in the top-right corner of the gadget.

**Screenshot: Adding a Comment in the Activity Stream Gadget**
Activity Stream Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Yes</td>
<td>None</td>
<td>Adds a title to the top of the Activity Stream.</td>
</tr>
<tr>
<td>Projects</td>
<td>No</td>
<td>None specified (i.e. display content in all spaces)</td>
<td>Filters the content by space. This gadget will display only the pages etc. which belong to the space(s) you specify here.</td>
</tr>
<tr>
<td>Username</td>
<td>No</td>
<td>None specified (i.e. display content by all users)</td>
<td>Filters the results by user. The macro will display only the pages etc. which were last modified by the user(s) you specify here.</td>
</tr>
<tr>
<td>Number of Entries</td>
<td>No</td>
<td>10</td>
<td>Specify the maximum number of results to be displayed. A maximum of 10 results will be displayed by default. The maximum value that this property can accept is 100.</td>
</tr>
</tbody>
</table>
Confluence: News Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show News?</td>
<td>No</td>
<td>True</td>
<td>Shows a short list of the most recent Confluence Product Blogs.</td>
</tr>
</tbody>
</table>
Confluence Page Gadget

The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.

For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

**Macros that work with the page gadget**

Please note, not all macros work with the page gadget. Please refer to the Working Macros section below for more information.

On this page:
- Confluence Page Gadget Properties
- Working Macros
- Related Topics

Screenshot: The Confluence page gadget displaying a sample page
Confluence Page Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro’s parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>No</td>
<td>None</td>
<td>Specify the space that your desired page is located in. Suggestions will display in a dropdown when you start typing. (Note, this property is only used to make searching for pages easier. It is not required.)</td>
</tr>
<tr>
<td>Page</td>
<td>Yes</td>
<td>None</td>
<td>Specify the page that you want to display in your gadget. Suggestions will display in a dropdown when you start typing.</td>
</tr>
<tr>
<td>Show View Link</td>
<td>No</td>
<td>Yes</td>
<td>Select whether to display a link to view the page on your Confluence site. Clicking the link will open the page in Confluence.</td>
</tr>
<tr>
<td>----------------</td>
<td>----</td>
<td>-----</td>
<td>-------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Edit Link</td>
<td>No</td>
<td>No</td>
<td>Select whether to display a link to edit the page on your Confluence site. Clicking the link will open the page for editing in Confluence.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>No</td>
<td>Never/false</td>
<td>Specify the time interval between each 'refresh' action undertaken by the page gadget. A refresh makes the activity stream gadget reflect any new activity that has been conducted on the Confluence site.</td>
</tr>
</tbody>
</table>

**Working Macros**

The Confluence page gadget will only render a subset of the macros that are used in Confluence correctly. Refer to the table below for the list of macros that work and do not work with the page gadget and known limitations.

> Some of the issues with macros in the page gadget can be worked around, if you are comfortable developing in Confluence. Please see [Troubleshooting Macros in the Page Gadget](#) for more information.

**Key:**
- ✓ Works with the page gadget
- * Partially works with the page gadget
- ✗ Does not work with the page gadget

<table>
<thead>
<tr>
<th>Macro</th>
<th>Works with page gadget?</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream</td>
<td>✗</td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Anchor (within a page)</td>
<td>✓ *</td>
<td>Opens in a new page</td>
</tr>
<tr>
<td>Attachments</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Blog Posts</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Chart</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Children Display</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Feature</td>
<td>Status</td>
<td>Note</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content By Label</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Content By User</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Excerpt</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Gallery</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Include Page</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Info</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Labels List</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Livesearch</td>
<td>❌</td>
<td>N/A</td>
</tr>
<tr>
<td>Note</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata Summary</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree Search</td>
<td>❌</td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Panel</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Quick Nav</td>
<td>❌</td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Recently Updated</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>RSS Feed</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Section &amp; Column</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Spaces List</td>
<td>✓</td>
<td>N/A</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>✓</td>
<td>Works, however links will be opened in a new browser window when clicked.</td>
</tr>
<tr>
<td>Tasklist</td>
<td>✓</td>
<td>Tasks can be viewed but not added/edited.</td>
</tr>
<tr>
<td>View File (PDF or PPT)</td>
<td>✓</td>
<td>Works, but you may need to refresh the gadget the first time (see CONF-19932).</td>
</tr>
</tbody>
</table>
Only works for some content:

- **Works:** blip.tv, Episodic, Flickr, Google Calendar, presentations on Google Docs, MySpace Video, Scribd, Skitch.com, SlideRocket, SlideShare, Viddler, Vimeo, YouTube, Dailymotion, Metacafe, FriendFeed, Yahoo Video, Wufoo HTML Form Builder

- **Does not work:** FriendFeed, Google Gadgets, Google Video (consumer service discontinued), Twitter, Widgetbox, DabbleDB, BackType

---

**Related Topics**

- Confluence Gadgets
- Confluence Quicknav Gadget

**The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.**

ℹ️ For instructions on how to use Confluence gadgets in your applications, please see [Confluence Gadgets](#).

**Screenshot: Using the QuickNav Gadget**

---

**Confluence QuickNav Gadget Properties**
This gadget has no properties and cannot be customised.

**Adding JIRA Gadgets to a Confluence Page**

This is a summary of the steps required to add a JIRA gadget to a Confluence page:

- If your JIRA site does not allow anonymous access, your JIRA administrator will need to configure JIRA to trust Confluence via Application Links. See the [JIRA administrator's guide](#).
- Your Confluence administrator will need to add the JIRA gadget URL to the list of authorised external gadgets in Confluence. See the [Confluence administrator's guide](#).
- Now you can add the gadget to a wiki page in Confluence using the Macro Browser. See the Confluence user's guide to the [Gadget macro](#).

Note that the Confluence Gadget macro is a specific type of macro which is used to display a gadget in a Confluence page - so once you have configured external gadgets in the Confluence Administration Console, they will appear in the Macro Browser.

**Related Topics**

- [All Atlassian gadgets](#)
- [External Gadgets](#)

**Developing Technical Documentation on Confluence Wiki**

Welcome! This is a guide to using Confluence wiki for technical documentation. You will find this guide useful if you want to write a technical manual such as a user's guide, administrator's guide, installation guide, and so on.

- [Creating your Technical Documentation Space](#)
- [Using Templates in Technical Documentation](#)
- [Re-using Content in Technical Documentation](#)
- [Managing the Life Cycle of your Technical Documentation](#)
- [Providing PDF Versions of your Technical Documentation](#)
- [Exporting and Printing Technical Documentation](#)
- [Essential Confluence Features for Technical Documentation](#)
- [Confluence Plugins for Technical Documentation](#)
- [Further Reading about Developing Technical Documentation on Confluence](#)

**RELATED TOPICS**

- [Confluence User's Guide](#)
- [Confluence Administrator's Guide](#)

**Creating your Technical Documentation Space**

This guide is for people who want to develop and publish technical documentation on Confluence wiki. You will find it useful if you want to write a technical manual such as a user's guide, administrator's guide, installation guide, and so on. This page is a quick-start guide to creating a wiki space for technical documentation.
Quick guide to creating a technical documentation space

- Add a space and select the Documentation theme.
- Set the space permissions.
- Change the title and content of the space home page.
- Customise the Documentation theme.
- Create an inclusions library to manage your re-usable content.
- Create the table of contents for your manual or manuals, by adding top-level pages for all the usual sections (user's guide, administrator's guide, and so on).
- Customise your PDF layout and stylesheet, if required.
- Hint: Now that you have a good skeleton for a documentation space, save the space as a template space.

The rest of this page gives more details of the above procedure.

On this page:

- Step 1. Add your Space
- Step 2. Set the Space Permissions
  - A Bit More about Permissions
- Step 3. Customise the Title and Content of the Home Page
- Step 4. Customise the Documentation Theme
  - Example of a Customised Footer
- Step 5. Create an Inclusions Library
  - Examples of Inclusions Libraries
- Step 6. Create the Table of Contents
- Step 7. (Optional) Customise the PDF Layout and Stylesheet
- Step 8. Save your New Space as a Template Space

Step 1. Add your Space

Below is a quick guide to adding a space. See Setting up a New Global Space for a full description.
1. Go to the Confluence dashboard and click the 'Add Space' link located above the list of spaces.

![Add Space](image)

**Add Space**

- Feed Builder
- People Directory

Spaces: Favourite New (1) Global

Demonstration Space

An example of a Confluence space with a tutorial and sample content.

*Hint:* If you cannot see the 'Add Space' link, this means that you do not have permission to add spaces. Please contact your Confluence administrator.

2. The 'Create Space' screen appears. Enter a **space name** and a short, unique **space key**.

3. Leave the **permission** settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.

4. Select the 'Documentation Theme'.

5. Click 'OK'.

The home page of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.

**Step 2. Set the Space Permissions**

Define the space permissions to determine who can do what in your new space.
1. Open the 'Browse' menu and select 'Space Admin'.

2. Click 'Permissions' in the left-hand panel.
3. Confirm your administrator access as prompted.
4. Click 'Edit Permissions'.
5. Set the permissions to suit your needs then click 'Save All'.
   - You can add groups and/or individual users to the list, then select the permissions for each group or user.
   - You can also set the permissions for anonymous users – these are people who have not logged in to the wiki. Anonymous access is available only if enabled for the entire Confluence site.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

A Bit More about Permissions

Confluence has a robust and granular permissions scheme that you can use to determine who can view, comment on and even update the documentation. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page. Below we discuss a way of using these in the draft, review and publishing workflow.

Space permissions in Confluence are simple yet granular enough to be useful for technical documentation. You can:

- Use the permission levels to control who can create pages in the space, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users.

Terminology:

- 'Anonymous' means people who have not logged in to the wiki.
- The 'confluence-users' group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.
For example, you might allow your team full edit and administration rights while others can only add comments. Or you might grant the general public access to your documentation, while only staff members can update it.

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

**Step 3. Customise the Title and Content of the Home Page**

When you created your space, Confluence created a home page with default content and a default title, 'Home'. You will want to change the title and content.
1. Go back to your space home page, by clicking the space name in the breadcrumbs at the top of the screen. In the example below, the space name is ‘MyProduct Documentation’:

   [Image of breadcrumbs]

   View Space Permissions

2. The space home page appears. By default, the page title is ‘Home’.

   [Image of home page]

   Added by Administrator, last edited by Administrator on Nov 04, 2010

3. Click ‘Edit’.

4. The page opens in edit mode. Change the title to suit your needs.

   [Image of edit mode]

5. Update the content to suit your needs.

   Hint: If you do not know what to add yet, just add a short description. You can refine the content of the page later. Take a look at an example of a home page.

6. Click ‘Save’.

**Step 4. Customise the Documentation Theme**

When you added the space you chose the Documentation theme, which provides a left-hand navigation bar and a good look and feel for technical documentation. If necessary, you can configure the Documentation theme to add your own page header and footer or to customise the default left-hand navigation bar. These customisations affect the online look and feel of your documentation. See Configuring the Documentation Theme for the full description.
1. Open the 'Browse' menu and select 'Space Admin'.
2. Click 'Themes' in the left-hand panel.
3. If the space is not yet using the Documentation theme, apply the theme now.
4. Click 'Configure theme' in the yellow area of the 'Current Theme' section at the top of the page.

**Current Theme**

The current theme controls the layout and colours of this space.

**Documentation Theme**

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer. This theme supports Firefox, Safari and Internet Explorer 7+.

**Configure theme** - further customise this theme's options

5. The 'Documentation Theme Configuration' screen appears. Customise the left-hand navigation bar, header and footer to suit your needs. Details are in the documentation. Here are some hints:
   - The 'Page Tree' check box determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
   - The 'Limit search results to the current space' check box determines whether Confluence will search only the current space or the whole Confluence site. This setting affects the default search. Viewers can override it each time they do a search.
   - Enter text, images, macros and other wiki markup into any or all of the three text boxes for the left-hand navigation bar, header and footer. You can use the Include macro and the Excerpt Include macro to include re-usable content.
   - Any content you add to the navigation panel will appear above the default page tree.
   - If you like, you can remove the default page tree (by unticking the box) and add your own, customised version of the Pagetree macro instead.

6. Click 'Save'.

Example of a Customised Footer

Take a look at the footer of a page in the Crowd documentation space.

To produce the above footer, we have the following content in the footer panel in the Documentation theme configuration screen:
Step 5. Create an Inclusions Library

Using Confluence, you can dynamically include content from one page into another page. You can include a whole page into another one, using the Include macro. You can also define an ‘excerpt’ on a page, and then include that excerpted text into another page using the Excerpt Include macro.

To organise your re-usable content, we recommend that you create a set of pages called an ‘inclusions library’.

1. Open the ‘Browse’ menu and select ‘Pages’.
2. The ‘List Pages’ screen will appear. Open the ‘Add’ menu and select ‘Page’. This will add a page at the root of the space, at the same level as the home page.
3. Enter a suitable title. We use ‘_InclusionsLibrary’. The unusual format of the title helps to let people know this page is special.
4. Enter some content on the page. We enter text explaining the purpose of the inclusions library and how to re-use the content. You can copy our text by clicking through to one of the example pages listed below.
5. Add child pages containing your re-usable content. See the examples of our own inclusions libraries listed below.

Some notes about inclusions libraries:

- The inclusions library is not a specific feature of Confluence. The pages in the inclusions library are just
like any other Confluence page.

- The pages are located at the root of the wiki space, not under the home page. This means that they will not appear in the table of contents on the left and they will not be picked up by the search in the left-hand navigation bar either.
- The pages will be picked up by other searches, because they are just normal wiki pages.
- We have decided to start the page name with an underscore. For example, `_My Page Name`. This indicates that the page is slightly unusual, and will help prevent people from changing the page name or updating the content without realising that the content is re-used in various pages.

**Examples of Inclusions Libraries**

Here are some examples in our documentation:

- [Crowd inclusions library](#)
- [Confluence inclusions library](#)

**Step 6. Create the Table of Contents**

Create the table of contents for your documentation, by adding the top-level pages for all the usual sections:

- User’s guide
- Administrator’s guide
- Installation guide
- Configuration guide
- Release notes
- FAQ
- Whatever else you need

1. Go back to your space home page, by clicking the space name in the breadcrumbs at the top of the screen.
2. Open the 'Add' menu and select 'Page'. This will add the page as a child of the home page.
3. Enter the page title, 'User's Guide'.
4. Enter the content of the page.
   **Hint:** If you do not know what to add yet, just add a short description then refine the content of the page later. If you like, you can add the [Children macro](#). That will act as a table of contents on the page once you have added child pages.
5. Click 'Save'.

Now do the same for all the sections of your technical document.

**Step 7. (Optional) Customise the PDF Layout and Stylesheet**

If you are planning to provide PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. You can skip this step for now and do it later, if you prefer. The instructions are in a separate section of this guide, dedicated to PDF. See [Providing PDF Versions of your Technical Documentation](#).

**Step 8. Save your New Space as a Template Space**

This is a useful suggestion. Once you have set up your first documentation space and are more-or-less happy with it, use the [Copy Space plugin](#) (see notes below) to copy the space while it still has very little content. From this point on, you can copy it each time you want to create a new documentation space.
1. Open the 'Browse' menu and select 'Space Admin'.
2. Click 'Copy Space' in the left-hand panel.

Hint: If you cannot see the 'Copy Space' option, this means that the plugin is not installed on your Confluence site. Refer to the documentation on installing plugins.
3. The 'Copy Space' screen will appear. Enter the details as prompted, to copy your space to another new space.

   ![Copy Space Screen](image)

4. Click 'Save'.

You now have a template space. From this point on, you can use the Copy Space plugin to copy the template space each time you want to create a new documentation space.

Notes:

- The Copy Space plugin is not covered by Atlassian support. However, the Atlassian technical writers use it for all our documentation. If you like, you can vote for an comment on the request for Atlassian support to cover this plugin: CONF-14198.
- Your site administrator will need to install the Copy Space plugin into Confluence. Refer to the documentation on installing plugins.

Next Steps

You now have the basic structure and configuration for your technical documentation space. You have also created a handy template to use next time you need a space. What next? Take a look at Using Templates in Technical Documentation.

Using Templates in Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. We have already
shown you how to create your technical documentation space. Now we offer an introduction to the templates that Confluence provides.

Quick guide to templates in Confluence
- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Templates are available across the Confluence site (global templates) or per space (space templates).
- Both 'global templates' and 'space templates', as described on this page, define the content of a page. They do not define the content of an entire space.
- You can import predefined templates, including those shipped with Confluence and additional templates from the Atlassian Plugin Exchange.
- To create a template for an entire space, see our guide to creating your documentation space.

On this page:
- Deciding Where to Put Your Templates
- Creating a Global Template
- Creating a Space Template
- Importing Templates
- Using a Template to Create a Page

Deciding Where to Put Your Templates

In Confluence, there are two places to store your page templates:
- **Space templates:** These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates:** These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Decide whether your template is useful across more than one space.
- If yes, create a global template. You will need Confluence administrator permissions.
- If no, create a space template.
  - You will need space administrator permissions for the relevant space(s).
  - You may have already saved your documentation space as a template, as described in our guide to creating your documentation space. In that case, it may be useful to save your template page in your template space. When you later copy the space, the template pages will be copied too.

Creating a Global Template

1. Choose Browse > Confluence Admin.
2. Enter your password if prompted.
3. Choose Global Templates in the left-hand panel.

See Global Templates for more information.

Creating a Space Template

1. From any page in the space, choose Browse > Templates.
2. Choose Add New Space Template.

See Adding a Template for more information.
Importing Templates

Confluence ships with a number of templates, including the 'Charts', 'Document List' and 'Meeting Notes' templates. These templates are not available for use by default. However, if you have the appropriate permissions to access the Administration Console, you can import any of these templates to be used globally or within a specific space. In addition, you can find more template bundles on the [Atlassian Plugin Exchange](https://plugins.atlassian.com).

1. Go to the Confluence Administration Console and choose **Import Templates**.
2. Select the templates that you want to import.
3. Select the space to import the templates to, or choose to import them as global templates.
4. Choose **Import**.

Using a Template to Create a Page

When people add a page on your Confluence site, they can choose to base their new page on a template.

Go to the page that will be the parent of your new page, and choose **Add > Page from template**. (This link is only displayed if there are templates already defined.)

See [Creating a Page using a Template](#) for more information.

Next Steps

You now have a good idea of how Confluence templates work. What next? Take a look at [Re-using Content in Technical Documentation](#).

Re-using Content in Technical Documentation

This page is part of the guide to [developing technical documentation on Confluence Wiki](https://confluence.atlassian.com/display/DOC/Developing+Technical+Documentation). In the page about creating your technical documentation space, we showed you how to set up an 'inclusions library' to contain content that you can re-use on more than one page. Now we offer further guidelines on re-using content in your documentation space.

Your documentation may be about using a software application, or it may be a technical manual for your product range. On this page, we use the term 'widget' to describe the things that you are documenting, such as the screen, form, document, product or object.
Quick guide to re-using content

- Create an 'inclusions library' to manage your re-usable content. See our guide to creating your technical documentation space.
- Use the **excerpt** macro to define a re-usable section ('excerpt') on a page, or just decide to re-use the entire content of the page.
- Use the **excerpt-include** macro to include the excerpt from one page onto another page.
- Use the **include** macro to include the entire content of a page onto another page.
- Consider installing the Multi Excerpt plugin if you need to define multiple excerpts per page.

The rest of this page gives an overview and more details of the above procedures.

On this page:
- **Reasons for Re-Using Content**
- **Defining an Inclusions Library**
- **Working with Excerpts and Inclusions**
  - Using the Include Page Macro
  - Using the Excerpt Include Macro
  - Using the Multi Excerpt Plugin
- **An Example of Content Re-Use: A Glossary**
  - Creating a One-Page Glossary
  - Creating a Glossary with Child Pages
  - Referring to Glossary Terms
- **Further Reading**

Reasons for Re-Using Content

A golden rule for technical documentation is to write the content only once but allow that content to be used in many places and in many forms.

For example, you may have the following types of content:

- A technical manual that describes each widget in detail.
- Tips and tricks on how to get the most out of the widget.
- A step-by-step user guide for first-time users on how to use the most common widgets.
- A training manual with exercises or videos that people can follow in their own time.
- A one-page cheat sheet for users to stick up on their workstation.
- Text for a sales brochure that is sent out to a print house for production.

Each of these types of content will share common information, such as a glossary entry, a technical or marketing description of the widget, or a step-by-step guide on how to use the widget.

Some initial planning of your technical documentation will allow you to re-use any or all of the content you write, so there is only ever one place to update the content, and those changes flow through to all of your other documentation.

Defining an Inclusions Library

We recommend that you create an 'inclusions library' to manage your re-usable content. If you have not already done this when creating your documentation space, see our guide to creating your technical documentation space.

Working with Excerpts and Inclusions
Excerpts and inclusions (sometimes called 'includes') are very useful for re-using content:

- Use the Excerpt macro (**excerpt**) to define a re-usable section ('excerpt') on a page.
- Use the Excerpt Include macro (**excerpt-include**) to include the excerpt on another page.
- Use the Include Page macro (**include**) to include the entire content of a page onto another page.

A simple example of an inclusion is a note or warning that is used in many places in your documentation. Here is an example:

```
⚠️ Example note -- "Draft in progress"

This document is still in draft status. Please treat the content with caution.
```

**Tip:** Keep your re-usable pages short and sweet. Do not worry if you find that you need hundreds of pages to hold your inclusions. It helps to keep things separate and organised.

### Using the Include Page Macro

In this example, we use the Include Page macro to create a note that you can re-use on your documentation pages. The Include Page macro will include the entire content of one page into another page. (See the 'Excerpt' macro below for including parts of a page.)

1. Create a page in your inclusions library called **_Draft Note**.
2. Add the content of the page. In this example, we use the Note macro with some text in the title and body:

```
{note:title=Draft in progress}This document is still in draft status. Please treat the content with caution.{note}
```

3. Use the Include Page macro to include that note in any page in your documentation. For example:

```
{include:_Draft Note|nopanel=true}
```

See the documentation on the [Include Page macro](#) for more details.

### Using the Excerpt Include Macro

An excerpt is a section of a page that you can include into another page.
1. Use the `excerpt` macro to define any content in your page that you want to be able to use elsewhere. This content can be as short as a word or as long as the entire page. For example, let's assume we have a page called 'My Short Poem':

```
I really love this poem:
(excerpt)
Mary had a little lamb
Its fleece was white as snow
(excerpt)
And I'm going to use it all over the place.
```

2. Use the Excerpt Include macro to include the excerpt into another page. For example:

```
(excerpt-include:My Short Poem|nopanel=true)
```

You can only define one `excerpt` on a page. See the documentation on the Excerpt Include macro for more details.

To have multiple excerpts on a page, see the 'Multi Excerpt plugin' below.

Using the Multi Excerpt Plugin

The Multi Excerpt plugin provides additional macros that enable you to have multiple excerpts on a page. A good example of where you would find this useful is in the glossary page discussed below. If you want to include a single glossary entry or a subset of the glossary entries in another page, then the named excerpts allowed by the Multi Excerpt plugin are very useful.

Notes:

- The Multi Excerpt plugin is a commercial plugin and is not free.
- Your Confluence administrator will need to download and install the plugin into your Confluence site before you can use the macros described below. Refer to the documentation on installing plugins.
- Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support. Please refer to the Multi Excerpt plugin page for support details.
1. Use the following code on the base page containing the content you want to use elsewhere:

```markdown
{multi-excerpt:name=ExcerptName1}
Excerpt text 1
{multi-excerpt}
Any other text
{multi-excerpt:name=ExcerptName2}
Excerpt text 2
{multi-excerpt}
```

2. Use the following code on the page where you want to include the named excerpt:

```markdown
{multi-excerpt-include:pageTitle=PageName|name=ExcerptName1|nopanel=true}
```

3. You can also include excerpts from other spaces using the following syntax:

```markdown
{multi-excerpt-include:spaceKey:pageName|name=excerptName|nopanel=true}
```

See the [Multi Excerpt plugin page](https://confluence.atlassian.com/pages/with-plugins/multi-excerpt-plugin) for more details.

**An Example of Content Re-Use: A Glossary**

A glossary is something that most technical documentation will require. There are a few ways to set up glossaries in Confluence. These are the most popular:

- All glossary entries on one page.
- Each glossary entry on separate child pages with a main page showing excerpts of the glossary.

Once you have defined the glossary entry, you can refer to it from the main pages of your technical documentation.

**Creating a One-Page Glossary**

This style of glossary is useful if the glossary entries tend to be short and there are not too many of them.
1. Create a page named **Glossary**.

2. Add an alphabetical index at the top of the page and a heading for each letter of the alphabet:

   ![Index Example]

   ```
   {anchor:A}
   h2. A
   {anchor:B}
   h2. B
   {anchor:C}
   h2. C ...
   ```

3. Enter each glossary entry under the relevant alphabetical heading. Each glossary entry (term) should include:
   - An anchor tag, so that you can link to it from other pages.
   - The term itself.
   - A definition of the term.
   - A link to the page in your technical documentation that explains the term in greater detail, where relevant.

   ```
   {anchor:MyGlossaryTerm}
   h4. MyGlossaryTerm
   This is the definition of MyGlossaryTerm. See [Page Name] for more information.
   ```

4. Optionally, include a horizontal line between the terms. This depends on how long each entry is. If your glossary tends to have short entries, it may look too cluttered with horizontal lines.

---

See the glossary in the [Confluence documentation](#) for an example of this style of glossary (without the alphabetical index).

**Creating a Glossary with Child Pages**

This style of glossary is useful if the glossary entries tend to be quite long or have additional information over and above the definition of the term.
1. Create a page named **Glossary**.
2. Create a child page for each glossary entry (term). Each child page should contain:
   - The term as the title of the page.
   - The definition of the term in the body of the page.
   - Excerpt tags (`{excerpt}`) tags surrounding the definition.
   - Any additional information after the `excerpt` tags.

   ```
   {excerpt}
   This is the definition of MyGlossaryTerm
   {excerpt}
   More information to describe MyGlossaryTerm
   ```

3. On the 'Glossary' page, use the `children` macro to show the excerpts from each child page in a list, with the page name displayed in 'h4' style.

   ```
   {children:excerpt=true|style=h4}
   ```

See the glossary in the [Crowd documentation](https://confluence.atlassian.com/crowd) for an example of this style of glossary.

**Referring to Glossary Terms**

In the main pages of your technical documentation, create a link to the glossary page for each glossary term.

```
_[MyGlossary Term|Glossary#MyGlossaryTerm]_
```

Note that this is a standard page link with an anchor. We have formatted the link as italics, because it helps to have the glossary links looking different to other page links. Readers can just skip over the glossary link if they are already familiar with the term.

**Further Reading**

- A blog post about content re-use: [Technical Writing in a Wiki - Content Re-use and Structure](https://confluence.atlassian.com/crowd) (November 2010).

**Next Steps**

You now have a good idea of how to re-use content in a Confluence documentation space. What next? Take a look at [Managing the Life Cycle of your Technical Documentation](https://confluence.atlassian.com/crowd).

**Managing the Life Cycle of your Technical Documentation**

This page is part of the guide to [developing technical documentation on Confluence Wiki](https://confluence.atlassian.com/crowd). We have already shown you how to [create your technical documentation space](https://confluence.atlassian.com/crowd), including how to set permissions for your space. Now we offer a quick-start guide to managing the life cycle of your technical documentation in Confluence. The life cycle includes drafting, reviewing and publishing a document, as well as managing documentation that is release-specific.
Quick guide to managing the technical documentation life cycle

- Create draft pages with restricted permissions, to hide them until they are ready for publication.
- Set the permissions to allow reviewers to comment on and/or update the pages.
- When ready, publish the page by removing the permission restrictions.
- Monitor updates to your draft and published pages by watching your space and/or subscribing to RSS feeds.
- Use spaces as a mechanism for matching your documentation version to product releases: one space per major release number.
- Consider installing plugins for extended workflow and publication management.

The rest of this page gives more details of the above procedures.

On this page:

- Using the Built-In Confluence Functionality to Manage Workflow and Release Cycle
  - Drafting, Reviewing and Publishing a Page
  - Keeping Track of Documentation Updates
    - Viewing the History of a Page
    - Receiving Email Notification of Updates
    - Monitoring Updates via RSS Feeds
  - Release Management
    - Space Keys
    - The Release Management Process
  - Other Scenarios using the Built-In Confluence Functionality
  - Using Add-Ons for Extended Workflow, Publication and Concurrent Version Management
  - Notes

Using the Built-In Confluence Functionality to Manage Workflow and Release Cycle

This section describes how to use the built-in Confluence functionality to manage your workflow (draft, review, publish) and to align your documentation version control to the product release cycle.

In this scenario we also assume that you want a live space that always has the same space key and always contains the latest version of your documentation. This scenario suits the requirements of an organisation that wants their technical documentation to be 'live'. Various groups of people can refine the content as and when required. People can also subscribe to the space, knowing that they will always get the latest version of the documentation and comments.

This is the way we manage our documentation at Atlassian. The content of the wiki is dynamic, continuously updated, commented on, subscribed to and watched by thousands of people all over the world.

Drafting, Reviewing and Publishing a Page

The workflow is simple.
### 1. Create a page with restricted permissions.

For example, you might restrict viewing to a group of people such as your team. On a public wiki, you might restrict viewing to staff members, so that the general public cannot see the page.

### 2. Write the page content.

### 3. Ask other people to review the page.

They can add comments to the page or simply edit the page content directly.

### 4. Publish the page when ready, by doing the following:

- Delete the comments on the page.
- Remove the permission restrictions on the page. The page has now been published.

The space permissions and site permissions now determine who can see and/or update the page.

---

The screenshot below shows a page under review. Notice the lock icon at top left, indicating that restricted permissions apply to this page.

---

### Keeping Track of Documentation Updates

On a wiki, it is quite usual for a number of different people to update a single page. Technical writers need to know what happens to our documents, both during review and after publication.

#### Viewing the History of a Page

Confluence creates a new version of the page every time someone edits the page. The page history shows all the versions, with date, author, and any comments made on the update.

Go to the page and choose **Tools > Page History.**

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changed By</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT (v. 41)</td>
<td>Jul 07, 2009 11:33</td>
<td>Gilies Gaskell [Atlassian Technical Writer]</td>
<td></td>
</tr>
<tr>
<td>v. 40</td>
<td>Jun 18, 2007 11:08</td>
<td>Rosie Jameson [Atlassian Technical Writer]</td>
<td>Restore this version</td>
</tr>
</tbody>
</table>

On the page history view, you can:
View the content of a specific version of the page.
Revert to (restore) a specific version.
Select any two versions and ask for a comparison, to see what has changed between those two versions.

See Page History and Page Comparison Views for detailed information.

It is all very well to go to a specific page and see what has happened to it, but how do you know when to go and look at the page? You need a notification of any changes made to your documentation space.

In Confluence, you can monitor updates to your documentation via email notifications and via RSS feeds.

**Receiving Email Notification of Updates**

You can ‘watch’ a page or an entire space. Whenever anyone updates the page or space, you will receive an email notification.

To watch a page:

1. Open the ‘Tools’ menu and select ‘Watch’.

To watch a space:

1. Go to a page in the space and choose Browse > Advanced.
2. In the left-hand panel, click ‘Start watching this space’.

See Subscribing to Email Notifications of Updates to Confluence Content for details of the various notifications Confluence will send, and how to configure your notification settings.

**Monitoring Updates via RSS Feeds**

RSS feeds provide another way to keep track of updates. The simplest way to build an RSS feed is to use Confluence’s feed builder, accessible from the dashboard. This will give you a URL that you can ping to get the latest updates.

Below we describe how to set up a useful feed for your technical documentation space. Remember that you can adjust the settings to suit your own needs.

1. Choose Browse > Feed Builder. The RSS feed builder form appears.
2. Check the boxes to select all the content types. (Even if you are not expecting comments, blog posts or mail in your documentation space, it does no harm to receive notifications if they do arrive.):
   - Pages and the comments and attachments on pages.
   - Blog posts and their comments and attachments.
   - Mail.
3. Select your documentation space from the list. Press Ctrl and click to select multiple spaces.
4. Click the Create RSS Feed button to create your feed.
5. This will take you to a new screen. Drag or copy the link into your RSS reader. The feed URL is linked to the words Drag or copy this link to your RSS reader.

Now that you have set up your RSS feed, you need to decide how to read it. There are various options to choose from. For example:

- Use an RSS reader, such as the Sage add-on for Firefox.
- Use an email client, such as Thunderbird.

See Subscribing to RSS Feeds within Confluence for details.
Let’s assume that your product goes through a regular release cycle, and that you need to retain separate documentation for each major version of the product.

At Atlassian, we use spaces as our version-control mechanism.

- **Archive spaces.** At each release, we create a new archive space to house the previous version of the documentation.
- **The live space.** The documentation for the latest version of the product resides in the live space. The live space always retains the same space key and is always available for viewing and updating.

**Space Keys**

The live space has just the product name as its space key. For example, for the Crowd product the space key is ‘CROWD’. (See the Crowd documentation space.)

For the archived versions, we use a combination of the product name plus version number as the space key. For example, we use ‘CROWD020’ for the Crowd 2.0 documentation, ‘CROWD016’ for the Crowd 1.6 documentation, and so on.

**The Release Management Process**

Here is an overview of the process we follow at Atlassian.

1. **Leading up to release date.** Work with hidden draft pages in the live space. A ‘hidden draft’ is simply a page that has restricted permissions applied:
   - For each new feature, create a new page with restricted permissions.
   - If you need to update existing pages, create a hidden copy of the existing page and apply the updates to the copy.
   - Follow the usual draft and review procedure for each page.
2. **A few days before release date.** Use the Copy Space plugin to copy the live space to a new space. This creates a snapshot of the current documentation, and will act as an archive for the current release which is soon to become the previous release. (We described the use of the Copy Space plugin in the earlier section of this guide: Creating your Technical Documentation Space.)
3. **On release date.** Publish the updated documentation for the new version of the product:
   - Rebrand the live documentation space to reflect the new release number. In other words, change the space name and any other descriptions that include the product release number.
   - Unhide all the new pages, by removing the permission restrictions on each hidden page.
   - Copy the content of the updated pages to the proper pages, then delete the copies.
   - Export the newly updated space to PDF, HTML and XML, for those customers who prefer offline versions of the documentation.

Note that the above process is applicable to major releases of the product. For minor bug-fix releases, we simply update the documentation in the live space. We do not create archive spaces for every minor release.

The example below shows an extract from the dashboard of our documentation wiki, listing the spaces for different versions of the Crowd documentation. (Crowd is one of our products.) Each space holds the documentation for a specific major release of Crowd.
Other Scenarios using the Built-In Confluence Functionality

It is easy to design other ways of managing your documentation spaces using the built-in Confluence functionality. For example, the simplest scenario is to publish a new space for every new release of your product, using the same Copy Space plugin as described above.

Using Add-Ons for Extended Workflow, Publication and Concurrent Version Management

For advanced workflow features, consider installing the Ad Hoc Workflows add-on onto your Confluence site.

For advanced publication and concurrent version management consider using the Scroll Versions add-on. Scroll Versions enables you to set up and manage concurrent versions of your documentation in a single space. Multiple versions of software, different product variants, and even multiple languages of documentation can be managed. Changes to pages are scheduled for a specified version and then published all at once.

1. Install the Scroll Versions add-on from the Marketplace or using Confluenes Universal Plugin Manager.
2. Create a space for your documentation or activate Scroll Versions on your existing documentation.
3. Add the version numbers that you want to work with, via the version management screen.
4. When a version is ready to publish go to ‘Browse’ > ‘Scroll Versions’ > ‘Manage Versions’ and publish your documentation within the same space or to another space.

See the documentation of Scroll Versions for further information.
Similarly, consider using the Content Publishing add-on to publish content from a master space to a published space. In this scenario, you will create a master space that contains your drafts in progress and new releases. The master space is visible only to the authors and reviewers. You will periodically publish the master space to a published space. This suits the requirements of an organisation that needs a 'published' or 'official' set of documentation, published only when a new version of the product is released. There is no requirement for continual updating of the documentation.

1. Install the Content Publishing plugin.
2. Create a space for your master content.
3. Create a space for your published content.
4. When the content in the master space is ready to publish, go to the ‘Advanced’ tab in the ‘Space Admin’ section of the master space.
5. Click ‘Publish Space’ to configure the settings and then publish your space. See the plugin documentation to choose the options best for your needs.
6. Click ‘Publish’.

**Notes**

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on installing plugins.

- **Plugin support.** Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

**Next Steps**

Now you know about managing your workflow and documentation release process on Confluence. What next? Take a look at Providing PDF Versions of your Technical Documentation.

**Providing PDF Versions of your Technical Documentation**

This page is part of the guide on Developing Technical Documentation on Confluence Wiki.

Confluence is a platform for publishing online documentation. It also provides an export to PDF feature for producing PDF versions of your documentation, allowing you to print it, or to provide a copy to customers who are unable to access the online version. This guide describes how to export your technical documentation to PDF using Confluence’s built-in PDF export, and introduces a third-party plugin that provides additional PDF layout and style functionality.

**Quick guide to PDF exports**

- Customise the PDF layout (title page, header and footer) and style, for use each time you export your documentation.
- Export a single page to PDF.
- Export a selection of pages or an entire space to PDF.
- Consider installing a third-party plugin for advanced PDF export functionality.

The rest of this page gives more details of the above procedures.
Customising the PDF Layout and Style

If you plan to create PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. These customisations will be applied every time you export documentation to PDF.

Under PDF layout you can add HTML to customise the PDF title page, and page headers and footers. Under PDF stylesheet, you can adjust the appearance of the PDF pages.

Editing the PDF Layout

Setting a global PDF layout
1. Open the Confluence Admin screen.
2. Select Look and Feel > PDF Layout. The following screens allows you to enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.

Setting the PDF layout at space level
1. Choose Browse > Space Admin.
   Note: ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click PDF Layout in the 'Look and Feel' section of the left-hand panel.
3. Click Edit, and customise the HTML that generates the following areas in the exported PDF document:
   - PDF Space Export Title Page – title page.
   - PDF Space Export Header – page headers.
   - PDF Space Export Footer – page footers.
4. Enter your customisations into each text box as required. The PDF layout section accepts HTML code. You can include inline CSS in the HTML too. Save your work.

Editing the PDF Stylesheet
Setting a global PDF Stylesheet

1. Open the Confluence Admin screen.
2. Click Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code that will render content on each page.

Setting a space-level PDF stylesheet

1. Choose Browse > Space Admin.
   Note: ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Click PDF Stylesheet in the left-hand panel. The ‘PDF Export Stylesheet’ section appears, showing the current contents of your PDF stylesheet. It contains all CSS rule customisations applied to the pages in the space.
3. Click Edit and enter your customisations into the text box as required. The PDF stylesheet section accepts Cascading Style Sheets (CSS) rules. Save your work.

Examples of PDF Customisation

Below are typical customisations you may want to make for your technical documentation. For more examples, see Customising Exports to PDF.

Adding a Title Page

You can create a title or cover page to your PDF document using HTML. Use the PDF Space Export Title Page section of the PDF layout to do this. Adding a New Title Page

The following example uses HTML with an inline CSS rule to generate a title page.

```html
<div class="fsTitlePage"
    style="margin-left:auto;margin-top:75mm;margin-right:auto;page-break-after:always">
    <img src="/download/attachments/12345/titlepage.png"/>
</div>
```

Including Content Above Table of Contents in Default Title Page

The following example includes content above the automatically-generated table of contents that appears on the default title page, so that your title page includes your own content plus the table of contents.

```html
<div class="fsTitlePage"
    style="margin-left:auto;margin-top:75mm;margin-right:auto;">
    <img src="/download/attachments/12345/titlepage.png"/>
</div>
```

Adding an Image to your Title Page

In the examples above, the title page includes an image called ‘titlepage.png’, centred in the middle of the page. The image is attached to a Confluence page and is referenced via its relative URL (that is, we use only the last part of the URL, excluding the Confluence site’s base URL).

Follow these instructions to include an image on your title page:
1. Attach the image to a Confluence page.
2. View the list of attachments on that page.
3. Right-click the image and copy its location.
4. Paste the link into the appropriate src="" attribute within your PDF stylesheet, as shown above.
5. Remove the first part of the URL before /download/....

Adding Headers and Footers

You can add headers and footers to your PDF pages using HTML. Use the 'PDF Space Export Header' and 'PDF Space Export Footer' sections of the PDF layout to do this. For simple headers and footers, plain text is enough. The following example adds a simple copyright notice.

Copyright © 2010, Atlassian Pty Ltd.

Adding Page Numbering to a Header or Footer

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. PDF Layout HTML: In the Footer section (or the Header section), use an empty span element with a unique ID, for example pageNum, to act as a place holder for the page number.

   HTML - PDF Layout: Footer Section
   ```html
   <span id="pageNum"/>
   ```

2. PDF Stylesheet CSS: Create the following CSS selector rule for the empty span:

   CSS - PDF Stylesheet
   ```css
   #pageNum:before
   {
   content: counter(page);
   }
   ```

Analysing the above CSS selector rule in more detail:

- The #pageNum rule selects the HTML element with the specified ID of "pageNum", which is the span element we created for the header or footer.
- The :before part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
- The counter(page) is a function that returns the current page number as its content.
- The content property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.

Exporting to PDF

You can use the built-in Confluence PDF export to export a single page, a selection of pages or an entire space to a single PDF file.

Exporting a Single Page to PDF

You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page.
- Go to a page in the space and choose **Tools > Export to PDF**. Follow the prompts to export the page.

**Exporting a Selection of Pages or a Space to PDF**

1. Go to a page in the space and choose **Browse > Advanced**.
2. Click **PDF Export** in the left-hand panel. This option will only be visible if you have the ‘Export Space’ permission.
3. Select the pages you want to export.
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
4. Click **Export**.
5. When the export process has finished, download and save the PDF file as prompted.

**Using the Scroll PDF Exporter Plugin to Export to PDF**

The Scroll PDF Exporter provides flexible themes for configuring PDF layout and styles. You can select one of Scroll PDF Exporter’s built-in themes and configure your table of contents, header and title pages. For even more flexibility, see the section **HowTos** in the Scroll PDF Exporter documentation.

For this advanced PDF export functionality, you will need to install the **Scroll PDF Exporter** plugin to your Confluence site.

**Notes**

- **Permissions required to export a space**: To use the space export functionality, you need ‘Export Space’ permission. See the guide to **space permissions** or contact a **space administrator** for more information.

- **Installing plugins**: If you decide to use additional plugins, your site administrator will need to install the plugins to your Confluence site. Refer to the documentation on **installing plugins**.
• **Plugin support:** Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

---

### Related Topics

- Developing Technical Documentation on Confluence Wiki
- Customising Exports to PDF
- Exporting Confluence Pages and Spaces to PDF
- Scroll PDF Exporter
- Installing a Plugin

### Next Steps

Now you know all about providing PDF versions of your documentation. What next? See other ways of exporting and printing technical documentation.

### Exporting and Printing Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. Confluence is a great tool for writing and maintaining technical documentation. There are times when we need to export the content out of Confluence into other forms, such as PDF, HTML, Microsoft Word and paper.

Confluence itself provides an export to both PDF and HTML. Plugins provide additional functionality. Below are guidelines on exporting your technical documentation to various formats, including printed output.

---

**Quick guide to printing and exporting content**

- Use the browser's print option to print a single page.
- To print more than one page and for more advanced printing options, export your documentation to PDF.
- Confluence can export your pages to PDF, HTML, Confluence-specific XML and Word.
- Consider installing plugins to export your pages to PDF (enhanced functionality). Word (enhanced functionality), DocBook XML, Eclipse Help and JavaHelp.
- Make your exports available to your customers for download by attaching the exported file to a Confluence page.

---

The rest of this page gives more details of the above procedures.

---

### On this page:

- **Printing**
- Exporting to PDF
- Exporting to HTML
- Exporting to Confluence-Specific XML
- Exporting to DocBook XML via a Plugin
- Exporting to Microsoft Word
- Exporting to Microsoft Word via a Plugin
- Exporting to Eclipse Help via a Plugin
- Exporting to EPUB via a Plugin
- Exporting to HTML via a Plugin
- Making the PDF and Other Exported Files Available to your Readers
- Notes
- Further Reading

---

*Printing*
To print a single Confluence page, just use the browser's print option. This option is available to all users who have permission to view the page.

To print more than one page and for more advanced printing options, export your documentation to PDF. See Providing PDF Versions of your Technical Documentation.

**Exporting to PDF**

Because this is such an important topic, we have a section of this guide dedicated to PDF. See Providing PDF Versions of your Technical Documentation.

**Exporting to HTML**

Using the built-in Confluence HTML export, you can export a single page, a selection of pages or an entire space to HTML. Confluence supplies the HTML and associated files in a zip file.

1. Go to a page in the space and choose **Browse > Advanced**.
2. Click **HTML Export** in the left-hand panel.
   
   This option will only be visible if you have 'Export Space' permission.
3. Select the **Include Comments** check box if you want to include comments for the pages you are exporting.
4. Select the pages you want to export by selecting the check boxes in the tree view of pages displayed. By default, all pages are selected. You have the option to **Select All** or **Deselect All** pages.
   
   If you select the check box of a page that contains one or more child or descendant pages, all of these child and descendant pages will also be selected. Similarly, if you clear the check box of such a page, all of its child and descendant pages will also be cleared. This provides a convenient method of exporting subtrees, for example, chapters or sections within a document.
5. Click **Export**. This will create a zipped archive of HTML files.
6. When the export process has finished, download the zipped archive as prompted and extract the files into a folder.
Exporting to Confluence-Specific XML

Confluence provides an XML export. The XML produced is a proprietary format and is intended for backups or for transferring a space from one Confluence instance to another. If you write your documentation on Confluence and your customers have Confluence too, then you can export your manuals to XML and customers can upload them onto their own Confluence site.

Exporting to DocBook XML via a Plugin

Scroll DocBook Exporter converts Confluence pages to DocBook XML. Your Confluence system administrator will need install the plugin onto your Confluence site.

Exporting to Microsoft Word

Confluence can export a page to Word. (Select 'Export to Word' from the 'Tools' menu.) This option performs a basic conversion of wiki content to HTML and applies some Word CSS stylesheets. It processes just one page at a time.

Exporting to Microsoft Word via a Plugin

Scroll Office is a Confluence plugin. Once installed, Scroll Office replaces Confluence's built-in 'Export to Word' functionality. You can export a single page or a hierarchy of pages.

You can define your templates in Word in the usual way, and upload them to Confluence as global templates or space templates. When you export your Confluence pages to Word, Scroll Office will use those templates to build native Word documents from the wiki pages.

Scroll Office provides additional features such as enforcing page-breaks, setting the page orientation to landscape or portrait, and ignoring content. The latest version offers a REST-style API for automated export.

Exporting to Eclipse Help via a Plugin

Scroll EclipseHelp Exporter provides an export to Eclipse Help format.

You can produce embeddable online help for Eclipse-based applications. Scroll EclipseHelp Exporter converts the Confluence content into EclipseHelp-compatible JAR files to create a standalone online help or a context-sensitive help.

A hint about the Eclipse Help platform: You can use a cut-down version of the Eclipse Help platform to provide online documentation for any system. It doesn't have to be an Eclipse tool that you are documenting. For some ideas, take a look at a couple of articles about documenting your project using the Eclipse help system.

Exporting to EPUB via a Plugin

The Scroll EPUB Exporter outputs an ebook in the common EPUB format that can be read on iPads, iPhones and any other ebook reader.

Exporting to HTML via a Plugin

The Scroll HTML Exporter enables the delivery of Confluence content from a web server. It converts the pages into static HTML pages that can be uploaded to a web server. The output of the Scroll HTML exporter can also be used as an input to produce other HTML-based help formats such as WinHelp and HTML Help.

Making the PDF and Other Exported Files Available to your Readers

There are a number of ways to make your exported files available to your readers, such as putting the files on a disc and shipping them with your product.
One of the simplest ways is to attach the files to a Confluence page. (See [Attaching Files to a Page](#).)

For example, Atlassian uses the out-of-the-box Confluence export functionality to provide PDF, HTML and XML versions of our documentation. People can download the files from our [documentation wiki](#). For example, here are the [JIRA documentation downloads](#) and the [Confluence documentation downloads](#).

For those people who would like to use the XML files to recreate the documentation on their own Confluence sites, we provide instructions on [setting up your own local documentation](#).

**Notes**

- **Permissions required to export a space.** To use the space export functionality, you need 'Export Space' permission. See the guide to [space permissions](#) or contact a space administrator for more information.

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on [installing plugins](#).

- **Plugin support.** Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on [plugin support](#).

**Further Reading**

- A blog post about exporting and importing content from/to Confluence: [Technical Writing in a Wiki - Single Source Publishing](#) (November 2010).

- A good overview of the Scroll Office features in this [blog post](#) (August 2010) and the [followup post](#) (November 2010).

**Next Steps**

Now you know about a number of ways to get your technical documentation out of Confluence into various formats, for printing or for input into another system or process flow. What next? Take a look at [Essential Confluence Features for Technical Documentation](#).

**Essential Confluence Features for Technical Documentation**

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight the built-in Confluence macros that are most useful in technical documentation. For more information about Confluence macros, see [Working with Macros](#).

---

### On this page:

- Auto-Generating a Table of Contents for Page Content
- Drawing Attention to Elements of a Page
- Putting Content inside Customisable Panels
- Inserting Anchor Links on Pages
- Structuring Content using Sections and Columns
- Making your Documentation more Engaging by Embedding Videos

---

**Auto-Generating a Table of Contents for Page Content**

It is important to make it easy for viewers to jump to the section of a Confluence page that they are most interested in. The Table of Contents macro helps you navigate lengthy pages by summarising the content structure and providing links to headings used on the page.

**Click here to see a common example >>**

2. Each feature in the release is a heading on the page.
3. You can generate a list of hyperlinks to each of the features in the release notes by inserting the Table of Contents macro:

![Image of Table of Contents macro](image)

4. The image below shows the Table of Contents macro inserted at the top of the 'Release Notes' page. Note that we have excluded the 'Highlights of Confluence 4.0' heading from the table of contents by modifying the macro's parameters.
5. The image below shows the macro parameters specified in the macro browser. Note the 'Minimum Heading Level' and 'Maximum Heading Level' parameters.

Return to top of page

Drawing Attention to Elements of a Page

Often when creating documentation there are elements of a page that you want to highlight, or draw the the viewers attention to. Confluence ships with the following macros that help you focus a viewer's attention to a note, information, tip or warning.

Click here to see common examples >>

**Note Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Note macro allows you to highlight a note on a Confluence page.</td>
<td><img src="https://example.com/draft-in-progress.png" alt="" /> Draft in progress</td>
</tr>
<tr>
<td>It creates a yellow coloured box surrounding your text, as shown to the right.</td>
<td>This document is a draft and is under development.</td>
</tr>
</tbody>
</table>

See [Note Macro](#) for more examples and instructions.

**Info Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
The Info macro allows you to highlight helpful information on a Confluence page.

It creates a blue coloured box surrounding your text, as shown to the right.

See [Info Macro](#) for more examples and instructions.

### Tip Macro

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Tip macro allows you to highlight a helpful tip on a Confluence page.</td>
<td><img src="#" alt="Learn more" /> Check out this blog post: <a href="#">Techni cal Writing in a Wiki: Technical Communicators Explain How &amp; Why?</a></td>
</tr>
<tr>
<td>It creates a green coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Tip Macro](#) for more examples and instructions.

### Warning Macro

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Warning macro allows you to highlight a warning note on a Confluence page.</td>
<td><img src="#" alt="Draft" /> This page is a draft in progress and visible to Atlassian staff only.</td>
</tr>
<tr>
<td>It creates a red coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Warning Macro](#) for more examples and instructions.

[Return to top of page](#)

**Putting Content inside Customisable Panels**

The [Panel macro](#) allows you to place content inside a customisable coloured panel. This is particularly useful when you want to clearly separate elements on a page.

*Click here to see a common example*
1. You are documenting a procedure which involves a number of steps.
2. You want to call out the steps of the procedure from the rest of the page by placing it inside a coloured box, or panel.
3. You can create a coloured panel using the Panel macro.
4. The image below shows the parameters set for the panel using the macro browser.

Return to top of page

Inserting Anchor Links on Pages

Anchor links can be especially useful when navigating between sections of a long document or when you want to link to a segment of a page from another page. The Anchor macro allows you to link to specific parts of a page.

Click here to see a common example >>

1. You are documenting part of a user guide.
2. The page is split into multiple sections.
3. After each section you want to provide a link for viewers to click, taking them back to the top of the page.
4. To achieve this you first must create an anchor at the top of the page using the Anchor macro. You can give the anchor any name you like. In the image below, the anchor at the top of the page will be named 'top'.

5. The anchor placeholder will appear to indicate where your anchor link is located on the page:
6. Create a link to the anchor, anywhere on the page, using the [Link Browser](#). The image below shows a link to the anchor called 'top' by using the hash '#' followed by the name of the anchor you created earlier, with an alias of 'Return to Top'.

See [Working with Anchors](#) for more examples and instructions.

**Structuring Content using Sections and Columns**

Sometimes it is necessary to structure content into sections and columns. The details are in [Working with Page Layouts and Columns and Sections](#).

- Page layouts offer a set of predefined columns and sections.
- The Section and Column macros allow more flexibility. You can set the width of the columns, and put the sections and columns in any part of the page.
- You can create any number of sections on a Confluence page using the Section macro.
- Each section can contain any number of columns, created using the Column macro.
- Columns can either have a fixed width, specified in pixels, or a dynamic width, specified as a percentage of the page width.
- Note: A `column` must be created inside a `section`.

**Click here to see a common example >>**

The images below show part of a Confluence page with two sections (outlined in red), each with two columns (blue) of different widths.
1. Section 1:

   1. Put a name to your face
   2. Learn how content is organised
   3. Get familiar with the Confluence screens
   4. Start creating content
   5. Add a panel to your page

   Put a face to your name
   Your profile picture is used to identify you across Confluence. Upload your own picture via your Profile.
   Learn More >>

   Fred Flintstone
   Profile   Network   Status Updates   Labels   Watches   Drafts   Settings
   Profile Details
   Picture
   Password
   Upload a Profile Picture: Upload your own profile picture. Profile pictures will be resized to 48 x 48 pixels.
   Upload

2. Columns in section 1 – left column has a fixed width of 400 pixels:

   1. Put a name to your face
   2. Learn how content is organised
   3. Get familiar with the Confluence screens
   4. Start creating content
   5. Add a panel to your page

   Put a face to your name
   Your profile picture is used to identify you across Confluence. Upload your own picture via your Profile.
   Learn More >>

   Fred Flintstone
   Profile   Network   Status Updates   Labels   Watches   Drafts   Settings
   Profile Details
   Picture
   Password
   Upload a Profile Picture: Upload your own profile picture. Profile pictures will be resized to 48 x 48 pixels.
   Upload
Making your Documentation more Engaging by Embedding Videos

Pictures can be worth a thousand words. The same can be said for videos. Often, it's easy to explain a concept or demonstrate a procedure using a video. The Widget macro allows you to embed web content, including YouTube, Episodic and Vimeo videos, in a Confluence page.

Click here to see a common example >>

1. You release a new version of your product.
3. The marketing team creates a video demonstrating the new features of the release and uploads it to YouTube.
4. You can embed the video in your Release Notes using the Widget macro, for playback on your Confluence page.
   a. Select 'Other Macros' from the 'Insert' menu in the Rich Text Editor toolbar.

   ![Image of Rich Text Editor toolbar with 'Other Macros' highlighted]

   b. Search for the 'Widget Connector' in the macro browser.

   ![Image of Select Macro dialog with 'Widget Connector' highlighted]
c. Insert the URL of your YouTube video into the ‘Web Sites Widget URL’ field.

![Web Sites Widget URL](https://example.com)

d. Click ‘Insert’ and save your page.

![Confluence 4.0 Release Notes](https://example.com)

See [Widget Connector Macro](https://example.com) for information on the supported services and for more usage examples.

**Return to top of page**

**Next Steps**

Take a look at [Confluence Plugins for Technical Documentation](https://example.com).

**Confluence Plugins for Technical Documentation**

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight some of the Confluence plugins that are useful for technical writers in designing and developing documentation.

A plugin is an extension module that you can add to your Confluence site, to extend the wiki’s core functionality. It is similar to an add-on for your browser. Confluence plugins may be developed by Atlassian or by third parties.
To find the plugins featured on this page, and other plugins too, visit the Atlassian Plugin Exchange.

This page features plugins that provide the following extended capabilities:

- **Extended Wiki Markup Features**
  - Quick Overview of Macros
  - Composition Plugin
  - Using the Composition Plugin to Outline Text Blocks
  - Using the Composition Plugin to Add Tabs to a Page
  - Using the Composition Plugin to Flow your Text around Images
  - Scaffolding Plugin

- **Extended Version Control**
  - Scroll Versions
  - Attachment Checkout Plugin

- **Drawing Tools**
  - Gliffy Plugin
    - Notes
    - Further Reading

---

Quick guide to the plugins featured below

- **Scroll Versions** – Adds functionality for sophisticated version management, enhanced content reuse, support for context-sensitive help, permalinks, and duplicate page titles. This is a commercial plugin.

- **Composition plugin** – Provides macros which allow finer control over the layout (composition) of a page. For example, outline text; add tabs to your page; flow your text around diagrams. This plugin is free.

- **Scaffolding plugin** – Provides macros for creating ‘permanent templates’ and editable forms. Commercial.

- **Attachment Checkout plugin** – Adds check-out/check-in functionality for Confluence attachments. Free.

- **Gliffy plugin** – Provides an embedded diagram editor. Commercial.
Extended Wiki Markup Features

All wiki markup extensions are provided by macros in Confluence. Some macros are built in to Confluence. Other macros are supplied by plugins.

Quick Overview of Macros

Before looking at plugins, let's take a quick look at macros in general. There are two ways to add a macro to your page:

- Use the macro browser. This is the simplest and recommended way.
- Or insert the macro's name in curly brackets into the text of your page and specify the parameters.

Click here to see an example of a macro >>
The following code uses the `{include}` macro to insert the text from the page called 'My Page'. The text will appear on the page where the macro is used:

```
Page text...
{include:My Page}
page text...
```

The resulting page will look like this:

```
Page text...
<text from the 'My Page' page>
page text...
```

A number of macros are shipped with your Confluence installation by default. See Working with Macros. Below we describe some plugins that provide additional useful macros for Confluence:

Composition Plugin

The **Composition plugin** adds some formatting features to compose a page in a more flexible way. Using the macros provided by the Composition plugin, you can:

- Outline your text blocks.
- Add tabs to a page.
- Flow your text around the images or diagrams on the page.

**Using the Composition Plugin to Outline Text Blocks**

Use the `{cloak}` macro to outline a text block.

**Usage:** The following code creates a text block named 'SeeAlso' for the outlined 'See Also' section within a page. The text block with id=’SeeAlso’ will be hidden after the 'See Also' title:

```
{composition-setup}
  h2. {toggle-cloak:id=SeeAlso} See Also
  {cloak:id=SeeAlso}
  h3. Working With Macros:
    [Link 1]
    [Link 2]
  h3. Working with Rich Text Editor:
    [Link 3]
    [Link 4]
  {cloak}
```

**Alternatives:** You can also use the `{expand}` macro available in Confluence by default, but this macro can outline only text of the same level and cannot hide headings within the text. The `{expand}` macro does not require parameters and just hides the text placed between the `{expand}` tags.

**Note:** If you need to outline a text block containing nested headings, consider the text structure. Maybe the block is too big. You could create a child page from this block to decompose the whole text. Then you can include and outline the text block using the `{include}` macro within `{expand}`.

**Using the Composition Plugin to Add Tabs to a Page**

Use the `{deck}` and `{card}` macros to separate content between tabs on the same page.
Usage: The following code creates two tabs with client information:

```
{composition-setup}

h1. Client Name
{deck:id=ClientName}
{card:label=Basic}

Client Company Name: Company
[Client Web Site|http://url.com]
Our projects: [Project1|Project1 Home]
{card}
{card:label=Contacts}
Company CEO: John Brown, e_mail: brown@company.com
{card}
{deck}
```

The tabs on a page will look like this:

![Client Name](image)

Using the Composition Plugin to Flow your Text around Images

Use the `{float}` macro to make your text flow around images or diagrams.

Usage: The following code demonstrates how a picture can be surrounded by the description, as often shown in printed publications:

```
{composition-setup}
{float:left}
!shakespeare.jpg!
{float}

William Shakespeare (baptised 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's pre-eminent dramatist.
```

The page will look like this:
William Shakespeare (baptized 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's pre-eminent dramatist. He is often called England's national poet and the "Bard of Avon". His surviving works, including some collaborations, consist of about 39 plays, 164 sonnets, two long narrative poems, and several other poems. His plays have been translated into every major living language and are performed more often than those of any other playwright.

Shakespeare was born and raised in Stratford-upon-Avon. At the age of 18, he married Anne Hathaway, with whom he had three children: Susanna, and twins Hamnet and Judith. Between 1586 and 1592, he began a successful career in London as an actor, writer, and part owner of a playing company called the Lord Chamberlain's Men, later known as the King's Men. He appears to have retired to Stratford around 1613, where he died three years later. Few records of Shakespeare's private life survive, and there has been considerable speculation about such matters as his physical appearance, sexuality, religious beliefs, and whether the works attributed to him were written by others.

Shakespeare produced most of his known work between 1592 and 1613. His early plays were mainly comedies and histories, genres he raised to the peak of sophistication and artistry by the end of the 16th century. He then wrote mainly tragedies until about 1608; including Hamlet, King Lear, and Macbeth, considered some of the finest works in the English language. In his last phase, he wrote tragicomedies, also known as romances, and collaborated with other playwrights.

For more macros, see the Composition plugin page.

Scaffolding Plugin

The Scaffolding plugin allows you to create sophisticated page templates in order to add content easily and fast. Scaffolding templates are suitable for dynamically-filled data and allow people to create pages by completing form fields and selecting values from drop-down lists.

The Scaffolding templates are useful for creating pages with a well-determined structure, such as:

- API methods or property descriptions.
- Constant list.
- Feature description.
- Software requirement specifications.

Example: The following Scaffolding template creates a description of an API method:
h3. Method Name
{text-data:methodName|required=true}{text-data}

h3. Method Description
{text-data:methodDescription|type=area|required=true|width=100%}description{text-data}

h3. Parameters
{table-data:parameters}
|| Name || Type || Mandatory || Description ||
| {text-data:paramName}ParamName{text-data} |
{list-data:paramType}{list-option:Number}Number{list-option}{list-option:String}String{list-option}{list-option:DateTime}DateTime{list-option:MACaddress}MACaddress{list-option}{list-option:IPaddress}IPaddress{list-option}{list-data} |
{list-data:paramMandatory}{list-option:Required}Required{list-option}{list-option:Optional}Optional{list-option}{list-data} |
{text-data:paramDescription|type=area}param description{text-data} |
{table-data}

h3. Return Value
The returned value is an XML structure of the following format:
\{code:xml\}
\(\text{code}\)\nWhere elements mean:
{table-data:returnValues}
|| Name || Type || Description ||
| {text-data:paramName}ParamName{text-data} |
{list-data:paramType}{list-option:Number}Number{list-option}{list-option:String}String{list-option}{list-option:DateTime}DateTime{list-option:MACaddress}MACaddress{list-option}{list-option:IPaddress}IPaddress{list-option}{list-data} |
{text-data:paramDescription|type=area}param description{text-data} |
{table-data}

h3. Remarks
{text-data:remarks}remarks{text-data}

h3. See Also

This template will look like this:
For more information on how to create templates in Confluence, see Adding a Template.

Alternatives: Confluence includes built-in templates which as useful for static data and simple text. For more information, see Working with Templates.

Notes: The Scaffolding (and any) template changes will affect only new pages created from the modified template. In order to change the existing pages, you need to edit each individual page and add or modify the formatting manually.

For more information on Scaffolding, see the Scaffolding plugin page.

Extended Version Control

Scroll Versions

Scroll Versions enables you to set up and manage concurrent versions of your documentation in a single space. Multiple versions of software, different product variants, and even multiple translations of documentation can be managed. Changes to pages are scheduled for a specified version and then published all at once. See the Scroll Versions documentation for an overview of the key features.

Video: Scroll Versions - Version Management for Confluence (4:20)

Attachment Checkout Plugin

The Attachment Checkout plugin adds check-out/check-in functionality for Confluence attachments. It allows you to control the versions of the documents attached to a page with the same file name.
Attachment checkout allows Confluence to warn contributors that the document is being edited by someone else. Note that there are no merge features for attachments.

**Example:** To store and control the versions of Project Vision documentation received from a customer on the Confluence page:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator (Last Modifier)</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client1_Project1_Vision.doc</td>
<td>30 kB</td>
<td>Ekaterina Stepalinga</td>
<td>Checkout</td>
</tr>
<tr>
<td>Version 2</td>
<td>30 kB</td>
<td>Ekaterina Stepalinga</td>
<td>Nov 8, 2010</td>
</tr>
<tr>
<td>Version 1</td>
<td>30 kB</td>
<td>Ekaterina Stepalinga</td>
<td>Nov 8, 2010</td>
</tr>
</tbody>
</table>

For information on working with attachments, see [Working with Attachments](#). For information on attachment versioning, see [Attachment Versions](#).

### Drawing Tools

**Gliffy Plugin**

The [Gliffy plugin](http://www.gliffy.com/) provides an embedded diagram editor. Gliffy allows you to create and edit diagrams directly from a Confluence page. It supports various [diagram types](#) (UML, business process, and so on).

**Alternatives:** As an alternative you can use the standalone version of Gliffy available at [http://www.gliffy.com/](http://www.gliffy.com/). Gliffy online has a free basic version.

For more information, see the [Gliffy plugin page](#).

### Notes

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on [installing plugins](#).
- **Plugin support.** Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on [plugin support](#).

### Further Reading

- A blog post about useful plugins and tools for exporting and importing content from/to Confluence: [Technical Writing in a Wiki - Single Source Publishing](#) (November 2010).
- Website for exploring and downloading the available plugins: [Atlassian Plugin Exchange](#).
- Documentation on installing and configuring plugins: [Installing and Configuring Plugins using the Universal Plugin Manager](#).
- Documentation on using macros: [Working with Macros](#).
- [Further Reading about Developing Technical Documentation on Confluence](#)

### Further Reading about Developing Technical Documentation on Confluence

This page is part of the guide to [developing technical documentation on Confluence](#). Once you have absorbed all the information in this guide, you may be ready for more reading. 😊

- The Confluence documentation: [Confluence Latest](#).
- Tips from other technical writers, in the Confluence documentation: Tips of the Trade.
- Blog post about using Confluence for online help: Using a wiki for online help.
- Blog posts about version management in Confluence with Scroll Versions plugin:
  - [Announcing Scroll Versions](#).
  - [Version management gets serious with Confluence Scroll Versions plugin](#).
- Now you have your documentation space up and running, it's fun and rewarding to use the full power of the wiki to engage your readers and embed content from other social sites. Here is a blog post and presentation slides on engaging readers in the documentation.
- A Wiki as Platform Extraordinaire for Technical Communication

Let us know about more links

We plan to add more links to this page or to the 'Tips of the Trade' page. Let us know of any we have missed.

Developing a Knowledge Base on Confluence Wiki

Welcome! This is a guide to using Confluence as a knowledge base. You will find this guide useful if you want to produce a knowledge base with a survey, content curation, intelligent search and standardized templates.

In these pages, we'll show you how to use Confluence to achieve a high-functioning knowledge base, including these features:

- Using Templates
- Subscriptions (RSS or Email)
- Exporting articles (PDF or Word)
- Organizing content (hierarchically or by label)
- Involving Customers (using comments)
- Populating data
- Scripts to update content programatically
- A “Was This Helpful?” survey
- Intelligent searching algorithms (higher ranked articles are promoted in search results)
- Targeted searching across specified Confluence spaces and content types
- How to show related content
- Extensive metrics and reporting
- Maintenance

PAGES IN THE GUIDE
- Creating Your Knowledge Base Space
- Using Templates and Formatting Macros in a Knowledge Base
- Proactive Communications in a Knowledge Base
- Additional Plugins for a Knowledge Base

RELATED TOPICS
- Confluence User's Guide
- Confluence Administrator's Guide

Creating Your Knowledge Base Space

This guide is for people who want to develop and publish a knowledge base using Confluence. You'll find Confluence useful because it combines professional web publishing features with the ease-of-use and flexibility of a wiki - requiring a low barrier to entry, but high quality output for all your team members. Confluence provides all of the collaborative features for your reports (such as automatic versioning, granular enterprise security, email and RSS subscriptions, and JIRA integration). This page is a quick-start guide to creating a wiki space for a knowledge base.
Quick guide to creating a knowledge base space

- Add a Space and Select the Documentation Theme
- Set the Space Permissions
- Customise the Title and Content of the Homepage
- Customise the Documentation Theme
- Create an Inclusions Library to Manage Reusable Content
- Create the Table of Contents
- Make your Knowledge Base Proactive with a Subscribable RSS Feed
- Insert Google Analytics Code into Confluence's Custom HTML
- Set up Atlassian's Content Survey and Reporting Plugin

The rest of this page gives more details of the above procedure.

### On this page:

- **Step 1. Add a Space and Select the Documentation Theme**
- **Step 2. Set the Space Permissions**
- **Step 3. Customise the Title and Content of the Homepage**
- **Step 4. Customise the Documentation Theme**
- **Step 5. Create an Inclusions Library to Manage Reusable Content**
- **Step 6. Create the Table of Contents**
- **Step 7. Make your Knowledge Base Proactive with a Subscribable RSS Feed**
- **Step 8. Insert Google Analytics Code into Confluence's Custom HTML**
- **Step 9. Set up Atlassian's Content Survey and Reporting Plugin**
- **Note about Plugin Support**

#### Step 1. Add a Space and Select the Documentation Theme

Below is a quick guide to adding a space. See [Setting up a New Global Space](#) for a full description.

1. Go to the Confluence dashboard and click **Add Space** located on the 'Spaces' tab.
   
   *Hint: If you cannot see the Add Space link, this means that you do not have permission to add spaces. Please contact your Confluence administrator.*

2. In the 'Create Space' screen, enter a **space name** and a short, unique **space key**.

3. Leave the **permission** settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.

4. Select the **Documentation Theme**.

5. Click **OK**.

The homepage of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.

#### Step 2. Set the Space Permissions

Define the space permissions to determine who can do what in your new space.
1. Choose **Browse > Space Admin**.
2. Click **Permissions** in the left-hand panel.
3. Confirm your administrator access as prompted.
4. Click **Edit Permissions**.
5. Set the permissions to suit your needs then click **Save All**.
   - You can add **groups** and/or individual **users** to the list, then select the permissions for each group or user.
   - You can also set the permissions for **anonymous** users – these are people who have not logged in to the wiki. Anonymous access is available only if enabled for the entire Confluence site. We recommend this setting if you are using this space for Technical Documentation or for a Knowledge Base.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

A Bit More about Permissions

Confluence has a robust and granular permissions scheme that you can use to determine who can view, comment on and even update the documentation. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page. Below we discuss a way of using these in the draft, review and publishing workflow.

Space permissions in Confluence are simple yet granular enough to be useful for technical documentation. You can:

- Use the permission levels to control who can create pages in the space, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users.

Terminology:

- 'Anonymous' means people who have not logged in to the wiki. These are users that won't affect your the number permitted by your license.
- The 'confluence-users' group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow 'Anonymous' users specific view and content creation rights so that they can access and engage with your knowledge base while your team lead (Bill) maintains full Space Administration rights.
Step 3. Customise the Title and Content of the Homepage

When you created your space, Confluence created a homepage with default content and a default title, 'Home'. You will want to change the title and content.
1. Go back to your space homepage, by clicking the space name in the breadcrumbs at the top of the screen. In the example below, the space name is 'My Knowledge Base':

   Dashboard › My Knowledge Base › Space Administration › View Space Permissions

2. The space homepage appears. By default, the page title is 'Home'.

   Dashboard › My Knowledge Base › Home

3. Click **Edit**.

4. Change the title to suit your needs.

5. Update the content to suit your needs.

   *Hint:* If you do not know what to add yet, just add a short description. You can refine the content of the page later. Take a look at an [example of a homepage](#).

6. Click **Save**.

**Step 4. Customise the Documentation Theme**

When you added this space you chose the Documentation theme, which provides a left-hand navigation bar and a good look and feel for a knowledge base. If necessary, you can configure the Documentation theme to add your own page header and footer or to customise the default left-hand navigation bar. These customisations affect the online look and feel of your knowledge base. See [Configuring the Documentation Theme](#) for the full description in our product documentation.
1. Choose **Browse > Space Admin**.
2. Click **Themes** in the left-hand panel.
3. If the space is not yet using the Documentation theme, apply the theme now.
4. Click **Configure theme** in the yellow area of the ‘Current Theme’ section at the top of the page.

**Current Theme**

The current theme controls the layout and colours of this space.

**Documentation Theme**

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer. This theme supports Firefox, Safari and Internet Explorer 7+.

**Configure theme** - further customise this theme's options

5. The ‘Documentation Theme Configuration’ screen appears. Customise the left-hand navigation bar, header and footer to suit your needs. Details are in the documentation. Here are some hints:
   - The **Page Tree** check box determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
   - The **Limit search results to the current space** check box determines whether Confluence will search only the current space or the whole Confluence site. This setting affects the default search. Viewers can override it each time they do a search.
   - Enter text, images, macros and other wiki markup into any or all of the three text boxes for the left-hand navigation bar, header and footer. You can use the **Include macro** and the **Excerpt Include macro** to include re-usable content.
   - Any content you add to the navigation panel will appear above the default page tree.
   - If you like, you can remove the default page tree (by unticking the box) and add your own, customised version of the **Pagetree** macro instead.

6. Click **Save**.

**Example of a Customised Footer**

Take a look at the footer of a page in the Crowd documentation space.

To produce the above footer, we have the following content in the footer panel in the Documentation theme configuration screen:

---

Except where otherwise noted, content in this space is licensed under a Creative Commons Attribution 2.5 Australia License.
Here it is in text form:

{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}

The above content consists of two Include macros.

- The first macro includes a page called _Documentation Footer. This page contains the big blue buttons and hyperlinked text.
- The second macro includes a page from a different space, the ALLDOC space, called _Copyright Notice. This page includes our standard copyright notice, used in all our documentation spaces.
- In each include macro, the content has been drawn from an inclusions library, a hidden content repository, from which you can store frequently and re-usable content throughout your knowledge base space.

**Step 5. Create an Inclusions Library to Manage Reusable Content**

Using Confluence, you can dynamically include content from one page into another page. You can include a whole page into another one, using the Include macro. You can also define an 'excerpt' on a page, and then include that excerpted text into another page using the Excerpt Include macro.

To organise your re-usable content, we recommend that you create a set of pages called an 'inclusions library'.

1. Choose Browse > Pages.
2. Choose Add > Page. This will add a page at the root of the space, at the same level as the homepage.
3. Enter a suitable title. We use '_InclusionsLibrary'. The unusual format of the title helps to let people know this page is special.
4. Enter some content on the page. We enter text explaining the purpose of the inclusions library and how to re-use the content. You can copy our text by clicking through to one of the example pages listed below.
5. Add child pages containing your re-usable content. See the examples of our own inclusions libraries listed below.

Some notes about inclusions libraries:

- The inclusions library is not a specific feature of Confluence. The pages in the inclusions library are just like any other Confluence page.
- The pages are located at the root of the wiki space, not under the homepage. This means that they will not appear in the table of contents on the left and they will not be picked up by the search in the left-hand navigation bar either.
- The pages will be picked up by other global searches, because they are just normal wiki pages.
- We have decided to start the page name with an underscore. For example, '_InclusionLibrary'. This indicates that the page is slightly unusual, and will help prevent people from changing the page name or updating the content without realising that the content is re-used in various pages.

**Examples of Inclusions Libraries**

Here are some examples in our documentation:
Step 6. Create the Table of Contents

Create the table of contents for your knowledge base, by adding the top-level pages for all the usual sections. For instance, our Technical Support Team designed the following pages in the Confluence Knowledge Base on our public wiki:

- Browse Articles by Label
- Browse Articles by Top Ranked Content
- Browse Articles by Page Tree Hierarchy
- Browse Articles by Version
- Subscribe to Proactive Announcements

1. Go back to your space homepage, by clicking the space name in the breadcrumbs at the top of the screen.
2. Choose Add > Page. This will add the page as a child of the homepage.
3. Enter the page title, for instance: ‘Browse Articles by Label’.
4. Enter the content of the page.
   - Hint: If you do not know what to add yet, just add a short description then refine the content of the page later. If you like, you can follow a similar outline as the Confluence Knowledge Base and add the Label List macro. This displays a hyperlinked alphabetical index of all labels within the current space. As you create content in this space and apply appropriate labels, the macro will update this page automatically.

Browse Content by Label

Click on one of the labels below to find related content:

Below are the 181 labels used in Confluence Knowledge Base listed alphabetically. Click a label to see its associated content.

A-B: apache, applinks, appserver, attachments, backup, bamboo, build
C: cache, calendar, camelcase, camel_case, captcha, case_sensitivity,
D: dashboard, database, db2, deadlock, directory, doc_import, documentation_theme, dynamic_tasklist

5. Click Save.

Now do the same for all the sections of your Knowledge Base that you wish to appear in the left-navigation bar of the Documentation theme. Below is what the Table of Contents looks like for our Confluence Knowledge Base:
Step 7. Make your Knowledge Base Proactive with a Subscribable RSS Feed

Let's populate the knowledge base homepage with content by creating an RSS feed that your coworkers and customers can subscribe to and receive important updates on your knowledge base and technical alerts on your products.

This is a strategy that Atlassian's Technical Support Team uses to create a proactive knowledge base that provides technical alerts to customers and coworkers and helps solve support issues before they're even created.

By following the quick guide below, you'll create a homepage similar to the one Atlassian's Technical Support Team has created for the Confluence Knowledge Base on our public wiki and turn your knowledge base from reactive to proactive.

Technical Announcements

Copy the RSS feed into your favourite RSS reader:

<table>
<thead>
<tr>
<th>Important Technical Announcements for Confluence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blog Posts</td>
</tr>
<tr>
<td><img src="image" alt="End of Support and New Support Announcements for Confluence 3.5 and Confluence 4.0" /> created by Sarah Maddox [Atlassian Technical Writer] Confluence Knowledge Base Jan 06</td>
</tr>
<tr>
<td><img src="image" alt="Welcome to the Confluence Technical Announcements Blog" /> created by Jeremy Largman [Atlassian] Confluence Knowledge Base Dec 22</td>
</tr>
<tr>
<td><img src="image" alt="Technical Alert for Confluence 3.4 - Login Errors when Delegating to Crowd" /> created by Adam Laskowski [Atlassian] Confluence Knowledge Base Oct 14</td>
</tr>
</tbody>
</table>

View more recent blog posts
### Creating your RSS Feed

Confluence can filter spaces by content type. To filter your knowledge base for 'blog post' content, do the following:

1. Choose **Browse > Blog Posts**.
2. Copy this URL to your clipboard.
3. Create an RSS feed for the URL of your knowledge base space.

Now your RSS feed will consist of any blog posts created in the knowledge base space.

### Highlighting Your Technical Announcement RSS Feed

1. Go to your space homepage by clicking the appropriate breadcrumb in the top-left of your screen.
2. Click **Edit**.
3. Insert an 'h2' heading, such as 'Important Technical Announcements'.
4. Insert bold text that reads something like, 'Copy the RSS feed into your favourite RSS reader:'.
5. Choose **Insert > Other Macros** to open the Macro Browser.
6. Select the 'Panel' macro in the Macro Browser and specify your desired macro preferences. We recommend that you change the **Panel Title**, **Border Style**, and **Background Color** to further highlight the panel on the page.
7. Click **Insert**.

### Insert a Blog Posts Macro

1. Click in the Panel macro placeholder and choose **Insert > Other Macros** to open the Macro Browser again.
2. Select the 'Blog Posts' macro in the Macro Browser and specify the following preferences:

   - **Content Type to Display**: Title
   - **Restrict to These Spaces**: Your knowledge base Spacekey
   - **Maximum Number of News Items**: 5
   - **Sort By**: Creation
   - **Reverse Sort**: Tick the box

3. Click **Insert** to insert the Blog Posts macro onto the page inside your Panel macro.

Now your panel will display the last 5 blog posts created in your knowledge base space.
## Inserting your RSS Feed into your 'Technical Announcement' Panel

First, let's create a link so that your coworkers and customers can view all of the blog posts in your knowledge base space. See [Working with Links](#) for a full description in our product documentation.

1. Place your cursor after/below the Blog Posts macro in the Panel macro placeholder.
2. Type: 'View more recent blog posts'.
3. Highlight this text and click **Link** on the editor toolbar.

### Insert Link

<table>
<thead>
<tr>
<th>Search</th>
<th>URL:</th>
<th>http://</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recently Viewed</td>
<td>Link Text:</td>
<td>View more recent blog posts</td>
</tr>
<tr>
<td>Attachments</td>
<td>Web Link</td>
<td></td>
</tr>
</tbody>
</table>

4. Select 'Web Link' and paste the link you copied to create your RSS Feed.
5. Click **Insert**.

Now, let's insert your RSS Feed into your panel by linking an image. See [Linking an Image](#) for a full description in our product documentation.

1. Attach an RSS Icon ![RSS 2.0](RSS.png) to the page by dragging and dropping it into the editor (preferably below the link you just created). See [Drag-and-Drop](#) for a full description in our product documentation.
2. Click the RSS Icon image and then click the 'Align right' button on the editor toolbar.
3. Click **Border** in the image properties panel.
4. Link the RSS Icon by selecting the image and then clicking **Link** on the editor toolbar.
5. Click the 'Web Link' tab and insert the RSS Feed URL you created.
6. Click **Insert** to link your RSS Feed to the RSS Icon image.
7. Click **Save** to save your page and test your RSS Icon.

Congratulations! You have successfully created a proactive knowledge base.

**Step 8. Insert Google Analytics Code into Confluence's Custom HTML**

Now that you have a strong foundation for a knowledge base, it's critical to assess how effectively it services your customers. Google Analytics is a tool that gives you rich insights into your website traffic and marketing effectiveness. You are going to want to understand how your customers are accessing the resources in your knowledge base. This is a quick guide to inserting Google Analytics HTML code into Confluence so you can measure your knowledge base traffic.
If you don’t have one already, create a Google Account and then create a Google Analytics Account using your Confluence instance’s URL. Copy the Google Analytics code to your clipboard.

Log into Confluence as a System Administrator or Confluence Administrator. Go to the Confluence ‘Administration Console’. To do this:

a. Choose Browse > Confluence Admin.

b. Enter your password and click Confirm. You’ll be temporarily logged into a secure session to access the ‘Administrator Console’.

Click Custom HTML under ‘Look and Feel’. Click Edit to insert custom HTML into your Confluence instance.

1. Insert Custom HTML

   - At end of the HEAD
   - At beginning of the BODY
   - At end of the BODY

7. Paste your Analytics code you have saved to your clipboard into the table labeled At end of the BODY.

8. Click Save.

You can now monitor the activity and traffic for every page you create in your Confluence instance and Knowledge Base.

Hint: If your knowledge base only represents a space within your greater Confluence instance, you can search Google Analytics for activity in the specific space by exclusively filtering for the space key.

Read David Simpson’s blog post about Tracking Confluence Usage with Google Analytics for more information.

**Step 9. Set up Atlassian’s Content Survey and Reporting Plugin**

Now that you can monitor the traffic and activity of your knowledge base, let’s measure its effectiveness. When the Content Survey and Reporting Plugin is activated for a space, it will generate a report that includes:

- Direct feedback from customers about article quality
- Amalgamated "composite score" results
- Answers to secondary questions, such as "Was the info complete?" or "Was the article well-written?".

Lastly, the Content Survey and Reporting Plugin will institute 'intelligent searching' which means that based on the results of the surveys, higher ranked pages are promoted in search results, so your best and most popular pages are found easiest. This is a quick guide for how to set up the Content Survey and Reporting Plugin.
This plugin only functions properly if the Documentation Theme is applied to the space.

Let's install the Content Survey and Reporting Plugin using Confluence's Universal Plugin Manager.

### Installing the Content Survey and Reporting Plugin

1. Log into Confluence as a System Administrator or Confluence Administrator.
2. Go to the Confluence 'Administration Console'. To do this:
   a. Choose **Browse > Confluence Admin**.
   b. Enter your password and click **Confirm**. You'll be temporarily logged into a secure session to access the 'Administrator Console'.
3. Click **Plugins** under 'Configuration'
4. Click the **Install** tab of the UPM and search for the 'Content Survey and Reporting Plugin'.
5. Click **Install**

Now that you've installed the Content Survey and Reporting Plugin, let's configure a survey:

### Configuring a Survey

1. Go to your space homepage by clicking the appropriate breadcrumb in the top-left of your screen.
2. Choose **Browse > Space Admin**.
3. Click **Configure Survey** under 'Knowledge Base Survey'. Here you can:
   - Add a question
   - Edit a question's text
   - Activate or deactivate a question
   - Edit the response text
4. Configure a 'Primary Question' for the survey

   **Primary Question:**
   - **Was this helpful?**
   - Add an Additional Question:
   - Edit Survey Completed Response (anonymous):
   - Edit Survey Completed Response (user):

5. Click **Save**.

Now that you've added a primary question, let's test out the plugin by adding it to the footer of the
Documentation theme so that every page within your Knowledge Base space includes your survey.

**Invoking the Content Survey and Reporting Macro**

1. Go to your space homepage by clicking the appropriate breadcrumb in the top-left of your screen.
2. Choose **Browse > Space Admin**.
3. Click **Themes** under 'Look and Feel'.
4. Click **Configure theme** in the yellow area of the 'Current Theme' section at the top of the page.
5. Visit the 'Footer' section of the 'Documentation Theme Configuration' page and insert this recommended markup to achieve a nice layout of the Content Survey and Reporting Plugin:

   ```
   {section}
   {column:width=5%}
   {column}
   {column:width=90%}
   {panel}
   {kbsurvey}
   {panel}
   {column}
   {column:width=5%}
   {column}
   {section}
   ```

6. Click **Save** and go to your space homepage to view your Content Survey and Reporting Plugin in the footer of the page.

With the Content Survey and Reporting Plugin you can dramatically improve the quality of your knowledge base and the efficiency with which your team creates and maintains it. Here is an example of how our Technical Support Team uses the Content Survey and Reporting Plugin in the Confluence Knowledge Base:

**Help us improve!**

<table>
<thead>
<tr>
<th>Is this article helpful?</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is the content complete?</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Is it well written?</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Content Survey and Reporting Plugin Results:**

Survey results are viewable by Space Administrators only. The plugin develops three results:

- **Pages with Results** - Determine page-by-page, which are you most effective knowledge base articles and which ones need improvement.
As you can see, the plugin develops a 'Composite Score' which ranks articles in search, so your highest scoring (best) content can be found most easily. The score is based on the last 32 votes cast, using the global search configuration. See Confluence Content Survey and Reporting Plugin for a full description on how Global Search boosting works.

- **Pages without Results** - These are the pages in your knowledge base without survey results.
- **Rollup Report** - This is the summary of all survey results. The report can be used to determine how effective your overall knowledge base content is.

<table>
<thead>
<tr>
<th>Page Category</th>
<th>Total Ballots</th>
<th>Composite Score</th>
<th>Is this article helpful?</th>
<th>Is the content complete?</th>
<th>Is it well written?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cannot Save Large Pages with Over 700,000 Characters</td>
<td>2</td>
<td>6</td>
<td>100% (2/2)</td>
<td>100% (1/1)</td>
<td>100% (2/2)</td>
</tr>
<tr>
<td>Unable to Export to HTML due to Page Title with * Symbol</td>
<td>2</td>
<td>6</td>
<td>100% (2/2)</td>
<td>100% (1/1)</td>
<td>100% (2/2)</td>
</tr>
<tr>
<td>Unable to Download Attachments in IE over SSL</td>
<td>2</td>
<td>4</td>
<td>100% (2/2)</td>
<td>100% (2/2)</td>
<td>100% (2/2)</td>
</tr>
<tr>
<td>MySQL Table is Marked as Crash and Should be Repaired</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>ClientAbortException java.net.SocketException Broken Pipe</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>Getting PacketToFileException Error - 'Packet for query is too large'</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>Cluster Panic due to Multiple Deployments</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>0% (0/0)</td>
<td>0% (0/0)</td>
</tr>
<tr>
<td>Page Footer Appears in the Middle of the Page</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>0% (0/0)</td>
<td>0% (0/0)</td>
</tr>
<tr>
<td>Confluence Fails to Process Index Queue Automatically</td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>0% (0/0)</td>
<td>0% (0/0)</td>
</tr>
<tr>
<td>Fatal JVM Crash - <code>java.lang.OutOfMemoryError ... Out of Swap Space?</code></td>
<td>1</td>
<td>3</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>'A call into SPS Single Sign-on failed' Due to Invalid Credentials in the Database</td>
<td>1</td>
<td>2</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>Database Deadlock on Microsoft SQL Server</td>
<td>2</td>
<td>2</td>
<td>50% (1/2)</td>
<td>0% (0/2)</td>
<td>0% (0/2)</td>
</tr>
<tr>
<td>Cluster Panic due to Multicast Traffic Communication Problem</td>
<td>2</td>
<td>2</td>
<td>50% (1/2)</td>
<td>0% (0/2)</td>
<td>0% (0/2)</td>
</tr>
<tr>
<td>Confluence Rebuild Indexing task fails to complete.</td>
<td>1</td>
<td>2</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
<td>100% (1/1)</td>
</tr>
<tr>
<td>Broken Page Layout Due to Disabled Velocity Helper Module in Documentation Theme Plugin</td>
<td>1</td>
<td>-1</td>
<td>0% (0/1)</td>
<td>0% (0/1)</td>
<td>100% (1/1)</td>
</tr>
</tbody>
</table>

Searching Multiple Spaces from your Knowledge Base

As mentioned, the Content Survey and Reporting Plugin generates a composite score that ranks pages and articles within your knowledge base to make the highest (most well regarded) pages more retrievable by visitors. The plugin also improves Confluence search by allowing users to search multiple spaces without ever leaving your knowledge base space. This is really helpful for users that are unfamiliar with Confluence because they can keep the knowledge base as a point of reference within the greater instance of Confluence.

At Atlassian, our product knowledge bases and product documentation exist in the same Confluence instance so that we can make both available to 'Anonymous' users. Our Technical Support team uses the Content Survey and Reporting Plugin to allow visiting users to search for Confluence resources in the product documentation space from the Confluence Knowledge Base space. This provides the visitor twice the chances of finding an answer to their question.

In the image below, you can see the space specific search used in the left-navigation bar to find content related to Confluence in both the 'Documentation' and 'Knowledge Base' spaces. Pages in the 'Documentation' space are listed first and pages in the 'Knowledge Base' space are listed second.
If a user doesn’t choose one of the recommendations from the quick search drop-down menu, the plugin will display a search results page inside the Knowledge Base space rather than directing them to the Confluence global search page. By keeping the visitor in the same space, it will help new users find the information they need and only navigate to pages they intend to, minimising confusion and the number of times a user has to hit the ‘Back’ button in their browser.

**Note about Plugin Support**

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

**Next Steps**
Using Templates and Formatting Macros in a Knowledge Base

This page is part of the guide to developing a knowledge base on Confluence Wiki. We have already shown you how to create your knowledge base space. Now we offer an introduction to the templates that Confluence provides.

Quick guide to templates in Confluence

- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Templates are available across the Confluence site (global templates) or per space (space templates).
- Both 'global templates' and 'space templates', as described on this page, define the content of a page. They do not define the content of an entire space.
- You can import predefined templates, including those shipped with Confluence and additional templates from the Atlassian Plugin Exchange.
- To create a template for an entire space, see our guide to creating your documentation space.

Space Information Design

One question that comes up is whether a knowledge base should be implemented as a decision matrix, with a multi-select or other list. We knew that most of our users visit our documentation directly from search engines. Early on, we learned that at least for us, Google Analytics was showing that most traffic was coming from search engines, not from within our site. See Metrics for a discussion on that. So, we knew to focus on optimising page titles and tags rather than focus on a decision matrix.

Confluence's Built-in Feature Set

Page Templates

Confluence’s Page Templates are an easy place to start. Begin by choosing how you want your templates to look. Here’s how we made our page template:

```
  h3. Symptoms
  FILL IN SYMPTOMS HERE

  h3. Cause
  FILL IN CAUSE HERE

  h3. Resolution
  FILL IN RESOLUTION HERE

  {htmlcomment}
  ENTER SUPPORT TICKET LINKS
  {htmlcomment}
```

You might consider the scaffolding plugin or Form Field Markup for filling out forms. Our support engineers are quite used to using wiki markup (we live and breathe Confluence!), so we left this template as is.

Construct a Home Page: Section, Panels, RSS, and Notifications
Check out the Confluence Knowledge Base Home. The colored content in the middle of the page is an amalgamation of panel, rss and attachment macros. Go to Tools >> Wiki Markup to see.

Wondering how we just made Tools >> Wiki Markup in a different font in the sentence above? Use the {{ }} notation to get the courier font, which you can use for breaking out text. And this would be, of course, a tip. Remember, you can visit Tools >> Wiki Markup on this page as well!

The wiki markup there is a little confusing, but it breaks down like this:

1. A Section macro, defining the top and bottom of the page
2. Column macros, dividing the panels into three
3. Panel macros, with hot, hot, hot html colours
4. Content By Label Macros
5. An RSS Icon, embedded as an attachment, with a link to the RSS feed. Notice the magic on this one:

```
[[rss20.gif|align=right!|http://confluence.atlassian.com/createrssfeed.action?types=pages&sort=created&showContent=true&spaces=CONFKB&labelString=conf32&rssType=rss1&maxResults=50&timeSpan=120&publicFeed=true&title=Confluence+3.2+Knowledge+Base+Articles&showDiff=false]
```

That's a link, with the attachment as the alias, an alignment parameter, and the URL to the RSS feed. Cool, right?

**Exporting Pages**

These are built-in Confluence features. Check Page Exports. You can learn how to customise the PDF export as well.

**Content Macros**

Besides the ones listed above, some favourite macros for formatting content around the site are the Tip, Info, Warning, and Note Macros, ad the Code macro. They make things look great. We also use Adaptavist’s Content Formatting Macros when we really want to bring our A-game.

Every once in a while we get mileage out of the {nomarkup} user macro, when we want to discuss using a macro itself. I suppose that’s because Confluence is one of the products we support! It might be useful for other reasons...

**JIRA Issues Macro**

Using JIRA for bug tracking? You can’t expect your users to necessarily have exactly the right JQL filters to show the appropriate topics. We have some nice JIRA Issues Macros on display. One of my favourites is in the JIRA KB’s Causes for OutOfMemory Errors:

```
{jiraissues:url=http://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/tem/SearchRequest.xml?jqlQuery=project+%3D+JRA+AND+issuetype+in+%28Bug%2C+Improvement%2C+subTaskIssueTypes%28%22+AND+component+%3D+%22Performance+-+Memory+leaks%22+ORDER+BY+key+DESC&tempMax=200|columns=fixversion;summary;status;key|anonymous=true}
```

Notice the JQL there including components and sorting, plus the specific columns.
Labels

Sometimes, an article needs to be cross listed. For that we label our articles. Some great macros to use for this are \{contentbylabel\}, \{listlabels\} and the \{dynamiccontentbylabels\} macro in the Content Survey Plugin.

Next Steps

You now have a good idea of how Confluence templates work. What next? Take a look at Proactive Communications in a Knowledge Base.

Proactive Communications in a Knowledge Base

This page is part of the guide to developing a knowledge base on Confluence Wiki. We have already shown you how to create your knowledge base space and how to use templates and formatting macros. We touched a bit on creating proactive communications in Creating your Knowledge Base Space, and discuss a bit further here.

Quick guide to proactive communications

- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Confluence can either produce or consume rss feeds
- Both the rss and blog-posts macro are a good way to show summaries

Proactive Alerts

Sending technical alerts to customers is a great way to keep customers and staff informed, and good way to reduce support load. At Atlassian we use the Knowledge Base both to consume and produce proactive content for which customers can opt in. This page describes how to achieve that.

Using Confluence as a producer

- The Working with Blog Posts describes how to produce blog posts from Confluence.
- Emailing a Page is a great way to send mass emails to users or an email distribution list.

Using Confluence as a consumer

Even if your Confluence instance isn't producing your proactive content, it can consume and display it in a prominent way:

- The RSS Feed Macro can consume content from any RSS feed on the Internet.
- We use the Blog Posts Macro for it looks especially handsome in a panel, accentuated by an RSS image in a link. Here's the wiki markup:

```markdown
h4. Technical Alerts
{panel:title=Important Technical Alerts for Confluence| borderStyle=solid| borderColor=#ccc| titleBGColor=#f93| bgColor=#fc9}
{blog-posts:content|title|max=5|sort=modified|spaces=CONFKB|time=30d}*
*[View more recent blog posts](http://confluence.atlassian.com/pages/viewrecentblogposts.action?key=CONFKB)*

![CONFKB:Confluence Knowledge Base Home^rss20.gif](http://confluence.atlassian.com/createrssfeed.action?types=blogpost&blogpostSubTypes=comment&blogpostSubTypes=attachment&spaces=CONFKB&title=Confluence+KB+-+Technical+Alerts&labelString=techalert&xcludedSpaceKeys%3D&sort=modified&maxResults=10&timeSpan=30&showContent=true&showDiff=true&confirm=Create+RSS+Feed|showTitleOnly=true)}
```
Next Steps

You now have a good idea of how to do proactive communications. Next up, consider Additional Plugins for a Knowledge Base in more detail.

Additional Plugins for a Knowledge Base

This page is part of the guide to developing a knowledge base on Confluence Wiki. This page includes additional plugins that might expand your usage.

Useful Plugins for a Knowledge Base

These are some great plugins for Confluence as a Knowledge Base:

- The Content Survey and Reporting Plugin gives a good report on popular and unpopular content.
- The Archiving Plugin flags old content.
- The Ad Hoc Workflows Plugin or Content Publishing Plugin, which manages workflows and a review process.

Note about Plugin Support

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

Bye

Hope you enjoyed the tutorial! Have a chocolate, and please share with us your experiences. You can comment directly on this page or email us at .

Developing an Intranet on Confluence Wiki

This guide is for people who are using Confluence as a platform for an intranet. You will find this guide useful if you want to create a space where your team can collaborate and share information.

Quick guide to creating an intranet space

- Add a space.
- Set the space permissions.
- Customise the title and content of the home page.
- Subscribe to email notifications for any updates made to the space.
- Manage your existing Office documents.
- Import page templates.
- Set up your personal space.
- Publish a blog post.

The rest of this page gives more details of the above procedures.

Step 1. Add a Space

Below is a quick guide to adding a space for your team.
1. Go to the Confluence dashboard and click the ‘Add Space’ link.
2. The ‘Create Space’ screen appears. Enter a space name and a short, unique space key.
3. Leave the permission settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.
4. Select a theme. We recommend the 'Global Look and Feel' theme for an intranet.
5. Click ‘OK’ to add the space to your Confluence site.

The home page of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.

Step 2. Set the Space Permissions

Define the space permissions to determine who can do what in your new space.
1. Open the ‘Browse’ menu and select ‘Space Admin’.

2. Click ‘Permissions’ in the left-hand navigation panel.
3. Confirm your administrator access as prompted.
4. Click ‘Edit Permissions’.
5. Set the permissions to suit your needs then click ‘Save All’.
   - You can add groups and/or individual users to the list, then select the permissions for each group or user.
   - You can also set the permissions for anonymous users – these are people who have not logged in to the wiki and will not count towards the number allocated by your license. Anonymous access is available only if enabled for the entire Confluence site. However, it is unlikely you will need anonymous users for your intranet.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

More about Permissions

Confluence has a robust and granular permissions scheme that you can use to determine who can view, create content and comment within your intranet. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page.

Space permissions in Confluence are simple yet granular enough to be useful for an intranet. You can:
- Use the permission levels to control who can create pages, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users. A space administrator has complete control.

Terminology:

- 'Anonymous' means people who have not logged in to the wiki.
- The 'confluence-users' group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow the 'confluence-users' group permission to create and edit comments, but reserve full editing rights for your team members. Let's assume your team members are all members of the 'dev-team' group. The example below shows that members of the 'dev-team' group have all permissions except space administration, but 'Ryan Reynolds' only has a few editing rights.

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

Step 3. Customise the Title and Content of the Home Page

When you created your space, Confluence created a home page with default content and a default title, 'Home'. You will want to change the title and content to suit your team.
1. Go back to your space home page, by clicking the space name in the breadcrumbs at the top of the screen. In the example below, the space name is 'Development Team Space':

```
Dashboard › Development Team › Space Administration › View Space Permissions
```

![View Space Permissions](image)

2. The space home page appears. By default, the page title is 'Home'.

```
Dashboard › Development Team › Home
```

![Home](image)

3. Click 'Edit'.
4. The page opens in edit mode. Change the title to suit your needs.

```
Dashboard › Development Team › Home › Edit Page
```

![Edit Page](image)

```
This is the home of the Development Team space.
```

5. Update the content to suit your needs.
   
   *Hint:* If you do not know what to add yet, just add a short description. You can refine the content of the page at any time.

6. Click 'Save' to save your home page.

**Step 4. Subscribe to Email Notifications for Updates Made to the Space**

You can configure your email notifications to suit your needs: Subscribe to all blog posts from Confluence, subscribe to your network, or stay informed about any changes in a specific space. Below is a quick guide to monitoring a space's content. See [Watching a Space](#) for a full description.
1. Open the ‘Browse’ menu and select ‘Advanced’.

2. Click ‘Start watching this space’ in the bottom section of the left-hand navigation panel.

If at any time you wish to stop watching the space, just click ‘Stop watching this space’.

**Example of an Email Notification**

Here is an example of the email notification you will receive when someone adds a comment to a page:

⭐ [Confluence@atlassian.com](mailto:Confluence@atlassian.com) to me

**Spend 5 minutes. Save a heck of a lot more.**

Blog post comment added by [Ryan Reynolds](mailto:Ryan.Reynolds@atlassian.com)

Required Reading. Auto-complete rocks. Nice video!

[View Online](#) | [Reply To This](#)

"Reply" | "Forward"

**More about Notifications**

You can specify the notifications you want to receive on a global, space and page level. The quick guide above demonstrated how to set up notifications for a space. Now we will show you how to configure your notifications on the global and page levels.

**Global Notifications**

Global notification settings determine the overall behaviour of the notifications you receive from Confluence.
1. Open the 'User' menu (Your name) and select 'Settings'

2. Click 'Email' in the left-hand navigation panel.
3. Click 'Edit'.
4. Change the default settings to suit your needs. You can alter these email settings at any time.
5. Click 'Submit' to save your changes.

**Page and Blog Post Notifications**

Follow the quick guide below to receive notifications from Confluence about changes to and comments on a specific page or blog post. See [Watching a Page or Blog Post](#) for a full description.

You can watch any given page or blog post that you have permission to view. We will use your space's home page as an example.
1. Open the home page of your space.
2. Open the 'Tools' menu and select 'Watch'.

You are now watching the current page and Confluence will notify you about any updates made or comments added.

Note that Confluence will not notify you about content changes that are due to the output of a macro. For example: The output of the Children macro will change if someone adds a child page. The page containing the Children macro will show the new child page. But the page content itself has not been edited, so no notifications will be sent.

You can stop watching a page or blog post at any time. Just open the page, go to the 'Tools' menu and click 'Stop Watching'.

Step 5. Attach or Import Office Documents if Applicable

Below are some guidelines on managing your existing Office documents in Confluence. You can choose to attach them to a Confluence page, so that team members can view and access them in Confluence. Or you can import the documents into Confluence, converting the content to wiki format.

**Attaching Office Documents to a Page**

You can use Confluence as a central repository for your team's the Microsoft Office documents. This means that you can share your Office documents without having to email them to your teammates. People can view the Office documents even if they do not have Office installed on their computers.
1. Go to your space home page, by clicking the space name in the breadcrumbs at the top of the screen.
2. Hovering over the 'Tools' menu and click 'Attachments'.
3. Choose one of the following methods for attaching files to the page:
   - Use the 'Attachments' view's 'browse and attach' feature to attach one or more file(s):
     a. Click the 'Browse' button.
     b. Browse through your files and select the file that you would like to attach to the page.
     c. Enter a description for the attachment in the 'Comment' text field (optional).
     d. Click 'Attach more files' if required. More attachment entry fields will appear, allowing you to attach more files.
     e. Click the 'Attach' button.

   Alternatively, use the drag-and-drop feature to attach one or more file(s): Drag one or more file(s) accessible from your computer and drop them onto the 'Attachments' view. The 'Attach File(s)' message box appears, indicating the upload status of the file(s) being attached to your page.

**Importing Existing Word Documents into Confluence**

You can also import content from Microsoft Word into Confluence, so that it becomes a wiki page. See Importing.
a Word Document into Confluence for a full description.

1. Go to your space home page, by clicking the space name in the breadcrumbs at the top of the screen.
2. Open the 'Tools' menu and select 'Import Word Document'. The Office Connector import screen will appear.
3. Click the 'Browse' button and find the Office document on your local drive or network.
4. Click the 'Open' or 'Upload' button provided by your browser. The path and file name of the document will now appear in the text box on the Office Connector import screen.
5. Click the 'Next' button. The import document options screen will display.

6. Enter the following information:
   - 'Root page title' – The title of the wiki page that will contain the information from your imported document.
   - 'Import as a new page in the current space' – A new wiki page will be created with the page title specified above.
   - Choose what you want the importer to do if there are page title conflicts, by selecting one of the following options:
     - 'Rename imported pages if page name already exists' – Confluence will assign new names to any new page which would otherwise have a duplicate name. The content of existing pages will remain unchanged.
     - 'Split by heading' – Use this field to split your document into multiple wiki pages. If you do not want to split your document into multiple wiki pages, leave the default 'Don't split' option selected.
6. Click 'Import' to import your document.

When the upload has finished, the content of the Office document will have been transformed into Confluence page content. You can now view and edit this page in the normal way, using the Confluence Rich Text Editor or Wiki Markup. There is no connection between the original Office document and this wiki page.

Step 6. Import Page Templates

In order for an intranet to be effective, people need to use it. One way to spur new user adoption is to provide your team mates with templates so that they can focus more on content creation and less on page format. Confluence offers a number of templates, including a template for 'Meeting Notes' and a 'Three-Column Layout',
to help your team get started populating your intranet and improving its productivity. See Importing Templates for a full description.

1. Log in to Confluence as an administrator and go to the Confluence 'Administration Console'.
2. Click 'Import Templates' in the left-hand navigation panel. The 'Import Templates' screen will appear, listing the template packages deployed to your Confluence instance (for example, 'Default Templates Package') and the templates included in each package.

   ![Import Templates](image)

   - Security
     - Security Configuration
     - Manage Users
     - Manage Groups
     - Global Permissions
     - User Directories
   - Configuration
     - General Configuration
     - Daily Backup Admin
     - Manage Referrers
     - Plugins
     - Languages
     - Shortcut Links
     - External Gadgets
     - Global Templates

   The following template package plugins were found. To import templates, tick the checkboxes for the desired templates, select to import the templates to, and click the Import button.

   - Default Templates Package (8) Check All Uncheck All
     - Charts
     - Document List
     - Meeting Notes
     - Multimedia Content
     - RSS News Feed
     - Tasklist
     - Three-Column Layout
     - Two-Column Layout

   Import To: Global Templates

3. Select the templates you want by ticking the check boxes next to the template names.
   Note: You can view a preview of the template by clicking the template name.
4. Select the import destination for the templates in the 'Import To' dropdown. If you want the templates to be available to a specific space only, select the name of the space, otherwise select 'Global Templates' to make the templates available to all spaces.
5. Click the 'Import' button to import the selected templates.

How Users will Find Templates

Now that you have made Confluence's templates available to your site or space, other Confluence users will be able to choose a template when they want to create a page.

Choosing a Template from the Dashboard

When you add a page from the Confluence dashboard, you will be able to select the template and space for the
new page at the same time.

1. Go to the Confluence Dashboard by clicking 'Dashboard' from the breadcrumbs at the top left of your screen.
2. Click the 'Add Page' button. The 'Add Page' dialog appears.

3. Select the space where you want to add the page.
4. Select the template you want to use to populate your page.

5. Click 'Next' to create the page.

Choosing a Template from within the Editor

Often you will add a page from within a space, or as a child of another page. This guide shows you how to choose a template from within the Confluence editor.

1. Go to your space home page, by clicking the space name in the breadcrumbs at the top of the screen.
2. Hover over the 'Add' menu and click 'Page'. This will launch the Confluence editor.
3. To populate the editor from a template, click the ‘Select a page template to start from’ link below the ‘Title’ field. This will launch the ‘Page Template Wizard’.
4. Choose a page template from those available in the list.

**Page Template Wizard**

**Step 1: Choose a page template**

Please choose a template from below:

<table>
<thead>
<tr>
<th>Name</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charts</td>
<td>Global</td>
</tr>
<tr>
<td>Document List</td>
<td>Global</td>
</tr>
<tr>
<td>Meeting Notes</td>
<td>Global</td>
</tr>
<tr>
<td>Multimedia Content</td>
<td>Global</td>
</tr>
<tr>
<td>RSS News Feed</td>
<td>Global</td>
</tr>
<tr>
<td>Tasklist</td>
<td>Global</td>
</tr>
<tr>
<td>Three-Column Layout</td>
<td>Global</td>
</tr>
<tr>
<td>Two-Column Layout</td>
<td>Global</td>
</tr>
</tbody>
</table>

Back  Next >>

5. Click 'Next' to populate the editor with the selected template.

**Step 7. Set Up your Personal Space**

Now that you have created a space for your team, let's create your **personal space**. This is a place where you can publish your own pages and blog posts. Once you have created it, Confluence users can reach your personal space by clicking your name in the People Directory or by searching for your name via the quick navigation search box.
1. Go to your name at the top of the page and select ‘Create Personal Space’ from the dropdown list.

2. Enter a few details about your space:
   - Choose who can view content.
   - Choose who can contribute (create and edit) content.
   - Choose the ‘Global Look and Feel’ for your personal space.

3. Click the ‘Create’ button.

4. The ‘Home’ page for your new space is displayed.

**Step 8. Publish a Blog Post**

Blog posts are a good way of letting your team mates and the company know your news. People can blog about product and strategic ideas, team updates, and things they want to get ideas about. New employees can write blog posts introducing themselves. People write about getting married or the birth of a child. Blog posts are a great way for people to share their visions, get to know their co-workers and start lively discussions.

Remember to set your email notifications to alert you about the blog posts published within Confluence, as described in an earlier step.

See [Working with Blog Posts](#) for a full description of adding, editing, viewing and linking to blog posts.

1. Go to a page in your space.
2. Hover over the ‘Add’ menu and select ‘Blog Post’.
3. Change the title to suit your needs.
4. Update the content to suit your needs.
5. Click ‘Save’ to publish your blog post.

**Related Topics**

- [Setting up a New Global Space](#)
- [Global Permissions Overview](#)
- [Assigning Space Permissions](#)
- [Setting a Page’s Restrictions](#)
- [Users and Groups](#)

**Confluence Administrator’s Guide**
Confluence 4.3 Documentation

Confluence Administrator's Guide

Configuring Confluence
Data and Backups
System Administration
Importing Data
Mail Configuration
Security
User Management
Design and Layout
Integrating Confluence and JIRA
Plugins and Macros
Performance Tuning
Character Encoding
Support

Additional Resources
Visit the Configuration Guide for documentation on configuring databases and application servers. The Confluence User's Guide has information on how to use Confluence as a collaborative tool. Go to Documentation Home for links to more resources.

Download
You can download the Confluence Admin Guide in PDF, HTML or XML formats.

Site Administrator?
The Confluence Administrator's Guide provides information to site administrators on how to manage their Confluence instances.

If you still have a question that hasn't been answered, write and tell us about it.

Configuring Confluence

Site Configuration
Configuring the Site Home Page
Editing the Site Title
Editing the Site Welcome Message
Configuring the Destination of View Space Links
Editing the Global Logo
Configuring the Server Base URL
Configuring HTTP Timeout Settings
Configuring System Properties
Customising Default Space Content

Optional Settings
Enabling the Remote API
Enabling Trackback
Enabling Threaded Comments
Attachment Storage Configuration
Configuring Attachment Size
Display Settings
Configuring Indexing Language
Configuring Character Encoding
Configuring Time and Date Formats
Configuring Number Formats
Configuring Shortcut Links

Data and Backups
Site Backup and Restore
Production Backup Strategy

Backups Configuration
Configuring Backups
Scheduled Jobs
Manually Backing Up the Site

Restoring Data
Restoring a Site
Restoring a Space
Restoring Data During Setup
Retrieve file attachments from a backup
Restoring a Test Instance from Production

Scheduled Jobs
Scheduled Jobs

Data Model
Confluence Data Model

System Administration
System Configuration
Viewing System Information
Viewing and Editing License Details
Cache Statistics
Viewing Site Statistics

System Administration
Content Index Administration
Upgrading Confluence
Migrating Confluence Between Servers
Migrate to Another Database
Important Directories and Files
Rebuilding the Ancestor Table
Finding Unused Spaces

Large Confluence Installations
Operating Large or Mission-Critical Confluence Installations
Configuring a Large Confluence Installation
Overview of Confluence Clusters
Cluster Administration page

Importing Data
Universal Wiki Converter
Importing Pages from Disk
Mail Configuration

Configuring a Server for Outgoing Mail
The Mail Queue

Security

Overview and Advisories
Security Overview and Advisories

Security Options

Configuring Captcha for Spam Prevention
Managing External Referrers
Hiding external referrers
Hiding External Links From Search Engines
Excluding external referrers
User Email Visibility
Anonymous Access to Remote API
Running Confluence Over SSL or HTTPS

User Management

Confluence User Management
Global Groups Overview
Global Permissions Overview
Setting Up Public Access
Adding and Inviting Users
Editing User Details
Removing or Deactivating Users
Adding or Removing Users in Groups
Restoring Passwords To Recover Admin User Rights

External User Management

Configuring User Directories
Connecting to an LDAP Directory
Requesting Support for External User Management

Crowd User Management

Connecting to Crowd or JIRA for User Management

JIRA User Management

Connecting to Crowd or JIRA for User Management

Design and Layout

Configuring Site and Space Layouts
Customising Look and Feel Overview
Customising Colour Schemes
Customising Site and Space Layouts
Working With Decorator Macros
Global Templates
Customising the eMail Templates

Configuring Themes
Themes Overview
Creating a Theme
Applying a Theme to a Site
Including Cascading Stylesheets in Themes

Integrating Confluence and JIRA

Integrating JIRA and Confluence
Installing Confluence and JIRA Together
Setting Up Trusted Communication between JIRA and Confluence

Plugin Management

Confluence Plugin Guide
Installing a Plugin
Installing and Configuring Plugins using the Universal Plugin Manager
Configuring the Office Connector
Setting Up Trusted Communication between JIRA and Confluence
Configuring a URL Whitelist for Macros

Macros

Adding, Editing and Removing User Macros
Enabling HTML macros
Enabling the html-include Macro
Troubleshooting the Gallery Macro
Configuring the User List Macro
Working With Decorator Macros
Writing Macros

Performance Tuning

Memory usage and requirements
Configuring a Large Confluence Installation
Performance tuning
Enabling HTTP Compression
Working with Confluence Logs
Page Request Profiling
Profiling using the YourKit Plugin

Character Encoding

Configuring Encoding
Troubleshooting Character Encodings

Support

How to Get Support

Managing Confluence Users

A Confluence user is a person who can read or update a Confluence site. You can choose whether your Confluence site is accessible to anonymous users (people who have not logged in) or only to logged-in users. See Setting up Public Access.

Confluence user management

You can add users to Confluence, and then assign them permissions that determine their access to the content and administrative functions in your Confluence site. You can also collect users into groups, and assign the permissions to groups for easier management. See the following topics:
Adding and Inviting Users
Removing or Deactivating Users
Searching For and Administering Users
Managing Site-Wide Permissions and Groups

By default, Confluence stores its users and groups in the Confluence database. This is called the internal
directory. You can choose to connect Confluence to an external userbase instead, such as Microsoft Active
Directory or another LDAP server. You can also use Atlassian Crowd and JIRA as directory managers. When
you add a user or group to Confluence, it will be added to the external directory too, based on your configuration
options. See Configuring User Directories.

On this page:
- Confluence user management
- Authentication
  - Seraph
  - XML-RPC and SOAP authentication
  - Password authentication
- Earlier user management frameworks

Related pages:
- Configuring Confluence Security
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If
you are using Confluence-only OnDemand, the information does apply.

Authentication

Seraph

Almost all authentication in Confluence (and JIRA) is performed through Seraph, Atlassian's open source web
authentication framework. The goal of Seraph is to provide a simple, extensible authentication system that we
can use on any application server.

Seraph is implemented as a servlet filter. Its sole job is, given a web request, to associate that request with a
particular user (or no user if the request is anonymous). It supports several methods of authentication, including
HTTP Basic Authentication, form-based authentication, and looking up credentials already stored in the user's
session.

Seraph itself performs no user management functions. It merely checks the credentials of the incoming request
and delegates any user management functions (looking up a user, checking a user's password) to Confluence's
user management system.

If you want to integrate Confluence with your own single sign-on (SSO) infrastructure, you would do so by
installing Atlassian Crowd or by writing a custom Seraph authenticator. See our developer documentation on HT
TP authentication with Seraph.

XML-RPC and SOAP authentication

Normally, requests for Confluence's remote API will include an authentication token as the first argument. With
this method of authentication, XML-RPC and SOAP authentication requests are checked directly against the
user management framework, and tokens are assigned directly by the remote API subsystem. These requests
do not pass through Seraph authenticators.
However, if the token argument is blank, Seraph will be used as a fallback authentication method for remote API requests. So, to use a custom Seraph authenticator with XML-RPC or SOAP requests, ensure that you pass an empty string as the authentication token to remote API methods.

**Password authentication**

By default, password authentication is delegated from Seraph to the user management system. This is not necessary, however. Single sign-on systems may have no password authentication at all, and get all the necessary credentials from the SSO provider.

**Earlier user management frameworks**

- **Atlassian-User – now behind the scenes.** Atlassian-User is a user and group management framework developed by Atlassian. It provides user, group and profile management services to Confluence. In earlier versions of Confluence, you needed to configure your user directories by editing the `atlassian-user.xml` file directly. In Confluence 3.5 and later this is no longer necessary, nor is it possible. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework. Refer to the Confluence 3.5 Upgrade Notes for details of the automatic migration that will occur during the upgrade process.

- **OSUser – obsolete.** OpenSymphony User was Confluence’s core user management framework before Atlassian-User. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework.

**Adding and Inviting Users**

There are a number of ways to add users to Confluence:

- **By user signup:** If user signup is enabled on your Confluence site, people can add themselves as users of the site. See below.

- **Via an invitation link:** You can invite people to sign up, by sending them an invitation link. You can copy and paste the link, or prompt Confluence to send the link in an email message. See below.

- **By adding users manually:** Administrators with Confluence Administrator or System Administrator permissions can add new users. See below.

- **Via an external user directory:** See Configuring User Directories.

**Allowing user signup**

If you enable user signup, a ‘Sign Up’ option will appear on the Confluence screens. The option will be on the login screen, and also in the header on public sites. People can choose the option to create their own usernames on Confluence.

You can restrict the signup to people whose email addresses are within a given domain or domains. This is useful if you want to ensure that only people within your organisation can add their own usernames.

You will still be able to add or invite users manually, whether user signup is enabled or not.

You need Confluence Administrator or System Administrator permissions to change the signup options.

**To set the user signup options:**

1. Choose **Invite Users** on the dashboard, then choose **User Signup Options**.
   Or take the longer route: Choose **Browse > Confluence Admin**. Then choose **Users > User Signup Options**.
2. Choose **Allow people to sign up to create their account**.
3. Choose one of the following options:
   - **Restricted by domain(s)** – Note: You need to set up a mail server for Confluence before you can configure domain restricted signup. When you choose this option, a text box will appear. Enter one or more domains, separated by commas. People will only be able to sign up if their email address belongs to one of the domains specified here. Confluence will send the person an email message, asking them to click a link to confirm their email address.
   For example: mydomain.com, mydomain.net
• No restrictions – Anyone will be able to sign up to Confluence. Confluence will not send any email message requesting confirmation.

4. Choose Notify administrators by email when an account is created if you want Confluence to send an email message to all administrators (people with Confluence Administrator or System Administrator permissions) every time someone signs up to Confluence.

On this page:

• Allowing user signup
• Enabling and disabling notifications about user signup
• Inviting people to sign up
• Resetting the invitation link
• Adding users manually
• Notes

Related pages:

• Managing Confluence Users
• Configuring a Server for Outgoing Mail
• Confluence Administrator’s Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Enabling and disabling notifications about user signup

By default, Confluence will send an email notification to all Confluence administrators whenever someone signs up to the Confluence site. The administrators (people with Confluence Administrator or System Administrator permissions) will receive this message when someone signs up either by clicking the 'Sign Up' link or by clicking the invitation URL sent by an administrator.

To disable this notification:

1. Choose Invite Users on the dashboard, then choose User Signup Options.
   Or take the longer route: Choose Browse > Confluence Admin. Then choose Users > User Signup Options.
2. Remove the tick from Notify administrators by email when an account is created.
3. Choose Save.

Screenshot: User signup options
Inviting people to sign up

You can invite new users to the site by sending them a signup URL, called an 'invitation link'. You can copy the invitation link and paste it onto a page or into an email message, or you can prompt Confluence to send an email message containing the same link.

The option to send invitations is independent of the signup options. You can send invitations if signup is open to all, restricted by domain, or disabled entirely. Even if signup is disabled, a person who has received an invitation will be able to sign up.

When someone visits the invitation link in a browser, a Confluence signup screen will appear.

To invite people to sign up:

1. Choose Invite Users on the dashboard.
2. Copy the Invitation Link and paste it into an email message, or onto a page on your intranet, for example.
3. Alternatively, prompt Confluence to send an email message for you:
   - Enter one or more email addresses in the field labelled Email To. Separate the addresses with commas. For example: john@example.com, sarah@example.com
   - Optional: Change the Message if you want to.
   - Choose Send.

Resetting the invitation link

The invitation link includes a security token, like this:
This security token is a shared token – individual invitations do not have unique tokens. Anyone who obtains this token will be able to sign up to Confluence.

You can change the token at any time, by choosing **Reset**. The previous invitation link will become unusable. People will no longer be able to use the previous link to sign up. If they try, they will see an error message that the signup token has expired.

**Screenshot: Inviting users**

Adding users manually

**To add a new user:**

1. Choose **Invite Users** on the dashboard, then choose **Add Users**.
   
   Or take the longer route: Choose **Browse > Confluence Admin**. Then choose **Users > Add Users**.

2. Enter the user's details: username, name, password, and email address.

3. Choose whether Confluence should send an **email** message informing the person of their new username.

   The email message will contain a link that the person can use to reset their password.

4. Choose **Create**.

**Screenshot: Adding users**
Notes

- **Multiple directories.** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#).

- **Email server required for domain restricted signup and for invitations.** You need to set up a mail server for Confluence, before you can configure domain restricted signup or send email invitations to users.

- **Are the user management options not visible?** If you have external user management turned on, internal user management is disabled. To configure external user management, go to Browse > Confluence > Security Configuration. See [Disabling the Built-In User Management](#).

Removing or Deactivating Users

If you are a [Confluence Administrator](#), you can remove and deactivate users.

You can **remove** a user from Confluence if they have not yet added or edited any content on the site. Such content includes pages and blog posts, and edits and comments on existing pages.

You can **deactivate**, or disable, a user, including one who has contributed content.

- Deactivated users can no longer log in to Confluence.
- Deactivating a user will not remove the content created by them.
- Deactivated users do not count towards your license count. (See the notes below.)

**Related pages:**
- [Managing Confluence Users](#)
- [Configuring User Directories](#)
To remove a user:

1. Go to the user's profile and choose Administer User.
2. Choose Remove.

To deactivate a user:

1. Go to the user's profile and choose Administer User.
2. Choose Disable.

Screenshots: Administering a user

<table>
<thead>
<tr>
<th>User:</th>
<th>alui</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name:</td>
<td>Andrew Lui [Atlassian Technical Writer]</td>
</tr>
<tr>
<td>Email:</td>
<td><a href="mailto:alui@atlassian.com">alui@atlassian.com</a></td>
</tr>
<tr>
<td>Directory:</td>
<td>Confluence Internal Directory</td>
</tr>
<tr>
<td>Created:</td>
<td>Feb 24, 2011 18:47</td>
</tr>
<tr>
<td>Last Updated:</td>
<td>Feb 24, 2011 18:47</td>
</tr>
<tr>
<td>Login:</td>
<td>Last Login: Mar 13, 2011 22:34 Last Failed Login: Jan 26, 2011 19:25 Total Failed Login Count: 3 Current Failed Login Count: 0</td>
</tr>
<tr>
<td>Groups:</td>
<td>atlassian-developers atlassian-staff confluence-administrators confluence-managers confluence-users documentation licensed-contributors</td>
</tr>
<tr>
<td>View Profile</td>
<td>Edit Groups</td>
</tr>
</tbody>
</table>

Notes

- The Administer User link is only visible if you are logged in as an administrator.
- You can also remove or disable users using the Administration Console.
- You can edit the groups that a user belongs to, to change their permissions without completely preventing their access to Confluence.
- Multiple user directories: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

- Number of users and your license: The Confluence 'License Details' screen tells you how many users
your Confluence instance is licensed to support, and how many are currently registered. See Viewing and Editing License Details. The number of registered users includes only users who have the 'Can Use' global permission. Deactivated users, as described above, are not included.

**Searching For and Administering Users**

If you have Confluence Administrator permissions, you can view users, edit their user details, reset their passwords, and assign them to groups.

**Accessing the user management screen**

There are two ways to do this.

Option 1: Administer a known user:

- Go to a user's profile
- Choose Administer User.

Option 2: Find the user first:

- Choose Browse > Confluence Admin.
- Choose Users in the left-hand panel.
- The 'Users' screen appears. You can now list all users or search for a specific user.

**Listing all users**

To list all users:

1. Choose Show all users. All members of the confluence-users group are listed in alphabetical order, by username. If there are more users than can fit on one page, the results will be divided into multiple pages.
2. To move to another page of results, choose the numbered links, Next or Previous near the top or bottom of the page.
3. To specify how many results should be shown per page, choose a number 10, 20, 50 or 100 near the top of the page.

---

**On this page:**

- Accessing the user management screen
- Listing all users
- Using the simple user search
- Using the advanced user search
- Notes

**Related pages:**

- Adding and Inviting Users
- Giving People Access to Content
- Confluence Administrator's Guide

⚠ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

---

**Using the simple user search**

To search for a user via the simple user search:

1. If the Simple link is showing, choose it. (If you see the 'Advanced' link and no 'Simple' link, then the
simple search is already active.)

2. Type some information about the user into the ‘Find User’ text box. You can type all or part of their username, full name or email address.

3. Choose Search.

4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

Using the advanced user search

The advanced user search allows you to specify the field in which your search term appears: username, full name or email address. This is useful if you need to limit the number of users appearing in the search results.

To search via the advanced user search:

1. If the Advanced link is showing, choose it. (If you see the ‘Simple’ link and no ‘Advanced’ link, then the advanced search is already active.)

2. Complete one or more of the following fields:
   - **Username** — Enter all or part of the person's username. This is their login ID, such as 'joe', or 'bloggs'.
   - **Full Name** — Enter all or part of the person's name. For example, 'joe bloggs', or 'bloggs', or 'joe'.
   - **Email** — Enter all or part of the person's email address. For example, 'acme'.

3. Choose Search.

4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

Notes

- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence *internal directory* and also connect to an *LDAP* directory server. In such cases, you can define the *directory order* to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#).

- **Crowd and the user search**: If you are using Atlassian's *Crowd* for user management, you will need *Crowd* 1.5.1 or later to use the ‘Simple’ option in the user search. If your version of Crowd does not support the simple user search, you will see only the ‘Advanced’ search form.

Screenshot: The user management screen
**Editing User Details**

To update a user's details:

1. First, go to the user management screen for the user concerned. There are two ways to do this:
   - Either, go to the user's **Profile** and click the 'Administer User' link on the user's profile screen.
   - Or, choose **Browse > Confluence Admin**.
     - Select the link 'Manage Users' in the left-hand panel.
     - Locate the user by doing a search on the username or the groups to which they belong.
     - Click the user link.

2. Now you should be able to see the user's current details and links allowing you to edit them.
   - **View Profile** — View the user's profile.
   - **Edit Groups** — Add or remove this user from a group.
   - **Edit Details** — Change details such as the user's name, email address, contact details and team or department information.
     - Changing a user's username is not supported. See **Changing Usernames** for information.
   - **Set Password** — Edit the user’s password details.
   - **Remove** — You can remove a user permanently if the user has not added or edited any content on the site.
   - **Disable** — You can disable (i.e. deactivate) access for a user who has already added or edited any content on the site.

<table>
<thead>
<tr>
<th>User:</th>
<th>alui</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name:</td>
<td>Andrew Lui [Atlassian Technical Writer]</td>
</tr>
<tr>
<td>Email:</td>
<td><a href="mailto:alui@atlassian.com">alui@atlassian.com</a></td>
</tr>
<tr>
<td>Directory:</td>
<td>Confluence Internal Directory</td>
</tr>
<tr>
<td>Created:</td>
<td>Feb 24, 2011 18:47</td>
</tr>
<tr>
<td>Last Updated:</td>
<td>Feb 24, 2011 18:47</td>
</tr>
<tr>
<td>Login:</td>
<td>Last Login: Mar 13, 2011 22:34</td>
</tr>
<tr>
<td></td>
<td>Last Failed Login: Jan 26, 2011 19:25</td>
</tr>
<tr>
<td></td>
<td>Total Failed Login Count: 3</td>
</tr>
<tr>
<td></td>
<td>Current Failed Login Count: 0</td>
</tr>
<tr>
<td>Groups:</td>
<td>atlassian-developers</td>
</tr>
<tr>
<td></td>
<td>atlassian-staff</td>
</tr>
<tr>
<td></td>
<td>confluence-administrators</td>
</tr>
<tr>
<td></td>
<td>confluence-managers</td>
</tr>
<tr>
<td></td>
<td>confluence-users</td>
</tr>
<tr>
<td></td>
<td>documentation</td>
</tr>
<tr>
<td></td>
<td>licensed-contributors</td>
</tr>
</tbody>
</table>

*Screenshot above: User details*

⚠️ The information on this page *does not apply* to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

**Notes**

- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#).

## RELATED TOPICS

No content found for label(s) managing-users.

---

### Resetting the Login Count for a User

Confluence records the number of failed logins attempts made against each user account. When the login attempts exceed a preset number (see [Configuring Captcha for Failed Logins](#)), the user will prompted to authenticate using CAPTCHA until they successfully log in.

If you are a [Confluence Administrator](#), you can manually reset the failed login count for a user.

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

---

To reset the failed login count for a user,

1. Choose **Browse > Confluence Admin**.
2. Select 'Manage Users' in the left-hand panel. The 'Manage Users' screen appears, as shown below.
3. Search for the desired user and click the user in the search results. The 'View User' screen will be displayed.
4. Click the 'Reset Failed Login Count' for the user. The 'Current Failed Login Count' will be reset to 0.

---

Screenshot: Resetting failed login count for a user

---

### Changing Usernames

A **username** is the name used to log into Confluence, eg. `jsmith`.

Currently, there is no straightforward method for changing a username and its associated content, to that of another user. The only practicable method currently available is to execute direct SQL queries on your database. There is a [feature request to facilitate this process via a web interface](#) and you can vote for it to improve its chances of being implemented. Be aware, however, that no matter what method you use to change usernames in Confluence, there is no support provided for this process. The instructions below provide suggested guidelines on how to change a username via SQL queries, although this may vary depending on your database.
**Instructions For Changing Usernames**

- This document is for use with 3.5 or later. If using an earlier version, please see the [3.4 version](#) of the page.

  The following SQL commands are only tested for MySQL and PostgreSQL Databases. If you have any other database please contact your DBA to determine the equivalent queries.

Usernames can only be changed through direct update to the Confluence database.

1. If you have a database administrator, request that they approve the database-related steps described below.
2. If you are using JIRA user management, [Revert from JIRA To Internal User Management](#).
3. [Backup Confluence](#).
4. If you are using MySQL, make sure you are not running in safe updates mode:

   ```sql
   set sql_safe_updates=0;
   ```

5. Create a `usermigration` table:

   ```sql
   create table usermigration
   (
   oldusername varchar(255),
   newusername varchar(255)
   )
   ```

6. Usernames that will be changed must be placed in the `usermigration` table with their current and planned user names:

   ```sql
   insert into usermigration (oldusername, newusername)
   values ('oldusername', 'newusername');
   ```

7. Run the following SQL commands:
   - If you have command line access to your database, download the scripts for PostgreSQL or MySQL, then run them against your database:
     - **PostgreSQL**
       ```bash
       $ psql -f PostgreSQLChangeUsernames.sql your_database_name
       ```
     - **MySQL**
       ```bash
       $ mysql your_database_name < MySQLChangeUsernames.sql
       ```
b. Otherwise, run the following:
   i. If your DB administration tool does not support multiple SQL queries, these must be entered individually:

   **PostgreSQL**

   ```sql
   update attachments
   set creator = newusername from usermigration u
   where creator = u.oldusername;

   update attachments
   set lastmodifier = newusername from usermigration u
   where lastmodifier = u.oldusername;

   update content
   set creator = newusername from usermigration u
   where creator = u.oldusername;

   update content
   set lastmodifier = newusername from usermigration u
   where lastmodifier = u.oldusername;

   update content
   set username = newusername from usermigration u
   where username = u.oldusername;

   update content_label
   set owner = newusername from usermigration u
   where owner = u.oldusername;

   update content_perm
   set creator = newusername from usermigration u
   where creator = u.oldusername;

   update content_perm
   set lastmodifier = newusername from usermigration u
   where lastmodifier = u.oldusername;

   update content_perm
   set username = newusername from usermigration u
   where username = u.oldusername;

   update cwd_user
   set lower_user_name = lower(newusername) from usermigration u
   where lower_user_name = lower(u.oldusername);

   update cwd_user
   set user_name = newusername from usermigration u
   where user_name = u.oldusername;

   update extrlnks
   set creator = newusername from usermigration u
   where creator = u.oldusername;

   update extrlnks
   set lastmodifier = newusername from usermigration u
   where lastmodifier = u.oldusername;

   update follow_connections
   set followee = newusername from usermigration u
   where followee = u.oldusername;
   ```
update follow_connections
set follower = newusername from usermigration u
where follower = u.oldusername;

update label
set owner = newusername from usermigration u
where owner = u.oldusername;

update links
set creator = newusername from usermigration u
where creator = u.oldusername;

update links
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update notifications
set creator = newusername from usermigration u
where creator = u.oldusername;

update notifications
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update notifications
set username = newusername from usermigration u
where username = u.oldusername;

update pagetemplates
set creator = newusername from usermigration u
where creator = u.oldusername;

update pagetemplates
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update remembermetoken
set username = newusername from usermigration u
where username = u.oldusername;

update spacegroups
set creator = newusername from usermigration u
where creator = u.oldusername;

update spacegroups
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update spacepermissions
set creator = newusername from usermigration u
where creator = u.old.username;

update spacepermissions
set lastmodifier = newusername from usermigration u
where lastmodifier = u.old.username;

update spacepermissions
set permusername = newusername from usermigration u
where permusername = u.old.username;

update spaces
set creator = newusername from usermigration u
where creator = u.old.username;
update spaces
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update trackbacklinks
set creator = newusername from usermigration u
where creator = u.oldusername;
update trackbacklinks
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

MySQL

update ATTACHMENTS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update ATTACHMENTS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update CONTENT a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update CONTENT_LABEL a, usermigration u
set a.owner = u.newusername
where a.owner = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update CWD_USER a, usermigration u
set a.lower_user_name = LOWER(u.newusername)
where a.lower_user_name = LOWER(u.oldusername);

update CWD_USER a, usermigration u
set a.user_name = u.newusername
where a.user_name = u.oldusername;

update EXTRNLNKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update EXTRNLNKS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update FOLLOW_CONNECTIONS a, usermigration u
set a.followee = u.newusername
set a.followee = u.newusername
where a.followee = u.oldusername;

update FOLLOW_CONNECTIONS a, usermigration u
set a.follower = u.newusername
where a.follower = u.oldusername;

update LABEL a, usermigration u
set a.owner = u.newusername
where a.owner = u.oldusername;

update LINKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update LINKS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update PAGETEMPLATES a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update PAGETEMPLATES a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update REMEMBERMETOKEN a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update SPACEGROUPS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update SPACEGROUPS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.permusername = u.newusername
where a.permusername = u.oldusername;

update SPACES a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update SPACES a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update TRACKBACKLINKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;
ii. Reassign user preferences in the OS_PROPERTYENTRY table. Usernames in the OS_PROPERTYENTRY table need to be prefixed with 'CWD_'.

**PostgreSQL**

```
update os_propertyentry
set entity_name = 'CWD_' || newusername from usermigration u
where entity_name = 'CWD_' || u.oldusername;
```

**MySQL**

```
update OS_PROPERTYENTRY a, usermigration u
set a.entity_name = concat('CWD_', u.newusername)
where a.entity_name = concat('CWD_', u.oldusername);
```

iii. Reassign personal spaces and settings associated with the old username to the new username. The tilda (~) is required as it is prepended to the space key of all personal spaces:

**PostgreSQL**

```
update spaces
set spacekey = '~' || newusername from usermigration u
where spacekey = '~' || u.oldusername;

update bandana
set bandanacontext = '~' || newusername from usermigration u
where bandanacontext = '~' || u.oldusername;
```

**MySQL**

```
update SPACES a, usermigration u
set a.spacekey = concat('~', u.newusername)
where a.spacekey = concat('~', u.oldusername);

update BANDANA a, usermigration u
set a.bandanacontext = concat('~', u.newusername)
where a.bandanacontext = concat('~', u.oldusername);
```

8. Each username is associated with a full name. For example, username 'jsmith' may have a full name of 'John M Smith'. If this fullname needs to be changed, modify the first_name, lower_first_name, last_name and lower_last_name in the cwd_user table. Ensure the lower_columns are merely copies of their normal counterparts but with all letters in lower case. Then modify the display_name and lower_display_name columns so that they are the first_name and last_name columns or the lower_first_name and lower_last_name columns put together but separated by a space.
Rebuild the Indexes

After all the updates, it's necessary to Rebuild the Indexes from Scratch.

All old usernames in Confluence should now be replaced with the new usernames from the `usrmigration` table.

RELATED TOPICS

No content found for label(s) confluence-usermanagement.

Restoring Passwords To Recover Admin User Rights

Use this document if you are unable to log in to Confluence as administrator. The most common reason for using these instructions is if you have lost the administration password for your Confluence site.

Before you Start

Please note the following before you start:

- The following instructions include example SQL that should work on MySQL and PostgreSQL. You may need to customise the queries for other databases or for your installation.
- We strongly recommend testing the queries on a test database before modifying your production database.

New user management in Confluence 3.5 and later

- Confluence now uses the `CWD_USER` table in the database to store and refer to its users.
- When you imported your backup on upgrade from Confluence 3.4.9 or earlier, the upgrade process copied the users from the `OS_USER` table (for upgrades from versions older than 2.7) or the `USERS` table (for versions 2.7 to 3.4) into the `CWD_USER` table.
- The new user management framework also introduced user directories. Making modifications to users in the database will only fully work for users in Confluence's Internal Directory. The instructions below include extra steps for instances in which the user management has been delegated to external sources (via LDAP, Crowd or JIRA).

Please refer to the older documentation if you are still using `OSUser` or `AtlassianUser`.

Using Crowd for SSO

- If Confluence is configured for SSO through Crowd, you will only be able to authenticate as users from the Crowd server.
- This document covers how to recover administration rights from the local 'Confluence Internal Directory' only. However, you will not be able to authenticate as a local Confluence administrator while Crowd SSO is enabled. Please refer to Integrating Crowd with Atlassian Confluence for details on how to configure or disable Crowd SSO.

On this page:

- Before you Start
- Step 0. Get access to the database
- Step 1. Identify Administrator
- Step 2. Replace Administrator Password
- Step 3. Put the Internal Directory in First Position
- Step 4. Clean Up
- Notes
The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Step 0. Get access to the database

If you are using the embedded HSQL database, you can find the files containing your database in <confluence-home-directory>/database. When you shut down Confluence, the SQL will be written to a '.script' or '.log' file in that directory to which you can append the SQL described below.

If you are using a proper production database, connect to the database with your normal tools. You will need to have permission to run queries and update data in the database.

Step 1. Identify Administrator

To find out which usernames have admin privileges, connect to your database using a database admin tool such as DBVisualiser. Please download a database admin tool now if you do not have one installed already. Then connect to your database and retrieve the list of administrator usernames and IDs with:

```
select u.id, u.user_name from cwd_user u
join cwd_membership m on u.id=m.child_user_id join cwd_group g on
m.parent_id=g.id join cwd_directory d on d.id=g.directory_id
where g.group_name='confluence-administrators' and d.directory_name='Confluence Internal Directory';
```

If there are multiple results, choose one ID/username combination to use for the following steps. If there are no results, skip down to 'If No Local Users Exist' in Step 2.

Step 2. Replace Administrator Password

Confluence does not store passwords in plain text in the database, but uses hashes computed from the original password. You will need to insert a hash, rather than the plain password, over the existing password in the database. Below is the hash for the password admin:

```
x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A==
```

For an External Database

To change the password to admin for a given username:

1. Shut down Confluence.
2. Connect to your database.
3. Run the following SQL:

```
update cwd_user set credential =
'x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A=='
where id=<id from Stage 1>;
```

For the Evaluation Embedded HSQL Database

1. Shut down Confluence.
2. Connect to your database.
3. Run the following SQL:

```
update cwd_user set credential =
'x61Ey612Kl2gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A=='
where id=<id from Stage 1>;
```
To change the password to admin for a given username:

1. Shut down Confluence.
2. Open `<confluence-home>/database/confluencedb.script`, or `confluencedb.log` if the .script file looks empty.
3. Search for:

```
INSERT INTO CWD_USER VALUES(
```

4. Keep searching until you find the appropriate user, then replace their password with the hash value above.
5. Save the file.

If No Local Users Exist

There may be no administrators in your Internal Directory. If this is the case, you need to add one:

1. Add a new admin user by running:

```
insert into cwd_user(id, user_name, lower_user_name, active, created_date,
updated_date, first_name, lower_first_name, last_name, lower_last_name,
display_name, lower_display_name, email_address, lower_email_address,
directory_id, credential) values (1212121, 'admin', 'admin', 'T',
'Ministrator', 'ministrator', 'A. D. Ministrator', 'a. d. ministrator',
'admin@example.com', 'admin@example.com', (select id from cwd_directory
where directory_name='Confluence Internal Directory'),
'x61Ey612K12gpFL56FT9weDnps04AV8j8qX2AuThdRy036xxzTrw10Wq3+4g2yB+XURPWx1
ONxp3Y3pB37A==');
```

2. Add new groups by running:

```
insert into cwd_group(id, group_name, lower_group_name, active, local,
created_date, updated_date, description, group_type, directory_id)
values ( 
'888888','confluence-administrators','confluence-administrators','T','F','2
011-03-21 12:20:29','2011-03-21 12:20:29',NULL,'GROUP',(select id from
cwd_directory where directory_name='Confluence Internal Directory'));
insert into cwd_group(id, group_name, lower_group_name, active, local,
created_date, updated_date, description, group_type, directory_id)
values ( '999999','confluence-users','confluence-users','T','F','2011-03-21
12:20:29','2011-03-21 12:20:29',NULL,'GROUP',(select id from cwd_directory
where directory_name='Confluence Internal Directory'));
```

3. Add group memberships into cwd_membership:
```sql
insert into cwd_membership (id, parent_id, child_user_id) values (888888, (select id from cwd_group where group_name='confluence-users' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
insert into cwd_membership (id, parent_id, child_user_id) values (999999, (select id from cwd_group where group_name='confluence-administrators' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
```

⚠️ If using an Oracle database, use `sysdate` instead of a string for the `created_date` column.

**Step 3. Put the Internal Directory in First Position**

Start Confluence, and try logging in with the username of the user you updated/created and the password 'admin'. If this works, skip to Step 4. Otherwise, your Internal Directory does not have high enough priority.

**To put your Internal Directory in first position:**

1. Find the directory names and their order:
   ```sql
   select d.id, d.directory_name, m.list_index from cwd_directory d join cwd_app_dir_mapping m on d.id=m.directory_id;
   ```

2. Take note of the ID with list_index 0, and the list_index and ID of the Confluence Internal Directory.

3. Switch the order of the directories:
   ```sql
   update cwd_app_dir_mapping set list_index = 0 where directory_id = <Internal Directory id>
   update cwd_app_dir_mapping set list_index = <Noted Internal Directory list_index> where directory_id = <Directory id that had list_index 0>;
   ```

4. Check to see if the directory is active (the 'active' column should be set to 'T'):
   ```sql
   select id, directory_name, active from cwd_directory where id = <Internal Directory id>;
   ```

5. If necessary, activate the directory:
   ```sql
   update cwd_directory set active = 'T' where id = <Internal Directory id>;
   ```

**Step 4. Clean Up**

To tidy up:

1. Start Confluence.
2. Log in with your modified/created username and use password `admin`.
3. Change your password. **Do not leave your password as admin, or your instance will not be secure.**
4. If you created a new user in Stage 2, create a new admin via the UI and delete the admin you created in Stage 2.
5. If you followed Stage Three, go to Confluence Administration > User Directories and rearrange your directories so they are correctly configured again.

Notes
- Learn more about the [password hash algorithm Confluence is using](https://confluence.apache.org/display/CONFLUENCE/Managing+Security+and+Access+Control).

**Managing Site-Wide Permissions and Groups**

Permissions determine what people can do on your Confluence site. Confluence recognises permissions at site level and at space level, as well as page-level restrictions.

You can create groups and allocate people to them, so that you can assign permissions to a number of people at once. For example, it is quicker to give group 'X' access to Confluence, rather than giving every team member access individually. You can also set the access levels for anonymous users.

**Related pages:**
- [Confluence Security](https://confluence.apache.org/display/CONFLUENCE/Managing+Security+and+Access+Control)
- [Confluence Administrator's Guide](https://confluence.apache.org/display/CONFLUENCE/Managing+Security+and+Access+Control)

**Global Groups Overview**

A group is a collection of users. Administrators create groups so that the administrator can assign permissions to a number of people at once. For example, it is quicker to give group 'X' access to Confluence, rather than giving every team member access individually. You need **Confluence Administrator permissions** to view and update groups.

Groups are available at the space and page levels to allow for flexible access control. A user in a group will automatically be granted all permissions granted to the group.

**Special groups**

There are two special default groups in Confluence:

1. **confluence-administrators**: This is a group of ‘super-users’ who can access the Confluence administration screens (‘administration console’) and perform site-wide administration. Members of this group can also see all spaces in the Confluence site. Any user who is a member of this group has site-wide administration powers, regardless of any other setting. The settings on the global permissions screen do **not** affect the powers allowed to members of this group.
2. **confluence-users**: This is the default group for all new users. Permissions you assign to this group will be assigned to all newly signed-up users of Confluence.

**The Confluence Administrator permission and the ‘confluence-administrators’ group are not related.** Going by the names, you would think the ‘confluence-administrators’ group and the ‘Confluence Administrator’ permission are related – but they are not. Granting a user or a group ‘Confluence Administrator’ permission is not the same as granting them membership of the ‘confluence-administrators’ group. Granting the ‘Confluence Administrator’ permission enables access to only a subset of the administrative functions. Granting membership to the ‘confluence-administrators’ group gives complete access.
Anonymous users

Confluence treats all users who do not log in when they access Confluence as being ‘anonymous’. You can grant anonymous ‘Use Confluence’ permission via the Global Permissions screen. See Setting up Public Access. This will allow non-registered users to access pages and spaces in Confluence. A space administrator can further control anonymous access per space via the space permissions.

Updating groups

To add a new group:

1. Choose Browse > Confluence Admin.
2. Choose Manage Groups in the left-hand panel.
3. Choose Add Group.
4. Enter a name for your group and choose Save.

You are now ready to start adding users to the group.

To remove a group:

1. Choose Browse > Confluence Admin.
2. Choose Manage Groups in the left-hand panel. You will see a list of all existing groups along with links to remove them.
3. Choose Remove beside the group you want to remove.

Notes

- Multiple user directories: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:
  - The order of the directories is the order in which they will be searched for users and groups.
  - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

Adding or Removing Users in Groups

If you are a Confluence Administrator, you can add users and groups, and assign users to groups in order to
determine their permissions.

This page tells you how to add a user to a group or remove a user from a group. For an overview of users and groups, please refer to Users and Groups and Managing Confluence Users.

You can edit group membership in two places:

- From the group management screen.
- From the user management screen for a particular user.

Both methods are described below.

On this page:
- Adding and Removing Members via the Group Management Screen
- Editing Group Membership from the User Management Screen
- Notes

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Adding and Removing Members via the Group Management Screen

This is the recommended method, available in Confluence 2.10 and later. It allows you to manage the group membership for a number of users at the same time.

To add members to a group:

1. Choose Browse > Confluence Admin.
2. Select ‘Manage Groups’ in the left-hand panel.
3. The ‘Manage Groups’ screen appears, showing a list of groups. Select the group to which you want to add users.
4. The ‘Group Members’ screen appears, showing the users who belong to the selected group. (See screenshot below.) Click the ‘Add Members’ link.
5. The ‘Add Members’ screen appears, as shown below. Type in the usernames of the people you want to add to the group. You can also search for and select users by clicking the magnifying glass icon, as described in Searching for Users.
6. When you have added the required username(s), click the ‘Add’ button to add the member(s) to the group.

To remove members from a group:

1. Choose Browse > Confluence Admin.
2. Select ‘Manage Groups’ in the left-hand panel.
3. The ‘Manage Groups’ screen appears, showing a list of groups. Select the group from which you want to remove the user.
4. The ‘Group Members’ screen appears, showing the users who belong to the selected group. (See screenshot below.) Click the ‘Remove user from group’ icon next to the user whose group membership you want to remove.
1. Go to the user management screen for the user concerned. There are two ways to do this:
   - Either,
     - Go to the user's Profile and click the 'Administer User' link on the user's profile screen. (This link is available in Confluence 2.8.2 and later.)
     - Or, Choose Browse > Confluence Admin.
       - Select 'Manage Users' in the left-hand panel.
       - The 'Manage Users' screen appears, as shown below. You can now choose to 'Show all users' or you can search for a specific user by entering all or part of the person's username, full name or email address. (For more details about the user search, see Searching For and Administering Users.)
       - Click the link on the username you want to edit.
   2. Now you should be able to see the user's current details, with links allowing you to edit the user's details and groups. See the screenshot showing a user's details below.
   3. Click 'Edit Groups'. This will display two lists of groups, as shown in the screenshot below. Update the user's group membership as follows:
      - 'Not a member of groups' — This box shows all groups to which the user does not belong. To add the user to a group, select a group and click 'Join'. Hold the Ctrl key down and click to select more than one group.
      - 'Member of groups' — This box shows all groups to which the user belongs. Select a group and click 'Leave' to remove the user from the group.
Multiple user directories: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups. Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories.

RELATED TOPICS
Global Permissions Overview

Permissions determine the actions which a user is allowed to perform within Confluence. Global permissions are one of the levels of permission provided by Confluence.

In order to assign these permissions, you must already have the global 'Confluence Administrator' or 'System Administrator' permission (described below). You can then assign global permissions to groups, individual users and anonymous users. Further permissions are granted from the space administration screens.

The Confluence permission scheme allows the following levels of site administrator permissions, with the most powerful at the top of the list:

- **Super user** – A 'super user' belongs to the confluence-administrators group, has full administrative access to Confluence, and can see all the content.
- **System Administrator** – A person with 'System Administrator' permission has full administrative access to Confluence.
- **Confluence Administrator** – A person with 'Confluence Administrator' permission has access to most of the Confluence administrative functions.

**Note:** The first system administrator and super-user is defined during initial setup. During the initial configuration of Confluence, the Setup Wizard asks for the username of the System Administrator. This user will have the 'System Administrator' permission and will be a member of the 'confluence-administrators' group.

### On this page:

- Overview of the global permissions
- Comparing the System Administrator permission with the Confluence Administrator permission
- Comparing the confluence-administrators group with the administrator permissions
- Updating global permissions
- Error messages you may see

### Related pages:

- Searching For and Administering Users
- Global Groups Overview
- Confluence Administrator's Guide

---

⚠️ Some functionality described on this page is restricted in Confluence OnDemand.

**Overview of the global permissions**

Global permissions control access across the whole Confluence site. Here is a list:

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Use</td>
<td>This is the most basic permission that allows users to access the site. Users with this permission count towards the number of users allowed by your license. See the information on removing/deactivating users.</td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Attach Files to User Profile</td>
<td>This allows the user to upload files to be stored in their user profile. This feature was made obsolete by the introduction of personal spaces in Confluence 2.2. Hence, this permission is no longer relevant. Attachments can be accessed from a user profile view (for example, an image within the 'About Me' field of a profile view) by attaching these files to a page within that user's personal space and referencing them using appropriate wiki markup code.</td>
</tr>
<tr>
<td>Update User Status</td>
<td>This allows the user to update their user status, which can be seen on the user's profile, pages in their personal space and on various activity streams accessible to other Confluence users.</td>
</tr>
<tr>
<td>Personal Space</td>
<td>This permission allows the user to create a personal space.</td>
</tr>
<tr>
<td>Create Space(s)</td>
<td>This permission allows users to create new spaces within your Confluence site. When a space is created, the creator automatically has the 'Admin' permission for that space and can perform space-wide administrative functions.</td>
</tr>
<tr>
<td>Confluence Administrator</td>
<td>This permission allows users to access the 'Administration Console' that controls site-wide administrative functions. Users with this permission can perform most, but not all, of the Confluence administrative functions. See the comparison of 'System Administrator' and 'Confluence Administrator' below.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>This permission allows users to access the 'Administration Console' that controls site-wide administrative functions. Users with this permission can perform all the Confluence administrative functions, including the ones which the 'Confluence Administrator' permission does not allow. See the comparison of 'System Administrator' and 'Confluence Administrator' below. Refer also to the note about the 'confluence-administrators' group below.</td>
</tr>
</tbody>
</table>

**Comparing the System Administrator permission with the Confluence Administrator permission**

Confluence recognises two levels of administrator:

- **System Administrator** – Users with this permission can perform all the Confluence administrative functions, including the ones which the 'Confluence Administrator' permission does not allow.
- **Confluence Administrator** – Users with this permission can perform most, but not all, of the Confluence administrative functions.
The two-tier administration is useful when you want to delegate some administrator privileges to project managers or team leaders. You can give 'Confluence Administrator' permission to users who should be able to perform most administrative functions, but should not be able to perform functions that can compromise the security of the Confluence system.

The following functions are granted to the 'System Administrator' permission but excluded from the 'Confluence Administrator' permission:

<table>
<thead>
<tr>
<th>Administration Screen</th>
<th>Excluded from Confluence Administrator permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Server Base URL</td>
</tr>
<tr>
<td></td>
<td>• Remote API plugin</td>
</tr>
<tr>
<td></td>
<td>• Public Signup</td>
</tr>
<tr>
<td></td>
<td>• Connection Timeouts</td>
</tr>
<tr>
<td>Security Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• External user management</td>
</tr>
<tr>
<td></td>
<td>• Append wildcards to user and group searches</td>
</tr>
<tr>
<td></td>
<td>• Anti XSS Mode</td>
</tr>
<tr>
<td></td>
<td>• Enable Custom Stylesheets for Spaces</td>
</tr>
<tr>
<td></td>
<td>• Show system information on the 500 page</td>
</tr>
<tr>
<td></td>
<td>• Maximum RSS Items</td>
</tr>
<tr>
<td></td>
<td>• XSRF Protection</td>
</tr>
<tr>
<td>Plugins</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Upgrade</td>
</tr>
<tr>
<td></td>
<td>• Install</td>
</tr>
<tr>
<td></td>
<td>• Confluence Upgrade Check</td>
</tr>
<tr>
<td>Daily Backup Admin</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Mail Servers</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>User Macros</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Attachment Storage</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Layouts</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Custom HTML</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Backup &amp; Restore</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Logging and Profiling</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Cluster Configuration</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>This function is disallowed entirely.</td>
</tr>
</tbody>
</table>
Comparing the confluence-administrators group with the administrator permissions

The 'confluence-administrators' group defines a set of 'super-users' who can access the Confluence administration console and perform site-wide administration. Members of this group can also see the content of all pages and spaces in the Confluence instance, regardless of space permissions. They cannot immediately see the pages that exclude them via page restrictions without knowing the direct URL to the page. They can remove the page restrictions via the Space Administration screen if need be. For example, they will not see restricted pages displayed by the children macro. But they are able to access restricted pages directly using the page URL.

The settings on the 'Global Permissions' screen do not affect the powers allowed to members of the 'confluence-administrators' group.

Granting the 'System Administrator' or 'Confluence Administrator' permission to a user will not automatically grant the user access to all spaces in the site. These permissions will only give access to the administration console.

Be aware, however, that users with 'System Administrator' can add themselves to the 'confluence-administrators' group and become a super-user.

The Confluence Administrator permission and the 'confluence-administrators' group are not related. Going by the names, you would think the 'confluence-administrators' group and the 'Confluence Administrator' permission are related – but they are not. Granting a user or a group 'Confluence Administrator' permission is not the same as granting them membership of the 'confluence-administrators' group. Granting the 'Confluence Administrator' permission enables access to only a subset of the administrative functions. Granting membership to the 'confluence-administrators' group gives complete access.

Updating global permissions

To view the global permissions for a group or user:

1. Choose Browse > Confluence Admin.
2. Choose Global Permissions in the left-hand panel. The 'View Global Permissions' screen appears.

Add or edit group and user permissions as follows:

To add permissions for a group:

1. First add the group to Confluence, if you have not already done so.
2. Choose Edit Permissions. The 'Edit Global Permissions' screen appears.
3. Enter the group name in the Grant browse permission to box in the 'Groups' section. You can search for the group name.
4. Choose Add.
5. The group will appear in the list and you can now edit its permissions.

To add permissions for a specific user:
(Consider adding the user to a group and then assigning the permissions to the group, as described above, instead of assigning permissions to the specific user.)

1. First add the user to Confluence, if you have not already done so.
2. Choose Edit Permissions. The 'Edit Global Permissions' screen appears.
3. Enter the username in the Grant browse permission to box in the 'Individual Users' section. You can search for the username.
4. Choose Add.
5. The username will appear in the list and you can now edit its permissions.
To add or edit the permissions for a user or group:

1. Select, or clear, the check box under the relevant permission in the row for the relevant user/group. A selected check box indicates that the permission is granted.
2. To allow anonymous access to your Confluence site, select the 'Use Confluence' and 'View User Profile' options in the 'Anonymous Access' section. For more information about these permissions, refer to Setting up Public Access.
3. Choose Save All to save your changes.

Screenshot: Editing global permissions

<table>
<thead>
<tr>
<th>Groups</th>
<th>Attach Files to User Profile</th>
<th>Update User Profile</th>
<th>Personal Space</th>
<th>Create Space(s)</th>
<th>Confluence Administrator</th>
<th>System Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Individual Users</th>
<th>Attach Files to User Profile</th>
<th>Update User Profile</th>
<th>Personal Space</th>
<th>Create Space(s)</th>
<th>Confluence Administrator</th>
<th>System Administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>tetsXX (tetsxx)</td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trisha Hong (thong)</td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Grant browse permission to [Add]

Anonymous Access

When a user is using Confluence while not logged in, they are using it anonymously. For example, Enabling anonymous 'USE' permission, allows non-logged-in users to browse pages and spaces in Confluence.

<table>
<thead>
<tr>
<th>Anonymous</th>
<th>Use Confluence</th>
<th>View User Profiles</th>
<th>Save All</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>can use</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Error messages you may see

Confluence will let you know if there is a problem with some permissions. In rare situations, you may see the following error messages below a permission:

- 'User/Group not found' — This message may appear if your LDAP repository is unavailable, or if the user/group has been deleted after the permission was created.
- 'Case incorrect. Correct case is: xxxxxx' — This message may appear if the upper/lower case in the permission does not match the case of the username or group name. If you see a number of occurrences of this message, you should consider running the routine supplied to fix the problem.

Setting Up Public Access

You can enable anonymous access (also known as public access) to your Confluence site by granting the 'Use Confluence' permission to 'anonymous' users. An 'anonymous' user is someone who has not logged in to the Confluence site. The 'Use Confluence' permission is also called 'can use'.

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
This user category gives you an easy way to administer users who have not logged into the site. Permissions assigned to this category apply to all anonymous users of the site.

**Enabling anonymous access to the site**

If you want to make your site visible to everyone, including people who have not logged in, you must enable anonymous access at site level.

**To enable anonymous access to your site:**

1. Choose **Browse > Confluence Admin**.
2. Choose **Global Permissions** in the left-hand panel.
3. Choose **Edit Permissions**.
4. In the 'Anonymous Access' section, select the **can use** check box to enable anonymous access to the content on your site.
5. If you want to allow anonymous users to see **user profiles**, select the check box in the **View User Profiles** section.
   
   **Note:** You must grant the 'can use' permission as well, if you want to grant the 'View User Profiles' permission.
6. Choose **Save All**.

---

**Disabling anonymous access to the site**

To disable anonymous access to your site, deselect the **can use** check box, then choose **Save All**. People will not be able to see the content on the site until they have logged in.

**Granting public access to a space**

To enable public access to a Confluence space, you must grant the following permissions to anonymous users:

- The site-wide 'can use' permission, as described above.
- The relevant **space permissions**. If you want a space to be publicly accessible, the anonymous user must have at least the 'View Space' permission. To set space permissions, choose **Browse > Space Admin > Permissions**.

**Notes**

- **We severely warn against** giving anonymous users any administrative privileges, either within a space, or especially over the Confluence site. Giving administrative privileges to untrusted users may lead to a serious security compromise of your site.
- You can allow people to sign up for usernames themselves, and choose other options for user signup and
Configuring User Directories

A user directory is a place where you store information about users and groups. User information includes the person's full name, username, password, email address and other personal information. Group information includes the name of the group, the users that belong to the group, and possibly groups that belong to other groups.

The **internal** directory stores user and group information in the Confluence database. You can also connect to **external** user directories, and to Atlassian **Crowd** and **JIRA** as directory managers.

### On this page:
- Configuring User Directories in Confluence
- Connecting to a Directory
- Updating Directories

⚠️ The information on this page does not apply to Confluence OnDemand.

### Configuring User Directories in Confluence

To configure your Confluence user directories:

1. Choose **Browse > Confluence Admin**.
2. Click ‘**User Directories**’ in the left-hand panel.

### Connecting to a Directory

You can add the following types of directory servers and directory managers:

- Confluence's internal directory. See Configuring the Internal Directory.
- Various other LDAP directory servers. See Connecting to an LDAP Directory.
- An LDAP directory for delegated authentication. See Connecting to an Internal Directory with LDAP Authentication.
- Atlassian Crowd. See Connecting to Crowd or JIRA for User Management.
- Atlassian JIRA 4.3 or later. See Connecting Confluence to JIRA for User Management.
- Atlassian JIRA 4.2 or earlier, using the legacy database connection. See Connecting to JIRA 4.2 or Earlier for User Management.

You can add as many external user directories as you need. Note that you can define the **order** of the directories. This determines which directory Confluence will search first, when looking for user and group information. See Managing Multiple Directories.

### Updating Directories

#### Limitations when Editing Directories

You cannot edit, disable or remove the directory your user belongs to. This precaution is designed to prevent administrators from locking themselves out of the application by changing the directory configuration in a way that prevents them logging in or removes their administration permissions.

This limitation applies to all directory types. For example:

- You cannot disable the internal directory if your user is an internal user.
- You cannot disable or remove an LDAP or a Crowd directory if your user comes from that directory.
In some situations, reordering the directories will change the directory that the current user comes from, if a user with the same username happens to exist in both. This behaviour can be used in some cases to create a copy of the existing configuration, move it to the top, then remove the old one. Note, however, that duplicate usernames are not a supported configuration.

You cannot remove the internal directory. This precaution aligns with the recommendation below that you always keep an administrator account active in the internal directory.

**Recommendations**

The recommended way to edit directory configurations is to log in as an internal user when making changes to external directory configuration.

⚠️ We recommend that you keep either an administrator or system administrator user active in your internal directory for troubleshooting problems with your user directories.

**Enabling, Disabling and Removing Directories**

You can enable or disable a directory at any time. If you disable a directory, your configuration details will remain but the application will not recognise the users and groups in that directory.

You have to disable a directory before you can remove it. Removing a directory will remove the details from the database.

![Configuring user directories](image)

**Screenshot above: Configuring user directories**

**RELATED TOPICS**

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management
- Adding and Inviting Users
- Managing Site-Wide Permissions and Groups
Configuring the Internal Directory

The internal directory stores user and group information in the Confluence database.

Overview

The internal directory is enabled by default at installation. When you create the first administrator during the setup procedure, that administrator's username and other details are stored in the internal directory.

If needed, you can configure one or more additional user directories. This is useful if you want to grant access to users and groups that are stored in a corporate directory or other directory server.

On this page:

- Overview
- Diagram of Possible Configuration

⚠️ The information on this page does not apply to Confluence OnDemand.

Diagram of Possible Configuration

Diagram above: Confluence using its internal directory for user management.

RELATED TOPICS

- Configuring User Directories
  - Configuring the Internal Directory
  - Connecting to an LDAP Directory
  - Connecting to an Internal Directory with LDAP Authentication
  - Connecting to Crowd or JIRA for User Management
  - Connecting to JIRA 4.2 or Earlier for User Management
  - Managing Multiple Directories
Connecting to an LDAP Directory

You can connect your Confluence application to an LDAP directory for authentication, user and group management.

Overview

An LDAP directory is a collection of data about users and groups. LDAP (Lightweight Directory Access Protocol) is an Internet protocol that web applications can use to look up information about those users and groups from the LDAP server.

We provide built-in connectors for the most popular LDAP directory servers:

- Microsoft Active Directory
- Apache Directory Server (ApacheDS)
- Apple Open Directory
- Fedora Directory Server
- Novell eDirectory
- OpenDS
- OpenLDAP
- OpenLDAP Using Posix Schema
- Posix Schema for LDAP
- Sun Directory Server Enterprise Edition (DSEE)
- A generic LDAP directory server

When to use this option: Connecting to an LDAP directory server is useful if your users and groups are stored in a corporate directory. When configuring the directory, you can choose to make it read only, read only with local groups, or read/write. If you choose read/write, any changes made to user and group information in the application will also update the LDAP directory.

Connecting to an LDAP Directory in Confluence

To connect Confluence to an LDAP directory:

1. Choose Browse > Confluence Admin.
2. Click User Directories in the left-hand panel.
3. Add a directory and select one of these types:
   - Microsoft Active Directory – This option provides a quick way to select AD, because it is the most popular LDAP directory type.
   - LDAP – You will be able to choose a specific LDAP directory type on the next screen.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see Managing Multiple Directories.
On this page:

- Overview
- Connecting to an LDAP Directory in Confluence
- Server Settings
- Schema Settings
- Permission Settings
  - Adding Users to Groups Automatically
- Advanced Settings
- User Schema Settings
- Group Schema Settings
- Membership Schema Settings
- Diagrams of Some Possible Configurations
- Notes

Related pages:

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

⚠️ The information on this page does not apply to Confluence OnDemand.

## Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter a meaningful name to help you identify the LDAP directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Example Company Staff Directory</td>
</tr>
<tr>
<td></td>
<td>• Example Company Corporate LDAP</td>
</tr>
<tr>
<td><strong>Directory Type</strong></td>
<td>Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for many of the options on the rest of screen. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Active Directory</td>
</tr>
<tr>
<td></td>
<td>• OpenDS</td>
</tr>
<tr>
<td></td>
<td>• And more.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of your directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• ad.example.com</td>
</tr>
<tr>
<td></td>
<td>• ldap.example.com</td>
</tr>
<tr>
<td></td>
<td>• opens.example.com</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which your directory server is listening. Examples:</td>
</tr>
<tr>
<td></td>
<td>• 389</td>
</tr>
<tr>
<td></td>
<td>• 10389</td>
</tr>
<tr>
<td></td>
<td>• 636 (for example, for SSL)</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Tick this check box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.</td>
</tr>
<tr>
<td>Username</td>
<td>The distinguished name of the user that the application will use when connecting to the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn=administrator,cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>• cn=user,dc=domain,dc=name</td>
</tr>
<tr>
<td></td>
<td>• <a href="mailto:user@domain.name">user@domain.name</a></td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user specified above.</td>
</tr>
<tr>
<td>Schema Settings</td>
<td></td>
</tr>
<tr>
<td>Base DN</td>
<td>The root distinguished name (DN) to use when running queries against the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• o=example,c=com</td>
</tr>
<tr>
<td></td>
<td>• cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>• For Microsoft Active Directory, specify the base DN in the following format: dc=domain1,dc=local. You will need to replace the domain1 and local if your specific configuration. Microsoft Server provides a tool called ldp.exe which is useful for finding out and configuring the the LDAP structure of your server.</td>
</tr>
<tr>
<td>Additional User DN</td>
<td>This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>• ou=Users</td>
</tr>
</tbody>
</table>
### Additional Group DN

This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN.

Example:
- `ou=Groups`

### Permission Settings

**Note:** You can only assign LDAP users to local groups when 'External Management User Management' is not selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read Only, with Local Groups</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens. However, you can add groups to the internal directory and add LDAP users to those groups.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>LDAP users, groups and memberships are retrieved from your directory server. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to your LDAP directory server. Please ensure that the LDAP user specified for the application has modification permissions on your LDAP directory server.</td>
</tr>
</tbody>
</table>

### Adding Users to Groups Automatically

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
**Default Group Memberships**

*Option available in Confluence 3.5 and later, and JIRA 4.3.3 and later.* This field appears if you select the 'Read Only, with Local Groups' permission. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas.

*In Confluence 3.5 to Confluence 3.5.1:* Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally.

*In Confluence 3.5.2 and later, and JIRA 4.3.3 and later:* The first time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally. On subsequent logins, the username will not be added automatically to any groups. This change in behaviour allows users to be removed from automatically-added groups. In Confluence 3.5 and 3.5.1, they would be re-added upon next login.

Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.

**Examples:**
- confluence-users
- confluence-users,jira-users,jira-developers

### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Paged Results</td>
<td>Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.</td>
</tr>
<tr>
<td>Follow Referrals</td>
<td>Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup <code>java.naming.referral</code>) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a <code>javax.naming.PartialResultException: Unprocessed Continuation Reference(s)</code> error.</td>
</tr>
</tbody>
</table>
| Naive DN Matching               | If your directory server will always return a consistent string representation of a DN, you can enable naive DN matching. Using naive DN matching will result in a significant performance improvement, so we recommend enabling it where possible. This setting determines how your application will compare DNs to determine if they are equal.  
  
  - If this check box is ticked, the application will do a direct, case-insensitive, string comparison. This is the default and recommended setting for Active Directory, because Active Directory guarantees the format of DNs.  
  - If this check box is not ticked, the application will parse the DN and then check the parsed version. |
| Enable Incremental Synchronisation | Enable incremental synchronisation if you only want changes since the last synchronisation to be queried when synchronising a directory.  
  
  **WARNING**: Please be aware that when using this option, the user account configured for synchronisation must have read access to:  
  
  - The `uSNChanged` attribute of all users and groups in the directory that need to be synchronised.  
  - The objects and attributes in the Active Directory deleted objects container (see Microsoft's Knowledge Base Article No. 892806 for details).  
  
  If at least one of these conditions is not met, you may end up with users who are added to (or deleted from) the Active Directory not being respectively added (or deleted) in JIRA. |
### Synchronisation Interval (minutes)
Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes.

### Read Timeout (seconds)
The time, in seconds, to wait for a response to be received. If there is no response within the specified time period, the read attempt will be aborted. A value of 0 (zero) means there is no limit. The default value is 120 seconds.

### Search Timeout (seconds)
The time, in seconds, to wait for a response from a search operation. A value of 0 (zero) means there is no limit. The default value is 60 seconds.

### Connection Timeout (seconds)
This setting affects two actions. The default value is 0.
- The time to wait when getting a connection from the connection pool. A value of 0 (zero) means there is no limit, so wait indefinitely.
- The time, in seconds, to wait when opening new server connections. A value of 0 (zero) means that the TCP network timeout will be used, which may be several minutes.

### User Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Object Class</td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>• user</td>
</tr>
<tr>
<td>User Object Filter</td>
<td>The filter to use when searching user objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• (&amp;(objectCategory=Person)(sAMAccountName=*))</td>
</tr>
<tr>
<td>User Name Attribute</td>
<td>The attribute field to use when loading the username. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td></td>
<td>• sAMAccountName</td>
</tr>
<tr>
<td></td>
<td>NB: In Active Directory, the 'sAMAccountName' is the 'User Logon Name (pre-Windows 2000)' field. The User Logon Name field is referenced by 'cn'.</td>
</tr>
<tr>
<td>User Name RDN Attribute</td>
<td>The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td>User First Name Attribute</td>
<td>The attribute field to use when loading the user's first name. Example:</td>
</tr>
<tr>
<td></td>
<td>• givenName</td>
</tr>
<tr>
<td>User Last Name Attribute</td>
<td>The attribute field to use when loading the user's last name. Example:</td>
</tr>
<tr>
<td></td>
<td>• sn</td>
</tr>
<tr>
<td>User Display Name Attribute</td>
<td>The attribute field to use when loading the user's full name. Example:</td>
</tr>
<tr>
<td></td>
<td>• displayName</td>
</tr>
<tr>
<td>User Email Attribute</td>
<td>The attribute field to use when loading the user's email address. Example:</td>
</tr>
<tr>
<td></td>
<td>• mail</td>
</tr>
<tr>
<td>User Password Attribute</td>
<td>The attribute field to use when loading a user’s password. Example:</td>
</tr>
<tr>
<td></td>
<td>• unicodePwd</td>
</tr>
</tbody>
</table>

**Group Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Object Class</td>
<td>This is the name of the class used for the LDAP group object. Examples:</td>
</tr>
<tr>
<td></td>
<td>• groupOfUniqueNames</td>
</tr>
<tr>
<td></td>
<td>• group</td>
</tr>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• (objectCategory=Group)</td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group's name. Example:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td>Membership Schema Settings</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Group Members Attribute</strong></td>
<td>The attribute field to use when loading the group's members. Example:</td>
</tr>
<tr>
<td></td>
<td>• member</td>
</tr>
<tr>
<td><strong>User Membership Attribute</strong></td>
<td>The attribute field to use when loading the user's groups. Example:</td>
</tr>
<tr>
<td></td>
<td>• memberOf</td>
</tr>
<tr>
<td><strong>Use the User Membership Attribute, when finding the user's group membership</strong></td>
<td>Put a tick in the checkbox if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is ticked, your application will use the group membership attribute on the user when retrieving the list of groups to which a given user belongs. This will result in a more efficient retrieval.</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is not ticked, your application will use the members attribute on the group ('member' by default) for the search.</td>
</tr>
<tr>
<td></td>
<td>• If the 'Enable Nested Groups' checkbox is ticked, your application will ignore the 'Use the User Membership Attribute' option and will use the members attribute on the group for the search.</td>
</tr>
<tr>
<td><strong>Use the User Membership Attribute, when finding the members of a group</strong></td>
<td>Put a tick in the checkbox if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is ticked, your application will use the group membership attribute on the user when retrieving the members of a given group. This will result in a more efficient search.</td>
</tr>
<tr>
<td></td>
<td>• If this checkbox is not ticked, your application will use the members attribute on the group ('member' by default) for the search.</td>
</tr>
</tbody>
</table>

*Diagrams of Some Possible Configurations*
Diagram above: Confluence connecting to an LDAP directory.

Diagram above: Confluence connecting to an LDAP directory with permissions set to read only and local groups.

Notes
Currently there is a bug which causes a system error if the username and password are not correct. This also happens if you are accessing anonymously, but the directory server does not support anonymous access. If you get a system error message, try checking the username and password credentials. You can watch this issue to see updates on this bug: [CONF-25961 - Authenticate](#) to see issue details

**Configuring the LDAP Connection Pool**

When connection pooling is enabled, the LDAP directory server maintains a pool of connections and assigns them as needed. When a connection is closed, the directory server returns the connection to the pool for future use. This can improve performance significantly.

**To configure your LDAP connection pool:**

1. Choose *Browse > Confluence Admin*.
2. Click *User Directories* in the left-hand panel.
3. Click *LDAP Connection Pool Configuration* in the 'Additional Configuration' section.

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Pool Size</td>
<td>The number of LDAP connections created when initially connecting to the pool.</td>
<td>1</td>
</tr>
<tr>
<td>Preferred Pool Size</td>
<td>The optimal pool size. LDAP will remove idle connections when the number of connections grows larger than this value. A value of 0 (zero) means that there is no preferred size, so the number of idle connections is unlimited.</td>
<td>10</td>
</tr>
<tr>
<td>Maximum Pool Size</td>
<td>The maximum number of connections. When the number of connections reaches this value, LDAP will refuse further connections. As a result, requests made by an application to the LDAP directory server will be blocked. A value of 0 (zero) means that the number of connections is unlimited.</td>
<td>0</td>
</tr>
<tr>
<td>Pool Timeout (seconds)</td>
<td>The length of time, in seconds, that a connection may remain idle before being removed from the pool. When the application is finished with a pooled connection, the connection is marked as idle, waiting to be reused. A value of 0 (zero) means that the idle time is unlimited, so connections will never be timed out.</td>
<td>30</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>----</td>
</tr>
</tbody>
</table>
| Pool Protocol         | Only these protocol types will be allowed to connect to the LDAP directory server. If you want to allow multiple protocols, enter the values separated by a space. Valid values are: | plain ssl  
(Both plain and ssl) |
|                       | • plain  
• ssl |
| Pool Authentication   | Only these authentication types will be allowed to connect to the LDAP directory server. If you want to allow multiple authentication types, enter the values separated by a space. See [RFC 2829](https://tools.ietf.org/html/rfc2829) for details of LDAP authentication methods. Valid values are: | simple |
|                       | • none  
• simple  
• DIGEST-MD5 |

Notes:

- The connection pool settings are system wide and will be used to create a new connection pool for every configured LDAP directory server.
- You must restart your application server for these settings to take effect.

**RELATED TOPICS**

- [Connecting to an LDAP Directory](#)
- [Configuring User Directories](#)
- [Configuring an SSL Connection to Active Directory](#)

If you want to configure a read/write connection with Microsoft Active Directory, you will need to install an SSL certificate, generated by your Active Directory server, onto your Confluence server and then install the certificate into your JVM keystore.
On this page:

- Prerequisites
- Step 1. Install the Active Directory Certificate Services
- Step 2. Obtain the Server Certificate
- Step 3. Import the Server Certificate

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Updating user, group, and membership details in Active Directory requires that your Atlassian application be running in a JVM that trusts the AD server. To do this, we generate a certificate on the Active Directory server, then import it into Java’s keystore.

Prerequisites

To generate a certificate, you need the following components installed on the Windows Domain Controller to which you’re connecting.

<table>
<thead>
<tr>
<th>Required Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Services (IIS)</td>
<td>This is required before you can install Windows Certificate Services.</td>
</tr>
<tr>
<td>Windows Certificate Services</td>
<td>This installs a certification authority (CA) which is used to issue certificates. Step 1, below, explains this process.</td>
</tr>
</tbody>
</table>

Step 1. Install the Active Directory Certificate Services

If Certificate Services are already installed, skip to step 2, below. The screenshots below are from Server 2008, but the process is similar for Server 2000 and 2003.

1. Log in to your Active Directory server as an administrator.
2. Click **Start**, point to **Administrative Tools**, and then click **Server Manager**.
3. In the **Roles Summary** section, click **Add Roles**.

5. On the Select Role Services page, select the Certification Authority check box, and then click Next.
6. On the **Specify Setup Type** page, click **Enterprise**, and then click **Next**.

7. On the **Specify CA Type** page, click **Root CA**, and then click **Next**.
8. On the **Set Up Private Key** and **Configure Cryptography for CA** pages, you can configure optional configuration settings, including cryptographic service providers. However, the default values should be fine. Click **Next** twice.

9. In the **Common name for this CA** box, type the common name of the CA, and then click **Next**.
10. On the **Set Validity Period** page, accept the default values or specify other storage locations for the certificate database and the certificate database log, and then click **Next**.
11. After verifying the information on the Confirm Installation Selections page, click Install.
12. Review the information on the results screen to verify that the installation was successful.

---

Step 2. Obtain the Server Certificate
The steps above describe how to install the certification authority (CA) on your Microsoft Active Directory server. Next, you will need to add the Microsoft Active Directory server’s SSL certificate to the list of accepted certificates used by the JDK that runs your application server.

The Active Directory certificate is automatically generated and placed in root of the C:\ drive, matching a file format similar to the tree structure of your Active Directory server. For example: c:\ad2008.ad01.atlassian.com_ad01.crt.

You can also export the certificate by executing this command on the Active Directory server:

```
certutil -ca.cert client.crt
```

Step 3. Import the Server Certificate

For an application server to trust your directory's certificate, the certificate must be imported into your Java runtime environment. The JDK stores trusted certificates in a file called a keystore. The default keystore file is called cacerts and it lives in the jre\lib\security sub-directory of your Java installation.

In the following examples, we use server-certificate.crt to represent the certificate file exported by your directory server. You will need to alter the instructions below to match the name actually generated.

Windows

1. Navigate to the directory in which Java is installed. It's probably called something like C:\Program Files\Java\jdk1.5.0_12.
2. Run the command below, where server-certificate.crt is the name of the file from your directory server:

```
keytool -import -keystore .\jre\lib\security\cacerts -file server-certificate.crt
```

3. keytool will prompt you for a password. The default keystore password is changeit.
4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

```
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Valid from: Tue Aug 21 01:10:46 ACT 2007 until: Tue Aug 21 01:13:59
ACT 2012
Certificate fingerprints:
Trust this certificate? [no]: yes
Certificate was added to keystore
```

You may now use the 'Secure SSL' option when connecting your application to your directory server.

UNIX

1. Navigate to the directory in which Java is installed. cd $JAVA_HOME will usually get you there.
2. Run the command below, where `server-certificate.crt` is the name of the file from your directory server:

```
sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

```
Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Certificate fingerprints:
  SHA1:
Trust this certificate? [no]: yes
Certificate was added to keystore
```

You may now use the 'Secure SSL' option when connecting your application to your directory server.

**Mac OS X**

1. Navigate to the directory in which Java is installed. This is usually `/Library/Java/Home`.
2. Run the command below, where `server-certificate.crt` is the name of the file from your directory server:

```
sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.

4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:
Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Valid from: Tue Aug 21 01:10:46 ACT 2007 until: Tue Aug 21 01:13:59
ACT 2012
Certificate fingerprints:
   SHA1:
Trust this certificate? [no]:  yes
Certificate was added to keystore

You may now use the ‘Secure SSL’ option when connecting your application to your directory server.

RELATED TOPICS

Connecting to an LDAP Directory
Configuring User Directories

Connecting to an Internal Directory with LDAP Authentication
You can connect your Confluence application to an LDAP directory for delegated authentication. This means that Confluence will have an internal directory that uses LDAP for authentication only. There is an option to create users in the internal directory automatically when they attempt to log in, as described in the settings section.

Overview
An internal directory with LDAP authentication offers the features of an internal directory while allowing you to store and check users' passwords in LDAP only. Note that the 'internal directory with LDAP authentication' is separate from the default 'internal directory'. On LDAP, all that the application does is to check the password. The LDAP connection is read only. Every user in the internal directory with LDAP authentication must map to a user on LDAP, otherwise they cannot log in.

When to use this option: Choose this option if you want to set up a user and group configuration within your application that suits your needs, while checking your users' passwords against the corporate LDAP directory. This option also helps to avoid the performance issues that may result from downloading large numbers of groups from LDAP.
Connecting Confluence to an Internal Directory with LDAP Authentication

To connect to an internal directory but check logins via LDAP:

1. Choose Browse > Confluence Admin.
2. Click 'User Directories' in the left-hand panel.
3. Add a directory and select type 'Internal with LDAP Authentication'.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. If you want LDAP users to be used in place of existing internal users, move the 'Internal with LDAP Authentication' directory to the top of the list. You can define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

   For details see Managing Multiple Directories.
7. Add your users and groups in Confluence. See Adding and Inviting Users and Managing Site-Wide Permissions and Groups.

Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name that will help you to identify the directory. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Internal directory with LDAP Authentication</td>
</tr>
<tr>
<td></td>
<td>• Corporate LDAP for Authentication Only</td>
</tr>
</tbody>
</table>
| Directory Type | Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for some of the options on the rest of screen. Examples:  
| | • Microsoft Active Directory  
| | • OpenDS  
| | • And more.  
| Hostname | The host name of your directory server. Examples:  
| | • ad.example.com  
| | • ldap.example.com  
| | • opens.example.com  
| Port | The port on which your directory server is listening. Examples:  
| | • 389  
| | • 10389  
| | • 636 (for example, for SSL)  
| Use SSL | Select this check box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.  
| Username | The distinguished name of the user that the application will use when connecting to the directory server. Examples:  
| | • cn=administrator,cn=users,dc=ad,dc=example,dc=com  
| | • cn=user,dc=domain,dc=name  
| | • user@domain.name  
| Password | The password of the user specified above.  
| Copying Users on Login |  
| Setting | Description |
| **Copy User on Login** | This option affects what will happen when a user attempts to log in. If this check box is selected, the user will be created automatically in the internal directory that is using LDAP for authentication when the user first logs in and their details will be synchronised on each subsequent log in. If this check box is not selected, the user’s login will fail.

If you select this check box the following additional fields will appear on the screen, which are described in more detail below:

- Default Group Memberships
- Synchronise Group Memberships
- User Schema Settings (described in a separate section below) |

| **Default Group Memberships** | This field appears if you select the **Copy User on Login** check box. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas. Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added to the internal directory that is using LDAP for authentication.

Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.

Examples:

- confluence-users
- confluence-users,jira-users,jira-developers |

| **Synchronise Group Memberships** | This field appears if you select the **Copy User on Login** check box. If this check box is selected, group memberships specified on your LDAP server will be synchronised with Confluence each time the user logs in.

If you select this check box the following additional fields will appear on the screen, both described in more detail below:

- Group Schema Settings (described in a separate section below)
- Membership Schema Settings (described in a separate section below) |

**Schema Settings**
Setting | Description
--- | ---
**Base DN** | The root distinguished name (DN) to use when running queries against the directory server. Examples:
- `o=example,c=com`
- `cn=users,dc=ad,dc=example,dc=com`
- For Microsoft Active Directory, specify the base DN in the following format: `dc=domain1,dc=local`. You will need to replace the `domain1` and `local` for your specific configuration. Microsoft Server provides a tool called `ldp.exe` which is useful for finding out and configuring the the LDAP structure of your server.

**User Name Attribute** | The attribute field to use when loading the username. Examples:
- `cn`
- `sAMAccountName`

### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Paged Results</td>
<td>Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.</td>
</tr>
<tr>
<td>Follow Referrals</td>
<td>Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup <code>java.naming.referral</code>) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a <code>javax.naming.PartialResultException: Unprocessed Continuation Reference(s)</code> error.</td>
</tr>
</tbody>
</table>

### User Schema Settings

Note: this section is only visible when **Copy User on Login** is enabled.
### Additional User DN
This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN.

Example:
- `ou=Users`

### User Object Class
This is the name of the class used for the LDAP user object. Example:
- `user`

### User Object Filter
The filter to use when searching user objects.

Example:
- `(&(objectCategory=Person)(sAMAccountName=*))`

### User Name RDN Attribute
The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:
- `cn`

### User First Name Attribute
The attribute field to use when loading the user's first name. Example:
- `givenName`

### User Last Name Attribute
The attribute field to use when loading the user's last name. Example:
- `sn`

### User Display Name Attribute
The attribute field to use when loading the user's full name. Example:
- `displayName`

### User Email Attribute
The attribute field to use when loading the user's email address. Example:
- `mail`

### Group Schema Settings

Note: this section is only visible when both **Copy User on Login** and **Synchronise Group Memberships** are enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

*Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/).*
### Additional Group DN

This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:

- `ou=Groups`

### Group Object Class

This is the name of the class used for the LDAP group object. Examples:

- `groupOfUniqueNames`
- `group`

### Group Object Filter

The filter to use when searching group objects. Example:

- `(objectCategory=Group)`

### Group Name Attribute

The attribute field to use when loading the group's name. Example:

- `cn`

### Group Description Attribute

The attribute field to use when loading the group's description. Example:

- `description`

---

**Membership Schema Settings**

Note: this section is only visible when both **Copy User on Login** and **Synchronise Group Memberships** are enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members Attribute</td>
<td>The attribute field to use when loading the group's members. Example:</td>
</tr>
<tr>
<td></td>
<td>- <code>member</code></td>
</tr>
<tr>
<td>User Membership Attribute</td>
<td>The attribute field to use when loading the user's groups. Example:</td>
</tr>
<tr>
<td></td>
<td>- <code>memberOf</code></td>
</tr>
<tr>
<td>Use the User Membership Attribute, when finding the user's group membership</td>
<td>Select the check box if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)</td>
</tr>
<tr>
<td></td>
<td>- If this check box is selected, your application will use the group membership attribute on the user when <strong>retrieving the members of a given group</strong>. This will result in a more efficient retrieval.</td>
</tr>
<tr>
<td></td>
<td>- If this check box is not selected, your application will use the members attribute on the group ('member' by default) for the search.</td>
</tr>
</tbody>
</table>
Diagrams of Possible Configurations

**Diagram above:** Confluence connecting to an LDAP directory for authentication only.

**Diagram above:** Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.

**RELATED TOPICS**

[Configuring User Directories](#)
Configuring the Internal Directory
Connecting to an LDAP Directory
Connecting to an Internal Directory with LDAP Authentication
Connecting to Crowd or JIRA for User Management
Connecting to JIRA 4.2 or Earlier for User Management
Managing Multiple Directories
Managing Nested Groups
Synchronising Data from External Directories
Diagrams of Possible Configurations for User Management
User Management Limitations and Recommendations
Requesting Support for External User Management
Disabling the Built-In User Management

Connecting to Crowd or JIRA for User Management

You can connect your Confluence application to Atlassian Crowd or to JIRA (version 4.3 or later) for management of users and groups, and for authentication (verification of a user’s login).

On this page:
- Connecting Confluence to Crowd for User Management
- Connecting Confluence to JIRA for User Management
- Diagrams of Some Possible Configurations

![The information on this page does not apply to Confluence OnDemand.]

Connecting Confluence to Crowd for User Management

Atlassian Crowd is an application security framework that handles authentication and authorisation for your web-based applications. With Crowd you can integrate multiple web applications and user directories, with support for single sign-on (SSO) and centralised identity management. The Crowd Administration Console provides a web interface for managing directories, users and their permissions. See the Crowd Administration Guide.

When to use this option: Connect to Crowd if you want to use the full Crowd functionality to manage your directories, users and groups. You can connect your Crowd server to a number of directories of all types that Crowd supports, including custom directory connectors.

To connect Confluence to Crowd:

1. Go to your Crowd Administration Console and define the Confluence application to Crowd. See the Crowd documentation: Adding an Application.
2. Choose Browse > Confluence Admin.
3. Click ‘User Directories’ in the left-hand panel.
4. Add a directory and select type ‘Atlassian Crowd’. Enter the settings as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   - For details see Managing Multiple Directories.
7. If required, configure Confluence to use Crowd for single sign-on (SSO) too. See the Crowd documentation: Integrating Crowd with Atlassian Confluence.
### Crowd Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name          | A meaningful name that will help you to identify this Crowd server amongst your list of directory servers. Examples:  
  - Crowd Server
  - Example Company Crowd |
| Server URL    | The web address of your Crowd console server. Examples:  
  - http://www.example.com:8095/crowd/  
  - http://crowd.example.com |
| Application Name | The name of your application, as recognised by your Crowd server. Note that you will need to define the application in Crowd too, using the Crowd administration Console. See the Crowd documentation on [adding an application](http://crowd.example.com). |
| Application Password | The password which the application will use when it authenticates against the Crowd framework as a client. This must be the same as the password you have registered in Crowd for this application. See the Crowd documentation on [adding an application](http://crowd.example.com). |

#### Crowd Permissions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd and can only be modified via Crowd. You cannot modify Crowd users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to Crowd. Please ensure that the application has modification permissions for the relevant directories in Crowd. See the Crowd documentation: <a href="http://crowd.example.com">Specifying an Application’s Directory Permissions</a>.</td>
</tr>
</tbody>
</table>

#### Advanced Crowd Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
### Enable Nested Groups

Enable or disable support for nested groups. Before enabling nested groups, please check to see if the user directory or directories in Crowd support nested groups. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

### Synchronisation Interval (minutes)

Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where x is the number specified here. The default value is 60 minutes.

---

**Connecting Confluence to JIRA for User Management**

Note that the license tiers for JIRA and Confluence do not need to match to use this feature. For example, you can manage a Confluence 50 user license with JIRA, even if JIRA only has a 25 user license.

Subject to certain limitations, you can connect a number of Atlassian web applications to a single JIRA server for centralised user management.

**When to use this option:** You can only connect to a server running JIRA 4.3 or later. Choose this option as an alternative to Atlassian Crowd, for simple configurations with a limited number of users.

**If you are running JIRA 4.2 or earlier, please see [Connecting to JIRA 4.2 or Earlier for User Management](#).**

**To connect Confluence to JIRA 4.3 or later:**

1. Go to your JIRA administration screen and define the Confluence application to JIRA:
   - For JIRA 4.3.x, select 'Other Applications' from the 'Users, Groups & Roles' section of the 'Administration' menu.
   - For JIRA 4.4 or later, select 'Users' > 'JIRA User Server' in Administration mode.
   - Click 'Add Application'.
   - Enter the **application name** and **password** that Confluence will use when accessing JIRA.
   - Enter the **IP address** or addresses of your Confluence server. Valid values are:
     - A full IP address, e.g. 192.168.10.12.
     - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to [CIDR notation on Wikipedia](https://en.wikipedia.org/wiki/CIDR_notation) and [RFC 4632](https://tools.ietf.org/html/rfc4632).
   - **Save** the new application.
2. Set up the JIRA user directory in Confluence:
   - Choose **Browse > Confluence Admin**.
   - Click 'User Directories' in the left-hand panel.
   - **Add** a directory and select type 'Atlassian JIRA'.
   - Enter the settings as described below. When asked for the **application name** and **password**, enter the values that you defined for your Confluence application in the settings on JIRA.
   - **Save** the directory settings.
   - Define the **directory order** by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
     - The order of the directories is the order in which they will be searched for users and groups.
• Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see Managing Multiple Directories.

3. In order to use Confluence, users must be a member of the confluence-users group or have Confluence 'can use' permission. Follow these steps to configure your Confluence groups in JIRA:
   a. Add the confluence-users and confluence-administrators groups in JIRA.
   b. Add your own username as a member of both of the above groups.
   c. Choose one of the following methods to give your existing JIRA users access to Confluence:
      • Option 1: In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
      • Option 2: Log in to Confluence using your JIRA account and go to the Confluence Administration Console. Click ‘Global Permissions’ and assign the ‘can use’ permission to the relevant JIRA groups.

### JIRA Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>• JIRA Server</td>
</tr>
<tr>
<td></td>
<td>• My Company JIRA</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <a href="http://www.example.com:8080">http://www.example.com:8080</a></td>
</tr>
<tr>
<td></td>
<td>• <a href="http://jira.example.com">http://jira.example.com</a></td>
</tr>
<tr>
<td>Application Name</td>
<td>The name used by your application when accessing the JIRA server that acts as user manager. Note that you will also need to define your application to that JIRA server, via the 'Other Applications' option in the 'Users, Groups &amp; Roles' section of the 'Administration' menu.</td>
</tr>
<tr>
<td>Application Password</td>
<td>The password used by your application when accessing the JIRA server that acts as user manager.</td>
</tr>
</tbody>
</table>

### JIRA Permissions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. They can only be modified via that JIRA server.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. When you modify a user, group or membership, the changes will be applied directly to your application and to the JIRA server that is acting as user manager.</td>
</tr>
</tbody>
</table>
### Advanced JIRA Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if nested groups are enabled on the JIRA server that is acting as user manager. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Synchronisation Interval (minutes)</td>
<td>Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes.</td>
</tr>
</tbody>
</table>

*Diagrams of Some Possible Configurations*
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.
Diagram above: Confluence connecting to JIRA for user management.
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

**RELATED TOPICS**

- Configuring User Directories
  - Configuring the Internal Directory
Reverting from Crowd or JIRA to Internal User Management

If your Confluence site currently uses JIRA or Crowd for user management, you can revert to internal user management as described below. If your Confluence instance has only a few users, it is easier to recreate the users and groups in Confluence manually. If you have a large number of users and groups, it is more efficient to migrate the relevant users and groups into the Confluence Internal directory.

Both options provided below will reset the affected users’ passwords. When done, be sure to notify them to use the ‘Reset My Password’ link on the Confluence log in page before they attempt to log in.

On this page:
- Option 1 – Manually Recreate Users and Groups in Confluence
- Option 2 – Transfer Crowd/JIRA Users and Groups to the Confluence Database

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Option 1 – Manually Recreate Users and Groups in Confluence

Use this option if you have only a few users and groups.

1. Log in to Confluence as a Confluence system administrator.
2. Go to the user directories administration screen and move the internal directory to the top of the list of directories, by clicking the arrows in the 'Order' column.
3. Make sure that you have at least one user from the internal directory in each of the confluence-users and confluence-administrators groups.
4. Make sure that you have a username in the internal directory with Confluence system administrator permissions.
   - If you do not have such a user, add a new one now, and log out of Confluence.
   - Log back in as the user you just added, and go back to the user directories administration screen.
5. Disable the 'Atlassian Crowd' directory.
6. Manually add the required users and groups in Confluence. They will be added to the internal directory, because you have moved it to the top of the list of directories.
   - If you have assigned Confluence permissions to a group which exists in JIRA, you must create a group in Confluence with the same name.
   - If a user who exists in JIRA has created content or has had permissions assigned to them in Confluence, you must also create that user in Confluence.
7. Add the users to the required groups.

Option 2 – Transfer Crowd/JIRA Users and Groups to the Confluence Database
Use this option to migrate External Application (Crowd or JIRA) users into the Confluence database. You need a knowledge of SQL to perform this task.

The SQL commands given below are tailored for MySQL. If you are using a database other than MySQL, you will need to modify the SQL to work in your database.

**Step 1. Create Backups**

Creating backups is the only way to restore your data if something goes wrong.

1. From Confluence, create a full XML site backup including attachments.
2. Stop Confluence.
3. Make a backup copy of the Confluence home and installation directories.
4. Repeat the above steps for your External Application.
5. From your MySQL administration tool, create a database backup for the Crowd/JIRA and Confluence databases.

**Step 2. Replace Confluence User Management**

Use the SQL below to move groups and users from your External Application to Confluence by transferring table content. The SQL provided is specific to MySQL and must be modified for other databases.

**Find the IDs for your Directories**

1. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as <Confluence Internal ID>.

```
select id from cwd_directory where directory_name='Confluence Internal Directory';
```

2. From the User Directories administration page, find the name of the directory who's users/groups you want to move. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as <External Application ID>.

```
select id from cwd_directory where directory_name='<External Directory Name>';
```

**Move Groups to Confluence**

1. It is possible that you have several groups in your Internal Directory that have the same name as groups in your External Application. To find these, run:

```
select distinct a.id, a.directory_id, a.group_name, d.directory_name from cwd_group a join cwd_group b on a.group_name=b.group_name join cwd_directory d on d.id=a.directory_id where a.directory_id != b.directory_id;
```

   a. If you have results from the previous query, for each of the group names that have duplicates, find the id for the group in the Confluence Internal Directory (<internal group id>) and the External Application (<external group id>). Run the following:
update cwd_group_attribute set group_id=<internal group id>,
directory_id=<Confluence Internal Id> where group_id=<external group id>
update cwd_membership set child_group_id=<internal group id> where
child_group_id=<external group id>
update cwd_membership set parent_id=<internal group id> where
parent_id=<external group id>
delete from cwd_group where id=<external group id>

2. Move all the groups in the External Application to the Confluence Internal Directory.

update cwd_group set directory_id=<Confluence Internal ID> where
directory_id=<External Application ID>

Move Users to Confluence

1. It is possible that you have several users in your Internal Directory that have the same name as users in your External Application. To find these, run:

select distinct a.id, a.directory_id, a.user_name, d.directory_name from
cwd_user a join cwd_user b on a.user_name=b.user_name join cwd_directory d
on d.id=a.directory_id where a.directory_id != b.directory_id;

a. If you have results from the previous query, for each of the user names that have duplicates, find the id for the user in the Confluence Internal Directory (<internal user id>) and the External Application (<external user id>). Run the following:

update cwd_membership set child_user_id=<internal user id> where
child_user_id=<external user id>
update cwd_user_credential_record set user_id=<internal user id>
where user_id=<external user id>
update cwd_user_attribute set user_id=<internal user id>,
directory_id=<Confluence Internal ID> where user_id=<external user id>
delete from cwd_user where id=<external user id>


update cwd_user set directory_id=<Confluence Internal ID> where
directory_id=<External Application ID>

Delete the External Application directory

1. You need to change the order of your directories so that the Internal directory is at the top, and active.

a. If you have only two directories - the Internal and the External Application directory you are deleting, then do the following:
b. If you have more than two directories, you need to rearrange them so the Internal Directory is at the top (list_index 0) and the External Application directory you are deleting is at the bottom.
   • List the directories and their order using

   ```
   select d.id, d.directory_name, m.list_index from cwd_directory d 
   join cwd_app_dir_mapping m on d.id=m.directory_id order by 
   m.list_index;
   ```

   • Change the list indexes so that they are in the order you want. Directory order can be rearranged using

   ```
   update cwd_app_dir_mapping set list_index = <position> where 
   directory_id = <directory id>;
   ```

c. Check that the internal directory is enabled.
   • List the internal directory. An enabled directory will have its ‘active’ column set to ‘T’

   ```
   select id, directory_name, active from cwd_directory where id = 
   <Internal Directory id>;
   ```

   • If the internal directory is not active, activate it by

   ```
   update cwd_directory set active = 'T' where id = <Internal 
   Directory id>;
   ```

2. When the directories are ordered correctly, delete the External Application directory from the directory order:

   ```
   delete from cwd_app_dir_operation where app_dir_mapping_id = (select id 
   from cwd_app_dir_mapping where directory_id = <External Application ID>); 
   delete from cwd_app_dir_mapping where directory_id = <External Application ID>;
   ```

3. The External Application directory is referenced in several other tables in the database. You need to remove the remaining references to it:
delete from cwd_directory_attribute where directory_id=<External Application ID>
delete from cwd_directory_operation where directory_id=<External Application ID>

4. All references to the External Directory should now have been removed. Delete the directory using:

delete from cwd_directory where id = <External Application ID>

Reset passwords

1. All users who were in the External Directory you deleted, including admins, will be unable to log in. Their passwords need to be reset by choosing the "Forgot your password?" link on the login page. Alternatively, use the instructions at Restoring Passwords To Recover Admin User Rights to reset the administrator password, then set the users' passwords for them via the Manage Users page in the administration screen.

RELATED TOPICS

Configuring User Directories

Connecting to JIRA 4.2 or Earlier for User Management

Atlassian JIRA is an issue and project tracking tool. Like Confluence, JIRA offers the ability to store its users and groups in its database. You can configure Confluence to look for its users and groups in the JIRA database. This page describes the legacy JIRA database connector, which provides a direct connection to the JIRA database.

When to use this option: Choose the legacy JIRA database connector if your JIRA server is JIRA 4.2 or earlier, for backwards compatibility with the already-existing option for Confluence to use JIRA for user management.

If you are using JIRA 4.3 or later, you cannot use the legacy JIRA database connector. Instead, choose the 'Atlassian JIRA' directory type.

On this page:
- Connecting Confluence to JIRA
- JIRA Settings in Confluence

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Connecting Confluence to JIRA

To connect Confluence to JIRA 4.2 or earlier:

1. Edit the Confluence server.xml file, to construct the datasource location, as described below.
2. Restart Confluence.
3. Choose Browse > Confluence Admin.
4. Click User Directories in the left-hand panel.
5. Add a directory and select type Legacy Atlassian JIRA (4.2 and earlier). Enter the settings as described below.
6. Save the directory settings.
7. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   For details see Managing Multiple Directories.
8. In order to use Confluence, users must be a member of the confluence-users group or have Confluence 'can use' permission. Follow these steps to configure your Confluence groups in JIRA:
   a. Add the confluence-users and confluence-administrators groups in JIRA.
   b. Add your own username as a member of both of the above groups.
   c. Choose one of the following methods to give your existing JIRA users access to Confluence:
      - Option 1: In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
      - Option 2: Log in to Confluence using your JIRA account and go to the Confluence Administra
      ration Console. Click 'Global Permissions' and assign the 'can use' permission to the relevant JIRA groups.

### JIRA Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>• JIRA</td>
</tr>
<tr>
<td></td>
<td>• Example Company JIRA</td>
</tr>
</tbody>
</table>
### Datasource Location

The JNDI name of the JIRA datasource configured in your application server. Example: `java:comp/env/jdbc/YourJiraDatasource`

In JIRA standalone distributions (using the default application server, Tomcat 6) you can construct the datasource location as follows:

1. Open your `<jira_install>/conf/server.xml` file in a text editor.
2. Look for the database setup section in that file. It looks something like this:

```xml
<Resource auth="Container"
    driverClassName="com.mysql.jdbc.Driver"
    maxActive="20"
    name="*jdbc/JiraDS*"
    password="jirauser"
    type="javax.sql.DataSource"
    url="jdbc:mysql://localhost/jiradb?useUnicode=true&characterEncoding=UTF8"
    username="jirauser"
    validationQuery="select 1"/>
```

3. Copy the above lines (the 'Resource' section) and paste it to your Confluence's `server.xml` file (located at `<confluence_install>/conf/server.xml`), under the Context path. This will then expose the value of the name attribute as the JNDI resource locator.
4. Copy the JNDI name from the `name` parameter. In this example, the datasource location is: `java:comp/env/jdbc/JiraDS`

---

### RELATED TOPICS

- Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management
Managing Multiple Directories

This page describes what happens when you have defined more than one user directory in Confluence. For example, you may have an internal directory and you may also connect to an LDAP directory server and/or other types of user directories. When you connect to a new directory server, you also need to define the directory order.

Duplicate usernames across directories are not supported. If you are connecting to more than one user directory, please ensure that the usernames are unique to one directory. For example, if you have a user `j smith` in both 'Directory1' and 'Directory2', that is an unsupported configuration.

Overview

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

On this page:

- Overview
- Configuring the Directory Order
- Effect of Directory Order
  - Login
  - Permissions
  - Updating Users and groups

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Configuring the Directory Order

You can change the order of your directories as defined to Confluence. Select 'User Directories' from the Confluence Administration Console and click the blue up- and down-arrows next to each directory.

Notes:

- Please read the rest of this page to understand what effect the directory order will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.

Effect of Directory Order

This section summarises the effect the order of the directories will have on login and permissions, and on the updating of users and groups.

Login

The directory order is significant during the authentication of the user, in cases where the same user exists in multiple directories. When a user attempts to log in, the application will search the directories in the order specified, and will use the credentials (password) of the first occurrence of the user to validate the login attempt.

Permissions
The directory order is significant when granting the user permissions based on group membership. If the same username exists in more than one directory, the application will look for group membership only in the first directory where the username appears, based on the directory order.

Example:

- You have connected two directories: The Customers directory and the Partners directory.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- The user jsmith is a member of group G1 in the Customers directory and group G2 in the Partners directory.
- The user jsmith will have permissions based on membership of G1 only, not G2.

Updating Users and groups

If you update a user or group via the application's administration screens, the update will be made in the first directory where the application has write permissions.

Example 1:

- You have connected two directories: The Customers directory and the Partners directory.
- The application has permission to update both directories.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- You update the email address of user jsmith via the application's administration screens.
- The email address will be updated in the Customers directory only, not the Partners directory.

Example 2:

- You have connected two directories: A read/write LDAP directory and the internal directory.
- The LDAP directory is first in the directory order.
- All new users will be added to the LDAP directory. It is not possible to add a new user to the internal directory.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

Managing Nested Groups

Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called ‘nested groups’. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.

This page describes how Confluence handles nested groups that exist in one or more of your directory servers.
Enabling Nested Groups

You can enable or disable support for nested groups on each directory individually. Go to the 'User Directories' section of the Confluence Administration Console, edit the directory and select 'Enable Nested Groups'. See Configuring User Directories.

Notes:

- Before enabling nested groups for a specific directory type in Confluence, please make sure that your directory server supports nested groups.
- Please read the rest of this page to understand what effect nested groups will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.

On this page:
- Enabling Nested Groups
- Effect of Nested Groups
  - Login
  - Permissions
  - Viewing Lists of Group Members
  - Adding and Updating Group Memberships
- Examples
  - Example 1: User is Member of Sub-Group
  - Example 2: Sub-Groups as Members of the 'jira-developers' group
  - Example 3: Sub-Groups as Members of the 'confluence-users' group
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Effect of Nested Groups

This section summarises the effect nested groups will have on login and permissions, and on the viewing and updating of users and groups.

Login

When a user logs in, they will be allowed access to the application if they belong to an authorised group or any of its sub-groups.

Permissions

The user will be allowed access to a function if they belong to a group that has the necessary permissions, or if they belong to any of its sub-groups.

Viewing Lists of Group Members

If you ask to view the members of a group, you will see all users who are members of the group and all users belonging its sub-groups, consolidated into one list. We call this a 'flattened' list.

You cannot view or edit the nested groups themselves. You will not be able to see that one group is a member of another group.

Adding and Updating Group Memberships

If you add a user to a group, the user is added to the named group and not to any other groups.
If you try to remove a user from a flattened list, the following will happen:

- If the user is a member of the top group in the hierarchy (tree) of groups contained in the flattened list, the user will be removed from the group.
- Otherwise, you will see an error message stating that the user is not a direct member of the group.

**Examples**

**Example 1: User is Member of Sub-Group**

Let's assume that the following two groups exist in your directory server:

- staff
- marketing

Memberships:

- The *marketing* group is a member of the *staff* group.
- User *jsmith* is a member of *marketing*.

You will see that *jsmith* is a member of both *marketing* and *staff*. You will not see that the two groups are nested. If you assign permissions to the *staff* group, then *jsmith* will get those permissions.

**Example 2: Sub-Groups as Members of the 'jira-developers' group**

In an LDAP directory server, we have groups *'engineering-group'* and *'techwriters-group'* We want to grant both groups developer-level access to our JIRA site.

- Add a group called *'jira-developers'*.
- Add the *'engineering-group'* as a sub-group of *'jira-developers'*. 
- Add the *'techwriters-group'* as a sub-group of *'jira-developers'*. 

Group memberships are now:

- *jira-developers* — sub-groups: *engineering-group*, *techwriters-group*
- *engineering-group* — sub-groups: *dev-a*, *dev-b*; users: *pblack*
- *dev-a* — users: *jsmith*, *sbrown*
- *dev-b* — users: *jsmith*, *dblue*
- *techwriters-group* — users: *rgreen*

When JIRA requests a list of users in the *'jira-developers'* group, it will receive the following list:

- *pblack*
- *jsmith*
- *sbrown*
- *dblue*
- *rgreen*

*Diagram: Sub-groups as members of the 'jira-developers' group*
Example 3: Sub-Groups as Members of the ‘confluence-users’ group

In an LDAP directory server, we have groups ‘engineering-group’ and ‘payroll-group’. We want to grant both groups access to our Confluence site.

- Add a group called ‘confluence-users’.
- Add the ‘engineering-group’ as a sub-group of ‘confluence-users’.
- Add the ‘payroll-group’ as a sub-group of ‘confluence-users’.

Group memberships are now:

- confluence-users — sub-groups: engineering-group, payroll-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- payroll-group — users: rgreen

When Confluence requests a list of users in the ‘confluence-users’ group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

Diagram: Sub-groups as members of the 'confluence-users' group
**Notes**

- **Possible impact on performance.** Enabling nested groups may result in slower user searches.

- **Definition of nested groups in LDAP.** In an LDAP directory, a nested group is defined as a child group entry whose DN (Distinguished Name) is referenced by an attribute contained within a parent group entry. For example, a parent group 'Group One' might have an `objectClass=group` attribute and one or more `member=DN` attributes, where the DN can be that of a user or that of a group elsewhere in the LDAP tree:

  ```
  member=CN=John Smith,OU=Users,OU=OrgUnitA,DC=sub,DC=domain
  member=CN=Group Two,OU=OrgUnitBGroups,OU=OrgUnitB,DC=sub,DC=domain
  ```

**RELATED TOPICS**

- Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
Synchronising Data from External Directories

For certain directory types, Confluence stores a cache of directory information (users and groups) in the application database, to ensure fast recurrent access to user and group data. A synchronisation task runs periodically to update the internal cache with changes from the external directory.

On this page:
- Affected Directory Types
- How it Works
- Finding the Time Taken to Synchronise
- Manually Synchronising the Cache
- Configuring the Synchronisation Interval

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Affected Directory Types

Data caching and synchronisation apply to the following user directory types:
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read only, with local groups.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to read/write.
- Atlassian Crowd.
- Atlassian JIRA.

Data caching and synchronisation do not occur for the following user directory types:
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to authentication only, with local groups.
- Internal Directory with LDAP Authentication.
- Internal Directory.

How it Works

Here is a summary of the caching functionality:
- The caches are held in the application database.
- When you connect a new external user directory to the application, a synchronisation task will start running in the background to copy all the required users, groups and membership information from the external directory to the application database. This task may take a while to complete, depending on the size and complexity of your user base.
- Note that a user will not be able to log in until the synchronisation task has copied that user’s details into the cache.
- A periodic synchronisation task will run to update the database with any changes made to the external directory. The default synchronisation interval, or polling interval, is one hour (60 minutes). You can change the synchronisation interval on the directory configuration screen.
You can manually synchronise the cache if necessary.
If the external directory permissions are set to read/write: Whenever an update is made to the users, groups or membership information via the application, the update will also be applied to the cache and the external directory immediately.
All authentication happens via calls to the external directory. When caching information from an external directory, the application database does not store user passwords.
All other queries run against the internal cache.

Finding the Time Taken to Synchronise

The ‘User Directories’ screen shows information about the last synchronisation operation, including the length of time it took.

Manually Synchronising the Cache

You can manually synchronise the cache by clicking ‘Synchronise’ on the ‘User Directories’ screen. If a synchronisation operation is already in progress, you cannot start another until the first has finished.

Configuring the Synchronisation Interval

Note: The option to configure the synchronisation interval for Crowd and JIRA directories is available in Confluence 3.5.3 and later. Earlier versions of Confluence allow you to configure the interval for LDAP directories only.

You can set the ‘Synchronisation Interval’ on the directory configuration screen. The synchronisation interval is the period of time to wait between requests for updates from the directory server.

The length you choose for your synchronisation interval depends on:

- The length of time you can tolerate stale data.
- The amount of load you want to put on the application and the directory server.
- The size of your user base.

If you synchronise more frequently, then your data will be more up to date. The downside of synchronising more frequently is that you may overload your server with requests.

If you are not sure what to do, we recommend that you start with an interval of 60 minutes (this is the default setting) and reduce the value incrementally. You will need to experiment with your setup.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
Diagrams of Possible Configurations for User Management
The aim of these diagrams is to help people understand each directory type at a glance. We have kept the diagrams simple and conceptual, with just enough information to be correct.

Some things that we do not attempt to show:

- In most cases, we do not attempt to show that you can have multiple directory types mapped to Confluence at the same time. We illustrate that fact in just the first two LDAP diagrams.
- We have not included a diagram for Confluence’s legacy connection to JIRA database.
- We do not attempt to show all of the possible configurations and layered connections that are available now that you can use JIRA as a directory manager.

On this page:

- Confluence Internal Directory
- Confluence with Read/Write Connection to LDAP
- Confluence with Read-Only Connection to LDAP, with Local Groups
- Confluence Internal Directory with LDAP Authentication
- Confluence with LDAP Authentication, Copy Users on First Login
- Confluence Connecting to JIRA
- Confluence Connecting to JIRA and JIRA Connecting to LDAP
- Confluence and JIRA Connecting to Crowd

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Confluence Internal Directory
Diagram above: Confluence using its internal directory for user management.

Confluence with Read/Write Connection to LDAP

![Diagram showing Confluence connecting to an LDAP directory.](image)

Diagram above: Confluence connecting to an LDAP directory.

Confluence with Read-Only Connection to LDAP, with Local Groups
**Confluence with LDAP Authentication, Copy Users on First Login**

Diagram above: Confluence connecting to an LDAP directory for authentication only.

---

**Confluence Internal Directory with LDAP Authentication**

Diagram above: Confluence connecting to an LDAP directory with permissions set to read only and local groups.

---
Diagram above: Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.

Confluence Connecting to JIRA
Diagram above: Confluence connecting to JIRA for user management.

Confluence Connecting to JIRA and JIRA Connecting to LDAP
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

**Confluence and JIRA Connecting to Crowd**
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.

RELATED TOPICS

- Configuring User Directories
  - Configuring the Internal Directory
  - Connecting to an LDAP Directory
  - Connecting to an Internal Directory with LDAP Authentication
  - Connecting to Crowd or JIRA for User Management
  - Connecting to JIRA 4.2 or Earlier for User Management
  - Managing Multiple Directories
  - Managing Nested Groups
  - Synchronising Data from External Directories
  - Diagrams of Possible Configurations for User Management
  - User Management Limitations and Recommendations
  - Requesting Support for External User Management
  - Disabling the Built-In User Management

User Management Limitations and Recommendations
This page describes the optimal configurations and limitations that apply to user management in Confluence.

On this page:

- General Recommendations
- Recommendations for Connecting to LDAP
  - Optimal Number of Users and Groups in your LDAP Directory
  - Redundant LDAP is Not Supported
  - Specific Notes for Connecting to Active Directory
- Recommendations for Connecting to JIRA for User Management
  - Single Sign-On Across Multiple Applications is Not Supported
  - Custom Application Connectors are Not Supported
  - Custom Directories are Not Supported
  - Optimal Number of Users and Applications
  - Recommendations

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

**General Recommendations**

- **Duplicate usernames across directories are not supported.** If you are connecting to more than one user directory, please ensure that the usernames are unique to one directory. For example, if you have a user jsmith in both 'Directory1' and 'Directory2', that is an unsupported configuration.

- **Be careful when deleting users in remote directories.** If you are connecting to an LDAP directory, a Crowd directory or a JIRA directory, please take care when deleting users from the remote directory. If you delete a user that is associated with data in Confluence, this will cause problems in Confluence.

**Recommendations for Connecting to LDAP**

Please consider the following limitations and recommendations when connecting to an LDAP user directory.

**Optimal Number of Users and Groups in your LDAP Directory**

The connection to your LDAP directory provides powerful and flexible support for connecting to, configuring and managing LDAP directory servers. To achieve optimal performance, a background synchronisation task loads the required users and groups from the LDAP server into the application's database, and periodically fetches updates from the LDAP server to keep the data in step. The amount of time needed to copy the users and groups rises with the number of users, groups, and group memberships. For that reason, we recommended a maximum number of users and groups as described below.

This recommendation affects connections to LDAP directories:

- Microsoft Active Directory
- All other LDAP directory servers

The following LDAP configurations are not affected:

- Internal directories with LDAP authentication
- LDAP directories configured for 'Authentication Only, Copy User On First Login'

Please choose one of the following solutions, depending on the number of users, groups and memberships in your LDAP directory.

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Our Test Results

We performed internal testing of synchronisation with an AD server on our local network consisting of 10 000 users, 1000 groups and 200 000 memberships.

We found that the initial synchronisation took about 5 minutes. Subsequent synchronisations with 100 modifications on the AD server took a couple of seconds to complete.

Please keep in mind that a number of factors come into play when trying to tune the performance of the synchronisation process, including:

- **Size of userbase.** Use LDAP filters to keep this to the minimum that suits your requirements.
- **Type of LDAP server.** We currently support change detection in AD, so subsequent synchronisations are much faster for AD than for other LDAP servers.
- **Network topology.** The further away your LDAP server is from your application server, the more latent LDAP queries will be.
- **Database performance.** As the synchronisation process caches data in the database, the performance of your database will affect the performance of the synchronisation.
- **JVM heap size.** If your heap size is too small for your userbase, you may experience heavy garbage collection during the synchronisation process which could in turn slow down the synchronisation.

Redundant LDAP is Not Supported

The LDAP connections do not support the configuration of two or more LDAP servers for redundancy (automated failover if one of the servers goes down).

**Specific Notes for Connecting to Active Directory**

When the application synchronises with Active Directory (AD), the synchronisation task requests only the changes from the LDAP server rather than the entire user base. This optimises the synchronisation process and gives much faster performance on the second and subsequent requests.

On the other hand, this synchronisation method results in a few limitations:

1. **Externally moving objects out of scope or renaming objects causes problems in AD.** If you move objects out of scope in AD, this will result in an inconsistent cache. We recommend that you do not use the external LDAP directory interface to move objects out of the scope of the sub-tree, as defined on the application's directory configuration screen. If you do need to make structural changes to your LDAP directory, manually synchronise the directory cache after you have made the changes to ensure cache consistency.

2. **Synchronising between AD servers is not supported.** Microsoft Active Directory does not replicate the uSNChanged attribute across instances. For that reason, we do not support connecting to different AD servers for synchronisation. (You can of course define multiple different directories, each pointing to its own respective AD server.)

3. **Synchronising with AD servers behind a load balancer is not supported.** As with synchronising between two different AD servers, Microsoft Active Directory does not replicate the uSNChanged attribute
across instances. For that reason, we do not support connecting to different AD servers even when they are load balanced. You will need to select one server (preferably one that is local) to synchronise with instead of using the load balancer.

4. **You must restart the application after restoring AD from backup.** On restoring from backup of an AD server, the uSNChanget timestamps are reverted to the backup time. To avoid the resulting confusion, you will need to flush the directory cache after a Active Directory restore operation.

5. **Obtaining AD object deletions requires administrator access.** Active Directory stores deleted objects in a special container called cn=Deleted Objects. By default, to access this container you need to connect as an administrator and so, for the synchronisation task to be aware of deletions, you must use administrator credentials. Alternatively, it is possible to change the permissions on the cn=Deleted Objects container. If you wish to do so, please see [this Microsoft KB Article](#).

6. **The User DN used to connect to AD must be able to see the uSNChanged attribute.** The synchronisation task relies on the uSNChanged attribute to detect changes, and so must be in the appropriate AD security groups to see this attribute for all LDAP objects in the subtree.

**Recommendations for Connecting to JIRA for User Management**

Please consider the following limitations and recommendations when connecting to a JIRA server for user management.

**Single Sign-On Across Multiple Applications is Not Supported**

When you connect to JIRA for user management, you will not have single sign-on across the applications connected in this way. JIRA, when acting as a directory manager, does not support SSO.

**Custom Application Connectors are Not Supported**

JIRA, Confluence, FishEye, Crucible and Bamboo can connect to a JIRA server for user management. Custom application connectors will need to use the new REST API.

**Custom Directories are Not Supported**

Earlier versions of JIRA supported OSUser Providers. It was therefore possible write a special provider to obtain user information from any external user directory. This is no longer the case.

**Optimal Number of Users and Applications**

Please consider the following limitations when connecting to a JIRA server for user management:

- Maximum 500 users.
- Maximum 5 connected applications.

**Recommendations**

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If **all** the following are true:

- You have fewer than 500 users.
- You want to share user and group management across just a few applications, such as one JIRA server and one Confluence server, or two JIRA servers.
- You do not need single sign-on (SSO) between JIRA and Confluence, or between two JIRA servers.
- You do not have custom application connectors. Or, if you do have them, you are happy to convert them to use the new REST API.
- You are happy to shut down all your servers when you need to upgrade JIRA.

Your environment meets the optimal requirements for using JIRA for user management.

If **one or more** of the following are true:

- You have more than 500 users.
- You want to share user and group management across more than 5 applications.
- You need single sign-on (SSO) across multiple applications.
- You have custom applications integrated via the Crowd SOAP API, and you cannot convert them to use the new REST API.
- You are not happy to shut down all your servers when you need to upgrade JIRA.

We recommend that you install [Atlassian Crowd](https://www.atlassian.com/software/crowd) for user management and SSO.

If you are considering creating a custom directory connector to define your own storage for users and groups...

Please see if one of the following solutions will work for you:

- If you have written a custom provider to support a specific LDAP schema, please check the supported LDAP schemas to see if you can use one of them instead.
- If you have written a custom provider to support nested groups, please consider enabling nested groups in the supported directory connectors instead.
- If you have written a custom provider to connect to your own database, please consider loading the data into the application's database instead.
- If you need to keep the custom directory connection, please consider whether [Atlassian Crowd](https://www.atlassian.com/software/crowd) meets your requirements. See the documentation on [Creating a Custom Directory Connector](https://confluence-docs.atlassian.com/display/DOC/Creating+a+Custom+Directory+Connector).

**RELATED TOPICS**

- [Connecting to an LDAP Directory](https://confluence-docs.atlassian.com/display/DOC/Connecting+to+an+LDAP+Directory)
- [Connecting to Crowd or JIRA for User Management](https://confluence-docs.atlassian.com/display/DOC/Connecting+to+Crowd+or+JIRA+for+User+Management)
- [Configuring User Directories](https://confluence-docs.atlassian.com/display/DOC/Configuring+User+Directories)
- [Requesting Support for External User Management](https://confluence-docs.atlassian.com/display/DOC/Requesting+Support+for+External+User+Management)
This page gives guidelines on how to request help from the Atlassian support team if you are having problems with external user management. External user management includes connections to Active Directory, other LDAP servers, Atlassian Crowd or Atlassian JIRA for user management. The information on this page is provided in addition to the more general page on Troubleshooting Problems and Requesting Technical Support.

The cause of such problems may be:

- The LDAP server is not responding.
- The application password is incorrectly configured, causing the LDAP server or other directory to return an authentication error.
- Other LDAP settings are incorrectly configured.

On this page:

- Troubleshooting the Connection to your External User Directory
- Problems During Initial Setup
- Complex Authentication or Performance Problems

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Troubleshooting the Connection to your External User Directory

The configuration screen for external directories in Confluence has a 'Test Settings' button. This will help you to diagnose problems with user management in Active Directory and other LDAP servers.

To test your directory connection:

1. Choose Browse > Confluence Admin.
2. Click 'User Directories' in the left-hand panel.
3. Edit the relevant directory.
4. Click 'Test Settings'.
5. The results of the test will appear at the top of the screen.

Please refer to our knowledge base articles for troubleshooting user management and login issues.

If the above resources do not help, continue below.

Problems During Initial Setup

Raise a support request and include the following information.

- Download an LDAP browser to make sure you have the right settings in your LDAP directory. Atlassian recommends LDAP Studio. Include screenshots of your user and group DNs.
- If you can start up Confluence and access the Administration Console, review your directory settings. See Connecting to an LDAP Directory. Attach screenshots of all your settings.

Complex Authentication or Performance Problems

Raise a support request and include the following information.

Confluence Server

Log in to Confluence and access the Administration Console.

- Take a screenshot of the 'System Information' screen, or save the page as HTML.
- Take a screenshot of the 'Global Permissions' screen, if people are having problems with logging in.
- Go to 'Space Admin' for the relevant space and take a screenshot of the 'Permissions' page, if you are having problems with space or page permissions.
**Confluence Configuration Files**

- If you have implemented a custom authenticator or in any way modified `seraph-config.xml` or `seraph-h-paths.xml`, please provide the modified file.

**User Management System**

- Include the name and version of your LDAP server.
- Does your LDAP server use dynamic or static groups?
- Review your directory settings. See [Connecting to an LDAP Directory](#). Attach screenshots of all your settings.

**Diagnostics**

- Enable profiling. See [Performance Tuning](#).
- Enable detailed user management logging, by editing `confluence/WEB-INF/classes/log4j.properties`. Change this section:

```
###
# Atlassian User
###
#log4j.logger.com.atlassian.user=DEBUG
#log4j.logger.com.atlassian.confluence.user=DEBUG
#log4j.logger.bucket.user=DEBUG
#log4j.logger.com.atlassian.seraph=DEBUG
#log4j.logger.com.opensymphony.user=DEBUG
```

Remove the `#` signs at the beginning of the lines, so that it looks like this:

```
###
# Atlassian User
###
log4j.logger.com.atlassian.user=DEBUG
log4j.logger.com.atlassian.confluence.user=DEBUG
log4j.logger.bucket.user=DEBUG
log4j.logger.com.atlassian.seraph=DEBUG
log4j.logger.com.opensymphony.user=DEBUG
```

- After enabling both the above, please attempt a Confluence LDAP account login and attach a copy of the log files that are produced when the problem occurs. To do this, locate your install directory or exploded WAR directory, then zip the full `/logs` subdirectory into a single file for us to examine. The logs subdirectory is located in your Confluence Home directory.

**RELATED TOPICS**

[Troubleshooting Problems and Requesting Technical Support](#)
[Configuring User Directories](#)

- [Configuring the Internal Directory](#)
- [Connecting to an LDAP Directory](#)
- [Connecting to an Internal Directory with LDAP Authentication](#)
- [Connecting to Crowd or JIRA for User Management](#)
- [Connecting to JIRA 4.2 or Earlier for User Management](#)
- [Managing Multiple Directories](#)
- [Managing Nested Groups](#)
**Disabling the Built-In User Management**

By selecting the 'External user management' option in Confluence, you can disable the group and user management screens in Confluence. You need **system administrator permissions** to set this option.

You will find it useful to select external user management under the following circumstances:

- When Crowd's directory permissions are configured so that Confluence cannot update the Crowd directories, then Confluence's external user management setting must be turned on. Otherwise, a 'System Error' will occur when Confluence attempts to write data into Crowd. For more information about integrating Crowd with Confluence, see [Connecting to Crowd or JIRA for User Management](#).
- If you are using JIRA for user management, we recommend that you turn on Confluence's external user management setting. This centralises user management in JIRA. See [Connecting to Crowd or JIRA for User Management](#) and [Connecting to JIRA 4.2 or Earlier for User Management](#).

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

To disable management of users and groups within Confluence:

1. Choose **Browse > Confluence Admin**.
2. Click 'Security Configuration' in the left-hand panel.
3. The 'Edit Security Configuration' screen will appear. Click 'Edit'.
4. Tick the 'External user management' check box.
5. Click 'Save'.

**Notes**

- Please refer to the following bugs and improvement requests:
  - CONF-16709 – When the External User Management check box is ticked, the group and user management screens are still functional.
  - CONF-21158 – Enabling both public signup and external user management renders a blank screen during signup.
  - CONF-9830 – This is a request to rename this feature to better reflect its functionality.

**RELATED TOPICS**

No content found for label(s) external-usermanagement.

---

**Installing Plugins and Macros**

A **plugin** is an add-on to the core Confluence code, which can extend the Confluence functionality. Some plugins are shipped with Confluence, others are available for you to install yourself.

A **macro** allows a developer to perform programmatic functions within a page, and gives the Confluence user...
access to more complex content structures. Many macros are made available by plugins.

You need **System Administrator** permissions in order to install and configure plugins.

### Installing and configuring plugins and macros

- **Installing and Configuring Plugins using the Universal Plugin Manager**
  - Checking Plugin Compatibility for Confluence Upgrades
  - Configuring a Plugin
  - Disabling or Enabling a Plugin
  - Installing a Plugin
  - Uninstalling a Plugin
  - Upgrading your Existing Plugins
  - Viewing the Plugin Audit Log
  - Viewing your Installed Plugins
- **Plugin loading strategies in Confluence**
- **Removing Malfunctioning Plugins**
- **Enabling and Configuring Macros**
  - Configuring a URL Whitelist for Macros
  - Configuring the User List Macro
  - Enabling HTML macros
    - Enabling the html-include Macro
    - Troubleshooting the Gallery Macro
- **Adding, Editing and Removing User Macros**
- **Writing User Macros**
  - Best Practices for Writing User Macros
  - Examples of User Macros
    - **Hello World Example of User Macro**
    - **Error Box Macro - Example of a User Macro**
    - **Colour and Size Macro - Example of a User Macro**
    - **NoPrint Example of a User Macro**
    - **Panel Preformatted with Specific Colours - Example of a User Macro**
    - **Preformatted Table - Example of a User Macro**
  - Guide to User Macro Templates
- **Configuring the Office Connector**

### Installing and Configuring Plugins using the Universal Plugin Manager

This page provides information about the Universal Plugin Manager (UPM) in Confluence and links to topics on how to install and configure plugins using the UPM. You need **System Administrator** permissions in order to install and configure plugins.

**A note about plugin safety:** Plugins are very powerful: they can change the behaviour of almost any part of the Confluence server. It is **very important** that you trust a plugin before you install it. Always be aware of where (and who) a plugin comes from.

### Overview of the Universal Plugin Manager

The Universal Plugin Manager (UPM) provides a set of functions for managing your plugins. The UPM is itself a system plugin. It allows you to perform common tasks such as:

- Enabling and disabling plugins and their plugin modules.
- Installing new plugins.
- Configuring advanced plugin options.
- Finding out-of-date plugins and updating them.
- Checking the compatibility of your installed plugins against newer versions of the application.

Through the UPM you can interact with the [Atlassian Plugin Exchange](https://plugins.atlassian.com). You can use the UPM to browse available plugins for your application, and try or buy any of these plugins without ever leaving your application.
Managing your plugins

- Checking Plugin Compatibility for Confluence Upgrades
- Configuring a Plugin
- Disabling or Enabling a Plugin
- Installing a Plugin
- Uninstalling a Plugin
- Upgrading your Existing Plugins
- Viewing the Plugin Audit Log
- Viewing your Installed Plugins

Notes

Having problems with the Universal Plugin Manager? Try the Universal Plugin Manager FAQ. (This will redirect you to the Universal Plugin Manager documentation. Use the back button on your browser to return the Confluence documentation.)

Checking Plugin Compatibility for Confluence Upgrades

The Application Upgrade Check in the Universal Plugin Manager (UPM) helps you to check whether your plugins will still work with Confluence after a Confluence upgrade.

For example, if you were thinking of upgrading from Confluence 4.1 to Confluence 4.2, the Application Upgrade Check can tell you the following:

- Installed plugins that are compatible with Confluence 4.1 and Confluence 4.2.
- Installed plugins that are not compatible with Confluence 4.2, but will be compatible with Confluence 4.2 if you upgrade them.
- Installed plugins that are not compatible with Confluence 4.2, even if you upgrade them to their latest version.

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To check compatibility of your plugins against different Confluence versions:
1. Click the Upgrade Check tab.
2. In the Check compatibility for dropdown menu, select the version of your application to check the plugins against.
3. Click the Check button.
4. The page display any of your installed plugins that are not compatible with the selected application version. The compatibility checker will also check the compatibility of the latest available version of each plugin.
plugin (if not already upgraded). You can click on the name of any of the plugins to view more information about the plugin.

The plugins are grouped into sections under the following headings:

- **Incompatible** – The installed versions of these plugins are not compatible with the selected application version. There are currently no plugin upgrades available that are compatible with the selected application version.
- **Compatible, if upgraded** – The installed versions of these plugins are not compatible with the selected application version. However, the plugins will be compatible if you upgrade them. There are buttons allowing you to upgrade these plugins.
- **Compatible if both <the application> and the plugin are upgraded** – The installed versions of these plugins are not compatible with the selected application version. There is a plugin compatible with the newer application version, but it is not compatible with the application version you are currently running. You must upgrade the application and then upgrade the plugin. There are buttons allowing you to disable these plugins before proceeding with the upgrade.
- **Compatible** – The currently installed versions of these plugins are compatible with the selected application version.
- **Unknown** – These plugins may or may not be compatible with the selected application version. If a plugin is not registered with the Atlassian Plugin Exchange, the Universal Plugin Manager cannot check its compatibility with different application versions.

Screenshot: Checking plugin compatibility against different Confluence versions

Configuring a Plugin

A number of Confluence plugins have advanced configuration options. If you have one of these plugins installed on your Confluence site, you can view and update these configuration options via the Universal Plugin Manager (UPM).

If you would like to disable or enable a plugin, please refer to **Disabling or Enabling a Plugin**.

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To configure a plugin in Confluence:

1. Click the Manage Existing tab.
2. Locate the plugin that you want to configure and click its title. The plugin details section expands.
3. Click the Configure button for that plugin. The advanced configuration options appear.

   **Warning:** If the plugin is disabled, you cannot configure it and so the Configure button does not appear. If there are no advanced configuration options for the plugin, there is no Configure button.

4. Update the configuration settings as desired and save your changes.
   **Note:** The plugin itself provides advanced configuration options. If you encounter any problems after you click the Configure button, the plugin is responsible for the issue, not the UPM.

**Screenshot: Configuring a plugin**

**Screenshot: Example of plugin configuration options – WebDAV configuration**

**Disabling or Enabling a Plugin**

Using the **Universal Plugin Manager (UPM)**, you can disable a plugin on your Confluence site without permanently removing the plugin. You can also enable any plugins that have been previously disabled. In some cases, you may want to disable or enable a specific module in a plugin.
You can also disable all user installed plugins in your application, by enabling **safe mode**. This may help you to diagnose a plugin-related problem more easily.

If you want to add or remove a plugin from your Confluence site, please refer to Installing a Plugin or Uninstalling a Plugin.

On this page:
- Disabling a plugin
- Enabling a plugin
- Disabling/Enabling a module within a plugin
- Disabling/Enabling all user-installed plugins (safe mode)

Related pages:
- Installing Plugins and Macros
- Confluence Administrator's Guide

**Disabling a plugin**

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To disable a plugin:
1. Click the Manage my plugins tab. You will see a list of the plugins installed in your application.
2. Locate the plugin that you want to disable and click the title to expand the plugin details section.
3. Click the Disable button.
4. Once a plugin has been disabled, you may need to restart your application for your change to take effect. If so, you will see a message for the plugin.
   Once the plugin is fully disabled, you will see an Enable link for the plugin.

**Screenshot: Disabling a plugin**

**Enabling a plugin**

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To enable a plugin:
1. Click the Manage Existing tab. You will see a list of the plugins installed in your application.
2. Locate the plugin that you want to enable and click the title to expand the plugin details section.
3. Click the Enable button.
4. Once a plugin has been enabled, you may need to restart your application for your change to take effect.
If so, you will see a message for the plugin: 'Enabled, requires restart'. Once the plugin is fully disabled, you will see a **Disable** link for the plugin.

**Screenshot: Enabling a plugin**

![WebDAV Plugin](image)

**Disabling/Enabling a module within a plugin**

In some cases, you may want to turn part of a plugin's functionality off or on, by disabling or enabling a specific module of the plugin.

**Note:** Be careful when disabling a module within a plugin. This can have unexpected effects on other parts of your Confluence functionality.

**To access the Universal Plugin Manager in Confluence:**

1. Choose **Browse > Confluence Admin.**
2. Click the **Plugins** link in the **Configuration** section of the left-hand menu. The Universal Plugin Manager will appear.

**To disable or enable a module within a plugin:**

1. Click the **Manage my plugins** tab. You will see a list of the plugins installed in your application.
2. Locate the plugin that contains the module you are interested in, and click the plugin title to expand the plugin details section.
3. Click **Manage plugin modules**.
4. Move your cursor over the module that you are interested in. If the module is enabled, a **Disable** option will appear. If the module is disabled, an **Enable** option will appear. Choose the option you want.

**Disabling/Enabling all user-installed plugins (safe mode)**

Running your application in safe mode disables all user installed plugins at once. All plugins that were disabled when you entered safe mode will be re-enabled when you exit safe mode.

**To access the Universal Plugin Manager in Confluence:**

1. Choose **Browse > Confluence Admin.**
2. Click the **Plugins** link in the **Configuration** section of the left-hand menu. The Universal Plugin Manager will appear.

**To enable safe mode:**

1. Click the **Manage my plugins** tab.
   The system displays a list the installed plugins.
2. Click the **Enable Safe Mode** link.
3. Click the **Continue** button in the confirmation window.
   All user installed plugins will be disabled and your application will now be running in safe mode.
4. Make changes to your installed plugins as desired.
   For example, you may want to enable/disable specific plugins or plugin modules.
5. Exit safe mode by clicking one of the links in the Safe Mode banner:
- Click **Exit Safe Mode and restore the previous configuration** to restore your plugin configuration to its state before you entered Safe Mode.
- Click **Exit Safe Mode and keep the current configuration** to keep all changes made to your plugin configuration during Safe Mode.

_Screenshot: Running Confluence in safe mode_

---

**Installing a Plugin**

This page describes how to install a plugin into Confluence using the Universal Plugin Manager (UPM). Plugins can be used to customise and extend the functionality available in Confluence.

You can search for plugins in the UPM, or upload your own. The UPM searches the plugins in the [Atlassian Plugin Exchange](https://addons.atlassian.com).

---

**On this page:**
- Adding a plugin from the Atlassian Plugin Exchange
- Uploading your own plugin
- Notes

---

⚠️ The information on this page _does not apply_ to Confluence OnDemand.

---

**Adding a plugin from the Atlassian Plugin Exchange**

To access the Universal Plugin Manager in Confluence:

1. Choose **Browse > Confluence Admin**.
2. Click the **Plugins** link in the **Configuration** section of the left-hand menu. The Universal Plugin Manager will appear.

To find and add a plugin from the Atlassian Plugin Exchange:

1. Click the **Install** tab in the UPM. You will see a list of featured plugins.
2. Search for your plugin as follows:
   - Enter some keywords that describe the plugin in the **Search the Plugin Exchange** search box and press Enter.
   - Alternatively, browse to the desired plugin in the list. You can choose **Featured, Popular, Support (by Atlassian)** or **All available** from the **Plugins to show** dropdown to see a different list of plugins.
3. Click the **Install** button for the desired plugin to add it to your application. A confirmation message and the plugin details will appear when the plugin is installed successfully.
**Note:** You may need to restart your application for your change to take effect. The Universal Plugin Manager will inform you if this is the case.

**Note:** Not all plugins can be automatically installed. Some required manual installation. These plugins will have a **Download** button instead of an **Install** button. In these cases, you should read and follow the plugin's installation instructions.

Screenshot: Finding a new plugin from the Atlassian Plugin Exchange

---

**Uploading your own plugin**

To access the Universal Plugin Manager in Confluence:

1. Choose **Browse > Confluence Admin**.
2. Click the **Plugins** link in the **Configuration** section of the left-hand menu. The Universal Plugin Manager will appear.

To upload your own plugin to Confluence:

1. Click the **Install** tab in the UPM. The system displays a list of featured plugins.
2. Click the **Upload Plugin** link. The system displays the **Upload Plugin** window.
3. Specify the location of your plugin:
   - If the plugin you want to install is on your computer, use the **Browse** dialogue to choose the plugin JAR file.
   - If you want to install a plugin from a remote location, enter the URL of the plugin JAR file in the **From this URL** text box.
4. Click the **Upload** button to upload and enable your plugin. A confirmation message will appear when the plugin is successfully installed.

**Note:** You may need to restart your application for your change to take effect. The Universal Plugin Manager will inform you if this is the case.

Screenshot: Uploading a new plugin
Uninstalling a Plugin

If you wish to remove a plugin from Confluence altogether, you can uninstall it via the Universal Plugin Manager (UPM). If you only want to temporarily remove it, you may wish to disable your plugin instead.

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To uninstall a plugin from Confluence:
1. Click the Manage Existing tab.
   The systems lists the plugins installed in your application.
2. Click the name of the plugin that you wish to uninstall.
   The system displays the plugin details.
3. Click the Uninstall button.
   The information summary displays an Uninstalling message and uninstalls the plugin from your application.

Notes

- In Confluence, you can install and uninstall both version 1 and version 2 plugins using the Universal Plugin Manager.
- Some entries that you find listed in the Universal Plugin Manager are not actually plugins. These entries will show a 'Download' button which allows you to download the application to your desktop and run it following the instructions given by that application.

The information on this page does not apply to Confluence OnDemand.
Upgrading your Existing Plugins

Plugins are often developed separately from Confluence. You may wish to upgrade your plugins to more recent versions to allow them to work with your Confluence version or simply to take advantage of new features in a plugin version. The Universal Plugin Manager (UPM) provides you with a list of plugins that have available upgrades and allows you to upgrade each plugin individually or in bulk.

Tip: If you are considering upgrading Confluence, you can use the Universal Plugin Manager to check the compatibility of your plugins with your desired Confluence version. See Checking Plugin Compatibility for Confluence Upgrades.

On this page:
- Upgrading a plugin
- Upgrading all plugins

⚠ The information on this page does not apply to Confluence OnDemand.

Upgrading a plugin

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To upgrade a plugin in Confluence:
1. Click the Manage my plugins tab. You will see a list of plugins that are available for upgrading, under the heading 'Available Updates'.
   - If there is a later version of a plugin that you have already installed, this page will show the latest compatible version of the plugin.
   - You can click the plugin name to expand the row and see more information about the plugin.
   - You can filter your list by entering keywords in the Filter visible plugins text box.
2. Click the name of the plugin that you want to upgrade, to see more information about the plugin.
3. Click the Update button next to the plugin to update it to the version shown.

Upgrading all plugins

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To upgrade all available plugins in Confluence:
1. Click the **Manage my plugins** tab. You will see a list of plugins that are available for upgrading, under the heading ‘Available Updates’:
   - If there is a later version of a plugin that you have already installed, this page will show the latest compatible version of the plugin.
   - You can click the plugin name to expand the row and see more information about the plugin.
   - You can filter your list by entering keywords in the **Filter visible plugins** text box.

2. Click the **Update All** button to upgrade every plugin to the plugin versions shown.

**Note:** Not all plugins can be installed or upgraded via the Universal Plugin Manager. There are some plugins that you must manually install and upgrade.

### Screenshot: Upgrading plugins

The Universal Plugin Manager (UPM) keeps a log of all plugin activity in your Confluence instance. For example, adding plugins, and enabling plugins. You can configure the audit log to adjust the period of time for which log entries should be kept.

### Viewing the Plugin Audit Log

The Universal Plugin Manager (UPM) keeps a log of all plugin activity in your Confluence instance. For example, adding plugins, and enabling plugins. You can configure the audit log to adjust the period of time for which log entries should be kept.

#### Viewing the plugin audit log

To access the Universal Plugin Manager in Confluence:

1. Choose **Browse** > **Confluence Admin**.
2. Click the **Plugins** link in the **Configuration** section of the left-hand menu. The Universal Plugin Manager will appear.

To view the plugin audit log:

1. Click the **Audit Log** tab.
   - The plugin audit log appears with a list of the 25 most recent entries.
2. Use the arrows if you want to view older entries.
3. Click the orange RSS icon if you want to receive the audit log activity in an RSS feed.

On this page:

- Viewing the plugin audit log
- Configuring the plugin audit log

Screenshot: Viewing the plugin audit log

Configuring the plugin audit log

To access the Universal Plugin Manager in Confluence:
1. Choose Browse > Confluence Admin.
2. Click the Plugins link in the Configuration section of the left-hand menu. The Universal Plugin Manager will appear.

To configure the amount of time log entries are kept:

1. Click the Audit Log tab.
   The plugin audit log appears.
2. Click the Configure purge policy link.
3. Specify how many days to keep the logs before purging in the Purge audit log after field.
4. Click the Confirm button.

Screenshot: Configuring the audit log’s purge policy

Viewing your Installed Plugins

The Universal Plugin Manager (UPM) allows you to easily view the plugins installed on your Confluence instance. This includes plugins that are bundled with Confluence as well as any third party plugins that you have installed. Both enabled and disabled plugins are displayed.

On this page:
Viewing your Installed Plugins

To view your installed plugins,

1. Click the 'Manage Existing' tab. The plugins installed on your application will be displayed.
   - The plugins will be grouped into 'User-installed Plugins' and 'System Plugins'.
   - You can filter your list by entering keywords in the 'Filter visible plugins' text box.
   - The list of 'System Plugins' will be hidden by default. Click the 'Show System Plugins' link, if you want to view them.
   - Enabled plugins will be listed with an icon. Disabled plugins will be listed with an icon.
   - Click the name of a plugin to view the plugin's details.
   - Click 'Enable Safe Mode' to run your application in safe mode. Read 'Disabling or Enabling a Plugin' (see Related Topics below) for more information on Safe Mode.

What is the difference between a 'System Plugin' and a 'User Installed Plugin'?  

- **System plugins** are those that shipped with the product when you downloaded it from Atlassian. These plugins are integral to the functioning of the system, and although you can disable some of them, you should not do so unless instructed by an Atlassian Support engineer. Note, not every system plugin can be disabled and you will not be able to uninstall any system plugins at all.
- **User-installed plugins** are those which have been installed in the product after it was set up: either by uploading a plugin jar file, or by placing it in the applications plugin directories. These plugins can be uninstalled.

Screenshot: Viewing Installed Plugins (Confluence)
Viewing a Plugin's Details

You can view the details for a plugin when you click the name of a plugin in the installed plugins list (as described above). The summary contains a short description of the plugin as well as buttons/links for plugin operations and related information.

Screenshot: Viewing a Plugin's Details (Confluence)

- **Plugin key** — This field shows the unique key that identifies each plugin in the system.
- **Developer** — This field lists the name of the plugin developer and a link to the developer's homepage, if provided by the plugin developer.
- **Plugin version** — This field lists the version of the plugin currently installed.
- **Manage plugin modules** — Click this link to display the modules below the plugin summary. This link will only display if the plugin has modules, e.g. the Confluence Advanced Macros plugin. If you want to enable or disable a plugin module, hover your mouse over the module and click the 'Enable'/'Disable' button that
displays.

- **Configure** — Click this link to display the configuration settings for the plugin in the Universal Plugin Manager. This link will be disabled if the plugin is disabled. Please note that not all plugins have settings that can be configured through the Universal Plugin Manager. Refer to 'Configuring a Plugin' (see Related Topics below) for more information.

- **Disable** — Click this button to disable the plugin in your application. This button will only display if the plugin is enabled. Refer to 'Disabling or Enabling a Plugin' (see Related Topics below) for more information.

- **Enable** — Click this button to enable the plugin in your application. This button will only display if the plugin is disabled.

- **Uninstall** — Click this button to uninstall the plugin from your application. This button will only display if the plugin is a user-installed plugin. Refer to 'Uninstalling a Plugin' (see Related Topics below) for more information.

**Related Topics**

- Configuring a Plugin
- Disabling or Enabling a Plugin
- Uninstalling a Plugin

**Plugin loading strategies in Confluence**

**The categories**

Confluence plugins have different behaviour based on how they are loaded by Confluence. The plugins themselves are the same, but based on how they are loaded, they may or may not be upgraded, or may not be disabled, or may not be uninstalled. This chart should explain how plugins can be loaded by Confluence, and the ramifications for each choice.

The category any particular plugin is in can vary with Confluence version or circumstance. The examples mentioned here describe the way particular plugins are loaded by default in Confluence 2.8.

⚠️ The information on this page does not apply to Confluence OnDemand.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>cannot be installed or upgraded without a Confluence restart</td>
<td></td>
</tr>
<tr>
<td><strong>Core</strong></td>
<td>Included with Confluence and cannot be uninstalled. The classes and plugin.xml are not bundled into plugin jars, but mixed in with Confluence source on the main classpath. Additionally, the plugin.xml definitions are not called &quot;atlassian-plugin.xml&quot; as they are everywhere else, but are named for the plugin e.g., &quot;basic-macros.xml&quot;. We would like to separate some of them out and turn them into Bundled plugins.</td>
<td><strong>WEB-INF/lib</strong></td>
</tr>
<tr>
<td><strong>Dynamic</strong></td>
<td>the opposite of static, these can be installed/upgraded while Confluence is running</td>
<td><strong>Admin Sections</strong></td>
</tr>
</tbody>
</table>
### Bundled

Bundled plugins can be administered from the Plugins console from Administration >> Plugins. You can upload or disable them there.

*Bundled* plugins are included in a zip of jars called `atlassian-bundled-plugins.zip` which is on the main Confluence classpath, in a resources directory: `<confluence-install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup`. At Confluence startup, they are extracted and copied into the `$CONFLUENCE_HOME/bundled-plugins` directory, from whence they are loaded. To remove a bundled plugin (you shouldn’t normally have to do this), remove the plugin from the `atlassian-bundled-plugins.zip` file and the `bundled-plugins` directory, otherwise Confluence will just put it back in place on the next startup. In versions later than 2.6, you'll have to recreate the `.jar` file (if the jar file is from the `lib` folder) or recreate the `zip` folder (if its in the `classes` folder). Bundled plugins can be upgraded or disabled.

### Uploaded

Installed by the user via the plugin repository or the Plugin Manager page. These plugins are stored in the database and then copied to the `$CONFLUENCE_HOME/plugins-cache` folder on each Confluence node.

could be anything

<table>
<thead>
<tr>
<th>Bundled</th>
<th>Office Connector</th>
</tr>
</thead>
</table>

To summarise the relationships of categories in the table, all plugins are either *Static* or *Dynamic*. *Static* plugins can be further categorised into *Core* or `WEB-INF/lib`. *Dynamic* plugins are divided into *Bundled* and *Uploaded*.

**Use of the categories in Confluence**

Within Confluence, the *Core* and `WEB-INF/lib` categories are not actually named as such, and they don't map neatly to other names (though they do map, as will be explained). They are used here because of the logical distinction they provide.

In Confluence, some of the *Core* plugins are called "System". Plugins can be designated as "System" by adding a flag to the plugin manifest file. To do this, `system=true` should be added to the top-level `atlassian-plugin` element of the manifest file. The manifest file is generally called `atlassian-plugin.xml`, but it could have another name; the *Core* plugins' files do.
All of the Core plugins once were labeled as "System", but it seems the practice has faded over time. If a plugin is designated as "System", then it will not show up in the Plugin Manager page in Confluence and thus cannot be enabled/disabled. However, it will show up in the Plugin Repository Client, where it can be disabled; allowing disabling there is probably incorrect behavior.

Static plugins that are not marked as "System" (any remaining Core and WEB-INF/lib plugins), are simply called Static in Confluence. There is no way to tell the WEB-INF/lib and Core plugins apart from within Confluence. You just have to figure out where the classes are.

Members of the other specific categories - Bundled and Uploaded - can be determined. We can tell which plugins are Bundled and which plugins are Uploaded, so we know which plugins are Uploaded though this specific term is never used in the Confluence UI. Instead, they are called Dynamic.

**Upgrading plugins**

- Core plugins cannot be upgraded.
- WEB-INF/lib plugins can be upgraded by replacing the JAR in WEB-INF/lib and restarting Confluence.
- Bundled plugins can be upgraded using the Plugin Manager or the Plugin Repository Client. A new plugin jar is uploaded and stored as an Uploaded plugin. Confluence compares the version number with the Bundled plugin and uses the newer.
- Uploaded plugins are upgradable using the Plugin Manager or the Plugin Repository Client. When a new plugin jar is uploaded, the previous version is discarded from the database and the $CONFLUENCE_HOME/plugin-cache.

**RELATED TOPICS**

Removing Malfunctioning Plugins

**Removing Malfunctioning Plugins**

Confluence goes to some lengths to prevent itself being unusable due to a problematic plugin. However, sometimes a plugin will manage to do this anyway. This page describes what to do if a plugin cannot be disabled or deleted from the Administration console (from Administration >> Plugins).

⚠️ The information on this page does not apply to Confluence OnDemand.

**Plugin Loading Strategies**

1. Read through Plugin loading strategies in Confluence.
2. Determine where your plugin is loaded. The usual options are:
   a. The PLUGINDATA table on the database
   b. The <confluence-home>/bundled-plugins folder
   c. The <confluence-home>/plugin-cache folder
   d. The <confluence-home>/plugins-osgi-cache folder
   e. The <confluence-home>/plugins-temp folder
   f. The <confluence-install>/confluence/WEB-INF/lib folder (deprecated approach)

Check these locations when troubleshooting plugin loading issues.

✅ Check the How to display classpath utility for tips on what’s loading, and the Knowledge Base Article on plugin malfunctioning.

**Deleting a plugin from the Database**

To remove a plugin from Confluence when Confluence is not running,
1. Connect to the Confluence database.
2. Run the following SQL statement in your database:
   
   ```sql
   select plugindataid, pluginkey, filename, lastmoddate from plugindata;
   ```

3. After you have found the plugindataid for the offending plugin, please run the following:
   
   ```sql
   delete from plugindata where plugindataid='XXXXXX';
   ```

   where XXXXXX is the plugindataid value.

4. Restart Confluence.

**Disabling a plugin from the database**

**To disable in the database,**

Run the following query on your Confluence database:

```sql
select BANDANAVALUE from BANDANA where BANDANAKEY = 'plugin.manager.state.Map'
```

This will return a value like:

```xml
<map>
  <entry>
    <string>com.atlassian.confluence.ext.usage</string>
    <boolean>true</boolean>
  </entry>
</map>
```

Edit the value `boolean` to have `false`:

```xml
<map>
  <entry>
    <string>com.atlassian.confluence.ext.usage</string>
    <boolean>false</boolean>
  </entry>
</map>
```

**Deleting a Bundled Plugin**

Bundled plugins can be administered from the Plugins console from Administration >> Plugins. You can upload or disable them there.
Bundled plugins are included in a zip of jars called `atlassian-bundled-plugins.zip` which is on the main Confluence classpath, in a resources directory - `<confluence-install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup`. At Confluence startup, they are extracted and copied into the `$CONFLUENCE_HOME/bundled-plugins` directory, from whence they are loaded. To remove a bundled plugin (you shouldn't normally have to do this), remove the plugin from the atlassian-bundled-plugins.zip file and the bundled-plugins directory, otherwise Confluence will just put it back in place on the next startup. In versions later than 2.6, you'll have to recreate the jar file (if the jar file is from the lib folder) or recreate the zip folder (if it's in the classes folder). Bundled plugins can be upgraded or disabled.

If you need to remove a bundled plugin, check to see if you have duplicates in the `<confluence-home>/bundled-plugins` or `<confluence-home>/plugin-cache` directory.

Usually, the problem is that an old plugin is getting loaded along with the properly bundled one, but if you need to remove a bundled plugin, check Plugin loading strategies in Confluence.

Enabling and Configuring Macros

Macros allow you to perform programmatic functions within a page, and can be used for generating more complex content structures.

Generally speaking, a macro is simply a command wrapped inside curly braces {...}. To learn how to write your own macro, or use macros written by other people, read the Confluence Plugin Guide.

⚠️ The information on this page does not apply to Confluence OnDemand.

Related Topics:

- Configuring a URL Whitelist for Macros
- Configuring the User List Macro
- Enabling HTML macros
  - Enabling the html-include Macro
  - Troubleshooting the Gallery Macro

Configuring a URL Whitelist for Macros

This page tells you how to restrict some Confluence macros so that they can get information from authorised sources (URLs) only.

Whitelisting URLs for the RSS and HTML Include macros

The RSS and HTML Include macros are used to include content dynamically from other websites onto a Confluence page. The included content may possibly be malicious or harmful to your Confluence instance.

Confluence administrators can set up a list of trusted URLs, thus limiting the locations from which the RSS macro and the HTML Include macro can draw their content.

The form below allows you to define specific URLs and/or URL patterns which are trusted, or to allow inclusion from all URLs without restriction.

To configure the URL whitelist:

1. Choose Browse > Confluence Admin.
2. Select Configure Whitelist in the left-hand panel. The 'Configure Whitelist' screen will appear, as shown in the screenshot below.
3. Select one of the options as follows:
   - Allow all domains — There will be no restrictions to the content which can be included onto your
Confluence pages.

- **Restrict to listed domains** — Confluence will allow content from trusted URLs only. When you select this option, a textbox will open allowing you to enter specific URLs and/or URL patterns. Enter one or more URLs, each on its own line. You can enter the full URL, or use the pattern matching rules described below.

4. Click **Save**.

**On this page:**

- [Whitelisting URLs for the RSS and HTML Include macros](#)
- [URL Pattern-Matching Rules](#)
- [Notes](#)
- [What Happens to a Page Containing a Disallowed URL?](#)

**Related pages:**

- [Enabling HTML macros](#)
- [RSS Feed Macro](#)
- [HTML Include Macro](#)
- [Configuring a URL Whitelist for Gadgets](#)
- [Confluence Administrator's Guide](#)

⚠️ The information on this page does not apply to Confluence OnDemand.

**Screenshot: Configuring a URL whitelist for RSS and HTML Include macros**

- **Enable Whitelist**
  - ![on] Allow all domains
  - ![off] Restrict to listed domains

- **Whitelist Rules**
  
  http://*.atlassian.com

**URL Pattern-Matching Rules**

Enter one URL or URL pattern per line. You can enter a full URL or use pattern-matching as described below:

- If the rule starts with an equals sign (=), only the exact URL following the ‘=’ will be allowed.
- If the rule starts with a slash (/) then the whole rule will be treated as a regular expression.
- Otherwise, any asterisk (*) will be treated as a wildcard to match one or more characters.

**Notes**

---

*Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).*
Some things to be aware of:

- By default, the RSS and HTML Include macros are disabled in Confluence. A System Administrator can enable them on the 'Plugins' screen of the Confluence Administration Console.
- A user who has the ‘Confluence Administrator’ permission, but not necessarily the ‘System Administrator’ permission, can configure the URL whitelist for the HTML Include and RSS macros.

**What Happens to a Page Containing a Disallowed URL?**

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence "could not access the content at the URL because it is not from an allowed source" and displays the offending URL. If the person viewing the page is a Confluence Administrator, they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
Configure whitelist >>
```

Here is an example of the error message, but without the link.

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
You may contact your site administrator and request that this URL be added to the list of allowed sources.
```

**Configuring the User List Macro**

The User List macro has an optional Display Online parameter. If the User Listener plugin is configured to allow this feature, then the page author can select Display Online to show a list of all online users.

ℹ️ You need to have System Administrator permissions in order to perform this function.

**To enable the Display Online filter in the User List macro:**

1. Choose Browse > Confluence Admin.
2. Select Plugins in the left-hand panel. This will list the currently installed plugins.
3. Scroll down and click User Listener. The User Listener plugin panel will appear at the top of the screen.
4. Enable the User Log In Listener module by clicking Enable on its right.
5. Restart Confluence.

⚠️ The information on this page does not apply to Confluence OnDemand.
List of online users can be misleading

When the Display Online parameter is used, Confluence uses a context listener to generate the list of online users. A context listener is a J2EE term for something that listens for events in the application server. We listen for session open and close events, so a user is 'online' if they have a session on the application server. Some application servers don’t correctly despatch close events for sessions – in these cases, the list of online users may be misleading.

Related Topics

User List Macro
Enabling and Configuring Macros

Enabling HTML macros

The \{html\} macro allows you to use HTML code within a Confluence page.

The \{html-include\} macro allows you to include the contents of an HTML file in a Confluence page.

CAUTION: Including unknown HTML inside a web page is dangerous. Because HTML can contain active scripting components, it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user’s authentication cookie and give the attacker their Confluence login password.

By default, the HTML macros are disabled. You should only turn on these macros if you trust all your users not to attempt to exploit them.

You need System Administrator permissions in order to perform this function.

Related pages:

- Working with Macros
- Confluence Administrator's Guide

The information on this page does not apply to Confluence OnDemand.
To enable the HTML macros:

1. Choose Browse > Confluence Admin.
2. Choose Plugins in the left-hand panel. This will display the installed plugins active for this Confluence installation.
3. Choose Show System Plugins to display bundled plugins.
4. Choose Confluence HTML macros, then choose Enable.
5. Choose Manage plugin modules to see the list of modules in the plugin.
6. Ensure that the html (html-xhtml) module is enabled.

Enabling the html-include Macro

The \{html-include\} macro allows you to include the content of an HTML file in a Confluence page. This page tells you how to enable the macro, so that it is available on your Confluence site. For help on using the macro, see HTML Include Macro.

⚠️ CAUTION: Including unknown HTML inside a web page is dangerous.

Because HTML can contain active scripting components, it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user’s authentication cookie and give the attacker their Confluence login password.

⚠️ The information on this page does not apply to Confluence OnDemand.

Enabling the HTML Macros

By default, the HTML macros are disabled. You should only turn on these macros if you trust all your users not to attempt to exploit them.

ℹ️ You need to have System Administrator permissions in order to perform this function.

To enable the HTML macros,

1. Choose Browse > Confluence Admin.
2. Select ‘Plugins’ in the left-hand panel. This will display the installed plugins active for this Confluence installation.
3. Click ‘HTML macros’, then click ‘Enable Plugin’.

To embed an external page,

Use the following syntax:

```
{html-include:url=http://www.example.com}
```

To include HTML inline,
Use the following syntax:

```html
<b>I like cheese</b>
```

RELATED TOPICS

**HTML Include Macro**

No content found for label(s) admin-macros.

**Troubleshooting the Gallery Macro**

**Gallery Macro**

The page _Gallery Macro Parameters does not exist.

For more information, refer to Gallery Macro.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Troubleshooting**

If you encounter the following error message: System does not support thumbnails: no JDK image support then ensure that you have following system property available for your JVM:

```
JAVA_OPTS=-Djava.awt.headless=true
```

Also see CONF-1737

⚠️ Please note that gallery-ext.jar is available at CONF-6620

**Adding, Editing and Removing User Macros**

User macros are short pieces of code that perform an often-used function or add some custom formatting to a page. People can call the macro into action by adding the macro keyword to their Confluence pages. You can write a 'user macro' by adding code on a screen in the Confluence Administration Console.

Notes:

- You need System Administrator permissions in order to perform this function.
- See Shared User Macros for a list of community-donated macros.
- Be careful when installing user macros from unknown authors.
- If you remove a user macro that is in use on Confluence pages, you will need to remove the macro from the pages manually. When you remove the user macro, the usage of the macro on the page will become invalid. Hint: Use the Confluence search to find all occurrences of the macro on pages and blog posts.
To add a user macro:

1. Choose Browse > Confluence Admin.
2. Click User Macros in the left-hand panel.
3. Click Create a User Macro at the top of the list of macros.
4. Enter the macro details as explained in the guide to writing user macros.
5. Click Add.

To edit a user macro:

1. Choose Browse > Confluence Admin.
2. Select User Macros in the left-hand panel. This will list the currently configured user macros.
3. Click Edit next to the relevant macro.
4. Update the macro details as explained in the guide to writing user macros.
5. Click Save.

To remove a user macro:

1. Choose Browse > Confluence Admin.
2. Select User Macros in the left-hand panel. This will list the currently configured user macros.
3. Click Remove next to the relevant macro.

Related Topics

Best Practices for Writing User Macros

Examples of User Macros

Writing User Macros

User macros are short pieces of code that perform an often-used function or add some custom formatting to a page. People can add the macro to a page by choosing it from the Macro Browser when editing a Confluence page. The macro is run when the page is loaded by the browser. You can write a user macro by adding code on a screen in the Confluence Administration Console.

You need to have System Administrator permissions in order to create user macros.

Do you need a plugin instead?

If you want to distribute your user macro as a plugin, please refer to the developer's guide to the User Macro plugin module. If you want to create more complex, programmatic macros in Confluence, you may need to write a Macro plugin.

On this page:

- Creating a User Macro
- Examples and Best Practices
- Related Topics
Creating a User Macro

To create a user macro:

1. Go to the Confluence Administration Console and click User Macros in the left-hand panel.
2. Click Create a User Macro.
3. Supply the information in the input fields as explained below, then click Add.

The sections below tell you about each of the input fields.

Macro Name

Enter the text that people will see when looking for the macro in the Macro Browser.

Visibility

Set the visibility options to specify who can see this macro when they are searching using the Macro Browser or Autocomplete.

User macros must have parameters defined in order to appear in the Confluence 4.0 Macro Browser.

The options are as follows:

<table>
<thead>
<tr>
<th>Visibility Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible to all users</td>
<td>All users will see this macro when searching for a macro using the Macro Browser or Autocomplete.</td>
</tr>
</tbody>
</table>
Visible only to system administrators

Choose this option if you want the macro to be 'hidden' from most users when the users are looking for a macro to add to a page. Note that this does not completely hide the macro. Instead, it is useful if you want to avoid cluttering the Macro Browser and Autocomplete with unnecessary macros. Specifically, if you are:

- **Editing a page and inserting a macro using the Macro Browser:** Only system administrators will see this macro in the Macro Browser. For other users, the macro will not show up in the Macro Browser when the user searches for a macro to add to a page.
- **Editing a page and inserting a macro using Autocomplete:** Only system administrators will see this macro in Autocomplete. For other users, the macro will not show up in the Autocomplete list when the user searches for a macro to add to a page.
- **Viewing the page:** The macro output will be visible to all users who have permission to see the page.
- **Editing a page that already contains the macro:** Provided a user has permission to edit the page, the macro will be visible to all users when editing the page, and all users who have permission to edit the page will also be able to edit or remove the macro.

Please note that all the macro information will also be discoverable, including the macro title, description, parameter names and other metadata. Do not include confidential data anywhere in the definition of a user macro, even if it is marked as visible only to system administrators.

**Macro Title**

Enter the text that should appear in the Macro Browser and in Autocomplete, to identify this macro when people are looking for it to insert onto a page.

**Description**

Enter the text that should appear in the Macro Browser describing this macro. Note that the Macro Browser's search will pick up matches in the description as well as in the title.

**Categories**

Select one or more categories for your macro. To select more than one category, hold down the 'Ctrl' key while selecting. These are the categories that appear in the Macro Browser, helping users to choose a macro from a logical set.

**Icon URL**

If you would like the Macro Browser to display an icon for your macro, enter the URL here. You can enter an absolute URL or a path relative to the Confluence base URL. For example:

- Absolute URL:
What is the macro body?

The macro body is the content that is displayed on the wiki page. If the macro allows a body, users will be able to enter body content when configuring the macro in the Macro Browser.

How can I use the macro body?

If you specify that your macro has a body, you will be able to pass text to the macro when you invoke it from within a page.

If your macro has a body, any body content that the user enters will be available to the macro in the $body variable. See the section about the template below. In addition, the options below allow you to tell Confluence to pre-process the body before it is placed in the macro output.

What are the options for macro body?

<table>
<thead>
<tr>
<th>Body Processing Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No macro body</td>
<td>Select this option if your macro does not need a body.</td>
</tr>
<tr>
<td>Escaped</td>
<td>If your macro has a body, and you make use of the body as $body in your template, Confluence will add escape characters to the HTML markup in the macro body. You could use this if you want to show the HTML markup in the rendered page. For example, if the body is:</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><code>&lt;b&gt;Hello World&lt;/b&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Then value of $body will be:</td>
</tr>
<tr>
<td></td>
<td><code>&amp;lt;b&amp;gt;Hello World&amp;lt;/b&amp;gt;</code></td>
</tr>
<tr>
<td></td>
<td>This will render as:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;b&gt;Hello World&lt;/b&gt;</code></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unrendered</th>
<th>If your macro has a body, and you make use of the body as $body in your template, HTML in the body will be processed within the template before being output. Ensure that HTML is ultimately output by the template.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rendered</td>
<td>If your macro has a body, and you make use of the body as $body in your template, Confluence will recognise HTML in the macro body. For example, if the body is:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;b&gt;Hello World&lt;/b&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Then value of $body will be:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;b&gt;Hello World&lt;/b&gt;</code></td>
</tr>
<tr>
<td></td>
<td>This will render as: <code>Hello World</code></td>
</tr>
</tbody>
</table>

**Template**

Enter code to specify what the macro will do. For example, to add a macro inside the macro you are writing, you would write:
Quick guide:

- Use HTML and Confluence-specific XML elements in the macro template. Details of Confluence's storage format are in Confluence Storage Format.
- You can use the Velocity templating language. Here is more information on the Velocity project.
- If your macro has a body, your template can refer to the macro body text by specifying 'body'.
- Each parameter variable you use must have a matching metadata definition. Use @param to define metadata for your macro parameters.
- When using the information passed using parameters, refer to your parameters as $paramXXX where 'XXX' is the parameter name that you specified in the @param metadata definition.
- Use @noparams if your macro does not accept parameters. Note that this will prevent your macro appearing in the macro browser.

See our detailed guide to writing a user macro template.

Examples and Best Practices

See:

- Examples of User Macros
- Best Practices for Writing User Macros

Related Topics

Developer documentation:

- User Macro Module
- Macro Module
- Confluence Plugin Guide

Library of user-contributed user macros

- Shared User Macros

Be careful when installing user macros. Ideally use only macros from authors and sources that are well known to you.

Best Practices for Writing User Macros

This section contains tips and suggestions for best practice in macro coding. To see how to write a user macro and add it to your Confluence site, take a look at our guide to writing user macros.

The information on this page does not apply to Confluence OnDemand.

Add a Descriptive Header to your Macro Template

We recommend that you include a short description of your macro via comments at the top of the Template field as shown below. You can see an excellent example in the 'Image rollover' user macro.
## Macro title: My macro name
## Macro has a body: Y or N
## Body processing: Selected body processing option
## Output: Selected output option

## Developed by: My Name
## Date created: dd/mm/yyyy
## Installed by: My Name

## Short description of what the macro does

### Expose your Parameters in the Macro Browser

Confluence offers great options for making your macro look good in the macro browser. You can specify the macro category, link to an icon, define the parameters that the macro browser will use to prompt the user for information, and more.

In particular, read the documentation on defining the macro parameters to be displayed in the macro browser.

### Supply Default Values for Macro Parameters

You cannot guarantee that a user will supply parameters, so one of the first things to do in the macro is check that you have received some value if you expect to rely on it later on in the macro code.

In the example below, the macro expects three parameters. It substitutes sensible defaults if they are not supplied:

```plaintext
#set($spacekey= $paramspacekey)
#set($numthreads= $paramnumthreads)
#set($numchars= $paramnumchars)

## Check for valid space key, otherwise use current
#if (!$spacekey)
   #set ($spacekey=$space.key)
#end

## Check for valid number of threads, otherwise use default of 5
#if (!$numthreads)
   #set ($numthreads=5)
#end

## Check for valid excerpt size, otherwise use default of 35
#if (!$numchars)
   #set ($numchars=35)
#end
```

### Related Topics

**Writing User Macros**

**Examples of User Macros**

Below are some sample user macros. To see how to write a user macro and add it to your Confluence site, take a look at our guide to writing user macros.

Example 1: A macro that displays 'Hello World'
Take a look at an example of a 'Hello World' macro.

Example 2: The 'Error' macro that creates a red box

Let's write a simple macro that creates a red box (using an existing Confluence style) around some text. See Error Box Macro - Example of a User Macro.

Example 3: A macro that demonstrates the use of parameters

See Colour and Size Macro - Example of a User Macro.

Example 4: A macro that prevents text from being printed

See NoPrint Example of a User Macro.

On this page:

- Example 1: A macro that displays 'Hello World'
- Example 2: The 'Error' macro that creates a red box
- Example 3: A macro that demonstrates the use of parameters
- Example 4: A macro that prevents text from being printed
- Example 5: A macro that creates a preformatted panel
- Example 6: A macro that creates a preformatted table
- Community-contributed user macros

Related pages:

- Writing User Macros
- Guide to User Macro Templates
- Guide to User Macro Templates Working with Macros

The information on this page does not apply to Confluence OnDemand.

Example 5: A macro that creates a preformatted panel

This user macro creates a panel preformatted with specific colours. See Preformatted Table - Example of a User Macro.

Example 6: A macro that creates a preformatted table

This user macro creates a table with predefined headings. See Panel Preformatted with Specific Colours - Example of a User Macro.

Community-contributed user macros

You may want to take a look at the library of shared user macros.

Be careful when installing user macros from unknown authors.

Hello World Example of User Macro

This page tells you how to create a user macro that displays the text 'Hello World!' and any text that the user places in the body of the macro. For full details about creating a user macro, see the guide to writing user macros.

Defining the 'Hello World' user macro

To create the 'Hello World' user macro:

1. Choose Browse > Confluence Admin.
2. Choose **User Macros** in the left-hand panel.
3. Choose **Create a User Macro** at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - **Macro Name**: helloworld
   - **Visibility**: Visible to all users in the Macro Browser
   - **Macro Title**: Hello World
   - **Description**: Displays "Hello World" and the macro body.
   - **Categories**: Confluence Content
   - **Icon URL**: You can leave this field empty.
   - **Documentation URL**: You can leave this field empty.
   - **Macro Body Processing**: Rendered
   - **Template**:

```
## @noparams
Hello World!
$body
```
5. Choose **Save**.

**Related pages:**
- [Writing User Macros](#)
- [Guide to User Macro Templates](#)
- [Examples of User Macros](#)

⚠️ **The information on this page does not apply** to Confluence OnDemand.

**Screenshot: Defining the 'Hello World' user macro**
Create User Macro

Macro Name: helloworld

Macro Browser Information

Visibility: Visible to all users in the Macro Browser

Macro Title: Hello World

Description: Displays "Hello World" and the macro body.

Definition of User Macro

Macro Body Processing:
- No macro body
- Escaped
- Unrendered
- Rendered

Template:

```
@{noparams}
Hello World!
$body
```

Using the 'Hello World' macro on a page

Now you can add the macro to your Confluence page using the Macro Browser:
The result is:

![Testing the Hello World macro]

You can also use autocomplete to add the macro onto your page: start typing '{hello' in the editor, and select the 'Hello World' macro from the list of suggestions that appears.

**Error Box Macro - Example of a User Macro**

Let's write a simple macro that creates a red box (using an existing Confluence style) around some text. This may be useful for writing about error conditions, for example. For full details about creating a user macro, see the guide to [writing user macros](#).

**Defining the 'Error' user macro**

**To create the 'Error' user macro:**

1. Choose **Browse > Confluence Admin**.
2. Choose **User Macros** in the left-hand panel.
3. Choose **Create a User Macro** at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - **Macro Name**: error
   - **Visibility**: Visible to all users in the Macro Browser
   - **Macro Title**: Error
   - **Description**: Displays a red box around some text
   - **Categories**: Confluence Content
   - **Icon URL**: You can leave this field empty.
Using the 'Error' macro on a page

To add the macro to a page, edit the page and choose Insert > Other Macros and find the 'Error' macro. (Or use autocomplete: start typing '{err' in the editor, and select the 'Error' macro from the list of suggestions that appears.)

Your page will display an error box, like this:

(Write your error message here.)

Colour and Size Macro - Example of a User Macro

This example demonstrates how you can pass parameters into your macro. Let's say you want to write your own font colour macro, with a parameter allowing the user to specify the colour. Then perhaps you want to add another parameter, that allows the user to specify the font size.

For full details about creating a user macro, see the guide to writing user macros.

Defining the 'Colour' user macro

This example uses a single parameter.

To create the 'Colour' user macro:

1. Choose Browse > Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: colour
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: Colour
   - Description: Colours a block of text
   - Categories: Confluence Content
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Rendered
   - Template:
5. Choose **Save**.

### Related pages:
- [Writing User Macros](#)
- [Guide to User Macro Templates](#)
- [Examples of User Macros](#)

> The information on this page does not apply to Confluence OnDemand.

### Using the 'Colour' macro on a page

To add the macro to a page, edit the page and choose **Insert > Other Macros** and find the 'Colour' macro. (Or use autocomplete: start typing '{colo' in the editor, and select the 'Colour' macro from the list of suggestions that appears.)

#### Defining the 'Stylish' user macro

If your macro requires more than one parameter, you can use variables $param0 to $param9 to represent them. Let's say that you want to add a parameter that allows the user to specify the size of the text.

Enter the macro attributes as follows:

- **Macro Name**: stylish
- **Visibility**: Visible to all users in the Macro Browser
- **Macro Title**: Stylish
- **Description**: Applies colour and size to text
- **Categories**: Confluence Content
- **Icon URL**: You can leave this field empty.
- **Documentation URL**: You can leave this field empty.
- **Macro Body Processing**: Rendered
- **Template**:

  ```html
  ## @param 0:title=colour|type=string
  ## @param 1:title=size|type=string
  <span style="color: $param0; font-size: $param1">$body</span>
  ```

#### Naming your parameters

Alternatively, you can also use explicitly-named parameters in your macro. These macro parameters will appear as variables with the name $param<x> where <x> is the name of your parameter.

```html
## @param Colour:title=colour|type=string
## @param Size:title=size|type=string
<span style="color: $paramColour; font-size: $paramSize">$body</span>
```
NoPrint Example of a User Macro

This page gives an example of a user macro, the 'NoPrint' macro, that you can use to prevent text from being printed. For full details about creating a user macro, see the guide to writing user macros.

Defining the 'NoPrint' user macro

To create the 'NoPrint' user macro:

1. Choose Browse > Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: noprint
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: NoPrint
   - Description: Hides text from printed output.
   - Categories: Confluence Content
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Rendered
   - Template:

```
## @noparams
<div class="noprint">$body</div>
```

5. Choose Save.

Related pages:
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

The information on this page does not apply to Confluence OnDemand.

Using the 'NoPrint' Macro on a page

Now you can add the macro to your Confluence page using the Macro Browser. Text entered into the body of the macro placeholder will not be printed, but will appear when the page is viewed online.

Making the PDF export recognise the NoPrint macro

See Advanced PDF Export Customisations.

Panel Preformatted with Specific Colours - Example of a User Macro

This user macro creates a panel pre-formatted to specific colours. It will create a panel that looks like this:
Defining the 'Formatted Panel' user macro

1. Choose Browse > Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: formpanel
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: Formatted Panel
   - Description: Creates a panel preformatted with specific colours
   - Categories: Formatting
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Escaped
   - Template:

```
## @param Title:title=Title|type=string|desc=Title
<ac:macro ac:name="panel">
  <ac:parameter ac:name="titleBGColor">#ccc</ac:parameter>
  <ac:parameter ac:name="borderStyle">solid</ac:parameter>
  <ac:parameter ac:name="borderColor">#6699CC</ac:parameter>
  <ac:parameter ac:name="borderWidth">2</ac:parameter>
  <ac:parameter ac:name="titleColor">#000000</ac:parameter>
  <ac:parameter ac:name="title">$!paramTitle</ac:parameter>
  <ac:rich-text-body>$body</ac:rich-text-body>
</ac:macro>
```

5. Choose Save.

Explanation of the code in the macro template

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@param Title:title=Title</td>
<td>Description</td>
</tr>
<tr>
<td>&lt;ac:macro ac:name=&quot;panel&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;titleBGColor&quot;&gt;#ccc&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;borderStyle&quot;&gt;solid&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;borderColor&quot;&gt;#6699CC&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;borderWidth&quot;&gt;2&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;titleColor&quot;&gt;#000000&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;ac:parameter ac:name=&quot;title&quot;&gt;$!paramTitle&lt;/ac:parameter&gt;</td>
<td></td>
</tr>
<tr>
<td><a href="">ac:rich-text-body</a>$body&lt;/ac:rich-text-body&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Note: The panel's title will be empty if the user does not give a value for the title parameter.

Related pages:
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

⚠️ The information on this page does not apply to Confluence OnDemand.
### @param

Title:title=Title|type=string|desc=Title

@param defines the metadata for your macro parameters. When users select this macro, the macro will contain a parameter called "Title" where they can enter data. A macro dialog window appears when the user selects this macro using **Insert > Other Macros** or when a user clicks the macro placeholder and chooses **Edit**. The macro will, later on, use the data stored in this parameter to enter data in the title section of the Panel macro.

@param Title

This parameter is called "Title".

title=Title

defines the parameter title that will appear in the macro dialog window as "Title".

type=string

defines the field type for the parameter as a text field.

desc=Title

defines the description of the parameter.

```xml
<ac:macro ac:name="panel">
```

This command activates the Confluence **Panel** macro.

Hint: To discover the code name of a Confluence macro, see **Confluence Storage Format for Macros**. If the macro you want is not documented there, follow these steps:

1. Create and save a page containing a Confluence macro you want to investigate.
2. Choose **Tools > View Storage Format**. This option is available to Confluence administrators only, and shows the XML source code for the page. (See **Confluence Storage Format**.)
3. A Confluence macro starts with the following string: `<ac: macro ac:name=```
Sets the parameters for the macro: the background colour, border style, border colour, border width and title colour.

Hint: To discover the names of the parameters for a Confluence macro, see Confluence Storage Format for Macros. If the macro you want is not documented there, follow these steps:

1. Create and save a page containing a Confluence macro you want to investigate.
2. Choose Tools > View Storage Format. This option is available to Confluence administrators only, and shows the XML source code for the page. (See Confluence Storage Format.)
3. The macro parameters start with the following string: <ac:parameter ac:name="paramName"

Enters the value stored in the 'Title' parameter into the title section of the macro.

The ! tells the macro to leave the title blank, when there is no data in the "Title" parameter.

Users can enter data that is stored in the body of the macro. This line enables the macro to access and store the body content passed to your macro.

This command marks the end of the macro.

Preformatted Table - Example of a User Macro

This user macro creates a 2 x 2 table, with the headings defined as 'Parameter' and 'Description'. It will create a table that looks like this:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: As the macro is written, the user cannot amend the heading titles when using the macro on a Confluence page.

Related pages:
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

⚠️ The information on this page does not apply to Confluence OnDemand.

Defining the 'Formatted Table' user macro

1. Choose Browse > Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
- Macro Name: formtable
- Visibility: Visible to all users in the Macro Browser
- Macro Title: Formatted Table
- Description: Creates a simple 2 x 2 table with the column headings filled in
- Categories: Formatting
- Icon URL: You can leave this field empty.
- Documentation URL: You can leave this field empty.
- Macro Body Processing: Escaped
- Template:

```
## @param Head1:type=string|desc=Heading
## @param Head2:type=string|desc=Heading
## @param Cell1:type=string|desc=cell
## @param Cell2:type=string|desc=cell
#set ($paramHead1 ="Parameter")
#set ($paramHead2 ="Description")

<div id="preformattedtable">
<table>
<tr>
<th>$paramHead1</th>
<th>$paramHead2</th>
</tr>
<tr>
<td>$!paramCell1</td>
<td>$!paramCell2</td>
</tr>
</table>
</div>
```

5. Choose **Save**.

*Using the macro on a Confluence page*

**To add the macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the ‘Formatted Table’ macro.
3. Enter the cell contents into the form.
4. Choose **Insert**.

**Amending the contents of the table**

To change the content in the cells of the table:

1. Edit the page.
2. Click the macro placeholder for the ‘Formatted Table’ macro, to see the properties panel.
3. Choose **Edit**.
4. Enter the cell contents into the form.
5. Choose **Save**

*Note:* Content entered into the body of the ‘Formatted Table’ macro will not appear on the page.

*Guide to User Macro Templates*

You write a user macro in a screen in the Confluence Administration Console. The ‘template’ is one of the fields
that you define when writing a user macro. (See the rest of the guide to writing user macros.) This page gives you guidelines about the code you can enter in a user macro template.

Quick guide to user macro templates:

- Use HTML and Confluence-specific XML elements in the macro template. Details of Confluence's storage format are in Confluence Storage Format.
- You can use the Velocity templating language. Here is more information on the Velocity project.
- If your macro has a body, your template can refer to the macro body text by specifying "$body".
- Each parameter variable you use must have a matching metadata definition. Use @param to define metadata for your macro parameters.
- When using the information passed using parameters, refer to your parameters as $paramXXX where 'XXX' is the parameter name that you specified in the @param metadata definition.
- Use @noparams if your macro does not accept parameters. Note that this will prevent your macro appearing in the macro browser.

On this page:

- Accessing your Macro's Body
- Using Parameters in your User Macro
- Objects Available to your Macro
- Controlling Parameter Appearance in the Editor Placeholder
- Related Topics

⚠️ The information on this page does not apply to Confluence OnDemand.

Accessing your Macro's Body

Use the $body object within your user macro template to access the content passed to your macro in the macro body.

The $body object is available if you have specified that your macro has a body (in other words, if you have not selected No macro body).

Example: Let's assume your macro is called helloworld.

Enter the following code in your template:

```
Hello World: $body
```

A user, when editing a Confluence page, chooses your macro in the Macro Browser and then enters the following in the macro placeholder that is displayed in the edit view:

```
From Matthew
```

The wiki page will display the following:

```
| Hello World: From Matthew |
```

Using Parameters in your User Macro

You can specify parameters for your macro, so that users can pass it information to determine its behaviour on a
How your Macro's Parameters are Used on a Confluence Page

When adding a macro to a Confluence page, the Macro Browser will display an input field for each of your macro's parameters. The field type is determined by the parameter type you specify for each parameter.

Defining the Parameters

Briefly, a parameter definition in the template contains:

- @param
- The parameter name
- A number of attributes (optional)

Format:

```
## @param MYNAME:title=MY TITLE|type=MY TYPE|desc=MY DESCRIPTION|required=true|multiple=true|default=MY DEFAULT VALUE
```

Additional notes:

- The order of the parameters in the template determines the order in which the Macro Browser displays the parameters.
- We recommend that you define the parameters at the top of the template.
- There may be additional attributes, depending on the parameter type you specify.

The sections below describe each of the attributes in detail.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
<th>Required / Recommended / Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>(an unnamed, first attribute)</td>
<td>A unique name for the parameter. The parameter name is the first attribute in the list. The name attribute itself does not have a name. See the section on name below.</td>
<td>Required</td>
</tr>
<tr>
<td>title</td>
<td>The parameter title will appear in the Macro Browser. If you do not specify a title, Confluence will use the parameter name.</td>
<td>Recommended</td>
</tr>
<tr>
<td>type</td>
<td>The field type for the parameter. See the section on type below.</td>
<td>Recommended</td>
</tr>
<tr>
<td>desc</td>
<td>The parameter description will appear in the Macro Browser.</td>
<td>Optional</td>
</tr>
<tr>
<td>required</td>
<td>Specifies whether the user must enter information for this parameter. Defaults to 'false'.</td>
<td>Optional</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>multiple</td>
<td>Specifies whether the parameter accepts multiple values. Defaults to ‘false’.</td>
<td></td>
</tr>
<tr>
<td>default</td>
<td>The default value for the parameter.</td>
<td></td>
</tr>
</tbody>
</table>

### Parameter Name

The parameter name is the first attribute in the list. The name attribute itself does not have a name.

**Example:** The following code defines 2 parameters, named ‘foo’ and ‘bar’:

```markdown
## @param foo
## @param bar
```

### Parameter Type

The field type for the parameter. If you do not specify a type, the default is string.

<table>
<thead>
<tr>
<th>Parameter Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Displays a checkbox to the user and passes the value ‘true’ or ‘false’ to the macro as a string.</td>
</tr>
</tbody>
</table>
| enum           | Offers a list of values for selection. You can specify the values to appear in a dropdown in the Macro Browser. Example of specifying the enum values:

```markdown
## @param
colour:title=Colour|type=enum
|enumValues=Grey,Red,Yellow,Green
```

*Note about i18n:* Confluence does not support internationalisation of the enum values. The value the user sees is the one passed to the macro as the parameter value, with the capitalisation given. In this case ‘Grey’, ‘Red’, etc.
<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string</td>
<td>A text field. This is the default type. Example with a required field:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>## @param status:title=Status</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td>confluence-content</td>
<td>Offers a control allowing the user to search for a page or blog post. Example:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>## @param page:title=Page</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td>username</td>
<td>Search for user.</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>## @param user:title=Username</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td>spacekey</td>
<td>Offers a list of spaces for selection. Passes the space key to the macro.</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>## @param space:title=Space</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td>date</td>
<td>Confluence accepts this type, but currently treats it in the same way as 'string'. Example:</td>
</tr>
<tr>
<td></td>
<td>```</td>
</tr>
<tr>
<td></td>
<td>## @param fromDate:title=From Date</td>
</tr>
<tr>
<td></td>
<td>Note about dates: A user can enter a date in any format, you should validate the date format in your user macro.</td>
</tr>
</tbody>
</table>
### int

Confluence accepts this type, but currently treats it in the same way as 'string'. Example with a default value:

```markdown
## @param
numPosts:title=Number of Posts|type=int|default=15|desc=Number of posts to display
```

### percentage

Confluence accepts this type, but currently treats it in the same way as 'string'. Example:

```markdown
## @param
pcent:title=Percentage|type=percentage|desc=Number of posts to display
```

---

**Using the Parameters in your Macro Code**

The parameters are available in your template as `$paramfoo`, `$parambar` for parameters named "foo" and "bar".

Normally, a parameter like `$paramfoo` that is missing will appear as '$paramfoo' in the output. To display nothing when a parameter is not set, use an exclamation mark after the dollar sign like this: `$!paramfoo`

**Using No Parameters**

If your macro does not accept parameters, you should use `@noparams` in your template. That will let Confluence know that it need not display a parameter input field in the Macro Browser.

If the user macro contains no parameters and does not specify `@noparams`, then the Macro Browser will display a free-format text box allowing users to enter undefined parameters. This can be confusing, especially if the macro does not accept parameters.

**Example:** Add the following line at the top of your template:

```markdown
## @noparams
```

---

**Objects Available to your Macro**

Including the macro body and parameters, the following Confluence objects are available to the macro:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Class Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>$body</td>
<td>The body of the macro (if the macro has a body)</td>
<td>String</td>
</tr>
</tbody>
</table>
$paramfoo, $parambar, ... $param<name> Named parameters ("foo", "bar") passed to your macro. String

$config The BootstrapManager object, useful for retrieving Confluence properties. BootstrapManager

$renderContext The PageContext object, useful for (among other things) checking $renderContext.outputType PageContext

$space The Space object that this content object (page, blog post, etc) is located in (if relevant). Space

$content The current ContentEntity object that this macro is a included in (if available). ContentEntityObject

Macros can also access objects available in the default Velocity context, as described in the developer documentation.

Controlling Parameter Appearance in the Editor Placeholder

A macro developer (or author of a user macro) can control which fields of the macro should appear in the placeholder in the Confluence Editor.

Plugin Macro Metadata

The macro metadata for a plugin macro now has parameter options as shown in the following example:

```xml
<macro name="panel" documentation-url="help.panel.macro">
  <category name="formatting"/>
  <parameters>
    <parameter name="title" type="string">
      <option key="showNameInPlaceholder" value="false" />  
      <option key="showValueInPlaceholder" value="true" />
    </parameter>
    <parameter name="borderStyle" type="string"/>
    <parameter name="borderColor" type="color"/>
  </parameters>
</macro>
```

The option showNameInPlaceholder specifies that in the above example the 'title' parameters name should not be shown.

The option showValueInPlaceholder specifies that the user entered value for this parameter should be shown.

So, for the above example, the macro placeholder could show something like 'panel | my panel title'. If showNameInPlaceholder was true instead of false it would show something like 'panel | title = my panel title'.

If a macro has neither option on any of it's parameters then the default behaviour is to show all parameters: full title and value. If one or more parameters has either option set then all parameters without the options set will default to false (i.e. will not be shown).

User Macro Metadata
The behaviour for a user macro is as described above, however the method of configuration is within the @param entry in the template. So, the example from above would look something like:

```html
## @param
title:type=string|option-showNameInPlaceholder=false|option-showValueInPlaceholder=true
```

Related Topics

* Writing User Macros
* Examples of User Macros

### Configuring the Office Connector

The Office Connector is a Confluence plugin that allows Confluence users to interact with Microsoft Office and Open Office in various ways. You can display content from Office documents on a wiki page and import content from an Office document into Confluence. Please refer to the User Guide for details of these interactions.

A **System Administrator** can enable or disable parts of the Office Connector and can configure options as described below.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enabling and Disabling the Office Connector and its Modules</strong></td>
</tr>
<tr>
<td><strong>Configuring the Office Connector Options</strong></td>
</tr>
<tr>
<td><strong>Related Topics</strong></td>
</tr>
</tbody>
</table>

⚠️ *The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.*

#### Enabling and Disabling the Office Connector and its Modules

The Office Connector is bundled with Confluence 2.10 and later, so you should not need to install it. But you may wish to enable or disable some of its modules.

A **System Administrator** can install, enable or disable plugins and plugin modules. You can read a general overview in *Installing Plugins and Macros*.

To enable or disable the Office Connector and its modules:

1. Select **Plugins**, under 'Configuration' in the left-hand panel of the Confluence Administration Console.
2. Click **Show system plugins** under 'System Plugins'.
3. Search the page for **Office Connector plugin** and select the link.
4. The 'Office Connector plugin' panel will appear near the top centre of the page, as shown in the screenshot below.
5. Now you can do one of the following:
   - **Configure plugin** – This will take you to the separate plugin configuration screen described below.
   - **Disable plugin** – Click this link if you want to disable all modules of the plugin, but leave the plugin installed on your Confluence site.
   - **Uninstall plugin** – Click this link if you want to remove the Office Connector permanently from your Confluence site. To restore it at a later date, you will need to re-install it from the Confluence Plugin Repository.
   - **Manage plugin modules** – You can also enable or disable one or more of the Office Connector modules, as described in the table below.
**Screenshot: Enabling the Office Connector plugin and its modules**

![Office Connector plugin](image)

This is the `com.atlassian.confluence.plugins.jira-office-connector` plugin for Atlassian Confluence.

**Module Description**

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC Settings Manager</td>
<td>Component to read and write persistent settings for the Office Connector.</td>
</tr>
<tr>
<td>Slide Cache Manager</td>
<td>Component to cache slide-based conversions when displaying PowerPoint and PDF documents.</td>
</tr>
<tr>
<td>Html Cache Manager</td>
<td>Component to cache HTML-based conversions when displaying Word and Excel documents.</td>
</tr>
<tr>
<td>File Cache Cleanup Job</td>
<td>This module is a recurring task that cleans up the Office Connector file cache.</td>
</tr>
<tr>
<td>File Cache Cleanup</td>
<td>This module is the trigger for the File Cache Cleanup Job.</td>
</tr>
<tr>
<td>Office Connector administration link</td>
<td>This module supplies the 'Office Connector Configuration' link in the left-hand panel of the Confluence Administration Console. The link gives access to the plugin configuration screen described below.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Link for previewing a search result</td>
<td>This module supplies the 'View' link which appears next to attachments displayed in search results, where the attachment is an Office document.</td>
</tr>
<tr>
<td>Link for previewing an attachment</td>
<td>This module supplies the 'View' link which appears next to attachments displayed on the 'Attachments' view of a page, where the attachment is an Office document.</td>
</tr>
<tr>
<td>viewfile</td>
<td>This module supplies the {viewfile} macro. See View File Macro.</td>
</tr>
<tr>
<td>viewdoc</td>
<td>This module supplies the Word document component of the {viewfile} macro.</td>
</tr>
<tr>
<td>viewxls</td>
<td>This module supplies the Excel document component of the {viewfile} macro.</td>
</tr>
<tr>
<td>viewppt</td>
<td>This module supplies the PowerPoint document component of the {viewfile} macro.</td>
</tr>
<tr>
<td>viewpdf</td>
<td>This module supplies the PDF document component of the {viewfile} macro.</td>
</tr>
<tr>
<td>editgrid</td>
<td>This module is used to migrate editgrid users to the Office Connector.</td>
</tr>
<tr>
<td>Import Word UI on page tabs</td>
<td>This module supplies a 'Doc Import' tab which appears in older versions of Confluence, next to the 'View', 'Edit', 'Attachments' and 'Info' tabs. Not relevant to Confluence 2.10 or later, except for custom themes.</td>
</tr>
<tr>
<td>Import Word UI on drop down menu</td>
<td>This module supplies the 'Doc Import' link which appears in the Confluence 'Tools' dropdown menu.</td>
</tr>
<tr>
<td>Edit in Office javascript resource</td>
<td>This module contains the javascript resources for launching the desktop applications for editing Office documents.</td>
</tr>
<tr>
<td>Office Connector Servlet</td>
<td>This module allows Confluence users to edit their Confluence pages in Microsoft Word. It performs the conversion to and from Word.</td>
</tr>
<tr>
<td>Office Authenticator Filter</td>
<td>This module authenticates HTTP requests from Office applications.</td>
</tr>
<tr>
<td>PPT slide web service</td>
<td>This module allows Confluence users to view a PowerPoint presentation on a wiki page. It provides the slide images to the Flash control which displays the slides on the wiki page.</td>
</tr>
</tbody>
</table>
DOC and XLS image cache web service

This module is required if Confluence users want to view a Word document or an Excel spreadsheet on a wiki page. It allows images to be stored in a cache on the server, so that they can be retrieved when the browser renders the HTML page.

Office Connector Actions

This module must be enabled if the Office Connector is used.

Configuring the Office Connector Options

A Confluence administrator can set the options described below, to determine the behaviour of the Office Connector on your Confluence site.

To set the configuration options for the Office Connector:

1. Select Office Connector under 'Configuration' in the left-hand panel of the 'Confluence Administration Console'. The 'Configure Office Connector plugin' screen will appear.
2. Set the configuration options as described in the table below.

**Screenshot: Configuring the Office Connector options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit in word button location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Warnings:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Formatting Options:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Authentication:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temporary storage for wvfile macro</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum file space for cache(MB)</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>Number of Conversion Queues</td>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>

The configuration options are described in the table below:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Default Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warnings: Show a warning before allowing a user to perform an import</td>
<td>Disabled</td>
<td>If this option is enabled, the user will receive a warning when importing a Word document. The warning will tell the user when they are about to overwrite existing content.</td>
</tr>
<tr>
<td>Advanced Formatting Options: Use the footnote macro for Word footnotes</td>
<td>Disabled</td>
<td>If this option is enabled, a Confluence page created from an imported Word document will use the (footnote) macro from Adaptavist to render any footnotes contained in the document. Note that you will need to install the Footnotes plugin onto your Confluence site. For more information about this plugin and macro, please refer to the Footnotes plugin.</td>
</tr>
<tr>
<td>Authentication: Allow authentication tokens in the URL path</td>
<td>Disabled</td>
<td>If this option is enabled, the Office Connector will use authentication tokens in the URL.</td>
</tr>
</tbody>
</table>
| Temporary storage for viewfile macro          | The Confluence Home directory. | The `{viewfile}` macro will cache data temporarily. This option allows you to set the location of the cache. Available settings are:  
  - **Confluence home directory** – The temporary file will be stored in your Confluence Home directory.  
  - **A directory specified in the directories.properties file** – You can specify a location by editing the Office Connector’s `directories.properties` file:  
    1. Go to the bundled-plugins directory in your Confluence Home directory.  
    2. Copy the Office Connector JAR file to a temporary location: `OfficeConnector-x.xx.jar`, where ‘x.xx’ is the version number. |
3. Unzip the JAR file and find the `directories.properties` file in the `resources` directory. The content of the file looks like this:

```properties
# Complete the following line to set a custom cache directory.
# If resetting to blank, don't delete anything before or including the '='
com.benhyan.confluence.word.edit.cacheDir=
```
4. Edit the last line, adding the path to your required temporary location directly after the '=' character. For example:

- On Windows:

```bash
com\be\nry\an\con\flu\ence\e.word\edit\cach\edir=c:\mypath\`
```

- On Linux:

```bash
com\be\nry\an\con\flu\ence\e.word\edit\cach\edir=/home/myusername/mypath
```
5. Save the file, recreate the JAR and put it in the bundled-plugins directory in your Confluence Home directory, overwriting the original JAR.

- Cache in-memory – The temporary file will be held in memory. We recommend this option if you are running in a clustered environment.

<table>
<thead>
<tr>
<th>Maximum file space for cache (MB)</th>
<th>500</th>
<th>This is the maximum size of the cache used by the {viewfile} macro. (See above.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Conversion Queues</td>
<td>6</td>
<td>This is the maximum number of threads used to convert PowerPoint or PDF slide shows. You can use this setting to manage Confluence performance, by limiting the number of threads so that the Office Connector does not consume too many resources. Click Manage Queues to view attachments that are still pending conversion.</td>
</tr>
</tbody>
</table>

Related Topics

Office Connector Prerequisites
Office Connector Limitations and Known Issues
Working with the Office Connector
Installing Plugins and Macros

Administration

- Viewing and Editing License Details
  - Reducing the User Count for your Confluence License
- Cache Statistics
- Confluence Data Directory Configuration
- Content Index Administration
- Finding Unused Spaces
- Important Directories and Files
  - Confluence Home Directory
  - Confluence Installation Directory
- Installing a Language Pack
- Site Backup and Restore
  - Production Backup Strategy
- Configuring Backups
  - User Submitted Backup & Restore Scripts
- Manually Backing Up the Site
- Restoring a Site
- Restoring a Space
- Changing the version of a space backup
- Restoring a Test Instance from Production
- Restoring Data from other Backups
- Retrieve file attachments from a backup
- Troubleshooting failed XML site backups
- Troubleshooting XML backups that fail on restore
- Migrating from HSQLDB to MySQL
- Rebuilding the Ancestor Table
- Viewing System Information
  - Live Monitoring Using the JMX Interface
  - Tracking Customisations Made to your Confluence Installation
  - Viewing Site Statistics
  - Viewing System Properties
- Installing Patched Class Files
- Finding Your Confluence Support Entitlement Number (SEN)

Viewing and Editing License Details

When you upgrade or renew your Confluence license, you will receive a new license key. You will need to update your Confluence installation with the new license key.

You can access your existing license key, or generate an evaluation license key, at [http://my.atlassian.com](http://my.atlassian.com).

Updating your license details in Confluence

To update your Confluence license:

1. If you do not already have a license key, get your existing license key, or generate an evaluation license key, at [http://my.atlassian.com](http://my.atlassian.com).
2. Log in to Confluence as a user with Confluence Administrator or System Administrator permissions.
3. Choose **Browse > Confluence Admin**.
4. Choose **License Details** in the left-hand panel.
5. Enter your new license details into the **License** field.
6. Choose **Save**.

If you are running a Confluence cluster, you will need to:

- Update each server's Confluence license separately.
- Ensure that the new license has enough nodes to cover all servers that are currently running in your cluster. To check the number of active servers in your cluster, see the [Cluster Administration page](#).

---

On this page:

- Updating your license details in Confluence
- Viewing your license details
- Understanding the user count for your Confluence license
- Downgrading your Confluence license to pay for fewer users

Related pages:

- Reducing the User Count for your Confluence License
- Managing Confluence Users
- Confluence Administrator's Guide
Screenshot: License details

This page shows your current licensing information. You can use the form below to update the license Confluence is running with.

<table>
<thead>
<tr>
<th>Organisation</th>
<th>Atlassian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Purchased</td>
<td>Feb 11, 2007</td>
</tr>
<tr>
<td>License Type</td>
<td>Confluence: Commercial Server</td>
</tr>
<tr>
<td>Licensed Users</td>
<td>500 (0 signed up currently)</td>
</tr>
<tr>
<td>Support Period</td>
<td>Your commercial Confluence support and updates are available until Feb 12, 2008.</td>
</tr>
<tr>
<td>Server ID</td>
<td>AACK-COIS-AACK-COIS (Atlassian sales or support may ask you to provide this ID)</td>
</tr>
</tbody>
</table>

Viewing your license details

To view the details of your Confluence license:

1. Log in to Confluence as a user with Confluence Administrator or System Administrator permissions.
2. Choose Browse > Confluence Admin.
3. Choose License Details in the left-hand panel.

The 'License Details' screen tells you:

- What type of license you have (for example: Commercial, Academic, Community, or Evaluation).
- How many users your Confluence site is licensed to support, and how many are currently registered (‘signed up currently’). See below for more about the user count. Choose Refresh button to make sure you see the latest count.
- How much time remains in your one-year support and upgrades period (for full licenses) or 30-day trial (for trial licenses).
- Your server ID, which:
  - is generated when you install Confluence for the first time
  - exists for the life of the Confluence installation
  - survives an upgrade
  - is held in the database
  - is not bound to a specific license
  - is the same for all servers in a cluster.

Understanding the user count for your Confluence license

The number of registered users allowed on your Confluence site may be limited, depending on your license type. See the licensing and pricing overview on the Atlassian website. If you have an 'unlimited' license, then the number of registered users is not significant.

The number of registered users is also called the 'user count' or the number of users 'signed up currently'. It is
Reducing the User Count for your Confluence License

This page tells you how to reduce the number of users that count towards your Confluence license. You may want to reduce your user count in Confluence if you have exceeded your license limit, or if you want to change to a lower-tier license to reduce costs.

Understanding the user count for your Confluence license

The number of registered users allowed on your Confluence site may be limited, depending on your license type. See the licensing and pricing overview on the Atlassian website. If you have an 'unlimited' license, then the number of registered users is not significant.

The number of registered users is also called the 'user count' or the number of users 'signed up currently'. It is determined as follows:

- It includes only those users who have the 'can use' global permission for the Confluence site. (See Global Permissions Overview for more about the 'can use' permission.)
- It does not include anonymous users, who may access your Confluence site if you have allowed anonymous access. (See Setting Up Public Access for more about allowing anonymous access.)
- It does not include deactivated users.

On this page:

- Understanding the user count for your Confluence license
- Reducing the user count

Reducing the user count

The recommended method for reducing your user count is to remove or deactivate the users. You can remove users who do not require access to Confluence and have never created content in Confluence. You can deactivate users who have created content but no longer require access to Confluence. See Removing or Deactivating Users.
Alternatively, if you have connected Confluence to an LDAP directory, you may want configure Confluence to synchronise a subset of users from LDAP rather than all users. This is described in the following knowledge base article: Changing the Number of Users Synchronized from LDAP to Confluence. This can be a complicated procedure and we recommend that you do not use this method unless necessary.

**Cache Statistics**

Confluence provides statistics about its internal caches that allow you to track the size and hit ratio of each cache and tune it for better performance (if necessary). See Performance Tuning for more information.

**Configurable Caches**

System administrators can change the sizes of Confluence's internal caches through the Administration Console and these changes will take effect without the need to first shut down and then restart Confluence. The maximum number of units for any of the defined cache regions can be adjusted individually.

Note that larger cache sizes will require more memory at runtime, so you should review the memory allocation of the Confluence Java process and the physical memory available on your server.

The information on this page does not apply to Confluence OnDemand.

**Viewing Cache Statistics and Modifying Cache Sizes**

To view the cache statistics:

1. Choose **Browse > Confluence Admin**.
2. Click **Cache Statistics** in the left-hand panel. There you will find a list of all objects cached within Confluence.
3. Click the **Advanced** tab for more detail. Below is an example for one of the most frequently used caches, the 'Content Object' cache.

<table>
<thead>
<tr>
<th>Name</th>
<th>Percent Used</th>
<th>Effectiveness</th>
<th>Objects / Size</th>
<th>Hit / Miss / Expiry</th>
<th>Adjust Size</th>
<th>Flush</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Object</td>
<td>80%</td>
<td>73%</td>
<td>4023 / 5000</td>
<td>374550 / 140460 / 55044</td>
<td>Adjust Size</td>
<td>Flush</td>
</tr>
</tbody>
</table>

About the generated numbers:

- **Percent Used**: 
  
  \[ \text{Percent Used} = \frac{\text{Objects}}{\text{Size}} \]

- **Effectiveness**: 
  
  \[ \text{Effectiveness} = \frac{\text{Hits}}{\text{Hits + Misses}} \]

- **Objects / Size**: 
  
  The number of entries in the cache / the number of total possible entries allowed (configurable).

- **Hit / Miss / Expiry**: 
  
  The number of reads accessing cache where required content was found / the number of reads accessing cache where required content was not found / the number of objects evicted from the cache.

- **Adjust Size**: 
  
  Use this option to specify a different maximum cache size. Enter a new cache size and click the **Adjust Size** button to set it.
Flush:

Flushes the cache.

For instance, to calculate **Percent Used**:

\[
\text{Percent Used} = \frac{\text{Objects}}{\text{Size}}
\]

\[
\text{Percent Used} = \frac{4023}{5000} = 80\%
\]

To calculate **Effectiveness**:

\[
\text{Effectiveness} = \frac{\text{Hits}}{\text{Hits} + \text{Misses}}
\]

\[
\text{Effectiveness} = \frac{374550}{374550 + 140460} = 73\%
\]

⚠️ The clustered versions of Confluence use distributed cache called Tangosol Coherence.

Watching the Cache Contents

To see the specific items in the caches, view the cache statistics at `<baseUrl>/admin/cachecontents.jsp`.

Additional Notes about Configurable Caches

Changes to cache size configurations persist across Confluence restarts as they are saved in the `<confluence-home>/config/ehcache.xml` file (or `<confluence-home>/config/confluence-coherence-cache-config-clustered.xml` for a clustered instance). In most cases, a Confluence administrator will never need to know about these files. However, if it is necessary to tune cache options other than the maximum cache size, this can be done by manually editing these files. See **Cache Performance Tuning** for details.

⚠️ Important note about clustered Confluence installations

The cache configuration file is stored in a home directory of each cluster node. When a Confluence administrator changes a cache size, all running cluster nodes will automatically update their own configuration files in their respective home directories. However, if a cluster node is not running when an administrator adjusts a cache size, the `/config/confluence-coherence-cache-config-clustered.xml` file in its home directory will not be updated. Since cluster caches are configured by the first node to start, if a node with an outdated cache configuration is the first to start up, the whole cluster would end up using the configuration of that node. However, copying this file from one node to another would resolve this issue.

Performance Tuning

If you need to tune your application when under high usage, you may like to review [this document](#) for suggestions.

**Related Topics**

No content found for label(s) system-information.
Confluence Data Directory Configuration

Here is a link listing important Confluence files.

The home directory defines the location of the directory where Confluence will store its data, including attachments, indexes and backups. Administrators can set this location by defining a value for the file <MY-INST ALL>/confluence/WEB-INF/classes/confluence-init.properties. To find what your home directory is currently set to, open this file and check the confluence.home property. It is unset on new installations.

⚠️ The information on this page does not apply to Confluence OnDemand.

Windows Configuration

On Windows, this path:

```
C:\confluence\data
```

will be written like so:

```
confluence.home=C:/confluence/data
```

Note that all backslashes (\) are written as forward slashes (/).

Linux/Solaris Configuration

On any Linux-based system, the property is defined using the normal directory syntax:

```
confluence.home=/var/confluence/
```

Symbolic links

If your confluence.home directory contains a symbolic link, you must define the absolute path.

⚠️ Please note that there can be no symbolic links within the confluence.home directory. If disk space is an issue, place the entire confluence.home directory on a disk partition where there is enough space.

The absolute path of generated files (such as exports) is compared with the absolute path of the confluence.home directory when constructing URLs. When a sub-directory has a different path, the URL will be incorrect, and you may receive "Page not found" errors. These measures are in place to prevent "directory traversal" attacks.

Fixing the Confluence Configuration

The Confluence configuration file: confluence-cfg.xml inside the home directory may contain references to the original location of your Confluence home. You will need to edit this file to update these references to also
point to the new location. The two properties in this file that need to change are:

- `daily.backup.dir` if you have not configured your backups to be placed elsewhere already
- `hibernate.connection.url` if you are using the embedded HSQL database.

**Content Index Administration**

The content indexes power Confluence's search functionality. They are also used for a number of related functions such as building email threads in the mail archive, the `space activity` feature and lists of recently-updated content. The [Gliffy plugin](https://confluence.atlassian.com/display/DOC/Gliffy+plugin) also uses them for some of its functionality.

For reasons of efficiency, Confluence does not immediately add content to the index. New and modified Confluence content is first placed in a queue and the queue is processed once every minute (by default).

**On this page:**

- Viewing the Content Index Summary
- Rebuilding the Content Indexes
- Slow Reindexing
- Viewing the Index Browser
- More Hints and Tips

⚠️ The information on this page does not apply to Confluence OnDemand.

**Viewing the Content Index Summary**

To see information about your Confluence instance's content indexing,

1. Choose Browse > Confluence Admin.
2. Click 'Content Indexing' under the heading 'Administration' in the left-hand panel.

*Screenshot: Index summary*
Rebuilding the Content Indexes

The content indexes are maintained automatically, but you may need to rebuild one or both of them manually under circumstances such as these:

- Your searching and mail threading are malfunctioning. (Rebuild the Search Index.)
- The Did You Mean feature is malfunctioning. (Rebuild the Did You Mean Index.)
- After an upgrade. If a content re-index is required after an upgrade, it will be noted in an upgrade subsection of the relevant Confluence Release Notes.

In new Confluence installations, the 'Did You Mean' feature is not initially activated. To activate it, you first need to build its index by clicking its 'Build' button on this page.

To rebuild either of the content indexes,

1. Choose Browse > Confluence Admin.
2. Click 'Content Indexing' under the heading 'Administration' in the left-hand panel.
3. Click the 'Rebuild' button in either the 'Search Index' or 'Did You Mean Index' sections on this page, depending on the particular index you want to rebuild.

- If one of these indexes has not yet been built, its button will indicate 'Build' instead of 'Rebuild).
- As shown in the image below, only one index can be (re)built at a time.

Screenshot: Content Indexing
Slow Reindexing

Does the reindexing take a long time to complete? The length of time depends on the following factors:

- Number of pages in your Confluence instance.
- Number, type and size of attachments.
- Amount of memory allocated to Confluence.

It may help to increase the heap memory allocation of Confluence by following the instructions in the JIRA documentation.

If you are running an older version of Confluence and find that the index rebuild is not progressing, you may need to shut down Confluence, and restart it with the following Java system property set: `bucket.indexing.threads.fixed=1`. This will cause the re-indexing to happen in a single thread and be much more stable (but slower).

Viewing the Index Browser

Confluence uses a search engine called Lucene. If you need to see more details of the indexed pages in your Confluence site, you can download and run Luke. Luke is a development and diagnostic tool that accesses existing Lucene indexes and allows you to display and modify their content in several ways.

Start Luke and use it to open the `index` directory, located in your Confluence Home directory. For example: `c:\confluence\data\confluence-home\index`.

More Hints and Tips

- If you are still experiencing problems after performing the above rebuild, the next step might be to remove the index and rebuild it from scratch.
  - The space activity feature uses the index to store data. If you remove the index file, the existing activity data will disappear.
  - A tip for the development community: If you have the Confluence source, you can look for references to the SmartListManager to find the screens and lists that rely on the content index.
Finding Unused Spaces

Sometimes, you want to know what is not being used. It's great to know what's getting most attention, but what about stagnant pages, or even entire spaces that are no longer active?

While viewing space activity can provide hints, it doesn't always provide enough detail. The simple way is to go directly to the database. We recommend DbVisualizer, and have basic instructions for connecting it to HSQLDB.

The following query identifies the last date on which content was modified in each space within a single Confluence instance:

```
SELECT spaces.spacename, MAX(content.lastmoddate)
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY spaces.spacename;
```

It returns a list of spacenames, and the last date and time at which any content was added or changed.

The information on this page does not apply to Confluence OnDemand.

Alternatively, this one simply identifies spaces whose content hasn't changed since a specified date:

```
SELECT spaces.spacename
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY spaces.spacename
HAVING MAX(content.lastmoddate) < '2006-10-10';
```

The result is a simple list of space names.

It's also possible to present the information in a wiki page, using the SQL plugin, which can be installed using the Plugin Exchange. You'll also need to define a database resource in conf/server.xml and confluence/WEB-INF/web.xml, as described here. Having done so, you can use wiki markup code like the following, replacing confluenceDS with the name of your own local datasource:

```
{sql: dataSource=confluenceDS|output=wiki}
SELECT spaces.spacename AS Space, MAX(content.lastmoddate) AS LastModified
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY Space;
{sql}
```
The result will be something like this:

<table>
<thead>
<tr>
<th>space</th>
<th>lastmodified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private Space</td>
<td>2007-10-11 11:34:04.914</td>
</tr>
</tbody>
</table>

You can try the Chart plugin in combination with the SQL plugin to give more visually attractive results.

**Important Directories and Files**

**The Installation Directory**

The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

**Important Files and Directories**

- **confluence/WEB-INF/classes/confluence-init.properties**: This file tells Confluence where to find the Confluence Home Directory. This file is modified by the administrator when installing Confluence.
- **confluence/WEB-INF/classes/osuser.xml**: This file is modified when connecting Confluence to an external user management system such as an LDAP server or JIRA instance in Confluence 2.0 and earlier. For more information, refer to Managing Confluence Users.
- **confluence/WEB-INF/classes/atlassian-user.xml**: This file is modified when connecting Confluence to an external user management system such as an LDAP server or Crowd. For more information, refer to Managing Confluence Users.
- **confluence/WEB-INF/lib/**: This directory is used when deploying plugins, especially those plugins that cannot automatically be loaded through the Administration Console.
- **confluence/WEB-INF/classes/log4j.properties**: Confluence's logging configuration file. See Working with Confluence Logs.
- **confluence/WEB-INF/classes/ehcache.xml**: This is where you can configure the size of Confluence's internal caches
- **confluence/WEB-INF/classes/styles/site-css.vm**: Confluence's main stylesheet, modify at your own risk
- **conf/server.xml**: SSL configuration.

**Memory Settings**

The file used to edit JAVA_OPTS memory settings will depend on the method used to install Confluence, as well as the operating system used for your installation.

- **Windows Users**
  - Confluence — bin/setenv.bat
  - Confluence Installer — wrapperwin32.conf
- **Mac/Linux Users**
  - Confluence — bin/setenv.sh
  - Confluence Installer — wrapperosx.conf

⚠️ The information on this page does not apply to Confluence OnDemand.

**The Temp Directory**
The temp directory is configured in the Java runtime and some Confluence components write temporary files or lockfiles into this directory.

For EAR/WAR installations typically, this directory is /tmp on Linux systems, or C:\Temp on Windows.

For Standalone installations the temp directory is located in the installation directory as /temp.

To change the location of this directory, start the Java Virtual Machine in which confluence is running with the argument:

-Djava.io.tmpdir=/path/to/your/own/temp/directory.

**The Confluence Home Directory**

The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'.

Administrators can expect the Confluence Home Directory to grow quite large in a busy site.

The location of this directory is configured by the system administrator during installation (see confluence-init.properties above).

**Important Files and Directories**

- **confluence.cfg.xml**: Confluence's core configuration file; includes the configuration for connecting to its database.
- **default-formatting.properties**: Some auxiliary configuration data concerning default number and date formats.
- **attachments/**: All file attachments in the Confluence site are stored under this directory. This is the only place Confluence keeps attachment files.
- **backups/**: If Confluence is configured to produce daily backups, these are kept in this directory. Administrators should occasionally delete old or unwanted backups from this directory to prevent it from growing too large.
- **config/**: Miscellaneous global and per-space configuration files are kept in this directory.
- **database/**: If Confluence is being run from the embedded HSQL database, the database files will be kept in this directory.
- **index/**: The full-text search index is kept in this directory. Removing or modifying files in this directory may cause search to no longer function. Rebuilding the search index from Confluence's global administration screen will completely regenerate the contents of this directory.
- **plugins/**: Dynamically uploaded plugins are stored in this directory. Administrators can install new plugins by copying them into this directory and triggering a scan from the plugin management page.
- **temp/**: Confluence stores temporary files in this directory, especially during backups and exports. A daily job within Confluence deletes files that are no longer needed.
- **thumbnails/**: Stores temporary files for image thumbnails. The contents of this directory can be safely deleted, as Confluence will regenerate thumbnails as required.
- **velocity/**: Storage for customised page layouts, globally and per-space.

**Database**

All other data — page contents, links, archived mail and so on — is kept in the database. If you have configured Confluence to use the embedded HSQL database, the database will store its files under database/ in the Confluence Home Directory. Otherwise, the database management system you are connecting to is responsible for where and how your remaining data is stored.
Tip

All of Confluence's persistent data is stored either in the Confluence Home Directory, or the database. If you have backup copies of both of these, taken at the same time, you will be able to restore Confluence from them (see Restoring Data from other Backups).

RELATED TOPICS

Confluence Home Directory
Confluence Installation Directory
The Embedded HSQLDB Database
Database Configuration

Confluence Home Directory

Often in the documentation, you'll see a reference to the 'Confluence Home directory'.

What is the Confluence Home Directory?
The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'.

⚠️ The information on this page does not apply to Confluence OnDemand.

Finding the Confluence Home Directory

The location of the Confluence Home directory is defined when you install Confluence. This location is stored in a configuration file called confluence-init.properties, which is located inside the confluence/WEB-INF/classes directory in your Confluence Installation directory.

When Confluence first starts up, it reads the confluence-init.properties file to determine where to look for the Home directory.

Once Confluence is running you can find the Confluence Home directory via the Administration console, under Administration > System Information > Confluence Information - Confluence Home.

Content of the Confluence Home Directory

The Confluence home directory contains some of the configuration data used by Confluence. Other data is stored in the database. This section outlines the purpose of the files and directories in the Confluence home directory.

confluence.cfg.xml

This file contains all of the information necessary for Confluence to start up, such as:

- Product license
- Context path
- Database details, such as location and connection pool settings
- Paths to important directories

attachments

This directory contains every version of each attachment stored in Confluence. This directory is not used when
Confluence is configured to store attachments in the database. Attachments are always stored in the database in clustered instances of Confluence.

Paths within this directory have the following structure:

```
/attachments/PAGE_ID/ATTACHMENT_ID/VERSION
```

You can specify an alternative directory for attachment storage by setting the `attachments.dir` property in `confluence.cfg.xml`.

**backups**

Confluence will place its daily backup archives in this directory, as well as any manually generated backups. Backup files in this directory take the following form:

```
daily-backup-YYYY_MM_DD.zip
```

You can specify an alternative directory for backups by setting the `daily.backup.dir` property in `confluence.cfg.xml`.

**bundled-plugins**

Confluence ships with a set of bundled plugins. These are plugins written by the Atlassian and the Confluence community that we think provide useful and broadly applicable functionality in Confluence. The `bundled-plugins` directory is where Confluence will unpack its bundled plugins when it starts up. This directory is refreshed on every restart, so removing a plugin from this directory will not uninstall the plugin. It will simply be replaced the next time Confluence starts up.

**database**

This is where Confluence stores its database when configured to run with the HSQL embedded database. In such cases this directory contains all Confluence runtime data. Installations configured to run using an external database such as MySQL will not use this directory.

**index**

This is where Confluence stores its indexes for rapid retrieval of often used data. The Confluence index is used heavily by the application for content searching and recently updated lists and as such is critical for a running Confluence instance. It is important to note however that should the data in this directory be lost or corrupted, it can be restored by running a full reindex from within Confluence. This can take a long time depending on how much data is stored Confluence’s database.

An alternative directory may be specified for the index by setting the `lucene.index.dir` property in `confluence.cfg.xml`. As this is the most heavily accessed directory in the Confluence home directory you might want to consider hosting it on the fastest disk available. It would also be useful if the disk holding the Confluence index was not heavily used by any other application to reduce access contention.

**plugin-cache**

All Confluence plugins are stored in the Confluence database. To allow for quicker access to classes contained within the plugin JARs, Confluence will cache these plugins in the `plugin-cache` directory. This directory is updated as plugins are installed and uninstalled from the system and is completely repopulated from the database every time Confluence is restarted. Removing plugins from this directory does not uninstall them.
resources

The `resources` directory stores any space logos used in your Confluence instance. For each space with a space logo, there is a directory within `resources` named after the space's key. That directory contains the space's logo.

temp

The `temp` directory is used for various runtime functions such as exporting, importing, file upload and indexing. As the name suggests, and file in this directory is of temporary importance and is only used during runtime. This directory can be safely emptied when Confluence is offline.

An alternative directory may be specified for temporary data by setting the `webwork.multipart.saveDir` property in `confluence.cfg.xml`.

thumbnails

When Confluence generates a thumbnail of an image (for example when the `gallery` macro is used), the resulting thumbnail is stored in this directory for quicker retrieval on subsequent accesses. This directory is essentially a thumbnail cache, and deleting files from this directory simply means the thumbnail will have to be regenerated on the next access.

RELATED TOPICS

Confluence Installation Directory
Important Directories and Files
The Embedded HSQLDB Database

Confluence Installation Directory

The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

⚠️ The information on this page does not apply to Confluence OnDemand.

RELATED TOPICS

Confluence Home Directory
Important Directories and Files

Installing a Language Pack

Confluence ships with a number of bundled language packs. These languages appear as options on the 'Language Configuration' screen in the Administration Console when choosing a default language and as 'Language' options for users in their user settings. You can make additional languages available for selection by installing language packs. Please note, you must be a Confluence administrator to install a language pack.

Language packs are plugins. The process of installing a language pack is the same as installing a new plugin.

⚠️ The information on this page does not apply to Confluence OnDemand.

Installing a Language Pack using the Plugin Manager

To install a language pack using the plugin manager:

1. Click 'Plugins' in the Confluence Administration Console.
2. Click 'Install'.
3. Locate the language pack and install it via the plugin manager interface.

**Installing a Language Pack Manually**

To install a language pack manually, you will need to upload the language pack plugin as described below. The language pack plugin will be enabled by default once you have installed it.

Plugins are distributed as a jar file. To install a plugin:
1. In the 'Administration' section of Confluence, click **Plugins**.
2. Use **Browse** to find the plugin jar you wish to install from your hard drive or network location, and select it.
3. Click **Upload**.
4. The plugin will be uploaded to Confluence and will be automatically installed.
5. Check the 'Plugin Administration' screen to ensure that the plugin is available.
6. Enable the plugin if necessary. (Some plugins will be enabled by default when they are installed. Others will have to be manually enabled from the 'Plugin Administration' screen.)

**Finding more Language Packs**

- You can download official language packs from the [Atlassian Plugin Exchange](https://plugins.atlassian.com). You can also download language packs developed by the Confluence user community from the [Language Pack Translations page](https://translations.atlassian.com).

**Showing User Interface Key Names for Translation**

For those customers working on creating translations of the Confluence user interface, from 4.1 onwards there is a feature that will help. After opening the Confluence dashboard, you can simply add this text to the end of your Confluence URL, like so:

```
?i18ntranslate=on
```

Then press Enter.

This will then cause each element of the user interface to display its special **key name** while Confluence is still in an interactive mode. This makes it easier to find the essential context for each key, which can then be searched on [http://translations.atlassian.com](http://translations.atlassian.com) where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a "lightning bolt" graphic between elements of the names. For example, the buttons will show up with elements shown like so:

```
Dashboard\title, dashboard
```

For example, for the **Browse** button, the associated key **system.space.menu** can be found on [http://translations.atlassian.com](http://translations.atlassian.com), allowing you to write a better translation for the term **Browse**, being able to see the full context of where the UI element belongs and what it means to the user.

To turn off the translation view, add this code to the end of the Confluence URL:
RELATED TOPICS

Choosing a Default Language
Configuring Indexing Language
Installing a Plugin

Site Backup and Restore

Atlassian suggests establishing a backup strategy using a native database tool for a production instance of Confluence.

By default, Confluence backs up all data and attachments once a day to a backup file. These files are called XML site backups, and are stored in the backups directory of Confluence home. You can also create XML site backups manually. This mechanism is intended for small to medium-sized deployments of Confluence. It is not intended for use with large deployments with lots of pages and attachments (see below).

- Restore your site from an XML site backup
- Manually create an XML site backup
- Configuring Backups
- User Submitted Backup & Restore Scripts

XML site backups are fine for most small to medium-sized instances of Confluence, containing a few thousand pages and attachments. However, large instances of Confluence may find that backups become slow to create and use large amounts of disk space.

The information on this page does not apply to Confluence OnDemand.

Backups For Large Instances

XML site backups are unsuitable for instances of Confluence that contain thousands of pages, as XML backups take progressively longer to complete as the amount of text increases. Another issue with XML site backups is that Confluence instances with gigabytes of attachments will consume disk space rapidly. This is because each site backup contains all content needed for a site restore. For example, if a 1 GB instance of Confluence is backed up daily, it will create 30 GB of backups per month if left unattended. When administering a large instance, you can reduce disk space by setting XML site backups to exclude attachments, then manually scheduling a backup of your attachments from the Confluence home directory or database. The backup manager can save space by saving changed files instead of all content.

<table>
<thead>
<tr>
<th>Creation Delay</th>
<th>Disk Usage</th>
<th>Recommended Backup Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptable</td>
<td>Acceptable</td>
<td>XML site backup with attachments</td>
</tr>
<tr>
<td>Acceptable</td>
<td>Unacceptable</td>
<td>XML site backup minus attachments, plus manual backup of attachments</td>
</tr>
<tr>
<td>Unacceptable</td>
<td>Unacceptable</td>
<td>Manual backup of database and attachments</td>
</tr>
</tbody>
</table>
**Creation Delay** is the time it takes to create an XML site backup *minus attachments*. **Disk Usage** can be estimated by multiplying the frequency of your XML site backups by their current size.

**Manual Backups**

Confluence's [Attachment Storage Configuration](https://confluencelassian.readthedocs.io/) can be set to store attachments in the Confluence home directory, or in the database.

**Database Backup**

Use your Database Administration Tool to create a backup of your Confluence database. If your database is storing your attachments, importing this later will restore all content. For instances with big attachments, please note that currently Confluence migrate attachments in a single transaction: [CONF-9888](https://confluencelassian.readthedocs.io/).

**Attachment Backup**

If stored on the filesystem, attachments are placed under the `attachments` directory of your Confluence home directory. Copy this directory to create a backup of all attachments.

To restore from these backups, please refer to [Restoring Data from other Backups](https://confluencelassian.readthedocs.io/).

**Related Topics**

- [Production Backup Strategy](https://confluencelassian.readthedocs.io/)
- [Backup FAQ](https://confluencelassian.readthedocs.io/)

**Production Backup Strategy**

Confluence automatic daily XML backup is suitable if you:

- are evaluating Confluence
- do not have database administration familiarity, and your Confluence installation is small

Once your Confluence installation reaches more than a few thousand pages, the XML backup facility can be inefficient compared to your database's own backup tools. The built in backup functionality requires a lot of memory to run and is less reliable when restoring data.

**Related pages:**

- [Site Backup and Restore](https://confluencelassian.readthedocs.io/)
- [Backup FAQ](https://confluencelassian.readthedocs.io/)

---

**Establishing a production system backup solution**

Atlassian recommends establishing an alternative database backup strategy:

- Create a backup or dump of your database using tools provided by your database
- Create a file system backup of your Confluence home directory

Once this is in place, disable the daily backups through the scheduled jobs feature via 'Administration Console > Administration > Scheduled Jobs'.

We want to stress that creating these two backups is better than having a Confluence XML backup. It is more robust and far more reliable for large production instances. You will be able to restore your whole site, including all data, attachments and configuration information intact with these two backups. See [Restoring Data from other Backups](https://confluencelassian.readthedocs.io/).

Which files need to be backed up?

Back up the whole home directory is the safest option, however most files and directories are populated on...
startup and can be ignored. At minimum, these files/directories must be backed up:

- attachments – but If you store your attachments in the database then you can ignore the attachments directory
- confluence-cfg.xml

The rest of the directories will be auto-populated on start up. You may also like to backup these directories:

- config – if you have modified your ehcache.xml file.
- index – if your site is large or reindexing takes a long time – this will avoid the need for a full reindex when restoring.

How do I restore?

Take a look a the Migrating Confluence Between Servers document for instructions on restoring a backup using this technique.

Other processes

XML backups are described and used for other processes in Confluence, like upgrading and moving servers. Using the backup strategy described above will work for those processes too.

- Our upgrade guide does not require the use of an XML backup (although the earlier Confluence upgrade procedure, and the JIRA upgrade guide, do use XML backups).
- Our migrate server procedure – used to set up a test server – can use a SQL dump as well.
- The database migration procedure uses the XML backup for small data sets. Large data sets will require third party database migration tools.

Note: The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

Configuring Backups

Confluence backs up your data regularly into a zipped XML file. By default, this backup is performed at 2.00 a.m. each day and the backup files are stored in the backups folder under the Confluence Home directory. The default naming convention for the backup files is 'backup-yyyy_MM_dd'. Confluence can write backups to both local and mapped network drives.

From the Backup Administration section of Confluence's administration console, you can:

- Include or exclude attachments in backups.
- Configure a different path to store backup files. (By default, this option is not available. See below for information about enabling the configuration option.)
- Change the naming format used for the files.

You can also change the schedule of this backup using Confluence's scheduled jobs feature.

You need to have System Administrator permissions in order to configure these options.

On this page:
- Configuring Confluence Backups
- Enabling Backup Path Configuration
- Notes

The information on this page does not apply to Confluence OnDemand.
To configure Confluence backups:

1. Choose Browse > Confluence Admin.
2. Click 'Backup Administration' in the 'Configuration' section.
3. Click the 'Edit' button on the 'Backup Administration' screen.
4. Now you can do the following:
   - To specify an alternate path to store backup files — Select 'Custom' and then enter the path. The directory must be on either a local drive or a mounted network drive.
   - By default, this option is not available. See below for information about enabling the configuration option.
   - Please ensure the mapped drive is on a physical server, not a Virtual Machine image.
   - To exclude attachments from backups — Select 'Off' beside 'Backup Attachments'. By default, this feature is 'On'.
   - To use a different naming prefix format — Enter the new format in the 'Backup File Prefix' input field.
   - To use a different date format — Enter the date format in the 'Backup File Date Pattern' input field using the syntax described in this document from Sun.
5. 'Save' your changes.

You can disable Confluence backups through the scheduled jobs feature.

Enabling Backup Path Configuration

By default, it is not possible to specify a backup path via the Confluence Administration Console. This feature is disabled by default for security reasons. Administrators can restore this functionality by updating the relevant configuration property as described below. However, we recommend that you turn the feature off in production environments. For production environments, please review our Production Backup Strategy.

To enable the configuration option:

1. Edit the confluence.cfg.xml file found in the Confluence Home Directory.
2. Set the value of property admin.ui.allow.daily.backup.custom.location to 'true' (without the quotation marks).
3. Restart Confluence.

If the value of the above configuration property is 'true', it will be possible to specify a backup path via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, the backup path is not configurable.

Notes

*Time is derived from the Confluence server*
The time zone is taken from the server on which Confluence is running.

To check the time according to the server, do the following:

1. Choose **Browse > Confluence Admin**.
2. Click 'System Information' in the left-hand panel and look at the 'System Time'.

**Backup strategy for large Confluence sites**

Consider using the **production backup strategy** if your Confluence site is large or you are encountering problems with your automated backup.

**RELATED TOPICS**

No content found for label(s) daily-backup.

**User Submitted Backup & Restore Scripts**

These scripts are user-submitted and should be used with caution as they are not covered by Atlassian technical support. If you have questions on how to use or modify these scripts, please post them to Atlassian Answers. Feel free to submit new scripts or post updates by logging in and adding them to the page as a comment.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Delete Old Backups - Wscript Script On Windows**

This script examines backup filename and deletes them if necessary, it may need to be edited.

```
'If you want 3 day old files to be deleted then insert 3 next to Date = "your number here"
'This script will search out and delete files with this string in them ".2005-12-04-" This of course depends on the number you enter. 
'You can always do a wscript.echo strYesterday or strFileName to see what the script thinks you are searching for.

dtmYesterday = Date - 3
strYear = Year(dtmYesterday)
strMonth = Month(dtmYesterday)
If Len(strMonth) = 1 Then
    strMonth = "0" & strMonth
End If
strDay = Day(dtmYesterday)
If Len(strDay) = 1 Then
    strDay = "0" & strDay
End If
strYesterday = strYear & "-" & strMonth & "-" & strDay
strFileName = "C:\test*." & strYesterday &"-"*
Set objFSO = CreateObject("Scripting.FileSystemObject")
objFSO.DeleteFile(strFileName)
```
Delete Old Backups - Basic Bash Script For Linux

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following:

```
ls -t <path to your backup dir>/* | tail -n +6 | xargs -i rm {}
```

Or, using the older form of the `tail` command if your system does not support the standard form:

```
ls -t <path to your backup dir>/* | tail +6 | xargs -i rm {}
```

Delete Old Backups - Advanced Bash Script For Linux

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following. Set the `BACKUP_DIR` and `DAYS_TO_RETAIN` variables to appropriate values for your site. Between runs, more files than `DAYS_TO_RETAIN` builds up.

```bash
#!/bin/sh
# Script to remove the older Confluence backup files.
# Currently we retain at least the last two weeks worth
# of backup files in order to restore if needed.
BACKUP_DIR="/data/web/confluence/backups"
DAYS_TO_RETAIN=14
find $BACKUP_DIR -maxdepth 1 -type f -ctime +$DAYS_TO_RETAIN -delete
```

Manual Database & Home Backup - Bash Script For Linux

This backs up a mySQL database and the Confluence home directory.

```bash
#!/bin/bash
CNFL=/var/confluence
CNFL_BACKUP=/backup/cnflBackup/`date +%Y%m%d-%H%M%S`
rm -rf $CNFL/temp/*
mkdir $CNFL_BACKUP
mysqldump -uroot -p<password> confluence|gzip > $CNFL_BACKUP/confluence.mysql.data.gz
tar -cjvf $CNFL_BACKUP/data.bzip $CNFL > $CNFL_BACKUP/homedir.status
```

Backup by Date - Postgres

```bash
export d=`date +%u`
mkdir -p /home/backup/postgres/$d
sudo -u postgres pg_dumpall | bzip2 > /home/backup/postgres/$d/sql.bz2
```
Manually Backing Up the Site

Confluence is configured to back up its data automatically. You can also manually perform this backup from the Administration Console.

You need to have System Administrator permissions in order to perform this function.

Note: Atlassian recommends that you follow the Production backup strategy if your Confluence site is large or you are encountering problems with your automated backup.

Creating the site backup

To manually back up your site:

1. Choose Browse > Confluence Admin.
2. Choose Backup & Restore in the left-hand panel.
3. Choose Archive to backups folder to store a copy of the backup in the same folder as Confluence’s backups.
   If you do not archive the backup it will be made available for you to download, and then deleted from the server after 24 hours.
4. Choose Backup attachments to include attachments in your backup.
5. Choose Backup.
   The process will take a few minutes.

Retrieving the Backup File

Confluence stores the backup as a zipped XML file in the 'backups' directory under the Confluence Home directory on your Confluence server. To find your Confluence Home directory, see the documentation. You will need access to the Confluence server in order to retrieve this file.

Enabling the download of the backup file via the administration console

By default, it is not possible to retrieve the backup file via the Confluence Administration Console. This feature is disabled for security reasons.

Administrators can enable this functionality by updating the relevant configuration property as described below. If this functionality is enabled, Confluence will prompt you to download the backup file when the backup process finished. However, we recommend that you turn the feature off in production environments.

To enable download of the backup file from the Administration Console:

1. Edit the confluence.cfg.xml file found in the Confluence Home Directory.
2. Set the value of property admin.ui.allow.manual.backup.download to 'true' (without the quotation marks).
3. Restart Confluence.
If the value of the above configuration property is 'true', it will be possible to download the backup file after manually backing up the site via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, you will need to retrieve the backup file from the file system on the Confluence server. By default, the value is 'false'.

Notes

If you experience timeout errors, please consider bypassing Apache and creating the export directly from Tomcat. This will speed up the process and prevent timeouts. For example, your URL might be something like http://<domain>.com. To bypass this and access Tomcat directly, use this URL: http://localhost:8080/confluence/admin/backup.action.

Restoring a Site

⚠️ CAUTION: Restoring a backup of an entire confluence site will:

- Wipe out all Confluence content in the database. Please ensure that your database is backed up before you start.
- Log you out after the restoration process. Please make sure you know the login details contained in the data that you are about to restore.

This page describes how to restore data from an XML backup file into an existing Confluence installation. If you want to restore data into a new site, follow the instructions on Restoring from Backup During Setup.

You need System Administrator permissions in order to perform this function.

Notes before you start:

- All content replaced. Restoring a site from backup will replace all your content, as described in the warning above.
- Selective space restoration not possible. You cannot select a single space to restore from the entire site backup when the backup contains more than one space.
- Backward version compatibility. Confluence supports backward compatibility for site backups (but not space backups). You can successfully restore backups of a site from an older version of Confluence to a newer version of Confluence. You cannot restore backups from a newer version to an older version. For example, if you create a site backup in Confluence 2.4.3, it cannot be restored into a Confluence 2.2.2 site. It can however, be restored into 2.4.5 or 2.5.x, because 2.4.5 and 2.5.x are newer versions of Confluence.

Related pages:

- Production Backup Strategy
- Manually Backing Up the Site
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

Restoring data from an XML backup

You can restore data from an XML backup file located somewhere on your local computer or a shared drive, or you can copy the XML file into the Confluence installation and restore it from there. The second option is recommended for large backup files. Both options are described below.

To restore data from an XML backup located outside Confluence:
1. Choose **Browse > Confluence Admin**.
2. Choose **Backup and Restore** in the left-hand panel.
3. Choose **Choose File** and browse for the backup file.
4. Uncheck **Build Index** if you want to create the index at a later stage.
5. Choose **Upload and Restore**.

### To restore data from an XML backup located in your Confluence installation:

1. Copy your XML backup zip file into the `restore` directory in your Confluence home directory. For example:
   - On UNIX: `/opt/java/src/confluence/deployments/conf.atlassian.com/home/restore`
   - On Windows: `C:\Program Files\Atlassian\Application Data\Confluence x.x\restore`
2. Choose **Browse > Confluence Admin**.
3. Choose **Backup and Restore** in the left-hand panel.
4. The zip file that you copied in step 1 will appear in the list of files under the heading **Restore a backup from the Confluence Home Directory** on your Confluence Administration Console. Select the zip file.
5. Uncheck **Build Index** if you want to create the index at a later stage.
6. Choose **Restore**.

### Notes

- **Production backup strategy preferred.** Atlassian recommends that you follow the [Production Backup Strategy](#) for your production Confluence site, because Confluence XML backups are not recommended for non-evaluation sites.

- **Restoring from other backups.** If your daily backup zip files cannot be restored for some reason, but you have backups of both your database and your Confluence home directory, then it is still possible to [restore from these backups](#).

### Restoring a Space

This page tells you how to import the contents of a Confluence space into another Confluence site, via an XML backup file.

You can **export the content of a space**, including pages, comments and attachments. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) and optionally, all the attachments in the space. To transfer this data to another Confluence site, you simply restore this zip file as described below.

Confluence will only allow you to restore a space if there is not already a space by that name on the site. If you already have a space with the identical name, you will need to delete or rename the existing space before restoring the new one.

---

⚠️ **The information on this page does not apply to Confluence OnDemand.**
**Cannot restore to a different major Confluence release**

Confluence only supports forward and backward compatibility for space import and export when executed within the **same major version** of Confluence.

Clarifying our terminology: By **major version**, we mean the version defined in the first two sections of the release number. For example, Confluence 2.2 and Confluence 2.3 are different major versions. Confluence 2.2.1 and Confluence 2.2.6 are the same major version.

**Restoration Data Must Share the Same Major Version Number**

This means that a space export created in one major version of Confluence cannot be imported into a different major version of Confluence. For example, if you create a space export in Confluence 2.2.5, it cannot be imported into a Confluence 2.2.2 site. It can be however imported into 2.3.6. Similarly, a space export created in 2.2.2 can not be imported into 2.3.5. However, it can be restored into a Confluence 2.2.6 site.

If you try to carry out such an operation, an error message similar to the one below will be displayed and the import action will be stopped.

**Screenshot: Major Version Clash on Space Restore**

The following error(s) occurred:

- Restore denied. You can only restore space backups exported from the same major version (e.g. 2.2.x or 2.3.x).

**Workaround for restoring Spaces between Major Releases**

You'll need to set up a test server, **download** and install the same version of confluence as the version you exported the space from, then import the space into this test server. Next **update Confluence** on your test installation to the right major version so that you can perform the export and import this space into your production confluence successfully. Otherwise, you can try to **Change the version of the space export**, but please try this on a test site as well.

---

**You need to have System Administrator permissions in order to perform this function.**

### To restore a space,

1. Choose **Browse > Confluence Admin**.
2. Select **Backup and Restore** in the ‘Administration’ section of the left-hand panel.

You can restore data in one of two ways:

1. **Upload a zipped backup to Confluence**:
   - Browse for the backup file.
   - Uncheck **Build Index** if you want to create the index at a later stage.
   - Click **Upload and Restore**.

2. **Restore a backup from the file system**:
   - Select the backup file from the form field displayed. If you do not see your backup file, make sure that it has been copied into the `/opt/java/src/confluence/deployments/conf.atlassian.com/home/restore` directory.
   - Uncheck **Build Index** if you want to create the index at a later stage.
   - Click **Restore**.
Changing the version of a space backup

Confluence prevents the import of space backups which aren’t from the same major version. The reason for this is that any schema change between the export and imported version of Confluence will cause the import to fail, leaving you with an incomplete import. Even worse, the failure can be database-dependent, so it may work fine on one particular database but your backup will fail to import later.

Do not import a modified space backup on a production server. Import the modified space backup on a test server, then export from the test server to create a pristine space backup for the new version.

To change the version of a space backup, do the following:

- extract the space backup ZIP file
- edit `exportDescriptor.properties` in a text editor
- change the `buildNumber` to the `buildNumber` of the Confluence version you wish to import into
- zip up the modified contents of the backup into a ZIP file again.

This will allow you to import a backup into a test instance of Confluence. After checking the imported space for errors, export it cleanly from the test server and import the fresh backup into your production server.

If your import fails on the test server due to Hibernate errors, this indicates a schema incompatibility and cannot be worked around. You will need to restore your entire site on an old version of Confluence, and export the space from there. See the last section of Restoring a Space for details.

Restoring a Test Instance from Production

See Migrating Confluence Between Servers for a more comprehensive explanation.

Many Confluence administrators will have a production instance running the "live" version of Confluence, as well as a test instance for testing upgrades and so on. In this situation, it’s quite common that the two instances are running different versions of Confluence. This document describes how to copy the data from a production instance to a test instance, where the production version may be different to the test version.

Before proceeding with this guide, ensure you have read and understood the normal procedure for upgrading Confluence.

Upgrading a test Confluence instance with production data

Essentially, we are copying both the production home directory and database to the test instance. We then update the database details on the test instance to point to the test database, leaving all other instance metadata (most importantly the Confluence `build number`) the same as production.

1. Shut down your test instance.
2. Restore the production database to the test database server.
3. Create a backup of the `confluence.cfg.xml` file found in the home directory of the test instance.
4. Copy the production confluence-home directory to the test application server.
5. Open the `confluence.cfg.xml` which has been copied in a text editor. Change the database settings...
to match the test database server. **Ensure you do not point to your production database.** (You can compare with the backup you made in Step 3 if you need to get the database settings. Don’t just copy this file – you need the build number unchanged from production to indicate the database is from an older version of Confluence.)

Before starting your test instance, you need to do the following steps to ensure no contact with production systems.

**Ensuring no contact with production systems**

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.smtp.mail.accounts';
   ```

2. Disable space-level mail archiving by running the following database query:

   ```sql
   SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.space.mailaccounts';
   ```

   Change the ‘SELECT *’ to a ‘DELETE’ in the above queries once you are sure you want to remove the specified accounts.

   Once this is done, you can start your test instance without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, etc.). These should be disabled promptly after starting the test instance.

   You can create a developer license for this server and update the License Details after starting up.

   **See also**

   - Upgrading Confluence
   - Migrating Confluence Between Servers
   - Restoring to a Test Instance of Confluence from Production

**Restoring Data from other Backups**

Typically, Confluence data is restored from the Administration Console or from the Confluence Setup Wizard.

If you are experiencing problems restoring from an zipped XML backup file, it is still possible to restore provided you have:

1. A backup of your home directory.
2. A backup of your database (if you’re using an external database).

Instructions for this method of restoring differ depending on whether you are using the embedded database or an external database (like Oracle, MS SQL Server, MySQL or Postgres).

⚠️ **The information on this page does not apply to Confluence OnDemand.**

**Embedded Database**
If you are running against the embedded database, the database is located inside the database folder of your Confluence Home Directory. Hence, all you need to do is:

1. Retrieve the most recent backup of your home directory.
2. Unpack the Confluence distribution and point the confluence-init.properties file to this directory.

---

**External Database**

If you’re using an external database, you need to do the following.

1. Prepare backups of your home directory and database (preferably backups that are dated the same). That is, make sure the home directory is accessible on the filesystem and the database available to be connected to.
2. If this database happens to have a different name, or is on a different server, you need to modify the jdbc url in the confluence.cfg.xml file inside the Confluence Home Directory. The value of this property is specified as hibernate.connection.url.
3. Unpack the Confluence distribution and point the confluence-init.properties file to the home directory.

---

**RELATED TOPICS**

- Important Directories and Files
- Migrating to a Different Database
- Confluence Administrator’s Guide

---

**Retrieve file attachments from a backup**

File attachments on pages can be retrieved from a backup without needing to import the backup into Confluence. This is useful for recovering attachments that have been deleted by users.

Both automated and manual backups allow this, as long as the 'Include attachments' property was set. Users wanting to restore pages, spaces or sites should check out the Confluence Administrator’s Guide instead.

Before following the instructions for recovering attachments, please review how backups store file and page information.

⚠️ The information on this page does not apply to Confluence OnDemand.

---

**How Backups Store File and Page Information**

The backup zip file contains entities.xml, an XML file containing the Confluence content, and a directory for storing attachments.

**Backup Zip File Structure**

Page attachments are stored under the attachments directory by page and attachment id. Here is an example listing:
Inside the attachment directory, each numbered directory inside is one page, and the numbered file inside is one attachment. The directory number is the page id, and the file number is the attachment id. For example, the file \attachments\98\10001 is an attachment with page id 98 and attachment id 10001. You can read entities.xml to link those numbers to the original filename. Entities.xml also links each page id to the page title.

**Entities.xml Attachment Object**

Inside the entities.xml is an Attachment object written in XML. In this example, the page id is 98, the attachment id is 10001 and the filename is *myimportantfile.doc*. The rest of the XML can be ignored:

```
<object class="Attachment" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="fileName">
    <![CDATA[myimportantfile.doc]]>
  </property>
  ...
  <property name="content" class="Page" package="com.atlassian.confluence.pages">
    <id name="id">10001</id>
  </property>
  ...
</object>
```

**Entities.xml Page Object**

This XML describes a page. In this example, the page id is 98 and the title is *Editing Your Files*. The rest of the XML can be ignored:

```
<object class="Page" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="title">
    <![CDATA[Editing Your Files]]>
  </property>
  ...
</object>
```

**Instructions for Recovering Attachments**

Each file must be individually renamed and re-uploaded back into Confluence by following the instructions below. Choose one of the three methods:

**Choice A - Recover Attachments By Filename**

Best if you know each filename you need to restore, especially if you want just a few files:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the filename and find the attachment object with that filename. Locate its page and attachment id.
3. Using the page and attachment id from entities.xml, go to the attachments directory and open that directory with that page id. Locate the file with the attachment id.
4. Rename the file to the original filename and test it.
5. Repeat for each file.
6. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Choice B - Restore Files By Page**

Best if you only want to restore attachments for certain pages:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the page title and find the page object with that title. Locate its page id.
3. Go to the attachments directory and open that directory with that page id. Each of the files in the directory is an attachment that must be renamed.
4. Search entities.xml for attachment objects with that page id. Every attachment object for the page will have an attachment id and filename.
5. Rename the file with that attachment id to the original filename and test it.
6. Repeat for each page.
7. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Choice C - Restore All Files**

Best if you have a small backup but want to restore many or all the attachments inside:

⚠️ Following process is applicable to space export only. Site xml backups do not require page id to be updated manually due to the nature of persistent page_id's.

1. Unzip the backup directory and open entities.xml.
2. Go to the attachments directory and open any directory. The directory name is a page id. Each of the files in the directory is an attachment that must be renamed.
3. Search entities.xml for attachment objects with that page id. When one is found, locate the attachment id and filename.
4. Rename the file with that attachment id to the original filename and test it.
5. Find the next attachment id and rename it. Repeat for each file in the directory.
6. Once all files in the current directory are renamed to their original filenames, search entities.xml for the page id, eg directory name. Find the page object with that page id and locate its page title.
7. Rename the directory to the page title and move on to the next directory. Repeat for each un-renamed directory in the attachments directory.
8. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

⚠️ To obtain detailed information about lost attachments, location, name and type of the attachments, you may use the findattachments script

**Troubleshooting failed XML site backups**

⚠️ XML site backups are only necessary for migrating to a new database. Setting up a test server or Establishing a reliable backup strategy is better done with an SQL dump.

Seeing an error when creating or importing a backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow instructions below</td>
</tr>
</tbody>
</table>
Exception while importing backup

| Follow [Troubleshooting XML backups that fail on restore](#) instead |

⚠️ The information on this page *does not apply* to Confluence OnDemand.

### Resolve Errors With Creating An XML Backup

The errors may be caused by a slightly corrupt database. If you're seeing errors such as *'Couldn’t backup database data'* in your logs, this guide will help you correct the error on your own. We strongly recommend that you backup your database and your Confluence home directory beforehand, so that you can [restore your site from those](#) if required. If you are unfamiliar with SQL, we suggest you contact your database administrator for assistance.

**Preferable solution**

The [Production Backup Strategy](#) is a very reliable and more efficient way to do backups. If you are running into problems with XML backups - whether memory related or because of problems like the one described here - use the native backup tool as an alternate solution.

**To Identify And Correct The Problem**

To work out where the data corruption or problems are, increase the status information reported during backup, then edit the invalid database entry:

1. Stop Confluence.
2. If you have an external database, use a database administration tool to create a manual database backup.
3. Backup your Confluence home directory. You will be able to [restore your whole site](#) using this and the database backup.
4. Open the `my_confluence_install/confluence/WEB-INF/classes/log4j.properties` and add this to the bottom and save:

   ```
   log4j.logger.com.atlassian.confluence.importexport.impl.XMLDatabinder=DEBUG
   log4j.additivity.com.atlassian.confluence.importexport.impl.XMLDatabinder=false
   
   log4j.logger.com.atlassian.confluence.importexport.impl.XMLDatabinder=DEBUG
   log4j.additivity.com.atlassian.confluence.importexport.impl.XMLDatabinder=false
   ```

5. Find your `atlassian-confluence.log`. Move or delete all existing Confluence logs to make it easier to find the relevant logging output.
6. Restart Confluence and login.
7. Begin a backup so that the error reoccurs.
8. You must now check your log files to find out what object could not be converted into XML format. Open `confluence-home/logs/atlassian-confluence.log`. Scroll to the bottom of the file.
9. Do a search for *'ObjectNotFoundException'*. You should see an error similar to this:
10. Open a DBA tool such as DbVisualizer and connect to your database instance. Scan the table names in the schema. You will have to modify a row in one of these tables.
11. To work out which table, open catalina.out, check the first line of the exception. This says there was an error writing the ContentPermission object with id 5 into XML. This translates as the row with primary key 5 in the CONTENTLOCK tablened needs fixing. To work out what table an object maps to in the database, here's a rough guide:
   - Pages, blogposts, comments --> CONTENT table
   - attachments --> ATTACHMENTS table
   - More information can be found in the schema documentation

12. Now you must find the primary key of the incorrect row in this table. In this case, you can check the first line and see that the row has a primary key of 5.

13. Each property is written to a column, so the last property that was being written has the incorrect value. The row being written to when the exception was thrown was CONTENT (line 5) with a value of 2535 (line 6). Now you know the column and value. This value 2535 is the id of an entry that no longer exists.

14. Using a database administrative tool, login ot the Confluence database. Locate the row in the relevant table and correct the entry. Check other rows in the table for the default column value, which may be null, 0 or blank. Overwrite the invalid row value with the default.

15. Restart Confluence.

16. Attempt the backup again. If the backup fails and you are stuck, please lodge a support request with your latest logs.

Troubleshooting “Duplicate Key” related problems

If you are encountering an error message such as:

could not insert:
[bucket.user.propertyset.BucketPropertySetItem#bucket.user.propertyset.BucketPropertySetItem@a70067d3]; SQL []; Violation of PRIMARY KEY constraint 'PK_OS_PROPERTYENTRY314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'.; nested exception is java.sql.SQLException: Violation of PRIMARY KEY constraint 'PKOS_PROPERTYENTRY_314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'.

this indicates that the Primary Key constraint 'PK_OS_PROPERTYENTRY_314D4EA8' has duplicate entries in table 'OS_PROPERTYENTRY'.

You can locate the constraint key referring to 'PK_OS_PROPERTYENTRY_314D4EA8' in your table 'OS_PROPERTYENTRY' and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OS_PROPERTYENTRY' table is:

SELECT ENTITY_NAME,ENTITY_ID,ENTITY_KEY,COUNT(*) FROM OS_PROPERTYENTRY
GROUP BY ENTITY_NAME,ENTITY_ID,ENTITY_KEY HAVING COUNT(*)>1

To Help Prevent This Issue From Reoccuring

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should migrate to an external database.

2. If you are using an older version of Confluence than the latest, you should consider upgrading at this point.

RELATED TOPICS

Enabling detailed SQL logging
Troubleshooting XML backups that fail on restore

XML site backups are only necessary for migrating to a new database. Upgrading Confluence, Setting up a test server or Production Backup Strategy is better done with an SQL dump.

If migrating from HSQLDB to MySQL, you might have a better experience using the MySQL Migration Toolkit.

Seeing an error when creating or importing a site or space backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow Troubleshooting failed XML site backups instead</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow instructions below</td>
</tr>
</tbody>
</table>

The information on this page does not apply to Confluence OnDemand.

Resolve Errors When Attempting To Restore An XML Backup

The errors may be caused by a slightly corrupt database. You will need to find the XML backup file entry that is violating the DB rules, modify the entry and recreate the XML backup:

1. On the instance being restored, follow the instructions to disable batched updates (for simpler debugging), log SQL queries and log SQL queries with parameters at Enabling Detailed SQL Logging.
2. Once all three changes have been made, restart Confluence.
3. Attempt another restore.
4. Once the restore fails, check your log files to find out what object could not be converted into XML format. For Confluence distribution users, check your Confluence install directory under the /logs/ and check both atlassian-confluence.log and catalina.out file. The correct file will contain SQL debug output.
5. Scroll to the bottom of the file and identify the last error relating to a violation of the database constraint. For example:

```
2006-07-13 09:32:33,372 ERROR
[confluence.importexport.impl.ReverseDatabinder] endElement
net.sf.hibernate.exception.ConstraintViolationException:
    could not insert: [com.atlassian.confluence.pages.Attachment#38]
net.sf.hibernate.exception.ConstraintViolationException: could not
insert: [com.atlassian.confluence.pages.Attachment#38]
...
Caused by: java.sql.SQLException: ORA-01400: cannot insert NULL
into ("CONFUSER"."ATTACHMENTS"."TITLE")
at oracle.jdbc.driver.DatabaseError.throwSqlException(DatabaseError.java:112)
at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:331)
at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:288)
```
This example indicates a row in your attachment table with ID = 38 that has a null title.

6. Go to the server that the backup was created on. You must have a copy of the database from which the backup was created. If you do not have this, use a DBA tool to restore a manual backup of the database.

7. Open a DBA tool and connect to the original database instance and scan the table names in the schema. You will have to modify a row in one of these tables.

8. To work out which table, open catalina.out, check the first line of the exception. To work out what table an object maps to in the database, here’s a rough guide:
   - Pages, blogposts, comments --> CONTENT table.
   - attachments --> ATTACHMENTS table.

9. To correct the example error, go to the attachment table and find that attachment object with id 38. This will have a a null title. Give a title using the other attachments titles as a guide. You may have a different error and should modify the database accordingly.

10. Once the entry has been corrected, create the XML backup again.

11. Import the backup into the new version.

12. If the import succeeds, revert the changes made in your SQL logging to re-enable disable batched updates and turn off log SQL queries and log SQL queries with parameters.


Troubleshooting “Duplicate Entry” for key "cp_" or "cps_

If you are encountering an error message such as:

```
com.atlassian.confluence.importexport.ImportExportException: Unable to complete import because the data does not match the constraints in the Confluence schema. Cause: MySQLIntegrityConstraintViolationException: Duplicate entry '1475804-Edit' for key 'cps_unique_type'
```

This indicates that the XML export came from a version of Confluence with a corrupt permissions database, caused by some 3rd party plugin. This is an issue that was fixed when CONF-22123 was implemented in Confluence 3.5.2. The simplest workaround is to export the space again after upgrading the instance to 3.5.2 or above. If that is not an option, then either the export will need to be edited manually to remove the duplicate permission entries or the source instance will need to have the offending entries removed. The following SQL queries can be used to look for such entries:
SELECT * FROM CONTENT_PERM WHERE USERNAME IS NULL AND GROUPNAME IS NULL;

SELECT cp.ID, cp.CP_TYPE, cp.USERNAME, cp.GROUPNAME, cp.CPS_ID, cp.CREATOR, cp.CREATIONDATE, cp.LASTMODIFIER, cp.LASTMODDATE
FROM CONTENT_PERM cp
WHERE cp.USERNAME IS NOT NULL AND cp.GROUPNAME IS NOT NULL;

SELECT cps1.ID, cps1.CONTENT_ID, cps1.CONT_PERM_TYPE FROM CONTENT_PERM_SET cps1,
CONTENT_PERM_SET cps2
WHERE cps1.ID <> cps2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cps1.CONT_PERM_TYPE = cps2.CONT_PERM_TYPE
ORDER BY cps1.CONTENT_ID, cps1.CONT_PERM_TYPE, cps1.CREATIONDATE ASC;

SELECT cp.ID, cp.CP_TYPE, cps.CONTENT_ID,
(SELECT scps.ID FROM CONTENT_PERM_SET scps WHERE scps.CONTENT_ID = cps.CONTENT_ID AND scps.CONT_PERM_TYPE = cp.CP_TYPE) AS suggested_cps_id
FROM CONTENT_PERM cp, CONTENT_PERM_SET cps
WHERE cp.CPS_ID = cps.ID AND
cp.CP_TYPE <> cps.CONT_PERM_TYPE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID, cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.USERNAME = cp2.USERNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.USERNAME, cp1.CREATIONDATE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID, cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.GROUPNAME = cp2.GROUPNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.GROUPNAME, cp1.CREATIONDATE;

SELECT * FROM CONTENT_PERM_SET
WHERE ID NOT IN (SELECT DISTINCT CPS_ID FROM CONTENT_PERM);

Remove all matching entries and perform the export again.

Troubleshooting “Duplicate Key” related problems

If you are encountering an error message such as:
could not insert: [bucket.user.propertyset.BucketPropertysetItem#bucket.user.propertyset.BucketPropertysetItem@a70067d3]; SQL []; Violation of PRIMARY KEY constraint 'PK_OS_PROPERTYENTRY314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'; nested exception is java.sql.SQLException: Violation of PRIMARY KEY constraint 'PKOS_PROPERTYENTRY_314D4EA8'. Cannot insert duplicate key in object 'OS_PROPERTYENTRY'.

This indicates that the Primary Key constraint 'PK_OS_PROPERTYENTRY_314D4EA8' has duplicate entries in table 'OS_PROPERTYENTRY'.

You can locate the constraint key referring to 'PK_OS_PROPERTYENTRY_314D4EA8' in your table 'OS_PROPERTYENTRY' and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OS_PROPERTYENTRY' table is:

```sql
SELECT ENTITY_NAME, ENTITY_ID, ENTITY_KEY, COUNT(*) FROM OS_PROPERTYENTRY GROUP BY ENTITY_NAME, ENTITY_ID, ENTITY_KEY HAVING COUNT(*)>1
```

Troubleshooting "net.sf.hibernate.PropertyValueException: not-null" related problems

If you're receiving a message like:

```
ERROR [Importing data task] [confluence.importexport.impl.ReverseDatabinder] endElement net.sf.hibernate.PropertyValueException: not-null property references a null or transient value: com.atlassian.user.impl.hibernate.DefaultHibernateUser.name
```

This means there's an unexpected null value in a table. In the above example, the error is in the name column in the USERS table. We've also seen them in the ATTACHMENTS table.

Remove the row with the null value, redo the xml export, and reimport.

To Help Prevent this Issue from Recurring

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should migrate to an external database.
2. If you are using an older version of Confluence than the latest, you should consider upgrading at this point.

The problem with different settings for case sensitivity varies between databases. The case sensitivity of the database is usually set through the collation that it uses. Please vote on the existing issue.

RELATED TOPICS

Troubleshooting failed XML site backups
Confluence Administrator's Guide
Migrating from HSQLDB to MySQL
If you've gone through Migrate to Another Database and cannot migrate because of a failed xml backup, this page might help.

**Disclaimer**

MySQL Migration Toolkit is released by the makers of MySQL and as such, problems with the software should be directed to them. Atlassian Support does not offer support for the Migration Toolkit, nor do we provide support for this migration path. These instructions are offered for strictly informational purposes, and your mileage may vary.

**Backup Reminder**

Please backup your database and your home folder before attempting this.

**The information on this page does not apply to Confluence OnDemand.**

**Resources needed**

- Empty MySQL DB with appropriate credentials to allow creation, deletion, and insertion of tables and rows.
- A Windows machine that can both communicate to the Confluence server and the destination DB.
- MySQL Migration Toolkit
- HSQL Database Engine

**Preparation for migrating to MySQL from HSQLDB**

1. Shutdown Confluence
2. Make a copy of the confluence home folder for backup purposes
3. Install the Migration Toolkit
4. Unzip the hsqldb package.
5. Copy the hsqldb.jar from hsqldb/lib into C:\Program Files\MySQL\MySQL Tools for 5.0\java\lib
6. Start the MySQL Migration Toolkit

**Running the Migration Toolkit**

You should be presented with the following screen.

Choose Direct Migration
Source Database

Select the source database you want to migrate from.

- **Database System:** Generic JDBC
  - **Connection String:**
    - `jdbc:hsqldb:file:PATHTODATABASEFOLDER\confluencedb`
  - **Username:** sa
  - **Password:** No password. Leave this field blank
Destination Database

Please make sure that the computer that is running MySQL Toolkit is able to access the MySQL server and that the user listed has the ability to create, drop, insert, and update tables.

If your MySQL user has a $ character in the password (such as 'pa$sword'), please change the password or create a temporary account with full permissions. If you do not, the toolkit will throw an "Illegal group reference" error and you will not be able to proceed with the migration.

Target Database
Select the destination database.

Target Database Connection
Select a RDBMS from the list of supported systems

Connection Parameters
Please enter the connection parameters to connect to the database.

Target Connection Parameter
Choose from the list of available drivers for this RDBMS

Connection String: [ ]
Job Connection String: [ ]

Connecting to Servers
Connecting to Servers
Establishing database connections.

<table>
<thead>
<tr>
<th>Connection Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tasks to execute:</strong></td>
</tr>
<tr>
<td>The following tasks will now be executed. Please monitor the execution progress. Press [Advanced &gt;&gt;] to see the log.</td>
</tr>
<tr>
<td>✔ Connecting to source database system</td>
</tr>
<tr>
<td>✔ Retrieve schema information from source database system</td>
</tr>
<tr>
<td>✔ Test connection to target database system</td>
</tr>
</tbody>
</table>

**Execution completed successfully.**

You should see the toolkit trying to connect. If you have problems, please click on the advanced options and sql will show you debugging information. Click Advanced to see the log. If you see "Java Heap Space: Out of Memory", you can start the *MySQL Migration Toolkit* with a -Xmx flag to allocate more memory to the JVM.

After this screen you should come to reverse engineering. Click next.

**Source Schemata Selection**

You should see 2 databases, **INFORMATION_SCHEMA** and **PUBLIC**. Choose **PUBLIC**

**Object Type Selection**
Object Type Mapping

Object Creation Options

- Database Object Creation Parameters
  - Select the desired options for the object creation. Click Next > to start the creation process.
  - Create Objects Online
  - Create Script File for Create Statements

Click **Show Details** on both sections. For **Migration Method for Type Schema**, choose **Multilanguage**. For **Migration Method for Type Table**, choose **Data Consistancy/Multilanguage**.

Click **Advanced**. Check **Enabled Detailed Mappings in Next Step**

Detailed Object Mapping

Click to rename the **destination database** to be the one set aside to migrate to.

From this point on, you should be able to click next all the way through to finish the migration.

**Rebuilding the Ancestor Table**

In Confluence, the ancestor table defines what pages are ancestors or descendants of other pages (which can be used by search restrictions with the ancestorids restriction). Occasionally, the ancestor table will become out of sync. When this happens, you can rebuild the table to restore everything to normal.

Simply access this URL:

```
http://yoursite/admin/permissions/pagepermsadmin.action
```

⚠️ The information on this page does not apply to Confluence OnDemand.
Screenshot: Page Level Permissions

1. Choose **Browse** > **Confluence Admin**.
2. Click **System Information** in the 'Administration' section.

The handy **Memory Graph** helps you keep track of Confluence's memory usage.

The information on this page **does not apply** to Confluence OnDemand.

---

**RELATED TOPICS**

- Administrators Guide Home
- Confluence Documentation Home

**Viewing System Information**

The System Information screen provides information about Confluence's configuration, and the environment in which Confluence has been deployed. Your system configuration information is helpful to us when diagnosing errors you may face using Confluence. If you file a support request or bug report, the more detail you can provide about your installation and environment the faster we will be able to help.

To view your system information,

1. Choose **Browse** > **Confluence Admin**.
2. Click **System Information** in the 'Administration' section.

The handy **Memory Graph** helps you keep track of Confluence's memory usage.

The information on this page **does not apply** to Confluence OnDemand.

**Related Topics**

- Cache Statistics
- Viewing Site Statistics
- Viewing and Editing License Details
- Viewing and Managing Installed Plugins
- Live Monitoring Using the JMX Interface
- Tracking Customisations Made to your Confluence Installation

---

**Live Monitoring Using the JMX Interface**

With the JMX interface (introduced in Confluence 2.8), you can monitor the status of your Confluence instance in real time. This will provide you with useful data such as the resource usage of your instance and its database latency, allowing you to diagnose problems or performance issues. To read the JMX data, you will need to use a JMX client.

**Disable JMX**

If you experience any problems during Confluence startup that are related to JMX, it is possible to disable the JMX registration process. Please place jmxContext.xml in your <confluence-install>/confluence/WEB-INF/classes folder to do so.
What is JMX?

JMX (Java Management eXtensions) is a technology for monitoring and managing Java applications. JMX uses objects called MBeans (Managed Beans) to expose data and resources from your application.

1. Enabling JMX Remote with Tomcat

By default, Confluence uses the Apache Tomcat web server. To use JMX, you must enable it on your Tomcat server, by carrying out the steps under the Apache Tomcat documentation, entitled Enabling JMX Remote. With those steps completed, restart your Tomcat server.

For the stand-alone, add the startup parameter -Dcom.sun.management.jmxremote to setenv.sh or setenv.bat. See instructions for the Windows Service - enter it in the same place as PermGen Memory.

2. Selecting your JMX Client

You need to use a JMX client in order to view the JMX output from Confluence. JConsole is a readily available JMX client that is included with the supported Java Developer Kit (version 5 onwards). The full name is the 'Java Monitoring and Management Console', but we will refer to it as JConsole for the purposes of this document.

3. Adding the JMX Client to your Path

You must add the location of the JConsole binary file to your path environment variable. As JConsole resides in the 'bin' (binaries) folder under your Java directory, the path should resemble something like this:

```
JDK_HOME/bin/
```

In this example, replace 'JDK_HOME' with the full system path to your Java directory.

4. Configuring JConsole

To configure JConsole:

1. Run the JConsole application.
2. You will be prompted to create a new connection. Choose remote process and enter the hostname of your Confluence instance and a port of your choosing.

```
To connect easily, add the startup parameters to setenv.bat or setenv.sh:
-Dcom.sun.management.jmxremote -Dcom.sun.management.jmxremote.port=8086
-Dcom.sun.management.jmxremote.authenticate=false
Port 8086 is unlikely to be used. Then, connect remotely using port 8086.
```

```
JConsole, or any JMX client, will not see applications which are not owned by the same user. For example under Windows, if an application is started as a service, it is the System User which owns the process, and not the Current User.
```

3. Click Connect.

Note: Other JMX clients besides JConsole can read JMX information from Confluence.

What can I monitor with JMX?
The JMX interface allows you to see live internal information from your Confluence instance, via the following MBeans:

**IndexingStatistics**

This MBean shows information related to search indexing.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flushing</td>
<td>Shows state of cache (i.e. flushing, or not).</td>
<td>True/False</td>
</tr>
<tr>
<td>LastElapsedTimeMilliseconds</td>
<td>Time taken during last indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>LastElapsedTimeReindexing</td>
<td>Time taken during last re-indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>TaskQueueLength</td>
<td>Shows number of tasks in the queue.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SystemInformation**

This MBean shows information related to database latency. It also contains most of the information presented on the [System Information page](#).

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DatabaseExampleLatency</td>
<td>Shows the latency of an example query performed against the database.</td>
<td>Milliseconds</td>
</tr>
</tbody>
</table>

**RequestMetrics**

This MBean shows information related to system load and error pages served.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AverageExecutionTimeForLastTenRequests</td>
<td>Average execution time for the last ten requests.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>CurrentNumberOfRequestsBeingServed</td>
<td>Number of requests being served at this instant.</td>
<td>Integer</td>
</tr>
<tr>
<td>ErrorCount</td>
<td>Number of times the Confluence error page was served.</td>
<td>Integer</td>
</tr>
<tr>
<td>NumberOfRequestsInLastTenSeconds</td>
<td>Obviously, the Number Of Requests In the Last Ten Seconds.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**MailServer-SMTPServer**

This MBean shows information related to email dispatch attempts and failures. There will be an MBean for every SMTP Mailserver that has been configured in the Confluence instance.
### Property name | Function | Values
--- | --- | ---
EmailsAttempted | The number of email messages Confluence has tried to send. | Integer
EmailsSent | The number of email messages sent successfully. | Integer

**MailTaskQueue**

This MBean shows information related to the email workload.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ErrorQueueSize</td>
<td>Number of errors in the queue.</td>
<td>Integer</td>
</tr>
<tr>
<td>Flushing</td>
<td>Shows state (i.e. flushing, or not)</td>
<td>True/False</td>
</tr>
<tr>
<td>FlushStarted</td>
<td>Time that operation began.</td>
<td>Time</td>
</tr>
<tr>
<td>RetryCount</td>
<td>The number of retries that were performed.</td>
<td>Integer</td>
</tr>
<tr>
<td>TaskSize</td>
<td>Number of email messages queued for dispatch.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SchedulingStatistics**

This MBean shows information related to current jobs, scheduled tasks and the time that they were last run.

**High CPU consuming threads**

For Java 1.6, add the Top Threads Plugin to monitor whether CPU is spiking. Download it to a directory and run JConsole like this:

```
JConsole -pluginpath /pathto/topthreads.jar
```

This works only with JDK 1.6, but that can be on the remote machine if the server is running a lower version.

Please note, adding live monitoring to a production instance may itself have an impact on performance.

**Related Topics**

- Viewing System Information
- Cache Statistics
- Viewing and Editing License Details
- Viewing and Managing Installed Plugins

**Tracking Customisations Made to your Confluence Installation**

The 'Modification' section of the Confluence 'System Information' screen lists the files that have been changed since your Confluence application was installed. You will find this information particularly useful when upgrading Confluence to a new version, because you will need to re-apply all customisations after the upgrade.
To see the modifications made to files in your Confluence installation,

1. Choose Browse > Confluence Admin.
2. Select ‘System Information’ in the ‘Administration’ section of the left-hand panel.
3. Scroll down to the section titled ‘Modification’.

Screenshot: Modifications tracker on the Confluence System Information screen

<table>
<thead>
<tr>
<th>Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modified: decorators/main.vmfd, pages/page-breadcrumbs.vmfd, template/includes/macros.vmfd, decorators/mail.vmfd, decorators/spaces.vmfd, template/includes/personal-sidebar.vmfd</td>
</tr>
<tr>
<td>Removed: No files removed</td>
</tr>
</tbody>
</table>

**Notes**
- The modification tracker does not detect changes to class files from the `confluence.jar` or other JAR files. If you modify classes, the Confluence modification detection does not report the modification. See issue CONF-20993.

**RELATED TOPICS**

**Viewing Site Statistics**
Note that the site activity information is **disabled by default**. See notes [below](#).

If enabled, the global activity screen displays statistics on the activity in your Confluence site. These include:

- How many pages and blog posts have been viewed, added or updated over a given period.
- Which spaces are the most popular (most frequently viewed).
- Which spaces are the most active (most frequently edited).
- Which people are the most active contributors/editors of content.

When viewing activity:

- **Viewed Pages**: Shows all pages and blog posts that have been viewed, added or updated.
- **Popular Spaces**: Shows which spaces are the most popular (most frequently viewed).
- **Active Spaces**: Shows which spaces are the most active (most frequently edited).
- **Active Users**: Shows which people are the most active contributors/editors of content.

**Screenshots**: Global Activity, Modifications tracker

---

*The information on this page does not apply to Confluence OnDemand.*
The top ten most popular and most active pages and/or blog posts will be listed, with a link to each.

**Notes**

- The [Confluence Usage Stats plugin](#), which provides the 'Global Activity' screen, is known to cause performance problems on large installations. This plugin is **disabled by default**. A status report on the progress of the performance issues with this plugin is available in this issue: [USGTRK-15](#).
- Your Confluence system administrator can enable the plugin, but please be aware of the possible impact upon your site's performance.
- The plugin is sometimes called 'Confluence Usage Tracking'.
- If your Confluence site is **clustered**, the global activity information will not be available.

### RELATED TOPICS

- [How Do I Get More Statistics from Confluence?](#)
- [Cache Statistics](#)
- [Viewing Space Activity](#)
- [Live Monitoring Using the JMX Interface](#)
- [Installing and Configuring Plugins](#)

Viewing System Properties

After adding memory, setting a proxy or changing other Java options, it can be difficult to diagnose whether the system has picked them up. This page tells you how to view the system properties that your Confluence site is using.
In Confluence 3.0.2 and Later

You can see the expanded system properties on the 'System Information' screen of the Confluence Administration Console.

To see the system properties recognised by your Confluence installation:

1. Choose Browse > Confluence Admin.
2. Select System Information in the 'Administration' section of the left-hand panel.
3. Scroll down to the section titled 'System Properties'.

In Confluence Versions Earlier than 3.0.2

To find out more about what properties are being picked up, download the file `systemproperties.jsp` (attached to this page). Place it in your `<confluence-install>/confluence/admin` directory. Access the following URL:

```
http://<yourbaseurl>/admin/systemproperties.jsp
```

No restart of Confluence is required.

Installing Patched Class Files

Atlassian support or the Atlassian bug-fixing team may occasionally provide patches for critical issues that have been resolved but have not yet made it into a release. Those patches will be class files which are attached to the relevant issue in our JIRA bug-tracking system.

Installation Instructions for the Confluence Distribution

Follow these steps to install a patched class file:

1. Shut down your confluence instance.
2. Copy the supplied class files to `<installation-directory>/confluence/WEB-INF/classes/<subdirectories>`, where:
   - `<installation-directory>` must be replaced with your Confluence Installation directory. (If you need more information, read about the Confluence Installation Directory.)
   - `<subdirectories>` must be replaced by the value specified in the relevant JIRA issue. This value will be different for different issues. In some cases, the subdirectories will not exist and you will need to create them before copying the class files. Some issues will contain the patch in the form of a ZIP file which will contain the desired directory structure.
3. Restart your Confluence instance for the changes to become effective.

Class files in the `WEB-INF/classes` directory of a web application will be loaded before classes located in JAR files in the `WEB-INF/lib` directory. Therefore, classes in the first directory will effectively replace classes of the same name and package which would otherwise be loaded from the JAR files.

**RELATED TOPICS**

- [How Do I Edit Files in Confluence JAR Files?](#)
- [Where are the files that used to be in my Confluence installation directory?](#)
Finding Your Confluence Support Entitlement Number (SEN)

There are three ways to find your Support Entitlement Number (SEN):

- **Method 1:** Check in the Confluence Administration Interface
  Select Administration >> License Details. The SEN is shown:

- **Method 2:**
  Log into my.atlassian.com as the Account Holder or Technical Contact

- **Method 3:** Atlassian Invoice
  Your Support Entitlement Number (SEN) appears on the third page of your Atlassian Invoice.

See Finding Your Support Entitlement Number in the support space for more general information about how Atlassian Support uses this number.

⚠️ The information on this page does not apply to Confluence OnDemand.

Configuring Confluence
The pages listed below contain instructions on configuring Confluence. If you cannot find what you are looking for, try searching this documentation via the search box in the left-hand navigation panel.

- **Site Configuration**
  - Configuring the Site Home Page
  - Configuring the Administrator Contact Page
  - Editing the Site Title
  - Editing the Global Logo
  - Configuring the Server Base URL
  - Customising Default Space Content
  - Configuring the Destination of View Space Links
  - Editing the Site Welcome Message
  - Configuring the What's New Dialog

- **Configuring Encoding**
  - Character encodings in Confluence
  - Troubleshooting Character Encodings
    - “€” Euro character not displaying properly
    - MySQL 3.x Character Encoding Problems

- **Configuring Mail**
  - Configuring a Server for Outgoing Mail
  - Setting Up a Mail Session for the Confluence Distribution
  - Configuring the Recommended Updates Email Notification
  - The Mail Queue

- **Optional Settings**
  - Attachment Storage Configuration
    - Hierarchical File System Attachment Storage
  - Configuring a WebDAV client for Confluence
  - Configuring Quick Navigation
  - Enabling OpenSearch
  - Enabling the Did You Mean Feature
  - Enabling the Remote API
  - Enabling Threaded Comments
  - Enabling Trackback

- **Other Settings**
  - Configuring Attachment Size
  - Configuring Character Encoding
  - Configuring HTTP Timeout Settings
  - Configuring Indexing Language
  - Configuring Number Formats
  - Configuring Shortcut Links
  - Configuring Time and Date Formats
  - Known Issues with Enterprise or Webhosting environments

- **Configuring System Properties**
  - Recognised System Properties

- **Application Server Configuration**
  - Application Server URL encoding
  - Configuring Tomcat’s URI encoding
  - Managing Application Server Memory Settings
  - Switching to Apache Tomcat

- **Database Configuration**
  - Known Issues For Supported Databases
    - Configuring Database Character Encoding
  - Database Setup Guides
    - Database JDBC drivers
    - Database Setup for Oracle
    - Database Setup for SQL Server
Site Configuration

- Configuring the Site Home Page
- Configuring the Administrator Contact Page
- Editing the Site Title
- Editing the Global Logo
- Configuring the Server Base URL
- Customising Default Space Content
- Configuring the Destination of View Space Links
- Editing the Site Welcome Message
- Configuring the What's New Dialog

Related Topics

- Tracking Customisations Made to your Confluence Installation
- Configuring Confluence

Site Configuration
Configuring the Site Home Page

You can configure Confluence to send users to any of the space home pages on the site when they log in, rather than to the dashboard.

To configure the site-wide home page:

1. Go to the 'Administration Console' and click 'General Configuration' in the left-hand panel.
2. Click 'Edit' next to the 'Site Configuration' panel.
3. Select a space from the 'Site Homepage' dropdown menu. When users log in, Confluence will open the home page of the space you choose here.
   a. The spaces available to set as the site home page will depend on the access permissions of the space and the site.
   i. The site home page must be accessible to the 'confluence-users' group
   ii. If the site allows anonymous access, the site home page must also be accessible to anonymous users, that is, people who have not logged in to Confluence.
4. Ensure that the 'View Space Goes to Browse Space' option is set to 'Off' if you want users to be sent to the space home page and not the space summary page.
5. Click the 'Save' button at the bottom of the screen.

Notes

- The user's personal settings will override the global setting.

Related Topics

No content found for label(s) site-configuration.
The Default Administrator Contact Message

By default, the 'contact administrators message' looks much like the highlighted area in the screenshot below, starting with 'Please enter information...'.

**Screenshot: The default 'Contact Site Administrators' message**

To restore the message to its default simply remove the custom message you entered when following the instructions above, so that the 'Custom Contact Administrators Message' field is empty.

**Customisation Examples**

When entering the 'Custom Contact Administrators Message', you can use text and Confluence wiki markup. This is similar to entering your own text and markup for the 'Site Welcome Message'. For examples of the kind of customisations possible, take a look at the guide to editing the site welcome message.

**Disabling the Administrator Contact Form**

If you prefer to disable the ability for users to send an email message to the site administrators, you can disable the form portion of this screen. You can only disable the form if you first provide a 'Custom Contact Administrators Message' as described above.

To enable or disable the administrator contact form:

1. Go to the 'Administration Console' and click **General Configuration** in the left-hand panel.
2. Click **Edit** at the top of the 'Site Configuration' section.
3. Select **on** or **off** for the 'Contact Administrators Form'.
4. Click **Save**.

**Configuring Spam Prevention**

You can configure Confluence to use Captcha to help prevent spam, including the spamming of Confluence administrators. The administrator contact form is covered by the site-wide Captcha settings as documented in Configuring Captcha for Spam Prevention.

**Related Topics**
Contacting Confluence Administrators
Configuring Captcha for Spam Prevention

Editing the Site Title

The site title appears in your browser's title bar. By default, it is set to 'Confluence'.

To change the title of your Confluence site:

1. Go to the 'Administration Console' and click 'General Configuration' in the left-hand panel.
2. Click 'Edit' at the top of the 'Site Configuration' screen.
3. Enter a new title for your site in the input field next to 'Site Title'.
4. Click 'Save'.

Related Topics

No content found for label(s) site-configuration.

Editing the Global Logo

By default, the global logo appears beside the page title on all pages in the site. You can disable the logo or replace it with one of your own.

You need to be a Confluence Administrator to configure the global logo.

To configure the global logo:

1. Choose Browse > Confluence Admin.
2. Click Global Logo, under 'Look and Feel' in the left panel.
3. Click Off to disable the current logo, or click Browse to upload a new logo.

Related Topics

No content found for label(s) site-configuration.

Configuring the Server Base URL

The Server Base URL is the URL via which users access Confluence. The base URL must be set to the same URL by which browsers will be viewing your Confluence site.

Confluence will automatically detect the base URL during setup, but you may need to set it manually if your site's URL changes or if you set up Confluence from a different URL to the one that will be used to access it publicly.

You need to have System Administrator permissions in order to perform this function.

The information on this page does not apply to Confluence OnDemand.

To configure the Server Base URL:

1. In Confluence, open the 'Browse' menu and select 'Confluence Admin'. The 'Administration Console' will open.
2. Click 'General Configuration' in the left-hand panel.
3. Click the 'Edit' button next to 'Site Configuration'.
4. Enter the new URL in the 'Server Base URL' text box.
5. 'Save' your changes.

Example

If Confluence is installed to run in a non-root context path (that is, it has a context path), then the server base URL should include this context path. For example, if Confluence is running at:

http://www.foobar.com/confluence

then the server base URL should be:

http://www.foobar.com/confluence

Notes

• **Using different URLs.** If you configure a different base URL or if visitors use some other URL to access Confluence, it is possible that you may encounter errors while viewing some pages.

• **Changing the context path.** If you change the context path of your base URL, you may also need to edit the web server's server.xml file to reflect the new path:
  1. Stop the Confluence server.
  2. Go to your Confluence 'destination directory'. This is the directory where the Confluence installation files are stored. For example, C:\Program Files\Atlassian\Confluence. Let's call this directory '{CONFLUENCE_INSTALLATION}'.
  3. Edit the configuration file at {CONFLUENCE_INSTALLATION}\conf\server.xml.
  4. Change the value of the path attribute in the Context element to reflect the context path. For example, if Confluence is running at http://www.foobar.com/confluence, then your path attribute should look like this:

```xml
<Context path="/confluence" docBase="../confluence" debug="0" reloadable="false" useHttpOnly="true"/>
```

  5. Save the file.

RELATED TOPICS

No content found for label(s) site-configuration.

Customising Default Space Content

**Confluence Administrators** can define default content for a space home page. This content will appear on the home page whenever someone adds a new space. You can define different content for global spaces and for personal spaces.

The default content will appear only for new spaces that are created after you have defined the content. Content in existing home pages will not be changed.

To define default content for home pages in global spaces:

1. Choose **Browse > Confluence Admin**.
2. Click **Default Space Content** under 'Configuration' in the left-hand panel.
3. The **Space Home Pages** tab will open on the 'Default Space Content' page.
4. Click **Customise**. (This step is necessary only if the content is still set to the default. If it has already been customised, the 'Customise' option will not appear.)
5. Enter the content that you want to appear on the home page for new global spaces. You can use special characters within the content as variables (place holders). Confluence will replace the curly brackets and digits with the corresponding information as shown below:
   - \{0\} — The space name.

6. Click Save.

**To define default content for home pages in personal spaces:**

1. Choose **Browse > Confluence Admin**.
2. Click **Default Space Content** under 'Configuration' in the left-hand panel.
3. The 'Default Space Content' screen will open. Click the **Personal Space Home Pages** tab.
4. Click **Customise**. (This step is necessary only if the content is still set to the default. If it has already been customised, the 'Customise' option will not appear.)
5. Enter the content which you want to appear on the home page for new personal spaces. You can use special characters within the content as variables (place holders). Confluence will replace the curly brackets and digits with the corresponding information as shown below:
   - \{0\} — The space owner's full name.
   - \{1\} — The space owner's e-mail address.
   - \{2\} — Any personal information the space owner has entered on their user profile in the 'Information about me' section.
6. Click the 'Save' button.

You can also undo all customisations of the default home page content, and go back to the default content as originally supplied with Confluence.

**To restore the original default content:**

1. Choose **Browse > Confluence Admin**.
2. Click **Default Space Content** under 'Configuration' in the left-hand panel.
3. Choose either the **Space Home Pages** tab or the **Personal Space Home Pages** tab, as required.
4. Click **Revert**. (This option appears only if the content has been customised. If the content is still set to the default, the 'Revert' option is not present.)

*Screenshot: Defining default space content*
Configuring the Destination of View Space Links

By default, when you click a space link in order to view the space, you are taken to the space’s home page. If you wish, you can configure Confluence to redirect all space links on the site to the ‘Browse Space’ view of the space instead.

To direct the space link to the ‘browse space’ view:

1. Go to the ‘Administration Console’ and click ‘General Configuration’ in the left-hand panel.
2. Click ‘Edit’ at the top of the ‘Site Configuration’ screen.
3. Select ‘On’ next to ‘View Space goes to Browse Space’.
4. Click ‘Save’.

Related Topics
No content found for label(s) site-configuration.

Editing the Site Welcome Message

The site welcome message appears at the top left of the Confluence dashboard, between the site logo and the list of spaces. You can use it to display an introduction to the site or a message of the day.

To edit the site welcome message:

1. Go to the Administration Console and click General Configuration in the left-hand panel.
2. Click Edit at the top of the Site Configuration section.
3. Type into the Site Welcome Message box. You can enter text or Confluence wiki markup.
4. Click Save.
The Default Site Welcome Message

By default, the site welcome message looks more or less like the screenshot below, starting with the words Welcome to Confluence and ending above the list of spaces.

To restore the default site welcome message and remove your customised message, just delete the text in the Site Welcome Message text box. Provided that you have not customised Confluence, your Confluence users will see the default message if there is no text in the Site Welcome Message text box in your Administration Console.

Example 1. Adding a Simple Welcome Message

Let's say you want to display a simple message like this at the top of your dashboard:

Welcome to the MyCompany Wiki

New to MyCompany? Find out about your induction

Otherwise, have fun, because you can't always work!
To produce the above welcome message, follow the step-by-step instructions above and add the following wiki markup into the **Site Welcome Message** text box:

```
{panel}
h2. Welcome to the MyCompany Wiki

New to MyCompany? [Find out about your induction|DS:Company Induction].
Otherwise, [have fun|DS:Have Fun], because you can't always work!
```

**Example 2: Formatting your Welcome Message**

Now let's say you want to put the words into a panel and add some spacing, so that your dashboard looks like this:

```
{panel}
h2. Welcome to the MyCompany Wiki

New to MyCompany? Find out about your induction.
Otherwise, have fun, because you can't always work!

Welcome to the MyCompany Wiki

New to MyCompany? Find out about your induction.
Otherwise, have fun, because you can't always work!
```

**Example 3: Including Content from Another Page**

It may be easier to write your welcome message on a normal Confluence page and include the page into the **Site Welcome Message** text box:

```
{panel}
h2. Welcome to the MyCompany Wiki

New to MyCompany? [Find out about your induction|DS:Company Induction].
Otherwise, [have fun|DS:Have Fun], because you can't always work!
```

```
{panel}
```

```
[panel]
```
**Welcome Message** text box. Using a normal page means that you can:

- Write the message using the editor rather than wiki markup.
- Preview the content of the welcome message before saving it, using the page editor's preview feature.
- Allow other people, who are not Confluence administrators, to edit the welcome message.

To include content from another page:

1. Create a Confluence page as usual and add your welcome message as the page content. Remember to limit the size of the content, because it must fit nicely onto the dashboard. For this example, let's assume you put your page in the 'DS' space and the title of your page is 'Dashboard Welcome Message'.
2. Add page permissions or space permissions to suit your requirements. You may want to restrict the editing of the page to a group of people, or you may want to allow any employee to edit the page. This will determine who can update the welcome message on the dashboard.
3. Follow the step-by-step instructions above and add the following wiki markup into the Site Welcome Message text box:

   ```{include:DS:Dashboard Welcome Message}
   ```

   In the above example we use the {{include}} macro to display the content from the given page. See the guide to the include macro. In our example, the space key 'DS' and the page name 'Dashboard Welcome Message' are variables. You can use any space and page you like.
4. Save the site welcome message. The dashboard will display the content of the page immediately. Similarly, if you or anyone else edits the page, the welcome message on the dashboard will change as soon as you save the page.

**Example 4. Adding Blog Posts Filtered by Labels to your Welcome Message**

Looking for more advanced ideas?

This video shows you how to display a list of blog posts on your dashboard and how to choose the blog posts by labelling them.

Video title: *Bring "Must Read" Content to the Dashboard*

Summary of the procedure shown in the video:

1. Create a page containing the {{blog-posts}} macro. Choose to display only the blog posts that are labelled with 'dashboard-blog'. (This is just an example of a label. You can choose any label text you like.) See the guide to the Blog Posts macro.
2. Add the label to a blog post. (In the video, we just add the label to one blog post. You will probably want to add it to a number of posts.)
3. Edit your site welcome message to include the above page, using the include macro.

**How We Use the Site Welcome Message at Atlassian**

Atlassian makes great use of the welcome message on our internal Confluence wiki. Here is an example of the dashboard as it appeared on a certain day:
The welcome message itself contains just an \{include\} macro:

```
{include:STAFF:Extranet Homepage}
```

The \include\ macro allows you to include the content an entire page onto another page. This particular page lives in the STAFF space, where anyone can edit it. It usually shows some amusing picture or company-wide notice. The featured photo generally changes once a week or so – whenever someone feels like changing it. The page itself has over 600 edits by many different people.

The page also includes an edit link, for quick access to change the welcome message. We have the Compositio\n plugin installed which allows you to use the \{float\} macro.

Our wiki markup in the 'Extranet Homepage' page looks something like this:
This is the content that goes on the Extranet homepage, above the spaces list.

NOTE: KEEP YOUR PICTURES SMALL (<80KB) -- USE JPG FOR PICTURES, WIDTH 400

h4. Experimental blogroll: All posts labelled "extranet-dashboard"

If you want to promote a good post to stand out from the eac white noise, just add the label *extranet-dashboard*. To avoid inflation please use the label carefully.

Related Topics

No content found for label(s) site-configuration.

Configuring the What's New Dialog

The 'What's New' dialog automatically displays when a user first logs in after a major Confluence upgrade (e.g. upgrading to Confluence 4.0). The dialog displays a summary of the new features for the release, sourced from our website (by default).

Confluence administrators can configure the behaviour of the 'What's New' dialog, as follows:

- Change the URL that the 'What's New' dialog retrieves information from.
- Disable the dialog.

On this page:

- [Changing the 'What's New' Dialog URL](#)
- [Disabling the 'What's New' Dialog](#)
- [Notes](#)
Changing the 'What's New' Dialog URL

The 'What's New' dialog URL is stored in your Confluence help-paths.properties file. This URL is a concatenation of the help.prefix property with the help.whats.new.iframe.link.

Before you begin:

- The help.prefix property also defines the base URL for Confluence help links, i.e. help links in the Confluence application.

To change the 'What's New' Dialog URL:
Follow the instructions in the 'Changing the Links for Individual Help Pages' section on Local Confluence Documentation. You will need to update the 'help.prefix' and 'help.whats.new.iframe.link' properties, as desired.

For example, you may have installed your Confluence documentation behind a firewall at http://www.example.com/ and created a page http://www.example.com/whatsnew that you use for change management. In this case, you would do the following:

- Set help.prefix to http://www.example.com/
- Set help.whats.new.iframe.link to whatsnew

There is an additional property 'help.whats.new.full.link'. This is only used if the content pointed to by the updated URL isn't loaded in 10 seconds, in which case a 'timeout' screen is displayed with a link to the full 'What's New' content. For locally-hosted pages you can just set this property to the same value as help.whats.new.iframe.link.

Disabling the 'What's New' Dialog

The 'What's New' dialogue is enabled via a plugin. To disable the 'What's New' dialogue, you need to disable the Confluence What's New plugin in Confluence.

To disable the 'Confluence What's New' plugin:
Follow the instructions on Disabling or Enabling a Plugin. Please note, the 'Confluence What's New' plugin is a 'System Plugin'. Click 'Show System Plugins' on the Plugins administration page to display the system plugins.
Related Topics

Disabling or Enabling a Plugin
Local Confluence Documentation

Configuring Encoding

Confluence allows the configuration of which character encoding is used to deliver pages.

⚠️ While different character encodings are supported, we strongly recommend that **UTF-8** is used. Confluence is heavily tested on UTF-8, and users are likely to have less problems with this encoding than others.

⚠️ **Mac Users**

Mac Users please note that **MacRoman** encoding is compatible with UTF-8. You do not need to change your encoding settings if you are already using MacRoman.

To avoid problems with character encoding, make sure the encoding used across the different components of your system are the same:

- [Configuring Database Character Encoding](#)
- [Application Server URL encoding](#)
- [Confluence Character Encoding](#)

If you are having problems with the character encoding in Confluence, please see the [Troubleshooting Character Encodings](#) page.

⚠️ The information on this page does not apply to Confluence OnDemand.

Character encodings in Confluence

Character encoding advice

In general, **always set all character encodings to UTF-8**. That includes database, JDBC drivers, application server, filesystem and Confluence.

In certain isolated cases (e.g. Microsoft Windows), it might not be possible to use a fully Unicode filesystem (that is, a default Windows install doesn't support Unicode filenames properly). If so, stick with UTF-8 for the other two and be aware that your operating system might have limitations around international attachments (pre-2.2), backup and restore of international data, etc.

The remainder of the document explains the encoding settings that are applicable in Confluence and how they relate to application behaviour.

⚠️ The information on this page does not apply to Confluence OnDemand.

Where character encoding is used

There are three places that character encoding matters to Confluence:

1. **Database encoding** - usually the most important; it is where almost all user data is stored.
2. **Filesystem encoding** - important for attachment storage (pre-2.2), reading Velocity templates and writing
exported files.

3. **HTTP request and response encoding** - important for form parsing, correct rendering by the browser and browser interpretation of encoded URLs.

Problems generally arise when Confluence thinks one of the above encoding is different to what it actually is. For example, Confluence might believe the database is using ISO-8859-1 encoding, when in fact it is UTF-8 encoded.

**Java character encoding**

Java *always uses the multibyte UTF-16 character encoding for all String data*. This means that each of the encodings above defines how, at that particular point, characters are converted to and from Java's native UTF-16 format into some other format that the browser, filesystem or database might understand.

So when a request comes in to Confluence, we convert it from the request encoding to UTF-16. Then we store that data into the database, converting from UTF-16 to the database's encoding. Retrieving information from the database and sending it back to the browser is the same process in the opposite direction.

*A char represents single Unicode code point from the Base Multilingual Plane (BMP), encoded as UTF-16. Multiple chars are used as surrogate pairs for characters beyond U+FFFF.*

**Problems with character encodings**

If Confluence has the wrong idea about encoding for one of the above, it manifests itself in different ways:

1. Incorrect database encoding - user data is corrupted between saving and restoring from the database. This often happens after a delay, as we cache data as it is written to the database and only later retrieve the corrupted copy from the database.
2. Incorrect/non-Unicode filesystem encoding - international filenames break attachment download/upload/removal (pre-2.2); exports break with international content or attachments.
3. Incorrect HTTP encoding - incorrect encoding selected by browser, resulting in incorrect rendering of characters. Changing browser encoding causes page to render properly. Broken URLs when linking to pages or attachments with non-ASCII characters.

**Configuration of character encodings**

The *Confluence character encoding* is a configuration setting found in *Administration > General Configuration*, and at runtime available in Settings.defaultEncoding. It is subsequently used in the following parts of the system:

- **ConfluenceWebWorkConfiguration** sets *webwork.i18n.encoding* to the this encoding, which WebWork uses in the response Content-Type header.
- **AbstractEncodingFilter** sets the HTTP request encoding to this encoding. This seems unnecessary, since the Content-Type header from the client should include the encoding used. This affects form submissions and file uploads.
- **VelocityUtils** reads in Velocity templates using this encoding when reading templates from disk.
- **AbstractXmlExporter** creates its output using this encoding.
- **GeneralUtil** uses this encoding when doing URLEncode and URLDecode. Different browsers have different support for character sets in URLs, so it's uncertain how much benefit this provides.

In summary, changing the Confluence character encoding will change your **HTTP request and response encoding** and your **Filesystem encoding** as used by exports and velocity templates.

The *database encoding* is the responsibility of your JDBC drivers. The drivers are responsible for reading and writing from the database in its native encoding and translating this data to and from Java Strings (which are UTF-16). For some drivers, such as **MySQL**, you must set Unicode encoding explicitly in the JDBC URL. For others, the driver is smart enough to determine the database encoding automatically.

Ideally, your database itself should be in a Unicode encoding (and we recommend [doing this](#) for the simplest...
configuration), but that is not necessary as long as:

- the database encoding supports all the characters you want to store in Confluence
- your JDBC drivers can properly convert from the database encoding to UTF-16 and vice-versa.

The **filesystem encoding** is mostly ignored by Confluence, except for the cases where the above configuration setting above plays a part (exports, velocity). When attachments are uploaded, they are written as a stream of bytes directly to the filesystem. It is the same when they are downloaded: the bytes from the file InputStream are written directly to the HTTP response.

In some places in Confluence, we use the *default filesystem encoding* as determined by the JVM and stored in the `file.encoding` system property (it can be overridden by setting this property at startup). This encoding is used by the Java `InputStreamReader` and `InputSteamWriter` classes by default. This encoding should probably never be used; for consistent results across all filesystem access we should be using the encoding set in the General Configuration.

In certain cases we explicitly hard-code the encoding used to read or write data to the filesystem. Two important examples are:

- importing Mbox mailboxes which are known to be ISO-8859-1
- Confluence Bandana config files are always stored as UTF-8.

Some application servers, Tomcat for example, have an encoding setting that modifies Confluence URLs before they reach the application. This can prevent access to international pages and attachments (really anything with international characters in the URL). See configuring your Application Server URL encoding.

**RELATED TOPICS:**
- Configuring Database Character Encoding
- Troubleshooting Character Encodings

**Troubleshooting Character Encodings**

Often users may have problems with certain characters in a Confluence instance. Symptoms may include:

- Non-ASCII characters appearing as question marks (?)
- Page links with non-ASCII characters not working
- Single characters being displayed as two characters
- Garbled text appearing

In most cases, it is due to a mis-configuration in one of the components that Confluence uses.

> The information on this page does not apply to Confluence OnDemand.

Follow these steps to diagnose the problem:

1. **Run the encoding test**

Confluence includes an encoding test that can reveal problems with your configuration.

To perform the test, access the Encoding Test page via the `<confluence base-url>/admin/encodingtest.action` page on your Confluence instance. You will be required to copy and paste a line of text and submit a form. The test will take the text and pass it through Confluence, the application server and the database, and return the results.

You should also test pasting some sample text (Japanese for example) if you are experiencing problems with a specific language.

Example:
A successful test looks like the following:

The encoding test has now been run. Below, you can compare the raw text delivered from Confluence back to you, as a round-trip through the database. All the test results should appear identical.

<table>
<thead>
<tr>
<th>Internacionalização</th>
<th>This image is how all of the test results below should appear. This page, and all of your System Information.</th>
</tr>
</thead>
</table>

**Test 1: Raw text**

This is the test string generated in Confluence.

**Internationalização**

**Test 2: Form submission**

This is the test string pasted by you into the web form and submitted back to Confluence.

**Internationalização**

**Test 3: Database round-trip (select as LOWER)**

This is the string from Test 2 after being stored in the database and then retrieved.

**internationalização**

Expected result: (converting Java string to lowercase)

**internationalização**

**Test 4: Database round-trip (select as UPPER)**

This is the string from Test 2 after being stored in the database and then retrieved.

**INTERNATIONALIZAÇÃO**

Expected result: (converting Java string to uppercase)

**INTERNATIONALIZAÇÃO**

⚠️ **MySQL 3.x**

MySQL 3.x is known to have some problems with the upper- and lower-casing of some characters, and may fail the last two tests. For more information, see [MySQL 3.x Character Encoding Problems](http://confluence.atlassian.com/admin/encodingtest.action).
2. Ensure the same encoding is used across all components

As mentioned in the Configuring Encoding document, the same character encoding should be used across the database, application server and web application (Confluence).

- To change the character encoding used in Confluence, see Configuring Character Encoding.
- To change the character encoding used in the application server, please ensure you set the Application Server URL encoding and view your application server's documentation on any other settings required to enable your encoding.
- To change the character encoding used in the database, see Configuring Database Character Encoding.

3. Requesting support

If there are still problems with character encoding after following the above steps, create a support request, and our support staff will aid in solving your problem.

Entering in the following details will help us to identify your problem:

- Attach screenshots of the problem
- Attach the results of the encoding test (above)
- Select which application server (and version) you are using
- Select which database (and version) you are using
- Copy the contents of the System Information page into the ‘Description’ field

"€“ Euro character not displaying properly

The € (euro) symbol is a three byte character, with byte values in file (UTF-8) of 0xE2, 0x82, 0xAC.

Sometimes, if the character encoding is not set consistently among all participating entities of the system, Confluence, server and the database, one may experience strange behaviour.

```
... I write a page with a Euro sign in it (€). All is well, the Euro sign shows up in the wiki markup text-box, and the preview, and the display of the saved page.
One day later, the Euro sign has changed into a question mark upside down!
... What is going on? Why does the Euro sign mysteriously change? How do I prevent it?
```

Interestingly enough the character encoding test passes with no problems, demonstrating that Confluence and the connected Database both recognise the € symbol.

⚠️ The information on this page does not apply to Confluence OnDemand.

There are two potential reasons for this behaviour:

**Database and Confluence is using utf-8 encoding. The connection is not.**

When data transferred to it via the connection which does not use utf-8 encoding gets encoded incorrectly. Hence, updating the connection encoding may resolve this problem from now on, yet it probably would not affect already existing data.

**Database is not using utf-8. Confluence and your connection are.**

If your Database encoding is not set to UTF-8, yet is using some other encoding such as latin1, it could be one of the potential reasons why you lose the "€“ characters at some stage. It could be occurring due to caching.
When Confluence saves data to the database, it may also keep a local cached copy. If the database encoding is set incorrectly, the Euro character may not be correctly recorded in the database, but Confluence will continue to use its cached copy of that data (which is encoded correctly). The encoding error will only be noticed when the cache expires, and the incorrectly encoded data is fetched from the database.

For instance the latin1 encoding would store and display all 2-byte UTF8 characters correctly except for the euro character which is replaced by ‘?’ before being stored. As Confluence’s encoding was set to UTF-8, the 2-byte UTF-8 characters were stored in latin1 database assuming that they were two latin1 different characters, instead of one utf8 character. Nevertheless, this is not the case for 3-byte utf8 characters, such as the Euro symbol.

Please ensure that you set the character encoding to UTF-8 for all the entities of your system as advised in this guide.

MySQL 3.x Character Encoding Problems
MySQL 3.x is known to have some problems upper- and lower-casing certain (non-ASCII) characters.

Diagnosing the problem
1. Follow the instructions for Troubleshooting Character Encodings.
2. If the upper- and lower-cased strings displayed on the Encoding Test are different, then your database is probably affected.

An example (faulty) output of the Encoding Test is shown below:

⚠️ The information on this page does not apply to Confluence OnDemand.

Screenshot: Encoding Test Output
Solution

Upgrade to a newer version of MySQL. (4.1 is confirmed to work.)

Configuring Mail

- Configuring a Server for Outgoing Mail
- Setting Up a Mail Session for the Confluence Distribution
- Configuring the Recommended Updates Email Notification
- The Mail Queue

Customising the eMail Templates

⚠️ The information on this page does not apply to Confluence OnDemand.

Configuring a Server for Outgoing Mail

Configuring your Confluence server to send email messages allows your Confluence users to:

- Receive emailed notifications and daily reports of updates.
- Send a page via email.
You can personalise email notifications by configuring the ‘From’ field to include the name and email address of the Confluence user who made the change.

You need System Administrator permissions in order to configure Confluence's email server settings.

On this page:
- Configuring Confluence to send email messages
- Testing the email settings
- Troubleshooting

Related pages:
- The Mail Queue
- Setting Up a Mail Session for the Confluence Distribution

The information on this page does not apply to Confluence OnDemand.

Configuring Confluence to send email messages

To configure Confluence to send outgoing mail:

1. Choose Browse > Confluence Admin.
2. Select Mail Servers under Configuration in the left-hand panel. This will list all currently configured SMTP servers.
3. Click Add New SMTP Server (or edit an existing server).
4. Edit the following fields as required:
   - **Name**: By default, this is simply 'SMTP Server'.
   - **From Address**: Enter the email address that will be displayed in the 'from' field for email messages originating from this server. This field is mandatory. You will not be able to complete the Confluence mail server configuration until this field has been specified.
   - **From Name**: Enter the name that will be displayed in the 'from' field for email messages originating from this server. This is the text which appears before the user's registered email address (in angled brackets). This field accepts the following variables, which reference specific details defined in the relevant Confluence user's profile:
     - **Variable** | **Description**
       - ${fullname} | The user's full name.
       - ${email} | The user's email address.
       - ${email.hostname} | The domain/host name component of the user's email address.
       - ${fullname} (Confluence) | Hence, if Joe Bloggs made a change to a page he was watching and the Confluence site's 'From Address' was set to confluence-administrator@example-company.com, then the 'From' field in his email notification would be: Joe Bloggs (Confluence) <confluence-administrator@example-company.com>.
   - **Subject Prefix**: Enter some text to appear at the beginning of the subject line.
5. Manually enter your Host Address, User Name and Password details (recommended)
OR

Specify the JNDI location of a mail session configured in your application server.

Testing the email settings

A Confluence administrator can test the email server as follows:

1. Set up a mail server at Confluence Admin > Mail Servers, as described above
2. Click Send Test Email to check that the server is working. Check that you get the test email in your inbox.
3. You can flush the email queue to send the email message immediately. Go to Confluence Admin > Mail Queue, and click Flush Mail Queue. See The Mail Queue.

A user can test that notifications are working as follows:

1. Go to your user profile (using the Settings link) and edit your email preferences. See Subscribing to Email Notifications of Updates to Confluence Content.
2. Enable Notify On My Actions. (By default, Confluence does not send you notifications for your own changes.)
3. Go to a page you wish to get notifications about.
4. Choose Tools > Watch. See Watching a Page or Blog Post.
5. Edit the page, make a change, and save the page.
6. Check your email inbox. You may need to wait a while for the email message to arrive.

Troubleshooting

If you experience problems with these configurations, please check that your <Confluence-Install>/confluence/WEB-INF/lib contains only one copy of the following JAR files:

1. activation-x.x.x.jar
2. mail-x.x.x.jar

Ideally, these should be:

- activation-1.0.2.jar
- mail-1.3.2.jar (or later)

You will then need to move these into the proper directory: Please move (not copy) the two jar files from the <confluence-install>/confluence/WEB-INF/lib directory to <confluence-install>/lib and restart Confluence.

Setting Up a Mail Session for the Confluence Distribution

Set up a mail session for the Confluence distribution to use Gmail as follows:

1. Stop Confluence.
2. Move (don't copy) activation-1.0.2.jar and mail-1.4.1.jar from <confluence-install>/confluence/WEB-INF/lib to <confluence-install>/lib.
3. Add the following to your server.xml file found in <confluence-install>/conf/ (add it just before the </Context> tag):
4. Restart Confluence.
5. Go to Browse > Confluence Admin and click on Mail Servers. Choose either Edit an existing configuration, or Add a new SMTP mail server.
6. Edit the server settings as necessary, and set the JNDI Location as:

```
java:comp/env/mail/GmailSMTPServer
```

Note that the JNDI Location is case sensitive and must match the resource name specified in server.xml.

7. Submit, and send a test email.

**Configuring the Recommended Updates Email Notification**

Confluence sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message. This is called the 'Recommended Updates' notification.

If you have Confluence Administrator or System Administrator permissions, you can configure the default settings that determine how often the Recommended Updates notification is sent. When new users are added to Confluence, the default settings will be applied to their user profiles.

Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

**Initial settings of the defaults**

When you install Confluence, the initial values of the default settings are as follows:

- The default frequency is weekly.
- If your Confluence site has public signup enabled, the Recommended Updates notification is disabled by default. If public signup is not enabled, the notification is enabled by default.

You can change the above settings, specifying a different default value for the site.

**Notes:**

- The Recommended Updates notification is sent only to people who have a user profile in Confluence. If your Confluence site uses external user management, such as LDAP, then people will receive the report only after they have logged in for the first time. (The first login creates their user profile.)
- The daily email message is sent at 1 p.m. in the user's configured time zone.
- The weekly email message is sent at 1 p.m. on Thursdays in the user's configured time zone.
Configuring the Recommended Updates notification

You can set the default send option (send / do not send) and the default schedule (daily or weekly).

To configure the Recommended Updates email notification:

1. Choose Browse > Confluence Admin.
2. Click Recommended Updates Email in the left-hand panel.

Disabling the Recommended Updates notification for the entire site

You can also turn off the recommended updates notification for the entire site, by disabling the 'Confluence daily summary email' plugin. See Disabling or Enabling a Plugin.

The Mail Queue

Email messages waiting to be sent are queued in a mail queue and periodically flushed from Confluence once a minute. A Confluence administrator can also manually flush messages from the mail queue.

If there is an error sending messages, the failed email messages are sent to an error queue from which you can either try to resend them or delete them.

To view the mail queue:

1. Choose Browse > Confluence Admin.
2. Choose Mail Queue in the left-hand panel. This will display the email messages currently in the queue.
3. Choose Flush Mail Queue to send all email messages immediately.
4. Choose Error Queue to view failed email messages. You can try to Resend the messages, which will flush the mails back to the mail queue, or you can Delete them from here.

Related pages:

- Configuring a Server for Outgoing Mail
- Setting Up a Mail Session for the Confluence Distribution

⚠️ The information on this page does not apply to Confluence OnDemand.

Optional Settings

- Attachment Storage Configuration
- Configuring a WebDAV client for Confluence
- Configuring Quick Navigation
- Enabling OpenSearch
- Enabling the Did You Mean Feature
- Enabling the Remote API
- Enabling Threaded Comments
Attachment Storage Configuration

Confluence allows you to store attachments in one of three places:

- Filesystem - locally in the Confluence home directory
- Database - in Confluence's configured database
- WebDAV - remotely on a WebDAV server (*deprecated*)

A System Administrator can configure Confluence's attachment storage via the 'Attachment Storage' option on the 'Administration Console'.

ℹ️ You need to have System Administrator permissions in order to perform this function.

---

**On this page:**

- Attachment Storage Options
  - Local File System
  - Database
  - WebDAV
- Migration between Attachment Storage Systems
- Troubleshooting

**Related pages:**

- Working with Confluence Logs
- Working with Confluence Logs
- Confluence Administrator's Guide

⚠️ The information on this page **does not apply** to Confluence OnDemand.

---

**Attachment Storage Options**

**Local File System**

By default, Confluence stores attachments in the attachments directory within the configured Confluence home folder. If you are looking to run Confluence Clustered, attachments must be stored in the database.

**Database**

Confluence gives administrators the option to store attachments in the database that Confluence is configured to use.

Here are some reasons why, as an administrator, you may want to choose this storage system:

- Ease of backup.
- Avoiding issues with certain characters in attachment file names.

⚠️ While storing attachments in the database can offer some advantages, please be aware that the amount of space used by the database will increase because of the greater storage requirements.

**WebDAV**
Confluence also allows administrators to set an external WebDAV repository as the location for attachment storage.

⚠️ **WebDAV attachment manager deprecated**

The option to store Confluence attachments on a WebDAV server has never worked in a useful fashion, and has not been maintained for many versions.

- The WebDAV attachment manager will be **deprecated** from Confluence 2.7, and will be removed from a later version of Confluence.
- If you store attachments on external WebDAV servers, we recommend that you migrate to file-system or database-backed attachment storage as soon as possible. Refer to CONF-9313 and CONF-2887.
- This DOES NOT affect the operation of the WebDAV plugin.

### Migration between Attachment Storage Systems

You can 'migrate' your attachments from one storage system to another. All existing attachments will be moved over to the new attachment storage system.

- When the migration occurs, all other users will be locked out of the Confluence instance. This is to prevent modification of attachments while the migration occurs. Access will be restored as soon as the migration is complete.

- When migrating attachments from your database to a filesystem, the attachments are removed from the database after migration. However, when migrating attachments from a filesystem to your database, the attachments remain on the filesystem after migration. If you wish to change this function's behaviour from 'copy' to 'move', please see CONF-14802 and cast your vote.

### To perform a migration, follow the steps below:

1. Choose **Browse > Confluence Admin**.
2. Click 'Attachment Storage' in the left-hand panel. The current configuration will be displayed.
3. Click the 'Edit' button to modify the configuration.
4. Select the storage system you desire.
Edit attachment storage

5. Click the 'Save' button to save the changes.
6. A screen will appear, asking you to confirm your changes. Clicking 'Migrate' will take you to a screen that displays the progress of the migration.

Migration warning

Troubleshooting

To enable debug logging for WebDAV attachment storage, add the following to the bottom of WEB-INF/classes/log4j.properties and restart Confluence:

```
log4j.logger.com.atlassian.confluence.pages.persistence.dao=DEBUG,confluentelog
log4j.additivity.com.atlassian.confluence.pages.persistence.dao=false

log4j.logger.org.apache.webdav=DEBUG,confluentelog
log4j.additivity.org.apache.webdav=false
```

For more about log file configuration, see Working with Confluence Logs.

Hierarchical File System Attachment Storage

For Confluence version 3.0, the structure of attachments stored on the filesystem was changed. In versions of Confluence prior to 3.0, attachments were stored in directories corresponding to the id of the content to which they belong. The more content in Confluence with attachments, the more directories you would have immediately beneath your configured attachments directory. This directory structure has been changed in Confluence 3.0 and since the default configuration of Confluence is to store attachments in the filesystem, this change is likely to have relevance to administrators of most existing Confluence installations.

If you are installing Confluence for the first time, there will be no consequences as a result of this change. If you are upgrading from a previous version of Confluence, the migration to this new filesystem structure should happen automatically during the upgrade.

The reason for introducing this change was to address the issue CONF-13004. Certain file systems have a limit on the number of files that can be stored in a directory and large Confluence installations were reaching this...
limit. In addition, storing too many files at a single directory level can cause performance degradation in some circumstances. This new attachment storage strategy ensures this will no longer be the case.

⚠️ The information on this page does not apply to Confluence OnDemand.

⚠️ Backup Confluence Home

Before upgrading to Confluence 3.0, as with any upgrade you must ensure you have a backup of your Confluence home directory before you proceed.

The New Directory Layout

The attachment storage layout was chosen to fulfil the following main requirements:

1. Limit the number of entries at any single level in a directory structure.
2. Partition attachments per space making it possible for a system admin to selectively back up attachments from particular spaces (see the JIRA issue for more details).

An attachment in Confluence can be thought of as having a number of identifying attributes: id, space id and content id. That is to say, the attachment logically belongs to a piece of content which logically belongs in a space (not all content belongs to a space). For attachments within a space in Confluence, the directory structure is typically 8 levels, with the name of each directory level based on the following algorithm:

<table>
<thead>
<tr>
<th>level</th>
<th>Derived From</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (top)</td>
<td>Always 'ver003' indicating the Confluence version 3 storage format</td>
</tr>
<tr>
<td>2</td>
<td>The least significant 3 digits of the space id, modulo 250</td>
</tr>
<tr>
<td>3</td>
<td>The next 3 least significant digits of the space id, modulo 250</td>
</tr>
<tr>
<td>4</td>
<td>The full space id</td>
</tr>
<tr>
<td>5</td>
<td>The least significant 3 digits of the content id, modulo 250</td>
</tr>
<tr>
<td>6</td>
<td>The next 3 least significant digits of the content id, modulo 250</td>
</tr>
<tr>
<td>7</td>
<td>The full content id</td>
</tr>
<tr>
<td>8</td>
<td>The full attachment id</td>
</tr>
</tbody>
</table>

Within the 8th level will be a file for each version of that attachment, named to match the version number e.g. 1

An example:
To find the directory where attachments for a particular space are stored, you can use the JSP findspaceattachments.jsp at the location <confluence url>/admin/findspaceattachments.jsp. This JSP requires a space key and returns the directory on the file system where attachments for that space are stored.

Attachment D in the above diagram is stored in a slightly different structure. Attachments that are not conceptually within a space replace the level 2 - 4 directories with a single directory called 'nonspaced'. Examples of such attachments are the global site logo and also attachments on draft content.

**Upgrading to the new attachment storage structure**
As mentioned previously, this upgrade is only necessary if you have Confluence configured to store attachments on the file system.

If migration is not necessary due to a different storage configuration (for example, because attachments are stored in the database), then no migration will occur during upgrade and the Confluence log will simply show the following messages -

```
INFO [main] [AbstractUpgradeManager] upgradeStarted Starting automatic upgrade of Confluence
INFO [main] [UpgradeTask] isUpgradeNeeded The configured attachmentDataDao does not store attachment data on the file system so the HierarchicalFileSystemAttachmentUpgradeTask is not necessary.
INFO [main] [AbstractUpgradeManager] upgradeFinished Upgrade completed successfully
```

Should migration be required, it will occur automatically during upgrade and the log will show output similar to this -

```
INFO [main] [UpgradeTask] doUpgrade Beginning HierarchicalFileSystemAttachmentUpgradeTask. Depending on the size of the attachment data this may take some time.
INFO [main] [UpgradeTask] run 4023 pages may have attachments to be moved to a new hierarchical structure.
INFO [main] [UpgradeTask] run 0 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 500 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 1000 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 1500 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 2000 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 2500 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 3000 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 3500 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run 4000 of 4023 pages have had their attachments moved to the new structure.
INFO [main] [UpgradeTask] run Successfully moved the attachments for all 4023 pages to the new hierarchical structure.
INFO [main] [UpgradeTask] doUpgrade Completed HierarchicalFileSystemAttachmentUpgradeTask.
INFO [main] [AbstractUpgradeManager] upgradeFinished Upgrade completed successfully.
```
It should be noted that for most implementations of Java, the migration to the new data structure involves moving the files (not copying them). Hence, there should not be a need to have additional disk space available. It also means that the migration should be relatively fast.

**Have you previously applied the CONF-8298 patch?**

The patch or workaround on the [CONF-8298](#) issue changed the structure of attachment storage but not to the most efficient possible structure. So during the Confluence 3.0 upgrade process this intermediate [CONF-8298](#) structure will be detected and automatically upgraded.

**Troubleshooting the upgrade**

⚠ It should be noted that in the event of a failure, your attachment directory may be in an inconsistent state and your first step in troubleshooting should be to restore the backup of your home directory.

There are a number of reasons the migration could fail. This will be shown in the log with a message similar to "Failed to move the attachments for all pages to the new hierarchical structure."

Immediately preceding this message in the log will be entries for each page whose attachments could not be moved. The following table shows examples of these messages and offers some possible explanations.

<table>
<thead>
<tr>
<th>Example Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The configured attachment directory <code>&lt;directory name&gt;</code> could not be found or was not a directory.</td>
<td>The configured Confluence attachment directory is not accessible. Check confluence home for the attachment directory and ensure the permissions are correct to allow reading and writing for this directory.</td>
</tr>
<tr>
<td>It is not possible to migrate the attachments to the new structure since files already exist which the attachment process may need to create.</td>
<td>Your attachments directory contains files or directories which the upgrade task wants to create. That is, a top level directory called ver003 containing directories or files with names containing up to 3 digits (e.g. 1, 213). This could be due to a previous failed attempt to migrate the attachments. You should restore a previous good copy of your attachments directory and remove any files or directories with this naming pattern before retrying.</td>
</tr>
<tr>
<td>Couldn't find current Confluence content for the id <code>&lt;content Id&gt;</code>. The attachment is a non-spaced attachment (e.g. global logo, draft attachment, etc) and will be migrated to the nonspaced directory.</td>
<td>This is a normal message indicating that the attachment being migrated does not belong to a space e.g. global logo.</td>
</tr>
<tr>
<td>Problem while accessing the database for content id <code>&lt;content Id&gt;</code> so its attachments will not be migrated.</td>
<td>It was not possible to access the database at this point during the migration. You will need restore your Confluence attachment directory from the backup and attempt the upgrade again, once the database is accessible again.</td>
</tr>
</tbody>
</table>
Could not create the new attachment directory directory.
The upgrade task could not create the new directory to contain the attachment being moved. Does the server user have sufficient permission to perform this operation in the indicated directory? Is there sufficient disk space?

Failed to move the current attachment directory <some path> to the new location of <some other path>.
The upgrade task could not move the directory. Does the server user have sufficient permission to perform this operation in the indicated directory?

Configuring a WebDAV client for Confluence
WebDAV allows users to access Confluence content via a WebDAV client, such as 'My Network Places' in Microsoft Windows. Provided that the user has permission, they will be able to read and write to spaces, pages and attachments in Confluence. Users will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

Introduction to Confluence’s WebDAV Client Integration
By default, all WebDAV clients have permission to write to Confluence. Write permissions include the ability for a WebDAV client to create, edit, move or delete content associated with spaces, pages and attachments in a Confluence installation.

On the ‘WebDAV Configuration’ screen in the Confluence Administration Console, you can:

- Deny a WebDAV client write permissions to a Confluence installation using a regular expression (regex).
- Disable or enable strict path checking.
- Enable or disable access to specific virtual files/folders.

Note:

- The 'WebDav Configuration' page is only be available if the WebDAV plugin has been enabled. Refer to Installing Plugins and Macros for more information on enabling Confluence plugins. Note that this plugin is installing Plugins and Macros
- The settings on the 'WebDav Configuration' page do not apply to external attachment storage configuration.

On this page:

- Introduction to Confluence's WebDAV Client Integration
- Restricting WebDAV Client Write Access to Confluence
- Disabling Strict Path Checking
- Virtual Files and Folders
- Using a WebDAV Client to Work with Pages
- Known Issues

Restricting WebDAV Client Write Access to Confluence
In earlier versions of the WebDAV plugin, separate options for restricting a WebDAV client's write permissions (that is, create/move, edit and delete actions), were available. However, in the current version of this plugin, they have been simplified and combined into a general write permission restriction that covers all of these actions.

WebDAV clients are now denied write permission to your Confluence installation by setting a regex that matches specific content within the WebDAV client's user agent header. Upon setting a regex, it will be added to a list of restricted WebDAV clients. Any WebDAV clients whose user agent header matches a regex in this list will be denied write permission to your Confluence installation.
Example: A PROPFIND method header generated by a Microsoft Web Folder WebDAV client, showing the user agent header field:

```
PROPFIND /plugins/servlet/confluence/default HTTP/1.1
Content-Language: en-us
Accept-Language: en-us
Content-Type: text/xml
Translate: f
Depth: 1
Content-Length: 489
User-Agent: Microsoft Data Access Internet Publishing Provider DAV
Host: 127.0.0.1:8082
Connection: Keep-Alive
```

Unlike earlier versions of the WebDAV plugin which could only restrict write permissions for all WebDAV clients, the current version of this plugin allows you to restrict write permissions to specific WebDAV clients selectively.

To restrict a WebDAV client’s write access permissions to your Confluence installation,

1. Choose **Browse > Confluence Admin**.
2. Click **WebDav Configuration** under ‘Configuration’ in the left panel. The ‘WebDAV Configuration’ page is displayed.
3. Enter a regex that matches a specific component of the user agent header sent by the WebDAV client you want to restrict.
4. Click the **Add new regex** button. The regex is added to the list of restricted WebDAV clients.
   - You can repeat steps 3 and 4 to add a regex for each additional WebDAV client you want to restrict.
5. Click the **Save** button to save the configuration changes.

To restore one or more restricted WebDAV client’s write access permissions to your Confluence installation,

1. Choose **Browse > Confluence Admin**.
2. Click **WebDav Configuration** under ‘Configuration’ in the left panel. The ‘WebDAV Configuration’ page is displayed.
3. Select the regex(es) from the list that match(es) the user agent header sent by the restricted WebDAV client(s) you want to restore.
4. Click the **Remove selected regexes** button. The regexes you had selected are removed from the list of restricted WebDAV clients.
5. Click the **Save** button to save the configuration changes.

Screenshot: WebDAV configuration
Disabling Strict Path Checking

If you observe any idiosyncrasies with your WebDAV client, such as a folder that does exist on your Confluence site but is missing from the client, you can disable the WebDAV plugin's strict path checking option, which may minimise these problems.

To disable the WebDAV plugin’s strict path checking option,

1. Choose Browse > Confluence Admin.
2. Click ‘WebDav Configuration’ under ‘Configuration’ in the left panel. The ‘WebDAV Configuration’ page is displayed.
3. Clear the ‘Disable strict path check’ check box.
4. You can re-enable this option at a later point in time by simply selecting this check box.
5. Click the ‘Save’ button to save this configuration change.

Virtual Files and Folders

In the unlikely event that you observe any problems with the WebDAV client's performance or stability, you can enable access to automatically generated (that is, virtual) files and folders.

By default, these options are hidden on the 'WebDAV Configuration' page. To make them visible, you must append the parameter hiddenOptionsEnabled=true to the end of your URL and reload the page. For example:

`<Confluence base URL>/admin/plugins/webdav/config.action?hiddenOptionsEnabled=true`
To enable or disable access to virtual files and folders,

1. Choose **Browse > Confluence Admin**.
2. Click **WebDav Configuration** under 'Configuration' in the left panel. The 'WebDav Configuration' page is displayed.
3. Amend your URL as described in the note above and reload the 'WebDav Configuration' page.
4. Select or clear the check box options in the 'Virtual Files and Folders' section as required.
5. Click the 'Save' button to save the configuration changes.

**Using a WebDAV Client to Work with Pages**

The following sections tell you how to set up a WebDAV client natively for a range of different operating systems. WebDAV clients typically appear as drives in your operating system's file browser application, such as Windows Explorer in Microsoft Windows, or Konqueror in Linux.

**Setting Up a WebDAV Client in Microsoft Windows**

This section covers the two methods for configuring a WebDAV client natively in Microsoft Windows:

- As a network drive
- As a web folder

If possible, use the network drive method as this will enable more comprehensive WebDAV client interaction with Confluence than that provided by a web folder. However, your Confluence instance must meet several environmental constraints if you use this method. If you cannot configure your instance to meet these requirements, then use the web folder method or third-party WebDAV client software.

If you run into any problems with the procedures in this section, please refer to the Troubleshooting WebDAV page.

**Windows Network Drive**

To map a Confluence WebDAV client network drive, your Confluence instance must be configured so that all of the following criteria is met:

- Uses HTTP (not HTTPS)
- Listens on port 80 (not 8080, which is the default port value used by the popular application server Apache Tomcat that runs many Confluence EAR / WAR installations, or 8090, the default for Confluence distributions)
- Has no context root
- There is an issue (WBDV-208) that can prevent Network Drives from being mapped. Please use the Network Folders steps below as a workaround.

The reason for these restrictions results from limitations in Microsoft's Mini-Redirector component. For more information, please refer to Microsoft's server discovery issue.
To map a Confluence WebDAV client network drive in Microsoft Windows,

1. In Windows XP, go to **My Computer** –> **Tools menu** –> **Map Network Drive**. In Windows Vista, go to **Computer** –> **Map Network Drive**. The 'Map Network Drive' dialog box opens.
2. Specify the following input to map the WebDAV client as a network drive:
   - **Drive**: `<Any drive letter>` (for example, `Z:`)
   - **Folder**: `\<hostname>\webdav` (for example, `\localhost\webdav`)
3. Click 'Finish'.
   - When prompted for login credentials, specify your Confluence username and password.

**Windows Web Folder**

To map a Confluence WebDAV client web folder in Windows XP,

1. Go to **My Network Places** and choose 'Add a network place'. The 'Add Network Place Wizard' opens.
2. Click 'Next', ensure that 'Choose another network location' is selected and then click 'Next' again.
3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, `http://<confluence server url>/confluence/plugins/servlet/confluence/default` or `http://<confluence server url>/plugins/servlet/confluence/default`) and then click 'Next'.
   - When prompted for login credentials, specify your Confluence username and password.
4. Provide a meaningful name for your web folder and proceed with the remainder of the wizard.
5. Click 'Finish'.

**Screenshot: A Confluence WebDAV Client Web Folder in Windows XP**

To map a Confluence WebDAV client web folder in Windows Vista,

- This procedure is very similar to the one for Windows XP. However, the following procedure includes the slight interface differences that are specific to Windows Vista.
1. Open the 'Map Network Drive' dialog box (refer to first step of the procedure above for mapping a network drive) and choose 'Connect to a Web site that you can use to store your documents and pictures'. The 'Add Network Location' wizard opens.

2. Click 'Next', ensure that 'Choose a custom network location' is selected and then click 'Next' again.

3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, http://<confluence server url>/confluence/plugins/servlet/confluence/default or http://<confluence server url>/plugins/servlet/confluence/default) and then click 'Next'.

   When prompted for login credentials, specify your Confluence username and password.

4. Provide a meaningful name for your network location/web folder and proceed with the remainder of the wizard.

5. Click 'Finish'.

**Setting up a WebDAV client in Linux or Solaris**

There are many tools and mechanisms available for configuring WebDAV clients in these operating systems. Therefore, we have chosen to demonstrate this using the file manager **Konqueror**, which is part of the Linux **K Desktop Environment**.

**To set up a Confluence WebDAV client in Konqueror,**

1. Open Konqueror.

2. In the 'Location' field, enter the URL for the Confluence WebDAV location using the 'protocol' webdavs (for example, webdavs://<confluence server url>/confluence/plugins/servlet/confluence/default or webdavs://<confluence server url>/plugins/servlet/confluence/default) and press Enter.

   If prompted for login credentials, specify your Confluence username and password.

   You should be able to click to load many, but not all files. In practice, you would normally save a modified file locally, then drag it to the Konqueror window to upload it to Confluence.

**Known Issues**

Please refer to the **WebDAV plugin documentation** for a description of the known issues and suggested workarounds.

**RELATED TOPICS**

No content found for label(s) data-storage,webdav.

**Configuring Quick Navigation**

When a user is searching Confluence (see **Using the Quick Navigation Aid**) the quick navigation aid automatically offers a dropdown list of pages and other items, matched by title to the search query. By default, this feature is enabled, with the maximum number of simultaneous quick navigation requests set to 40. However, these options can be modified as described below.

The maximum number of simultaneous quick navigation requests defines the maximum number of individuals who can use this feature simultaneously on the same Confluence server. If your Confluence server serves a large number of individuals who use this feature regularly, some of whom are being denied access to it, you may wish to increase this value.
To modify the quick navigation feature's options,

1. Choose **Browse > Confluence Admin**.
2. Select '**General Configuration**' in the left-hand panel.
3. In the '**General Configuration**' screen, click '**Edit**'.
4. To disable this feature, select '**Off**' beside '**Quick Navigation**'.
5. To modify the maximum number of simultaneous quick navigation requests, enter the appropriate number in the field beside '**Max Simultaneous Requests**'.
6. Click '**Save**'.

The following screenshot demonstrates the user interface of the quick navigation aid.

**Screenshot: The quick navigation aid showing titles matching the query 'mark'**

**RELATED TOPICS**

**Searching Confluence**

**Enabling OpenSearch**

With OpenSearch autodiscovery, you can add Confluence search to your Firefox or IE7 search box (see **Searching Confluence from your Browser's Search Box**). By default, OpenSearch autodiscovery is enabled. This feature can be enabled or disabled as described below.

**To enable or disable OpenSearch autodiscovery,**
1. Choose Browse > Confluence Admin.
2. Select 'General Configuration' in the left-hand panel.
3. In the 'General Configuration' screen, click 'Edit'.
4. Select 'On' beside 'Open Search' to enable this feature, or 'Off' to disable it.
5. Click 'Save'.

**RELATED TOPICS**

**Searching Confluence**

Enabling the Did You Mean Feature

When you perform a full Confluence search, Confluence may offer you an alternative spelling of your search query. The alternative spelling will appear next to the words 'Did you mean'. By default, this feature is disabled. You can enable it as described below.

**To enable the 'Did You Mean' feature,**

1. Choose Browse > Confluence Admin.
2. Select 'General Configuration' in the left-hand panel.
3. In the 'General Configuration' screen, click 'Edit'.
4. Select 'On' beside 'Did You Mean'.
   - If you have no 'Did you mean' feature index or you have not yet created it, this option will not be available. To create this index, click 'build the did-you-mean index' and on the subsequent page, click 'Build' in the 'Did You Mean Index' section. Then return to the 'General Configuration' screen in Edit mode.
5. Click 'Save'.

**Languages and Locales**

The 'Did You Mean' feature supports only the English language. In addition, the 'Did You Mean' index requires the built-in UK-English locale (en_UK). If your Confluence site uses a different language pack, such as English (US), the 'Did You Mean' feature will not work. You will see an error message like this:

> For Did You Mean both the indexing language and the global default language must be set to English.

For more information about how the 'Did You Mean' feature works, please refer to the user guide.

You can track the request to support other languages by watching issue CONF-14768.

**RELATED TOPICS**

**Enabling the Remote API**

Confluence provides XML-RPC and SOAP remote APIs (application programming interfaces). You need to enable the APIs from the Administration Console before you can access Confluence remotely.

You need System Administrator permissions in order to perform this function.

**To enable the remote API:**
1. Choose **Browse > Confluence Admin.**
2. Click **General Configuration** in the left-hand panel.
3. Click **Edit.**
4. Click the check box next to **Remote API (XML-RPC & SOAP).**
5. Click **Save.**

**Related pages:**

[Confluence Remote API Reference](#)

---

**Enabling Threaded Comments**

Comments on pages or blog posts are displayed in one of two views:

- **Threaded:** Shows the comments in a hierarchy of responses. Each reply to a comment is indented to indicate the relationships between the comments.
- **Flat:** Displays all the comments in one single list and does not indicate the relationships between comments.

By default, comments are displayed in **threaded** mode. A Confluence Administrator (see **Global Permissions Overview**) can enable or disable the threaded view for the entire Confluence site.

To enable or disable the threaded view:

1. Choose **Browse > Confluence Admin.**
2. Select **General Configuration** in the left-hand panel.
3. Click **Edit.**
4. Check **Threaded Comments** to enable threaded mode. Clear the check box to disable threaded mode and display all comments in flat mode.
5. Click **Save.**

**Related pages:**

- [Commenting on pages and blog posts](#)
- [Confluence Administrator's Guide](#)

---

**Enabling Trackback**

When Trackback is enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery and when Trackback is enabled, can receive trackback pings sent by other sites.

To enable trackback,

1. Choose **Browse > Confluence Admin.**
2. Select ‘**General Configuration**’ in the left panel.
3. In the ‘**Feature Settings**’ screen, click ‘**Edit**’.
4. Select ‘**On**’ beside ‘**Trackback**’ and click ‘**Save**’.

---

**RELATED TOPICS**

No content found for label(s) security-options.
Other Settings

- Configuring Attachment Size
- Configuring Character Encoding
- Configuring HTTP Timeout Settings
- Configuring Indexing Language
- Configuring Number Formats
- Configuring Shortcut Links
- Configuring Time and Date Formats
- Known Issues with Enterprise or Webhosting environments

Configuring Attachment Size

Confluence gives you the option of limiting the maximum size of a single file attachment. Confluence administrators should keep in mind that the amount of disk space used by Confluence is directly proportional to the number and size of attachments put into the system.

To configure the maximum size allowed for an attachment:

1. Go to the ‘Administration Console’ and click ‘General Configuration’ in the left-hand panel.
2. Click ‘Edit’ on the ‘General Configuration’ screen.
3. Enter the maximum size next to ‘Attachment Maximum Size’. The default is 10 MB.
4. ‘Save’ your changes.

To configure the maximum 'index-able size of attachments':

By default, large attachment is defined as greater than 1 MB. The threshold for attachments that won't get excerpts can be modified using the system property atlassian.indexing.contentbody.maxsize, which takes a size in bytes.

Example

To specify 250 kb you would use the following JVM parameter:
-J-Datlassian.indexing.contentbody.maxsize=256000

Outcomes of Limiting Attachment Indexing Size

Limiting the size of attachment indexing has the following effects:

- Decreases the size of the index when large attachments are present.
- Decreases the memory used in indexing large attachments.
- Prevent excerpts of large attachments being displayed in search results.

For more details, please refer to the following JIRA issue.

Related Topics

No content found for label(s) other-settings.
Configuring Character Encoding

Confluence uses UTF-8 character encoding to deliver its pages.

⚠️ While it is possible to change the character encoding, unless you are certain of what you are doing, we recommend that you leave this as it is.

To change the character encoding:

1. Go to the ‘Administration Console’ and click on ‘General Configuration’ in the left panel.

2. Click ‘Edit’ at the bottom of the ‘Formatting and International Settings’ screen. For Confluence version earlier than 2.6.2, look for the ‘Options and Settings’ screen.


4. ‘Save’ your changes.

Related Links


Related Topics

No content found for label(s) other-settings.

Configuring HTTP Timeout Settings

When macros such as the RSS Macro make HTTP requests to servers which are down, a long timeout value is used. You can set this timeout value through a system parameter to avoid this.

To configure the HTTP Timeout Settings:

1. Choose Browse > Confluence Admin.

2. Select ‘General Configuration’ under the ‘Configuration’ heading in the left-hand panel.

3. Find the ‘Connection Timeouts’ section in the lower portion of the screen.

4. Click ‘Edit’ to adjust the settings:
   - **Adjust External connections enabled**: This setting allows system administrators to disable external connections so macros like the RSS Macro won’t be allowed to make connections to an external server. It’s provides protection against external servers providing insecure HTML, timing out or causing performance problems. The default setting is ‘true’.
   - **Connection Timeout (milliseconds)**: Sets the maximum time for a connection to be established. A value of zero means the timeout is not used. The default setting is ten seconds (10000).
   - **Socket Timeout (milliseconds)**: Sets the default socket timeout (SO_TIMEOUT) in milliseconds, which is the maximum time Confluence will wait for data. A timeout value of zero is interpreted as an infinite timeout. The default setting is ten seconds (10000).

Configuring Indexing Language

Changing the indexing language defined in Confluence may improve the accuracy of Confluence search results, if the majority of the content of your site is in some language other than English. Confluence supports content indexing in English (default), German, Russian, Chinese, CJK, Custom Japanese, French, Brazilian, Czech and Greek.

To configure a different indexing language:
1. Go to the ‘Administration Console’ and click ‘General Configuration’ in the left-hand panel.
2. Click any of the ‘Edit’ links.
3. Select the ‘Indexing Language’ from the dropdown list in the ‘Formatting and International Settings’ section.
4. Click ‘Save’.

Related Topics

Choosing a Default Language
Installing a Language Pack
Content Index Administration
Rebuild the Content Indices from Scratch
Creating a Lowercase Page Title Index

Configuring Number Formats

To change the number formats:
1. Go to the ‘Administration Console’ and click on ‘General Configuration’ in the left panel.
2. Click ‘Edit’ at the bottom of the ‘Options and Settings’ screen.
   - There are two number format settings:
     - Long Number Format
     - Decimal Number Format
3. Change the formats using the guidelines in this document.
4. ‘Save’ your changes.

Related Topics

No content found for label(s) other-settings.

Configuring Shortcut Links

Shortcut links provide a quick way of linking to resources that are frequently referenced from Confluence. When you create a shortcut link, you assign a key to an URL so that, when editing, a user can type just the key instead of the complete URL.

Here is an example:

Most Google searches look like this: http://www.google.com/search?q=. If you create a shortcut for this search with the key ‘google’, every time a user needs to use http://www.google.com/search?q=sear

searchterms, they can just type [searchterms@google] instead.

Here is a screenshot showing the shortcuts currently defined on http://confluence.atlassian.com:

<table>
<thead>
<tr>
<th>Key</th>
<th>Expanded Value</th>
<th>Default Alias</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache</td>
<td><a href="http://www.google.com/search?q=cache">http://www.google.com/search?q=cache</a>;</td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>imdb</td>
<td><a href="http://us.imdb.com?Title">http://us.imdb.com?Title</a>?</td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>jira</td>
<td><a href="http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=">http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=</a></td>
<td>JIRA Issue %s</td>
<td>Remove</td>
</tr>
<tr>
<td>google/groups</td>
<td><a href="http://groups.google.com/groups?q=">http://groups.google.com/groups?q=</a></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>google</td>
<td><a href="http://www.google.com/search?q=">http://www.google.com/search?q=</a></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>dictionary</td>
<td><a href="http://www.dict.org/bin/Dict?Database=%25&amp;Form=Dict&amp;Strategy=%25&amp;Query=">http://www.dict.org/bin/Dict?Database=%&amp;Form=Dict&amp;Strategy=%&amp;Query=</a></td>
<td></td>
<td>Remove</td>
</tr>
</tbody>
</table>
Shortcut links are added and maintained by Confluence administrators from the Administration Console.

Creating Shortcut Links

To create a shortcut link:

1. Go to the Administration Console and click Shortcut Links in the left panel.
2. Enter a Key for your shortcut. This is the shortcut name a user will use to reference the URL.
3. Enter the Expanded Value. This is the URL for the link. You can use ‘%s’ in the URL to specify where the user's input is inserted. If there is no ‘%s’ in the URL, the user's input will be put at the end.
4. (Optional. Available in Confluence version 2.3 and later.) Enter a Default Alias. This is the text of the link which will be displayed on the page where the shortcut is used, with the user's text being substituted for ‘%s’.
5. Click Save.

Using Shortcut Links

Enter a shortcut link on the Advanced tab of the Insert Link dialog. See Linking to Pages for details.

Specify in the link what should be appended to the end of the shortcut URL, followed by an at-sign (@) and the key of the shortcut. Shortcut names are case-insensitive. So, for example, using the keys shown in the above screenshot:

<table>
<thead>
<tr>
<th>To link to...</th>
<th>Type this</th>
<th>Resulting URL</th>
<th>Demonstration</th>
</tr>
</thead>
<tbody>
<tr>
<td>a JIRA issue</td>
<td>CONF-1000@JIRA</td>
<td><a href="http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=CONF-1000">http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=CONF-1000</a></td>
<td>CONF-1000</td>
</tr>
<tr>
<td>a Google search</td>
<td>Atlassian Confluence@Google</td>
<td><a href="http://www.google.com/search?q=Atlassian+Confluence">http://www.google.com/search?q=Atlassian+Confluence</a></td>
<td>Atlassian Confluence@Google</td>
</tr>
</tbody>
</table>

Deleting Shortcut Links

Shortcut links are listed on the Shortcut Links tab of the Administration Console. Click Remove to delete the shortcut.

Related Topics

Configuring Time and Date Formats

Confluence allows you to localise the formats used to display dates and times within the web interface. The settings use the syntax of Java’s SimpleDateFormat class (described below).

To change the time and date formats:

1. Go to the ‘Administration Console’ and click on ‘General Configuration’ in the left panel.
2. Click ‘Edit’ at the bottom of the ‘Options and Settings’ screen.
   - There are three time and date format settings:
     - Time Format: displaying only the time of day (for example, when each news item is posted)
     - Date Time Format: displaying both the date and the time of day (for example, in historical versions of pages)
• Date Format: displaying only the date (for example, the creation and most recent modification dates of pages)

3. Change the formats using the guidelines in this document.

4. ‘Save’ your changes.

Related Links
• Java 1.4.2 SimpleDateFormat API

Related Topics
No content found for label(s) other-settings.

Known Issues with Enterprise or Webhosting environments

When you attempt to run Confluence, you may get the following error:

```
java.security.AccessControlException: access denied (java.lang.RuntimePermission accessDeclaredMembers)
    at java.security.AccessControlContext.checkPermission(AccessControlContext.java(Compiled Code))
    at java.security.AccessController.checkPermission(AccessController.java(Compiled Code))
    at java.lang.SecurityManager.checkPermission(SecurityManager.java(Compiled Code))
```

Some of the libraries Confluence relies on to function make use of features of the Java language that may be restricted by Java security policies. This does not normally cause any problems: the default security configuration of most application servers will happily run Confluence. However, in some shared-hosting or enterprise environments, security settings may be such that Confluence can not function.

The permissions required by Confluence to run are detailed in the sample policy file below. You may need to give this information to your systems administrator so that they can be deployed with the Confluence application.

```
grant codeBase "file:${catalina.home}/webapps/confluence/-" {
    permission java.security.AllPermission;
};

grant {
    permission java.lang.RuntimePermission "accessDeclaredMembers";
    permission java.lang.reflect.ReflectPermission "suppressAccessChecks";
    permission java.lang.RuntimePermission "defineCGLIBClassInJavaPackage";
};
```

Configuring System Properties
This page describes how to set Java properties and options on startup for Confluence Stand-alone and EAR/WAR versions.
See [How to Fix Out of Memory Errors by Increasing Available Memory](#) for specific instructions for OutOfMemory Errors.

---

### Linux

**To Configure System Properties in Linux Installations,**

1. From `<confluence-install>/bin` (Stand-alone) or `<Tomcat-home>/bin` (EAR-WAR installation), open `setenv.sh`.
2. Find the section `JAVA_OPTS=`
3. Refer to the list of parameters **below**.

- Add all parameters in a space-separated list, inside the quotations.

### Windows (starting from .bat file)

**To Configure System Properties in Windows Installations When Starting from the .bat File,**

1. From `<confluence-install>/bin` (Stand-alone) or `<Tomcat-home>/bin` (EAR-WAR installation), open `setenv.bat`.
2. Find the section `set JAVA_OPTS=%JAVA_OPTS%`
3. Refer to the list of parameters **below**.

- Add all parameters in a space-separated list. Make sure to keep the string `%JAVA_OPTS%` in place.

### Windows Service

There are two ways to configure system properties when you [Start Confluence Automatically on Windows as a Service](#), either via **command line** or in the **Windows Registry**

---

**Setting Properties for Windows Services via Command Line**
### Setting Properties for Windows Services via Command Line

1. Identify the name of the service that Confluence is installed as in Windows (Control Panel > Administrative Tools > Services):

   ![Confluence Service](image)

   In the above example, the **SERVICENAME** is: JIRA030908110721. Find the Confluence equivalent.

2. Open the command window from Start >> Run >> type in 'cmd' >> Enter

3. `cd` to the bin directory of your Confluence instance, or the bin directory of your Tomcat installation if your are running Confluence EAR/WAR.

4. Run:

   ```
   tomcat6w \ES\%SERVICENAME%
   ```

   In the above example, it would be `tomcat6w \ES\JIRA030908110721`

5. Click on the Java tab to see the list of current start-up options:

   ![Java Tab](image)

6. Append any new option on its own new line by adding to the end of the existing Java Options. Refer to the list of parameters below.

---

### Setting Properties for Windows Services via the Windows Registry

In some versions of Windows, there is no option to add Java variables to the service. In these cases, you must add the properties by viewing the option list in the registry.
To Set Properties for Windows Services via the Windows Registry,

1. Go to {{Start >> Run, and run "regedit32.exe".}

2. Find the Services entry:
   - **32-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Apache Software Foundation >> Procrun 2.0 >> Confluence
   - **64-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Wow6432Node >> Apache Software Foundation >> Procrun 2.0 >> Confluence

3. To change existing properties, especially increasing Xmx memory, double-click the appropriate value.

4. To change additional properties, double-click options.

5. Refer to the list of parameters [below](#). Enter each on a separate line.

### Verifying Your Settings

To see what Confluence is using, check [Viewing System Properties](#).

### Recognised System Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Since</th>
<th>Default Value</th>
<th>Module...</th>
<th>Effect</th>
</tr>
</thead>
</table>

[Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.](#)
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Version</th>
<th>Default Value</th>
<th>Property Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>atlassian.forceSchemaUpdate</td>
<td>1.0</td>
<td>false</td>
<td>atlassian-config</td>
<td>By default, Confluence will only run its database schema update when it detects that it has been upgraded. This flag will force Confluence to perform the schema update on system startup.</td>
</tr>
<tr>
<td>confluence.home</td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
<td>If this system property is set, Confluence will ignore the contents of the confluence-init.properties file, and use this property as the setting for the Confluence Home directory.</td>
</tr>
<tr>
<td>confluence.devmode</td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
<td>Enables additional debugging options that may be of use to Confluence developers (additionally it changes spring bean creation to use lazy initialization by default to decrease startup time). Do not enable this flag on a production system.</td>
</tr>
<tr>
<td>confluence-disable.mailpolling</td>
<td>2.4</td>
<td>false</td>
<td>Confluence</td>
<td>If set to &quot;true&quot;, will prevent Confluence from retrieving mail for archiving within spaces. Manually triggering &quot;check for new mail&quot; via the web UI will still work. This property has no effect on outgoing mail.</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>confluence.i18n.reloadbundles</td>
<td>1.0</td>
<td>true</td>
<td>Setting this property will cause Confluence to reload its i18n resource bundles every time an internationalised string is looked up. This can be useful when testing translations, but will make Confluence run <strong>insanely slowly</strong>.</td>
<td></td>
</tr>
<tr>
<td>confluence.ignore.debug.logging</td>
<td>1.0</td>
<td>true</td>
<td>Confluence will normally log a severe error message if it detects that DEBUG level logging is enabled (as DEBUG logging generally causes a significant degradation in system performance). Setting this property will suppress the error message.</td>
<td></td>
</tr>
<tr>
<td>confluence.jmx.disabled</td>
<td>3.0</td>
<td>false</td>
<td>If set to &quot;true&quot;, will disable Confluence's JMX monitoring. This has the same effect as setting the &quot;enabled&quot; property to false in WEB-INF/classes/jmxC OnText.xml</td>
<td></td>
</tr>
<tr>
<td>confluence.optimize.index.module</td>
<td>2.2</td>
<td>20</td>
<td>Number of index queue flushes before the index is optimised.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.plugins.bundled.disable</td>
<td>2.9</td>
<td>false</td>
<td>Confluence</td>
<td>Starts confluence without bundled plugins. May be useful in a development environment to make Confluence start quicker, but since bundled plugins are necessary for some of Confluence's core functionality, this property should not be set on a production system.</td>
</tr>
<tr>
<td>atlassian.mail.fetchdisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence</td>
<td>Disables mail fetching services for IMAP and POP</td>
</tr>
<tr>
<td>atlassian.mail.senddisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence and atlassian-mail</td>
<td>Disables sending of mail</td>
</tr>
<tr>
<td>atlassian.disable.caches</td>
<td>2.4</td>
<td>true</td>
<td>atlassian-plugins, atlassian-cache-servlet</td>
<td>Setting this property will disable conditional get and expires: headers on some web resources. This will significantly slow down the user experience, but is useful in development if you are frequently changing static resources and don't want to continually flush your browser cache.</td>
</tr>
<tr>
<td>confluence.html.encode.automatic</td>
<td>2.9</td>
<td></td>
<td>Confluence</td>
<td>Setting this property forces the antixss encoding on or off, overriding the behaviour dictated by settings. The default behaviour differs between Confluence versions.</td>
</tr>
<tr>
<td>org.osgi.frame.work.bootdelegation</td>
<td>2.10</td>
<td>empty</td>
<td>atlassian-plugins</td>
<td>Comma-separated list of package names to provide from application for OSGi plugins. Typically required when profiling Confluence. For example: &quot;com.jprofiler,.com.yourkit.&quot;.</td>
</tr>
<tr>
<td>confluence.diff.pool.size</td>
<td>3.1</td>
<td>20</td>
<td>Confluence</td>
<td>Maximum number of concurrent diffs. When that number is exceeded, additional attempts by RSS feeds to create diffs are ignored and logged. (The RSS requests succeed, they are just missing diffs).</td>
</tr>
<tr>
<td>confluence.diff.timeout</td>
<td>3.1</td>
<td>1000</td>
<td>Confluence</td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>confluence.html.diff.timeout</td>
<td>4.0</td>
<td>10000</td>
<td>Confluence</td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Version</td>
<td>Value</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>atlassian.user.experimentalMapping</td>
<td>2.10</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes the relationship between local users and local groups to reduce performance degradation when adding a local user to a local group with a large number of users. Please note, setting this property can slow down other user management functions. We recommend that you set it only if you are experiencing performance problems when adding local users to large local groups. Please refer to CONF-123 19, fixed in Confluence 3.1.1.</td>
</tr>
<tr>
<td>confluence.import.experimental-importer</td>
<td>3.2</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes Confluence to use the Experimental XML Importer. It is designed to be a more stable implementation but, at the time of the release of 3.2, the importer is largely untested and thus not supported.</td>
</tr>
<tr>
<td>atlassian.webresource.disable.minification</td>
<td>3.3</td>
<td>false</td>
<td>atlassian-plugins</td>
<td>Disables automatic minification of JavaScript and CSS resources served by Confluence.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Value</td>
<td>See “Effect”</td>
<td>Confluence</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>--------</td>
<td>--------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>index.queue.thread.count</td>
<td>3.3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sets the number of threads to be used for the reindex job. The value has to be in the range of 1 to 10 (inclusive), i.e. at least one thread but no more than 10 threads will be used. There is no default value, i.e.

- If you don't set `index.queue.thread.count`, the number of threads to be used are calculated based on the number of objects that need to be reindexed and the number of processors available (a maximum of 10 threads will be used).
- If you set `index.queue.thread.count=2`, then two threads will be used to reindex the content (regardless of the number of objects to be reindexed or the number of processors available)
- If you set `index.queue.thread.count=200`, then ten threads (the maximum allowed) will be used to reindex the content.
<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index.queue.batch.size</td>
<td>3.3</td>
<td>Size of batches used by the indexer. Reducing this value will reduce the load that the indexer puts on the system, but indexing takes longer. Increasing this value will cause indexing to be completed faster, but puts a higher load on the system. Normally this setting does not need tuning.</td>
</tr>
<tr>
<td>password.confirmation.disabled</td>
<td>false</td>
<td>This property disables the password confirmation functionality that Confluence uses as an additional security measure. With this property set, Confluence will not require password confirmation for the following actions: administrative actions, change of email address and Captcha for failed logins. Disabling password confirmations is useful if you are using a custom authenticator.</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td>true</td>
</tr>
<tr>
<td>upm.pac.disable</td>
<td></td>
<td>false</td>
</tr>
<tr>
<td>confluence.reindex.documents.to.pop</td>
<td>3.5.9</td>
<td>20</td>
</tr>
<tr>
<td>confluence.reindex.attachments.to.pop</td>
<td>3.5.9</td>
<td>10</td>
</tr>
<tr>
<td>Setting</td>
<td>Version</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>confluence.upgrade.active.directory</td>
<td>3.5.11</td>
<td>false</td>
</tr>
<tr>
<td>com.atlassian.logout.disable.session.invalidate</td>
<td>4.0</td>
<td>false</td>
</tr>
<tr>
<td>Property</td>
<td>Since</td>
<td>Default Value</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>---------------</td>
</tr>
<tr>
<td>atlassian.forceSchemaUpdate</td>
<td>1.0</td>
<td>false</td>
</tr>
</tbody>
</table>

**Related Topics**

- [Recognised System Properties](#)
- [How to Fix Out of Memory Errors by Increasing Available Memory](#)

**Recognised System Properties**

Confluence supports some configuration and debugging settings that can be enabled through Java system properties. System properties are usually set by passing the `-D` flag to the Java virtual machine in which Confluence is running. See the full instructions: [Configuring System Properties](#).

⚠️ The information on this page does not apply to Confluence OnDemand.
<table>
<thead>
<tr>
<th>Property</th>
<th>Version</th>
<th>Value</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.home</td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
<td>If this system property is set, Confluence will ignore the contents of the confluence-init.properties file, and use this property as the setting for the Confluence Home directory.</td>
</tr>
<tr>
<td>confluence.devmode</td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
<td>Enables additional debugging options that may be of use to Confluence developers (additionally it changes spring bean creation to use lazy initialization by default to decrease startup time). Do not enable this flag on a production system.</td>
</tr>
<tr>
<td>confluence.disable.mailpolling</td>
<td>2.4</td>
<td>false</td>
<td>Confluence</td>
<td>If set to &quot;true&quot;, will prevent Confluence from retrieving mail for archiving within spaces. Manually triggering &quot;check for new mail&quot; via the web UI will still work. This property has no effect on outgoing mail.</td>
</tr>
<tr>
<td>confluence.i18n.reloadbundles</td>
<td>1.0</td>
<td>true</td>
<td>Confluence</td>
<td>Setting this property will cause Confluence to reload its i18n resource bundles every time an internationalised string is looked up. This can be useful when testing translations, but will make Confluence run <em>insanely slowly</em>.</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>confluence.ignore.debug.logging</td>
<td>1.0</td>
<td>true</td>
<td>Confluence will normally log a severe error message if it detects that DEBUG level logging is enabled (as DEBUG logging generally causes a significant degradation in system performance). Setting this property will suppress the error message.</td>
<td></td>
</tr>
<tr>
<td>confluence.jmx.disabled</td>
<td>3.0</td>
<td>false</td>
<td>Confluence If set to &quot;true&quot;, will disable Confluence's JMX monitoring. This has the same effect as setting the &quot;enabled&quot; property to false in WEB-INF/classes/jmxContext.xml</td>
<td></td>
</tr>
<tr>
<td>confluence.optimize.index.modulo</td>
<td>2.2</td>
<td>20</td>
<td>Confluence Number of index queue flushes before the index is optimised.</td>
<td></td>
</tr>
<tr>
<td>confluence.plugins.bundled.disable</td>
<td>2.9</td>
<td>false</td>
<td>Confluence Starts confluence without bundled plugins. May be useful in a development environment to make Confluence start quicker, but since bundled plugins are necessary for some of Confluence's core functionality, this property should not be set on a production system.</td>
<td></td>
</tr>
<tr>
<td>atlassian.mail.fetchdisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence Disables mail fetching services for IMAP and POP</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Category</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><code>atlassian.mail.senddisabled</code></td>
<td>3.5</td>
<td>false</td>
<td>Confluence and atlassian-mail</td>
<td>Disables sending of mail</td>
</tr>
<tr>
<td><code>atlassian.disable.caches</code></td>
<td>2.4</td>
<td>true</td>
<td>atlassian-plugins, atlassian-cache-servlet</td>
<td>Setting this property will disable conditional get and expires: headers on some web resources. This will significantly slow down the user experience, but is useful in development if you are frequently changing static resources and don’t want to continually flush your browser cache.</td>
</tr>
<tr>
<td><code>confluence.html.encode.automatic</code></td>
<td>2.9</td>
<td></td>
<td>Confluence</td>
<td>Setting this property forces the antixss encoding on or off, overriding the behaviour dictated by settings. The default behaviour differs between Confluence versions.</td>
</tr>
<tr>
<td><code>org.osgi.framework.bootdelegation</code></td>
<td>2.10</td>
<td>empty</td>
<td>atlassian-plugins</td>
<td>Comma-separated list of package names to provide from application for OSGi plugins. Typically required when profiling Confluence. For example: &quot;com.jprofiler.,com.yourkit.&quot;.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Version</td>
<td>Value</td>
<td>Confluence</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------</td>
<td>-------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>confluence.dif.f.pool.size</td>
<td>3.1</td>
<td>20</td>
<td>Confluence</td>
<td>Maximum number of concurrent diffs. When that number is exceeded, additional attempts by RSS feeds to create diffs are ignored and logged. (The RSS requests succeed, they are just missing diffs).</td>
</tr>
<tr>
<td>confluence.dif.f.timeout</td>
<td>3.1</td>
<td>1000</td>
<td>Confluence</td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>confluence.htm.l.diff.timeout</td>
<td>4.0</td>
<td>10000</td>
<td>Confluence</td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Setting</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>---------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>atlassian.user.experimentalMapping</code></td>
<td>2.10</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes the relationship between local users and local groups to reduce performance degradation when adding a local user to a local group with a large number of users. Please note, setting this property can slow down other user management functions. We recommend that you set it only if you are experiencing performance problems when adding local users to large local groups. Please refer to <a href="#">CONF-123</a>, fixed in Confluence 3.1.1.</td>
</tr>
<tr>
<td><code>confluence.import.use-experimental-importer</code></td>
<td>3.2</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes Confluence to use the Experimental XML Importer. It is designed to be a more stable implementation but, at the time of the release of 3.2, the importer is largely untested and thus not supported.</td>
</tr>
<tr>
<td><code>atlassian.webr.esource.disable.minification</code></td>
<td>3.3</td>
<td>false</td>
<td>atlassian-plugins</td>
<td>Disables automatic minification of JavaScript and CSS resources served by Confluence.</td>
</tr>
<tr>
<td>Variable</td>
<td>Value</td>
<td>See “Effect”</td>
<td>Confluence</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>index.queue.thread.count</td>
<td>3.3</td>
<td></td>
<td>Sets the number of threads to be used for the reindex job. The value has to be in the range of 1 to 10 (inclusive), i.e. at least one thread but no more than 10 threads will be used. There is no default value, i.e.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If you don't set <code>index.queue.thread.count</code>, the number of threads to be used are calculated based on the number of objects that need to be reindexed and the number of processors available (a maximum of 10 threads will be used).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If you set <code>index.queue.thread.count=2</code>, then two threads will be used to reindex the content (regardless of the number of objects to be reindexed or the number of processors available)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• If you set <code>index.queue.thread.count=200</code>, then ten threads (the maximum allowed) will be used to reindex the content.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Value</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>index.queue.batch.size</td>
<td>3.3</td>
<td>Size of batches used by the indexer. Reducing this value will reduce the load that the indexer puts on the system, but indexing takes longer. Increasing this value will cause indexing to be completed faster, but puts a higher load on the system. Normally this setting does not need tuning.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>password.confirmation.disabled</td>
<td>false</td>
<td>This property disables the password confirmation functionality that Confluence uses as an additional security measure. With this property set, Confluence will <em>not</em> require password confirmation for the following actions: administrative actions, change of email address and Captcha for failed logins. Disabling password confirmations is useful if you are using a custom authenticator.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td>true</td>
<td>Setting this property to &quot;false&quot; disables the detection of browser language headers, effectively restoring Confluence behaviour to that of earlier releases. Setting this property to &quot;true&quot; enables the detection of the language headers sent by the browser. Confluence will change the UI language based on the browser headers. See documentation on how users can choose a language preference.</td>
<td></td>
</tr>
<tr>
<td>upm.pac.disable</td>
<td>Universal Plugin Manager 1.5</td>
<td>false</td>
<td>Universal Plugin Manager (UPM) When this property is set to true, then UPM will not try to access the Atlassian Plugin Exchange. This is useful for application servers that do not have access to the Internet. See the UPM documentation.</td>
<td></td>
</tr>
<tr>
<td>confluence.reindex.documents.to.pop</td>
<td>3.5.9</td>
<td>20</td>
<td>Confluence Indicates how many objects each indexing thread should process at a time during a full re-index. Please note that this number does not include attachments</td>
<td></td>
</tr>
<tr>
<td>confluence.reindex.attachments.to.pop</td>
<td>3.5.9</td>
<td>10</td>
<td>Confluence Indicates how many attachments each indexing thread should process at a time during a full re-index.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Value</td>
<td>Confluence</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>confluence.upgrade.active.directory</td>
<td>3.5.11</td>
<td>false</td>
<td>Confluence forces Confluence to treat any LDAP directories it migrates as Active Directory, rather than relying on looking for sAMAccountName in the username attribute. This is necessary if you are upgrading from before Confluence 3.5, and need to use an attribute other than sAMAccountName to identify your users and are seeing LDAP: error code 4 - Sizelimit Exceeded exceptions in your logs. For more details, see Unable to Log In with Confluence 3.5 or Later Due to 'LDAP error code 4 - Sizelimit Exceeded'</td>
<td></td>
</tr>
<tr>
<td>com.atlassian.logout.disable.session.invalidation</td>
<td>4.0</td>
<td>false</td>
<td>Confluence disables the session invalidation on log out. As of 4.0 the default behaviour is to invalidate the JSession assigned to a client when they log out. If this is set to true the session is kept active (but the user logged out). This may be valuable when using external authentication systems, but should generally not be needed.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Value</td>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>officeconnector.spreadsheet.xlsxmaxsize</td>
<td>4.0.5</td>
<td>2^21</td>
<td>Office Connector Indicates the maximum size in bytes of an Excel file that can be viewed using the viewxls macro. If empty, the maximum size defaults to 2Mb. See CONF-21043 for more details.</td>
<td></td>
</tr>
<tr>
<td>com.atlassian.confluence.extensions.calendar3.display.events.calendar.maxpeircalendar</td>
<td>200</td>
<td>Team Calendars</td>
<td>Specifies the maximum number of events per calendar. This property is effective only if the Team Calendars plugin is installed on your Confluence site.</td>
<td></td>
</tr>
</tbody>
</table>

**RELATED TOPICS**

**Configuring System Properties**

**Application Server Configuration**

The following pages contain information about configuring your application server for Confluence:

- Application Server URL encoding
- Managing Application Server Memory Settings
- Switching to Apache Tomcat

**Application Server URL encoding**

Application servers may have different settings for character encodings. We strongly suggest setting this to UTF-8 where possible.

Information on setting the character encoding is available at:

- Configuring Tomcat's URI Encoding

**Configuring Tomcat's URI encoding**

By default, Tomcat uses ISO-8859-1 character encoding when decoding URLs received from a browser. This can cause problems when Confluence's encoding is UTF-8, and you are using international characters in attachment or page names.

1. Edit `conf/server.xml` and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8090"/>
   ```

2. Add a `URIEncoding="UTF-8"` property to the connector:
3. Restart Tomcat

If you are using mod_jk

You should apply the same URIEncoding parameter as above to the AJP connector if you are using mod_jk, and add the following option to your Apache mod_jk configuration:

```xml
<Connector port="8090" URIEncoding="UTF-8"/>
```

```
JkOptions +ForwardURICompatUnparsed
```

More information using Apache with Tomcat

For comprehensive examples of how to use Tomcat and Apache with Confluence, see Running Confluence behind Apache.

Managing Application Server Memory Settings

The minimum and maximum JVM heap space allocated to the application server affects performance. Confluence administrators may wish to modify this value from the defaults depending on their server load. This document only provides guidelines rather than rules, so administrators optimising for performance should use this document as a starting point only.

⚠️ For a comprehensive overview of memory management, and memory tuning in Confluence under Sun JRE, please read Garbage Collector Performance Issues

Testing For Optimum Memory Settings

In the general case, both JIRA & Confluence users will benefit from setting the minimum and maximum values identical. In larger installations, there is benefit to memory tuning, if there is a perceived performance issue. If you are experiencing Out of Memory Heap errors, try doubling the -Xmx and -Xms values for your installation to see if this resolves or helps resolve your issue. If not, please lodge a support ticket as there may be other factors contributing.

Memory usage is most likely to be maximised under peak load, and when creating a site XML backup. In many cases, the backup can be the cause of the OOM, so increase -Xmx values and verify if a backup was occurring at the time of OOM. A quick rule of thumb for gauging the success of a memory adjustment is using simple anecdotal evidence from users. Is it snappier? The same? How does it handle while a backup is occurring?

⚠️ Atlassian recommends in normal use, to disable the XML backup and use a Production Backup Strategy.

- If you normally perform manual XML site backups on your server, test your maximum memory requirements by performing a site XML backup while the server is under maximum load
- If you do not create manual XML site backups, simply monitor the server while under maximum load
Applying Memory Settings

See [How to Fix Out of Memory Errors by Increasing Available Memory](#).

**Related Topics**
- Garbage Collector Performance Issues
- How to Fix Out of Memory Errors by Increasing Available Memory
- Server Hardware Requirements Guide
- Performance Tuning
- Troubleshooting Slow Performance Using Page Request Profiling
- Tomcat JVM options and Modify the Default JVM Settings

**Switching to Apache Tomcat**

Apache Tomcat is the only application server supported for Confluence. To move Confluence from an application server (e.g. WebSphere) to Tomcat using the same database, follow the instructions below.

Please note, you cannot simply copy the WAR file or expanded WAR directory from an old Confluence EAR/WAR version in the old application server to Tomcat. **This will not work.**

Follow these instructions:

1. **Before You Start**
2. **Backing Up**
3. **Switching Application Servers**
4. **Applying Customisations**
   - Confluence Server
   - Plugins
   - Look and Feel
   - Performance
   - Advanced Customisations
5. **Testing Confluence**

**1. Before You Start**

1. The following instructions will only work if you are running the same major version of Confluence on both application servers. If you are running different major versions of Confluence, you will need to upgrade Confluence before you can switch to Tomcat.
2. Note that you need current software maintenance, as the process for changing application servers involves installing Confluence or Confluence EAR-WAR.
3. If the environment (e.g. the database system, the operating system and so on) that you are running Confluence in has changed, please ensure it still complies with the Confluence [System Requirements](#).
4. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user login) has sufficient permissions to modify the database schema.
5. Note any customisations that you have made to Confluence, e.g. enabled/installed plugins, modified layouts, custom themes, etc. You will need to reapply these after you have switched to Tomcat. You can view the list of customisations in the Reapplying Customisations section below.
6. We recommend that you **do not** run any other applications in your Tomcat application server that is running Confluence, to prevent performance issues.

**2. Backing Up**

Before you switching to Tomcat, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using
1. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade and check that the backup was created properly. If you are not a database expert or unfamiliar with the backup-restore facilities of your database, you should try to restore the backup to a different system to ensure that the backup worked before proceeding. This recommendation is not specific to Confluence usage, but it is good practice to ensure that your database backup is not broken.

   The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes, you don't need to back it up since it is stored in the home directory. But you should not use this database for production systems anyway, so if you happen to accidentally still use HSQLDB in a production system, please **migrate to a proper database before** the upgrade.

2. **Switching Application Servers**

   1. Install Confluence on your new application server. We recommend that you **install Confluence** (from the zip file) as it is preconfigured with Tomcat. If you want more control over the installation process, you can **install Confluence EAR-WAR on Tomcat** however this requires more manual configuration.

      Regardless of which method you choose, as part of the installation process:
      - If you are connecting to your database via a standard JDBC connection, enter the URL, username and password for your existing database.
      - If you are connecting to your database via datasource, use the settings for your existing database when you configure the JDBC datasource in your new server. Refer to the appropriate guide below:
          - [Configuring a MySQL Datasource in Apache Tomcat](#)
          - [Configuring a SQL Server Datasource in Apache Tomcat](#)
          - [Configuring a PostgreSQL Datasource in Apache Tomcat](#)

   2. Copy the following files from your old Confluence installation to your new one:

      - `{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\confluence-init.properties`
      - `{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\atlassian-user.xml`
      - `{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\osuser.xml` (*copy this over if you are using JIRA user management*)
      - `{CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\seraph-config.xml` (*copy this over if you using custom SSO*)
      - `{CONFLUENCE_INSTALL}\confluence\WEB-INF\web.xml` (*copy this over if you have previously modified it, e.g. to configure a datasource*)

   3. Make sure you shutdown the old server before you startup the new one.

   4. If you are running the new application server on a different machine to the old one, carry out the following actions as soon as you start the new server:
      - **Re-index your data.**
      - Make sure that the **attachments location** is valid for the new server.

   5. If you have applied special settings to their Confluence server and/or Confluence look and feel, you will need to reapply these customisations as described in **below.**

4. **Applying Customisations**

   - the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   - **Tip:** Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory.
After switching to Tomcat, you need to review any customisations and other special configurations you previously used for your Confluence instance, and re-apply if necessary. This section also contains some Tomcat-specific customisations that you may wish to considering applying, if you haven’t used Confluence with Tomcat before.

⚠️ Before you apply customisations

Please ensure that your Confluence installation works correctly on Tomcat without any customisations before you apply any of customisations listed below. This will make it easier to identify problems, if you run into trouble during the switch to Tomcat.

**Confluence Server**

- For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.
- If you are using the Confluence edition and you have previously defined a **CATALINA_HOME environment variable**, please check that it points to the correct path for the new Confluence Tomcat server.
- If you were previously running **Confluence on a non-standard port**, edit your new `<Installation-DIrectory>\conf\server.xml` file as described in [Change listen port for Confluence](#).

**Plugins**

- If you were previously using any **plugins**, install the latest compatible version and disable any plugins that are incompatible with your new instance of Confluence. The easiest way to do this is to use the [Plugin Repository](#) in the Confluence Administration Console.

**Look and Feel**

- If you are using any **customised themes**, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.
- If you had previously customised the **default site or space layouts**, you will need to reapply your changes to the new defaults as described here. Please do not just copy your VM (velocity) files across. Ensure that Confluence works without your custom layouts then apply the layout via the Confluence Administration console.

**Performance**

- If the load on your Confluence instance is high, you may need more simultaneous connections to the database. Read more about this in the [Performance Tuning](#) guide.
- If you had previously modified the **memory flags** (`Xms` and `Xmx`) in either the `<Installation-Directory>\bin\setenv.sh` or the `<Installation-Directory>\bin\setenv.bat` file, you may want to make the modifications in your new installation. The parameters are specified in the `JAVA_OPTS` variable. See [How to Fix Out of Memory Errors by Increasing Available Memory](#) for more information.

**Advanced Customisations**

- If you were previously running **Confluence over SSL**, you will need to reapply your configuration as described in [Running Confluence Over SSL or HTTPS](#).
- If you were using a custom SSO authenticator, change `seraph-config.xml` to the correct authenticator.
- If you had changed the **Confluence interface text**, you will need to copy over the `ConfluenceActionSupport.properties` file.
- If you had previously modified the Confluence **source code**, you will need to reapply your changes to the new version.

5. Testing Confluence

Make sure you test **Confluence on the new server** before deploying it in production.

The [Working with Confluence Logs](#) document contains the locations for the application logs, if you need to refer
Database Configuration

This document provides information on configuring an external database.

The embedded HSQL database for evaluation purposes

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the `database` folder under your Confluence Home directory. See also Important Directories and Files.

![Embedded Database is Not Suitable for Production Instances of Confluence](image)

Production instances of Confluence should use an external database. When using the default HSQLDB database, you run the risk of unrecoverable data loss due to not being transaction safe.

- Corruption is occasionally encountered after sudden power loss and can usually be corrected using this data recovery procedure.
- HSQLDB is still suitable for evaluation purposes, but the risk can only be eliminated by switching databases. External databases may also provide superior speed and scalability.

Selecting an external database

**Note:** Take time to choose your database wisely. The XML backup built into Confluence is not suited for migration or backup of large data sets. If you need to migrate later, you will need to use a third party database migration tool.

Below is more information on selecting and migrating to an external database:

- Migrating to a Different Database
- List Of Supported Databases
- Known Issues For Supported Databases

Database setup

Setup instructions are shown below.

- Database JDBC drivers
- Database Setup for Oracle
- Database Setup for SQL Server
- Database Setup For Any External Database
- Database Setup for PostgreSQL
- Database Setup For MySQL

Optimising database performance

To improve database responsiveness:

- Improving Database Performance
- Known Issues For Supported Databases

Database troubleshooting
For solving database-related problems:

- Troubleshooting External Database Connections
- Troubleshooting the Embedded Database (HSQL DB)
- Interpreting DB2 error codes
- Known Issues For Supported Databases

Obtain technical support from Troubleshooting Problems and Requesting Technical Support.

Notes

- Issue CONF-12599 requests a more robust strategy for migrating large Confluence sites.

Known Issues For Supported Databases

Supported Databases

Please refer to the Supported Platforms topic.

Troubleshooting

Known Issues For PostgreSQL
Known Issues For Oracle
Known Issues For MySQL
Known Issues For SQL Server
Known Issues For Db2

Configuring Database Character Encoding

The database used with Confluence should be configured to use the same character encoding as Confluence. The recommended encoding is Unicode UTF-8 (the equivalent for Oracle databases is AL32UTF8).

There are two places where character encoding may need to be configured:

- when creating the database
- when connecting to the database (JDBC connection URL or properties).

The configuration details for each type of database are different. Some examples are below.

On this page:

- JDBC connection settings
- Creating a UTF-8 database
- Updating existing database to UTF-8

⚠️ The information on this page does not apply to Confluence OnDemand.

JDBC connection settings

MySQL

Append "useUnicode=true to your JDBC URL:

```text
jdbc:mysql://hostname:port/database?useUnicode=true&characterEncoding=utf8
```

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
If you are modifying `confluence.cfg.xml` directly rather than via the Confluence Installation GUI, you'll need to escape out the & in the URL string as this is a reserved XML token and will break the syntax when the XML is parsed. An effective URL could be similar to:

```xml
<property
    name="hibernate.connection.url">jdbc:mysql://hostname:port
/database?useUnicode=true&amp;characterEncoding=utf8</property>
```

### Creating a UTF-8 database

**MySQL**

1. Create a UTF-8 database with binary UTF-8 collation.
   - Binary UTF-8 provides case-sensitive collation.

   ```sql
   CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;
   ```

2. You will also need to set the Server Characterset to utf8. This can be done by adding the following in `my.ini` for Windows or `my.cnf` for other OS. It has to be declared in the Server section, which is the section after `[mysqld]`:

   ```ini
   [mysqld]
   default-character-set=utf8
   ```

   If the above option does not work, try using `character_set_server=utf8` in lieu of `default-character-set=utf8`.

3. Use the `status` command to verify database character encoding information.
3. In some cases, the individual tables collation and character encoding may differ from the one that the database as a whole has been configured to use. Please use the command below to ensure all tables within your Confluence database are correctly configured to use UTF-8 character encoding and binary UTF-8 collation:

```
use confluence;
show table status;
```

Check for the value listed under the **Collation** column, to ensure it has been set to **utf8_bin** (that is, case-sensitive) collation for all tables. If not, then this can be changed by the following command, executed for each table in the Confluence database:

```
ALTER TABLE tablename CONVERT TO CHARACTER SET utf8 COLLATE utf8_bin;
```

Please substitute the `<tablename>` above, with each table within the confluence database.

Relevant MySQL manual for more detailed explanation:

- [Specifying Character Sets and Collations documentation](https://dev.mysql.com/doc/refman/5.0/en/collation-specification.html)
- [Connection Character Sets and Collations](https://dev.mysql.com/doc/refman/5.0/en/charset-connection.html)
- [SHOW TABLE STATUS Syntax](https://dev.mysql.com/doc/refman/5.0/en/show-table-status.html)
- [ALTER TABLE Syntax](https://dev.mysql.com/doc/refman/5.0/en/alter-table.html)

---

**PostgreSQL**
CREATE DATABASE confluence WITH ENCODING 'UNICODE';

Or from the command-line:

$ createdb -E UNICODE confluence

For more information see the PostgreSQL documentation.

For PostgreSQL running under Windows

Please note that international characters sets are only fully supported and functional when using PostgreSQL 8.1 and above under Microsoft Windows.

For PostgreSQL running under Linux

Please make sure you check the following to ensure proper handling of international characters in your database

When PostgreSQL creates an initial database cluster, it sets certain important configuration options based on the host environment. The command responsible for creating the PostgreSQL environment `initdb` will check environment variables such as `LC_CTYPE` and `LC_COLLATE` (or the more general `LC_ALL`) for settings to use as database defaults related to international string handling. As such it is important to make sure that your PostgreSQL environment is configured correctly before you install Confluence.

To do this, connect to your PostgreSQL instance using `psql` and issue the following command:

```
SHOW LC_CTYPE;
```

If `LC_CTYPE` is set to either "C" or "POSIX" then certain string functions such as converting to and from upper and lower case will not work correctly with international characters. Correct settings for this value take the form `<LOCAL>.<ENCODING>` (for example `en_AU.UTF8`).

If your `LC_CTYPE` is incorrect please check the PostgreSQL documentation for information on configuring database localisation. It is not easy to change these settings with a database that already contains data.

Updating existing database to UTF-8

MySQL database with existing data

For an existing database

If you're using a existing database, confirm the Character Encoding by executing the query:

```
SHOW VARIABLES LIKE 'character%';
```

```
SHOW VARIABLES LIKE 'collation%';
```

The results should be UTF-8.

Before proceeding with the following changes, please backup your database.

This example shows how to change your database from latin1 to utf8.
1. Dump the database to a text file using `mysqldump` tool from the command-line:
   
   ```
   mysqldump -p --default-character-set=latin1 -u <username> --skip-set-charset confluence > confluence_database.sql
   ```

2. Copy `confluence_database.sql` to `confluence_utf8.sql`.

3. Open `confluence_utf8.sql` in a text editor and change all character sets from 'latin1' to 'utf8'.

4. Encode all the latin1 characters as UTF-8:
   
   ```
   recode latin1=utf8 confluence_utf8.sql (the recode utility is described at http://directory.fsf.org/recode.html; it can actually be downloaded from http://recode.progiciels-bpi.ca/, and is available for Ubuntu via apt-get)
   ```

In MySQL:

1. DROP DATABASE confluence;

2. CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;

Finally, reimport the UTF-8 text file:

1. ```
   mysql -u <username> -p --default-character-set=utf8 --max_allowed_packet=64M confluence < /home/confluence/confluence_utf8.sql
   ```

To support large imports, the parameter '--max_allowed_packet=64M' used above sets the maximum size of an SQL statement to be very large. In some circumstances, you may need to increase it further, especially if attachments are stored in the database.

**Testing database encoding**

See Troubleshooting Character Encodings for a number of tests you can run to ensure your database encoding is correct.

**RELATED TOPICS:**

- [Character encodings in Confluence](#)
- [Known Issues for MySQL](#)
- [Database Setup Guides](#)
  - Database JDBC drivers
  - Database Setup for Oracle
  - Database Setup for SQL Server
  - Database Setup For Any External Database
  - Database Setup for PostgreSQL
  - Database Setup For MySQL

**Database JDBC drivers**

The JDBC drivers for all databases currently supported for Confluence are linked below. You will need to make the driver available to your application server, as described in the appropriate setup guide.

ℹ️ Please note, we bundle a number of JDBC drivers with Confluence, as shown below. You do not have to download or install the drivers for the relevant databases, if you are using a direct JDBC connection. If you are connecting via a datasource, you will still need to download and install the drivers manually.

**JDBC Driver Download Links**

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC Drivers Bundled with Confluence?</th>
<th>JDBC Drivers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Status</td>
<td>Version</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>PostgreSQL</td>
<td>✔️</td>
<td>8.4-701.jdbc3</td>
</tr>
<tr>
<td>MySQL</td>
<td>✔️</td>
<td>5.1.11</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>✔️</td>
<td>jTDS 1.2.2</td>
</tr>
<tr>
<td>Oracle</td>
<td>❌</td>
<td></td>
</tr>
<tr>
<td>DB2</td>
<td>❌</td>
<td></td>
</tr>
</tbody>
</table>

**Database Setup for Oracle**

This guide covers deploying the Confluence or Confluence WAR distributions with an Oracle database.

⚠️ **This database can only be set up by an Oracle database administrator (DBA)**

If you are not a DBA, you should not attempt to set up this database.

Oracle has a history of being extremely difficult to set up. If you do not have access to an experienced Oracle DBA in your organisation, you are recommended to select any free, scalable and easy-to-install alternative rather than proceeding with Oracle. Users evaluating Confluence are recommended to start with an alternative database and only consider migrating to Oracle after approval from their DBA. Atlassian's technical support for Oracle setup difficulties will also reflect the high minimum skill requirements for attempting an Oracle setup.

**Database Setup Information**

This setup guide must be used in conjunction with the list of Known Issues For Oracle. Please review that page before continuing.

**Schema Requirements**

Confluence can be deployed to a schema in any Oracle instance.

**Database Compatibility**

Please refer to Supported Platforms for information about supported database versions. If your version of Oracle is not supported, please upgrade to a supported version before installing Confluence.

Check your database drivers, to see if you need an update.

- For Oracle 11.1, use the 10.2.0.4 or 11.1.0.7.0 driver (Java 6 ojdbc6.jar).
- For Oracle 11.2, use the 11.2.0.1.0 driver (Java 6 ojdbc6.jar).

Tip: search for the jar filename on the download site.

Check that your version of Oracle does not have any known issues:
### Database Preparation

Tailor these instructions to your particular database version:

1. Perform any necessary database or driver upgrades. Download the latest compatible database drivers. See the Oracle JDBC driver FAQ.
2. Create a Confluence user and grant the connect and resource permissions only to the user:

   ```sql
   create user <user> identified by <password>;
   grant connect, resource to <user>;
   ```

3. Add a local "all_objects" view to the user's schema, so that there is no possibility that a table with the same name as one of the Confluence tables in another schema will cause any conflicts. This is a workaround for the bug CONF-3613:

   ```sql
   create view <user>.all_objects as
   select *
   from sys.all_objects
   where owner = upper('<user>');
   ```

   **⚠️** Do not grant the database user the select any table permission, or it can cause problems with other schemas, as per the same bug CONF-3613.

### Determining Your JDBC URL

The JDBC thin driver for Oracle use three different styles of URL:

<table>
<thead>
<tr>
<th>New Style</th>
<th>Old Style</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>jdbc:oracle:thin:@//[HOST][:PORT]/SERVICE</code></td>
<td><code>jdbc:oracle:thin:@[HOST][:PORT]:SID</code></td>
</tr>
</tbody>
</table>

You may be also interested in the relevant JIRA documentation to check the compatibility of your Oracle server and driver.

**Deploying Confluence with Oracle**

Complete the instructions for installing Confluence, then return to this document instead of proceeding to the Confluence Setup Guide.
The tnsnames style is required for connecting to an Oracle RAC cluster. This example has been broken up over multiple lines for clarity, but it should be compacted into a single line. These may need more analysis than documented below, so you should seek the assistance of an experienced DBA.

If you use the new style URL, then SERVICE can be either an SID or Service Name, but if you use the old style URL, it can only be the SID.

You should be able to determine the host, port, service name, and/or SID by getting a DBA to run the following command as the user running oracle (by default "oracle"):

```bash
lsnrctl status
```

For reference, here is a sample output:

tnsnames

```sql
jdbc:oracle:thin:@(DESCRIPTION=
  (SDU=32768)
  (enable=broken)
  (LOAD_BALANCE=yes)
  (FAILOVER=yes)
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver1.example.com)
    (PORT=1525))
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver2.example.com)
    (PORT=1525))
  (CONNECT_DATA=
    (SERVICE_NAME=CONFDB)))
```
SNRCTL for Linux: Version 11.2.0.2.0 - Beta on 29-JUN-2012 15:20:59
Copyright (c) 1991, 2010, Oracle. All rights reserved.
Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=IPC)(KEY=EXTPROC_FOR_XE)))

STATUS of the LISTENER
---------------------------------------------
Alias                     LISTENER
Version                   TNSLSNR for Linux: Version 11.2.0.2.0 - Beta
Start Date                06-JUN-2012 08:36:34
Uptime                    23 days 6 hr. 44 min. 25 sec
Trace Level               off
Security                  ON: Local OS Authentication
SNMP                      OFF
Default Service           XE
Listener Parameter File   /u01/app/oracle/product/11.2.0/xe/network/admin/listener.ora
Listener Log File         /u01/app/oracle diag/tnslsnr/<HOSTNAME>/listener/alert/log.xml
Listening Endpoints Summary...
    (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=EXTPROC_FOR_XE)))
    (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=1521)))

    (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=8080))(Presentation=HTTP))

Services Summary...
Service "PLSExtProc" has 1 instance(s).
    Instance "PLSExtProc", status UNKNOWN, has 1 handler(s) for this service...
Service "XE" has 1 instance(s).
    Instance "XE", status READY, has 1 handler(s) for this service...
Service "XEXDB" has 1 instance(s).
    Instance "XE", status READY, has 1 handler(s) for this service...
The command completed successfully

1. The host and port is determined by the line containing PROTOCOL=tcp, **without** Presentation=HTTP.
2. Under services summary, each service which has an instance with READY status is a connectable service. The name following Service is a service name for connecting to the database name following Instance on the next line.
3. The SID is the name of the database instance, as defined by the $ORACLE_SID variable when you have sourced the Oracle environment to your shell.

For example, assuming that you are running Confluence on the same server as the Oracle database, with the above lsnrctl status output, you would use one of the following URLs:

```
jdbc:oracle:thin:@localhost:1521/XE
jdbc:oracle:thin:@//localhost:1521/XE
```

The URL can be used in either a direct JDBC connection or using a Tomcat datasource. If you want to use a datasource, please follow the instructions of the next two sections Adding a Datasource to Tomcat and Configuring Confluence Datasource Access, or if you'd prefer to just use a direct JDBC URL, skip to Running the Confluence Setup Wizard.

For further information on Oracle JDBC URLs, see [this page](#).

*Adding a Datasource to Tomcat*
1. Open `<INSTALL>/conf/server.xml` for editing.
2. Locate the section Host -> Context

   ```xml
   <Host name="localhost" debug="0" appBase="webapps" unpackWARs="true"
   autoDeploy="false">
   <Context path="" docBase="./confluence" debug="0" reloadable="true">
   <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
   Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   <Manager pathname="" />
   </Context>
   </Host>
   
   Paste in the Resource section provided, before Manager as shown:

   ```xml
   <Host name="localhost" debug="0" appBase="webapps" unpackWARs="true"
   autoDeploy="false">
   <Context path="" docBase="./confluence" debug="0" reloadable="true">
   <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
   Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   <Resource
   name="jdbc/confluence"
   auth="Container"
   type="javax.sql.DataSource"
   driverClassName="oracle.jdbc.OracleDriver"
   url="jdbc:oracle:thin:@hostname:port:sid"
   username="<username>"
   password="<password>"
   connectionProperties="SetBigStringTryClob=true"
   maxActive="25"
   maxIdle="5"
   maxWait="10000"
   />
   </Context>
   </Host>
   
3. Change the `username` and `password` to match the Oracle login.
4. Change `url` to match what you determined in Determining the JDBC URL. For example:
   
   ```
   jdbc:oracle:thin:@example.atlassian.com:1521:confluencedb
   ```
5. If required, choose different `maxActive` and `maxIdle` values. These set how many total database
   connections will be allowed at one time, and how many will be kept open even when there is no database
   activity.

   **Configuring Confluence Datasource Access**

   Configure Confluence to use this datasource:

   1. Edit the file `<INSTALL>/confluence/WEB-INF/web.xml`
   2. Go to the end of the file and just before `</web-app>`, insert the following:
<resource-ref>
<description>Connection Pool</description>
<res-ref-name>jdbc/confluence</res-ref-name>
<res-type>javax.sql.DataSource</res-type>
<res-auth>Container</res-auth>
</resource-ref>

**Running the Confluence Setup Wizard**

Now Confluence is ready to attempt to connect to Oracle:

1. Download the Oracle JDBC database drivers for your JDK version via the [Database JDBC drivers](#) page. We recommend using the thin drivers only. Copy the JAR file into `<confluence install>/WEB-INF/lib`. This directory path is potentially `<INSTALL>/lib` if Confluence is running off Apache Tomcat version 6 or above.

2. Startup Confluence using `<INSTALL>/bin/startup.bat` or `<INSTALL>/bin/startup.sh`

3. Insert your licence and select **External Database**.

4. If you are using a Datasource:
   a. Select **Datasource Connection** using your Oracle version.
   b. Enter `java:comp/env/jdbc/confluence` for the name of the datasource.

5. If you are using a Direct JDBC URL:
   a. Select **Direct JDBC URL** using your Oracle version.
   b. Enter your JDBC URL to match what you determined in [Determining the JDBC URL](#)

Confluence should now deploy using the Oracle database specified. Please read this [comment](#) on Oracle database optimisation.

**Oracle Configuration Tips**

**24-hour time format with Oracle 8i**

We have received a report from a user that when an Oracle 8i database is configured to use 24-hour time as the default format, an exception like this may occur:
One symptom of this problem is that Confluence may refuse to start after midday.

The workaround is to go to 'General Configuration' and set the default time format to "HH:mm".

**RELATED TOPICS**

[Known Issues For Oracle](#)

**Database Setup for SQL Server**

Use this guide in conjunction with the more general [Database Setup Guide for Any Database](#). These instructions add some reference notes specific to SQL Server.

1. Review the [known issues for SQL Server](#).
2. Identify which character encoding to use. To do this, check the encoding currently used by your application server and Confluence. All three must use compatible encoding. For example, the default SQL Server encoding of USC-2 is compatible with UTF-8.
3. Create a new database (as an SQL administrator). If you set your application server and Confluence to use an encoding incompatible with USC-2, specify that character encoding for the database.
4. Set the default collation for the database to be 'SQL_Latin1_General_CP1_CS_AS' (case sensitive). You can do this by issuing the following SQL query:

```
ALTER DATABASE <database_name> COLLATE SQL_Latin1_General_CP1_CS_AS
```

NB: if you receive an error at this point stating "The database could not be exclusively locked to perform the operation", you may need to prevent other connections by setting the mode to single user for the transaction:

```
ALTER DATABASE <database_name> SET SINGLE_USER WITH ROLLBACK IMMEDIATE;
<your ALTER DATABASE query>
ALTER DATABASE <database_name> SET MULTI_USER;
```

5. Configure the database to use the isolation level, Read Committed with Row Versioning. You can do this by issuing the following SQL query:

```
Determine if READ_COMMITTED_SNAPSHOT is enabled

SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name= 'YourDatabase'
```

Return value:

1 = READ_COMMITTED_SNAPSHOT option is ON. Read operations under the read-committed isolation level are based on snapshot scans and do not acquire locks.

0 = READ_COMMITTED_SNAPSHOT option is OFF (default). Read operations under the read-committed isolation level use share locks.

```
ALTER DATABASE <database_name>
SET READ_COMMITTED_SNAPSHOT ON
WITH ROLLBACK IMMEDIATE;
```

6. Create a new SQL user account for Confluence (as an SQL administrator). Provide full create, read and write permissions for the database tables. Please note, Confluence must be able to create its own schema.

7. Install the database drivers, if needed:

**SQL Server JDBC Drivers bundled with Confluence**

The JDBC drivers for this database are bundled with Confluence. You do not have to download or install any JDBC drivers to use this database with Confluence, if you are using a direct JDBC connection. If you are connecting via a datasource, you will still need to download and install the drivers manually. See [Database JDBC drivers](#) for more information on the bundled JDBC drivers.

- If you're not sure which connection you're using, it's most likely JDBC. A JNDI resource must be configured manually, as described in [Configuring a MySQL Datasource in Apache Tomcat](#).
If you are configuring a datasource to connect to your MS SQL server database, you will need to place the jar file in `<confluence install>/WEB-INF/lib` (for Confluence 2.10 onwards) or `<confluence install>/common/lib` (for earlier versions). Information and links to the appropriate database drivers are available on Database JDBC drivers. You may also find this page helpful: http://jtds.sourceforge.net/faq.html

8. Start Confluence and visit the home URL (e.g. http://localhost:8090) to start the Confluence Setup Wizard and select a Custom Install, insert the relevant connection information.

- When prompted for a driver class name in the database setup step enter:

  ```
  net.sourceforge.jtds.jdbc.Driver
  ```

- When prompted for the jdbc url, the format to use is:

  ```
  jdbc:jtds:sqlserver://<server>:<port>/<database>
  ```

### Configuring a SQL Server Datasource in Apache Tomcat

This page contains instructions on how to set up an SQL Server datasource connection for Confluence or Confluence EAR/WAR.

**On this page:**

- 1. Install the Driver
- 2. Shut down Tomcat
- 3. Configure Tomcat
- 4. Configure the Confluence web application
- 5. Configure Confluence

#### 1. Install the Driver

2. After unpacking the file you have downloaded, you'll find a file called something like `jtds-1.2.5.jar` (whatever is the latest version).
3. Copy this file into the common/lib directory of your Tomcat installation. Be aware that this directory may be just lib for Tomcat version 6 and beyond (i.e. `<tomcat-install>/lib` rather than `<tomcat-install>/common/lib`).

  - Alternatively you can get the driver from `/confluence/WEB-INF/lib/jtds-1.2.2.jar` and move it into the common/lib directory of your Tomcat installation.

#### 2. Shut down Tomcat

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.

  - Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE_INSTALL>/conf/server.xml` file so you can easily revert should there be a problem.

#### 3. Configure Tomcat

1. Firstly, you need to edit `<confluence install>/conf/server.xml` and find the following lines:
1. Within the Context tags, directly after the opening <Context/> line, insert the DataSource Resource tag:

```xml
<Resource name="jdbc/confluence" auth="Container"
  type="javax.sql.DataSource"
  username="yourDatabaseUser"
  password="yourDatabasePassword"
  driverClassName="net.sourceforge.jtds.jdbc.Driver"
  url="jdbc:jtds:sqlserver://localhost:1433/yourDatabaseName"
  maxActive="20"
  maxIdle="10"
  validationQuery="select 1" />
```

- Replace the username and password parameters with the correct values for your database.
- In the url parameter, replace the word 'yourDatabaseName' with the name of the database your confluence data will be stored in.

2. Why is the validationQuery element needed?

   When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot.

   However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

   If switching from a direct JDBC connection to datasource, you can find the above details in your <CONFLUENCE_HOME>/confluence.cfg.xml file.

3. The configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:

   - driverClassName — Fully qualified Java class name of the JDBC driver to be used.
   - maxActive — The maximum number of active instances that can be allocated from this pool at the same time.
   - maxIdle — The maximum number of connections that can sit idle in this pool at the same time.
   - maxWait — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
   - password — Database password to be passed to our JDBC driver.
   - url — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
   - user — Database username to be passed to our JDBC driver.
   - validationQuery — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.
4. **Configure the Confluence web application**

1. Edit `/confluence/WEB-INF/web.xml` in your confluence installation
2. Go to the end of the file and just before `</web-app>`, insert the following:

```xml
<resource-ref>
  <description>Connection Pool</description>
  <res-ref-name>jdbc/confluence</res-ref-name>
  <res-type>javax.sql.DataSource</res-type>
  <res-auth>Container</res-auth>
</resource-ref>
```

5. **Configure Confluence**

- **If you have not yet set up Confluence**
  1. Follow the steps in the [Confluence Setup Guide](#)
  2. In the Database Setup section, choose the “Datasource Connection” option.
  3. Set the JNDI name to `java:comp/env/jdbc/confluence`
  4. Set the Database dialect to SQL Server.

- **If you are changing an existing Confluence installation over to using a Tomcat datasource**
  1. Edit the `<confluence home>/confluence.cfg.xml` file
  2. Delete any line that contains a property that begins with hibernate.
  3. Insert the following at the start of the `<properties>` section.

```xml
<property name="hibernate.setup">true</property>
<property name="hibernate.dialect">net.sf.hibernate.dialect.SQLServerIntlDialect</property>
<property name="hibernate.connection.datasource">java:comp/env/jdbc/confluence</property>
```

4. Restart Confluence.

**RELATED TOPICS**

- [Configuring a MySQL Datasource in Apache Tomcat](#)
- [Database Setup For Any External Database](#)

If you are using Confluence in a production environment, data should be stored in an external database. The embedded database is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss.

This document provides instructions for setting up Confluence for use with a production-ready database. It covers both migration from an evaluation installation of Confluence and installation of an empty database during initial setup. The following specific database guides have additional information:

- [PostgreSQL Guide](#)
- [MySQL Guide](#)
- [Oracle Guide](#)
- [SQL Server](#)

**Preparation**

Install the following on the Confluence server:
- Database administration tool, for example DBVisualizer
- JDBC database drivers
- The database server (unless accessed remotely)

The instructions refer to two particular directories:

- The `<Confluence Installation Directory>` is the directory where you unpacked the Confluence download.
- The `<Confluence Home Directory>` is the directory where Confluence stores its data, which you set by editing the `confluence-init.properties` file in `Confluence Installation Directory/WEB-INF/classes`.

### Database Setup

Create the schema and setup permissions:

1. Visit the [Database Configuration](#) page to review any known issues and database setup for your database.
2. Create a new schema using the [correct database encoding](#).
3. Create a user with full read/write access to the Confluence schema, including the ability to create tables.
4. If the database only permits users to log in from approved hosts (e.g. localhost), grant database access permission for the Confluence server.
5. If the database is hosted remotely to the Confluence server, set up any firewall permissions.
6. Test the connection by using the database administration tool installed on the Confluence server to log in to the database.

### Migration From an Evaluation Instance of Confluence

Continue here if you are migrating from an evaluation instance with the built-in database. If you are installing Confluence for the first time, continue below.

### Create Backups

To keep any existing Confluence content:

1. If you are already using an external database, use your database administration tool to create a full database backup.
2. Manually create an XML backup of Confluence under `Administration` -> `Backup & Restore`. If you have less than 100MB of attachments, check `Backup attachments` when creating the backup. If you have over 100MB of attachments, you should not check the 'Backup attachments' and instead you should manually copy the `/attachments` directory in your Confluence home to a backup location. This attachments directory will later be copied into the new home directory.
3. Download the backup file to a backup location.

### Database Connection Setup

Set up Confluence's database connection:

1. Stop Confluence if it is already running.
2. The JDBC database drivers for your database must be available to the application server. You can skip this step if the drivers are already loaded.
   a. Copy the database driver JAR file into the `lib` directory. In Confluence this directory is `/confluence/WEB-INF/lib`. Other application servers will use a different path.
   b. If the application server does not support dynamic library loading, stop your application server.
3. Create a new Confluence home directory.
4. Open the `WEB-INF/classes/confluence-init.properties` file in your Confluence installation and change the `confluence.home` property to point to this new Confluence home directory.
5. Start up Confluence. Refer to the platform-specific installation instructions to learn how. You should be presented with the Confluence setup wizard. Enter your license information.
6. Select 'Custom install'.
7. Select a database from the drop down list.
8. Select Direct JDBC and then enter the username, password and database driver of the new database.
9. If you created a Confluence backup earlier and wish to restore it, import it into Confluence now.
10. Once the wizard is complete, if you did not check the 'Backup attachments', copy the backed up /attach ments directory into the new Confluence home.

RELATED TOPICS

Troubleshooting External Database Connections

Database Setup for PostgreSQL

This document provides instructions for setting up Confluence for use with a PostgreSQL database. Please check the Known Issues for PostgreSQL before you start.

On this page:

- **1. Install PostgreSQL**
- **2. Create a User and a Database**
- **3. Configure Confluence to use the PostgreSQL Database**
- **Troubleshooting**

1. Install PostgreSQL

To install PostgreSQL,

1. Download the database software and installer from the PostgreSQL download site and save it to your desktop. Choose the package that matches your operating system. Where available, choose the One Click Installer. These instructions assume you will use the One Click Installer. For example:
   - PostgreSQL One Click Installer for Windows.
   - PostgreSQL One Click Installer for Linux.
   - PostgreSQL One Click Installer for Mac OS X.
2. Run the installer. Please note the following information when installing PostgreSQL:
   - The password that you are prompted to provide during the installation process is for the 'postgres' account, which is the db root level account.
   - The default port for PostgreSQL is 5432. If you decide to change the default port, please ensure that your new port number does not conflict with any services running on that port. You will also need to remember to update all further mentions of db port.
   - Choose the locale that best fits your geographic location, when prompted to enter a locale.
   - Do not launch Stack Builder at the completion of the installer.
3. PostgreSQL is now installed on your machine.

2. Create a User and a Database

All screenshots below are taken from a PostgreSQL configuration on a Windows machine.

To create a PostgreSQL user and database,
1. Start the ‘pgAdmin III’ administration tool on your machine. The pgAdmin III administration console will display. The database user and database that will be used by Confluence are created via the ‘pgAdmin III’ tool.

2. Connect to the PostgreSQL server (e.g. double-click on the server name in the object browser). Enter a ‘postgres’ password when prompted.

3. Create a new user, i.e. login role (e.g. right-click ‘Login Roles’ in the object browser and select ‘New Login Role...’):
   - Enter a name and password for the new user.
   - Do not select any role privileges.

4. Create a database (e.g. right-click ‘Databases’ and select ‘New Database...’):
   - Enter a name for the new database.
   - Set the owner of the database to the user you created in the previous step.
   - Select ‘UTF8’ for ‘Encoding’.
Creating a User and Database via Linux command-line

If you are on Linux and do not have the above pgAdmin III administration tool, you can use the command line interface instead. Assuming that you are using the default installation directory of /opt/PostgreSQL/8.3/bin/, enter the following commands:

```
sudo -s -H -u postgres
# Create the Confluence user:
/opt/PostgreSQL/8.3/bin/createuser -S -d -r -P -E confuser
# Create the Confluence database:
/opt/PostgreSQL/8.3/bin/createdb -O confuser confluence
exit
```

3. Configure Confluence to use the PostgreSQL Database

Once you have installed and set up PostgreSQL, you will need to configure Confluence to use the PostgreSQL database.

**To configure Confluence to use PostgreSQL,**
1. **Install Confluence**, if you haven’t done so already. Ensure that you download the Confluence distribution, not the evaluation installer.
2. Ensure that Confluence is stopped (for example, by ensuring that the application server or service which is running Confluence has been stopped or terminated).
3. Install the database drivers, if needed:

   **PostgreSQL JDBC Drivers bundled with Confluence**
   The JDBC drivers for this database are bundled with Confluence. You do not have to download or install any JDBC drivers to use this database with Confluence, if you are using a direct JDBC connection. If you are connecting via a datasource, you will still need to download and install the drivers manually. See Database JDBC drivers for more information on the bundled JDBC drivers.
   - If you’re not sure which connection you’re using, it’s most likely JDBC. A JNDI resource must be configured manually, as described in Configuring a MySQL Datasource in Apache Tomcat.

   Note: Confluence only bundles the JDBC 3 driver which will work under the 1.6 JVM. However, if you are using Java 6 and want to use the JDBC 4 driver, you can download it via Database JDBC drivers and install it as described below. You will need to remove the existing PostgreSQL JDBC 3 driver (e.g. postgresql-8.4-701.jdbc3), if you do want to use the JDBC 4 driver.

   - If you are configuring a datasource to connect to your PostgreSQL database, you will need to place the jar file in `<confluence install>/WEB-INF/lib` (for Confluence 2.10 onwards) or `<confluence install>/common/lib` (for earlier versions). Information and links to the appropriate database drivers are available on Database JDBC drivers.

   Windows renames .jar extensions to .zip! Just rename it back to .jar. You’ll have to set your folder options to view hidden file extensions if you can’t rename it without changing the file type (Tools >> Folder Options >> View >> Uncheck “Hide Extensions for known file types.”

4. Start Confluence and after entering your license code on the 'Confluence Setup Wizard' page, click ‘Custom Installation’. The ‘Choose a Database Configuration’ page will display.
5. Select ‘PostgreSQL’ and click ‘External Database’. The ‘Configure Database’ page will display.
6. Choose your desired database connection method (please note that if you choose to connect via datasource, you will need to install the appropriate database drivers as described in the previous step).
7. Enter your PostgreSQL database setup details (as defined in the previous step above):

   **Connecting to an SSL Database**
   Simply add ssl=true parameter in the Database URL, for example:

   ```
   jdbc:postgresql://localhost:5432/confluence?ssl=true
   ```
If the server that is hosting the PostgreSQL database is not the same server as Confluence, then please ensure that the confluence server can contact the database server and also refer to the PostgreSQL documentation on how to set up `pg_hba.conf`. If the pg_hba.conf file is not set properly, remote communication to the PostgreSQL server will fail.

**Running SQL Queries**

For ongoing maintenance of your server, you can continue to use PGAdmin as your SQL browser.

**Troubleshooting**

- **Known Issues for PostgreSQL** contains common issues encountered when setting up your PostgreSQL database to work with Confluence.
- If you are unable to connect to the database from Confluence and they are on different machines, most likely you have a firewall in between the two machines or your `pg_hba.conf` file is misconfigured. Verify that your firewall is set to allow connections through 5432 or double check your `hba configuration`.
- If Confluence is complaining that it's missing a class file, you might have forgotten to place the jdbc driver in the WEB-INF/lib folder or possibly have placed it in the wrong folder.
- If none of the above describes your issue, please create a support ticket at [http://support.atlassian.com](http://support.atlassian.com) and be sure to include your logs (found in confluence-install/logs and confluence-data/logs).

---

**Configuring a PostgreSQL Datasource in Apache Tomcat**

This page contains instructions on how to set up an PostgreSQL datasource connection for Confluence or Confluence EAR/WAR.

**On this page:**

- 1. **Install the Driver**
- 2. **Shut down Tomcat**
- 3. **Configure Tomcat**
- 4. **Configure the Confluence web application**
- 5. **Configure Confluence**

**1. Install the Driver**

2. Copy this file into the `common/lib` directory of your Tomcat installation. Be aware that this directory may be just `lib` for Tomcat version 6 and beyond (i.e. `<tomcat-install>/lib` rather than `<tomcat-install>/common/lib`).

If you are using Confluence 3.2.0 or later you can get the driver from `/confluence/WEB-INF/lib/postgresql-8.4-701.jdbc3.jar` and move it into the `common/lib directory` of your Tomcat installation.
2. Shut down Tomcat

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.

   Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONF
   LUENCE_INSTALL>/conf/server.xml` file so you can easily revert should there be a problem.

3. Configure Tomcat

1. Firstly, you need to edit `<confluence install>/conf/server.xml` and find the following lines:

   ```xml
   <Context path="" docBase="/confluence" debug="0" reloadable="true">
     <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   </Context>
   ```

2. Within the Context tags, directly after the opening `<Context.../>` line, insert the DataSource Resource tag:

   ```xml
   <Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource">
     username="postgres"
     password="postgres"
     driverClassName="org.postgresql.Driver"
     url="jdbc:postgresql://localhost:5432/yourDatabaseName"
     maxActive="20"
     maxIdle="10"
     validationQuery="select 1" />
   ```

   - Replace the `username` and `password` parameters with the correct values for your database.
   - In the `url` parameter, replace the word 'yourDatabaseName' with the name of the database your confluence data will be stored in.

   **Why is the validationQuery element needed?**

   When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot.

   However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

   **If switching from a direct JDBC connection to datasource, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.**
The configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:

- **driverClassName** — Fully qualified Java class name of the JDBC driver to be used.
- **maxActive** — The maximum number of active instances that can be allocated from this pool at the same time.
- **maxIdle** — The maximum number of connections that can sit idle in this pool at the same time.
- **maxWait** — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
- **password** — Database password to be passed to our JDBC driver.
- **url** — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
- **user** — Database username to be passed to our JDBC driver.
- **validationQuery** — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

4. Configure the Confluence web application

1. Edit /confluence/WEB-INF/web.xml in your confluence installation
2. Go to the end of the file and just before </web-app>, insert the following:

```xml
<resource-ref>
  <description>Connection Pool</description>
  <res-ref-name>jdbc/confluence</res-ref-name>
  <res-type>javax.sql.Datasource</res-type>
  <res-auth>Container</res-auth>
</resource-ref>
```

5. Configure Confluence

- **If you have not yet set up Confluence**
  1. Follow the steps in the Confluence Setup Guide
  2. In the Database Setup section, choose the "Datasource Connection" option.
  3. Set the JNDI name to java:comp/env/jdbc/confluence
  4. Set the Database dialect to Postgres.

- **If you are changing an existing Confluence installation over to using a Tomcat datasource**
  1. Edit the <confluence home>/confluence.cfg.xml file
  2. Delete any line that contains a property that begins with hibernate.
  3. Insert the following at the start of the <properties> section.

```xml
<property name="hibernate.setup"><![CDATA[true]]></property>
<property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.PostgreSQLDialect]]></property>
<property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
```

4. Restart Confluence.

**RELATED TOPICS**
**Configuring a MySQL Datasource in Apache Tomcat**

**Database Setup For MySQL**

This page provides instructions for installing Confluence and the open-source MySQL database on Microsoft Windows, as well as how to set up and configure MySQL to work with Confluence. Additional instructions are also provided for migrating across any existing Confluence database content. Use this guide in conjunction with the more general Database Setup Guide for Any Database. These instructions add some important reference notes specific to MySQL.

Please note the following points:

- Throughout the instructions below, the Confluence Installation Directory refers to the directory where you extracted the Confluence zipped installer.
- The MySQL Database Setup procedure below will make modifications to your default MySQL Server settings. These modifications result in:
  1. The default collation (localisation) option being changed to utf8_bin (that is, case-sensitive binary UTF8), such that by default, all new database tables will be created with this type of case-sensitive collation.
  2. The default MySQL database storage engine being changed to 'InnoDB'.

On this page:

- **1. Install Confluence**
- **2. Install MySQL Server**
- **3. Set up your MySQL Database and User**
- **(Optional) 4. Back Up Confluence Data**
- **5. Set Up your Database Connection**
- **Troubleshooting**
- **Related Documents**

1. **Install Confluence**

   Install Confluence if you have not done so already. Ensure that you download Confluence, not the evaluation installer.

2. **Install MySQL Server**

   To install MySQL Server,

   1. If you do not have an operational MySQL database server instance available, install 'MySQL Community Server' database server (version 5.0). The installation package can be downloaded from the MySQL download page or from the version 5.0 download page. Instructions for installing the MySQL 5.0 database server on Windows can be found on the 'Installing MySQL on Windows' page of the MySQL web site.
2. Run the 'MySQL Server Instance Config Wizard':
   a. At the start of the Config Wizard (or after having chosen Reconfigure Instance), choose Detailed Configuration.
   b. Choose the type of MySQL Server that best suits your hardware requirements. This will affect the MySQL Server's usage of memory, disk and CPU resources. Refer to the relevant MySQL documentation for further information.
   c. Choose 'Transactional Database Only' for the database usage step. This ensures that your MySQL database will use InnoDB as its default storage engine.
   
   It is highly recommended that you only use the InnoDB storage engine with Confluence. Avoid using the MyISAM storage engine as this can lead to data corruption.
   d. Set the InnoDB Tablespace settings to your requirements. (The default settings are acceptable).
   e. Set the approximate number of concurrent connections permitted that best suits your Confluence usage requirements. You can use one of the presets if desired or enter a number manually. Refer to the relevant MySQL documentation for further information.
   f. For the networking options, ensure the 'Enable TCP/IP Networking' and 'Enable Strict Mode' options are selected (default). Refer to the MySQL documentation on setting the networking and server SQL modes for further information.
   g. For the MySQL server instance's default character set option, choose 'Best Support For Multilingualism' (i.e. UTF-8).
   h. For the Windows configuration option, choose whether or not to install the MySQL Server as a Windows Service. If your hardware is going to be used as a dedicated MySQL Server, you may wish to choose the 'Install As Windows Service' and Launch the MySQL Server automatically) options. Refer to the relevant MySQL documentation for further information.
   i. Finally, select the 'Modify Security Settings' option to enter and set your MySQL Server (root) access password.

3. Install the database drivers, if needed:

MySQL JDBC Drivers bundled with Confluence
The JDBC drivers for this database are bundled with Confluence. You do not have to download or install any JDBC drivers to use this database with Confluence, if you are using a direct JDBC connection. If you are connecting via a datasource, you will still need to download and install the drivers manually. See Database JDBC drivers for more information on the bundled JDBC drivers.

- If you're not sure which connection you're using, it's most likely JDBC. A JNDI resource must be configured manually, as described in Configuring a MySQL Datasource in Apache Tomcat.

- If you are configuring a datasource to connect to your MySQL database, you will need to place the jar file i.e. mysql-connector-java-5.x.y-bin.jar where x.y depends on the driver version) in <confluence install>/WEB-INF/lib (for Confluence 2.10 onwards) or <confluence install>/common/lib (for earlier versions). Information and links to the appropriate database drivers are available on Database JDBC drivers.
4. Configure your MySQL server’s settings by editing MySQL’s `my.cnf` file (often named `my.ini` on Windows operating systems). Locate the `[mysqld]` section in the file and modify the following parameters:
   - Specify the default character set to be UTF-8:
     - MySQL 4.1.3 and above
       ```
       [mysqld]
       ...
       character-set-server=utf8
       collation-server=utf8_bin
       ...
     ```
     - MySQL 4.1.2 and below
       ```
       [mysqld]
       ...
       default-character-set=utf8
       default-collation=utf8_bin
       ...
     ```
   - Set the default storage engine to InnoDB:
     ```
     [mysqld]
     ...
     default-storage-engine=INNODB
     ...
     ```
   - Specify/increase the value of `max_allowed_packet` to be at least 32M:
     ```
     [mysqld]
     ...
     max_allowed_packet=32M
     ...
     ```

(Refer to MySQL Option Files for detailed instructions on editing `my.cnf` and `my.ini`.)

5. Restart your MySQL server for the changes to take effect:
   - On Windows, use the Service Manager to restart the service
   - On Linux, depending on your setup you will need to run either `"/etc/init.d/mysqld stop"` or `"/etc/init.d/mysql stop"` or `"service mysqld stop"` followed by the same command with "stop" replaced with "start"
   - On Mac OS X, run `"sudo /Library/StartupItems/MySQLCOM/MySQLCOM restart"

3. Set up your MySQL Database and User

To create the database and user privileges,
1. Run the "mysql" command as a MySQL super user. The default is "root" with a blank password.
2. Create an empty Confluence database schema by running
   
   ```sql
   CREATE DATABASE confluence;
   ```

3. Create the Confluence database user by running
   
   ```sql
   GRANT ALL PRIVILEGES ON confluence.* TO 'confluenceuser'@'localhost' IDENTIFIED BY 'confluencepass';
   ```

Replace "confluenceuser" and "confluencepass" with a username and password of your choice. If Confluence is not running on the same server as your MySQL database server, replace "localhost" with the hostname or IP address of the Confluence server.

To support international languages in Confluence, you should verify that the newly created database is using UTF-8 encoding and re-examine the JDBC URL settings (configured in Stage 3).

For an existing database

If you're using a existing database, confirm the Character Encoding by executing the query:

   ```sql
   SHOW VARIABLES LIKE 'character%';
   SHOW VARIABLES LIKE 'collation%';
   ```

The results should be UTF-8.

(Optional) 4. Back Up Confluence Data

This stage is only required if you have existing Confluence content you wish to transfer.

To back up your Confluence data,

1. Manually create an XML backup of Confluence under Administration -> Backup & Restore. If you have less than 100MB of attachments, check 'Backup attachments' when creating the backup. If you have over 100MB of attachments, you should not check the 'Backup attachments' and instead you should manually copy the /attachments directory in your Confluence home to another location. This attachments directory can then be copied into the new home directory as described later.
2. Download the backup file to a backups folder.

5. Set Up your Database Connection

To set up your Confluence MySQL database connection or to switch to using this external database,
1. Ensure that Confluence is stopped (for example, by ensuring that the application server or service which is running Confluence has been stopped or terminated).

2. If you haven't started Confluence yet, you can skip this step. If you have set up Confluence with the built-in (HSQLDB) database, edit Confluence Installation Directory_/confluence/WEB-INF/classes/confluence-init.properties and change the confluence.home property to point to a new directory. e.g. if you had

   confluence.home=c:/confluencedata

   You could change it to:

   confluence.home=c:/confluencedata_mysql

   This is your new Confluence Home Directory. (The name doesn't have to end in _mysql – that's just an example)

3. Start Confluence and set up the new configuration.
   a. Enter your license key and click the 'Custom Installation' button.
   b. Under the 'External Database' heading, select 'MySQL' from the dropdown list and click 'External Database'.
   c. On the next page, click 'Direct JDBC'.
   d. Enter confluenceuser in the User Name field, and the password you chose earlier in the Password field
   e. Click the Next button. If you get the error message Could not successfully test your database: : Server connection failure during transaction. Due to underlying exception: 'java.sql.SQLException: Access denied for user 'confluenceuser'@'localhost' (using password: YES)' verify that you have properly given the confluenceuser user all the right permissions when connecting from localhost.
   f. (optional) If you previously backed up your Confluence data, you can choose to restore it at the 'Load Content' page. Choose 'Restore From Backup', browse for the backup you created and restore it. Otherwise choose either the example or empty site as you wish.

Troubleshooting

- Known Issues for MySQL contains common issues encountered when setting up your MySQL database to work with Confluence.
- If Confluence is complaining that it's missing a class file, you might have forgotten to place the jdbc driver in the WEB-INF/lib folder or possibly have placed it in the wrong folder.
- If none of the above describes your issue, please create a support ticket at http://support.atlassian.com and be sure to include your logs (found in confluence-install/logs and confluence-data/logs).

Related Documents

- Configuring Database Character Encoding
- Known Issues for MySQL

Configuring a MySQL Datasource in Apache Tomcat

This page tells you how to set up a MySQL datasource connection for Confluence or Confluence EAR/WAR.
1. Shut down Tomcat

1. Run bin/shutdown.sh or bin/shutdown.bat to bring Tomcat down while you are making these changes.
2. Make a backup of your <CONFLUENCE_HOME>/confluence.cfg.xml file and your <CONFLUENCE_INSTALL>/conf/server.xml file so that you can easily revert if you have a problem.

2. Install the Drivers

2. After unpacking the file you have downloaded, you will find a file called something like mysql-connector-java-3.0.10-stable-bin.jar.
3. Copy this file into the common/lib directory of your Tomcat installation. Be aware that this directory may be just lib for Tomcat version 6 and beyond (i.e. <tomcat-install>/lib rather than <tomcat-install>/common/lib).

3. Configure Tomcat

1. If you are using the Confluence distribution, edit the conf/server.xml file in your Tomcat installation. If you are running your own Tomcat instance, edit the XML file where you declared the Confluence Context descriptor.
2. If editing conf/server.xml, find the following lines:

```xml
<Context path="" docBase="../confluence" debug="0" reloadable="true">
   <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
</Context>
```

3. Within the Context tags, directly after the opening <Context.../> line, insert the DataSource Resource tag:

```xml
<Resource name="jdbc/confluence" auth="Container"
type="javax.sql.DataSource"
   username="yourusername"
   password="yourpassword"
   driverClassName="com.mysql.jdbc.Driver"
   url="jdbc:mysql://localhost:3306/confluence?useUnicode=true&characterEncoding=utf8"
   maxActive="15"
   maxIdle="7"
   defaultTransactionIsolation="READ_COMMITTED"
   validationQuery="Select 1" />
```

- Replace the username and password parameters with the correct values for your database.
- In the url parameter, replace the word 'confluence' with the name of the database your Confluence data will be stored in.
If you plan to use non-Latin characters, you will also need to add "&useUnicode=true&characterEncoding=utf8" on the end of the above URL. These options are not required for any database other than MySQL.

Notes

- If switching from a direct JDBC connection to datasource, you can find the above details in your <CONFLUENCE_HOME>/confluence.cfg.xml file.

- Why is the validationQuery element needed? When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires an application server reboot.

However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

- The configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:
  - driverClassName – Fully qualified Java class name of the JDBC driver to be used.
  - maxActive – The maximum number of active instances that can be allocated from this pool at the same time.
  - maxIdle – The maximum number of connections that can sit idle in this pool at the same time.
  - maxWait – The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
  - password – Database password to be passed to our JDBC driver.
  - url – Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
  - user – Database username to be passed to our JDBC driver.
  - validationQuery – SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

4. Configure the Confluence Web Application

1. Edit confluence/WEB-INF/web.xml in your Confluence installation.
2. Go to the end of the file and insert the following element just before </web-app>:

   <resource-ref>
     <description>Connection Pool</description>
     <res-ref-name>jdbc/confluence</res-ref-name>
     <res-type>javax.sql.DataSource</res-type>
     <res-auth>Container</res-auth>
   </resource-ref>

5. Configure Confluence

If you have not yet set up Confluence:

1. Follow the steps in the Confluence Setup Guide
2. In the Database Setup section, choose the "Datasource Connection" option.
3. Set the JNDI name to java:comp/env/jdbc/confluence
4. Set the Database dialect to MySQL.

If you are changing an existing Confluence installation over to using a Tomcat datasource:

1. Find your ConfluenceHome directory (see: Confluence Home Directory if you don't know where it is).
2. Edit the confluence.cfg.xml file
3. Delete any line that contains a property that begins with `hibernate`.
4. Insert the following at the start of the `<properties>` section.

```xml
<property name="hibernate.setup"><![CDATA[true]]></property>
<property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.MySQLDialect]]></property>
<property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
```

6. Restart Confluence

Run `bin/startup.sh` or `bin/startup.bat` to start Tomcat with the new settings.

### RELATED TOPICS

- **Database Setup For MySQL**
- **Creating Database Schema Manually**
- **Database Schema Creation**

This document provides information on how to find the SQL for database table creation.

Often, DBAs will require that table creation be done manually. To find the required SQL statements, you can use the script generated from our evaluation version's HSQLDB database.

- Install Confluence with no external database.
- Shut down Confluence.
- Find the file located in `<confluence-home>/database/confluencedb.script`

The `confluence-home` directory is not your installation directory, its the directory specified in `confluence-init.properties`. For more information, see [Confluence Home Directory](#) and [Confluence Installation Directory](#).

To see some example SQL statements, click 'Tools' and select 'Attachments' on this wiki page.

To get Confluence to run against this established schema, configure the database with the normal procedure, then modify the hibernate.connection.url, username and password from `confluence-home/confluence.cfg.xml` or `server.xml`, depending on whether it's a direct jdbc or resource connection. This is described in [Migrating Confluence Between Servers](#).

### RELATED TOPICS

- **Database Configuration**
- **Migrate to Another Database**

This document outlines how to migrate your data from your existing database to another database. It is designed for migrating from an evaluation to a production database. Large data sets will require third party database migration tools. You should use this method when moving from the embedded database to an external database. Provided your dataset is not large, you may use this method to move from one type of external database to another – for example, from Oracle to PostgreSQL.

**Note:** If you are simply moving your database from one server to another you can just change the JDBC URL in `<confluence.home>/confluence.cfg.xml` (if you are using a direct JDBC connection) or in the definition
of your datasource (if you are connecting via a datasource).

**Limitations of database migration**

**Note:** The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

**Database migration**

There are two ways you can perform the migration:

1. Method one is the standard procedure.
2. For large installations of Confluence: If the total size of attachments on your installation exceeds 500MB, use method two.

**On this page:**

- **Method one – standard procedure**
  - **Step One: Backing up your data**
  - **Step Two: Configuring the Confluence Home Directory**
  - **Step Three: Setting up the new database**
  - **Step Four: Setting up Confluence with the new database**

- **Method two – for large installations**
  - **Step One: Backing up your data**
  - **Step Two: Configuring the Confluence Home Directory**
  - **Step Three: Moving your attachments**
  - **Step Four: Setting up new database**
  - **Step Five: Setting up Confluence with the new database**

- **A note about case sensitivity in your database**
- **Troubleshooting**

**Method one – standard procedure**

**Step One: Backing up your data**

1. Note which plugins are currently installed/enabled, so that you can reinstate them later.
2. Create a backup of your existing data. This is done from the Administration Console. Instructions on how to create a backup can be found here.
4. If you are already using an external database, please make a backup of it using the utilities that were installed with it.

**Step Two: Configuring the Confluence Home Directory**

1. Create a new Confluence Home Directory. You can place this directory anywhere you like and give it a name of your choice.
2. Open WEB-INF/classes/confluence-init.properties file in your Confluence installation and change the confluence.home property to point to this new Confluence Home Directory.

**Step Three: Setting up the new database**

Perform the database setup instructions for your database.

**Step Four: Setting up Confluence with the new database**

If your databases are not already configured for Confluence, refer to Database Configuration to setup your database access.
1. Make sure that the JDBC drivers for your database are available to the application server. If you don't already have the JDBC driver, please download one from here.
2. Make sure that your database is using a case-sensitive collation. Please refer to the section on case sensitivity below and see this issue for more details: CONF-7917.
3. If you are running the Confluence distribution, copy your JDBC database driver (a .jar file), into the <confluence-install>/lib folder.
4. Start up Confluence. You will see the Confluence Setup Wizard.
5. Select 'Custom Install'.
6. Select your database from the drop down list.
7. Select 'Direct JDBC' and then enter the details of the new database you want to migrate to. 
   ☀️ Read the documentation on the Setup Wizard for more detailed explanation.
8. When prompted, restore the contents of the backup you made in Step One into the new Confluence site.

Your old Confluence data will now be imported to your new database.

**Method two – for large installations**

**Step One: Backing up your data**

1. Before proceeding with these instructions please check that:
   - you are upgrading from at least Confluence version 2.2 and
   - your attachments are stored in the file system, and not in your database. (To migrate between attachment storage systems, please see Attachment Storage Configuration)
   ☢️ These instructions will not work if either of the above is not true.
2. From Confluence, go to Administration -> Backup & Restore and create a manual backup that excludes attachments.
3. Shut down and back up the Confluence Home Directory.
4. If you are already using an external database, please make a backup of it using the utilities that were installed with it.

**Step Two: Configuring the Confluence Home Directory**

1. Create a new Confluence Home Directory. You can place this directory anywhere you like and give it a name of your choice.
2. Open WEB-INF/classes/confluence-init.properties file in your Confluence installation and change the confluence.home property to point to this new Confluence Home Directory.

**Step Three: Moving your attachments**

Move the contents of your attachments directory from your old Confluence Home to your new Confluence Home.

**Step Four: Setting up new database**

Perform the database setup instructions for your database.

**Step Five: Setting up Confluence with the new database**

If your databases are not already configured for Confluence, refer to Database Configuration to setup your database access.

1. Make sure that the JDBC drivers for your database are available to the application server. If you don't already have the JDBC driver, please download one from here.
2. Make sure that your database is using a case-sensitive collation. Please refer to the section on case sensitivity below and see this issue for more details: CONF-7917.
3. If you are running the Confluence distribution, copy your JDBC database driver (a .jar file), into the <confluence-install>/lib folder.
4. Start up Confluence. You will see the Confluence Setup Wizard.
5. Select 'Custom Install'.
6. Select your database from the drop down list.
7. Select 'Direct JDBC' and then enter the details of the new database you want to migrate to.
A note about case sensitivity in your database

'Collation' refers to a set of rules that determine how data is sorted and compared. Case sensitivity is one aspect of collation. Other aspects include sensitivity to kana (Japanese script) and to width (single versus double byte characters).

Case sensitive or case insensitive collation – how should you create your Confluence database? What about when you are migrating your existing Confluence instance from one database to another?

Setting up a New Confluence Instance

For new Confluence instances, we recommend using case sensitive collation for your Confluence database. This is the default collation type used by many database systems.

Note: Even if the database is configured for case sensitive collation, Confluence reduces all usernames to lower case characters before storing them in the database. For example, this means that 'joebloggs', 'joeBloggs' and 'JoeBloggs' will be treated as the same username.

Migrating an Existing Confluence Instance to a Different Database

The default Confluence configuration uses case sensitive database collation. This is typical of databases created under default conditions. If you are migrating from this type of configuration to a new database, we recommend that the new database uses case sensitive collation. If you use case insensitive collation, you may encounter data integrity problems after migration (for example, via an XML import) if data stored within your original Confluence site required case sensitive distinctions.

Troubleshooting

If you are unable to restore your XML backup, consult our Troubleshooting Guide.

The Embedded HSQLDB Database

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the \database folder under your Confluence Home directory. See also Important Directories and Files.

Embedded Database is Not Suitable for Production Instances of Confluence

Production instances of Confluence should use an external database. When using the default HSQLDB database, you run the risk of unrecoverable data loss due to not being transaction safe.

- Corruption is occasionally encountered after sudden power loss and can usually be corrected using this data recovery procedure.
- HSQLDB is still suitable for evaluation purposes, but the risk can only be eliminated by switching databases. External databases may also provide superior speed and scalability.

RELATED TOPICS
**Important Directories and Files**

**Database Configuration**

**Troubleshooting the Embedded Database (HSQL DB)**

*java.sql.SQLException: User not found: SA*


HSQLDB periodically must update its files to represent changes made in the database. In doing so, it must delete the current confluencedb.data file on the filesystem (beneath conf.home/database) and replace it with a new one.

If an administrator issues a shutdown on Confluence in this period, data can be lost, and is typically noticed by the error message, when starting Confluence up again, of 'User not found: SA'.

Users encountering this problem should seek to restore backups, contained in the backup directory beneath confluence.home. If daily backups have been turned off, and no other copy of data remains, the data is lost.

**Hibernate logging**

It can be useful to [enable detailed Hibernate logging](http://hsqldb.sourceforge.net/doc/guide/ch01.html#N101C2) when debugging problems with HSQL.

**Connecting to the Embedded Database**

Connecting to the Embedded HSQL Database can be quite difficult. You may need to connect to the database to retrieve information, or for troubleshooting purposes.

Please follow the instructions on how to connect to the embedded HSQL Database using the Database Administration tool [DBVisualizer](http://dbvisualizer.org/).

**Connecting to HSQLDB using DBVisualizer**

The purpose of this guide is to walk you through connecting to Confluence’s embedded Hypersonic SQL Database using the Database Administration tool [DBVisualizer](http://dbvisualizer.org/).

Below are step by step instructions on how to Configure DBVisualizer and connect it to HSQLDB.

**Prerequisites**

1. Download and install the latest copy of [DBVisualizer](http://dbvisualizer.org/).
2. You will also need to download a copy (preferably the latest version) of [HSQLDB](http://hsqldb.sourceforge.net/).
3. Extract the contents of the HSQLDB archive.
4. Ensure that Confluence is not running.

**Connection Procedure**

Please ensure that you read and follow the instructions below carefully.

⚠️ **Remember to backup your `<confluence-home>/database` folder before attempting any modifications**

**1. Enter Connection Name**
1. Click on the icon highlighted in Red
2. Enter an identifiable name for the connection. e.g. conf2.5.4-std

2. Select JDBC Driver

1. From the drop down list select HSQLDB Embedded
2. Click on Load Driver Files
3. Browse to directory where the HSQLDB.jar file is located. Confluence bundles this and it can be found at <confluence-installation>/confluence/WEB-INF/lib/hsqldb-*.jar.

3. Select Database Path
   1. Browse to your <Confluence-Home> directory
   2. Open the Database folder
   3. Select the confluencedb.properties file

4. Enter Connection Details
1. Remove the ".properties" from the end of confluencedb
2. Type in sa for the username
3. Leave the password field blank

*refer to the example screenshot above if you are unsure*

### 5. Connect to embedded Database

1. Click on Test Connection to verify that the details are correct.
2. Click on "**Finish**" to complete the setup.
3. Select the connection from the list on the left hand side.
4. You can now click on "**Connect**" to connect to the embedded database.

*HSQL database manager*
Alternatively, you can use HSQLDB’s database manager. Just copy the value of hibernate.connection.url in confluence.cfg.xml as the URL and you’re good to go.

Related Topics
Universal SQL client Squirrel
HSQL
Enable Hibernate Logging
Database Tables Reference
Confluence data model

Database Tables Reference

Below is a diagram of the Table References in Confluence (2.5.4).

This may be useful for Database Administrators that need to manually create the Database tables.

Right Click and Select Save Link As here to download this image.

Troubleshooting External Database Connections

A common administration issue when configuring Confluence is identifying database connectivity problems. This page tells you about a helper utility, in the form of a JSP page, that can help you to isolate database connectivity issues. It checks whether you can connect to a database with your application server. If your application server cannot connect to the database, Confluence will not be able to connect to the database either.

Introduction to the Atlassian Database Check Utility

You can use this utility to:

- Check that your application server can successfully query your database, either via immediate JDBC connectivity or a datasource in the context of your application server.
- Pinpoint problems in your configuration which may occur if the above is failing.

This is what the utility does:

- Check that a JDBC driver can be loaded into memory and view what is already loaded.
- Connect to a JDBC URL and do a ‘select 1’ from the database.
- Find a DataSource in the JNDI environment and do the above.
- View the System classpath (to ensure that the JDBC JAR file is there).

Using the Utility

If you have already set up Confluence completely
1. Download the attached testdatabase.jsp to your <confluence-install>/confluence directory.
2. Restart Confluence.
4. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the <confluence-install>/lib directory (for Confluence version 2.10 onwards) or <confluence-install>/common/lib (for earlier versions). Here are some instructions.
5. Enter the DB settings Confluence is using and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.

If you cannot set up Confluence because of an error in 'Configuring Database'

1. Record the DB settings you are using for your direct JDBC or datasource connection in the 'Configure Database' step of your setup.
2. Download the attached testdatabase.jsp to your <confluence-install>/confluence directory.
3. Rename your <confluence-install>/confluence/WEB-INF/web.xml file to backup web.xml. This disables redirection.
4. Restart Confluence.
6. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the <confluence-install>/common/lib directory as described in these instructions.
7. Enter the DB settings you recorded and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.
8. After correcting the error, rename <confluence-install>/confluence/WEB-INF/backup web.xml back to web.xml.

Notes

If you use this utility, please let us know ways in which we could improve it or leave helpful hints for others here.

For a comprehensive set of database instructions that might be helpful for troubleshooting, please refer to the following links:

- PostgreSQL
- MySQL

Requesting Technical Support

If you are still stuck after attempting the suggestions above, lodge a free technical support request with information on your database setup.

Configuring database query timeout

If database queries are taking too long to perform, and your application is becoming unresponsive, you can configure a timeout for database queries. There is no default timeout in Confluence.

To configure a database query timeout, do the following on your test server:

1. Shut down Confluence.
2. Extract databaseSubsystemContext.xml from the confluence-x.x.x.jar that is in confluence/WEB-INF/lib/, and put a copy in confluence/WEB-INF/classes/.
3. Edit confluence/WEB-INF/classes/databaseSubsystemContext.xml to add the defaultTimeout property to the "transactionManager" bean:
<bean id="transactionManager" class="org.springframework.orm.hibernate.HibernateTransactionManager">
  <property name="sessionFactory">
    <ref bean="sessionFactory"/>
  </property>
  <property name="defaultTimeout" value="120"/>
</bean>

The timeout is measured in seconds and will forcibly abort queries that take longer than this. In some cases, these errors are not handled gracefully by Confluence and will result in the user seeing the Confluence error page.

4. Start Confluence.

Once the timeout is working properly in your test environment, migration the configuration change to Confluence.

⚠️ You will need to reapply these changes when upgrading Confluence, as the original databaseSubsystemContext.xml file changes from version to version.

### Improving Database Performance

**Diagnosis**

Use native database tools to assess the impact of your database. If you'd like to check what Confluence is doing from it's side, you can enable sql logging. If you analyze thread dumps, as this is done in general Troubleshooting Confluence Hanging or Crashing guide, you may find the kinds of threads like this:

```
"http-8080-Processor150" daemon prio=1 tid=0x08543368 nid=0x11aa in Object.wait() [0x665a4000..0x665a51b0]
at java.lang.Object.wait(Native Method)
  - waiting on <0x83140488> (a com.mchange.v2.resourcepool.BasicResourcePool)
  - locked <0x83140488> (a com.mchange.v2.resourcepool.BasicResourcePool)
```

These threads are waiting for a database connection. It could be that the database is not performing optimally, or it may just need tuning for allowing more connection threads. Both are discussed below.

**Upgrade your Database and Drivers**

SQL Server 2000, Oracle 9i, and MySQL with 3.1 drivers are among some of the issues with database performance. Ensure you are using updated versions of databases and their drivers.

**Upgrade your hardware**

Atlassian does not offer specific recommendations on hardware for database performance. Use good judgment and native OS and database tools for your assessment.
Confluence 4.3 Documentation

Ensure you have the Latest Database Indices

Confluence has improved database performance over time. You’ll want to make sure you have all the latest, if you’re getting hung threads waiting for db connections.

Confluence 2.10 or Manual .ddl Indices

With 2.10 and later, Confluence includes database indices bundled. Confluence 2.10 automatically creates the necessary database indexes when you upgrade. If you are not on 2.10, you may have run the .ddl manually during the upgrade process. To check, you can look against these.

Additional Indices not Included in 2.10

- One import db index is the lower case page title index. Prior to Confluence 3.0, querying for a page by title and space key can take a long time due to table scans necessary on a lowercase where clause. On most databases it is possible to add a lowercase index on these columns that helps with performance. See Creating a Lowercase Page Title Index for instructions on how to do this. Prior to 2.10, apply lowercase title indexes (all Confluence versions).
- The compound database index for the ATTACHMENTDATA table is described in CONF-13819.
- A composite index on some of the columns in SpacePermissions table is described in CONF-14488.

Tuning the Database Connection Pool

This is described in the knowledge base article Confluence Slows and Times out During Periods of High Load due to DB Connection Pool.

Configure a Database Query Timeout

If a database is getting overloaded, you can prevent it from crashing Confluence by Configuring a Database Query Timeout.

Related Articles

Troubleshooting Database Issues.

Creating a Lowercase Page Title Index

**Diagnosis**

Confluence sometimes has performance problems retrieving pages by title because the query uses the lower() function. For example, the query looks something like this:

```
select * from CONTENT where lower(TITLE) = :title and SPACEID = :spaceid
```

Database profiling might show a query like the following taking a long time to execute (emphasis added):

```
select ... from CONTENT page0_, SPACES space1_
where page0_.CONTENTTYPE='PAGE'
and (lower(space1_.SPACEKEY)= @P0 and page0_.SPACEID=space1_.SPACEID)
and(lower(page0_.TITLE)= @P1)
and(page0_.PREVVER is null )and(page0_.CONTENT_STATUS='current' ))
```

Typically, databases don't use indexes when you use a function in a where clause; they do a table scan instead. This makes the performance of this query not ideal (CONF-11577).

**Generic solution**

On many databases (e.g. Oracle, PostgreSQL, DB2 for z/OS), it is possible to create the index using the normal "create index" syntax, just using the function instead of the column name.
CREATE INDEX CONFTITLE_LOWER ON CONTENT(lower(TITLE));

Sources:
- [http://www.postgresql.org/docs/current/static/sql-createindex.html](http://www.postgresql.org/docs/current/static/sql-createindex.html)
- [http://asktom.oracle.com/tkyte/article1/](http://asktom.oracle.com/tkyte/article1/)

**SQL Server**

On SQL Server, you can add a computed column to the database table and then add an index on this column.

```
ALTER TABLE CONTENT ADD TITLE_LOWER AS lower(TITLE);
CREATE INDEX CONFTITLE_LOWER ON CONTENT(TITLE_LOWER);
```

Sources:

**MySQL**

It is not currently possible to create a lowercase index on MySQL. Confluence 3.0 includes some caching improvements which should alleviate this performance problem on this database.

Source:

**Workaround for MySQL databases, using a case-insensitive collation:**

Please check whether your MySQL database has been set to use case-sensitive or case-insensitive collation. The queries to check whether your database is set to case-insensitive collation are:

```
SHOW FULL COLUMNS FROM CONTENT WHERE FIELD = 'title';
SHOW FULL COLUMNS FROM SPACES WHERE FIELD = 'spacekey';
```

If the `collation_name` is returned as `<encoding>_ci`, the `ci` indicates case-insensitive collation.

If the database has been set to use case-insensitive collation, you can try removing `lower` from the following queries, in your `ContentEntityObject.hbm.xml` file residing in your `<Confluence-Install>`/confluence/WEB-INF/lib/confluence-2.x.x.jar/com/atlassian/confluence/core/:
DB2 for Linux or Windows

DB2 supports indexes on generated columns which are used for queries with a matching predicate. You can implement it like this:

```sql
ALTER TABLE CONTENT ADD COLUMN TITLE_LOWER GENERATED ALWAYS AS (LOWER(TITLE));
CREATE INDEX CONFTITLE_LOWER ON CONTENT(TITLE_LOWER)
```

Related pages
- Improving Database Performance
- CONF-10030: Queries that use 'lower' do not use index because of case sensitivity

Surviving Database Connection Closures

When a database server reboots or a network failure has occurred, all connections in the database connection pool are broken. To overcome this issue, Confluence would normally need restarting (or for Confluence WAR distributions, the application server running Confluence would need restarting).

However, database connections in the database connection pool can be validated by running a simple SQL query. If a broken database connection is detected in the pool, a new one is created to replace it.

To do this, you can specify an optional validation query for your database connection. Depending on whether you are using a direct JDBC URL, or a data source, this is configured differently.

Determining the validation query SQL for your database type

Different database types have slightly different SQL syntax requirements for their validation query. The validation query should be as simple as possible, as this is run every time a connection is retrieved from the pool.

The following validation queries are recommended for the following types of databases:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Validation Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td>select 1</td>
</tr>
</tbody>
</table>
Microsoft SQL Server | select 1  
Oracle | select 1 from dual  
PostgreSQL | select 1  

**Enabling validation query using direct JDBC**

**To ensure Confluence validates database connections in the database connection pool:**

1. Shut down Confluence
2. Edit the `confluence.cfg.xml` file at the root of your Confluence Home Directory
3. Add the property "hibernate.c3p0.validate" and set it to "true", and add the property "hibernate.c3p0.preferredTestQuery" and set it to the value of the query you determined above for your database type. See this excerpt of the file with the two added properties for details:

```
<property name="hibernate.c3p0.validate">true</property>
<property name="hibernate.c3p0.preferredTestQuery">select 1</property>
```

4. Save `confluence.cfg.xml`
5. Restart Confluence

**Ensuring validation query using a data source**

**To ensure Confluence validates database connections in the database connection pool:**

1. Shut down Confluence (or the Tomcat installation running Confluence).
2. Edit the `conf/server.xml` file in your Confluence Install Directory, or in the Tomcat installation's CATALINA_HOME directory.
3. Find the Resource element for your data source, and add the "validationQuery" field, with the value of the query you determined above for your database type. See this excerpt of the file with this added for details:
server.xml (excerpt)

```xml
...<Resource name="jdbc/confluence" auth="Container"
type="javax.sql.DataSource"
    username="postgres"
    password="postgres"
    driverClassName="org.postgresql.Driver"
    url="jdbc:postgresql://localhost:5432/yourDatabaseName"
    maxActive="20"
    maxIdle="10"
    validationQuery="select 1" />
...```

4. Save `conf/server.xml`

5. Restart Confluence (or the Tomcat installation running Confluence).

**Results and Considerations**

You should now be able to recover from a complete loss of all connections in the database connection pool without the need to restart Confluence or the application server running Confluence.

⚠️ **Performance Considerations:**

- Setting this option has a performance impact. The overall decrease in performance should be minimal, as the query itself is quick to run. In addition, the query will only execute when you make a connection. Thus, if the connection is kept for the duration of a request, the query will only occur once per request.

- If you are running a large Confluence installation, you may wish to assess the performance impact of this change before implementing it.

**Webserver Configuration**

- [Configuring Web Proxy Support for Confluence](#)
- [Running Confluence behind Apache](#)
  - [General Apache Configuration Notes](#)
  - [Using Apache with mod_proxy](#)
  - [Using Apache with virtual hosts and mod_proxy](#)
  - [Using Apache with mod_jk](#)
  - [Using mod_rewrite to Modify Confluence URLs](#)
  - [Configuring Apache to Cache Static Content via mod_disk_cache](#)

**Configuring Web Proxy Support for Confluence**

Some of Confluence’s macros, such as `{rss}` and `{jiraissues}` need to make web requests to remote servers in order to retrieve data. If Confluence is deployed within a data centre or DMZ, it may not be able to access the Internet directly to make these requests. If you find that the `{rss}` macro does not work, ask your network administrator if Confluence needs to access the Internet through a web proxy.

**Configuring an outbound HTTP proxy in Confluence**

Proxy support is configured by passing certain system properties to the Java Virtual Machine on startup. These properties follow the conventions defined by Oracle:

- `http.proxyHost`
- `http.proxyPort` (default: 80)
- `http.nonProxyHosts` (default: `<none>`)
At a minimum, you need to define `http.proxyHost` to configure an HTTP proxy. System property configuration is described in the [Configuring System Properties](#).

Properties `http.proxyHost` and `http.proxyPort` indicate the proxy server and port that the http protocol handler will use.

```bash
-Dhttp.proxyHost=proxy.example.org -Dhttp.proxyPort=8080
```

Property `http.nonProxyHosts` indicates the hosts which should be connected to directly and not through the proxy server. The value can be a list of hosts, each separated by a pipe character |. In addition, a wildcard character (asterisk) * can be used for matching. For example:

```bash
-Dhttp.nonProxyHosts=*.foo.com|localhost
```

Note: You may need to escape the pipe character | in some command-line environments.

If the `http.nonProxyHosts` property is not configured, all web requests will be sent to the proxy.

Please note that any command line parameters set are visible from the process list, and thus anyone who has the appropriate access to view the process list will see the proxy information in the clear. To avoid this, you can set these properties in the `catalina.properties` file, located in `confluence-install/conf/`. Add this to the end of the file:

```properties
http.proxyHost=yourProxyURL
http.proxyPort=yourProxyPort
http.proxyUser=yourUserName
http.proxyPassword=yourPassword
```

**Configuring HTTP proxy authentication**

Proxy authentication is also configured by providing `system properties` to Java in your application server’s configuration file. Specifically, the following two properties:

- `http.proxyUser` – username
- `http.proxyPassword` – secret

**HTTP proxy (Microsoft ISA) NTLM authentication**

Confluence supports NTLM authentication for outbound HTTP proxies when Confluence is running on a Windows server.

This means that the `{rss}` and `{jiraissues}` macro will be able to contact external websites if requests have to go through a proxy that requires Windows authentication. This support is not related to logging in Confluence users automatically with NTLM, for which there is a [user-contributed authenticator](#) available.

To configure NTLM authentication for your HTTP proxy, you need to define a domain `system property`, `http.auth.ntlm.domain`, in addition to the properties for host, port and username mentioned above:
-Dhttp.auth.ntlm.domain=MYDOMAIN

Configuring authentication order

Sometimes multiple authentication mechanisms are provided by an HTTP proxy. If you have proxy authentication failure messages, you should first check your username and password, then you can check for this problem by examining the HTTP headers in the proxy failure with a packet sniffer on the Confluence server. (Describing this is outside the scope of this document.)

To set the order for multiple authentication methods, you can set the system property http.proxyAuth to a comma-separated list of authentication methods. The available methods are: ntlm, digest and basic; this is also the default order for these methods.

For example, to attempt Basic authentication before NTLM authentication, and avoid Digest authentication entirely, you can set the http.proxyAuth property to this value:

- Dhttp.proxyAuth=basic,ntlm

Troubleshooting

1. There’s a diagnostic jsp file in CONF-9719 for assessing the connection parameters.
2. ‘Status Code [407]‘ errors are described in APR-160.
3. Autoproxies are not supported. See CONF-16941.

Running Confluence behind Apache

This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Introduction

For improved performance in high-load environments, you should run Confluence behind a web server. In general, web server caching and thread management is far superior to that provided by your application server’s HTTP interface.

To run Confluence behind the Apache httpd web server, there are two main configuration options: mod_jk or mod_proxy.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>mod_proxy (also known as reverse proxy)</td>
<td>• recommended connection method</td>
</tr>
<tr>
<td></td>
<td>• simple HTTP proxy to application server</td>
</tr>
<tr>
<td></td>
<td>• works with all application servers</td>
</tr>
<tr>
<td></td>
<td>• if application paths are consistent, there is minimal load on the web server</td>
</tr>
</tbody>
</table>
mod_jk (also known as AJP) | • uses the AJP binary protocol
• provides failover (and load balancing, which Confluence supports only with a clustered license)
• only works with some application servers (typically Tomcat)
• if application paths are consistent, there is some load on the web server to translate requests to AJP

Features common to both mod_proxy and mod_jk
• application paths must be consistent to avoid complex and slow URL rewriting
• works with name-based virtual hosting, both on web server and app server
• web server keeps a pool of connections to application server

Using mod_proxy
• Using Apache with mod_proxy is the main documentation for this configuration.
• If you want to set up the common configuration of JIRA and Confluence virtual hosts, you can use Apache's virtual hosts with separate application servers.

Using mod_jk
• Using Apache with mod_jk is the main documentation for this configuration.
• You can follow a similar method to the mod_proxy documentation above for setting up virtual hosts in Apache and Tomcat, if required.

Mod_jk2 not supported
The misleadingly-named mod_jk2 is an older method of connecting to Tomcat from Apache. Since mod_jk2 is no longer supported by the Apache Foundation, we do not support this configuration, and are not updating our mod_jk2 documentation. Mod_jk2 also has unresolved problems with Unicode URLs; you need to use either mod_proxy or mod_jk for international characters to work correctly in Confluence.

Caching static content via mod_disk_cache
To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

Other related documentation
• Configuring Tomcat's URI encoding
• Running Confluence Over SSL or HTTPS

General Apache Configuration Notes

On this page:
• Prefer Apache mod_deflate to Confluence's built-in gzip implementation
• Ensure keepalive is enabled
• Enable keepalive for recent MSIE user agents

Prefer Apache mod_deflate to Confluence's built-in gzip implementation
1. Disable gzip in confluence. See Compressing an HTTP Response within Confluence.
2. Enable gzip compression in Apache. For RedHat distributions this can be achieved by adding the following lines:
Ensure keepalive is enabled

```
KeepAlive On
```

Enable keepalive for recent MSIE user agents

The standard Apache SSL configuration is very conservative when it comes to MSIE and SSL. By default all keepalives are disabled when using HTTPS with MSIE. While MSIE will always be special, the issues with SSL and MSIE have been solved since Service Pack 2 for Windows XP, released over 4 years ago. For anyone using an XP machine SP2 or above, it is safe to allow keepalive for MSIE 6 and above.

Remove the following lines:

```
SetEnvIf User-Agent ".*MSIE.*" \
    nokeepalive ssl-unclean-shutdown \ 
    downgrade-1.0 force-response-1.0
```

Add these in their place:

```
BrowserMatch "MSIE [1-5]" nokeepalive ssl-unclean-shutdown downgrade-1.0 force-response-1.0
BrowserMatch "MSIE [6-9]" ssl-unclean-shutdown
```

RELATED TOPICS

- Running Confluence behind Apache
- Configuring Tomcat's URI encoding
- Running Confluence Over SSL or HTTPS
- Using Apache with mod_proxy

This page describes how to integrate Confluence into an Apache website using mod_proxy.

There are some common situations where you might use the configuration:

- You have an existing Apache-based website, and want to add Confluence to the mix (for example, http://
www.example.com/confluence).

- You have two or more Java applications, each running in their own application server on different ports, for example, http://example:8090/confluence and http://example:8080/jira. By setting up Apache with mod_proxy, you can have both available on the regular HTTP port (80) – for example, at http://www.example.com/confluence and http://www.example.com/jira. This allows each application to be restarted, managed and debugged separately.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

We describe two options:

- If you want a URL like http://www.example.com/confluence, go to the **simple configuration**.
- If you want a URL like http://confluence.example.com, go to the **complex configuration**.

**Simple configuration**

In these examples, we use the following:

- http://www.example.com/confluence - your intended URL
- http://example:8090 - the hostname and port Confluence is currently installed to
- /confluence - the intended context path (the part after hostname and port)

Please substitute the examples below with your intended URL's in your own server. Copy/pasting these suggestions will not work on your server.

**Set the context path**

Set your Confluence application path (the part after hostname and port). To do this in Tomcat (bundled with Confluence), edit conf/server.xml, locate the "Context" definition:

```
<Context path="" docBase="../confluence" debug="0" reloadable="true">
```

and change it to:

```
<Context path="/confluence" docBase="../confluence" debug="0" reloadable="true">
```

Then restart Confluence, and ensure you can access it at http://example:8090/confluence

**Set the URL for redirection**

Set the URL for redirection. In the same conf/server.xml file, locate this code segment:

```
<Connector port="8090" maxHttpHeaderSize="8192"
        maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
        enableLookups="false" redirectPort="8443" acceptCount="100"
        connectionTimeout="20000" disableUploadTimeout="true" />
```

And append the last line:

```xml
<Connector port="8090" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" redirectPort="8443" acceptCount="100"
    connectionTimeout="20000" disableUploadTimeout="true"
    proxyName="www.example.com" proxyPort="80" />
```

If this isn't working for you, try adding a scheme attribute to your Connector tag: `scheme="https"`.

**Configure mod_proxy**

Now enable mod_proxy in Apache, and proxy requests to the application server by adding the example below to your Apache httpd.conf (note: the files may be different on your system; the [JIRA docs](https://confluence.atlassian.com/doc/enable-mod-proxy-in-apache/) describe the process for Ubuntu/Debian layout):

```xml
# Put this after the other LoadModule directives
LoadModule proxy_module /usr/lib/apache2/modules/mod_proxy.so
LoadModule proxy_http_module /usr/lib/apache2/modules/mod_proxy_http.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
ProxyRequests Off
ProxyPreserveHost On

<Proxy *>
   Order deny,allow
   Allow from all
</Proxy>

ProxyPass /confluence http://www.example.com/confluence
ProxyPassReverse /confluence http://www.example.com/confluence
<Location /confluence>
   Order allow,deny
   Allow from all
</Location>
```

**Note to Windows Users**

It is recommended that you specify the absolute path to the `mod_proxy.so` and `mod_proxy_http.so` files.

**Restart your Apache server**

This is needed to pick up on the new configuration. This can be done by running the following on your command line/terminal/shell:

```bash
sudo apachectl graceful
```

**Set the Confluence Base URL**

The last stage is to set the Base URL to the address you're using within the proxy. In this example, it would be `http://www.example.com/confluence`

Complex configuration
Complex configuration involves using the mod_proxy_html filter to modify the proxied content en-route. This is required if the Confluence path differs between Apache and the application server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (Apache) URL</th>
<th><a href="http://confluence.example.com/">http://confluence.example.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

Notice that the application path in the URL is different in each. On Apache, the path is /, and on the application server the path is /confluence.

For this configuration, you need to install the mod_proxy_html module, which is not included in the standard Apache distribution. Alternative solutions are discussed below.

```xml
# Put this after the other LoadModule directives
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so
LoadModule proxy_html_module modules/mod_proxy_html.so

<VirtualHost *>
  ServerName confluence.example.com

    # Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
    ProxyRequests Off
    ProxyPreserveHost On

    <Proxy *>
      Order deny,allow
      Allow from all
    </Proxy>

    ProxyPass / http://app-server.internal.example.com:8090/confluence
    ProxyPassReverse / http://app-server.internal.example.com:8090/confluence

    ProxyHTMLURLMap / /confluence/

  <Location />
    Order allow,deny
    Allow from all
  </Location>

</VirtualHost>
```

The ProxyHTMLURLMap configuration can become more complex if you have multiple applications running under this configuration. The mapping should also be placed in a Location block if the web server URL is a subdirectory and not on a virtual host. The Apache Week tutorial has more information how to do this.

Adding SSL

If you're running Apache in front of Tomcat, it's a good idea to terminate your SSL configuration at Apache, then forward the requests to Tomcat over HTTP. You can set up Apache to terminate the SSL connection and use the ProxyPass and ProxyPassReverse directives to pass the connection through to Tomcat (or the appropriate application server) which is running Confluence.

1. Create a new SSL host by creating a virtual host on 443
2. The standard http connection on apache could be used to redirect to https if you want or it could just be firewalled.
3. Within the VirtualHost definition:
   a. define the SSL options (SSLEngin and SSLCertificateFile)
   b. define the ProxyPass and ProxyPassReverse directives to pass through to Tomcat.

Most of the relevant Apache Config:

```plaintext
Listen 443
NameVirtualHost *:443
<VirtualHost *:443>
   SSLEngine On
   SSLCertificateFile /etc/apache2/ssl/apache.pem
   ProxyPass / http://localhost:8090/
   ProxyPassReverse / http://localhost:8090/
</VirtualHost>
```

Apart from the Apache configuration there is a couple of things you will need to do before you get your server working:

1. You will have to change your base URL to point to https addresses. See the documentation on configuring the server base URL.
2. We need to set up the connector to use https. In your installation directory, edit the file server.xml and add this attributes to your connector:

   ```xml
   proxyName="proxy.example.com" proxyPort="443" scheme="https"
   ```

More information

- The mod_proxy_html site has documentation and examples on the use of this module in the complex configuration.
- Apache Week has a tutorial that deals with a complex situation involving two applications and ProxyHTMLURLMap.
- Using Apache with virtual hosts and mod_proxy shows how to configure the special case where you want JIRA and Confluence running on separate application servers on virtual host subdomains.

Alternatives

If Tomcat is your application server, you have two options:

- use mod_jk to send the requests to Tomcat
- use Tomcat's virtual hosts to make your Confluence application directory the same on the app server and the web server, removing the need for the URL mapping.

If your application server has an AJP connector, you can:

- use mod_jk to send the requests to your application server.

Using Apache with virtual hosts and mod_proxy

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.
The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_proxy simply redirects requests for certain URLs to another web server, so it typically requires no additional configuration on the application server.

This page documents a very common configuration request: configuring JIRA and Confluence on two Apache virtual hosts, running on different application servers. This is just a special case of mod_proxy configuration.

You can use virtual hosts in your application server if you want to run JIRA and Confluence on the same application server. There is a sample configuration for Tomcat you can use after configuring Apache.

**Apache configuration**

For this configuration to work properly, the application paths must be the same on both the application servers and the web server. For both JIRA and Confluence below, this is /.

<table>
<thead>
<tr>
<th>JIRA external URL</th>
<th><a href="http://jira.example.com/">http://jira.example.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA application server URL</td>
<td><a href="http://jira-app-server.internal.example.com:8080/">http://jira-app-server.internal.example.com:8080/</a></td>
</tr>
<tr>
<td>Confluence external URL</td>
<td><a href="http://confluence.example.com/">http://confluence.example.com/</a></td>
</tr>
<tr>
<td>Confluence application server URL</td>
<td><a href="http://confluence-app-server.internal.example.com:8090/">http://confluence-app-server.internal.example.com:8090/</a></td>
</tr>
</tbody>
</table>

Add the following to your Apache httpd.conf:
Points to note:

- ProxyPass and ProxyPassReverse directives send traffic from the web server to your application server.
- The application path is the same on the application server and on the web server (both are /).
- Because the above configuration uses name-based virtual hosting, you must configure your DNS server to point both names (jira.example.com, confluence.example.com) to your web server.

More information

For different ways to configure mod_proxy, see Using Apache with mod_proxy.

If you use Tomcat, mod_jk provides a different way of connecting Apache via AJP. You can also use the above configuration with just one application server if you use Tomcat's virtual hosts.

Using Apache with mod_jk

Note:

- The preferred configuration is Using Apache with mod_proxy. This works with any application server, and together with mod_proxy_html allows complex URL rewriting to deal with different application paths on
the web server and the application server.

- This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

**Introduction**

The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_jk allows request forwarding to an application via a protocol called AJP. Configuration of this involves enabling mod_jk in Apache, configuring a AJP connector in your application server, and directing Apache to forward certain paths to the application server via mod_jk.

Mod_jk is sometimes preferred to mod_proxy because AJP is a binary protocol, and because some site administrators are more familiar with it than with mod_proxy.

The scope of this documentation is limited to configuring the AJP connector in Tomcat 5.x. Other application servers may support AJP connectors; please consult your application server documentation for instructions on how to configure it.

The configuration below assumes your Confluence instance is accessible on the same path on the application server and the web server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (web server) URL</th>
<th><a href="http://www.example.com/confluence/">http://www.example.com/confluence/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL (HTTP)</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

The AJP connection of the application server is set to: app-server.internal.example.com:8009.

**Configuring mod_jk in Apache**

The standard distribution of Apache does not include mod_jk. You need to download it from the [JK homepage](https://httpd.apache.org/docs/2.4/mod/mod_jk.html) and put the mod_jk.so file in your Apache modules directory.

Next, add the following in `httpd.conf` directly or included from another file:

```sh
# Put this after the other LoadModule directives
LoadModule jk_module modules/mod_jk.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
JkWorkersFile conf/workers.properties
JkLogLevel info

# JkMount /confluence worker1
# JkMount /confluence/* worker1
```

**Configuring workers.properties**

Create a new file called 'workers.properties', and put it in your Apache conf directory. (The path for workers.properties was one of the configuration settings above.)
worker.list=worker1
worker.worker1.host=app-server.internal.example.com
worker.worker1.port=8009
worker.worker1.type=ajp13

Tomcat 5.x configuration

In Tomcat 5, the AJP connector is enabled by default on port 8009. An absolutely minimal Tomcat server.xml is below for comparison. The relevant line is the Connector with port 8009 – make sure this is uncommented in your server.xml.

```xml
<Server port="8000" shutdown="SHUTDOWN">
  <Service name="Catalina">
    <!-- Define a HTTP/1.1 Connector on port 8090 -->
    <Connector port="8090" />
    <!-- Define an AJP 1.3 Connector on port 8009 -->
    <Connector port="8009" protocol="AJP/1.3" />
    <Engine name="Catalina" defaultHost="localhost">
      <Host name="localhost" appBase="webapps">
        <Context path="/confluence" docBase="/opt/webapps/confluence-2.2/confluence"/>
        <Logger className="org.apache.catalina.logger.FileLogger"/>
      </Host>
    </Engine>
  </Service>
</Server>
```

Points to note:

- the Connector on port 8009 has protocol of "AJP/1.3". This is critical.
- the Context path of the Confluence application is "/confluence". This must match the path used to access Confluence on the web server.
- we recommend keeping your application Contexts outside the server.xml in Tomcat 5.x. The above example includes them for demonstration only.

Improving the performance of the mod_jk connector

The most important setting in high-load environments is the number of processor threads used by the Tomcat AJP connector. By default, this is 200, but you should increase it to match Apache's maxThreads setting (256 by default):

```xml
<Connector port="8009" minSpareThreads="5" maxThreads="256" protocol="AJP/1.3" />
```

All the configuration parameters for the AJP connector are covered in the Tomcat documentation.

Ensuring UTF-8 compatibility

If you have problems downloading attachments with non-ASCII characters in the filename, add the following to your Apache configuration:
And specify UTF-8 as the URIEncoding in the AJP connector configuration:

```xml
<Connector port="8009" protocol="AJP/1.3" URIEncoding="UTF-8" />
```

These settings are discussed further on [Configuring Tomcat's URI encoding](#).

### Configuring Tomcat's URI encoding

The [Tomcat JK website](http://tomcat.apache.org/) has complete documentation on workers.properties and Apache configuration. You can also find information there on how to use mod_jk with IIS.

### Using mod_rewrite to Modify Confluence URLs

**Note**: This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Confluence requires URL rewriting for proper functionality, if Confluence is accessible via different domain names. If Confluence is configured for multiple domains without URL rewriting, you will experience an array of problems. See [Various Issues Caused when Server Base URL Does Not Match the URL Used to Access Confluence](#).

An example of why you may want to access Confluence from different domains:

- From an internal network:
  
  http://wiki

- The externally visible domain:
  
  http://wiki.domain.com

### Using URL rewriting to access Confluence over multiple domains

**To configure Confluence over multiple domains:**

1. Add a DNS entry mapping [http://wiki](http://wiki) to the externally visible IP address of the Confluence server.
2. Set Confluence’s [server base URL](http://wiki.domain.com).
3. Add Apache HTTP proxy, using the instructions from [Running Confluence behind Apache](#).
4. Add the mod_rewrite module to change the URL.

### Configuring Apache to Cache Static Content via mod_disk_cache

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content.

Static content in Confluence includes most JavaScript, CSS and image files which are included with the application or an installed plugin. This content will be cached by Apache in this configuration. User-provided content like space logos, attachments or embedded images are not considered static content and will not be
configured.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

### Configuring Apache mod_disk_cache

**To configure Apache to cache static Confluence content:**

1. **Add a mod_disk_cache stanza to the virtual host configuration:**

   ```
   <IfModule mod_disk_cache.c>
     # "s" is where Confluence serves "static" stuff. Instruct Apache
to cache it:
     CacheEnable disk /s
     CacheIgnoreHeaders Set-Cookie
     CacheRoot "/var/cache/mod_proxy"
   </IfModule>
   ```

2. **Configure Apache to load mod_disk_cache.** For example, in our server configuration this is done in `/etc/httpd/conf/httpd.conf`:

   ```
   LoadModule disk_cache_module modules/mod_disk_cache.so
   ```

3. **Restart Apache after both modifications are complete.**

### Notes

- Please refer to the Apache documentation for [mod_disk_cache](http://httpd.apache.org/docs/2.4/mod/mod_disk_cache.html).
- If you encounter problems where users are served stale content, you may need to purge the Apache cache directory (`/var/cache/mod_proxy` in the above configuration) after a Confluence or plugin upgrade. This is a simple 3 step process:
  - Shut down Apache.
  - Clear the cache directory. For example: `sudo rm -r /var/cache/mod_proxy/*`
  - Restart Apache.
- Ensure that you are running the `htcacheclean` daemon in order to prevent excessive use of disk space. In our situation we ran it like this:

  ```
  sudo htcacheclean -d30 -n -t -p /var/cache/mod_proxy -l 512M
  ```

  This will purge content once the cache reaches 512M every 30 minutes. See the Apache documentation for [htcacheclean](http://httpd.apache.org/docs/2.4/htcacheclean.html) for details of the options.

### Starting Confluence Automatically on System Startup

You can configure Confluence to start automatically on system startup, allowing it to recover automatically after a reboot.

---

No content found for label(s) auto-startup.

**Start Confluence Automatically on Linux**
On Linux/Solaris, the best practice is to install, configure and run each service (including Confluence) as a dedicated user with only the permissions they require.

To install, configure and run Confluence automatically on Linux/Solaris:

1. Create a `confluence` user for instance, using the following command:

   ```bash
   sudo useradd --create-home -c "Confluence role account" confluence
   ```

2. Create a directory to install Confluence into:

   ```bash
   sudo mkdir /usr/local/confluence
   sudo chown confluence: /usr/local/confluence
   ```

3. Log in as the `confluence` user to install Confluence:

   ```bash
   sudo su - confluence
   cd /usr/local/confluence/
   tar zxvf /tmp/confluence-3.0.1-std.tar.gz
   ln -s confluence-3.0.1-std/ current
   ```

4. Edit `<<CONFLUENCE_INSTALL_DIRECTORY>>/confluence/WEB-INF/classes/confluence-init.properties` file, and set `confluence.home=/usr/local/confluence/<Confluence_Data_Home>` (ensure you have removed the comment `#`)

5. Then back as root, create the file `/etc/init.d/confluence` (code shown below), which will be responsible for starting up Confluence after a reboot (or when manually invoked).

   ```bash
   #!/bin/sh
   # Confluence Init Script
   # $Id$
   # $Log$
   # This script is responsible for starting up the Confluence server.
   # In the future, you can disable Confluence by removing this file.

   confluence_home=/usr/local/confluence
   confluence_base_dir=$confluence_home/confluence
   confluence_classpath=confluence_home/WEB-INF/lib
   confluence_jar=confluence_home/WEB-INF/confluence.jar
   confluence_logdir=$confluence_home/logs

   # Start Confluence
   start() {
     if test -x $confluence_classpath/$confluence_jar; then
       java -Dconfluence_home=$confluence_home -Dconfluence_base_dir=$confluence_base_dir -Dconfluence_classpath=$confluence_classpath -Dconfluence_jar=$confluence_jar -Dconfluence_logdir=$confluence_logdir -Dconfluence_startfile=confluence-config.xml -jar $confluence_base_dir/confluence.jar
     fi
   }

   # Stop Confluence
   stop() {
     if ! confluence.base_dir=$confluence_home; then
       echo "Confluence is not running" 1>&2
       return
     fi

     echo "Stopping Confluence" 1>&2
     kill -INT confluence.base_dir/confluence.pid
     while ! test -e confluence.base_dir/confluence.pid; do
       sleep 1
     done
   }

   # Reload Confluence
   reload() {
     stop
     start
   }

   case "$1" in
     start)
       start
       start
     ;; stop)
       stop
       stop
     ;; reload)
       reload
       reload
     ;; *)
       echo "usage: confluence-init.sh start|stop|reload"
          exit 1
     esac

   # The following enables the script to be executed from anywhere
   # (the next line can be removed when you are satisfied)
   # chown root root init.d/confluence
   # chmod 755 init.d/confluence
   ```

   If you are running Ubuntu Jaunty (or later) do not perform this step. Please use the instructions further down this page.
#!/bin/sh -e
# Confluence startup script
#chkconfig: 2345 80 05
#description: Confluence

# Define some variables
# Name of app ( JIRA, Confluence, etc )
APP=confluence
# Name of the user to run as
USER=confluence
# Location of application's bin directory
CATALINA_HOME=/usr/local/confluence/current
# Location of Java JDK
export JAVA_HOME=/usr/lib/jvm/java-6-sun

case "$1" in
  # Start command
  start)
    echo "Starting $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/startup.sh &> /dev/null"
    ;;
  # Stop command
  stop)
    echo "Stopping $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/shutdown.sh &> /dev/null"
    echo "$APP stopped successfully"
    ;;
  # Restart command
  restart)
    $0 stop
    sleep 5
    $0 start
    ;;
  *)
    echo "Usage: /etc/init.d/$APP (start|restart|stop)"
    exit 1
    ;;
  esac

exit 0

6. Make this file executable:

    sudo chmod +x /etc/init.d/confluence

7. Set this file to run at the appropriate runlevel. For example, use sudo chkconfig --add confluence on Redhat-based systems, sudo update-rc.d confluence defaults or rcconf on Debian-based systems.

8. You should now be able to start Confluence with the init script. A successful startup output typically looks like this:
$ sudo /etc/init.d/confluence start
Starting Confluence:
If you encounter issues starting up Confluence, please see the Installation guide at http://confluence.atlassian.com/display/DOC/Confluence+Installation+Guide
Using CATALINA_BASE: /usr/local/confluence/current
Using CATALINA_HOME: /usr/local/confluence/current
Using CATALINA_TMPDIR: /usr/local/confluence/current/temp
Using JRE_HOME: /usr/lib/jvm/java-1.5.0-sun
done.

You should then see this running at http://<server>:8090/
The port for this will be whatever is defined in your Confluence server.xml file.

Adding Confluence as a service for Ubuntu Jaunty (or later)

To continue configuring Confluence to start automatically as a service on Ubuntu Jaunty (or later):

1. After logging in as the confluence user to install Confluence, create start and stop scripts in /usr/local/confluence:

Example start script:

```bash
#!/bin/bash
export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
cd /usr/local/confluence/current/bin
./startup.sh
```

Example stop script:

```bash
#!/bin/bash
export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
cd /usr/local/confluence/current/bin
./shutdown.sh
```

2. Make both of these scripts executable. For example, by issuing the command: sudo chmod a+x /usr/local/confluence/start /usr/local/confluence/stop.

3. Karmic and later: Create two text files in /etc/init/ called confluence-up.conf and confluence-down.conf:

```bash
confluence-up:
```

```bash
confluence-down:
```
start on runlevel [2345]

script

date >> /tmp/confluence-startup.out
exec sudo -u confluence /usr/local/confluence/start >>
/tmp/confluence-startup.out 2>&1

end script

confluence-down:

start on runlevel [16]

expect fork
responder

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/init/confluence-up.conf /etc/init/confluence-down.conf

1. Jaunty, Intrepid: Create two text files in /etc/event.d/ called confluence-up and confluence-down:

   confluence-up:

   start on runlevel 2
   start on runlevel 3
   start on runlevel 4
   start on runlevel 5

   exec sudo -u confluence /usr/local/confluence/start >>
   /tmp/confluence-startup.out 2>&1

   confluence-down:
start on runlevel 1
start on runlevel 6

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/event.d/confluence-up /etc/event.d/confluence-down

RELATED TOPICS

Starting Confluence Automatically on System Startup

Start Confluence Automatically on Windows as a Service

For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.

There are two ways to install the Confluence distribution as a service: using the Confluence installer or manually as described below.

On this page:

- Reasons for Starting Confluence as a Service
- Changing the User Running the Service
- Manually Installing the Confluence Distribution as a Service
- Managing Confluence as a Service
- Upgrading Confluence
- Troubleshooting Confluence while Running as a Windows Service
- Requesting Support

⚠️ Problem with 64-bit Windows

If you are running 64-bit Windows, please note that Apache Tomcat cannot run as a Windows service if you are using a 64-bit JDK. Please ensure that you are using a 32-bit JDK. Refer to our knowledge base article for more information.

Reasons for Starting Confluence as a Service

Installation as a Windows service offers these advantages:

- Reduced risk of shutting down Confluence by accident (If you start Confluence manually, a console window opens and there is a risk of someone accidentally shutting down Confluence by closing the window).
- Automated Confluence recovery after server restart.
- Improved troubleshooting through logging server output to file.

You can read more about Windows services in the Microsoft Developer Network.

Changing the User Running the Service

If you wish to run the service as a non-administrator user for security, or if you are using network drives for backups, attachments or indexes, you can run the service as another user. To change users, open the Apache
Tomcat Confluence properties, go to the 'Log On' tab and enter the required username and password. Go to your Windows Control Panel -> User Accounts and confirm that the user has write permissions for the %CATALINA_HOME%, index and database directories. Note that any network drives must be specified by UNC and not letter mappings (eg. \\backupserver\confluence not z:\confluence).

For more detail, see Creating a Dedicated User Account on the Operating System to Run Confluence.

**Manually Installing the Confluence Distribution as a Service**

From your Windows-based server:

1. Open a command prompt in the `<CONFLUENCE-INSTALL>/bin` directory.
2. Confirm that the JAVA_HOME variable is set to the JDK base directory with the command:
   
   ```
   echo %JAVA_HOME%
   ```
   
   Note that any directory in the path with spaces (eg. C:\Program Files must be converted to its eight-character equivalent (e.g. C:\Progra~1).

3. If you are installing Confluence on a Windows 2008 server, be sure to run the command prompt using 'run as administrator'. (Otherwise running 'service.bat', as described in the next step, will fail.)
4. Use the following command to install the service with default settings:
   
   ```
   service.bat install Confluence
   ```

5. Now, to have the service start automatically when the server starts, run:
   
   ```
   tomcat6 //US//Confluence --Startup auto
   ```

6. If you have a less than a 512 megabytes of memory, skip this step. For users with large Confluence installations, you can increase the maximum memory Confluence can use. (The default is 256MB). For example, you can set the maximum memory to 512 megs using:
   
   ```
   tomcat6 //US//Confluence --JvmMx 512
   ```

7. If you do not have any JVM parameters that you pass to your distribution of Confluence, you can skip this step. If you do, add them to the service using:
   
   ```
   tomcat6 //US//Confluence ++JvmOptions="-Djust.an.example=True"
   ```

8. For further configuration options, please refer to the Tomcat Windows Service How-To guide
9. Go to your Windows Control Panel -> Administrative Tools -> Services -> Apache Tomcat Confluence and right-click on Properties to verify the settings are correct.

Confluence is now installed as a service, but will not automatically start up until the next server reboot

10. Start the Confluence service with the command:
Managing Confluence as a Service

You can manage the Confluence service from the command prompt.

- Stop Confluence with:
  ```
  net stop Confluence
  ```

- Uninstall the Confluence service with:
  ```
  service.bat remove Confluence
  ```

Upgrading Confluence

After upgrading Confluence, you can either uninstall and reinstall the Windows service or change the StartPath parameter to your new folder. Refer to the Tomcat documentation for help.

Troubleshooting Confluence while Running as a Windows Service

- Check the Knowledge Base articles:
  No content found for label(s) windows_service.

- If none of the above solves your problem, please refer to the complete list of known issues in our Knowledge Base.

- When investigating memory issues or bugs, it may be useful to view information from Confluence's garbage collection. To turn on the verbose garbage collection, use the command:
  ```
  tomcat6 //US//Confluence
  ++JvmOptions="-Xloggc:<CONFLUENCE-INSTALL>\logs\atlassian-gc.log"
  ```

- The Confluence 2.9 installer does not work when installed as service, due to a missing semi-colon in service.bat. Please refer to reported issue CONF-12785.

- You can use a Sysinternals tool called Procmon.exe from the The Microsoft Windows Sysinternals Team, to check that the error occurred at the specific time when the Confluence service started. You need to match the time when Tomcat failed, as captured by this tool, against the time in the Windows Event Viewer.

⚠️ **Note**

We do not recommend that you run this tool for too long as it may disrupt other Atlassian applications. Once you have captured the required information you will need to press Ctrl + E to stop capturing.
**Requesting Support**

If, after following the troubleshooting guide above, you still cannot make Confluence run as a Windows Service or if there is an error when setting the JVM configuration for the service, you can create a support request.

Please provide the following information when creating your support request, because we will need it to assist you:

- Are you running a 32 bit or 64 bit Windows?
- Give us the result of running `java -version` from Windows command line console.
- A screen shot of your Windows Registry setting for Tomcat.
- If you have modified `service.bat`, please give us a copy of this file for review.
- What application server are you using? eg. Are you using the Confluence distribution?

**RELATED TOPICS**

Starting Confluence Automatically on System Startup  
How to Fix Out of Memory Errors by Increasing Available Memory

**Configuring a Large Confluence Installation**

Deploying any application to several thousand users requires care and planning, especially if those users are going to be relying on the application to get their work done.

⚠️ The information on this page does not apply to Confluence OnDemand.

**General Advice**

**Staged Rollout**

Do not try to deploy Confluence immediately to your whole organisation. Instead, roll it out department by department, or project by project.

How Confluence will scale given a particular software and hardware configuration depends very much on how Confluence is likely to be used in your organisation. Launching Confluence to everybody at once may seem like a neat idea, but it also means that any problems you might experience scaling the system up to your entire organisation will hit you all at once, annoy everyone and possibly hurt adoption.

Rolling Confluence out gradually will give you the chance to tune it as you go, resulting in a much more painless experience. There will also be organisational advantages: you can identify those teams or projects who are most likely to be successful 'early adopters', and those teams can experiment with how best a wiki might suit your organisation, and pass on their 'best wiki practices' as usage of Confluence expands.

**Plugin Governance**

Confluence plugins can add tremendous value. Before adding one, visit the plugin's page and explore its issues (available from the issue management link). Try the plugin in a test environment and make sure to note any adverse effects after adding it to a production environment. Test plugins independently when upgrading.

**Backup strategy**

Disable the XML backup and use the Production Backup Strategy.

**New Spaces Governance**

For both performance and good practice, put some modest governance in place around the creation of new spaces, such as a simple request that includes a check for duplicates and some strategy around how to best use
a space. Duplicates and unused spaces should be purged by a wiki gardener. Try to keep it to one space per group.

**Choosing User Management and Single Sign-On**

We recommend that you choose and configure your user management solution as soon as possible, rather than adding it to your Confluence installation at a later date.

It is possible to integrate with an LDAP repository, such as Microsoft Active Directory, or add a single sign-on solution later (especially with the addition of Crowd). But if possible it is best to configure your user management system up front. You can configure access for only a specific group or set of groups, thereby keeping the gradual rollout.

Please refer to our detailed guide to Configuring User Directories and examine the User Management Limitations and Recommendations.

**Configuring your Application Server, Web Server and Database**

Because Confluence can be deployed in so many server combinations, we do not currently have guides on the best tuning parameters for each individual server. We will be happy to provide support, however. If you have any tuning parameters that you find particularly useful for Confluence instances, feel free to share them with other Confluence users in the Confluence Community space.

**Best Practices**

**Troubleshooting possible memory leaks**

The Troubleshooting Confluence Hanging or Crashing guide is a good place to start. Some of the known causes listed there could result in performance issues short of a crash or hang. Many of the issues reported there are exacerbated with a large installation.

**Memory Usage**

The Java virtual machine is configured with a "maximum heap size" that limits the amount of memory it will consume. If Confluence fills up this maximum heap size it will run out of memory, and start behaving unpredictably. You can keep track of Confluence's memory usage from the System Information screen of the administration console:

<table>
<thead>
<tr>
<th>Java VM Memory Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Memory</td>
</tr>
<tr>
<td>Free Memory</td>
</tr>
<tr>
<td>Used Memory</td>
</tr>
<tr>
<td>Memory Graph</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

This example shows that, at the time of writing, confluence.atlassian.com is using 173MB of an allocated 313MB of heap. (The JVM was configured with a maximum heap size of 450MB, but this information is not available in the graph. The 313MB figure shows that the full 450MB of heap has not yet been needed)

**Database Connection Pool**

Confluence will need a database connection for each simultaneous user connection to the server. It is also a good idea to have 5-10 connections spare for Confluence internal processes such as backups, re-indexing or daily notification jobs.

Running out of pooled connections will cause the server to slow down as more users are waiting for a connection to be freed before starting their own request, and will eventually cause visible system errors as Confluence times out waiting for a database connection.
If you are using Confluence's internal connection pool, you can increase the number of available connections by modifying the `hibernate.c3p0.max_size` property in `{confluence_home}/confluence-cfg.xml`, and restarting Confluence. **Make sure** you have also configured your database to be able to support that many simultaneous connections.

**Cache Sizes**

The [Performance Tuning](#) page includes some useful rules of thumb for configuring the sizes of Confluence's internal caches.

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See [Configuring Apache to Cache Static Content via mod_disk_cache](#).

**RELATED TOPICS**

- Operating Large or Mission-Critical Confluence Installations
- Performance Tuning
- Confluence Clustering Overview
- Requesting Performance Support
- Managing Confluence Users
- Confluence Administrator's Guide
- Configuring Confluence

**Configuring Logging**

We recommend that you configure Confluence's logging to your own requirements. You can change the log settings in two ways:

- Configure logging in Confluence Administration – Your changes will be in effect only until you next restart Confluence.
- Edit the properties file – Your changes will take effect next time you start Confluence, and for all subsequent sessions.

Both methods are described below. In some rare circumstances you may also need to configure Configuring Logging.

**Terminology:** In log4j, a 'logger' is a named entity. Logger names are case-sensitive and they follow a hierarchical naming standard. For example, the logger named `com.foo` is a parent of the logger named `com.foo.Bar`.

⚠️ *The information on this page does not apply to Confluence OnDemand.*

**Configure logging in Confluence Administration**

You can change some of Confluence's logging behaviour via the Administration Console while Confluence is running. Any changes made in this way will apply only to the currently-running Confluence lifetime. The changes are not written to the `log4j.properties` file and are therefore discarded when you next stop Confluence.

Not all logging behaviour can be changed via the Administration Console. For logging configuration not mentioned below, you will need to stop Confluence and then edit the logging properties file instead.

The 'Logging and Profiling' screen shows a list of all currently defined loggers. On this screen you can:

- Turn page profiling on or off.
- Turn detailed SQL logging on or off.
- Add a new logger for a class/package name.
- Remove a logger for a class/package name.
- Set the logging level (INFO, WARN, FATAL, ERROR or DEBUG) for each class or package name.
- Reset all logging levels to a predefined profile.

### Changing the logging configuration

1. Choose **Browse > Confluence Admin**.
2. Select 'Logging and Profiling' in the 'Administration' section of the left-hand panel.
   - You need to have **System Administrator** permissions in order to perform this function.
3. The 'Logging and Profiling' screen appears, as shown below. Use the following guidelines to change the logging behaviour while Confluence is running:
   - 'Performance Profiling' — See [Page Request Profiling](#).
   - 'SQL Logging' — Click the 'Enable SQL Logging' button to log the details of SQL requests made to the database.
     - If you need to enable logging of SQL parameter values, you will need to change the setting in the properties file. This option is not available via the Administration Console.
   - 'Log4j Logging' — Click one of the profile buttons to reset all your loggers to the predefined profiles:
     - The 'Production' profile is a fairly standard profile, recommended for normal production conditions.
     - The 'Diagnostic' profile gives more information, useful for troubleshooting and debugging. It results in slower performance and fills the log files more quickly.
   - 'Add New Entry' — Type a class or package name into the text box and click the 'Add Entry' button. The new logger will appear in the list of 'Existing Levels' in the lower part of the screen.
   - 'Existing Levels' - These are the loggers currently in action for your Confluence instance.
     - You can change the logging level by selecting a value from the 'New Level' dropdown list. Read the Apache documentation for a definition of each level.
     - Click the 'Remove' link to stop logging for the selected class/package name.
4. Click the 'Save' button to save any changes you have made in the 'Existing Levels' section.

*Screenshot: Changing Log Levels and Profiling*
Performance Profiling
Profiling is currently OFF.

Enable Profiling

SQL Logging

Enable SQL Logging

Log4j Logging

Choose from one of the predefined logging options or configure logging below.

Production Diagnostic

OR:

Customise specific logging settings

Add New Entry

<table>
<thead>
<tr>
<th>Class/Package Name</th>
<th>New Level</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>INFO</td>
</tr>
</tbody>
</table>

Existing Levels

<table>
<thead>
<tr>
<th>Class/Package Name</th>
<th>Current Level</th>
<th>New Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.atlassian.confluence.cluster</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.cluster.safety</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.importexport.impl.PdfExporter</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>com.atlassian.confluence.lifecycle</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.upgrade</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.core.util.FileUtils</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>com.atlassian.upgrade</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>net.sf.hibernate.cache.ReadWriteCache</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.impl.SessionImpl</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.type.CustomType</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.util.JDBCExceptionReporter</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>org.apache.fop</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>root</td>
<td>WARN</td>
<td>WARN</td>
</tr>
</tbody>
</table>

Save
To configure the logging levels and other settings on a permanent basis, you need to stop Confluence and then change the settings in the `log4j.properties` file, described above.

The properties file contains a number of entries for different loggers that can be uncommented if you are interested in logging from particular components. Read more in the Apache log4j documentation.

See Working with Confluence Logs for some guidelines on specific configuration options you may find useful.

Configuring Levels for java.util.logging in `logging.properties`

A few libraries used by Confluence use java.util.logging rather than log4j or slf4j. These libraries include:

- com.sun.jersey
- org.apache.shindig
- net.sf.ehcache

Confluence’s `logging.properties` file is set to redirect java.util.logging at specific levels to log4j via slf4j.

To increase logging levels for these libraries you must first configure the `logging.properties` file in `<CONFLUENCE-INSTALL>/confluence/WEB-INF/classes/`. The logging levels are different from log4j and are listed here.

For example, to increase logging for shindig change the following line in the `logging.properties` file:

```
org.apache.shindig.level = INFO
```

to

```
org.apache.shindig.level = FINE
```

And then use one of the methods above as well to configure the log4j level.

Troubleshooting SQL Exceptions

If you get an exception similar to those shown below, it is a good idea to increase the logging levels of your Confluence instance. If you request Atlassian support, this additional logging will help us work out the cause of the error.

Increased logging levels will enable us to diagnose errors like these:

```
org.springframework.dao.DataIntegrityViolationException: (HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
at org.springframework.jdbc.support.SQLStateSQLExceptionTranslator.translate(SQLStateSQLExceptionTranslator.java:88)
caused by: java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
```

or

```
org.springframework.dao.DataIntegrityViolationException: (HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
at org.springframework.jdbc.support.SQLStateSQLExceptionTranslator.translate(SQLStateSQLExceptionTranslator.java:88)
caused by: java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
```
Confluence 4.3 Documentation

(HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: ORA-00001: unique constraint (CONFLUENCE.SYS_C0012345) violated

This document outlines the steps to take to increasing logging on your system.

### Changing the logging levels via the Administration Console

With Confluence 2.7 and later, you can adjust logging levels at runtime via the Administration Console — read the [instructions](#). Below we tell you how to edit the log4j files directly.

1. Open `confluence/WEB-INF/classes/log4j.properties` and uncomment the following lines. The double `##` lines are comments, leave them intact.

   ```properties
   ## log hibernate prepared statements/SQL queries (equivalent to setting 'hibernate.show_sql' to 'true')
   #log4j.logger.net.sf.hibernate.SQL=DEBUG
   ## log hibernate prepared statement parameter values
   #log4j.logger.net.sf.hibernate.type=DEBUG
   ```

   If you can not locate these lines in your log4j.properties file, please add them to the end of it.

2. Restart Confluence.
3. Redo the steps that led to the error.
4. Zip up your logs directory and attach it your support ticket.
5. If you are using Oracle and received a [constraint error](#), please ask your database administrator which table and column the constraint (that is, CONFLUENCE.SYS_C0012345) refers to and add that information to your support ticket.
6. Open `confluence/WEB-INF/classes/log4j.properties` again and remove the 4 lines you added in step 1. (The additional logging will impact performance and should be disabled once you have completed this procedure.)

### RELATED TOPICS

- [Enabling Detailed SQL Logging](#)
- [Working with Confluence Logs](#)
- [Troubleshooting failed XML site backups](#)

### Registering External Gadgets

You can register gadgets from external web sites (such as [JIRA](#), [iGoogle](#) or [Gmail](#)) with your Confluence installation, so that the gadgets appear in the [macro browser](#) and people can add them to Confluence pages via a [gadget macro](#).

Choose one of the following ways to register the external gadgets on Confluence:

- **Subscribe to all of the external application’s gadgets**: You can add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.
- **Register the external gadgets one by one**: If you cannot subscribe to an application’s gadgets, you will need to add the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.
Both methods are described below. First, consider whether you need to set up a trust relationship between Confluence and the other application.

**Setting up a trust relationship with the other application**

In addition to registering the external gadgets, we recommend that you set up an OAuth or Trusted Application relationship between the application that serves the gadget (the service provider) and Confluence (the consumer). The trust relationship is required for gadgets that access restricted data from the external web application.

See how to configure [OAuth](#) or [Trusted Applications Authentication](#), using Application Links.

If the external web application provides anonymous access to all the data you need in the gadgets, then you do not need a trust relationship.

For example, if your gadgets will retrieve data from [JIRA](#) and your JIRA server includes projects and issues that are restricted to logged-in users, then you will need a trust relationship between Confluence and JIRA. If you do not set up the trust relationship, then the gadgets will show only the information that JIRA makes visible to anonymous users.

**Subscribing to all of the application's gadgets**

You can add all the gadgets from your [JIRA](#), [Bamboo](#), [FishEye](#) or [Crucible](#) site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.

**To subscribe to another site’s gadgets:**

1. Choose **Browse** > **Confluence Admin**.
2. Click **External Gadgets** in the left-hand panel.
3. Click the **Gadget Feeds** tab.
4. Enter the base URL of the application you want to subscribe to, in the text box labelled **Gadget Feed URL**. For example, `http://example.com/jira` or `http://example.com/confluence`.
5. Click **Add**. Confluence will convert the URL to a gadget feed and place it in the list of ‘Added Gadget Feeds’.

---

On this page:

- Setting up a trust relationship with the other application
- Subscribing to all of the application's gadgets
- Registering individual gadgets
- Removing access to external gadgets

Related pages:

- Configuring a URL Whitelist for Gadgets
- The big list of Atlassian gadgets
- Adding JIRA Gadgets to a Confluence Page
- Configuring Application Links

⚠️ *The information on this page does not apply to Confluence OnDemand.*

---

**Screenshot 1: Subscribing to a gadget feed**
Registering individual gadgets

If you cannot subscribe to an application's gadgets, you will need to register the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.

First you will need to obtain that gadget's URL and copy it to your clipboard.

Getting a gadget's URL from an Atlassian application

If your web application is another Atlassian application such as Confluence or JIRA:

A gadget's URL points to the gadget's XML specification file. In general, a gadget's URL looks something like this:

```
http://example.com/my-gadget-location/my-gadget.xml
```

If the gadget is supplied by a plugin, the URL will have this format:

http://my-app.my-server.com:port/rest/gadgets/1.0/g/my-plugin.key:my-gadget/my-path/my-gadget.xml

For example:

http://mycompany.com/jira/rest/gadgets/1.0/g/com.atlassian.streams.streams-jira-plugin:activitystream-gadget/gadgets/activitystream-gadget.xml

To find a gadget's URL in JIRA:

- Go to your dashboard by clicking the Dashboards link at the top left of the screen.
- Click Add Gadget to see the list of gadgets in the directory.
- Find the gadget you want, using one or more of the following tools:
  - Use the scroll bar on the right to move up and down the list of gadgets.
  - Select a category in the left-hand panel to display only gadgets in that category.
  - Start typing a key word for your gadget in the Search textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
  - Right-click the Gadget URL link for that gadget and copy the gadget's URL into your clipboard.

To find a gadget's URL in Confluence:

- Choose Browse > Confluence Gadgets to see the list of available Confluence gadgets.
- Find the gadget you want.
- Right-click the Gadget URL link for that gadget and copy the gadget's URL into your clipboard.
Getting a gadget's URL from another application

If the gadget comes from a non-Atlassian web application or web site, please consult the relevant documentation for that application to obtain the gadget's URL.

Registering the gadget for use in Confluence

Now that you have the gadget's URL, you can register it in Confluence, so that people can add it to their pages.

To register the gadget in Confluence:

1. Choose **Browse > Confluence Admin**.
2. Click **External Gadgets** under 'Configuration' in the left panel. The 'External Gadgets' page is displayed.
3. In the 'Add a new Gadget' section, paste your gadget's URL into the **Gadget Specification URL** field.
4. Click **Add**. Your gadget will be shown in the list of registered gadgets below and it will also become available in the [macro browser](#).

Screenshot 2: Registering external gadgets one by one

Removing access to external gadgets

To remove a single gadget from Confluence, click the **Remove** button next to the gadget URL.

If you have subscribed to an application's gadgets, you will need to remove the entire subscription. You cannot unregister a single gadget. Click the **Remove** button next to the gadget feed URL.

The gadget(s) will no longer be available in the macro browser, and people will not be able to add them using the Gadget macro. Any pages that already use the gadget will show a broken gadget link.

Configuring a URL Whitelist for Gadgets

For security reasons, you may wish to limit the URLs from which users can get content that is displayed on your Confluence site, such as the content displayed in a gadget. A whitelist is a list of URLs whose content you wish to make available to users of your site.

**Adding whitelist URLs for external gadgets**
By default, Confluence will block a gadget's access to third-party data sources. When you are using a gadget that draws content from a third-party data source, you will need to add the URL of that data source to the gadget whitelist.

To add a URL to the whitelist for gadgets:

1. Choose **Browse > Confluence Admin**.
2. Click **External Gadgets** in the left-hand panel.
3. Click the **Gadget Whitelist** tab.
4. Enter a URL for the **Host to Whitelist**. For example, http://jira.atlassian.com. You can also enter a URL pattern, as described below.
5. Click **Add**.

---

**On this page:**
- Adding whitelist URLs for external gadgets
- Rules for URL pattern-matching
- Notes

**Related pages:**
- Registering External Gadgets
- Configuring a URL Whitelist for Macros
- Confluence Administrator's Guide

---

**Rules for URL pattern-matching**

Enter one URL or URL pattern per line. You can enter a full URL or use pattern-matching as described below:

- If the rule starts with an equals sign (=), only the exact URL following the '=' will be allowed.
- If the rule starts with a slash (/) then the whole rule will be treated as a regular expression.
- Otherwise, any asterisk (*) will be treated as a wildcard to match one or more characters.

**Notes**

- URLs for which Application Links are configured are automatically whitelisted, so you do not need to add them to this list.

---

The information on this page does not apply to Confluence OnDemand.

---

Screenshot: Configuring a URL whitelist for external gadgets
When a gadget or subscription is removed from your site, the whitelist entry is not automatically removed.

Confluence Data Model

On this page:

- **General Database Diagram**
- **Authentication**
  - Atlassian-user
  - OpenSymphony
- **Content**
- **Clustering**
  - System information
  - Spaces
- **Appearance**
- **Miscellaneous**

The Hibernate mapping files are the authoritative reference. These are the *.hbm.xml files which have been bundled into the main Confluence .jar file in recent releases.

This document is little more than the Confluence schema with added comments, but the priority was placed on making the information available.

General Database Diagram

Authentication

Atlassian-user

This is the "new" authentication system, which is more flexible and extensible than OpenSymphony.

<table>
<thead>
<tr>
<th>Table &quot;groups&quot;</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td></td>
<td></td>
</tr>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>groupname</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:

"groups_pkey" PRIMARY KEY, btree (id)
**local_members**: establishes many-to-many association between users and groups.

```
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>userid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>groupid</td>
<td>bigint</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "local_members_pkey" PRIMARY KEY, btree (groupid, userid)
- "fk6b8fb445117d5fda" FOREIGN KEY (groupid) REFERENCES groups(id)
- "fk6b8fb445ce2b3226" FOREIGN KEY (userid) REFERENCES users(id)
```

**external_entities**: Maps users from LDAP (or any other external authentication system) to IDs in Confluence DB

```
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>name</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "external_entities_pkey" PRIMARY KEY, btree (id)
```

**external_members**: associates LDAP (or other external) users with local groups.
OpenSymphony

The "old" authentication system, which was the default prior to 2.7.

Table "external_members"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>extentityid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>groupid</td>
<td>bigint</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "external_members_pkey" PRIMARY KEY, btree (groupid, extentityid)
- "fkd8c8d8a5117d5fda" FOREIGN KEY (groupid) REFERENCES groups(id)
- "fkd8c8d8a5f25e5d5f" FOREIGN KEY (extentityid) REFERENCES external_entities(id)

Table "os_group"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>groupname</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "os_group_pkey" PRIMARY KEY, btree (id)
- "os_group_groupname_key" UNIQUE, btree (groupname)

Table "os_user"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>passwd</td>
<td>character varying(255)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "os_user_pkey" PRIMARY KEY, btree (id)
- "os_user_username_key" UNIQUE, btree (username)

Table "os_user_group"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>group_id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>user_id</td>
<td>bigint</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "os_user_group_pkey" PRIMARY KEY, btree (user_id, group_id)
- "fk93247246e2e76db" FOREIGN KEY (group_id) REFERENCES os_group(id)
- "fk93247246f73ae0f" FOREIGN KEY (user_id) REFERENCES os_user(id)
Content

The actual information that users are storing and sharing.

attachmentdata: stores the binary data for attached files.
Only used when Confluence is configured to store attachments in the database; otherwise, attachments are stored in the local filesystem.

```
Table "attachmentdata"
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachmentdataid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>attversion</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>data</td>
<td>bytea</td>
<td></td>
</tr>
<tr>
<td>attachmentid</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"attachmentdata_pkey" PRIMARY KEY, btree (attachmentdataid)
"attch_data_idx" btree (attachmentid)

Foreign-key constraints:
"fk9dc3e34d34a4917e" FOREIGN KEY (attachmentid) REFERENCES attachments(attachmentid)
```

attachments: metadata for attachments.

```
Table "attachments"
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachmentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>filesize</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>attachment_comment</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>attversion</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"attachments_pkey" PRIMARY KEY, btree (attachmentid)
"att_pageid_idx" btree (pageid)
"att_prevver_idx" btree (prevver)

Foreign-key constraints:
"fk54475f9017d4a070" FOREIGN KEY (prevver) REFERENCES attachments(attachmentid)
"fk54475f908c38fbea" FOREIGN KEY (pageid) REFERENCES content(contentid)
```

bodycontent: stores the actual content of Confluence pages. No versioning information or other metadata is stored here, though; that's all in the content table.
Table "bodycontent"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>bodycontentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>body</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

"bodycontent_pkey" PRIMARY KEY, btree (bodycontentid)
"body_content_idx" btree (contentid)

Foreign-key constraints:

"fka898d4778dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

content: a persistence table for the ContentEntityObject class of objects. The subclass is indicated by the contenttype column.
### Table "content"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>version</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>versioncomment</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>content_status</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>parentid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>messageid</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftpageid</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftspacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>drafttype</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftpageversion</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>parentcommentid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

- "content_pkey" PRIMARY KEY, btree (contentid)
- "c_draftpageid_idx" btree (draftpageid)
- "c_draftspacekey_idx" btree (draftspacekey)
- "c_drafttype_idx" btree (drafttype)
- "c_messageid_idx" btree (messageid)
- "c_parentcommid_idx" btree (parentcommentid)
- "c_parentid_idx" btree (parentid)
- "c_prevver_idx" btree (prevver)
- "c_spaceid_idx" btree (spaceid)
- "c_title_idx" btree (title)
- "c_username_idx" btree (username)

Foreign-key constraints:

- "fk6382c05917d4a070" FOREIGN KEY (prevver) REFERENCES content(contentid)
- "fk6382c05974b18345" FOREIGN KEY (parentid) REFERENCES content(contentid)
- "fk6382c0598c38fbea" FOREIGN KEY (pageid) REFERENCES content(contentid)
- "fk6382c059b2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)
- "fk6382c059b97e9230" FOREIGN KEY (parentcommentid) REFERENCES content(contentid)

content_label: Arbitrary text labels for content.
Table "content_label"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>labelid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>owner</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "content_label_pkey" PRIMARY KEY, btree (id)
- "cl_contentid_idx" btree (contentid)
- "cl_labelid_idx" btree (labelid)
- "cl_lastmoddate_idx" btree (lastmoddate)
- "cl_spacekey_idx" btree (spacekey)

Foreign-key constraints:
- "fkf0e7436e27072aef" FOREIGN KEY (labelid) REFERENCES label(labelid)
- "fkf0e7436e8dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

**label**: the other half of the content_label system.

Table "label"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>labelid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>name</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>owner</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>namespace</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "label_pkey" PRIMARY KEY, btree (labelid)
- "l_name_idx" btree (name)
- "l_namespace_idx" btree (namespace)
- "l_owner_idx" btree ("owner")

**content_perm**: content-level permissions objects.
Table "content_perm"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>cp_type</td>
<td>character varying(10)</td>
<td>not null</td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>groupname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>cps_id</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "content_perm_pkey" PRIMARY KEY, btree (id)
- "cp_gn_idx" btree (groupname)
- "cp_os_idx" btree (cps_id)
- "cp_un_idx" btree (username)

Foreign-key constraints:
- "fkbd74b31676a33274" FOREIGN KEY (cps_id) REFERENCES content_perm_set(id)

content_perm_set: one-to-many mapping for content items and their permissions, with added metadata.

Table "content_perm_set"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>cont_perm_type</td>
<td>character varying(10)</td>
<td>not null</td>
</tr>
<tr>
<td>content_id</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "content_perm_set_pkey" PRIMARY KEY, btree (id)
- "cps_content_idx" btree (content_id)

Foreign-key constraints:
- "fkb45a7992ca22c1" FOREIGN KEY (content_id) REFERENCES content(contentid)

Clustering

clustersafety: normally, this table only contains one row. The value of the safetynumber is what Confluence uses to find out whether another instance is sharing its database without being part of the cluster.
Table "clustersafety"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>clustersafetyid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>safetynumber</td>
<td>integer</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"clustersafety_pkey" PRIMARY KEY, btree (clustersafetyid)

System information

`confversion` used by the upgrade system to determine what to expect from the database, so as to negotiate upgrades.

Table "confversion"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>confversionid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>buildnumber</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>installdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>versiontag</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"confversion_pkey" PRIMARY KEY, btree (confversionid)
"confversion_buildnumber_key" UNIQUE, btree (buildnumber)

`plugindata`: records which plugins have been installed, and when.

`data` is a blob of the actual plugin .jar file. This is principally cluster-related.

Table "plugindata"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>plugindataid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>pluginkey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>filename</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>data</td>
<td>bytea</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"plugindata_pkey" PRIMARY KEY, btree (plugindataid)
"plugindata_filename_key" UNIQUE, btree (filename)
"plugindata_pluginkey_key" UNIQUE, btree (pluginkey)

Spaces

`spacegroups`: this table is only used by the hosted environment.
Table "spacegroups"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>spacegroupid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacegroupname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spacegroupkey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>licensekey</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "spacegroups_pkey" PRIMARY KEY, btree (spacegroupid)
- "spacegroups_spacegroupkey_key" UNIQUE, btree (spacegroupkey)

Table "spacepermissions"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>permid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>permtype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>permgroupname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>permusername</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "spacepermissions_pkey" PRIMARY KEY, btree (permid)
- "sp_permtype_idx" btree (permtype)
- "sp_pgroupname_idx" btree (permgroupname)
- "sp_puname_idx" btree (permusername)
- "sp_spaceid_idx" btree (spaceid)

Foreign-key constraints:
- "fkd33f23beb2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)

spaces: information about the spaces themselves: key, human-friendly name and numeric ID.
### Table "spaces"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacename</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>spacedescid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>homepage</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>spacetype</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spacegroupid</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "spaces_pkey" PRIMARY KEY, btree (spaceid)
- "spaces_spacekey_key" UNIQUE, btree (spacekey)
- "s_homepage_idx" btree (homepage)
- "s_spacedescid_idx" btree (spacedescid)
- "s_spacegroupid_idx" btree (spacegroupid)

Foreign-key constraints:
- "fk9228242d11b7bfee" FOREIGN KEY (homepage) REFERENCES content(contentid)
- "fk9228242d16994414" FOREIGN KEY (spacegroupid) REFERENCES spacegroups(spacegroupid)
- "fk9228242d2c72d3d2" FOREIGN KEY (spacedescid) REFERENCES content(contentid)

### Appearance

**decorator:** storage of custom display templates, for customising layouts.

### Table "decorator"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>decoratorid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>decoratorname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>body</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "decorator_pkey" PRIMARY KEY, btree (decoratorid)
- "dec_key_idx" btree (spacekey)
- "dec_name_idx" btree (decoratorname)

### Miscellaneous

**os_propertyentry:** for arbitrary association of entities and properties.
Table "os_propertyentry"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>entity_name</td>
<td>character varying(125)</td>
<td>not null</td>
</tr>
<tr>
<td>entity_id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>entity_key</td>
<td>character varying(200)</td>
<td>not null</td>
</tr>
<tr>
<td>key_type</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>boolean_val</td>
<td>boolean</td>
<td></td>
</tr>
<tr>
<td>double_val</td>
<td>double precision</td>
<td></td>
</tr>
<tr>
<td>string_val</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>text_val</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>long_val</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>int_val</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>date_val</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"os_propertyentry_pkey" PRIMARY KEY, btree (entity_name, entity_id, entity_key)

**bandana**: A catch-all persistence layer. It contains things like user settings and space- and global-level configuration data, and is used as storage by plugins such as the Dynamic Task List plugin. Essentially, for storing arbitrary data that doesn't fit anywhere else.

Table "bandana"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>bandanaid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>bandanacontext</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>bandanakey</td>
<td>character varying(100)</td>
<td></td>
</tr>
<tr>
<td>bandanavalue</td>
<td>text</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"bandana_pkey" PRIMARY KEY, btree (bandanaid)
"band_context_idx" btree (bandanacontext)
"band_key_idx" btree (bandanakey)

**extrnlnks**: Storage of referral links.
Table "extrnlnks"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>viewcount</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>url</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "extrnlnks_pkey" PRIMARY KEY, btree (linkid)
- "el_contentid_idx" btree (contentid)

Foreign-key constraints:
- "fk97c10fe78dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

hibernate_unique_key: used by the high/low ID generator - the subsystem which generates our primary keys.
Mess with this at the cost of being able to create objects.

Table "hibernate_unique_key"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>next_hi</td>
<td>integer</td>
<td></td>
</tr>
</tbody>
</table>

indexqueueentries: arbitrates full-content indexing across the system.
This table generally contains the last 12 hours or so of updates, to allow re-syncing of cluster nodes after restarts.

Table "indexqueueentries"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>entryid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>handle</td>
<td>character varying(255)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "indexqueueentries_pkey" PRIMARY KEY, btree (entryid)

keystore: used by the trusted apps framework to store the server's private key, and other servers' public keys.
Table "keystore"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>alias</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>type</td>
<td>character varying(32)</td>
<td>not null</td>
</tr>
<tr>
<td>algorithm</td>
<td>character varying(32)</td>
<td>not null</td>
</tr>
<tr>
<td>keyspec</td>
<td>text</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "keystore_pkey" PRIMARY KEY, btree (keyid)

links: tracks links within the server (i.e. across and within spaces).

Table "links"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>destpagetitle</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>destspacekey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "links_pkey" PRIMARY KEY, btree (linkid)
- "l_contentid_idx" btree (contentid)
- "l_destspacekey_idx" btree (destspacekey)

Foreign-key constraints:
- "fk45157998dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

notifications: storage of page- and space-level watches.
Table "notifications"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>notificationid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"notifications_pkey" PRIMARY KEY, btree (notificationid)
"n_pageid_idx" btree (pageid)
"n_spaceid_idx" btree (spaceid)

Foreign-key constraints:
"fk594acc88c38fbea" FOREIGN KEY (pageid) REFERENCES content(contentid)
"fk594acc8b2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)

Table "pagetemplates"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>templateid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>templatename</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>templatedesc</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>labels</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>content</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>version</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"pagetemplates_pkey" PRIMARY KEY, btree (templateid)
"pt_prevver_idx" btree (prevver)
"pt_spaceid_idx" btree (spaceid)

Foreign-key constraints:
"fkbc7ce96a17d4a070" FOREIGN KEY (prevver) REFERENCES pagetemplates(templateid)
"fkbc7ce96ab2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)

pagetemplates: acts as the back-end of the templates feature.
Table "trackbacklinks"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>viewcount</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>url</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>blogname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>excerpt</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "trackbacklinks_pkey" PRIMARY KEY, btree (linkid)
- "tbl_contentid_idx" btree (contentid)

Foreign-key constraints:
- "fkf6977a478dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

Table "confancestors"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>descendentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>ancestorid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>ancestorposition</td>
<td>integer</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "confancestors_pkey" PRIMARY KEY, btree (descendentid, ancestorposition)

Foreign-key constraints:
- "fk9494e23cc37e35a2e" FOREIGN KEY (ancestorid) REFERENCES content(contentid)
- "fk9494e23cc45e94dc" FOREIGN KEY (descendentid) REFERENCES content(contentid)

Confluence Clustering Overview

It is possible to run Confluence in a clustered environment instead of on a single server. This means that you can run multiple copies of Confluence in a cluster, so that clients (such as a browser) can connect to any copy and see the same information.

⚠️ Consider your options carefully before deciding on a clustered installation

While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change and requires extra planning for deployment and upgrades. Please consider the information on the Cluster Checklist and then consult Atlassian support before making your final decision.
This page gives an overview and links to further pages with information on installing, configuring and administering a Confluence cluster.

⚠️ The information on this page does not apply to Confluence OnDemand.

Before Deciding to Run a Confluence Cluster

1. Read and consider the details on the Cluster Checklist.
2. Consider the difference between clustering for scalability and clustering for high availability (HA).
3. Contact Atlassian support for further information and advice.

Technical Overview

Confluence on Virtualised Environments

Atlassian officially supports non-clustered installations of Confluence 3.0 and later on VMware. Although possible, we do not recommend (nor support) running versions of Confluence prior to 3.0 on VMware, since Confluence 3.0 resolved many performance issues that were present in earlier versions. Be aware that we also do not support clustered installations of Confluence on VMware. Please comment or vote on the feature request at CONF-19559.

Read a technical overview of clustering in Confluence.

Server and Network Requirements

- Server hardware requirements
- Technical overview of Confluence clustering
- Diagram of recommended network topology

Installation and Upgrading

There are two methods of installing Confluence in a cluster, depending on whether you have existing data:

- Fresh installation
- Existing data

If you are upgrading an existing Confluence cluster to a new version of Confluence, refer to the cluster upgrade guide.

Configuration and Administration

- Cluster Administration page in the Administration Console
- Changing datasources in clusters

Troubleshooting

- Cluster troubleshooting

RELATED TOPICS

- Operating Large or Mission-Critical Confluence Installations
- Performance Tuning
- Requesting Performance Support
- Confluence Administrator's Guide
- Configuring Confluence
Technical Overview of Clustering in Confluence

Overview of clustering documentation
Refer to the overview of Confluence clustering in the Administrators’ Guide.

The information on this page does not apply to Confluence OnDemand.

Introduction

From version 2.3, Confluence has had the ability to configure and run multiple copies of itself in a cluster, so that clients can connect to any copy and see the same information. In effect, a Confluence cluster behaves as a single, powerful Confluence installation. While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change from earlier versions (or non-clustered installations) and consequently, requires extra planning for deployment and upgrades.

This document will give a technical overview of clustering in Confluence, primarily for those users and developers who will be installing and configuring Confluence in a cluster. A separate overview is available for Confluence plugin developers.

Cluster topology

A simple description of the cluster topology for Confluence would be multiple applications, shared data source. A cluster of Confluence consists of:

- multiple homogeneous installations of Confluence (called nodes below)
  - a Confluence home directory for each installation.
- a distributed Oracle Coherence cache (formerly known as Tangosol Coherence), which all nodes use via a multicast group - see network summary below
- a single database, which all nodes connect to

The user is responsible for configuring an appropriate HTTP load balancer in front of the clustered installations. Typically this means using mod_jk or another application server load-balancing technology. The load balancer must be configured to support session affinity.

Communication between clustered nodes is minimised by using a distributed cache which propagates updates to all other nodes automatically. Where necessary, Coherence provides a locking mechanism for synchronising jobs and a RMI interface for more complex communication.

LAN Clustering Only
Atlassian only supports clustering over a local area network. While it is theoretically possible to configure Confluence to cluster across a WAN, the latency involved is likely to kill performance of the cluster. We can’t stop you trying, of course, but you’re going to have to work out how to configure Coherence yourself, and we’re not going to support the resulting mess.

**Homogeneous Confluence installations**

All the Confluence installations must be running exactly the same application, down to the lowest level. Items that must be the same include:

- Confluence version
- Application server version
- JDK version
- Libraries and plugins in the Confluence classpath, WEB-INF/lib
- Libraries in the application server classpath

The installation section has more information how to ensure homogeneous node installations.

**Creating a Confluence cluster**

When installing Confluence in a clustered setup, you will be responsible for configuring your web server and load balancer to distribute traffic between each node. No additional software is required as Coherence is bundled with Confluence.

Here is an overview of the process:

1. Obtain a clustered licence key from Atlassian for each node
2. Upgrade a single node to the clustered licence
3. Start the cluster from that node’s administration menu, specifying a name and optionally a preferred network interface
4. Restart the single node and test it
5. Copy the Confluence application and Confluence home directory to the second node
6. Bring up the second node and it will automatically join the cluster.

Copying the Confluence application and home directory helps ensure that the installations are homogeneous.

An alternative to this method is to copy the Confluence web application, but not the Confluence home directory. In this case, the installation wizard will require your cluster name to connect to the other nodes, and it will automatically configure itself. You will need to rebuild the index manually after this installation, however.

There is now full documentation for a Confluence Cluster Installation.

**Upgrade process**

Another consequence of the homogeneous requirement is that upgrades must be done by following a strict process.

1. All cluster nodes are brought down
2. Upgrade a single node to the latest Confluence version
3. Start the single node so it can upgrade the database
4. Upgrade subsequent nodes and start them one-by-one.

This is the only safe method of upgrading a Confluence cluster.

**Single database**

The Confluence database in a cluster is shared by all nodes. This means that the database must be able to scale to service all the Confluence nodes, which will probably mean implementing some kind of database cluster and JDBC-level load balancing. We can not offer support with scaling or tuning your database, you will need to talk to your DBA or database vendor.
For obvious reasons, you must have an external database to run Massive - you can not cluster Confluence when using the embedded HSQL database.

The most important requirement for the cluster database is that it have sufficient connections available to support the expected number of application nodes. For example, if each Confluence instance has a connection pool of 20 connections and you expect to run a cluster with four nodes, your database server must allow at least 80 connections to the Confluence database. In practice, you may require more than the minimum for debugging or administrative purposes.

In a cluster, attachments must be stored in the database. Configuring a cluster in an existing installation will automatically migrate your attachments to the database. Non-clustered installations still have the option of using the Confluence home directory for storing attachments.

While attachments are stored in the database, they are temporarily written to the cluster node's local filesystem, designated `<confluence-home>/temp` folder, when being streamed to users (so Confluence doesn't have to hold open database connections unnecessarily). For this reason, Confluence will still need enough temporary disk space to hold any attachments currently in transit.

**Distributed cache**

In a normal configuration, Confluence uses many caches to reduce the number of database queries required for common operations. Viewing a page might require dozens of permissions checks, and it would be very slow if Confluence queried the database for this information with every page view. However, caches must be carefully maintained so they are consistent with the application data. If the page permissions change, the old invalid data needs to be removed from the cache so it can be replaced with a fresh correct copy.

To preserve consistent caches across a cluster, Confluence uses a distributed cache called Oracle Coherence, which manages replicating cache updates transparently across all nodes. The network requirements of the distributed cache are quite simple, but must be preserved if the cluster is to work properly.

To discover other nodes in the cluster, Confluence broadcasts a join request on a multicast network address. Confluence must be able to open a UDP port on this multicast address, or it will not be able to find the other cluster nodes.

Once the nodes are discovered, each responds with a unicast (normal) IP address and port where it can be contacted for cache updates. Confluence must be able to open a UDP port for regular communication with the other nodes.

Because the Coherence network requirements are different to those required by the Confluence database connection, the situation can arise where Confluence can use the database but not talk to the other nodes in the cluster via Coherence. When Confluence detects this, it will shut itself down in a cluster panic.

For more details on the network configuration of the distributed cache, see the [networking summary](#).

**Home directory**

Confluence’s home directory has a much-reduced role in a cluster. Because the application data must be shared between all nodes for consistency, the only information stored in the Confluence home directory is either node-specific, or needed to start Confluence. This includes information related to:

- database connection
- license
- cluster connection

The only application data stored in the Confluence home directory is the Lucene search index. Confluence synchronises this data itself by keeping track of indexing tasks in the database.

This is also why we recommend copying the Confluence home directory from the first node when setting up subsequent nodes. If you did not copy the Confluence home directory, you would need to rebuild the search
index from scratch on the subsequent nodes after installation.

**Event handling**

Broadcasting events to all nodes in a cluster is supported in Confluence, but not recommended. The cluster topology uses a shared data store so that application state does not need to be synchronised by events.

The event broadcasting is done only for certain events, like installing a plugin. When a plugin is installed in one node, Confluence puts the plugin data in the database, and notifies the other nodes that they need to load the plugin into memory.

**Indexing**

Confluence maintains a copy of its Lucene search index on each node of the cluster. This index is used for many things beside full-text searches, including RSS feeds and lists of recently updated content. Indexing in a cluster works like this:

1. Node 1 gets a request to save some page update
2. After saving the page in the database, Node 1 adds a "page-updated" index entry to the queue, which is in the database
3. Periodically, each node picks up the "latest entries" from the queue, where what is latest is determined from a timestamp on a file in the Confluence home directory which indicates when the queue was last inspected. This process is called "flushing the index queue".
4. Each node independently updates its local Lucene index. The "page-updated" index entry is internally changed into a delete-document task and an add-document task to apply the changes to Lucene.
5. Each node updates the timestamp on its index-queue-timestamp file to reflect the most recent processing or "flushing" of the index queue.

Because of step #3, if the timing of the nodes is not synchronised or changes sporadically (due to a virtualisation environment, typically), index changes will not be correctly synchronised in the cluster. This is the most common cause of index sync problems in clusters.

If a node is disconnected from the cluster for a short amount of time (less than three hours), it will be able to bring its copy of the index up-to-date when it rejoins the cluster. If a node is down for a long amount of time and its lucene index has become stale as a result, you may want to avoid the expensive operation of rebuilding the index. To do that, you must copy a "live" version of the Lucene index from an active node. Simply replace the contents of the Confluence Home]/index directory with those from an active node before bringing the stale node back up.

**Job synchronisation**

For tasks such as sending the daily report emails, it is important that only one node in the cluster does this. Otherwise you would get multiple emails from Confluence every day.

Confluence uses locks in the Coherence distributed cache to ensure only one node can be running certain jobs at a time. This ensures email notifications will only be sent once.

**Activity tracking**

*Activity tracking* does not work in a cluster, and will be disabled for clustered deployments. We're working on making the activity tracker clusterable in a future release. You can follow [this issue](https://confluence.atlassian.com/display/CONFLUENCE/Activity+tracking). You can try some [other options](https://confluence.atlassian.com/display/CONFLUENCE/Other+options) for tracking usage.

**Cluster panic**

In some situations, there can be a network issue or firewall that prevents the distributed cache from communicating but still allows Confluence to update the database. This is a dangerous situation because when the caches on the detached nodes become inconsistent, users on different nodes will see different information and updates can be lost.
Confluence can detect this problem by checking a database value against a cached value, and if they differ, all the clustered nodes will be shut down with a 'Cluster panic' message. This is considered a fatal error because the consequences can cause damage to your data. For those administrators that like to live on the edge, there is a system property to prevent cluster panic and allow data corruption. For more information, see Cluster safety mechanism.

If a cluster panic does occur, you need to ensure proper network connectivity between the clustered nodes. Most likely multicast traffic is being blocked or not routed correctly. See the networking summary below.

**Summary of network requirements**

In addition to normal connectivity with its database, all clustered Confluence instances require access to a multicast group and the ability to open a UDP unicast port.

By default, the multicast address is automatically generated from the cluster name you provide when starting the cluster and the multicast port is fixed. During cluster setup, Confluence will prompt for the unicast IP address to use if the server has multiple network interfaces, and by default the unicast port is fixed. The cluster multicast group will be joined on the same network interface as the bound unicast IP address.

For any settings which are not configurable through the Confluence web interface, they can be configured via an XML file in the Confluence home directory for more exotic networking requirements.

**Scaling Confluence On A Single Server**

Since the maximum addressable memory on a 32 bit JVM is 4GB, some large servers may scale Java applications by running JVM instances concurrently. This would be implemented as separate, clustered Confluence nodes running on a single server and communicating internally. Because each JVM replicates the cache entirely, it may be useful to test a single, massive instance running a 64 bit JVM as an alternative. This configuration may result in superior performance than an internal cluster.

**Geographically Distributed Clusters**

Collocating nodes is strongly recommended as high latency will almost certainly degrade performance due to the overhead of cache replication. Cluster nodes will provide the best performance if servers are physically adjacent. However, as long as all nodes share a LAN, users may wish to test alternative configurations to see how performance is affected.

**RELATED TOPICS**

- Server Hardware Requirements Guide
- Overview of Confluence Clusters
- Developers' Guide to Clustering

**Cluster safety mechanism**

**Introduction**

A mechanism was added in Confluence 2.3 and above to ensure database consistency when running multiple cluster nodes against the same database. This is called the cluster safety mechanism, and is designed to ensure that your wiki cannot become inconsistent because updates by one user are not visible to another. A failure of this mechanism is a fatal error in Confluence and is called cluster panic.

Because the cluster safety mechanism helps prevents data inconsistency whenever any two copies of Confluence running against the same database, it is enabled in _all_ instances of Confluence, not just clusters.

*The information on this page does not apply to Confluence OnDemand.*
How cluster safety works

A scheduled task, ClusterSafetyJob, runs every 30 seconds in Confluence. In a cluster, this job is run only on one of the nodes. The scheduled task operates on a safety number – a randomly generated number that is stored both in the database and in the distributed cache used across a cluster. It does the following:

1. **Generate** a new random number
2. **Compare the existing safety numbers**, if there is already a safety number in both the database and the cache.
3. **If the numbers differ, publish a ClusterPanicEvent.** Currently in Confluence, this causes the following to happen:
   - disable all access to the application
   - disable all scheduled tasks
   - update the database safety number to a new value, which will cause all nodes accessing the database to fail.
4. If the numbers are the same or aren’t set yet, **update the safety numbers**:
   - set the safety number in the database to the new random number
   - set the safety number in the cache to the new random number.

How to fix it

See ['Database is being updated by an instance which is not part of the current cluster' Error Message](#)

Technical details

The cluster safety number in the database is stored in the CLUSTERSAFETY table. This table has just one row: the current safety number.

**Changing Datasources Manually in a Cluster**

The recommended way of changing database connections is to shut down the whole cluster, install Confluence into new and empty directories and use the Setup Wizard to configure all new database connection settings.

However, if you wish to manually change your settings, you may proceed as described below.

⚠️ It is **strongly recommended** that you test all of the following in a staging or test instance of Confluence before performing these steps in your production environment.

⚠️ The information on this page **does not apply** to Confluence OnDemand.

**Step 1: Prepare**

- Locate the confluence-cfg.xml file in the Confluence home directory.
- Make a backup copy of that file.
- Prepare the necessary changes to that file.

**Step 2: Shut Down Confluence**

You need to shut down all the nodes in the cluster, not just one.

**Step 3: Apply your Changes**

Apply your configuration changes to the required node.

**Step 4: Restart the Changed Node**

It is crucial that you bring up the node on which you applied the changes **first**. Otherwise you will get an error
message, and have to shut down all instances again.

**Step 5: Restart all Other Nodes**

Done.

**RELATED PAGES**

Overview of Confluence Clusters

Cluster Troubleshooting

Confluence on Virtualised Environments

Atlassian officially supports non-clustered installations of Confluence 3.0 and later on VMware. Although possible, we do not recommend (nor support) running versions of Confluence prior to 3.0 on VMware, since Confluence 3.0 resolved many performance issues that were present in earlier versions. Be aware that we also do not support clustered installations of Confluence on VMware. Please comment or vote on the feature request at CONF-19559.

Overview of clustering documentation

Refer to the overview of Confluence clustering.

This page covers troubleshooting for the Clustered Edition. If you're experiencing Cluster Panic messages in a Standard Edition, visit the Knowledge Base article 'Database is being updated by an instance which is not part of the current cluster' Error Message.

On this page:

- Symptoms
- Confluence cluster debugging tools
- Didn't find a solution?
- Related

The information on this page does not apply to Confluence OnDemand.

### Symptoms

Below is a list of potential problems with a Confluence cluster, and their likely solutions. The solutions are listed below.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Likely solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database is being updated by an instance which is not part of the current cluster errors on a stand-alone</td>
<td>'Database is being updated by an instance which is not part of the current cluster' Error Message</td>
</tr>
</tbody>
</table>
Confluence 4.3 Documentation

| Database is being updated by an instance which is not part of the current cluster | Add multicast route, Check firewall |
| Cannot assign requested address on startup, featuring an IPv6 address | Prefer IPv4 |
| Error in log: The interface is not suitable for multicast communication | Change multicast interface, Add multicast route |
| Multicast being sent, but not received (detectable with Multicast Test) | Check firewall, Check intermediate routers, Increase multicast TTL |
| Any issue not covered here | Contact support |

Confluence cluster debugging tools

There is an umbrella issue opened for all cluster debugging tools [here](#).

It includes the tools listed below.

**Multicast**

- Which multicast address?

The multicast address and port used by Confluence can be found on the [Cluster Administration page](#) or in `confluence.cfg.xml` in the Confluence home directory.

- Multicast address generation.

Confluence uses a hashing algorithm to take the inputted name during setup and it is then turned into a multicast address stored in the config file. Thus, once the initial setup is completed, Confluence will use the address this is the reason why user can change the address if needed, without actually changing the name. Consequently the additional nodes using the same multicast address specified in the config file are able to join the cluster.

Each node has a multicast address configured in the `confluence-cfg.xml` file:

```xml
name="confluence.cluster.address">xxx.xx.x.x</property>
```

A warning message is displayed when an user changes the address from the one that Confluence has generated by the hashing of the name. There is no way of eliminating the message any other way other than by returning the address to the one that matches the cluster name. Purpose of the warning message is to remind the user that the address has been changed - as it is not the hashed version any longer - consequently the node can not join the cluster just by using the name. It is also necessary to provide the correct address as well.

**Mapping interface to IP address.**

To ensure that the interface name is mapped correctly, the following tool can be used. It shows the mapping of the interface name to the IP address.
C:\>java -jar list-interfaces.jar
interfaces.size() = 4
networkInterface[0] = name:lo (MS TCP Loopback interface) index: 1
 addresses:
 /127.0.0.1;

networkInterface[1] = name:eth0 (VMware Virtual Ethernet Adapter for VMnet8) index: 2 addresses:
 /192.168.133.1;

networkInterface[2] = name:eth1 (VMware Virtual Ethernet Adapter for VMnet1) index: 3 addresses:
 /192.168.68.1;

networkInterface[3] = name:eth2 (Broadcom NetXtreme 57xx Gigabit Controller - Packet Scheduler Miniport) index: 4 addresses:
 /192.168.0.101;

**Debugging tools**

Listed below are some debugging tools that help determine what the status of the multicast traffic is:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Information provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>netstat -gn</td>
<td>Lists multicast groups. Does not work on Mac OS X.</td>
</tr>
<tr>
<td>netstat -rn</td>
<td>Lists system routing table.</td>
</tr>
<tr>
<td><strong>Multicast Test</strong></td>
<td>Coherence tool for testing multicast traffic from one node to another.</td>
</tr>
<tr>
<td>tcpdump -i interface</td>
<td>Captures network traffic on the given interface. Most useful on an interface that only receives cluster traffic.</td>
</tr>
</tbody>
</table>

**Add multicast route**

Multicast networking requirements vary across operating systems. Some operating systems require little configuration, while some require the multicast address to be explicitly added to a network interface before Confluence can use it.

If the **Multicast Test** tool shows that multicast traffic can't be sent or received correctly, adding a route for multicast traffic on the correct interface will often fix the problem. The example below is for a Ubuntu Linux system:

```
rout add -net 224.0.0.0 netmask 240.0.0.0 dev eth0
```

To support multiple applications using multicast on different interfaces, you may need to specify a route specific to the **Confluence multicast address**.
Check firewall

Ensure your firewall allows UDP traffic on the multicast address and port used by Confluence.

Prefer IPv4

⚠️ There's a known issue with IPv6, especially on Linux.

The fix is to add -Djava.net.preferIPv4Stack=true to JAVA_OPTS. This tells the JVM to try binding an IPv4 address first, and resort to IPv6 only if that fails.
Note: A more radical approach is to add NETWORKING_IPV6=no to /etc/sysconfig/network, yet probably should be left for a later consideration on a production machine.

Change multicast interface

Confluence might have selected the incorrect interface for multicast traffic, which means it cannot connect to other nodes in the cluster. To override the interface used for multicast traffic after initial setup, edit confluence.cfg.xml in the Confluence home directory and add a property (or change the existing one) to select your desired network interface. For example to tell Confluence to use eth1:

```xml
<property name="confluence.cluster.interface">eth1</property>
```

Increase multicast TTL

The multicast time-to-live (TTL) specifies how many hops a multicast packet should be allowed to travel before it is discarded by a router. It should be set to the number of routers in between your clustered nodes: 0 if both are on the same machine, 1 if on two different machines linked by a switch or cable, 2 if on two different machines with one intermediate router, and so on.

Create a file in the Confluence home directory called tangosol-coherence-override.xml. Add the following to it, setting the TTL value appropriately (1 is the default):

```xml
<?xml version='1.0'?><coherence><cluster-config><multicast-listener><time-to-live system-property='tangosol.coherence.ttl'>1</time-to-live></multicast-listener></cluster-config></coherence>
```

Alternatively, simply start Confluence with the system property: -Dtangosol.coherence.ttl=1. Again, 1 is the default value, and you should change it to something appropriate to your network topology.

Check intermediate routers

Advanced switches and routers have the ability to understand multicast traffic, and route it appropriately. Unfortunately sometimes this functionality doesn't work correctly with the multicast management information (IGMP) published by the operating system running Confluence.

If multicast traffic is problematic, try disabling advanced multicast features on switches and routers in between the clustered nodes. These features can prevent multicast traffic being transmitted by certain operating systems.

For best results, use the simplest network topology possible for the cluster traffic between the nodes. For two
nodes, that means a single network cable. For larger numbers, try using a single high-quality switch.

**Advanced Tangosol configuration**

If the solution to your problem involves changes to the Tangosol configuration, these changes should **not** be made to the Confluence configuration in `confluence WEB-INF classes/`. Instead, to ensure your configuration survives upgrades, make your changes via:

- Tangosol system properties
- creating a `tangosol-coherence-override.xml` file in the Confluence home directory.

Examples of making these changes are shown in the increasing the TTL section.

**Didn’t find a solution?**

*Check Related Articles from the Confluence Knowledge Base*

No content found for label(s) cluster.

**Open JIRA Features and Bug Reports**

<table>
<thead>
<tr>
<th>JIRA Issues (50 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>Conf</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>CONF-14120</td>
</tr>
<tr>
<td>CONF-9297</td>
</tr>
<tr>
<td>CONF-8959</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>CONF-2</td>
</tr>
<tr>
<td>CONF-1</td>
</tr>
<tr>
<td>CONF-1</td>
</tr>
<tr>
<td>CONF-1</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>CONF-15523</td>
</tr>
<tr>
<td>CONF-9324</td>
</tr>
<tr>
<td>CONF-25211</td>
</tr>
<tr>
<td>CONF-12345</td>
</tr>
<tr>
<td>CONF-9813</td>
</tr>
<tr>
<td>CONF-10325</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>CONF-9 594</td>
</tr>
<tr>
<td>CONF-1 0868</td>
</tr>
<tr>
<td>CONF-9 040</td>
</tr>
<tr>
<td>CONF-1 4657</td>
</tr>
<tr>
<td>Ticket</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>CONF-2352</td>
</tr>
<tr>
<td>CONF-335</td>
</tr>
<tr>
<td>CONF-10980</td>
</tr>
<tr>
<td>CONF-2486</td>
</tr>
<tr>
<td>CONF-20500</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>CONF-10323</td>
</tr>
<tr>
<td>CONF-22979</td>
</tr>
<tr>
<td>CONF-10977</td>
</tr>
<tr>
<td>CONF-13870</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>CONF-9749</td>
</tr>
<tr>
<td>CONF-1206</td>
</tr>
<tr>
<td>CONF-17577</td>
</tr>
<tr>
<td>CONF-17040</td>
</tr>
<tr>
<td>Conf</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>CONF-1</td>
</tr>
<tr>
<td>CONF-1</td>
</tr>
<tr>
<td>CONF-2</td>
</tr>
<tr>
<td>CONF-9 281</td>
</tr>
<tr>
<td>CONF-1 9559</td>
</tr>
<tr>
<td>CONF-1 4088</td>
</tr>
</tbody>
</table>
Multicast Test

This page describes the Multicast Test, a Coherence tool for testing multicast traffic from one node to another. You may find this useful when troubleshooting a clustered installation of Confluence.

In order to run the Multicast test, you need to the Coherence file from Oracle. You will need to sign up for a free Oracle account and sign the license agreement, before downloading the file. The Multicast Test comes as a script called multicast-test, which you will find located in the bin folder in the above zip file.

Instructions on how to run this script file can be found in the Coherence documentation. You may like to go straight to the subheading called 'Example' in the guide, where there is an example on how to use the multicast-test script.

The Multicast Test will use the multicast address of 237.0.0.1:9000 by default. Confluence creates a unique address based on the cluster name that you enter during setup. As such, you should include the -group flag in your multicast testing to ensure your tests are broadcasting across the same address as your Confluence nodes.

The information on this page does not apply to Confluence OnDemand.

RELATED TOPICS

Cluster Troubleshooting
Confluence Clustering Overview

Clustering for Scalability vs Clustering for High Availability (HA)

People occasionally enquire about setting up High-Availability (HA) Confluence clusters. Confluence's clustering is designed to solve a different problem, that of scaling under high load. This page explains the difference.

What is High Availability (HA)?

HA means that your application will be available, without interruption. It's a very difficult thing to achieve, and is typically what people are talking about when they refer to five-nines availability.

In the context of application clustering, it means that any given node (or combination of nodes) can be shut down, blown up, or simply disconnected from the network unexpectedly, and the rest of the cluster will continue operating cleanly as long as at least one node remains. It requires that nodes can be upgraded individually while the rest of the cluster operates, and that no disruption will result when a node rejoins the cluster. It typically also requires that nodes be installed in geographically separate locations.

What does Confluence's clustering do, then?
Confluence's clustering system allows a single installation to serve a much greater number of concurrent requests than a single server. This is what we refer to as 'scaling under load'.

It does provide a certain amount of resilience, as the death of one node won't bring the other(s) down. However, it requires very low network latency, which rules out geographic separation of the servers, and upgrading can only be performed while the entire cluster is shut down. This doesn't mean that Confluence's clustering is buggy or broken. It simply reflects the difference between the two design aims.

On this page:

- What is High Availability (HA)?
- What does Confluence's clustering do, then?
- So what kind of resilience can I build into a Confluence installation?
- What's the difference between load balancing and failover?
- What do you mean by 'session affinity'?  
  - RELATED TOPICS

The information on this page does not apply to Confluence OnDemand.

So what kind of resilience can I build into a Confluence installation?

It's still entirely possible to build a resilient Confluence installation, using a 'cold-failover' approach in which two (or more) servers share a database and (normally) a network-mounted file system, where no more than one server is actually running at any given time.

Several different approaches are feasible, but the common elements are:

- a well-configured load balancer (session affinity is irrelevant in this case)
- a reliable monitoring system which can detect and shut down a misbehaving Confluence instance before starting the spare server
- startup scripts with added smarts to check for the presence of another running node before deciding whether to start up a server
- servers with the same view of both the database and the home directory.

It's vital to ensure that only one server is running at any one time, in this kind of setup. If a server starts while another is already running against the same database, the result will be a cluster panic that shuts down both servers.

A single database becomes the single point of failure in such a system. This can be alleviated by database clustering, or by replication from the 'active' database server to the standby server(s) if you wish to separate the failover systems while keeping database latency to a minimum.

In the same vein, the home directory can be hosted on a shared network system — SAN or NAS, preferably with its own replication/rapid recovery system — though there's a known issue to consider. Alternatively, to avoid the use of networked file systems, a utility such as rsync can be used to periodically bring the spare servers' home directories up to date, so long as you keep the period sufficiently short — probably between one and five minutes, depending on the rate of activity. This can be avoided altogether by keeping attachments in the database; it increases the demands on the bandwidth between the application and database servers, but guarantees that the system is in a consistent state at switchover. If the data is at all sensitive or confidential, it's advisable to run rsync over ssh, to minimise the opportunity for the data to be captured on its way across the network.

What's the difference between load balancing and failover?

Load balancing means that all servers are active, and new requests are distributed among them. Several
strategies are available, but the most common are:

- **round-robin** — the first request goes to the first server, the second request goes to the second server, and so on. When you run out of servers, the next request goes to the first server, and around it goes again.
- **percentage-based** — if (for example) you have two servers, and one can handle twice the load of the other, you can tell the load balancer to send two requests to the stronger server for every request that goes to the weaker one.
- **availability** — the load balancer sends a test query to each of the servers every second or so, and directs each new request to the server that’s currently responding the fastest.

Failover means that only one server is active at any given time, and normally involves two servers (any number of servers may be involved, depending on the system). If the active one stops responding, requests are directed to the other server — the system ‘fails over’ to the second one.

‘Cold failover’ means that the second server is only started up after the first one has been shut down. This is the case for non-clustered Confluence.

‘Hot failover’ or ‘hot standby’ means that all servers are running at all times, and that the load is directed entirely toward one server at any one time.

A load balancer can be used in both scenarios, especially if it's smart enough to keep track of which servers are currently running.

Failover can also be managed via DNS, in a sufficiently well-controlled environment.

**What do you mean by ‘session affinity’?**

Sessions consist of several transmissions in each direction between the client (browser) and the server. Session affinity means that the load balancer keeps track of which server received the initial transmission from a given browser, and that it will then send any subsequent requests from that browser to the same server.

This is necessary with Confluence clustering, in particular, because sessions are not shared across cluster nodes. If you log into one node and then send a request to another, the other node will send you the login screen because it doesn't recognise your session cookie.

**RELATED TOPICS**

*Confluence Clustering Overview*

**Recommended network topology**

Atlassian recommends a network topology similar to the one shown below, to get the best results from a Confluence Clustered deployment.

The number of Confluence nodes in the deployment is adjustable — select the number which suits your own requirements.

The most important aspect is that cluster, database and HTTP (client) traffic are all carried on separate subnets. It is possible, on a sufficiently fast network, to carry cluster and database traffic on the same subnet but we do strongly recommend that HTTP traffic be always confined to a separate subnet on production deployments.

Confluence Clustered does not support clustered communication over WAN, VLAN or VPN. All Confluence Clustered nodes must be on the same local subnet, ideally networked via an ethernet hub or simple switch. The cluster communication network must also support multicast IP networking.

⚠️ The information on this page does not apply to Confluence OnDemand.
Use this example as a basis for your own network diagram

When you are considering a Confluence Clustered deployment, you should prepare a network diagram like the one on this page. This will facilitate discussion with Atlassian Support and help with your own planning. Please refer to the cluster checklist for more guidance on planning your clustered deployment.

Cluster Administration page

Overview
Any instance of Confluence which uses a clustered license has a Cluster Configuration page which includes information about the active cluster.

To open the Cluster Administration page,

1. Choose **Browse > Confluence Admin**.
2. Click 'Cluster Configuration' in the left-hand menu, in the section called 'Clustering'.

⚠️ **The information on this page does not apply to Confluence OnDemand.**

### Availability

To access this functionality, you must:

- Be a System Administrator (i.e. have global System Administrator permissions), and
- be using Confluence 2.3 or later, and
- be using a clustered Confluence license.

---

**Screenshot: Cluster Administration Page**

```
<table>
<thead>
<tr>
<th>Cluster Status</th>
<th>RUNNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Name</td>
<td>extranet</td>
</tr>
<tr>
<td>Multicast Listen Address</td>
<td>235.54.69.161:32357</td>
</tr>
<tr>
<td>Active Nodes</td>
<td>2</td>
</tr>
<tr>
<td>Licensed Nodes</td>
<td>8</td>
</tr>
</tbody>
</table>

**Active Nodes**

```

<table>
<thead>
<tr>
<th>Node ID</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unicast Listen Address</td>
<td>172.16.0.11:8088</td>
</tr>
<tr>
<td>Uptime</td>
<td>1 day, 20 hours, 49 minutes, 47 seconds</td>
</tr>
<tr>
<td>JVM Version</td>
<td>1.4.2_12</td>
</tr>
<tr>
<td>Operating System</td>
<td>Linux 2.6.9-42.0.3.ELsmp</td>
</tr>
<tr>
<td>Memory Graph</td>
<td>9 % Free</td>
</tr>
</tbody>
</table>

```

<table>
<thead>
<tr>
<th>Node ID</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unicast Listen Address</td>
<td>172.16.0.10:8088</td>
</tr>
<tr>
<td>Uptime</td>
<td>1 day, 20 hours, 27 minutes, 32 seconds</td>
</tr>
<tr>
<td>JVM Version</td>
<td>1.4.2_12</td>
</tr>
<tr>
<td>Operating System</td>
<td>Linux 2.6.9-42.0.3.ELsmp</td>
</tr>
<tr>
<td>Memory Graph</td>
<td>17 % Free</td>
</tr>
</tbody>
</table>
```

This page shows your cluster configuration, and allows you to start a new Confluence cluster using data from this instance.

**Cluster Status** indicates whether your cluster is currently running.
**Licensed nodes** is the maximum number of instances of Confluence your license allows in a cluster.

**Active nodes** lists the instances of Confluence currently participating in the cluster.

**Starting a new cluster** will perform the following changes:

- enable a clustered cache
- migrate attachments from file system to the database
- publish database connection information so other nodes can join the cluster.

ℹ️ All access to Confluence will be locked while this takes place, and you will be forced to restart Confluence afterwards.

**Cluster name** is a short name for identifying your cluster. Other Confluence instances can join the cluster using this name.

ℹ️ To join an existing cluster, start a clean copy of Confluence on this node and select ‘Join Cluster’ during the setup wizard.

**Related documents**

- [Overview of Confluence Clusters](#)
- [Confluence Cluster Installation](#)
- [Cluster Troubleshooting](#)

**Cluster Checklist**

It is possible to run Confluence in a **clustered** environment instead of on a single server. This means that you can run multiple copies of Confluence in a cluster, so that clients (such as a browser) can connect to any copy and see the same information.

ℹ️ Refer to the [clustering overview](#) for more information and a list of related pages about clustering Confluence.

⚠️ **Consider your options carefully before deciding on a clustered installation**

While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change and requires extra planning for deployment and upgrades. Please consider the information below and then consult [Atlassian Sales](#) before making your final decision.

---

**On this page:**

- [Purpose of this Document](#)
- [Assumed Knowledge](#)
- [General Considerations](#)
- [Server Setup](#)
- [Database Setup](#)
- [Network Setup](#)
- [Staging Environment](#)

⚠️ **The information on this page does not apply** to Confluence OnDemand.

**Purpose of this Document**

The purpose of this cluster checklist is to help you:
- Decide whether Confluence Clustered is the right solution for you.
- Create a plan for your clustered deployment.

If you need to raise a support request with Atlassian during or after cluster deployment, we will need to ask you questions about your configuration. It will save crucial time if you can provide us with your deployment plan.

For more information about clustering Confluence, refer to the clustering overview.

Assumed Knowledge

In writing this document, we have assumed that our readers have an in-depth knowledge of the following technical areas:

- Database
- Networking
- Application servers
- Load balancers

Before starting a clustered deployment please read the information on this page carefully, as well as the linked documentation, to assess if you have the assumed knowledge.

General Considerations

Confluence Clustered is designed to scale the number of simultaneously connected users at a much better performance than what a single node can achieve.

Confluence Clustered will not improve performance in systems with few users.

Clustering Confluence means that user requests can be served by independent machines. The performance gains are substantial, and have improved a lot further since Confluence 3.0. Clustering is especially great in dealing with spikes to the load, e.g. during certain hours of business. Just note that if rendering a complicated page (e.g. containing many macros or rendering many graphs) takes five seconds on an otherwise idle server, will not be faster in a clustered environment. Also, the first step when you encounter performance issues is to tune your existing system, make sure you are using the right hardware and have looked at your database.

Confluence Clustered is not a high availability solution.

General availability is higher in a Confluence cluster than on a single installation, you can for example take one node down for minor maintenance tasks e.g. when adding a new CPU or adding RAM. But you still have to bring down all nodes at the same time for software upgrades. Also there are certain conditions, like loss of network connectivity between nodes (‘split brain’), that will result in the cluster shutting itself down. Confluence Clustered offers higher reliability, but not high availability.

Confluence Clustered is not for disaster recovery nor for transparent failover.

If one node crashes, there is no transparent failover for the connected client. Also, our network requirements (see below) make Confluence unsuitable for deployment to different cities or even to different buildings.

Server Setup

The number of supported cluster nodes is limited to four.

⚠️ Not supported. In theory, you can connect more than four nodes — but that is not covered by Atlassian Support.
All cluster nodes must have the same version of OS, application server, etc.

Confluence requires a homogeneous environment. All Confluence cluster nodes must have the same version of the following:

- Operating system
- CPU
- Installed memory
- Java
- Application server

Note that 'same version' means 'same to the last digit'. For example, Java v1.4.2_16 is not the same as v1.4.2_15.

We strongly recommend users to have the same memory configuration (both the JVM and the physical memory) because a cluster uses a replicated cache. A replicated cache requires the same amount of memory on each node in the operating cluster. The memory allocations must be equal.

Use good and up-to-date hardware.

While the details are up to you, we strongly suggest that your servers have at least 4GB of physical RAM. A high number of concurrent users means that a lot of RAM will be consumed. You usually don't need to assign more than 4GB per JVM process, and most of the time even just 1GB or 2GB will be fine, you should just be prepared to fine-tune the settings.

Confluence Clustered is not supported when run in VMware or other virtualisations.

**Not supported.** We strongly discourage you to deploy a production environment of Confluence to virtual servers, and we will not be able to support you when problems arise.

When running a Confluence cluster your goal is high capacity and performance, so you should not risk lower performance by virtualising it and sharing a computer with other processes.

Many customers who are running Confluence on VMware, or similar virtualisation solutions, experience major performance problems that are extremely hard to pinpoint. Since the problems are not related to Confluence itself, we will not be able to help you.

Confluence should be the only application on the cluster servers.

No additional applications (other than core operating system services) should be running on the same servers as Confluence.

Since your goal should be increased capacity and performance, you should not risk this by running any other process on the machine with a Confluence Clustered node. While it may be fine to run JIRA, Confluence and Bamboo on a dedicated Atlassian software server for small installations, it is strongly discouraged for clustering Confluence.

Do not upgrade and switch to Confluence Clustered at the same time

If you plan to migrate to a clustered solution, make sure you are migrating within the same version of Confluence. If you plan to upgrade to a higher version of Confluence, do this **before** the migration to the clustered version.

For example, if you are currently running Confluence 2.9.2, and want to roll out the clustered version of Confluence 3.0, you must first upgrade to Confluence 3.0 and check that everything works fine (e.g. by running and monitoring your production system for a week). Then you are in a good position to migrate to the clustered version.

**Database Setup**

Run the database on its own physical server.

You are optimising for performance, so you don't want the database to slow down your application servers, or vice versa. In high load scenarios, the database may need to have better hardware than the application servers to be able to handle all requests. You should find out by performing load testing.

Attachments must be stored in a database and not the local file system

Storing attachments in the database is the only supported **attachment storage configuration** for clustering Confluence.
Make sure that you use a supported version of a database server to store Confluence's data.
Please check that your intended database is officially supported by Atlassian Confluence. The load on an average cluster solution is higher than on a single box installation, and it is therefore even more crucial to use the right database vendor and version.

Your database must be provisioned to store a large volume of binary data.
Note that Confluence clustered stores file attachments in the database, and you need an experienced DBA who can monitor and manage the data growth.

You need an experienced DBA available to troubleshoot database performance issues.
Not having an experienced full-time DBA at hand at short notice when entering the realm of high load is dangerous. While small installations of Confluence basically work 'out of the box', anything that involves high load and a lot of database space requires continual monitoring, optimising and fine tuning of the Confluence database. When we ramp up the load on our loadtesting environment, we see that database usage goes up as well. Having powerful hardware in place helps, but if there are queries that become inefficient with you particular load pattern, you need an expert to tune it. As an example, we have seen PostgreSQL switch its internal caching mechanism when a particular table reached a certain size, which resulted in a drop of performance by about 200ms per request. This happened from one second to the other. Being able to troubleshoot and then fix issues like these is important in any enterprise system, but it is even more in a high load scenario.

Network Setup
We recommend hardware load balancers or putting a software loadbalancer onto its own server.
If you use a software load balancer (which is fine except for really extreme installations), it must be deployed on a machine of its own. Running a software load balancer on a cluster node is not supported. If a node unexpectedly got overwhelmed by a spike in load, a load balancer on that node would turn unresponsive. As a result, your whole cluster would be inaccessible even though the other nodes would be available. So using a different server is common practice and common sense.

Use separate network adapters for communication between servers. The Confluence cluster nodes should have a separate physical network (i.e. separate NICs) for inter-server communication.

This is the best way of getting the cluster to run fast and reliably. Performance problems are likely to occur if your cluster nodes connect via a network that has lots of other data streaming through it.

The switch connecting the Confluence cluster nodes must not be a 'smart switch'.
⚠️ Not supported. Smart switches are not covered by Atlassian Support for Confluence Clustered.

Do not use smart switches between cluster nodes. Many problems have been reported and attributed to smart switches. They have a tendency to interrupt broadcast or multicast traffic, thus reliably killing a cluster after a certain amount of time has passed. This makes troubleshooting especially complex and tedious.

Cisco switches need additional configuration.
If the switch connecting the Confluence cluster nodes is a Cisco switch then it might need additional configuration to support Confluence clustering.

Please make sure you find out all the details about your switches before you start the deployment.

It is recommended that the database is on a different physical network from the Confluence server nodes. Since you want to increase your capacity and performance for high loads, it is recommended to have your database on a different network. Please refer to the recommended topology diagram for more information.

Minimize the latency between the Confluence cluster nodes and the database.
Even though having the nodes and the database on the same physical network usually suffices, you should take the time to explicitly measure network latency, and make sure it is as close to zero as possible.

Prepare a network diagram.
To facilitate discussion and to ease planning, you should prepare a network diagram like this example of recommended network topology.
If you request support with Confluence Clustered, we may ask for your network diagram. We recommend that you create one similar to our example before you proceed with the installation.

You need network support staff available to troubleshoot cluster communication issues.

Setting up a cluster is not trivial. Even small problems in network design will be expanded in a clustered installation. (This is true of any kind of software.)

It is absolutely vital that you have dedicated network staff available to track down problems when they arise. A cluster will usually be used by thousands of users, and you don't want to keep them waiting because a network card breaks, or because someone made an undocumented change to the network and you don't have an expert around who can figure it out.

**Staging Environment**

You need a staging environment that is exactly the same as your production system.

You must be able to test drive any change to the cluster (installing upgrades, installing plugins) and to perform other tests (checking connectivity, debugging problems) on a staging cluster.

The staging environment must be:

- On the same OS, database, and Java version as your production environment.
- Clustered.

If you require support, we may for example ask you to turn off certain third-party plugins. If you can't do this in your production environment and you don't have a staging environment for troubleshooting, we may not be able to help you.

---

### Related Topics

No content found for label(s) cluster.

---

### Confluence Security

This document is for system administrators looking to evaluate the security of the Confluence web application. The page addresses overall application security and lists the security advisories issued for Confluence. As a public-facing web application, Confluence's application-level security is important. This document answers a number of questions that commonly arise when customers ask us about the security of our product.

Other topics:

- For information about user management, groups and permissions, please refer to the [internal security overview](#).
- For guidelines on configuring the security of your Confluence site, see the [administrator's guide to configuring Confluence security](#).

---

### On this page:

- Application Security Overview
- Finding and Reporting a Security Vulnerability
- Publication of Confluence Security Advisories
- Severity Levels
- Our Patch Policy
- Published Security Advisories
- Other Security Resources
Application Security Overview

Password Storage

When Confluence's internal user management is used, passwords are hashed through SHA1 before being stored in the database. There is no mechanism within Confluence to retrieve a user's password – when password recovery is performed, a reset password link is generated and mailed to the user's registered address.

When external user management is enabled, password storage is delegated to the external system.

Buffer Overflows

Confluence is a 100% pure Java application with no native components. As such it is highly resistant to buffer overflow vulnerabilities – possible buffer overruns are limited to those that are bugs in the Java Runtime Environment itself.

SQL Injection

Confluence interacts with the database through the Hibernate Object-Relational mapper. Database queries are generated using standard APIs for parameter replacement rather than string concatenation. As such, Confluence is highly resistant to SQL injection attacks.

Script Injection

Confluence is a self-contained Java application and does not launch external processes. As such, it is highly resistant to script injection attacks.

Cross-Site Scripting

As a content-management system that allows user-generated content to be posted on the web, precautions have been taken within the application to prevent cross-site scripting attacks:

- The wiki markup language in Confluence does not support dangerous HTML markup
- Macros allowing the insertion of raw HTML are disabled by default
- HTML uploaded as a file attachment is served with a content-type requesting the file be downloaded, rather than being displayed inline
- Only system administrators can make HTML-level customisations of the application

When cross-site scripting vulnerabilities are found in the Confluence web application, we endeavour to fix them as quickly as possible.

Transport Layer Security

Confluence does not directly support SSL/TLS. Administrators who are concerned about transport-layer security should set up SSL/TLS at the level of the Java web application server, or the HTTP proxy in front of the Confluence application.

For more information on configuring Confluence for SSL, see: Running Confluence Over SSL or HTTPS

Session Management

Confluence delegates session management to the Java application server in which it is deployed. We are not aware of any viable session-hijacking attacks against the Tomcat application server shipped with Confluence. If you are deploying Confluence in some other application server, you should ensure that it is not vulnerable to session hijacking.
**Plugin Security**

Administrators install third party plugins at their own risk. Plugins run in the same virtual machine as the Confluence server, and have access to the Java runtime environment, and the Confluence server API.

Administrators should always be aware of the source of the plugins they are installing, and whether they trust those plugins.

**Administrator Trust Model**

Confluence is written under the assumption that anyone given System Administrator privileges is trusted. System administrators are able, either directly or by installing plugins, to perform any operation that the Confluence application is capable of.

As with any application, you should not run Confluence as the root/Administrator user. If you want Confluence to listen on a privileged network port, you should set up port forwarding or proxying rather than run Confluence with additional privileges. The extra-careful may consider running Confluence inside a chroot jail.

**Stack Traces**

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

**Finding and Reporting a Security Vulnerability**

Atlassian’s approach to reporting security vulnerabilities is detailed in [How to Report a Security Issue](#).

**Publication of Confluence Security Advisories**

Atlassian’s approach to releasing security advisories is detailed in [Security Advisory Publishing Policy](#).

**Severity Levels**

Atlassian’s approach to ranking security issues is detailed in [Severity Levels for Security Issues](#).

**Our Patch Policy**

Atlassian’s approach to releasing patches for security issues is detailed in [Security Patch Policy](#).

**Published Security Advisories**

- [Confluence Security Advisory 2012-05-17](#)
- [Confluence Security Advisory 2011-05-31](#)
- [Confluence Security Advisory 2011-03-24](#)
- [Confluence Security Advisory 2011-01-18](#)
- [Confluence Security Advisory 2010-11-15](#)
- [Confluence Security Advisory 2010-10-12](#)
- [Confluence Security Advisory 2010-09-21](#)
- [Confluence Security Advisory 2010-08-17](#)
- [Confluence Security Advisory 2010-07-06](#)
- [Confluence Security Advisory 2010-06-02](#)
Confluence Security Advisory 2006-01-19

⚠️ This security advisory is not endorsed by Atlassian - this is a public service advisory from a member of the confluence community. Please remember to backup any modified files, and use these instructions at your own risk. While this information is based on Confluence v2.1.2, it may have uses with older affected versions of Confluence.

The official security advisory is located at Confluence Security Advisory 2006-01-20

Problem

There is a possibility of XSS exploitation of the Full Name user profile field when displayed.

Solution

The problem was unescaped outputting of the fullname - wrapping the output in $generalUtil.htmlEncode() resolve it. The vast majority of the problem can be resolved by changing /confluence/template/includes/macros.vm in the distribution on the following lines:

- 180
- 186
I have attached the modified macros.vm file here which you can copy into your distribution.

Scope

There are other places which are still affected which Atlassian have been made aware of, a complete resolution should be provided by Atlassian in their own official advisory.

I hope this helps some of you!

Confluence Security Advisory 2005-02-09

A flaw has been found in Confluence by which attackers can bypass Confluence security and change content on the site. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 1.3.3

Vulnerability

By crafting custom URLs, any person with the ability to browse Confluence can modify content on the site, bypassing security settings. This vulnerability does not allow users to view content they would not normally be able to view, or escalate their privileges in other ways.

This flaw affects all versions of Confluence prior to 1.3.3, including the 1.4-DR development releases.

Fix

This vulnerability is fixed in Confluence 1.3.3 and later. Customers who do not wish to migrate to 1.3.3 can fix this bug using the procedure below:

1. Edit the file confluence/WEB-INF/classes/xwork.xml
2. Find the following section near the top of the file (around line 34):

   <interceptor-stack name="defaultStack">
     <interceptor-ref name="profiling">
       <param name="location">Before defaultStack</param>
     </interceptor-ref>
     <interceptor-ref name="transaction"/>
     <interceptor-ref name="authentication"/>
     <interceptor-ref name="requestParameterHack"/>
     <interceptor-ref name="eventnotifier"/>
     <interceptor-ref name="autowire"/>
     <interceptor-ref name="params"/>
     <interceptor-ref name="servlet"/>
     <interceptor-ref name="pageAware"/>
     <interceptor-ref name="permissions"/>
     <interceptor-ref name="profiling">
       <param name="location">After defaultStack</param>
     </interceptor-ref>
   </interceptor-stack>

3. Locate the "autowire" and "params" entries:
4. Swap the two lines around. The whole stack should now look like this:

```xml
<interceptor-stack name="defaultStack">
  <interceptor-ref name="profiling">
    <param name="location">Before defaultStack</param>
  </interceptor-ref>
  <interceptor-ref name="transaction"/>
  <interceptor-ref name="authentication"/>
  <interceptor-ref name="requestParameterHack"/>
  <interceptor-ref name="eventnotifier"/>
  <interceptor-ref name="params"/>
  <interceptor-ref name="autowire"/>
  <interceptor-ref name="servlet"/>
  <interceptor-ref name="pageAware"/>
  <interceptor-ref name="permissions"/>
  <interceptor-ref name="profiling">
    <param name="location">After defaultStack</param>
  </interceptor-ref>
</interceptor-stack>
```

5. Restart Confluence.

**Confluence Security Advisory 2005-12-05**

A flaw has been found in Confluence by which attackers can inject malicious HTML code into Confluence. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 2.0.2.

**Vulnerability**

By entering HTML code into the Confluence search input fields, attackers can cause arbitrary scripting code to be executed by the user's browser in the security context of the Confluence instance.

This flaw affects all versions of Confluence between 1.4-DR releases and 2.0.1.

(Atlassian was not informed of the problem before it was published by third-party security researchers. You can read the third-party security advisory here: [http://secunia.com/advisories/17833/](http://secunia.com/advisories/17833/). The vulnerability was originally reported [here](http://secunia.com/advisories/17833/).)

**Fix**

This vulnerability is fixed in Confluence 2.0.2 and later. Customers who do not wish to migrate to 2.0.2 can fix this bug using the procedure below:

1. Edit the confluence/decorators/components/searchresults.vmd
2. Replace the following reference (around line 48):

```vmd
$action.getText("search.result", [$start, $end, $total, $queryString])
```
3. Edit the confluence/search/searchsite-results.vm.
4. Replace the following reference (around line 11):

```
$action.getText("search.result", [$start, $end, $total, $generalUtil.escapeXml($queryString)])
```

with

```
Searched for <b>$action.searchQuery.queryString</b>
```

with

```
Searched for <b>$generalUtil.escapeXml($action.searchQuery.queryString)</b>
```

5. Restart Confluence.

Alternatively, you can download the patched source files from [CONF-4825](http://conf.atlassian.com/bugzilla/show_bug.cgi?id=CONF-4825). If you are patching a 2.0.x installation, then use the files with the .2.0 suffix. If you are patching a 1.4.x installation, then use the files with the .1.4 suffix.

**Confluence Security Advisory 2006-01-20**

A flaw has been found in Confluence by which attackers to inject malicious HTML code into Confluence. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 2.1.3.

**Vulnerability**

By entering HTML/JavaScript code into the full name of a user's profile, attackers can cause arbitrary scripting code to be executed by the user's browser in the security context of the Confluence instance.

This flaw affects all versions of Confluence between 1.4-DR releases and 2.1.2.

This issue was initally reported by Ricardo Sueiras and a fix was quickly documented by Dan Hardiker at the [Confluence Community Security Advisory 2006-01-19](http://confluence.atlassian.com/display/CONFLUENCE/Confluence+Community+Security+Advisory+2006-01-19) page. Our thanks to them for bringing this to our attention.

There is an issue in JIRA at [CONF-5233](http://conf.atlassian.com/bugzilla/show_bug.cgi?id=CONF-5233).

**Fix**

This vulnerability is fixed in Confluence 2.1.3 and later. Customers who do not wish to migrate to 2.1.3 can fix this bug using the procedure below:

Steps to fix:

1. Copy `macros.vm` to your confluence/template/includes folder
2. Restart Confluence

**Note:** If you are using version 1.4.4, please download and copy this file instead. You will need to rename it back
If you are not using any of the above versions, you will need to replace wrap calls to display full names of users in $generalUtil.htmlEncode(). Alternatively, send us an email. We do however encourage you to use the latest stable point release regardless of the version you are using.

**Confluence Security Advisory 2006-01-23**

A flaw has been found in Confluence by which the unrestricted content of a space can be revealed in search results.

**Vulnerability**

By entering in a space key and blank query string into the Search macro, pages from the specified space will be displayed, without filtering on page and space permissions. This can allow unpermitted users to view the excerpts of pages they don't have access to.

This flaw is confirmed to affect all releases from 1.4 to 2.1.2.

More information is available at [CONF-5189](http://example.com/CONF-5189).

**Fix**

This vulnerability is fixed in Confluence 2.1.3 and later. We strongly suggest that customers upgrade to this release to fix the vulnerability.

Customers who are using 1.4.x and do not wish to upgrade can download a patched class from [CONF-5198](http://example.com/CONF-5198).

**Confluence Security Advisory 2006-06-14**

**Vulnerability**

By crafting a custom HTTP request, an attacker can delete or modify global permissions settings on a Confluence site.

This flaw affects all Confluence versions between 1.4 and 2.2.2. 2.2.3 and later are not vulnerable.

**Fix**

This issue has been fixed in Confluence 2.2.3. Patches are also available for all versions of Confluence between 1.4 and 2.2.2. For more information, please see [this issue report](http://example.com/this-issue-report).

Atlassian STRONGLY recommends that all customers either upgrade to Confluence 2.2.3, or apply the patch.

**Confluence Security Advisory 2007-07-26**

In this advisory:

- **Users with view permission in a space can copy and save a page**
  - **Vulnerability**
  - **Fix**

- **Space name and key are not validated nor escaped**
  - **Vulnerability**
  - **Fix**

**Users with view permission in a space can copy and save a page**

**Vulnerability**

A user who has only view permissions in a space can copy a page and then save it in the space. In this way,
users can create a page in a space where they have only view permission.

This flaw affects only Confluence version 2.5.4.

Fix

This issue has been fixed in Confluence 2.5.5. A patch is also available for Confluence 2.5.4. For more information, including instructions on applying the patch, please see this issue report.

If you are using Confluence 2.5.4, Atlassian **strongly** recommends that you upgrade to Confluence 2.5.5 or apply the patch.

**Space name and key are not validated nor escaped**

Vulnerability

The input for space name and key is not validated properly - any characters are allowed. This makes a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.5. For more information, please see this issue report.

Atlassian recommends that you upgrade to Confluence 2.5.5.

**Confluence Security Advisory 2007-08-08**

In this advisory:

- **Input in the RSS Feed Builder is not validated**
  - Vulnerability
  - Fix
- **Input when editing Space Permissions is not validated**
  - Vulnerability
  - Fix
- **Number of labels that can be added to a page is not restricted**
  - Vulnerability
  - Fix
- **Input when editing navigation themes is not validated**
  - Vulnerability
  - Fix
- **Viewing of space content alphabetically is not validated**
  - Vulnerability
  - Fix
- **Input when editing Space Name is not validated**
  - Vulnerability
  - Fix
- **Input when viewing attachments by file-type is not validated**
  - Vulnerability
  - Fix

**Input in the RSS Feed Builder is not validated**

Vulnerability

The input for the RSS Feed Builder is not required to be escaped. This can make a Confluence instance
vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8993.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Input when editing Space Permissions is not validated

Vulnerability

The 'Grant permission to' field on the 'Edit Space Permissions' screen is not validated. This can make a Confluence instance vulnerable to an XSS or DoS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8980 and CONF-8979.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Number of labels that can be added to a page is not restricted

Vulnerability

There is no restriction on the number of labels that can be added to a page at a time. This can make a Confluence instance vulnerable to a DoS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8978.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Input when editing navigation themes is not validated

Vulnerability

The 'Navigation Page' specified in the 'Left Navigation Theme' configuration is not validated. This can make a Confluence instance vulnerable to a XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8956.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Viewing of space content alphabetically is not validated

Vulnerability

When viewing space content by alphabetic character, the input is not validated as being alphabetic. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8952.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Input when editing Space Name is not validated
Vulnerability

The 'Name' field on the 'Edit Space Details' screen is not validated. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8951.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Input when viewing attachments by file-type is not validated

Vulnerability

The 'Filter By Extension' field on the 'List Space Attachments' screen is not validated. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8950.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Confluence Security Advisory 2007-11-19

In this advisory:

- DWR debug mode enabled
  - Vulnerability
  - Fix

- XSS vulnerability in exception error page
  - Vulnerability
  - Fix

- XSS vulnerability in the URL destination for the print icon
  - Vulnerability
  - Fix

- XSS vulnerability in wiki markup for images
  - Vulnerability
  - Fix

Atlassian recommends that you upgrade to Confluence 2.6.1 to fix the vulnerabilities described below.

DWR debug mode enabled

Vulnerability

Debug mode was enabled by default on Direct Web Remoting (DWR). This made it easy for a potential attacker to find information about available AJAX request handlers in Confluence.

Fix

This issue has been fixed in Confluence 2.6.1. If you do not wish to upgrade at this time, you can fix the problem by editing your $confluence install$/confluence/WEB-INF/web.xml file. For more information, please see CONF-9718.

XSS vulnerability in exception error page
Vulnerability

The attributes and parameters were not escaped on the Confluence exception error page. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. For more information, please see CONF-9704 and CONF-9560.

XSS vulnerability in the URL destination for the print icon

Vulnerability

The print icon on the HTTP 404 error page uses the path of the requested URL, which potentially contains malicious JavaScript. The 404 page did not correctly escape it. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. A patch is supplied for customers with Confluence version 2.6 who do not wish to upgrade at this time. For more information, please see CONF-9456.

XSS vulnerability in wiki markup for images

Vulnerability

When using image URLs in wiki markup, quotes were not correctly escaped. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. For customers with Confluence 2.6 who do not wish to upgrade at this time, the new atlassian-renderer JAR should resolve this issue. For more information, please see CONF-9209.

Confluence Security Advisory 2007-11-27

In this advisory:

- XSS Type 2 Vulnerabilities in Macros and Wiki Markup
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Type 2 Vulnerabilities in Macros and Wiki Markup

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed some security flaws which may affect Confluence instances in a public environment. These flaws are XSS (cross-site scripting) vulnerabilities in some of Confluence's macros and Wiki Markup, which potentially allow a malicious user (hacker) to insert their own HTML tags or script into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by
sending the credentials back to the hacker’s own web server.

- The hacker’s text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

Atlassian recommends that you upgrade to Confluence 2.6.2 to fix the vulnerabilities described below.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

**Risk Mitigation**

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

**Vulnerability**

The following macros are affected:

- `{color}`
- `{panel}`
- `{section}`
- `{column}`
- `{code}`

The Wiki Markup for inserting images (e.g. ![myImage.png!]) is also vulnerable to XSS exploitation.

**Fix**

The fix is to escape all user input, so that no user input is interpreted as HTML or CSS. In some cases we also perform stricter validation on the range of values a user can supply in an attribute.

These issues have been fixed in Confluence 2.6.2. For more information, please see [CONF-9350](#).

Our thanks to Igor Minar, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Please let us know what you think of the format of this security advisory and the information we have provided.

**Confluence Security Advisory 2007-12-14**

**In this advisory:**

- [XSS Vulnerability in Configure RSS Feed Action](#)

**XSS Vulnerability in Configure RSS Feed Action**

**Severity**

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious
user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7, or
- Download and install the patch for Confluence 2.5.8 or Confluence 2.6.2 from our JIRA site – see issue CONF-10164.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the following Confluence action:

```
http://www.anyhost.com/confluence/dashboard/configurerssfeed.action
```

The above Confluence action is used to build an RSS feed based on your Confluence pages and news items. The action is invoked when a selects 'Feed Builder' from your Confluence Dashboard. It can also be invoked by simply entering the URL into the browser address bar.

Fix

These issues have been fixed in Confluence 2.7, which you can download from the download centre.

A patch is available for Confluence 2.5.8 and Confluence 2.6.2. For more information, please see CONF-10164.

Our thanks to jeff peichel, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Please let us know what you think of the format of this security advisory and the information we have provided.

Confluence Security Advisory 2008-01-24

In this advisory:

- XSS Vulnerability in Dashboard Action
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Dashboard Action

Severity
Atlassian rates this vulnerability as **high**, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/CONFSEC/Confluence+Security). The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to [Confluence 2.7.1](https://confluence.atlassian.com/display/CONFSEC/Confluence+2.7.1), or
- Download and install the patch for Confluence 2.6.2 or Confluence 2.7.0 from our JIRA site – see issue [CONF-10289](https://jira.atlassian.com/browse/CONF-10289).

You can read more about XSS attacks at [cgisecurity](https://www.cgisecurity.com/) and [CERT](https://www.cert.org) and other places on the web.

**Risk Mitigation**

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

**Vulnerability**

A hacker can inject their own JavaScript into the following Confluence action:

```
http://confluence-location/dashboard.action?spacesSelectedTab
```

The above Confluence action is used to determine which spaces are listed on a user's Dashboard. For example, the following URL requests a list of team spaces only:

```
http://confluence-location/dashboard.action?spacesSelectedTab=team
```

The action is invoked when a user selects one of the 'Spaces' tabs on the Dashboard, such as the 'Team' tab. It can also be invoked by simply entering the URL into the browser address bar.

**Fix**

These issues have been fixed in [Confluence 2.7.1](https://confluence.atlassian.com/display/CONFSEC/Confluence+2.7.1) (see the release notes), which you can download from the download centre.

A patch is available for [Confluence 2.6.2](https://confluence.atlassian.com/display/CONFSEC/Confluence+2.6.2) and [Confluence 2.7.0](https://confluence.atlassian.com/display/CONFSEC/Confluence+2.7.0). For more information, please see [CONF-10289](https://jira.atlassian.com/browse/CONF-10289).

Our thanks to Mary Johnson, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate her working with us towards identifying and solving the problem.

*Please let us know what you think of the format of this security advisory and the information we have provided.*
Confluence Security Advisory 2008-03-06

In this advisory:

- Users with View-Only Permission can Delete (Purge) Pages
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Users with View-Only Permission can Delete (Purge) Pages

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

More explanation of the ranking we chose:

- You might rank this vulnerability as critical, because in most installations the vulnerability will allow anonymous users to delete information.
- We have chosen a ranking of high, because the vulnerability does not allow privilege escalation i.e. it doesn't allow users to gain administration privileges.

Risk Assessment

We have identified and fixed a security flaw which allowed users who have 'View' permission (or higher) on a space to purge (delete) any page in that space.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.7.1 inclusive.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7.2, or
- Download and install the patch for Confluence 2.6.x or Confluence 2.7.x from our JIRA site – see issue ONF-10807.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

If it is not immediately feasible to upgrade to Confluence 2.7.2 or apply a patch, we recommend an alternative strategy:

- As a temporary measure, you can block the URL which allows someone to purge (delete) a page. Please ask your website administrator to block the URL described below.
- The impact is that Space Administrators will not be able to purge individual pages or news items. However, Space Administrators can still use the 'Purge All' link to clear the entire contents of Trash.

Vulnerability

Description:
A user can use the following Confluence action to permanently delete (purge) any Confluence page, provided that the user has 'View' permission (or higher) in the space to which the page belongs:
The above action is invoked when a space administrator clicks the 'Purge' link on the space's 'Trash' page next to a wiki page which has already been deleted.

The action can also be invoked by simply entering the URL into the browser address bar. In this way, it is possible for a user with 'View' permission (or higher) to remove a page via the 'Purge' action, even if the page has not been deleted.

Fix

These issues have been fixed in Confluence 2.7.2 (see the release notes), which you can download from the download centre.

A patch is available for Confluence 2.6.x, Confluence 2.7.0 and Confluence 2.7.1. For more information, please see CONF-10807.

Out thanks to Neeraj Jhanji, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Confluence Security Advisory 2008-03-19

In this advisory:

- XSS Vulnerabilities in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

### XSS Vulnerabilities in Various Confluence Actions

**Severity**

Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7.3, or
- Download and install the patches for Confluence 2.6.x from our JIRA site — refer to the list of issues below.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.
Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence Actions</th>
<th>Affected Confluence Versions</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create, edit or copy a page or news item</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11027</td>
<td></td>
</tr>
<tr>
<td>Add a comment</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11027</td>
<td></td>
</tr>
<tr>
<td>Create a space</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11042</td>
<td>Wyatt Crossin</td>
</tr>
<tr>
<td>Sign up for an account</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11005</td>
<td></td>
</tr>
<tr>
<td>Choose a page (page picker)</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11137</td>
<td></td>
</tr>
<tr>
<td>View a user</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11002</td>
<td></td>
</tr>
<tr>
<td>Insert an image or link</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11141</td>
<td></td>
</tr>
<tr>
<td>Choose a user or group (user picker and group picker)</td>
<td>From 2.2 to 2.7.2 inclusively</td>
<td>CONF-11040</td>
<td>Jean Marois</td>
</tr>
<tr>
<td>Add a user to favourites</td>
<td>From 2.0 to 2.7.2 inclusively</td>
<td>CONF-11026</td>
<td></td>
</tr>
<tr>
<td>HTTP 500 error page</td>
<td>From 1.3 to 2.7.2 inclusively</td>
<td>CONF-11019</td>
<td></td>
</tr>
</tbody>
</table>
Add bookmark | All Confluence instances that have the Social Bookmarking plugin. Note that the plugin is bundled with Confluence since version 2.6, so Confluence 2.6.x and 2.7.x are vulnerable even if you don't use social bookmarking. Patches are supplied for Confluence 2.6.x and 2.7.x. | CONF-11153

Fix

These issues have been fixed in Confluence 2.7.3 (see the release notes), which you can download from the download centre.

Patches are available for Confluence 2.6.x. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Our thanks to the people who reported some of the vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate their working with us towards identifying and solving the problem.

Confluence Security Advisory 2008-05-21

In this advisory:

- Users can Move Attachments to Any Page Regardless of Permissions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- XSS Vulnerability in Page Information View
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Users can Move Attachments to Any Page Regardless of Permissions

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who have 'Create Page' permission in a space to move an attachment from a page in that space to any other page in the Confluence site, regardless of the user's permissions in the destination space.
The following Confluence versions are vulnerable: All versions from 1.0 to 2.8.0.

Risk Mitigation

This security flaw grants extra powers only to users who already have 'Create Page' permissions in one of the spaces on the Confluence site. In most installations, this will be a trusted group of users.

If your Confluence instance allows a less trusted group of users to create and edit pages in one space, while restricting access to other spaces, you may judge it necessary to disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

Any user who has 'Create Page' permission in a Confluence space can move an attachment from a page in that space to any other page in the Confluence site, regardless of the user's permissions in the destination space.

Note: If a user has permission to create a space, they will also have 'Create Page' permission in any space they create, including a personal space. Such users could upload an attachment onto the space they have created and then move the attachment to any page in the Confluence site.

Fix

This issue has been fixed in Confluence 2.8.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.x or Confluence 2.8.0 from our JIRA site – see issue CONF-11452.

Our thanks to Stafford Vaughan from CustomWare, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate it when people work with us towards identifying and solving a problem.

XSS Vulnerability in Page Information View

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at coisecurity, CERT and other places on the web.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.8.0 inclusive.

Risk Mitigation

If you judge it necessary, you can hide referrers on page information views by disabling this functionality.

Vulnerability
A hacker can inject their own JavaScript into the referrer URLs which are displayed on the 'Info' view of a wiki page. The rogue JavaScript will be executed when a user opens the 'Info' view.

Fix

This issue has been fixed in Confluence 2.8.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.x or Confluence 2.8.0 from our JIRA site – see issue CONF-11524.

Confluence Security Advisory 2008-07-03

In this advisory:

- **XSS Vulnerability in Various Confluence Actions**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Actions

Severity

Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.
Confluence 4.3 Documentation

Confluence Actions | Affected Confluence Versions | More Details | Reporter (If Not Atlassian)
--- | --- | --- | ---
Create, edit or copy a page or news item | 2.8.0 and 2.8.1 | CONF-11985 | James Rinker
Page picker and space picker | 2.2.0 to 2.8.1 inclusive | CONF-11137 |  

Fix

These issues have been fixed in Confluence 2.8.2 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patches provided on our JIRA site. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Our thanks to James Rinker who reported some of the vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Confluence Security Advisory 2008-09-08

In this advisory:

- **XSS Bug: Usernames Not HTML-Encoded in All Places**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Inherited Page Restrictions Are Not Applied After 2.9 Upgrade**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Access Vulnerability in View Wiki Markup Function**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Access Vulnerability in Copy Page Function**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Access Vulnerability in Diff Page Function**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
Fix

XSS Bug: Usernames Not HTML-Encoded in All Places

Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/SECURITY/SecLevel). The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allowed certain users to circumvent Confluence’s security measures, by including HTML markup in their own username. This could allow a malicious user to execute Javascript on another user's authenticated session.

The following Confluence versions are vulnerable: All versions from **1.0 to 2.9**.

Risk Mitigation

If the user specified a username that included HTML markup (which could include Javascript), in some places Confluence would not correctly escape this source before displaying it. This could result in Javascript being executed in another user's authenticated session. To address the issue, you should update your Confluence instance as soon as possible (or follow the [patch instructions](https://confluence.atlassian.com/display/SECURITY/Confluence+Patch+Instructions) on the issue).

Vulnerability

This is a classic [Cross-Site Scripting](https://en.wikipedia.org/wiki/Cross-site_scripting) issue where usernames could include malicious Javascript.

Fix

This issue has been fixed in Confluence 2.9.1 (see the [release notes](https://confluence.atlassian.com/display/SECURITY/Confluence+Release+Notes), which you can download from the [download centre](https://confluence.atlassian.com/download-center).

For more information, see issue **CONF-7615** which has instructions on how to patch the affected velocity template.

Inherited Page Restrictions Are Not Applied After 2.9 Upgrade

Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/SECURITY/SecLevel). The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw that caused any content permission inherited by a page to be lost during the upgrade process to Confluence 2.9.

The following Confluence versions are vulnerable: Version **2.9**; specifically instances of Confluence that were **upgraded to version 2.9** (from an earlier version) only.

Risk Mitigation

This issue can be resolved by following the steps under **Fix**, or upgrading to Confluence 2.9.1. If this cannot be done immediately, it may be prudent to manually apply restrictions to each page that is normally protected by inherited restrictions (that is, all child pages residing under a restricted page). Enacting the fix is trivial and should take around ten minutes for a typical Confluence instance.

Vulnerability
If you had given a parent page restrictions prior to the 2.9 upgrade, then any child pages that should be inheriting these restrictions are no longer restricted. This potentially renders these child pages viewable and editable by Confluence users who should not have these rights. However you should note that any space level restrictions are still respected so these affected pages are only opened as far as the space level security allows for your site. Note for individual pages where you have manually set the permissions, those pages are not at risk — just the pages underneath them using inherited permissions.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

Alternatively, you can apply the manual fix, which involves a simple series of actions in the Confluence administration screens.

For more information see issue CONF-12911.

Access Vulnerability in View Wiki Markup Function

Severity

Atlassian rates this vulnerability as HIGH, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don't have the correct 'View Page' permission in a space to view the Wiki Markup source of the page content.

The following Confluence versions are vulnerable: Version 2.9 only.

Risk Mitigation

If a user knows the URL to view the source of a page they will be able to bypass Confluence's security checks. This will allow the user to view the contents of a page they aren't meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing this string: /pages/viewpagesrc.action. You may judge it necessary to disable public access.

Vulnerability

If a user knows the ID of a page that they do not have 'View Page' permission for they can use the view source URL to view the Wiki Markup of a page. This will allow them to copy and paste the contents of the page to another location, or simply read the markup and deduce its final content.

Note: the user will need to know the page ID of a page. Confluence will not provide any links to the restricted page through a search or other navigation.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

For more information see issue CONF-12845.

Access Vulnerability in Copy Page Function

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/SECURITY/Atlassian+Vulnerability+Severity+Definitions). The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don’t have the correct ‘View Page’ permission in a space to copy a page and therefore see its content.

The following Confluence versions are vulnerable: All versions from **1.0 to 2.9**.

Risk Mitigation

If a user knows the URL to copy a page they will be able to bypass Confluence’s security checks. This will allow the user to view the contents of a page they aren’t meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing this string: `/pages/copypage.action`. You may judge it necessary to disable public access.

Vulnerability

If a user knows the ID of a page they do not have permissions for, they can use the copy page URL to copy the page to a space where they do have permission. This will allow them to create a new page based on the content of a page they aren’t meant to see.

Fix

This issue has been fixed in Confluence 2.9.1 (see the [release notes](https://confluence.atlassian.com/display/SECURITY/Atlassian+Vulnerability+Severity+Definitions)), which you can download from the [download centre](https://confluence.atlassian.com/download-center).

Alternatively, you can download and install the patch for Confluence **2.7.3** or **2.8.2** from our JIRA site – see issue [CONF-12859](https://confluence.atlassian.com/download-center).

Instruction on installing the patch can be found [here](https://confluence.atlassian.com/download-center).

---

**Access Vulnerability in Diff Page Function**

Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/SECURITY/Atlassian+Vulnerability+Severity+Definitions). The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don’t have the correct ‘View Page’ permission in a space to create a diff of a page (a comparison of its contents with another page) and therefore see its content.

The following Confluence versions are vulnerable: All versions from **1.0 to 2.9**.

Risk Mitigation

If a user knows the URL to perform a diff of a page they will be able to bypass Confluence’s security checks. This will allow the user to view the contents of a page they aren’t meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing this string: `/pages/diffpages.action`. You may judge it necessary to disable public access.

Vulnerability
If a user knows the ID of a page they do not have permissions for, they can use the 'Diff Page' URL to compare the contents of that page with one where they do. This will allow them to deduce the contents of a page they don’t have access to.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.3 or 2.8.2 from our JIRA site – see issue CONF-12860.

Instruction on installing the patch can be found here.

Our thanks to Neeraj Jhanji from Atlassian Partner ImaHima, who reported the copy and diff page issues to Atlassian. We fully support the reporting of vulnerabilities and we appreciate it when people work with us towards identifying and solving a problem.

Confluence Security Advisory 2008-10-14

In this advisory:

- Parameter Injection Vulnerability in Confluence
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- XSS Vulnerability in Various Confluence Actions and Plugins
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- Privilege Escalation Vulnerability in Confluence Watches
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- Privilege Escalation Vulnerability in Confluence Favourites
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Parameter Injection Vulnerability in Confluence

Severity

Atlassian rates this vulnerability as critical, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a flaw which would allow a malicious user (hacker) to inject their own values into a
Confluence request by adding parameters to the URL string. This would allow a hacker to bypass Confluence's security checks and perform actions that they are not authorised to perform.

Risk Mitigation

To address the issue, you should upgrade Confluence as soon as possible or follow the patch instructions below. If you judge it necessary, you can block all untrusted IP addresses from accessing Confluence.

Vulnerability

A hacker can design a URL string containing parameters which perform specific actions on the Confluence server, bypassing Confluence’s security checks. This is because Confluence does not adequately sanitise user input before applying it as an action on the server.

Exploiting this issue could allow an attacker to access or modify data and compromise the Confluence application.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, a patch is available that will work with any affected version of Confluence. You can download and install the patch from our JIRA site. For more information, please refer to CONF-13092.

XSS Vulnerability in Various Confluence Actions and Plugins

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cisisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.
For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence Actions</th>
<th>Affected Confluence Versions</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>View children via the Pagetree plugin (bundled with Confluence)</td>
<td>2.8.0 to 2.9.1 inclusive</td>
<td>CONF-13043</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Update bookmark via the Social Bookmarking plugin (bundled with Confluence)</td>
<td>2.6.0 to 2.9.1 inclusive</td>
<td>CONF-13041</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Build RSS feed</td>
<td>2.0 to 2.9.1 inclusive</td>
<td>CONF-13042</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Search via Search macro</td>
<td>All versions from 1.0 to 2.9.1 inclusive</td>
<td>CONF-13040</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Search</td>
<td>All versions from 1.0 to 2.9.1 inclusive</td>
<td>CONF-12944</td>
<td></td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported most of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Privilege Escalation Vulnerability in Confluence Watches

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a flaw which would allow an unauthorised user to add a Confluence page to the list of pages they are watching, even if the user does not have permission to view that page. Under some circumstances, the unauthorised user may thus have access to information they are not authorised to see.

Risk Mitigation

This flaw does not allow the unauthorised user to update the page, but it may give the user access to information that they do not have permission to see.

Vulnerability

An unauthorised user can manipulate the HTTP request, so that it adds a watch to a page which the user does
not have permission to view. The page then appears in the user's list of watched pages, displaying the page title and the corresponding space name. In this way, the user can bypass Confluence's permission checks and gain access to information they are not authorised to see.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to CONF-13039.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported the vulnerability listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Privilege Escalation Vulnerability in Confluence Favourites

Severity

Atlassian rates this vulnerability as moderate, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a flaw which would allow an unauthorised user to add a Confluence page to their list of favourites, even if the user does not have permission to view that page. Under some circumstances, the unauthorised user may thus have access to information they are not authorised to see.

Risk Mitigation

This flaw does not allow the unauthorised user to update the page, and it gives the user only very limited access to the information they do not have permission to see.

Vulnerability

An unauthorised user can manipulate the HTTP request, so that it marks as 'favourite' a page which the user does not have permission to view. The page is then added to the number of favourites for the user. The user cannot see the page title or content, but can see that the favourite count has been incremented.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to CONF-13044.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported the vulnerability listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2008-12-03

In this advisory:
XSS Vulnerability in Various Confluence Actions

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

A hacker can inject their own JavaScript into various Confluence URLs — see the table below for the affected functional areas. A URL may be invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The URL can also be invoked by simply entering it into the browser address bar. If rogue JavaScript is injected into such a URL, the JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Affected Confluence Functionality</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
</table>

Users can View a List of All Attachments by Supplying an Edited URL

Severity

Risk Assessment

Risk Mitigation

Vulnerability

Fix
### Handling of error messages.
(Vulnerability in the DWR code library used by Confluence.)

<table>
<thead>
<tr>
<th></th>
<th>2.7.3 to 2.9.2 inclusive</th>
<th>2.9.2 and 2.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-11808</td>
<td></td>
<td>Bjoern Froebe</td>
</tr>
</tbody>
</table>

### Attachments macro.

<table>
<thead>
<tr>
<th></th>
<th>2.8 to 2.9.2 inclusive</th>
<th>2.8.2, 2.9.2 and 2.10**</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-13713</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Uploading of attachments.

<table>
<thead>
<tr>
<th></th>
<th>2.6 to 2.9.2 inclusive</th>
<th>2.8.2, 2.9.2 and 2.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-13717</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Inserting images as thumbnails.

<table>
<thead>
<tr>
<th></th>
<th>2.8 to 2.9.2 inclusive</th>
<th>2.8.2, 2.9.2 and 2.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-13625</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Log events listed in the Confluence 500 error page.

<table>
<thead>
<tr>
<th></th>
<th>2.9 to 2.9.2 inclusive</th>
<th>2.10 only</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-13584</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Wiki Markup link rendering.

<table>
<thead>
<tr>
<th></th>
<th>2.7 to 2.9.2 inclusive</th>
<th>2.7.x, 2.8.x, 2.9.x, 2.10</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-13451</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The patch for CONF-13713 also addresses the bug in CONF-13736.

** To fix this issue, please upgrade your Attachments plugin to the latest version. This plugin is available for Confluence 2.8.2, 2.9.2 and 2.10, via the Confluence Plugin Repository.

### Fix

These issues have been fixed in Confluence 2.10 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.10, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.8, you will need to upgrade to version 2.8.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Please note that one of the issues can only be fixed by upgrading to Confluence 2.10. Please see the table above for details.

---

Our thanks to **Bjoern Froebe**, who reported one of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

---

### Users can View a List of All Attachments by Supplying an Edited URL

#### Severity

Atlassian rates this vulnerability as medium, according to the scale published in [Confluence Security](https://confluence.atlassian.com/display/SECURITY/Confluence+Security). The scale allows us to rank a vulnerability as critical, high, moderate or low.

#### Risk Assessment

We have identified and fixed a security flaw which allows a user to view the list of all attachments for all pages in a Confluence instance, regardless of space-level or page-level permissions.
While the user cannot open the files, a range of metadata is available for viewing, including file name, the page that the file is attached to, the creator, and the creation and last-modified date of the attachment.

Risk Mitigation

If you judge it necessary, you can disable anonymous access to your wiki until you have applied the necessary patch or upgrade.

Vulnerability

If a user removes the space key from the URL while viewing attachments for a space, Confluence will display the full list of all attachments for all spaces. For more details, please refer to CONF-13874.

Fix

These issues have been fixed in Confluence 2.10 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.10, you can download and install the patches provided in the JIRA issue, CONF-13874. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.8, you will need to upgrade to version 2.8.2) and then apply the patch.

Our thanks to Matthew Goonan, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2009-01-07

In this advisory:

- Content Overwrite Vulnerability in the Office Connector Plugin
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Content Overwrite Vulnerability in the Office Connector Plugin

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified a risk that makes it possible for users with read-only access to a Confluence wiki space to modify its contents via the document import feature of the Office Connector plugin. This issue, however, does not expose restricted content on a Confluence wiki space to unauthorised users.

Risk Mitigation

Please see the ‘Fix’ section below. If you cannot apply the fix immediately, you can consider taking one or more of the following steps:

- Disable the whole Office Connector plugin, as explained here.
- If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade.
- For even tighter control, you could restrict access to trusted groups.
Vulnerability

The Office Connector plugin was first bundled in Confluence version 2.10.0. Hence, this vulnerability affects Confluence 2.10.0 where the Office Connector Plugin is enabled. Additionally, this plugin is compatible with all versions of Confluence from 2.3.0 onwards. Hence, if you have installed the plugin, this vulnerability will affect your Confluence instance.

Fix

Please download and install the latest version of the Office Connector plugin via the Confluence Plugin Repository (instructions here). If you wish to install this plugin manually, you can download it from here.

Alternatively, install or upgrade to Confluence version 2.10.1. (See the release notes.) The Confluence 2.10.1 installation files can be downloaded from the download centre.

For more information, please refer to CONF-14014.

Our thanks to Justin Wong, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2009-02-18

In this advisory:

- HTTP Header Injection Flaw
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

HTTP Header Injection Flaw

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

An Advanced Warning of this Security Advisory published last week stated the severity of this vulnerability as critical. After further assessing the likelihood of attack, however, we have amended this to high.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an HTTP header injection vulnerability in the Seraph web framework that is used by Confluence. This potentially allows a malicious user (attacker) to modify the HTTP response to insert malicious code. An attacker could present a modified URL to users (e.g. disguised in an email message). If any user clicks the URL, the malicious code would be executed in the user's session.

- The attacker may take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker could also gain control over the underlying system, based on the privileges of the user whose session cookie has been stolen.
- The attacker could redirect the user to undesirable web sites. This is potentially damaging to your company's reputation.

Atlassian recommends that you upgrade to Confluence 2.10.2 to fix the vulnerabilities described below.

Risk Mitigation
We strongly recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

Alternatively, you may consider taking the following step, although the time required to fix this vulnerability and the extent of its effectiveness will depend on your application server running Confluence and its configuration:

- Consult the vendor of your application server to see whether your application server is immune to header injection vulnerabilities or has configuration options to prevent such attacks. For example, the Coyote (HTTP) connector in Tomcat version 5.5 and later is immune to header injection attacks, as acknowledged in this reference.

  Technical note: In your application server, header injection vulnerabilities can be mitigated if the setHeader(), addHeader(), and sendRedirect() methods in the HttpServletResponse class have their parameters properly checked for header termination characters.

    You may wish to forward this technical note to the vendor of your application server to help them assess the vulnerability of your application server to header injection attacks.

Vulnerability

All versions of Confluence prior to 2.10.2 are vulnerable to this security flaw.

Fix

The fix updates the Seraph framework to a version which correctly encodes and validates redirect URLs before sending them back to the user.

To patch your existing installation of Confluence, please refer to CONF-14275. This JIRA issue contains the downloadable patch file and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.2. (See the release notes.) The Confluence 2.10.2 installation files can be downloaded from the download centre.

For more information, please refer to CONF-14275.

Confluence Security Advisory 2009-04-15

In this advisory:

- XSS Vulnerability in Various Confluence Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- HTTP Header Injection Flaw with Attachment Filenames
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Macros

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment
We have identified and fixed two security flaws which may affect Confluence instances in a public environment. These flaws are all cross-site scripting (XSS) vulnerabilities in Confluence's Index and Widget Macros. Each vulnerability potentially allows a malicious user (attacker) to embed their own JavaScript into a Confluence page, which will be executed when the page is rendered.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

Alternatively if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

You could also temporarily disable the Widget Connector plugin and the Index Macro module of the Confluence Advanced Macros plugin until you have applied the necessary patch or upgrade. Be aware, however, that this will cause any occurrence of these macros on existing pages or blogs in your Confluence site to render with 'Unknown Macro' indications.

Vulnerability

All versions of Confluence prior to 2.10.3 are vulnerable to this security flaw.

Fix

The fixes include an update to the Index Macro, such that it correctly renders content on the page and an update to the Widget Macro, such that it correctly encodes all parameters passed to it.

To patch your existing installation of Confluence, please refer to CONF-14753 for the Index Macro and CONF-14337 for the Widget Macro. These JIRA issues contain the downloadable patch files and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.3. (See the release notes.) The Confluence 2.10.3 installation files can be downloaded from the download centre.

For more information, please refer to CONF-14753 and CONF-14337.

Our thanks to Igor Minar, who reported one of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

HTTP Header Injection Flaw with Attachment Filenames

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw with attachment filenames. This vulnerability could lead to an HTTP Header Injection attack through the upload of attachments with modified filenames designed to exploit this flaw. An attacker could insert malicious code into the HTTP response, which would be executed in the user's session.
The attacker may take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.

The attacker could also gain control over the underlying system, based on the privileges of the user whose session cookie has been stolen.

The attacker could redirect the user to undesirable web sites. This is potentially damaging to your company's reputation.

Risk Mitigation

We strongly recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Alternatively, you may consider taking the following step, although the time required to fix this vulnerability and the extent of its effectiveness will depend on your application server running Confluence and its configuration:

- Consult the vendor of your application server to see whether your application server is immune to header injection vulnerabilities or has configuration options to prevent such attacks. For example, the Coyote (HTTP) connector in Tomcat version 5.5 and later is immune to header injection attacks, as acknowledged in this reference.

  Technical note: In your application server, header injection vulnerabilities can be mitigated if the setHeader(), addHeader(), and sendRedirect() methods in the HttpServletResponse class have their parameters properly checked for header termination characters.

You may wish to forward this technical note to the vendor of your application server to help them assess the vulnerability of your application server to header injection attacks.

Vulnerability

All versions of Confluence prior to 2.10.3 are vulnerable to this security flaw.

Fix

The fix includes a new header-injection prevention filter in Confluence, which ensures attachment filenames or any other user-provided data is correctly encoded before being included in HTTP headers.

To patch your existing installation of Confluence, please refer to CONF-14704. This JIRA issue contains the downloadable patch files and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.3. (See the release notes.) The Confluence 2.10.3 installation files can be downloaded from the download centre.

For more information, please refer to CONF-14704.

Confluence Security Advisory 2009-06-01

In this advisory:

- XSS Vulnerability in Various Confluence Actions and Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Actions and Macros

Severity
Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. These are cross-site scripting (XSS) that affect various Confluence page/blog features and functions.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

A hacker can inject their own JavaScript into various Confluence URLs — see the table below for the affected functional areas. A URL may be invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The URL can also be invoked by simply entering it into the browser address bar. If rogue JavaScript is injected into such a URL, the JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Affected Confluence Functionality</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent page edit message</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.9.2 and 2.10.3</td>
<td>CONF-15883</td>
</tr>
<tr>
<td>Gallery Macro (Confluence Advanced Macros Plugin)</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.10.3</td>
<td>CONF-15376</td>
</tr>
<tr>
<td>View File Macro (Office Connector Plugin)</td>
<td>2.10.0 to 2.10.3 inclusive *</td>
<td>2.10.3</td>
<td>CONF-15402</td>
</tr>
<tr>
<td>Instant Messenger Macro</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.8.2, 2.9.2 and 2.10.3</td>
<td>CONF-15397</td>
</tr>
<tr>
<td>Contributors Macro</td>
<td>2.3 to 2.10.3 inclusive</td>
<td>2.9.2 and 2.10.3</td>
<td>CONF-15399</td>
</tr>
<tr>
<td>JIRA Issues Macro</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.10.3</td>
<td>CONF-15754</td>
</tr>
</tbody>
</table>
* This vulnerability may be present in earlier Confluence versions with the Office Connector plugin installed.

**Fix**

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.9, you will need to upgrade to version 2.9.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

**Confluence Security Advisory 2009-06-16**

In this advisory:

- **Page Content Vulnerabilities**
  - **Severity**
  - **Risk Assessment**
  - **Risk Mitigation**
  - **Vulnerability**
  - **Fix**

---

**Page Content Vulnerabilities**

If you have already upgraded to Confluence 3.0, then you are not affected by the vulnerabilities described on this page and there is no need to take any further action.

**Severity**

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed two security vulnerabilities which may affect Confluence instances in a public environment. Both of these fixes are associated with a tightening of user access restrictions when either viewing specific page content or adding new page content.

The first of these vulnerabilities allows a user without permission to view a given page, to view the contents of any files attached to that page using the view file macro. This assumes that the user has permission to edit or create another page within the Confluence site and knows the name of the file attached to the page they cannot view. For more information, please refer to the JIRA issue CONF-15809.

The second of these vulnerabilities allows users with space administrator permissions to import pages to a Confluence space. The security level of this function has been tightened to permit only users with the system administration permission to access it. For more information, please refer to CONF-15267.

**Risk Mitigation**

If you have not already upgraded to Confluence 3.0, then we recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the ‘Fix’ section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.
All versions of Confluence up to and including version 2.10.3 with the Office Connector plugin installed are affected by the first view file macro vulnerability.

All versions of Confluence 2.10.x are affected by the second page imports vulnerability.

Fix

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.10.0, you will need to upgrade to version 2.10.3) and then apply the patches. For more information, please refer to the specific JIRA issues shown below.

To download the patch to fix the first view file macro vulnerability, please refer to CONF-15809.

To download the patch to fix the second page import vulnerability, please refer to CONF-15267.

Confluence Security Advisory 2009-08-20

In this advisory:

- Privilege Escalation Vulnerability in Profile Picture Handling
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- XSS Vulnerability in Various Page and Blog Post Features and Functions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Privilege Escalation Vulnerability in Profile Picture Handling

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified a privilege escalation vulnerability, which could provide an attacker with access to administrative areas and functions of Confluence when specifying a profile picture. Under some circumstances, the attacker could gain access to Confluence administrative functions that they are not authorised to use.

Risk Mitigation

To address the issue, you should upgrade to Confluence 3.0.1 as soon as possible or follow the patch instructions in the Fix section below. If you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or have performed the upgrade. For even tighter control, you could also restrict access to trusted groups or additionally, disable anonymous access until your system is patched or upgraded.

Vulnerability
The profile picture handling feature in all versions of Confluence up to 3.0.0 are affected by this issue. However, the Form Token Handling mechanism available in Confluence 3.0.0 and later means that the administrative areas in these versions of Confluence cannot be compromised by this vulnerability.

Fix

This issue has been fixed in Confluence 3.0.1 (see the release notes), which you can download from the download center.

If you do not wish to upgrade to Confluence 3.0.1 and you are running Confluence 2.10.x, you can download and install the patches provided on our JIRA site. We strongly recommend that you upgrade to the latest point release (2.10.3) before applying the patch. For more information, please refer to CONF-16141.

Our thanks to Elliot Kendall of Emory University, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSS Vulnerability in Various Page and Blog Post Features and Functions

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of XSS vulnerabilities in various Confluence page/blog features and functions, which may affect Confluence instances in a public environment.

XSS vulnerabilities potentially allow a malicious user (attacker) to embed their own JavaScript into a Confluence page.

- The attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.
<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicking a username link</td>
<td>3.0.0</td>
<td>3.0.0 and 3.0.1</td>
<td>CONF-15970</td>
</tr>
<tr>
<td>Moving pages between spaces</td>
<td>2.8 to 2.10.3 inclusive</td>
<td>2.10.x and 3.0.1</td>
<td>CONF-16019* CONF-16135*</td>
</tr>
<tr>
<td>Entering content into the WebDAV Configuration page</td>
<td>3.0.0 2.10.x with version 2.0 of the WebDAV plugin</td>
<td>2.10.x, 3.0.0 and 3.0.1</td>
<td>CONF-16136</td>
</tr>
<tr>
<td>Entering content into the PDF Export Stylesheet</td>
<td>3.0.0</td>
<td>3.0.0 and 3.0.1</td>
<td>CONF-16209</td>
</tr>
</tbody>
</table>

* Applying the patch for one of these issues fixes the other.

Fix

These issues have been fixed in Confluence 3.0.1 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.1, you can patch your existing installation by downloading and installing the patched files provided on our JIRA site. For the WebDAV plugin vulnerability, this would involve upgrading the version of the plugin. We strongly recommend that you upgrade to the latest point release of the major version of Confluence that you are running before applying the patches. For example, if you are running Confluence 2.10.1, you should upgrade to version 2.10.3 and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Confluence Security Advisory 2009-10-06

In this advisory:

- Session Fixation Vulnerability
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- XSS Vulnerability in Various Confluence Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Session Fixation Vulnerability

Severity

Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security vulnerability which may affect Confluence instances in a public
environment. This vulnerability could lead to a session fixation attack, in which the malicious user (attacker) can gain access to a victim’s Confluence resources whilst the victim is logged in to their Confluence user account.

The attacker does this by fixating (or setting) their session ID onto the victim's computer. While the victim is logged in, all the victim's privileges are associated with the attacker's session ID, effectively granting the attacker access to all of the Confluence data and resources accessible to the victim.

For more information about session fixation attacks, please refer to the following sources:

- Chris Shiflett's Security Corner article
- The Web Application Security Consortium’s overview

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the ‘Fix’ section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

All versions of Confluence prior to 3.0.2 are vulnerable to this security issue.

Fix

These issues have been fixed in Confluence 3.0.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.2 and you are currently running Confluence version 2.10.x or 3.0.x, you can patch your existing installation by downloading the appropriate patch file attached to JIRA issue CONF-15108 and installing the patch file using the instructions provided in this JIRA issue.

Our thanks to Ben L Broussard who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSS Vulnerability in Various Confluence Macros

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities in Confluence’s pagetree, userlister and content by label macros. These XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page.

- The attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation
We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pagetree Macro</td>
<td>2.8.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-16651</td>
</tr>
<tr>
<td>Userlister Macro</td>
<td>2.6.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-16644</td>
</tr>
<tr>
<td>Content by Label Macro</td>
<td>2.10.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-15440</td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 3.0.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.2, you can patch your existing installation by upgrading the plugins for these macros via the Confluence Plugin Repository to the version indicated in the JIRA issues listed in the vulnerability section (above).

Confluence Security Advisory 2009-12-08

In this advisory:

- XSS Vulnerability in Various Confluence Actions and Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Actions and Macros

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities that could occur when creating a
page or blog post in a personal space, using the `indexbrowser.jsp` form and when using the `gallery macro`.

- The attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to the attacker’s own web server.
- The attacker’s text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at [cquisecurity](https://cquisecurity.com), [CERT](https://www.cert.org) and other places on the web.

**Risk Mitigation**

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the ‘Fix’ section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

**Vulnerability**

An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page or blog post creation in a personal space</td>
<td>2.10 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17031</td>
</tr>
<tr>
<td>Using the <code>indexbrowser.jsp</code> form</td>
<td>All versions prior to and including 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17165</td>
</tr>
<tr>
<td>Gallery macro</td>
<td>2.9 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17361</td>
</tr>
<tr>
<td>Page tree and page tree search macros</td>
<td>2.9 – 3.0.2</td>
<td>2.8 – 3.1 inclusive</td>
<td>CONF-17967</td>
</tr>
<tr>
<td>Status updates tab of the user profile area</td>
<td>3.0.0 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17933</td>
</tr>
</tbody>
</table>

**Fix**

These issues have been fixed in Confluence 3.1 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.1, you can patch your existing installation by upgrading the plugins for these macros via the Confluence Plugin Repository to the version indicated in the JIRA issues listed in the vulnerability section (above).

**Confluence Security Advisory 2010-05-04**
This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.2.1. In addition to releasing Confluence 3.2.1, we also provide patches for the most important vulnerabilities mentioned. You will be able to apply these patches to older versions of Confluence. There will, however, be a number of security improvements in Confluence 3.2.1 that cannot be patched or backported. We recommend upgrading to Confluence 3.2.1 rather than applying the patches.

In this advisory:

- **XSS Vulnerabilities**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**
    - Changed behaviour in Confluence

- **XSS Vulnerability in Database Check Utility (Not Bundled with Confluence)**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**

- **Unnecessary Exposure of and Access to Information**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**
    - Changed Behaviour in Confluence

- **General Tightening of the Confluence Security Model**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**
    - Changed Behaviour in Confluence

- **Available Patches and Plugin Upgrades**
  - **Step 1 of the Patch Procedure: Install the Patches**
    - Applying the patch
  - **Step 2 of the Patch Procedure: Upgrade your Plugins**
  - **Step 3 of the Patch Procedure: Remove the Database Check Utility if Previously Installed**

**XSS Vulnerabilities**

**Severity**

Atlassian rates these vulnerabilities as **high**, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities exposed in the Confluence functions described in the table below.

- An attacker might take advantage of the vulnerability to steal other users' session cookies or other...
credentials, by sending the credentials back to such an attacker's own web server.

- An attacker’s text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at cisisecurity, CERT and other places on the web.

**Vulnerability**

We identified and fixed vulnerabilities in the Confluence features described in the table below.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index browser JSP (JavaServer Page)</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19404</td>
<td>High</td>
</tr>
<tr>
<td>A JSP that provides an administrator with the location on the file system where the attachments for a given space are stored</td>
<td>2.8.3 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19404</td>
<td>High</td>
</tr>
<tr>
<td>A JSP that allows and administrator to reset null emails addresses to <a href="mailto:dummyvalue@nowhere.org">dummyvalue@nowhere.org</a></td>
<td>2.8.3 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19404</td>
<td>High</td>
</tr>
<tr>
<td>Colour scheme settings</td>
<td>3.1.2 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19384</td>
<td>High</td>
</tr>
<tr>
<td>Error messages</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19390 and CONF-19402</td>
<td>High</td>
</tr>
<tr>
<td>Searching Confluence</td>
<td>2.7.4 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19382</td>
<td>High</td>
</tr>
<tr>
<td>Attachment upload</td>
<td>3.0.2 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19388</td>
<td>High</td>
</tr>
<tr>
<td>Content rendering</td>
<td>3.0.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19441</td>
<td>High</td>
</tr>
<tr>
<td>Advanced Macros plugin</td>
<td>3.1.0 – 3.2.0</td>
<td>3.2.1 and plugin upgrade</td>
<td>CONF-19403</td>
<td>High</td>
</tr>
<tr>
<td>Social Bookmarking plugin</td>
<td>3.0.0 – 3.2.0</td>
<td>3.2.1 and plugin upgrade</td>
<td>CONF-19381</td>
<td>High</td>
</tr>
</tbody>
</table>

**Risk Mitigation**
We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade or patch immediately and you judge it necessary, you can disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

**Fix**

Confluence 3.2.1 fixes all of these issues. See the release notes. You can download Confluence 3.2.1 from the download centre.

If you cannot upgrade to Confluence 3.2.1, you can patch your existing installation using the patches and plugin upgrades listed below. We strongly recommend upgrading to 3.2.1 however, since it adds even more security features than the patches.

**Changed behaviour in Confluence**

We have removed the indexbrowser.jsp and the viewdocument.jsp pages that used to provide access to the Confluence index browser. Instead, if you need to see more details of the indexed pages in your Confluence site, you can download and run Luke. Luke is a development and diagnostic tool that accesses existing Lucene indexes and allows you to display and modify their content in several ways. See our document on content index administration.

Our thanks to Brett Porter of The Apache Software Foundation and to David Belcher of Research in Motion, who reported some of the vulnerabilities mentioned above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

**XSS Vulnerability in Database Check Utility (Not Bundled with Confluence)**

**Severity**

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security.

**Risk Assessment**

We have identified and fixed a cross-site scripting (XSS) vulnerability in the Atlassian database check utility that some customers may have installed. The utility is a JSP file, supplied as an attachment to a documentation page.

Note that this utility is not bundled with Confluence. This vulnerability applies to you only if you have downloaded and installed the JSP.

**Vulnerability**

An attacker can inject their own JavaScript when invoking the database check utility. The rogue JavaScript will be executed when a user invokes the URL. For more details, please refer to CONF-19406.

**Risk Mitigation**

If you have previously downloaded and installed the testdatabase.jsp utility from the documentation page, you should now remove the testdatabase.jsp file from your <confluence-install>\confluence directory.

When you need to use the utility again, you can download the updated version from the same documentation.
Fix

If you have previously downloaded and installed the `testdatabase.jsp` utility from the [documentation page](#), you should now remove the `testdatabase.jsp` file from your `<confluence-install>` directory.

When you need to use the utility again, you can download the updated version from the same documentation page.

⚠️ This fix is not part of Confluence 3.2.1

Because the JSP file is not shipped with the Confluence installation, there is no patch for this vulnerability and there is no fix for it in Confluence 3.2.1. Please check your installation and remove or update the JSP if present.

Unnecessary Exposure of and Access to Information

**Severity**

Atlassian rates these vulnerabilities as **high** and **moderate**, according to the scale published in [Confluence Security](#).

**Risk Assessment**

We have identified a number of areas where Confluence exposes an unnecessary amount of information that may be useful to an attacker if such an attacker gained access to the information.

**Vulnerability**

We have identified a number of areas where Confluence exposes an unnecessary amount of information, including sensitive information such as usernames and passwords. If an attacker gains access to such information, it may allow such an attacker to gain access to administrative areas and functions of Confluence that they are not authorised to use. Details of each vulnerability are in the table below.

For more details please refer to the related JIRA issues, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).
<table>
<thead>
<tr>
<th>Feature</th>
<th>Version</th>
<th>Constraints</th>
<th>Description</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support request form</td>
<td>3.1.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The Confluence support request form automatically generates a zip file containing system information and log files, and submits the file to a given email address along with the support request. The zip file includes configuration files containing usernames, passwords and license details. See <a href="CONF-19391">CONF-19391</a></td>
<td>High</td>
</tr>
<tr>
<td>Support request form</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The Confluence support request form offers a 'CC' email address, allowing the support request and all attached information to be sent to any email address. In addition, it is also possible to set the default email address to any email address, via the Confluence Administration Console. See <a href="CONF-19392">CONF-19392</a></td>
<td>High</td>
</tr>
<tr>
<td>XML site backup</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>It is possible to download an XML backup of the Confluence site from the Confluence Administration Console. See <a href="CONF-19393">CONF-19393</a></td>
<td>High</td>
</tr>
<tr>
<td>Daily site backup</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The path to the daily site backup is configurable via the Confluence Administration Console. It is possible to set the daily backup path and (partial) name through the web UI. This allows an attacker to put the backup in a location that is served by the application server. See CONF-19397</td>
<td>Moderate</td>
</tr>
<tr>
<td>SOAP and XML-RPC APIs</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The SOAP and XML-RPC APIs give too much information when returning an error about an incorrect login. See CONF-19398</td>
<td>High</td>
</tr>
<tr>
<td>Information about Confluence administrators</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The list of Confluence administrators is accessible via a URL and shows the username, full name and email address of all administrators. See CONF-19395</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade or patch immediately, consider applying these measures:

- Control the access to your administrator accounts, as described in our document on [best practices for configuring Confluence security](#).
- Disable access to the SOAP and XML-RPC APIs, if these remote APIs are not required. (Remote API access is disabled by default.) See the page about [enabling remote APIs](#).
- Manually remove the list of Confluence administrators that is accessible via a URL, by editing the relevant Velocity template file as follows:
  1. Edit the `administrators.vm` file, located in `{confluence-install}/confluence` for standalone installations, or at the root of the web app for WAR installations.
  2. Replace the content with a message that you would like to be displayed whenever someone accesses this URL. For example:
<html>
<head>
    <title>$action.getText("title.administrators")</title>
</head>
<body>
    The list of Confluence administrators is no longer available. If you would like to contact an administrator, please email admins at example dot com.
</body>
</html>

3. Save the file. (There is no need to restart Confluence.)

**Fix**

Confluence 3.2.1 fixes these issues. See the release notes. You can download Confluence 3.2.1 from the download centre.

**Changed Behaviour in Confluence**

In order to fix these problems, we have changed Confluence's behaviour as follows:

- We have removed all license, username and password information from the zip file generated by the Confluence support request form.
- It is no longer possible to specify a 'CC' email address on the Confluence support request form.
- By default, it is no longer possible to specify a site support email address in the 'General Configuration' section of the Confluence Administration Console. Administrators can restore this functionality by updating the confluence.cfg.xml file found in the Confluence Home Directory. Confluence now recognises a new property in this configuration file, called admin.ui.allow.site.support.email. If the value of the property is 'true', it will be possible to specify a site support email address via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the file, the email address is not configurable. By default in Confluence 3.2.1 and later, the value is 'false'.
- By default, the path to the daily site backup is no longer configurable via the Confluence Administration Console. Confluence now recognises a new property called admin.ui.allow.daily.backup.custom.location in the confluence.cfg.xml file. If the value of this property is 'true', the administrator can change the daily backup path. If the value of this property is 'false' or the property is not present in the file, the backup path is not configurable. By default in Confluence 3.2.1 and later, the value is 'false'.
- By default, it is no longer possible to download an XML backup of the Confluence site from the Confluence Administration Console. Instead, you need access to the Confluence server machine in order to retrieve the XML site backup file. Confluence now recognises a new property called admin.ui.allow.manual.backup.download in the confluence.cfg.xml file. If the value of this property is 'true', the Administration Console provides an option to download the XML site backup file. If the value of this property is 'false' or the property is not present in the file, the XML download is not available from the Administration Console. By default in Confluence 3.2.1 and later, the value is 'false'.
- On invalid login attempts, the SOAP and XML-RPC APIs no longer give away the specific information that the user does not exist or that the password is invalid.
- The administrators.action URL no longer opens a page showing the list of Confluence administrators. Instead, the URL will now present a form which you can use to email all the administrators of the site. This is preferable since it does not give the user any information about who these administrators are. See our documentation on configuring the administrator contact page.

**General Tightening of the Confluence Security Model**

**Severity**
Atlassian rates these vulnerabilities as **high** and **moderate**, according to the scale published in [Confluence Security](#).

**Risk Assessment**

We have improved the security of the following areas in Confluence:

- Prevention of brute force attacks by imposing a maximum number of repeated login attempts.
- Handling of decorator layouts.

**Vulnerability**

We have identified and fixed a problem where Confluence allows an unlimited number of repeated login attempts, potentially opening Confluence to a brute force attack. We have also improved the security around the handling of decorator layouts. Details of each improvement are in the table below.

For more details please refer to the related JIRA issues, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site and space decorator layouts</td>
<td>All versions up to and including 3.2.0</td>
<td>3.2.1 and patch</td>
<td>The BootstrapManager exposed in site and space layout templates should be read only. See <a href="#">CONF-19401</a></td>
<td>High</td>
</tr>
<tr>
<td>Login</td>
<td>All versions up to and including 3.2.0</td>
<td>3.2.1 only</td>
<td>Confluence does not set a maximum to the number of repeated login attempts. This makes Confluence vulnerable to a brute force attack. See <a href="#">CONF-19396</a></td>
<td>Moderate</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade immediately, you can patch your existing installation using the patches listed below. The patch will fix the problem with the decorator layouts.

You can prevent brute force attacks by following our guidelines on using [Fail2Ban to limit login attempts](#).

**Fix**

Confluence 3.2.1 fixes these issues. See the [release notes](#). You can download Confluence 3.2.1 from the [download centre](#).

Alternatively, if you are not in a position to upgrade immediately, you can patch your existing installation using...
the patches listed below. The patch will fix the problem with the decorator layouts.

**Changed Behaviour in Confluence**

In order to fix these problems, we have changed Confluence's behaviour as follows:

- We have improved the security in the way Confluence handles decorator layouts. The BootstrapManager is now read only.
- After three failed login attempts, Confluence will display a Captcha form asking the user to enter a given word when attempting to log in again. This will prevent brute force attacks via the login screen. In addition, after three failed login attempts via the XML-RPC or SOAP API, an error message will be returned instructing the user to log in via the web interface. Captcha will automatically be activated when they attempt this login.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.2.1, you can apply the following patches and plugin upgrades to fix the most pressing vulnerabilities described in this security advisory.

**Step 1 of the Patch Procedure: Install the Patches**

Patches are available for Confluence 3.2.0, 3.1.2, 3.0.2, 2.10.4, 2.9.3 and 2.8.3. You need to upgrade to the specified bug-fix release of the relevant major version before applying the patches. For example, if your version is Confluence 3.0.0, first upgrade to 3.0.2 and then apply the relevant patch.

The available patches address the following issues:

- XSS in search (CONF-19382).
- XSS in attachment upload (CONF-19388).
- XSS in the index browser JSP (CONF-19404).
- XSS in the JSP that provides an administrator with the location on the file system where the attachments for a given space are stored (CONF-19404).
- XSS in the JSP that allows an administrator to reset null emails addresses (CONF-19404).
- XSS in colour scheme settings (CONF-19384).
- XSS in error messages (CONF-19390 and CONF-19402).
- XSS in content rendering (CONF-19441).
- Secure handling of site and space decorator layouts (CONF-19401).

Each patch covers all of the above issues, and is applicable to the specific version of Confluence. To install the patch, download the appropriate version and follow the instructions below.

<table>
<thead>
<tr>
<th>Your Confluence Version</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.0</td>
<td>confluence-project-3.2.0-stable.zip</td>
</tr>
<tr>
<td>3.1.2</td>
<td>confluence-project-3.1-stable.zip</td>
</tr>
<tr>
<td>3.0.2</td>
<td>confluence-project-3.0-stable.zip</td>
</tr>
<tr>
<td>2.10.4</td>
<td>confluence-project-2.10-stable.zip</td>
</tr>
<tr>
<td>2.9.3</td>
<td>confluence-project-2.9-stable.zip</td>
</tr>
<tr>
<td>2.8.3</td>
<td>confluence-project-2.8-stable.zip</td>
</tr>
</tbody>
</table>

**Applying the patch**
If you are using the Standalone distribution of Confluence:

1. Make a backup of the <confluence_install_dir>/confluence/ directory.
2. Download the confluence-x-patch.zip file from the location given in the table above, for your version of Confluence.
3. Expand the zip file into <confluence_install_dir>/confluence/, overwriting the existing files in that location.
4. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Make a backup of the <confluence_exploded_war>/confluence/ directory.
2. Download the confluence-x-patch.zip file from the location given in the table above, for your version of Confluence.
3. Expand the zip file into <confluence_exploded_war>/confluence/, overwriting the existing files in that location.
4. Run 'build.sh clean' on UNIX, or 'build.bat clean' on Windows.
5. Run 'build.sh' on UNIX or 'build.bat' on Windows.
6. Redeploy the Confluence web app into your application server.

Step 2 of the Patch Procedure: Upgrade your Plugins

Two of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to upgrade the affected plugin to get the fixed version. You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository. Please refer to the documentation for more details on installing plugins.

1. If you are running Confluence 3.1.0 or later, you will need to install the latest version of the Confluence Advanced Macros plugin. Earlier versions of Confluence are not affected and therefore do not need an upgraded plugin.
2. If you are running Confluence 3.0.0 or later, you will need to install the latest version of the Social Bookmarking plugin. Earlier versions of Confluence are not affected and therefore do not need an upgraded plugin.

Step 3 of the Patch Procedure: Remove the Database Check Utility if Previously Installed

If you have previously downloaded and installed the testdatabase.jsp utility from the documentation page, you should now remove the testdatabase.jsp file from your <confluence-install>\confluence directory. See above for more details of this utility.

Confluence Security Advisory 2010-06-02

This security advisory announces a vulnerability in the Confluence Mail Page plugin that may expose a Confluence site to XSS (cross-site scripting) attacks, if it is enabled (note, the Confluence Mail Page plugin is disabled by default). If you do not have this plugin enabled, your site will not be affected. However, we recommend that you still read the advisory below.

In this advisory:

- XSS Vulnerability in Confluence Mail Page Plugin
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

XSS Vulnerability in Confluence Mail Page Plugin
Severity

Atlassian rates this vulnerability as **high**, according to the scale published in [Severity Levels for Security Issues](https://confluence.org/security). The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security vulnerability which may affect Confluence instances in a public environment. This flaw is a cross-site scripting (XSS) vulnerability that could occur if you have the Confluence Mail Page plugin enabled. The Confluence Mail Page plugin is bundled with Confluence, although it is disabled by default.

- The attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to the attacker’s own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at [cguide](http://www.cguide.com) and other places on the web.

Vulnerability

An attacker can execute their own JavaScript when a user enters a custom URL into the browser address bar (e.g. the user clicks a crafted link in an email). The rogue JavaScript will be executed when the user invokes the URL. For more details, please refer to [CONF-19802](http://www.conf-19802.com).

Risk Mitigation

We recommend installing the updated Confluence Mail Page plugin into your Confluence installation to fix this vulnerabilities. Please see the 'Fix' section **below**.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable the Confluence Mail Page plugin (note, the plugin is disabled by default). You may also wish to disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Fix

These issues have been fixed in the latest version (v1.10) of the Confluence Mail Page plugin, which you can download from the [Atlassian Plugin Exchange](http://www.pluginexchange.com). Installation instructions are available on the [plugin documentation page](http://www.plugindocumentation.com).

Please note, version 1.10 of the Confluence Mail Page plugin will only work with Confluence 3.2. You will need to upgrade to Confluence 3.2 before installing the updated plugin.

Confluence Security Advisory 2010-07-06

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in [Confluence 3.3](http://www.confluence.org). In addition to releasing Confluence 3.3, we also provide patches (in the form of plugin upgrades) for the vulnerabilities mentioned. You will be able to apply these plugin upgrades to older versions of Confluence. There will, however, be a number of security improvements in Confluence 3.3 that cannot be patched or backported. We recommend upgrading to Confluence 3.3 rather than applying the plugin upgrades.

In this advisory:

- XSS Vulnerabilities
- Severity
- Risk Assessment
• Vulnerability
• Risk Mitigation
• Fix
  • Option 1 (Recommended): Upgrade to Confluence 3.3
  • Option 2: Upgrade or Disable the Affected Plugins

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of these vulnerabilities as high, according to the scale published in [Severity Levels for Security Issues](#). The scale allows us to rank the severity as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances in a public environment. These vulnerabilities are exposed in the Confluence functions described in the table below.

- An attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker’s text and script might be displayed to other people viewing the page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at [cisisecurity](#), [CERT](#) and other places on the web.

**Vulnerability**

We have identified and fixed vulnerabilities in the Confluence features described in the table below.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF export</td>
<td>3.1.0 – 3.2.1</td>
<td>CONF-20121</td>
</tr>
<tr>
<td>Clickr theme</td>
<td>2.7.0 – 3.2.1</td>
<td>CONF-20126</td>
</tr>
<tr>
<td>Tasklist macro</td>
<td>2.8.0 – 3.2.1</td>
<td>CONF-20119</td>
</tr>
<tr>
<td>Contributors plugin (Contributors macro and Contributors Summary macro)</td>
<td>3.0.0 – 3.2.1</td>
<td>CONF-20122 CONF-20125</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can apply one or both of the following mitigations:

- Disable every one of the affected plugins, as listed below. You can disable plugins via the Confluence Administration Console. See our documentation on [installing and configuring plugins](#).
- Disable public access (such as [anonymous access](#) and [public signup](#)) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted [groups](#).
In addition, please refer to our guidelines on best practices for configuring Confluence security. In particular, please read our guidelines on using Apache to limit access to the Confluence administration interface.

**Fix**

Please choose one of the options below that best suits your Confluence version and your ability to upgrade immediately.

**Option 1 (Recommended): Upgrade to Confluence 3.3**

We recommend that you upgrade to Confluence 3.3, which fixes all of the security issues reported in this advisory. See the Confluence 3.3 release notes. You can download Confluence 3.3 from the download centre.

**Option 2: Upgrade or Disable the Affected Plugins**

If you cannot upgrade your Confluence installation, you can upgrade or disable the affected plugins to fix the vulnerabilities described in this security advisory.

- You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository or by manually uploading the JAR. Please refer to the documentation for more details on installing plugins.
- You can disable plugins via the Confluence Administration Console. See our documentation on installing and configuring plugins.

<table>
<thead>
<tr>
<th>Affected Feature</th>
<th>Confluence Versions that Can Update the Plugin</th>
<th>Upgrade or Disable Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF export plugin</td>
<td>3.1 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ If you are running Confluence 3.1.x or 3.2.x, you should install version 1.9 of the PDF Export plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ If you are running Confluence 3.0.2 or earlier, you do not need to take any action as these versions are not affected by the security flaw.</td>
</tr>
<tr>
<td>Clickr theme</td>
<td>3.2 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ If you are running Confluence 3.2.x, you should install version 2.10 of the Clickr Theme plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>▶ If you are running Confluence 3.1.2 or earlier, you should disable the 'Clickr Theme' plugin.</td>
</tr>
</tbody>
</table>
Tasklist macro

<table>
<thead>
<tr>
<th>3.1 – 3.3</th>
</tr>
</thead>
</table>

If you cannot upgrade to Confluence 3.3:

- If you are running Confluence 3.1.x or 3.2.x, you should install version 3.2.5.2 of the Dynamic Task List 2 plugin.
- If you are running Confluence 2.8.x to 3.0.x, you should disable the 'Dynamic Task List 2' plugin.
- If you are running Confluence 2.7.x or earlier, you do not need to take any action as these versions are not affected by the security flaw.

Contributors plugin

<table>
<thead>
<tr>
<th>3.0 – 3.3</th>
</tr>
</thead>
</table>

If you cannot upgrade to Confluence 3.3:

- If you are running Confluence 3.0.x to 3.2.x, you should install version 1.2.6 of the Contributors plugin.
- If you are running Confluence 2.10.4 or earlier, you do not need to take any action as these versions are not affected by the security flaw.

Confluence Security Advisory 2010-08-17

This advisory announces a security vulnerability in Confluence 3.3 that we have found and fixed in Confluence 3.3.1. We recommend that you upgrade to Confluence 3.3.1 to fix this vulnerability.

In this advisory:

- Secure Administrator Session Vulnerability
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

Secure Administrator Session Vulnerability

Severity

Atlassian rates this vulnerability as **high**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a vulnerability in the Secure Administrator Sessions feature, introduced in Confluence 3.3, that allows it to be bypassed.

Vulnerability
If an attacker is able to gain access to a session with administrator privileges, they will be able to access all administrator functions without having to re-authenticate.

This vulnerability exists in Confluence 3.3 only.

See CONF-20508 for more details.

Risk Mitigation

We recommend upgrading your Confluence installation to fix these vulnerabilities. Please see the ‘fix’ section below.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary upgrade. For even tighter control, you could restrict access to trusted groups.

Fix

Confluence 3.3.1 fixes this issue. See the release notes. You can download Confluence 3.3.1 from the download centre.

Confluence Security Advisory 2010-09-21

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.3.3. We recommend that you upgrade to Confluence 3.3.3 to fix these vulnerabilities.

In this advisory:

- Path Traversal Vulnerability in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

- Configuration of Office Connector Temporary Storage Location
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

- XSS Vulnerability in the Office Connector
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

- XSRF Vulnerability in Confluence Mail Page Plugin
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

- Available Patches and Plugin Upgrades
  - Step 1 of the Patch Procedure: Install the Patch
Applying the patch

- Step 2 of the Patch Procedure: Upgrade your Plugins

Path Traversal Vulnerability in Various Confluence Actions

**Severity**

Atlassian rates this vulnerability as **critical**, according to the scale published in [Severity Levels for Security Issues](https://confluence.atlassian.com/doc/levels-of-security). The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a path traversal vulnerability in various Confluence actions. By exploiting a path traversal vulnerability, attackers may be able to retrieve any file on the server that is running Confluence, based on the permissions of the user under which Confluence is running. Path traversal attacks are also called 'directory traversal' or 'dot-dot-slash' (../) attacks.

The degree to which a Confluence instance is vulnerable depends on a number of factors in the implementation of the instance. See the mitigation strategies below, for details of how you can reduce your vulnerability.

You can read more about path traversal attacks at [Open Web Application Security Project](https://owasp.org) and other places on the web.

**Vulnerability**

The path traversal vulnerability exists in various Confluence actions, in **all versions of Confluence up to and including 3.3.1**.

See [CONF-20668](https://confluence.atlassian.com/doc/CONF-20668) for issue tracking.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately, please consider the following mitigation strategies:

- Make sure that you do not start Confluence from the root directory when starting Confluence automatically. Instead, start it from a reduced-scope directory such as the *{Confluence-installation}/bin* directory.
- Upgrade your Tomcat version to 6.0.26 or later. This is relevant if you are using a WAR distribution of Confluence in your own Tomcat server.
- If you are running Confluence under UNIX, you should run Confluence inside a chroot jail. See [Best Practices for UNIX chroot() Operations](https://confluence.atlassian.com/doc/Best-Practices-for-UNIX-chroot-Operations) from Steve Friedl.
- In addition, please refer to our guidelines on [Tomcat security best practices](https://confluence.atlassian.com/doc/Tomcat-security-best-practices). (This is a JIRA document but the principles apply to Confluence.) In particular, you should restrict the file access of the username under which Confluence is running.

**Fix**

Confluence 3.3.3 fixes this issue. See the [release notes](https://confluence.atlassian.com/doc/release-notes). You can download Confluence 3.3.3 from the [download centre](https://confluence.atlassian.com/doc/download-centre).

If you cannot upgrade to Confluence 3.3.3, you can patch your existing installation using the patches listed below.

---

Our thanks to [Warren Leung](https://confluence.atlassian.com/doc/Warren-Leung) of UCLA, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.
Configuration of Office Connector Temporary Storage Location

Severity

Atlassian rates this vulnerability as **high**, according to the scale published in [Severity Levels for Security Issues](#).

Risk Assessment

Earlier versions of Confluence allow the administrator to set the temporary storage location for the View File **macro**, part of the Office Connector. Provided an attacker has gained administrative access to the system in some way, they could then exploit this vulnerability to save malicious files onto the file system.

Vulnerability

This vulnerability exists in the Office Connector configuration, made available to Confluence administrators via the Confluence Administration Console and the related Confluence action.

This vulnerability affects **versions of Confluence from 2.8 up to and including 3.3.1**, where the Office Connector is installed. Please note that the Office Connector is bundled in Confluence 2.10 and later.

See [CONF-20669](#) for issue tracking.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can choose one of the following mitigation strategies:

- Disable the Office Connector plugin. You can disable plugins via the Confluence Administration Console. See our documentation on [installing and configuring plugins](#).
- Disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary upgrade. For even tighter control, you could restrict access to trusted groups.

In addition, please refer to our guidelines on [best practices for configuring Confluence security](#).

Fix

Confluence 3.3.3 fixes this issue. Administrators must edit a properties file to configure the path. See the release notes for more information. You can download Confluence 3.3.3 from the [download centre](#).

If you cannot upgrade to Confluence 3.3.3, you can patch your existing installation using the patches listed below.

XSS Vulnerability in the Office Connector

Severity

Atlassian rates the severity level of this vulnerability as **high**, according to the scale published in [Severity Levels for Security Issues](#).

Risk Assessment

We have identified and fixed a cross-site scripting (XSS) vulnerability which may affect Confluence instances, including publicly available instances.

- An attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker's text and script might be displayed to other people viewing the page. This is potentially
damaging to your company’s reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Vulnerability

The XSS vulnerability is exposed in the document import function of the Confluence Office Connector.

This vulnerability exists in Confluence 3.3.1 only, where the Office Connector is enabled. Please note that the Office Connector is bundled in Confluence.

See CONF-20670 for issue tracking.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable the Office Connector plugin. You can disable plugins via the Confluence Administration Console. See our documentation on installing and configuring plugins.

In addition, please refer to our guidelines on best practices for configuring Confluence security. In particular, please read our guidelines on using Apache to limit access to the Confluence administration interface.

Fix

Confluence 3.3.3 fixes this issue. See the release notes. You can download Confluence 3.3.3 from the download centre.

XSRF Vulnerability in Confluence Mail Page Plugin

Severity

Atlassian rates the severity level of this vulnerability as high, according to the scale published in Severity Levels for Security Issues.

Risk Assessment

We have identified and fixed a cross-site request forgery (XSRF) vulnerability which may affect Confluence instances, including publicly available instances.

An attacker might take advantage of the vulnerability to trick users into emailing the contents of restricted pages to an arbitrary address without their knowledge. An XSRF attack works by exploiting the trust that a site has for the user. If a user is logged in to Confluence and an attacker tricks their browser into making a request to a Confluence URL, then the task is performed as the logged in user.

You can read more about XSRF attacks at cgisecurity and other places on the web.

Vulnerability

The XSRF vulnerability is exposed in the Confluence Mail Page plugin.

This vulnerability exists in versions of Confluence from 2.4 up to and including 3.3.1, where the Mail Page plugin is enabled. Note that the Mail Page plugin is disabled by default. If you do not have this plugin enabled, your site will not be affected.

See CONF-20671 for issue tracking.

Risk Mitigation
We recommend that you upgrade your Confluence installation, or install the updated Confluence Mail Page plugin into your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable the Confluence Mail Page plugin. (Note that the plugin is disabled by default).

**Fix**

Confluence 3.3.3 fixes this issue. See the release notes. You can download Confluence 3.3.3 from the download centre.

The latest version (v1.12) of the Confluence Mail Page plugin also fixes this issue. You can download the plugin from the Atlassian Plugin Exchange. Please refer to the documentation for instructions on installing plugins.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.3.3, you can apply the following patches and plugin upgrades to fix the vulnerabilities described in this security advisory.

**Step 1 of the Patch Procedure: Install the Patch**

A patch is available for Confluence 3.2.1. (That is, the Confluence 3.2.1_01 distribution.) If you have Confluence 3.2.0, you need to upgrade to Confluence 3.2.1 before applying the patch.

The patch addresses the following issue:

- Path traversal vulnerability (CONF-20668).

**Applying the patch**

If you are using the Confluence 3.2.1 distribution:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.2.1-to-3.3.2-security-patch.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.2.1-to-3.3.2-security-patch.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
6. Run `build.sh` on UNIX or `build.bat` on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.

**Step 2 of the Patch Procedure: Upgrade your Plugins**

Some of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to upgrade the affected plugin to get the fixed version. You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository. Please refer to the documentation for more details on installing plugins.

1. Install the latest version (v1.12) of the Mail Page plugin.
2. Install version 1.7.1 of the Office Connector plugin.
Confluence Security Advisory 2010-10-12

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.4. In addition to releasing Confluence 3.4, we also provide patches for the vulnerabilities mentioned below. You will be able to apply these patches to existing installations of Confluence 3.3.3. However, we recommend that you upgrade to Confluence 3.4 to fix these vulnerabilities.

In this advisory:

- **XSS Vulnerabilities**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**

- **Available Patches and Plugin Upgrades**
  - **Step 1 of the Patch Procedure: Install the Patch**
  - **Step 2 of the Patch Procedure: Upgrade the Affected Plugins**

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of these vulnerabilities as **high**, according to the scale published in [Severity Levels for Security Issues](#). The scale allows us to rank the severity as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances.

- An attacker might take advantage of an XSS vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker’s text and script might be displayed to other people viewing the page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at [cgisecurity](#), [CERT](#) and other places on the web.

**Vulnerability**

The table below describes the parts of Confluence affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space names</td>
<td>2.9 – 3.3.3</td>
<td>CONF-20740</td>
</tr>
<tr>
<td>Office Connector</td>
<td>3.0 – 3.3.3</td>
<td>CONF-20963</td>
</tr>
<tr>
<td>Tasklist macro</td>
<td>1.3 – 3.3.3</td>
<td>CONF-20964</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable...
public access (such as anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security and using Apache to limit access to the Confluence administration interface.

**Fix**

Confluence 3.4 fixes these issues. For a full description of this release, see the release notes. You can download Confluence 3.4 from the download centre.

If you cannot upgrade to Confluence 3.4, you can patch your existing installation using the patches listed below.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.4, you can apply the following patches and plugin upgrades to fix the vulnerabilities described in this security advisory.

**Step 1 of the Patch Procedure: Install the Patch**

A patch is available for Confluence 3.3.3.

The patch addresses the following issues:

- XSS vulnerability in space names (CONF-20740).
- XSS vulnerability in Office Connector (CONF-20963).

If you are using the Confluence distribution:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.3.3-to-3.4-security-patch.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.3.3-to-3.4-security-patch.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run 'build.sh clean' on UNIX, or 'build.bat clean' on Windows.
6. Run 'build.sh' on UNIX or 'build.bat' on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.

**Step 2 of the Patch Procedure: Upgrade the Affected Plugins**

Some of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to upgrade the affected plugins. You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository. Please refer to the documentation for more details on installing plugins.

- Install the latest version (v3.3.1) of the Dynamic Tasklist 2 plugin.
- Install the latest version (v1.2.2) of the Documentation Theme plugin.

**Confluence Security Advisory 2010-11-15**

Security Vulnerability in Confluence Remote API
Severity

Atlassian rates the severity level of this vulnerability as critical, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a vulnerability in the Remote API which affects Confluence instances, including publicly available instances. The Remote API allows an attacker to escalate user privileges, excluding the level of system administrator privileges.

Vulnerability

The table below describes the Confluence versions and the specific functionality affected by the RPC vulnerability.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Access</td>
<td>2.7 – 3.4</td>
<td>3.4.2</td>
<td>CONF-21162</td>
</tr>
</tbody>
</table>

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

We strongly advise that you disable the remote APIs until your Confluence instance is patched or upgraded. If the Remote API is vital, we recommend you disable anonymous access to the remote API.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

Fix

Confluence 3.4.2 fixes this issue. For a full description of this release, see the release notes. You can download Confluence 3.4.2 from the download centre.

If you cannot upgrade to Confluence 3.4.2, you can patch your existing installation using the patch listed below.

Available Patch

If for some reason you cannot upgrade to the latest version of Confluence, you can apply the following patch to fix the vulnerability described in this security advisory.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security vulnerability in Confluence Remote API</td>
<td>confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip</td>
</tr>
</tbody>
</table>

Patch Procedure: Install the Patch

A patch is available for Confluence 2.7 – 3.4.1.

The patch addresses the following issue:

- Security vulnerability in Confluence RPC (CONF-21162).

Applying the patch
If you are using the Confluence 2.7 – 3.4.1 distributions:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.
6. Visit `<Confluence base url>/admin/patch342applied.jsp` and confirm that it reports: "The Patch for Confluence 3.4.2 has been correctly applied."

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
6. Run `build.sh` on UNIX or `build.bat` on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.
9. Visit `<Confluence base url>/admin/patch342applied.jsp` and confirm that it reports: "The Patch for Confluence 3.4.2 has been correctly applied."

Confluence Security Advisory 2011-01-18

This advisory announces a number of security vulnerabilities that we have found and fixed in recent versions of Confluence. We also provide patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your Confluence installation rather than applying the patches. Enterprise Hosted customers should request an upgrade by raising a support request at http://support.atlassian.com. JIRA Studio is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

In this advisory:

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches

XSS Vulnerabilities

Severity

Atlassian rates the severity level of these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances (that is, internet-facing servers). XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at cgisecurity.com, The Web Application Security Consortium and other places on the web.
**Vulnerability**

The table below describes the Confluence versions and the specific functionality affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code macro</td>
<td>2.7 – 3.4</td>
<td>CONF-21098</td>
</tr>
<tr>
<td>Attachments macro</td>
<td>3.3 – 3.4</td>
<td>CONF-21099</td>
</tr>
<tr>
<td>Bookmarks macro</td>
<td>3.1 – 3.4.3</td>
<td>CONF-21390</td>
</tr>
<tr>
<td>Global Reports macro</td>
<td>2.7 – 3.4.3</td>
<td>CONF-21391</td>
</tr>
<tr>
<td>Recently Updated macro</td>
<td>3.0 - 3.4.3</td>
<td>CONF-21392</td>
</tr>
<tr>
<td>Pagetree macro</td>
<td>2.7 - 3.4.3</td>
<td>CONF-21393</td>
</tr>
<tr>
<td>Create Space Button macro</td>
<td>2.7 - 3.4.3</td>
<td>CONF-21394</td>
</tr>
<tr>
<td>Documentation Link macro</td>
<td>2.7 – 3.4.5</td>
<td>CONF-21508</td>
</tr>
</tbody>
</table>

Our thanks to dave b, who reported the vulnerability in the Documentation Link macro. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable [pub lic signup](#) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted [groups](#).

We also recommend that you read our guidelines on [best practices for configuring Confluence security](#).

**Fix**

Confluence 3.4.6 fixes these issues. For a full description of this release, see the [release notes](#). You can download the latest version of Confluence from the [download centre](#).

**Patches**

If for some reason you cannot upgrade to the latest version of Confluence, you can apply patches to fix the vulnerabilities described in this security advisory. The patches are attached to the relevant issues, as listed in the table above.
Please note that we have released a number of advisories about Confluence recently. We recommend that you review them and upgrade to the most recent release of the product or apply external security controls if you cannot. Most of the disclosed vulnerabilities are not critical and often present less risk when used in a corporate environment with no access from the Internet.

We usually provide patches only for vulnerabilities of critical severity, as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative – we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend to upgrade to the most recent version regularly.

We recommend patching only when you can neither upgrade nor apply external security controls.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Code Macro</td>
<td>atlassian-renderer-6.2.jar</td>
<td>CONF-21098</td>
<td>Download</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.3.x</td>
<td>Code Macro</td>
<td>atlassian-renderer-6.0.6.jar</td>
<td>CONF-21098</td>
<td>Download</td>
</tr>
</tbody>
</table>

Customers running Confluence 3.4.x:

Please replace the following JAR file with the updated atlassian-renderer-6.2.jar:

CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/lib/atlassian-renderer.jar

Customers running Confluence 3.3.x:

Please replace the following JAR file with the updated atlassian-renderer-6.0.6.jar:

CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/lib/atlassian-renderer.jar

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Attachments macro</td>
<td>attachments-table.vm-3.4.x.zip</td>
<td>CONF-21099</td>
<td>Download</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.3.x</td>
<td>Attachments macro</td>
<td>attachments-table.vm.zip</td>
<td>CONF-21099</td>
<td>Download</td>
</tr>
</tbody>
</table>

Customers running Confluence 3.4.x:

Please replace the following vm file with the updated attachments-table.vm-3.4.x.zip:

CONFLUENCE_INSTALL_DIR/confluence/pages/includes/attachments-table.vm

Customers running Confluence 3.3.x:
Please replace the following `vm` file with the updated [attachments-table.vm](#):

CONFLUENCE_INSTALL_DIR/confluence/pages/includes/attachments-table.vm

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x, 3.3.x</td>
<td>Bookmarks macro</td>
<td>socialbookmarking-1.3.4.jar</td>
<td>CONF-21390</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- Open the file `atlassian-bundled-plugins.zip`
- Decompress the contents into another location
- Replace the current `socialbookmarking.jar` with the correct file according to your version.
- Compress all the `.jar` files into another zip with the same name as the original file (`atlassian-bundled-plugins.zip`)
- Please note, make sure you place the files directly inside the `zip`, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Global Reports Macro</td>
<td>confluence-dashboard-macros-3.4.4.jar</td>
<td>CONF-21391</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Global Reports Macro</td>
<td>confluence-dashboard-macros-1.13.1.jar</td>
<td>CONF-21391</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- Open the file `atlassian-bundled-plugins.zip`
- Decompress the contents into another location
- Replace the current `confluence-dashboard-macros.jar` the correct file according to your version.
- Compress all the `.jar` files into another zip with the same name as the original file (`atlassian-bundled-plugins.zip`)
- Please note, make sure you place the files directly inside the `zip`, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Code Macro</td>
<td>confluence-advanced-macros-1.12.3.jar</td>
<td>CONF-21392</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Code Macro</td>
<td>confluence-advanced-macros-1.9.2.jar</td>
<td>CONF-21392</td>
<td>Download</td>
</tr>
</tbody>
</table>
Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** `CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup`
- **Open the file** `atlassian-bundled-plugins.zip`
- **Decompress the contents into another location**
- **Replace the current** `confluence-advanced-macros.jar` **with the correct file according to your version.**
- **Compress all the** `.jar` **files into another zip with the same name as the original file** (`atlassian-bundled-plugins.zip`)
- **Please note, make sure you place the files directly inside the zip, not contained inside another folder.**

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Pagetree Macro</td>
<td>pagetree-1.20.jar</td>
<td>CONF-21393</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** `CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup`
- **Open the file** `atlassian-bundled-plugins.zip`
- **Decompress the contents into another location**
- **Replace the current** `pagetree.jar` **with the correct file according to your version.**
- **Compress all the** `.jar` **files into another zip with the same name as the original file** (`atlassian-bundled-plugins.zip`)
- **Please note, make sure you place the files directly inside the zip, not contained inside another folder.**

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Create Space Button macro</td>
<td>confluence-dashboard-macros-3.4.4.jar</td>
<td>CONF-21394</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Create Space Button macro</td>
<td>confluence-dashboard-macros-1.13.1.jar</td>
<td>CONF-21394</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** `CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup`
- **Open the file** `atlassian-bundled-plugins.zip`
- **Decompress the contents into another location**
- **Replace the current** `confluence-dashboard-macros.jar` **with the correct file according to your version.**
- **Compress all the** `.jar` **files into another zip with the same name as the original file** (`atlassian-bundled-plugins.zip`)
- **Please note, make sure you place the files directly inside the zip, not contained inside another folder.**

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Documentation Link macro</td>
<td>confluence-advanced-macros-1.12.3.jar</td>
<td>CONF-21508</td>
<td>Download</td>
</tr>
</tbody>
</table>
Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

- Browse to CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- Open the file atlassian-bundled-plugins.zip
- Decompress the contents into another location
- Replace the current confluence-advanced-macros.jar with the correct file according to your version.
- Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
- Please note, make sure you place the files directly inside the zip, not contained inside another folder.

### Confluence Security Advisory 2011-03-24

This cumulative advisory announces a number of security vulnerabilities that we have found in Confluence and fixed in recent versions of Confluence. We also provide upgraded plugins and patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your complete Confluence installation rather than upgrading only the affected plugins. **Enterprise** and **Hosted** customers should request an upgrade by raising a support request at [http://support.atlassian.com](http://support.atlassian.com). **JIRA Studio** is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

#### In this advisory:

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches
    - Include Page Macro
    - Activity Stream Gadget
    - Action links of attachments lists
    - Table of Contents macro

### XSS Vulnerabilities

**Severity**

Atlassian rates the severity level of these vulnerabilities as **high**, according to the scale published in [Severity Levels for Security Issues](http://security.com). The scale allows us to rank the severity as critical, high, moderate or low.

These vulnerabilities are **not** critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Risk Assessment**

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at [ciscosity.com](http://ciscosity.com), [The Web Application Security Consortium](http://security.com) and other places on the web.
Vulnerability

The table below describes the Confluence versions and the specific functionality affected by each of the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Page macro</td>
<td>2.7 – 3.4.6</td>
<td>CONF-21604</td>
</tr>
<tr>
<td>Activity Stream gadget</td>
<td>3.1 – 3.4.6</td>
<td>CONF-21606</td>
</tr>
<tr>
<td>Action links of attachments lists</td>
<td>2.7 – 3.4.7</td>
<td>CONF-21766</td>
</tr>
<tr>
<td>Table of Contents macro</td>
<td>2.9 – 3.4.8</td>
<td>CONF-21819</td>
</tr>
</tbody>
</table>

Our thanks to Dave B, who reported the vulnerability in the action links of attachments lists. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

Fix

Confluence 3.4.9 or later fixes all of these issues. Some issues have been fixed in earlier versions as described in the table above. For a full description of this release, see the release notes. You can download the latest version of Confluence from the download centre. The most recent version at the time of this advisory is Confluence 3.5.

Patches

If for some reason you cannot upgrade to the latest version of Confluence, you can upgrade the relevant plugins (below) in your Confluence installation to fix the vulnerabilities described in this security advisory.

For details on upgrading Confluence's plugins using the plugin manager, see:

- Upgrading your Existing Plugins (for Confluence 3.4.x) or
- Installing and Configuring Plugins using the Plugin Repository Client (for Confluence 3.3.x).

Patches are also attached to the relevant issues (listed in the table above) if you need to apply these fixes manually.
Please note that we have released a number of advisories about Confluence recently. We recommend that you review them and upgrade to the most recent release of the product or apply external security controls if you cannot. Most of the disclosed vulnerabilities are not critical and often present less risk when used in a corporate environment with no access from the Internet.

We usually provide patches only for vulnerabilities of critical severity, as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative – we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend to upgrade to the most recent version regularly.

We recommend patching only when you can neither upgrade nor apply external security controls.

### Include Page Macro

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>CONF-21604</td>
<td>confluence-advanced-macros-1.12.4.jar</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>CONF-21604</td>
<td>confluence-advanced-macros-1.9.3.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

To apply this fix, use the plugin manager to upgrade the Advanced Macros plugin to a version greater than or equal to that specified in the file name above.

### Activity Stream Gadget

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3.x</td>
<td>CONF-21606</td>
<td>streams-confluence-plugin-3.3-CONF-21606.jar</td>
<td>Download</td>
</tr>
<tr>
<td>3.4.x</td>
<td>CONF-21606</td>
<td>streams-confluence-plugin-3.4.6.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

It's currently not possible to upgrade the Activity Streams Plugin automatically using the 3.4 plugin manager or the 3.3 plugin repository. Instead, you will need to manually install the plugin as follows:

1. Download the JAR file for your version of Confluence (see above).
2. Install the plugin manually using the "Upload Plugin" link on the "Install" tab of the plugin manager.

### Action links of attachments lists

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
</table>
To apply this fix, use the plugin manager to upgrade the Confluence Attachments Plugin plugin to a version greater than or equal to that specified in the file name above.

### Table of Contents macro

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Download</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3.x, 3.4.x</td>
<td>CONF-21766</td>
<td>confluence-attachments-plugin-2.20.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

To apply this fix, use the plugin manager to upgrade the Table of Contents Plugin plugin to a version greater than or equal to that specified in the file name above.

### Confluence Security Advisory 2011-05-31

⚠️ It has been incorrectly advised previously that CONF-22479 (User Preferences) affects all versions starting 2.7 while in fact it is exploitable only in 3.5 and above. Our sincere apologies, this will not happen again.

You can still apply the patch to 3.4 in order to remove the root cause of this bug and potentially prevent other similar vulnerabilities from appearing.

This advisory announces security vulnerabilities that we have found in Confluence and fixed in a recent version of Confluence. We also provide upgraded plugins and patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your complete Confluence installation rather than upgrading only the affected plugins. Enterprise Hosted customers should request an upgrade by raising a support request at [http://support.atlassian.com](http://support.atlassian.com). JIRA Studio is not vulnerable to the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

In this advisory:

- **XSS Vulnerabilities**
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches
  - Patch Procedure: Install the Patch
    - Applying the patch

- **XSRF Vulnerability**
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches
  - Patch Procedure: Install the Patch
Applying the patch

XSS Vulnerabilities

Severity

Atlassian rates the severity level of both these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, medium or low. These vulnerabilities are not critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

Risk Assessment

We have identified and fixed cross-site scripting (XSS) vulnerabilities that may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at cgisecurity.com, The Web Application Security Consortium and other places on the web.

Vulnerability

The table below describes the Confluence versions and the specific functionality affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Version</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>3.5 – 3.5.2</td>
<td>3.5.3</td>
<td>CONF-22402</td>
</tr>
<tr>
<td>User Preferences</td>
<td>3.5 – 3.5.2</td>
<td>3.5.3</td>
<td>CONF-22479</td>
</tr>
</tbody>
</table>

Our thanks to Marian Ventuneac (http://www.ventuneac.net) who reported the vulnerabilities mentioned above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

Fix

These vulnerabilities (CONF-22402 and CONF-22479) are both fixed in Confluence 3.5.3, and later versions. For a full description of the latest version of Confluence, see the release notes. You can download the latest version of Confluence from the download centre.

If you cannot upgrade to the latest version of Confluence, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

Patches
If you are running Confluence 3.5, we highly recommend that you upgrade to Confluence 3.5.3, or later.
If you are running Confluence 3.4, you can apply the following patch to fix the CONF-22479 vulnerability. The CONF-22402 vulnerability does not affect Confluence 3.4.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Attached to issue CONF-22479</td>
<td>CONF-22479_patch.zip</td>
</tr>
</tbody>
</table>

**Patch Procedure: Install the Patch**

A patch is available for Confluence 3.4 – 3.4.9.

The patch addresses the following issue:

Security vulnerability in Confluence User Preferences (CONF-22479).

**Applying the patch**

If you are using Confluence 3.4 – 3.4.9:

1. Download the CONF-22479_patch.zip file that is attached to the CONF-22479 issue.
2. Stop Confluence.
3. Make a backup of the `<confluence_install_dir>` directory.
4. Expand the downloaded zip file into `<confluence_install_dir>`, overwriting the existing files.
5. Check that the following files were created:
   - `confluence/WEB-INF/classes/com/atlassian/confluence/core/ConfluenceActionSupport.properties`
   - `confluence/WEB-INF/classes/com/atlassian/confluence/languages/DefaultLocaleManager.class`
   - `confluence/WEB-INF/classes/com/atlassian/confluence/user/actions/EditMySettingsAction.class`

**XSRF Vulnerability**

**Severity**

Atlassian rates the severity level of both this vulnerability as medium, according to the scale published in **Severity Levels for Security Issues** for Security Issues. The scale allows us to rank the severity as critical, high, medium or low.

This vulnerability is not critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Risk Assessment**

We have identified and fixed a cross-site request forgery (XSRF) vulnerability that may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSRF vulnerabilities allow an attacker to trick users into unintentionally adding bookmarks to Confluence spaces. You can read more about XSRF attacks at [http://www.cgisecurity.com/csrf-faq.html](http://www.cgisecurity.com/csrf-faq.html) and other places on the web.

**Vulnerability**

The table below describes the Confluence versions and the specific functionality affected by the XSRF vulnerability.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Version</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Bookmarking plugin</td>
<td>3.0 – 3.4.9</td>
<td>3.5</td>
<td>CONF-22565</td>
</tr>
</tbody>
</table>
Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security for configuring Confluence security.

Fix

This vulnerability (CONF-22565) is fixed in Confluence 3.5, and later versions. For a full description of the latest version of Confluence, see the release notes. You can download the latest version of Confluence from the download centre.

If you cannot upgrade to the latest version of Confluence, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

Patches

If you are running Confluence 3.5, the CONF-22565 vulnerability is already fixed, but we highly recommend that you upgrade to the latest version of Confluence.

If you are running Confluence 3.4, you can apply the following patch to fix the CONF-22565 vulnerability.

For details on upgrading Confluence's plugins using the plugin manager, see:

- Upgrading your Existing Plugins

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Bookmarking plugin</td>
<td>Attached to issue CONF-22565</td>
<td>socialbookmarking-1.3.9.jar</td>
</tr>
</tbody>
</table>

Patch Procedure: Install the Patch

A patch is available for Confluence 3.4 – 3.4.9.

The patch addresses the following issue:

- Security vulnerability in Confluence Settings Social Bookmarking plugin (CONF-22565).

Applying the patch

If you are using Confluence 3.4 – 3.4.9, use the plugin manager to upgrade the Social Bookmarking plugin to a version equal to or greater than that specified in the file name above. For details on using the plugin manager, see Upgrading your Existing Plugins.

Confluence Security Advisory 2012-05-17

This advisory discloses a critical security vulnerability that exists in all versions of Confluence up to and including 4.1.9.

- Customers who have downloaded and installed Confluence should upgrade their existing Confluence installations to fix this vulnerability.
- Enterprise Hosted customers need to request an upgrade by raising a support request at http://support.atlassian.com in the "Enterprise Hosting Support" project.
- JIRA Studio and Atlassian OnDemand customers are not affected by any of the issues described in
Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com/.

In this advisory:

- **Critical XML Parsing Vulnerability**
  - **Severity**
  - **Description**
  - **Risk Mitigation**
  - **Fix**

**Critical XML Parsing Vulnerability**

**Severity**

Atlassian rates the severity level of this vulnerability as **critical**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Description**

We have identified and fixed a vulnerability in Confluence that results from the way third-party XML parsers are used in Confluence. This vulnerability allows an attacker to:

- execute denial of service attacks against the Confluence server, or
- read all local files readable to the system user under which Confluence runs.

The attacker does not need to have an account with the affected Confluence instance.

All versions of Confluence up to and including 4.1.9 are affected by this vulnerability. This issue can be tracked here: CONF-25077 - Authenticate to see issue details

The Gliffy for Confluence plugin is also vulnerable to this exploit. If you are using the Gliffy plugin for Confluence with any version of Confluence, you will need to upgrade it (see 'Fix' section below) or disable it.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately, you should do **all** of the following until you can upgrade. Please note, these measures will only limit the impact of the vulnerability, they will not mitigate it completely.

- Disable access to the SOAP and XML-RPC APIs, if these remote APIs are not required. Note, remote API access is disabled by default. See [enabling remote APIs](#) for instructions.
- Disable the following plugins/plugin modules (see [Disabling or Enabling a Plugin](#)):
  - Office Connector plugin
  - JUnitReport macro module of the confluence-advanced-macros plugin (called "Advanced Macros" in the interface)
  - confluence-jira3-macros plugin (called "JIRA Macros" in the interface)
  - WebDAV
- Disable public access (such as [anonymous access](#) and [public signup](#)) to Confluence until you have
upgraded.

- Ensure that your Confluence system user is restricted as described in [best practices for configuring Confluence security](#).

**Fix**

**Upgrade**

1. Upgrade to Confluence 4.2 or later which fixes this vulnerability. For a full description of this release, see the [Confluence 4.2 Release Notes](#). The following releases have also been made available to fix these issues in older Confluence versions. You can download these versions of Confluence from the [download centre](#).

   - Confluence 4.1.10 for Confluence 4.1
   - Confluence 4.0.7 for Confluence 4.0
   - Confluence 3.5.17 for Confluence 3.5

2. Upgrade the following Confluence third-party plugins, if you are using them. The table below describes which version of the plugin you should upgrade to, depending on your Confluence version. See [Upgrading your Existing Plugins](#) for instructions on how to upgrade a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Confluence 4.2</th>
<th>Confluence 4.1</th>
<th>Confluence 4.0</th>
<th>Confluence 3.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gliffy plugin for Confluence</td>
<td>4.2</td>
<td>4.2</td>
<td>4.2</td>
<td>4.2</td>
</tr>
</tbody>
</table>

**Patches**

There are no patches available for this vulnerability. Due to the extent of the changes required to fix the vulnerability, it is not possible to provide patches that resolve the issue without compromising the reliability of Confluence. You must upgrade to fix this vulnerability.

**Configuring Confluence Security**

This section gives guidelines on configuring the security of your Confluence site.

Other topics:

- For information about user management, groups and permissions, please refer to the [internal security overview](#).
- For an overview of Confluence application security, see the page on [Confluence security](#).

**Setting up a Secure Confluence Site**

- [Confluence Cookies](#)
- [Configuring Secure Administrator Sessions](#)
- [Using Fail2Ban to limit login attempts](#)
- [Securing Confluence with Apache](#)
  - [Using Apache to limit access to the Confluence administration interface](#)
- [Managing External Referrers](#)
  - [Excluding external referrers](#)
  - [Hiding external referrers](#)
  - [Ignoring External Referrers](#)
- [Best Practices for Configuring Confluence Security](#)
- [Hiding the People Directory](#)
- [Configuring Captcha for Spam Prevention](#)
- [Hiding External Links From Search Engines](#)
- [Configuring Captcha for Failed Logins](#)
- [Configuring XSRF Protection](#)
Confluence Cookies

This page lists cookies stored in Confluence users' browsers which are generated by Confluence itself. This page does not list cookies that may originate from 3rd-party Confluence plugins.

Authentication cookies

Confluence uses Seraph, an open source framework, for HTTP cookie authentication. Confluence uses two types of cookies for user authentication:

- The JSESSIONID cookie is created by the application server and used for session tracking purposes. This cookie contains a random string and the cookie expires at the end of every session or when the browser is closed.
- The 'remember me' cookie, seraph.confluence, is generated by Confluence when the user selects the Remember me check box on the login page.

ℹ️ You can read about cookies on the Wikipedia page about HTTP cookies.
The 'remember me' cookie

The 'remember me' cookie, seraph.confluence, is a long-lived HTTP cookie. This cookie can be used to authenticate an unauthenticated session. Confluence generates this cookie when the user selects the Remember me check box on the login page.

Cookie key and contents

By default, the cookie key is seraph.confluence, which is defined by the login.cookie.key parameter in the CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml file.

The cookie contains a unique identifier plus a securely-generated random string (i.e. token). This token is generated by Confluence and is also stored for the user in the Confluence database.

Use of cookie for authentication

When a user requests a web page, if the request is not already authenticated via session-based authentication or otherwise, Confluence will match the 'remember me' cookie (if present) against the token (also if present), which is stored for the user in the Confluence database.

If the token in the cookie matches the token stored in the database and the cookie has not expired, the user is authenticated.

Life of 'remember me' cookies

You can configure the maximum age of the cookie. To do that you will need to modify the CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml file and insert the following lines below the other init-param elements:

```xml
<init-param>
  <param-name>autologin.cookie.age</param-name>
  <param-value>2592000</param-value><!-- 30 days in seconds -->
</init-param>
```

Automatic cleanup of 'remember me' tokens

Every cookie issued by Confluence has a corresponding record in the database. A scheduled job runs on the 20th of every month to clean up expired tokens. The name of the trigger is clearExpiredRememberMeToken.

Note: The only purpose of this job is to prevent the database table from growing too big. For authentication purposes, Confluence will ignore expired tokens even if they still exist in the database.

Is it possible to disable the 'remember me' feature?

Confluence does not offer an option for disabling the 'Remember Me' feature. See the workaround.

Other Confluence cookies

There are several cookies that Confluence uses to store basic 'product presentation' states. Confluence users' authentication details are not stored by these cookies.

<table>
<thead>
<tr>
<th>Cookie Key</th>
<th>Purpose</th>
<th>Cookie Contents</th>
<th>Expiry</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Doc-sidebar

Remembers the user's preference for the width of the navigation sidebar in the Confluence documentation theme.
The width of the sidebar in pixels. For example, 300px
One year from the date it was set or was last updated.

Confluence.list.pages.cookie

Remembers the user's last chosen tab in the "list pages" section.
The name of the last selected tab. For example, list-content-tree
One year from the date it was set or was last updated.

Confluence.browse.space.cookie

Remembers the user's last chosen tab in the "browse space" section.
The name of the last selected tab. For example, space-pages
One year from the date it was set or was last updated.

Confluence-language

Remembers the user's language chosen on the login page. This cookie relates to a feature that allows a user to change Confluence's language from (and including) the login page, when the language presented to the user prior to logging in is not appropriate.
A locale relating to the chosen language. For example, de_DE
360 days from the date it was set or was last updated.

AJS.conglomerate.cookie

Tracks which general tabs were last used (e.g. in Confluence's plugin manager) or expansion elements were last opened or closed.
One or more key-value strings which indicate the states of your last general tab views or expansion elements.
One year from the date it is set or was last updated.

Notes

- The autocomplete feature in browser text fields (which are typically noticeable when a user logs in to Confluence) is a browser-specific feature, not a Confluence one. Confluence cannot enable or disable this autocompletion, which is typically set through a browser's settings.

 RELATED TOPICS

  Administrators Guide Home  Confluence Documentation Home

Configuring Secure Administrator Sessions

Confluence protects access to its administrative functions by requiring a secure administration session to use the Confluence administration console or administer a space. When a Confluence administrator (who is logged into Confluence) attempts to access an administration function, they are prompted to log in again. This logs the administrator into a temporary secure session that grants access to the Confluence/space administration console.

The temporary secure session has a rolling timeout (defaulted to 10 minutes). If there is no activity by the administrator in the Confluence/space administration console for a period of time that exceeds the timeout, then the administrator will be logged out of the secure administrator session (note, they will remain logged into Confluence). If the administrator does click an administration function, the timeout will reset.

⚠️ The information on this page does not apply to Confluence OnDemand.
To configure secure administrator sessions:

1. Choose Browse > Confluence Admin.
2. Click ‘Security Configuration’ in the ‘Security’ section. The ‘Edit Security Configuration’ screen will be displayed.
3. Click the ‘Edit’ link.
   - To disable secure administrator sessions (i.e. administrators will not be required to log into a secure session to access the administration console), uncheck the ‘Enable’ checkbox next to ‘Secure administrator sessions’.
   - To change the timeout for secure administrator sessions, update the value in textbox next to ‘minutes before invalidation’. The default timeout for a secure administration session is 10 minutes.
4. Click the ‘Save’ button.

![Screenshot above: Configuring secure administrator sessions](image)

Notes

- **Disabling password confirmation.** Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the password.confirmation.disabled system property to disable the password confirmation functionality. See Recognised System Properties. See issue CONF-20958 "Confluence features that require password confirmation (websudo, captcha) do not work with custom authentication".

- **WebSudo.** The feature that provides secure administrator sessions is also called 'WebSudo'.

- **Manually ending a secure session.** An administrator can choose to manually end their secure session by clicking the ‘drop access’ link in the banner displayed at the top of their screen.

- **Note for developers.** Secure administrator sessions can cause exceptions when developing against Confluence or deploying a plugin. Please read this FAQ: How do I develop against Confluence with Secure Administrator Sessions? Note: The Confluence XML-RPC and REST APIs are not affected by...
Using Fail2Ban to limit login attempts

What is Fail2Ban?

We need a means of defending sites against brute-force login attempts. Fail2Ban is a Python application which trails logfiles, looks for regular expressions, and works with Shorewall (or directly with iptables) to apply temporary blacklists against addresses that match a pattern too often. This can be used to limit the rate at which a given machine hits login URLs for Confluence.

Prerequisites

- Requires Python 2.4 or higher to be installed
- Needs a specific file to follow, which means your Apache instance needs to log your Confluence access to a known logfile. You should adjust the configuration below appropriately.

How to set it up

This list is a skeletal version of the instructions

- There's an RPM available for RHEL on the download page, but you can also download the source and set it up manually
- Its configuration files go into /etc/fail2ban
- The generic, default configuration goes into .conf files (fail2ban.conf and jail.conf). Don't change these, as it makes upgrading difficult.
- Overrides to the generic configuration go into .local files corresponding to the .conf files. These only need to contain the specific settings you want overridden, which helps maintainability.
- Filters go into filter.d — this is where you define regexps, each going into its own file
- Actions go into action.d — you probably won't need to add one, but it's handy to know what's available
- "jails" are a configuration unit that specify one regexp to check, and one or more actions to trigger when the threshold is reached, plus the threshold settings (e.g. more than 3 matches in 60 seconds causes that address to be blocked for 600 seconds)
- Jails are defined in jail.conf and jail.local. Don't forget the enabled setting for each one — it can be as bad to have the wrong ones enabled as to have the right ones disabled.

Running Fail2Ban

- Use /etc/init.d/fail2ban {start|stop|status} for the obvious operations
- Use fail2ban-client -d to get it to dump its current configuration to STDOUT. Very useful for troubleshooting.
- Mind the CPU usage; it can soak up resources pretty quickly on a busy site, even with simple regexp
- It can log either to syslog or a file, whichever suits your needs better

Common Configuration

jail.local
# The DEFAULT allows a global definition of the options. They can be override
# in each jail afterwards.

[DEFAULT]

# "ignoreip" can be an IP address, a CIDR mask or a DNS host. Fail2ban will not
# ban a host which matches an address in this list. Several addresses can be
# defined using space separator.
# ignoreip = <space-separated list of IPs>

# "bantime" is the number of seconds that a host is banned.
bantime  = 600

# A host is banned if it has generated "maxretry" during the last "findtime"
# seconds.
findtime  = 60

# "maxretry" is the number of failures before a host get banned.
maxretry = 3

[ssh-iptables]

enabled  = false

[apache-shorewall]

enabled  = true
filter   = cac-login
action   = shorewall
logpath = /var/log/httpd/confluence-access.log
bantime = 600
maxretry = 3
findtime = 60
backend = polling

---

**Configuring for Confluence**

⚠️ The following is an example only, and you should adjust it for your site.

filter.d/confluence-login.conf
Securing Confluence with Apache

The following outlines some basic techniques to secure a Confluence instance using Apache. These instructions are basic to-do lists and should not be considered comprehensive. For more advanced security topics see the "Further Information" section below.

- **Using Apache to limit access to the Confluence administration interface**
- **Using Fail2Ban to limit login attempts**

**Further Information**

Running Confluence behind Apache

Warning: The information on this page does not apply to Confluence OnDemand.

Using Apache to limit access to the Confluence administration interface

**Limiting administration to specific IP addresses**

The Confluence administration interface is a critical part of the application; anyone with access to it can potentially compromise not only the Confluence instance but the entire machine. As well as limiting access to users who really need it, and using strong passwords, you should consider limiting access to it to certain machines on the network or internet. If you are using an Apache web server, this can be done with Apache's Location functionality as follows:

1. **Create a file that defines permission settings**

   This file can be in the Apache configuration directory or in a system-wide directory. For this example we'll call it "sysadmin_ips_only.conf". The file should contain the following:

   ```
   Order Deny,Allow
   Deny from All
   # Mark the Sysadmin's workstation
   Allow from 192.168.12.42
   ```

2. **Add the file to your Virtual Host**

   In your Apache Virtual Host, add the following lines to restrict the administration actions to the Systems Administrator:

```
This configuration assumes you've installed Confluence under '/confluence'. If you have installed under '/' or elsewhere, adjust the paths accordingly.

```xml
<Location /confluence/admin>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/list>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/view-consumer-info>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/service-providers/list>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/service-providers/add>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/add>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/add-manually>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/update-consumer-info>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/pages/templates/listpagetemplates.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/pages/templates/createpagetemplate.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/spacepermissions.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/listpermissionpages.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/removespace.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/importmbox.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/viewmailaccounts.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/addmailaccount.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/importpages.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/flyingpdf/flyingpdf.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/exportspacehtml.action>
  Include sysadmin_ips_only.conf
</Location>
```
<Location /confluence/spaces/exportspacexml.action>
  Include sysadmin_ips_only.conf
</Location>

<Location /confluence/plugins/servlet/embedded-crowd>
  Include sysadmin_ips_only.conf
</Location>
Managing External Referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

By default, external referrers for a page are listed under 'Hot Referrers' on the 'Info' screen of the page. (See Screenshot 1 below.) Confluence shows a maximum of 10 referrers. If there are more than 10, confluence shows the 10 with the highest number of hits.

Note that you do not need to enable trackback in order to have external referrers enabled.

To manage your external referrers:

1. Choose Browse > Confluence Admin.
2. Select the 'Manage Referrers' option (See Screenshot 2 below.).

The following actions will be available:

- **Record or ignore all external referrers**: By default, Confluence records the number of hits made to a page from the link on the external site. If you turn this option off, Confluence will not record the hits.
- **Show or hide all external referrers**: By default, Confluence lists the external referrers as 'Hot Referrers' on the 'Info' screen of a page, as shown below. If you turn this option off, external referrers will not be listed on the page.
- **Specify which external referrers to exclude**: You can decide which referrers you want to exclude from being displayed on your site.

Screenshot above: Hot Referrers showing on a page's Info screen
Excluding external referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

You can exclude external referrers to prevent them from being recorded or displayed anywhere on your site. Once you have specified your list of blocked URLs, any incoming links from URLs that match the list will no longer be recorded. Referrer URLs are blocked if they start with any of the URLs in the exclusion list. So `http://evilspamsite.blogspot.com` will also match `http://evilspamsite.blogspot.com/nastypage.html`.

There are two instances where you may want to do this:

1. If you are running a Confluence installation that is open to public:
   In a site that is open to public, one unfortunate problem is that malicious sites can spam the display of a page’s incoming links statistics. This is usually done to get the site's URL to appear in the sidebar. By adding these sites to the ‘excluded referrers’ list, you can prevent them from being listed on your site.
2. If Confluence is installed on a server with multiple domain names or IP addresses:
   Confluence will consider any URL originating from the domain name where Confluence is installed as an internal link. However, if Confluence is installed on a server with multiple domain names or IP addresses, you will need to add the other domain name prefixes to this list to let Confluence know that any links from these domains should not be considered external links.

You need to be a Confluence administrator and to know the URL of the site to add it to the excluded referrers list.

To add a URL to the excluded referrers list:

1. Choose Browse > Confluence Admin.
2. Select Manage Referrers in the left-hand panel.
3. Add the URL to the ‘Excluded External Referrer Prefixes’ section.
   - You must include ‘http://’ at the front of the URL.
   - You can add more than one URL by putting each URL on a new line.
Hiding external referrers

By default, Confluence lists the external referrers as 'Hot Referrers' on the 'Info' screen of a page. If you turn this option off, external referrers will not be listed on the page.

To hide external referrers:

1. Choose **Browse** > **Confluence Admin**.
2. Select 'Manage Referrers' in the left-hand panel.
3. Click 'Off' beside 'Show Referrers in Page Info'.

Ignoring External Referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external
link, your Confluence site can record the click as a referral. By default, Confluence records the number of hits made to a page from any link on an external site. If you turn this option off, Confluence will not record the hits.

To ignore external referrers:

1. Choose **Browse > Confluence Admin.**
2. Select ‘**Manage Referrers**’ in the left-hand panel.
3. Click ‘**Off**’ beside ‘**Record External Referrers**’.

<table>
<thead>
<tr>
<th>Record External Referrers:</th>
<th>On</th>
<th>Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Referrers in Page Info:</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>Excluded External Referrer Prefixes:</td>
<td>![Add button]</td>
<td></td>
</tr>
</tbody>
</table>

Screenshot above: Managing external referrers

**Related Topics**

No content found for label(s) security-options.

---

**Best Practices for Configuring Confluence Security**

The best way to harden a system is to look at each of the involved systems individually. Contact your company’s security officer or department to find out what security policies you should be using. There are many things to consider, such as the configuration of your underlying operating systems, application servers, database servers, network, firewall, routers, etc. It would be impossible to outline all of them here.

This page contains guidelines on good security practices, to the best of our knowledge.

---

**The information on this page does not apply to Confluence OnDemand.**

---

**Configuring the Web Server**

Please refer to the following guides for system administrators:

- How to configure Apache to lock down the administration interface to those people who really need it: Using Apache to limit access to the Confluence administration interface.
- How to reduce the risk of brute force attacks: Using Fail2Ban to limit login attempts.

**Configuring the Application Server**

See the following system administrator guide for general hints on the application server level:

- **Tomcat security best practices**

**Configuring the Application**

The way you set up Confluence roles, permissions and processes makes a big difference in the security of your Confluence site.
Below are some more Confluence-specific items to consider. None of these provides 100% security. They are measures to reduce impact and to slow down an intruder in case your system does become compromised.

- Keep the number of Confluence administrators extremely low. For example, 3 system administrator accounts should be the maximum.
- Similarly, restrict the number of users with powerful roles or group memberships. If only one department should have access to particularly sensitive data, then do restrict access to the data to those users. Do not let convenience over-rule security. Do not give all staff access to sensitive data when there is no need.
- The administrators should have separate Confluence accounts for their administrative roles and for their day to day roles. If John Doe is an administrator, he should have a regular user account without administrator access to do his day to day work (such as writing pages in the wiki). This could be a ‘john.doe’ account. In addition, he should have an entirely separate account (that cannot be guessed by an outsider and that does not even use his proper name) for administrative work. This account could be ‘jane smith’ – using a username that is so obscure or fake that no outsider could guess it. This way, even if an attacker singles out the actual person John Doe and gets hold of his password, the stolen account would most likely be John’s regular user account, and the attacker cannot perform administrative actions with that account.
- Lock down administrative actions as much as you can. If there is no need for your administrators to perform administrative actions from outside the office, then lock down access to those actions to known IP adresses, for example. See Using Apache to limit access to the Confluence administration interface.
- Put documented procedures in place for the case of employees leaving the company.
- Perform security audits regularly. Know who can help in case a security breach occurs. Perform ‘what if’ planning exercises. (‘What is the worst thing that could happen if a privileged user's password were stolen while he's on vacation? What can we do to minimise damage?’).
- Make sure the Confluence database user (and all datasource database users) only has the amount of database privileges it really needs.
- Monitor your binaries. If an attacker compromises an account on your system, he will usually try to gain access to more accounts. This is sometimes done by adding malicious code, such as by modifying files on the system. Run routine scripts that regularly verify that no malicious change has been made.

As another precaution:

- Regularly monitor the above requirements. There are many things that could start out well, but deteriorate over time:
  - A system may start out with just 3 administrators, but over the course of a year this could grow to 30 administrators if no one prevents expansion.
  - Apache administration restrictions may be in place at the start of the year, but when the application server is migrated after a few months, people may forget to apply the rules to the new system.

Again, keep in mind that the above steps may only be a fraction of what could apply to you, depending on your security requirements. Also, keep in mind that none of the above rules can guarantee anything. They just make it harder for an intruder to move quickly.

**Hiding the People Directory**
The [People Directory](#) provides a list of all users in your Confluence system.

If you need to disable the People Directory set the following system properties on your application server command line:

- To disable the People Directory for [anonymous users](#),

  ```
  -Dconfluence.disable.peopledirectory.anonymous=true
  ```

- To disable the People Directory entirely,
This workaround will prevent the People directory from appearing on the dashboard, but if you navigate to the profile of a user, and then click on the "People" in the breadcrumb link (Dashboard >> People >> FullName >> Profile) or you go to the URL directly <CONFLUENCE_INSTALL>/browsepeople.action, you will be able to access the people directory.

To workaround this, set up Apache webserver in front of confluence and redirect requests to this URL.

To remove the link on the dashboard:

Procedure for Confluence 2.5.2 to 2.9.x. only

- This only applies to Confluence 2.5.2 to 2.9.x. Confluence 2.10.x or later only needs to configure system properties using the above.
- Edit the <confluence-install>/confluence/decorators/global.vmd:
- Comment out line 37:

```xml
<!--                    <img
 src="$req.contextPath/images/icons/people_directory_32.gif" 
 align='absmiddle' height="32" width="32"> <b><a class="fontSizeDefault" 
 href="$req.contextPath/peopledirectory.action"> 
 $action.getText("people.directory.title")</a></b><span 
 class="smalltext"> -
 $action.getText("people.directory.description")</span><br> -->
```

Related Topics

No content found for label(s) security-options.

Configuring Captcha for Spam Prevention

- You need to be a Confluence administrator to configure Captcha for spam prevention in Confluence.

If your Confluence site is open to the public you may find that automated spam is being added, in the form of
comments or new pages.

You can configure Confluence to deter automated spam by asking users to prove that they are human before they are allowed to:

- Sign up for an account.
- Add a comment.
- Create a page.
- Edit a page.
- Send a request to the Confluence administrators.

Captcha is the technical term for a test that can distinguish a human being from an automated agent such as a web spider or robot. You can read more about Captcha on Wikipedia.

When Captcha is switched on, users will need to recognise a distorted picture of a word, and must type the word into a text field. This is easy for humans to do, but very difficult for computers.

![Captcha Test](Screenshot above: Example of a Captcha test)

You can configure Confluence to enforce Captcha for certain types of users. You can exempt logged-in users (they will have completed a Captcha when they signed up) or members of particular groups.

By default, Captcha for spam prevention is disabled. If you enable it, the default is that Captcha for spam prevention will apply to anonymous users only. Only anonymous users will have to perform the Captcha test when creating comments or editing pages. Captcha images will not be shown to logged-in users.

To enable Captcha for spam prevention in Confluence:

1. Choose Browse > Confluence Admin.
2. Select ‘Spam Prevention’ from the ‘Configuration’ menu on the left.
3. Turn on Captcha by clicking the ‘ON’ link.
4. If you want to disable Captcha for certain groups:
   - Select ‘No one’ if you want everyone to see Captchas.
   - Select ‘Signed in users’ if you want only anonymous users to see Captchas.
   - If you want everyone to see Captchas except members of specific groups, select the ‘Members of the following groups’ and enter the group names in the text box. You can click the magnifying-glass icon to search for groups. Search for all or part of a group name and click the ‘Select Groups’ button to add one or more groups to the list.
   - To remove a group from the list, delete the group name.
5. Click the ‘Save’ button.

Related Topics
No content found for label(s) security-options.

Hiding External Links From Search Engines
Hiding external links from search engines helps to discourage spammers from posting links on your site. If you turn this option on, any URLs inserted in pages and comments will be given the 'nofollow' attribute, which prevents search engines from following them.

Shortcut links (e.g. CONF-2622@JIRA) and internal links to other pages within Confluence are not tagged.
To hide external links from search engines:

1. Choose Browse > Confluence Admin.
2. Click 'Security Configuration' in the left panel.
3. This will display the 'Security Configuration' screen. Click 'Edit'.
4. Check the 'Hide External Links From Search Engines' checkbox.
5. Click the 'Save' button.

**Background to the nofollow attribute**

As part of the effort to combat the spamming of wikis and blogs (Confluence being both), Google came up with some markup which instructs search engines not to follow links. By removing the main benefit of wiki-spamming it's hoped that the practice will stop being cost-effective and eventually die out.

**Related Topics**

No content found for label(s) security-options.

---

**Configuring Captcha for Failed Logins**

If you have confluence administrator permissions, you can configure Confluence to impose a maximum number of repeated login attempts. After a given number of failed login attempts (the default is three) Confluence will display a Captcha form asking the user to enter a given word when attempting to log in again. This will prevent brute force attacks on the Confluence login screen. Similarly, after three failed login attempts via the XML-RPC or SOAP API, an error message will be returned instructing the user to log in via the web interface. Captcha will automatically be activated when they attempt this login.

'Captcha' is the technical term for a test that can distinguish a human being from an automated agent such as a web spider or robot. You can read more about Captcha on Wikipedia.

When Captcha is activated, users will need to recognise a distorted picture of a word, and must type the word into a text field. This is easy for humans to do, but very difficult for computers.
Enabling, Disabling and Configuring Captcha for Failed Logins

By default, Captcha for failed logins is enabled and the number of failed login attempts is set to three.

To enable, disable and configure Captcha for failed logins:

1. Choose **Browse > Confluence Admin.**
2. Select ‘Security Configuration’ from the ‘Security’ menu on the left.
3. Click the ‘Edit’ button.
4. To enable Captcha:
   - Check the ‘Enable’ checkbox next to ‘CAPTCHA on login’.
   - Set the maximum number of failed logins next to ‘Maximum Authentication Attempts Allowed’. You must enter a number greater than zero.
5. To disable Captcha, remove the check from the ‘Enable’ checkbox.
6. Click the ‘Save’ button.

![Security and Privacy](image)

Screenshot above: Configuring Captcha for failed logins

**Notes**

- **Disabling all password confirmation requests, including Captcha on login.** Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the `password.confirmation.disabled` system property to disable the password confirmation functionality on administrative actions, change of email address and Captcha for failed logins. See [Recognised System Properties](#)

**Related Topics**

- Administrators Guide Home
- Confluence Documentation Home

**Configuring XSRF Protection**

Confluence requires an XSRF token to be present on comment creation, to prevent users being tricked into unintentionally submitting malicious data (read more about XSRF (Cross Site Request Forgery)). All of the themes bundled with Confluence have been designed to use this feature. However, if you are using a custom theme that does not support this security feature, you can disable it.
Please carefully consider the security risks before you disable XSRF protection in your Confluence installation.

Some functionality described on this page is restricted in Confluence OnDemand.

To configure XSRF protection:

1. Choose Browse > Confluence Admin.
2. Click ‘Security Configuration’ in the ‘Security’ section. The ‘Edit Security Configuration’ screen will be displayed.
3. Click the ‘Edit’ link.
4. To disable XSRF protection, uncheck the ‘Add Comments’ checkbox in the ‘XSRF Protection’ section.
5. Click the ‘Save’ button.

User Email Visibility

Confluence provides three options for email address privacy which can be configured by a Confluence administrator from the Administration Console:

- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Only visible to site administrators**: only Confluence administrators can see the email addresses. Note that, if you select this option, email addresses will not be available in the ‘User Search’ popup (e.g. when setting Page Restrictions).
The information on this page does not apply to Confluence OnDemand.

To configure user email visibility:

1. Choose Browse > Confluence Admin.
2. Select 'Security Configuration' in the left-hand panel. The 'Security Configuration' screen will be displayed.
3. Click 'Edit'. The fields on the 'Security Configuration' screen will be editable.
4. Select one of the options from the 'User email visibility' dropdown: 'public', 'masked', or 'only visible to site administrators'.
5. Click the 'Save' button.

<table>
<thead>
<tr>
<th>User email visibility:</th>
</tr>
</thead>
<tbody>
<tr>
<td>public</td>
</tr>
<tr>
<td>masked (i.e. user at example dot com)</td>
</tr>
<tr>
<td>only visible to site administrators</td>
</tr>
</tbody>
</table>

Screenshot above: Email Visibility

Related Topics

No content found for label(s) security-options.

Anonymous Access to Remote API

Sites may wish to disable anonymous access to the Remote API to make it harder for malicious users to write 'bots' that perform bulk changes to the site. If you wish to enable the Remote APIs but do not want anonymous users to access Confluence remotely, you can disable anonymous access from the Administration Console.

To disable anonymous access to Remote APIs:

1. Choose Browse > Confluence Admin.
2. Click 'Security Configuration' in the left panel. The 'Security Configuration' screen will be displayed.
3. Click 'Edit'. The fields on the 'Security Configuration' screen will now be editable.
4. Uncheck the 'Anonymous Access to API' checkbox.
5. Click the 'Save' button.

Related Topics

No content found for label(s) security-options.

Running Confluence Over SSL or HTTPS

This page documents configuration of SSL, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with SSL. Please be aware that this material is provided for your information only, and that you use it at your own risk.

This document tells you how to configure Confluence to enable access via HTTPS (HTTP over SSL), so that your Confluence logins and data are encrypted during transport to and from Confluence. SSL encryption is a good way to safeguard your Confluence data and user logins from being intercepted and read by outsiders.
These instructions apply to the following platforms:

- **Confluence or Confluence WAR distribution using Tomcat.** Apache Tomcat is the application server shipped with Confluence, and is the only supported application server. If you are using a different application server or Apache HTTP Server ("httpd"), see the page on [Apache with mod_proxy](http://httpd.apache.org/docs/2.2/ssl/mod_ssl.html) for instructions on how to terminate an SSL connection at the Apache web server.

- **Java 6.** JDK 1.6 is the [supported](http://java.sun.com/javase/downloads/) Java version for Confluence. Note that you need the JDK, since it includes the `keytool` utility used in the instructions below. The JRE is not enough. If you are using JDK 1.5, please refer to the [Java SE documentation](http://java.sun.com/javase/6/docs/technotes/guides/security/keytool Whiplet.html) to see the differences in the `keytool` utility from JDK 1.5 to JDK 1.6.

The default connector port for Confluence is 8090, while a plain Tomcat installation (used for EAR / WAR distribution) will default to 8080.

---

### On this page:

- [Step 1. Create or Request a New SSL Certificate](#step-1-create-or-request-a-new-ssl-certificate)
- [Step 3. Specify the Location of your Certificate](#step-3-specify-the-location-of-your-certificate)
- [Step 4. Change your Confluence Base URL to HTTPS](#step-4-change-your-confluence-base-url-to-https)
- [Step 5. Add a Security Constraint to Cause Redirect of All URLs to HTTPS](#step-5-add-a-security-constraint-to-cause-redirect-of-all-urls-to-https)
- [Notes](#notes)
- [Troubleshooting](#troubleshooting)

---

The information on this page does not apply to Confluence OnDemand.

### Step 1. Create or Request a New SSL Certificate

You will need a valid SSL certificate before you can enable HTTPS. If you already have a certificate prepared, skip to step 2 [below](#step-2-modify-the-server-configuration-file-in-your-confluence-installation).

You can choose to create a self-signed certificate or to use a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority'). We described both options below.

**Certificate Option 1 – Create a Self-Signed Certificate**

Self-signed certificates are useful if you require encryption but do not need to verify the identity of the requesting website. In general, you might use a self-signed certificate on a test environment and on internal corporate networks (intranets).

Because the certificate is not signed by a certificate authority (CA), users may receive a message that the site is not trusted and may have to perform several steps to accept the certificate before they can access the site. This usually will only occur the first time they access the site.

Follow the steps below to generate a certificate using Java's `keytool` utility. This tool is included in the JDK.

1. Use Java's `keytool` utility to generate the certificate:
   - On Windows, run the following command at the command prompt:
     ```bash
     "%JAVA_HOME%\bin\keytool" -genkeypair -alias tomcat -keyalg RSA
     ```
On OS X or UNIX-based systems, run the following command at the command prompt:

```bash
$JAVA_HOME/bin/keytool -genkeypair -alias tomcat -keyalg RSA
```

2. When asked for a **password**:
   - Specify the password you want to use for the certificate (private key). Note that the password text will not appear as you type it.
   - Make a note of the password you choose, because you will need it in the next step when editing the configuration file.
   - The default password is 'changeit'.

3. Follow the prompts to specify your name, organisation and location. This information is used to construct the X.500 Distinguished Name (DN) of the entity. The CN ("What is your first and last name?") must match the fully-qualified hostname of the server running Confluence, otherwise Tomcat will not be able to use the certificate for SSL. For example for a Confluence running on a server named "confluence.example.com":
   
   CN=confluence.example.com, OU=Java Software Division, O=Sun Microsystems Inc, C=US
   
   Enter 'y' to confirm the details.

4. Enter 'y' to confirm the details.

5. When asked for the **password** for 'tomcat' (the alias you entered in the keytool command above), press the 'Enter' key. This specifies that your keystore entry will have the **same password** as your private key.
   
   You MUST use the same password here as was used for the keystore password itself. This is a restriction of the Tomcat implementation.

6. You certificate is now ready. Go to step 2 below.

**Certificate Option 2 – Use a Certificate Issued by a Certificate Authority**

When running Confluence in a production environment, you will need a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority') such as VeriSign, Thawte or TrustCenter. The instructions below are adapted from the [Tomcat documentation](#).

First you will generate a local certificate and create a 'certificate signing request' (CSR) based on that certificate. You will submit the CSR to your chosen certificate authority. The CA will use that CSR to generate a certificate for you.

1. Use Java's `keytool` utility to generate a local certificate, as described in the previous section.
2. Use the `keytool` utility to generate a CSR, replacing the text `<MY_KEYSTORE_FILENAME>` with the path to and file name of the `.keystore` file generated for your local certificate:

   ```bash
   keytool -certreq -keyalg RSA -alias tomcat -file certreq.csr -keystore <MY_KEYSTORE_FILENAME>
   ```

3. Submit the generated file called `certreq.csr` to your chosen certificate authority. Refer to the documentation on the CA's website to find out how to do this.
4. The CA will send you a certificate.
5. Import the new certificate into your local keystore:

   ```bash
   keytool -importcert -alias tomcat -keystore <MY_KEYSTORE_FILENAME> -file <MY_CERTIFICATE_FILENAME>
   ```
If you receive an error, and you use Verisign or GoDaddy, you may need to export the certificate to PKCS12 format along with the private key.

1. First, remove the certificate added above from the keystore:

   ```
   keytool -delete -alias tomcat -keystore <MY_KEYSTORE_FILENAME>
   ```

2. Then export to PKCS12 format:

   ```
   openssl pkcs12 -export -in <MY_CERTIFICATE_NAME> -inkey <MY_PRIVATEKEY_NAME> -inkey <MY_ROOTCERTIFICATE_NAME> -out <MY_PKC12_KEYSTORE_NAME> -name tomcat -C Afile <MY_ROOTCERTIFICATE_NAME> -alsoCalledBundleCertificateInGoDaddy -caname root
   ```

3. Then import from PKCS12 to jks:

   ```
   keytool -importkeystore -deststorepass <MY_DESTINATIONSTORE_PASSWORD> -destkeypass <MY_DESTINATIONKEY_PASSWORD> -destkeystore <MY_KEYSTORE_FILENAME> -srckeystore <MY_PKC12_KEYSTORE_NAME> -srcstoretype PKCS12 -srcstorepass <MY_PKC12_KEYSTORE_PASSWORD> -alias tomcat
   ```

**Step 2. Modify the Server Configuration File in your Confluence Installation**

1. Edit the server configuration file at this location: {CONFLUENCE-INSTALLATION}/conf/server.xml.
2. Uncomment the following lines:

   ```
   <Connector port="8443" maxHttpHeaderSize="8192"
     maxThreads="150" minSpareThreads="25"
     maxSpareThreads="75"
     enableLookups="false" disableUploadTimeout="true"
     acceptCount="100" scheme="https" secure="true"
     clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
     URIEncoding="UTF-8"
     keystorePass="<MY_CERTIFICATE_PASSWORD/>
   ```

3. Replace the text `<MY_CERTIFICATE_PASSWORD>` with the password you specified for your certificate.
4. Make sure that the attribute-value pair `SSLEnabled="true"` is part of the Connector element, as shown above. If this attribute is not present, attempts to access Confluence will time out.
5. Save the server configuration file.

**Step 3. Specify the Location of your Certificate**
By default, Tomcat expects the keystore file to be named .keystore and to be located in the user home directory under which Tomcat is running (which may or may not be the same as your own home directory). This means that, by default, Tomcat will look for your SSL certificates in the following location:

- On Windows: C:\Documents and Settings\#{CURRENT_USER}\.keystore
- On OS X and UNIX-based systems: ~/.keystore

You may decide to move the certificate to a custom location. If your certificate is not in the default location, you will need to update your server configuration file as outlined below, so that Tomcat can find the certificate.

1. Edit the server configuration file at this location: {CONFLUENCE-INSTALLATION}/conf/server.xml
2. Add the attribute `keystoreFile="<MY_CERTIFICATE_LOCATION>"` to the `Connector` element, so that the element looks like this:

   ```xml
   <Connector port="8443" maxHttpHeaderSize="8192"
      maxThreads="150" minSpareThreads="25"
      maxSpareThreads="75"
      enableLookups="false" disableUploadTimeout="true"
      acceptCount="100" scheme="https" secure="true"
      clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
      URIEncoding="UTF-8"
      keystorePass="<MY_CERTIFICATE_PASSWORD>"
      keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
   ```

3. Replace the text `<MY_CERTIFICATE_LOCATION>` with the path to your certificate, including the path and the name of the .keystore file.
4. Save the server configuration file.

**Step 4. Change your Confluence Base URL to HTTPS**

1. In your browser, go to the Confluence Administration Console.
2. Change the Server Base URL to HTTPS. See the documentation on configuring the server base URL.

**Step 5. Add a Security Constraint to Cause Redirect of All URLs to HTTPS**

Although HTTPS is now activated and available, the old HTTP URLs (http://localhost:8090) are still available. Now you need to redirect the URLs to their HTTPS equivalent. You will do this by adding a security constraint in web.xml. This will cause Tomcat to redirect requests that come in on a non-SSL port.

1. Check whether your Confluence site uses the RSS macro. If your site has the RSS macro enabled, you may need to configure the URL redirection with a firewall rule, rather than by editing the web.xml file. Skip the steps below and follow the steps on the RSS Feed Macro page instead.
2. Otherwise, Edit the file at `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml`.
3. Add the following declaration to the end of the file, before the </web-app> tag:
<security-constraint>
  <web-resource-collection>
    <web-resource-name>Restricted URLs</web-resource-name>
    <url-pattern>/</url-pattern>
  </web-resource-collection>
  <user-data-constraint>
    <transport-guarantee>CONFIDENTIAL</transport-guarantee>
  </user-data-constraint>
</security-constraint>


Confluence has two web.xml files. The other one is at `<CONFLUENCE_INSTALLATION>/conf/web.xml`. Please only add the security constraints to `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml`, as described above.

Notes

- **Background information on generating a certificate**: The `keytool -genkeypair` command generates a key pair consisting of a public key and the associated private key, and stores them in a keystore. The command packages the public key into an X.509 v3 self-signed certificate, which is stored as a single-element certificate chain. This certificate chain and the private key are stored in a new keystore entry, identified by the alias that you specify in the command. The [Java SE documentation](https://docs.oracle.com/javase/8/docs/technotes/guides/security/Configuring/keystores.html) has a good overview of the utility.

- **Custom SSL port**: If you have changed the port that the SSL connector is running on from the default value of 8443, you must update the `redirectPort` attribute of the standard HTTP connector to reflect the new SSL port. Tomcat needs this information to know which port to redirect to when an incoming request needs to be secure.

- **Multiple instances on the same host**: When running more than one instance on the same host, it is important to specify the `address` attribute in the `<CONFLUENCE_INSTALLATION>/conf/server.xml` file because by default the connector will listen on all available network interfaces, so specifying the address will prevent conflicts with connectors running on the same default port. See the Tomcat Connector documentation for more about setting the address attribute: [http://tomcat.apache.org/tomcat-5.5-doc/config/http.html](http://tomcat.apache.org/tomcat-5.5-doc/config/http.html)

```xml
<Connector port="8443" address="your.confluence.url.com"
  maxHttpHeaderSize="8192"
  maxThreads="150" minSpareThreads="25"
  maxSpareThreads="75"
  enableLookups="false" disableUploadTimeout="true"
  acceptCount="100" scheme="https" secure="true"
  clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
  URIEncoding="UTF-8"
  keystorePass="<MY_CERTIFICATE_PASSWORD>"
  keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
```

- **Protection for logins only or for individual spaces**: As of Confluence 3.0, Atlassian does not support HTTPS for logins only or for specific pages. We support only site-wide HTTPS. To see the reasoning behind this decision, please see [CONF-18120](https://jira.atlassian.com/browse/CONF-18120) and [CONF-4116](https://jira.atlassian.com/browse/CONF-4116).

**Troubleshooting**
• Check the Confluence knowledge base articles on troubleshooting SSL.

• If any of your users will access Confluence from Internet Explorer 7 on Vista, please note the following additional points when using Java’s keytool utility:
  • Make sure that you specify the -keyalg RSA option, as shown in the example of the keytool command above. The default is the SHA1 algorithm, which results in an error ‘Internet Explorer cannot display the webpage’ on IE7 on Vista.
  • You may also need to specify the -sigalg MD5withRSA option. Otherwise, SHA1 will be used even if you specify the -keyalg RSA option. See this Atlassian blogpost for more information.

• Problems with Internet Explorer being unable to download attachments: Applying SSL site wide can prevent IE from downloading attachments correctly. To fix this problem, edit `<CONFLUENCE_INSTALLATION>/conf/server.xml` and add the following line within the `<Context ... />` element:

```
<Valve className="org.apache.catalina.authenticator.NonLoginAuthenticator"
     disableProxyCaching="true" securePagesWithPragma="false" />
```

Related Topics

• SSL Configuration HOW-TO in the Apache Tomcat 6.0 documentation
• SSL Configuration HOW-TO in the Apache Tomcat 5.5 documentation
•keytool - Key and Certificate Management Tool in the Java SE documentation
• Connecting to LDAP or JIRA or Other Services via SSL
• Supported Platforms

Connecting to LDAP or JIRA or Other Services via SSL

This page describes how to get Confluence connecting to external servers over SSL, via the various SSL-wrapped protocols.

Here are some examples of when you may need to connect to an external server over SSL/HTTPS:

• You need to connect to an LDAP server, such as Active Directory, if the LDAP server is running over SSL.
  For specific instructions for Active Directory, see Configuring an SSL Connection to Active Directory.
• You want to set up JIRA as a trusted application in Confluence, when JIRA is running over SSL.
• You want to refer to an https://... URL in a Confluence macro.

If you want to run Confluence itself over SSL, see Running Confluence Over SSL or HTTPS.

⚠️ The information on this page does not apply to Confluence OnDemand.

✓ There's a Beta version of a Confluence SSL plugin that facilitates this process.

Importing SSL Certificates

The following commands apply to JDK 1.5. For commands/syntax relevant to JDK 1.6, please refer to this document from Oracle.

1. Add the root certificate to your default Java keystore with the following command. This is the certificate that was used to authorise the LDAP server's certificate. It will be either the one that was used for signing it, or will come from further up in the trust chain, possibly the root certificate. This is often a self-signed
In Confluence, when both ends of the SSL connection are within the same network. Again, the exact alias is not important.

```shell
keytool -import -alias serverCert -file RootCert.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -import -alias serverCert -file RootCert.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
```

2. Import your LDAP or JIRA server’s public certificate into the JVM Keystore. This is the certificate that the LDAP server will use to set up the SSL encryption. You can use any alias of your choosing in place of "JIRAorLDAPServer.crt".

```shell
keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
```

3. Verify that the certificate has been added successfully by entering the following command:

```shell
keytool -list -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -list -keystore $JAVA_HOME/jre/lib/security/cacerts (Unix/Linux)
keytool -list -keystore /Library/Java/Home/lib/security/cacerts (Mac)
```

4. Ensure that you have updated JAVA_OPTS to specify the path to the keystore, as specified in Connecting to SSL services, before restarting Tomcat/Confluence.

There is no need to specify an alias for Confluence to use. On connecting to the LDAP server, it will search through the keystore to find a certificate to match the key being presented by the server.

**Troubleshooting**

Check the following knowledge base articles:

- Unable to Connect to SSL Services due to PKIX Path Building Failed
- Sun.security.provider.certpath.SunCertPathBuilderException
- SSL troubleshooting articles

**Related Topics**

- Configuring an SSL Connection to Active Directory
- Configuring Web Proxy Support for Confluence
- Running Confluence Over SSL or HTTPS

**Configuring RSS Feeds**

A Confluence System Administrator can configure the following aspects of RSS feeds:

- The maximum number of items that Confluence returns to an RSS feed request.
- The maximum time period that Confluence allows to respond to an RSS feed request.

Both of these are set in the ‘Edit Security Configuration’ screen.
To configure RSS feeds:

1. Choose **Browse > Confluence Admin**.
2. Click **Security Configuration** in the left panel. The 'Edit Security Configuration' screen will be displayed.
3. Click **Edit**.
4. Edit the value for **Maximum RSS Items**. The default value is 200.
5. Edit the value for **RSS timeout**.
6. Click **Save**.

### Screenshot: Configuring RSS feeds

<table>
<thead>
<tr>
<th>Maximum RSS Items</th>
<th>200</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit the maximum number of items an RSS Feed can request.</td>
<td></td>
</tr>
<tr>
<td>RSS timeout</td>
<td>60</td>
</tr>
<tr>
<td>The time in seconds allowed to create each RSS Feed. Any items rendered within the timeout will still be returned.</td>
<td></td>
</tr>
</tbody>
</table>

### Notes

- When using the RSS **Feed Builder**, a user could potentially enter such a large value for the number of feed items returned that Confluence would eventually run out of memory.
- When using the **Feed Builder**, if a user's a value greater than this setting (or less than 0) they will get a validation error.
- If any pre-existing feeds are set to request more than the configured maximum, they will be supplied with only the configured maximum number of items. This is done silently - there is no logging and no message is returned to the RSS reader.
- If Confluence times out when responding to an RSS feed request, any items already rendered are returned.

### Related Topics

- Using the RSS Feed Builder
- Preventing and Cleaning Up Spam

#### Using the RSS Feed Builder

**Preventing and Cleaning Up Spam**

If you have a public-facing Confluence site, your site may be affected by spammers.

**Stopping Spammers**

To prevent spammers:

1. Enable Captcha. See **Configuring Captcha for Spam Prevention**.
2. Run Confluence behind an **Apache webserver** and create rules to block the spammer’s IP address.

**Blocking Spam at Apache or System Level**

If a spam bot is attacking your Confluence site, they are probably coming from one IP address or a small range of IP addresses. To find the attacker’s IP address, follow the **Apache access logs** in real time and filter for a page that they are attacking.

For example, if the spammers are creating users, you can look for `signup.action:`
Compare the actual spam users being created with the log entries to make sure you do not block legitimate users. By default, Apache logs the client’s IP address in the first field of the log line.

Once you have the offender’s IP address or IP range, you can add it to your firewall’s blacklist. For example, using the popular Shorewall firewall for Linux you can simply do this:

```
# echo "1.2.3.4" >> /etc/shorewall/blacklist
# /etc/init.d/shorewall reload
```

To block an IP address at the Apache level, add this line to your Apache vhost config:

```
Deny from 1.2.3.4
```

You can restart Apache with a “graceful” command which will apply the changes without dropping any current sessions.

If this still does not stop the spam, then consider turning off public signup.

### Deleting Spam

#### Profile Spam

By ‘profile spam’, we mean spammers who create accounts on Confluence and post links to their profile page.

If you have had many such spam profiles created, it is easier to delete them via SQL, as described below.

**To delete a spam profile:**

1. Shut down Confluence and back up your database. **Note:** This step is essential before you run any SQL commands on your Confluence database.
2. Find the last real profile:

   ```
   SELECT bodycontentid, body FROM bodycontent WHERE contentid IN 
   (SELECT contentid FROM content WHERE contenttype='USERINFO')
   ORDER BY bodycontentid DESC;
   ```

3. Look through the bodies of the profile pages until you find where the spammer starts. You may have to identify an number of ranges.
4. Find the killset:
CREATE TEMP TABLE killset AS SELECT
  bc.bodycontentid, c.contentid, c.username FROM
  bodycontent bc JOIN content c ON bc.contentid=c.contentid WHERE
  bodycontentid >= BOTTOM_OF_SPAM_RANGE AND bodycontentID <=
  TOP_OF_SPAM_RANGE
  AND c.contenttype='USERINFO';

DELETE FROM bodycontent WHERE bodycontentid IN (SELECT
bodycontentid FROM killset);

DELETE FROM links WHERE contentid IN (SELECT contentid FROM
killset);

DELETE FROM content WHERE prevver IN (SELECT contentid FROM
killset);

DELETE FROM attachments WHERE pageid IN (SELECT contentid FROM
killset);

DELETE FROM content WHERE contentid IN (SELECT contentid FROM
killset);

DELETE FROM os_user_group WHERE user_id IN (SELECT id FROM killset
k JOIN os_user o ON o.username=k.username);

DELETE FROM os_user WHERE username IN (SELECT username FROM
killset);

5. Once the spam has been deleted, restart Confluence and rebuild the index. This will remove any references to the spam from the search index.

Notes
- See CONF-1469. Your comments that issue are very much appreciated.

Design and Layout
- Choosing a Default Language
- Custom Decorator Templates
- Customising Look and Feel Overview
  - Customising Colour Schemes
  - Customising Site and Space Layouts
    - Adding a Navigation Sidebar
    - Adding an All Versions Section to your Navigation Bar
    - Upgrading Customised Site and Space Layouts
- Global Templates
- Importing Templates
- Modify Confluence Interface Text
- Working With Decorator Macros
- Customising a Specific Page
- Customising PDF or HTML Content
- Customising the Dashboard
- Customising the eMail Templates
- Customising the Login Page
- Themes Overview
### Choosing a Default Language

Administrators can define a default language to be applied to all spaces in your Confluence site. Note that individual users can select a language preference for their session.

**Setting the Default Language**

To change the default language for the Confluence site:

1. Choose **Browse > Confluence Admin**.
2. Select 'Languages' in the 'Configuration' section of the left-hand panel.
3. The 'Language Configuration' screen will appear. Select the language that you want to use as the default language for your Confluence site.

**Other Settings that Affect the Language**

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from highest to lowest:

- The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
- The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too.
- The language set in your browser.
  - Note that your Confluence administrator can disable this option by setting a system property.
  - The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list.
- The default language for your site, as defined by your Confluence site administrator.

**Showing User Interface Key Names for Translation**

For those customers working on creating translations of the Confluence user interface, from 4.1 onwards there is a feature that will help. After opening the Confluence dashboard, you can simply add this text to the end of your Confluence URL, like so:
Then press Enter.

This will then cause each element of the user interface to display its special key name while Confluence is still in an interactive mode. This makes it easier to find the essential context for each key, which can then be searched on http://translations.atlassian.com where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a "lightning bolt" graphic between elements of the names. For example, the buttons will show up with elements shown like so:

For example, for the Browse button, the associated key system.space.menu can be found on http://translations.atlassian.com, allowing you to write a better translation for the term Browse, being able to see the full context of where the UI element belongs and what it means to the user.

To turn off the translation view, add this code to the end of the Confluence URL:

?i18ntranslate=off

RELATED TOPICS

Editing User Settings
Recognised System Properties
Configuring Indexing Language
Installing a Language Pack

Custom Decorator Templates

About Decorators

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through "decorators" that define a page's layout and structure, and into which the specific content of the page is placed. If you are interested, you can read more on the SiteMesh website.

What this means for Confluence is that you can customise the look and feel of almost all of your Confluence site through editing three decorators:

- The "Main" decorator defines the look and feel of most pages on the site
- The "Popup" decorator defines the look and feel of the popup windows such as the "Insert Link" and "History" pages.
- The "Printable" decorator defines the look and feel of the printable versions of pages (available through the icon on each page)

You can view and edit these decorators from within Confluence: they are available from the "Layouts" option on the site's Administration menu. Changes to the decorators will affect all spaces hosted on that Confluence
installation.

The decorator that is used to draw Confluence's administrative pages can not be edited from within Confluence. This means that if you make some editing mistake that renders the rest of the site unuseable, the administrative pages should still be available for you to fix the template.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Browsing the Default Decorators**

At any time, you can browse the default decorators that come packaged with Confluence by following the "View Default" links on the "Site Layouts" page. The template browser also allows you to view the "#parsed" templates that are included within the template when it is compiled. While you can't edit these included templates, you will probably have to copy some or all of them into your custom template as you do your customisation.

**Editing Custom Decorators: Add a Logo**

To edit Confluence decorators, you should have a good knowledge of [HTML](https://www.w3.org/html), and some understanding of the [Velocity templating language](https://velocity.apache.org/).

The first thing you will see when you choose to create a custom "Main" decorator is... there's not much to edit. By default, most of the content of this decorator is included from other files:
We can add our logo, changing the "logocell" table cell:
When you insert this into the right section of the template and hit save, visitors to the site will see the logo at the top of each page. Note, the administrative pages will be unaffected: you will have to go to the dashboard or to a space to see the changes you have made.

**Macros**

Some parts of the page are drawn using Velocity macros, including the navigation bar. The macros you should know about when editing decorators are described in [Working With Decorator Macros](#).

**If Something Goes Terribly Wrong**

From the "Site Layouts" page in Confluence's administrative menu, you can delete your custom templates. When you do this, the default template will be restored, fixing anything that may have been broken.

Alternatively, the custom templates are stored in the DECORATOR table in the database. If you have somehow managed to render Confluence completely unuseable through editing your templates, delete the relevant entries from the DECORATOR table.

**For Advanced Users**

The `velocity` directory is at the front of Confluence's velocity template search path. As such, you can override any of Confluence's velocity templates by placing an identically named file in the right place.

While we don't recommend you do this unless you know exactly what you're doing, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through the web interface.

There are, however, two important caveats:

1. Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in `WEB-INF/classes/velocity.properties`, or restart the server to make your changes visible.
2. Because we only officially support the modification of the three global decorator files, other changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site.

**Customising Look and Feel Overview**

You can customise the 'look and feel' of Confluence at both the global and space levels.

Any changes you make to the look and feel of the site at the global level will be applied as the default look and feel for all the spaces in the site. This means that any customisations will only be reflected in the "Default" theme. No other theme will have an impact from this change. An individual space can be configured to have its own look and feel through the [space administration screens](#).

⚠️ Some functionality described on this page is restricted in [Confluence OnDemand](#).

Here's how you can customise the look and feel of your site:

- **Colour Scheme** : Change the colour scheme of the user interface.
Layouts: Change the site layout, which determines how the controls are laid out in the site. This does not change the actual page layouts, but it does change the way the surrounding controls appear in the page.
Themes: Use themes for advanced layout customisation.

RELATED TOPICS

No content found for label(s) customising-looknfeel.

Customising Colour Schemes
A Confluence administrator can configure a new colour scheme for the site dynamically from the Administration Console.

The default colour scheme for the site will also become the default for all spaces within it. However, it is possible for space administrators to configure a different colour scheme for spaces from the space administration screens.

To change the site's colour scheme:

1. Choose Browse > Confluence Admin.
2. Select 'Colour Scheme' in the left-hand panel. This will bring up a new screen. See screenshot below.
3. Click 'Edit'. Enter standard HTML/CSS2 colour codes, or use the colour-picker to choose a new colour from the palette provided. Any changes you make will immediately be reflected across the Confluence installation.

The colour scheme applies to the following UI elements:

- Top Bar - the bar across the top of the page that contains the breadcrumbs
- Tab Navigation Background - the background colour of the tab navigation menus
- Tab Navigation Text - the text of the tab navigation menus
- Breadcrumbs Text - the breadcrumbs text in the top bar of the page
- Space Name Text - the text of the current space name located above the page title
- Heading Text - all heading tags throughout the space.
- Links - all links throughout the space.
- Borders and Dividers - table borders and dividing lines.
- Tab Navigation Background Highlight - the background colour of the tab navigation menu when highlighted
- Tab Navigation Text Highlight - the text of the tab navigation menu when highlighted
- Top Bar Menu Selected Background - the background colour of the top bar drop down menu when selected
- Top Bar Menu Item - the text colour of the menu items in the top bar drop down menu
- Page Menu Selected Background - the background colour of the drop down page menu when selected
- Page Menu Item Text - the text of the menu items in the drop down page menu
- Menu Item Selected Background - the background colour of the menu item when selected (applies to both the top bar and page drop down menus)
- Menu Item Selected Text - the text colour of the menu item when selected (applies to both the top bar and page drop down menus)

Please note that some UI elements are specific to the default theme and may not take effect for other themes.
Note

If you mess things up, just click the 'Reset' button and then try again.

Related Topics

No content found for label(s) customising-looknfeel.

Customising Site and Space Layouts

You can modify Confluence's look and feel by editing the 'decorator' (layout) files. Modifying these files allows you to change the look and feel of:

- The Confluence site as a whole, which includes all spaces within the Confluence site.
- An individual space within the Confluence site.

This page tells you how to customise the layout files for your Confluence site as a whole. These customisations:

- Modify the default 'decorator' files of each space in your site.
- Are reflected in every space unless the space's own equivalent layout files have been customised.

You need System Administrator permissions to perform these customisations.
You can also customise the layout files for a given space. For more information, refer to Customising Space Layouts. Space layout customisations override the equivalent site customisations.

⚠️ The information on this page does not apply to Confluence OnDemand.

⚠️ If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with your customisation. For more information on updating your customisations, please refer to Upgrading Customised Site and Space Layouts.

Confluence is built on top of the open source SiteMesh library, a web-page layout system. Read more on the SiteMesh website. To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a very simple programming language called Velocity. You can learn more from the Velocity User Guide.

Once you are familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, the header and the footer.
- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but allow you to alter the way the surrounding comments or attachments are displayed.
- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.

**Editing a site decorator file**

1. Choose Browse > Confluence Admin.
2. Select Layouts under Look and Feel in the left-hand navigation panel.
   - Click View Default to view the .vmd file.
   - Click Create Custom to edit the default .vmd file. This will open up the .vmd file in edit mode.
3. Make changes and click Update.

If something goes wrong: Click Reset Default to revert to the original layouts.

**Using Velocity macros**

When editing Custom Decorator Templates, there are a number of macros available to define complex or variable parts of the page such as menus and breadcrumbs. You may insert these macros anywhere in your templates. More information on Working With Decorator Macros.

**For advanced users**

**Overriding Velocity templates**

The velocity directory is at the front of Confluence's Velocity template search path. As such, you can override any of Confluence's Velocity templates by placing an identically named file in the right place. While we don't recommend you do this unless you know exactly what you're doing, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through the web interface.
Caching

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in WEB-INF/classes/velocity.properties, or restart the server to make your changes visible.

Location of Velocity files

In Confluence 2.6 and later, some Velocity files are located inside the Confluence JAR file that can be found at confluence/WEB-INF/lib/confluence-x.x.x.jar. To override files inside this JAR (which you can open with any ZIP tool like WinZip or 7-Zip), put your customised file in the same directory structure under confluence/WEB-INF/classes/.

For example, the file templates/macros/alphaindex.vm inside confluence.jar can be replace by putting your custom file in WEB-INF/classes/templates/macros/alphaindex.vm. You do not need to modify the file inside the JAR.

See also How Do I Edit Files in Confluence JAR Files?

Finding the layout via the URL

If the layout has changed so extensively as to not be visible, you can browse to the URL directly:

```
http://<confluence base url>/admin/resetdecorator.action?decoratorName=decorators/main.vmd
```

Substitute the base URL and the appropriate .vmd file.

RELATED TOPICS

No content found for label(s) customising-looknfeel.

Velocity Template Overview
Basic Introduction to Velocity

Adding a Navigation Sidebar

You can include a left-hand navigation sidebar (table of contents) in your Confluence space. There are two ways to do this:

- **Recommended: Use the Documentation Theme** – The Documentation theme provides the left-hand navigation sidebar that you see in this documentation. Please go to the page that tells you how to configure the Documentation theme.
- **Customise the Space Layouts** — This is an alternative method (documented below) that is more complex to set up than the Documentation theme and requires more maintenance with Confluence major release upgrades.

⚠️ The information on this page does not apply to Confluence OnDemand.

Notes to Read before you Start
Please take note of the following points before you use the method documented on this page:

- **Reapply customisation whenever you upgrade Confluence.** Every time you upgrade Confluence, you must reapply the layout customisations described on this page. When you upgrade to a new major Confluence version (such as moving from Confluence 2.9.x to Confluence 2.10.x or from Confluence 3.0.x to Confluence 3.1.x) you will need to reapply the layout customisation. See instructions below.
- **Check your wiki permissions.** To customise a space layout as described below, you must be a space administrator in the given space and you must be a system administrator on the Confluence site. See the overview of permissions and the glossary entries for space administrator and system administrator.

Customising your Space Layouts to Add a Navigation Sidebar

**Screenshot: A left-hand navigation bar resulting from customising the space layouts**

Follow the instructions below to add the navigation sidebar to your Confluence space.

**Step 1. Create the TreeNavigation Page**

First, you will create a Confluence page containing the `pagetree` macro. This is just a normal Confluence page. The only slight oddity is that it should reside at the root of your space, instead of under the space’s home page.

Follow these instructions:

1. Go to the ‘Space Pages’ view for the current space. To do this:
   - Go to a page in the space and choose **Browse > Pages**.
   You are now at the ‘root’ level of your space. The ‘root’ level contains pages that are added above the space’s home page, not as children of the home page.
2. At the root level of the space, create a page named ‘TreeNavigation’.
3. On the page, insert the following text:

   ```
   {pagetree}
   ```
4. Now decide if you want to add extra functionality to your page tree. By default, using the code above, the page tree will use the home page of the space as its root. You can choose to:
   - Specify a different root for your page tree.
   - Add a search box at the top of the tree.
   - Allow the viewers to expand and collapse the whole tree.
   - Control other aspects of the display.
   For more information, read about the Pagetree macro.

**Step 2. Change the Space's Page Layout**

Now you will change the space's page layout, to include the above page on the left of every web page displayed.

1. Choose **Browse > Space Admin**.
   *Note:* 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
2. Make sure the Confluence Default theme is selected from the **Themes** menu.
3. Click **Layout** in the **Look and Feel** section.
   *Note:* The layout option is only displayed if you are a system administrator on the Confluence site.
4. Click **Create Custom** in the **Page Layout** section.
5. In the layout, locate the **VIEW** section, and find this code:

```html
<div class="wiki-content">
$body
</div>
```

6. Replace the above code block with this code:
7. If you want to, you can change the table title in the above code from 'Table of Contents' to something else. For example, it might say 'Confluence Documentation'.

8. Save the updated layout.

### Reapplying the Customisation on Upgrade

When you upgrade to a new major Confluence version (e.g. from Confluence 2.9.x to Confluence 2.10.x or from Confluence 3.0.x to Confluence 3.1.x), you will need to reapply this customisation.

**Reason:**
The new Confluence version may contain updates to the space layouts. Because you have customised the space layouts, Confluence will not overwrite your customisation. So your space will not get the latest updates until you set the layout to default and then reapply your changes.

**Here's how to do it:**

1. First make a copy of your customised code, if you have changed it from the code above:
   - Go to **Space Admin**, click **Layout** and edit the customised page layout (as created above).
   - Copy the section of code that inserts the customised left-hand navigation panel.
   - Close the page layout.
2. Click **Reset Default** next to **Page Layout**, to set the page layout back to default. This will bring in the new code for the upgraded version of Confluence.
3. Create a custom layout as described in step 2 above, and reinsert the custom left-hand navigation code.
4. Save the updated layout.

**RELATED TOPICS**

- Configuring the Documentation Theme
- Customising Site and Space Layouts
- Upgrading Customised Site and Space Layouts
- Example Confluence Designs

**Adding an All Versions Section to your Navigation Bar**

This page gives an example of how you might add an 'All Versions' section to your navigation side bar, as currently used in the Confluence documentation, Crowd documentation and the other Atlassian product documentation spaces.

If you are viewing this page online on the Atlassian documentation wiki, you will be able to see the 'All Versions' section at the top left of the navigation sidebar. Below is a screenshot.

A number of people have asked how we do it, so this page gives the answer. For details about creating the navigation side bar itself, please refer to Adding a Navigation Sidebar.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Adding the Version Index to the Navigation Sidebar**

This is how we added the 'All Versions' section to the sidebar:

- For each product (Confluence, Crowd, Bamboo, etc) there is a page in the Inclusions Library of the ALLDOC space. The page lists all the versions of that product's documentation, linking to the relevant spaces. For example, here is the page for Confluence and the page for Crowd.
  - We put the 'all versions' page in ALLDOC because the page is used in a number of different spaces, via the {include} macro. For example, the 'all versions' page may be included:
    - In every documentation space (each version) for the product concerned, such as DOC, CONF29, CONF28, CROWD, CROWD013, CROWD012, etc.
    - In the Enterprise Hosting doc space.
    - As a panel on the documentation home page, as shown in the 'All Versions' panel of the above screenshot, as well as in the left-hand navigation bar.
    - Any other places where useful.
- In each documentation space, there is a page called 'TreeNavigationVersions' like this one or this one, which copies in the content of the above 'all versions' page.
- For each documentation space, the space's page layout now includes two pages instead of just one:
  - The 'TreeNavigation' page, as already described on the page above.
  - The new 'TreeNavigationVersions' page.

Here's the relevant section of our page layout as it is currently for the Confluence documentation (DOC) space:
Adding the Expand/Collapse Functionality to the Version Index

Another question we are asked is how we group the content of the included page under a collapsible control.

We use the Expand macro. The details are on the Expand macro’s documentation page.

Related Topics

Adding a Navigation Sidebar

Upgrading Customised Site and Space Layouts

As Confluence evolves, so do the default site and space layouts that drive the rendering of every page. As new functionality is added or current functionality is changed, the default layouts are modified to support these changes.

⚠️ If you are using custom layouts based on defaults from a previous Confluence version, you run the risk of breaking functionality, or worse, missing out on great new features!

Take care on each new release of Confluence to reapply your changes to the new default templates.
To reapply your custom layouts, you need to:

1. Obtain the source of your custom layouts from your current version of Confluence.
2. Reapply your customisations to the new default layouts.

⚠️ The information on this page does not apply to Confluence OnDemand.

Step 1. Obtain your Custom Layouts

Ideally, you should keep a record of each customisation you have applied to each of your Confluence site or space layouts.

If not, you should be able to find your customisations using the following method. This method extracts all site- and space-level layouts from your Confluence site as a single output. From this output, you should be able to identify your customisations.

☑ This method is handy to use if you have:

- Many spaces with space layout customisations, or
- Do not have an independent record of your site or space layout customisations.

Custom layouts are stored in the `DECORATOR` table within your Confluence database. You can **SELECT** for the source of the layout using SQL like this:

```sql
mysql> select SPACEKEY, DECORATORNAME, BODY from DECORATOR;
+----------+---------------------+------+
| SPACEKEY | DECORATORNAME       | BODY |
|----------+---------------------+------+
| NULL     | decorators/main.vmd | ...  |
+----------+---------------------+------+
```

This example was tested on MySQL, but should be applicable to all SQL databases.

Step 2. Reapply your Customisations

When you upgrade Confluence to another major release of Confluence, you will need to manually reapply any customisations you made to any site-wide or space-specific layouts. Unless otherwise stated, you should not need to reapply customisations after conducting a minor release upgrade of Confluence.

What are 'major' and 'minor' releases? Major release upgrades are ones where the 1st digit of Confluence's version number or the 1st digit after the 1st decimal place differ after the upgrade, for example, when upgrading from Confluence 3.0 to 3.1, or 2.8 to 3.0. Minor release upgrades are ones where the 1st digit of Confluence’s version number and the 1st digit after the 1st decimal place remain the same after the upgrade, for example, when upgrading Confluence 3.0 to 3.0.1.

If you have made Confluence site-wide layout customisations:

1. Choose **Browse > Confluence Admin**.
2. Select **Layouts** under **Look and Fee** in the left-hand navigation panel. The decorators are grouped under Site, Content and Export layouts.
3. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).
4. Click **Reset Default** next to the layout whose customisations need to be reapplied.
5. Click **Create Custom** next to the same layout and reapply your customisations (by copying and pasting...
them) into the appropriate locations within the new default layout.
6. Click the **Save** button.
7. Repeat this procedure from step 4 for each layout whose customisations need to be reapplied.

If you have made space-specific layout customisations:

1. Visit any page in the relevant space.
2. Choose **Browse > Space Admin**.
   *Note:* ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).
3. Click **Layout** under **Look and Feel** in the left-hand navigation panel. The decorators are grouped under **Site**, **Content** and **Export** layouts.
4. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).
5. Click **Reset Default** next to the layout whose customisations need to be reapplied.
6. Click **Create Custom** next to the same layout and reapply your customisations (by copying and pasting them) into the appropriate locations within the new default layout.
7. Click the **Save** button.
8. Repeat this procedure from step 5 for each layout whose customisations need to be reapplied.

**Step 3. Test your Modifications Carefully**

Changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site. It's beyond the scope of Atlassian Support to test and deploy these changes.

**Turning Off Caching**

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off Velocity’s caching temporarily in `WEB-INF/classes/velocity.properties`, or restart the server to make your changes visible.

The `velocity.properties` file is available in the `confluence-x.x.x.jar` file, where `x.x.x` is the Confluence version number. The JAR file is located in the `WEB-INF/lib` directory. If you wish to make modification to the files in the JAR, we recommend the following steps:

1. Stop Confluence.
2. Make a backup copy of the JAR file.
3. Un-jar the file
4. Locate and edit the appropriate file that you wish to modify.
5. Re-jar the `confluence-x.x.x.jar` file.
6. Relocate the JAR file to the appropriate directory.
7. Restart Confluence.

**RELATED TOPICS**

**Customising Site and Space Layouts**

**Global Templates**

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. See [Working with Templates](#).

**Importing Templates**

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format.
Confluence ships with a number of templates, including the 'Charts', 'Document List' and 'Meeting Notes' templates. These templates are not available for use by default. However, if you have the appropriate permissions to access the Administration Console, you can import any of these templates to be used globally or within a specific space.

In addition, you can download additional template bundles from the Atlassian Plugin Exchange and then make them available by importing them.

**Quick guide to importing a template:**

1. Go to the Confluence Administration Console and choose **Import Templates**.
2. Select the templates that you want to import.
3. Select the space to import the templates to, or choose to import them as global templates.
4. Choose **Import**.

The rest of this page gives more detail about the above steps.

**On this page:**

- Step 1. Check the templates installed on your Confluence site
- Step 2. (Optional) Upload additional templates from the Atlassian Marketplace
- Step 3. Import a template to make it available to users
- Notes

**Related pages:**

- Working with Templates
- Editing a template
- Removing a Template
- Working with Pages

**Step 1. Check the templates installed on your Confluence site**

To see the templates that are currently available for import on your Confluence site:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose **Browse > Confluence Admin**.
3. Select 'Import Templates' in the left-hand panel. The 'Import Templates' screen will appear, listing the template packages installed on your Confluence instance (for example, 'Default Templates Package') and the templates included in each package.

**Step 2. (Optional) Upload additional templates from the Atlassian Marketplace**

Additional templates are available as plugins, known as template packages. Follow the steps below if you want to add template packages to your site that were not shipped with your Confluence installation.

*Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.*

**To upload more templates:**

1. Go to the Atlassian Marketplace and download the template bundle that you need.
2. Log in to Confluence as a System Administrator or Confluence Administrator.
3. Choose **Browse > Confluence Admin**.
4. Choose **Plugins** in the left-hand panel.
5. The **Plugins** screen will appear. Choose the **Install Plugins** tab.
6. Choose **Upload Plugin**, browse to find the template bundle file that you downloaded, and upload it to Confluence.

**Step 3. Import a template to make it available to users**
To import a template:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose Browse > Confluence Admin.
3. Choose Import Templates in the left-hand panel. The Import Templates screen will appear, listing the template packages installed on your Confluence site (for example, 'Default Templates Package') and the templates included in each package.
4. Select the templates to be imported by ticking the check boxes next to the relevant template names. **You can see a preview of the template by clicking the template name.**
5. Select the import destination for the templates in the Import To dropdown. If you want the templates to be available to only a specific space, select the name of the space, otherwise select **Global Templates** to make the templates available to all spaces.
6. Choose Import.

**Screenshot: Importing a template**

**Screenshot: Previewing a template**

**Notes**

- **Building your own custom template bundles.** You can build a template bundle as a plugin and then
deploy it to your Confluence instance. You can then import the templates from your custom template bundle, as described above. You will need some programming knowledge to develop a custom template bundle. See Creating A Template Bundle.

- **Duplicate template names.** If a template with the same name already exists on import, a duplicate template of the same name will be created. You will need to check the templates and rename them manually.

- **Removing the template.** Removing the plugin that contains a template will not remove the template from your Confluence site if you have already imported it. You will need to remove the template manually via the administration console or space administration screen.

**Modify Confluence Interface Text**

All Confluence UI text is contained in a single Java properties file. This file can be modified to change the default text, and also to translate Confluence into other languages than English.

The UI text file is ConfluenceActionSupport.properties. From your Confluence install directory:

```
\confluence\WEB-INF\lib\confluence-3.x.jar
```

Within this File, the relevant file to edit is :
```
:\com\atlassian\confluence\core\ConfluenceActionSupport.properties.
```

Refer to Editing jar files for reference.

⚠️ The information on this page does not apply to Confluence OnDemand.

The file contains parameters with name=value pairs, in the format:

```
parameter.name=Parameter value
```

Parameter names are any text before the '=' character and should never be modified. Any text after the '=' character is the parameter value, which can be modified freely and can also contain variables. An example involving variables is:

```
popular.labels=The three most popular labels are {0}, {1} and {2}.
```

For more information on replacing values, check out Translating ConfluenceActionSupport Content. Note that plugins store their text internally, so you must modify plugin text individually.

**Steps For Modification**

1. Stop Confluence
2. Under your install directory, open `\confluence\WEB-INF\lib\confluence-3.x.jar\com\atlassian\confluence\core\ConfluenceActionSupport.properties`
3. Search for the text you wish to modify, replace it and save the file in `<Confluence-Install>\confluence\WEB-INF\classes\com\atlassian\confluence\core`. Please create this folder structure, if it does not exist already.
4. Restart Confluence

Common Modifications

- Rename 'Dashboard' by searching for Dashboard. To change "Dashboard" to "My Portal", change `dashboard.name=Dashboard` to `dashboard.name=My Portal`

<table>
<thead>
<tr>
<th>Task</th>
<th>Search For</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename 'Dashboard'</td>
<td>Dashboard</td>
<td>The <code>dashboard.name</code> parameter has the name. To change 'Dashboard' to 'My Portal', change <code>dashboard.name=Dashboard</code> to <code>dashboard.name=My Portal</code> and update any other occurrences of the word 'Dashboard' in the instance</td>
</tr>
<tr>
<td>Modify login page text</td>
<td>login.</td>
<td>The <code>login.instructions</code> parameter has the &quot;Enter your account details below to login to Confluence&quot; text</td>
</tr>
</tbody>
</table>

Modify Keyboard Shortcuts

Confluence provides a set of keyboard shortcuts. You could customise the shortcuts by making modifications inside the `ConfluenceActionSupport.properties` file.

- To disable a particular shortcut, you can simply just comment out a respective line of code. One may like to disable the shortcut to one of the navigation links: View, Edit, Attachments, Info. For instance, to disable shortcut to Attachments one would comment out the following line:

  ```
  #navlink.attachments.accesskey=a
  ```

- To modify an access key, one could simply just change the letter, bearing in mind the fact that the letter must be unique.

Working With Decorator Macros

Decorator Macros are Velocity macros which are used to draw complex or variable parts of the page such as menus and breadcrumbs when editing Custom decorators. Decorator macros can be inserted anywhere in your templates.

The macro is called by inserting a string of the form: `#macroName("argument1" "argument2" "argument3")`. There are no commas between the arguments. Unless otherwise noted, these macros take no arguments.

**NOTE**: These macros will only work reliably when customising `main.vmd`. They may not work in other Velocity decorators. Decorator macros will not work inside normal confluence pages.
<table>
<thead>
<tr>
<th>Macro</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>#breadcrumbs()</td>
<td>Draws the &quot;You are here&quot; breadcrumbs list, like the one found above the page name in the default template.</td>
</tr>
<tr>
<td>#includePage(pageTitle)</td>
<td>Includes a confluence page with the specified title. If you have 2 or more pages with the same title across multiple spaces, this macro will include the page belonging to the space you are currently viewing.</td>
</tr>
<tr>
<td>#searchbox()</td>
<td>Inserts a search box into the page, like the one to the far right of the breadcrumbs in the default template.</td>
</tr>
<tr>
<td>#globalnavbar(type)</td>
<td>Draws the global navigation bar, as found in the top right-hand corner of the default template. The navigation bar can be displayed in two modes:</td>
</tr>
<tr>
<td></td>
<td>#globalnavbar(&quot;table&quot;) Displays the navigation bar in its default mode: drawn as a table of links with coloured backgrounds and mouse-over effects.</td>
</tr>
<tr>
<td></td>
<td>#globalnavbar(&quot;text&quot;) Displays the navigation bar as series of text links separated by</td>
</tr>
<tr>
<td></td>
<td>#usernavbar()</td>
</tr>
<tr>
<td></td>
<td>#helpicon()</td>
</tr>
<tr>
<td></td>
<td>#printableicon()</td>
</tr>
<tr>
<td></td>
<td>#pagetitle(class)</td>
</tr>
</tbody>
</table>
#poweredby()  
Writes out the "Powered by Confluence" and Confluence version-number boilerplate found at the bottom of the default template.

#bottomshadow()  
Draws the fading shadow-effect found at the bottom of the content area in the default template.

#dashboardlink()  
Inserts a link to the dashboard page.

### RELATED TOPICS

No content found for label(s) admin-macros.

#### Customising a Specific Page

If you'd like to change the appearance of a specific page, you can modify the corresponding Velocity template. Here's how to find out which one:

1. Access the page. Note the name of the action. For example, the "Contact Administrators" page is <baseURL>/administrators.action.
3. Unzip or unjar the file using a standard unzipper or the java jar utility.
4. Open xwork.xml. Search the file for the name of the action corresponding to the page you'd like to modify. You'll see an entry like:

   ```xml
   <action name="administrators"
   class="com.atlassian.confluence.user.actions.AdministratorsAction">
   <interceptor-ref name="defaultStack"/>
   <result name="success" type="velocity">/administrators.vm</result>
   </action>
   ```

5. The file to look for is the vm or vmd file. In the above example, it's administrators.vmd. Because there is no context path (just a / before the name of the file), it's in the root of the Confluence webapp. For the stand-alone, that's <confluence-install>/confluence folder.
6. Modify the file.

For details on how to configure the file, check the [Velocity Template Overview](#).

⚠️ The information on this page does not apply to Confluence OnDemand.

### RELATED CONTENT

No content found for label(s) customising-looknfeel.

#### Customising PDF or HTML Content

To customise Confluence's PDF output, you can edit the CSS stylesheets used by the PDF exporter. See [Customising Exports to PDF](#).

To customise the HTML output, you will need to modify the file `confluence-x.y.z.jar/com/atlassian/confluence/pages/Page.htmlexport.vm`. See [How Do I Edit Files in Confluence JAR Files?](#) to learn how
Customising the Dashboard

If you are a Confluence Administrator, you can customise the global dashboard, affecting the way all users will see the dashboard.

Confluence users can customise their own view of the dashboard too. See the user's guide.

Sending users to a space home page instead of the dashboard

See Configuring the Site Home Page.

Editing the top left-hand section of the dashboard

See Editing the Site Welcome Message.

Disabling the 'Popular' tab on the dashboard

In some environments, you may prefer not to display the new 'Popular' tab on the dashboard. For example, if your wiki allows only a small group of people to log in and contribute content or comments, then the tab may not be relevant to you.

To prevent the tab from appearing, you can disable the relevant plugin module. You need System Administrator permissions to do this. Go to the Dashboard Macros plugin (See Configuring a Plugin), click Manage plugin modules and disable the Popular Tab module.

On this page:

- Sending users to a space home page instead of the dashboard
- Editing the top left-hand section of the dashboard
- Disabling the 'Popular' tab on the dashboard
- Advanced customisations
  - Editing the bottom left-hand section of the dashboard
  - Editing the top right-hand action bar
  - Modifying the global template or layout

Related pages:

- Customising your Personal Dashboard
- Customising Look and Feel Overview

⚠️ The information on this page does not apply to Confluence OnDemand.

Advanced customisations

These configurations require knowledge of plugin development and/or the Velocity template language. See our guide to the Atlassian Plugin SDK and our introduction to Velocity.

Editing the bottom left-hand section of the dashboard

This section can be updated using Confluence web panels. You can add items to the dashboard by including a web panel with the key atl.dashboard.left:
Confluence 4.3 Documentation

<web-panel key="{key}" location="atl.dashboard.left">
<resource name="view" type="velocity"
location="{location}"/>
</web-panel>

You can remove the existing entities panel by disabling the global-entities-panel plugin from the dashboard
macros plugin.
Editing the top right-hand action bar

You can add more links to the top right navigation bar by adding web items to system.dashboard.button:

<web-item key="{key}" name="{name}" section="system.dashboard.button">
<label key="{label}"/>
<link/>
<styleClass/>
</web-item>

Modifying the global template or layout

You can also modify files to add content to the global dashboard.
To make modifications to the dashboard, modify the global template /confluence/decorators/global.vm
d or the layout at Administration > Layouts > Global Layout.
For example, search the global layout for these macros:

$helper.renderConfluenceMacro("{recently-updated-dashboard:dashboard|sho
wProfilePic=true}")

To modify the bundled plugin macros used in the Confluence dashboard:
1. Modify the atlassian-bundled-plugins.zip file located at <Confluence
install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup.
2. Update the confluence-dashboard-macros-x.x.jar file, rezip it and then put it back to <Conflue
nce install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup. Refer to
How Do I Edit Files in Confluence JAR Files?.
3. Delete the JAR from <confluence-home>/bundled-plugins.
4. Restart Confluence.
To customise the space list, you can work with spacelist.vm.

Customising the eMail Templates
Customisations to the Confluence email templates will need to be reapplied when you
upgrade Confluence. Consider this before making drastic changes to the layout, and be sure
to keep a list of what you have changed for your upgrade process later.

Only administrators with access to the server where Confluence is running can modify the Confluence email
templates.

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.

1366


Process to change the email templates

1. Shut down your test instance of Confluence.
2. In the Confluence web application folder, find the file `confluence/web-INF/lib/confluence-2.x.jar`.
3. Make a copy of this file as a backup.
4. Learn how to edit files within .jar archives.
5. Within the jar file, find the `/templates/email` folder. Find the appropriate file(s) within that folder.
6. Edit the file with a text editor to make the required changes. The content is mostly HTML, but has some Velocity template variables in it. See Velocity Template Overview for more information about how these work.
7. Again using the guide on editing files within .jar archives, either rejar the set of folders or drop the new files into the identical folder structure in the `WEB-INF/classes` directory.
8. Start Confluence up again and test your changes.
9. Apply the changes to your production Confluence instance.

The same process can be applied to modify most of the templates in the Confluence web application. For velocity files that are not in a jar file, you need not shut down and restart Confluence. Be careful to test your changes before applying them to a live site. The templates contain code that is vital for Confluence to function, and it is easy to accidentally make a change that prevents use of your site.

**RELATED TOPICS**
- Velocity Template Overview
- Customising Site and Space Layouts
- Customising Look and Feel Overview
- Modify Confluence Interface Text

**Customising the Login Page**

This page gets you started on customising the Confluence login page, to add your own logo or custom text. This will not customise the login process, just what users sees when they log in.

**Notes:**
- Customisations to the Confluence login page will need to be reapplied when you upgrade Confluence. Consider this before making drastic changes to the layout, and be sure to keep a list of what you have changed for your upgrade process later.
- Please test your changes on a test Confluence site first.

Only administrators with access to the server where Confluence is running can modify the Confluence login page.

**Related pages:**
- Editing the Global Logo
- Velocity Template Overview
- Customising Site and Space Layouts
- Customising Look and Feel Overview
- Modify Confluence Interface Text

⚠️ The information on this page does not apply to Confluence OnDemand.
To change the login page:

1. Shut down your Confluence server.
2. In the Confluence installation directory, find the file `confluence/login.vm`.
3. Make a copy of this file as a backup.
4. Edit the file with a text editor to make the required changes. The content contains a mixture of HTML and Velocity. See Velocity Template Overview (in our developer documentation).
5. Start Confluence and test your changes.

The same process can be applied to modify most of the templates in the Confluence web application. Be careful to test your changes before applying them to a live site. The templates contain code that is vital for Confluence to function, and it is easy to accidentally make a change that prevents use of your site.

Themes Overview

Themes are pre-defined style sets that can be applied to alter the appearance of your site. Themes allow you to personalise the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site and to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. In addition, a site administrator can install new themes as plugins via the Confluence Administration Console. Provided that the theme is installed into your Confluence site, any space administrator can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.

To look at the themes installed:

1. Choose Browse > Confluence Admin.
2. Select 'Themes' under 'Look and Feel' in the left-hand panel.
3. You will see a list of all installed themes.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Adaptavist's Theme Builder Plugin for Confluence allows you to customise your Confluence site by adding layouts, logo banners, menu-driven navigation, style sheets, footers and more.

Related Topics

No content found for label(s) themes-configuration.

Applying a Theme to a Site

Themes allow you to personalise the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site and to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. In addition, a site administrator can install new themes as plugins via the Confluence Administration Console. Provided that the theme is installed into your Confluence site, any space administrator can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.
To apply a theme across the site,

1. Ensure that the theme you wish to apply has been installed as a plugin.
2. Choose Browse > Confluence Admin.
3. Select 'Themes' under 'Look and Feel' in the left-hand panel.
4. The screen will display all available themes. Click a radio button to select a theme.
5. Click 'Confirm'.

Screenshot: Applying a theme

RELATED TOPICS

No content found for label(s) themes-configuration.

Customising the Left Navigation Theme

⚠️ The Left Navigation theme is no longer part of Confluence

This theme is no longer part of Confluence and is not supported from Confluence 3.4 onwards. We suggest the Documentation theme, as it provides a customisable left-hand navigation panel and additional configurable features. If you are using an earlier version of Confluence, please refer to the documentation for your version. For example, go to the documentation for Confluence 3.3.

Modifying Look and Feel (for themes)

Here's how you can define a new look and feel for Confluence in your theme:

1. Layout: Edit Confluence’s layout by modifying the decorator files that are used to define it.
   - Working with Decorators
   - Velocity Template Overview
1. Configuring the `atlassian-plugin.xml` file to reference the decorators

2. **Colour schemes**: Configure a new colour scheme for your theme. **Optional**
   - **Configuring a new colour scheme**
   - **Configuring the `atlassian-plugin.xml` file to include the new colour scheme**

3. **Stylesheet**: Include a stylesheet to define your theme. **Optional**

   Note that for every component you edit, you will need to configure the `atlassian-plugin.xml` which is the central configuration file for the plugin to override the default files with the new files you’ve created.

   *The information on this page does not apply to Confluence OnDemand.*

---

**Layout: Working with decorators**

**What are decorators?**

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system. To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a `.vmd` file and is written in a very simple programming language called **Velocity**. Learn more about **Velocity**.

Confluence comes bundled with a set of decorator or VMD files that you can customize. Broadly these are categorised into Site, Content and Export decorators. These are further grouped into categories called contexts and under each context has various modes (ways of viewing the context).

To make editing easier, layout for similar screens (example: view and edit page screens) is configured through the same VMD file. So, if you want to customize how the Confluence **View Page Screen** or **Edit Page Screen** looks, you can make both of these changes inside one decorator file: `page.vmd`.

<table>
<thead>
<tr>
<th>Decorator</th>
<th>Context</th>
<th>Mode</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>page.vmd</td>
<td>page</td>
<td>'view', 'edit', 'edit-preview', 'view-information', and 'view-attachments'</td>
<td></td>
</tr>
<tr>
<td>blogpost.vmd</td>
<td>blogpost (news)</td>
<td>'view', 'edit', 'edit-preview', and 'remove'</td>
<td>We prefer to use 'news' as an end-user term; all templates and classes use 'blogpost' to indicate RSS related content</td>
</tr>
<tr>
<td>mail.vmd</td>
<td>mail</td>
<td>'view', 'view-thread' and 'remove'</td>
<td></td>
</tr>
<tr>
<td>space.vmd</td>
<td>space-pages, space-mails, space-blogposts, space-templates, space-operations, space-administration</td>
<td>CONTEXT: &quot;space-pages&quot;. MODES: &quot;list-alphabetically&quot;, &quot;list-recently-updated&quot;, &quot;list-content-tree&quot;, &quot;create-page&quot;. CONTEXT: &quot;space-mail&quot;. MODES: &quot;view-mail-archive&quot;. CONTEXT: &quot;space-blogposts&quot;. MODES: &quot;view-blogposts&quot;, &quot;create-blogpost&quot;. CONTEXT: &quot;space-templates&quot;. MODES: &quot;view-templates&quot;. CONTEXT: &quot;space-operations&quot;. MODES: &quot;view-space-operations&quot;. CONTEXT: &quot;space-administration&quot;. MODES: &quot;view-space-administration”, “list-permission-pages&quot;.</td>
<td>space.vmd handles a wide range of options, this context is accessed by clicking on ‘browse space’ in the default theme of Confluence (tabbed theme)</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>global.vmd</td>
<td>global</td>
<td>'dashboard', 'view-profile', 'edit-profile', 'change-password-profile', 'edit-notifications-profile'</td>
<td></td>
</tr>
<tr>
<td>main.vmd</td>
<td>n/a (header and footer formatting)</td>
<td>main.vmd is used to control the header and footer of each page, not the page specific presentation logic</td>
<td></td>
</tr>
</tbody>
</table>

For example, if you wanted to remove the ‘Attachments’ tab on the view page screen, you would make this layout change in the page.vmd file - where the ‘view’ mode is handled (as shown below).
Step One: Copying the decorators

The easiest way to begin configuring a new layout is by copying the default decorator files and editing them to suit your theme.

1. Choose Browse > Confluence Admin.
2. Select Layouts in the left panel. This will display options to view and edit the default decorators.
3. Copy the files that you intend to modify and place them in a directory structure that makes sense to you.
   See example below.

Step Two: Creating a directory structure for the decorators:

You should place your decorators in a directory hierarchy which makes sense to you. We recommend that you place the atlassian-plugin.xml file at the top level of the directory structure, and then place the decorators in directories which make a meaningful division of what they do.

Here is an example:

```java
atlassian-plugin.xml
com/atlassian/confluence/themes/mytheme/
com/atlassian/confluence/themes/mytheme/global.vmd
com/atlassian/confluence/themes/mytheme/space.vmd
com/atlassian/confluence/themes/mytheme/mail.vmd
com/atlassian/confluence/themes/mytheme/blogpost.vmd
com/atlassian/confluence/themes/mytheme/main.vmd
com/atlassian/confluence/themes/mytheme/page.vmd
```

Step Three: Editing the decorators

To edit the decorators, you will require knowledge of a very simple programming language called Velocity. Learn more about Velocity.

Decorator Macros

When editing the decorators, you will need to use Decorator Macros to draw complex or variable parts of the page such as menus and breadcrumbs. See Working With Decorator Macros

Theme Helper Object
When editing decorator files you will also come across a variable called $helper - this is the theme helper object.

The following table summarises what this object can do:

<table>
<thead>
<tr>
<th>Behaviour</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>$helper.domainName</td>
<td>displays the base URL of your Confluence instance on your page. This is useful for constructing links to your own Confluence pages.</td>
</tr>
<tr>
<td>$helper.spaceKey</td>
<td>returns the current space key or null if in a global context.</td>
</tr>
<tr>
<td>$helper.spaceName</td>
<td>returns the name of the current space</td>
</tr>
<tr>
<td>$helper.renderConfluenceMacro(&quot;(create-space-button)&quot;)</td>
<td>renders a call to a Confluence Macro for the velocity context</td>
</tr>
<tr>
<td>$helper.getText(&quot;key.key1&quot;)</td>
<td>looks up a key in a properties file matching key.key1=A piece of text and returns the matching value (&quot;A piece of text&quot;)</td>
</tr>
<tr>
<td>$helper.action</td>
<td>returns the XWork action which processed the request for the current page.</td>
</tr>
</tbody>
</table>

If you are on a page or space screen you also have access to the actual page and space object by using $helper.page and $helper.space respectively.

If you want to deliver more into what other methods are available in this object, please see our API's for ThemeHelper.

Step Four: Configuring the central configuration file to reference the new decorators

How to do this is explained in Configuring the Theme Plugin

Working with colour schemes for themes

Configuring the colour scheme

The easiest way to configure a colour scheme is to do it dynamically from the Administration Console (as you would normally when you want to change the site's colour scheme online), and then express it as an xml file. This method makes it possible for you to experiment with different colours and test them out before including the colour scheme in your theme.

1. Choose Browse > Confluence Admin.
2. Select 'Colour scheme' in the left panel.
3. Use the colour picker to define the colours for the following UI elements:
   - Top Bar - the bar across the top of the page that contains the breadcrumbs.
   - Space Name Text - the text of the current space name located above the page title.
More information on customising colour schemes

Expressing the colour scheme as XML

Once, you have decided on the colours for the different UI elements, you will need to configure the atlassian.plugin.xml to include the new colour scheme. How to do this is explained in detail in Configuring the Theme Plugin.

RELATED TOPICS

No content found for label(s) themes-configuration.

The structure of an atlassian-plugin.xml file is fairly self-explanatory:

```
<atlassian-plugin key="com.atlassian.confluence.themes.tabless" name="Plain Theme">
  <plugin-info>
    <description>This theme demonstrates a plain look and feel for Confluence. It is useful as a building block for your own themes.</description>
    <version>1.0</version>
    <vendor name="Atlassian Software Systems Pty Ltd" url="http://www.atlassian.com/">
  </plugin-info>
  <theme key="tabless" name="Tabless Theme" class="com.atlassian.confluence.themes.BasicTheme">
    <description>plain Confluence theme.</description>
    <layout key="com.atlassian.confluence.themes.tabless:main"/>
    <layout key="com.atlassian.confluence.themes.tabless:global"/>
    <layout key="com.atlassian.confluence.themes.tabless:space"/>
    <layout key="com.atlassian.confluence.themes.tabless:page"/>
    <layout key="com.atlassian.confluence.themes.tabless:blogpost"/>
  </theme>
</atlassian-plugin>
```
Modifying the `atlassian-plugin.xml` file

We will configure this file section by section.

**Plugin information**

```xml
<atlassian-plugin key="com.atlassian.confluence.themes.tables" name="Plain Theme">
  <plugin-info>
    <description>This theme demonstrates a plain look and feel for Confluence. It is useful as a building block for your own themes.</description>
    <version>1.0</version>
    <vendor name="Atlassian Software Systems Pty Ltd" url="http://www.atlassian.com/"/>
  </plugin-info>
</atlassian-plugin>
```

**Plugin key**: Specify a key that uniquely identifies the plugin, eg. `com.example.themes.dinosaur`

**name**: Give the plugin a name.

**description**: Provide a short description of the plugin.

**vendor**: Replace the text with your information.

**Theme information**

```xml
<theme key="dinosaurs" name="Dinosaur Theme"
      class="com.atlassian.confluence.themes.BasicTheme">
  <description>A nice theme for the kids</description>
  <colour-scheme key="com.example.themes.dinosaur:earth-colours"/>
  <layout key="com.example.themes.dinosaur:main"/>
  <layout key="com.example.themes.dinosaur:mail-template"/>
</theme>
```

**theme key**: Specify a key that uniquely identifies the theme.

**class**: The class of a theme must implement `com.atlassian.confluence.themes.Theme`. The `com.atlassian.confluence.themes.BasicTheme` class provided with Confluence gathers together all the resources listed within the module definition into a theme.

**name**: Give the theme a name. Make sure that you replace all instances of the theme name with this name.

**description**: Provide a short description of your theme

**colour-scheme key**: A theme can contain an optional `colour-scheme` element that defines which colour-scheme module this theme will use. If you are using a new colour scheme, enter its key.

**layout key**: A theme can contain any number of `layout` elements that define which layouts should be applied in this theme. Refer to these modules by their complete module key as shown above.
Referencing the decorators

You will need to add a layout entity as shown below for each of the decorators you are using. See working with decorators

```xml
<layout key="page" name="Page Decorator"
        class="com.atlassian.confluence.themes.VelocityDecorator"
        overrides="/decorators/page.vmd">
  <resource type="velocity" name="decorator"
              location="com/atlassian/confluence/themes/tabless/page.vmd"/>
</layout>
```

**class** : The class which each decorator, or layout, is mapped to must implement `com.atlassian.confluence.themes.VelocityDecorator`.

**overrides** : The layout entry must provide an `overrides` attribute which defines which decorator within Confluence is being overridden by the theme.

**Location** : Specify the location of the new decorator file, so Confluence know where to look when overriding the default decorator.

ℹ️ It is possible for a theme to use modules that aren't in the same plugin as the theme. Just keep in mind that your theme will be messed up if the plugin that the theme depends on is removed.

Including the colour scheme

Colour schemes can be pre-configured for your theme dynamically from the Administration Console. See configuring colour schemes.

To transport them within a theme however, they need to be expressed in the `atlassian-plugin.xml` file as shown above.

```xml
<colour-scheme key="earth-colours" name="Brown and Red Earth Colours"
              class="com.atlassian.confluence.themes.BaseColourScheme">
  <colour key="topbar" value="#440000"/>
  <colour key="spacename" value="#999999"/>
  <colour key="headingtext" value="#663300"/>
  <colour key="link" value="#663300"/>
  <colour key="border" value="#440000"/>
  <colour key="navbg" value="#663300"/>
  <colour key="navtext" value="#ffffff"/>
  <colour key="navselectedbg" value="#440000"/>
  <colour key="navselectedtext" value="#ffffff"/>
</colour-scheme>
```

**colour-scheme key** : Specify a key that uniquely identifies the colour scheme.

**name** : Give a name to the colour scheme.

**class** : The class of the colour scheme must implement `com.atlassian.confluence.themes.ColourScheme`. The `com.atlassian.confluence.themes.BaseColourScheme` class provided with Confluence sets the colours based on the module's configuration.

**colour key** : For each UI element, you will need to add its name and value.
Including Cascading Stylesheets in Themes

Confluence allows you to integrate your own stylesheets within the theme plugin so you can have greater control over the appearance of your site. Confluence’s main stylesheet is a useful reference when overriding styles and can be found in the Confluence install directory under `...confluence/styles/site-css.vm`.

The information on this page does not apply to Confluence OnDemand.

Step One: Defining the stylesheet in the `atlassian-plugin.xml`

To make a stylesheet available to a decorator, you will need to reference it as a resource from within the central configuration file - `atlassian-plugin.xml`.

Here is an example where a stylesheet is being used to define the 'leftnavigation' theme:

```xml
<layout key="main" name="Main Decorator" class="com.atlassian.confluence.themes.VelocityDecorator" overrides="/decorators/main.vmd">
  <resource type="velocity" name="decorator" location="templates/leftnavigation/main.vmd"/>
  <resource type="stylesheet" name="leftnav.css" location="templates/leftnavigation/leftnav-css.vm">
  </resource>
</layout>
```

The resource parameter takes three arguments:

- **Type**: The type of resource-in this instance, 'stylesheet'.
- **Name**: The name of the stylesheet.
- **Location**: The location of the file represented in the jar archive you will use to bundle your theme.

Step Two: Using the stylesheet in the decorator

To reference the stylesheet in the decorator, you will need to use the `#pluginStylesheet` velocity macro.

For example, here’s how you reference the leftnav.css file defined in the layout entry above:

```velocityEngine
#pluginStylesheet("com.atlassian.confluence.themes.leftnavigation:main" "leftnav.css")
```

The macro takes two arguments:

- **completePluginKey**: The complete plugin key which is constructed from the pluginkey and the layout key like this: `[pluginKey]:[layoutKey]`  
  In the above example, `com.atlassian.confluence.themes.leftnavigation` is the key of the
plugin, and main is the key of the layout.

- **stylesheetName**: the name of the stylesheet

If you place your stylesheet after the `#standardHeader` macro in the decorator, the contents of your custom stylesheet will override those in Confluence's default stylesheet.

If your stylesheet needs to reference the colour scheme, you need to use the space stylesheet macro instead:

```
#pluginSpaceStylesheet("com.atlassian.confluence.themes.leftnavigation:main" "leftnav.css" $spaceKey)
```

You can then use colour scheme references in your stylesheet, similar to Confluence's stylesheets, and they will be replaced with the appropriate global or space-specific colour scheme:

```plaintext
.navItemOver {
  color: $action.navSelectedTextColor;
}
```

## RELATED TOPICS

No content found for label(s) themes-configuration.

### Creating a Theme

Unsure what a theme is? See the overview of themes.

If you want to create your own theme, you will need to write a Confluence plugin. Please refer to the following pages:

- Get started with plugin development.
- Create a theme using the theme plugin module.

### Related pages:

- Including Cascading Stylesheets in Themes
- Applying a Theme to a Site
- Applying a Theme to a Space
- Configuring the Documentation Theme
- Configuring the Documentation Theme
- Installing Plugins and Macros
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

## Importing Data

- Importing Content from Another Wiki

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Universal Wiki Converter
Importing Content Into Confluence

⚠️ The information on this page does not apply to Confluence OnDemand.

Importing Content from Another Wiki
The Universal Wiki Converter (UWC) allows you to import content from other wikis into Confluence. The Confluence Administration Console offers a link to the Universal Wiki Converter documentation and download sites.

⚠️ You need to install and run the UWC separately from Confluence.

The UWC is a standalone application that communicates with Confluence remotely. You cannot install the UWC directly into Confluence. Instead, download the UWC separately and run it according to the instructions below.

⚠️ The information on this page does not apply to Confluence OnDemand.

The UWC supports many wiki dialects. In addition, the UWC is an extensible framework, which means that developers can continue writing new conversion modules for other wikis. To see the latest list of conversions available, please refer to the UWC documentation.

- Download the latest version of the UWC.
- For information on installation and usage, see the UWC Quick Start Guide.
- For information on developing your own converter module, see the UWC Developer Documentation.
- For information about a specific wiki, including a list of currently supported wikis, see the UWC documentation.
- To ask a question, see the UWC discussions on Atlassian Answers.

Screenshot: Links from the Confluence Administration Console to the UWC
Performance Tuning

This document describes tuning your application for improved performance. It is not a guide to troubleshooting Confluence outages. Check Troubleshooting Confluence Hanging or Crashing for help if Confluence is crashing.

Description

Like any server application, Confluence may require some tuning as it is put under heavier use. We do our best to make sure Confluence performs well under a wide variety of circumstances, but there's no single configuration that is best for everyone's environment and usage patterns.

If you are having problems with the performance of Confluence and need our help resolving them, you should read Requesting Performance Support.

Use the latest version of your tools

Use the latest versions of your application servers and Java runtime environments. Newer versions are usually
better optimized for performance. As an example, our internal performance tests show a **20% speed-up** (when viewing pages under load) between Tomcat 6 on Java 6 vs Tomcat 5.5 on Java 5 **out of the box**.

**Avoid swapping due to not enough RAM**

Always watch the swapping activity of your server. If there is not enough RAM available, your server may start swapping out some of Confluence's heap data to your hard disk. This will slow down the JVM's garbage collection considerably and affect Confluence's performance. In clustered installations, swapping can lead to a C**luster Panic due to Performance Problems**. This is because swapping causes the JVM to pause during Garbage Collection, which in turn can break the inter-node communication required to keep the clustered nodes in sync.

---

**On this page:**

- Description
- Use the latest version of your tools
- Avoid swapping due to not enough RAM
- Being aware of other systems using the same infrastructure
- Choice of database
- Database connection pool
- Database in general
- Database indexes
- Database statistics and query analysers
- Cache tuning in Confluence and Apache
- Antivirus software
- Enabling HTTP compression
- Virtual operating systems
- Performance testing
- Access logs
- Built-in profiler
- Application server memory settings
- Web server configuration
- Parallel GC
- Troubleshooting possible memory leaks
- Plugins

---

⚠️ The information on this page **does not apply** to Confluence OnDemand.

---

**Being aware of other systems using the same infrastructure**

It may sound tempting: Just have one powerful server hosting your database and/or application server, and run all your crucial programs on that server. If the system is set up perfectly, then you might be fine. Chances are however that you are missing something, and then one application's bug might start affecting other applications. So if Confluence is slow every day around noon, then maybe this is because another application is using the shared database to generate complicated reports at that time? Either make sure applications can't harm each other despite sharing the same infrastructure, or get these systems untangled, for example by moving them to separate instances that can be controlled better.

**Choice of database**

The **embedded database** that is provided with Confluence is meant only to be used for evaluation, not for production Confluence sites. After the evaluation finishes, you will certainly need to switch to an external
relational database management system. Beyond this, we do not recommend any particular RDBMS over another. We recommend using what you are familiar with, because your ability to maintain the database will probably make far more difference to what you get out of it than the choice of database itself.

**Database connection pool**

If load on Confluence is high, you may need more simultaneous connections to the database.

- If you are using JNDI data-sources, you will do this in your application server's configuration files.
- If you have configured Confluence to access the database directly, you will need to manually edit the `hibernate.c3p0.max_size` property in the `confluence.cfg.xml` file in your `confluence.home` directory. After you have changed the URL in this file, restart Confluence.

To assess whether you need to tune your database connection pool, take thread dumps during different times (including peak usage). Inspect how many threads have concurrent database connections.

**Database in general**

If Confluence is running slowly, one of the most likely causes is that there is some kind of bottleneck in (or around) the database.

The first item you should check is the "Database Latency" field in the System Information tab in the admin console.  

<table>
<thead>
<tr>
<th>Database connection</th>
<th>Transaction</th>
<th>Isolation</th>
<th>Head committed</th>
<th>Database Latency</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Confluence Usage</td>
<td></td>
</tr>
</tbody>
</table>

The latency is calculated by sending a trivial request to the database, querying a table which is known to have only one column and one row. ("select * from CLUSTERSAFETY"). Obviously this query should be blazing fast, and return within 1 or 2 milliseconds. If the value displayed is between 3 and 5 milliseconds, you might already have an issue. If the value is above 10ms, then you **definitely** need to investigate and improve something! A few milliseconds may not sound so bad, but consider that Confluence sends quite a few database queries per page request, and those queries are a lot more complex too! High latency might stem from all sorts of problems (slow network, slow database, connection-pool contention, etc), so it’s up to you to investigate. Don't stop improving until latency is below 2ms on average.

Obviously, latency is just the very first thing to look at. You may get zero latency and still have massive database problems, e.g. if your tables are poorly indexed. **So don't let a low latency fool you either.**

**Database indexes**

Especially if you have more than a few thousand active users, and all most obvious measures have been tried out but the database still seems to be under high load, you should consider engaging a database administrator (DBA) to tune the database specifically to the demands that your particular Confluence installation is placing on it. If you do not have a full-time DBA and can't even get one for temporary consulting, you may want to consult the [database indexing advice](#) that we have been gathering from customer reports and our own experience running and developing Confluence. The instructions on that page are for Oracle, but most of the indexes can be applied to (and will help with) any database.

(These database indexes are now created automatically when Confluence is installed, but existing installations upgrading to a more recent version may still need to add them manually)

**Database statistics and query analysers**

Modern databases have query optimisers based on collecting statistics on the current data. Using the SQL `EXPLAIN` statement will provide you information on how well the query optimiser is performing. If the cost estimate is wildly inaccurate then you will need to run statistics collection on the database. The exact command
will depend on your database and version. In most cases you can run statistics collection while Confluence is running, but due to the increased load on the database it’s best to do this after normal hours or on a week-end.

**Cache tuning in Confluence and Apache**

To reduce the load on the database, and speed up many operations, Confluence keeps its own cache of data. Tuning the size of this cache may speed up Confluence (if the caches are too small), or reduce memory (if the caches are too big).

Please have a look at our documentation on [Cache Performance Tuning](https://confluence.org) for information on how to tune Confluence caches.

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See [Configuring Apache to Cache Static Content via mod_disk_cache](https://confluence.org).

**Antivirus software**

Antivirus software greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental, and may even cause errors with Confluence. You should configure your antivirus software to ignore the Confluence home directory, its index directory and any database-related directories.

**Enabling HTTP compression**

If bandwidth is responsible for bottlenecking in your Confluence installation, you should consider enabling HTTP compression. This may also be useful when running an external facing instance to reduce your bandwidth costs.

Take note of the [known issues with HTTP compression](https://confluence.org) in versions of Confluence prior to 2.8, which may result in high memory consumption.

**Virtual operating systems**

Virtual Environments such as VMWare can cause Confluence CPU to spike. Run Confluence on a native OS. Refer to the list of supported operating systems for Confluence in the [Supported Platforms](https://confluence.org) topic.

**Note:** In some situation the VMTools can crash, cause a excessive context switches and interrupts causing the JVM to run slowly and Confluence to start up very slowly.

**Performance testing**

You should try out all configuration changes on a demo system. Ideally, you should run and customize loadtests that simulate user behaviour. Learn about how to test performance issues using the [Performance Testing Scripts](https://confluence.org).

**Access logs**

You can find out which pages are slow and which users are accessing them by enabling Confluence’s built-in access logging.

**Built-in profiler**

You can identify the cause of page delays using Confluence’s built-in profiler according to [Troubleshooting Slow Performance Using Page Request Profiling](https://confluence.org).

**Application server memory settings**
See [How to Fix Out of Memory Errors by Increasing Available Memory](#).

**Web server configuration**

For high-load environments, performance can be improved by using a web server such as Apache in front of the application server. There is a configuration guide to [Running Confluence behind Apache](#).

When configuring your new web server, make sure you configure sufficient threads/processes to handle the load. This applies to both the web server and the application server connector, which are typically configured separately. If possible, you should enable connection pooling in your web server connections to the application server.

**Parallel GC**

If you have multiple CPU's on your server, you can add `-XX:+UseParallelOldGC` to your JAVA_OPTS options. This will allow garbage collection of the Tenured Space to happen in parallel with the application and can boost performance and can reduce slow performance spikes. For more information, please refer to our detailed page on [Garbage Collector Performance Issues](#), and Sun's [summary](#) of collectors.

**Troubleshooting possible memory leaks**

Some external plugins, usually ones that have been written a long time ago and that are not actively maintained anymore, have been reported to consume memory and never return it. Ultimately this can lead to a crash, but first this manifests as reduced performance. The [Troubleshooting Confluence Hanging or Crashing](#) guide is a good place to start. Some of the known causes listed there could result in performance issues short of a crash or hang.

**Plugins**

Some 3rd-party plugins were not written to scale to large enterprises' needs.

Confluence has been optimized to work under high load and with many pages. Some 3rd party plugins however have been written with small size companies in mind, and can't cope with large numbers of concurrent users, or large numbers of pages and permissions, or large numbers of spaces. It is impossible to tell which ones will fail under which conditions, but it will always help to turn off 3rd-party plugins that are not strictly mission-critical while investigating performance issues.

**RELATED TOPICS**

- [Garbage Collector Performance Issues](#)
- [Cache Performance Tuning](#)
- [Cache Performance Tuning for Specific Problems](#)
- [Performance Testing Scripts](#)
- [Working with Confluence Logs](#)
- [Operating Large or Mission-Critical Confluence Installations](#)
- [Confluence Clustering Overview](#)
- [Requesting Performance Support](#)
- [Confluence Administrator's Guide](#)
- [Configuring Confluence](#)

**Cache Performance Tuning**

Confluence performance can be significantly affected by the performance of its caches. It is essential for the administrator of a large production installation of Confluence to tune the caches to suit its environment. There are several configurable parameters for each of the cache regions, most notably cache size, cache expiry delay and eviction policy. In the majority of the cases, cache size is the parameter you would want to change.
Fortunately, from Confluence 3.0, it is very easy to adjust cache sizes through the Administration Console. However, if you need to modify parameters other than a cache size, you would need to modify the relevant configuration files manually.

The cache performance information for your Confluence installation is available under Administration > Cache Statistics. For more information about the numbers displayed on that screen, see Cache Statistics.

Notes:

- To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.
- If you only need to modify Confluence's maximum cache sizes, you can do this through the Cache Statistics feature of the Administration Console.

Cache tuning example

As an example of how to tune Confluence's caches, let's have a look at the following table:

<table>
<thead>
<tr>
<th>Caches</th>
<th>% Used</th>
<th>% Effectiveness</th>
<th>Objects/Size</th>
<th>Hit/Miss/Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>87%</td>
<td>29%</td>
<td>874/1000</td>
<td>78226/189715/187530</td>
</tr>
<tr>
<td>Content Attachments</td>
<td>29%</td>
<td>9%</td>
<td>292/1000</td>
<td>4289/41012/20569</td>
</tr>
<tr>
<td>Content Bodies</td>
<td>98%</td>
<td>81%</td>
<td>987/1000</td>
<td>28717/6671/5522</td>
</tr>
<tr>
<td>Content Label Mappings</td>
<td>29%</td>
<td>20%</td>
<td>294/1000</td>
<td>4693/18185/9150</td>
</tr>
<tr>
<td>Database Queries</td>
<td>96%</td>
<td>54%</td>
<td>968/1000</td>
<td>105949/86889/83334</td>
</tr>
<tr>
<td>Object Properties</td>
<td>27%</td>
<td>18%</td>
<td>279/1000</td>
<td>5746/25386/8102</td>
</tr>
<tr>
<td>Page Comments</td>
<td>26%</td>
<td>11%</td>
<td>261/1000</td>
<td>2304/17178/8606</td>
</tr>
<tr>
<td>Users</td>
<td>98%</td>
<td>5%</td>
<td>982/1000</td>
<td>6561/115330/114279</td>
</tr>
</tbody>
</table>

The caches above are of size 1000 (meaning that it can contain up to 1000 objects), which is the default size for caches in the default cache scheme. Refer to Confluence Cache Schemes for more explanation.

You can tell when a cache size needs to be increased because the cache has both:

- a high usage percentage (above 75%)
- a low effectiveness percentage.

Check the 'effectiveness' versus the 'percent used'. A cache with a low percent used need not have its size lowered; it does not use more memory until the cache is filled.

Based on this, the sizes of the "Attachments", "Database Queries", and "Users" caches should be increased to improve their effectiveness.
As the stored information gets older or unused it will expire and be eliminated from the cache. Cache expiry may be based on time or on frequency of use.

There is not much that you can do with a cache that has both a low percentage of usage and effectiveness. Over time, as the cache is populated with more objects and repeat requests for them are made, the cache's effectiveness will increase.

On this page:
- Cache tuning example
- Finding the configuration file
- Cache key mappings
- Standard editions of Confluence
- Clustered editions of Confluence
- Important caches
- Cache tuning follow-up
- Notes

Related pages:
- Cache Performance Tuning for Specific Problems
- Confluence Cache Schemes
- Performance Testing Scripts
- Working with Confluence Logs
- Operating Large or Mission-Critical Confluence Installations
- Confluence Clustering Overview
- Requesting Performance Support
- Confluence Administrator's Guide
- Configuring Confluence

⚠️ The information on this page does not apply to Confluence OnDemand.

Finding the configuration file

The caches are configured in ecache.xml (for standard editions) or confluence-coherence-cache-config-clustered.xml (for clustered editions) which is stored in `<confluence-home>/config/`.

Oracle Coherence Licensing Change:
- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
    - If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information about these changes, please refer to the Coherence License Changes document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the Confluence 3.0.1 Upgrade Notes for additional upgrade information.

Cache key mappings
The cache configuration file configures caches by their keys. When you move your mouse over the cache names displayed on the cache statistics page, a tooltip will indicate the actual cache key for that cache name.

Using our example from the table above, if we were to modify parameters for the Users cache we would need to change the cache with the key com.atlassian.user.impl.hibernate.DefaultHibernateUser. Do not get confused with Users (External Mappings) and Users (External Groups) which are in themselves, two separate caches. "Users" is the friendly name for com.atlassian.user.impl.hibernate.DefaultHibernateUser.

Standard editions of Confluence

In standard editions of Confluence, the caching layer is Ehcache.

Understanding the Ehcache configuration file

For more information about the Ehcache configuration file and a full reference on Ehcache configuration, please refer to the Ehcache configuration documentation.

Converting your Coherence configuration to Ehcache

This section only applies to customers who:

- Have an installation of Confluence that was downloaded before the 4th of September 2009.
- Intend to (or have already) upgraded to Confluence 3.0.1 or later (or to Confluence versions 2.6.3, 2.7.4, 2.8.3, 2.9.3 and 2.10.4).
- Will use a non-clustered Confluence license for the Confluence upgrade.
- Have implemented customisations to their Confluence installation's cache configuration file (confluence-coherence-cache-config.xml).

To maintain your existing cache configuration file settings, you will need to transfer any cache customisations you have implemented in the Coherence cache configuration file (confluence-coherence-cache-config.xml) to the relevant entries in the Ehcache cache configuration file (ehcache.xml).

Each cache has a cache-mapping element in the Coherence file (of which there is an equivalent cache element in the ehcache.xml file). Unfortunately, copying across your customisations is not quite a straightforward process because the Coherence file defines several 'caching schemes' to store the actual cache values, which in turn are referenced by the cache-mapping elements. In contrast, the ehcache.xml file does not support caching schemes and a cache's values are expressed explicitly in separate parameters of a cache element.

To convert your Coherence cache configuration file customisations across to the equivalent Ehcache file:

1. Open both the confluence-coherence-cache-config.xml and ehcache.xml files in a text editor. These files are located in the <confluence-home>/config directory.

   If you implemented your customisations in a version of Confluence prior to 3.0, you will most likely find the confluence-coherence-cache-config.xml file in the <confluence-install>/confluence/WEB-INF/classes directory.

2. In the customised confluence-coherence-cache-config.xml file:
   a. Identify the caching schemes that were customised in this file and make a note of the values of all its child elements.
1. Typically, each caching scheme is located inside a local-scheme element and all of these are enclosed within the cache-schemes element, which appears towards the end of this file.

b. Note each customised caching scheme by the content of its scheme-name element.

c. For each cache-mapping element (which typically appears towards the top of this file), identify if it has a scheme-name element whose content matches one noted in the previous step and if so, make a note of its associated cache-name element.

3. In the ehcache.xml file:

   a. Identify each cache element whose 'name' parameter matches the cache-name elements noted in step '2c'.

   b. Using the mappings table below, apply the values noted in step '2a' to the appropriate parameters of the cache elements identified in the previous step ('3a').

Mappings table showing how elements of the Coherence cache configuration file map to parameters of the equivalent Ehcache file.

<table>
<thead>
<tr>
<th>Coherence Element</th>
<th>Ehcache Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>high-units</td>
<td>maxElementsInMemory</td>
</tr>
<tr>
<td>expiry-delay &gt; 0s</td>
<td>timeToIdleSeconds - Use this attribute for expiry delays greater than 0s along with the eternal attribute set to 'false'</td>
</tr>
<tr>
<td>expiry-delay = 0s</td>
<td>eternal - For expiry delays of 0s, set this attribute to 'true'.</td>
</tr>
</tbody>
</table>

Clustered editions of Confluence

Understanding the Coherence configuration file

The Coherence configuration file is a mapping of cache keys to cache schemes. Each cache scheme controls the expiry, eviction policy and size of the caches linked to it. A cache scheme can extend another scheme.

For a full reference, see the [Oracle's Coherence cache configuration documentation](#).

Defining caching scheme mappings in Coherence cache config file

If a cache key does not have an explicit definition in the caching scheme mappings (defined in confluence-coherence-cache-config.xml) then it will use the "default" cache-mapping.

In our example, com.atlassian.user.impl.hibernate.DefaultHibernateUser is not explicitly defined in the caching scheme mappings. Hence to increase the expiry-delay to 2 hours, we will need to define the mapping ourselves and add the following within the <caching-scheme-mapping> tags:

```xml
<cache-mapping>
  <cache-name>com.atlassian.user.impl.hibernate.DefaultHibernateUser</cache-name>
  <scheme-name>cache:com.atlassian.user.impl.hibernate.DefaultHibernateUser</scheme-name>
</cache-mapping>
```

Then we will need to define a cache schema with name cache:com.atlassian.user.impl.hibernate.D
It's possible to define a local-scheme mapping for a cache key without defining certain parameters (e.g. `<high-units>`). In such a cases, their parameters will be inherited from `scheme-ref` scheme, which is the default scheme in our case.

**Important caches**

- `com.atlassian.confluence.core.ContentEntityObject` (known as Content Objects cache) should be set to at least 20-30% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `SELECT COUNT(*) FROM CONTENT WHERE prevver IS NULL`.

- `com.atlassian.confluence.core.ContentEntityObject.bodyContents` (known as Content Body Mappings cache) should be set to at least 20% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `SELECT COUNT(*) FROM CONTENT WHERE prevver IS NULL`.

- `com.atlassian.confluence.security.PermissionCheckDispatcher.isPermitted()` (known as User Authorized URLs cache) should be set to at least the number of concurrent users you expect to access Confluence at the same time.

- `com.atlassian.user.impl.hibernate.DefaultHibernateUser` (known as Users cache) should be set to the number of users you have: `SELECT COUNT(*) FROM users`. Note that by default, this will also control the LDAP user's cache, including expiration.

- `com.atlassian.confluence.security.SpacePermission` (known as Permissions cache) should be set to the number of space permissions in your deployment (a good rule of thumb is 20 times the number of spaces). You can find the number of space permissions using the query `SELECT COUNT(*) FROM SPACEPERMISSIONS`.

**Cache tuning follow-up**

After you have made changes to your cache config, doing a follow up on the changes in the next week or after the expected performance spike would be important.

Make sure that you take a screenshot of the cache statistics before and after the change. Then compare them with the cache statistics in the later period where performance improvement is expected.

**Notes**

You can monitor what's in the cache by using a JSP included in the Confluence distribution. Browse to `<base-URL>/admin/cachecontents.jsp` to monitor the cache contents.
Cache Performance Tuning for Specific Problems

The following are more specific performance problems that can be resolved from tuning the cache.

LDAP cache sizes and expiry does not appear to be picked up.

This is a known problem, please refer to CONF-11858 for the solution.

"Edit Page" screen takes a long time to load

If your installation of Confluence is suffering from this problem, it may be due to an insufficient SpacePermissions cache size. To address this problem, first determine the number of space permission objects in your Confluence instance. You can do this by running this query against your database:

```
> select count(*) from SPACEPERMISSIONS
```

Now locate the cache entry for SpacePermissions in your `confluence-coherence-cache-config.xml`:

```xml
<local-scheme>
  <scheme-name>cache:com.atlassian.confluence.security.CachingSpacePermissionManager</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
  <expiry-delay>0s</expiry-delay>
<local-scheme>
```

Adjust the `maxElementsInMemory` or `high-units` property to the number of space permissions you have (in the example above, I've used 10000). Also, just as important, you need to adjust the `timeToLiveSeconds` or `expiry-delay` property to 0.

Note: 10K of space permissions consumes approximately 8MB of memory. Please ensure there is enough memory allocated to your instance to cater for this.

How to set specific cache settings

1. Find the cache name from the cache name mappings:
   - For Confluence 2.5.x and earlier, the cache name mappings are in file `confluence/WEB-INF/classes/com/atlassian/confluence/admin/actions/cache-name-mappings.properties`.
   - For Confluence 2.6.0 and later, you will find the cache name mappings in the file `com/atlassian/confluence/core/ConfluenceActionSupport.properties` which is packed into the `confluence-2.x.*.jar` file.

2. Find the appropriate `<cache-mapping>` tag in `confluence-coherence-cache-config.xml` or `confluence-coherence-cache-config-clustered.xml`. If the tag doesn't exist, you can create it within the `<caching-scheme-mapping>` tag.
3. The `<scheme-name>` will correspond to a `<local-scheme>` tag below. It refers to a scheme reference. Either change the high-units tag in the scheme reference, or add a high-units tag to override the scheme reference. For example, the following tag would change the Content Bodies cache from the default 1000 units to 2000 units:

```xml
<local-scheme>
  <scheme-name>cache:com.atlassian.confluence.core.ContentEntityObject.bodyContents</scheme-name>
  <high-units>2000</high-units>
  <scheme-ref>default</scheme-ref>
  <expiry-delay>0s</expiry-delay>
</local-scheme>
```

Another popular cache to change is the LDAP related User cache:

```xml
<local-scheme>
  <scheme-name>user</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>
```

4. After updating the appropriate file, you do not need to repack it into the jar to use it. You can simply place the file in your `confluence/WEB-INF/classes/` directory. The file in this directory will override the settings in your jar file. If you want to back out the changes, you only need to remove the file from your `confluence/WEB-INF/classes/` directory — then the default values in the `confluence-coherence-cache-config.xml` located in your jar file will apply.

You can find more information about configuring the Coherence cache in the Coherence cache documentation.

**RELATED TOPICS**

- Cache Performance Tuning
- Performance Testing Scripts
- Confluence Cache Schemes
- Working with Confluence Logs
- Operating Large or Mission-Critical Confluence Installations
- Confluence Clustering Overview
- Requesting Performance Support
- Confluence Administrator's Guide
- Configuring Confluence

**Confluence Cache Schemes**

*Default Scheme*
If a cache has not been defined, then it will use the default cache size and expiry. As the start of your confluence/WEB-INF/classes/confluence-coherence-cache-config.xml file you will notice the following:

```
<cache-mapping>
  <cache-name>*</cache-name>
  <scheme-name>default</scheme-name>
</cache-mapping>
```

So basically all caches will default to using the default scheme, which is defined as below:

```
<!-- Default scheme -->
<local-scheme>
  <scheme-name>default</scheme-name>

  <class-name>com.atlassian.confluence.cache.tangosol.ExpiryCountingLocalCache</class-name>
  <high-units>1000</high-units>
  <expiry-delay>3600</expiry-delay>
</local-scheme>
```

I.e. with a size of 1000 Objects and an expiry of 3600 seconds. Other schemes use the above as their default and either override the size of the cache, or the length of the expiry.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Common Schemes**

In addition to the default scheme, there are also common schemes used in Confluence caches:
<local-scheme>
  <scheme-name>large</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>medium</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>small</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>100</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>large-transient</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>
<local-scheme>
  <scheme-name>user</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>

RELATED TOPICS

Cache Performance Tuning
Confluence Cache Schemes
Cache Performance Tuning for Specific Problems
Requesting Performance Support
Confluence Administrator's Guide
Configuring Confluence

Memory usage and requirements
Managing Confluence’s performance and memory usage really depends on what resources are available - Confluence will run faster if you give it lots of memory for its caches, but it should still be able to run quite well in low-memory environments, with the right tuning. Below are some tips on getting the most out of your Confluence site.

On this page:

⚠️ The information on this page does not apply to Confluence OnDemand.

Increasing the amount of memory available to Confluence

See Increasing JIRA Memory for details on how to increase the memory available to web application servers typically used to run Confluence.
**Embedded Database**

The embedded HSQL database that comes with Confluence essentially holds all your data in memory while the Confluence server is running. If you are running out of memory, you should consider migrating Confluence to some external RDBMS.

**Caching**

By default, Confluence keeps large in-memory caches of data to improve its responsiveness and the user experience. The trade off is an increase in memory requirements to support the cache. Administrators of larger Confluence sites may need to configure the size of their caches to improve performance.

To customise Confluence's cache to meet your needs, see cache tuning. To increase the amount of memory available to confluence, see How to Fix Out of Memory Errors by Increasing Available Memory.

**Mail error queue**

Confluence keeps a copy of all emails that it failed to send within an internal error queue. In the event of intermittent failures such as network connectivity issues, the emails in this queue can be manually resent when the problem is fixed. Under certain circumstances, the mail queue can fill up with large objects. The queue is regularly flushed, but if you get a lot of mail errors, you might get a spike in memory usage.

**Attachments**

The indexing of large attachments requires that the attachment be loaded into memory. In the case of large attachments, this can cause a temporary strain on the systems resources, and may result in indexing failing because the attachment could not be fully loaded into memory.

**System backup / restore**

The Confluence backup and restore process scales linearly with the size of data. This can have a significant impact on large Confluence instances where the amount of data exceeds the amount of available memory. If you are experiencing an OutOfMemoryError during either a backup or restore processes, then we strongly recommend that you choose and Production Backup Strategy.

If you encounter an OutOfMemoryError while restoring a backup and wish to overcome this issue by increasing memory, how much more will you need to make this process work? A good rule of thumb is to have a look at the size of the entities.xml file in your backup. This file contains all of the data Confluence will be loading, so at least that much is required. Add another 64-128Mb to ensure that Confluence has enough memory to load and function and that should be enough. To increase the amount of memory available to Confluence, see How to Fix Out of Memory Errors by Increasing Available Memory.

**Known issues that we do not have control over.**

There are also some memory issues we don't have any control over. For example,

- There's a memory leak in the Oracle 10g JDBC drivers. Not much we can do about that.
- one customer found a rather nasty memory leak that appeared to originate inside Tomcat 5, but only using the IBM JDK on PowerPC.

If you are having problems that appear to result from a memory leak, file an issue on http://support.atlassian.com. Our memory profiler of choice is YourKit. It would be helpful to us if you can provide us with a memory dump from that tool showing the leak.

**Confluence is taking long periods of time to respond to some actions**

A common cause of random pauses in Confluence is the JVM running garbage collection. To determine if this is what is happening, enable verbose garbage collection and look at how long Java is taking to free up memory. If
the random pauses match when Java is running its garbage collection, garbage collection is the cause of the pause.

Verbose garbage collection will generate log statements that indicate when Java is collecting garbage, how long it takes, and how much memory has been freed.


For example, with a Windows service, run:

```
tomcat5 //US//Confluence ++JvmOptions="-XX:+PrintGCDetails -XX:+PrintGCTimeStamps -verbose:gc -Xloggc:c:\confluence\logs\gc.log"
```

or in `bin/setenv.sh`, set:

```
export CATALINA_OPTS="$CATALINA_OPTS -XX:+PrintGCDetails -XX:+PrintGCTimeStamps -verbose:gc -Xloggc:${CATALINA_BASE}/logs/gc.log"
```

If you modify `bin/setenv.sh`, you will need to restart Confluence for the changes to take effect.

What can you do to minimise the time taken to handle the garbage collection? See [http://java.sun.com/docs/hotspot/gc1.4.2/](http://java.sun.com/docs/hotspot/gc1.4.2/) for details on tuning the JVM to minimise the impact that garbage collection has on the running application.

**Requesting Performance Support**

**Basic Performance Troubleshooting Steps**

Begin with the following procedures:

1. Go through the [Troubleshooting Confluence Hanging or Crashing](#) page to identify the major known performance problems
2. Proceed with the [Performance Tuning](#) tips to help optimize performance

⚠️ **The information on this page does not apply to Confluence OnDemand.**

**Requesting Basic Performance Support**

If those tips don't help or you're not sure where to start, open a [support ticket](#) starting with at least the basic information:

1. The [atlassian-confluence.log](#)
2. The catalina.out log (or your application server log), with a series of three thread dumps separated by 10 seconds
3. A description with as much detail as possible regarding:
   a. What changes have been made to the system?
   b. When did performance problems begin?
   c. When in the day do performance issues occur?
   d. What pages or operations experience performance issues?
   e. Is there a pattern?
Continue with as much of the Advanced Performance Troubleshooting information as you can.

**Advanced Performance Troubleshooting**

Please gather **all** of the information listed below and include it in your support request, even if you think you have a good idea what's causing the problem. That way we don't have to ask for it later.

**System Information**

**Confluence Server**
- Take a screenshot of Confluence's Administration System Information (or save the page as HTML)
- Take a screenshot of Confluence's Administration Cache Statistics (or save the page as HTML)
- Find out the exact hardware Confluence is running on
  - How many CPUs? What make and model? What MHz?
  - How much memory is installed on the machine?
  - How much memory is assigned to Confluence's JVM? (i.e. what are the -Xmx and -Xms settings for the JVM?)
  - What other applications are being hosted on the same box?

**Confluence Content**
- How many users are registered in Confluence?
- On average, to how many groups does each user belong?
- How many spaces (global and personal) are there in your Confluence server?
- How many of those spaces would be viewable by the average user?
- Approximately how many pages? (Connect to your database and perform 'select count(*) from content where prevver is null and contenttype = 'PAGE'')
- How much data is being stored in Bandana (where plugins usually store data)? (Connect to your database and perform 'select count(*), sum(length(bandanavalue)) from bandana')

**The Database**
- What is the exact version number of Confluence's database server?
- What is the exact version number of the JDBC drivers being used to access it? (For some databases, the full filename of the driver JAR file will suffice)
- Is the database being hosted on the same server as Confluence?
- If it is on a different server, what is the network latency between Confluence and the database?
- What are the database connection details? How big is the connection pool? If you are using the standard configuration this information will be in your confluence_cfg.xml file. Collect this file. If you are using a Data source this information will be stored in your application server’s configuration file, collect this data.

**User Management**
- Are you using external user management or authentication? (i.e. JIRA or LDAP user delegation, or single sign-on)
- If you are using external JIRA user management, what is the latency between Confluence and JIRA's database server?
- If you are using LDAP user management:
  - What version of which LDAP server are you using?
  - What is the latency between Confluence and the LDAP server?

**Diagnostics**

**Observed Problems**
- Which pages are slow to load?
  - If it is a specific wiki page, attach the wiki source-code for that page
- Are they always slow to load, or is the slowness intermittent?
Monitoring data

Before drilling down into individual problems, helps a lot to understand the nature of the performance problem. Do we deal with sudden spikes of load, or is it a slowly growing load, or maybe a load that follows a certain pattern (daily, weekly, maybe even monthly) that only on certain occasions exceeds critical thresholds? It helps a lot to have access to continuous monitoring data available to get a rough overview.

Here are sample graphs from the confluence.atlassian.com system, showing

Load

This graph shows the load for two consecutive days. The obvious pattern is that the machine is under decent load, which corresponds to the user activity, and there is no major problem.

Resin Threads and Database Connections

These two charts show the active threads in the application server (first chart) and the size database connection pool (second chart). As you can see, there was a sudden spike of server threads and a corresponding spike of db-connections.
The database connection pool size

The database connection pool size peaked over 112, which happened to be more than the maximum number of connections the database was configured for (100). So it was no surprise that some requests to Confluence failed and many users thought it had crashed, since many requests could not obtain the crucial database connections.

We were able to identify this configuration problem quite easily just by looking at those charts. The next spikes were uncritical because more database connections were enabled.

The bottom line being: it helps a lot to monitor your Confluence systems continuously (we use Hyperic, for example), and it helps even more if you are able to send us graphs when you encounter problems.

Access logs

- How to Enable User Access Logging, including redirecting the logs to a separate file
  - You can run this file through a log file analyser such as AWStats, or manually look through for pages which are slow to load.

Profiling and Logs

- Enable Confluence's built-in profiling for long enough to demonstrate the performance problem using Troubleshooting Slow Performance Using Page Request Profiling.
  - If a single page is reliably slow, you should make several requests to that page
  - If the performance problem is intermittent, or is just a general slowness, leave profiling enabled for thirty minutes to an hour to get a good sample of profiling times
- Find Confluence's standard output logs (which will include the profiling data above). Take a zip of the entire logs directory.
- Take a thread dump during times of poor performance

CPU Load

- If you are experiencing high CPU load, please install the YourKit profile and attach two profiler dumps taken during a CPU spike. If the CPU spikes are long enough, please take the profiles 30-60 seconds apart. The most common cause for CPU spikes is a virtual machine operating system.
- If the CPU is spiking to 100%, try Live Monitoring Using the JMX Interface, in particular with the Top threads plugin.

Instance Metrics and Scripts

- It is essential to understand the user access and usage of your instance. Please use the access log scripts and sql scripts to generate Usage statistics for your instance.

Next Step

Open a ticket on https://support.atlassian.com and attach all the data you have collected. This should give us the
information we need to track down the source of your performance problems and suggest a solution. Please follow the progress of your enquiry on the support ticket you have created.

If your site is non-responsive, please use our [Live Support](https://confluence.atlassian.com/live-support) during business hours once you have created the ticket to escalate your problem.

**Access Log Scripts**

The access log scripts are [attached to this page](https://confluence.atlassian.com/access-log-scripts). To use the scripts:

1. Unzip the 7z file.
2. Copy all the daily access logs to a folder called `logs`.
3. Run `Atlassian-processDailyLog.rb`. This will generate a csv file called `summary.csv` and several directories which contain the access logs of each defined user action.
4. Run the appropriate script `Atlassian-processDailyLog-hourly.rb` to use the scripts. For example, `Atlassian-processDailyLog-hourly.rb admin` will process the admin logs extracted in step 3.
5. Import the csv files to `www-log-Analysis.xls` (summary.csv to 'raw stats - daily' sheet and `admin`, `csv` to 'admin -hours' sheet, etc) to generate the load profiles and graphs. You may need to modify the number of rows in each sheet depending on the number of logs.

⚠️ The information on this page does not apply to Confluence OnDemand.

---

**Note**

All scripts are written in Ruby and assume the log file name contains the string 'confluence.atlassian.com-access.log'. Scripts need to be changed if another name is used.

Modify the line:

```ruby
filenameRegexp = Regexp.new('confluence.atlassian.com-access.log')
```

---

**Troubleshooting Slow Performance Using Page Request Profiling**

This page tells you how to enable page-request profiling. With profiling turned on, you will see a record of the time it takes (in milliseconds) to complete each action made on any Confluence page. If Confluence is responding slowly, an internal timing trace of the slow page request can help to identify the cause of the delay.

You will need access to the Confluence server to view a profile.

---

**On this page:**

- [Enabling Page-Request Profiling](#enabling-page-request-profiling)
- [Profiling an Activity](#profiling-an-activity)
- [Example of a Profile](#example-of-a-profile)
- [Start Confluence with Profiling Enabled](#start-confluence-with-profiling-enabled)

⚠️ The information on this page does not apply to Confluence OnDemand.

---

**Enabling Page-Request Profiling**

To see just the slow performing macros, see [Identifying Slow Performing Macros](https://confluence.atlassian.com/identifying-slow-performing-macros).
From Confluence 2.7, you can use the ‘Logging and Profiling’ option to enable or disable profiling.

ℹ️ You need to have System Administrator permissions in order to perform this function.

**To enable page profiling,**

1. Go to the 'Administration Console' and click ‘Logging and Profiling’ in the ‘Administration’ section of the left-hand panel.
2. The ‘Logging and Profiling’ screen appears. Click the ‘Enable Profiling’ button.
   ℹ️ If profiling is already enabled, the button will be labelled ‘Disable Profiling’ instead.

**To disable page profiling,**

1. Go to the 'Administration Console' and click ‘Logging and Profiling’ in the ‘Administration’ section of the left-hand panel.
2. The ‘Logging and Profiling’ screen appears. Click the ‘Disable Profiling’ button.
   ℹ️ If profiling is already disabled, the button will be labelled ‘Enable Profiling’ instead.

*Screenshot: Changing Log Levels and Profiling*
Performance Profiling
Profiling is currently OFF.

Enable Profiling

SQL Logging

Enable SQL Logging

Log4j Logging

Choose from one of the predefined logging options or configure logging below.

Production Diagnostic

OR:

Customise specific logging settings

Add New Entry

<table>
<thead>
<tr>
<th>Class/Package Name</th>
<th>New Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>class=<code>org.apache</code></td>
<td>INFO</td>
</tr>
</tbody>
</table>

Existing Levels

<table>
<thead>
<tr>
<th>Class/Package Name</th>
<th>Current Level</th>
<th>New Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.atlassian.confluence.cluster</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.cluster.safety</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.importexport.impl.PDFExporter</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>com.atlassian.confluence.lifecycle</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.confluence.upgrade</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>com.atlassian.core.util.FileUtils</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>com.atlassian.upgrade</td>
<td>INFO</td>
<td>INFO</td>
</tr>
<tr>
<td>net.sf.hibernate.cache.ReadWriteCache</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.impl.SessionImpl</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.type.CustomType</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>net.sf.hibernate.util._JDBCExceptionReporter</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>org.apache.fop</td>
<td>ERROR</td>
<td>ERROR</td>
</tr>
<tr>
<td>root</td>
<td>WARN</td>
<td>WARN</td>
</tr>
</tbody>
</table>

Save

Profiling an Activity
1. Enable profiling, using either of the methods described above. Profiles for every page hit, for all users, will now be logged to your application server's default logs until Confluence is restarted. Note that each time a user visits a link, a single profile is printed.

2. Confirm that profiles are being written to the Confluence log file — see Working with Confluence Logs for location of the log files and other details.

3. Perform the activity that is resulting in unusually slow response time.

4. Copy the profile for that action. When deciding which profiles to copy, look for the links that took a long time to respond. If a single page is slow, only that profile is necessary. If Confluence is generally or intermittently slow, copy all profiles logged during the slowdown until a reasonable sample has been collected.

5. If you were instructed to profile your instance by Atlassian technical support, attach all relevant profiles to your support ticket.

6. Turn profiling off again, using either of the methods described above.

7. Confirm that profiles are no longer being printed to the Confluence log file.

Example of a Profile

Below are the first few lines of a normal profile for accessing a page called Confluence Overview.

```
[344ms] - /display/ds/Confluence+Overview
[313ms] - SiteMesh: parsePage:
http://localhost:8080/display/ds/Confluence+Overview
[313ms] - XW Interceptor: Before defaultStack:
/pages/viewpage.action (ViewPageAction.execute())
[0ms] - SpaceAwareInterceptor.intercept()
[16ms] - PageAwareInterceptor.intercept()
[0ms] - AOP: PageManager.getPage()
[16ms] - AOP: PermissionManager.hasPermission()
[0ms] - AOP: SpacePermissionManager.hasPermission()
[16ms] - AOP: SpacePermissionManager.hasPermission()
[0ms] - AOP: SpacePermissionManager.hasPermission()
[0ms] - AOP: SpacePermissionManager.hasPermission()
[0ms] - AOP: SpacePermissionManager.hasPermission()
[281ms] - XW Interceptor: After defaultStack:
/pages/viewpage.action (ViewPageAction.execute())
[281ms] - XW Interceptor: After validatingStack:
/pages/viewpage.action (ViewPageAction.execute())
...```

Start Confluence with Profiling Enabled

There may be some situations where you may wish to have Confluence profiling enabled during startup. This may be useful if you restart often and may forget to enable profiling for Support/Trouble-shooting purposes.

Edit the file `CONFLUENCE_HOME/confluence/WEB-INF/web.xml`. You should see a stanza similar to the one below. Set the parameter value for `autostart` to `true`:

```xml
<Parameter name="autostart" value="true"/>
```
Remember to turn it back to false or your logs will grow very large.

**RELATED TOPICS**

- Requesting Performance Support
- Working with Confluence Logs

**Compressing an HTTP Response within Confluence**

Confluence supports HTTP GZip transfer encoding. This means that if a user's web browser supports it, Confluence will compress the data it sends to the user. This will speed up Confluence over slow or congested Internet links, and reduce the amount of bandwidth consumed by a Confluence server.

Gzipping the HTTP Response is available in Confluence 1.4 and later.

You should turn on Confluence's GZip encoding if:

- Users are accessing Confluence over the Internet, or a WAN connection with limited bandwidth.
- You wish to reduce the amount of data transfer between the Confluence server and client.

If you are accessing Confluence over a Local Area Network or over a particularly fast WAN, you may wish to leave GZip encoding disabled. If the network is fast enough that transferring data from Confluence to the user isn't a limiting factor, the additional CPU load caused by having to compress each HTTP response may in fact slow Confluence down.

⚠️ The information on this page does not apply to Confluence OnDemand.
Known issues in Confluence 2.7 and earlier

There are known issues with the GZip filter and memory consumption evident in versions 2.7 of Confluence and earlier (CONF-9930). If you are running a large instance of Confluence 2.7 or earlier and frequently experiencing 'out of memory' errors, we recommend that you do not enable HTTP compression. These issues have been resolved in Confluence 2.8.

Enabling HTTP Compression

1. Choose Browse > Confluence Admin.
2. Select 'General Configuration' in the left-hand panel.
3. Enable 'Compress HTTP Responses'.

In Confluence 2.8 and later, you can configure which types of content are compressed within Confluence. By default, the following mime types will be compressed:

- text/html
- text/javascript
- text/css
- text/plain
- application/x-javascript
- application/javascript

If you wish to change the types of content to be compressed, add a replacement `urlrewrite-gzip-default.xml` file within the `WEB-INF/classes/com/atlassian/gzipfilter/` directory in your Confluence Installation Directory. A sample file is provided as an attachment. Generally speaking, it is unlikely that you will need to alter this file.

RELATED TOPICS

Performance Tuning
Confluence Administrator's Guide

Performance Testing Scripts
Load Testing Confluence

This page contains scripts and hints on load-testing your Confluence installations.

Introduction

Before making a new Confluence instance available to your users it is useful to get a feel for how it will perform under your anticipated load and where you may need to consider improving your configuration to remove bottlenecks. Likewise, before making changes to your Confluence instance it would again be useful to assess the impact of these changes before making them live in a production context.

This kind of testing is not an exact science but the tools and process described here are intended to be a straightforward, configurable and extensible way of allowing you to begin this kind of load testing.

It will rarely be the case that these scripts will perform representative testing for you 'out of the box'. But either through configuration or by extending the scripts it should be possible to build an appropriate load test.
Load testing scripts are not designed for a production environment

The load testing scripts will update the data within the targeted Confluence instance and are not designed to be run against a production server. If you want to load test your production environment you will need to perform these tests on a backup of your data and restore your real data after the tests.

On this page:

- Load Testing Confluence
- Introduction
- Setup
- Quick, Just Tell Me How To Run It.
- Creating the Test Data
- Running the Test

The information on this page does not apply to Confluence OnDemand.

Setup

You will need the following -

- A Confluence server, set up and running with an admin user. The scripts assume a default username and password for this user: ‘admin’/’admin’.
- Ensure the Confluence Remote API is enabled in the administration options. See Enabling the Remote API for details on how to configure this.
- Apache JMeter
- The load testing scripts and resources which are available in our public Maven repository — Please choose the version that most closely matches your Confluence version and download the ZIP or Gzip file in that directory. If in doubt, download the ZIP file archive.

Users have reported problems when using the Windows built-in unzip utility. Please use a third party file archiving and extraction program (for example, 7-Zip) to extract these performance tests.

The test scripts have been updated to work with Confluence 3.4 in version 3.4. Using an older version of the tests will result in errors when running the test.

Quick, Just Tell Me How To Run It.

If you don't want to read the rest of this document, here are the main points:

1. Download and Unzip the performance tests
2. Open a command prompt and change directory to the performanceTest directory that has just been unzipped.
3. Create the test data:
4. Run the test:

```bash
<jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
```

The remainder of this document is just an elaboration of those two steps.

⚠️ For information on how to use JMeter please refer to the manual.

Creating the Test Data

A known data set is required to run the testing against. By default this is the Confluence demo space (space key = DS) although this can be changed (more on this later). If you decide to use the Confluence demo space, ensure that the group "confluence-users" is able to update content in this space.

The script `jmeter-test-setup.jmx` is used to:

- create a set of users to be used in the test
- import the Confluence demo space for running tests against.

You should first ensure that you don't already have the demo space (key = DS) on your test instance. Delete it if you do.

Run the script from the performanceTest directory as follows:

```bash
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx
-Jspace.zip=<path to a space export.zip>-Jadmin.user=<username>
-Jadmin.pass=<password>
```

Where:

- `<path to a space export.zip>` is the absolute path to the space export zip you want to be used in your testing. For example, the path to `demo-site.zip` as found in your Confluence distribution or
  **source:** `<confluence-install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup/demo-site.zip`

- `<username>` and `<password>` are the username and password for an admin user that is able to create Confluence users and to import spaces.

By default the setup process will create 250 users — 50 each of the following formats: `tstreader<n>`, `tstcommentor<n>`, `tsteditor<n>`, `tstcreator<n>` and `tstsearcher<n>`. The password for each matches the username.

A typical run of the setup script will only take a few seconds.

Removing the Test Data
You can reverse the effects of the setup script by setting the `remove.data` parameter to `true`, e.g.:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx
-Jremove.data=true -Jadmin.user=<username> -Jadmin.pass=<password>
```

**Setup Script Parameters**

You can modify the behaviour of the setup script via JMeter parameters. These are supplied on the command line in the form `-J<parameter name>=<parameter value>`.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>script.base</td>
<td>.</td>
<td>The absolute path to the script. Defaults to the current working directory.</td>
</tr>
<tr>
<td>space.zip</td>
<td>N/A</td>
<td>The absolute path to space export zip file to be imported as test data.</td>
</tr>
<tr>
<td>remove.data</td>
<td>false</td>
<td>Run the script in reverse — remove all test data.</td>
</tr>
<tr>
<td>admin.user</td>
<td>admin</td>
<td>The admin user name used to import data and create users.</td>
</tr>
<tr>
<td>admin.pass</td>
<td>admin</td>
<td>The password for the admin user.</td>
</tr>
<tr>
<td>confluence.context</td>
<td>confluence</td>
<td>The confluence webapp context.</td>
</tr>
<tr>
<td>confluence.host</td>
<td>localhost</td>
<td>The address or host name of the test instance.</td>
</tr>
<tr>
<td>confluence.port</td>
<td>8080</td>
<td>The port of the test instance.</td>
</tr>
<tr>
<td>space.key</td>
<td>ds</td>
<td>The space key for the space import that will be tested against.</td>
</tr>
<tr>
<td>space.setup</td>
<td>true</td>
<td>Control whether the test space will be created (or removed).</td>
</tr>
<tr>
<td>commentor.max</td>
<td>250</td>
<td>The number of users to be created for making comments.</td>
</tr>
<tr>
<td>creator.max</td>
<td>250</td>
<td>The number of users to be created for adding pages.</td>
</tr>
<tr>
<td>editor.max</td>
<td>250</td>
<td>The number of users to be created for editing existing pages.</td>
</tr>
</tbody>
</table>
reader.max 250 The number of users to be created for viewing existing pages.

searcher.max 250 The number of users to be created for performing searches.

resource.max 250 The number of users to be created for downloading site resources.

attachments.max 250 The number of users to be created for downloading attachments.

Setup Script Output

On the console you will see no obvious indication of success or otherwise. JMeter will output something similar to this:

```
Created the tree successfully
Starting the test @ Mon Apr 14 17:35:08 EST 2008 (1208158508222)
Tidying up ... @ Mon Apr 14 17:35:08 EST 2008 (1208158508928)
... end of run
```

The scripts location/results directory will contain the file jmeter-result-setuptest.jtl. There were failures or errors if there are any assertions in this file that have the value true for the failure or error element, e.g.

```
<assertionResult>
  <name>Manage Users</name>
  <failure>true</failure>
  <error>false</error>
  <failureMessage>Test failed: URL expected to contain /browseusers.action/</failureMessage>
</assertionResult>
```

Running the Test

The test script itself will put Confluence under a fixed load. Each thread group will attempt to do a certain amount of work for a prescribed period of time (30 minutes by default). This is by design so that load during test runs can accurately be compared against each other.

Execute the test as follows:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
```

Where:
<scripts location> is the absolute path to where you extracted the scripts e.g. /Users/YourName/Down load/performanceTest. This is needed for the script to find its external resources.

Test Behaviour
The test has a number of parameters to tweak its behaviour but generally speaking it has the rough format of:

- 5 groups of users - readers, commentors, searchers, editors and creators.
  - readers simply view a set of individual pages or browse space functionality.
  - commentors add comments to a set of pages.
  - searchers perform searches on a fixed set of keywords.
  - editors make small additions to the end of a set of pages.
  - creators add new pages to a particular space.
- Each individual user in each group will repeat for a fixed amount of time with a small pause between each request.

Note that there is no execution of JavaScript by the client. Keep this in mind if you use this test to gauge Confluence performance in a production environment.

There is also very little use of permissions in these tests. All data involved is accessible to all of the test users.

**Test Script Parameters**

You can modify the behaviour of the test script via JMeter parameters. These are supplied on the command line in the form `-J<parameter name>=<parameter value>`.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>script.base</td>
<td>.</td>
<td>The absolute path to the script. Defaults to the current working directory.</td>
</tr>
<tr>
<td>confluence.context</td>
<td>confluence</td>
<td>The confluence webapp context.</td>
</tr>
<tr>
<td>confluence.host</td>
<td>localhost</td>
<td>The address or host name of the test instance.</td>
</tr>
<tr>
<td>confluence.port</td>
<td>8080</td>
<td>The port of the test instance.</td>
</tr>
<tr>
<td>create.page.prefix</td>
<td>Nihilist</td>
<td>The title prefix for any created page e.g. Nihilist00001.</td>
</tr>
<tr>
<td>script.runtime</td>
<td>1800</td>
<td>The amount of time the script will run for in seconds.</td>
</tr>
</tbody>
</table>

**Test Thread Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>threads.reader</td>
<td>15</td>
<td>Number of readers.</td>
</tr>
<tr>
<td>pause.reader</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between reader repeats.</td>
</tr>
<tr>
<td>threads.searcher</td>
<td>8</td>
<td>Number of searchers.</td>
</tr>
<tr>
<td>Action</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>pause.searcher</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between searcher repeats.</td>
</tr>
<tr>
<td>threads.creator</td>
<td>3</td>
<td>Number of page creators.</td>
</tr>
<tr>
<td>pause.creator</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between creator repeats.</td>
</tr>
<tr>
<td>threads.editor</td>
<td>3</td>
<td>Number of page editors.</td>
</tr>
<tr>
<td>pause.editor</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between editor repeats.</td>
</tr>
<tr>
<td>threads.commentor</td>
<td>4</td>
<td>Number of page commentors.</td>
</tr>
<tr>
<td>pause.commentor</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between commentor repeats.</td>
</tr>
</tbody>
</table>

In version 3.0 of the tests, it's now possible to control the percentage executions of certain actions. These percentages are defined in the "Thread Details" configuration screen.

So with the default parameters, you are emulating a load on Confluence of 33 concurrent users who will each be hitting the server approximately every 2 seconds (16 users per second).

23 of these users are read only (searchers or readers) and 10 of them are read/write — 11 read only users per second and 5 read/write users per second.

**Test Script Output**

During the run of the test script Jmeter will output progress to the console of the form:
Garbage Collector Performance Issues

This document relates broadly to memory management with Oracle's Hotspot JVM. These are recommendations based on Support's successful experiences with customers and their large Confluence instances.

Please do not use the Concurrent Mark Sweep (CMS) Collector with Confluence, unless otherwise advised by Atlassian Support. It requires extensive manual tuning and testing, and is likely to result in degraded performance.

The information on this page does not apply to Confluence OnDemand.

Summary

1. Set the Young space up to 30-40% of the overall heap: `-XX:NewSize=<between 30% and 40% of your Xmx value, eg, 384m>`
2. Use a parallel collector: `-XX:+UseParallelOldGC (make sure this is Old GC)`
3. Limit the Tomcat connector's spare thread counts to minimize impact
4. Effectively disable explicit garbage collection triggered from distributed remote clients: `-Dsun.rmi.dgc.client.gcInterval=900000 -Dsun.rmi.dgc.server.gcInterval=900000`
5. Disable remote clients from triggering a full GC event: `-XX:+DisableExplicitGC`
6. Set the minimum and maximum Xmx and Xms values as the same (eg. `-Xms1024m -Xmx1024m`) to discourage address map swapping
7. Turn on GC logging (add the flags `-verbose:gc -Xloggc:<confluence-home>/logs/gc.log -XX:+PrintGCTimeStamps -XX:+PrintGCDetails`) and submit the logs in a support ticket
   a. (Optional) You can enable date stamps: `-XX:+PrintGCDateStamps` This makes the logs easier
to read via the naked eye, but may run into problems if you’re trying to use third-party applications to view the GC logs.

8. Use Java 1.6
9. Read below if heap > 2G

See Configuring System Properties for how to add these properties to your environment.

Background

Performance problems in Confluence, and in rarer circumstances for JIRA, generally manifest themselves in either:

- frequent or infrequent periods of viciously sluggish responsiveness, which requires a manual restart, or, the application eventually and almost inexplicably recovers
- some event or action triggering a non-recoverable memory debt, which in turn envelops into an application-fatal death spiral (Eg. overhead GC collection limit reached, or Out-Of-Memory).
- generally consistent poor overall performance across all Confluence actions

There are a wealth of simple tips and tricks that can be applied to Confluence, that can have a significantly tangible benefit to the long-term stability, performance and responsiveness of the application.

On this page:

- Summary
- Background
- Why Bad Things Happen
- Appreciate how Confluence and the JAVA JVM use memory
- Memory is contiguous
- Figure out which (default) collector implementation your vendor is using
- Use the Parallel Garbage Collector
- Restrict ability of Tomcat to ‘cache’ incoming requests
- Disable remote (distributed) garbage collection by Java clients
- Virtual Machines are Evil
- Use Java 1.6
- Use -server flag
- If using 64bit JRE for larger heaps, use CompressedOops
- Use NUMA if on SPARC, Opteron or recent Intel (Nehalem or Tukwila onwards)
- Use 32bit JRE if Heap < 2GB
- JVM core dumps can be instigated by memory pressures
- Artificial Windows memory limit
- Instigate useful monitoring techniques
- Tuning the frequency of full collections
- Performance tuning works

Why Bad Things Happen

Confluence can be thought of like a gel or a glue, a tool for bringing things together. Multiple applications, data-types, social networks and business requirements can be efficiently amalgamated, leading to more effective collaboration. The real beauty of Confluence, however, is its agility to mould itself into your organizations’ DNA - your existing business and cultural processes, rather than the other way around - your organization having to adapt to how the software product works.

The flip side of this flexibility is having many competing demands placed on Confluence by its users. Historically, this is an extraordinarily broad and deep set of functions, that really, practically can't be predicted for individual use cases.

The best mechanism to protect the installation is to place Confluence on a foundation where it is fundamentally more resilient and able to react and cope with competing user requirements.
Appreciate how Confluence and the JAVA JVM use memory

The Java memory model is naive. Compared to a unix process, which has four intensive decades of development built into time-slicing, inter-process communication and intelligent deadlock avoidance, the Java thread model really only has 10 years at best under its belt. As it is also an interpreted language, particular idiosyncrasies of the chosen platform Confluence is running can also influence how the JRE reacts. As a result it is sometimes necessary to tune the jvm parameters to give it a "hint" about how it should behave.

There are circumstances whereby the Java JVM will take a mediocre option in respect to resource contention and allocation and struggle along with oftentimes highly impractical goals. For example, The JRE will be quite happy to perform at 5 or 10% of optimum capacity if it means overall application stability and integrity can be ensured. This often translates into periods of extreme sluggishness, which effectively means that the application isn't stable, and isn't integral (as it cannot be accessed).

This is mainly because Java shouldn't make assumptions on what kind of runtime behavior an application needs, but it's plain to see that the charter is to assume 'business-as-usual' for a wide range of scenarios and really only react in the case of dire circumstances.

Memory is contiguous

The Java memory model requires that memory be allocated in a contiguous block. This is because the heap has a number of side data structures which are indexed by a scaled offset (ie n*512 bytes) from the start of the heap. For example, updates to references on objects within the heap are tracked in these "side" data structures.

Consider the differences between:

1. Xms (the allocated portion of memory)
2. Xmx (the reserved portion of memory)

Allocated memory is fully backed, memory mapped physical allocation to the application. That application now owns that segment of memory.

Reserved memory (the difference between Xms and Xmx) is memory which is reserved for use, but not physically mapped (or backed) by memory. This means that, for example, in the 4G address space of a 32bit system, the reserved memory segment can be used by other applications, but, because Java requires contiguous memory, if the reserved memory requested is occupied the OS must swap that memory out of the reserved space either to another non-used segment, or, more painfully, it must swap to disk.

Permanent Generation memory is also contiguous. The net effect is even if the system has vast quantities of cumulative free memory, Confluence demands contiguous blocks, and consequently undesirable swapping may occur if segments of requested size do not exist. See Causes of OutOfMemoryErrors for more details.

Please be sure to position Confluence within a server environment that can successfully complete competing requirements (operating system, contiguous memory, other applications, swap, and Confluence itself).

Figure out which (default) collector implementation your vendor is using

Default JVM Vendor implementations are subtly different, but in production can differ enormously.

The Oracle JVM by default splits the heap into three spaces

1. Young (New, divided into Eden and Survivor)
2. Tenured (Old)
3. Permanent Generation (classes & library dependencies)

Objects are central to the operation of Confluence. When a request is received, the Java runtime will create new objects to fulfill the request in the Eden Space. If, after some time, those objects are still required, they may be moved to the Tenured (Old) space. But, typically, the overwhelming majority of objects created die young, within
the Eden space. These are objects like method local references within a while or for loop, or Iterators for scanning through Collections or Sets.

But in IBM J9 the default policy is for a single, contiguous space - one large heap. The net effect is that for large Websphere environments, garbage collection can be terribly inefficient - and capable of suffering outages during peak periods.

For larger instances with performance issues, it is recommended to tune Confluence such that there is a large Young space, at up to 50% the overall size of the heap.

-XX:NewSize=XXXm where XXX is the size in megabytes, is the command line parameter. -XmnXXXm can also be used interchangeably. Ie. -XX:NewSize=700m, -Xmn700m

By setting a larger NewSize, the net effect is that the JRE will spend less time garbage collecting, clearing dead memory references, compacting and copying memory between spaces, and more time doing actual work.

Use the Parallel Garbage Collector

Confluence out of the box, and Oracle Java as default, uses the serial garbage collector on the Full Tenured heap. The Young space is collected in parallel, but the Tenured is not. This means that at a time of load if a full collection event occurs, since the event is a 'stop-the-world' serial event then all application threads other than the garbage collector thread are taken off the CPU. This can have severe consequences if requests continue to accrue during these 'outage' periods. As a rough guide, for every gigabyte of memory allocated allow a full second (exclusive) to collect.

If we parallelize the collector on a multi-core/multi-cpu architecture instance, we not only reduce the total time of collection (down from whole seconds to fractions of a second) but we also improve the resiliency of the JRE in being able to recover from high-demand occasions.

Additionally, Oracle provide a CMS, Concurrent Mark-Sweep Collector (-XX:+UseConcMarkSweepGC), which is optimized for higher-throughput, server-grade instances. As a general rule, the Parallel Collector (-XX:+UseParallelOldGC) is the right choice for JIRA or Confluence installations, unless otherwise advised by support.

Restrict ability of Tomcat to 'cache' incoming requests

Quite often the fatal blow is swung by the 'backlog' of accumulated web requests whilst some critical resource (say the index) is held hostage by a temporary, expensive job. Even if the instance is busy garbage collecting due to load, Tomcat will still trigger new http requests and cache internally, as well as the operating system beneath which is also buffering incoming requests in the socket for Tomcat to pick up the next time it gets the CPU.

Here the Tomcat Connector is configured for 150 "maxThreads" with an "acceptCount" of 100. This means up to 150 threads will awaken to accept (but importantly not to complete) web requests during performance outages, and 100 will be cached in a queue for further processing when threads are available. That's 250 threads, many of which can be quite expensive in and of themselves. Java will attempt to juggle all these threads concurrently and become extremely inefficient at doing so, exacerbating the garbage collection performance issue.

Resolution: reduce the number of maxThreads and acceptCount to something slightly higher than normal.
‘busy-hour’ demands.

Disable remote (distributed) garbage collection by Java clients

Many clients integrate third-party or their own custom applications to interrogate, or add content to Confluence via its RPC interface. The Distributed Remote Garbage Collector in the client uses RMI to trigger a remote GC event in the Confluence server. Unfortunately, as of this writing, a `System.gc()` call via this mechanism triggers a full, serial collection of the entire Confluence heap (as it needs to remove references to remote client objects in its own deterministic object graph). This is a deficiency in the configuration and/or implementation of the JVM. It has the potential to cause severe impact if the remote client is poorly written, or operating within a constricted JVM.

This can be disabled by using the flag `-XX:+DisableExplicitGC` at startup.

Virtual Machines are Evil

Vmware Virtual Machines, whilst being extremely convenient and fantastic, also cause particular problems for Java applications because it's very easy for host operating system resource constraints such as temporarily insolvent memory availability, or I/O swapping, to cascade into the Java VM and manifest as extremely unusual, frustrating and seemingly illogical problems. We already document some disk I/O metrics with VMware images. Although we now officially support the use of virtual instances we absolutely do not recommend them unless maintained correctly.

This is not to say that vmware instances cannot be used, but, they must be used with due care, proper maintenance and configuration. Besides, if you are reading this document because of poor performance, the first action should be to remove any virtualization. Emulation will never beat the real thing and always introduces more black box variability into the system.

Use Java 1.6

Java 1.6 is generally regarded via public discussion to have an approximate 20% performance improvement over 1.5. Our own internal testing revealed this statistic to be credible. 1.6 is compatible for all supported versions of Confluence, and we strongly recommend that installations not using 1.6 should migrate.

Use -server flag

The hotspot server JVM has specific code-path optimizations which yield an approximate 10% gain over the client version. Most installations should already have this selected by default, but it is still wise to force it with `-server`, especially on some Windows machines.

If using 64bit JRE for larger heaps, use CompressedOops

For every JDK release, Oracle also build a "Performance" branch in which specifically optimized performance features can be enabled; it is available on the Java SE page after a brief survey. These builds are certified production grade.

Some blogs have suggested a 25% performance gain and a reduction in heap size when using this parameter. The use and function of the `-XX:+UseCompressedOops` parameter is more deeply discussed on Oracle's Official Wiki (which itself uses Confluence!)

Use NUMA if on SPARC, Opteron or recent Intel (Nehalem or Tukwila onwards)

`-XX:+UseNUMA` flag enables the Java heap to take advantage of Non-Uniform-Memory-Architectures. JAVA will place data structures relevant to the thread which it owns / operates on, in memory locations closest to that particular processor. Depending on the environment, gains can be substantial. Intel market NUMA as Quick Path Interconnect™.
Use 32bit JRE if Heap < 2GB

Using a 64bit JRE when the heap is under 2GB will cause substantial degradation in heap size and performance. This is because nearly every object, reference, primitive, class and variable will use twice as much memory to be addressed.

A 64bit JRE/JDK is only recommended if heaps greater than 2GB are required. If so, use CompressedOops.

JVM core dumps can be instigated by memory pressures

If your instance of Confluence is throwing Java core dumps, it's known that memory pressure and space/generation sizings can influence the frequency and occurrence of this phenomena.

If your Tomcat process completely disappears and the logs record similar to:

```
# An unexpected error has been detected by HotSpot Virtual Machine:
# SIGSEGV (0xb) at pc=0xfe9bb960, pid=20929, tid=17
# Java VM: Java HotSpot(TM) Server VM (1.5.0_01-b08 mixed mode)
# Problematic frame:
# V [libjvm.so+0x1bb960]
#
--------------  T H R E A D  ---------------
Current thread (0x01a770e0):  JavaThread "JiraQuartzScheduler_Worker-1"[_thread_in_vm, id=17]
siginfo:si_signo=11, si_errno=0, si_code=1, si_addr=0x00000000
Registers:
  O0=0xf5999882 O1=0xf5999882 O2=0x00000000 O3=0x00000000
  O4=0x00000000 O5=0x00000001 O6=0xc24ff0b0 O7=0x00008000
  GI=0xe9bb80c G2=0xf5999a48 G3=0x0a67677d G4=0xf5999882
  G5=0xc24ff380 G6=0x00000000 G7=0xfd6c3800 Y=0x00000000
PC=0xe9bb960 nPC=0xe9bb964
```

then you should upgrade the JVM. See Sigsegv Segmentation Fault JVM Crash.

Artificial Windows memory limit

On Windows, the maximum heap allocatable to the Tomcat 32bit wrapper process is around 1400MB. If the instance is allocated too close to this limit, chronic garbage collection is likely to result, often producing JAVA core dumps similar to:
A fatal error has been detected by the Java Runtime Environment:

java.lang.OutOfMemoryError: requested 8388608 bytes for GrET in
C:\BUILD_AREA\jdk6_18\hotspot\src\share\vm\utilities\growableArray.cpp.
Out of swap space?

Internal Error (allocation.inline.hpp:39), pid=11572, tid=12284
Error: GrET in
C:\BUILD_AREA\jdk6_18\hotspot\src\share\vm\utilities\growableArray.cpp

JRE version: 6.0_18-b07
Java VM: Java HotSpot(TM) Server VM (16.0-b13 mixed mode windows-x86 )
If you would like to submit a bug report, please visit:
http://bugreport.sun.com/bugreport/crash.jsp

---------------  THREAD  ---------------
Current thread (0x002af800):  GCTaskThread [stack: 0x00000000,0x00000000] [id=12284]

Workarounds include:

- changing the server OS to something other than Windows. For example, Linux
- switching to the 64 bit Tomcat wrapper (this is not supported)
- reducing memory allocation to the Tomcat process. Try backing off 100MB at a time and observe the results.
Instigate useful monitoring techniques

At all times the best performance tuning recommendations are based on current, detailed metrics. This data is easily available and configurable and helps us **tremendously** at Atlassian when diagnosing reported performance regressions.

1. enable JMX monitoring
2. enable Confluence Access logging
3. enable Garbage Collection Logging
4. Take **Thread dumps** at the time of regression. If you can't get into Confluence, you can take one **externally**.
5. **Jmap** can take a memory dump in real time without impacting the application. **Syntax:**
   ```
   jmap -heap:format=b <process_id>
   ```

Great tools available include:

- The excellent **VisualVM**, [documentation](https://www.visualvm.org/).
- **Thread Dump Analyzer** - a great all-round thread debugging tool, particularly for identifying deadlocks.
- **Samurai**, an excellent alternative thread analysis tool, good for iterative dumps over a period of time.
- **GC Viewer** - getting a bit long in the tooth, but is a good mainstay for GC analysis.
- **GChisto** - A GC analysis tool written by members of the Sun Garbage Collection team.

Documentation:

- An [Excellent](http://www.ibm.com/developerworks/library/wa-20030212/) IBM document covering native memory, thread stacks, and how these influence memory constricted systems. Highly recommended for additional reading.
- The complete list of JRE 6 options

⚠️ **Atlassian recommends at the very least to get VisualVM up and running (you will need JMX), and to add Access and Garbage Collection logging.**

Tuning the frequency of full collections

The JVM will generally only collect on the full heap when it has no other alternative, because of the relative size of the Tenured space (it is typically larger than the Young space), and the natural probability of objects within tenured not being eligible for collection, i.e. they are still alive.

Some installations can trundle along, only ever collecting in Young space. As time goes on, some object will survive the initial Young object collection and be promoted to Tenured. At some point, it will be dereferenced and no longer reachable by the deterministic, directed object graph. However, the occupied memory will still be held in limbo as "dead" memory until a collection occurs in the Tenured space to clear and compact the space.

It is not uncommon for moderately sized Confluence installations to reclaim as much as 50% of the current heap size on a full collection; This is because full collections occur so infrequently. By reducing the occupancy fraction heap trigger, this means that more memory will be available at any time, meaning that fewer swapping/object collections will occur during the busy hour.

Atlassian would classify frequency tuning on collections as an **advanced** topic for further experimentation, and is provided for informational purposes only. Unfortunately, it's impractical for Atlassian to support these kinds of changes in general.

**Performance tuning works**
Atlassian has a number of high profile and some extremely high demanding, mission-critical clients who have successfully, usually through trial and error, applied these recommendations to production instances and have significantly improved their instances. For more information, please file a support case at support.atlassian.com.

### Operating Large or Mission-Critical Confluence Installations

This page gives guidelines for operational management teams who are responsible for a large Confluence installation, or for a Confluence installation which is crucial to the business of their organisation.

### Introduction to this Page

#### Motivation for Presenting these Guidelines

Most Confluence installations start off small. Ten people in an early-adoption department use it for a couple of weeks. Everything works well and the good news starts spreading. Adoption increases throughout the organisation. More and more people use the wiki, and more and more rely on Confluence being up and running. After a while even the CEO starts blogging. And then a system outage occurs.

Now what?

Wikis like Confluence often grow into mission-critical applications within just a few months. Often adoption is so fast that IT departments haven't had the time to scale up their support.

We have assembled some requirements to help you make sure that your installation of Confluence can be mission critical. There are no surprises to be found here — all of the requirements would apply to any other piece of software that is mission critical within your organisation.

#### Who should Read these Guidelines?

The guidelines do not apply to you if you are using Confluence with just a few dozen users, and no one really minds if Confluence is down for a couple of hours because your database has crashed.

But if any one of the following applies to you, then these guidelines are a must read for you!

- The wiki has become your organisation's documentation base.
- Your users can't work properly when Confluence is down.
- Your boss or customer threatens to terminate your contract if you don't meet a strict service level agreement (SLA), such as 99.9% availability.

### Requirements of Large or Mission-Critical Confluence Installations

**Confluence 4.3 Documentation**

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Dedicated Hardware for Confluence

In a small work group with a few dozen or even hundreds of users, your Confluence installation can happily share the CPUs, memory and disks with other low-profile applications and a database.

But with thousands or even tens of thousands of users, you need dedicated hardware that runs Confluence and nothing else, and it needs to be fast hardware with plenty of RAM. While you can run Confluence in a virtualised environment such as VMware, we suggest you don't do it for mission-critical or high-load installations unless you are a real expert in virtualisation. Otherwise your other VMs might have performance problems which propagate to Confluence.

If you experience database-related problems, you should consider moving the Confluence database to a dedicated machine. Confluence itself can run queries that impact the performance of other applications, and other application problems or scheduled tasks can have an adverse affect on the usability of Confluence.

Dedicated Qualified Staff

If your Confluence installation is mission critical and your service level agreements require 24/7 up time, you need to be able to pinpoint problems quickly. You need qualified staff, dedicated to looking after Confluence, who are available during business hours and possibly beyond.

If you require assistance from the Atlassian Support team, you may need to answer some pretty technical questions to help us diagnose what is going on in your systems. Also keep in mind that Atlassian support assists you in finding problems in Confluence, but we can't help you administer your systems.

In particular, we recommend that you have dedicated staff in the roles listed below.

**Operations Team with General Administrators**

If your organisation relies on Confluence being up and running around the clock with very little downtime, you need people who can set up, maintain, tune and improve your Confluence installation. This requires at least one person, but ideally you will have a team of operational engineers.

If your wiki is mission critical, chances are that other IT systems within your organisation have already made it necessary to have such an operations team. So you will probably not need to hire someone specifically to administrate Confluence. But it is vital that supporting and maintaining Confluence is added to the list of responsibilities of that operations teams, and that you can get them to troubleshoot and analyse Confluence at short notice.

If problems arise and you need to contact Atlassian Support, these engineers will be our first point of contact. We may ask them to provide details of log files, application-server settings, monitoring systems, and so on.

**Network Staff**

If Confluence is mission critical for large numbers of users, it is vital that you have dedicated network staff available to track down problems when they arise.

A mission-critical installation will usually be used by hundreds or even thousands of users, and you don't want to keep them waiting because a network card breaks, or because someone has made an undocumented change to the network and you don't have an expert around who can figure it out.

Again, this only applies to mission-critical systems. If you use Confluence for less critical collaboration and knowledge sharing, and a broken network cable causing a day's downtime is no major catastrophe, then you will not need dedicated networking staff.

**Database Staff**

If Confluence is mission critical for a large number of users, you need an experienced database administrator
(DBA) available to troubleshoot database performance issues and other potential problems. It is dangerous not to have an experienced full-time DBA at hand at short notice when running a mission critical application. While small installations of Confluence basically work ‘out of the box’, any system that involves high load or high-availability requirements needs continual monitoring, optimising and fine tuning of the Confluence database. Database monitoring is no trivial task — it's not something that anyone can learn quickly.

**Developers**

You may have decided to customise Confluence by changing its source-code, or by writing your own plugins. If your server is mission-critical, you must nominate staff who will be responsible for that code, and they must be up for the task. Otherwise you might end up in a situation in which your server experiences downtimes because of custom code is broken, or does not work with a newer version of Confluence anymore, but you can't fix the problem because no one knows how the customized code works, and you can't uninstall it either because it has become critical for your Confluence usage pattern. Keep good track of changes, and have someone available to jump into action if there is a problem. Don't let the summer intern write mission-critical plugins, unless you have more senior staff to maintain that code as long as it is in use.

**Constant Monitoring of Production Systems**

You will need to monitor your production systems constantly.

When the wiki is the lifeblood of your organisation, you need know exactly what is going on inside, so that you can plan for future needs and analyse potential bottlenecks.

Monitoring involves a number of essential tasks, including those listed below:

- Monitoring log files.
- Checking for HTTP-availability and performance (e.g. by getting the same page every five minutes and displaying the time on a graph).
- Looking at many different parameters such as load, connections, IO, database-trends, and so on.
- Charting long-term trends.
- Keeping an access log of requests to the web server. This is vital, especially when requesting performance support from Atlassian.

Monitoring a web application like Confluence implies also monitoring the subsystems it uses. Many outages and downtimes are caused by broken mail servers, databases running out of space, file systems filling up and so on. It is often possible to detect these trends way before the actual web application breaks down. Keep an eye on the file system, and if you see it is getting closer to 90% utilisation, you can mend the situation without Confluence breaking down. Or even if the worst case happens (e.g. the database breaks down and Confluence is affected straight away) then having the proper monitoring for the database server makes troubleshooting a lot easier.

**Tools for Monitoring Confluence**

At Atlassian we use [Hyperic](https://www.atlassian.com/software/hyperic). But the list of monitoring systems is long and we can't recommend a specific product over the other. If your organisation has a monitoring system already, make sure you hook up Confluence to it. If you don't have a monitoring system yet, you need to install one as soon as you feel Confluence is mission critical.

As an example of what our monitoring UI looks like, have a look at this screenshot:
The following screenshot shows one of our sensors looking at the HTTP response times of our documentation wiki over the last 8 days. You can clearly see an incident four days ago. Having the graph (and regularly looking at it) allowed us to pinpoint the problem. We analysed the access logs and found that webpage-profiling had been enabled but not disabled again, which caused performance problems.
This page would get too long if we described all our monitoring sensors - but just to give you an impression, this is what we monitor on the JVM level alone.

**JVM basics**

- Current Loaded Classes
- Daemon Thread Count
- Heap Memory Committed
- Heap Memory Max
- Heap Memory Used
- Loaded Classes
- Loaded Classes per Minute
- Object Pending Finalization Count
- Peak Thread Count
- Thread Count
- Unloaded Classes
- Unloaded Classes per Minute

**JVM garbage collection**

- Collection Count
- Collection Count per Minute
- Collection Time
- Collection Time per Minute

**JVM memory: (Metrics for Eden space, Old Gen, Survivor space, Perm Gen)**

- Committed Memory
- Used Memory

We get the same level of detail for our database, for the file system, for the CPU, for the network, and so on. Not all of this is needed all the time. But if your company depends on an application, then the more information you have at your fingertips the better. Fortunately these metrics can be extracted quite easily once you have a monitoring system in place.

**Adherence to Strict Upgrade Procedures**

Your organisation will have its own upgrading procedure. Here are a few recommendations that you should add to your list:

- **Our main recommendation:** Never change more than one component at a time. Sometimes it may be tempting to upgrade the server hardware when you upgrade Confluence, but we recommend you don't do that. It makes pinpointing errors much more difficult. So, for example, don't upgrade hard disks in conjunction with a Confluence version upgrade, don't change the Confluence configuration at the same time as you upgrade your Apache software, and don't upgrade a major third-party plugin the day you move your database system to a new machine. The list is endless, these were just a few examples to get you thinking.
- After each upgrade step, run Confluence for a couple of days to check that everything is still fine.
- Keep track diligently of what you change, and when. It will be nearly impossible for us to help you if you can't tell us what exactly you changed at what time.
- Keep a copy of all log files produced during the upgrade, together with notes about what changed between successive restarts.
Always take careful note of the upgrade notes published with the Confluence Release Notes of each Confluence version, as well as the Confluence Upgrade Guide.

**Example**

Here you can see an extract of our change log for [http://confluence.atlassian.com](http://confluence.atlassian.com) — the server that hosts this very page.

<table>
<thead>
<tr>
<th>Sydney time</th>
<th>Server time</th>
<th>Event</th>
<th>Reason/Purpose (including JIRA issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008-03-25 22:18</td>
<td></td>
<td>Started upgrade to 2.8-m9-r3 (build #1314)</td>
<td></td>
</tr>
<tr>
<td>2008-03-25 22:25</td>
<td></td>
<td>App server brought down due to failed database upgrade</td>
<td></td>
</tr>
<tr>
<td>2008-03-26 00:51</td>
<td></td>
<td>Server brought back up after database restored from backup. Running 2.8-m9-r3.</td>
<td></td>
</tr>
<tr>
<td>2008-03-28 04:18</td>
<td></td>
<td>GC algorithm changed from concurrent to parallel collector. Max heap increased from 1.4 GB to 2.0 GB</td>
<td></td>
</tr>
<tr>
<td>2008-04-24</td>
<td></td>
<td>Hyperic agent started with connection to Resin.</td>
<td></td>
</tr>
<tr>
<td>2008-05-08 20:30</td>
<td>2008-05-08 22:30</td>
<td>Manual updates to menu.css, comments.js and comments.css in webapp</td>
<td>Temporary fix for @JIRA, @JIRA which was impacting performance</td>
</tr>
<tr>
<td>2008-05-12</td>
<td></td>
<td>Updated cache sizes for five caches, bounced server.</td>
<td>Cache efficiency was low on these caches.</td>
</tr>
<tr>
<td>2008-05-13 18:00-18:20</td>
<td>2008-05-13 03:00-03:20</td>
<td>Upgrade from Resin 3.0 to Tomcat 5.5</td>
<td></td>
</tr>
<tr>
<td>2008-05-14 16:30-17:00</td>
<td></td>
<td>Upgrade from Confluence 2.8.1-rc2 to 2.8.1-rc3</td>
<td></td>
</tr>
<tr>
<td>2008-05-14 20:30</td>
<td></td>
<td>Install new cronjob as j2ee for automating access log analysis</td>
<td>@JIRA</td>
</tr>
</tbody>
</table>

**Testing of Upgrades before Production Implementation**
You should test upgrades in a staging environment.

Before rolling out a new version of Confluence (or of the software or hardware that it uses, e.g. database systems, application servers, data storage), make sure that you test the upgrade with real data (e.g. a database dump) on a completely independent machine.

Here's an example of what such a test would pick up: The new release of Confluence may not be compatible with a custom third party plugin you have previously installed, thus breaking the plugin's functionality. You may not even know that anyone installed that plugin — but maybe many people are already using it. You'll want to find out about this before you actually roll out the new version of Confluence.

Here is an outline for a simple upgrade test:

1. Create a clone of your production environment, using a database dump to obtain a copy of the Confluence data. We'll call this your 'staging environment'.
2. Upgrade the staging environment to the new version of Confluence.
3. Ask a few selected users from different departments to check the pages they commonly access, but have them do it in the staging environment.

Hint: In addition to finding weirdnesses with plugins, this may also show whether training for new functionality is needed in some of the departments. The IT department staff may be able to handle the upgrade to a new version of Confluence without training, but perhaps the sales representatives who use the wiki less often will need some training.

Getting a license for your staging environment
The page Getting a License for a Staging Environment does not exist.

Enforcing Security Guidelines

Security is one of the most important issues for Confluence. We are constantly spending large amounts of effort to keep up with security threats and to Confluence's security model. We treat security breaches with utmost priority, and the recent releases have been improved to fend off advanced attack vectors like cross-site scripting (XSS), cross-site request forgery (XSRF) and header injection flaws. Altogether we believe that Confluence is a very secure product. But of course as with any software there are occasional bugs, and we are fixing security issues whenever they come up. We regularly release minor software releases that contain security fixes. This means you should upgrade your system frequently. Obviously this can affect your system's uptime. You should also make sure your whole infrastructure around Confluence is made robust as well (consider operating systems, webservers, application servers, networks, social engineering aspects, etc).

As with any other distributed system, you need to decide on a case by case basis if classified documents can be stored in it. It is common practice to store the most secure documents on computers that are not even connected to the physical intranet. Please contact your company's security officer to learn more about your enterprise's security procedures.

Make sure to have qualified staff around, so you can deal with security issues quickly. Once a security patch becomes available or a security incident happens, speed is essential.

Please refer to our dedicated Configuring Confluence Security page for more technical details.

Load-Testing Environments

Many customers ask us,

So, how many users and spaces can I put into Confluence, and what is the best hardware do to so?

The answer is, 'It depends'.

It depends a lot on your use case. Confluence is so successful because it can cover a huge range of use cases.
If most of your users only access Confluence infrequently, it is no problem to have 70,000 to 100,000 users. But if each user is a power-user who uses the system the whole day, there's a substantial decrease in number Confluence can take without tuning. If your pages are short, simple, and don't contain a lot of macros, then the situation will be vastly different from a system that relies heavily on macros, background-tasks, or other features.

If your system is large (for example serving more than 10,000 users or storing more than 1000 spaces) or mission-critical (which it could be with as few as 1000 users who use it all the time) you need one or more more load-testing environments.

Even if your system is working nicely for 20,000 users right now, it might take just another 2000 users to push it over the edge.

We recommend the following basic procedure:

- Set up an environment that closely resembles your production environment.
- Gather statistics from your production system.
- Regularly apply a similar kind of load (and slightly higher) to the load-testing environment.
- Analyse how well Confluence scales for your usage patterns.

The Confluence development team has load-testing scripts available which you can use to simulate load. You can also contact Atlassian Support for more details.

**Tuning**

You may need to be able to tune your installation in the ways mentioned below.

**Optimising your System**

If you have large numbers of users, then downloading all the static content (CSS, default images, JavaScript-files) may result in a high additional load on the application server that can be offloaded to a caching web server.

Please refer to the following additional information:

- Our general Performance Tuning page.
- Information on configuring a large Confluence installation.

**Limiting Third-Party Plugins**

You may have to restrict the number of third-party plugins installed on your Confluence instance.

Most third-party plugins are not specifically written for high-load environments. What works fine in low-load environments could have unexpected and adverse effects when thousands of users are competing for your application server's CPU time or for database IO.

A common source of problems is access to database connections. If you have fewer users than database connections, it does not matter if an operation holds on to a database connection for two seconds while it downloads some data from the internet. With hundreds of concurrent users, this could quickly become a bottleneck.

Confluence itself is tested and optimised to handle high loads and avoids these kinds of problems. But if you install a number of plugins that have not been tested against high load, your system may become unstable.

We recommend that you load test the common use cases of each unofficial third-party plugin if your Confluence installation is mission critical. Only activate plugins that are vital to your business, and never allow experimental plugins onto your production system until they have been tested in a staging environment.

**Selecting and Tuning your JVM**

You should select your JVM carefully and you may need to be able to tune it.
The selection of the JVM for your large Confluence instance can have a huge impact on the performance perceived by the users. Between versions 1.4 and 6 of the Sun Java JVM there have been some impressive improvements in performance, especially under high concurrent load.

Here are some essential guidelines:

- Always run the most recent point release of your selected JVM.
- Where ever possible run the most recent major release from your selected JVM manufacturer. The Sun JVM version 6 is much faster than 1.4, especially under high loads.
- Tune your garbage collection algorithms. Experiment with different algorithms and settings to get the response times you desire in your environment. Here are some specific guidelines for Sun JVM in the Sun documentation:
  - Java 6
  - Java 5
  - Java 1.4

Customising Confluence to Optimise Performance

You may need to customise Confluence for performance reasons. Depending on your usage scenario, there may be ways to enhance Confluence performance that become necessary when you reach a certain level of usage.

Here are some things you might decide to do:

- Remove the display of the space list on the Dashboard. See Customising the Dashboard.
- Configure any search appliances or other crawlers which are configured to index the Confluence site:
  - These should be suitably rate limited.
  - Configure them to crawl only pages in the /display/ URL path, and only current versions of pages.

Please refer to our general Performance Tuning page for more details.

Related Topics

Performance Tuning
Configuring a Large Confluence Installation
Confluence Clustering Overview
Requesting Performance Support
Confluence Administrator's Guide
Configuring Confluence
Server Hardware Requirements Guide
How to Fix Out of Memory Errors by Increasing Available Memory

Scheduled Jobs

The administration console allows you to schedule various administrative jobs in Confluence, so that they are executed at regular time intervals. The types of jobs which can be scheduled cover:

- Confluence site backups
- Storage optimisation jobs to clear Confluence's temporary files and caches
- Index optimisation jobs to ensure Confluence's search indexes are up to date
- Mail queue optimisation jobs to ensure Confluence's mail queue is maintained and notifications have been sent.

You need to have System Administrator permissions in order to configure and execute jobs.
Accessing Confluence’s Scheduled Jobs Configuration

To access Confluence’s Scheduled Jobs configuration page:

1. Choose Browse > Confluence Admin.
2. Click ‘Scheduled Jobs’ under ‘Administration’ in the left panel to open the ‘Scheduled Jobs’ page. For each job listed down this page, the following information is shown:
   - **Job** — the name of a job.
   - **Status** — the job’s status, which is either ‘Scheduled’ (it it is currently enabled) or ‘Disabled’. See below for details on disabling or re-enabling a job.
   - **Last Execution** — the date and time when the job was last executed. This field will be empty if the job was never executed.
   - **Next Execution** — the date and time when the job is next scheduled to be executed. This field will contain dash symbol (‘-’) if the job is disabled.
   - **Avg. Duration** — the length of time (in milliseconds) that it took to complete the job’s last execution.
   - **Actions** — allows you to configure the job, execute it manually, view a history of previous executions or disable the job.

<table>
<thead>
<tr>
<th>Job</th>
<th>Status</th>
<th>Last Execution</th>
<th>Next Execution</th>
<th>Avg. Duration</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Confluence</td>
<td>Scheduled</td>
<td>26-Feb-2011 02:00:00</td>
<td>02-Mar-2011 02:00:00</td>
<td>220</td>
<td>History</td>
</tr>
<tr>
<td>Check Cluster Safety</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:30</td>
<td>01-Mar-2011 17:30:00</td>
<td>12</td>
<td>History</td>
</tr>
<tr>
<td>Clean Index Queue</td>
<td>Scheduled</td>
<td>02-Mar-2011 02:00:00</td>
<td>02-Mar-2011 02:00:00</td>
<td>115</td>
<td>History</td>
</tr>
<tr>
<td>Clean Temporary Directory</td>
<td>Scheduled</td>
<td>28-Feb-2011 04:00:00</td>
<td>02-Mar-2011 04:00:00</td>
<td>109</td>
<td>History</td>
</tr>
<tr>
<td>Clear Expired Mail Errors</td>
<td>Scheduled</td>
<td>02-Mar-2011 03:00:00</td>
<td>02-Mar-2011 03:00:00</td>
<td>80</td>
<td>History</td>
</tr>
<tr>
<td>Clear Expired Reminders Tokens</td>
<td>Scheduled</td>
<td>26-Mar-2011 00:00:00</td>
<td>02-Mar-2011 00:00:00</td>
<td>0</td>
<td>Run</td>
</tr>
<tr>
<td>Email Daily Reports</td>
<td>Scheduled</td>
<td>28-Feb-2011 00:00:00</td>
<td>02-Mar-2011 00:00:00</td>
<td>571</td>
<td>History</td>
</tr>
<tr>
<td>Flush Did You Mean Index</td>
<td>Scheduled</td>
<td>01-Mar-2011 18:00:00</td>
<td>01-Mar-2011 18:00:00</td>
<td>0</td>
<td>Run</td>
</tr>
<tr>
<td>Flush Index Queue</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:00</td>
<td>01-Mar-2011 17:30:00</td>
<td>50</td>
<td>History</td>
</tr>
<tr>
<td>Flush Local Task Queue</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:00</td>
<td>01-Mar-2011 17:30:00</td>
<td>6</td>
<td>History</td>
</tr>
<tr>
<td>Flush Mail Queue</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:00</td>
<td>01-Mar-2011 17:30:00</td>
<td>5</td>
<td>History</td>
</tr>
<tr>
<td>Flush Task Queue</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:00</td>
<td>01-Mar-2011 17:30:00</td>
<td>4</td>
<td>History</td>
</tr>
<tr>
<td>Optimize Indexing</td>
<td>Scheduled</td>
<td>28-Feb-2011 15:00:00</td>
<td>02-Mar-2011 03:00:00</td>
<td>47</td>
<td>History</td>
</tr>
<tr>
<td>Poll Mail</td>
<td>Scheduled</td>
<td>01-Mar-2011 17:29:00</td>
<td>01-Mar-2011 17:30:00</td>
<td>12</td>
<td>History</td>
</tr>
</tbody>
</table>

Screenshot above: Scheduled Jobs

Executing a Job Manually

1. Access the ‘Scheduled Jobs’ configuration page (above).
2. Locate the job you wish to execute manually and click its ‘Run’ link in the ‘Actions’ column. The job will be run immediately.

   ✔ Refer to ‘Types of Jobs’ (below) for detailed descriptions about each job.
Not all jobs can be run manually.

### Configuring a Job's Schedule

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose schedule you wish to configure and click its 'Edit' link in the 'Actions' column. The job's 'Edit Schedule for job' dialog box opens.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
3. Enter an appropriate cron expression to define the frequency with which the job is executed.
   - Refer to 'Cron Expressions' (below) for more details about their syntax. To revert the job's schedule back to its default settings, click the 'Default' button.
4. Click 'Save' to record your job's new schedule.

Not all jobs' schedules are configurable.

### Disabling/Re-enabling a Job

By default, all jobs in Confluence are enabled.

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job you wish to disable/re-enable.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
   - If a job is enabled, click its 'Disable' link in the 'Actions' column to disable the job.
   - If a job is disabled, click its 'Enable' link in the 'Actions' column to enable the job.

Not all jobs in Confluence can be disabled.

### Viewing a Job's Execution History
1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose execution history you wish to view and click the 'History' link.
   - If a job has not completed at least one execution, its 'History' link will not be available.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.

   The 'History for job' dialog box opens, showing a list of previous executions of the job in reverse chronological order, including the:
   - Start date and time
   - End date and time
   - The length of time (in milliseconds) that it took to complete the job

   Screenshot above: Job Execution History

### Types of Jobs

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
<th>Execution Behaviour</th>
<th>Default Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Confluence</td>
<td>Performs a backup of your entire Confluence site.</td>
<td>Per cluster</td>
<td>At 2am every day</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>Frequency</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td></td>
</tr>
<tr>
<td>Check Cluster Safety</td>
<td>For clustered Confluence installations, this job ensures that only one Confluence instance in the cluster writes to the database at a time. For standard (non-clustered) editions of Confluence, this job is useful for alerting customers who have accidentally connected a second Confluence instance to a Confluence database which is already in use.</td>
<td>Every 30 seconds</td>
<td></td>
</tr>
<tr>
<td>Clean Index Queue</td>
<td>Triggers a periodical clean of the index queue to ensure that its size does NOT grow indefinitely.</td>
<td>At 2am every day</td>
<td></td>
</tr>
<tr>
<td>Clean Temporary Directory</td>
<td>Cleans up temporary files generated in the 'temp' subdirectory of the Confluence home directory. This temp directory may be created by exports etc. If this does not include the temp directory located in the confluence install directory.</td>
<td>At 4am every day</td>
<td></td>
</tr>
<tr>
<td>Clear Expired Mail Errors</td>
<td>Clears notification errors in the mail error queue. A notification error is sent to the mail error queue whenever the notification fails to be sent due to an error.</td>
<td>At 3am every day</td>
<td></td>
</tr>
<tr>
<td>Clear Expired Remember Me Tokens</td>
<td>Clears all expired 'Remember Me' tokens from the Confluence site. Remember Me tokens expire after two weeks.</td>
<td>On the 20th of each month</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>Frequency</td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Email Daily Reports</strong></td>
<td>Emails a daily summary report of all Confluence changes to all subscribers. Since each email report only records changes from the last 24-hour period, it is recommended that you only change the time of this job whilst keeping the job's frequency to 24 hours.</td>
<td>Per cluster At 12am every day</td>
<td></td>
</tr>
<tr>
<td><strong>Flush Did You Mean Index</strong></td>
<td>Flushes changes to the 'Did You Mean' index, which keeps the 'Did You Mean' feature up to date. Confluence records each content update in the 'Did You Mean' index.</td>
<td>Per node Every 2 hours from 12 am</td>
<td></td>
</tr>
<tr>
<td><strong>Flush Index Queue</strong></td>
<td>Flushes changes to Confluence's index so that Confluence's search results are up to date. Confluence records each content update in its search index.</td>
<td>Per node Every minute</td>
<td></td>
</tr>
<tr>
<td><strong>Flush Local Task Queue</strong></td>
<td>Flushes the local task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.)</td>
<td>Per node Every minute</td>
<td></td>
</tr>
<tr>
<td><strong>Flush Mail Queue</strong></td>
<td>Sends notifications that have been queued up in the mail queue.</td>
<td>Per cluster Every minute</td>
<td></td>
</tr>
<tr>
<td><strong>Flush Task Queue</strong></td>
<td>Flushes the task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.)</td>
<td>Per node Every minute</td>
<td></td>
</tr>
</tbody>
</table>
### Optimise Indexing

Compacts the confluence indexes to maintain searching performance.

- This task is demanding on system resources and does not need to be performed too regularly. If you see Confluence performance deteriorate around 3pm, try scheduling this job for 3am only and check if search performance remains reasonable.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optimise Indexing</td>
<td>Compacts the confluence indexes to maintain searching performance.</td>
<td>Per node At 3am and 3pm every day</td>
</tr>
<tr>
<td>Poll Mail</td>
<td>Polls POP accounts on all spaces that have them configured.</td>
<td>Per cluster Every minute</td>
</tr>
</tbody>
</table>

### Cron Expressions

A cron expression is a string of 6-7 'time interval' fields that defines the frequency with which a job is executed. Each of these fields can be expressed as either a numerical value or a special character and each field is separated by at least one space or tab character.

The table below is shows the order of time interval fields in a cron expression and each field's permitted numerical values.

You can specify a special character instead of a numerical value for any field in the cron expression to provide flexibility in defining a job's frequency. Common special characters include:

- `'*'` — a 'wild card' that indicates 'all permitted values'.
- `'?'` — indicates 'ignore this time interval' in the cron expression. That is, the cron expression will not be bound by the time interval (such as 'Month', 'Day of week' or 'Year') to which this character is specified.

For more information about cron expressions, please refer to the [Cron Trigger tutorial on the Quartz website](#).

<table>
<thead>
<tr>
<th>Order in cron expression</th>
<th>Time interval field</th>
<th>Permitted values*</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Seconds</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Minutes</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Hours</td>
<td>0-23</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Day of month</td>
<td>1-31</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Month</td>
<td>1-12 or JAN-DEC</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Day of week</td>
<td>1-7 or SUN-SAT</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Year</td>
<td>1970-2099</td>
<td>No</td>
</tr>
</tbody>
</table>
**Search**

No content found for label(s) modify-search.

* Excluding special characters.

**RELATED TOPICS**

- Trigger Module
- Configuring Backups

---

**Setup Confluence To Index External Sites**

**Confluence Indexing External Sites**

Confluence cannot easily index external sites due to technical reasons, but there are two alternatives:

1. **Embed External Pages Into Confluence**
2. **Replace Confluence Search**

---

**Technical Reasons**

Confluence indexes pages using a customised Lucene search engine that returns matching pages, mail and blog posts for which the searcher has view permission. It would require significant source code modifications to enable Confluence to process search results from external pages, as the indexing process has been customised to utilise internal Confluence metadata. Note that users can still index content from new attachment filetypes.

**Embed External Pages Into Confluence**

If you only have a small number of external sites to index, you may prefer to enable the HTML-include Macro and use it embed the external content inside normal Confluence pages.

**Replace Confluence Search**

Use your own programmer resources to replace Confluence's internal search with a crawler that indexes both Confluence and external sites. This advanced option is easier than modifying the internal search engine. It requires removing Confluence internal search from all pages and replacing the internal results page with your own crawler front-end.

1. Setup a replacement federated search engine to index the Confluence site, as well as your other sites, and provide the results that way. You would need to host a web crawler, such as these open-source crawlers. Note that you can perform a search in Confluence via the remote API
2. Replace references to the internal search by modifying the site layout so that it links to your search front-end
3. Host another site containing the search front-end. You may wish to insert it into a suitable context path in your application server so that it appears to be from a path under Confluence. Tomcat sets Confluence's paths from the Confluence install\confluence\WEBINF\web.xml file.

---

**RELATED TOPICS**
Setup External Search Tool To Index Confluence

Setup External Search Tool To Index Confluence
Any web crawler can be configured to index Confluence content, for example the Google Search Appliance or similar. If a login is required to view content that will be indexed, you should create a Confluence user specifically for the search crawler to use. Grant this user view rights to all content you wish to index, but deny that user all delete and administration rights. This ensures that an aggressive crawler will not be able to perform actions that could modify the site. There is also a forum thread on Google Mini integration.

External applications can also use the search function in the Confluence Remote API.

The information on this page does not apply to Confluence OnDemand.

Related Information
No content found for label(s) modify-search.

Working with Confluence Logs

Confluence uses Apache’s log4j logging service. This allows a developer or administrator to control the logging behavior and the log output file by editing a configuration file, without touching the application binary. There are six known log4j logging levels.

If you request help from Atlassian Support, we will almost always ask for the atlassian-confluence.log from the confluence-home/logs directory. You can access the logs from the Confluence Administration Console, via the support tool. If you cannot access the Confluence Administration Console, check the properties file at <confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties, look for the confluence.home setting in that file, then find the logs in the Confluence home directory.

On this page:
- Finding the Confluence Log Files
- Finding the Log Configuration File
- Changing the Destination of the Log Files
- Changing the Logging Levels
- Using Some Specific Confluence Logging Options
- Scanning Log Files for Known Problems
- Notes

The information on this page does not apply to Confluence OnDemand.

Finding the Confluence Log Files

This section describes Confluence’s default logging behaviour, assuming that you have not changed the destination of the logs. In order to unify logging across different application servers, Confluence uses the atlassian-confluence.log as its primary log, not the application server log.

Both the Confluence and Confluence EAR/WAR distributions follow the same default behaviour:
- When you start Confluence, log entries will be sent to the application server logs until Confluence has completed its initial bootstrap. Any log entries written to the console will be repeated into the log in the Confluence home directory as described below.
• Once the initial startup sequence is complete, all logging will be to <confluence-home>/logs/atlassian-confluence.log. For example: c:/confluence/data/logs/atlassian-confluence.log.

Note that the default location is the Confluence home directory, not the application server’s log file. The home directory is specified in <confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties.

Finding the Log Configuration File

Confluence’s logging behaviour is defined in the following properties file:
<CONFLUENCE-INSTALL>/confluence/WEB-INF/classes/log4j.properties

This file is a standard log4j configuration file, as described in the Apache log4j documentation.

Changing the Destination of the Log Files

Terminology: In log4j, an output destination is called an ‘appender’.

To change the destination of the log files, you need to stop Confluence and then change the settings in the ‘Logging Location and Appender’ section of the log4j.properties file. The location of this file is described above.

In the standard properties file, you will find entries for two appenders:

• com.atlassian.confluence.logging.ConfluenceHomeLogAppender – This is a custom appender which controls the default logging destination described above. This appender allows the following settings:
  • MaxFileSize
  • MaxBackupIndex

• org.apache.log4j.RollingFileAppender – If you want to log to a different location, uncomment the RollingFileAppender line and change the destination file in the line below it. Comment out the previous lines referring to the ConfluenceHomeLogAppender.

Confluence ships with the full suite of appenders offered by log4j. Read more about appenders in the log4j documentation.

Changing the Logging Levels

See Configuring Logging for instructions on how to change the logging configuration of Confluence.

Using Some Specific Confluence Logging Options

This section contains some pointers to specific log configurations you may need.

Log the Details of SQL Requests made to the Database

You may want to increase Confluence’s logging so that it records individual SQL requests sent to the database. This is useful for troubleshooting specific problems.

You can enable detailed SQL logging in two ways:

• At runtime – see instructions above.
• Via the logging properties file – see the detailed instructions.
Log the Details of Users Viewing/Accessing each Confluence Page

You can configure the log to show which users are accessing which pages in Confluence. This can only be done via the logging properties file – see the detailed instructions.

Scanning Log Files for Known Problems

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker. See Troubleshooting Problems and Requesting Technical Support.

Notes

- **Finding the thread dumps.** Thread dumps are logged to the application server log file.

Related Topics

- Important Directories and Files
- Enabling Detailed SQL Logging
- Enabling user access logging
- Generating a Thread Dump
- Enabling Page Request Profiling
- Troubleshooting Problems and Requesting Technical Support

log4j Logging Levels

Logging Levels

- **DEBUG** - designates fine-grained informational events that are most useful to debug an application *(what is going on)*
- **INFO** - announcements about the normal operation of the system - scheduled jobs running, services starting and stopping, user-triggered processes and actions
- **WARN** - any condition that, while not an error in itself, may indicate that the system is running sub-optimally
- **ERROR** - a condition that indicates something has gone wrong with the system
- **FATAL** - a condition that indicates something has gone wrong so badly that the system can not recover
- **TRACE** - n/a within Confluence

There are two ways to modify the logging levels, as described in Working with Confluence Logs.

1. Modifying the runtime log levels via the Administration Console.
2. Manually modifying the `<Confluence-install>\confluence\WEB-INF\classes\log4j.properties` file.

The information on this page does not apply to Confluence OnDemand.

Default Log Level

The standard Confluence log level **WARN** is a way for Confluence to communicate with the server administrator. Logging at WARN level and higher should be reserved for situations that require some kind of attention from the server administrator, and for which corrective action is possible.
Integrating Confluence with Other Applications

You can integrate Confluence with other applications using Application Links. The Application Links feature allows you to link Confluence to applications like Atlassian’s JIRA. Linking two applications allows you to share information and access one application's functions from within the other. For example, if you linked your Confluence server with a JIRA server, you could view JIRA issues in a Confluence page via the JIRA Issues Macro.

Getting Started

The Application Links quick start guide provides instructions on how to set up the most common application link configuration.

Administrator’s Guide

The administrator's guide is for administrators who want to configure application links for their applications. The guide contains information on adding a new application link, configuring the authentication for an application link, setting up project links and more.

Developer Resources

These resources are for developers who want to develop with the Application Links plugin. Take a look at the Development Hub.

Related Topics

- Configuring Application Links
- Confluence and JIRA

Configuring Application Links

An application link is a trust relationship between two applications. Linking two applications allows you to share information and to access one application's functions from within the other.

Notes

- In the above screenshot, the column titled 'Incoming Authentication' is visible in Confluence 3.5.1 and later. The column does not appear in Confluence 3.5.

Related Topics

- Adding an Application Link
Adding an Application Link

This page describes how to add a new application link in Confluence. The process for adding an application link is different depending on whether the application that you are linking Confluence to, supports Application Links (i.e. has Application Links installed) or not.

If you are linking Confluence to an application that does not have Application Links, you will need to do additional configuration in that application. This is because Application Links in Confluence will not be able to automatically configure authentication in your remote application.

Please read the appropriate set of instructions below:

- Linking to an application that supports Application Links.
- Linking to an application that does not support Application Links.

On this page:
- Adding an Application Link to an Application That Supports Application Links
- Adding an Application Link to an Application That Does Not Support Application Links
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Adding an Application Link to an Application That Supports Application Links

Before you begin:

- Make sure that the base URL is set correctly in Confluence. See Configuring the Server Base URL for instructions.
- Make sure that the base URL is set correctly in the application which you intend to link to. See the appropriate instructions: JIRA instructions | FishEye/Crucible instructions | Bamboo instructions. This is required for synchronisation to work correctly.

To link to an application that supports Application Links:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click ‘Add Application Link’. Step 1 of the link wizard will appear.
3. Enter the server URL of the application that you want to link to (the ‘remote application’).
4. Click the ‘Next’ button. Step 2 of the link wizard will appear.
5. Enter the following information:
   - 'Create a link back to this server' – Tick this check box if you want to create a two-way link between the remote application and your application. If you want to do this, you will need to enter the username and password of an administrator for the remote application.
     Note: These credentials are only used to authenticate you to the remote application, so that Application Links can make the changes required for the new link. The credentials are not saved.
   - 'Reciprocal Link URL' – The URL you give here will override the base URL specified in your remote application’s administration console, for the purposes of the application links connection.
Application Links will use this URL to access the remote application.

6. Click the 'Next' button. Step 3 of the link wizard will appear.

7. Enter the information required to configure authentication for your application link:
   - 'The servers have the same set of users' or 'The servers have different sets of users' – Select one of these options depending on how you manage users between the two applications.
   - 'These servers fully trust each other' – Tick this check box if you know that the code in both applications will behave itself at all times and are sure each application will maintain the security of its private key.

   For more information about configuring authentication, see Configuring Authentication for an Application Link.

8. Click the 'Create' button to create the application link.

---

Adding an Application Link to an Application That Does Not Support Application Links

Before you begin:

- Make sure that the base URL is set correctly in Confluence. See Configuring the Server Base URL for instructions.
- Make sure that the base URL is set correctly in the application which you intend to link to. See the appropriate instructions: JIRA instructions, FishEye/Crucible instructions, Bamboo instructions. This is required for synchronisation to work correctly.

To link to an application that does not support Application Links:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click 'Add Application Link'. Step 1 of the 'Link to another server' dialogue will be displayed.
3. Enter the server URL of the application that you want to link to, in the 'Server URL' field. Click the 'Next' button. Step 2 of the 'Link to another server' dialogue will be displayed.
4. Fill out the fields, as follows:
   - 'Application Name' — Enter the name by which this remote application will be referred to, in your application.
   - 'Application Type' — Select the type of application that you are linking to: Bamboo, FishEye/Crucible, JIRA, Confluence, Subversion.
5. Click the 'Create' button to create the application link. The 'Configure Application Links' page will be displayed, listing all of the application links that have currently been set up for your application including the one you just added.

6. Configure the desired authentication type (Trusted Applications, OAuth, basic HTTP, none) for your new application link. See Configuring Authentication for an Application Link.

7. In your application that does not support Application Links, configure the same type of authentication that you configured for your application link's outgoing authentication (in the previous step). For example, if you configured outgoing Trusted Applications authentication in your Application-Links-enabled application, you also need to log into your non-Application-Links application and manually configure Trusted Applications (see the relevant administrator's documentation for the application).

Screenshots above: Adding an application link to an application that supports Application Links (click to view full-sized images)

Notes

Related Topics

- Making an Application Link the Primary Link
- Configuring Authentication for an Application Link
- Configuring Project Links across Applications

Configuring Authentication for an Application Link

Configuring authentication for an application link is essentially defining the level of trust between Confluence and the application that it is linked to.

On this page:

- Choosing Authentication for an Application Link
- Security Implications for each Authentication Type
- About Primary Authentication Types
- About Impersonating and Non-Impersonating Authentication Types

⚠️ The information on this page does not apply to Confluence OnDemand.
Choosing Authentication for an Application Link

The level of authentication that you should configure for your application link depends on a number of factors.

- Do the two applications you are linking trust each other? i.e. are you sure that the code in the application will behave itself at all times and that the application will maintain the security of its private key?
- Do the two applications you are linking share the same user base or not?
- Do you have administrative access to the application you are linking to?

Common scenarios include:

- If the two applications you are linking trust each other and share the same user base, configure two-way authentication using Trusted Applications for both incoming and outgoing authentication. For example, you may link your internal Confluence server to an internal JIRA server.
- If the two applications you are linking trust each other but do not share the same user base, configure two-way authentication using OAuth for both incoming and outgoing authentication. For example, you may link your internal Confluence server to an external (customer-facing) JIRA server.
- If you do not have administrative rights to the application that you are linking to (e.g. linking to a public FishEye server), configure a one-way outgoing link authenticated using basic HTTP authentication or do not configure any authentication for the link. For example, you may link your external Confluence server to a partner organisation’s Confluence server. An unauthenticated link will still allow the local application to render hyperlinks to the remote application or query anonymously-accessible APIs.

The flowchart below provides a guide to what authentication you should configure for your application link.

Read the following topics for information on how to configure authentication for an application link:

- Configuring Basic HTTP Authentication for an Application Link
- Configuring OAuth Authentication for an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Incoming and Outgoing Authentication
Flowchart above: Determining what authentication to configure for an Application Link

**Security Implications for each Authentication Type**

If you configure **Trusted Applications authentication** for your application (i.e. your servers have the same set of users and they fully trust each other), please be aware of the following security implications:

- Trusted applications are a **potential security risk**. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.

If you configure **OAuth authentication** for your application (i.e. your servers have different sets of users and they fully trust each other), please be aware of the following security implications:

- Adding an OAuth consumer requires the transmission of sensitive data. To prevent *man-in-the-middle* attacks, it is recommended that you **use SSL** for your applications while configuring OAuth authentication.
- Do not link to an application using OAuth authentication, unless you **trust all code in the application** to behave itself at all times. OAuth consumers are a potential security risk to the applications that they are linked to.
About Primary Authentication Types

You can configure multiple authentication types for each application link. When a feature makes a request using an Application Link, it will use one of the configured authentication types. If more than one authentication type is configured, it will by default use the authentication type that is marked as the primary authentication type. The default authentication type is indicated by the green tick next to the authentication type on the list application link screen.

You cannot configure which authentication type is the primary authentication type. The primary authentication type is determined automatically by Application Links and depends on a weight defined by each authentication type. However, every feature that uses Application Links can also choose to use a specific authentication type and might not use the default primary authentication type.

About Impersonating and Non-Impersonating Authentication Types

Applications Links allows you to configure 'impersonating' and 'non-impersonating' authentication types:

- **Impersonating authentication types** make requests on behalf of the user who is currently logged in. People will see only the information that they have permission to see. This includes OAuth and Trusted Applications authentication.

- **Non-impersonating authentication types** always use a pre-configured user when making a request. Everyone logged into the system will see the same information. This includes basic HTTP authentication.

Configuring Basic HTTP Authentication for an Application Link

The instructions on this page describe how to configure Basic HTTP authentication for outgoing authentication and/or incoming authentication for an application link.

Basic HTTP authentication allows Confluence to provide user credentials to a remote application and vice versa. Once authenticated, one application can access specified functions on the other application on behalf of that user. For example, if you supply the credentials of a Confluence administrator on your Confluence server to a remote application, the remote application will be able to access all functions on your Confluence server that the Confluence administrator can access.

This method of authentication relies on the connection between Confluence and the remote application being secure. We recommend that you use Trusted Applications authentication or OAuth authentication for your application link instead, if possible.

On this page:

- **Before You Begin**
- Configuring Basic HTTP Authentication for Outgoing Authentication
- Configuring Basic HTTP Authentication for Incoming Authentication
- Notes

The information on this page does not apply to Confluence OnDemand.

Before You Begin

- The instructions assume that both of the applications that you are linking have the Application Links plugin installed. If the remote application that you are linking to supports Basic HTTP authentication, but does not have the Application Links plugin installed, you will need to configure Basic HTTP authentication from within the remote application (see the relevant administrator's documentation for the application). This is in addition to configuring the outgoing/incoming authentication for the application link (as described below).

- You must be a Confluence administrator to configure Basic HTTP authentication for an application link.
Configuring Basic HTTP Authentication for Outgoing Authentication

Configuring **outgoing basic http authentication** will allow Confluence to trust a remote application (i.e. allow the remote application to access specified functions in Confluence).

To configure basic http authentication for an outgoing application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure authentication for.
3. Click the ‘Outgoing Authentication’ tab. The outgoing authentication page will be displayed.
4. Click the ‘Basic Access’ tab.
5. Click the ‘Configure’ button and enter the credentials (username and password) that the remote application will use to log into your application.
6. Click the ‘Apply’ button to save your changes.

Configuring Basic HTTP Authentication for Incoming Authentication

Configuring **incoming basic http authentication** will allow the remote application that you are linking to, to trust Confluence (i.e. allow Confluence to access specified functions on the remote application it is linked to).

To configure basic http authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure authentication for.
3. Click the ‘Incoming Authentication’ tab. The incoming authentication page will be displayed.
4. Click the ‘Basic Access’ tab.
5. Click the ‘Configure’ button and enter the credentials (username and password) that your application will use to log in to the remote application.
6. Click the ‘Apply’ button to save your changes.

**Notes**

**Related Topics**

- Configuring OAuth Authentication for an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Configuring OAuth Authentication for an Application Link

The instructions on this page describe how to configure OAuth for outgoing authentication and/or incoming authentication for an application link.

**OAuth** is a protocol that allows a web application to share data/resources with any other OAuth-compliant external application. These external applications could be another web application (such as a JIRA installation or an iGoogle home page), a desktop application or a mobile device application, provided that they are accessible from within your network or available on the Internet.

For example, you could set up an application link between Confluence and an iGoogle page using OAuth authentication. This would allow you to view data from your Confluence server in a Confluence gadget on the iGoogle page (see Configuring Confluence Gadgets for Use in Other Applications).

A typical scenario is setting up an application link between two applications which trust each other, do not share the same set of users but both applications have the Application Links plugin installed. In this case, you would configure OAuth for both outgoing authentication and incoming authentication. See Configuring Authentication.
Key OAuth Terminology

- **Service provider** — An application that shares ('provides') its resources.
- **Consumer** — An application that accesses ('consumes') a service provider's resources.
- **User** — An individual who has an account with the Service Provider.

For more information about OAuth, see [Configuring OAuth](#) as well as the [OAuth specification](#).

---

### Before You Begin

- Adding an OAuth consumer requires the transmission of sensitive data. To prevent 'man-in-the-middle' attacks, it is recommended that you use SSL for your applications while configuring OAuth authentication.
- Do not link to an application using OAuth authentication, unless you trust all code in the application to behave itself at all times. OAuth consumers are a potential security risk to the applications that they are linked to.
- The instructions assume that both of the applications that you are linking have the Application Links plugin installed. If the remote application that you are linking to supports OAuth, but does not have the Application Links plugin installed, you will need to configure OAuth from within the remote application (see the relevant administrator's documentation for the application) in addition to configuring the outgoing/incoming authentication for the application link (as described below).
- You must be a Confluence administrator to configure OAuth authentication for an application link.

### Configuring OAuth for Outgoing Authentication

Configuring **outgoing OAuth authentication** will allow Confluence to access data in a remote application on behalf of a user (i.e. allow Confluence to access specified functions in the remote application).

**To configure OAuth authentication for an outgoing application link:**

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to configure OAuth for.
3. Click the 'Outgoing Authentication' tab. The outgoing authentication page will be displayed.
4. Click the 'OAuth' tab.
5. If you are not currently logged in to the remote application (or you logged in to the remote application under a variant of the application's hostname, such as the IP address), a login dialogue will display.
   - Enter the 'Username' and 'Password' for the remote server, not your local server, and click the 'Login' button. The remote server needs to learn the identity of your local server for the OAuth protocol to work and your admin credentials are used to store your local server's public key on the remote server. If you are already logged into your remote server, then the appropriate changes can be made without having to log in again.
6. Click the 'Enable' button to enable OAuth authentication for the outgoing link. Your application will be
automatically set up to be the 'consumer' and the remote application as a 'service provider'.

Configuring OAuth for Incoming Authentication

Configuring incoming OAuth authentication will allow the remote application that you are linking to, to access data in Confluence.

To configure OAuth authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure OAuth for.
3. Click the ‘Incoming Authentication’ tab. The incoming authentication page will be displayed.
4. Click the ‘OAuth’ tab.
5. Click the ‘Enable’ button to enable OAuth authentication for the incoming link. The remote application will be automatically set up to be the 'consumer' and your local application as a 'service provider'.

Related Topics

- Configuring Basic HTTP Authentication for an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Configuring Confluence Gadgets for Use in Other Applications

Configuring Trusted Applications Authentication for an Application Link

The instructions on this page describe how to configure Trusted Applications for outgoing authentication and/or incoming authentication for an application link.

Trusted Applications authentication allows one application to allow access to specified functions on another application on behalf of any user, without the user having to log into the second application. For example, if you configure a JIRA server to trust a Confluence server, every Confluence user will see exactly the same list of issues when they view the Confluence jira issues macro as they see when they use the JIRA Issue Navigator as a logged-in JIRA user.

A typical scenario is setting up an application link between two applications which trust each other, have the same set of users and both have the application links plugin installed. In this case, you would configure Trusted Applications for both outgoing authentication and incoming authentication. See Configuring Authentication for an Application Link for other configurations.

On this page:

- Before You Begin
- Configuring Trusted Applications for Outgoing Authentication
- Configuring Trusted Applications for Incoming Authentication
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Before You Begin

- Trusted applications are a potential security risk. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.
• The instructions below assume that **both of the applications that you are linking have the Application Links plugin installed**. If the remote application that you are linking to supports Trusted Applications, but does not have the Application Links plugin installed, you will need to configure Trusted Applications from within the remote application (see the relevant administrator's documentation for the application) in addition to configuring the outgoing/incoming authentication for the application link (as described below).
• You must be a Confluence administrator to configure Trusted Applications authentication for an application link.

### Configuring Trusted Applications for Outgoing Authentication

Configuring **outgoing Trusted Applications authentication** will allow the remote application to trust Confluence (i.e. allow Confluence to access specified functions and data on the remote application).

**To configure Trusted Applications authentication for an outgoing application link:**

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to configure Trusted Applications authentication for.
3. Click the 'Outgoing Authentication' tab. The outgoing authentication page will show, with the 'Trusted Applications' tab displayed.
4. If you are not currently logged into the remote application (or you logged into the remote application under a variant of the application's hostname, e.g. the IP address), a login dialogue will display.
   • Enter the 'Username' and 'Password' for the remote server, (not your local server), and click the 'Login' button. You need to enter the credentials for the remote server, as the remote server needs to be instructed to trust your local server for the Trusted Applications protocol to work. If you are already logged into your remote server, then the appropriate changes can be made without having to log in again.
5. Configure the settings for the Trusted Applications authentication:
   • 'IP Patterns' — Enter the IP addresses (IPv4 only) from which the remote application will accept requests (this effectively is the IP address your local server). You can specify wildcard matches by using an asterisk (*) (note, you cannot use netmasks to specify network ranges). If you are entering multiple IP addresses, separate them with commas or spaces. **Please note, if you are setting up Trusted Applications between two applications that both have the Application Links plugin installed, you can leave this field blank (or explicitly use *.*.*.*). However, if your remote application does not have the Application Links plugin installed and you are configuring the IP Patterns in the remote application (not the Application Links plugin), you must not leave this field blank nor use *.*.*.*. Failure to configure IP address restrictions in this scenario is a security vulnerability, allowing an unknown site to log into your site under a user's login ID.**
   Consider the following scenarios, if you want to limit access by using this field:
   • If your local application is using a proxy server, you need to add the proxy server's IP address to this field.
   • If your local application is a clustered instance of Confluence, you need to configure the remote server to accept requests from each cluster node. If you do not set up each node appropriately, your Confluence users may not be able to view any information from the remote server. You can set this up by either specifying each individual IP address for each node of the cluster (e.g. 172.16.0.10, 172.16.0.11, 172.16.0.12), or specifying the IP address for the clustered Confluence instance using wildcards (e.g. 172.16.0.*).
   • 'URL Patterns' — Enter the URLs in the remote application that your local application will be allowed to access. Each URL corresponds to a particular application function. Enter one URL per line, as follows:
     • If your remote application is JIRA, enter the following URL Patterns: /plugins/servlet/streams, /sr/jira.issueviews:searchrequest, /secure/RunPortlet, /rest, /rpc/soap
If your remote application is Confluence, enter the following URL Patterns: `/plugins/servlet/streams`, `/plugins/servlet/applinks/whoami`

- **'Certificate Timeout (ms)'** — Enter the certificate timeout. The default is 10 seconds. The certificate timeout is used to prevent replay attacks. For example, if a Trusted Applications request is intercepted and (maliciously) re-sent, the application will be able to check when the request was first sent. If the second request is sent more than 10 seconds (or whatever the certificate timeout is set to) after the initial request, it will be rejected. Please note, you should not have to change the default value of this field for most application links. Note that the certificate timeout relies on the clocks on both servers being synchronised.

6. Click the 'Apply' button to save your changes.

Configuring Trusted Applications for Incoming Authentication

Configuring incoming Trusted Applications authentication will allow Confluence to trust the remote application that you are linking it to (i.e. allow your 'trusted' remote application to access specified functions and data on Confluence).

To configure Trusted Applications authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to configure Trusted Applications authentication for.
3. Click the 'Incoming Authentication' tab. The incoming authentication page will show, with the 'Trusted Applications' tab displayed.
4. The tab will show whether Trusted Applications is currently enabled or not. Use the 'Modify' or 'Configure' button to configure Trusted Applications. The Trusted Applications configuration settings will be displayed:

- **'IP Patterns'** — Enter the IP addresses (IPv4 only) from which our application will accept requests. You can specify wildcard matches by using an asterisk (*), e.g. '192.111.*.*' (note, you cannot use netmasks to specify network ranges). If you are entering multiple IP addresses, separate them with commas or spaces. Please note, if you are setting up Trusted Applications between two applications that both have the Application Links plugin installed, you can leave this field blank (or explicitly use *. *.*.*). However, if your remote application does not have the Application Links plugin installed and you are configuring the IP Patterns in the remote application (not the Application Links plugin), you must not leave this field blank nor use *. *.*.*. Failure to configure IP address restrictions in this scenario is a security vulnerability, allowing an unknown site to log into your site under a user's login ID.

Consider the following scenarios, if you want to limit access by using this field:

- If the remote application is using a proxy server, you need to add the proxy server's IP address to this field.
- If the remote application is a clustered instance of Confluence, you need to accept requests from each cluster node. If you do not specify each node's address, Confluence users may not be able to view any data from your application. You can set this up by either specifying each individual IP address for each node of the cluster (e.g. 172.16.0.10, 172.16.0.11, 172.16.0.12), or specifying the IP address for your clustered Confluence instance using wildcards (e.g. 172.16.0.*).

- **'URL Patterns'** — Enter the local URLs that the remote application will be allowed to access. Each URL corresponds to a particular application function. Enter one URL per line, as follows:
  - If your local application is JIRA, enter the following URL Patterns — `/plugins/servlet/streams`, `/sr/jira.issueviews:searchrequest`, `/secure/RunPortlet`, `/rest`, `/rpc/soap`
  - If your local application is Confluence, enter the following URL Patterns — `/plugins/servlet/streams`, `/plugins/servlet/applinks/whoami`
• ‘Certificate Timeout (ms)’ — Enter the certificate timeout. The default is 10 seconds. The certificate timeout is used to prevent replay attacks. For example, if a Trusted Applications request is intercepted and (maliciously) re-sent, the application will be able to check when the request was first sent. If the second request is sent more than 10 seconds (or whatever the certificate timeout is set to) after the initial request, it will be rejected. Please note, you should not have to change the default value of this field for most application links. Note that the certificate timeout relies on the clocks on both servers being synchronised.

5. Click the ‘Apply’ button to save your changes.

Notes

Related Topics

Configuring Basic HTTP Authentication for an Application Link
Configuring OAuth Authentication for an Application Link

Incoming and Outgoing Authentication

When you configure authentication for an application link, you are defining the level of trust between the two linked servers. When configuring a link from one application to another, you can set up:

• **Incoming authentication** (authentication of requests coming from a linked application into this application).
• **Outgoing authentication** (authentication of requests sent from this application to a linked application).

See Configuring Authentication for an Application Link.

⚠️ The information on this page does not apply to Confluence OnDemand.

Editing an Application Link

You can change the details, such as the application name and display URL, for an existing application link.

On this page:

- Editing an Application Link
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Edited an Application Link

To edit an application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to edit the details for. The application details for the application link will be displayed.
3. Update the application details as desired. Please note, you cannot update the Application Type nor the Application URL.

  - ‘Application Name’ — Update this field to change the display name for the application that you are linking to.
  - ‘Display URL’ — This URL is used when displaying links to the application in the browser. When creating the application link, you may have used a URL that is not accessible to other users, such as an internal IP address. If so, you can change the display URL to an address in a domain that is
accessible to other users.

4. Click the 'Update' button to save your changes.

Screenshot above: Editing an application link

**Notes**

**Related Topics**

Configuring Authentication for an Application Link
Making an Application Link the Primary Link
Relocating an Application Link

**Making an Application Link the Primary Link**

If you have set up application links to more than one of the same application type, e.g. you have linked your application to two JIRA servers, then one of the servers will be marked as the 'Primary' link. This means that any outgoing requests will be directed to the primary link's application.

For example, if you have set up a Confluence server that is linked to two JIRA servers with two-way authentication for both links, you can nominate an application link to one of the JIRA servers as the primary link. Every time Confluence requests JIRA information (e.g. for a JIRA issues macro), it will request it from the primary link's JIRA server. Note, both JIRA servers can still make requests of the Confluence server (e.g. a Confluence page gadget on the dashboards of each JIRA instance).

*On this page:*

- [Making an Application Link the Primary Link](#)
- [Notes](#)

⚠️ The information on this page does not apply to Confluence OnDemand.
Making an Application Link the Primary Link

To make an application link the primary link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the 'Make Primary' link next to the application link that you want to make the primary link. A '✔' symbol will display in the 'Primary' column next to the application link.

   The 'Primary' column and 'Make Primary' link will only display if you have set up application links to more than one of the same application type, e.g. you have linked your application to two JIRA servers.

Notes

Please read Making a Project Link the Primary Link for information on how primary project links also influence the information shared between servers.

Related Topics

Making a Project Link the Primary Link

Relocating an Application Link

This page describes how to change the location of an application link. You will need to relocate an application link if the target application has been moved to a new address.

The information on this page does not apply to Confluence OnDemand.

To relocate an application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. If the remote application for an application link cannot be reached by your application, the 'List Application Links' page will display a warning message (see 'Relocate Link - Warning Message' screenshot below).
3. If your remote application has been moved to a different address (rather than just being offline temporarily), click the 'Relocate' link in the warning message (see 'Relocate Link - Updating URL' screenshot below).
4. Enter the new URL for the remote application of your application link and click 'Relocate'.
5. You will need to confirm the relocation, if the new URL cannot be contacted. Otherwise, the application link will be updated.

Screenshot above: Relocate link – The warning message
1. After your application upgrade, navigate to the administration console.
2. Click ‘Application Links’. The ‘Configure Application Links’ screen will be displayed with the following message:
   “There are existing Trusted Applications or OAuth relationships that should be upgraded to Application Links. Click here to upgrade.”
3. Click the ‘Click here to upgrade’ link. The ‘Existing Trust Relationships’ screen will be displayed showing
all Trusted Applications and OAuth relationships that can be upgraded to Application Links.

4. Click the 'Upgrade to Application Link' link next to the desired trust relationship. The 'Upgrade to Application Link' wizard will be displayed.

5. Complete the wizard. The process will be similar to adding a new link (described on Adding an Application Link), except that most fields should be pre-filled.

Screenshots above: Upgrading an application link for local application

**Upgrading an Application Link (Remote App Upgraded to Include Application Links)**

When an application link is created between a version of Confluence that supports Application Links, and a remote legacy application (either a non-Atlassian product, or an older version of an Atlassian product that did not ship with Application Links), this link is configured to run in "legacy mode". While there is no distinguishable difference to a user, connection and configuration without Application Links is a little different. For example:

- Setting up OAuth requires manual configuration by the administrator. In OAuth authentication for between applications that support Application Links, exchange of the consumer keys and public keys is done automatically.
- The Trusted Applications protocol (Atlassian-specific) will not be available for authentication.

If you upgrade your remote application to a version that does include Application Links, the application link will continue to work. However, upgrading your link may simplify link configuration and make additional authentication protocols available (as mentioned above).

**To upgrade an application link when your remote application has been upgraded to include Application Links:**

1. After you have upgraded your remote application to a version that includes Application Links, go to the administration console of your local application. A warning will be displayed, requesting that you upgrade the link to full Application Links mode.

2. Click 'Upgrade' in the warning message to start the upgrade wizard. Note the following:
   - You will be prompted to make your application link a reciprocal link. You will need to provide administrator credentials for your remote application, if you choose to do so.
   - If you make your application link a reciprocal link, you will also be able to make reciprocal links for your project links. For example, you may be able to link your JIRA project to a FishEye repository and also make a link from your FishEye repository back to the JIRA project.
Screenshot above: Upgrading an application link for remote application

**Configure Application Links**

<table>
<thead>
<tr>
<th>Name</th>
<th>Application</th>
<th>Application URL</th>
<th>Configured Authentication</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>REFAPP</td>
<td>Reference Application</td>
<td><a href="http://localhost:5990/refapp">http://localhost:5990/refapp</a></td>
<td>Basic Access</td>
<td>Configure</td>
</tr>
</tbody>
</table>

**Notes**

**Related Topics**

- [Adding an Application Link](#)
- [Configuring Authentication for an Application Link](#)
Deleting an Application Link

Deleting an application link stops the two applications from sharing information. You will no longer be able to make requests from one application to the other. This means that certain features may not work, e.g. JIRA issues macro in Confluence, Confluence Page Gadget in JIRA, etc.

If you have set up application links to multiple servers of the same application type, e.g. you have linked your application to multiple JIRA servers, deleting the primary link will mean that another of the links will be made the primary link.

Deleting an application link will also delete all project links set up for that application link.

To delete an application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Delete' link next to the application link that you want to delete. A confirmation screen will be displayed.
3. Click the 'Confirm' button to delete the application link.

RELATED TOPICS

Editing an Application Link
Relocating an Application Link

Configuring Project Links across Applications

Let's assume that you are managing a project or team. You would like to connect your project's Confluence space with your JIRA project, and link up your team's source repository too.

When you have connected your applications via Application Links, you can also connect the areas of those applications that contain information relating to your project or team. Using project links (also called entity links) you can associate one or more projects, spaces and repositories across the linked applications.

To connect all the information relating to the project or team that you are managing, you can link one or more of the following:

- JIRA projects.
- Confluence spaces.
- FishEye repositories.
- FishEye projects. A FishEye 'project' is the Crucible project if you have installed FishEye and Crucible, otherwise it is the paths associated via the 'FishEye Project Content' function in FishEye.
- Crucible projects.
- Bamboo projects.

On this page:

- Uses for Project Links
- Managing Project Links

The information on this page does not apply to Confluence OnDemand.
The following integration features use project links:

- Activity streams. For example, the project links determine the activity retrieved from JIRA to display in the activity stream of a FishEye repository or a Crucible project.
- The JIRA FishEye plugin. For example:
  - The link between a JIRA project and a FishEye repository determines the repository searched for a particular issue key when displaying the FishEye source tab in JIRA.
  - The link between a JIRA project and a Crucible project determines the Crucible project scanned for review activity when displaying the Crucible reviews tab in JIRA.
  - When you create a defect in Crucible, Crucible will know which JIRA project to put it in.
- Third-party plugins may make use of project links to enrich their functionality too.

**Managing Project Links**

- [Adding Project Links between Applications](#)
- [Making a Project Link the Primary Link](#)
- [Deleting a Project Link](#)

**RELATED TOPICS**

**Adding an Application Link**

**Adding Project Links between Applications**

Let's assume that you are managing a project or team. You would like to connect your project's Confluence space with your JIRA project, and link up your team's source repository too.

When you have connected your applications via Application Links, you can also connect the areas of those applications that contain information relating to your project or team. Using project links (also called entity links) you can associate one or more projects, spaces and repositories across the linked applications.

To connect all the information relating to the project or team that you are managing, you can link one or more of the following:

- JIRA projects.
- Confluence spaces.
- FishEye repositories.
- FishEye projects. A FishEye 'project' is the Crucible project if you have installed FishEye and Crucible, otherwise it is the paths associated via the 'FishEye Project Content' function in FishEye.
- Crucible projects.
- Bamboo projects.

⚠️ The information on this page does not apply to Confluence OnDemand.

To link a Confluence space to a project in another application:

1. Choose **Browse > Space Admin**.
   
   *Note*: 'Space Admin' is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).

2. Click 'Application Links' in the left-hand panel.

3. Choose the Confluence space that you want to link from.

4. The instructions for adding a project link will vary depending on whether the target application has the Application Links functionality installed:
   
   - If the target application has Application Links:
     a. Click 'Add Link'. A dropdown menu will appear listing the applications you have already linked to.
     b. In the dropdown menu, click the application that contains the project you want to link to. For example, if you want to link to a specific JIRA project, click the JIRA site that contains that...
project. If you want to link to a Confluence space, click the Confluence site that contains that space.

c. Click one of the options on the 'Authorization required' screen:
   - 'Authorize' — Click this option if you want to grant your project authorised access to the target project. The target application will open in a new window, so that you can log in and authorise access.
   - 'Skip – your access is anonymous' — Click this option if you only want to allow anonymous access to the target project.

d. In the 'Name or Key' field, enter the name/key of the project in the remote application that you want to link to. For example, if you want to link to a JIRA project, enter the project key. If you want to link to a Confluence space, enter the space key.

e. Click the 'Create' button to create the project link.

If the target application does not have Application Links:

a. Click 'Add Link'. A dropdown menu will display listing the applications you have already linked to.

b. In the dropdown menu, click the application that contains the project you want to link to. For example, if you want to link to a specific JIRA project, click the JIRA site that contains that project. If you want to link to a Confluence space, click the Confluence site that contains that space.

c. In the 'Key' field, enter the name/key of the project in the remote application that you want to link to. For example, if you want to link to a JIRA project, enter the project key. If you want to link to a Confluence space, enter the space key.

d. (optional) Enter the alias for the project in the 'Alias' field. This is the display name for the project in your administration console.

e. Click the 'Create' button to create the project link.

Screenshots above: Linking to a JIRA project (where the target JIRA server supports Application Links)

RELATED TOPICS

Making a Project Link the Primary Link
Deleting a Project Link

Making a Project Link the Primary Link

If you have set up project links to more than one project in the same application, for example you have linked your Confluence space to two JIRA projects, then one of the project links will be marked as the primary link. All outgoing requests will be directed to the primary link.

For example, if you have a Confluence space that is linked to two JIRA projects, you can nominate the link to
one of the JIRA projects as the primary link. Every time Confluence requests JIRA information (for example, in a JIRA issues macro) it will request it from the primary link's JIRA project. Note, both JIRA projects can still request information from the Confluence space (for example, a Confluence page gadget on the dashboards of each JIRA instance).

**To make a project link the primary link:**

1. Choose **Browse > Space Admin.**
   
   *Note:* ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).

2. Click ‘**Application Links**’ in the left-hand panel.

3. Click the ‘**Make Primary**’ link in the ‘**Action**’ column for the project link that you want to make the primary link. A ☑️ symbol will display in the ‘Primary’ column next to the link.

   *Note:* The ‘Primary’ column and ‘Make Primary’ link will appear only if you have set up multiple project links to the same application, for example you have linked a Confluence space to a number of JIRA projects.

```
<table>
<thead>
<tr>
<th>Application</th>
<th>Type</th>
<th>Name</th>
<th>Key</th>
<th>Primary</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA (JIRA)</td>
<td>JIRA</td>
<td>JIRA</td>
<td>JRA</td>
<td>☑️</td>
<td>Delete</td>
</tr>
<tr>
<td>StuA (JIRA)</td>
<td>JIRA</td>
<td>JIRA</td>
<td>JST</td>
<td></td>
<td>Delete</td>
</tr>
</tbody>
</table>
```

_Screenshot above: Viewing the project links for a Confluence space_

**RELATED TOPICS**

*Adding Project Links between Applications*

*Deleting a Project Link*

**Deleting a Project Link**

Deleting a project link stops the two projects from sharing information.

If you have set up multiple project links to the same application, for example you have linked a Confluence space to multiple JIRA projects, deleting the **primary link** will mean that another of the links will be made the primary link.

**To delete a project link:**

1. Choose **Browse > Space Admin.**
   
   *Note:* ‘Space Admin’ is displayed only if you are a space administrator for that space, or you are a super user (a member of the confluence-administrators group).

2. Click ‘**Application Links**’ in the left-hand panel.

3. Click the ‘**Delete**’ link next to the link that you want to delete.

4. A confirmation screen will appear. Click the ‘**Confirm**’ button to delete the link.
Screenshot above: Confirming the deletion of a project link

Related Topics

Adding Project Links between Applications
Making a Project Link the Primary Link

Confluence and JIRA
- Installing Confluence and JIRA Together
- Integrating JIRA and Confluence
- Setting Up Trusted Communication between JIRA and Confluence

RELATED TOPICS
Connecting to Crowd or JIRA for User Management
JIRA Issues Macro

⚠️ The information on this page does not apply to Confluence OnDemand.

Installing Confluence and JIRA Together
This page describes Atlassian’s recommendation for installing JIRA and Confluence on the same server. Refer to Here Be Dragons for instructions on integrating all Atlassian applications.

⚠️ Do not deploy multiple Atlassian applications in a single Tomcat container —
Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat’s lib subdirectory.
Recommended Setup - Separate Stand-Alone Installations

Atlassian recommends running JIRA and Confluence in separate stand-alone instances running behind an Apache Web Server. See the guides for:

- Installing Confluence
- Running Confluence behind Apache
- Installing JIRA
- Integrating JIRA with Apache

Advantages

- Each application can be restarted without affecting the other.
- If one webapp hangs for any reason (eg. running out of memory), it doesn't affect the other.
- Any problems can be debugged more easily. Logs are separate and product-specific, rather than everything going to catalina.out. Thread and heap dumps are smaller and more relevant.
- It reduces the likelihood of jar conflicts (eg. jars that must be installed in common/lib or lib for Confluence running off Apache Tomcat version 6 or above), particularly if you later want to install a third webapp not from Atlassian.
- Apache HTTP Web Server is well suited for running publicly available sites, with extensive modules for security and efficiency. It also allows for flexibility with URLs (ie http://confluence.atlassian.com, http://confluence, and so on).

Integrating JIRA and Confluence

Please refer to the guide to Installing Confluence and JIRA Together.

JIRA and Confluence are designed to complement each other. Collect your team's thoughts, plans and knowledge in Confluence, track your issues in JIRA, and let the two applications work together to help you get your job done.

Below are some ways you can get JIRA and Confluence working together.

On this page:

- Setting Up Trusted Communication between JIRA and Confluence
- Inserting JIRA issues
- Combining Confluence Shortcuts and JIRA Quick Search
- Viewing Confluence Content in JIRA or JIRA Content in Confluence
- Integrating JIRA and Confluence User Management
- Useful Plugins

Setting Up Trusted Communication between JIRA and Confluence

An administrator can configure JIRA (3.12.0 or later) and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.
Trusted communication is used when embedding information from one application (for example, a list of JIRA issues) into another application (for example, a Confluence page).

Read more about trusted communication.

**Inserting JIRA issues**

You can insert issues from a JIRA site onto your Confluence page using the 'Insert JIRA Issue' dialogue box. You can also use this dialogue box to create a new issue on the JIRA site. See Inserting JIRA Issues.

**Combining Confluence Shortcuts and JIRA Quick Search**

In our Confluence site's global configuration (Administration > Shortcut Links) we have the following shortcut defined:

```
JIRA: http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=
```

Use the above option to create links using Confluence's shortcut notation.

- Link directly to JIRA issues like this: CONF-1000
- Use JIRA’s quick-search functionality to create links to particular groups of issues. The following link will display a list of all open issues in the Confluence project of type 'Improvement': CONF open improvements

**Viewing Confluence Content in JIRA or JIRA Content in Confluence**

**Using Gadgets**

You can embed a Confluence activity stream or a Confluence page in JIRA's dashboard. Likewise, JIRA gadgets can be rendered on a Confluence page. See Adding a Confluence Gadget to a JIRA Dashboard and Gadget Macro for information on how to set up gadgets.

**Using the JIRA Issues macro**

For versions earlier than Confluence 3.1 and JIRA 4.0, use the (jiraissues) macros to embed JIRA reports and portlets into your Confluence site.
Any JIRA search result can be embedded in a Confluence page using the JIRA Issues macro with your choice of included fields and field ordering, and any JIRA gadgets can be embedded in a Confluence page by Registering External Gadgets.

**Integrating JIRA and Confluence User Management**

To save you having to enter users into both JIRA and Confluence, you may benefit from using Atlassian Crowd as the user repository for both applications. Alternatively you can configure Confluence to use JIRA's user database. See Connecting to Crowd or JIRA for User Management.

**Useful Plugins**

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- The JIRA Linker plugin provides a custom field that helps you find an URL, particularly a Confluence page, so you can add a page link into a JIRA issue.

**Setting Up Trusted Communication between JIRA and Confluence**

An administrator can configure JIRA and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.

When JIRA is configured to trust Confluence in this way, we call Confluence the ‘trusted application’ and JIRA the ‘trusting application’.

Trusted communication is used when embedding information from one application (e.g. a list of JIRA issues) into another application (e.g. a Confluence page). Currently only JIRA can be configured to trust Confluence, and only the following macro has been enhanced to use trusted communication:

- JIRA Issues macro

Further implementations will follow, especially as we roll out the tight integration required between Atlassian products for JIRA Studio.

---

**Potential security risk**

Do not configure a trusted application unless you trust all code in that application to behave itself at all times. Trusted communication uses public/private key cryptography to establish the identity of the trusted server, so you must also be sure that the trusted application will maintain the security of its private key. Read the details of the security risks below.

---

**On this page:**

- Prerequisites
- Why do we need Trusted Communication?
- Overview
- Configuring JIRA to Trust Confluence Using Trusted Applications
- Configuring the Macro Plugin in Confluence
- Adding the Macro to a Confluence Page
- Viewing the Confluence Page
- Security Risks
- Troubleshooting
- Technical Overview of the Trusted Applications Authentication (TAA) Protocol

---

The information on this page does not apply to Confluence OnDemand.


**Prerequisites**

- JIRA 4.2.0 or later.
- Confluence 3.5.0 or later.
- In order to authenticate successfully against JIRA, the Confluence user must also be registered as a JIRA user with the same username.

⚠️ Common user base recommended

It is **highly recommended** that your JIRA and Confluence instances share a common user base, rather than two separate user bases with duplicated usernames. You will receive an error if Confluence passes JIRA a username which JIRA cannot recognise. Also, with separate user bases you run the risk that the same username may be used by two different people. The trusted application does not supply the user's password, so the trusting application will assume the username belongs to the user registered in the trusting application's own user base.

✅ Tip: Try [Atlassian Crowd](https://www.atlassian.com/software/crowd) for a tidy user management solution.

---

**Why do we need Trusted Communication?**

The [JIRA Issues](https://confluence.atlassian.com/display/CQ43/JIRA+Issues+Macro) macro allows you to embed a list of JIRA issues into a Confluence page. Prior to Confluence JIRA Issues 2.7, if you wanted to display JIRA issues that had restricted viewing, then you needed to store the JIRA user's credentials (username and password) in the macro code directly on the Confluence page. This was not very secure.

The reasons we require the user credentials are:

- Your JIRA instance might not be public, and you might not want to allow anonymous access to your issues.
- You might have security restrictions on some of your issues. So you don't want to allow someone to leak data from your JIRA project by using the JIRA Issues Macro on a Confluence page.

---

**Overview**

Here is a summary of the integration points in a trusted communications relationship. Each of the following points is described in more detail in the sections below.

- A JIRA System Administrator [configures JIRA to trust Confluence](https://confluence.atlassian.com/display/JIRA/JIRA+Trusted+Applications+Configuration).
- A Confluence System Administrator [configures the macro plugin](https://confluence.atlassian.com/display/DOC43/Configuring+Trusted+Applications+Authentication+for+an+Application+Link) to use (or not use) trusted communication.
- A Confluence user [adds one of the macros to a Confluence page](https://confluence.atlassian.com/display/DOC43/Configuring+Trusted+Applications+Authentication+for+an+Application+Link).
- A Confluence user or anonymous user [views the Confluence page](https://confluence.atlassian.com/display/DOC43/Configuring+Trusted+Applications+Authentication+for+an+Application+Link).

---

**Configuring JIRA to Trust Confluence Using Trusted Applications**

Trust only has to be established once between the two applications. Once trust has been established, it is entirely transparent to the Confluence users.

Application links are used to enable trust relationships between two applications. Linking two applications allows you to share information and access one application's functions from within the other.

You can configure an application link to use Trusted Applications as the authentication mechanism. For instructions, see [Configuring Trusted Applications Authentication for an Application Link](https://confluence.atlassian.com/display/DOC43/Configuring+Trusted+Applications+Authentication+for+an+Application+Link).
Configuring the Macro Plugin in Confluence

By default, Confluence ships with trusted communication enabled for the following macro:

- JIRA Issues macro

A Confluence System Administrator can decide on the level of trusted communication used by the macros. The different levels are:

- Ignore trusted communications altogether. Trusted communication is turned off at the global level.
- Perform trusted communications whenever the macro is used on a Confluence page, but do not show certain warning messages.
- Perform trusted communications whenever the macro is used on a Confluence page, and show all warning messages. This is the default configuration.

To change the default trusted communication level for the JIRA Macros plugin,

1. Choose Browse > Confluence Admin.
2. Select ‘Plugins’ in the left-hand panel.
3. The ‘Plugin Manager’ screen appears, showing a list of installed plugins. Scroll down and click the ‘JIRA Macros’ link.
4. The ‘JIRA Macros’ panel appears in the top middle of the screen, as shown below. Click ‘Enable’ or ‘Disable’ next to the following options:
   - ‘JIRA application trust support’ – With this option enabled, Confluence will attempt trusted communication with JIRA whenever a user views a page containing the JIRA Issues macro, provided criteria are met as described below. With this option disabled, Confluence will never attempt trusted communication with JIRA for these macros.
     - Disable the above option if you do not intend to configure trusted communication between JIRA and Confluence.
   - ‘JIRA application trust warnings’ – With this option enabled, Confluence will display all error and warning messages that may arise from a problem during trusted communication (assuming that trusted communication is enabled). With this option disabled, Confluence will suppress certain warnings. See troubleshooting below.
     - Disable the above option if you have a large number of existing JIRA macros already on your Confluence instance, pointing at a diverse range of JIRA servers. Some of those JIRA servers may have a trusted communication link established (requiring the functionality to be enabled) while other JIRA servers may have no trusted communication link. In this case, you may want to turn off the warning messages so they do not appear on your Confluence pages where the JIRA macros point to non-trusting JIRA servers.

Screenshot: JIRA Macros panel in Plugin Manager
Adding the Macro to a Confluence Page

The Confluence user can add and edit the macros as described on the following page:

- Using the JIRA Issues macro

Remove the username and password from your macro markup code

Prior to Confluence 2.7, you needed to include a username and password in the macro markup code if you wanted to display JIRA issues which had restricted viewing. Once your administrator has set up trusted communication between Confluence and JIRA, you no longer need to include a username and password in the markup code for your JIRA macros.

The following options are available for determining the issues which will be retrieved from JIRA and displayed on the Confluence page:

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Macro parameter</th>
<th>URL parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable plugin</td>
<td>jiraportlet</td>
<td></td>
<td>Disable</td>
</tr>
<tr>
<td></td>
<td>jiraissues</td>
<td></td>
<td>Disable</td>
</tr>
<tr>
<td></td>
<td>JIRA application trust support</td>
<td></td>
<td>Disable</td>
</tr>
<tr>
<td></td>
<td>JIRA application trust warnings</td>
<td></td>
<td>Enable</td>
</tr>
</tbody>
</table>

Macros to retrieve information from JIRA.
<table>
<thead>
<tr>
<th>Display the JIRA issues which the logged-in user is authorised to see. And if the user is not logged in, display only issues which allow unrestricted viewing.</th>
<th>Do not specify any authentication parameters. In this case, the behaviour depends on the way your administrator has set up trusted communication between JIRA and Confluence. Here is a summary of the behaviour. If trusted communication is <strong>enabled</strong>, the authorisation will work seamlessly. When a logged-in user views your page, they will see only the JIRA issues they are allowed to see. And if they are not logged in, they will see only the issues which allow unrestricted viewing. If trusted communication is <strong>disabled</strong>, the Confluence page will show only the JIRA issues which allow unrestricted viewing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure that Confluence will display only the JIRA issues which allow unrestricted viewing.</td>
<td><strong>anonymous</strong></td>
</tr>
<tr>
<td>Use a pre-determined username and password to access the JIRA issues.</td>
<td>&amp;os_username=MYUSERNAME&amp;os_password=MYPASSWORD</td>
</tr>
</tbody>
</table>
Refer to the section below for details of what happens when a user views a Confluence page containing a JIRA macro.

**Viewing the Confluence Page**

When a user views a Confluence page which contains a JIRA Issues macro, this is what happens:

- If the macro markup contains an explicit username and password in the URL parameter, Confluence will not request trusted communication with JIRA. Confluence will retrieve the JIRA issues which the specified username is authorised to see. This behaviour is the same as Confluence versions prior to 2.7.
- If the macro markup contains the `anonymous` parameter, Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If the user is anonymous (not logged in), Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If trusted communication is disabled via the Plugin Manager in Confluence, then Confluence will not request trusted communication with JIRA. So if there is no explicit username and password in the markup code, Confluence will retrieve only the JIRA issues which allow unrestricted viewing. This behaviour is the same as Confluence versions prior to 2.7.
- If trusted communication is enabled via the Plugin Manager in Confluence:
  - If the user is logged in, then Confluence attempts trusted communication with JIRA. Confluence sends the username to JIRA. JIRA returns a set of issues which that username is authorised to access, based on the JIRA user base and the JIRA groups and permissions. Confluence displays those issues on the page.
  - If JIRA or Confluence encounters a problem during the trusted communication process, an error message may appear on the Confluence page above the macro output – see troubleshooting below.

**Security Risks**

Please take the following considerations into account when setting up trusted communication:

- When you configure JIRA to trust an application, you are allowing the application to access JIRA in the name of a particular user. The trusted application passes JIRA the user's login name, but no other authentication information. JIRA does not request the user's password. By doing this, you are bypassing JIRA's authentication mechanism.
- Do not configure a trusted application unless you trust all code in that application to behave itself at all times.
- Trusted communication uses public/private key cryptography to establish the identity of the trusted server. The trusted application needs to maintain the security of its private key. Confluence stores its private key in the database. So you must be sure that the Confluence database is secure, and also any full backups of the database.
- Ensure that you specify an IP address for your Confluence site when configuring trusted applications in JIRA. Do not use the wild card `*.*.*.*` as the IP address. Failure to configure IP address restrictions is a security vulnerability, allowing an unknown site to log into your JIRA site under a user's login ID.
- Be aware of the risks associated with using separate user bases, as explained above. We strongly recommend a common user base between the trusted and trusting applications.
- When configuring an application to trust another application, you should use a trusted network or SSL to protect the sensitive information passed between the applications during the configuration procedure. This will help to prevent man-in-the-middle attacks.

**Troubleshooting**

Below are the warning messages which may appear on your Confluence page, above the output of the JIRA
## Issues macro.

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Cause</th>
<th>Solution</th>
<th>Warning Message Can be Turned Off?</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>javax.net.ssl.SSLHandshakeException: sun.security.validator.ValidatorException: PKIX path building failed: sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested target</code></td>
<td>JIRA is running over SSL</td>
<td><a href="#">Add JIRA's SSL Certificate to the Java Keystore</a></td>
<td>No</td>
</tr>
<tr>
<td>The JIRA server does not recognise your user name. Issues have been retrieved anonymously.</td>
<td>The logged-in Confluence user is not registered in the JIRA user base.</td>
<td>Add the username to your JIRA user base. It is highly recommended that your JIRA and Confluence instances share a common user base.</td>
<td>No</td>
</tr>
</tbody>
</table>
| The JIRA server does not trust this Confluence instance for user authentication. Issues have been retrieved anonymously. You can set the macro to always use an anonymous request by setting the 'anonymous' parameter to 'true'. | Your JIRA instance has not been configured to trust your Confluence instance. | One of the following solutions:  
- [Configure JIRA](#) to trust Confluence.  
- [Disable trusted communications](#) for the JIRA macros in Confluence.  
- Use the [anonymous parameter](#) in all your JIRA Issues macros. | Yes                                  |
The JIRA server does not support trust requests. Issues have been retrieved anonymously. You can set the macro to always use an anonymous request by setting the 'anonymous' parameter to 'true'.

Your JIRA instance is not able to handle trusted communications (i.e. the JIRA version is earlier than 3.12.0).

One of the following solutions:
- **Download** the latest version of JIRA and then [configure JIRA](https://confluence.atlassian.com/tdo developersguide-integrations-jira.html) to trust Confluence.
- **Disable trusted communications** for the JIRA macros in Confluence.
- Use the **anonymous parameter** in all your JIRA Issues macros.

<table>
<thead>
<tr>
<th>Failed to login trusted application: confluence:14159892 due to: com.atlassian.security.auth.trustedApps.CertificateTooOldException: OLD_CERT; Certificate too old.</th>
<th>There is a date/time difference between the JIRA server and Confluence server.</th>
<th>Yes</th>
</tr>
</thead>
</table>

Consult [Troubleshooting the JIRA Issues Macro and Trusted Applications](https://confluence.atlassian.com/tdo developersguide-integrations-jira.html) for further troubleshooting.

**Technical Overview of the Trusted Applications Authentication (TAA) Protocol**

- **Read** this section if you want a bit more information on the technical side of things.

Atlassian has developed its own protocol to set up trust between JIRA and Confluence. Below is a technical overview of the process.

**Configuring JIRA to trust Confluence:**

1. When the JIRA System Administrator provides the base URL of the Confluence instance, JIRA requests a trusted application authentication certificate from Confluence. The certificate contains Confluence's trusted application ID and public key (generated specifically for use with the TAA protocol).
2. JIRA validates the certificate and asks the System Administrator for a few extra details about the trust relationship, such as a name for the Confluence instance, timeout, allowed IP addresses and allowed request URLs.
3. JIRA stores all this information in the database.

**Making a trusted request from Confluence to JIRA:**

1. Confluence sends a web request to JIRA, appending additional headers to the request, including:
   - Timestamp (nonce) of the request + user name of the currently logged-in Confluence user, encrypted with a symmetric key (generated on the fly).
   - The symmetric key, encrypted with Confluence's private key.
   - Confluence's application ID (as displayed when trusted communication was established).
2. JIRA attempts to decode the encrypted headers, using the stored information about the relationship. It conducts the following checks to validate the request:
   - The trusted application ID refers to a valid trusted application.
• The given username exists in the JIRA user base.
• The agreed timeout has not expired.
• The request originated from a trusted IP address.
• The resource being requested matches those specified in the URL match list.

3. If any of these checks fails, a response is sent to Confluence indicating the reason for failure. Otherwise, JIRA will authenticate the specified user for the duration of the single request, and respond with the resources (i.e. the JIRA issues).

RELATED TOPICS

JIRA Issues Macro
Connecting to LDAP or JIRA or Other Services via SSL
Single Sign-on Integration with JIRA and Confluence
Troubleshooting the JIRA Issues Macro and Trusted Applications

Confluence Installation and Upgrade Guide

The pages listed below contain information on installing and upgrading Confluence:

• System Requirements
  • Server Hardware Requirements Guide
  • Example Size and Hardware Specifications From Customer Survey
• Confluence Installation Guide
  • Installing Confluence
  • Installing the Confluence EAR-WAR Edition
  • Confluence Cluster Installation
  • Creating a Dedicated User Account on the Operating System to Run Confluence
  • Getting a Confluence License
  • Running Confluence in a Virtualised Environment
• Confluence Setup Guide
  • External Database
  • Load Content for the Site
  • Restoring from Backup During Setup
  • Configuring JIRA Integration in the Setup Wizard
• Upgrading Confluence
  • Upgrading Beyond Current Licensed Period
  • Confluence Post-Upgrade Checks
  • Upgrading Confluence EAR-WAR Distribution
  • Migration from Wiki Markup to XHTML-Based Storage Format
  • Migration of Templates from Wiki Markup to XHTML-Based Storage Format
  • Upgrading Confluence Manually
• Supported Platforms
  • End of Support Announcements for Confluence
  • Supported Platforms FAQ
• Migrating Confluence Between Servers
  • Migrating from Confluence OnDemand to a Confluence Installed Site

System Requirements

Confluence works with a broad range of operating systems, database systems and application servers. Provided you have the technical knowledge, it is very likely that you will be able to run Confluence with an 8-year-old database or even on some 8-year-old hardware. Realistically, it is not technically feasible for us to provide our legendary support service on all environments available. There can only be a finite number of platforms and release versions of those that we support.

Our rule of thumb when releasing a new version of Confluence is that we will officially support platforms that have been released within the last one to two years (or the latest version of that platform if no new version of it was released in that period). This does not necessarily mean that you will need to upgrade your database or
application server every time you upgrade Confluence. However, if you do run into problems with an unsupported version of a database or application server, we may have to ask you to upgrade to something newer.

Please refer to our Supported Platforms topic for details on platforms that we currently support in this version of Confluence and our Supported Platforms FAQ topic for details on our support handling procedures.

On this page:
- Confluence Software Requirements
  - Operating Systems
  - Application Servers
  - Databases
  - Java
  - Please Note: Impact of Antivirus Software
- Confluence Hardware Requirements
- Atlassian Hosted Solutions

Confluence Software Requirements

Please read the Supported Platforms page for Confluence. That page contains a list of specific software that Confluence will work with.

Operating Systems

Atlassian supports the operating systems listed on the Supported Platforms page.

If you would like to run Confluence on VMware, please read our Running Confluence in a Virtualised Environment document first.

Confluence on Virtualised Environments

Atlassian officially supports non-clustered installations of Confluence 3.0 and later on VMware. Although possible, we do not recommend (nor support) running versions of Confluence prior to 3.0 on VMware, since Confluence 3.0 resolved many performance issues that were present in earlier versions. Be aware that we also do not support clustered installations of Confluence on VMware. Please comment or vote on the feature request at CONF-19559.

Application Servers

An application server is required to run Confluence. Apache Tomcat is bundled with the distribution.

Atlassian only supports the application servers listed on the Supported Platforms page, provided they are running on Windows, Linux, or Solaris. If you are using a different application server or earlier version, we may ask you to migrate to one of the supported application servers before we can provide you with further support.

Databases

A database is required to run Confluence. Atlassian supports the databases listed on the Supported Platforms page.

If you have no preference for a particular database and wish to set up Confluence for production purposes, we highly recommend using PostgreSQL. This is a scalable, robust and free database server that is also easy to set
up. For database setup information, please refer to Database Setup For Any External Database.

Confluence should work with the database versions listed below. However, we do not test these versions regularly and we may ask you to migrate to one of the supported databases before we can provide you with further support.

- **PostgreSQL** — 8.2, 8.3, 8.4, 9.0
- **MySQL** — 5.1 (using the InnoDB storage engine, not MyISAM)
- **Oracle** — 11.1, 11.2
- **Microsoft SQL Server** — 2005, 2008, 2008 R2
- **DB2** — 9.7

**Java**

Confluence requires the Java Runtime Environment (JRE) installed.

If using the Zip or archive distribution of Confluence, you will need to install a supported JRE. The automated installer bundles Java and will install this for you. For instructions on installing the JRE for Windows and Linux/Solaris, please refer to Installing Java for Confluence.

**Please Note: Impact of Antivirus Software**

The presence of antivirus software on your operating system running Confluence greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental and may even cause errors in Confluence.

You should configure your antivirus software to ignore the following directories:

- Confluence home directory
- Confluence's index directory
- All database-related directories

⚠️ This recommendation above is particularly important if you are running Confluence on Windows. No matter how fast your hardware is, antivirus software will almost always have a negative impact on Confluence's performance and may render Confluence impossible to use.

**Confluence Hardware Requirements**

Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.

See Server Hardware Requirements Guide for details.

Refer also to the tips on reducing out of memory errors, in particular the section on Permanent Generation Size.

**Atlassian Hosted Solutions**

If you do not have the resources to set up and maintain a Confluence installation locally, consider Atlassian hosted solutions. Atlassian can run and maintain your own installation of Confluence, handling all the testing, monitoring and upgrading processes for you. For more information, please refer to our Confluence Hosted and our integrated JIRA Studio solutions on our website.
Server Hardware Requirements Guide

Server administrators can use this guide in combination with the free Confluence trial period to evaluate their server hardware requirements. Because server load is difficult to predict, live testing is the best way to determine what hardware a Confluence instance will require in production.

Peak visitors are the maximum number of browsers simultaneously making requests to access or update pages in Confluence. Visitors are counted from their first page request until the connection is closed and if public access is enabled, this includes internet visitors as well as logged in users. Storage requirements will vary depending on how many pages and attachments you wish to store inside Confluence.

Minimum Hardware Requirements

The values below refer to the minimum available hardware required to run Confluence only, eg the minimum heap size to allocate to Confluence is 512mb. You will need additional physical hardware, of at least the minimum amount required by your Operating System, and any other applications that run on the server. Also please note that these are a guide only, and your configuration may require more.

On small instances, server load is primarily driven by peak visitors.

5 Concurrent Users
- 2GHz+ CPU
- 512MB RAM
- 5GB database space

25 Concurrent Users
- Quad 2GHz+ CPU
- 2GB+ RAM
- 10GB database space

Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.

Example Hardware Specifications

These are example hardware specifications for non-clustered Confluence instances. It is not recorded whether the RAM refers to either total server memory or memory allocated to the JVM, while blank settings indicate that the information was not provided.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Spaces</th>
<th>Pages</th>
<th>CPUs</th>
<th>CPU (GHz)</th>
<th>RAM (Meg)</th>
<th>Notes</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Server Load & Scalability

When planning server hardware requirements for your Confluence deployment, you will need to estimate the server scalability based on peak visitors, the editor to viewer ratio and total content.

- The editor to viewer ratio is how many visitors are performing updates versus those only viewing content
- Total content is best estimated by a count of total spaces

Confluence scales best with a steady flow of visitors rather than defined peak visitor times, few editors and few spaces. Users should also take into account:

- Total pages is not a major consideration for performance. For example, instances hosting 80K of pages can consume under 512 meg of memory
- Always use an external database, and check out the performance tuning guides.

As mentioned on the documentation for Operating Large or Mission-Critical Confluence Installations, some important steps are loadtesting your usecase and monitoring the system continuously to find out where your system could do better and what might need to improve in order to scale further.

### Maximum Reported Usages

These values are largest customer instances reported to Atlassian or used for performance testing. Clustering for load balancing, database tuning and other performance tuning is recommended for instances exceeding these values.

<table>
<thead>
<tr>
<th>Visits</th>
<th>Updates</th>
<th>Pages</th>
<th>Editors</th>
<th>Ratio</th>
<th>Scalability</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>30</td>
<td>1,000</td>
<td>1</td>
<td>2.6</td>
<td>1,024</td>
</tr>
<tr>
<td>350</td>
<td>100</td>
<td>15,000</td>
<td>2</td>
<td>2.8</td>
<td>700</td>
</tr>
<tr>
<td>5,000</td>
<td>500</td>
<td>4</td>
<td>3</td>
<td>2,024</td>
<td></td>
</tr>
<tr>
<td>10,000</td>
<td>350</td>
<td>16,000</td>
<td>2</td>
<td>3.8</td>
<td>2,024</td>
</tr>
<tr>
<td>10,000</td>
<td>60</td>
<td>3,500</td>
<td>2</td>
<td>3.6</td>
<td>4,048</td>
</tr>
<tr>
<td>21,000</td>
<td>950</td>
<td>2</td>
<td>3.6</td>
<td>4,048</td>
<td></td>
</tr>
<tr>
<td>85,000</td>
<td>100</td>
<td>12,500</td>
<td>4</td>
<td>2.6</td>
<td>4,048</td>
</tr>
</tbody>
</table>

3 machines total: application server, database server, Apache HTTPD + LDAP tunnel server. See Accenture's slides and video for full video details (That link isn't working, but the slides can be found here).
### Hard Disk Requirements

All wiki content is stored in the database, while attachments use either the database or filesystem. For example, the wiki instance you are reading now uses approximately 1 GB of database space and 9.4 GB of disk space.

Here is a breakdown of the disk usage requirements for this wiki, as at December 2008:

<table>
<thead>
<tr>
<th>Data</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database size</td>
<td>1003 MB</td>
</tr>
<tr>
<td>Home directory size</td>
<td>9.4 GB</td>
</tr>
</tbody>
</table>

#### Size of selected database tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Rows</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content bodies (incl. all versions of blogs, pages and comments)</td>
<td>170462</td>
<td>145 MB</td>
</tr>
<tr>
<td>Content metadata (incl. title, author)</td>
<td>188697</td>
<td>48 MB</td>
</tr>
<tr>
<td>Content and user properties</td>
<td>193652</td>
<td>42 MB</td>
</tr>
<tr>
<td>Users</td>
<td>20679</td>
<td>5.8 MB</td>
</tr>
<tr>
<td>Attachment metadata</td>
<td>25718</td>
<td>5.0 MB</td>
</tr>
<tr>
<td>Labels</td>
<td>43235</td>
<td>4.5 MB</td>
</tr>
</tbody>
</table>

Note: not all database tables or indexes are shown, and average row size may vary between instances.

#### Size of selected home directory components

<table>
<thead>
<tr>
<th>Data</th>
<th>Files</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments (incl. all versions)</td>
<td>27484</td>
<td>5.9 GB</td>
</tr>
<tr>
<td>Usage index (now disabled)</td>
<td>240</td>
<td>2.6 GB</td>
</tr>
<tr>
<td>Search index</td>
<td>10</td>
<td>236 MB</td>
</tr>
<tr>
<td>Office Connector cache</td>
<td>44</td>
<td>222 MB</td>
</tr>
</tbody>
</table>
Temporary files | 7269 | 201 MB
Plugin files | 1508 | 139 MB
Thumbnails | 10154 | 84 MB
Did-you-mean search index | 3 | 9.9 MB

Note: not all files are shown, and average file size may vary between instances.

**Private & Online Comparison**

Private instances manage their users either internally or through a user repository such as LDAP, while online instances have public signup enabled and must handle the additional load of anonymous internet visitors. Please keep in mind that these are examples only, not recommendations:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Space s</th>
<th>User Accounts</th>
<th>Editor s</th>
<th>Editor To Viewer Ratio</th>
<th>Pages</th>
<th>Page Revisions</th>
<th>Attachments</th>
<th>Comments</th>
<th>Total Data Size (GB)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Documentation</td>
<td>140</td>
<td>11,500</td>
<td>1,000</td>
<td>9%</td>
<td>8,800</td>
<td>65,000</td>
<td>7,300</td>
<td>11,500</td>
<td>10.4</td>
<td></td>
</tr>
<tr>
<td>Private Intranet</td>
<td>130</td>
<td>180</td>
<td>140</td>
<td>78%</td>
<td>8,000</td>
<td>84,000</td>
<td>3,800</td>
<td>500</td>
<td>4.5</td>
<td></td>
</tr>
<tr>
<td>Company-Wide Collaboration</td>
<td>100</td>
<td>85,000</td>
<td>1,000+</td>
<td>1%+</td>
<td>12,500</td>
<td>120,000</td>
<td>15,000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Professional Assistance**

For large instances, it may be worthwhile contacting an [Atlassian Expert](https://www.atlassian.com/experts) for expertise on hardware sizing, testing and performance tuning. Simply contact a local Expert directly or email our Experts team for a recommendation.

**Related Pages**
No content found for label(s) sizing-guide.

Example Size and Hardware Specifications From Customer Survey

Below are the results of a survey conducted by Atlassian in July 2007, showing some capacity statistics for Confluence users. The figures are broken down by industry and number of users.

<table>
<thead>
<tr>
<th>Num Users</th>
<th>Length of time in production</th>
<th>Database</th>
<th>Application Server</th>
<th>Num CPUs/Cores</th>
<th>Physical Memory/RAM</th>
<th>Operating System</th>
<th>Satisfaction with Confluence Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banking/Finance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26 - 50</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Windows</td>
<td>Neutral</td>
</tr>
<tr>
<td>26 - 50</td>
<td>2 Years Ago</td>
<td>Sybase ASE</td>
<td>Weblogic</td>
<td>&gt;8</td>
<td>&gt;16G</td>
<td>Unix</td>
<td>Satisfied</td>
</tr>
<tr>
<td>51 - 250</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>4G</td>
<td>Unix</td>
<td>Neutral</td>
</tr>
<tr>
<td>501 - 1,000</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Websphere</td>
<td>2</td>
<td>2G</td>
<td>AIX</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>4G</td>
<td>Windows</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>2 Years Ago</td>
<td>Oracle</td>
<td>Websphere</td>
<td>4</td>
<td>&gt;16G</td>
<td>Solaris</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>5,001 - 10,000</td>
<td>10-12 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>4</td>
<td>16G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>Education</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-25</td>
<td>2 Years Ago</td>
<td>DB2</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>Company Type</td>
<td>Timeframe</td>
<td>Database</td>
<td>Type of Confluence Distribution</td>
<td>Tomcat</td>
<td>RAM (GB)</td>
<td>OS</td>
<td>Satisfied Level</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------</td>
<td>----------</td>
<td>---------------------------------</td>
<td>--------</td>
<td>---------</td>
<td>--------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>26 - 50</td>
<td>10-12 Months Ago</td>
<td>MySQL</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Linux</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>51 - 250</td>
<td>&lt;3 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>1</td>
<td>1G</td>
<td>Windows</td>
<td>Unsatisfied</td>
</tr>
<tr>
<td>51 - 250</td>
<td>10-12 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>1</td>
<td>2G</td>
<td>Unix</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Engineering/Aerospace</td>
<td>251 - 500</td>
<td>Oracle</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>1</td>
<td>1G</td>
<td>Mac OS X</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>7-9 Months Ago</td>
<td>MySQL</td>
<td>JBoss</td>
<td>2</td>
<td>4G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>Entertainment</td>
<td>1,001 - 5,000</td>
<td>PostgreSQL</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>2</td>
<td>8G</td>
<td>Linux</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Government</td>
<td>51 - 250</td>
<td>MySQL</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Mac OS X</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Technology</td>
<td>501 - 1,000</td>
<td>MySQL</td>
<td>Confluence distribution / Apache Tomcat</td>
<td>1</td>
<td>2G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
</tbody>
</table>
### Confluence Installation Guide

#### Prerequisites

Before beginning to install Confluence, please check that:

- Your system meets the [minimum system requirements](#) to run Confluence.
- This version of the Confluence documentation matches the version of Confluence that you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the 'breadcrumb trail' in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the [documentation home page](#).

#### Choose the Confluence Installation Type

Choose the type of Confluence installation you'd like from the table below, and follow the link(s) to the installation instructions.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Confluence on Windows</td>
<td>Install Confluence via the Atlassian installer. This is the easiest method of installing Confluence. This is the best option for evaluators.</td>
</tr>
<tr>
<td>Installing Confluence on Linux</td>
<td></td>
</tr>
<tr>
<td>Installing from a Zip File on Windows</td>
<td>This option requires you to manually carry out installing the files and configuring system properties. Use this option if there is no specific installer for your operating system.</td>
</tr>
<tr>
<td>Installing From an Archive File on Linux</td>
<td></td>
</tr>
<tr>
<td>EAR/WAR distribution (Zip Archive)</td>
<td>This distribution allows you to deploy Confluence onto your own existing application server, instead of the Apache Tomcat server bundled with the regular distribution.</td>
</tr>
</tbody>
</table>
Confluence Clusters (Zip Archive)

Install Confluence as a series of clusters, to improve performance or availability. Please read the Confluence Clustering Overview and the Cluster Checklist before you consider installing Confluence in a cluster.

Please read Running Confluence in a Virtualised Environment if you are interested in running Confluence in a virtual machine.
If you wish to upgrade Confluence, see Upgrading Confluence.

Related Topics

Upgrading Confluence
System Requirements

Installing Confluence

Choose the type of Confluence installation you'd like from the table below and follow the link to the installation instructions. When you have finished the installation phase, you will be prompted to start the setup phase.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Installing Confluence on Windows</td>
<td>Install Confluence via the Atlassian installer. This is the easiest method of installing Confluence.</td>
</tr>
<tr>
<td>• Installing Confluence on Linux</td>
<td>This is the best option for evaluators.</td>
</tr>
<tr>
<td>• Installing from a Zip File on Windows</td>
<td>This option requires you to manually carry out installing the files and configuring system properties.</td>
</tr>
<tr>
<td>• Installing From an Archive File on Linux</td>
<td>Use this option if there is no specific installer for your operating system.</td>
</tr>
</tbody>
</table>

If you have not already done so, please verify that this version of the Confluence documentation matches that of the Confluence version you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the 'breadcrumb trail' in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the documentation home page.

Take me back to the Confluence Installation Guide.

Installing Confluence on Windows

This guide describes how to install a new Confluence installation on Windows using the automated 'Windows Installer'. You can also install Confluence from a 'zip' archive — see Installing Confluence on Windows from Zip File for details.
If you are upgrading Confluence, please refer to the Upgrading Confluence guide.

⚠️ Please Note:

• Some anti-virus or other Internet security tools may interfere with the Confluence installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.

• Before you begin installing Confluence, please read the System Requirements page.
On this page:

- **Using the Installation Wizard**
  - 1. Download and Run the Confluence 'Windows Installer'
  - 2. Starting Confluence
  - 3. Run the Setup Wizard
  - 4. Next Steps

- **Performing an Unattended Installation**
  - Download and Run the Confluence 'Windows Installer' in Unattended Mode

---

**Using the Installation Wizard**

Use the installation wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in 'unattended mode' without any user input required (see below for details).

1. **Download and Run the Confluence 'Windows Installer'**

   - To install Confluence as a service, the Windows Installer must be run using a Windows administrator account. While you can run the Windows Installer with a non-administrator account, your installation options will be much more limited.
   
   1. Download the Confluence 'Windows Installer' (.exe) file from the Confluence Download page.
   2. Run the installer file to start the installation wizard.
   3. If a Windows 7 (or Vista) 'User Account Control' dialog box requests if you want to allow the installation wizard to make changes to your computer, click 'Yes'. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
   4. Choose between the 'Express Install' or 'Custom Install' options:
      a. **Express Install** — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the installation wizard. If you want to customise any of these options, click the 'Back' button and choose the 'Custom Install' option instead.
      b. **Custom Install** — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the installation wizard and pre-populated with default values):
         - The 'Destination Directory' in which to install Confluence.
         - The Confluence Home Directory (which must be unique for each Confluence installation).
         - The Windows 'Start' menu folder options.
         - The TCP ports (i.e. an HTTP connector port and a control port) that Confluence will operate on.
         - If you are running the installer using an administrator account, you will be prompted to 'Install Confluence as a service' (recommended). You can also do this manually later, as described in Start Confluence Automatically on Windows as a Service.
   5. If you installed Confluence as a service, you must start Confluence through the Windows 'Start' menu, since Confluence will not start if you run start-confluence.bat at the Windows Command Prompt.

4. The installation wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes. Confluence will also be launched automatically in your browser window if you chose this option.

**Please Note:**

- If you chose to install Confluence as a service, the Confluence service will be run as the Windows
'SYSTEM' user account. To change this user account, see Changing the Windows user that the Confluence service uses.

- If you do not install Confluence as a service, then once started, Confluence will be run as the Windows user account under which Confluence was installed.
- If you use Confluence running on a Windows Server in production, we strongly recommend creating a dedicated user account (e.g. with username 'confluence') for running Confluence.
  - For more information about creating a dedicated user account and defining which directories this account should have write access to, refer to our guidelines.
  - If your Windows Server is operating under Microsoft Active Directory, ask your Active Directory administrator to create a dedicated user account that you can use to run Confluence (with no prior privileges).
  - If Confluence is installed as a service, do not forget to change the user account that runs the Confluence service to your dedicated user account for running Confluence.

2. Starting Confluence

If Confluence is not already started, you can start Confluence using the appropriate Windows 'Start' menu shortcut or command prompt option.

Once Confluence is started, you can access Confluence from the appropriate Windows 'Start' menu shortcut or a browser on any computer with network access to your Confluence server.

2.1 Windows 'Start' Menu Shortcuts

The Installer will have created the following Windows 'Start' menu shortcuts:

- **Access Confluence** — opens a web browser window to access your Confluence application.
  - Your Confluence server must have been started for this shortcut to work.
- **Start Confluence Service** — starts up the Apache Tomcat application server which runs your Confluence installation, so that you can access Confluence through your web browser.
- **Stop Confluence Service** — stops the Apache Tomcat application server which runs your Confluence installation. You will not be able to access Confluence through your web browser after choosing this shortcut.
- **Uninstall Confluence** — uninstalls Confluence from your Windows operating system.

2.2 Starting and Stopping Confluence from a Command Prompt

Enter the bin subdirectory of your Confluence installation directory and run the appropriate file:

- **start-confluence.bat** (to start Confluence)
- **stop-confluence.bat** (to stop Confluence)

If you followed our guidelines for running Confluence with a dedicated user account, then to run Confluence as this user account (e.g. 'confluence'), use the runas command to execute start-confluence.bat. For example:

  ```
  > runas /env /user:<DOMAIN>\confluence start-confluence.bat
  (where <DOMAIN> is your Windows domain or computer name.)
  ```

2.3 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:
1. **http://<computer_name_or_IP_address>:<HTTP_port_number>**

where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

If Confluence does not appear in your web browser, you may need to change the port that Confluence runs on.

3. **Run the Setup Wizard**

See the Confluence Setup Guide.

4. **Next Steps**

- See Confluence 101.
- If you did not install Confluence as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Windows as a Service.
- To get the most out of Confluence, please see Performance Tuning.

**Performing an Unattended Installation**

If you have previously installed Confluence using the installation wizard (above), you can use a configuration file from this Confluence installation (called `response.varfile`) to re-install 'unattended mode' without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same configuration.

⚠️ **Please Note:**

- The `response.varfile` file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
- If you intend to modify the `response.varfile` file, please ensure all directory paths specified are absolute, for example, `sys.installationDir=C:\Program Files\Atlassian\Confluence`. Unattended installations will fail if any relative directory paths have been specified in this file.

**Download and Run the Confluence 'Windows Installer' in Unattended Mode**

1. Download the Confluence 'Windows Installer' (.exe) file from the Confluence Download Center to a suitable location.
2. Open the Windows command prompt and perform the remaining steps in the command prompt.
3. copy the `response.varfile` file located in the `install4j` subdirectory of your previous Confluence installation directory, to the same location as the downloaded 'Windows Installer' file.
   - You can uninstall your previous Confluence installation after this step. Save your `response.varfile` if you need to install Confluence on multiple machines.
4. Change directory (cd) to the location of the 'Windows Installer' file and run the following command:

   ```bat
   atlassian-confluence-X.Y.exe -q -varfile response.varfile
   ```

   Where:
   - `X.Y` — refers to the version of Confluence you are about to install.
- `-q` — instructs the installer to operate in unattended mode (i.e. 'quietly').
- `--varfile response.varfile` — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `--varfile` option.

5. Confluence will start automatically when the silent installation finishes. Continue from step 2 [Starting Confluence](#) (above).

### Installing Confluence on Windows from Zip File

These instructions apply to:
- Confluence distributed as an archive file. This distribution includes Apache Tomcat as the application server.
- Windows systems. For other operating systems please refer to the Confluence Installation Guide.
- Manual installation and configuration using a zipped download file. For a simpler installation process, please use the Confluence Installer instead.

Also, please check that the version of Confluence which you are installing coincides with the version that this documentation is written for.

**On this page:**

1. **Before you Start**

   Please check the following points:

   1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please refer to our Supported Platforms topic and for further details, our System Requirements topic.
   2. Have your Confluence license key ready. You can obtain a trial, free or commercial license now, or retrieve your existing license key.

2. **Install Java**

   Please refer to Installing Java for Confluence. If you are certain that this has already been installed and that the JAVA_HOME environment variable has been correctly configured, then proceed to the next step.

3. **Download the Confluence Installation File**

   1. If you have not downloaded Confluence already, download the zip file.
   2. Please check your unzip program before extracting the downloaded zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one of these before continuing:
      - 7Zip (recommended). If in doubt, download the '32-bit.exe' version.
      - Winzip.
   3. Use your unzipped program to unzip the installation file to a directory such as `c:\confluence`.
      - Do not use spaces in your directory path.

   The directory into which you unzipped the Confluence installation is called the Confluence Installation directory. Next, you will define the Confluence Home directory.

4. **Define your Confluence Home Directory**

   Now you need to define the Confluence Home directory. This is where Confluence will store its configuration information, indexes and attachments.

   **Tip:** Another term for 'home directory' would be 'data directory'.

   We suggest using different paths for your installation and home directories. This will facilitate easier upgrades.
Examples of Installation and Home Directories

**Installation directory:** `c:\confluence\confluence-vX.X`

**Home directory:** `c:\confluence\data`

1. Open your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under the Installation directory, open this file: `confluence\WEB-INF\classes\confluence-init.properties` in a text editor such as Notepad.
3. Scroll to the bottom of the text and find this line:

   ```
   # confluence.home=c:/confluence/data
   ```

4. Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with `confluence.home`.
5. If you decide to change the Confluence Home directory from the default, please note the following:
   - Avoid spaces in the directory path or file name.
   - Use forward slashes `/` to define the path.

   For example:

   ```
   confluence.home=c:/data/confluence-home
   ```

5. **Check the Ports**

If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have an installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port '8090'. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

  ```
  <Server port="8000" shutdown="SHUTDOWN" debug="0">
  <Service name="Tomcat-Standalone">
  <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8090" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
  ...
  ```

  You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine.

  **Hint:** You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.
For example, here are the first four lines of a modified server.xml file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIVisualizationHack="false"/>
  ...
```

To access Confluence in this configuration, point your web browser to http://localhost:8099/.

You will find more information on this page.

6. Select an External Database

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements topic for help in choosing an external database.

External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled with Confluence and should not be used in production.

When you have chosen your external database, follow the database setup guide for setting up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the Database Setup Guide during the Confluence Setup Wizard. (See step 8 below.)

7. Start Confluence

1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: startup.bat. A command prompt window should appear.
   Please do not close this command prompt window. If you do so, Confluence will stop running.

   Troubleshooting

   If the window closes immediately when started, this means that an error is preventing Confluence from starting. To view this error:
   a. Open a command prompt: Click on your 'Start' menu, then click 'Run'. In the Run box, type cmd and click 'OK'.
   b. From the command prompt, go to your Confluence Installation directory.
   c. Go into the bin subdirectory.
   d. Run catalina.bat run.
      You should not run startup.bat at this point, because that would still produce a popup window that would close straight away.
   e. Read the error message.
   f. Find the solution to that error in the Installation FAQ.

3. Once Confluence is running, open a web browser and visit http://localhost:8090/.
   ✔ If you changed the port earlier, use the port you specified in step 5 above.
   🚨 If your web browser window shows an error, try waiting for 30 seconds or so and then refresh the browser page.
8. Next Step is the Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.

If the web browser shows an error instead of the Setup Wizard, check the Installation FAQ.

9. Start Confluence automatically on Windows as a Service

Confluence should be run as a service.

Related Topics

Change listen port for Confluence
Running Confluence Over SSL or HTTPS
Confluence Setup Guide
Configuring Confluence
Confluence Documentation Home

Uninstalling Confluence from Windows

This page describes the procedure for uninstalling an instance of Confluence which has been installed using the Windows Installer.

To uninstall Confluence from Windows:

1. Log in to Windows as the same user that was used to install Confluence with the Windows Installer.
2. Start the uninstaller by doing either of the following:
   - Click the Windows Start Menu > All Programs > Confluence > Uninstall Confluence
   - OR
   - Open the Windows Control Panel, choose Add or Remove Programs (on Windows XP) or Programs and Features (on Windows 7, Vista) and then select Confluence X.Y from the list of applications and click Uninstall/Change.
   - OR
   - Open the Windows command prompt and do the following:
     a. Change directory to your Confluence installation directory
     b. Run the uninstall.exe file
3. Follow the prompts to uninstall Confluence from your computer.

Please note:

- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log older located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the -q option at the Windows command prompt — i.e. uninstall -q
- If you wish to re-install Confluence in 'unattended mode', do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.

Installing Confluence on Linux

This guide describes how to install a new Confluence installation on Linux using the automated 'Linux Installer'. You can also install from a 'zip' archive — see Installing Confluence on Linux from Archive File for details.

If you are upgrading Confluence, please see Upgrading Confluence.

Please Note:

- It is possible that any anti-virus or other Internet security tools installed on your Linux operating system may interfere with the Confluence installation process and prevent the process from completing.
successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.

- Before you begin installing Confluence, please read the System Requirements page.

**Using the Console Wizard**

Use the console wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in 'unattended mode' without any user input required (see below for details).

1. **Download and install the Confluence 'Linux Installer'**

   - If you execute the Linux Installer with 'root' user privileges, the installer will create and run Confluence using a dedicated user account. You can also execute the Linux Installer without 'root' user privileges, although your installation options will be much more limited and a dedicated user account (to run Confluence) will not be created. To run Confluence as a service, the Linux Installer must be executed with 'root' user privileges.

   1. Download the appropriate Confluence 'Linux 64-bit / 32-bit Installer' (.bin) file from the Confluence Download page.

   - **Please Note:**
     - To access the 32-bit installer, you may need to click the 'Show all' link on the 'Confluence Download' page to access the other installation packages.
     - The difference between the 64-bit / 32-bit .bin installers relates to their bundled Java platforms that run Confluence. Bear in mind that a Confluence installation using the 64-bit installer may require additional memory (to run at a similar level of performance) to a Confluence installation using the 32-bit installer. This is because a 64-bit Java platform's object references are twice the size as those for a 32-bit Java platform.

   2. Open a Linux console and change directory (cd) to the '.bin' file's directory.

   - If the '.bin' file is not executable after downloading it, make it executable, for example:
     ```
     chmod a+x atlassian-confluence-X.Y.bin
     ```
     (where X.Y represents your version of Confluence)

   3. Execute the '.bin' file to start the console wizard.

   4. When prompted to choose between 'Express Install', 'Custom Install' or 'Upgrade an existing Confluence installation', choose either the 'Express Install' or 'Custom Install' options:

      - **Express Install** — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the console wizard.

      - **Please Note:**
        - If you are running the installer with 'root' user privileges, Confluence will be installed as a service.
        - If you want to customise any of these options:
          i. Enter 'e' to exit the console wizard.
          ii. Execute the console wizard again (step 3 above).
          iii. Choose the 'Custom Install' option instead.

      - **Custom Install** — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the console wizard and pre-populated with default values):
        - The 'Destination Directory' in which to install Confluence.
        - The Confluence Home directory (which must be unique for each Confluence installation).
        - The TCP ports (i.e. an HTTP and a Control port) that Confluence will run through.
        - If you are running the installer 'root' user privileges, you will be prompted to 'Run Confluence as a service' (recommended). You can also do this manually later, as described in Start Confluence Automatically on Linux.

   5. The console wizard will install Confluence onto your operating system and will start Confluence automatically.
automatically when the wizard finishes.

**Please Note:**

if you executed the Linux Installer with 'root' user privileges, the Linux Installer creates a dedicated Linux user account with username 'confluence', which is used to run Confluence. This account has only:

- Full write access to your Confluence Home Directory.
- Limited write access to your Confluence Installation Directory.

If you executed the Linux Installer without 'root' user privileges, be aware that Confluence can still be run with 'root' privileges. However, to protect the security of your operating system, **this is not recommended**.

2. Start Confluence

If Confluence is not already started, you can start Confluence using the appropriate command at the Linux console.

Once Confluence is started, you can access Confluence from a browser on any computer with network access to your Confluence server.

2.1 Starting and Stopping Confluence manually

In the Linux console, enter the `bin` subdirectory of your Confluence installation directory and execute the appropriate file:

- `start-confluence.sh` (to start Confluence)
- `stop-confluence.sh` (to stop Confluence)

Confluence will be ready to access (from a browser window) when the following message appears in the application's log file:

```
******************************************************
... You can now access Confluence through your web browser.
******************************************************
```

2.2 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:

- `http://<computer_name_or_IP_address>:<HTTP_port_number>`

where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

**Please Note:** If Confluence does not appear, you may need to change the port that Confluence runs on.

Note: Application server logs (i.e. for Apache Tomcat) will be written to `logs/catalina.out`.

3. Run the Setup Wizard
See the Confluence Setup Guide.

4. Next Steps

- See Confluence 101.
- If you did not install Confluence to run as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Linux.
- To get the most out of Confluence, please see Performance Tuning.

Performing an Unattended Installation

If you have previously installed Confluence using the console wizard (above), you can use a configuration file from this Confluence installation (called response.varfile) to re-install Confluence in ‘unattended mode’ without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same configuration.

⚠️ Please Note:

- The response.varfile file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
- If you intend to modify the response.varfile file, please ensure all directory paths specified are absolute, for example, sys.installationDir=/opt/atlassian/confluence
Unattended installations will fail if any relative directory paths have been specified in this file.

Download and Run the Confluence 'Linux Installer' in Unattended Mode

1. Download the Confluence 'Linux Installer' (.bin) file from the Confluence Download Center to a suitable location.
2. Open a Linux console.
3. Copy (cp) the file .install4j/response.varfile located in your previous Confluence installation directory, to the same location as the downloaded 'Linux Installer' file.
   - You can uninstall your previous Confluence installation after this step. Save your response.varfile if you need to install Confluence on multiple machines.
4. Change directory (cd) to the location of the 'Linux Installer' file and execute the following command:
   ```
   atlassian-confluence-X.Y.bin -q -varfile response.varfile
   ```
   Where:
   - X.Y — refers to the version of Confluence you are about to install.
   - -q — instructs the installer to operate in unattended mode (i.e. 'quietly').
   - -varfile response.varfile — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the -varfile option.
5. Confluence will start automatically when the silent installation finishes. Continue from the step above, Start Confluence.

Installing Confluence on Linux from Archive File
These instructions apply to:
- Confluence distributed as an archive file. The distribution includes Apache Tomcat as the application server.
- Linux or Solaris systems. If you are installing Confluence on a different system, please refer to Installing Confluence.

Also, please check the version of Confluence which you are installing. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.

**Hint:** If you are evaluating Confluence on Solaris or you are unsure which version to install, this is the one to use.

On this page:

- 1. Before you Start
- 2. Install Java
- 3. Download and Extract the Confluence Installation File
- 4. Define your Confluence Home Directory
- 5. Check the Ports
- 6. Select an External Database
- 7. Start Confluence
- 8. Confluence Setup Wizard

1. **Before you Start**

Please check the following points:

1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please read the detailed System Requirements.
2. Have your Confluence license key ready. You can obtain a trial, free or commercial license now, or retrieve your existing license key.
3. You must be able to use a command prompt and install Java to continue. If not, please contact your system administrator to assist you or consider the Confluence Hosted evaluation option.
4. Make sure that you use a Gnu version of zip application - Solaris and AIX are known to have problems with zip, because they use their own (old) versions instead of the Gnu version.

2. **Install Java**

Please refer to the Supported Platforms for the required version of Java. (OpenJDK is currently **not** supported. A JIRA issue to request support for this JDK has **been created**.)

1. If you are not sure whether you have Java installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type `echo $JAVA_HOME` in the shell console and then press Enter.
   c. View the result:
      - If a line is displayed such as `/opt/jdk1.6.0_12` or `/usr/lib/jvm/java-6-sun`, then Java is installed and properly configured.
      - If nothing is displayed, then you either need to install Java or set the `$JAVA_HOME` environment variable. You can set this environment variable in your user account's 'profile' file. Alternatively, you can set this after installing Confluence ([in step 4 below](#)) by defining this path in your Confluence installation's `setenv.sh` file, usually located in the Confluence `bin` directory.
      - If you have installed an unsupported JDK and you want to use SSL then you need to install the Sun JSSE package.
2. If you need to install Java, follow these instructions:
3. Download and Extract the Confluence Installation File

1. If you have not downloaded Confluence already, download the TAR.GZ file.

Use your unzip program to unzip the installation file to a directory such as /home/jsmith/confluence-2.7.0-std/.

Most Linux/Solaris users can use any unzip program (such as GNU Tar) to extract the Confluence installer. However, Solaris users should not use the Solaris Tar program due to a known issue associated with its use in extracting Confluence. Use another application such as GNU Tar instead.

For example, change directory to your home directory in Linux and enter the following commands in the shell console:

- `gunzip confluence-<version>-std.tar.gz`
- `tar -xf confluence-<version>-std.tar` (where <version> refers to the Confluence version you downloaded.)

As usual on Linux/Solaris-based operating systems, avoid using spaces in your directory path. The directory into which you unzipped the Confluence installation is called the Confluence Installation directory.

4. Define your Confluence Home Directory

Now you need to define the Confluence Home directory. This is where Confluence will store its configuration information, indexes and attachments.

Tip: Another term for 'Home directory' would be 'data directory'.

We suggest using different paths for your installation and home directories. This will facilitate upgrades.

Examples of Installation and Home Directories:

- **Installation directory:** /usr/local/confluence/
  
  If you wish to install or maintain multiple versions of Confluence, you can add a version number to the Confluence installation directory name like /usr/local/confluence-3.1-std/ and optionally, create the symbolic link /usr/local/confluence/ that points to /usr/local/confluence-3.1-std/

- **Home directory:** /usr/local/confluence-data/

1. Open your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under the Installation directory, find this file: confluence/WEB-INF/classes/confluence-init.properties
3. Open the confluence-init.properties file in a text editor.
4. Scroll to the bottom and find this line:

   ```
   # confluence.home=c:/confluence/data
   ```

5. Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with `confluence.home`
6. If you decide to change the Confluence Home directory from the default, use an absolute path rather than a symbolic link to specify the path and file name. For example:

```
confluence.home=/home/jsmith/confluence-data/
```

5. Check the Ports

If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have a installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port '8090'. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

  ```xml
  <Server port="8000" shutdown="SHUTDOWN" debug="0">
    <Service name="Tomcat-Standalone">
      <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8090" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
  </Service>
  ...
  </Server>
  ``

  You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine.

  <div style="color: green">Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on <a href="http://www.windows.com">Windows</a> or on <a href="http://www.linux.com">Linux</a>.</div>

  For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

  ```xml
  <Server debug="0" shutdown="SHUTDOWN" port="8020">
    <Service name="Tomcat-Standalone">
      <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
  </Service>
  ...
  </Server>
  ```

  To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

  You will find more information on this page.

6. Select an External Database

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements.
External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled with Confluence and should not be used in production.

When you have chosen your external database, follow the database setup guide for setting up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the Database Setup Guide during the Confluence Setup Wizard. (See step 8 below.)

7. Start Confluence

1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: start-confluence.sh.
3. Once Confluence is running, open a web browser and visit http://localhost:8090/
   ✔ Hint: If you changed the port earlier, use the port you specified in step 6 above.

8. Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.

If the web browser shows an error instead of the Setup Wizard, check the Installation FAQ.

Related Topics

- Change listen port for Confluence
- Running Confluence Over SSL or HTTPS
- Confluence Setup Guide
- Configuring Confluence
- Documentation Home

Uninstalling Confluence from Linux

This page describes the procedure for uninstalling Confluence, which had been installed using the Linux Installer.

To uninstall Confluence from Linux:

1. Open a Linux console.
2. Change directory (cd) to your Confluence installation directory.
3. Execute the command uninstall. This command must be executed as the same user account that was used to install Confluence with the Linux Installer.
4. Follow the prompts to uninstall Confluence from your computer.

Please note:

- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log folder located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the --q option — i.e. uninstall -q
- If you wish to re-install Confluence in ‘unattended mode’, do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.
Problem

This page tells you what to do if you get errors like the following when starting Confluence, when you can't access Confluence on port 8090.

If you see this error:

```
java.net.BindException: Address already in use: JVM_Bind:8090
```

This means you are running other software on Confluence's default port of 8090. This may be another other process running on the same port. It may also be a previous instance of Confluence that hasn't been shut down cleanly.

To find out what process is listening on that port, load a command prompt and type: `netstat -an`

- `a`: Displays all active TCP connections and the TCP and UDP ports on which the computer is listening.
- `n`: Displays active TCP connections, however, addresses and port numbers are expressed numerically and no attempt is made to determine names.

There is also Process Explorer tool available to determine what is binding port 8090.

Solution: Change the Ports which Confluence Listens On

To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory.

The first four lines of the file look like this:

```
<Server port="8000" shutdown="SHUTDOWN" debug="0">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8090" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIVisualizationHack="false"/>
    ...
```

You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine.

Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

```
<Server port="8020" shutdown="SHUTDOWN" debug="0">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIVisualizationHack="false"/>
    ...
```
Modified conf/server.xml using ports 8020 and 8099

```xml
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
  </Service>
</Server>
```

To access Confluence in this configuration, point your web browser to http://localhost:8099/

NOTES

[1] For more information on netstat, see using netstat on Windows, or netstat man page (Linux).

[2] The JIRA distribution runs on port 8080 by default. If you're looking to change the port of the JIRA distribution, see Changing JIRA Standalone's port.

RELATED PAGES

Installing Confluence
Documentation Home

Installing the Confluence EAR-WAR Edition

The Confluence EAR-WAR distribution is intended for deployment into an existing J2EE application server.

To use this method of installation, you need to know how to deploy a web application on an existing application server. If not, please use the Confluence distribution instead.

On this page:

- Step 1. Check the System Requirements and Known Issues
- Step 2. Download and Extract EAR-WAR Installation File
- Step 3. Review Application Server Memory Allocation
- Step 4. Configure confluence-init.properties
- Step 5. Edit Tomcat Context Descriptors
- Step 6. Add UTF-8 Encoding
- Step 7. (Optional) Configure Tomcat to Run on a Different Port
- Step 8. (Optional) Configure Confluence to Run as a Windows Service
- Step 8. Run the Confluence Setup Wizard
- Notes

Step 1. Check the System Requirements and Known Issues

1. Please check the Confluence system requirements.
2. In addition to the above requirements, the EAR-WAR distribution requires the Apache Tomcat application server. For more information on Confluence's supported application servers, please refer to our Supporte d Platforms page.
3. If deploying as an unexploded WAR, Ant 1.3 or later is required. This is bundled with the WAR download.
4. Confluence, the database and application server must use the same character encoding. UTF-8 is recommended.
5. Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

We also do not support deploying multiple Atlassian applications to a single Tomcat container for a
number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.

6. Read through the Known Issues for Apache Tomcat.

Step 2. Download and Extract EAR-WAR Installation File

This section gives detailed instructions for installing Confluence EAR-WAR edition on an Apache Tomcat 5.5, or 6 server.

1. Download the Confluence EAR/WAR zip file. (You need to click the 'Show all' link to see the EAR/WAR zip file.)
2. Please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file:
   - Windows users must avoid the Windows built-in unzip utility, as it doesn't extract all the files. Use a third-party unzip program like 7Zip or Winzip.
   - Solaris users will need to use GNU tar to handle the long file names.
3. Extract the downloaded zip file.
4. You have now unzipped your Confluence installation directory, which should contain the version number e.g. confluence-4.0.1 or confluence-4.0.2. This directory will be later referred to as the Confluence installation directory. Inside is a confluence subdirectory, referred to later as the (Exploded) Confluence WAR directory. Record the absolute path to the Confluence WAR directory.

Step 3. Review Application Server Memory Allocation

Confluence requires a maximum heap allocation (Xmx) of at least 256 MB for normal operation. Also, remember to set the maximum PermGen memory allocation (XX:MaxPermSize). See Increasing Application Server Memory.

⚠️ Do not configure a heap allocation so large that it does not allow enough remaining physical memory for your operating system and other applications on the server. The heap allocation should be large enough for Confluence, but not so large that the memory would be paged to disk during normal operation.

Step 4. Configure confluence-init.properties

1. Inside the Confluence installation directory, edit ...confluence/WEB-INF/classes/confluence-init.properties in a text editor.
2. Now define your Confluence Home directory, by setting the confluence.home property to a directory of your choosing. We suggest using different paths for your installation and home directories. This will facilitate upgrades. This is the directory that will contain all of Confluence's configuration, backup and attachment files.
   - Tip: Another term for 'Home directory' would be 'data directory'.

Step 5. Edit Tomcat Context Descriptors

1. Create a file called confluence.xml and save in the conf/Catalina/localhost sub-directory of Tomcat. If these directories don't exist you can create them manually.
2. Open your new confluence.xml file and add these lines:
3. For `docBase`, specify the value you noted down earlier.
4. Restart Tomcat, and Confluence should be accessible under `/confluence/` on your Tomcat server.
5. Follow the link below to proceed with the setup wizard.

**Step 6. Add UTF-8 Encoding**

1. Edit `conf/server.xml` and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8080"/>
   ```

2. Add a `URIEncoding="UTF-8"` property to the connector:

   ```xml
   <Connector port="8080" URIEncoding="UTF-8"/>
   ```

**Step 7. (Optional) Configure Tomcat to Run on a Different Port**

See [Switching to Apache Tomcat](#).

**Step 8. (Optional) Configure Confluence to Run as a Windows Service**

Confluence can be [run as a service](#).

**Step 8. Run the Confluence Setup Wizard**

Once Confluence is running, open a web browser and visit [http://localhost:8080/](http://localhost:8080/) (Tomcat default port).

If you changed the port earlier, use the port you specified. Note that the Confluence installer normally uses port 8090 as the default, to avoid conflicts with JIRA (using port 8080).

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on screen, and read more guidelines on the [Confluence Setup Wizard](#).

**Notes**
Tomcat users, take care not to unzip the Confluence installation into your Tomcat `webapps` folder, as this may cause Confluence to be deployed more than once. It may cause a [Cluster Panic](#) error.

If you deploy Confluence on an unsupported server, server-related issues cannot be covered by Atlassian technical support. You can try [Atlassian Answers](#) for assistance instead.

### Known Issues for Apache Tomcat

**On this page:**

- [Supported Application Servers](#)
- [Tomcat Documentation](#)
- [Known Issues](#)

#### Supported Application Servers

Check the list of supported application servers on the [Supported Platforms](#) topic.

#### Tomcat Documentation

An excellent resource for Tomcat configuration is the [Apache documentation](#).

#### Known Issues

No content found for label(s) tomcat.

### RELATED TOPICS

- [Running Confluence behind Apache](#)
- [Configuring a MySQL Datasource in Apache Tomcat](#)

#### Installing Java for Confluence

This page contains instructions for installing a Java Runtime Environment (JRE). This is a manual step that is only required for Confluence installations where you are installing from a zip or archive file.

If you are using the automated installer, the required Java files are bundled and will be automatically put in place, hence you will not need to follow the instructions on this page.

Please refer to our [Supported Platforms](#) topic for details of the Java versions that are supported for Confluence.

#### Installing the JRE

A JRE (Java Runtime Environment) needs to be installed on the same server machine that will have Confluence installed.

### For Windows: (click to expand)

#### Installing the JRE on Windows

1. If you are not sure whether you have a JRE installed, please confirm by doing the following:
   - Check Control Panel > Programs and Features in Windows 7 (just Programs on older version of Windows).
   - Java should appear as a line item in the list. If not, you do not have Java installed.

2. To install the JRE, follow these instructions:
   - Go to the [Java download page](#).
   - Download the version entitled 'Java SE Update XX (JRE)', where 'XX' stands for some number. (The latest version will be available on that page.)
   - When the download has finished, run the Java installer. At one point, you will be asked to choose a directory to install to. Copy or write this directory down for use later.

3. Check that the `JAVA_HOME` environment variable has been set correctly.
   - Open the Start menu, choose Run, type `cmd` in the Run dialog box and click OK.
In the command prompt window, type `echo %JAVA_HOME%` and then press Enter.

View the result:

- If a directory path is displayed that looks similar to one of the following examples, with the letters 'jre' immediately preceding a series of version numbers, and this path matches the location where you installed the JRE in step 2, then your JRE has been successfully installed and your JAVA_HOME environment variable has been set correctly.

Examples of typical JAVA_HOME environment variable values:

- C:\Program Files\Java\jre6
- C:\Program Files\Java\jre6
- C:\Java\jre6
- C:\jre6

- If nothing is displayed or you do not see 'jre' immediately followed by a series of version numbers (like one of the examples above), then you need to set the JAVA_HOME environment variable. Please follow these instructions to set your JAVA_HOME environment variable to the directory you where you have just installed the Jre. By default, this directory is under C:\Program Files\Java.

For Linux: (click to expand)

**Installing the JRE on Linux**

1. If you are not sure whether you have JRE installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type `echo $JAVA_HOME` in the shell console and then press Enter.
   c. View the result:
      - If a line is displayed such as `/opt/jre6` or `/usr/lib/jvm/java-6`, then your JRE is installed and properly configured.
      - If nothing is displayed, then you either need to install the JRE or set the $JAVA_HOME environment variable. You can set this environment variable in your user account’s ‘profile’ file. Alternatively, you can set this after installing Confluence (in step 4 below) by defining this path in your Confluence installation’s `setenv.sh` file, usually located in the Confluence bin directory.
      - If you have installed an unsupported JRE and you want to use SSL then you need to install the Sun JSSE package.

2. If you need to install the JRE, follow these instructions:
   - Go to the Java download page.
   - Download the version entitled ‘Java SE Update XX (JRE)’, where 'XX' stands for some number. (The latest version is available on that page.)
   - When the download has finished, run the Java installer. Detailed installation instructions are provided on Oracle’s website.

**Setting the JAVA_HOME Variable in Windows**

This information is only relevant if you are installing Confluence on a Windows server.

After you have installed the Java Runtime Environment (JRE) in Windows, you must set the JAVA_HOME environment variable to point to the JRE installation directory.

**Stage 1. Locate the JRE Installation Directory**

If you already know the installation path for the Java Runtime Environment, go to Stage 2 below. Otherwise, find the installation path by following these instructions:

1. If you didn’t change the installation path for the Java Runtime Environment during installation, it will be in a directory under C:\Program Files\Java. Using Explorer, open the directory C:\Program Files\Java.

2. Inside that path will be one or more subdirectories such as C:\Program Files\Java\jre6.
Once you have identified the JRE installation path:

1. Right-click the **My Computer** icon on your desktop and select **Properties**.
2. Click the **Advanced** tab.
3. Click the **Environment Variables** button.
4. Under **System Variables**, click **New**.
5. Enter the variable name as **JAVA_HOME**.
6. Enter the variable value as the installation path for the Java Development Kit.
   - If your Java installation directory has a space in its path name, you should use the shortened path name (e.g. `C:\Progra~1\Java\jre6`) in the environment variable instead.

   **Note for Windows users on 64-bit systems**

   ```
   Progra~1 = 'Program Files'
   Progra~2 = 'Program Files(x86)'
   ```

7. Click **OK**.
8. Click **Apply Changes**.
9. Close any command window which was open before you made these changes, and open a new command window. There is no way to reload environment variables from an active command prompt. If the changes do not take effect even after reopening the command window, restart Windows.
10. If you are running the Confluence EAR/WAR distribution, rather than the regular Confluence distribution, you may need to restart your application server.

### Related Topics

- [Starting Tomcat as a Windows Service](#)
- [Installing Confluence in Linux](#)
- [Confluence Cluster Installation](#)

#### Overview

There are two methods of installing Confluence in a cluster, depending on whether you have existing data. **This page describes a fresh installation with no existing data.**

See also [Confluence Cluster Installation with Existing Data](#).  

---

**Oracle Coherence Licensing Change:**

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
    - If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information about these changes, please refer to the [Coherence License Changes](#) document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a [clustered edition of Confluence](#) and please refer to the [Confluence 3.0.1 Upgrade Notes](#) for additional upgrade information.
Installation with no existing data

To get Confluence running in a two-node cluster, you must do the following:

1. Ensure you meet the clustering requirements, including obtaining a clustered license key from Atlassian for each node.
2. Install Confluence on a single node, configuring an external database and a cluster name.
3. Load test the single node installation, see whether clustering is required.
4. Shut down the first node, copy the Confluence application and Confluence home directory to the second node.
5. Start the first node, wait until it is running, then bring up the second node and it will automatically join the cluster.
6. Test the cluster is working correctly.
7. Configure a load balancer in front of the two clustered nodes.

Each of these steps will be described in detail below.

1. Clustering requirements

Your Confluence cluster installation must meet all the following criteria for clustering:

- You must have a clustered license.
- You must use an external database.
- You must use a load balancer with session affinity in front of the cluster.

Clustered commercial licenses may be purchased through Confluence website. Clustered evaluation licenses may be obtained by emailing sales@atlassian.com.

A cluster can run using two copies of Confluence. However, cluster administrators must understand how to configure an application server and web server with load balancing, so we recommend you are comfortable installing Confluence as a EAR/WAR in your application server before proceeding with a clustered installation.

2. Installation on first node

Cluster administrators should already be comfortable with the normal installation method, so it won't be repeated here. There are two differences in the Confluence Setup Wizard from a normal installation:

- You must use an external database.
- You must enter a cluster name.

![Enter a cluster name to create a new cluster](image)

**Technical note**

The cluster name will be converted into a unique multicast IP address and port for your Confluence cluster. UDP multicast traffic is used for Confluence to automatically discover other nodes in the cluster when they start up.

3. Load test the single node

Most Confluence installations do not need to be clustered. Ensure you have tested your single node installation with the number of users you expect to host before going ahead with the additional complexity of clustering.
Check out our performance tuning tips for ways to improve the performance of a single instance of Confluence.

You can upgrade your single node to a multi-node cluster at any time by resuming this guide from step 4 below.

4. **Copy Confluence to second node**

Confluence clusters must use the same JDK, application server and application. The easiest way to ensure this is to shut down Confluence on the first node, then copy its web application and home directory to the second node:

1. Shut down Confluence on node #1.
2. Shut down your application server on node #2, or stop it automatically loading web applications.
3. Copy the Confluence web application from node #1 to node #2.
4. Copy the Confluence home directory from node #1 to node #2.

Copying the web application ensures any modifications you have made to the application itself, custom LDAP settings (atlassian-user.xml), and any other advanced configuration are copied to node #2.

Copying the home directory ensures the Confluence search index (the index/ directory), the database and cluster configuration (confluence.cfg.xml), and any other home directory settings are copied to node #2.

5. **Start Confluence on the first node, wait, then start Confluence on second node**

For the most stable start-up process, it is important to start Confluence one server at a time.

1. Start Confluence on node #1.
2. Wait for Confluence to become available on node #1.
3. Start Confluence on node #2.
4. Wait for Confluence to become available on node #2.

6. **Test cluster connectivity**

The Cluster Administration page (Administration, Cluster Configuration) includes information about the active cluster. When the cluster is running properly, this page displays:

- a correct count of the nodes in the cluster
- a status display for each node in the cluster
- an uptime for each node that is accurate.

A simple process to ensure your cluster is working correctly is:

1. Create a new document on node #1.
2. Ensure the new document is visible by accessing it directly on node #2.
3. Wait one minute (Confluence does batch indexing once per minute).
4. Search for the new document on node #1, ensure it appears.
5. Search for the new document on node #2, ensure it appears.
7. Configure load balancer

For the moment, configuring the load balancer is outside the scope of this document.

However, a simple [Apache and Tomcat load-balancing configuration](#) is available, which includes sample configuration for the Apache Tomcat and the Apache web server, using its load-balancing JK connector.

**Troubleshooting**

If you have problems with the above procedure, please see our [Cluster Troubleshooting guide](#).

**Upgrading a cluster**

It is important that upgrades follow the procedure for [Upgrading a Confluence Cluster](#).

**Related documentation**

- [Overview of Confluence Clusters](#)
- [Clustering in Confluence](#)
- [Confluence Cluster Installation with Existing Data](#)
- [Confluence Installation Guide](#)
- [Upgrading a Confluence Cluster](#)
- [Cluster Administration page](#)

**Confluence Cluster Installation with Existing Data**

**Overview**

There are two methods of installing Confluence in a cluster, depending on whether you have existing data. This page describes how to upgrade an existing Confluence instance into a cluster.

See also [Cluster installation without existing data](#).

---

**Oracle Coherence Licensing Change:**

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
    - If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information about these changes, please refer to the [Coherence License Changes](#) document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the [Confluence 3.0.1 Upgrade Notes](#) for additional upgrade information.
BEFORE ATTEMPTING THIS, PLEASE MAKE A BACKUP. To upgrade an existing copy of Confluence to run in a two-node cluster, you must do the following:

1. Ensure that your version of the Confluence distribution has been upgraded to the version you want to run the Cluster on. **Do not upgrade your version of Confluence and switch to the clustered version at the same time.** First upgrade your system (e.g. from Confluence 2.5.8 to 2.7.1) and make sure everything works fine (e.g. for a week) before switching (e.g. from Confluence 2.7.1 to 2.7.1 Clustered).
2. Ensure you meet the clustering requirements, including obtaining a clustered license key from Atlassian for each node.
3. Due to **CONF-8959**, you need to perform attachment migration to the database before you change your license to a clustered license.
4. Upgrade the existing Confluence instance to a clustered license. Do this by going to Admin> Licence Details. Confluence should warn you that this version of Confluence is not capable of clustering.
5. Shutdown Confluence. Deploy a clustered version of Confluence (Do not attempt to install any version of Confluence that is not the Clustered equivalent to your current release). Edit confluence-init.properties (confluence-ver-clustered/confluence/WEB-INF/classes/confluence-init.properties) to set confluence.home to the same path as the old home. Start the first node, and verify that things are working correctly.
6. Shut down the first node, copy the Confluence application and Confluence home directory to the second node.
7. Start the first node, wait until it is running, then bring up the second node and it will automatically join the cluster.
8. Test the cluster is working correctly.
9. Configure a load balancer in front of the two clustered nodes.

Each of these steps will be described in detail below.

1. Clustering requirements

Your Confluence cluster installation must meet **all** the following criteria for clustering:

- you must be running Confluence 2.3 or later
- you must have a clustered license
- you must use an external database
- you must use a load balancer with session affinity in front of the cluster.

Clustered commercial licenses may be purchased through [Confluence website](https://confluence.atlassian.com). Clustered evaluation licenses may be obtained by emailing sales@atlassian.com.

A cluster can run using two copies of the Confluence distribution. However, cluster administrators must understand how to configure an application server and web server with load balancing, so we recommend you are comfortable installing Confluence as a EAR/WAR in your application server before proceeding with a clustered installation.

You can follow the instructions to [Migrate Confluence to an external database](https://confluence.atlassian.com).

2. Upgrade existing instance to clustered license

Once you've obtained your clustered license from Atlassian, you can simply update the license in your running Confluence instance:

1. Go to ‘Administration’.
2. Go to 'License Details', and paste in the new license.
3. Click ‘Save’.

When you enter a clustered license, you will see a new line appear on this page: **Licensed Clustered Nodes**. This tells you how many nodes your Confluence license will allow.
License Details page shows the number of cluster nodes permitted

3. Migrate your attachments to the Database

You can do this by navigating to Admin > Attachment Storage > Edit, and changing it to “Database”.

4. Copy Confluence to second node

For the remaining steps in setting up a cluster with existing data, please continue from step 4 in the normal Confluence cluster installation guide.

5. Start Confluence on the first node, wait, then start Confluence on second node

See comment in step 4.

6. Test cluster connectivity

See comment in step 4.

7. Configure load balancer

See comment in step 4.

Troubleshooting

If you have problems with the above procedure, please see our Cluster Troubleshooting guide.

Upgrading a cluster

It is important that upgrades follow the procedure for Upgrading a Confluence Cluster.

Related documentation

Overview of Confluence Clusters
Confluence Cluster Installation
Confluence Installation Guide
Upgrading a Confluence Cluster
Confluence User Guide

Upgrading a Confluence Cluster

This page contains instructions for upgrading an existing Confluence cluster to a new version of Confluence. If you are not running a clustered instance of Confluence and wish to, see Confluence Cluster Installation with Existing Data.
Oracle Coherence Licensing Change:

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache’s caching technology (available to customers with non-clustered Confluence licenses).
    - **Warning**: If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle’s Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information about these changes, please refer to the [Coherence License Changes](#) document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a **clustered edition of Confluence** and please refer to the [Confluence 3.0.1 Upgrade Notes](#) for additional upgrade information.

You can download the latest version of Confluence from [here](#).

**Overview**

The steps involved in upgrading a multi-node Confluence cluster are:

1. Backup your Confluence instance.
2. Read the Release Notes for this version and check you have the required expertise to perform the upgrade.
3. Stop each node in the cluster.
4. Install the new version into the application server on the first node.
5. Install the new version into the application server onto the remaining nodes.

**Step One: Backing up**

We highly recommend that you backup your Confluence home and install directories and your database before proceeding.

For specific files to backup see [Upgrading Confluence](#).

**Step Two: Things you need to check ...**

- Always check the [release-notes](#) for the version of Confluence you are installing for upgrade instructions specific to that version.
- To perform this upgrade you must be familiar with the usage of the application server running your Confluence Cluster, and the web server load balancing it.
- Check the [Configuring Confluence](#) for your application server and database, to make sure there isn't anything extra you need to do to get Confluence running.
- Check that you know what configurations or customisations have been made to your Confluence instance. These may include specialised user management configurations and changes to Confluence’s Java classes and Velocity templates.

**Step Three: Stopping the cluster**

It is vital that all nodes in the cluster are running the same version of Confluence. That's why the first step is to stop all the nodes.

Stop the Confluence application on each node using your application server.

**Step Four: Upgrading the first node**
We advise configuring your load balancing web server to redirect traffic away from Confluence until the upgrade is complete on multiple nodes.

Upgrading a cluster node uses the same process as Upgrading Confluence.

1. Unzip the new version.
2. Edit its confluence-init.properties to point to the existing home directory.
3. Port any immediately required customisations from the old version to the new one. Eg atlassian-user .xml.
4. Install the new version into the application server. Eg for Tomcat edit confluence.xml or server.xml to point to the new location, and restart Tomcat.
5. Wait for the Node to finish upgrading and confirm that you can log in and view pages before continuing to Step Five.
6. Port any additional customisations from the old version to the new version. Eg modifications to Java classes or Velocity templates.

Step Five: Upgrading other nodes

Copy the confluence installation, complete with customisations, to the next node.

1. Edit its confluence-init.properties to point to the existing home directory.
2. Install the new version into the application server. Eg for Tomcat 5 edit confluence.xml to point to the new location, and restart Tomcat.
3. Wait for the Node to finish upgrading and confirm that you can log in and view pages before continuing with the next node.

Troubleshooting

For suggested troubleshooting techniques, see our Cluster Troubleshooting page.

Related documentation

Overview of Confluence Clusters
Confluence Installation Guide
Cluster Troubleshooting
Confluence Cluster Installation
Confluence Cluster Installation with Existing Data
Confluence User Guide

Apache and Tomcat load balancing

Overview

The following is a description of how to set up a Confluence Cluster on a Windows machine using Apache and mod_jk to handle the load-balancing.

The characteristics of this cluster are:

- Session affinity: sessions are associated with single servers.
- Failover: if a server dies, a connection will be directed to the nearest available server. (NOTE: sessions are not replicated)
- Failback: when a server comes back online, it will rejoin the cluster.
- Weighted load balancing: the load balancing can be controlled to take into account machine differences. (See the mod_jk documentation for details on this.)

What do you need?

1. Download and install one copy of Apache httpd. Do not install Apache as a service, but set it to listen on port 8080. (Tested with Apache httpd 2.0.55.)
2. Download the latest version of mod_jk. Copy this file into the Apache modules/ directory and rename it to mod_jk.so. (Tested with JK-1.2.19.)
3. Download and extract one copy of the ZIP distribution of Apache Tomcat. (Tested with Tomcat 5.5.)

Apache configuration

Edit the main Apache config file, conf/http.conf:

- add the following immediately after the other LoadModule directives:

```bash
LoadModule jk_module modules/mod_jk.so
```

- add the following just before the end of the file:

```bash
JkWorkersFile conf/workers.properties
JkLogFile logs/mod_jk.log
JkLogLevel info

JkMount /confluence loadbalancer
JkMount /confluence/* loadbalancer
```

Create a workers.properties file in the Apache conf/ directory. This version of the workers.properties file is configured to use 2 Tomcat instances: tomcat1 and tomcat2.

```bash
worker.list=loadbalancer
tomcat1.port=18081
tomcat1.host=localhost
tomcat1.type=ajp13
tomcat1.lbfactor=1
tomcat2.port=28081
tomcat2.host=localhost
tomcat2.type=ajp13
tomcat2.lbfactor=1

worker.loadbalancer.type=lb
worker.loadbalancer.balance_workers=tomcat1, tomcat2
worker.loadbalancer.method=Busyness
```

Tomcat configuration

The Tomcat configuration below will run multiple instances from the same binaries in the main Tomcat directory. For complete documentation of this configuration, see the RUNNING.txt file in the Tomcat distribution.

Create instance home directories

Create a directory for each instance of Tomcat, somewhere outside where you installed Tomcat. For example, if you extracted Tomcat to /opt/apache/tomcat-5.5, your instances could be in /var/tomcat-instances/tomcat1, /var/tomcat-instances/tomcat2. These folders will be referred to as the instance home directories.
Copy the following folders from the Tomcat installation directory into each instance home directory. Some of the folders may be empty, but copy them anyway.

- conf
- logs
- shared
- webapps

### Configure server.xml in each instance

Edit conf/server.xml in the instance home directories to include the Confluence application and have distinct listen ports for Server, HTTP Connector and AJP13 Connector. All nodes can use the same Confluence webapp as long as you set confluence.home via a system property (see startup scripts below).

Attached are two sample configurations:

- **tomcat1/conf/server.xml** - listens on port 18080 (http) and 18081 (ajp13)
- **tomcat2/conf/server.xml** - listens on port 28080 (http) and 28081 (ajp13)

To use these sample config files, you will need to edit them to set the Confluence web-app location and the data source configuration.

If editing the configuration files yourself, the points to note are:

- 'Server' port must be distinct
- 'Connector' for HTTP must be uncommented and use a distinct port. Use this port for testing the node individually.
- 'Connector' for AJP13 must be uncommented and use a distinct port. This port must match the port of the worker in the Apache workers.properties.
- 'Engine' for localhost must have jvmRoute matching the name of the worker in Apache's workers.properties.
- 'Context' for Confluence must be added inside the 'Host' tag, and include a 'Resource' for the datasource, as per normal Confluence installation under Tomcat.

### Create a startup script for each instance

The startup scripts for each instance must set the CATALINA_BASE environment variable and confluence.home system property. The variables in the sample scripts below should reference:

- CATALINA_HOME - Tomcat installation directory
- CATALINA_BASE - Tomcat instance home directory (distinct for each node)
- JRE_HOME - Java runtime directory
- JAVA_OPTS - include a confluence-home system property (distinct for each node)

**tomcat1/startup.bat:**

```
set CATALINA_HOME=C:\home\mryall\opt\apache\apache-tomcat-5.5.16
set CATALINA_BASE=C:\home\mryall\var\tomcat-instances\tomcat1
set JRE_HOME=C:\Java\jre1.5.0_06
set JAVA_OPTS=-Dconfluence.home=C:\home\mryall\data\confluence\cluster\tomcat1
              -Xmx512m
%CATALINA_HOME%\bin\startup.bat
```

**tomcat2/startup.bat:**
Continue setting up Confluence

Follow the [Confluence Cluster Installation](#) procedure with the steps following the app server setup.

### Troubleshooting

#### General advice

The above tomcat configurations enable HTTP connectors on each Tomcat instance so that you can connect to the nodes individually. To check whether the load balancer (Apache & mod_jk) is causing the problem, try connecting to the individual Tomcat instances. Please note that you should not allow users to directly access individual nodes in production mode: You don’t want people to bookmark nodes since the node details might change, or single nodes may be taken out of the cluster for maintenance while the cluster itself is still available.

**Session-affinity doesn’t seem to be working?**

Ensure the name you use for your worker in workers.properties (e.g. tomcat1) matches the jvmRoute attribute of the engine tag in your Tomcat server.xml. For an example, search for 'Engine' in the [attached sample config](#).

For troubleshooting your Confluence cluster, see [Cluster Troubleshooting](#).

### References

#### General


#### Tomcat Clustering support


#### Creating a Dedicated User Account on the Operating System to Run Confluence

![This step is optional if you are evaluating Confluence, but should be mandatory for Confluence installations used in production. If you have used the Confluence installer on Linux, this user will be created automatically.](#)

A dedicated user should be created to run Confluence, because Confluence runs as the user it is invoked under and therefore can potentially be abused. For example:

- If your operating system is *nix-based (for example, Linux or Solaris), type the following in a console:
  
  ```
  $ sudo /usr/sbin/useradd --create-home --comment "Account for running Confluence" --shell /bin/bash confluence
  ```

- If your operating system is Windows:
  
  1. Create the dedicated user account by either:
     
    - Typing the following at the Windows command line:
      ```
      > net user confluence mypassword /add /comment:"Account for running Confluence"
      ```
(This creates a user account with user name 'confluence' and password 'mypassword'. You should choose your own password.)

- Opening the Windows 'Computer Management' console to add your 'confluence' user with its own password.

2. **(Optional)** Use the Windows 'Computer Management' console to remove the 'confluence' user's membership of all unnecessary Windows groups, such as the default 'Users' group.

   - If Windows is operating under Microsoft Active Directory, ask your Active Directory administrator to create your 'confluence' account (with no prior privileges).

Ensure that only the following directories can be written to by this dedicated user account (e.g. 'confluence'):

- The following subdirectories of your Confluence Installation Directory:
  - logs
  - temp
  - work
- Your Confluence Home Directory.

⚠️ Do not make the Confluence Installation Directory itself writeable by the dedicated user account.

ℹ️ See also Best Practices for Configuring Confluence Security.

### Getting a Confluence License

Need a Confluence license or license key?

- If you do not yet have a license, you can get a **free multi-user evaluation license** or a **10-user starter license** immediately.
- If you already have a Confluence license, you can retrieve your key or generate a new key from the **license viewer**.
- For enterprise, non-profit, open source and educational licenses, see **Confluence licensing and pricing**.
- If you cannot find your key or are having problems, contact **sales@atlassian.com**.

**Related pages:**
- Viewing and Editing License Details
- Reducing the User Count for your Confluence License
- Confluence Administrator's Guide

### Running Confluence in a Virtualised Environment

This page provides some performance data and observations on running Confluence with **VMware**. The information on this page is intended to help you decide whether or not to run Confluence using a VMware product. It does not contain detailed instructions on how to set this up (please refer to the appropriate VMware product documentation instead).

**On this page:**

- **Summary**
- **Recommendations**
  - General
  - VMware ESX 3.5
  - VMware ESX 4i
- **Performance Testing Setup**
  - Server Configuration
  - Installed Software
  - Testing Tool
- **Test Results**
  - Result Descriptions
  - Low-to-Medium-load Confluence
Medium-to-High-load Confluence

Summary

**Confluence on Virtualised Environments**

Atlassian officially supports non-clustered installations of Confluence 3.0 and later on VMware. Although possible, we do not recommend (nor support) running versions of Confluence prior to 3.0 on VMware, since Confluence 3.0 resolved many performance issues that were present in earlier versions. Be aware that we also do not support clustered installations of Confluence on VMware. Please comment or vote on the feature request at CONF-19559.

Confluence is generally slower in a virtualised environment. As can be seen in the test results below, the amount by which Confluence slows down varies based on the workload.

Under low load there are several operations which are in fact faster under VMware. This is probably due to the 4CPU VM instance running on 8 real CPUs as opposed to there being only 4 real CPUs on the baseline machine.

**Please note, no performance tuning was applied to VMware for these tests. It may be possible to improve Confluence's performance by tuning VMware. However, this may cause other applications to run more slowly in the virtual environment. We recommend that you consult the VMware documentation before deciding whether to do this.**

Recommendations

**General**

- If you are a running a medium-to-high-load instance, your biggest performance gain will be to run the application and database on a real machine and not on virtual infrastructure.
- Under medium-to-high-load, moving the database onto another machine will help.
- Always ensure that there are enough virtual CPUs and memory allocated to the virtual instance. This may not be possible under VMware ESX 3.5 due to limitations of 4 vCPUs per VM.
- Always ensure that there is enough CPU time and memory available on the physical host to service all VMs. Applications should not go into swap.
- Use modern CPUs with VT extensions — there is still a noticeable performance penalty for using a VM with these CPUs, but it will likely be much higher when using old CPUs.
- Carefully monitor your VMware hosts to ensure that there is no resource starvation.

**VMware ESX 3.5**

- If possible, upgrade to VMware ESX 4i.
- Under low-to-medium-load, using a non-virtualised database will generally result in better response times.

**VMware ESX 4i**

- Under low-to-medium-load, keep the database inside the virtual machine if there is enough CPU time for both the database and application.
- Using VMware EX 4i and virtual machine version 7, you will be able to allocate up to 8 vCPUs to an instance.

Performance Testing Setup

**Server Configuration**

All testing was performed on the following hardware. In the case of virtual machines, one VM per machine was configured.
<table>
<thead>
<tr>
<th>Platform</th>
<th>CPU</th>
<th>Real Ram</th>
<th>Disk</th>
<th>Virtualisation Software</th>
<th>Virtual machine version</th>
<th>Virtual CPU's</th>
<th>Virtual Ram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell R610</td>
<td>2 x Intel 'Nehalem' Xeon E5520 (Quad Core)</td>
<td>32Gb (8x 4Gb DDR3)</td>
<td>2 x 15K 146Gb SAS, Raid 1 4,5</td>
<td>VMware ESX 3.5</td>
<td>4</td>
<td>4</td>
<td>32Gb</td>
</tr>
<tr>
<td>Dell R610</td>
<td>2 x Intel 'Nehalem' Xeon E5520 (Quad Core)</td>
<td>32Gb (8x 4Gb DDR3)</td>
<td>2 x 15K 146Gb SAS, Raid 1 4,5</td>
<td>VMware ESXi 4</td>
<td>7</td>
<td>4</td>
<td>32Gb</td>
</tr>
<tr>
<td>Dell R610</td>
<td>2 x Intel 'Nehalem' Xeon E5520 (Quad Core)</td>
<td>32Gb (8x 4Gb DDR3)</td>
<td>2 x 15K 146Gb SAS, Raid 1 4,5</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

**Notes:**

1. VT extensions were enabled in the BIOS on the machines running VMWare.
2. VT extensions were disabled in the BIOS on the machines not running VMWare, as per Dell best practices.
3. In order to limit the CPUs in the baseline test to match the number in VMWare, the kernel boot parameter `maxcpus=4` was added to the startup.
4. The full disk was allocated to VMWare.
5. The filesystem used in all machines was EXT3.

**Installed Software**

Each server was set up with identical software, as follows:

<table>
<thead>
<tr>
<th>Atlassian Product</th>
<th>Confluence 3.0.1-rc2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>PostgreSQL 8.2.6</td>
</tr>
<tr>
<td>Application Server</td>
<td>Tomcat 6.0.14</td>
</tr>
<tr>
<td>Java</td>
<td>Java(TM) SE (build 1.6.0_07-b06), Java HotSpot(TM 64-Bit Server VM (build 10.0-b23, mixed mode)</td>
</tr>
</tbody>
</table>
Operating System

Redhat Enterprise Linux 5.3 (Tikanga) 64bit (Kernel 2.6.18-128.2.1.el5). The file system used for all tests was EXT3 with the default options. The following tuning was applied to the operating system, in order to allow for more memory usage by the database server and better network throughput:

```plaintext
net.ipv4.ip_forward = 0
net.ipv4.conf.default.rp_filter = 1
net.ipv4.conf.default.accept_source_route = 0
kernel.sysrq = 0
kernel.core_uses_pid = 1
net.ipv4.tcp_syncookies = 1
kernel.msgmnb = 65536
kernel.msgmax = 65536
kernel.shmmmax = 1310720000
kernel.shmall = 4294967296
net.core.rmem_max = 16777216
net.core.wmem_max = 16777216
net.ipv4.tcp_rmem = 4096 87380 16777216
net.ipv4.tcp_wmem = 4096 65536 16777216
net.ipv4.tcp_no_metrics_save = 1
net.ipv4.tcp_moderate_rcvbuf = 1
net.core.netdev_max_backlog = 2500
```

Testing Tool

Performance tests were conducted with **Apache Jakarta JMeter 2.3.4** using the standard Confluence performance tests.

Test Results

The following tests were performed for each application. In each case, the test was performed with a database local to the host instance (i.e. in the same operating system image) and also with the database residing on a separate, non-virtualised physical server of the same specifications as above.

Result Descriptions

The following descriptions relate to the result graphs below.

- **Average time Comparison** — The average response time of the requests in the scenario - the lower the better.
- **95 percent Comparison** — The time (in milliseconds) by which 95% of all requests in the scenario have completed. This is not an average value — rather, you can think of it as a ‘how long the slowest requests (except the very worst 5% cases) take to complete’ scenario.
- **Scenarios:**
  - **Dashboard** — Simulates visiting the Confluence dashboard.
  - **Edit Page** — Simulates saving a page back to Confluence and notifying all people who are
watching this page.

- **View Page** — Simulates loading one out of hundreds of different Confluence pages. Some are short, others are long. Some have many images, others have many comments. Some have many macros, others do not. The pages are accessed through their full URL, as if someone had clicked link within the application or a bookmark.

- **Search Site** — Simulates a search across the whole system.

- **Browse User Personal Space** — Simulates regular browsing of pages in a user's personal space.

- **Ext-DB** (In the legend of each graph) — Indicates scenarios in which the database resides on a separate non-virtualised physical server.

### Low-to-Medium-load Confluence

This test performs around **18 requests/second** on the Confluence instance. This is not enough to saturate the host CPU time and during the test there is around **50-75% idle time**. You could expect to see similar results if your Confluence instance has enough resources available to it.

![Average time Comparison](image)

![95 percent Comparison](image)

### Medium-to-High-load Confluence

This test tries to perform double the requests/second of the lower load test (i.e. approximately **36 requests/second**) on the Confluence instance. This is enough load to saturate the available CPU time on a 4 CPU machine. This test is designed to simulate an instance which does not have enough resources to serve the number of requests being made to it.
## Confluence Setup Guide

Before running the Confluence Setup Wizard, as described below, you should have already completed **installing Confluence**.

When you access Confluence in your web browser for the first time, you will see the **Confluence Setup Wizard**. This is a series of screens which will prompt you to supply some default values for your Confluence site. It will also offer some more advanced options for setting up data connections and restoring data from a previous installation.

1. **Start the Setup Wizard**
   1. If Confluence is not already running, start it now:
      - If you are running the Confluence distribution on Windows, click Start > Programs > Confluence > Start Confluence Server.
      - Or, run the start-up script found in the bin folder of your installation directory:
        - `start-confluence.bat` for Windows.
        - `start-confluence.sh` for Linux-based systems.
   2. Go to the following web address in your web browser: [http://localhost:8090](http://localhost:8090)
      - The above web address uses port '8090'. If you chose a different port during installation, change '8090' to the number you chose.
      - You should see the licensing screen described **below**.
      - If an error message appears, first check that you are using the port which you specified during installation. Then check the **Installation FAQ**.
On this page:
- 1. Start the Setup Wizard
- 2. Enter your License Key
- 3. Choose your Installation Type
- 4. Production Installation: Database Configuration
- 5. Production Installation: External Database
- 6. Production Installation: Load Content
- 7. Production Installation: Restore Data from Backup
- 9. Production Installation: Connect to JIRA
- 10. Set Up System Administrator
- 11. Setup is Complete

2. Enter your License Key

Confluence Setup Wizard

Confluence needs some information before it is fully installed. If at any stage of the installation you need more information, check out the online setup guide. If you get stuck, you can lodge a support request with us and we will assist you further with your licensing query.

Enter License

Please enter your Confluence license key below - either commercial or evaluation. You can generate an evaluation license online and then return to this page.

Server ID: BYWJ-P433-BABM-EXTA
License Key: 

Choose Installation Type

There are two ways to install Confluence:

Evaluation Installation

Install Confluence with default settings and an embedded database. This is recommended for anyone evaluating or demonstrating Confluence, as it will get you up and running as quickly as possible. This option is not advised for running a production instance of Confluence.

Evaluation Installation

Production Installation

Perform a custom setup. Select this option if you want to configure Confluence with an external database, or initialise the server with your own data. This is strongly recommended for running a production instance, as the use of an external database is essential for data integrity.

Production Installation

Screenshot above: Licensing and installation type

✔ Hint: The above image and all the images on this page are screenshots. Clicking an image will not configure Confluence.

Find your Confluence license key and paste it into the License Key field, shown on the screenshot above.

If you already have a license key, you can retrieve it from the Atlassian website.
If you do not already have a Confluence license, you can obtain one now:

- To get a free evaluation license:
  1. Click **generate an evaluation license online** on the setup wizard, shown on the screenshot above.
  2. Follow the prompts to generate your license key and insert it into the setup wizard's licensing screen automatically.

- To get a commercial, academic, non-profit or open source license:
  1. Copy your **Server ID** from the setup wizard's licensing screen, shown on the screenshot above.
  2. Choose the license type you need from the list on the **Atlassian website**.
  3. Complete the **online order form**.

3. **Choose your Installation Type**

Refer to the screenshot *above*. In this step, you will choose whether you want an evaluation or a production installation.

**Option 1: Evaluation Installation** — Set up Confluence with the embedded **HSQLDB database** and default settings. This option will also install a Demonstration space with some example content to get you working with Confluence as quickly and easily as possible. You may upgrade to another type of database later on.

Who should choose this option?

- Choose the evaluation installation if you are evaluating Confluence or if you are new to Confluence.
- This option is not recommended for production instances of Confluence.

⚠️ **For production use, we strongly recommend that you connect to an external database rather than using the embedded database. The evaluation installation is therefore not suitable for production environments.**

Next, you will be asked for details of your system administrator. Go to **step 10 below**. Yes, you really can skip all the steps between. 😊

**Option 2: Production Installation** — Customise your Confluence instance to use your own database and your own data.

The production installation offers the following options:

- Connect Confluence to an external database. **Recommended for Confluence used in production environments.**
- Restore data from an existing Confluence database.
- Install Confluence without the demonstration content.

4. **Production Installation: Database Configuration**
Screenshot above: Database configuration

The above screen appears if you have chosen a production installation of Confluence. You can choose to use the embedded database supplied with your Confluence installation, or to connect to an external database.

- **Option 1: Embedded Database** — If you select this option, Confluence will use an embedded [HSQLDB database](https://hsqldb.org/). You should only select this option for the purposes of evaluating or demonstrating the use of Confluence. You can migrate to an external database later on if you wish.

- **Option 2: External Database** — If you wish Confluence to use an external database, select your database type from the database dropdown list and then click the 'External Database' button.
  - For production purposes, you **should use an external database** to ensure your data is kept safe and consistent.
  - If you choose PostgreSQL, please make sure that the version you install is supported by Atlassian. It is possible that we do not yet support the latest version of PostgreSQL.
  - Read the page about supported platforms for more information about which databases are supported. For details about choosing an external database, refer to the page on [system requirements](https://confluence.atlassian.com/display/DOC/Choose+a+Database+Configuration).

5. Production Installation: External Database

**Before you Start**

- **Character encoding:**
  - We strongly recommend that character encoding is consistent across your database, application server and web application, and that you use UTF-8 encoding.
  - Before setting up your database, please read about configuring character encoding.
- **Database name:** When creating a new external database, give it the name ‘confluence’.

You can choose to configure your database via a standard JDBC connection or via a server-managed
Datasource connection. Choose one of the two options below.

**Option 1: Standard Database Connection** — This uses a standard JDBC database connection. Connection pooling is handled within Confluence.

### Setup Standard Database

<table>
<thead>
<tr>
<th><strong>Driver Class Name</strong></th>
<th>com.mysql.jdbc.Driver</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database URL</strong></td>
<td>jdbc:mysql://localhost/confluence</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td></td>
</tr>
</tbody>
</table>

*Screenshot above: Standard (JDBC) connection*

Supply the following information:

- **Driver Class Name** — The Java class name for the appropriate database driver. This will depend on the JDBC driver, and will be found in the documentation for your database. You will also need to put the appropriate database driver 'jar' file in the server's classpath. For the Confluence distribution, this means copying the jar file into the `<confluence-install>/lib` directory.
- **Database URL** — The JDBC URL for the database you will be connecting to. This will depend on the JDBC driver, and will be found in the documentation for your database.
- **User Name** — A valid username which Confluence will use to access your database.
- **Password** — The password corresponding to the above username.

You will also need to know:

- The size of the connection pool Confluence should maintain. If in doubt, just go with the default provided.
- What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

**Option 2: Datasource Connection** — This asks the Java application server for a database connection. You will need to have configured a datasource into your application server.

### Setup Datasource Connection

If `java:comp/env/jdbc/DataSourceName` doesn't work, try `jdbc/DataSourceName` (or vice versa)

| **Datasource Name** | java:comp/env/jdbc |

*Screenshot above: Datasource connection*

Supply the following information:

- **Datasource Name** — The JNDI name of the datasource, as configured in the application server. Note: Some servers will have JNDI names like `jdbc/DataSourceName`; others will be of the form `java:comp/env/jdbc/DataSourceName`. Consult your application-server documentation.

You will also need to know:
What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

6. Production Installation: Load Content

**Load Content**

If you are evaluating or demonstrating Confluence, or are introducing Confluence to users who are new to the idea of a Wiki, we recommend the example site as the best way to become acquainted with what Confluence can do for you. More experienced users will want to start with an empty site, or restore a backup of their own.

- **Example Site**
  
  Recommended: Load the 'Demonstration Space' to begin working with Confluence immediately.

- **Empty Site**
  
  Start with an empty site. After finishing the setup you will need to create at least one space before you can add any content of your own.

- **Restore From Backup**
  
  Use data from a previous installation of Confluence. If you are upgrading or replicating Confluence you will probably want to select this option.

**Screenshot above: Load content**

Select one of the following options:

- **Example Site** — This option will load Confluence's 'Demonstration Space'. Select this if you are using Confluence for the first time, or if you want the Demonstration Space for your other Confluence users. The Demonstration Space helps to familiarise you with Confluence and what it can do for you. You can then continue using your Confluence deployment as normal — there's no need to reinstall later.
- **Empty Site** — Select this option if you are already familiar with Confluence. You will need to create at least one space before you can start adding content to the site.
- **Restore from Backup** — Select this option if you want to use Confluence data from a previous installation.

7. Production Installation: Restore Data from Backup

This option allows you to reload your data from an existing Confluence installation into your new Confluence site during the initial setup procedure. You can choose to upload data from a zipped backup file, or to restore from a backup file on your file system.

**Option 1: Upload a zipped backup to Confluence** — This option will load the data from a zipped backup file.

- To create a backup file from your existing version of Confluence, go to the 'Backup & Restore' section of your Administration Console.

- To restore from a zipped backup:
  1. Browse for the relevant daily backup file or a file you have created via a manual backup.
  2. Check 'Build Index' to build the data index, used for the search.
  3. Click the 'Upload and Restore' button.

**Option 2: Restore a backup from the filesystem** — This option is recommended if you have a very large daily backup file (greater than 100MB), or a daily backup file that is already on the server and doesn't require
1. Copy the XML backup file into the `restore` directory inside your Confluence Home directory and then refresh the page. You should now see your backup file appear on the 'Restore Data' screen (pictured above), in the box beneath the heading 'Restore a backup from the filesystem'.

2. Check 'Build Index' to build the data index, used for the search.

3. Click the 'Restore' button.

When the restore process has finished, you are ready to log in to Confluence. The system administrator account and all other information has been transferred from your previous Confluence installation.

8. Production Installation: Set Up User Management

You can choose to manage Confluence's users and groups inside Confluence or in JIRA.

- If you do not have Atlassian JIRA installed, or if you would prefer to set up external user management later, choose Manage users and groups within Confluence.
- If you have JIRA installed, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options. It will configure a JIRA user directory for Confluence, and set up application links between JIRA and Confluence for easy sharing of data. Choose Connect to JIRA.

9. Production Installation: Connect to JIRA
Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:
  
  http://www.example.com:8080/jira/
  http://jira.example.com

- **JIRA Administrator Login: Username** – Enter the username of a user with the ‘JIRA System Administrators’ global permission in JIRA.
- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.
- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.
- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is jira-users. (These groups will receive the ‘can use’ permission in Confluence.)
- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is jira-administrators. (These groups will receive the ‘Confluence system administrator’ and ‘Confluence administrator’ permissions in Confluence.)

For full details and a troubleshooting guide, see [Configuring JIRA Integration in the Setup Wizard](#).

**10. Set Up System Administrator**
The system administrator has full administrative power over your Confluence instance. This person will be able to add more users, create spaces, and set further Confluence options. Please refer to the overview of global permissions for more information.

**Hint:** If you are evaluating Confluence, set yourself up as the administrator.

1. Enter the following information to set up your system administrator's user account:
   - **Username** — The username under which the system administrator will log in to Confluence, e.g. 'jsmith'.
   - **Password** — The password which the system administrator will use to log in.
   - **Confirm** — Enter the same password again.
   - **Name** — The system administrator's full name, e.g. 'John Smith'.
   - **Email** — The system administrator's email address, e.g. 'jsmith@example.com'.

2. Click 'Next'.

### 11. Setup is Complete

**Confluence Setup Successful**

Confluence has now been installed with the Demonstration Space!

Start using Confluence now.

Learn how to import data from another wiki.

**Screenshot above: Setup is complete**

Congratulations! You have installed and set up Confluence. Click the Start using Confluence now link to open the Demonstration space in your Confluence wiki. This space contains some sample content and ideas, to help you get started quickly.

If you wish, you can click the link to learn how to import data from another wiki. This link leads to an overview page on your own Confluence server, containing information about the Universal Wiki Converter, an application that you can use to import data from other wiki types such as MediaWiki, DokuWiki and others.

**RELATED TOPICS**

Confluence 101
External Database

Custom Installation - Connecting to an External Database

This page is part of the Confluence Setup Guide.

**Before you Start**
- **Character encoding:**
  - We strongly recommend that character encoding is consistent across your database, application server and web application, and that you use UTF-8 encoding.
  - Before setting up your database, please read about configuring character encoding.
  - **Database name:** When creating a new external database, give it the name 'confluence'.

You can choose to configure your database via a standard JDBC connection or via a server-managed datasource connection. Choose one of the two options below.

**Option 1: Standard Database Connection** — This uses a standard JDBC database connection. Connection pooling is handled within Confluence.

[Screenshot above: Standard (JDBC) connection]

Supply the following information:

- **Driver Class Name** — The Java class name for the appropriate database driver. This will depend on the JDBC driver, and will be found in the documentation for your database. You will also need to put the appropriate database driver 'jar' file in the server's classpath. For the Confluence distribution, this means copying the jar file into the `<confluence-install>/lib` directory.

- **Database URL** — The JDBC URL for the database you will be connecting to. This will depend on the JDBC driver, and will be found in the documentation for your database.

- **User Name** — A valid username which Confluence will use to access your database.

- **Password** — The password corresponding to the above username.

You will also need to know:

- The size of the connection pool Confluence should maintain. If in doubt, just go with the default provided.
- What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

**Option 2: Datasource Connection** — This asks the Java application server for a database connection. You will need to have configured a datasource into your application server.
Setup Datasource Connection

If "java:comp/env/jdbc/DatasourceName" doesn't work, try "jdbc/DatasourceName" (or vice versa)

Datasource Name: java:comp/env/jdbc/

Next >>

Screenshot above: Datasource connection

Supply the following information:

- **Datasource Name** — The JNDI name of the datasource, as configured in the application server. Note: Some servers will have JNDI names like jdbc/datasourcename; others will be of the form java:comp/env/jdbc/datasourcename. Consult your application-server documentation.

You will also need to know:

- What kind of database you’re connecting to, so you can tell Confluence which dialect it needs to use.

Next Step

Load content for the site

RELATED TOPICS

Database Configuration
Confluence Setup Guide
Confluence User's Guide
Confluence Documentation Home

Load Content for the Site

This page is part of the Confluence Setup Guide.

- **Example Site**
  Recommended: Load the 'Demonstration Space' to begin working with Confluence immediately.

- **Empty Site**
  Start with an empty site. After finishing the setup you will need to create at least one space before you can add any content of your own.

- **Restore From Backup**
  Use data from a previous installation of Confluence. If you are upgrading or replicating Confluence you will probably want to select this option.
Screenshot above: Load content

Select one of the following options:

- **Example Site** — This option will load Confluence's 'Demonstration Space'. Select this if you are using Confluence for the first time, or if you want the Demonstration Space for your other Confluence users. The Demonstration Space helps to familiarise you with Confluence and what it can do for you. You can then continue using your Confluence deployment as normal — there's no need to reinstall later.
- **Empty Site** — Select this option if you are already familiar with Confluence. You will need to create at least one space before you can start adding content to the site.
- **Restore from Backup** — Select this option if you want to use Confluence data from a previous installation.

**Next Steps**

- Restore your data from backup, if you have chosen that option.
- Start using Confluence — see the Confluence User's Guide.

**RELATED TOPICS**

Confluence Setup Guide
Universal Wiki Converter
Confluence User's Guide
Confluence Documentation Home

**Restoring from Backup During Setup**

This page is part of the Confluence Setup Guide.

This option allows you to reload your data from an existing Confluence installation into your new Confluence site during the initial setup procedure. You can choose to upload data from a zipped backup file, or to restore from a backup file on your file system.

**Option 1: Upload a zipped backup to Confluence** — This option will load the data from a zipped backup file.

To create a backup file from your existing version of Confluence, go to the 'Backup & Restore' section of your Administration Console.

To restore from a zipped backup:

1. Browse for the relevant daily backup file or a file you have created via a manual backup.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Upload and Restore' button.

**Option 2: Restore a backup from the filesystem** — This option is recommended if you have a very large daily backup file (greater than 100MB), or a daily backup file that is already on the server and doesn't require uploading.

1. Copy the XML backup file into the `restore` directory inside your confluence Home directory and then refresh the page. You should now see your backup file appear on the 'Restore Data' screen (pictured above), in the box beneath the heading 'Restore a backup from the filesystem'.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Restore' button.

When the restore process has finished, you are ready to log in to Confluence. The system administrator account and all other information has been transferred from your previous Confluence installation.
Configuring JIRA Integration in the Setup Wizard

This page describes the Connect to JIRA step in the Confluence setup wizard.

Overview

You can connect your application to a JIRA server, to manage your users via JIRA and share information with JIRA. When you are installing the application, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options.

You can also configure the JIRA connections via the application administration screens. In that case, you will need to set up connections individually. There are two parts to the integration process:

- A peer-to-peer link between JIRA and the application for sharing information and facilitating integration features. This link is set up via Application Links.
- A client-server link between the application and JIRA for delegating user and group management to your JIRA server.

Requirements: You need JIRA 4.3 or later.

Connecting to JIRA in the Setup Wizard
Confluence 4.3 Documentation

Screenshot above: Connecting to JIRA in the Confluence setup wizard

Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:
  
  http://www.example.com:8080/jira/
  http://jira.example.com

- **JIRA Administrator Login: Username** – Enter the username of a user with the ‘JIRA System Administrators’ global permission in JIRA.
- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.
- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.
- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is jira-users. (These groups will receive the ‘can use’ permission in Confluence.)
- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is jira-administrators. (These groups will receive the ‘Confluence system administrator’ and ‘Confluence administrator’ permissions in Confluence.)

**Troubleshooting**

This section describes the possible problems that may occur when integrating your application with JIRA via the setup wizard, and the solutions for each problem.
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The setup wizard displays one of the following error messages:</td>
<td>The setup wizard failed to complete registration of the peer-to-peer application link with JIRA. JIRA integration is only partially configured.</td>
<td>Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
</tbody>
</table>
| - Failed to create application link from JIRA server at <URL> to this <application> server at <URL>.  
- Failed to create application link from this <application> server at <URL> to JIRA server at <URL>.  
- Failed to authenticate application link from JIRA server at <URL> to this <application> server at <URL>.  
- Failed to authenticate application link from <application> server at <URL> to this JIRA server at <URL>. |                                                                                                                                                                                                     |                                                                                                                                                                                                         |
| The setup wizard displays one of the following error messages:          | The setup wizard failed to complete registration of the client-server link with JIRA for user management. The peer-to-peer link was successfully created, but integration is only partially configured.        | Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.                                                     |
| - Failed to register <application> configuration in JIRA for shared user management. Received invalid response from JIRA:  
- Failed to register <application> configuration in JIRA for shared user management. Received:  |                                                                                                                                                                                                     |                                                                                                                                                                                                         |
| The setup wizard displays the following error message:                  | The setup wizard successfully established the peer-to-peer link with JIRA, but could not persist the client-server link for user management in your config.xml file. This may be caused by a problem in your environment, such as a full disk. | Please investigate and fix the problem that prevented the application from saving the configuration file to disk. Then remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below. |
| - Error setting Crowd authentication                                    |                                                                                                                                                                                                     |                                                                                                                                                                                                         |
| The setup wizard displays the following error message:                  | The setup wizard has completed the integration of your application with JIRA, but is unable to start synchronizing the JIRA users with your application.                                             | Restart your application. You should then be able to continue with the setup wizard. If this solution does not work, please contact Atlassian Support.                                                      |
| - Error reloading Crowd authentication                                  |                                                                                                                                                                                                     |                                                                                                                                                                                                         |
The setup wizard displays the following error message:

- An error occurred: java.lang.IllegalStateException: Could not create the application in JIRA/Crowd (code: 500). Please refer to the logs for details.

The setup wizard has not completed the integration of your application with JIRA. The links are only partially configured. The problem occurred because there is already a user management configuration in JIRA for this <application> URL.

Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below.

No users can log in after you have set up the application with JIRA integration.

Possible causes:
- There are no users in the group that you specified on the ‘Connect to JIRA’ screen.
- For FishEye: There are no groups specified in the ‘groups to synchronize’ section of your administration console.
- For Stash: You may not have granted any JIRA groups or users permissions to log in to Stash.

Go to JIRA and add some usernames to the group.
- For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is ‘jira-users’.
- For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.

If this solution does not work, please contact Atlassian Support.

Solution 1: Removing a Partial Configuration – The Easiest Way

If the application’s setup wizard fails part-way through setting up the JIRA integration, you may need to remove the partial configuration from JIRA before continuing with your application setup. Please follow the steps below.

Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup wizard:

1. Log in to JIRA as a user with the ‘JIRA System Administrators’ global permission.
2. Click the ‘Administration’ link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
   a. Click ‘Application Links’ in the JIRA administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the ‘Application URL’ matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the ‘Application URL’ matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the ‘Application URL’ matches the base URL of your Stash server.
   c. Click the ‘Delete’ link next to the application link that you want to delete.
   d. A confirmation screen will appear. Click the ‘Confirm’ button to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click ‘Other Applications’ in the ‘Users, Groups & Roles’ section of the JIRA administration screen.
      - In JIRA 4.4: Select ‘Administration’ > ‘Users’ > ‘JIRA User Server’.
   b. Look for a link to your application. It will have a name matching this format:
<Type> - <HostName> - <Application ID>

For example:

FishEye / Crucible - localhost -
92004b08-5657-3048-b5dc-f886e662ba15

Or:

Confluence - localhost - 92004b08-5657-3048-b5dc-f886e662ba15

If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:

  `<baseUrl>/rest/applinks/1.0/manifest`

  Replace `<baseUrl>` with the base URL of your application.

  For example:

  http://localhost:8060/rest/applinks/1.0/manifest

- The application links manifest will appear. Check the application ID in the `<id>` element.

  c. In JIRA, click ‘Delete’ next to the application that you want to remove.

  5. Go back to the setup wizard and try the ‘Connect to JIRA’ step again.

**Solution 2: Removing a Partial Configuration – The Longer Way**

If solution 1 above does not work, you may need to remove the partial configuration and then add the full integration manually. Please follow these steps:

1. Skip the ‘Connect to JIRA’ step and continue with the setup wizard, to complete the initial configuration of the application.
2. Log in to JIRA as a user with the ‘JIRA System Administrators’ global permission.
3. Click the ‘Administration’ link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
   a. Click ‘Application Links’ in the JIRA administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the ‘Application URL’ matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the ‘Application URL’ matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the ‘Application URL’ matches the base URL of your Stash server.
   c. Click the ‘Delete’ link next to the application link that you want to delete.
d. A confirmation screen will appear. Click the 'Confirm' button to delete the application link.

5. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      • In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      • In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. Look for a link to your application. It will have a name matching this format:

   ```
   <Type> - <HostName> - <Application ID>
   ```

   For example:

   ```
   FishEye / Crucible - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   Or:

   ```
   Confluence - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:
      • Go to the following URL in your browser:

   ```
   <baseUrl>/rest/applinks/1.0/manifest
   ```

   Replace `<baseUrl>` with the base URL of your application.
   For example:

   ```
   http://localhost:8060/rest/applinks/1.0/manifest
   ```

   • The application links manifest will appear. Check the application ID in the `<id>` element.
   c. In JIRA, click 'Delete' next to the application that you want to remove.

6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and your application:
   a. Click 'Add Application Link'. Step 1 of the link wizard will appear.
   b. Enter the server URL of the application that you want to link to (the 'remote application').
   c. Click the 'Next' button.
   d. Enter the following information:
      • 'Create a link back to this server' – Tick this check box to add a two-way link between the two applications.
      • 'Username' and 'Password' – Enter the credentials for a username that has administrator access to the remote application.
      Note: These credentials are only used to authenticate you to the remote application, so that Application Links can make the changes required for the new link. The credentials are not saved.
      • 'Reciprocal Link URL' – The URL you give here will override the base URL specified in your remote application's administration console, for the purposes of the application links
connection. Application Links will use this URL to access the remote application.

e. Click the 'Next' button.

f. Enter the information required to configure authentication for your application link:
   - 'The servers have the same set of users' – Tick this check box, because the users are the same in both applications.
   - 'These servers fully trust each other' – Tick this check box, because you trust the code in both applications and are sure both applications will maintain the security of their private keys.

   For more information about configuring authentication, see Configuring Authentication for an Application Link.

g. Click the 'Create' button to create the application link.

7. Configure a new connection for user management in JIRA:

   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.

   b. Add an application.

   c. Enter the application name and password that your application will use when accessing JIRA.

   d. Enter the IP address or addresses of your application. Valid values are:
      - A full IP address, e.g. 192.168.10.12.
      - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.

   e. Save the new application.

8. Set up the JIRA user directory in the application.
   - For Confluence:
     a. Go to the Confluence Administration Console.
     b. Click 'User Directories' in the left-hand panel.
     c. Add a directory and select type 'Atlassian JIRA'.

   d. Enter the following information:
      - Name – Enter the name of your JIRA server.
      - Server URL – Enter web address of your JIRA server. Examples:

        http://www.example.com:8080/jira/
        http://jira.example.com

      - Application name and Application password – Enter the values that you defined for Confluence in the settings on JIRA.

   e. Save the directory settings.

   f. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen.

   For details see Connecting to Crowd or JIRA for User Management.

   - For FishEye/Crucible:
     a. Click 'Authentication' on the FishEye/Crucible 'Admin Menu'.
     b. Click 'Edit' in the section titled 'JIRA or Crowd Authentication'.

     c. Enter the following information:
        - Application name and Application password – Enter the values that you defined for your application in the settings on JIRA.
        - JIRA/Crowd URL – The web address of your JIRA server. Examples:

        http://www.example.com:8080/jira/
        http://jira.example.com
• **Auto-add** – Select ‘Create a FishEye/Crucible user on successful login’ (default) to ensure that your JIRA users will be automatically enrolled into FishEye/Crucible when they first log in via JIRA.

• **Synchronize users with JIRA/Crowd** – Select ‘Yes’ (default) to ensure that JIRA will synchronize all changes in the user information on a regular basis. The **synchronization interval** is set to 60 minutes (1 hour) by default.

• **Single sign on (SSO)** – Select ‘Disabled’. This option is not available when using JIRA for user management and if enabled will make the integration fail.

• **Groups of users to synchronize** – Select at least one group to synchronize. The default is ‘jira-users’.
  
d. Click ‘Apply changes’.

• For Stash:
  
a. Go to the **Stash Administration Console**.
  
b. Click ‘**User Directories**’ in the left-hand panel.
  
c. **Add** a directory and select type ‘**Atlassian JIRA**’.
  
d. Enter the following information:
    
    • **Name** – Enter the name of your JIRA server.
    
    • **Server URL** – Enter web address of your JIRA server. Examples:
      
      ```
      http://www.example.com:8080/jira/
      http://jira.example.com
      ```
    
    • **Application name** and **Application password** – Enter the values that you defined for Stash in the settings on JIRA.
    
e. Save the directory settings.
  
f. Define the **directory order** by clicking the blue up- and down-arrows next to each directory on the ‘**User Directories**’ screen.
    
    For details see **Connecting to JIRA for user management**.

**Notes**

• When you connect to JIRA in the setup wizard, the setup procedure will configure **Trusted Applications** authentication for your application. Please be aware of the following security implications:
  
  • Trusted applications are a potential security risk. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.
  
  • In the next step, you will specify the username and password of your **Confluence system administrator**. If you have connected to JIRA, the setup wizard will add the Confluence administrator's username and password to both JIRA and Confluence. This is done so that you can still access Confluence even if JIRA is down. Please note that the password in Confluence is not linked to the password in JIRA. If you subsequently change the administrator's password, only the password in JIRA will change. This is because the JIRA user directory is placed first in the list of user directories. See **Managing Multiple Directories**.

**Related Topics**

- User Management Limitations and Recommendations
- Confluence Setup Guide
- Configuring Application Links

**Upgrading Confluence**

This document describes the standard, recommended procedure for upgrading to **Confluence Latest**. Use this procedure when upgrading from Confluence version 3.5 or later on Windows or Linux.
Notes:

- **Clustered Confluence.** The automatic installer/upgrader does not support upgrading clustered installations of Confluence. See Upgrading a Confluence Cluster.
- **Upgrading from an early version of Confluence.** If you are upgrading from a version earlier than Confluence 3.5, you will need to use manual upgrade procedure. See Upgrading Confluence Manually.
- **Moving to a different OS, database or file location.** If you are changing the operating system that will run Confluence, the database it is using, or the location of its files, you will need to use manual upgrade procedure. See Upgrading Confluence Manually.

### Upgrading to Confluence 4.3?

If so, please review the [Confluence 4.3 Release Notes](https://confluence-atlassian.com/release-notes) for important information about this version of Confluence. Ensure that you have read the [Confluence 4.3 Known Issues](https://confluence-atlassian.com/known-issues) in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the [Upgrade Notes Overview](https://confluence-atlassian.com/upgrade-notes-overview) page.

Finally, please check the [Supported Platforms](https://confluence-atlassian.com/supported-platforms) page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The [End of Support Announcements for Confluence](https://confluence-atlassian.com/end-of-support-announcements) page has important information regarding supported platforms.

### On this page:

- **Before you Start**
- **Backing Up**
- **Testing the Upgrade in a Test Environment**
  - Upgrade Overview
  - Performing the Upgrade
    - Upgrading Confluence on Windows
    - Upgrading Confluence on Linux
  - Upgrade Check List
    - Back Up Your External Database
    - Check Plugin Compatibility

### Before you Start

#### Changing your Database?

If you are planning to change to a different database, we recommend that you complete the Confluence upgrade first. Then follow the instructions on [migrating to a different database](https://confluence-atlassian.com/migrating-to-a-different-database).

1. Note that you need current software maintenance to perform the upgrade.
2. Confirm that your license support period is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade. **⚠️** If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on [upgrading beyond current license period](https://confluence-atlassian.com/upgrading-beyond-current-license-period).
4. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for...
any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)

5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.

6. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.

7. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.

8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your Administration screens, and selecting Confluence Upgrade Check. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.

9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.

10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.

11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

**Backing Up**

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   Tip: Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation. The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes. You don't need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using
Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

Testing the Upgrade in a Test Environment

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

XML imports

⚠️ Importing an old XML backup file to a new major version (i.e Confluence 3.5 to Confluence 4.0) is not recommended. Please recreate your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

RELATED TOPICS

Upgrading Confluence

Upgrade Overview

The upgrade feature of the Linux and Windows Installers automates the following tasks for you:

1. Backs up the Installation and Home Directories of the existing Confluence installation to be upgraded.
2. Installs Confluence Latest whilst migrating the following from your existing Confluence installation to the new Confluence Latest installation:
   - TCP port values in your existing Confluence installation's server.xml file. Be aware that other configurations or customisations in this file are not migrated during upgrade, and will need to be re-applied.
   - Custom values in your existing Confluence installation's confluence-init.properties (confluence.home property) and setenv.sh/setenv.bat files (JAVA_OPTS parameters)

The upgrade feature detects and notifies you of any files in the confluence subdirectory of your existing Confluence Installation Directory which have been deleted, added or modified from a 'default' Confluence installation. This informs you of any customisations you will need to migrate manually over to your upgraded Confluence installation directory. Note that modifications to files in directories other than confluence will not be detected when you upgrade to Confluence 4.0, for example any modifications to start-up scripts under the bin directory will not be detected. The next time you upgrade (e.g. to version 4.0.1) the the upgrade feature will cover modifications across the whole Confluence Installation Directory.

⚠️ Please Note:

- The upgrade process requests that you conduct a backup of your database using your database's backup utilities. If your database does not support online backups, you can stop the upgrade process, shut down Confluence, perform your database backup and then restart the upgrade process to continue on.
- If you have made customisations to your server.xml file or any other files in your Confluence
installation directory which are not handled by the upgrade wizard, these must be re-applied manually.

- If your attachments and index files are located outside your Confluence Home Directory, then backups of these directories must be performed manually.

Performing the Upgrade

Refer to the appropriate upgrade instructions below for your operating system:

Upgrading Confluence on Windows

1. Download the Confluence 'Windows Installer' (.exe) file (for the new version of Confluence) from the Confluence Download Center.
2. Run the '.exe' file to start the upgrade wizard.
   - If a Windows 7 (or Vista) 'User Account Control' dialog box requests if you want to allow the upgrade wizard to make changes to your computer, specify 'Yes'. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
3. At the 'Upgrading Confluence?' step, choose the 'Upgrade an existing Confluence installation' option.
4. In the 'Existing Confluence installation directory' field, specify the Confluence Installation Directory of your Confluence installation to be upgraded.
   - The upgrade wizard will attempt to find an existing Confluence installation and use its location to pre-populate this field. However, always verify this location, particularly if you have multiple Confluence installations running on the same machine.
5. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:
   a. At the 'Back up Confluence directories' step, ensure the 'Back up Confluence home' option is selected. This creates 'zip' archive file backups of your existing Confluence Installation and Confluence Home Directories in their respective parent directory locations.
      - Please Note:
        - Choosing this option is strongly recommended!
   b. At this point, the upgrade wizard notes any customisations in your existing Confluence Installation Directory which it cannot automatically migrate to your upgraded Confluence installation. If you are notified by the installer about any files containing such customisations, please make a note of the locations of these files as you will need to manually migrate their customisations (which are not mentioned in the overview above) to your upgraded Confluence installation. One relatively common customisation that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the conf/server.xml file of the Confluence Installation Directory. Please Note: when upgrading from the version that was not installed by the installer the customisations can only be detected in the confluence subdirectory of your existing Confluence Installation Directory. Modifications to files in directories other than confluence will not be detected when you upgrade, for example, modifications to conf/server.xml. However the next time you upgrade (e.g. to version 4.1.1) the upgrade feature will cover modifications across the whole Confluence Installation Directory.
   c. At the 'Upgrade Check List' step, back up your external database and check that any non-bundled plugins will be compatible with your upgraded Confluence version. You may have already conducted the latter (in step 5 of the Before You Start section above).
   d. Upon clicking 'Next', your existing Confluence installation will be shut down if it is still running. The upgrade wizard will then:
      i. Back up your existing Confluence installation.
      ii. Delete the contents of the existing Confluence Installation Directory.
      iii. Install the new version of Confluence to the existing Confluence Installation Directory.
      iv. Starts your new (upgraded) Confluence installation.
         - If you noted any files that contain customisations which must be migrated manually to your upgraded Confluence installation (above), then:
           1. Stop the upgraded Confluence installation.
           2. Migrate the customisations from these files into the upgraded Confluence Installation Directory.
3. Restart the upgraded Confluence installation.

6. At the last step of the upgrade wizard, select the option to launch the upgraded Confluence installation in a browser so you can check the upgrade.

Congratulations, you have completed upgrading your Confluence installation on Windows!

**Upgrading Confluence on Linux**

1. Download the appropriate Confluence 'Linux 64-bit / 32-bit Installer' (.bin) file that suits your operating system (for the new version of Confluence) from the Confluence Download Center.

2. Open a Linux console and change directory (cd) to the '.bin' file's directory.
   
   If the '.bin' file is not executable after downloading it, make it executable, for example:
   ```bash
   chmod a+x atlassian-confluence-X.Y.bin
   ```
   (where X.Y represents your version of Confluence)

3. Execute the '.bin' file to start the upgrade wizard.

4. When prompted to choose between creating a new Confluence installation or upgrading an existing installation, choose the 'Upgrade an existing Confluence installation' option.

5. Specify the Confluence Installation Directory of your Confluence installation to be upgraded.
   
   The upgrade wizard will attempt to find an existing Confluence installation and will provide its location as a choice. However, always verify this location, particularly if you have multiple Confluence installations running on the same machine.

6. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:
   
   a. Choose the option to back up Confluence's directories. This creates 'zip' archive file backups of your existing Confluence Installation and Confluence Home directories in their respective parent directory locations.
   
   Please Note:
   
   - **Choosing this option is strongly recommended!**
   
   At this point, the upgrade wizard notes any customisations in your existing Confluence Installation Directory which it cannot automatically migrate to your upgraded Confluence installation. If you are notified of any files containing such customisations, please make a note of the locations of these files as you will need to manually migrate their customisations (which are not mentioned in the overview above) to your upgraded Confluence installation. One relatively common customisation that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the conf/server.xml file of the Confluence Installation Directory. Please Note: when upgrading from the version that was not installed by the installer the customisations can only be detected in the confluence subdirectory of your existing Confluence Installation Directory. Modifications to files in directories other than confluence will not be detected when you upgrade, for example, modifications to conf/serv er.xml. However the next time you upgrade (e.g. to version 4.1.1) the upgrade feature will cover modifications across the whole Confluence Installation Directory.

   b. At the 'Upgrade Check List' step, back up your external database and check that any non-bundled plugins will be compatible with your upgraded Confluence version. You may have already conducted the latter (in step 5 of the Before You Start section above).

   c. Upon proceeding, your existing Confluence installation will be shut down if it is still running. The upgrade wizard will then:
      
      i. Back up your existing Confluence installation.
      
      ii. Delete the contents of the existing Confluence installation directory.
      
      iii. Install the new version of Confluence to the existing Confluence installation directory.
      
      iv. Starts your new (upgraded) Confluence installation.
      
      Please Note: if you noted any files that contain customisations which must be migrated manually to your upgraded Confluence installation (above), then:
      
      1. Stop the upgraded Confluence installation.
      
      2. Migrate the customisations from these files into the upgraded Confluence Installation Directory.
      
      3. Restart the upgraded Confluence installation.

7. The last step of the upgrade wizard provides you with a link to launch the upgraded Confluence
installation in a browser, so you can check the upgrade.

Congratulations, you have completed upgrading your Confluence installation on Linux!

**Upgrade Check List**

The upgrade wizard requests that you perform the following tasks before it actually commences the upgrade of your existing Confluence installation.

**Back Up Your External Database**

Perform a backup of your external database (using your database's native backup tools) and verify that the backup was created correctly.

- If your database's native backup tools support 'online backups' (i.e. which would typically create a 'snapshot' of your Confluence database while the database is still in use), you can leave the upgrade wizard running while you perform the database backup and then continue on with the wizard after verifying that the database backup was created correctly.
- If your database's native backup tools do not allow you to perform an 'online backup' of your Confluence database, you should:
  1. Quit the upgrade wizard now.
  2. Use your database's native backup tools to perform an 'offline backup' of your Confluence database and verify that this backup was created correctly.
  3. Re-run the Linux / Windows Installer to start the upgrade wizard again and continue from where you left off.
- If you are using HSQLDB as the Confluence internal database, please note that this should be used for evaluating Confluence only. If you happen to accidentally use the HSQLDB database for a production system, quit the upgrade wizard now and use the [Migrating Confluence Between Servers](#) procedure to upgrade Confluence.

⚠️ **Inconsistent database backups may not restore correctly!** If you are unfamiliar with your database's native backup/restore facilities, then test your database backup's integrity by doing the following:

1. Restoring the database backup to a different (test) system,
2. Connecting a test instance of your current Confluence version to this restored database.

Alternatively, use the [Migrating Confluence Between Servers](#) procedure to upgrade Confluence instead.

**Check Plugin Compatibility**

If you have installed any 3rd-party Confluence plugins (i.e. not included in Confluence), please verify that they will be compatible with the version of Confluence you are upgrading to. You can find a plugin's compatibility information from the the plugin's home page on the [Atlassian Plugin Exchange](#). Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. This can be done by navigating to **Browse > Confluence Admin > Configuration > Plugins**.

**Upgrading Beyond Current Licensed Period**

This page explains the recovery process should you mistakenly try to upgrade your Confluence installation to a version beyond your current license entitlement.

**License warnings**

During an upgrade an obvious indication that your license has expired can be found in your log file. You will see a 'WARN' level entry similar to this:
[confluence.upgrade.impl.DefaultUpgradeManager] isUpgradeAllowed
Your license is now outside of it's support period.
You need to renew the license before you can upgrade to this version of Confluence.

Related pages:
- Upgrading Confluence
- Working with Confluence Logs
- Confluence Administrator's Guide

When you try to access the Confluence site in your browser, you will see the following warning screen:

<table>
<thead>
<tr>
<th>Time</th>
<th>Level</th>
<th>Type</th>
<th>Description</th>
<th>Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008-02-04 16:51:04</td>
<td>null</td>
<td>EventType:</td>
<td>Cannot proceed with upgrade. Your current license does not entitle you to</td>
<td>fatal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>upgrade</td>
<td>upgrade to this version of Confluence. Please check that the support period</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>of your license has not expired or that you have the correct partner license.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If you wish to renew your license, please contact <a href="mailto:sales@atlassian.com">sales@atlassian.com</a>. If you</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>have a new license, please enter it on this <a href="#">page</a> and <a href="#">restart</a>.</td>
<td></td>
</tr>
</tbody>
</table>

**Updating the Confluence license**

1. Contact [Atlassian Sales](#) to arrange for a new license to be issued, as instructed on the warning screen illustrated above.
2. Once you have received a suitable license, supply the license key to Confluence:
   - Click link given on the license warning screen, illustrated above.
   - You will first be asked to log in as a Confluence administrator.
   - Then you will be presented with a simplified license administration screen. Enter the credentials of a Confluence system administrator.
   - Copy the license key into the **License** field and choose **Save**.

   ![Confluence License Administration Screen](#)

3. Restart Confluence to continue the upgrade.

**Confluence Post-Upgrade Checks**

This article provides a list of items for Confluence Administrators to check after a [Confluence upgrade](#) to ensure...
that it has completed successfully. This list is not exhaustive, but it does cover common upgrade mistakes.

On this page:

- **Before You Begin**
- **Upgrade Checklist**
  - **1. Layout and Menu**
  - **2. Search**
  - **3. Permissions**
  - **4. Attachments**
  - **5. Plugins**

**Before You Begin**

After you have completed an upgrade, you should see the following message in the `atlassian-confluence.log` file:

```
2010-03-08 08:03:58,899 INFO [main] [atlassian.confluence.upgrade.AbstractUpgradeManager] upgradeFinished
Upgrade completed successfully
```

If you do not see the line in your log similar to the one above, this means that your upgrade has not completed successfully. Please check our [Troubleshooting Upgrades](#) documentation to check for a suitable recommendation or fix. If there are no errors logged or if none of the errors are referenced in the [Troubleshooting Upgrades](#) documentation, please contact Atlassian Support using the [Support Utilities](#) in your administration console.

**Upgrade Checklist**

Below is a recommended list of items to check after completing an upgrade.

1. **Layout and Menu**

   Visit the [Confluence dashboard](#) and check that it is accessible and displays as expected. Test the different Internet browsers that you have in use in your environment. In addition, confirm that the layout appears as expected and that the menus are clickable and functioning.

2. **Search**

   Try searching for content, for example pages, attachments or user names. Check that the expected results are returned.

3. **Permissions**

   Confirm that you can visit a page that has viewing restrictions, but you have permission to view. Confirm that you can edit a page that has edit restrictions but you have permission to edit. Make sure that the permissions of child pages are functioning as well. Involve as many space administrators as possible to confirm they are working. Confirm that anonymous or forbidden users cannot access or modify restricted pages.

4. **Attachments**

   Confirm that attachments are accessible and searchable.

5. **Plugins**
Outdated third-party plugins can cause upgrade failure. Quite often, they will just be incompatible and simply do not work anymore. If you discover that your plugin is no longer working, please check for the latest version for your plugin in the Atlassian Plugin Exchange.

✅ Universal Plugin Manager

Use the Universal Plugin Manager to easily check for plugin compatibility.

RELATED TOPICS

- Troubleshooting Upgrades
- Upgrading Confluence

**Upgrading Confluence EAR-WAR Distribution**

This document tells you how to upgrade from one version of Confluence to a later version. These instructions apply to the EAR-WAR Distribution of Confluence, deployed on your own existing application server.

If you want to upgrade the regular Confluence distribution, which includes Apache Tomcat as the application server, please refer to Upgrading Confluence instead.

Please also check the following before you start using this guide:

- The version of Confluence that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The supported platforms for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running Confluence on a cluster, please see Upgrading a Confluence Cluster instead of this document.

💡 Upgrading to Confluence 4.3?

If so, please review the Confluence 4.3 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 4.3 Known Issues in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the Upgrade Notes Overview page.

Finally, please check the Supported Platforms page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The End of Support Announcements for Confluence page has important information regarding supported platforms.

On this page:

- Before you Start
- Backing Up
- Testing the Upgrade in a Test Environment
- Performing the Upgrade
- Reapplying Customisations to your New Confluence
- Checking for Known Issues and Troubleshooting the Confluence Upgrade

**Before you Start**
Changing your Database?

If you are planning to change to a different database, we recommend that you complete the Confluence upgrade first. Then follow the instructions on migrating to a different database.

1. Note that you need current software maintenance to perform the upgrade.
2. Confirm that your license support period is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade.
   ▲ If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
4. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
6. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
7. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your Administration screens, and selecting Confluence Upgrade Check. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.
10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.
11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

Backing Up

Before you begin the Confluence upgrade, you must back up the following:

1. Back up your Confluence Home directory. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   □ Tip: Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called confluence-init.properties, which is located inside the confl
1. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation.

2. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

### Testing the Upgrade in a Test Environment

1. Be sure to test the upgrade in a test environment before proceeding on your production server.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

### Performing the Upgrade

If you are migrating servers or migrating databases, perform those operations in separate steps.

The upgrade process allows you to unzip the new Confluence installation into a directory of your choice and then edit the configuration files to point your new installation to your existing data files. Follow these instructions:

1. Shut down your existing Confluence instance.
2. Download the Confluence EAR-WAR zip file: Go to the Download Center, and click 'Show all' to find the EAR-WAR zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing.
7Zip — Recommended. If in doubt, download the ‘32-bit.exe’ version
Winzip

4. Use your unzip program to unzip the installation file. You should now have a new directory called confluence-<version>.
   • In the rest of this document, we will refer to this as the <Installation-Directory>.
   • Do not use spaces in your directory path.
   • You can read more about the Confluence Installation directory.

5. Edit the confluence-init.properties file found at: <Installation-Directory>\confluence \WEB-INF\classes\confluence-init.properties and update 'confluence.home' to point to your existing Confluence Home directory.
   • Make sure you have first backed up your Home directory.
   • Open the confluence-init.properties file in a text editor such as Notepad.
   • Scroll to the bottom and find this line:

```
# confluence.home=c:/confluence/data
```

   • Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home.
   • Update the directory name after the = sign, to point to your existing Confluence Home directory.

6. If you are using Tomcat, you need to update either your confluence.xml or server.xml (depending on where you have defined the Confluence context descriptor) to point to the location of the new Confluence installation (also remember to copy over any customisations such as a tomcat datasource if you have one).

7. If you have delegated your user management to JIRA, LDAP or any other external user management system, copy the following files from your old Confluence installation to your new Confluence installation:
   • <Installation-Directory>/confluence/WEB-INF/classes/osuser.xml.
   • <Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml (if you are upgrading from Confluence 2.2 or later).

   Upgrading to Confluence 3.5+ and using JIRA user management?
   Please review our KB article first: Upgrade to Confluence 3.5 with JIRA User Management Fails

   If you are upgrading from an earlier version of Confluence (2.5.5 and earlier) and are copying your existing atlassian-user.xml file from your previous instance, please ensure that the hibernate cache parameter in this file has been enabled, to avoid performance related issues. (NOTE: If you use Crowd for your user management, you do not need to do this.):

```
<hibernate name="Hibernate Repository"
key="hibernateRepository"
description="Hibernate Repository" cache="true"
/>`

8. If you have delegated your user management to Crowd, you will also need to copy the Crowd client library and configuration files from your old Confluence installation to your new Confluence installation: <Installation-Directory>/confluence/WEB-INF/lib/crowd-integration-client-X.X.X.jar and <Installation-Directory>/confluence/WEB-INF/classes/crowd.properties. If you need more information, please refer to the Crowd documentation.

9. Restart your application server and start Confluence.
Please note that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser. (There is no easy and quick way to determine if the indexing process is completed. Please wait for approximately 10 minutes after the server start up before accessing Confluence via a web browser.)

10. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property hibernate.hbm2ddl.skip Creating Missing Indexes to true to skip automatic index creation.

11. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

12. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

13. Consider any adjustments you need to make to customisations and special configurations, as described below.

Reapplying Customisations to your New Confluence

Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel

After upgrading your Confluence installation to a later version of Confluence, you need to consider any customisations you have applied to your system and other special configurations:

- If you had previously installed Confluence/Tomcat as a Windows service, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see Start Confluence Automatically on Windows as a Service.
- If you are using the Confluence distribution and you have previously defined a CATALINA_HOME environment variable, please check that it points to the correct path for the new Confluence Tomcat server.
- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented SSL, edit your new web.xml file and and copy over any relevant modifications from your old web.xml file, which relate to these customisations.
- If you were previously running Confluence on a non-standard port, edit your new <Installation-Directoy>\conf\server.xml file as described in Change listen port for Confluence.
- If you had previously defined a Tomcat datasource, edit your new <Installation-Directoy>\conf\server.xml and copy over the datasource definition from your old server.xml.
- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Plugin Repository in the Confluence Administration Console.
- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.
- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here.
- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.
- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.
- If you had previously modified the memory flags (Xms and Xmx) in either the <Installation-Directoy>\bin\setenv.sh or the <Installation-Directory>\bin\setenv.bat file, you may want to make the modifications in your new installation. The parameters are specified in the JAVA_OPTS variable.
- If you had changed the Confluence interface text, you will need to pull over the ConfluenceActionSupport.properties file.
• If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.

Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the **Confluence post-upgrade checklist** to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

• **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

• **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

**RELATED TOPICS**

- Upgrading Confluence
- Confluence Installation Guide
- Important Directories and Files
- Site Backup and Restore
- Database Configuration

Migration from Wiki Markup to XHTML-Based Storage Format

If you are upgrading to **Confluence 4.0 or later** from an older version (From Confluence 3.5.x or earlier) then as part of the upgrade an automatic migration of your content will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each wiki markup page. The new version will use the new XHTML-based storage format, so that you can edit the page in the Confluence rich text editor.

In addition, if you are **upgrading to Confluence 4.3 or later** from an older version then as part of the upgrade an automatic migration of your page templates will take place. See [Migration of Templates from Wiki Markup to XHTML-Based Storage Format](#).

**Note:** Even though the process is non-destructive, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any Confluence upgrade.

**Migration process**

Depending on the size of your Confluence installation, the migration from wiki markup to the new XHTML-based storage format could prove time consuming. The duration of the migration is difficult to estimate; this is due to a number of site specific factors. As a rough guide, a test dataset we migrated was 130,000 pages, totalling approximately 700Mb, which took six minutes.

---

**On this page:**

- Migration process
- Watching the migration logs during the upgrade
- Re-running the migration – for content that completely failed the migration
- Re-attempting the migration – for content in 'unmigrated-wiki-markup' macro
- Notes

**Related pages:**

- [Migration of Templates from Wiki Markup to XHTML-Based Storage Format](#)
- [Upgrading Confluence](#)
The following properties that can be modified to allow finer control over the migration process:

<table>
<thead>
<tr>
<th>Property</th>
<th>Purpose</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.wiki.migration.threads</td>
<td>The number of concurrent worker threads migrating content</td>
<td>4</td>
</tr>
<tr>
<td>confluence.wiki.migration.batch.size</td>
<td>The number of items migrated in each batch of work</td>
<td>500</td>
</tr>
<tr>
<td>confluence.wiki.migration.versioncomment</td>
<td>The comment associated with the newly migrated version of each piece of content</td>
<td>&quot;Migrated to Confluence 4.0&quot;</td>
</tr>
</tbody>
</table>

(For instructions on setting Confluence system properties see [this document](#).)

Again, due to the large variability in Confluence installations it is hard to give specific recommendations for the above settings. One point to note though that both increasing batch size and the number of threads (or both) will increase the peak memory required for migration. If memory is an issue then as you increase one of these settings consider decreasing the other.

Another factor to be aware of if modifying these defaults is that of the cache settings employed in your site. The migration will quickly populate certain Confluence caches so be sure that if you have customised caches as described here that there is enough memory on the server for these caches should they reach maximum capacity.

**Watching the migration logs during the upgrade**

To monitor the progress of a site migration you should watch the output in the application log.

Typical logging progress will be shown by multiple log entries at the INFO level of the following format:

```
WikiToXhtmlMigrationThread-n - Migrated 2500 of 158432 pages, this batch migrated 500/500 without error
```

There may be a wide array of messages logged from each individual page but any errors are also collected for display in a single migration report once all content has been processed. Here is a typical example of such a report:
Wiki to Xhtml Exception Report:
Summary:
0 settings values failed.
0 PageTemplates failed.
2 ContentEntityObjects failed.
Content Exceptions:
1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown. Message: The macro link is unknown.
2) Type: comment, Id: 6919, Title: null, Global Scope. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new Xhtml-based storage format, but will actually consist of wiki markup content wrapped within an xml 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the new Confluence Editor.

However, in some cases a batch of content may actually have completely failed to migrated. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

Unable to start up Confluence. Fatal error during startup sequence:
confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require the plugin framework to be available) - com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view any such unmigrated content they will see an exception similar to this:

java.lang.UnsupportedOperationException: The body of this ContentEntityObject ('Page Title') was 'WIKI' but was expected to be 'XHTML'

The solution is to ensure you manually re-run the site migration after the restart.

Re-running the migration – for content that completely failed the migration

A Confluence Administrator can restart the site migration if there was any content that failed migration (see previous section). Only the content that is still formatted in wiki markup will be migrated, so typically a
re-migration will take less time than the original migration.

To manually re-run migration:

1. Open this URL in your browser: <Confluence Address>/admin/force-upgrade.action
2. Select wikiToXhtmlMigrationUpgradeTask in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.

![Force Upgrade](image)

**Re-attempting the migration – for content in 'unmigrated-wiki-markup' macro**

The previous section was about dealing with the exceptional circumstance where certain content was left completely unmigrated. The most common migration problem is that the content was migrated but remains formatted as wiki markup on the page, within the body of an 'unmigrated-wiki-markup' macro. Any content which is referenced in the migration report will be found in this state. This content is still viewable and editable but since it is wiki markup it cannot be edited using the full feature set of the rich text editor.

The most common reason for content to be in this state is that the page contains an unknown macro, or a macro that is not compatible with Confluence 4.x.

There are two possible fixes for this situation:

1. Install a version of the macro that is compatible with Confluence 4.x. See [Plugin Development Upgrade FAQ for 4.0](#).
2. Edit the page and remove the problematic macro.

Regardless of the solution you choose, you can then force a re-migration of all the content (including content in templates) that was left wrapped in an 'unmigrated-wiki-markup' macro. This feature is found at <Confluence Address>/admin/unmigratedwikicontent.action

![Update with incompatible macros](image)

**Notes**
We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

**Migration of Templates from Wiki Markup to XHTML-Based Storage Format**

If you are **upgrading to Confluence 4.3 or later from an older version** (from Confluence 4.2.x or earlier) then as part of the upgrade an automatic migration of your page templates will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each space template and each global template on your Confluence site. The new version will use the new XHTML-based storage format, so that you can edit the template in the Confluence rich text editor.

**Note:** Nevertheless, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any Confluence upgrade.

**Watching the migration logs during the upgrade**

To monitor the progress of a site migration you should watch the output in the application log.

A typical logging progress will be shown by multiple log entries at the INFO level of the following format:

```
WikiToXhtmlMigrationThread-n - Migrated 22 of 29 PageTemplates.
```

There may be a wide array of messages logged from each individual template, but any errors are also collected for display in a single migration report once all content has been processed. Here is a typical example of such a report:
Wiki to XHTML Exception Report:

Summary:
0 settings values failed.
2 PageTemplates failed.
0 ContentEntityObjects failed.

Content Exceptions:
1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown.. Message: The macro link is unknown.
2) Type: comment, Id: 6919, Title: null, Global Scope. Cause:
com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown.. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new XHTML-based storage format, but will actually consist of wiki markup content wrapped within an XML 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the Confluence rich text editor.

However, in some cases a batch of content may actually have completely failed to migrate. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

Unable to start up Confluence. Fatal error during startup sequence: 
confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require the plugin framework to be available) - com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view or edit an unmigrated template, the wiki template editor will be used.

The solution is to manually re-run the site migration after the restart, as described below.

Re-running the migration

A Confluence administrator can restart the template migration if any templates have failed the migration (see previous section). Only the templates that are still formatted in wiki markup will be migrated again. Typically, a re-migration will take less time than the original migration.

To manually re-run the migration:

1. Open this URL in your browser: <Confluence Address>/admin/force-upgrade.action
2. Select pageTemplateWikiToXhtmlMigrationUpgradeTask in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.
Notes

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Upgrading Confluence Manually

This document tells you how to upgrade from one version of Confluence to a later version. This document refers to the Confluence distribution, which includes Apache Tomcat as the bundled application server.

If you want to upgrade a Confluence EAR/WAR distribution deployed on your own existing application server, please refer to Upgrading Confluence EAR-WAR Distribution instead.

Please also check the following before you start using this guide:

- The version of Confluence that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The supported platforms for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running Confluence on a cluster, please see Upgrading a Confluence Cluster instead of this document.

Upgrading to Confluence 4.3?

If so, please review the Confluence 4.3 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 4.3 Known Issues in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the Upgrade Notes Overview page.

Finally, please check the Supported Platforms page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The End of Support Announcements for Confluence page has important information regarding supported platforms.

Upgrading from Confluence 3.4 or earlier?

Please upgrade to Confluence 3.5 before upgrading to Confluence 4.x.
On this page:

- Before you Start
- Backing Up
- Testing the Upgrade in a Test Environment
- Performing the Upgrade
- Reapplying Customisations to your New Confluence
- Checking for Known Issues and Troubleshooting the Confluence Upgrade
- Useful Plugins

Before you Start

1. Note that you need current software maintenance to perform the upgrade.
2. Confirm that your license support period is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade.
   - If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
4. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
6. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
7. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your Administration screens, and selecting Confluence Upgrade Check. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.
10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.
11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production
Confluence outside of hours where people need to use it.

Back up

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   Tip: Another term for ‘Home directory’ would be ‘data directory’. The location of the Home directory is stored in a configuration file called confluence-init.properties, which is located inside the confluence/WEB-INF/classes directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation.

   The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes. You don't need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

Testing the Upgrade in a Test Environment

Be sure to test the upgrade in a test environment before proceeding on your production server.

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

   **XML imports**

   Importing an old XML backup file to a new major version (i.e Confluence 3.5 to Confluence 4.0) is not recommended. Please recreate your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

Performing the Upgrade
To install Confluence, unzip the new Confluence installation zip file into a directory of your choice and then edit the configuration files to point your new installation to your existing data files. Follow these instructions:

1. Shut down your existing Confluence instance.
2. Download the Confluence zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing:
   - 7Zip — Recommended. If in doubt, download the '32-bit.exe' version
   - Winzip
4. Use your unzip program to unzip the installation file. You should now have a new directory called confluence-<version>, e.g. confluence-4.0.0-std.
   - In the rest of this document, we will refer to this as the <Installation-Directory>.
   - If you decide to change the location from the default, make sure that you choose a different location from your existing Confluence installation, because legacy files may cause problems if you install the new Confluence version into an existing directory.
   - Do not use spaces in your directory path.
   - You can read more about the Confluence Installation directory.
5. Edit the confluence-init.properties file found at: <Installation-Directory>/confluence/WEB-INF/classes/confluence-init.properties and update 'confluence.home' to point to your existing Confluence Home directory.
   - You can read more about the Confluence Home directory.
   - Make sure you have first backed up this directory, as instructed above.
   - Open the confluence-init.properties file in a text editor such as Notepad.
   - Scroll to the bottom and find this line:
     ```
     # confluence.home=c:/confluence/data
     ```
   - Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home.
   - Update the directory name after the = sign, to point to your existing Confluence Home directory.
6. If you are running Confluence as a Windows service, use the command prompt and type <Installation-Directory>/bin/service.bat remove Confluence.
   - It is vital that you stop and remove the existing service prior to uninstalling the old instance of Confluence! For more information on running Confluence as Windows service, please refer to the Start Confluence Automatically on Windows as a Service topic.
   - To remove the service installed by the Confluence installer, you need to run the <confluence auto installer installation folder>/UninstallService.bat.
7. If you are using an external database (i.e. not the embedded HSQLDB database supplied for evaluation purposes), copy the jdbc driver jar file from your old Confluence installation to the new Confluence installation. The jdbc driver jar file in the old Confluence installation should be located in either the <Installation-Directory>/common/lib or <Installation-Directory>/confluence/WEB-INF/lib directories. Once you have identified this file, copy it to either the <Installation-Directory>/lib or <Installation-Directory>/confluence/WEB-INF/lib directories of your Confluence installation.
8. If you have delegated your user management to JIRA, LDAP, Crowd, or any other external user
management system, copy the following files from your old Confluence installation to your new Confluence installation:

- `<Installation-Directory>/confluence/WEB-INF/classes/osuser.xml`
- `<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml` (if you are upgrading from Confluence 2.2 or later).

If you are upgrading from an earlier version of Confluence (2.5.5 and earlier) and are copying your existing `atlassian-user.xml` file from your previous instance, please ensure that the hibernate cache parameter in this file has been enabled, to avoid performance related issues. (NOTE: If you use Crowd for your user management, you do not need to do this.):

```xml
<hibernate name="Hibernate Repository" key="hibernateRepository" description="Hibernate Repository" cache="true" />
```

9. If you have delegated your user management to Crowd, you will also need to copy the Crowd configuration file from your old Confluence installation to your new Confluence installation: `<Installation-Directory>/confluence/WEB-INF/classes/crowd.properties`. If you need more information, please refer to the Crowd documentation.

10. Consider any adjustments you need to make to customisations and special configurations, as described below. Your new version of Confluence may not function correctly or could encounter problems or errors if these are not implemented.

11. Start your new version of Confluence.

   Please note that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser.

12. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property `hibernate.hbm2ddl.skip_creating_missing_index` to `true` to skip automatic index creation.

13. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

14. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

**Reapplying Customisations to your New Confluence**

Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel

After upgrading your Confluence installation to a later version of Confluence, you need to consider any customisations you have applied to your system and other special configurations:

- If you had previously installed **Confluence/Tomcat as a Windows service**, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see [Start Confluence Automatically on Windows as a Service](#).
- If you are using the Confluence distribution and you have previously defined a `CATALINA_HOME`
environment variable, please check that it points to the correct path for the new Confluence Tomcat server.

- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented SSL, edit your new web.xml file and and copy over any relevant modifications from your old web.xml file, which relate to these customisations.

- If you were previously running Confluence on a non-standard port, edit your new <Installation-Directory>\conf\server.xml file as described in Change listen port for Confluence.

- If you had previously defined a Tomcat datasource, edit your new <Installation-Directory>\conf\server.xml and copy over the datasource definition from your old server.xml.

- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Plugin Repository in the Confluence Administration Console.

- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.

- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here.

- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.

- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.

- If you had previously modified the memory flags (Xms and Xmx) in either the <Installation-Directory>\bin\setenv.sh or the <Installation-Directory>\bin\setenv.bat file, you may want to make the modifications in your new installation. The parameters are specified in the JAVA_OPTS variable.

- If you had changed the Confluence interface text, you will need to pull over the ConfluenceActionSupport.properties file.

- If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.

Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire’s Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

**RELATED TOPICS**

Upgrading Confluence
Upgrading Confluence EAR-WAR Distribution
Confluence Installation Guide
Important Directories and Files
Site Backup and Restore
Database Configuration
Supported Platforms
This page describes the supported platforms for Confluence. Please review them before installing Confluence. The information on this page applies to Confluence Latest.

Further information:
- End of support for various platforms and browsers when used with Confluence: [End of Support Announcements for Confluence](#).
- More information about these supported platforms and hardware requirements: [System Requirements](#).

### Related pages:
- Confluence Installation Guide
- Confluence Setup Guide
- Installing Confluence and JIRA Together
- Server Hardware Requirements Guide
- Supported Platforms FAQ
- Confluence Documentation Home

### Key:
- ✔️ = Supported. ✗ = Not Supported

<table>
<thead>
<tr>
<th>Java Version</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle JRE / JDK</td>
<td>✔️ 1.6.0_4+ (Note: Java 6 update 18+ have known issues.) Recommend to use Java 6 Update 26+. ✔️ 1.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (including 64-bit)¹</td>
<td>✔️ (Microsoft Supported Versions only)</td>
</tr>
<tr>
<td>Linux / Solaris (¹, ²)</td>
<td>✔️</td>
</tr>
<tr>
<td>Apple Mac OS X</td>
<td>✗ Not supported as server. ✔️ Supported as client platform.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application Servers</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Apache Tomcat</td>
<td>✔️ 5.5.20 - 6.0.x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Databases</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL</td>
<td>✔️ 8.3, 8.4, 9.0</td>
</tr>
<tr>
<td>MySQL (³)</td>
<td>✔️ 5.1, 5.5</td>
</tr>
<tr>
<td>Oracle</td>
<td>✔️ 11.1, 11.2</td>
</tr>
<tr>
<td>HSQLDB (⁴)</td>
<td>✔️ (for evaluation purposes only)</td>
</tr>
</tbody>
</table>
Web Browsers – Desktop

<table>
<thead>
<tr>
<th>Browser</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (Windows)</td>
<td>✔ 8, 9</td>
</tr>
<tr>
<td>Mozilla Firefox (all platforms)</td>
<td>✔ Latest stable version supported, ✔ Tested with 10</td>
</tr>
<tr>
<td>Google Chrome (Windows and Mac)</td>
<td>✔ Latest stable version supported, ✔ Tested with 17</td>
</tr>
<tr>
<td>Safari (Windows and Mac)</td>
<td>✔ Latest stable version supported, ✔ Tested with 5</td>
</tr>
</tbody>
</table>

Web Browsers – Mobile

<table>
<thead>
<tr>
<th>Browser</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mobile Safari (iOS)</td>
<td>✔ Latest stable version supported, ✔ Tested with iOS 5.1</td>
</tr>
</tbody>
</table>

1. Confluence is a pure Java application and should run on this platform provided the JRE or JDK requirement is satisfied.
2. While some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.
3. Ensure that you configure your Confluence MySQL database to use the InnoDB storage engine as the MyISAM storage engine could lead to data corruption.
4. Confluence ships with a built-in HSQL database. While this database is fine for evaluation purposes, it is somewhat susceptible to data loss during system crashes. Hence, for production environments, we recommend that you configure Confluence to use an external database.
5. Internet Explorer 8 and 9 do not support the drag-and-drop functionality of HTML5. As Confluence relies on this functionality, the drag-and-drop experience in Internet Explorer 8 and 9 is not complete.
6. Confluence is tested with these versions of Internet Explorer in standards-compliant rendering mode, not compatibility mode. Enabling compatibility mode may cause problems because it emulates older, unsupported rendering modes.
7. Chrome does not have WEBDAV / plugin support so features such as Edit in Word for attachments will not work. Please refer to CONF-23322 for information on the progress of the issue.
8. Confluence does not support editing in Mobile Safari on iOS devices (such as iPhone and iPad). Please refer to CONF-19524 for information on the progress of this issue.

End of Support Announcements for Confluence

This page contains announcements of the end of support for various platforms and browsers when used with Confluence. This is summarised in the table below. Please see the sections following for the full announcements.

End of Support Matrix for Confluence

The table below summarises information regarding the end of support announcements for upcoming Confluence releases. If a platform (version) has already reached its end of support date, it is not listed in the table.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Confluence End of Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 5.5.x</td>
<td>Confluence 5.0 (announcement)</td>
</tr>
<tr>
<td>Java 6</td>
<td>Confluence 5.0 (announcement)</td>
</tr>
</tbody>
</table>
Why is Atlassian ending support for these platforms?

Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are also committed to providing world class support for all the platforms our customers run our software on. However, as the complexity of our applications grows, the cost of supporting multiple platforms increases exponentially. Each new feature has to be tested on several combinations of application servers, databases, web browsers, etc, with setup and ongoing maintenance of automated tests. Moving forward, we want to reduce the time spent there to increase Confluence development speed significantly.

On this page (most recent announcements first):

- [Deprecated Tomcat platform for Confluence (29 August 2012)](EOLAnnouncementForTomcat5.5x_Support)
- [Deprecated Java platform for Confluence (6 August 2012)](EOLAnnouncementForJavaPlatforms)
- [Deprecated Databases for Confluence (1 May 2012)](EOLAnnouncementForDatabases)
- [Deprecated Databases for Confluence (13 March 2012)](EOLAnnouncementForDatabases)
- [Deprecated Operating Systems for Confluence (21 July 2011)](EOLAnnouncementForOperatingSystems)
- [Deprecated Databases for Confluence (7 January 2011)](EOLAnnouncementForDatabases)
- [Deprecated Web Browsers for Confluence (7 January 2011)](EOLAnnouncementForWebBrowsers)
- [Deprecated Databases for Confluence (12 October 2010)](EOLAnnouncementForDatabases)
- [Deprecated Web Browsers for Confluence (12 October 2010)](EOLAnnouncementForWebBrowsers)
- [Deprecated Databases for Confluence (6 July 2010)](EOLAnnouncementForDatabases)
- [Deprecated Web Browsers for Confluence (6 July 2010)](EOLAnnouncementForWebBrowsers)
- [Deprecated Databases for Confluence (24 March 2010)](EOLAnnouncementForDatabases)
- [Deprecated Application Servers for Confluence (27 January 2010)](EOLAnnouncementForApplicationServers)
- [Deprecated Java Platforms for Confluence (27 January 2010)](EOLAnnouncementForJavaPlatforms)
- [Deprecated Web Browsers for Confluence (14 December 2009)](EOLAnnouncementForWebBrowsers)

### Deprecated Tomcat platform for Confluence (29 August 2012)

This section announces the end of Atlassian support for Tomcat 5.5.x for Confluence. Please note: Apache has announced that support for Apache Tomcat 5.5.x will end on 30 September 2012: [End of life for Apache Tomcat](https://httpd.apache.org/lists/html/apr/2009/apr09-03.html).

End of support means that Atlassian will not fix bugs related to the specified version of Tomcat, past the support end date for your version of Confluence. The details are below. Please refer to the list of [supported platforms](https://www.atlassian.com/software/confluence/products#confluence-platforms) for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email [eol-announcement at atlassian dot com](mailto:eol-announcement@atlassian.com).

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 5.5.x</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

**Tomcat 5.5.x notes:**

- Confluence 4.3 is the last major version that will support Tomcat 5.5.x. The Confluence 4.3.x bug-fix releases will also continue to support Tomcat 5.5.x.
- Tomcat 6.0.x will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Tomcat 5.5.x. However, we will not fix bugs affecting Tomcat 5.5.x after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Tomcat 5.5.x.

**Deprecated Java platform for Confluence (6 August 2012)**

This section announces the end of Atlassian support for Java 6 for Confluence. Please note that Oracle has announced the end of public updates for Java 6: [Java SE 6 End of Public Updates Notice](#).

End of support means that Atlassian will not fix bugs related to the specified version of Java, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Java 6 Support**

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 6 (JRE and JDK 1.6)</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

**Java 6 notes:**

- Confluence 4.3 is the last major version that will support Java 6. The Confluence 4.3.x bug-fix releases will also continue to support Java 6.
- Java 7 (JRE and JDK 1.7) will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Java 6. However, we will not fix bugs affecting Java 6 after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Java 6.

**Deprecated Databases for Confluence (1 May 2012)**

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Database Support**

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 8.2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

**PostgreSQL 8.2 notes:**

- Confluence 4.2 is the last version that will support version 8.2 of PostgreSQL.
- Versions 8.3, 8.4 and 9.0 will still be supported in Confluence 4.3.
• Confluence 4.2 and previously-released versions will continue to work with PostgreSQL 8.2. However, we will not fix bugs affecting PostgreSQL 8.2 after the end-of-life date for your version of Confluence.
• Confluence 4.3 will not be tested with PostgreSQL 8.2.

Deprecated Databases for Confluence (13 March 2012)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

DB2 notes:
• Confluence 4.2 is the last version that will support DB2.
• From Confluence 4.3, no versions of DB2 will be supported.
• Confluence 4.2 and previously-released versions will continue to work with DB2. However, we will not fix bugs affecting DB2 after the end-of-life date for your version of Confluence.
• Confluence 4.3 will not be tested with DB2.
• For help with moving from DB2 to a supported database, please refer to the list of supported databases and the guide to migrating to another database.

Deprecated Operating Systems for Confluence (21 July 2011)

This section announces the end of Atlassian support for certain operating systems for Confluence. End of support means that Atlassian will not fix bugs related to running Confluence server on that operating system past the support end date.

We will stop supporting the following operating systems from Confluence 4.0, due in late 2011:
• Mac OS X (as a Confluence server platform).

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Operating System Support

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X (as a Confluence server platform)</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>
Mac OS X Notes:
- Atlassian intends to end support for Mac OS X (as a server platform) in Confluence 4.0 (due for release in late 2011). Confluence 3.5 is the last version that will support Mac OS X.
- The Sun/Oracle JDK/JRE 1.6 is the only JDK platform officially supported by Atlassian. This means that Apple Mac OS X is not a supported operating system for the Confluence server, as the Sun/Oracle JDK does not run on Mac OS X.
- Accessing Confluence as a user from Mac OS X via a compatible web browser will still be supported for the foreseeable future.

Deprecated Databases for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions** from Confluence 4.0, due in late 2011:
- MySQL 5.0.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL (version 5.0 only)</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>

MySQL Notes:
- Atlassian intends to end support for MySQL 5.0 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support MySQL 5.0.
- MySQL 5.1 will still be supported.
- ‘Support End Date’ means that Confluence 3.5 and previously released versions will continue to work with MySQL 5.0. However, we will not fix bugs affecting MySQL 5.0 past the support end date.
- Confluence 4.0 will not be tested with MySQL 5.0.

Deprecated Web Browsers for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will **stop supporting the following web browser versions** from Confluence 4.0, late middle of 2011:
- Microsoft Internet Explorer 7 (IE7).
- Safari 4.
- Firefox 3.5.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support
<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (version 7 only)</td>
<td>When Confluence 4.0 releases, late of the middle of 2011</td>
</tr>
<tr>
<td>Safari (version 4 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
<tr>
<td>Firefox (version 3.5 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
</tbody>
</table>

- **Internet Explorer Notes:**
  - Atlassian intends to end support for IE7 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support IE7.
  - IE8 will still be supported.
  - ‘Support End Date’ means that Confluence 3.5 and previously released versions will continue to work with IE7. However, we will not fix bugs affecting IE7 past the support end date.
  - Confluence 4.0 will not be tested with IE7.

- **Safari Notes:**
  - Atlassian will introduce support for Safari 5 in Confluence 3.5.
  - We intend to end support for Safari 4 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Safari 4.
  - ‘Support End Date’ means that Confluence 3.5 and previously released versions will continue to work with Safari 4. However, we will not fix bugs affecting Safari 4 past the support end date.
  - Confluence 4.0 will not be tested with Safari 4.

- **Firefox Notes:**
  - Atlassian will end support for Firefox 3.0 in Confluence 3.5, as previously announced.
  - We intend to end support for Firefox 3.5 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Firefox 3.5.
  - Firefox 3.6 will still be supported.
  - ‘Support End Date’ means that Confluence 3.5 and previously released versions will continue to work with Firefox 3.5. However, we will not fix bugs affecting Firefox 3.5 past the support end date.
  - Confluence 4.0 will not be tested with Firefox 3.5.

**Deprecated Databases for Confluence (12 October 2010)**

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions:

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support PostgreSQL 8.1. *Note, PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.*

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Database Support**

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL (version 8.1 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>
- **PostgreSQL (version 8.1 only) End of Support Notes:**
  - Atlassian intends to end support for PostgreSQL 8.1 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.
  - ‘Support End Date’ means that Confluence 3.4 and previous released versions will continue to work with the PostgreSQL 8.1. However, we will not fix bugs affecting PostgreSQL 8.1 past the support end date.
  - Confluence 3.5 (due to release in the first half of 2011) will not be tested with PostgreSQL 8.1.

**Deprecated Web Browsers for Confluence (12 October 2010)**

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will **stop supporting the following web browser versions:**

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support Firefox 3.0.
  
  Note, Firefox 3.5 and Firefox 3.6 will still be supported.

The details are below. Please refer to the **Supported Platforms** for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Web Browser Support**

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox (version 3.0 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>

- **Firefox (version 3.0 only) End of Support Notes:**
  - Atlassian intends to end support for Firefox 3.0 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. Firefox 3.5 and Firefox 3.6 will still be supported.
  - ‘Support End Date’ means that Confluence 3.4 and previous released versions will continue to work with Firefox 3.0. However, we will not fix bugs affecting Firefox 3.0 past the support end date.
  - Confluence 3.5 (due to release in the first half of 2011) will not be tested with Firefox 3.0.

**Deprecated Databases for Confluence (6 July 2010)**

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions:**

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Oracle 10g (i.e. Oracle 10.1 and Oracle 10.2).
  
  Note, Oracle 11g (i.e. Oracle 11.1 and Oracle 11.2) will still be supported.

We have made these decisions in line with Oracle's decision to stop support for Oracle 10g, as per the "Oracle Database (RDBMS) Releases Support Status Summary [ID 161818.1]" article on the Oracle Support site (note you will need an Oracle Support account to find and view the article). This also will reduce the testing time required for each release and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to Oracle 11g if needed.
The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle (version 10.1 and 10.2 only)</td>
<td>When Confluence 3.4 releases, due in the second half of 2010</td>
</tr>
</tbody>
</table>

- **Oracle (version 10.1 and 10.2 only) End of Support Notes:**
  - Atlassian intends to end support for Oracle 10.1 and Oracle 10.2 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Oracle 11.1 and Oracle 11.2 will still be supported.
  - ‘Support End Date’ means that Confluence 3.3 and previous released versions will continue to work with the Oracle 10.1 and Oracle 10.2. However, we will not fix bugs affecting Oracle 10.1 or Oracle 10.2 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Oracle 10.1 and Oracle 10.2.

### Deprecated Web Browsers for Confluence (6 July 2010)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will stop supporting the following web browser versions:

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Safari 3 or Safari 3.1.
  
  Note, Safari 4 will still be supported.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safari (version 3 and 3.1 only)</td>
<td>When Confluence 3.4 releases, due in the second half of 2010</td>
</tr>
</tbody>
</table>

- **Safari (version 3 and 3.1 only) End of Support Notes:**
  - Atlassian intends to end support for Safari 3 and Safari 3.1 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Safari 4 will still be supported.
  - ‘Support End Date’ means that Confluence 3.3 and previous released versions will continue to work with the Safari 3 and Safari 3.1. However, we will not fix bugs affecting Safari 3 and Safari 3 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Safari 3 and Safari 3.1.

### Deprecated Databases for Confluence (24 March 2010)
This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions:**

- From Confluence 3.3, due in Q3 2010, Confluence will no longer support DB2 8.2.
  
  *Note, DB2 9.7 will still be supported.*

We are reducing our database support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to DB2 9.7 if needed.

The details are below. Please refer to the [Supported Platforms](#) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 (version 8.2 only)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- **DB2 (version 8.2 only) End of Support Notes:**
  - Atlassian intends to end support for DB2 8.2 in Q3 2010, with the final support for these platforms in Confluence 3.2. DB2 9.7 will still be supported.
  - ‘Support End Date’ means that Confluence 3.2 and previous released versions will continue to work with the DB2 8.2. However, we will not fix bugs affecting DB2 8.2 past the support end date.
  - Confluence 3.3 (due to release in Q3 2010) will not be tested with DB2 8.2.

**Deprecated Application Servers for Confluence (27 January 2010)**

This section announces the end of Atlassian support for certain application servers for Confluence. End of support means that Atlassian will not fix bugs related to certain application servers past the support end date.

We will **stop supporting the following application servers:**

- From Confluence 3.2, due late Q1 2010, Confluence will no longer support JBoss application servers.
- From Confluence 3.3, due in Q3 2010, Confluence will no longer support Oracle WebLogic, IBM WebSphere or Caucho Resin.

We are reducing our application server platform support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in migrating to Tomcat, our supported application server.

The details are below. Please refer to the [Supported Platforms](#) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Application Server Support

<table>
<thead>
<tr>
<th>Application Servers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>JBoss 4.2.2</td>
<td>When Confluence 3.2 releases, due late Q1 2010</td>
</tr>
</tbody>
</table>
Oracle WebLogic 9.2 | When Confluence 3.3 releases, due Q3 2010
---|---
IBM WebSphere 6.1 | When Confluence 3.3 releases, due Q3 2010
Caicho Resin 3.0, 3.1.6, 3.1.7 | When Confluence 3.3 releases, due Q3 2010

- **JBoss End of Support Notes:**
  - 'Support End Date' means that Confluence 3.1 and previous released versions will continue to work with stated application servers. However, we will not fix bugs affecting JBoss application servers.
  - Confluence 3.2 will not support JBoss application servers.

- **WebLogic, WebSphere and Resin End of Support Notes:**
  - Atlassian intends to end support for Oracle WebLogic, IBM WebSphere, and Caicho Resin in Q3 2010, with the final support for these platforms in Confluence 3.2.
  - 'Support End Date' means that Confluence 3.2 and previous released versions will continue to work with the stated application servers. However, we will not fix bugs affecting Oracle WebLogic IBM WebSphere, and Caicho Resin application servers past the support end date.
  - Confluence 3.3 (due to release in Q3 2010) will only be tested with and support Tomcat 5.5.20+ and 6.0.
  - If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

**Why is Atlassian doing this?**

We have chosen to standardise on Tomcat, because it is the most widely used application server in our user population. It is fast, robust, secure, well-documented, easy to operate, open source, and has a huge community driving improvements. It is the de facto industry standard, with several companies available that specialise in providing enterprise grade support contracts for it, ranging from customisations to 24/7 support.

**Deprecated Java Platforms for Confluence (27 January 2010)**

This section announces the end of Atlassian support for certain Java Platforms for Confluence.

We will **stop supporting the following Java Platforms:**

- From Confluence 3.3, due Q3 2010, support for Java Platform 5 (JDK/JRE 1.5) will end.

We are ending support for Java Platform 5, in line with the [Java SE Support Roadmap](https://java.oracle.com/roadmap.html) (i.e. "End of Service Life for Java Platform 5 dated October 30, 2009). We are committed to helping our customers understand this decision and assist them in updating to Java Platform 6, our supported Java Platform.

The details are below. Please refer to the [Supported Platforms](https://confluence.atlassian.com/display/DOC/Supported+Platforms) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Java Platform Support**

<table>
<thead>
<tr>
<th>Java Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Platform 5 (JDK/JRE 1.5)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- **Java Platform 5 End of Support Notes:**
  - Atlassian intends to end support for Java Platform 5 in Q3 2010.
  - 'Support End Date' means that Confluence 3.2.x and previous released versions will continue to...
work with Java Platform 5 (JDK/JRE 1.5), however we will not fix bugs related to Java Platform 5 past the support end date.

- Confluence 3.3 will only be tested with and support Java Platform 6 (JDK/JRE 1.6).
- If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

Deprecated Web Browsers for Confluence (14 December 2009)

This section announces the end of Atlassian support for certain web browsers for Confluence.

We will stop supporting older versions of web browsers as follows:

- From Confluence 3.2, due late Q1 2010, support for Firefox 2 and Safari 2 will end.
- From 13 July 2010, in line with Microsoft's Support Lifecycle policy, support for IE6 will end.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browsers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox 2</td>
<td>When Confluence 3.2 releases, late Q1 2010</td>
</tr>
<tr>
<td>Safari 2</td>
<td>When Confluence 3.2 releases, late Q1 2010</td>
</tr>
<tr>
<td>Internet Explorer 6</td>
<td>When Confluence 3.3 releases (target Q3 2010) or 13 July 2010, whichever is sooner</td>
</tr>
</tbody>
</table>

- Firefox 2 and Safari 2 Notes:
  - Confluence 3.1 is the last version to officially support Firefox 2 and Safari 2.
  - You may be able to use these older browser for the most common use cases like viewing and editing content, but official support for these browsers will end once you upgrade to Confluence 3.2.
  - Confluence 3.2 is currently targeted to release late Q1 2010 and will not be tested with Firefox 2 and Safari 2. After the Confluence 3.2 release, Atlassian will not provide fixes in older versions of Confluence for bugs affecting Firefox 2 and Safari 2.

- Internet Explorer 6 Notes:
  - Confluence 3.2 (due late Q1 2010) will be the last version to officially support Internet Explorer 6.
  - Confluence 3.3 is currently targeted to release Q3 2010 and will not support IE6.
  - Atlassian will support IE6 in Confluence until the 13th of July 2010, in line with Microsoft's Support Lifecycle policy. Beyond that date, released versions of Confluence will continue working with IE6 just as they did before, but we will not fix bugs affecting Internet Explorer 6.
  - You may be able to use Internet Explorer 6 for the most common use cases like viewing and editing content, but official support for this browser will end once you upgrade to Confluence 3.3.

Supported Platforms FAQ

Q: How does Atlassian choose which JRE versions, application servers and databases to support?

For application servers and databases, we try to pick a good cross-section of open source options and popular commercial platforms. We then choose which JRE versions to support based on the recommended environments for these servers.
Q: What is a supported platform?

A supported platform is one that:

- Confluence is regularly tested on during the development cycle
- One that is available within Atlassian for support technicians and developers to reproduce problems
- Bugs raised against it will be given a high priority

Supporting a platform means we know how to get Confluence running in that environment and can troubleshoot Confluence issues within it. It does not mean we have any particular expertise beyond that. As such, we may not be able to provide assistance with customising or tuning that application server or database. (Atlassian support is not a substitute for a good database administrator.)

Q: Can I get assistance with running Confluence on a platform that is not supported?

If you are running Confluence on an unsupported platform, then we can not guarantee providing any support for it. Furthermore, we will recommend that you switch to a platform which is supported.

Q: If you write your application to standards like J2EE, JDBC and SQL, doesn’t that mean it should run on any compliant server?

Confluence is a complicated application and we commonly encounter interesting edge-cases where different servers have interpreted the specifications differently. Then again, each server has its own different collection of bugs.

Q: How can I get Atlassian to support Confluence on a new platform?

Supporting a new platform involves a significant investment of time by Atlassian, both up-front costs to set up new testing environments and fix any issues we might encounter and the ongoing costs involved in maintaining the application against this new environment in the future. As such, supporting a new platform is not something we will do unless we know there is significant demand for it.

Please be aware that your interest alone will not be enough for us to add support for your application server or database. We would need to see a significant number of votes on the issue raised in our public JIRA site or a significant level of interest in our forums, before considering supporting that platform.

Q: My organisation has standardised on an operating environment that Confluence does not support. What can I do?

In this situation, you have the following two options:

1. Run Confluence in the unsupported environment, with the caveats mentioned above.
2. Make an exception to your standardised operating environment and set up Confluence based on its supported platforms.

Migrating Confluence Between Servers

This page describes how to move Confluence between physical servers. It is distinct from other functions. It does not cover database migration, application server migration, or upgrading. Atlassian suggests doing each of these steps separately. See also:

- [Upgrading Confluence](#)
- [Migrate to Another Database](#)
- [Switching to Apache Tomcat](#)

How to Create a Test or Development Site

Administrators may need to move a Confluence site from one server to another for upgrades or downtime. This page tells you how to copy a Confluence site from one server to another. For example, you may want to transfer your current production snapshot to a test server as permitted in the licence agreement.
Avoid upgrades while migrating. If you are planning to switch databases, application servers or Confluence versions, firstly perform the application transfer in isolation, and test that it was successful before making other changes.

Development licenses are available for any Commercial or Academic license. Create one or contact Atlassian for help.

On this page:

- How to Create a Test or Development Site
- Transferring Confluence To Another Server Using The Same Operating System
- Transferring Confluence To Another Server Using a Different Operating System
- Ensuring no contact with production systems
- Migrating from HTTPS to HTTP
- Notes

The information on this page does not apply to Confluence OnDemand.

Transferring Confluence To Another Server Using The Same Operating System

If the operating systems on both servers are the same, then the home and install folders can be copied straight into an identical external database and user management setup.

1. On the original server, create zips of the Confluence install and home directories. Copy the zips to the new server.
2. On the new server, unzip the install and home directories. Windows users should avoid unzipping with the Windows built-in extractor, instead use Winzip or the free 7Zip.

If you are changing the location of the home directory, open the Confluence install\confluence\WEB-INF\classes directory and edit confluence-init.properties by changing the line starting with 'confluence.home='.

Modify the location of your war file if need be. If using Tomcat, this is likely in /Conf/Catalina/localhost. You'll want to make sure the docbase attribute is pointing to the right location.

This next step is dependent on your database:

a. Database configuration:
   i. For users of the internal database, the database content is stored inside the home directory. You should switch to an external database after the transfer is successful.
   ii. For external databases stored on another server: change the user account or datasource permissions so that the new server has the same network access permissions as the original. Then confirm from the new server that the hostname can be resolved and is listening for database connections on the expected port.
   iii. For external databases hosted locally (ie. localhost): on the original server, create a manual database backup using a native db dump backup tool. Copy the database backup to the new server.

b. On the new server, install or upgrade the database version to match the original server.
c. Import the database backup.
d. Add a database user account with the same username and password as the original.
e. Provide the user with the full access to the imported database.
f. Use a database administration tool to confirm that the user can login from the localhost.
g. To modify any database connection information, go to the Confluence home directory and edit confluence.cfg.xml. The connection URL is set under hibernate.connection.url. Ensure it does not
point to your production database server.

h. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration, provide the new server with network or local access to the same hosts as the original. If this is a true test site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change the server.xml or atlassian-user.xml files to point to the appropriate test servers. Note that it might be acceptable to use a production connection here, as users won’t be logging on to the test system in high volume.

i. If appropriate, make sure no emails are sent out from the test system.

j. Start Confluence.

k. Go to Administration > License Details and add your development license key. You can generate one at http://my.atlassian.com. There are more details in How Can I Get a License for a Staging Environment?

l. If you configured Confluence as a Windows service, repeat those instructions.

m. Add your development license key.

5. Some customers have experienced problems with Confluence’s search functions after performing a migration, or that the content of their [recently-updated] macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you perform a rebuild of your content indices after performing a migration.

Transferring Confluence To Another Server Using a Different Operating System

Migrating from Windows to Linux

You will need to replace the backslash with forward slash in the following lines in confluence.cfg.xml:

```xml
<property
  name="attachments.dir">${confluenceHome}/attachments</property>
<property name="lucene.index.dir">${confluenceHome}/index</property>
<property
  name="webwork.multipart.saveDir">${confluenceHome}/temp</property>
```

Using database tools (preferred option)

If you are using the Production backup strategy, follow these steps:

1. Download the proper distribution (the same one you have from your original site) from the Download Archive.
2. Copy your Confluence home (not install) directory from your original server (even if it was a different OS).
3. If you are changing the location of the home directory, open the Confluence install\confluence\WEB-INF\classes directory and edit confluence-init.properties by changing the line starting with 'confluence.home='.
4. For external databases stored locally, on the original server, create a manual database backup using a native db dump backup tool.
5. Copy the database backup to the new server.
6. On the new server, install or upgrade the database version to match the original server.
7. Import the database backup.
8. Add a database user account with the same username and password as the original.
9. Provide the user with the full access to the imported database.
10. Use a database administration tool to confirm that the user can login from the localhost.
11. To modify any database connection information, go to the Confluence home directory and edit confluence.cfg.xml. The connection URL is set under hibernate.connection.url. Ensure it does not point to your production database server.
12. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration, provide the new server with network or local access to the same hosts as the original.
13. Copy server.xml, atlassian-user.xml, osuser.xml, any patches, and any other customized files velocity or
properties files. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration, provide the new server with network or local access to the same hosts as the original. If this is a true test site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change the server.xml or atlassian-user.xml files to point to the appropriate test servers. Note that it might be acceptable to use a production connection here, as users won’t be logging on to the test system in high volume.

14. If appropriate, make sure no emails are sent out from the test system.
15. Start Confluence.
16. Go to Administration > License Details and add your development license key. You can generate one at http://my.atlassian.com. There are more details in How Can I Get a License for a Staging Environment?

17. If you configured Confluence as a Windows service, repeat those instructions.
18. Add your development license key.
19. Some customers have experienced problems with Confluence’s search functions after performing a migration, or that the content of their {recently-updated} macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you perform a rebuild of your content indices after performing a migration.

Using XML data backups (only for small to medium sized installations)

Note: The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

If you're not yet using the Production backup strategy, you can migrate Confluence to a different server machine by creating an XML data backup as usual, and then importing that to Confluence on the new server.

1. Create an XML data backup from Confluence as follows:
   a. Choose Browse > Confluence Admin.
   b. Select Backup & Restore.
   c. Check the Backup Attachments option and click Backup.
2. Identify the version of Confluence that you are currently using. This is displayed at the bottom of each Confluence page.
3. Download Confluence to the new server. Get the version of Confluence that you identified above, but for the operating system of the new server. You may be using either the latest Confluence version, or an older version.
4. Install Confluence on the new server.
5. Go to Administration > License Details and add your development license key. You can generate a license at http://my.atlassian.com. You can find more details in How Can I Get a License for a Staging Environment?
6. Restore your XML data backup from Administration > Backup and Restore.
7. If appropriate, make sure that no email contact can be made with the test system.
8. Some customers have experienced problems with Confluence’s search functions after performing a migration, or that the content of their {recently-updated} macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you rebuild your content indices after performing a migration.

Ensuring no contact with production systems

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:
2. Disable space-level mail archiving by running the following database query:

```
SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.space.mailaccounts';
```

Change 'SELECT' to 'DELETE' in the above queries once you are sure you want to remove the specified accounts.

Once this is done, you can start your test site without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, JIRA macro, etc.). If these write content, or create unwanted load on external systems, they should be disabled promptly after starting the test site.

### Migrating from HTTPS to HTTP

You may want to migrate from a server secured by SSL to one which is not secured by SSL. For example, this may be useful if you are copying a Confluence site from a production to a test site.

To migrate from HTTPS to HTTP, undo the HTTPS-specific settings that are described on this page: Adding SSL for Secure Logins and Page Security.

### Notes

- Ricky Sheaves ([calebscreek](#)) has written an interesting blog post on Moving Confluence from Windows to (Ubuntu) Linux.
- If you wish to merge two Confluence sites, you can consider using the [remote import plugin](#). This plugin is currently not supported. The supported method would be to export a space and then import each space one by one. The two Confluence sites must be running the same version of Confluence.

### Migrating from Confluence OnDemand to a Confluence Installed Site

This page is for people who are currently using a Confluence OnDemand site, and wish to move to a Confluence site that is hosted on their own servers.

#### Summary

You will need to download and install a special [OnDemand release](#) of Confluence (for example, ‘Confluence 5.0-OD-1’) and then move your data from your hosted Confluence OnDemand site into your newly installed site. You cannot move your data from Confluence OnDemand to a site installed from the standard Confluence download.

#### Instructions

**Note:** You must do the data export and the Confluence download (both described in the steps below) **on the same day**. This will ensure that your data and your Confluence installation are of the same version and are therefore compatible.

**To migrate from Confluence OnDemand to a Confluence installed site:**

1. Export the data from your Confluence OnDemand site, using the Confluence backup manager.
   - For instructions, see this page in the Confluence OnDemand documentation: Exporting wiki data.
   - You now have a backup file, also called an XML export, of your Confluence OnDemand data.
2. Download the OnDemand release of Confluence. Go to the [Confluence OnDemand download page](https://confluence.atlassian.com/confluenceondemand-manual-upgrade-1201382506.html) and get the latest 'OD' release for your operating system. The latest downloads are at the top of the list. For example, get the following files, replacing 'x' with the latest number available:

- **For Windows 64-bit**: Get '5.0-OD-x - Windows Installer (64 bit)'
- **For Windows 32-bit**: Get '5.0-OD-x - Windows Installer (32 bit)'
- **For Linux 64-bit**: Get '5.0-OD-x - Linux Installer (64 bit)'
- **For Linux 32-bit**: Get '5.0-OD-x - Linux Installer (32 bit)'
- To install Confluence from an archive on UNIX or Mac OS X: Get '5.0-OD-x - Standalone (TAR.GZ Archive)'
- To install Confluence from an archive on Windows: Get '5.0-OD-1 - Standalone (ZIP Archive)'
- EAR/WAR archives are also available.

3. Install Confluence as described in the [Confluence Installation Guide](https://confluence.atlassian.com/confluenceinstallguide-1003538173.html).

4. Import the data from your backup file (XML export) into your new Confluence installation. See [Restoring a Site](https://confluence.atlassian.com/confluenceondemand-manual-upgrade-1201382506.html).

5. Log in to your new Confluence site, using the following credentials:

- **Username**: sysadmin
- **Password**: sysadmin

6. Change the password immediately after logging in.

---

**Background**

Backups taken from Confluence OnDemand are only compatible with the current OnDemand release (for example, 'Confluence 5.0-OD-1'). The reason is that Confluence OnDemand is typically ahead of the downloadable version of Confluence, meaning that you will have new features in Confluence OnDemand that are not yet available in the downloadable version.

It is therefore not possible to migrate your data to a Confluence site installed from the standard Confluence download. You will need to download and install the special OnDemand release of Confluence (for example, 'Confluence 5.0-OD-1') as described above.

The advantage is that you will be able to keep the Confluence OnDemand features currently not available to other customers who are using the standard downloadable version of Confluence. However, there are a few major limitations as noted below.

**Support, limitations, and recommendations**

Please note the following points about your Confluence site installed from an OnDemand release.

**Upgrade required as soon as full release is available**

Atlassian Support will support your newly installed Confluence site, running the OnDemand release, until the full Confluence release is available.
For example, if your OnDemand release is ‘Confluence 5.0-OD-1’, then we will support it until Confluence 5.0 is released.

When the full version is released, you will need to upgrade to the full release in order to continue to receive support.

**Compatibility of third-party plugins**

Because Confluence OnDemand is typically ahead of the downloadable version of Confluence, most third-party plugins will not be compatible with the OnDemand release. You may have some problems with third-party plugins on your Confluence site, until you are able to upgrade to the full release. Note, however, that any third-party plugins that you were using in Confluence OnDemand should be compatible with your newly installed site too.

If you have any questions about the compatibility of third-party plugins with your OnDemand release, please contact the plugin vendors. Contact details are on the [Atlassian Marketplace](https://marketplace.atlassian.com).

**PostgreSQL database recommended**

If you are uncertain about which database to choose for your Confluence site, we recommend PostgreSQL. See [Database Setup for PostgreSQL](https://confluence.atlassian.com/display/DEV/Database+Setup+for+PostgreSQL). The Confluence OnDemand site runs on PostgreSQL, and we therefore know it to be compatible with your OnDemand release.

If you decide to choose another supported database and discover any problems with compatibility, please contact [Atlassian Support](https://confluence.atlassian.com/display/DEV/Atlassian+Support). For a list of supported databases, see [Supported Platforms](https://confluence.atlassian.com/display/DEV/Supported+Platforms).

**Confluence license**

Your Atlassian OnDemand license cannot be used in a site installed from the downloadable version of Confluence. Please get your new Confluence license at [https://my.atlassian.com](https://my.atlassian.com).

**Confluence Release Notes**

Welcome to this page about all production releases of Confluence wiki. The release notes give up-to-date information about the improvements made in each release. If you are upgrading from an earlier version of Confluence, you will find essential information in the upgrade notes associated with the relevant release notes.

**Latest major release: Confluence 4.3**

With great pleasure, Atlassian presents **Confluence 4.3**. Keep up with what's happening, rediscover your team's focus, and take action faster – even while on the go!

Read the [full release notes](https://confluence.atlassian.com/display/DEV/Confluence+4.3+Release+Notes).

---

**Related pages:**

- [Confluence Development Releases](https://confluence.atlassian.com/display/DEV/Confluence+Development+Releases)
- [Confluence Documentation Home](https://confluence.atlassian.com/display/DEV/Confluence+Documentation+Home)

---

**Summary of major releases**

Looking for a list of highlights in the major Confluence releases? See the [Confluence Release Summary](https://confluence.atlassian.com/display/DEV/Confluence+Release+Summary).

**All release notes**

**Confluence 4.3**

- [Confluence 4.3 Release Notes](https://confluence.atlassian.com/display/DEV/Confluence+4.3+Release+Notes)
Confluence 4.2
- Confluence 4.2.13 Release Notes
- Confluence 4.2.12 Release Notes
- Confluence 4.2.11 Release Notes
- (Confluence 4.2.9 and 4.2.10 were internal releases)
- Confluence 4.2.8 Release Notes
- Confluence 4.2.7 Release Notes
- Confluence 4.2.6 Release Notes
- Confluence 4.2.5 Release Notes
- Confluence 4.2.4 Release Notes
- Confluence 4.2.3 Release Notes
- Confluence 4.2.2 Release Notes
- Confluence 4.2.1 Release Notes
- Confluence 4.2 Release Notes

Confluence 4.1
- Confluence 4.1.9 Release Notes
- (Confluence 4.1.8 was an internal release)
- Confluence 4.1.7 Release Notes
- Confluence 4.1.6 Release Notes
- Confluence 4.1.5 Release Notes
- Confluence 4.1.4 Release Notes
- Confluence 4.1.3 Release Notes
- Confluence 4.1.2 Release Notes
- (Confluence 4.1.1 was an internal release)
- Confluence 4.1 Release Notes

Confluence 4.0
- Confluence 4.0 Release Notes

Confluence 3.5
- Confluence 3.5.17 Release Notes
- Confluence 3.5.16 Release Notes
- Confluence 3.5.13 Release Notes
- (Confluence 3.5.12 was an internal release)
- Confluence 3.5.11 Release Notes
- (Confluence 3.5.10 was an internal release)
- Confluence 3.5.9 Release Notes
- (Confluence 3.5.8 was an internal release)
- Confluence 3.5.7 Release Notes
- Confluence 3.5.6 Release Notes
- Confluence 3.5.5 Release Notes
- Confluence 3.5.4 Release Notes
- Confluence 3.5.3 Release Notes
- Confluence 3.5.2 Release Notes
- Confluence 3.5.1 Release Notes
- Confluence 3.5 Release Notes

Confluence 3.4
- Confluence 3.4.9 Release Notes
- Confluence 3.4.8 Release Notes
- Confluence 3.4.7 Release Notes
- Confluence 3.4.6 Release Notes
- Confluence 3.4.5 Release Notes
- (Confluence 3.4.4 was an internal release)
Confluence 3.3
- Confluence 3.3.3 Release Notes
- (Confluence 3.3.2 was an internal release)
- Confluence 3.3.1 Release Notes
- Confluence 3.3 Release Notes

Confluence 3.2
- Confluence 3.2.1 Release Notes
- Confluence 3.2 Release Notes

Confluence 3.1
- Confluence 3.1.2 Release Notes
- Confluence 3.1.1 Release Notes
- Confluence 3.1 Release Notes

Confluence 3.0
- Confluence 3.0.2 Release Notes
- Confluence 3.0.1 Release Notes
- Confluence 3.0 Release Notes

Confluence 2.10
- Confluence 2.10.4 Release Notes
- Confluence 2.10.3 Release Notes
- Confluence 2.10.2 Release Notes
- Confluence 2.10.1 Release Notes
- Confluence 2.10 Release Notes

Confluence 2.9
- Confluence 2.9.3 Release Notes
- Confluence 2.9.2 Release Notes
- Confluence 2.9.1 Release Notes
- Confluence 2.9 Release Notes

Confluence 2.8
- Confluence 2.8.3 Release Notes
- Confluence 2.8.2 Release Notes
- Confluence 2.8.1 Release Notes
- Confluence 2.8 Release Notes
- Confluence 2.8 Beta Release Notes

Confluence 2.7
- Confluence 2.7.4 Release Notes
- Confluence 2.7.3 Release Notes
- Confluence 2.7.2 Release Notes
- Confluence 2.7.1 Release Notes
- Confluence 2.7 Release Notes

Confluence 2.6
- Confluence 2.6.3 Release Notes
- Confluence 2.6.2 Release Notes
- Confluence 2.6.1 Release Notes
- Confluence 2.6 Release Notes

Confluence 2.5
- Release Notes 2.5.8
- Release Notes 2.5.7
- Release Notes 2.5.6
- Release Notes 2.5.5
- Release Notes 2.5.4
- Release Notes 2.5.3
- Release Notes 2.5.2
- Release Notes 2.5.1
- Release Notes 2.5

Confluence 2.4
- Release Notes 2.4.5
- Release Notes 2.4.4
- Release Notes 2.4.3
- Release Notes 2.4.2

Confluence 2.3
- Release Notes 2.3.3
- Release Notes 2.3.2
- Release Notes 2.3.1
- Release Notes 2.3

Confluence 2.2
- Release Notes 2.2.10
- Release Notes 2.2.9
- Release Notes 2.2.8
- Release Notes 2.2.7
- Release Notes 2.2.6a
- Release Notes 2.2.5
- Release Notes 2.2.4
- Release Notes 2.2.3
- Release Notes 2.2.2
- Release Notes 2.2.1
- Release Notes 2.2

Confluence 2.1
- Release Notes 2.1.5
- Release Notes 2.1.4
- Release Notes 2.1.3
- Release Notes 2.1.2
- Release Notes 2.1.1
- Release Notes 2.1

Confluence 2.0
- Release Notes 2.0.3
- Release Notes 2.0.2
- Release Notes 2.0.1
- Release Notes 2.0

Confluence 1.4
Notes

How to find a list of known issues

To find a list of known issues in a particular Confluence version, you can create a filter in the Atlassian issue tracker and use the permalink located at the top right of the issue tracker's page to access the filtered report. The following example filter is the list of bugs reported for Confluence 4.3 and now fixed:

https://jira.atlassian.com/secure/IssueNavigator.jspa?reset=true&jqlQuery=project +%3D+CONF+AND+issuetype+%3D+Bug+AND+affectedVersion+%3D+%224.3%22+AND+resolution+ +%3D+Fixed

Read the JIRA documentation on creating filters.

Confluence Release Summary

This page shows the highlights of the major Confluence releases.

Current Release

For information about the latest release, please go to the Confluence Release Notes.
Confluence 4.3 — 4 September 2012

- Workbox notifications
- Personal tasks
- Tasks on pages
- Confluence mobile
- Table sorting and highlighting
- Draggable images and macros
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Default space permissions
- More in the Confluence 4.3 Release Notes

Confluence 4.2 — 10 April 2012

- Page layouts
- Likes
- Quick comments
- Popular content on the dashboard
- Recommended content by email
- Labels on attachments
- Signup invitations via URL
- Easy upgrade, try and buy for plugins
- More in the Confluence 4.2 Release Notes

Confluence 4.1 — 13 December 2011

- Autoconvert for Pasted Links
- Image effects
- Quick find and replace
- Follow Your Network On the Dashboard
- Space attachments macro
- Global PDF stylesheets
- Use any character in page titles
- New translation feature
- More in the release notes

Confluence 4.0 — 19 September 2011

- Brand New Editor
- Simplified Editing Experience
- New Macros
- Faster Editing Experience
- Introducing @mentions
- Improved Page Comparison Functionality
- Email Notification Improvements
- New Confluence Installer and Guided Upgrades
- New Editor Plugin Points for Developers
- More in the release notes

Confluence 3.5 — 16 March 2011

- Easy, Powerful Connections to Active Directory, LDAP and Crowd
- Improved JIRA Integration
- Drag-and-Drop for HTML5 Browsers
- Autowatch and Improved Notification Settings
- Sharing Pages and Blog Posts
- Enhanced Code Macro
- More Administrative Improvements
Confluence 3.4 — 12 October 2010

- New Keyboard Shortcuts, Mac-Friendly Too
- Keyboard Shortcut Dialog
- User Macros in Macro Browser and Autocomplete
- New Plugin Manager
- Improved Performance
- Infrastructure Changes
- More in the release notes

Confluence 3.3 — 7 July 2010

- Confluence Page Gadget
- Autocomplete for Inserting Macros
- Property Panels for Links
- Property Panels for Images
- Manage Watchers
- Email Notifications for Network Activity and Blogs
- Blog Improvements
- Context-Sensitive Help Links
- Security Features
- Infrastructure Changes
- More in the release notes

Confluence 3.2 — 24 March 2010

- Autocomplete for Inserting Links
- Autocomplete for Embedding Images and Documents
- A Link Browser that's Smarter, Smoother, Faster
- New Documentation Theme
- New Easy Reader Theme
- Template Bundles
- Reordering while Moving a Page
- New Keyboard Shortcuts and Editor Hints
- User Interface Enhancements
- More in the release notes

Confluence 3.1 — 8 December 2009

- Introducing Gadgets
- Drag-and-Drop
- Office 2007 Support
- New 'Move Page' Feature
- Enhanced Image Browser
- Draft Comparisons
- Page Restrictions Dialog Box
- Other Editor Enhancements
- New Web Browser Versions Supported
- More in the release notes

Confluence 3.0 — 1 June 2009

- Introducing the Macro Browser
- Enhanced User Profiles
• Introducing Your Network
• New User Status
• New Hover Profile Feature
• Customisable Enhanced PDF Exports
• Improved Rich Text Editor
• Performance Improvements
• Engine Room and Developer Community
• Administration Improvements
• More in the release notes

Confluence 2.10 — 3 December 2008
• Introducing the Widget Connector
• Improved Office Connector Now Bundled
• Introducing Quick Navigation
• ‘Did You Mean’, OpenSearch and More
• Custom Stylesheets for Confluence Spaces
• Updated JIRA Issues Macro with Custom Fields and Dynamic Display
• Enhanced User and Group Management
• Upgraded Rich Text Editor
• Universal Wiki Converter now with SharePoint Import and More
• Improved Activity Macros
• Plugin Framework 2
• More in the release notes

Confluence 2.9 — 7 August 2008
• Streamlined Search
• Auto Save
• Charts
• Page Tree
• Gallery
• New Tutorial
• More in the Menus
• Alphabetical Page Ordering
• Better Spam Prevention
• Plugin Repository
• Engine Room and Developers’ Community
• More in the release notes

Confluence 2.8 — 10 April 2008
• Dynamic menus and simplified screen design
• Page ordering
• Collapsible comments
• Multiple-label filter
• Confluence installer
• Task list
• Performance enhancements
• Administration, management and monitoring
• More in the release notes

Confluence 2.7 — 12 December 2007
• JIRA Issues and Portlet macros use new trusted authentication
• Two-tier administrator permissions
• Inserting images and attaching files during page creation
• Sorting of images in Gallery macro
• Simplified and improved logging
• Performance, maintainability and administration
• More in the release notes

Confluence 2.6 — 27 September 2007
• Fresh look for the Default theme
• Personalised comments and Dashboard
• Space description on Dashboard
• Labels on templates
• Default content for space home pages
• Social Bookmarking plugin now bundled with Confluence
• Back-dating and renaming news items
• More in the release notes

Confluence 2.5 — 29 April 2007
• Introducing flexible page restrictions
• Dynamic task list JRE incompatibilities
• contentbylabel macro supports AND condition
• More in the release notes

Confluence 2.4 — 14 March 2007
• Editable comments
• Page mailing
• More in the release notes

Confluence 2.3 — 5 January 2007
• Confluence Massive — cluster support
• People directory
• Activity plugin — usage statistics
• Blogging RPC plugin — manage news in Confluence using blogger-compatible desktop clients
• WebDAV client support via WebDAV plugin — create, edit, move pages, attachments, etc via WebDAV
• More in the release notes

Confluence 2.2 — 27 April 2006
• Personal spaces
• Localisation/internationalisation — drop-in language packs (similar to JIRA)
• CAPTCHA support — spam protection
• Improved searching
• Improved LDAP performance
• Confluence ships with Tomcat 5.5
• More in the release notes

Confluence 2.1 — 20 December 2005
• Autosave
• Concurrent edit warnings
• LDAP integration with Atlassian User/POLIS
• More in the release notes

Confluence 2.0 — 17 November 2005
• Rich Text Editing — WYSIWYG editor
• Labels
• Dashboard tabs — All, My, Team, New
• RSS builder
• Export pages as Word documents
• Copy pages
Confluence 1.4 — 23 May 2005
- New user interface
- Enhanced editing — doing more in the edit interface
- Page permissions
- New plugin types
- Configurable themes
- Completely rewritten Wiki to HTML conversion engine
- More in the release notes

Confluence 1.3 — 30 November 2004
- Mail archiving
- Themes
- Trash can
- More granular space permissions
- More in the release notes

Confluence 1.2 — 23 August 2004
- Page list views — alphabetical, directory view and search view of all pages in a space
- Image thumbnails and thumbnail galleries
- Threaded comments
- Enhanced Search - indexing attachment comments and file names and contextual searching
- New permissions interface
- More in the release notes

Confluence Release Cycle

New versions of Confluence are released frequently. Our goals are to:

- Make bug-fixes available to customers sooner
- Give interested customers early access to new features and API changes
- Make Confluence major releases predictable

Feature Releases

We aim to release new versions of Confluence every three to four months. These releases will contain the bulk of new functionality.

Feature releases are numbered by incrementing Confluence's minor version number, so the move from Confluence 2.0 to 2.1 and 2.1 to 2.2 both introduced significant new features to the product. Occasionally we may change to a whole new major version number (Confluence 2.0 was originally slated to be released as 1.5), but that is mostly done for marketing purposes, and shouldn't be considered to have any practical meaning.

Feature releases may not be API-compatible with the previous release. This means that you should test RPC clients, macros and plugins before running them on a newer version of Confluence.

You can find the time line history of our major releases at the downloads archive.

Bug-Fix Releases

Confluence bug-fix releases are scheduled every three to four weeks, depending on the number and urgency of the bugs that have been fixed during that particular development cycle. We aim to minimise the time between a bug being reported and a fix being available, without either us or our customers having to manage clumsy sets of manual patches.

Bug-fix releases will contain mostly bug-fixes, plus the occasional minor new feature or enhancement. Enhancements will be limited, however, as the main aim of these point releases is to improve stability, and make
no significant API changes.

Bug-fix releases are numbered by incrementing the patch-level. So the first bug-fix release after Confluence 2.2 is 2.2.1, followed by 2.2.2. Occasionally, we will re-issue a bug-fix release because something was faulty with the original download. In that case we will create a “re-issue” release number, for example 2.1.5a or 2.2.1a.

Obviously, we don’t expect anyone to upgrade Confluence every two weeks, administrators should keep their own schedule, based on how much of an inconvenience is being caused by any bugs that may have been fixed since. Sometimes, however, a security issue or serious application bug will arise that we feel it is in everyone’s best interests to fix as soon as possible. In such cases, we will recommend in the Confluence Release Notes that all customers upgrade to the latest version.

**Milestone Releases**

Occasionally, when possible, we will release preview “milestone releases” of the next major Confluence version. How often and when we do so depends on the particulars of the current development cycle. In situations where we are working on a number of disparate features we may be able to do a number of progressive development releases, whereas in iterations where we are making significant changes to the Confluence internals, we may not have anything suitable for public consumption until quite late in the release cycle.

Milestone releases will be announced in the developer release notes. Milestone releases are published for testing plugins and early feedback about our work, please don’t use them on production systems.

The version number of a milestone release will be the version number of the next major release, suffixed with -m. So Confluence 2.3-m1 will be followed by 2.3-m2, and so on until the ultimate release of the finished Confluence 2.3.

**Upgrade Notes Overview**

Typically, each major release of Confluence comes with upgrade notes, which are specific recommendations for upgrading from the previous major version. If you plan to upgrade and skip a few Confluence versions, you must read the upgrade notes for all major versions between your current version and the version to which you are upgrading, to make sure you do not miss something important.

Please read our general information about upgrading Confluence.

**For example:**

When upgrading from Confluence 3.4 to Confluence 4.0, read the upgrade notes for Confluence 3.5, as well as those for Confluence 4.0.

Also, we strongly recommend that you read the upgrade notes for any minor releases in-between, since they contain important information that will affect your Confluence upgrade.

**Below is a list of upgrade notes for previous major releases of Confluence, as well as the upgrade notes for important minor releases:**

- [Confluence 4.3 Upgrade Notes](#)
- [Confluence 4.2 Upgrade Notes](#)
- [Confluence 4.1 Upgrade Notes](#)
- [Confluence 4.0 Upgrade Notes](#)
- [Confluence 3.5 Upgrade Notes](#)
- [Confluence 3.4 Upgrade Notes](#)
- [Confluence 3.3 Upgrade Notes](#)
- [Confluence 3.2 Upgrade Notes](#)
- [Confluence 3.1 Upgrade Notes](#)
Confluence 4.3 Documentation

- Confluence 3.0.1 Upgrade Notes
- Confluence 3.0 Upgrade Notes
- Confluence 2.10 Upgrade Notes
- Confluence 2.9 Upgrade Notes
- Confluence 2.8 Upgrade Notes
- Confluence 2.7 Upgrade Notes
- Confluence 2.6 Upgrade Notes

You will find the upgrade notes attached to the release notes for the relevant version.

Useful plugins

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

RELATED TOPICS

- Confluence Release Summary
- Confluence Release Notes

Confluence 4.3 Release Notes

4 September 2012

With great pleasure, Atlassian presents Confluence 4.3. Keep up with what's happening, rediscover your team focus, and take action faster – even while on the go!

Highlights of Confluence 4.3

- Workbox notifications
- Personal tasks
- Tasks on pages
- Confluence mobile
- Table sorting and highlighting
- Draggable images and macros
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Default space permissions
- Other improvements
- Infrastructure changes

More

- Read the upgrade notes for important information about this release.
- See the full list of issues resolved in this release.

Thank you for your feedback

⭐ Over 20 feature and improvement requests fulfilled
⭐ More than 960 votes satisfied

Video of what's new
Workbox notifications

The new Confluence workbox collects your notifications from page watches, shares and mentions. Use the inline actions to comment on, like, or watch a page. More...

Do you want to mark a notification for later attention? Add it to your task list and come back to it later.
Personal tasks

As part of your workbox, you can now create and manage all your tasks in Confluence: personal tasks, tasks from notifications, and tasks assigned to you on Confluence pages. Plan your day’s work, drag your tasks into order of priority, make notes, and mark your tasks as complete – all in one place. More...

Tasks on pages

It’s now really simple to track your team’s tasks on a page: project tasks, meeting action items, checklists, and whatever takes your fancy.

1. **Create task lists**
   Choose the new task icon in the editor to add a task list.

2. **Assign tasks using mentions**
   You can @mention a user within a task to assign it to that person. The task will appear in the user’s personal task list.

3. **Notify assignees**
   Users receive a notification when a task has been assigned to them. In addition, page watchers will be notified when tasks in a page are marked as complete.

4. **Track tasks from anywhere**
   View all your assigned tasks in your workbox. Add notes, prioritise the tasks, and mark them as complete.
Confluence mobile

Stay productive on the go with a new, super-responsive interface optimised for iOS 5. With Confluence mobile you can:

- Manage your personal tasks and notifications.
- Browse popular content, recent blog posts and network activity.
- Search Confluence for content and people.
- Like pages, blog posts and comments.
- Add comments to pages and blog posts.
- View the profiles of your colleagues. Tap to call, SMS or email them directly from your mobile device.

More...
Table sorting and highlighting

Sortable tables are here! They're colourful and easier to read too.

- **Column sorting**
  When viewing a page, click a column header to sort the table by the values in the column.
- **Cell highlighting**
  Fill cells, rows and columns with a background colour to highlight important information.

Custom **Highlighting**
Highlight important information with custom background colors for cells and rows.
Draggable images and macros

Within the Confluence editor, you can drag and drop images and macros anywhere on the page that you are editing. This feature is supported in the following browsers: Chrome, Firefox, and Internet Explorer 9.

Rich text templates

The template editor now supports rich text content, just like the page editor. You no longer need to use wiki markup to create and update templates. This means that you can convert an existing page to a template. And it's easy to add form fields, known as variables, to your templates. More...
Space archiving

Do you need to make a space’s content less visible, but keep the space available on your Confluence site? Archive it! When a space is archived, the pages and other content do not appear in the Confluence search results, activity streams, or dropdown menus. In the space directory, the archived space will appear on a new archive tab. More...

Improved user invitations and signup options
If you want to invite people to sign up to Confluence, you can email an invitation directly from the Confluence user administration screen. To further encourage people to sign up, the login screen includes a signup option too.

If you choose to add users manually, Confluence can send them an email message informing them of their new account.

If you want to allow only people from within your organisation to sign up, use the new domain restriction option. People will only be able to sign up if their email address belongs to one of the domains specified. Confluence will send the person an email message, asking them to click a link to confirm their email address. More...

Default space permissions

Confluence administrators can now set the default permissions that will be applied to new spaces. The default permissions are configurable for groups, and not for individual users or anonymous users. Note that the space permissions scheme remains as flexible as before. Space administrators can change the space permissions at any time, including the anonymous permissions, group permissions and individual user permissions. More...
We've also simplified the way you create spaces. The quick 'Add Space' option at the top of the dashboard lead you into the new, simplified dialog for adding global spaces, shown below. Adding a personal space is even simpler.

**Lightning Fast**
A new dialog loads in the blink of an eye.

**Automagic Space Keys**
Just type and let Confluence suggest a Space key for you. No thinking required.

**Intuitive Permissions**
Public or private? Yes, it's that simple.

**Other improvements**
- **Removing attachment versions.** You can now delete a specific version of an attachment.
Mentions now available via the 'Insert' menu. In Confluence 4.0 we introduced @mentions, a handy way of mentioning someone in a page or comment. Now we have added this user mention option to the editor’s ‘Insert’ menu, to help new users discover this useful feature.

Multiple new drafts. You can now have more than one draft of a new page or blog post in the same space. (In earlier versions of Confluence, you could have multiple drafts of existing pages, but only one new draft.)

Reduced memory usage by up to 2 MB per plugin. We have improved the implementation of the Atlassian template renderer, reducing memory usage by up to 2 megabytes per plugin, for those plugins that bundle their own Velocity templates.

Support for MySQL 5.5. Reminder: We support MySQL 5.5 as well as 5.1. We announced this support with the Confluence 4.2.3 release, and made it applicable to Confluence 4.2 and later.

Session resource management. Confluence now aggressively expires HTTP sessions that appear to come from bots or web crawlers, by lowering the idle timeout for sessions that only perform a single request. This significantly reduces the resource consumption by HTTP sessions on public-facing Confluence servers, or on servers integrated with third-party search appliances. This functionality is supplied by the Atlassian Bot Session Killer plugin, now bundled with Confluence.

Faster switching of dashboard tabs. Switching between the activity tabs on the dashboard no longer causes the entire dashboard to reload.

Infrastructure changes

Here are some points of interest for plugin developers.

JIRA Portlets gone. We have removed the JIRA Portlet code from Confluence. We deprecated the use of JIRA portlets in Confluence 4.2 (see the Confluence 4.2 upgrade notes) and the JIRA Portlet plugin is no longer bundled in Confluence 4.3.

Improved data storage for plugin developers. In previous versions of Confluence, Bandana was the primary data storage mechanism available to plugin developers. Confluence 4.3 ships with Active Object, a new ORM (object relational mapping) layer for Atlassian products, implemented as a plugin. It enable easier, faster, and more scalable data access and storage than the existing Bandana and PluginSettings APIs. Active Objects in Confluence is still under rapid development, and is currently used by only a few plugins. If you would like to experiment with it, we would love to hear your feedback.

API changes. Please see our guide to preparing for Confluence 4.3.

Experimental API for workbox notifications and tasks. Confluence 4.3 introduces the workbox for managing notifications and tasks. We have an experimental API available and we're requesting your feedback! Here is your chance to help us shape the notifications and tasks API. Details are in our guide preparing for Confluence 4.3.
The Confluence 4.3 team

Development
Alex Dickson
Jonathan Raoult
Adrien Ragot
Edith Tom
Anatoli Kazatchkov
Ryan Ackley
Richard Atkins
Peter Camilleri
Niraj Bhawnani
Joseph Clark
Paul Curren
Anna Dominguez
Matthew Erickson
Steven Haffenden
Chris Kiehl
Fabien Kraemer
Daniel Kjellin
Steve Lancashire
David Loeng
Craig Petchell
Sam Tardif
David Taylor
Wesley Walser
Don Willis
Joe Xie
Shihab Hamid
Charles O’Farrell
Olli Nevalainen
Peggy Kuo
Nabeelah Ali

Architecture
Charles Miller

Plugin updates
David Chui
Philip Cher
Kai Fung Chong

Management

Product management
Bill Arconati
Helen Hung
John Masson
Sherif Mansour

Product marketing management
Ryan Anderson
Terrence Caldwell
Matthew Hodges
Development manager
Matt Ryall

Support

Sydney support
Michael Seager
Denise Unterwurzacher
David Mason
Ray Elsleiman

Amsterdam support
Dennis Kromhout van der Meer
Yilin Mo
John Inder
Alex Conde
Peter Koczan

Brazil support
Alyson Reis
Guilherme Heck
Rodrigo Adami
Tiago Comasseto
Luiz Carlos Junior
Guilherme Nedel
Bernardo Acevedo
William Zanchet

Kuala Lumpur support
Joachim Ooi
Husein Alatas
Septa Cahyadiputra
Foogie Sim
Hanis Suhailah
Rian Josua Masikome
Amalia Sanusi

San Francisco support
Adam Laskowski
Tim Wong
Robert Chang
Ryan Goodwin
Andrew Campbell
Daniel Borcherding

Cross-product team

Design
Henry Tapia
Valter Fatia

Quality assurance
Joey Corea
Mark Hrynczak
Glenn Martin

Technical writing
Sarah Maddox
Confluence 4.3 Upgrade Notes

Below are some important notes on upgrading to **Confluence 4.3**. For details of the new features and improvements in this release, please read the [Confluence 4.3 Release Notes](#).

On this page:

- **Preparing your team for Confluence 4**
- **Upgrade notes**
  - End of support for DB2 and PostgreSQL 8.2
  - Removal of JIRA Portlet macro
  - Active Objects bundled
  - Migration of templates from wiki markup to the rich text format
  - Advance notice: End of support for Java 6 in Confluence 5.0
  - Advance notice: End of support for Tomcat 5.5.x in Confluence 5.0
- **Upgrade procedure**
- **Checking for known issues and troubleshooting the Confluence upgrade**

Preparing your team for Confluence 4

If you are **upgrading to Confluence 4 for the first time** (coming from Confluence 3.5 or earlier) then please note that the change to the Confluence editing experience is significant. People in your organisation will need to be aware of the coming changes, so that they can plan and prepare for them. We have written some guides to help you:

**Planning for Confluence 4**

- [Confluence 4 Editor FAQ](#)
- [Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor](#)
- [Confluence 4 Editor - What's Changed for Wiki Markup Users](#)
- [Quick Administrator Tips To Prepare for Confluence 4](#)
- [Trying Confluence 4 Yourself](#)
- [Giving Feedback on Confluence Releases](#)
- [Confluence 4 Editor - Customer Feedback](#)

Upgrade notes

**End of support for DB2 and PostgreSQL 8.2**

As previously announced, **from this release onwards** we no longer offer support for the following database platforms:

- No versions of DB2 database are supported. For help with moving from DB2 to a supported database, please refer to the list of [supported databases](#) and the guide to [migrating to another database](#).
- Version 8.2 of PostgreSQL database is not supported.

Please see [End of Support Announcements for Confluence](#).

**Removal of JIRA Portlet macro**

The JIRA Portlet macro is no longer supported. Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1. We deprecated the use of JIRA portlets in Confluence 4.2 (see the [Confluence 4.2 upgrade notes](#)) and have removed the portlet code in Confluence 4.3. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this...
behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in How to Migrate from JIRA Issues and JIRA Portlets to Gadgets.

**Active Objects bundled**

Confluence 4.3 ships with the Active Objects plugin. If you have previously installed Active Objects into your Confluence 4.2 site, you will need to uninstall it before upgrading to Confluence 4.2. This is because user-installed plugins override bundled plugins.

**Migration of templates from wiki markup to the rich text format**

As part of the Confluence upgrade, an automatic migration of your page templates will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each space template and each global template on your Confluence site. The new version will use the new XML storage format, so that you can edit the templates in the Confluence rich text editor.

This process is automatic, and you should not need to take any action. For more details about the upgrade process, see Migration of Templates from Wiki Markup to XHTML-Based Storage Format.

**Advance notice: End of support for Java 6 in Confluence 5.0**

We are planning to end support for Java 6 (JRE and JDK 1.6) in Confluence 5.0. See End of Support Announcements for Confluence.

**Advance notice: End of support for Tomcat 5.5.x in Confluence 5.0**

We are planning to end support for Tomcat 5.5.x in Confluence 5.0. See End of Support Announcements for Confluence.

**Upgrade procedure**

**Note: Upgrade to a test environment first.** Test your upgrades in your test environment before rolling them into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
   2. If your version of Confluence is earlier than 3.5, then you must upgrade to Confluence 3.5.x before upgrading to Confluence 4.x. There are several reasons for this:
      - There were major changes to user management and LDAP in Confluence 3.5.
      - From version 3.5, you will be able to use our new automated installer / upgrader to move to 4.0. The Confluence 4.0 installer does not support upgrading from Confluence versions earlier than 3.5.
      - We recommend that you fix any issues arising from the upgrade to version 3.5.x, separately from those that may arise from upgrading to version 4.x. Please contact Atlassian Support for assistance.
      - Please read the Upgrade Notes Overview and the upgrade notes for each version of Confluence listed on that page. (There are hyperlinks to each one.)
   If you are upgrading from 2.1 or earlier, please read the 2.2 Release Notes.
   If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade from version 2.7.x to version 3.5.x, then upgrade to the latest version. For more details, please refer to CONF-11767.
2. Download the latest version of Confluence.
3. Follow the instructions in the Upgrade Guide.
Checking for known issues and troubleshooting the Confluence upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

Issues Resolved in Confluence 4.3

Below are the issues resolved in Confluence 4.3, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. The Confluence 4.3 Release Notes describe the new features in this release.

Features and Improvements

<table>
<thead>
<tr>
<th>JIRA Issues (22 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>![Issue Icon]</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>CONF-8577</td>
</tr>
<tr>
<td>CONF-7644</td>
</tr>
<tr>
<td>CONF-6318</td>
</tr>
<tr>
<td>CONF-5520</td>
</tr>
<tr>
<td>CONF-12555</td>
</tr>
<tr>
<td>CONF-23144</td>
</tr>
<tr>
<td>CONF-26057</td>
</tr>
<tr>
<td>CONF-25658</td>
</tr>
<tr>
<td>CONF-25657</td>
</tr>
<tr>
<td>CONF-25292</td>
</tr>
</tbody>
</table>
### Bugs Fixed

<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-25000</td>
<td>Better wording on the Like feature for Anonymous users</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-23756</td>
<td>Move to vertical positioning of the labels on the login form</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-21845</td>
<td>Confusing label on CAPTCHA screen</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>

### JIRA Issues (24 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-4540</td>
<td>Complex headings generate invalid anchors</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>CONF-25642</td>
<td>External developers are unable to compile plugins against Confluence 4.2</td>
<td>Resolved</td>
<td>Fixed</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>CONF-25518</td>
<td>Mention @user email notification doesn't work on page or comment edit</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>CONF-26238</td>
<td>Backup Manager not working in OnDemand</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-23665</td>
<td>Cannot save Page after trying to insert a status macro with a % character</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>CONF-26341</td>
<td>Misbehavior when you type an username inside the Network tab (in the following field)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-26045</td>
<td>PageTemplateManager API change in 4.3 without deprecation</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-26040</td>
<td>Misleading statement of 'Like' status in Deutsch</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-26019</td>
<td>Editor freezes when moving down with cursor and pasting status macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-25965</td>
<td>&quot;n people like this&quot; link does not work in IE8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-22804</td>
<td>Code Macro's parameter case sensitivity is causing issues</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-26340</td>
<td>Opening Notifications panel throws ActiveObjectsSQLException</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-26248</td>
<td>The LucidChart plugin is automatically enabled for every OnDemand customer</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-26170</td>
<td>French translation of &quot;Child Pages&quot; (&quot;enfants&quot;) is wrong</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-26014</td>
<td>Macro browser does not work in 4.3-beta1</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-25995</td>
<td>Confluence 4.2.9 and 4.3-beta1 can not upgrade due to invalid cast</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-25701</td>
<td>Scheduled Job Admin fails to load when running Confluence in Dev mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-25683</td>
<td>User reports being unable to 'Like' a Comment with IE8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
Confluence 4.2.13 Release Notes

20 August 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.13, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.
Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.13 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (5 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>

Confluence 4.2.13 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.13. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:
1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

Confluence 4.2.12 Release Notes

7 August 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.12, which is a bug-fix release.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.12 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2 issues)</td>
<td>📜</td>
<td>CONF-26039</td>
<td>Confluence is sending an 'Unlike' notification</td>
<td>✱</td>
<td>🏷️ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📜</td>
<td>CONF-22985</td>
<td>Space directory fails to load: ORA-01795: maximum number of</td>
<td>↓</td>
<td>🏷️ Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 4.2.12 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.12. For details of the fixes in this release, please read the release notes.

Upgrade notes

⚠️ Note: An API change in Confluence 4.2.6 and later is incompatible with the current version of the Refined Wiki theme. The changed API may result in problems with other plugins too. Please watch this issue for news:

CONF-25981 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.

In particular:

• Please read the Confluence 4.2 Upgrade Notes.
• Please read the Confluence 3.5 Upgrade Notes.
• If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.11 Release Notes

24 July 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.11, which is a bug-fix release.

Note: Confluence 4.2.9 and 4.2.10 were internal releases, not publicly available.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Release Notices
Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.11 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (6 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
</tr>
</tbody>
</table>
Confluence 4.2.11 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.11. For details of the fixes in this release, please read the release notes.

Upgrade notes

⚠️ Note: An API change in Confluence 4.2.6 and later is incompatible with the current version of the Refined Wiki theme. The changed API may result in problems with other plugins too. Please watch this issue for news:

CONF-25981 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   ✅ Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.

   In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.8 Release Notes

9 July 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.8, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.8 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading...
Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (7 issues)</th>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>📗</td>
<td>CONF-26030</td>
<td>Pasting code into a code block in Confluence looses existing formatting of the code</td>
<td>⬆️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25312</td>
<td>PDF Export is using a very large font size for code-macro blocks</td>
<td>⬆️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25860</td>
<td>Using ExceptionUtils.getRootCause(e).getMessage causes NPEs to be thrown</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25483</td>
<td>Preformatted text outputs too large when exporting to PDF</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25283</td>
<td>Provide option to disable &quot;Add User&quot; link / signup URL from being visible to anyone</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25259</td>
<td>Confluence Page Gadget on JIRA will shows &quot;Resource cannot be found&quot; on Confluence 4.2</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>📗</td>
<td>CONF-25223</td>
<td>Comment section does not follow theme colors</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Confluence 4.2.8 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.8. For details of the fixes in this release, please read the release notes.

Upgrade notes

⚠️ Note added on 10 July 2012: An API change in Confluence 4.2.6 to 4.2.8 is incompatible with the current...
version of the Refined Wiki theme. The changed API may result in problems with other plugins too. Please watch this issue for news: CONF-25981 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.
3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.7 Release Notes

2 July 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.7, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Release notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.7 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and fixes in this release

<table>
<thead>
<tr>
<th>JIRA Issues (5 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence 4.2.7 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.7. For details of the fixes in this release, please read the release notes.

Upgrade notes

⚠️ Note added on 10 July 2012: An API change in Confluence 4.2.6 and Confluence 4.2.7 is incompatible with the current version of the Refined Wiki theme. The changed API may result in problems with other plugins too. Please watch this issue for news: CONF-25981 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   ✅ Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.6 Release Notes

25 June 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.6. This release includes the option to set default permissions for new spaces, and a simplified dialog for adding spaces. We have also fixed some bugs.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Default space permissions

Confluence administrators can now set the default permissions that will be applied to new spaces. The default permissions are configurable for groups only, not for individual users or anonymous users.

Simplified option for adding a space

In Confluence 4.2.3, we introduced a simple dialog for adding spaces. Now in Confluence 4.2.6, it has become even simpler. Just enter the space name and key, and indicate whether the space is private or not. A private space will be visible only to the person who created it. If you do not make it private, the space will have the default space permissions. Adding a personal space is even simpler – just say whether it is private or not. You can change the space permissions later.
Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.6 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (6 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
Confluence 4.2.6 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.6. For details of the fixes in this release, please read the release notes.

Upgrade notes

⚠️ Note added on 10 July 2012: An API change in Confluence 4.2.6 is incompatible with the current version of the Refined Wiki theme. The changed API may result in problems with other plugins too. Please watch this issue for news: CONF-25981 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   ✔ Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.

   In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.5 Release Notes

14 June 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.5. This release includes a new option for administrators to send an email message directly from Confluence, inviting new users to the site.

We have also fixed some bugs.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.
Inviting new users by email

You can now send an email message directly from the Confluence user administration screen, inviting people to join the site. We have also clarified the signup modes as public, private, or disabled.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.5 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (17 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>🚹</td>
</tr>
<tr>
<td>Issue ID</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>CONF-25610</td>
</tr>
<tr>
<td>CONF-25498</td>
</tr>
<tr>
<td>CONF-25236</td>
</tr>
<tr>
<td>CONF-25678</td>
</tr>
<tr>
<td>CONF-25255</td>
</tr>
<tr>
<td>CONF-25213</td>
</tr>
<tr>
<td>CONF-18379</td>
</tr>
<tr>
<td>CONF-11092</td>
</tr>
<tr>
<td>CONF-26048</td>
</tr>
<tr>
<td>CONF-25572</td>
</tr>
<tr>
<td>Issue Number</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>CONF-25468</td>
</tr>
<tr>
<td>CONF-25442</td>
</tr>
<tr>
<td>CONF-25424</td>
</tr>
<tr>
<td>CONF-24449</td>
</tr>
<tr>
<td>CONF-20695</td>
</tr>
<tr>
<td>CONF-18422</td>
</tr>
</tbody>
</table>

### Confluence 4.2.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.5. For details of the fixes in this release, please read the release notes.

### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database
supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.4 Release Notes

28 May 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.4, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.4 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>(8 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Key</strong></td>
</tr>
<tr>
<td>📬</td>
<td>CONF-25525</td>
</tr>
<tr>
<td>📬</td>
<td>CONF-25405</td>
</tr>
<tr>
<td>📬</td>
<td>CONF-24057</td>
</tr>
</tbody>
</table>
#userLogoBlock
Otherwise uses deprecated GeneralUtil method and breaks in ‘dev’ mode

<table>
<thead>
<tr>
<th></th>
<th>CONF-20248</th>
<th>Documentation Theme CSS is over-riding content styling</th>
<th></th>
<th>Resolved</th>
<th>Fixed</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-25583</td>
<td>Japanese character in comment are garbled on some browsers (except Firefox)</td>
<td></td>
<td>Resolved</td>
<td>Resolved Locally</td>
</tr>
<tr>
<td></td>
<td>CONF-24493</td>
<td>Document Theme css setting prevents Table-Plus and csv Plugins to highlight table rows</td>
<td></td>
<td>Resolved</td>
<td>Duplicate</td>
</tr>
<tr>
<td></td>
<td>CONF-20468</td>
<td>Scroll bar disappears when Space Theme is set to Easy Reader Theme and Global Site Theme is set to Documentation Theme</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>CONF-18710</td>
<td>No Cache Configuration for ImageDetailsDto</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Confluence 4.2.4 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.4. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.
3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.3 Release Notes

21 May 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.3. This release includes a faster and simpler dialog for adding spaces. We have also added support for MySQL 5.5, and fixed some bugs.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Adding spaces quickly and simply

Confluence 4.2.3 introduces a quick 'Add Space' option at the top of the dashboard, which leads you to the new, simplified dialog for adding global spaces, shown below. Adding a personal space is even simpler.

Support for MySQL 5.5

Confluence 4.2 and later now support MySQL 5.5 as well as 5.1. See Supported Platforms. This announcement is retrospectively applicable to the Confluence 4.2 release.

Release notices
Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and fixes in this release

<table>
<thead>
<tr>
<th>JIRA Issues (11 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
### Confluence 4.2.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.3. For details of the fixes in this release, please read the release notes.

#### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you **should** upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.

   In particular:
Confluence 4.3 Documentation

- Please read the Confluence 4.2 Upgrade Notes.
- Please read the Confluence 3.5 Upgrade Notes.
- If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.2 Release Notes

8 May 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.2, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (19 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>📚</td>
</tr>
<tr>
<td>📚</td>
</tr>
<tr>
<td>📚</td>
</tr>
<tr>
<td>📚</td>
</tr>
<tr>
<td>Entry into gadgets white-list the browser jumps back to the first tab</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>CONF-25194</td>
</tr>
<tr>
<td>CONF-24644</td>
</tr>
<tr>
<td>CONF-24584</td>
</tr>
<tr>
<td>CONF-4862</td>
</tr>
<tr>
<td>CONF-25373</td>
</tr>
<tr>
<td>CONF-25201</td>
</tr>
<tr>
<td>CONF-25120</td>
</tr>
<tr>
<td>CONF-25114</td>
</tr>
</tbody>
</table>
### Confluence 4.2.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.2. For details of the fixes in this release, please read the release notes.

#### Upgrade notes

**Bug sends the recommended updates email message to all LDAP users**

Confluence now sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message. By default Confluence will send a weekly update to all users, except under these conditions:

- If you have public signup enabled, the Recommended Updates email notification is turned off by default.
- If you are connected to LDAP and a user has never logged in to Confluence, that user will not receive the Recommended Updates notification.

⚠️ Due to a bug in Confluence 4.2, 4.2.1 and 4.2.2, the Recommended Updates email notification may be sent to all LDAP Confluence users, whether they have logged in or not. The problem is tracked on this issue:

<table>
<thead>
<tr>
<th>Status</th>
<th>Project Name</th>
<th>Issue Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved</td>
<td>CONF-24354</td>
<td>Project names do not render while mapping a Confluence a JIRA project</td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-23497</td>
<td>Bullet points are not aligned with the text in Safari/Chrome</td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-23268</td>
<td>Chrome 14 and above can't displayed attached .swf file on a page</td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-16993</td>
<td>Multiple emails sent out when multiple files are uploaded at once</td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-25177</td>
<td>Space admin &gt; Space Labels uses incorrect i18n key 'space-labels'</td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-25170</td>
<td>Fix French translation for the comment summary in &quot;Confluence Like Plugin&quot;</td>
</tr>
</tbody>
</table>
The problem will be fixed in Confluence 4.2.3. Until then, you may wish to disable the notification as described in the next paragraph, if your Confluence site is connected to a large LDAP user base.

You can turn off the Recommended Updates notification, or change its settings for the site. See Configuring the Recommended Updates Email Notification. Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

Advance notice: End of support for PostgreSQL 8.2 in Confluence 4.3

We are planning to end support for version 8.2 of PostgreSQL in Confluence 4.3. See End of Support Announcements for Confluence.

Upgrade procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.
3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   • Please read the Confluence 4.2 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.2.1 Release Notes

23 April 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.2.1, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 4.2 yet?

Take a look at the new features and other highlights in the Confluence 4.2 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.2.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (3 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
</tbody>
</table>

Confluence 4.2.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2.1. For details of the fixes in this release, please read the release notes.

Upgrade Notes

Confluence now sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message. By default Confluence will send a weekly update to all users, except under these conditions:

- If you have public signup enabled, the Recommended Updates email notification is turned off by default.
- If you are connected to LDAP and a user has never logged in to Confluence, that user will not receive the Recommended Updates notification.

Due to a bug in Confluence 4.2, 4.2.1 and 4.2.2, the Recommended Updates email notification may be sent to all LDAP Confluence users, whether they have logged in or not. The problem is tracked on this issue: CONF-25213 - Authenticate to see issue details The problem will be fixed in Confluence 4.2.3. Until then, you may wish to disable the notification as described in the next paragraph, if your Confluence site is connected to a large LDAP user base.

You can turn off the Recommended Updates notification, or change its settings for the site. See Configuring the Recommended Updates Email Notification. Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and
**database.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

*Tip:* Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you *should* upgrade to Confluence 3.5.x before upgrading to Confluence 4.2.x.

3. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.2 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

---

**Confluence 4.2 Release Notes**

**10 April 2012**

With great pleasure, Atlassian presents **Confluence 4.2**. Create content that pops, see what’s trending, and be a trendsetter.

**Highlights of Confluence 4.2**

- Page layouts
- Likes
- Quick comments
- Popular content on the dashboard
- Recommended content by email
- Labels on attachments
- Signup invitations via URL
- Easy upgrade, try and buy for plugins
- Other improvements
- Infrastructure changes

**More**

- Read the upgrade notes for important information about this release.
- See the full list of issues resolved in this release.

**Thank you for your feedback**

- Over 440 votes recognised
- More than 40 requests fulfilled

**Video of What’s New**

---

**Highlights of Confluence 4.2**
Page layouts

Page layouts offer a quick and easy way to add sections and columns to a page. Choose a predefined layout, add the content to each section, and you're done. It's a great way of creating a common page structure, so that readers know where to find the information on each page. Don't worry, the Section and Column macros are still available too. See the video.

![Example of a two-column page layout](image)

A two-column page layout in edit mode. (It's all laid out in the documentation.)

Likes

Has someone written a mind-bogglingly clever post on Confluence? Did you laugh out loud at someone's comment? Click Like to let them know. Confluence has like buttons on every page, blog post and comment. If enough people like the post, it will show up on the dashboard's new 'Popular' tab and in the 'Recommended Updates' summary sent by email. See the video.
Quick comments

Showing people a picture of themselves is a great way to encourage them to say something! We have added an enticingly empty comment at the bottom of every page, with the user's profile picture. This replaces the rather uninviting Add Comment button in earlier versions of Confluence. And here's what we are really proud of: When you click the box to write a comment, the full editor loads instantly. No page refresh required. See the video. Pow!
So let's talk about chocolate

Two penguins find themselves together on an ice floe, drifting helplessly into warmer waters. The penguins are very fond of each other. Suddenly, "crac-a-ack", the ice floe splits in half. Right between the penguins. As they drift apart, one penguin sadly waves a flipper and calls out, "Chocolate milk!"

Popular content on the dashboard

Want to see what's trending? The new 'Popular' tab on the dashboard shows the pages, blog posts and comments that are attracting most attention, based on the number of comments and likes they have received. The items are listed in order of popularity, with the most popular at the top. Activity that involves people in your network ranks higher than activity not involving your network, and the most recent activity ranks higher than earlier activity. See the video.
Recommended content by email

Confluence sends out a daily or weekly email message summarising the top news that is relevant to you. This is a great way of drawing people into the wiki discussions even if they are infrequent users of Confluence. The report shows the most popular content in the wiki, based on the number of likes and comments, and recently-created pages or blog posts. Confluence gives a higher ranking to activity by people in your network or in your favourite spaces. A link in the email message allows you to choose daily or weekly notifications, or to turn the notification off. See the video.

Note: All Confluence users will receive this email message by default. For instructions on turning it off, see the Confluence 4.2 Upgrade Notes.
Labels on attachments

You can now label attachments, just as you can label pages and blog posts.

- Using the Gallery macro, you can display a selection of images on your page filtered by label.
- The Attachments macro and the Space Attachments macro can show documents or other attachments with a specific label.
- The Content by Label macro also displays attachments (alongside pages, blog posts and spaces) with a given label, and you can filter by content type to show only attachments.

<table>
<thead>
<tr>
<th>Attached Files</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>MyWordDoc.doc</td>
<td>24 kB</td>
<td>Sarah Maddox</td>
<td>Mar 13, 2012 11:18</td>
<td>None</td>
</tr>
<tr>
<td>HotChoc.jpg</td>
<td>4 kB</td>
<td>Sarah Maddox</td>
<td>Mar 13, 2012 11:07</td>
<td>chocolate, beverage, my_choc</td>
</tr>
<tr>
<td>Chocs3.png</td>
<td>9 kB</td>
<td>Sarah Maddox</td>
<td>Mar 09, 2012 13:33</td>
<td>chocolate, beverage</td>
</tr>
<tr>
<td>chocolate-034-450px.jpg</td>
<td>15 kB</td>
<td>Sarah Maddox</td>
<td>Mar 05, 2012 14:20</td>
<td>chocolate</td>
</tr>
</tbody>
</table>

Labels on attachments. (Become attached to our documentation.)
Signup invitations via URL

It's what you have been dreaming of: a quick and easy way of inviting people to sign up to Confluence. Just send them a URL. You can also choose between public and private signup modes, and decide whether you want a notification each time someone signs up.

Inviting users and setting the signup mode. (You're invited to see the documentation too.)

Easy upgrade, try and buy for plugins

Now you can view, manage and upgrade your existing plugins from just one tab, called Manage my plugins. Simple, logical, clean. You will also notice some shiny Try, Buy, and Renew buttons appearing, for plugins that support the new functionality in the Universal Plugin Manager. Clicking one of those buttons takes you straight to MyAtlassian.com, where you can get an evaluation or full license on the spot. The license is automatically added to Confluence, and you are returned to the plugin manager. And the plugin manager looks much prettier too.
## Manage my plugins

The Universal Plugin Manager allows you to view, manage and update your installed plugins, as well as install new ones from the [Atlassian Plugin Exchange](https://plugins.atlassian.com).

### Available Updates

These plugins have updates that are compatible with your current version of Confluence and may be updated immediately.

**Reporting Plugin**

- **This plugin will generate reports on collected information in a flexible manner.**
- **Plugin key:** net.customware.confluence.plugin.reporting
- **Available plugin version:** 4.0.0
- **Plugin system version:** 2.0
- **License:** Commercial

### User-installed Plugins

These plugins may be configured, enabled, disabled or uninstalled.

**Adaptavist Advanced Search**

- A plugin to provide an alternative and advanced AJAX searching interface.

**Adaptavist Content Formatting Macros**

- This is a plugin for Confluence which provides advanced formatting options.

Plugins offered for upgrade under ‘Available Updates’ (See the [documentation](https://plugins.atlassian.com)).

---

### Other improvements

- **Author lozenge on blog post comments:**
  
  You will see an ‘author’ lozenge on blog comments, making it easy to scan a post for comments from the author. The author lozenge appears only on blog posts, and only for the original creator of the post.

  ![John Masson](https://via.placeholder.com/150)

  **John Masson**  
  Mar 01, 2012

  I think since 100% is out we need to keep it narrower. I didn't think it was that bad before, but right now it looks odd because it's "almost" 100% but not quite... Perhaps 50% looks better? Seems more intentional?

  Edit · Remove · Reply · Like

- **Share notifications showing all people notified:**
  
  When someone shares a page with you, the email message shows the other people they shared it with too.
Mouse-free macros, links and images:
This is one for wiki markup fans! Now you can add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page. See the video.

Fixed images in Word exports:
We have fixed this bug: CONF-6246 - Authenticate to see issue details

Personal spaces more open:
The permissions for personal spaces are now more in line with Confluence's philosophy of encouraging collaboration. When you create your personal space, the option that allows registered users to update content is selected by default. You will also be assigned as a watcher of your new personal space. (Existing settings will not be changed on upgrade.)

Gadget subscriptions:
An administrator can quickly add all the gadgets from a JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages. Before this release, the administrator had to register the gadgets one by one. To subscribe to another site's gadgets, go to Confluence Admin > External Gadgets and open the new Gadget Feeds tab.

Infrastructure changes
- PostgreSQL 9.0: From this release of Confluence, we support PostgreSQL 9.0 as well as 8.2, 8.3 and 8.4. See Supported Platforms.
- Java 7: We now support Oracle JRE / JDK 1.7 as well as 1.6. See Supported Platforms.
- MySQL 5.5: Confluence 4.2 and later now support MySQL 5.5 as well as 5.1. See Supported Platforms.
Announcement made on 11 May 2012, retrospectively applicable to the Confluence 4.2 release.)

- Confluence 4.2 includes version 2.0.5 of the Universal Plugin Manager (UPM).
- Confluence 4.2 includes Atlassian Gadgets 3.2
- The implementation of quick comments required some significant changes to the editor’s initialisation code. This will have consequences for some Confluence plugins. Details are in this blog post: JavaScript Changes Required for Confluence 4.2 Compatibility.

The Confluence 4.2 team

Development
Ryan Ackley
Nabeelah Ali
Richard Atkins
Niraj Bhawnani
Joseph Clark
Paul Curren
Lachlan Dally
Chris Darroch
Anna Dominguez
Matthew Erickson
Steven Haffenden
Chris Kiehl
Fabien Kraemer
Anatoli Kazatchkov
Daniel Kjellin
Steve Lancashire
David Loeng
Brian Nguyen
Craig Petchell
Agnes Ro
Matt Ryall
Stefan Saasen
Sam Tardif
David Taylor
Ryan Thomas
Wesley Walser
Don Willis
Joe Xie

Architecture
Charles Miller

Build and release engineering
Adrián Deccico

Plugin updates
David Chui
Philip Cher
Kai Fung Chong

Management

Product management
Bill Arconati
Helen Hung
John Masson

**Product marketing management**
Ryan Anderson
Terrence Caldwell
Matthew Hodges

**Development manager**
Jonathan Gilbert

**Support**

**Sydney support**
Denise Unterwurzacher
Michael Seager
Tim Wong

**Amsterdam support**
Dennis Kromhout van der Meer
Yilin Mo
John Inder

**Brazil support**
Alyson Reis
Guilherme Heck
Rodrigo Adami
Tiago Comasseto
Luiz Carlos Junior
Guilherme Nedel
Bernardo Acevedo
William Zanchet

**Kuala Lumpur support**
Joachim Ooi
Husein Alatas
HengHwa Loi
Septa Cahyadiputra
Foogie Sim
Hanis Suhailah
Rian Josua Masikome

**San Francisco support**
Adam Laskowski
Robert Chang
Ryan Goodwin
Andrew Campbell

**Cross-Product Team**

**Design**
Henry Tapia
Valter Fatia

**Quality assurance**
Joey Corea
Mark Hrynczak
Glenn Martin

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence 4.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.2. For details of the new features and improvements in this release, please read the Confluence 4.2 Release Notes.

On this page:

- Upgrade Notes
  - Checking for compatible plugins before upgrading
  - Disabling notification of signups
  - Configuring the Recommended Updates notification
  - Disabling the new ‘Popular’ tab on the dashboard
  - Advance notice: End of support for DB2 in Confluence 4.3
  - Advance notice: Removal of JIRA Portlet macro in Confluence 4.3
  - Advance notice: End of support for PostgreSQL 8.2 in Confluence 4.3

- Upgrade Procedure
  - Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

Upgrade Notes

Checking for compatible plugins before upgrading

Before upgrading to Confluence 4.2, please consider the plugins that are essential for your installation, and use the plugin upgrade check to see whether there is a compatible version of those plugins available for Confluence 4.2.

In particular, the implementation of quick comments required some significant changes to the editor’s initialisation code. This will have consequences for some Confluence plugins. Details are in this blog post: JavaScript Changes Required for Confluence 4.2 Compatibility.

Disabling notification of signups

This release includes an automatic notification, sent by email to all administrators, each time someone signs up to the Confluence site. This notification is part of the feature that allows you to invite people to sign up via a URL, and to set your signup mode to public or private. See the documentation.

The notification is enabled by default on the first upgrade to Confluence 4.1.9 or later. If you are upgrading to Confluence 4.2 from Confluence 4.1.7 or earlier, you may want to disable the notification after upgrading, especially if you allow public signup and are expecting a large number of signups.

To disable the notification:

The email notification includes a link to change notification settings. Alternatively, follow these steps:

1. Click Add Users on the dashboard.
   
   Or take the longer route: Choose Browse > Confluence Admin. Click Users > Add User.
2. Remove the tick from Notify administrators when users sign up.

Configuring the Recommended Updates notification

Confluence now sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message. By default Confluence will send a weekly update to all users, except under these conditions:
If you have public signup enabled, the Recommended Updates email notification is turned off by default.

If you are connected to LDAP and a user has never logged in to Confluence, that user will not receive the Recommended Updates notification.

⚠️ Due to a bug in Confluence 4.2, 4.2.1 and 4.2.2, the Recommended Updates email notification may be sent to all LDAP Confluence users, whether they have logged in or not. The problem is tracked on this issue: CONF-25213 - Authenticate to see issue details. The problem will be fixed in Confluence 4.2.3. Until then, you may wish to disable the notification as described in the next paragraph, if your Confluence site is connected to a large LDAP user base.

You can turn off the Recommended Updates notification, or change its settings for the site. See Configuring the Recommended Updates Email Notification. Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

Disabling the new 'Popular' tab on the dashboard

In some environments, you may prefer not to display the new 'Popular' tab on the dashboard. For example, if your wiki allows only a small group of people to log in and contribute content or comments. Then the tab may not be relevant to you.

To prevent the tab from appearing, you can disable the relevant plugin module. You need System Administrator permissions to do this. Go to the Dashboard Macros plugin (See Configuring a Plugin), click Manage plugin modules and disable the Popular Tab module.

Advance notice: End of support for DB2 in Confluence 4.3

We are planning to end support for DB2 in Confluence 4.3. See End of Support Announcements for Confluence.

Advance notice: Removal of JIRA Portlet macro in Confluence 4.3

The JIRA Portlet macro, for JIRA 3.x and earlier, allows you to display a JIRA dashboard portlet on a Confluence page. Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1.

In Confluence 4.1 and 4.2, it is no longer possible to add a JIRA Portlet macro via the Confluence macro browser. It is still possible to add the macro using wiki markup or by copying an existing JIRA Portlet macro. The macro still displays information correctly.

In Confluence 4.3, we will remove the JIRA Portlet macro from Confluence. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in How to Migrate from JIRA Issues and JIRA Portlets to Gadgets.

Advance notice: End of support for PostgreSQL 8.2 in Confluence 4.3

Update added on 1 May 2012: We are planning to end support for version 8.2 of PostgreSQL in Confluence 4.3. See End of Support Announcements for Confluence.

Upgrade Procedure

⚠️ Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest
version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.5, then you must upgrade to Confluence 3.5.x before upgrading to Confluence 4.x. There are several reasons for this:
   - There were major changes to user management and LDAP in Confluence 3.5.
   - From version 3.5, you will be able to use our new automated installer / upgrader to move to 4.0. The Confluence 4.0 installer does not support upgrading from Confluence versions earlier than 3.5.
   - We recommend that you fix any issues arising from the upgrade to version 3.5.x, separately from those that may arise from upgrading to version 4.x. Please contact Atlassian Support for assistance.
   - Please read the Upgrade Notes Overview and the upgrade notes for each version of Confluence listed on that page. (There are hyperlinks to each one.)

   If you are upgrading from 2.1 or earlier, please read the 2.2 Release Notes.
   If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade from version 2.7.x to version 3.5.x, then upgrade to the latest version. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

Issues Resolved in Confluence 4.2

Below are the issues resolved in Confluence 4.2, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 4.2 Release Notes for the new features in this release.

**Features and Improvements**

**JIRA Issues** (10 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="icon.png" alt=" " /></td>
<td>CONF-3963</td>
<td>Label attachments</td>
<td>Resolved</td>
<td>Fixed</td>
<td>117</td>
</tr>
<tr>
<td><img src="icon.png" alt=" " /></td>
<td>CONF-21797</td>
<td>Add official support for Postgresql 9.x</td>
<td>Resolved</td>
<td>Fixed</td>
<td>11</td>
</tr>
<tr>
<td><img src="icon.png" alt=" " /></td>
<td>CONF-23549</td>
<td>Support Java 7</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
</tr>
</tbody>
</table>
### Bugs Fixed

<table>
<thead>
<tr>
<th>JIRA Issues (56 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>📈</td>
</tr>
<tr>
<td>📈</td>
</tr>
<tr>
<td>📈</td>
</tr>
<tr>
<td>📈</td>
</tr>
<tr>
<td>📈</td>
</tr>
<tr>
<td>Conf Number</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>CONF-6152</td>
</tr>
<tr>
<td>CONF-24438</td>
</tr>
<tr>
<td>CONF-21785</td>
</tr>
<tr>
<td>CONF-24902</td>
</tr>
<tr>
<td>CONF-19740</td>
</tr>
<tr>
<td>CONF-20075</td>
</tr>
<tr>
<td>CONF-13647</td>
</tr>
<tr>
<td>CONF-24571</td>
</tr>
<tr>
<td>CONF-24300</td>
</tr>
<tr>
<td>CONF-21057</td>
</tr>
<tr>
<td>Conf.</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>CONF-19549</td>
</tr>
<tr>
<td>CONF-16692</td>
</tr>
<tr>
<td>CONF-10395</td>
</tr>
<tr>
<td>CONF-25145</td>
</tr>
<tr>
<td>CONF-25012</td>
</tr>
<tr>
<td>CONF-24228</td>
</tr>
<tr>
<td>CONF-16542</td>
</tr>
<tr>
<td>CONF-14929</td>
</tr>
<tr>
<td>CONF-26301</td>
</tr>
<tr>
<td>CONF-25916</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>CONF-25313</td>
</tr>
<tr>
<td>CONF-25226</td>
</tr>
<tr>
<td>CONF-25126</td>
</tr>
<tr>
<td>CONF-25077</td>
</tr>
<tr>
<td>CONF-25047</td>
</tr>
<tr>
<td>CONF-25037</td>
</tr>
<tr>
<td>CONF-25001</td>
</tr>
<tr>
<td>CONF-24999</td>
</tr>
<tr>
<td>CONF-24783</td>
</tr>
<tr>
<td>CONF-24768</td>
</tr>
<tr>
<td>CONF-24688</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>CONF-20306</td>
</tr>
<tr>
<td>CONF-18039</td>
</tr>
<tr>
<td>CONF-17722</td>
</tr>
<tr>
<td>CONF-17241</td>
</tr>
<tr>
<td>CONF-15945</td>
</tr>
<tr>
<td>CONF-15097</td>
</tr>
<tr>
<td>CONF-14460</td>
</tr>
</tbody>
</table>

Confluence 4.1.10 Release Notes

17 May 2012

Confluence 4.1.10 is a bug-fix release. The full list of fixes is provided at the bottom of this page.
Don't have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Release Notices

- **Security advisory:** This release fixes some security flaws. Please refer to the [security advisory](#) for details of the security vulnerabilities, risk assessment and mitigation strategies.
- Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.10 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (1 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>XML</td>
</tr>
</tbody>
</table>

Confluence 4.1.10 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.10. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.1 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1.9 Release Notes

27 March 2012
The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.9. This release includes the new invitation URL, providing a quick and easy way of inviting people to sign up to Confluence. We have also fixed some bugs.

Note: Confluence 4.1.8 was an internal release, not available publicly.

Don’t have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Inviting people to sign up via a URL

It's what you have been dreaming of: a quick and easy way of inviting people to sign up to Confluence. Just send them a URL. You can also choose between public and private signup modes, and decide whether you want a notification each time someone signs up. See the documentation.

Inviting users and setting the signup mode.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.9 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (10 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
<tr>
<td>![Icon]</td>
</tr>
</tbody>
</table>
Confluence 4.1.9 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.9. For details of the fixes in this release, please read the release notes.

Upgrade Notes

Disabling notification of signups

This release includes an automatic notification, sent by email to all administrators, each time someone signs up to the Confluence site. This notification is part of the feature that allows you to invite people to sign up via a URL, and to set your signup mode to public or private. See the documentation.

The notification is enabled by default on the first upgrade to Confluence 4.1.9 or later. You may want to disable the notification after upgrading to Confluence 4.1.9, especially if you allow public signup and are expecting a large number of signups.

To disable the notification:

The email notification includes a link to change notification settings. Alternatively, follow these steps:

1. Click Add Users on the dashboard.
   Or take the longer route: Choose Browse > Confluence Admin. Click Users > Add User.
2. Remove the tick from Notify administrators when users sign up.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   • Please read the Confluence 4.1 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1.7 Release Notes

12 March 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.7, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Download the latest version of Confluence.

Follow the instructions in the Upgrade Guide.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.7 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (5 issues)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Key</strong></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-24709</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-24691</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-25046</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-24559</td>
</tr>
</tbody>
</table>
Confluence 4.1.7 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.7. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   ✓ Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   • Please read the Confluence 4.1 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1.6 Release Notes

27 February 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.6, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.6 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
Updates and Fixes in this Release

### JIRA Issues (7 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📘</td>
<td>CONF-24567</td>
<td>Copy &amp; paste image data into RTE no longer working in Firefox 10</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-24423</td>
<td>Activity Streams Plugin throws Error when it encounters a space in the space name</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-24643</td>
<td>Space Permissions -&gt; Individual Users -&gt; Select All -&gt; all(!) boxes are checked</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-24561</td>
<td>Startup fails with VIEWS in MySQL database</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-24382</td>
<td>Cannot search user by fullname in languages that use multi-byte characters within Share dialog.</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-24232</td>
<td>Selecting any label in Space Categories leads to Page not found error</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📘</td>
<td>CONF-22011</td>
<td>The code macro doesn't render URL within XML</td>
<td>🟥</td>
<td>🍁 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

### Confluence 4.1.6 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.6. For details of the fixes in this release, please read the release notes.

### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and
Confluence 4.1.5 Release Notes

13 February 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.5, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.5 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (13 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>CONF</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td><img src="image" alt="" /></td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence 4.1.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.5. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 4.1 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1.4 Release Notes

31 January 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.4, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Download Latest Version
Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.4 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (3 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
</tbody>
</table>

Confluence 4.1.4 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.4. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   • Please read the Confluence 4.1 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.
Confluence 4.1.3 Release Notes

16 January 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.3, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.

Updates and Fixes in this Release

JIRA Issues (14 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟢</td>
<td>CONF-24361</td>
<td>Pressing TAB inside a plain text macro placeholder should insert a tab character (rather than shifting the browser’s focus)</td>
<td></td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟢</td>
<td>CONF-24221</td>
<td>Show complete location of an image on the tooltip in the editor</td>
<td></td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟢</td>
<td>CONF-22183</td>
<td>The Jira macro cannot find a Jira project that has alphanumeric characters within its project key.</td>
<td></td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟢</td>
<td>CONF-24277</td>
<td>Documentation Theme - comment anchor links have</td>
<td></td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>Number</td>
<td>Description</td>
<td>Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-24198</td>
<td>The spacing between columns that have panels has been altered</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CONF-24194</td>
<td>SOAP incompatibility introduced in 4.1 - addComment</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CONF-23983</td>
<td>Allow copy and pasting of the last row (or selections involving the last row) in webkit</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-23691</td>
<td>Selecting the whole contents of a code macro and pasting text into it removes the placeholder in webkit</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONF-23566</td>
<td>Copying and pasting white space inside the code macro does not work (right click also causes the selection to collapse undesirably)</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CONF-22358</td>
<td>Upgrade PDFBox to 1.3.1</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CONF-17968</td>
<td>Page order seems to randomly re-arrange itself</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CONF-24365</td>
<td>PRE elements containing a textnode with only white space is erroneously considered empty by core tinymce code</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>CONF-24330</td>
<td>Confluence editor does not preserve layout when pasting tab characters</td>
<td>Resolved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Confluence 4.1.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.3. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.1 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1.2 Release Notes

03 January 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.1.2, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.1 yet?

Take a look at the new features and other highlights in the Confluence 4.1 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.1.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
## Updates and Fixes in this Release

### JIRA Issues (30 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>CONF-24038</td>
<td>Allow quick insertion of macros, links and embedded content using autoformat</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-23899</td>
<td>Backspacing a bullet item should remove the bullet style only</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-22269</td>
<td>The new “Share” button should allow arbitrary email addresses</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-24233</td>
<td>In Confluence 4.1.1, image (e.g. PNG) and Gliffy diagram attachments on pages which are ‘included’ (and possibly ‘excerpt-included’) on host pages are broken on these host pages.</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-23544</td>
<td>Default macro parameter not accessible within EditorImagePlaceholder#getImagePlaceholder</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-23360</td>
<td>Drag-dropping images into the editor does nothing in FireFox 7</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-23279</td>
<td>Multi-byte characters in macro placeholder aren’t displayed at all.</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-23273</td>
<td>Blog Posts Macro in</td>
<td></td>
<td>🚚 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>Issue Number</td>
<td>Title</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-22867</td>
<td>Viewfile PDF causes Confluence to crash</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-22853</td>
<td>XML export of a small space from in a large system is very slow</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-17147</td>
<td>Edit Link Inside Section Macro Causes Unknown Runtime Error in IE</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-25764</td>
<td>Search times out with specific search terms</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-24157</td>
<td>The attachments macro used in an included page is not displaying attachments from included page, but instead showing attachments from current page</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-24089</td>
<td>Can't escape out of a list item containing a macro body placeholder</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-24028</td>
<td>Copying and pasting a macro placeholder into a table cell only copies the contents of the macro placeholder</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-23981</td>
<td>Fix copying and pasting into a table with more columns than the clipboard contents</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>🔴</td>
<td>CONF-23946</td>
<td>Notification emails get sent with the locale of</td>
<td>🔄</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>PR</td>
<td>Issue Number</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-23700</td>
<td>Drag-and-Drop upload sets incorrect mimeType for Office 2007 and 2010 documents</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-23603</td>
<td>Wrong avatar shows up in &quot;Share&quot; email notifications for Apple Mail and iPhone email client</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-19611</td>
<td>Unable to remove a space - gives a DataIntegrityViolationException</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-16284</td>
<td>viewpdf macro causes OOM when used to view large pdf documents</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-24276</td>
<td>Image attachment on page which is included isn't displayed.</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Duplicate</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-24250</td>
<td>Paste images has broken after re-implementing FF7 drag and drop</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-24107</td>
<td>OFFCONN-50 update webdav plugin for firefox 7</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-24090</td>
<td>Unbolding text causes the page to slowly creep down</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-23844</td>
<td>More weirdness with nested bullets</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-23805</td>
<td>Mention Notifications are in language of sender</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>CONF-23718</td>
<td>Broken Emoticons in Panel Titles</td>
<td><img src="image2.png" alt="Icon" /></td>
<td>Resolved Fixed</td>
<td></td>
</tr>
</tbody>
</table>
Confluence 4.1.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1.2. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.1.x.
3. If your version of Confluence is earlier than 4.1, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.1 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1 Release Notes

13 December 2011

With great pleasure, Atlassian presents Confluence 4.1. With numerous improvements for content presentation, it delivers the extraordinary new Autoconvert feature, along with attractive new image effects, find and replace, new icons, improved translation features and global PDF stylesheets.

Highlights of Confluence 4.1:

- Autoconvert for Pasted Links
- Image effects
- Quick find and replace
- Follow Your Network On the Dashboard
- Space attachments macro
- Global PDF stylesheets
- Use any character in page titles
- New translation feature
- Other improvements
- Helping you transition to the Confluence 4.x generation
- Confluence Quick Reference Guide
- Release notices

Thank you for your feedback:

⭐ More than 35 requests implemented
⭐ Over 185 votes fulfilled

More:

- Read the Upgrade Notes for important information about this release.
- See the full list of issues resolved in this release.

OnDemand Customers

Confluence OnDemand customers will be automatically upgraded to Confluence 4.1 in the next scheduled maintenance window.

Highlights of Confluence 4.1

1

Autoconvert for Pasted Links

When you paste URLs into Confluence, Autoconvert will now analyse what you are pasting and automatically convert it into something that will display well in Confluence. Examples include YouTube videos, JIRA issue queries and Google Maps; many other content types are supported.

YouTube URLs

Create the widget below with Autoconvert, simply by pasting the YouTube URL onto the page.

Paste this:
http://www.youtube.com/watch?feature=player_embedded&v=2XqIqGi0lnk

To get this:
JIRA Issues URLs

Create the JIRA list below with Autoconvert, simply by pasting the JIRA query URL onto the page.

Paste this:  
https://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project...

To get this:

<table>
<thead>
<tr>
<th>JIRA Issues (20 issues)</th>
<th>Key</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-26509</td>
<td>TOC Macro is poorly formatted and uses too much whitespace</td>
</tr>
<tr>
<td></td>
<td>CONF-26503</td>
<td>Dragging content into body macro causes placeholder to shake</td>
</tr>
<tr>
<td></td>
<td>CONF-26501</td>
<td>Dragging content towards the bottom of a page causes editor to jump</td>
</tr>
<tr>
<td></td>
<td>CONF-26484</td>
<td>Implement User Recognition Feature in Confluence</td>
</tr>
<tr>
<td></td>
<td>CONF-26483</td>
<td>Add &quot;pilcrow&quot; (¶) toolbar button in the editor</td>
</tr>
<tr>
<td></td>
<td>CONF-26479</td>
<td>View Access Database Directly From Within Wiki</td>
</tr>
<tr>
<td></td>
<td>CONF-26472</td>
<td>Create a way for a non-internet connected Confluence to check for plugin updates</td>
</tr>
<tr>
<td></td>
<td>CONF-26459</td>
<td>RLC Loader</td>
</tr>
<tr>
<td></td>
<td>CONF-26454</td>
<td>aaaaa</td>
</tr>
<tr>
<td></td>
<td>CONF-26451</td>
<td>Export to html reference links in other spaces with a relative option on export</td>
</tr>
<tr>
<td></td>
<td>CONF-26450</td>
<td>Add &quot;Change&quot;</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>CONF-26446</td>
<td>Inherit Edit Restrictions for Child Pages</td>
<td></td>
</tr>
<tr>
<td>CONF-26439</td>
<td>Search content by certain user/permission combination</td>
<td></td>
</tr>
<tr>
<td>CONF-26434</td>
<td>Add ability to prevent certain users from calling certain user macros</td>
<td></td>
</tr>
<tr>
<td>CONF-26429</td>
<td>Is it possible to display all cards without scrolling the horizontal scroll bar?</td>
<td></td>
</tr>
<tr>
<td>CONF-26425</td>
<td>Add compatibility with iWork Pages on export to Word feature</td>
<td></td>
</tr>
<tr>
<td>CONF-26422</td>
<td>Confluence throws exception when clicking Add Page with no space selected</td>
<td></td>
</tr>
<tr>
<td>CONF-26417</td>
<td>PDF Rendering in Confluence</td>
<td></td>
</tr>
<tr>
<td>CONF-26412</td>
<td>Links with asterisks won't render as a clickable link</td>
<td></td>
</tr>
<tr>
<td>CONF-26411</td>
<td>Blog post macro documentation for excerpts not consistent with functionality</td>
<td></td>
</tr>
</tbody>
</table>

**Google Maps URLs**

Create the **Google Maps Widget** below with Autoconvert, simply by pasting the Google Maps URL onto the page.

**Paste this:**
http://maps.google.com/maps?f=q&source=s_q&hl=en&geocode=&q=san+francisco+golden+gate+bridge...

**To get this:**
Other supported content types:

- Confluence page, blog, comment, status, user links,
- Shared screenshot links from Skitch,
- Google search results links,
- Confluence shortcut links: when pasting these, just the name of the link content (minus the URL prefix) will be used as the link display name.

Image effects

Enhance the presentation of your images and screenshots with slick new border effects.

Click **Effects** to apply taped style, instant camera style, drop shadow style, captions and more.
Quick find and replace

Updating your wiki content is now easier with the new find and replace feature. Using familiar conventions, automatically find and replace specific text strings within your Confluence page or blog. It’s also accessible with a keyboard shortcut **Ctrl-F** (Windows) or **Cmd-F** (Mac OS).

See the documentation for more details.
Follow Your Network On the Dashboard

See recent updates from just the people you follow in Confluence, with the new network tab on the Confluence dashboard. With this, following a few people in different parts of your company to make a quick filter of the main events happening outside your immediate team.

Space attachments macro

The new Space Attachments macro allows you to show all the attachments in the current space on your page. You can even filter them by file extension. Previously, you've only been able to show the attachments on the current page, using the Attachments macro.
Simply type `{space-attachments}` into a page to use it.

## Global PDF stylesheets

Set your custom PDF stylesheets at the global level, as with custom layouts. When there is no specific individual space stylesheet defined, PDF space exports will fall back to this global stylesheet. This means that users won’t have to re-apply the same stylesheet to all their individual spaces. This is an efficient way of achieving one look and feel.

See the [documentation](#) for more details.

## Use any character in page titles

Confluence now allows "special" characters in your page titles, such as semicolons and exclamation marks. This allows more descriptive page names and generally removes restrictions when creating page titles and naming your content.
New translation feature

For those customers working on creating translations of the Confluence user interface, the 4.1 release has a new feature that will help. After opening the Confluence dashboard, you can simply add this text to the end of your Confluence URL, like so:

```
?i18ntranslate=on
```

Then press Enter.

This will then cause each element of the user interface to display its special **key name** while Confluence is still in an interactive mode. This makes it easier to find the essential context for each key, which can then be searched on [http://translations.atlassian.com](http://translations.atlassian.com) where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a "lightning bolt" graphic between elements of the names. For example, the buttons will show up with elements shown like so:

![Example interface with key names](image)

For the **Browse** menu, you can find its associated `system.space.menu` key on [http://translations.atlassian.com](http://translations.atlassian.com). When you use this new translation feature, you can see the full context of the user interface elements. By understanding where a feature appears on the interface, for example the **Browse** menu, you can write a more meaningful translation for your users.

To turn off the translation view, use this:

```
?i18ntranslate=off
```
Other improvements

As always, we have made various small improvements to Confluence.

General improvements

- **Favourites have been refined**
  You'll now see a newly named and cleaner Favourites tab in your personal space. Additionally, the list of favourites is now paginated and you can click the stars to remove favourites.

- **Global plugin & macro timeout setting**
  There is now a globally configurable timeout setting. This will stop pages going into a permanent loading state. In the past, this could lead to instability issues.

- **New JSON RPC**
  Confluence now has a JSON RPC library. This offers a way for Javascript developers to more easily access the Confluence API. For more details, see the documentation.

Editor improvements

- **Copy and paste table improvements**
  You can now copy and paste multiple table rows and entire tables. There are also new keyboard shortcuts. You can now use **Alt+Up Arrow** or **Alt+Down Arrow** to add a row above or below the current row.

- **Copy and paste list improvements**
  If you copy and paste list items from one list to another, the list content will now be joined together as expected.

New icons

- Based on customer feedback, this version of Confluence has a number of redesigned interface and installer icons. These new designs add more of a contemporary look and feel and are aimed at improving icon consistency and ease of use in Confluence.

General Confluence Icon

![General Confluence Icon](image)

Installer icons

![Installer icons](image)

User Interface icons

![User Interface icons](image)
Helping you transition to the Confluence 4.x generation

We've created a set of resources to help you manage the transition to Confluence 4.x. The change management resources are listed under the current documentation.

Note: The Wiki Markup editor has been removed in Confluence 4.x and replaced with a new XHTML-based editor. Please see Why We Removed the Wiki Markup Editor in Confluence 4.0 for full details.

Confluence Quick Reference Guide

Kick-start Confluence adoption with the Origami Necktie – full of tips and tricks to help your users get off the ground running. Get yours now!

Release notices

Upgrading from a previous version of Confluence

We strongly recommend that you back up your Confluence Home directory and your database before upgrading. Follow the normal upgrade instructions to upgrade your test instance to this release.

When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in Cache Performance Tuning) then you may run into memory problems during the wiki to XHTML
migration. We are working to fix this in a later release, but in the meantime you can revert your ehcache.xml to the default version.

**Removed functionality**

Features removed from Confluence

- **Personal labels**
  The ability to create personal labels is being removed in Confluence 4.1. You will still be able to access any personal labels you have created previously by going directly to http://<confluence_url>/users/viewmylabels.action

- **Mail archiving**
  This feature is being disabled by default in Confluence 4.1. However, it is still bundled as the Confluence Mail Archiving plugin, and easy to restore. Current users of the feature will not suffer any interruption, as the feature will be automatically kept in an operational state if you are using it. See details.

- **The SVG graphics library Batik**
  Any plugins that previously relied on the Batik package being provided by Confluence will now have to bundle their own version of Batik into their plugin. See details.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better!

**The Confluence 4.1 team**

**Development**

Ryan Ackley  
Nabeelah Ali  
Richard Atkins  
Niraj Bhawnani  
Joseph Clark  
Paul Curren  
Lachlan Dally  
Chris Darroch  
Anna Dominguez  
Matthew Erickson  
Steven Haffenden  
Chris Kiehl  
Fabien Kraemer  
Daniel Kjellin  
Steve Lancashire  
David Loeng  
Brian Nguyen  
Craig Petchell  
Agnes Ro  
Matt Ryall  
Stefan Saasen  
Sam Tardif  
David Taylor  
Ryan Thomas  
Wesley Walser  
Don Willis  
Joe Xie

**Architecture**

Charles Miller

**Build and release engineering**
Adrián Deccico

**Plugin updates**
David Chui
Philip Cher
Kai Fung Chong

**Management**

**Product management**
Bill Arconati
John Masson

**Product marketing management**
Ryan Anderson
Terrence Caldwell
Matthew Hodges

**Development manager**
Jonathan Gilbert

**Cross Team**

**Design**
Henry Tapia

**Quality assurance**
Joey Corea
Mark Hrynczak
Glenn Martin

**Technical writing**
Edwin Dawson

**Support**

**Sydney support**
Vincent Choy
Partha Kamal
Donna McGahan
Michael Seager

**Amsterdam support**
Tony Atkins
Sherali Karimov
Dennis Kromhout van der Meer

**Brazil support**
Rodrigo Adami
Tiago Kolling Comasseto
Guilherme Heck
Alyson Reis

**Kuala Lumpur support**
Husein Alatas
Janet Albion
Septa Cahyadiputra
Kah Loun Foong
Sim Foo Guan

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Confluence 4.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.1. For details of the new features and improvements in this release, please read the Confluence 4.1 Release Notes.

On this page:

- Upgrade Notes
  - Confluence Clustered reactivated
  - Personal labels deprecated
  - Legacy Crowd SSO Authenticator removed
  - Reduced functionality for JIRA Portlets macro

- Upgrade Procedure
- Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

Upgrade Notes

Confluence Clustered reactivated
Please be aware that **Confluence Clustered** is now available again, following a brief hiatus after the release of Confluence 4.0.

**Personal labels deprecated**

The tab that displays personal labels in the user profile has been hidden in Confluence 4.1. We are planning to remove personal labels altogether from Confluence in a future release. The functionality for creating personal labels is still in Confluence, but we recommend that you stop using them. People can still see their existing personal labels by visiting the following URL:

```plaintext
CONFLUENCE-URL/users/viewmylabels.action
```

Where CONFLUENCE-URL is the URL of your Confluence site.

For example: [https://confluence.atlassian.com/users/viewmylabels.action](https://confluence.atlassian.com/users/viewmylabels.action)

**Legacy Crowd SSO Authenticator removed**

For customers with Crowd SSO authentication who ever used Confluence 3.4.9 or earlier: Customers who were using the `com.atlassian.crowd.integration.seraph.v22.CrowdAuthenticator` in their `seraph-config.xml` must replace this with `com.atlassian.confluence.user.ConfluenceCrowdSSOAuthenticator`. This has been the default Crowd SSO authenticator since Confluence 3.5, so users who installed from scratch with Confluence 3.5 or higher are not affected.

**Reduced functionality for JIRA Portlets macro**

*Upgrade notes updated in March 2012:* In Confluence 4.1, it is no longer possible to add a [JIRA Portlet macro](https://confluence.atlassian.com/display/CONFDOC100987788/Upgrade+Notes+for+JIRA+Portlets+macro) via the Confluence macro browser. It is still possible to add the macro using wiki markup or by copying an existing JIRA Portlet macro. The macro still displays information correctly.

**Upgrade Procedure**

⚠️ **Upgrade a test environment first**

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your [Confluence Home Directory](https://confluence.atlassian.com/display/CONFDOC100987788/Backing+up+your+Confluence+site) and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.5.x, then you *should* upgrade to Confluence 3.5.x before upgrading to Confluence 4.1. There are several reasons for this:
   - There were major changes to user management and LDAP in Confluence 3.5.
   - From version 3.5, you’ll be able to use our new automated Installer / Upgrader to move to 4.1. The
Confluence 4.1 Installer does not support upgrading from earlier versions of Confluence than 3.5.x.

- We recommend that any issues arising from the upgrade to version 3.5.x be fixed separately to those that may arise from upgrading to version 4.1. Please contact Atlassian Support for assistance.
- Please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.)

If you are upgrading from 2.1 or earlier, please read the 2.2 Release Notes.
If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade from version 2.7.x to version 3.5.x, before upgrading to the latest version. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

**RELATED TOPICS**

Confluence 4.1 Release Notes

**Issues Resolved in Confluence 4.1**

Below are the issues resolved in Confluence 4.1, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 4.1 Release Notes for the new features in this release.

**Features and Improvements**

**JIRA Issues** (12 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>📚</td>
<td>CONF-16210</td>
<td>Global custom PDF stylesheet</td>
<td>Resolved</td>
<td>Fixed</td>
<td>90</td>
</tr>
<tr>
<td>🐘</td>
<td>CONF-9458</td>
<td>Remove restrictions on characters in page and blog titles</td>
<td>Resolved</td>
<td>Fixed</td>
<td>53</td>
</tr>
<tr>
<td>🌐</td>
<td>CONF-6351</td>
<td>Attachments macro should allow listing attachments from another page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>32</td>
</tr>
<tr>
<td>Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
<td>Votes</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-3813</td>
<td>Space attachments macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
<td></td>
</tr>
<tr>
<td>CONF-984</td>
<td>Extended Characters to be allowed in Page Title</td>
<td>Resolved</td>
<td>Fixed</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>CONF-7835</td>
<td>Rewrite URLs to internal links if possible.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CONF-4042</td>
<td>Search/Replace support in WYSIWYG Editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>CONF-23730</td>
<td>Performance improvements for /admin/viewgeneralconfig.action</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-24000</td>
<td>Reach parity in behaviour between PageContext#getTextSpaceKey() and ConversionContext#getTextSpaceKey()</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23683</td>
<td>note macro alignment is out unless an optional title is entered</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23567</td>
<td>Autoformat for JIRA URL</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22387</td>
<td>Add a shadow effect to images</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

**Bugs Fixed**

**JIRA Issues (37 issues)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>CONF-23380</td>
<td>Can’t see bottom of some pages in editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>15</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-23578</td>
<td>Cannot delete list item that is before a nested list item in webkit</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-7882</td>
<td>Multiple AttachmentData objects were returned when</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
</tr>
<tr>
<td>ID</td>
<td>Title</td>
<td>Description</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-23551</td>
<td>Multi-byte characters aren't displayed correctly in Code Block Macro.</td>
<td>only one was expected</td>
<td>Resolved</td>
<td>Fixed</td>
<td>11</td>
</tr>
<tr>
<td>CONF-23188</td>
<td>Officially Support IE8</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>CONF-15104</td>
<td>CLONE - System error when adding users to a group if the group name contains certain characters</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>6</td>
</tr>
<tr>
<td>CONF-23816</td>
<td>Null pointer exception when viewing previous version of page</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>CONF-23318</td>
<td>Restore and data import from XML file both fail on Confluence 4.0</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>CONF-23281</td>
<td>Highlight panel text look mis-aligned with icon when there is no title.</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>CONF-24066</td>
<td>Copying and pasting plain text containing brackets into a table cell freezes the editor</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>CONF-24017</td>
<td>Link Text not editable when editing a link to an attachment</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>CONF-23651</td>
<td>Daily updates or changes email contains a broken or blank image</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>CONF-24350</td>
<td>code macro add a &gt; before =</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CONF-24084</td>
<td>Daily email notifications sends empty mails</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>CONF-24058</td>
<td>error when you</td>
<td>Resolved Fixed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Resolution Status</td>
<td>Fix Status</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-23712</td>
<td>Copy and paste content in editor results in indented text and undesirable markup being entered</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-23570</td>
<td>Code in code block macro gets mangled when http:// is included in <code>&lt;a href=&quot;...&quot;&gt;</code> tag.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-24097</td>
<td>Trying to delete bullets from editor results in unselectable hanging bullet</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-24031</td>
<td>Bad constraints on SQL Server</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23982</td>
<td>Documentation Theme does not load resources for atl.general</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23911</td>
<td>Activity Streams may be slow when filtering specifically for &quot;blog added&quot; or &quot;space added&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23881</td>
<td>Code Block displayed incorrectly if &quot;/&quot; is present</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-23865</td>
<td>Pasting a URL that contains</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Key</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Count</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23783</td>
<td>Attachment Migration stores too much in the hibernate session</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23771</td>
<td>Attachment Migration from database to filesystem fails due to filesize mismatch</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23726</td>
<td>Link browser does an unnecessary Search on open</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23725</td>
<td>If you open the Link Browser more than once while editing a page, the up and down keys no longer work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23724</td>
<td>Link browser quick search has no result limit and then displays the results poorly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23721</td>
<td>Selecting link from quick search should clear the search results</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23652</td>
<td>Upgrades can log errors for ignorable errors</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23648</td>
<td>Searching for attachment doesn't highlight attachment in result overview</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23621</td>
<td>Regression: <code>&lt;code:xml/&gt; broken after upgrade to confluence 4.0</code></td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![image]</td>
<td>CONF-23599</td>
<td>Cannot reduce number of</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>
Confluence 4.0.7 Release Notes

17 May 2012

Confluence 4.0.7 is a bug-fix release. The full list of fixes is provided at the bottom of this page.

Don’t have Confluence 4.0 yet?

Take a look at the new features and other highlights in the Confluence 4.0 Release Notes.

Release Notices

- **Security advisory**: This release fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.
- Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.0.7 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (1 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![issue icon]</td>
</tr>
</tbody>
</table>

CONF-23596

**Special characters not rendered in Code Macro**

Resolved  Fixed  0

CONF-21306

**Lucene search characters are not escaped from the dosearchsite.action's contributor query parameter, resulting in a system error whenever users (unwittingly) enter them into the "Who" input field.**

Resolved  Fixed  0

CONF-19730

**Error thrown when search results filtered by Author in Russian**

Resolved  Fixed  0
Confluence 4.0.7 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.0.7. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   ▶ Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.
3. If your version of Confluence is earlier than 4.0, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.0 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.0.5 Release Notes

⚠️ Note: The Wiki Markup editor has been removed in Confluence 4.x and replaced with a new XHTML-based editor. Please see Why We Removed the Wiki Markup Editor in Confluence 4.0 for full details

25 November 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 4.0.5, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.0 yet?

Take a look at the new features and other highlights in the Confluence 4.0 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.0.5 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

## Updates and Fixes in this Release

### JIRA Issues (25 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-24244</td>
<td>Cut. Paste Table row can't be performed to put a row at the bottom.</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23929</td>
<td>Add keyboard shortcut to quickly insert a row before or after the current row</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23842</td>
<td>Copying and pasting list items into an existing list</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23408</td>
<td>Ability for users to copy and paste tables and multiple rows and cells</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-24106</td>
<td>ExcelXMLTextExtractor causes OOME in onDemand</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23809</td>
<td>Mention user name links are occasionally replaced by the page title</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-24096</td>
<td>Crossing out of text does not work</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23911</td>
<td>Activity Streams may be slow when filtering specifically for &quot;blog added&quot; or &quot;space added&quot;</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-23795</td>
<td>Some text boxes in a Powerpoint presentation get flipped horizontally when viewed in Confluence</td>
<td>![ ]</td>
<td><img src="Resolved" alt="Resolved" /></td>
<td>Fixed</td>
</tr>
<tr>
<td>Conf</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Status Notes</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-23658</td>
<td>Links with Multi-byte Characters are Displayed as HTML Escape Characters (&amp;#xxxx;)</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CONF-23650</td>
<td>Confluence serves anchors to the browser as an empty element <code>&lt;a name=&quot;...&quot; /&gt;</code> which the browsers don't handle very well leading to all subsequent text being rendered as a link</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CONF-23554</td>
<td>Russian links in toc follow to wrong places</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-23483</td>
<td>Pasting email links containing upper-case (capital) letters does not autoformat correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONF-23353</td>
<td>jiraissues macro can no longer be rendered by the wiki markup renderer (eg. Dashboard welcome message, User Macros, unmigrated wiki markup blocks)</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CONF-23289</td>
<td>Table Copy / Paste in Safari 5 always copies cell information into another cell instead of contents</td>
<td>Resolved</td>
<td>Duplicate</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CONF-23234</td>
<td>up and down arrow keys should navigate the cursor to the cell above/below in the table</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-23114</td>
<td>Some people not showing up in user autocomplete for Share button</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21043</td>
<td>Excel Sheets with large row count causes out of memory errors</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15937</td>
<td>OutOfMemoryError or while migrating attachments from database to files</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23810</td>
<td>ALT + CTRL + S inserts an illegal control character in safari that prevents the page from being saved</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23727</td>
<td>Share button autocomplete can get in a state where it will not share with a particular email</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23684</td>
<td>Link is not recognized when &quot;Hide External Links From Search Engines&quot; is unchecked</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23456</td>
<td>Copy pasting text into the new editor causes the page to &quot;jump&quot; to the end of the pasted text rather than staying put</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23436</td>
<td>Entity references appear in space descriptions and when editing a space description</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18922</td>
<td>if the last content on a page is a table row, positioning the cursor after it and pressing</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Confluence 4.0.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.0.5. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you **should** upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

3. If your version of Confluence is earlier than 4.0, read the release notes and upgrade guides for all releases between your version and the latest version.

   - Please read the Confluence 4.0 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. **Download** the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

Confluence 4.0.4 Release Notes

**Note:** The Wiki Markup editor has been removed in Confluence 4.x and replaced with a new XHTML-based editor. Please see Why We Removed the Wiki Markup Editor in Confluence 4.0 for full details

08 November 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 4.0.4, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

**Don’t have Confluence 4.0 yet?**

Take a look at the new features and other highlights in the Confluence 4.0 Release Notes.
Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.0.4 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (11 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
Confluence 4.3 Documentation

### Confluence 4.0.4 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.0.4. For details of the fixes in this release, please read the [release notes](#).

#### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you [back up your Confluence Home directory and database](#). The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about [finding your Home directory](#).

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

3. If your version of Confluence is earlier than 4.0, read the [release notes and upgrade guides](#) for all releases between your version and the latest version.

   In particular:
   - Please read the [Confluence 4.0 Upgrade Notes](#).
   - Please read the [Confluence 3.5 Upgrade Notes](#).
If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.0.3 Release Notes

⚠️ Note: The Wiki Markup editor has been removed in Confluence 4.x and replaced with a new XHTML-based editor. Please see Why We Removed the Wiki Markup Editor in Confluence 4.0 for full details.

19 October 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 4.0.3, which is a bug-fix release. 4.0.1 and 4.0.2 were internal releases only.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.0 yet?

Take a look at the new features and other highlights in the Confluence 4.0 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.0.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

Updates and Fixes in this Release

Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.

Confluence 4.0.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.0.3. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration.
information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.

3. If your version of Confluence is earlier than 4.0, read the release notes and upgrade guides for all releases between your version and the latest version.

In particular:
- Please read the Confluence 4.0 Upgrade Notes.
- Please read the Confluence 3.5 Upgrade Notes.
- If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.

### Confluence 4.0 Release Notes

Confluence 4.3 has now been released – see the Confluence 4.3 Release Notes.

**19 September 2011**

With great pleasure, Atlassian presents Confluence 4.0. This is one of the most significant updates to Confluence since its initial release in 2004. With a brand new WYSIWYG editor and wide-ranging user interface improvements, we're confident that Confluence 4.0 is the most productive and user-friendly version to date.

**Highlights of Confluence 4.0:**

- Brand New Editor
- Simplified Editing Experience
- New Macros
- Faster Editing Experience
- Introducing @mentions
- Improved Page Comparison Functionality
- Email Notification Improvements
- New Confluence Installer and Guided Upgrades
- New Editor Plugin Points for Developers
- Other Improvements
- Helping You Transition to Confluence 4.0
- Release Notices

**More:**

- Read the Upgrade Notes for important information about this release.
- See the full list of issues resolved in this release.

**Video of What's New:**

Thank you for your feedback:
More than 215 requests implemented

Over 1050 votes fulfilled

⚠️ Note: The Wiki Markup editor has been removed in Confluence 4.x and replaced with a new XHTML-based editor. Please see Why We Removed the Wiki Markup Editor in Confluence 4.0 for full details

Highlights of Confluence 4.0

1

Brand New Editor

We've rebuilt the Confluence editor from the ground up, bringing you an editing experience that's simpler, faster and richer.

The new Confluence editor delivers many advantages:

- Just one editor!
- New, streamlined user interface.
- Redesigned toolbar with enhanced text formatting (indent paragraphs) and alignment controls.

2

Simplified Editing Experience

Editing in Confluence 4.0 is more visual and more contextual, putting more power at your fingertips.

Table Editing

We've made table operations better in Confluence 4.0 with the following features:

- Drag to Insert Tables
  Inserting tables is now easier and truly "WYSIWYG" with this new feature. Just click on the new Table
dropdown and drag your mouse to choose the number of rows and columns you'd like in your new table.

Oh, and don't worry if you like inserting tables with your keyboard, you can still use autoformatting or CTRL+SHIFT+I to insert a table.

- **New In-Context Table Toolbar**
  The new table toolbar removes the need for a context menu and only appears when you add a table to the page.

- **Merge and Split Table Cells.**

- **Highlight cells, rows or columns.**

- **Cut, copy and paste table rows.**

---

**Improved Image Handling**

- **Paste Images From Clipboard (Firefox and Chrome only)**
  Just copy any image to your clipboard and hit CTRL+V in the editor. The image will get attached and embedded directly into your page. There's nothing to install on your desktop, it just works!

- **Turn Images Into Links**
  Now you can turn images into links. This is especially handy for turning images into a button.

- **Custom Image Sizes**
  If you don't like the preset image sizes, you can now specify an exact image width.

---

- **Search Images**
You can now embed images from other pages using the new Search tab in the image browser.

Simplified Macro Editing

Confluence 4.0 introduces macro placeholders, a visual representation of your macros while editing. Create rich content with new and existing macros, without the tools getting in the way. Makes macros easier to manage while editing.

- **A More Visual Experience**
  Making it easier to visualise what the page will look like when you save it.

- **Macro Properties Panel**
  Every macro has a properties panel. The property panels for particular macros, such as the Status and View PowerPoint macros have additional functionality, as shown in the screenshot below.

- **Quick Access to Macro Editing**
  Double-click the macro to open the Macro Browser for parameter editing. The contents of some macros can be modified directly from the editor.
New Macros

We've bundled more macros with Confluence, and made some of the existing macros better, to help you easily include and present relevant content:

- **Status Macro**
  The Status macro is an easy way to show your status in reports (i.e. red, yellow or green) as a coloured lozenge. You can use the properties panel to quickly change the status.

- **Expand Macro**
  The Expand macro allows you to add a dynamically expandable section of text to your page.
Faster Editing Experience

*Write Wiki Markup ... Fast!*

Many of Confluence’s biggest fans are avid wiki markup users. For you aficionados, we wanted to give you the fastest editing experience possible, while preserving the speed and efficiency of your existing wiki markup skills. So, we present you with Autoformatting!

*Video of Autoformatting in Action:*

*What is Autoformatting?*

Autoformatting lets you type wiki markup into the editor. This new feature will "auto-format" your text on the fly.

To learn more, click on the help button in the editor and select the **Editor Autoformatting** tab.

Try these and see what you think:

- **Font Formatting**
  - Bold, underline, strikethrough, italic, superscript, subscript – just type the markup, such as *Bold*, and watch it convert to **Bold** on the fly!

- **Basic Tables**
  - Try typing |||||, or || **Heading 1** || **Heading 2** ||, then hit enter to to instantly see this:
• **Emoticons**
  All of our emoticons convert on the fly. Try typing :-) into the editor to instantly see this: 😊. It even works for (():), showing this: ✌.

• **Lists**
  For numbered lists, type # and a space at the start of each line.
  For bulleted lists, type * and a space at the start of each line.

• **Headings**
  Type h4. then some heading text to see a level 4 heading.

**New Page Links**

Quickly insert a link to create a page with Autocomplete for links. Simply type `[` in the editor and as you type, Confluence will display a Create Page link if a page with that title does not already exist in your current space.

![Create Page Link](image)

[Introduced in a previous release of Confluence (see details in this blog post), adding links, media and macros can still be quickly added by typing [], ! or { in the editor to add various kinds of content to your page.](image)

**Introducing @mentions**

Confluence 4.0 includes the new @mentions feature. This allows you to easily bring collaborators into a conversation: if you are mentioned in any Confluence content (a page, blog post or comment) you will be notified by email.

To mention someone, type @ and their name, when editing. Mentions will instantly suggest people you are following in your network, so you can quickly find and involve your friends.
Improved Page Comparison Functionality

We've got a better way to view changed content in Confluence.

**Improved Page Diffs**

We've simplified page diffs to make them easier to read. Now, page differences appear exactly as they do in Confluence. Images, text and tables are displayed as rendered. Additionally, page diffs now show changes to both formatting and macros.
Diffs in Email

Where possible, email notifications are now rendered in your email view with the correct diff colour coding.

Email Notification Improvements

New Email Design

All email notifications in Confluence now have a new design. This works in major email clients as well as on the iPhone.
Follow Notifications

Confluence now sends email when someone follows you.

New Confluence Installer and Guided Upgrades

Much to the delight of any sysadmins that are looking after Confluence, the Windows and Linux guided installers are now available.

Guided Upgrades

The new Linux and Windows Installers include an option that allows you to upgrade an existing Confluence 3.5 (or later) installation. This upgrade automates the following tasks for you:

1. Backs up the Installation and Home Directories of the existing Confluence installation.
2. Installs **Confluence 4.0.x** whilst migrating the following from your existing Confluence installation:
   - TCP port values in your existing Confluence installation's server.xml file,
   - The upgrade feature detects and notifies you of any other files in the Confluence subdirectory of your existing Confluence Installation Directory, which have been deleted, added or modified from the default. This informs you of any customisations you will need to manually migrate across to your upgraded Confluence installation directory.

**Simplified Installation Process**

- **Guided installer**: The guided install wizard has been implemented for Confluence 4.0 on both Windows and Linux operating systems. Installing a new instance is a breeze.
- **Easy JIRA Integration**: Hook Confluence up with JIRA, right within the Confluence setup wizard.

**New Editor Plugin Points for Developers**

We've added more editor plugin points for developers. Notable improvements include:

**Editor Plugin Points**

- **Extend the Macro Property Panel**
  Plugin developers can add buttons to the Macro Property Panel in the editor. For example, insert a Gliffy diagram or [see the tutorial](#) on how to do this.

- **Render an Image in the Macro Placeholder**
  A plugin developer can now render an image instead of a placeholder for bodyless macros. For more information, [check out the tutorial](#) on how to do this.

- **Custom Parameter Rendering in Placeholders**
  You can choose to display any parameter in the macro placeholder in the editor, instead of having the placeholder automatically show the first few parameters.

- **New Pluggable More Menu**
  Plugin developers can add items to the editor's More menu. See this [tutorial](#) for details.

**Developer Resources**
• **View Storage Format**
  To assist with plugin developers and help with developer issues, developers running in Dev mode and Confluence administrators can view the page storage format from the Tools menu in Confluence.

• **New API Changes**
  We have disabled the getPage() and getBlogEntry() read methods in the XML-RPC/SOAP API. If you have a script that primarily reads or appends to existing pages, it will break. Creating pages and overwriting existing pages will still work.

• **Plugin Developer Documentation**
  We have created a landing page for Confluence 4.0 planning. This includes resources for plugin developers to help you create new plugins, and make use of the new plugin points, as well as upgrade your existing plugins.

*Infrastructure Changes*

This release includes a number of improvements in the APIs and under the covers as well.

• **Anti-XSS Mode**
  This is now enabled by default for plugins.

• **Alignment and Border Parameters**
  The `alignment` and `border` properties in the macro definition template have been removed.

• **Thumbnail Settings**
  The `Thumbnail maximum height` and `Thumbnail maximum width` settings have been removed from the General Configuration page.

• **Link Browser**
  The Link browser is no longer built in GWT and is now built in core JavaScript.

• **Integration Platform 2.12.0**

• **Upgrade to AUI 3.5.0**

*Other Improvements*

As always, we have made various small improvements to Confluence screens, functionality and supported platforms.

• **Chrome and Internet Explorer 9 Support**
  See the upgrade notes for more information about browser support.

• **Administrator’s task list in the Admin Console**
  This new task list in the Admin Console helps administrators get started after a new install.

• **New keyboard shortcut:**
  `CTRL+SHIFT+E` to preview when you are in the editor; hit 'E' to get back to the editor.

• **Administration UI**
  Help tips have been added to the field descriptions.

• **Quicknav Improvements**
  Quicknav now indicates the space the page is coming from. This helps you find a page that might have the same title across multiple spaces, as well as selecting the first search result by default, making it quicker to open the link.

• **Advanced Linking**
  We’ve updated the Link dialog to cater for these link types: shortcut links, anchor Links, and undefined links (which you can do using Autocomplete).
Helping You Transition to Confluence 4.0

We've created a set of resources to help you manage the transition away from wiki markup. We know your people have become experts with using wiki markup in Confluence, but we think you'll really appreciate the new editor, and we want to make it as easy as possible for you to make the change. The change management resources are listed under the current documentation.

Release Notices

Upgrading from a previous version of Confluence

⚠️ You can only upgrade to Confluence 4.0 from Confluence 3.5. From version 3.5, you'll be able to use our now automated upgrader to move to 4.0. See the Confluence 4.0 Upgrade Notes.

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.

When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in Cache Performance Tuning) then you may run into memory problems during the wiki to XHTML migration. We are working to fix this in a later release, but in the meantime you can revert your ehcache.xml to the default version.

- If you still experience problems, try reducing the 'maxElementsInMemory' attribute on each cache to a very small value such as 50.
- Note that any cache changes you make to work around migration problems should only be considered temporary. You should restore caching to its original settings again after migration has been successful.

Removed Functionality

Features removed from Confluence

- The Edit Page in Word functionality
  This is being removed in Confluence 4.0. Note: This is a different feature to "Edit attachment in Word".
- Mail Page Plugin
  The Mail Page plugin is no longer bundled in Confluence. With the introduction of the “Share Page” feature in 3.5 this is no longer needed.
- Social Bookmarking Plugin
  The Social Bookmarking plugin is no longer bundled in Confluence but is still supported.
- The SnipSnap importer has been removed from the admin console.
- Please be aware that Confluence Clustered is not available for version 4.0 yet. It will be forthcoming in a minor release, following the launch of version 4.0.

Settings removed from Confluence

These settings were removed due to low recorded usage and the ongoing goal of simplifying Confluence.

- The CamelCase Links setting, from general configuration.
- The Number of Ancestors to Show in Breadcrumbs setting.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better!

The Confluence 4.0 Team
Development

Ryan "Lawson" Ackley
Nabeelah "Stitch" Ali
Richard "Karaoke King" Atkins
Niraj "Max Connections" Bhawnani
Joseph "C# forever!" Clark
Paul "Caravan of Courage" Curren
Lachlan "Dilly" Dally
Chris "Daz" Darroch
Anna "A18Z" Dominguez
Matthew "Sony" Erickson
Steven "Lefty" Haffenden
Sam "@Mentions" Haldane
Chris "Killer" Kiehl
Daniel "Threads" Kjellin
Steve "CMD+V" Lancashire
David "Long" Loeng
Brian "The Intern" Nguyen
Craig "Patient Zero" Petchell
Agnes "GWT-free" Ro
Matt "Kermit" Ryall
Stefan "Git FTW" Saasen
Sam "Design School" Tardif
David "Animal" Taylor
Ryan "Bieber" Thomas
Wesley "Weasles" Walser
Don "Not Fun" Willis
Jared "Goonbag" Wyles

Architecture

Charles "Egregious" Miller

Build and Release Engineering

Adrián "Elastic" Deccico

Plugin Updates

David "Calendars" Chui
Philip "The Mac" Cher
Kai Fung "KFC" Chong

Management

Product Management

Bill "Keynote" Arconati
Sherif "Corners" Mansour

Product Marketing Management

Ryan "Phish" Anderson
Terrence "Yet Another CMC Guy" Caldwell
Matthew "Hollywood" Hodges

Development Manager

Jonathan "The Running Man" Gilbert

Cross Team

Technical Writing
Edwin "Rambo" Dawson
Paul "TOC That Rocks" Watson
Sarah "Mad Docs" Maddox

**Quality Assurance**
Joey "Good Morrow" Corea
Mark "Triple Word Score" Hrynczak
Federico "Boy Scout" Silva Armas

**Front-end Development**
Ben "Owie" Buchanan

**Design**
Stephen "Pixels" Russell

**Support**

**Sydney Support**
Renan Battaglin
Vincent Choy
Roy Hartono
Partha Kamal
Donna McGahan
Michael Seager

**Amsterdam Support**
Tony Atkins
Sherali Karimov
Dennis Kromhout van der Meer

**Brazil Support**
Rodrigo Adami
Tiago Kolling Comasseto
Guilherme Heck
Alyson Reis

**Kuala Lumpur Support**
Husein Alatas
Janet Albion
Septa Cahyadiputra
Kah Loun Foong
Sim Foo Guan
Heng Hwa Loi
Joachim Ooi
Hanis Suhailah

**San Francisco Support**
Rick Bal
David Chan
Robert Chang
Ty Davis
Marian Finch
Adam Laskowski
Brad Mallow
Wayne Tombo
Timothy Wong

**Integration Management**
Issues Resolved in Confluence 4.0

Below are the issues resolved in Confluence 4.0, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 4.0 Release Notes for the new features in this release.

Features and Improvements

<table>
<thead>
<tr>
<th>JIRA Issues (49 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>JIRA</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>CONF-22057</td>
</tr>
<tr>
<td>CONF-2803</td>
</tr>
<tr>
<td>CONF-4902</td>
</tr>
<tr>
<td>CONF-5311</td>
</tr>
<tr>
<td>CONF-8268</td>
</tr>
<tr>
<td>CONF-5308</td>
</tr>
<tr>
<td>CONF-4997</td>
</tr>
<tr>
<td>CONF-6007</td>
</tr>
<tr>
<td>CONF-22757</td>
</tr>
<tr>
<td>CONF-20394</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>Issue ID</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>CONF-23145</td>
</tr>
<tr>
<td>CONF-22538</td>
</tr>
<tr>
<td>CONF-21787</td>
</tr>
<tr>
<td>CONF-20174</td>
</tr>
<tr>
<td>CONF-18696</td>
</tr>
<tr>
<td>CONF-17518</td>
</tr>
<tr>
<td>CONF-16568</td>
</tr>
<tr>
<td>CONF-10280</td>
</tr>
<tr>
<td>CONF-9912</td>
</tr>
<tr>
<td>CONF-8977</td>
</tr>
<tr>
<td>CONF-5978</td>
</tr>
</tbody>
</table>
### Bugs Fixed

#### JIRA Issues (200 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🐛</td>
<td>CONF-6992</td>
<td>Markup umbrella issue - errors switching between modes or rendering escaped content</td>
<td>Resolved</td>
<td>Fixed</td>
<td>139</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-4907</td>
<td>Rich text editor indenting feature does not seem to work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>67</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-10058</td>
<td>Links in macro bodies not updated on rename page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>51</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-14374</td>
<td>RTE is showing extra line breaks and space characters on IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>31</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-4435</td>
<td>When indents used in a table (eg list items) there appears to be no way to stop indenting further text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>23</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-17582</td>
<td>Missing attachments causes Confluence page move to other space to fail</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-8207</td>
<td>Extra <code>\</code> line breaks added by rich text editor near macros and images</td>
<td>Resolved</td>
<td>Fixed</td>
<td>19</td>
</tr>
<tr>
<td>🐛</td>
<td>CONF-5895</td>
<td>Switching between editing modes doesn’t preserve backslash escapes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>18</td>
</tr>
<tr>
<td>Key</td>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution</td>
<td>Fixation</td>
<td>Status</td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------</td>
<td>--------</td>
</tr>
<tr>
<td>CONF-3844</td>
<td>Anchor links to the current page break when included in a different page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CONF-11599</td>
<td>Link from comment or page to blog attachment doesn't work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>17</td>
<td></td>
</tr>
<tr>
<td>CONF-5950</td>
<td>Rich Text Editing destroys layout when using User Macros</td>
<td>Resolved</td>
<td>Fixed</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>CONF-17385</td>
<td>Anchor Name must be unique following the HTML 4 standard</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>CONF-16526</td>
<td>RTE incorrectly escapes code syntax within macros</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>CONF-5258</td>
<td>Escaped backslash is lost in WYSIWYG -&gt; wiki markup roundtrip</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>CONF-20692</td>
<td>google-caja warnings cluttering atlassian-confluence.log file upon Confluence startup</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>CONF-7595</td>
<td>WYSIWYG editor adds unnecessary double backslashes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>CONF-5228</td>
<td>Table editing bugs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>CONF-13434</td>
<td>Image size settings are corrupted on round tripping</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CONF-9929</td>
<td>Rich Text Editor handling of macros with body markup is buggy and/or incomplete</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Conf</td>
<td>Issue</td>
<td>Description</td>
<td>Status</td>
<td>Severity</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>-------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-8722</td>
<td>Shortcut links in content moved between spaces append the space key of the previous space to the shortcut link</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CONF-21371</td>
<td>Page move fails with deep page hierarchy</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-20774</td>
<td>Pages with toc macro do not fully render after restoring Site or Space XML backup</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-7262</td>
<td>Can't escape double-backslash (like &quot;&quot;) in wiki markup editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-22292</td>
<td>Image lightbox popup fails to render on some IE8 systems</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>CONF-20444</td>
<td>Floating footer bar</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>CONF-15990</td>
<td>Cannot edit panel macro in RTE using the macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>CONF-12566</td>
<td>In wiki markup-mode completely erased content reappears in rich text-mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>CONF-11830</td>
<td>WYSIWYG corrupts consecutive escaped characters</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>CONF-17477</td>
<td>Linked image does not work on IE when align=left or align=right is used</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-9029</td>
<td>Superscripts, eg for floating point notation, are lost</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONF-8677</td>
<td>Changes to panel macro’s title does not take effect when editing using Rich Text mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-22263</td>
<td>PDF export doesn't render the content of a code macro inside an include macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-21780</td>
<td>Updated: Cannot produce special characters using AltGr due to RTE keyboard shortcuts</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-21375</td>
<td>Pasting blocks of text in to the Rich Text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-18010</td>
<td>Additional escape character added when bold and strikethrough surround a macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-11962</td>
<td>Using (excerpt-include) in (excerpt) does not render wiki markup correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-11032</td>
<td>Switching between editor modes breaks the (include) macro wrapped in a link markup</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-7767</td>
<td>When using a line break () followed by a table, the table heading does not render properly due to additional characters</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-6041</td>
<td>Headings declared in list items break the</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>CONF-5426</td>
<td>Switching between editors changes markup with + characters</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
</tr>
<tr>
<td>-----</td>
<td>-----------</td>
<td>-------------------------------------------------------------</td>
<td>----------</td>
<td>-------</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>CONF-4920</td>
<td>Color tags surrounding a link are not rendered correctly by WYSIWYG</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>CONF-22372</td>
<td>include and excerpt-include macros do not render wiki markup if they are part of an excerpt</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-21026</td>
<td>link to attachment with @ in filename is broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-19917</td>
<td>Round-trips after entering image markup with width parameter (with quoted value) along with a page rename causes INVALID_CHARACTER_ERR error</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-16434</td>
<td>RTE: Links containing a hyphen save with an alias, even if not necessary breaking renames</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-15708</td>
<td>Link text with blackslashes followed by some characters render incorrectly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-14278</td>
<td>Asterix and quote characters mangled with output when using bold, quote and text color in RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-13422</td>
<td>excerpt-include macro is not rendering wiki markup correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-11547</td>
<td>Links with strikethru are duplicated by the rich text editor in IE and Safari</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-10846</td>
<td>list inside table is rendered outside when table immediately follows list item</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-10451</td>
<td>Merge of concurrent page edits seems broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-7907</td>
<td>Multiple underscores entered into Rich Text Editor should be individually escaped</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-7219</td>
<td>Square [] brackets in image filename should be automatically escaped by !this syntax!</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-5655</td>
<td>Adding macros with attributes using separators (!) in rich text (WYSIWYG) breaks</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-5569</td>
<td>First image inserted with Rich Text Editor actually inserts wiki tag as text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-22185</td>
<td>Insert image in rich text editor doesn't follow up formatting</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-21410</td>
<td>Copy and paste of emoticons shows broken image icon in IE7 and IE8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-21056</td>
<td>Confluence Wysiwyg icons are truncated when browser is resized manually</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-21020</td>
<td>Round-tripping between RTE and Wiki Markup causes WiKi Markup that contains bullets and BlockQuote macro to mangle</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-21005</td>
<td>Improper size of image in Rich Text Editor mode during editing as to compare with in Wiki Markup or Preview mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-20381</td>
<td>Round-tripping between RTE and Wiki Markup causes sub-item bullet to mangle if the preceding bullet has emoticon at the end of the line</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-20197</td>
<td>Make Wiki Markup editor's Full notation guide keyboard navigable</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-20128</td>
<td>Switching between Editor and Wiki Markup containing at least two links will cause second link to add new line space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-19711</td>
<td>&quot;Edit in Word&quot; resizes former thumbnail to normal size</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-14506</td>
<td>The combo of a bulleted list (and numbered list) w/ a heading inside a table creates the error condition</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Fixes</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>1</td>
<td>CONF-10622</td>
<td>Text is not spaced when image/thumbnail is aligned to the left</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>CONF-7244</td>
<td>Hyphen is not escaped when switching between RT and Wiki, causes strikethrough</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>CONF-6405</td>
<td>Unexpected behaviour with multiple escape characters in editors</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>CONF-25068</td>
<td>Link to attachments with special characters (i.e. &quot;@&quot;) does not work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>CONF-24795</td>
<td>Failure to save when editing long pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>CONF-23850</td>
<td>Thumbnail does not expand when using Windows 7 x64bit</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>CONF-23323</td>
<td>Make cursor handling around placeholders in webkit and firefox more robust</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>CONF-23173</td>
<td>Error rendering JIRA issues macro on release notes page: &quot;Unable to determine if sort should be enabled&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>CONF-22386</td>
<td>Problem Creating Link to a Page when the Page Title contains &quot;-&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>CONF-22084</td>
<td>Unresponsive</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Severity</td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>CONF-21898</td>
<td>Corrupt Anchor Link After Copying a Page if RTE is Marked as Default</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-21042</td>
<td>Image file attached to Confluence page is not displayed, if its filename contains some specific characters</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-21030</td>
<td>Changing the colour of a link in the Rich Text Editor can break the link</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20817</td>
<td>Autocomplete for links doesn't work with apostrophes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20382</td>
<td>Round-tripping between RTE and Wiki Markup will break bullets formatting inside some macros such as {panel}, {quote}, {note}, etc if heading is preceding the macros</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20331</td>
<td>&quot;\n\n&quot; added when switching from wiki-markup to rich-text mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20177</td>
<td>Bold markup gets reliably corrupted to/from WYSIWYG editor with certain sequences of escaped literal *</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-19158</td>
<td>Frequent logins by one user across a cluster lead to errors</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-19134</td>
<td>Page title with</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-18928</td>
<td>Autocomplete doesn't create links for special character pages correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-18694</td>
<td>Autocomplete: A link inserted onto coloured text will not display the colour</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-18200</td>
<td>Editor appends new line after heading</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-17972</td>
<td>PageManager getById can return a Page.class for a blogpost or other non-page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-17923</td>
<td>Unable to add content beneath a table when in RTE mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-16693</td>
<td>When editing a page, embedded images do not display according to the align parameter</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-16566</td>
<td>Rich Text Editor allows table resizing but changes are not saved</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-16493</td>
<td>Increasing backslashes in table cells</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-16035</td>
<td>Image macro: Markup is corrupted by round-tripping when there are square brackets in the filename</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-15460</td>
<td>Rich Text editor removes bold and italics from nolink macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Conf. ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-14665</td>
<td>Strikethrough around monospace can produce very odd results</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-14036</td>
<td>Problem with strikethrough of an eMail address in Rich Text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-13464</td>
<td>Links containing images with center alignment break when converted from the rich text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-12542</td>
<td>Links containing macros with empty body are broken when edited in Rich Text Editor (RTE)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-9329</td>
<td>Duplicate content when &quot;Save&quot; button is being clicked twice during page editing</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-8901</td>
<td>WYSIWYG editor turns &lt;BR/&gt; into &lt;BR/&gt; &lt;/BR&gt; inside HTML macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-7811</td>
<td>Border around image does not appear when generating a PDF</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-5771</td>
<td>Confluence loses wiki source formatting since the WYSIWYG-Editor was introduced</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-5269</td>
<td>WYSIWYG breaks excerpt-include macro when used as link tip</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-25886</td>
<td>Login fails if total</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Code</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Count</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>1</td>
<td>CONF-25414</td>
<td>Number of failed login attempts is too large</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>CONF-24055</td>
<td>Search Macro Causes TOC Malfunction</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>CONF-24044</td>
<td>Renaming Page doesn't update Link in Table</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>CONF-23836</td>
<td>Sublinks inside a macro break when a page is moved to another space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>CONF-23717</td>
<td>Exporting a space to pdf/word/html leaves the links in the export document pointing back to the wiki rather than referencing itself.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>CONF-23090</td>
<td>Wysiwyg editor messup links in content</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>CONF-23066</td>
<td>Internal page links (with custom link aliases) on a page moved to a new space, get the space key of the originating space prefixed to their actual alias text.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>CONF-23045</td>
<td>Use of hash characters within Code Block Macro creates hyperlinks; using a slash to escape works but slash remains visible</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>CONF-22950</td>
<td>Upgrade Tasks fail when</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-XXXX</td>
<td>Issue Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-22938</td>
<td>Can't insert a link with an associate image</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22871</td>
<td>Include mp4 in the multimedia macro description in the dialog</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22866</td>
<td>Plugin manager is initialised inconsistently during setup process</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22793</td>
<td>Fix german translation for &quot;custom&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22737</td>
<td>Lost position on copy/paste in newcode plugin</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22698</td>
<td>Missing group and world execute permissions in bin/ scripts in tarball</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22485</td>
<td>Markup of &quot;**&quot; is being corrupted when Edited in Rich Text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22424</td>
<td>Plugin fails to start with &quot;NoSuchBeanDefinitionException: no unique bean of type&quot; error due to duplicate interfaces in host component exports</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22346</td>
<td>Typos in the default language resource</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22261</td>
<td>&quot;What's new in Confluence 3.5&quot; banner fails</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22180</td>
<td>Thumbnail zooms behind embedded powerpoint</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-22151</td>
<td>Missing german translation on labels page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22125</td>
<td>java.util.logging (jul) is blocking ehcache gets</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22029</td>
<td>The What's New popup doesn't appear by default</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22024</td>
<td>Changing color of links in Rich Text breaks table layouts</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21983</td>
<td>Escaping of strikethrough and italics lost when editing previously escaped text in Rich Text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21969</td>
<td>Move page notifications have incorrect user in the from address</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21877</td>
<td>Strange question mark parsing anomaly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21799</td>
<td>Strikethrough text does not save in Rich Text editor in Chrome and Safari</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21684</td>
<td>Switching from Wiki Markup to Rich Text Editor causes the first line of text in the page to be replicated many times</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21581</td>
<td>Labelled spaces aren't shown in the list of content when browsing by label</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21576</td>
<td>Selecting some text effects consecutively</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-21483</td>
<td>The structure of list in editor is broken when using with shortcut links.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21479</td>
<td>Hitting Enter in the Macro Browser cancels instead of inserting</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21445</td>
<td>Mispelling at &quot;Insert 'Table of Contents' Macro&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21307</td>
<td>Escaping of rich edit component is not consistent with wiki escaping.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21123</td>
<td>Network notifications for move page use the last editor, not the mover</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21031</td>
<td>Move Page dialog: Text is cut off when language is set to german</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21011</td>
<td>Seeing null wiki markup link when linking to an old version of a page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20915</td>
<td>Copying and pasting links that use the color macro doesn't work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20908</td>
<td>Rich Text Editor Inserts Extra Lines using FireFox</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20893</td>
<td>Copy/Paste problem of (code) in Rich Text Editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20849</td>
<td>Underline button can get out of synch in Safari</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Title</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>----------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-20596</td>
<td>Rich Text mode inconsistently escapes emoticons</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20344</td>
<td>Rich text editor strips characters from code blocks.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20198</td>
<td>Space character behind a macro can be swallowed when switching editors in Internet Explorer</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20151</td>
<td>Formatting in the RTE should be rendered at the back end</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19990</td>
<td>Problems when creating link in wiki markup with a trailing space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19915</td>
<td>Round-trips causing Form Field Markup to be rendered incorrectly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19712</td>
<td>Unable to copy a double indented bullet point in RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19697</td>
<td>Linefeed is not rendered properly when using Doc Import or Edit in Word</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19584</td>
<td>RTE instead of completely removing all formatting associated with heading only removes line feed leaves tags for color &amp; bold</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19354</td>
<td>Image dialog double-escapes html characters in invalid file names</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19267</td>
<td>Copy from Gmail and Paste to</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Count</td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-19111</td>
<td>Macro Browser parses parameters differently in Rich Text compared to Wiki Markup</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-19091</td>
<td>German translation of Link Location causes a UI problem in the Link Browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-18945</td>
<td>There is no way for new users to know about having to enable the context menu.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-18943</td>
<td>Can't add a link to a page that doesn't exist (even by typing the page name into the Add Link dialog).</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-18919</td>
<td>Autocomplete in Full Screen not working for IE browsers</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-18441</td>
<td>Search Results Image Previews: Preview is not shown when there is a double quote in the filename.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-17792</td>
<td>RTE discards leading spaces when copying and pasting</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-17447</td>
<td>Incorrect path displaying</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-17428</td>
<td>Switching between rich text editor to wiki markup removes bulleted list</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📲</td>
<td>CONF-17125</td>
<td>Custom</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Ticket</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17021</td>
<td>RTE changes automatically ([\text{<a href="mailto:somebody@somewhere.com">mailto:somebody@somewhere.com</a></td>
<td>phone:+1234]}) into ([\text{<a href="mailto:somebody@somewhere.com">mailto:somebody@somewhere.com</a>}]) after saving page.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16397</td>
<td>Page/space watches notification contains full contents despite option is unchecked</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16352</td>
<td>Cursor should remain in place when applying formatting in the RTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16300</td>
<td>Text that looks like a hyperlink in a color tag in a link alias is broken by the Rich Text Editor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16052</td>
<td>Edit and copy an emoticon in a table results in table row being split into two rows</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15878</td>
<td>RTE inserts unwanted new lines into metadata tables</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15874</td>
<td>RTE - Paste into a code block lose the line orientation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15855</td>
<td>Wiki Markup around inline macros is not rendered in wysiwyg mode and therefore lost</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15853</td>
<td>Links containing inline macros round-trip badly using RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15847</td>
<td>Editing an image in the RTE with IE causes a default height and width to be added</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15715</td>
<td>Links are broken by roundtripping if the user does not have permission to view the linked space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15698</td>
<td>New lines in heading tags inside tables are lost when round tripping</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15572</td>
<td>Emoticons cannot be used as link alias in the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15225</td>
<td>Formatting lost after typing in RTE around macro start/end tags</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14842</td>
<td>Switching editor causes curly bracket being deleted in <code>{}</code></td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14788</td>
<td>Bulleted lists in the WYSIWYG Editor can no longer have blank lines between items</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14750</td>
<td>in IE, a table following immediately after a heading is lost when switching to wiki-markup mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14241</td>
<td>html macro loses following space on IE after roundtripping</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14232</td>
<td>Pasted entities</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Comments</td>
</tr>
<tr>
<td>-----</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-14204</td>
<td>Roundtrip through wysiwyg breaks whitespace within noformat macro within color macro in IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-14169</td>
<td>Monospace bullets lose newline when edited with Rich Text Editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13830</td>
<td>Links that contain ^ (ie attachment filenames) are interpreted as wiki markup and are rendered as superscript rather than links</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13827</td>
<td>RTE adds unrequested alias to attachment links that contain apostrophes, breaking the links</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13511</td>
<td>When resizing images with scaled width and height parameters in the RTE, they do not correctly get updated</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13432</td>
<td>Rich Text editor breaks badly on &quot;file:&quot; text in page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13377</td>
<td>Pressing enter several times when editing a table in the RTE results in a new row after saving</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>🔄</td>
<td>CONF-13239</td>
<td>Formatting text in lists is inconsistent with formatting paragraph text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>
Confluence 4.0 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.0. For details of the new features and improvements in this release, please read the Confluence 4.0 Release Notes.

On this page:

- Upgrade Notes
  - Content updates after upgrade
  - User macros migration
  - Email notifications
  - Plugins may not be compatible with Confluence 4.0
  - Functionality removed: converting a Global Space to a Personal Space
  - Functionality removed: editing a Confluence page in an Office application
  - Functionality removed: linking to comments using commentid
  - Functionality removed: Mail Page plugin
  - Functionality removed: Social Bookmarking plugin
  - Drag-and-drop in Internet Explorer 9
  - Various admin settings removed
Upgrade Procedure
Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

Upgrade Notes

Content updates after upgrade

You will notice once you upgrade to Confluence 4.0, every page will have been edited during the migration process. This manifests itself in the appearance of changes to every page's content by various different users. When migrating pages, Confluence will show the same username that last contributed to your content as the author of the change. This is the upgrade task of migrating your wiki page storage format to XHTML from Wiki Markup. Do not be alarmed by this. This will only happen once for all current versions of content. This will not trigger email notifications, but will update your RSS feeds. Where possible, a change comment of "Upgraded to Confluence 4" will be added to pages and blog posts.

User macros migration

After upgrading, user macros will not be able to be inserted until they have defined macro parameters. See Guide to User Macro Templates. Defining macro parameters will mean that they can once again insert these user macros.

Email notifications

With the update of the email templates, the textual content of the notifications has also changed. These wording changes may invalidate any email filters set up to label or organise your email notifications.

Plugins may not be compatible with Confluence 4.0

To check your plugins are compatible with Confluence 4.0, see the Universal Plugin Manager (UPM) under Confluence Admin > Plugins > Confluence Upgrade Check. Here, you can select the new version of Confluence and see whether your existing plugins are compatible. If your custom plugins are not working following the upgrade to Confluence 4.0, see the Plugin Development Upgrade FAQ for 4.0 for guidance on how to solve this issue.

Functionality removed: converting a Global Space to a Personal Space

Confluence 4.0 does not offer the ability to convert a global space to a personal space. Our research has shown that this feature is not used much. We have decided to remove it as part of our ongoing mission to simplify Confluence where possible. We deprecated this functionality in the Confluence 3.5 Upgrade Notes.

Functionality removed: editing a Confluence page in an Office application

After extensive usability testing, we are confident the new Confluence 4.0 editor will be easier to learn and more reliable to use than the previous editor. Therefore this feature is no longer required. Other functions of the Office Connector (e.g. "Edit Attachments in Office") remain.

Functionality removed: linking to comments using commentid

Confluence 4.0 does not allow linking to comments by comment ID. Users will now have to use the permalink URL to link to comments. This will primarily affect plugin developers.

Functionality removed: Mail Page plugin

The Mail Page plugin is no longer bundled in Confluence. With the introduction of the "Share Page" feature, this is no longer needed.

Functionality removed: Social Bookmarking plugin

The Social Bookmarking plugin is no longer bundled with Confluence as of the 4.0 release. Our research has
shown that this feature is not used much. If you are currently using this plugin, you will need to reinstall it from plugins.atlassian.com. Atlassian continues to fully support this plugin.

**Drag-and-drop in Internet Explorer 9**

Internet Explorer 9 does not support the drag-and-drop functionality of HTML5. This means that when using IE9, you will not be able to use the attachments drag-and-drop feature in Confluence 4.0.

**Various admin settings removed**

In Confluence 4.0, rarely used admin settings have been taken out. These are as follows:

- The Set Site Support Address setting,
- The CamelCase Links general configuration setting,
- The Number of Ancestors to Show in Breadcrumbs setting,
- The SnipSnap Importer settings.

**Confluence Clustered delayed**

Please be aware that Confluence Clustered is not available for version 4.0 yet. It will be forthcoming in a minor release, following the launch of version 4.0.

**Upgrade Procedure**

⚠️ **Upgrade a test environment first**

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0. There are several reasons for this:
   - There were major changes to user management and LDAP in Confluence 3.5.
   - From version 3.5, you’ll be able to use our new automated Installer / Upgrader to move to 4.0. The Confluence 4.0 Installer does not support upgrading from earlier versions of Confluence than 3.5.x.
   - We recommend that any issues arising from the upgrade to version 3.5.x be fixed separately to those that may arise from upgrading to version 4.0. Please contact Atlassian Support for assistance.
   - Please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.)

If you are upgrading from 2.1 or earlier, please read the 2.2 Release Notes.

If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade from version 2.7.x to version 3.5.x, before upgrading to the latest version. For more details, please refer to CONF-11767.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

**Checking for Other Known Issues and Troubleshooting the Confluence Upgrade**

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence...
after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to [troubleshooting upgrades](#) in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a [support ticket](#) and one of our support engineers will help you.

**RELATED TOPICS**

Confluence 4.0 Release Notes

**Older Releases**

These Confluence versions were released earlier than the current major release series.

- [Confluence 3.x.x Releases](#)
- [Confluence 2.x.x Releases](#)
- [Confluence 1.x.x Releases](#)

**Confluence 3.x.x Releases**

- [Confluence 3.0.1 Release Notes](#)
  - [Coherence license changes SEPT 2009 - new Standard and Clustered Confluence Editions](#)
  - [Confluence 3.0.1 Upgrade Notes](#)
- [Confluence 3.0.2 Release Notes](#)
  - [Confluence 3.0.2 Upgrade Notes](#)
- [Confluence 3.0 Release Notes](#)
  - [Confluence 3.0 Known Issues](#)
  - [Confluence 3.0 Upgrade Notes](#)
  - [Confluence 3 Performance improvements](#)
    - High Load Cluster
    - High Load Single Node
    - Medium Load Cluster
    - Medium Load Single Node
    - Peak Load Cluster
    - Peak Load Single Node
  - [Issues Resolved in Confluence 3.0](#)
- [Confluence 3.1.1 Release Notes](#)
  - [Confluence 3.1.1 Upgrade Notes](#)
- [Confluence 3.1.2 Release Notes](#)
  - [Confluence 3.1.2 Upgrade Notes](#)
- [Confluence 3.1 Release Notes](#)
  - [Confluence 3.1 Known Issues](#)
  - [Confluence 3.1 Upgrade Notes](#)
  - [Issues Resolved in Confluence 3.1](#)
- [Confluence 3.2.1 Release Notes](#)
  - [Confluence 3.2.1 Upgrade Notes](#)
- [Confluence 3.2 Release Notes](#)
  - [Confluence 3.2 Upgrade Notes](#)
  - [Issues Resolved in Confluence 3.2](#)
- [Confluence 3.3.1 Release Notes](#)
  - [Confluence 3.3.1 Upgrade Notes](#)
- [Confluence 3.3.3 Release Notes](#)
  - [Confluence 3.3.3 Upgrade Notes](#)
- [Confluence 3.3 Release Notes](#)
Confluence 3.0.1 Release Notes

20 August 2009

Confluence 3.0.1 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the security advisory for details of the security vulnerabilities, risk assessments and mitigation strategies.
Critical issue affecting non-clustered implementations of Confluence 3.0.1

Non-clustered (i.e. you do not have a clustered license) implementations of Confluence 3.0.1 are affected by an issue that can cause Confluence to crash. Please read the Confluence 3.0.1 Upgrade Notes for details on the issue and instructions on how to address it.

Attachment Handling Fixes

When a hierarchy of pages was moved from one space to another, the attachments on child or descendent pages of the parent page were not correctly moved. Instead, users would have to move one page at a time between spaces in order to maintain page attachment integrity. This issue has now been resolved.

Sporadic issues associated with attachment migration occurred when upgrading from either Confluence 2.9.x or 2.10.x, to 3.0. These have now been fixed.

Macro Fixes

A bug was identified in which excerpted content would not be rendered in a blog post macro until the source page containing that content had first been viewed. This phenomenon could occur when excerpt include macros were used in a blog post. It could also occur when excerpt macros were used in a blog post in conjunction with the content=excerpts blog post macro parameter. This problem has now been fixed.

An issue was found with the tasklist macro whereby special characters used in its title were not correctly escaped. This has now been resolved.

Rich Text Editor Fixes

A bug was identified in which the Rich Text Editor's link removal feature (available from the right-click context menu) did not work with external links. This has now been resolved.

In the Firefox web browser, the spell checker is now automatically enabled by default in the Rich Text Editor. Users no longer have to first disable the link removal menu and then enable and select 'Check Spelling' from the Firefox's own right-click context menu.

An issue was identified, which prevented the ability to escape from the quote text effect once it had been selected. This has now been addressed, such that a paragraph is automatically added after selecting this text effect.

Other Enhancements and Fixes

When a Confluence administrator first installs Confluence, runs through the Confluence Setup Wizard and then reaches the database configuration step, the database password is now hidden and is no longer shown in clear text.

It is now possible to filter network RSS feeds by different content types. This is achieved by implementing parameter modifications to the RSS feed link in your RSS newsreader. For more information, please refer to Subscribing to a Network RSS Feed.

Some customers experienced problems importing their site backup from a previous version of Confluence into version 3.0. This has now been resolved in Confluence 3.0.1.

An issue was identified in which multiple blog posts posted on a single day would be listed out of chronological order. This has now been fixed and multiple blog posts posted on a single day are now ordered according to their time of creation.

A problem was identified when accessing Confluence content in Internet Explorer that caused file downloads to fail over an SSL connection. This problem has now been fixed in this release of Confluence.
An issue was found in the page tree views on instances of Confluence running on Weblogic 10.x. This has now been resolved.

There's a complete list of fixes below. Click a specific issue to see details of the fix.

**Don't have Confluence 3.0 yet?**

Take a look at the new features and other highlights in the [Confluence 3.0 Release Notes](https://confluence.3.0). [Download Latest Version]

**Upgrading from a Previous Version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the [Confluence 3.0.1 Upgrade Notes](https://confluence.3.0.1). We **strongly recommend** that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

### JIRA Issues (44 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-16141</td>
<td>Directory traversal in Profile Picture path - leads to privilege escalation in &lt; 3.0</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16136</td>
<td>XSS vulnerability can be exploited on the WebDAV Configuration page</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16135</td>
<td>XSS vulnerability in space name when page move would create a duplicate</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16348</td>
<td>Attachment File Not Found - in children pages when a page is moved to another space</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16019</td>
<td>XSS vulnerability when moving page between spaces</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16509</td>
<td>Upgrading from any version before 2.9 to 3.0 doesn't migrate attachments</td>
<td>![ ]</td>
<td>![ ]</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16466</td>
<td>Attachment migration from 2.10 to 3.0 fails</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16420</td>
<td>Update PDF export plugin to be compatible with new cluster/cache architecture</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16311</td>
<td>Build a Standard Edition of Confluence 3.0 (without Coherence)</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16225</td>
<td>Some bundled themes don't support web resource injection</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16209</td>
<td>XSS in PDF screen</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16084</td>
<td>Cannot filter a network feed by contentType</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16016</td>
<td>The JIRA Issues Macro in the Macro Browser is missing two parameters - &quot;renderMode&quot; and &quot;baseUrl&quot;</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16014</td>
<td>Blog Posts Macro only renders excerpts if target page has been rendered</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-16005</td>
<td>The Favourite Pages Macro in the Macro Browser is missing its &quot;Maximum Number of Results&quot; parameter</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-15997</td>
<td>Invalid error message when</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15970</td>
<td>XSS in user links</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15940</td>
<td>Server Base URL not set when sending a support request email...</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15923</td>
<td>Unlink in RTE doesn't work for external links</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15908</td>
<td>Tasklist macros double escaping titles in IE</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15788</td>
<td>Unable to import site backup during set up of Confluence 3.0</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15751</td>
<td>Cursor jumps to beginning of the page from new paragraph after cancelling the Macro Browser on Firefox</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15722</td>
<td>The DynamicTaskList2 plugin provides an explicit description making it impossible to internationalised</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15701</td>
<td>Passwords are visible when configuring database</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15610</td>
<td>New look for user email preferences needs its layout fixed</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-15001</td>
<td>Firefox 3 does not enable the spell checker on the comment text area by default</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![Icon]</td>
<td>CONF-14276</td>
<td>Unable to create renderer-compo</td>
<td>![Resolve]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13702</td>
<td>Session must not be invalidated on logout</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13482</td>
<td>Can't get out of blockquote format in the rte</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12576</td>
<td>Duplicate friendly cache names which result in cache statistics not being visible</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-10607</td>
<td>Blog posts appear in wrong order</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8098</td>
<td>User browser shows duplicate accounts when a user exists both locally and in LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16552</td>
<td>Renaming the ehcache config file fails on windows</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16218</td>
<td>Add a note into the admin screen explaining that you can use wiki markup and even an include macro to put an actual page onto the dashboard.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16037</td>
<td>Misleading message when removing page permissions through info page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16017</td>
<td>The JUnit Macro in the Macro Browser is missing one parameter - &quot;debug&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15995</td>
<td>User Profile page does not indicate why</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Click here to open a report on http://jira.atlassian.com for Resolved or Closed issues in Confluence 3.0.1.

**Coherence license changes SEPT 2009 - new Standard and Clustered Confluence Editions**

**Summary**

**Oracle Coherence** (formerly known as Tangosol Coherence) is the technology that provides clustering and distributed caching in Confluence. It has also been used for caching purposes in non-clustered Confluence deployments.

The Oracle Coherence technology was first incorporated into Confluence version 2.3. Since then, Atlassian has been able to distribute the Coherence technology library files via the following means:

- Included with all versions and distributions of Confluence downloadable from our web site since version 2.3, regardless of whether these were intended for clustered or single-server installations.
- From the Atlassian Maven repositories.

However, Atlassian is about to enter a new license agreement with Oracle over the Coherence technology. This means that from late September 2009, Atlassian will only be permitted to distribute the Coherence library files to customers who have purchased a license for it (that is, a Confluence clustered license).
As a result, the following changes will occur:

- The next version of Confluence (3.0.1) will be released in two editions:
  - **Standard** — Editions of Confluence without the Coherence library files. Ehcache will replace the local caching functionality previously provided by the Coherence technology.
  - **Clustered** — Editions of Confluence containing the Coherence library files.
- Customers who have purchased a non-clustered Confluence license will only be able to download standard editions of Confluence from the Atlassian web site, whereas customers who have purchased a Confluence clustered license will be able to download clustered editions of Confluence.
- **From late September 2009:**
  - **Standard editions of Confluence will be made available for each previous major releases of Confluence back to version 2.6.** These will be available as Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3 and will be available to customers with non-clustered licenses.
  - **All other previous versions of Confluence currently available from our download page (from 2.6 to 3.0 inclusively), will be re-released as clustered editions and will only be available to customers with Confluence clustered licenses.**
  - The Coherence library files will no longer be available in any form from the Atlassian Maven repositories.
  - The installation files for all versions of Confluence prior to 2.6 (which are no longer supported) will be removed from the Atlassian web site and will no longer be available for download and installation.

⚠️ If you are currently running a **clustered installation of Confluence**, please do not upgrade it with a **standard edition** of Confluence.

**What are the implications?**

**I am a Confluence customer with a non-clustered Confluence license, running Confluence 2.3 or later.**

The Confluence distribution you are running will continue to function and if it is Confluence version 2.6 or later, be supported by Atlassian in accordance with our standard support policy.

However, if you upgrade to Confluence version 3.0.1 or later or obtain any Confluence version released after late September 2009, you will only be able to download and upgrade to standard editions of Confluence.

**I run a customised installation of Confluence 2.3 or later and must build Confluence from source.**

Confluence source code downloaded before late September 2009 requires that the Coherence library files are present in either your local or the Atlassian Maven repositories for automated Maven builds to complete successfully.

If you have Confluence source code downloaded before late September 2009 (excluding version 3.0.1) but conduct an automated Maven build of Confluence using this source code after this date, your build will fail if the Coherence library files are not available in your local Maven repository. This is because the Coherence library files will also not be available in the Atlassian Maven repository.

Hence, to build a customised installation of Confluence using this source code, we recommend that you locate the `tangosol-3.3.jar` and `coherence-3.3.jar` from the `WEB-INF/lib` directory of your own existing Confluence installation and install them into your local Maven repository using the following commands:

---

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
These commands will install the Coherence library files into your local Maven repository, which should be available to you only. Please do not upload these files to any public Maven repository nor make them publicly available by any other means. Atlassian's End User License Agreement does not grant permission to redistribute any part of Confluence, which includes these Coherence library files.

Alternatively, you can download the sources for one of the new standard or clustered editions of Confluence and reapply your customisations. These will compile without any additional problems.

**I am a plugin developer and wish to compile plugins against old or existing versions of Confluence**

This will affect plugin developers in two ways:

1. When building a plugin, Maven will complain about the absence of the Coherence library files in the Atlassian Maven repository.
2. When using the Atlassian Plugin Toolkit to test a plugin, Maven will be unable to download the appropriate Confluence EAR-WAR distribution file (from the Atlassian Maven repository), against which to perform integration tests.

Therefore, we recommend that as soon as possible, plugin developers start compiling their plugins based on the new standard editions of Confluence (without the Coherence library files). Standard editions of Confluence will be binary-compatible with clustered editions and existing clustered instances of Confluence. Hence, plugins developed against standard editions of Confluence will also run on any clustered editions and existing clustered instances of Confluence.

**I am a plugin developer concerned about API changes and multiple Confluence editions resulting from these changes**

As long as you are using only Confluence APIs to develop plugins, your plugins will be binary compatible with both standard and clustered editions of Confluence. The interfaces of the Confluence CacheManager, Cache and ClusterManager will be the same in both editions of Confluence, although there will be only one important change from previous versions of Confluence.

In existing versions of Confluence, the ClusterManager exposes the Coherence InvocationService to allow clients to execute code or perform queries across all nodes of the cluster. This API will be unavailable in all standard edition versions of Confluence from version 3.0.1 back to 2.6. If your plugin uses this service (and Atlassian is not aware of any that do) you should instead use Confluence's RemoteEvent API to send messages to other cluster nodes and direct them to perform the work.

Also, if for some reason your plugin references some other Coherence classes directly (or imports the Coherence-specific implementations of the CacheManager, Cache or ClusterManager), you will need to rewrite your plugin to use the generic interfaces only.

**I am a plugin developer and want to test my plugin**
against Confluence in a cluster

For testing purposes, you must own a Confluence clustered license and have access to a clustered Confluence installation (either an existing one or one based on the new Confluence clustered edition).

Confluence 3.0.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.0.1. Confluence 3.0.1 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the Confluence 3.0.1 Release Notes.

On this page:

- Upgrade Notes
  - ClusterManager for Non-Clustered Licenses causes Critical Errors
  - Introduction of 'Standard' and 'Clustered' editions
  - Confluence Caching Layer Changes
- Upgrade Procedure
- Useful Plugins

Upgrade Notes

⚠️ If you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read ALL information on this page before upgrading to Confluence 3.0.1 or to a 'standard edition' of Confluence. This page also contains important information for customers who are upgrading their installation of Confluence to version 2.6 or later from September 2009.

ClusterManager for Non-Clustered Licenses causes Critical Errors

The ClusterManager in the non-clustered (i.e. you do not have a clustered license) implementations of Confluence 3.0.1 and Confluence 3.0.2 does not perform any locking (e.g. for job synchronisation). As a result, your Confluence instance may crash due to certain jobs being executed concurrently when they shouldn't be.

We strongly recommend that you upgrade to Confluence 3.1 or later to avoid this issue, if possible. If you wish to install or upgrade to a non-clustered implementation of Confluence 3.0.1 or 3.0.2, you must apply the patch attached to CONF-17136 after upgrading.

Introduction of 'Standard' and 'Clustered' editions

ℹ️ Oracle Coherence Licensing Change:

- Due to a license agreement change between Atlassian and Oracle over the Coherence technology, from September 2009, Confluence will be made available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
    - If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information, please refer to the Coherence License Changes document.
- In standard editions of Confluence, Ehcache replaces the local caching functionality previously provided by the Coherence technology.
Confluence 3.0.1 is the first Confluence version to be released in two editions 'standard' and 'clustered'.

Also, from September 2009:

- Standard editions will be released for each previous major version of Confluence back to 2.6. These will be:
  - Available as Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3.
  - Available to customers with non-clustered Confluence licenses.

- The remaining previous versions of Confluence currently available from our download page (from 2.6 to 3.0 inclusively), will be re-released as clustered editions and will only be available to customers with Confluence clustered licenses.

- The installation files for all versions of Confluence prior to 2.6 (which are no longer supported) will be removed from the Atlassian web site and will no longer be available for download and installation.

### Confluence Caching Layer Changes

Due to the caching layer changes in the 'standard editions' of Confluence, you will need to reapply any cache customisations made to your cache sizes and/or cache configuration file, if all three of the following points are applicable:

- You have implemented cache customisations to your Confluence installation's cache sizes (either via the Administration Console or cache configuration file).

- You have an existing installation of Confluence 3.0 or earlier (excluding the 'standard edition' versions) and will be upgrading to Confluence 3.0.1 or later (or one of the earlier standard editions).

- Your Confluence installation is using a non-clustered Confluence license.

If you customised your Confluence instance's cache settings via the Administration Console, please refer to the Reapplying Cache Size Modifications via the Administration Console section below.

If you customised your Confluence instance's cache settings by modifying the cache configuration file, please refer to the Reapplying Cache Configuration File Modifications section below.

### Reapplying Cache Size Modifications via the Administration Console

To reapply your cache size modifications via the administration console:

1. Before you upgrade, use the procedure described on the Cache Statistics page to open the 'Cache Statistics' section of the Administration Console in the 'Advanced' view.

2. Print out this view or save a copy of the web page for later reference. (This contains your existing individual cache settings.)

3. After upgrading Confluence, view the 'Cache Statistics' section of your upgraded Confluence installation in the 'Advanced' view.

4. Use the same procedure describe on the Cache Statistics page to re-adjust the size of each cache based on the previous settings that you had printed out (or saved).

### Reapplying Cache Configuration File Modifications To
maintain your existing cache configuration file settings, you will need to transfer any cache customisations you have implemented in the Coherence cache configuration file (confluence-coherence-cache-config.xml) to the relevant entries in the Ehcache cache configuration file (ehcache.xml).

Each cache has a cache-mapping element in the Coherence file (of which there is an equivalent cache element in the ehcache.xml file). Unfortunately, copying across your customisations is not quite a straightforward process because the Coherence file defines several 'caching schemes' to store the actual cache values, which in turn are referenced by the cache-mapping elements. In contrast, the ehcache.xml file does not support caching schemes and a cache's values are expressed explicitly in separate parameters of a cache element.

To convert your Coherence cache configuration file customisations across to the equivalent Ehcache file:

1. Open both the confluence-coherence-cache-config.xml and ehcache.xml files in a text editor. These files are located in the <confluence-home>/config directory.
   - If you implemented your customisations in a version of Confluence prior to 3.0, you will most likely find the confluence-coherence-cache-config.xml file in the <confluence-install>/confluence-e/WEB-INF/classes directory.

2. In the customised confluence-coherence-cache-config.xml file:

   a. Identify the caching schemes that were customised in this file and make a note of the values of all its child elements.
      - Typically, each caching scheme is located inside a local-scheme element and all of these are enclosed within the cache-schemes element, which appears towards the end of this file.
   b. Note each customised caching scheme by the content of its scheme-name element.
   c. For each cache-mapping element (which typically appears towards the top of this file), identify if it has a scheme-name element whose content matches one noted in the previous step and if so, make a note of its associated cache-name element.

3. In the ehcache.xml file:

   a. Identify each cache element whose 'name' parameter matches the cache-name elements noted in step '2c'.
   b. Using the mappings table below, apply the values noted in step '2a' to the appropriate parameters of the cache elements identified in the previous step ('3a').

Mappings table showing how elements of the Coherence cache configuration file map to parameters of the equivalent Ehcache file.

<table>
<thead>
<tr>
<th>Coherence Element</th>
<th>Ehcache Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>high-units</td>
<td>maxElementsInMemory</td>
</tr>
<tr>
<td>expiry-delay &gt; 0s</td>
<td>timeToIdleSeconds - Use this attribute for expiry delays greater than 0s along with the eternal attribute set to 'false'</td>
</tr>
<tr>
<td>expiry-delay = 0s</td>
<td>eternal - For expiry delays of 0s, set this attribute to 'true'.</td>
</tr>
</tbody>
</table>
Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your `confluence.home` directory and database.

2. If your version of Confluence is earlier than 3.0.1, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 3.0.1 release notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's [Upgrade Assistant for Confluence (UAC)](https://www.appfire.com/products/upgrade-assistant) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.0.2 Release Notes

**6 October 2009**

Confluence 3.0.2 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the [security advisory](https://confluence.atlassian.com/display/DOCS/Confluence+3.0.2+Release+Notes) for details of the security vulnerabilities, risk assessments and mitigation strategies.

⚠️ Critical issue affecting non-clustered implementations of Confluence 3.0.2

Non-clustered (i.e. you do not have a clustered license) implementations of Confluence 3.0.2 are affected by an issue that can cause Confluence to crash. Please read the [Confluence 3.0.2 Upgrade Notes](https://confluence.atlassian.com/display/DOCS/Confluence+3.0.2+Upgrade+Notes) for details on the issue and instructions on how to address it.

Editing and Visual Improvements

A bug in the Rich Text Editor lead to the generation of line break and other character formatting problems after saving a page. This bug has been fixed.

The sizes of some headings were considered too similar to be visually distinguishable on a page, especially when the headings were separated by intervening text content. This was particularly the case for heading sizes 2 and 3. Hence, the sizes of headings were modified to make them visually more distinct.

The format of colours used in Confluence's user profile areas has been modified slightly to make headings more prominent and form labels clearer.

The blog posts macro was missing the 'Restrict to These Authors' (author) parameter from the macro browser. However, this parameter is now available in the macro browser.

Other Enhancements and Fixes
Some customers’ users experienced long delays while logging into Confluence, especially when their user accounts belonged to groups containing a large number of other user accounts. This issue was fixed.

Customers were able to generate Confluence page PDF exports directly from external web sites by adding the ‘Export to PDF’ link (accessible via a Confluence page’s ‘Tools’ menu) to their external web pages. Unfortunately, this function was broken by the introduction of the form token handling security enhancement feature introduced in Confluence 3.0. In Confluence 3.0.2, however, this issue was resolved.

Some customers experienced an issue in which automatic content indexing would stop. This problem has been resolved.

When browsing Active Directory groups in Confluence, it was not possible to view group members if the LDAP Distinguished Names (DN) did not include the username. This bug was fixed.

There’s a complete list of fixes below. Click a specific issue to see details of the fix.

**Don’t have Confluence 3.0 yet?**

Take a look at the new features and other highlights in the [Confluence 3.0 Release Notes](#).

![Download Latest Version](download.png)

### Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the [Confluence 3.0.2 Upgrade Notes](#). We strongly recommend that you back up your confluence.home directory and database before upgrading.

### Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (23 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
</tr>
<tr>
<td><img src="icon.png" alt="icon" /></td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>9</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>Issue ID</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>CONF-17159</td>
</tr>
<tr>
<td>CONF-16955</td>
</tr>
<tr>
<td>CONF-16774</td>
</tr>
<tr>
<td>CONF-16089</td>
</tr>
<tr>
<td>CONF-13635</td>
</tr>
<tr>
<td>CONF-16745</td>
</tr>
<tr>
<td>CONF-16683</td>
</tr>
</tbody>
</table>

Click [here](http://jira.atlassian.com) to open a report on Confluence 3.0.2. For Resolved or Closed issues in Confluence 3.0.2.

**Confluence 3.0.2 Upgrade Notes**

Below are some important notes on upgrading to **Confluence 3.0.2**. Confluence 3.0.2 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the [Confluence 3.0.2 Release Notes](#).

On this page:

- [Upgrade Notes](#)
  - ClusterManager for Non-Clustered Licenses causes Critical Errors
  - New License Key Requirements for Confluence 3.1
  - Upgrading an Existing Confluence License for Confluence 3.1 Compatibility
- [Upgrade Procedure](#)
- [Useful Plugins](#)
Upgrade Notes

ClusterManager for Non-Clustered Licenses causes Critical Errors

The ClusterManager in the non-clustered (i.e. you do not have a clustered license) implementations of Confluence 3.0.1 and Confluence 3.0.2 does not perform any locking (e.g. for job synchronisation). As a result, your Confluence instance may crash due to certain jobs being executed concurrently when they shouldn't be.

We strongly recommend that you upgrade to Confluence 3.1 or later to avoid this issue, if possible. If you wish to install or upgrade to a non-clustered implementation of Confluence 3.0.1 or 3.0.2, you must apply the patch attached to CONF-17136 after upgrading.

New License Key Requirements for Confluence 3.1

The next major release of Confluence (version 3.1) will require Confluence administrators to upgrade (or have upgraded) their Confluence license to Atlassian's new license key format. We are undertaking this change to enhance and improve the support we provide our customers. Bear in mind that this license upgrade will not incur any additional costs and does not change Confluence's functionality in any way.

Confluence 3.0.2 will still operate as usual under your existing Confluence license. However, any customers running Confluence 3.0.0 or later will be able to upgrade their Confluence license to the new license key format before Confluence 3.1 is released. Customers whose licenses expire before Confluence 3.1 is released will be required to upgrade their license to the new license key format.

As a consequence of these imminent licensing changes, relevant pages of the Administration Console area in Confluence 3.0.2 contain warnings about Atlassian's new license key requirement, which will be mandatory in Confluence 3.1. Links to upgrade old licenses to the new license key format are provided in these warnings.

Upgrading an Existing Confluence License for Confluence 3.1 Compatibility

If you have just upgraded to Confluence 3.1:

Please refer to the License Upgrade procedure for Confluence 3.1 in the Confluence 3.1 Upgrade Notes instead.

The following procedure can only be performed by Confluence Administrators, on Confluence versions 3.0.0 or later.

To upgrade your existing license to the new license key format, which will be required for continued use of Confluence 3.1:

1. Visit the license upgrade area in your account at my.atlassian.com.

   If you are using Confluence 3.0.2, you can also access this site by visiting the opening page of the Administration Console (by selecting 'Browse' --> 'Confluence Admin' menu item) or the License Details page of your Confluence installation and clicking on the 'Upgrade this license key now' link. If you are already using an upgraded Confluence license, this link will not appear on these pages.

2. Enter your Atlassian account details (email address and password) to access and manage your Atlassian product licenses.
3. Select the appropriate Confluence license to expand its details.

4. In the 'info' note below your license on the right-hand side of the page, click the 'update your license key' link (as shown in screenshot 1 below). Once this is done, the note changes to that shown in screenshot 2 below.

- If the 'info' note looks like the one in screenshot 2, then your license key has been upgraded and you should not need to take any further action.

**Screenshot 1: License Key Update Function**

![License Key Update Function](image)

**Screenshot 2: Updated License Key Note**

![Updated License Key Note](image)

5. Copy the new license from the text box above this message to your clipboard.

6. Visit the License Details page in your Confluence installation and paste the new license from your clipboard into the 'License' field.

7. Click the 'Save' button. You will notice two changes:

   - If you are using Confluence version 3.0.2, the links to upgrade your license on the License Details and Administration Console opening pages will vanish.
   - A 'Support Entitlement Number' (SEN) will be assigned to your license on the License Details page.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your confluence home directory and database**.

2. If your version of Confluence is earlier than 3.0.2, read the [release notes and upgrade guides](https://confluence.org/upgrade) for all releases between your version and the latest version. In particular:
   - Please read the [3.0.2 release notes](https://confluence.org/3.0.2-release-notes).
   - If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](https://confluence.org/2.2-release-notes).

3. Download the latest version of Confluence.

4. Follow the instructions in the [Upgrade Guide](https://confluence.org/upgrade).

**Useful Plugins**

**Before installing a plugin into your Confluence site,**
Confluence 3.0 Release Notes

⚠️ Confluence 3.0 fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

1 June 2009

With great pleasure, Atlassian presents Confluence 3.0.

Confluence 3.0 is a major release which presents a number of new features and enhancements. With Confluence 3.0, we introduce the new Macro Browser feature, which provides a simple, point-and-click interface for discovering and inserting any of Confluence’s 80+ bundled macros into a page. Macros greatly enhance the functionality of Confluence pages by allowing users to add tools like task lists, RSS feeds and multi-media content. The macro browser makes it easy to select the macro you need and preview its output with your chosen settings before finally adding it to your page. It also makes it easy to edit and modify the parameters of existing macros on a page.

Confluence 3.0 also provides a range of social features that allow you to discover and connect with other users in your Confluence site. User Profiles have been redesigned with a more intuitive layout and provide additional fields for users to share information about themselves like their IM handle or personal website. The new Network feature lets you follow other users inside your Confluence site and view an aggregated stream of all the activity such as page edits, blogs posts and status updates they undertake. The new Hover Profile feature displays a user’s summary profile information whenever you hover your mouse pointer over their name anywhere in Confluence. Hover profiles provide easy access to the user’s email address and profile details and allow you to add them to your network. Finally, you can let others know what you are working on, share a link or simply broadcast a short message to your team by setting your User Status. Once your current status message has been updated, it will appear in various activity streams, your profile views and your profile sidebar.

The new PDF Export feature addresses one of the most highly voted requests for Confluence. You have full control over your PDF exports using Cascading Style Sheet (CSS) modifications. You also have the ability to customise page and margin sizes, add a title page or table of contents list to your exported document, add customisable headers and footers and easily select a subsection of documentation for export.

The Rich Text Editor now includes a right-click context menu that makes it easier to insert links, images, macros and tables into your Confluence page. It is now also possible to copy/cut and paste rows within tables.

Confluence’s performance has been substantially improved, with dramatic improvements in response times. Furthermore, scalability has been enhanced, with significantly improved CPU utilisation compared to previous Confluence versions.

**Highlights of this Release:**

- Introducing the Macro Browser
- Enhanced User Profiles
- Introducing Your Network
- New User Status
- New Hover Profile Feature
- Customisable Enhanced PDF Exports
- Improved Rich Text Editor
- Performance Improvements
- Engine Room and Developer Community
Responding to your Feedback:
⭐ 680+ votes satisfied

Thank you for all your issues and votes. Keep logging, to help us keep improving!
Below is a list of the highlights in this release.
Attached is the full list of issues resolved in this release.

Upgrading from a previous version of Confluence

- Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**
- Please refer to the Confluence 3.0 Upgrade Notes for further essential information about plugins and other factors affecting your upgrade.

Highlights of Confluence 3.0

1

*Introducing the Macro Browser*

Now you can choose from Confluence's plugin-based macros and implement them with ease, from a single point.

- Using the macro browser's fast filtering capabilities, you can quickly find any bundled macro, including additional plugin-based macros installed on your Confluence system.
- Select your macro and modify and preview its parameters before adding it to your Confluence page or blog post.
- Take a look at our documentation for more details on the new macro browser feature.
**Enhanced User Profiles**

Confluence's enhanced user profiles area has been augmented to incorporate Confluence 3.0's new community-based features and to improve the overall user experience.

- User profiles now allow users to enter 'structured' information about themselves, which can be used by Confluence's community-based features.
- Each user's profile view shows a list of their own recent activities, such as page or blog post updates, changes to their profile information and status updates (described below).
- A summary of each user's profile information is displayed in a 'profile sidebar' on the right-hand side of pages within their personal space and their blog posts too. The profile sidebar appears on pages based on the default Confluence theme.
- Take a look at our documentation for more details on the enhanced user profiles feature.

*The new user profile view*

![User Profile Image](image)

*The new profile sidebar which appears on your blog posts or pages within your personal space*
Introducing Your Network

The new network feature helps you keep track of what other users are doing throughout your Confluence site, by allowing you to ‘follow’ their recent activities.

- The activities tracked by the network feature include:
- Additions or edits to pages or blog posts, including comments of users you are following.
- Updates to statuses or profile details of users you are following.
- From the network view, you can set up an RSS feed which provides notifications on the activities of users you are following.
- Take a look at our documentation for more details on the network feature.

New User Status

User status allows you to broadcast a short message of up to 140 characters rapidly for others to see.

- Your messages could include anything from what you are currently working on to a message or a hyperlink you want to share immediately with other users.
- Other users can see your status messages on various activity streams throughout Confluence and on your profile views and personal space pages.
- Take a look at our documentation for more details on the new user status feature and your status updates page.

What are you working on?

Touching up the Community-based features.

New Hover Profile Feature

Hover profile is a convenient tool that provides quick access to key information about other Confluence users, their user profile features and their network functions. Whenever you hover your mouse pointer over a Confluence user's name, key details about them appears in a popup balloon, such as their name, profile picture, email address and their current status.

- From a user's hover profile popup balloon, you can access the following functions:
  - Follow the user to track their recent activities via your network (or stop following them).
  - Directly send the user an email message via your email client.
- You can also access the following features of their user profile via their hover profile popup:
  - The user's personal space.
  - The user's profile, network or status updates views.

Customisable Enhanced PDF Exports

The enhanced PDF export feature in Confluence 3.0 has been rebuilt from the ground up and provides full customisation of your PDF exports with CSS modifications, to suit your particular requirements.

- Key enhancements to PDF export customisations include the ability to:
  - Customise page and margin sizes.
  - Add a table of contents or add headers and footers with customisable content.
  - Add a title page to your document.
  - Select a subsection of a space (for example, a chapter or section) to export more easily.
- PDF exports are now up to four times faster on large spaces.
- This feature addresses some of the most highly voted Confluence issues. Important bugs in the old PDF export feature have been fixed in this new version, including:
  - Fixed width columns — Table columns were consistently presented with fixed widths using the old PDF export function. However, the new PDF export function presents table columns with variable widths, as they appear on screen.
  - Ability to handle landscape page exports.
- Take a look at our documentation for more details on the enhanced PDF export and PDF stylesheet features.
The old PDF export function only generated fixed-width table columns

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>no</td>
<td>none</td>
<td>Uniquely identifies the Liveseach when there are multiple liveseach macros in one page.</td>
</tr>
<tr>
<td>spaceKey</td>
<td>no</td>
<td>all spaces</td>
<td>Specify a space key to limit the search to the given space.</td>
</tr>
</tbody>
</table>

The new PDF export feature now generates variable-width table columns

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>no</td>
<td>none</td>
<td>Uniquely identifies the Liveseach when there are multiple liveseach macros in one page.</td>
</tr>
<tr>
<td>spaceKey</td>
<td>no</td>
<td>all spaces</td>
<td>Specify a space key to limit the search to the given space.</td>
</tr>
</tbody>
</table>

Easily add a title page when you export a space as a PDF

A table of contents is generated in the PDF by default when you export a space
It's easy to add custom headers and footers

Introduction to Confluence

7

Improved Rich Text Editor

The rich text editor contains several interface enhancements and bug fixes that improve its overall user experience.

- The rich text editor includes a right-click context menu, making it easier to insert links, images, macros and tables into your Confluence page or blog post.
- It is now possible to cut/copy and paste rows.
- Take a look at our documentation for more details on the rich text editor overview to see more information about its enhancements and redesigned interface.

Right-click context menu
Performance Improvements

A number of performance improvements have been implemented.

- Confluence is now able to use more available resources under high load conditions.
- For Confluence installations, actions are up to 2 times faster.
- For Confluence Clustered installations:
  - Viewing pages is up to 2.5 times faster under medium, high and peak load.
  - Other actions are up to 5 times faster under medium load and 10 times faster under high and peak load.
- For more information, please refer to the [Confluence 3.0 performance improvements documentation](#).

Confluence installations - Medium Load

![Average time Comparison](chart)

**Average time Comparison**

- Dashboard
- Edit Page
- View Page
- Search Site
- Reader RSS Comments

- [2.10](#) vs [3.0](#)
Engine Room and Developer Community

- Confluence 3.0 now implements the Atlassian Plugin Framework 2.2 and the new Shared Access Layer (SAL).
- For more information, please refer to the Plugin Framework Documentation.

Administration Improvements

Confluence contains a number of improvements to its administrative features, many of which are easily accessible from the Administration Console.

- Security improvements:
  - A new form token authentication mechanism provides Confluence with the means to validate the origin and intent of requested actions, thus adding an additional level of security against phenomena such as cross-site request forgery. This feature also provides a mechanism for Confluence plugin developers to protect their plugins. For more information, please refer to the form token handling documentation.
  - Anti-XSS mode is now enabled by default and the remaining encoding bugs have been fixed.
- You can now generate a thread dump from the Administration Console. See our documentation on generating a thread dump.
- It is now possible to adjust the size of Confluence's internal caches, allowing administrators to fine tune Confluence's cache handling and performance at runtime without the need to restart Confluence. For more information on using this feature, refer to our page on cache statistics.
- The Office connector contains additional configuration options and provides simplified handling of the {viewfile} macro for the new Macro Browser.

More than 240 Fixes and Improvements

Page comparisons have been improved such that deletions or additions of single words (and short phrases) within a single line are highlighted red or green, respectively. Furthermore, large sections of unchanged text are compacted to reduce page length, but their content and context can easily be revealed at a click.

- Page comparisons now appear in email notifications, whenever a user edits a page or blog post.
- As well as the enhanced PDF export feature, you can now choose a subsection of a space (such as a document chapter) more easily, to export to XML or HTML.
- Using the new network, profile and user status list macros, you can incorporate components of Confluence 3.0's new community-based features directly into your page or blog post.
- Atlassian now provides support for recently added features to the widget macro, which include Widgetbox, Yahoo Video, Dailymotion, Wufoo HTML Form Builder, DabbleDB, Google Calendar and BackType micro-blogging.
- The Activity Macros now incorporate improved handling of the 'author' parameter.
- Take a look at the complete list of issues resolved in Confluence 3.0.

Page comparisons in email notifications
Known Issues in this Release

We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release, and report any problems so that we can fix them quickly.

We would like to highlight a known issue affecting the rich text editor, in which text cannot be added to the end of line that already ends with a link. Refer to CONF-15053 for more information about this issue. For more information on other known issues associated with the release of Confluence 3.0, please refer to Confluence 3.0 Known Issues.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

The Confluence 3.0 Team

Development

Bugfixing, Security, PDF Export, Office Connector
Andrew Lynch
Charles Miller
Paul Curren
Ryan Ackley

Engine Room and Performance
Matt Ryall
Chris Kiehl
Anatoli Kazatchkov

Macro Browser and Rich Text Editor
Agnes Ro
David Taylor
Dmitry Baranovskiy
Don Willis

Community-based features
Matthew Jensen
David Loeng
Brian Nguyen
Chris Broadfoot

Plugin Updates
David Chui

Team Lead
Per Fragemann

Support

Kuala Lumpur
Arie Murdianto
Azwandi Mohd Aris
Ming Giet Chong
Zed Yap

San Francisco
Jeremy Largman
Maleko Taylor
Tim Wong
Vincent Chang
Peter White

Sydney
Gurleen Anand
Ivan Benko
James Fleming
Michael Seager
Roy Hartono

Others

Design
Stephen Russell
Jason Taylor

Performance Engineering
George Barnett

Product Management
Adnan Chowdhury

Product Marketing Management
Bill Arconati

Quality Assurance
Confluence 3.0 Known Issues

We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release, and report any problems so that we can fix them quickly. Below is a list of known issues. We're working on them, and will have a point release out as soon as possible.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

While you're waiting, take a look at the great new features in Confluence 3.0 Release Notes.

You can also browse the Confluence project in our issue tracker to see what's fixed and what's not, for each release.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>In the rich text editor, text cannot be added to the end of line that already ends with a link.</td>
<td>CONF-15053</td>
</tr>
</tbody>
</table>

Other Issues

⚠️ Early 3.0 Build Issue

Note that an early build of 3.0 (Build number 1626) had a problem when moving a page from one space to another. If the default filesystem attachment storage was configured then any attachments on the page would fail to be moved if the page was moved to a new space. The attachment would only be accessible again if the page was moved back to its original space.

The current 3.0 release (3.0.0_01) does not have this problem. See CONF-15986 for more details.

Confluence on MySQL databases

Some customers who run Confluence on a MySQL database may find that when they upgrade to Confluence 3.0 or later, their Confluence 3.0 upgrade fails, with the Confluence logs revealing a "Specified key was too long" error. This issue is known to occur when MySQL's MyISAM storage engine and UTF-8 character set is used with Confluence.

If this is the case, please refer to the Upgrade to Confluence 3.0 with MySQL database fails with messages like "specified key was too long" knowledge base article on how to resolve this upgrade issue.

Confluence 3.0 Upgrade Notes

Below are some essential notes on upgrading to Confluence 3.0. For details of the new features and improvements in this release, please read the Confluence 3.0 Release Notes.

On this page:

- Upgrade Notes
Anonymous Access to User Profiles

Confluence 3.0 introduces a new Anonymous Access Global Permission, *View User Profiles*, which prevents individuals who have not logged in to Confluence from viewing other users' profiles. This permission, which is accessible from the Administration Console was introduced to protect the identity and security of Confluence user accounts and details associated with the Confluence 3.0 Community-based features.

In all new installations of Confluence 3.0, this permission is disabled for Anonymous users by default, such that an individual will not be able to view another user's profile details until they have logged in to Confluence.

Plugins

If you are having trouble with any screens in Confluence 3.0, which could be related to potentially incompatible or unsupported third-party plugins, try using the plugin safe mode to disable all unsupported plugins.

The Usage Tracking Plugin is disabled by default

Due to performance issues in high load environments, the Confluence Usage Tracking Plugin is disabled by default in Confluence 3.0. While upgrading to Confluence 3, the plugin will be turned off even if it was active before. We do still deliver the plugin as part of Confluence (and have even improved its performance since 2.10), so if you don't have a high load environment and are happy with the performance of the plugin, you can easily reactivate this plugin through the Administration Console.

Upgrade Procedure

⚠️ Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 2.10.x, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.10 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

5. If you encounter a problem during the upgrade, please create a support ticket and one of our support
useful plugins

before installing a plugin into your confluence site, please check the plugin's information page to see whether it is supported by atlassian, by another vendor, or not at all. see our guidelines on plugin support.

- appfire's upgrade assistant for confluence (uac) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

related topics

confluence 3.0 release notes

confluence 3 performance improvements

confluence 3.0 has significant performance improvements over confluence 2.10 and earlier versions. this page explains the performance characteristics of confluence 3.0 and shows the improvements that were made when compared to its predecessor confluence 2.10. in brief, compared to version 2.10, confluence 3.0 response times are down by 30% to 40%, and response times in a cluster are down by 50%. in other words, the clustered version of confluence 3.0 is now twice as fast as before. confluence also scales a lot better than before: More or faster cpu's are better utilised with confluence 3.0 than they were with 2.10 and earlier versions.

1 specific performance improvements

we have fixed a few bottlenecks that were so specific that you might have encountered them while analysing logfiles and thread dumps. even if you did not see them, they might have been slowing your system down, depending on your use-case.

- rebuilding the search index is significantly faster, up to factor 2. in our performance testing, a sample set of 20,000 pages that took 30 minutes using confluence 2.10 now just takes 16 minutes in confluence 3.0.
- improved database queries
  - conf-14488 : added composite database index to spacepermissions table. this will speed up installations with many page or space restrictions
  - conf-14422 : now, only the most recent version of an attachment is loaded when retrieving it for the first time. this had slowed down pages (and the dashboard) when an attachment had hundreds or thousands of revisions
  - conf-14273 : reduced overall db load when rendering pages, which can help overall performance in case the database server was under high load already

- caching enhancements
  - conf-12894 : improved resource caching to improve https/ssl speed. this will make the screen render faster when you are using https.
  - conf-8034 : now serving caching headers for attachments to improve user interface responsiveness: Attachments (this includes user avatars) will not be downloaded again by the browser, leading to faster page loads

- others:
  - viewing pdf files through the office connector will use less memory and therefore significantly reduce garbage collection, which has caused some systems to perform a lot slower than needed
  - usgtrk-37 : a bug was fixed in the usage statistics plugin that enables it to work smarter. it is still a plugin that is not made for high load so we suggest you disable it on high load scenarios

2 general performance improvements

we have been improving confluence response time and scalability by implementing small improvements across the board. they are too many and too small to be presented individually, so we will use the results of our general
In our general Confluence performance tests, we execute a standardised set of commonly-used functions that simulates the activity of concurrent users. We base this profile on the actual usage patterns of our public Confluence installation, a rather large and active instance. To cater for irregular usage spike, we increase the load by factor 10. On average, this load test performs 10 to 15 Confluence requests per second. Most customer installations do not even get close to these numbers during normal operation. Under normal (low) load, the response times are actually a lot better than what we present here. But we prefer to use this medium load scenario because it simulates cases which may occur infrequently, and in which Confluence still needs to perform reasonably well. In addition to this scenario, we defined two additional, more extreme scenarios that perform the same requests, but at 20 to 35 requests per second to simulate an even higher load.

How to read and understand the statistics

Please note that we use the term "request" for anything that requests or posts data to Confluence. So viewing a Confluence page is a request, performing a search is a request, posting a comment is a request, and also using the quick navigation drop-down performs requests.

The data table

Each row in the table represents one use case. All use cases are run in parallel for 30 minutes, with a 5 minute ramp-up period.

- **Samplers**: The first column is the name of the requests performed in this scenario, like reading pages, commenting pages, or performing searches.
- **95% Percentile**: This is the time (in milliseconds) by which 95% of all requests of this scenario have completed. This is not an average value, you rather can think of it as a "how long the slowest requests (except the very worst 5% cases) take" - scenario.
- **Average**: the third column shows the average response time of the requests in this scenario - the lower the better.

The most important use-cases are the following:

- **View Page**: This loads one out of hundreds of different Confluence pages. Some are short, others are long. Some have many images, others have many comments. Some have many macros, others do not. The pages are accessed through their full URL, as if someone had clicked a link within the application or a bookmark.
- **Search Site**: A search across the whole system.
- **Quick Nav**: This simulates typing a character into the search field and getting back suggestions in real time. This is one of the most popular and time-critical operations. Therefore, this operation needs to be very fast.
- **Dashboard**: Simulates visiting the Confluence dashboard.
- **Edit Page**: This saves a page back to Confluence, and notifies all people who are watching this page.

The graph

The chart shows how many concurrent requests per second are being processed. The blue line indicates the moving average per second, and they green lines indicate variation. The blue line is not constant, since the pages and operations requested are extremely different in their CPU usage: A short page with no comments will render faster than a long page with many macros and comments, which in turn, will render faster than a page-edit that triggers many notifications. These differences in requests result in different CPU loads over time.

The more stable the blue average line is, the more consistent the user experience. The higher the line is, the more users can access and use Confluence simultaneously.
Applying the numbers to your company's usage patterns

The notes on this page geared at showing the performance differences between 2.10 and 3.0, using the same tests we used to test Confluence 2.10.

Hardware specification

All tests were conducted on two to four servers, each of which had the following specifications:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server model</td>
<td>Dell 2950</td>
</tr>
<tr>
<td>CPU type</td>
<td>Intel(R) Xeon(R) CPU E5405 @ 2.00GHz (4 Cores)</td>
</tr>
<tr>
<td>CPUs per server</td>
<td>1 or 2, depending on test. See test details</td>
</tr>
<tr>
<td>RAM</td>
<td>32Gb (but just 2Gb are used for the JVMs, and the database uses 3Gb)</td>
</tr>
<tr>
<td>Disks</td>
<td>2 x 15K, 72Gb SAS</td>
</tr>
<tr>
<td>Network</td>
<td>1Gbps</td>
</tr>
<tr>
<td>Webserver</td>
<td>Tomcat 6, Java 6</td>
</tr>
<tr>
<td>Database</td>
<td>Postgres 8.2.4</td>
</tr>
</tbody>
</table>

When testing the Confluence distribution, one server acts as the application server and one as the database server, which is the setup we recommend to customers to enable high performance. A third server is used to generate the load, using JMeter. In the cluster, we use two application servers and one database server. In the cluster configuration we use the Pound load balancer, which runs on the same (fourth) server as the load generator JMeter. We do not use any webserver or caching proxy for our tests, and we cannot make any recommendations about which one to use. We want to measure the raw performance of the application server and suggest that you use the webservers/proxies with which you are most familiar.

Software and Settings

The JVM settings we used were -XX:MaxPermSize=192m -Xmx2000m -X:+PrintGCTimeStamps -verbosegc -XX:+PrintGCDetails -XX:+PrintTenuringDistribution -XX:NewSize=384m -XX:SurvivorRatio=2 -XX:+UseParallelGC -XX:+UseParallelOldGC.

The usage tracking plugin was disabled during these tests because it is known to have performance issues and we recommend that it be turned off in high load deployments.

Confluence

Confluence is most frequently installed on one physical machine. Unless you know you are using (or are planning to use) a cluster, then this section is for you.

Confluence 3.0 has significantly better performance characteristics than Confluence 2.10. We compare three load scenarios and give the details below.

Medium Load scenario, 1 CPU
We define Medium Load as requesting roughly 15 requests per second from the loadtest. Most customers with smaller user bases never get even close to this usage, so they will experience a lot faster response times than what you can see below. But occasionally even customers with less than 1000 active users might experience spikes in usage, so we chose 15 requests per second as our medium load scenario.

We are using modest hardware (see above) with just one Xeon CPU with 4 cores, since we assume this is what a medium sized company would be using.

## Confluence 2.10 vs Confluence 3.0 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>1619ms</td>
<td>1129ms</td>
<td>43%</td>
<td>3979ms</td>
<td>2387ms</td>
<td>66%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>306ms</td>
<td>338ms</td>
<td>-9%</td>
<td>805ms</td>
<td>794ms</td>
<td>1%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>737ms</td>
<td>628ms</td>
<td>17%</td>
<td>3386ms</td>
<td>1783ms</td>
<td>89%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>989ms</td>
<td>707ms</td>
<td>39%</td>
<td>4133ms</td>
<td>2168ms</td>
<td>90%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>402ms</td>
<td>211ms</td>
<td>90%</td>
<td>765ms</td>
<td>391ms</td>
<td>95%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>525ms</td>
<td>387ms</td>
<td>35%</td>
<td>1161ms</td>
<td>882ms</td>
<td>31%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>256ms</td>
<td>233ms</td>
<td>9%</td>
<td>704ms</td>
<td>501ms</td>
<td>40%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>554ms</td>
<td>382ms</td>
<td>44%</td>
<td>1685ms</td>
<td>634ms</td>
<td>165%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>520ms</td>
<td>417ms</td>
<td>24%</td>
<td>1881ms</td>
<td>1065ms</td>
<td>76%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>332ms</td>
<td>250ms</td>
<td>32%</td>
<td>831ms</td>
<td>620ms</td>
<td>34%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1199ms</td>
<td>961ms</td>
<td>24%</td>
<td>3949ms</td>
<td>3459ms</td>
<td>14%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>274ms</td>
<td>456ms</td>
<td>-39%</td>
<td>486ms</td>
<td>2795ms</td>
<td>-82%</td>
</tr>
<tr>
<td>Log In</td>
<td>342ms</td>
<td>333ms</td>
<td>2%</td>
<td>774ms</td>
<td>480ms</td>
<td>61%</td>
</tr>
<tr>
<td>Feature</td>
<td>Time 1</td>
<td>Time 2</td>
<td>Time 3</td>
<td>Time 4</td>
<td>Time 5</td>
<td>Percentage</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>134ms</td>
<td>57ms</td>
<td>133%</td>
<td>597ms</td>
<td>110ms</td>
<td>439%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>551ms</td>
<td>369ms</td>
<td>49%</td>
<td>1266ms</td>
<td>615ms</td>
<td>105%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>170ms</td>
<td>59ms</td>
<td>184%</td>
<td>637ms</td>
<td>67ms</td>
<td>838%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>206ms</td>
<td>95ms</td>
<td>116%</td>
<td>754ms</td>
<td>97ms</td>
<td>675%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>203ms</td>
<td>126ms</td>
<td>60%</td>
<td>929ms</td>
<td>481ms</td>
<td>92%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>369ms</td>
<td>151ms</td>
<td>143%</td>
<td>1602ms</td>
<td>477ms</td>
<td>235%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>628ms</td>
<td>513ms</td>
<td>22%</td>
<td>2725ms</td>
<td>2147ms</td>
<td>26%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>800ms</td>
<td>547ms</td>
<td>46%</td>
<td>3381ms</td>
<td>2196ms</td>
<td>53%</td>
</tr>
<tr>
<td>View Page</td>
<td>890ms</td>
<td>584ms</td>
<td>52%</td>
<td>3259ms</td>
<td>1854ms</td>
<td>75%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>904ms</td>
<td>677ms</td>
<td>33%</td>
<td>2219ms</td>
<td>1566ms</td>
<td>41%</td>
</tr>
<tr>
<td>Search Site</td>
<td>505ms</td>
<td>340ms</td>
<td>48%</td>
<td>2006ms</td>
<td>598ms</td>
<td>235%</td>
</tr>
</tbody>
</table>

**Average time Comparison**

![Average time Comparison Graph](image-url)
Confluence 2.10 throughput

Confluence 3.0 throughput

Medium Load comparison between 2.10 and 3.0

The most important scenario ("View Page") used to take about 900ms in Confluence 2.10, but in 3.0 it is down to 600ms, which is a performance improvement of about 50%. Almost all other scenarios have improved as well, some even by more than 100% (e.g. more than twice as fast). The throughput in this scenario has only changed from approximately 13/s to 14/s. However, this is because the test itself is not making more requests. The main improvement here is that the throughput has less variations (ups/downs) for example when rendering very complicated or large pages. You can improve the smoothness of the line even further by using a different garbage collector, as explained on our tuning page.

High Load Scenario, 2 CPUs

We define a High Load Scenario as one in which the load generation equates to approximately 25 requests per second. In this test, we are using the same hardware as above, but with 2 CPUs. We assume that any company which expects 20 or more requests per second, even if this occurs during a short time frame, will have greater hardware resources (of equivalent cost) than to what is used in this test.
## Confluence 2.10 vs Confluence 3.0 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>2389ms</td>
<td>1531ms</td>
<td>56%</td>
<td>6196ms</td>
<td>4195ms</td>
<td>47%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>424ms</td>
<td>397ms</td>
<td>6%</td>
<td>1779ms</td>
<td>1603ms</td>
<td>10%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1211ms</td>
<td>815ms</td>
<td>48%</td>
<td>4729ms</td>
<td>2863ms</td>
<td>65%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>1402ms</td>
<td>912ms</td>
<td>53%</td>
<td>5284ms</td>
<td>3094ms</td>
<td>70%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>558ms</td>
<td>297ms</td>
<td>87%</td>
<td>1962ms</td>
<td>1543ms</td>
<td>27%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>783ms</td>
<td>522ms</td>
<td>49%</td>
<td>2567ms</td>
<td>1545ms</td>
<td>66%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>443ms</td>
<td>284ms</td>
<td>55%</td>
<td>1845ms</td>
<td>843ms</td>
<td>118%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>905ms</td>
<td>506ms</td>
<td>78%</td>
<td>2771ms</td>
<td>1245ms</td>
<td>122%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>807ms</td>
<td>504ms</td>
<td>59%</td>
<td>2650ms</td>
<td>2165ms</td>
<td>22%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>551ms</td>
<td>338ms</td>
<td>63%</td>
<td>1961ms</td>
<td>1461ms</td>
<td>34%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1524ms</td>
<td>1180ms</td>
<td>29%</td>
<td>5115ms</td>
<td>4189ms</td>
<td>22%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>409ms</td>
<td>419ms</td>
<td>-2%</td>
<td>1171ms</td>
<td>982ms</td>
<td>19%</td>
</tr>
<tr>
<td>Log In</td>
<td>520ms</td>
<td>346ms</td>
<td>50%</td>
<td>2124ms</td>
<td>700ms</td>
<td>203%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>318ms</td>
<td>124ms</td>
<td>155%</td>
<td>1895ms</td>
<td>369ms</td>
<td>413%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>866ms</td>
<td>492ms</td>
<td>76%</td>
<td>2439ms</td>
<td>1579ms</td>
<td>54%</td>
</tr>
<tr>
<td>Feature</td>
<td>2.10</td>
<td>3.0</td>
<td>%</td>
<td>2.10</td>
<td>3.0</td>
<td>%</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>----</td>
<td>--------</td>
<td>--------</td>
<td>----</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>300ms</td>
<td>105ms</td>
<td>186%</td>
<td>1549ms</td>
<td>191ms</td>
<td>709%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>299ms</td>
<td>98ms</td>
<td>203%</td>
<td>1954ms</td>
<td>183ms</td>
<td>965%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>390ms</td>
<td>224ms</td>
<td>74%</td>
<td>1946ms</td>
<td>931ms</td>
<td>108%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>362ms</td>
<td>254ms</td>
<td>42%</td>
<td>1824ms</td>
<td>1196ms</td>
<td>52%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>1098ms</td>
<td>777ms</td>
<td>41%</td>
<td>4804ms</td>
<td>2848ms</td>
<td>68%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>1126ms</td>
<td>807ms</td>
<td>39%</td>
<td>4532ms</td>
<td>3406ms</td>
<td>33%</td>
</tr>
<tr>
<td>View Page</td>
<td>1248ms</td>
<td>742ms</td>
<td>68%</td>
<td>4188ms</td>
<td>2839ms</td>
<td>47%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>1410ms</td>
<td>914ms</td>
<td>54%</td>
<td>3749ms</td>
<td>2487ms</td>
<td>50%</td>
</tr>
<tr>
<td>Search Site</td>
<td>804ms</td>
<td>411ms</td>
<td>95%</td>
<td>2611ms</td>
<td>1475ms</td>
<td>76%</td>
</tr>
</tbody>
</table>

**Average time Comparison**

**95 percent Comparison**
Confluence 2.10 throughput

Confluence 3.0 throughput

High Load comparison between 2.10 and 3.0

This scenario shows the performance improvements between Confluence 2.10 and 3.0 best. Confluence 2.10 managed about 22 requests per second, Confluence 3.0 about 27 requests per second. Although this is a significant improvement, those in response times are even more impressive. If you have times when there are 20 requests per second, Confluence will respond a lot better and end users will notice the difference.

Peak Load Scenario, 2 CPUs

We define a Peak Load Scenario as one in which approximately 35 requests per second from the load generator. Very few of our customers ever reach these high levels of requests per second, but if you do have 100,000 users and many of them view pages at the same time, then the peak load scenario may occasionally be reached. Again, these tests are run on a 2CPU hardware.

Confluence 3.0 vs Confluence 2.10 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>4747ms</td>
<td>3207ms</td>
<td>47%</td>
<td>10951ms</td>
<td>7575ms</td>
<td>44%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>1517ms</td>
<td>1146ms</td>
<td>32%</td>
<td>4521ms</td>
<td>3611ms</td>
<td>25%</td>
</tr>
<tr>
<td>Task Description</td>
<td>Mean Time (ms)</td>
<td>Median Time (ms)</td>
<td>IQR (%)</td>
<td>Mean + SD (ms)</td>
<td>Median + SD (ms)</td>
<td>Percentile (%)</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>----------------</td>
<td>------------------</td>
<td>---------</td>
<td>----------------</td>
<td>------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>3148</td>
<td>2173</td>
<td>44%</td>
<td>9222</td>
<td>6184</td>
<td>49%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>3302</td>
<td>2317</td>
<td>42%</td>
<td>9891</td>
<td>6410</td>
<td>54%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>1693</td>
<td>934</td>
<td>81%</td>
<td>3904</td>
<td>3170</td>
<td>23%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>2777</td>
<td>1959</td>
<td>41%</td>
<td>5812</td>
<td>5170</td>
<td>12%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>1589</td>
<td>1065</td>
<td>49%</td>
<td>3523</td>
<td>3358</td>
<td>4%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>2121</td>
<td>1420</td>
<td>49%</td>
<td>5492</td>
<td>3704</td>
<td>48%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>2216</td>
<td>1502</td>
<td>47%</td>
<td>5081</td>
<td>4233</td>
<td>20%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>1714</td>
<td>1062</td>
<td>61%</td>
<td>4008</td>
<td>3452</td>
<td>16%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>3945</td>
<td>3205</td>
<td>23%</td>
<td>10523</td>
<td>9467</td>
<td>11%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>934</td>
<td>818</td>
<td>14%</td>
<td>4544</td>
<td>4091</td>
<td>11%</td>
</tr>
<tr>
<td>Log In</td>
<td>807</td>
<td>913</td>
<td>-11%</td>
<td>2879</td>
<td>3531</td>
<td>-18%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>1121</td>
<td>568</td>
<td>97%</td>
<td>4288</td>
<td>2704</td>
<td>58%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>2159</td>
<td>1222</td>
<td>76%</td>
<td>4265</td>
<td>3472</td>
<td>22%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>864</td>
<td>531</td>
<td>62%</td>
<td>2796</td>
<td>2511</td>
<td>11%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>1099</td>
<td>527</td>
<td>108%</td>
<td>4307</td>
<td>2691</td>
<td>60%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>1110</td>
<td>736</td>
<td>50%</td>
<td>3469</td>
<td>2760</td>
<td>25%</td>
</tr>
<tr>
<td>Category</td>
<td>Time 1</td>
<td>Time 2</td>
<td>%Diff</td>
<td>Time 3</td>
<td>Time 4</td>
<td>%Diff</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------</td>
<td>--------</td>
<td>-------</td>
<td>--------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>Reader RSS Comment</td>
<td>1159ms</td>
<td>863ms</td>
<td>34%</td>
<td>3959ms</td>
<td>3130ms</td>
<td>26%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>2395ms</td>
<td>2300ms</td>
<td>4%</td>
<td>7588ms</td>
<td>7342ms</td>
<td>3%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>2661ms</td>
<td>2258ms</td>
<td>17%</td>
<td>8295ms</td>
<td>7922ms</td>
<td>4%</td>
</tr>
<tr>
<td>View Page</td>
<td>3038ms</td>
<td>2055ms</td>
<td>47%</td>
<td>7809ms</td>
<td>5702ms</td>
<td>36%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>3005ms</td>
<td>1990ms</td>
<td>51%</td>
<td>6298ms</td>
<td>4850ms</td>
<td>29%</td>
</tr>
<tr>
<td>Search Site</td>
<td>1950ms</td>
<td>1247ms</td>
<td>56%</td>
<td>4902ms</td>
<td>3647ms</td>
<td>34%</td>
</tr>
</tbody>
</table>

Average time Comparison

95 percent Comparison

Confluence 2.10 throughput
Confluence 3.0 throughput:

Please note that this test is slightly skewed by the Load generator sitting one the same machine. The actual results will look a bit better.

Peak Load comparison between 2.10 and 3.0

Confluence 2.10 is able to deliver about 22 requests per second, but response times are not so good. Rendering a page takes 3s and rendering the dashboard takes 2s on average. Confluence 3.0 delivers improved throughput of about 28 requests per second and response times are significantly better than 2.10 (rendering a page is down to 2s, and rendering the dashboard is down to 1.4s). However, response times under Peak Load in 3.0 are still not ideal. Even with 2 CPUs Confluence 3.0 starts reaching its limits here. While Confluence 3.0 is able to deliver results, what we really recommend for this peak load scenario is a clustered solution. Read on for more details.

Confluence Clustered

When rolling out Confluence to a larger amount of users, Clustering becomes important to balance spikes in load. The most commonly used deployment is a 2-node cluster, running on three physical machines (two application servers connected to one database server).

Clustering does not make a single request faster in low load scenarios, but it helps the system dealing with a larger number of requests in parallel, without degrading in performance.

Medium Load Scenario, Clustered, 2 nodes, 1 CPU per node

As above, we define the Medium Load scenario as making 15 requests per second. This test uses just 1 CPU per machine.

Confluence 3.0 vs Confluence 2.10 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvemen t</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvemen t</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Time (ms)</th>
<th>Speed %</th>
<th>Time (ms)</th>
<th>Speed %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>2477</td>
<td>169%</td>
<td>6365</td>
<td>196%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>410</td>
<td>7%</td>
<td>1127</td>
<td>31%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1029</td>
<td>72%</td>
<td>4193</td>
<td>129%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>1367</td>
<td>73%</td>
<td>5264</td>
<td>105%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>611</td>
<td>184%</td>
<td>1463</td>
<td>253%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>692</td>
<td>63%</td>
<td>1596</td>
<td>70%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>329</td>
<td>150%</td>
<td>1034</td>
<td>404%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>1319</td>
<td>234%</td>
<td>3787</td>
<td>581%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>750</td>
<td>93%</td>
<td>2592</td>
<td>82%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>493</td>
<td>136%</td>
<td>1569</td>
<td>261%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1500</td>
<td>53%</td>
<td>4903</td>
<td>42%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>854</td>
<td>138%</td>
<td>2898</td>
<td>429%</td>
</tr>
<tr>
<td>Log In</td>
<td>961</td>
<td>127%</td>
<td>3320</td>
<td>455%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>183</td>
<td>226%</td>
<td>1178</td>
<td>1001%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>663</td>
<td>89%</td>
<td>1562</td>
<td>181%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>499</td>
<td>577%</td>
<td>2674</td>
<td>2166%</td>
</tr>
</tbody>
</table>
Confluence 2.10 throughput
As you can see, the response time of each request is a lot better in Confluence 3.0. On average the performance has doubled, leading to response times that are just 50% of what they used to be. This means that a clustered Confluence installation provides the same responsiveness as a Confluence installation, while still being much better at scaling, which will be shown below. In this example the load was so low that throughput did not increase very much.

High Load Scenario, Clustered, 2 nodes, 2 CPUs per node

As above, we define the High Load scenario as making 25 requests per second. Few customers will reach these levels of requests per second, but if you have several ten thousand users these levels can be reached during peak business hours. This test is run on servers with 2 CPUs per machine.

### Confluence 3.0 vs Confluence 2.10 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>4674ms</td>
<td>1447ms</td>
<td>222%</td>
<td>12831ms</td>
<td>3822ms</td>
<td>235%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>584ms</td>
<td>442ms</td>
<td>31%</td>
<td>1948ms</td>
<td>1340ms</td>
<td>45%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1728ms</td>
<td>680ms</td>
<td>154%</td>
<td>5943ms</td>
<td>2164ms</td>
<td>174%</td>
</tr>
<tr>
<td>Action</td>
<td>Commentor view page</td>
<td>Creator add page</td>
<td>Creator submit new page</td>
<td>Creator view page</td>
<td>Dashboard</td>
<td>Editor display page</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------</td>
<td>------------------</td>
<td>-------------------------</td>
<td>-------------------</td>
<td>-----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Time (ms)</td>
<td>2048ms</td>
<td>838ms</td>
<td>896ms</td>
<td>443ms</td>
<td>2707ms</td>
<td>960ms</td>
</tr>
<tr>
<td>Time (ms) as %</td>
<td>129%</td>
<td>241%</td>
<td>92%</td>
<td>186%</td>
<td>697%</td>
<td>115%</td>
</tr>
<tr>
<td>Total time (ms)</td>
<td>7111ms</td>
<td>2333ms</td>
<td>2308ms</td>
<td>1300ms</td>
<td>7781ms</td>
<td>2909ms</td>
</tr>
<tr>
<td>Total time as %</td>
<td>147%</td>
<td>314%</td>
<td>95%</td>
<td>454%</td>
<td>1722%</td>
<td>78%</td>
</tr>
<tr>
<td>Feature</td>
<td>2.10 Throughput</td>
<td>3.0 Throughput</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------</td>
<td>----------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dashboard</td>
<td>2440ms</td>
<td>5560ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Page</td>
<td>630ms</td>
<td>2728ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Page</td>
<td>8300ms</td>
<td>1976ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Site</td>
<td>2263ms</td>
<td>407ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>266%</td>
<td>103%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>273%</td>
<td>111%</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>8027ms</td>
<td>2263ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Page RSS2</td>
<td>2530ms</td>
<td>2530ms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Average Time Comparison**

**95 Percent Comparison**

**Confluence 2.10 throughput**

**Confluence 3.0 throughput**

---

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
High Load comparison between 2.10 and 3.0 in clustered mode

In this test we show how using a Cluster for high load instances can increase throughput and reduce response time. Confluence 3.0 has many improvements which benefit the clustered version. In the case of the test above, we can see that as the load is increased, Confluence is able to use more of the available CPU power on the 8 core machines to scale up and handle the higher load with an very good response time. This is where clustering makes a lot of sense now.

Peak Load Scenario, Clustered, 2 nodes, 2 CPUs per node

As above, we define peak load as the load generator making around 35 requests per second. During this test we used 2 CPUs per machine.

Confluence 3.0 vs Confluence 2.10 response times

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>9179ms</td>
<td>2150ms</td>
<td>326%</td>
<td>22987ms</td>
<td>5695ms</td>
<td>303%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>999ms</td>
<td>859ms</td>
<td>16%</td>
<td>3175ms</td>
<td>2712ms</td>
<td>17%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>2760ms</td>
<td>1213ms</td>
<td>127%</td>
<td>8739ms</td>
<td>3908ms</td>
<td>123%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>3225ms</td>
<td>1672ms</td>
<td>92%</td>
<td>10941ms</td>
<td>5323ms</td>
<td>105%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>2396ms</td>
<td>379ms</td>
<td>532%</td>
<td>7285ms</td>
<td>1487ms</td>
<td>389%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>1913ms</td>
<td>858ms</td>
<td>122%</td>
<td>4850ms</td>
<td>2548ms</td>
<td>90%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>1070ms</td>
<td>270ms</td>
<td>296%</td>
<td>2925ms</td>
<td>1130ms</td>
<td>158%</td>
</tr>
<tr>
<td>Feature</td>
<td>Time 1</td>
<td>Time 2</td>
<td>% Change</td>
<td>Time 3</td>
<td>Time 4</td>
<td>% Change</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Dashboard</td>
<td>7383ms</td>
<td>466ms</td>
<td>1481%</td>
<td>19349ms</td>
<td>1429ms</td>
<td>1254%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>2460ms</td>
<td>761ms</td>
<td>223%</td>
<td>7388ms</td>
<td>2737ms</td>
<td>169%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>2609ms</td>
<td>357ms</td>
<td>630%</td>
<td>7143ms</td>
<td>1385ms</td>
<td>415%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>4064ms</td>
<td>1821ms</td>
<td>123%</td>
<td>12599ms</td>
<td>6287ms</td>
<td>100%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>3622ms</td>
<td>280ms</td>
<td>1191%</td>
<td>13728ms</td>
<td>497ms</td>
<td>2657%</td>
</tr>
<tr>
<td>Log In</td>
<td>3603ms</td>
<td>497ms</td>
<td>625%</td>
<td>12477ms</td>
<td>1045ms</td>
<td>1093%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>1268ms</td>
<td>92ms</td>
<td>1273%</td>
<td>9515ms</td>
<td>435ms</td>
<td>2084%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>1591ms</td>
<td>539ms</td>
<td>195%</td>
<td>3616ms</td>
<td>1622ms</td>
<td>122%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>4514ms</td>
<td>78ms</td>
<td>5688%</td>
<td>14570ms</td>
<td>136ms</td>
<td>10605%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>4666ms</td>
<td>84ms</td>
<td>5416%</td>
<td>14554ms</td>
<td>134ms</td>
<td>10689%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>4750ms</td>
<td>328ms</td>
<td>1346%</td>
<td>14934ms</td>
<td>1545ms</td>
<td>866%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>4723ms</td>
<td>302ms</td>
<td>1460%</td>
<td>16526ms</td>
<td>1412ms</td>
<td>1070%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>6443ms</td>
<td>1012ms</td>
<td>536%</td>
<td>20556ms</td>
<td>4005ms</td>
<td>413%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>6287ms</td>
<td>1109ms</td>
<td>466%</td>
<td>17762ms</td>
<td>4175ms</td>
<td>325%</td>
</tr>
<tr>
<td>View Page</td>
<td>3363ms</td>
<td>1345ms</td>
<td>150%</td>
<td>10510ms</td>
<td>4717ms</td>
<td>122%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>3069ms</td>
<td>1161ms</td>
<td>164%</td>
<td>9475ms</td>
<td>3023ms</td>
<td>213%</td>
</tr>
<tr>
<td>Search Site</td>
<td>3334ms</td>
<td>378ms</td>
<td>780%</td>
<td>10560ms</td>
<td>1368ms</td>
<td>671%</td>
</tr>
</tbody>
</table>
Confluence 2.10 throughput

Confluence 3.0 throughput

Peak Load comparison between 2.10 and 3.0 in clustered mode
This test highlights how well Confluence 3.0 can now scale. Response times remain low as the load is increased. Confluence 3.0 is able to make far better use of more powerful hardware than Confluence 2.10 which is shown by the improved response times for key scenarios like Page view and Dashboard.

*Feedback welcome*

We welcome your feedback! Is this document understandable, does it cover the areas that you are most interested about? Tell us and leave comments on this page!

---

### High Load Cluster

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvemen t</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvemen t</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>4674ms</td>
<td>1447ms</td>
<td>222%</td>
<td>12831ms</td>
<td>3822ms</td>
<td>235%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>584ms</td>
<td>442ms</td>
<td>31%</td>
<td>1948ms</td>
<td>1340ms</td>
<td>45%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1728ms</td>
<td>680ms</td>
<td>154%</td>
<td>5943ms</td>
<td>2164ms</td>
<td>174%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>2048ms</td>
<td>893ms</td>
<td>129%</td>
<td>7111ms</td>
<td>2868ms</td>
<td>147%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>838ms</td>
<td>245ms</td>
<td>241%</td>
<td>2333ms</td>
<td>562ms</td>
<td>314%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>896ms</td>
<td>466ms</td>
<td>92%</td>
<td>2308ms</td>
<td>1181ms</td>
<td>95%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>443ms</td>
<td>155ms</td>
<td>186%</td>
<td>1300ms</td>
<td>234ms</td>
<td>454%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>2707ms</td>
<td>339ms</td>
<td>697%</td>
<td>7781ms</td>
<td>427ms</td>
<td>1722%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>960ms</td>
<td>446ms</td>
<td>115%</td>
<td>2909ms</td>
<td>1633ms</td>
<td>78%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>735ms</td>
<td>255ms</td>
<td>188%</td>
<td>2276ms</td>
<td>699ms</td>
<td>225%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1888ms</td>
<td>1108ms</td>
<td>70%</td>
<td>6513ms</td>
<td>4060ms</td>
<td>60%</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>1525ms</td>
<td>256ms</td>
<td>494%</td>
<td>4650ms</td>
<td>524ms</td>
<td>786%</td>
</tr>
<tr>
<td>Log In</td>
<td>1278ms</td>
<td>406ms</td>
<td>214%</td>
<td>3712ms</td>
<td>598ms</td>
<td>520%</td>
</tr>
<tr>
<td>Feature</td>
<td>2.0</td>
<td>3.0</td>
<td>%</td>
<td>2.0</td>
<td>3.0</td>
<td>%</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
<td>------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>540ms</td>
<td>49ms</td>
<td>1000%</td>
<td>4292ms</td>
<td>95ms</td>
<td>4418%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>882ms</td>
<td>413ms</td>
<td>113%</td>
<td>2151ms</td>
<td>813ms</td>
<td>164%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>1165ms</td>
<td>49ms</td>
<td>2245%</td>
<td>5052ms</td>
<td>72ms</td>
<td>6888%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>1494ms</td>
<td>51ms</td>
<td>2825%</td>
<td>5565ms</td>
<td>69ms</td>
<td>7872%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>1655ms</td>
<td>195ms</td>
<td>748%</td>
<td>5990ms</td>
<td>763ms</td>
<td>684%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>1497ms</td>
<td>197ms</td>
<td>656%</td>
<td>5892ms</td>
<td>822ms</td>
<td>616%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>2440ms</td>
<td>630ms</td>
<td>287%</td>
<td>8300ms</td>
<td>2263ms</td>
<td>266%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>2562ms</td>
<td>685ms</td>
<td>273%</td>
<td>8027ms</td>
<td>2530ms</td>
<td>217%</td>
</tr>
<tr>
<td>View Page</td>
<td>1780ms</td>
<td>750ms</td>
<td>137%</td>
<td>5560ms</td>
<td>2728ms</td>
<td>103%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>1668ms</td>
<td>835ms</td>
<td>99%</td>
<td>4177ms</td>
<td>1976ms</td>
<td>111%</td>
</tr>
<tr>
<td>Search Site</td>
<td>1691ms</td>
<td>275ms</td>
<td>513%</td>
<td>5853ms</td>
<td>407ms</td>
<td>1338%</td>
</tr>
</tbody>
</table>

**Average time Comparison**
### High Load Single Node

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvemnt</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvemnt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>2389ms</td>
<td>1531ms</td>
<td>56%</td>
<td>6196ms</td>
<td>4195ms</td>
<td>47%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>424ms</td>
<td>397ms</td>
<td>6%</td>
<td>1779ms</td>
<td>1603ms</td>
<td>10%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1211ms</td>
<td>815ms</td>
<td>48%</td>
<td>4729ms</td>
<td>2863ms</td>
<td>65%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>1402ms</td>
<td>912ms</td>
<td>53%</td>
<td>5284ms</td>
<td>3094ms</td>
<td>70%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>558ms</td>
<td>297ms</td>
<td>87%</td>
<td>1962ms</td>
<td>1543ms</td>
<td>27%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>783ms</td>
<td>522ms</td>
<td>49%</td>
<td>2567ms</td>
<td>1545ms</td>
<td>66%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>443ms</td>
<td>284ms</td>
<td>55%</td>
<td>1845ms</td>
<td>843ms</td>
<td>118%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>905ms</td>
<td>506ms</td>
<td>78%</td>
<td>2771ms</td>
<td>1245ms</td>
<td>122%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>807ms</td>
<td>504ms</td>
<td>59%</td>
<td>2650ms</td>
<td>2165ms</td>
<td>22%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>551ms</td>
<td>338ms</td>
<td>63%</td>
<td>1961ms</td>
<td>1461ms</td>
<td>34%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1524ms</td>
<td>1180ms</td>
<td>29%</td>
<td>5115ms</td>
<td>4189ms</td>
<td>22%</td>
</tr>
<tr>
<td>Feature</td>
<td>2.10</td>
<td>2.10</td>
<td>3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------</td>
<td>--------</td>
<td>-------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to log in page</td>
<td>409 ms</td>
<td>419 ms</td>
<td>-2%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log In</td>
<td>520 ms</td>
<td>346 ms</td>
<td>50%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>318 ms</td>
<td>124 ms</td>
<td>155%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>866 ms</td>
<td>492 ms</td>
<td>76%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>300 ms</td>
<td>105 ms</td>
<td>186%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>299 ms</td>
<td>98 ms</td>
<td>203%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>390 ms</td>
<td>224 ms</td>
<td>74%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>362 ms</td>
<td>254 ms</td>
<td>42%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>1098 ms</td>
<td>777 ms</td>
<td>41%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>1126 ms</td>
<td>807 ms</td>
<td>39%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Page</td>
<td>1248 ms</td>
<td>742 ms</td>
<td>68%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>1410 ms</td>
<td>914 ms</td>
<td>54%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Site</td>
<td>804 ms</td>
<td>411 ms</td>
<td>95%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Average time Comparison

- View Page: 47%
- Reader RSS Comment Atom: 76%
### Medium Load Cluster

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvemen</th>
<th>95 percent</th>
<th>95 percent</th>
<th>Improvemen</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>in 2.10</td>
<td>in 3.0</td>
<td>in 2.10</td>
<td>in 3.0</td>
</tr>
<tr>
<td>Browse Label</td>
<td>2477ms</td>
<td>919ms</td>
<td>169%</td>
<td>6365ms</td>
<td>2143ms</td>
<td>196%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>410ms</td>
<td>380ms</td>
<td>7%</td>
<td>1127ms</td>
<td>856ms</td>
<td>31%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>1029ms</td>
<td>595ms</td>
<td>72%</td>
<td>4193ms</td>
<td>1826ms</td>
<td>129%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>1367ms</td>
<td>786ms</td>
<td>73%</td>
<td>5264ms</td>
<td>2557ms</td>
<td>105%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>611ms</td>
<td>214ms</td>
<td>184%</td>
<td>1463ms</td>
<td>414ms</td>
<td>253%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>692ms</td>
<td>422ms</td>
<td>63%</td>
<td>1596ms</td>
<td>938ms</td>
<td>70%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>329ms</td>
<td>131ms</td>
<td>150%</td>
<td>1034ms</td>
<td>205ms</td>
<td>404%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>1319ms</td>
<td>395ms</td>
<td>234%</td>
<td>3787ms</td>
<td>556ms</td>
<td>581%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>750ms</td>
<td>387ms</td>
<td>93%</td>
<td>2592ms</td>
<td>1420ms</td>
<td>82%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>493ms</td>
<td>208ms</td>
<td>136%</td>
<td>1569ms</td>
<td>433ms</td>
<td>261%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1500ms</td>
<td>980ms</td>
<td>53%</td>
<td>4903ms</td>
<td>3435ms</td>
<td>42%</td>
</tr>
<tr>
<td>Task</td>
<td>2.10</td>
<td>2.0</td>
<td>3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------</td>
<td>------</td>
<td>------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to log in page</td>
<td>854ms</td>
<td>357ms</td>
<td>138%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log In</td>
<td>961ms</td>
<td>422ms</td>
<td>127%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>183ms</td>
<td>56ms</td>
<td>226%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>663ms</td>
<td>351ms</td>
<td>89%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>499ms</td>
<td>73ms</td>
<td>577%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>453ms</td>
<td>65ms</td>
<td>589%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>776ms</td>
<td>194ms</td>
<td>300%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>742ms</td>
<td>186ms</td>
<td>297%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>1378ms</td>
<td>618ms</td>
<td>122%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>1497ms</td>
<td>584ms</td>
<td>156%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View Page</td>
<td>1352ms</td>
<td>631ms</td>
<td>114%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>1251ms</td>
<td>793ms</td>
<td>57%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Search Site</td>
<td>709ms</td>
<td>258ms</td>
<td>174%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Average time Comparison

![Average time Comparison Graph]
### Medium Load Single Node

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvemnt</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvemnt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>1619ms</td>
<td>1129ms</td>
<td>43%</td>
<td>3979ms</td>
<td>2387ms</td>
<td>66%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>306ms</td>
<td>338ms</td>
<td>-9%</td>
<td>805ms</td>
<td>794ms</td>
<td>1%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>737ms</td>
<td>628ms</td>
<td>17%</td>
<td>3386ms</td>
<td>1783ms</td>
<td>89%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>989ms</td>
<td>707ms</td>
<td>39%</td>
<td>4133ms</td>
<td>2168ms</td>
<td>90%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>402ms</td>
<td>211ms</td>
<td>90%</td>
<td>765ms</td>
<td>391ms</td>
<td>95%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>525ms</td>
<td>387ms</td>
<td>35%</td>
<td>1161ms</td>
<td>882ms</td>
<td>31%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>256ms</td>
<td>233ms</td>
<td>9%</td>
<td>704ms</td>
<td>501ms</td>
<td>40%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>554ms</td>
<td>382ms</td>
<td>44%</td>
<td>1685ms</td>
<td>634ms</td>
<td>165%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>520ms</td>
<td>417ms</td>
<td>24%</td>
<td>1881ms</td>
<td>1065ms</td>
<td>76%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>332ms</td>
<td>250ms</td>
<td>32%</td>
<td>831ms</td>
<td>620ms</td>
<td>34%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>1199ms</td>
<td>961ms</td>
<td>24%</td>
<td>3949ms</td>
<td>3459ms</td>
<td>14%</td>
</tr>
</tbody>
</table>
## Average time Comparison

<table>
<thead>
<tr>
<th>Task Description</th>
<th>Old Time</th>
<th>New Time</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to log in page</td>
<td>274ms</td>
<td>456ms</td>
<td>-39%</td>
</tr>
<tr>
<td>Log In</td>
<td>342ms</td>
<td>333ms</td>
<td>2%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>134ms</td>
<td>57ms</td>
<td>133%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>551ms</td>
<td>369ms</td>
<td>49%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>170ms</td>
<td>59ms</td>
<td>184%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>206ms</td>
<td>95ms</td>
<td>116%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>203ms</td>
<td>126ms</td>
<td>60%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>369ms</td>
<td>151ms</td>
<td>143%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>628ms</td>
<td>513ms</td>
<td>22%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>800ms</td>
<td>547ms</td>
<td>46%</td>
</tr>
<tr>
<td>View Page</td>
<td>890ms</td>
<td>584ms</td>
<td>52%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>904ms</td>
<td>677ms</td>
<td>33%</td>
</tr>
<tr>
<td>Search Site</td>
<td>505ms</td>
<td>340ms</td>
<td>48%</td>
</tr>
</tbody>
</table>

**Notes:**
- 2.0 Version
- 3.0 Version
- % Improvement
## Peak Load Cluster

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvem.</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvem.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>9179ms</td>
<td>2150ms</td>
<td>326%</td>
<td>22987ms</td>
<td>5695ms</td>
<td>303%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>999ms</td>
<td>859ms</td>
<td>16%</td>
<td>3175ms</td>
<td>2712ms</td>
<td>17%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>2760ms</td>
<td>1213ms</td>
<td>127%</td>
<td>8739ms</td>
<td>3908ms</td>
<td>123%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>3225ms</td>
<td>1672ms</td>
<td>92%</td>
<td>10941ms</td>
<td>5323ms</td>
<td>105%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>2396ms</td>
<td>379ms</td>
<td>532%</td>
<td>7285ms</td>
<td>1487ms</td>
<td>389%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>1913ms</td>
<td>858ms</td>
<td>122%</td>
<td>4850ms</td>
<td>2548ms</td>
<td>90%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>1070ms</td>
<td>270ms</td>
<td>296%</td>
<td>2925ms</td>
<td>1130ms</td>
<td>158%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>7383ms</td>
<td>466ms</td>
<td>1481%</td>
<td>19349ms</td>
<td>1429ms</td>
<td>1254%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>2460ms</td>
<td>761ms</td>
<td>223%</td>
<td>7388ms</td>
<td>2737ms</td>
<td>169%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>2609ms</td>
<td>357ms</td>
<td>630%</td>
<td>7143ms</td>
<td>1385ms</td>
<td>415%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>4064ms</td>
<td>1821ms</td>
<td>123%</td>
<td>12599ms</td>
<td>6287ms</td>
<td>100%</td>
</tr>
<tr>
<td>Operation</td>
<td>Time 1</td>
<td>Time 2</td>
<td>Time 3</td>
<td>Time 4</td>
<td>Time 5</td>
<td>Time 6</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>3622ms</td>
<td>280ms</td>
<td>1191%</td>
<td>13728ms</td>
<td>497ms</td>
<td>2657%</td>
</tr>
<tr>
<td>Log In</td>
<td>3603ms</td>
<td>497ms</td>
<td>625%</td>
<td>12477ms</td>
<td>1045ms</td>
<td>1093%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>1268ms</td>
<td>92ms</td>
<td>1273%</td>
<td>9515ms</td>
<td>435ms</td>
<td>2084%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>1591ms</td>
<td>539ms</td>
<td>195%</td>
<td>3616ms</td>
<td>1622ms</td>
<td>122%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>4514ms</td>
<td>78ms</td>
<td>5688%</td>
<td>14570ms</td>
<td>136ms</td>
<td>10605%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>4666ms</td>
<td>84ms</td>
<td>5416%</td>
<td>14554ms</td>
<td>134ms</td>
<td>10689%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>4750ms</td>
<td>328ms</td>
<td>1346%</td>
<td>14934ms</td>
<td>1545ms</td>
<td>866%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>4723ms</td>
<td>302ms</td>
<td>1460%</td>
<td>16526ms</td>
<td>1412ms</td>
<td>1070%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>6443ms</td>
<td>1012ms</td>
<td>536%</td>
<td>20556ms</td>
<td>4005ms</td>
<td>413%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>6287ms</td>
<td>1109ms</td>
<td>466%</td>
<td>17762ms</td>
<td>4175ms</td>
<td>325%</td>
</tr>
<tr>
<td>View Page</td>
<td>3363ms</td>
<td>1345ms</td>
<td>150%</td>
<td>10510ms</td>
<td>4717ms</td>
<td>122%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>3069ms</td>
<td>1161ms</td>
<td>164%</td>
<td>9475ms</td>
<td>3023ms</td>
<td>213%</td>
</tr>
<tr>
<td>Search Site</td>
<td>3334ms</td>
<td>378ms</td>
<td>780%</td>
<td>10560ms</td>
<td>1368ms</td>
<td>671%</td>
</tr>
</tbody>
</table>

**Average time Comparison**

![Graph showing average time comparison](image-url)
### Peak Load Single Node

**95 percent Comparison**

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Average time in 2.10</th>
<th>Average time in 3.0</th>
<th>Improvement</th>
<th>95 percent in 2.10</th>
<th>95 percent in 3.0</th>
<th>Improvement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Label</td>
<td>4747ms</td>
<td>3207ms</td>
<td>47%</td>
<td>10951ms</td>
<td>7575ms</td>
<td>44%</td>
</tr>
<tr>
<td>Commentor submit comment</td>
<td>1517ms</td>
<td>1146ms</td>
<td>32%</td>
<td>4521ms</td>
<td>3611ms</td>
<td>25%</td>
</tr>
<tr>
<td>Commentor view commented page</td>
<td>3148ms</td>
<td>2173ms</td>
<td>44%</td>
<td>9222ms</td>
<td>6184ms</td>
<td>49%</td>
</tr>
<tr>
<td>Commentor view page</td>
<td>3302ms</td>
<td>2317ms</td>
<td>42%</td>
<td>9891ms</td>
<td>6410ms</td>
<td>54%</td>
</tr>
<tr>
<td>Creator add page</td>
<td>1693ms</td>
<td>934ms</td>
<td>81%</td>
<td>3904ms</td>
<td>3170ms</td>
<td>23%</td>
</tr>
<tr>
<td>Creator submit new page</td>
<td>2777ms</td>
<td>1959ms</td>
<td>41%</td>
<td>5812ms</td>
<td>5170ms</td>
<td>12%</td>
</tr>
<tr>
<td>Creator view page</td>
<td>1589ms</td>
<td>1065ms</td>
<td>49%</td>
<td>3523ms</td>
<td>3358ms</td>
<td>4%</td>
</tr>
<tr>
<td>Dashboard</td>
<td>2121ms</td>
<td>1420ms</td>
<td>49%</td>
<td>5492ms</td>
<td>3704ms</td>
<td>48%</td>
</tr>
<tr>
<td>Editor display page</td>
<td>2216ms</td>
<td>1502ms</td>
<td>47%</td>
<td>5081ms</td>
<td>4233ms</td>
<td>20%</td>
</tr>
<tr>
<td>Edit Page</td>
<td>1714ms</td>
<td>1062ms</td>
<td>61%</td>
<td>4008ms</td>
<td>3452ms</td>
<td>16%</td>
</tr>
<tr>
<td>Editor submit edit</td>
<td>3945ms</td>
<td>3205ms</td>
<td>23%</td>
<td>10523ms</td>
<td>9467ms</td>
<td>11%</td>
</tr>
<tr>
<td>Task Description</td>
<td>Time for 2.10</td>
<td>Time for 3.0</td>
<td>Speedup</td>
<td>Time for 2.10</td>
<td>Time for 3.0</td>
<td>Speedup</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>---------</td>
<td>----------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>Go to log in page</td>
<td>934ms</td>
<td>818ms</td>
<td>14%</td>
<td>4544ms</td>
<td>4091ms</td>
<td>11%</td>
</tr>
<tr>
<td>Log In</td>
<td>807ms</td>
<td>913ms</td>
<td>-11%</td>
<td>2879ms</td>
<td>3531ms</td>
<td>-18%</td>
</tr>
<tr>
<td>Quick Navigation Search</td>
<td>1121ms</td>
<td>568ms</td>
<td>97%</td>
<td>4288ms</td>
<td>2704ms</td>
<td>58%</td>
</tr>
<tr>
<td>Reader Not Found</td>
<td>2159ms</td>
<td>1222ms</td>
<td>76%</td>
<td>4265ms</td>
<td>3472ms</td>
<td>22%</td>
</tr>
<tr>
<td>Reader RSS Blogpost Atom</td>
<td>864ms</td>
<td>531ms</td>
<td>62%</td>
<td>2796ms</td>
<td>2511ms</td>
<td>11%</td>
</tr>
<tr>
<td>Reader RSS Blogpost RSS2</td>
<td>1099ms</td>
<td>527ms</td>
<td>108%</td>
<td>4307ms</td>
<td>2691ms</td>
<td>60%</td>
</tr>
<tr>
<td>Reader RSS Comment Atom</td>
<td>1110ms</td>
<td>736ms</td>
<td>50%</td>
<td>3469ms</td>
<td>2760ms</td>
<td>25%</td>
</tr>
<tr>
<td>Reader RSS Comment RSS2</td>
<td>1159ms</td>
<td>863ms</td>
<td>34%</td>
<td>3959ms</td>
<td>3130ms</td>
<td>26%</td>
</tr>
<tr>
<td>Reader RSS Page Atom</td>
<td>2395ms</td>
<td>2300ms</td>
<td>4%</td>
<td>7588ms</td>
<td>7342ms</td>
<td>3%</td>
</tr>
<tr>
<td>Reader RSS Page RSS2</td>
<td>2661ms</td>
<td>2258ms</td>
<td>17%</td>
<td>8295ms</td>
<td>7922ms</td>
<td>4%</td>
</tr>
<tr>
<td>View Page</td>
<td>3038ms</td>
<td>2055ms</td>
<td>47%</td>
<td>7809ms</td>
<td>5702ms</td>
<td>36%</td>
</tr>
<tr>
<td>Reader for Space Page</td>
<td>3005ms</td>
<td>1990ms</td>
<td>51%</td>
<td>6298ms</td>
<td>4850ms</td>
<td>29%</td>
</tr>
<tr>
<td>Search Site</td>
<td>1950ms</td>
<td>1247ms</td>
<td>56%</td>
<td>4902ms</td>
<td>3647ms</td>
<td>34%</td>
</tr>
</tbody>
</table>

Average time Comparison

![Average time comparison chart](chart.png)
### Issues Resolved in Confluence 3.0

Below are the issues resolved in Confluence 3.0, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. You can also take a look at the Confluence 3.0 Release Notes.

#### JIRA Issues (200 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🇦🇺</td>
<td>CONF-5853</td>
<td>Tables in PDF. Exports have the same width for every column. Width should be appropriate to the column content.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>96</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-8436</td>
<td>Add support for page breaks in PDF page exports</td>
<td>Resolved</td>
<td>Fixed</td>
<td>25</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-599</td>
<td>Changing header/footer of exported PDF document</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-1790</td>
<td>Export Page Hierarchy</td>
<td>Resolved</td>
<td>Fixed</td>
<td>19</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-6917</td>
<td>Include external images in PDFs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-3092</td>
<td>Selecting hierarchy in space during export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-6750</td>
<td>Custom layouts for PDF exports</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
</tr>
<tr>
<td>🇦🇺</td>
<td>CONF-6756</td>
<td>Improve the Export Space pages selection to allow easy selection of a page and all its children</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
</tr>
</tbody>
</table>
| Issue | Key   | Description                                                                 | Status | Priority | Resolution
|-------|-------|-----------------------------------------------------------------------------|--------|----------|------------
| CONF-11762 | Support for DB2 9 | Resolved, Fixed, 0
| CONF-10692 | Add logging as an audit trail for plugins being installed and enabled/disabled | Resolved, Fixed, 0
| CONF-5415 | Investigate performance gains of multicolumn and functional indexes in Postgres | Resolved, Fixed, 0
| CONF-14181 | Reduce blocking inside ognl.OgnlRuntime | Resolved, Fixed, 0
| CONF-14516 | Only acquire a lock for deferred operations cache if necessary | Resolved, Fixed, 0
| CONF-14533 | Expose the id in content name search results | Resolved, Fixed, 0
| CONF-14462 | User Status | Resolved, Fixed, 0
| CONF-14438 | Deprecate com.atlassian.confine.util.io.IOUtils | Resolved, Fixed, 0
| CONF-14490 | Add the ability to Hibernate to have more than one index per column | Resolved, Fixed, 0
| CONF-13917 | Improve performance by caching Userprofile-Pictures and Space-logos | Resolved, Fixed, 0
| CONF-14059 | Synchronization inside ognl.EvaluationPool is a performance bottleneck in high load instances | Resolved, Fixed, 0
| CONF-14705 | Workaround for authentication login prompt | Resolved, Fixed, 0
<table>
<thead>
<tr>
<th>Priority</th>
<th>Key</th>
<th>Text</th>
<th>Resolution</th>
<th>Status</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CONF-14434</td>
<td>Display the most recent edit by a user, even if other users edited the same pages afterwards</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>CONF-15073</td>
<td>Add web-items plugin point on Dashboard for navigation items similar to the Page and BlogPost pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>CONF-15647</td>
<td>change uploadplugin action to redirect to viewplugins.addAction on success</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>CONF-12741</td>
<td>Space Permissions Screen not displayed properly on 1024x768 display</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
</tr>
<tr>
<td>1</td>
<td>CONF-13276</td>
<td>Restrict anonymous users from viewing user profiles</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
</tr>
<tr>
<td>1</td>
<td>CONF-8298</td>
<td>Reduce the number of directories created under ${confluence.home}/attachments</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>CONF-14156</td>
<td>Code Macro - Rich Text Editor removes spaces</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
</tr>
<tr>
<td>1</td>
<td>CONF-9928</td>
<td>Wiki markup containing &lt;tag&gt; elements is erased when switching to the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>CONF-13823</td>
<td>Editing a page with columns in RTE overwrites</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>#</td>
<td>CONF-XXXX</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Count</td>
</tr>
<tr>
<td>---</td>
<td>------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td></td>
<td>CONF-11172</td>
<td>Line-break markup () uses clear=all style, breaking blog post layout in 2.8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>CONF-14248</td>
<td>Exception given when Doc Import tries to create pages with duplicate names</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-14798</td>
<td>pdf [viewfile] slide renderer creates vast amounts of garbage which lead to poor performance</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-15809</td>
<td>Viewfile macros do not respect page restrictions</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-15754</td>
<td>Jira issues add icon mapping configuration is susceptible to XSS</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-16184</td>
<td>Lock contentions in didyoumean code</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-15146</td>
<td>Saving a page or Switching to wiki markup fails with java.lang.AbstractMethodError: getTextContent error in Weblogic</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-15644</td>
<td>Did-you-mean search IncrementalIndexBuilder uses large amount of PermGen memory to store words</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-14539</td>
<td>The XStream serializer only uses the plugins class loader</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-15986</td>
<td>Page’s attachments become</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>#</td>
<td>Key</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Notes</td>
</tr>
<tr>
<td>-----</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>1</td>
<td>CONF-15376</td>
<td>Gallery Macro XSS</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>CONF-2079</td>
<td>More control over PDF exporting</td>
<td>Resolved</td>
<td>Fixed</td>
<td>232</td>
</tr>
<tr>
<td>3</td>
<td>CONF-12836</td>
<td>Add ability to tune caches from the UI</td>
<td>Resolved</td>
<td>Fixed</td>
<td>36</td>
</tr>
<tr>
<td>4</td>
<td>CONF-6919</td>
<td>Macros and plugins should be able to render themselves properly for PDF and HTML export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>35</td>
</tr>
<tr>
<td>5</td>
<td>CONF-986</td>
<td>Search inside of a tree of nested pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>22</td>
</tr>
<tr>
<td>6</td>
<td>CONF-8945</td>
<td>Watch emails (change notifications) should contain html diffs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td>7</td>
<td>CONF-8302</td>
<td>Allow recently updated macro to filter results by users</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td>8</td>
<td>CONF-8071</td>
<td>Generate PDF with specific cover page or custom layout</td>
<td>Resolved</td>
<td>Fixed</td>
<td>17</td>
</tr>
<tr>
<td>9</td>
<td>CONF-7910</td>
<td>PDF Export of wide tables does not resize the table properly to fit the 'paper' size.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>CONF-1104</td>
<td>Allow configuration of page size and orientation in PDF Export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>14</td>
</tr>
<tr>
<td>11</td>
<td>CONF-5114</td>
<td>Provide ability to search within only part of a space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
</tr>
<tr>
<td>12</td>
<td>CONF-8273</td>
<td>Copying a page to a new space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
</tr>
<tr>
<td>Issue ID</td>
<td>Title</td>
<td>Description</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-7708</td>
<td>html macro loses formatting wiki markup and rich text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CONF-6622</td>
<td>Ability to see all pages edited by user</td>
<td>Resolved</td>
<td>Fixed</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CONF-14058</td>
<td>Whitespace added between (section) and (column) every wysiwyg round-trip</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-13524</td>
<td>Left navigation theme displays &quot;news operations&quot; instead of &quot;page operations&quot; when viewing the left nav main menu categories</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-12083</td>
<td>Outlook 2007 is unable to read Confluence RSS feeds over HTTPS</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>CONF-14328</td>
<td>Expose a remote API to set custom ordering of pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>CONF-11552</td>
<td>height and width of embedded movies is changed to 32 by Rich Text Editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>CONF-7225</td>
<td>PDF Export throws an exception when an unterminated macro is used in a heading</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>CONF-11286</td>
<td>Allow ability to view a users profile after they've created a personal space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-14698</td>
<td>A number of</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-11878</td>
<td>PDF Customization Console</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7491</td>
<td>Escaped (+) and (-) in content revert to emoticons when opening for Edit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9934</td>
<td>Full screen editor does not autosave to Drafts folder</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7027</td>
<td>Wiki markup for graphical emoticons not escaped by rich text editor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-5135</td>
<td>Ability to search part of the page tree</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7398</td>
<td>Make PDF export fonts and styles themeable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-5079</td>
<td>Partial terms do not return any results when searching for usernames, full names or emails in “manage users”</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14175</td>
<td>Confluence Macro Browser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8034</td>
<td>Serve attachments, including embedded images, with cache headers</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-3594</td>
<td>Activity report for content a user has been involved with</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-11799</td>
<td>Editing tables with Rich Text -</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Jenkins Job</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-15040</td>
<td>Confluence 2.10.x incompatible with WebSphere - plugins do not load</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-4128</td>
<td>Can't copy and paste text from Confluence generated PDFs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-9234</td>
<td>Label order in popular-labels macro changes when using a space key parameter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-14505</td>
<td>Wildcards in &quot;manage user&quot; searches cause performance problems with large LDAP repositories</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-7623</td>
<td>PDF export is missing the title information from the code macro in the page</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-14192</td>
<td>cut/paste row from table (move rows)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-9901</td>
<td>Export space to PDF or HTML fails if the space has attachments</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-12321</td>
<td>Update attachment comment should not update last modification date of all historical versions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-14791</td>
<td>Confluence doesn't start up on OpenJDK because it requires com.sun.image.codec.jpeg.JPEGImageEncoder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Summary</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------</td>
<td>------------</td>
<td>---------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-5990</td>
<td>export to PDF truncates HTML links to external sites</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-7425</td>
<td>Error in pdf export using content formatting macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-12634</td>
<td>PDF Exporter doesn't handle situations when JTidy fails</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-7209</td>
<td>Em-dash inserted in Rich Text Edit breaks after saving or changing to WIKI markup mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-8709</td>
<td>On Space Export screen add the ability to select all children of a page for export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-4334</td>
<td>Escaping smileys in wiki markup doesn't work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-13094</td>
<td>Export page tree should be use subtree selection</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-4584</td>
<td>Users with Acrobat Reader 7 installed cannot open PDF files in browser.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-13933</td>
<td>Add optional diff to email notifications and improve the diffing logic</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-14072</td>
<td>Alphabetical listing of pages does not work when there are too many pages beginning with a letter</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-6865</td>
<td>Side by side images will expand across</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
<th>Description</th>
<th>Status</th>
<th>Type</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-3904</td>
<td>Hint macro not displaying correctly in page created from PDF Export</td>
<td>Resolved Fixed 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12366</td>
<td>Image width and height are to 32 by wysiwyg editor for missing image files</td>
<td>Resolved Fixed 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13188</td>
<td>Code macro breaks PDF export when there is a pattern //&lt;keyword&gt; &lt;keyword&gt;</td>
<td>Resolved Fixed 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15864</td>
<td>Switching between Rich text editor and Wiki markup editor causes code macro add line space</td>
<td>Resolved Fixed 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14783</td>
<td>Encoding test should use a GET submission to mimic quick search</td>
<td>Resolved Fixed 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9603</td>
<td>Restore recent activity to a user profile screen</td>
<td>Resolved Fixed 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8453</td>
<td>Links created via the Rich Text Editor dialog lose the space character immediately after the link</td>
<td>Resolved Fixed 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14282</td>
<td>Section macro loses parameters when switching between RTE and Wiki Markup</td>
<td>Resolved Fixed 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15450</td>
<td>If a user has no text in their profile, XML-RPC calls</td>
<td>Resolved Fixed 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-14733</td>
<td>Excessive logging during export word page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>CONF-14724</td>
<td>Clicking on thumbnail images in IE prompts for download instead of opening popup with large image</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-8647</td>
<td>Removing an entire table in Rich Text Editor is not intuitive</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-12612</td>
<td>Menus look bad in IE7</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-14128</td>
<td>Reduce blocking in Velocity when accessing cache</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-14491</td>
<td>Add a system property to enable logging of Macros used.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-10166</td>
<td>Inconsistent escaping of emoticons in rich-text edit mode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-8320</td>
<td>Search macro output inconsistent with notation guide</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-12894</td>
<td>Slow page rendering when using Confluence via HTTPS / SSL due to lack of caching</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-14222</td>
<td>i18n support for macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-3609</td>
<td>PDF export with png image cannot be read with Adobe Reader</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>CONF-13684</td>
<td>Inserting a link in RTE behaves</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>--------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-7868</td>
<td>PDF Export of page with user macros fail</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-8322</td>
<td>PDF export fails under certain unfortunate naming of pages and headings</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-13814</td>
<td>Error removing space with custom space logo and attachments stored in the database</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-6445</td>
<td>Visual page diff tool: Only display that part of a diff that actually has changes</td>
<td>Closed</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-15120</td>
<td>Can't install Office Connector firefox plugin because 'Signing could not be verified'</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-4211</td>
<td>Page doesn't get exported if its parents are not exported.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-7432</td>
<td>PDF export fails when uploaded font contains a space in its path</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-12058</td>
<td>popular-labels macro doesn't order the labels alphabetically</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-9736</td>
<td>Large embedded images are converted to a thumbnail size when exported into the PDF format</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-7412</td>
<td>Text inside code macro displays outside boundaries in exported PDF</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue Key</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-7749</td>
<td>Don’t block index readers during index updates and optimization</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-14441</td>
<td>PDF export of noformat-content displayed with variable font (wrongly)</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-13843</td>
<td>Recently-Updated macro throws a BooleanQuery$TooManyClauses exception</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-13769</td>
<td>The full screen view has no scroll bar</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-13825</td>
<td>NullPointerException when thumbnail cannot be generated</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-14029</td>
<td>Javascript error on “Add Members” in Manage Groups in IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-6860</td>
<td>Blank lines in a table row are lost in a PDF Export of the table</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-13795</td>
<td>Index searcher not properly closed after searches</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-13663</td>
<td>Links within Charting Portlet displaying results inside IFrame</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>CONF-14431</td>
<td>Write Anti-XSS documentation for plugin developers</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>CONF-13846</td>
<td>Wildcard and range queries always converted to lower case</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>CONF-14121</td>
<td>Use putAll() instead of put() on the</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Priority</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-14098</td>
<td>Coherence cache</td>
<td>Remove unnecessary synchronization on Hibernates UpdateTimestampsCache</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-13911</td>
<td></td>
<td>Using heading formats in lists and tables inserts unwanted new lines @ cursor</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-15643</td>
<td></td>
<td>Sensible default settings for Remote API and Public Sign Up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-15731</td>
<td></td>
<td>Document changes made for Conf-15643</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-15703</td>
<td></td>
<td>One pagetree-macro in a pagelayout prevents another pagetree-macro on a page from working correctly</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-15253</td>
<td></td>
<td>Jsonator does not encode string according to the spec</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-14081</td>
<td></td>
<td>Allow disabling of JMX via a system property</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-13469</td>
<td></td>
<td>Replace LuceneSmartListManager with V2SearchSmartListManager and ensure backwards compatibility</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-13865</td>
<td></td>
<td>Admin users should be able to see content in all spaces when using QuickNav</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf-13945</td>
<td></td>
<td>History version comparison should never be a POST</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-15720</td>
<td>Include-Excerpt macro doesn't include excerpts until the page has been viewed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-9615</td>
<td>Cluster information page should tell you which node you're currently on.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15396</td>
<td>Improve performance of TransactionalCacheFactory</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14272</td>
<td>Remove deprecated ThumbnailManager classes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14257</td>
<td>Avatars should be served with proper cache control headers</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-11576</td>
<td>Add a remove link button to the Rich Text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13858</td>
<td>Rendering of insert table dialog poor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14688</td>
<td>Improve performance of HtmlSafe annotation checking</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-5782</td>
<td>Selecting several lines and applying the heading style produces incorrect markup</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-9038</td>
<td>PDF Generation fails when bgcolor wiki markup is used</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15251</td>
<td>Remove Table Layout from Profile Pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15119</td>
<td>Update to atlassian-plugins 2.2</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15566</td>
<td>Upgrade atlassian xwork</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Assigned</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>CONF-15550</td>
<td>Remove dependency on atlassian-bucket</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14015</td>
<td>500page.jsp always reports Confluence User as anonymous</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15157</td>
<td>viewfile macro does not work for non printable PDFs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14073</td>
<td>Deprecate ThumbnailInfoFactory</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15059</td>
<td>Deprecate com.atlassian.confluence.cache.CacheManagerKeys</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-11749</td>
<td>Uploaded pdf fonts break when the home directory is moved</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14689</td>
<td>Comment edits do not trigger email notification</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-12264</td>
<td>Extra newline appears when converting to H2 in a new page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13490</td>
<td>Attachments can be moved to a page which the user cannot access</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14969</td>
<td>Remove &quot;Open Web Folder&quot; link from attachment lists</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15484</td>
<td>Cache personal information objects to improve performance</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15385</td>
<td>Confluence runs out of file handles when running the did you mean index</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-14318</td>
<td>Preview macro in macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14406</td>
<td>User Profile Sidebar in personal spaces</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14411</td>
<td>Network Macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15047</td>
<td>Users can remove pages with remove page permission via moving the page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14339</td>
<td>Avoid unnecessary cluster replication of the spacekey cache</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-11371</td>
<td>ConfluenceEncodingFilter removes Unicode dashes, quotes, bullets and ellipses</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13844</td>
<td>Allow plugins to indicate whether they should be subject to automatic HTML encoding</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14343</td>
<td>Add and display macro parameter descriptions in macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-12191</td>
<td>Page title font should match the header fonts when printing</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14559</td>
<td>RTE does not deal with <code>&lt;foo&gt;</code> correctly.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15345</td>
<td>Follow macro does not render the 'Full theme' (large icons) when previewing it either in the</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14517</td>
<td>Look and Feel improvements to User Profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14495</td>
<td>Remove public logger in VersionedHibernateObjectDao</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14938</td>
<td>viewfile causing OutOfMemoryError for Powerpoint files that contain embedded PICT file (Mac OS X)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7484</td>
<td>Pages with image larger than the PDF 'paper' size will cause a failure during PDF export.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14298</td>
<td>Last modifier and creator username gets set to null when modifying CEOs from outside a request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15534</td>
<td>Add a new search filter to allow in place pagination of search results</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14651</td>
<td>Improve cluster performance by avoiding cache puts for already-cached objects</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15531</td>
<td>BuildNumberCondition would make it easier to control display of web items in plugins</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13893</td>
<td>Add context menus for the RTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14273</td>
<td>Reduce DB load for loading pages</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13893</td>
<td>Add context menus for the RTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13893</td>
<td>Add context menus for the RTE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14517</td>
<td>Look and Feel improvements to User Profile</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14495</td>
<td>Remove public logger in VersionedHibernateObjectDao</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14938</td>
<td>viewfile causing OutOfMemoryError for Powerpoint files that contain embedded PICT file (Mac OS X)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7484</td>
<td>Pages with image larger than the PDF 'paper' size will cause a failure during PDF export.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Confluence 3.0 Issues Resolved

<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Description</th>
<th>Status</th>
<th>Type</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-9519</td>
<td>Allow search results to be bookmarked</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14531</td>
<td>Add filtering/search box to macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14523</td>
<td>Insert macro form for macros that don’t provide parameter metadata</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14093</td>
<td>Implement Hibernate’s ReadWriteCache in a non blocking way</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14094</td>
<td>Confluence Support Request Improvements</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-7633</td>
<td>Error in PDF Export after the first call of a sql-macro producing a table output</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-15061</td>
<td>Extract build information responsibilities from GeneralUtil</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14823</td>
<td>Dynamic tasklist, widget macros and plugin repository don’t work after upgrade to Confluence 2.10.1 or 2.10.2</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14213</td>
<td>Correct MySQL collation for Confluence database</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>

Above are the issues resolved in Confluence 3.0, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our [issue tracker](https://confluence.atlassian.com/display/CONFLUENCE/Issue+Tracker).

### Confluence 3.1.1 Release Notes

**27 January 2010**

**Confluence 3.1.1** is a recommended upgrade which fixes a number of issues.

**Performance Enhancements and Fixes**
This release fixes two bugs that affected configuration of Confluence's internal caches. The first bug caused an error to be thrown when a Confluence internal cache was either increased to over 5000 elements (from under 5000) or resized when it was already over 5000 elements, via the Administration Console. The second bug caused changes made to Confluence's internal caches via the Administration Console to be lost after a Confluence restart. This meant that caches could only be resized by manually editing the cache configuration files (XML).

We identified an issue where Hibernate was not cleaning up its session correctly when closed, causing memory leaks. We have changed the way that Hibernate SessionImpl objects are stored which should fix this problem and reduce memory consumption.

A system property (atlassian.user.experimentalMapping) was introduced in Confluence 2.10 to fix performance problems noted when adding a local user to a local user group. We have fixed an bug with this system property that prevented users from being removed from user groups via the Administration Console, when the system property is set.

Other Fixes

We have found a bug that periodically caused an error to display when trying to view the ‘Confluence Gadgets’ window. This has now been fixed.

There’s a complete list of fixes below. Click a specific issue to see details of the fix.

Don’t have Confluence 3.1 yet?

Take a look at the new features and other highlights in the Confluence 3.1 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 3.1.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (46 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CONF-18030</td>
</tr>
<tr>
<td>CONF-17898</td>
</tr>
<tr>
<td>CONF-17884</td>
</tr>
<tr>
<td>CONF-17246</td>
</tr>
<tr>
<td>CONF-17039</td>
</tr>
<tr>
<td>CONF-12319</td>
</tr>
<tr>
<td>CONF-18164</td>
</tr>
<tr>
<td>CONF-18093</td>
</tr>
<tr>
<td>CONF-18024</td>
</tr>
<tr>
<td>CONF-17973</td>
</tr>
<tr>
<td>Ticket</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>CONF-17946</td>
</tr>
<tr>
<td>CONF-17932</td>
</tr>
<tr>
<td>CONF-17864</td>
</tr>
<tr>
<td>CONF-17847</td>
</tr>
<tr>
<td>CONF-16643</td>
</tr>
<tr>
<td>CONF-16176</td>
</tr>
<tr>
<td>CONF-14005</td>
</tr>
<tr>
<td>CONF-11838</td>
</tr>
<tr>
<td>CONF-7735</td>
</tr>
<tr>
<td>CONF-18103</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CONF-17877</td>
</tr>
<tr>
<td>CONF-17784</td>
</tr>
<tr>
<td>CONF-17631</td>
</tr>
<tr>
<td>CONF-17273</td>
</tr>
<tr>
<td>CONF-17114</td>
</tr>
<tr>
<td>CONF-16974</td>
</tr>
<tr>
<td>CONF-16852</td>
</tr>
<tr>
<td>CONF-16815</td>
</tr>
<tr>
<td>CONF-16088</td>
</tr>
<tr>
<td>CONF-16060</td>
</tr>
</tbody>
</table>
Correctly - instead, showing some internal code variable.

<table>
<thead>
<tr>
<th>#</th>
<th>CONF-14494</th>
<th>Borders are not applied to image thumbnails</th>
<th>Resolved</th>
<th>Fixed</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>CONF-13032</td>
<td>Download All attachments link breaks when servlet context contains capital letter</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>CONF-10671</td>
<td>export throws null pointer exception when servlet context contains capital letter</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>CONF-10653</td>
<td>Confluence is not able to move pages from one space to another that contain asterisks</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

If you like, you can open a report on jira.atlassian.com showing all resolved and closed issues in this release.

Confluence 3.1.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.1.1. Confluence 3.1.1 is a recommended upgrade which fixes a number of issues. For more details, please read the Confluence 3.1.1 Release Notes.

On this page:

- Upgrade Procedure
- Useful Plugins

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.
2. If your version of Confluence is earlier than 3.1.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.1.1 Release Notes.
   - If you are upgrading from 2.1 or earlier, please pay careful attention to the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see...
whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.
- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.1.2 Release Notes

3 March 2010

Confluence 3.1.2 is a recommended upgrade which fixes a number of bugs. Please see the 'Updates and Fixes in this Release' section below for details.

We identified a bug (see CONF-18437) that caused errors to be thrown whenever the macro browser was used in a theme other than the default theme. This bug also caused the preview mode to hang when the preview tab was clicked (i.e. the loading icon would spin forever without the preview mode loading). This has been fixed for all themes bundles with Confluence. If you are using a custom theme, you will need to implement a custom workaround, as described in the related JIRA issue.

Don't have Confluence 3.1 yet?

Take a look at the new features and other highlights in the Confluence 3.1 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 3.1.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

There's a complete list of fixes below. Click a specific issue to see details of the fix. Click here to open a report on http://jira.atlassian.com for Resolved or Closed issues in Confluence 3.1.2.

<table>
<thead>
<tr>
<th>JIRA Issues (21 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>🚨</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CONF-18207</td>
</tr>
<tr>
<td>CONF-18202</td>
</tr>
<tr>
<td>CONF-17311</td>
</tr>
<tr>
<td>CONF-16389</td>
</tr>
<tr>
<td>CONF-14820</td>
</tr>
<tr>
<td>CONF-13627</td>
</tr>
<tr>
<td>CONF-13529</td>
</tr>
<tr>
<td>CONF-7473</td>
</tr>
<tr>
<td>CONF-18271</td>
</tr>
<tr>
<td>CONF-18235</td>
</tr>
<tr>
<td>CONF-18194</td>
</tr>
<tr>
<td>CONF-18144</td>
</tr>
<tr>
<td>CONF-17533</td>
</tr>
</tbody>
</table>
Confluence 3.1.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.1.2. Confluence 3.1.2 is a recommended upgrade which fixes a number of bugs. For more details, please read the Confluence 3.1.2 Release Notes.

On this page:
- Upgrade Notes
- Upgrade Procedure
- Useful Plugins

Upgrade Notes

There are no upgrade tasks specific to Confluence 3.1.2. Please refer to the ‘Upgrade Procedure’ section below.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest
Before you upgrade, we strongly recommend that you [backup your Confluence home directory and database](https://confluence.jetbrains.com/doc/23080).

If your version of Confluence is earlier than 3.1.2, read the [release notes and upgrade guides](https://confluence.jetbrains.com/doc/23080) for all releases between your version and the latest version. In particular:

- Please read the [Confluence 3.1.2 Release Notes](https://confluence.jetbrains.com/doc/23080).
- If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](https://confluence.jetbrains.com/doc/23080).

Download the latest version of Confluence.

Follow the instructions in the [Upgrade Guide](https://confluence.jetbrains.com/doc/23080).

### Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on [plugin support](https://confluence.jetbrains.com/doc/23080).**

- Appfire’s [Upgrade Assistant for Confluence (UAC)](https://confluence.jetbrains.com/doc/23080) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

### Confluence 3.1 Release Notes

Confluence 3.1 fixes some security flaws. Please refer to the [security advisory](https://confluence.jetbrains.com/doc/23080) for details of the security vulnerabilities, risk assessment and mitigation strategies.

8 December 2009

With great pleasure, Atlassian presents Confluence 3.1.

Confluence 3.1 is a major release which presents a number of new features and enhancements. With Confluence 3.1, we introduce [OpenSocial Gadgets](https://confluence.jetbrains.com/doc/23080), which allow you to add functionality from other web applications or websites, such as JIRA 4.0+, iGoogle or Gmail, directly into a Confluence page or blog post. Confluence also provides its own Gadgets that can be embedded into other web applications.

The new [Drag-and-Drop](https://confluence.jetbrains.com/doc/23080) feature is a major step forward in Confluence file attachment. With Drag-and-Drop, you can attach one or more files to a page or blog post simply by dragging them from your desktop onto the Confluence page. You can also embed images, Office documents and PDF files into a page or blog post while in edit mode simply by dragging and dropping them into the rich text editor.

Office 2007 documents are now fully supported in Confluence so features like document import, edit in Word and embedding documents in a page now work with Office 2007 files. With the new [Move Page](https://confluence.jetbrains.com/doc/23080) feature, you can more quickly and reliably move the page you are editing or viewing to a new parent page, even to one within a new space. An enhanced [Image Browser](https://confluence.jetbrains.com/doc/23080) lets you preview images before embedding them into a page. You can also attach image files to a page by dragging and dropping them into the Image Browser window itself. A new [Page Restrictions](https://confluence.jetbrains.com/doc/23080) dialog lets you view and apply page restrictions without editing the page. [Draft Comparisons](https://confluence.jetbrains.com/doc/23080) allow you to view changes made to a page or blog post before they are actually saved.

Other editor enhancements include [Exit Notifications](https://confluence.jetbrains.com/doc/23080) to prevent the loss of unsaved content in a page, blog post or comment, a new [Insert Menu](https://confluence.jetbrains.com/doc/23080) for the rich text editor, fields that auto-completes in the macro browser and improved rich text editor speed.

Confluence 3.1 now fully supports Internet Explorer 8, Safari 4 and Firefox 3.5. Other smaller improvements include the ability to add pages or blog posts directly from the Confluence dashboard, a facility to link to Confluence pages more easily and the ability to expand activity streams at the click of a button.

Finally, we have also introduced a simplified installation process for evaluators to help get Confluence up and running.
running quickly. Simplified Confluence evaluation installers have been created for MacOS X and Windows operating systems.

**Highlights of this Release:**

- **Introducing Gadgets**
- **Drag-and-Drop**
- **Office 2007 Support**
- **New 'Move Page' Feature**
- **Enhanced Image Browser**
- **Draft Comparisons**
- **Page Restrictions Dialog Box**
- **Other Editor Enhancements**
  - Edit Mode Exit Notification
  - New Rich Text Editor Insert Menu
  - Macro Browser Smart Fields
  - Rich Text Editor Speed
- **New Web Browser Versions Supported**
- **Other Improvements**
  - Add Pages or Blog Posts from the Dashboard
  - New 'Link to this page' feature
  - Get 'More' from your Activity Streams
  - User Interface Performance Improvements
  - Other Small Enhancements and Improvements to Confluence

**Responding to your Feedback:**

🌟 300+ votes satisfied

Thank you for all your issues and votes. Keep logging, to help us keep improving!

Below is a list of the highlights in this release.

Attached is the full list of issues resolved in this release.

---

**Upgrading from a previous version of Confluence**

- Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**
- Please refer to the Confluence 3.1 Upgrade Notes for further essential information about plugins and other factors affecting your upgrade.

---

**Highlights of Confluence 3.1**

### Introducing Gadgets

Gadgets are small objects that offer dynamic content and functionality which may be served by any OpenSocial-compliant web application, such as JIRA 4.0+, Confluence or non-Atlassian applications such as iGoogle and Gmail. Confluence can interact with any gadgets that support the OpenSocial specification.

- Confluence supports the use of gadgets in pages and blog posts, which are accessible through the macro browser.
- Confluence can also serve its own gadgets, for use in any other OpenSocial-compliant web application. Gadgets bundled with Confluence include:
  - **Activity Stream** — This gadget shows a list of recent activities that have occurred on the...
Confluence server, such as the addition of new pages, blog posts or comments, content edits, status updates and so on.

- **Quick Navigation Aid** — This gadget provides heading and content search capabilities on a Confluence server.
  
  Your Confluence installation can also serve these gadgets in any of its own pages or blog posts.
  
  For more information on using these gadgets, refer to [Confluence Gadgets](#).

### Inserting a JIRA Gadget onto a Confluence Page

![Insert 'Created vs Resolved Chart' Macro](image)

**Drag-and-Drop**

The new 'drag-and-drop' feature allows you to drag one or more file(s) which are accessible from your computer and drop them directly into a Confluence page or blog post.

- Files can be attached to a page or blog post by dropping them directly onto the page view or the 'Attachments' list associated with the page.
- Image files can be attached to a page or blog post by dragging them from your computer directly onto the Image Browser.
- Image and Office files can be added directly into your Confluence page or blog post content by dropping them into the rich text editor's editor window.

For more information about this feature and on how to set it up, refer to the [Drag-and-Drop](#) documentation.

**Screenshot: 'Drag-and-Drop' Images or Other Files Directly onto a Page**
**Video: Using Drag-and-Drop**

app.episodic.com

**Download Video**

**Screenshots: Attaching an Image to the Image Browser**

**Screenshot: Attaching Multiple Files to an 'Attachments' list**
Office 2007 Support

Confluence now provides full support for the new Office 2007 file formats, allowing you to view and edit content from Microsoft Word 2007 (.docx and .dotx), PowerPoint 2007 (.pptx and .potx) and Excel 2007 (.xlsx) files.

- Along with existing Microsoft Office versions, Confluence now fully indexes Microsoft Office 2007 files and their content can be searched by Confluence.
- Using Confluence's Office connector macros, you can insert Word, PowerPoint or Excel 2007 files directly into your Confluence page or blog post.
- Office files can be edited directly from any page or blog post or their list of attachments.

   If you use the Firefox browser to work with Confluence, don't forget to reconfigure the Firefox add-on (WebDAV Launcher options) to handle the new Office 2007 file extensions. Otherwise, you will not be able to edit these new Office 2007 file formats from Confluence.

Screenshot: Embedding an Office 2007 Document

This feature uses technology licensed from Aspose.
**New 'Move Page' Feature**

Confluence introduces a new page moving feature, that easily allows you to move the page you are currently viewing, adding or editing, to another page in the same or another space within your Confluence site. This feature is available through a new 'Move Page' dialog box, which provides the following flexible methods for moving pages:

- **Known Location** – Allows you to type the name of a space and within that space, the 'parent' page under which to move your page.
- **Search** – Allows you to search for a 'parent' page (within a selected space or set of spaces) under which to move your page.
- **Recently Viewed** – Allows you to select one of your recently viewed pages to be the 'parent' of your page to be moved.
- **Browse** – Allows you to select a space and page that will be the 'parent' of your page to be moved. Pages are browsed via a tree view.

For more information, refer to [Moving a Page](#).

**Screenshot: Moving a Page to a Known Parent Page**

---

**Enhanced Image Browser**

A new 'Image Browser' has been introduced to replace the old 'Insert Image' window. The image browser provides a less-cluttered and enhanced interface that allows you to:

- Preview an image in detail before inserting it into a page. This is done by hovering over any image in the browser and clicking the 'magnifying glass' icon in the lower-right corner.
- Preview an image elsewhere on the web via its URL before inserting it into a page.

**Screenshot: Previewing an Image in the Image Browser**
Confluence’s drafts feature has been enhanced, such that you can now view unsaved changes in your drafts as a ‘diff’ before you decide to resume editing them. This nifty ‘draft comparison’ feature comes in handy, particularly when other people have made subsequent changes to a page or blog post in your drafts list and you need to merge changes or resolve a conflict.

**Screenshots: Accessing and Viewing Changed Content with Draft Comparisons**

<table>
<thead>
<tr>
<th>Title</th>
<th>Last Saved Date</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page with Partial Content</td>
<td>less than a minute ago</td>
<td>Resume Editing</td>
</tr>
<tr>
<td>Page with Content to Merge</td>
<td>2 minutes ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Page with a Conflict</td>
<td>12 minutes ago</td>
<td>View Changes</td>
</tr>
</tbody>
</table>
Page Restrictions Dialog Box

Confluence’s page restrictions feature has been incorporated into a convenient and accessible dialog box, which is now easier to use than before.

- The page restrictions dialog box can be accessed from the padlock icon or the ‘Tools’ – ‘Restrictions’ menu item whilst viewing any Confluence page. From this dialog box, you can see all viewing and editing restrictions associated with the current page. You no longer need to view the page’s associated ‘Info’ page to see the page’s restrictions.
- You no longer have to edit a page to modify its page restrictions. You can edit all page restrictions from this easily accessible dialog box.
- The page restrictions dialog box is still accessible when a page is in edit mode.
- In addition to user and group names, the name field also accepts a user's full name. Full names are 'auto-completed' to help you find the relevant person more rapidly.

Screenshot: The Page Restrictions Dialog Box

Other Editor Enhancements

Edit Mode Exit Notification

Whenever you add or edit a page, comment or blog post and then click onto another Confluence feature that
navigates away from your unsaved content, a message box appears, warning that your content will be saved as a draft (if it is a page) or lost (if a comment). This allows you to cancel out of this action if it was accidental.

New Rich Text Editor Insert Menu

Confluence's rich text editor now combines a number of its commonly used editing features into a new convenient 'Insert' menu.

- The Horizontal line, Insert Symbol and Insert Emoticon Toolbar icons have been moved into the new insert menu.
- The functionality to insert images, links or attachments into a page can now also be accessed from this menu.
- The macro browser, as well as a number of commonly-used macros are conveniently accessible from this menu too.

Macro Browser Smart Fields

When using the Macro Browser, an 'auto-complete' feature is now provided on any parameters that require the entry of a single item, such as a page title, username or space key. This greatly facilitates the customisation of macros and minimises the need to know the exact item names in advance.
Rich Text Editor Speed

Thanks to many individual technical improvements, the rich text editor opens up a lot faster than in previous Confluence releases. In a local network environment, the rich text editor is accessible almost instantly. When accessing a Confluence server on a different continent, the rich text editor still opens up rapidly. In our Sydney office for instance, accessing the rich text editor from our Confluence server in the US takes less than 3 seconds.

New Web Browser Versions Supported

Confluence 3.1 now fully supports the following recent web browser versions:

- Internet Explorer 8
- Safari 4
- Firefox 3.5

Confluence now provides full usability with these recent browser versions as many bugs associated with these browsers have been fixed.

Other Improvements

Add Pages or Blog Posts from the Dashboard

You can now add pages or blog posts directly from the Dashboard without having to browse to a specific space first. To do this, click on either the 'Add Page' or 'Add Blog Post' buttons to open the pop-up balloon, which allows you to choose the space in which to add the new page or blog post and in the case of pages, a template on which to base the page content.
New 'Link to this page' feature

If you wish to link to a Confluence page from any other location on the web, use the convenient 'Link to this Page' feature (available from any page's or blog post's 'Tools' menu). Upon selecting this feature, the 'Link to this Page' dialog box opens, from which you can copy three versions of the link to embed elsewhere:

- **Link** – Standard URL which should work from any other accessible location on the web.
- **Tiny Link** – A reduced-length version of the 'Link', which can be used in text fields of limited length, such as tweets or Confluence Status Updates.
- **Wiki Markup** – A wiki markup version of the link, which can be used in any other location within your Confluence site.

![Link to this Page dialog box](image)

Get 'More' from your Activity Streams

A 'More' feature has been added to various activity streams throughout the Confluence interface, including the user profile sidebar, user profile page and recently updated macro. Clicking 'More' expands the list of results, providing a convenient means of accessing progressively more distant user activities.
User Interface Performance Improvements

Most JavaScript and Cascading Style Sheet (CSS) files are now downloaded in one batch, greatly improving the performance of Confluence's editing features and general page rendering.

Other Small Enhancements and Improvements to Confluence

- Support for OAuth — With the introduction of gadgets (above) in this release, Confluence 3.1 now allows you to establish OAuth relationships with other web applications such as JIRA 4.0+, iGoogle, Gmail etc., thereby allowing them to share resources via gadgets.
- New Log In and Log Out screens.
- In an aim to minimise confusion, 'News Items' are now consistently called 'Blog Posts' throughout the Confluence interface and a list of blog posts is collectively referred to as a 'Blog'.
- Macro developers are now able to specify whether the macro body should or should not be displayed in Rich Text editor. For more information, please refer to CONF-12149.
- Other minor interface improvements.

Known Issues in this Release

We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release and report any problems so that we can fix them quickly.

We value this feedback, which means that we can tell you about some minor known issues in Confluence 3.1. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the important technical advisories on the front page of the Knowledge Base.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.
The Confluence 3.1 Team
Development

Bugfixing, Maintenance and Drag-and-Drop
Anatoli Kazatchkov
David Loeng
David Taylor

Engine Room
Agnes Ro
Charles Miller
Matthew Jensen

Gadgets and Office Connector
Chris Kiehl
Andrew Lynch
Xu-Heng Tjhin
Ryan Ackley
Jonathan Gilbert

Editor Enhancements
Paul Curren
Don Willis
Matt Ryall
Dmitry Baranovskiy

Small Improvements
Brian Nguyen
Chris Broadfoot

Plugin Updates
David Chui

Team Lead
Per Fragemann

Support

Kuala Lumpur
Sashidaran Jayaraman
Zed Yap
Arie Murdianto
Azwandi Mohd Aris
Ming Giet Chong

San Francisco
Jeremy Largman
Maleko Taylor
Tim Wong
Vincent Chang
Peter White
Marian Finch

Sydney
Confluence 3.1 Known Issues

Below are some known issues associated with Confluence 3.1.

On this page:

- JIRA/Crowd and Confluence deployment
- JIRA Gadgets in Confluence
- Bamboo integration
- PDF exports only render gadgets as links
- Problematic Confluence Gadgets window when running Confluence on Java 6
- Other issues

JIRA/Crowd and Confluence deployment

Confluence will not start up or will display strange behaviour (drop down menus not working) if JIRA 4.0/4.0.1 or Crowd 2.0.x is running on the same application server installation, for example, by attempting to run Confluence and JIRA 4.0 in the same Apache Tomcat server installation. This problem results from a bug in JIRA (tracked as JRA-19894) that is scheduled to be fixed in JIRA 4.0.2. Crowd will be fixed in the 2.1 release. In the meantime, please read our KB article on how to resolve this issue.

In the meantime, you can run JIRA or Crowd and Confluence in different 'instances' of the same application server, for example two separate Apache Tomcat server installations. If you already do so, or have installed both the Confluence distribution and JIRA 4.0 distribution, or Crowd 2.0.x, you can ignore this known issue.

JIRA Gadgets in Confluence

As of Confluence 3.1, users can embed gadgets into Confluence pages. When integrating JIRA gadgets into
Confluence pages, you may encounter UI problems like a missing "Login"-button which is required to make the gadget authenticate with the JIRA server. This problem can be circumvented by setting up JIRA and Confluence to use Trusted Apps communication (since it removes the need for manual authentication). See KB article for details.

**Bamboo integration**

Our continuous integration product Bamboo exposes gadgets which can be embedded into Confluence pages. However, some of these exhibit problems once embedded onto a Confluence page:

- `BAM-4900`: Unable to edit Bamboo gadgets in Confluence
- `BAM-4890`: Bamboo gadget added in JIRA dashboard is not saving the preferences

These bugs are being fixed in Bamboo 2.5, which will ship in January 2010.

**PDF exports only render gadgets as links**

If you place any gadget on a Confluence page and export the page to PDF, the gadget output will not be rendered in the PDF output. Instead, each gadget is rendered on a page as a box containing the name of the gadget, the latter of which is hyperlinked. Clicking this hyperlink, opens the gadget contents itself in a new browser window or tab.

**Problematic Confluence Gadgets window when running Confluence on Java 6**

The Confluence Gadgets window may indicate that ‘**An error has occurred while trying to load the Gadget Directory**’ and prevent you from accessing the URLs of your Confluence gadgets. This problem can occur if you are running Confluence on Java 6. After you install Confluence 3.1 or upgrade an existing Confluence installation to this version, please check the Confluence Gadgets window immediately after starting the Confluence server.

If you see this error message and cannot access your Confluence gadgets, it can be resolved by restarting Confluence. (You may need to do this more than once.)

For more information about this issue, please refer to [CONF-17417](#).

**Other issues**

Refer to our JIRA site for a list of Confluence 3.1-specific bugs.

**Confluence 3.1 Upgrade Notes**

Below are some important notes on upgrading to **Confluence 3.1**. For details of the new features and improvements in this release, please read the [Confluence 3.1 Release Notes](#).

On this page:

- **Upgrade Notes**
  - New License Key Requirements for Confluence 3.1
  - Upgrading an Existing Confluence License for Confluence 3.1 Compatibility
  - Custom layouts must be re-implemented after upgrading Confluence
  - Customers running Confluence on Weblogic are required to specify the `prefer-web-inf-classess` element in the `weblogic.xml` file prior to upgrading Confluence
  - The Drag-and-Drop feature disables the ability to drag and drop links or text in Firefox 3.0
  - Clarification of supported user management configurations in Confluence

- **Upgrade Procedure**
- Checking for Known Issues and Troubleshooting the Confluence Upgrade
Useful Plugins

Upgrade Notes

New License Key Requirements for Confluence 3.1

牢记使命，在继续使用Confluence时，您必须升级您的Confluence许可到Atlassian的新许可密钥格式。

我们已经采取了这一改变，以增强和改善我们为客户提供支持的方式。请注意，这个许可升级将不会产生任何额外的费用，也不会改变Confluence的功能。

升级现有Confluence许可的Confluence 3.1兼容性

此过程只能由Confluence管理员进行。

为了将您的现有许可证升级到新的许可密钥格式，这将要求继续使用Confluence 3.1，您需要:

1. 访问您账户的许可升级区域，网址为my.atlassian.com。
2. 输入您的Atlassian账户详细信息（电子邮件地址和密码）以访问和管理Atlassian产品许可证。
3. 如果您的Confluence许可已经被关联到一个Confluence服务器ID（大多数运行最近版本的Confluence的客户），请遵循下面的步骤b。如果my.atlassian.com提示您在升级许可之前输入服务器ID，请遵循步骤a:
   a. ** Procedure for associating a Confluence license with your Confluence Server ID:**
      i. 如果您尚未升级您的Confluence安装到版本3.1，请访问您的Confluence安装的许可证详情页面以获取关联到您的许可的服务器ID。记下这个服务器ID。
      ii. 如果您已经升级到Confluence 3.1且无法访问许可证详情页面，请打开文件confluence.cfg.xml（位于Confluence数据目录）并在文本编辑器中查看服务器ID。
      iii. 如果您无法访问Confluence安装的服务器ID，请联系我们客户服务团队以获取进一步的帮助。此问题可能在升级到非常旧的Confluence版本时出现。
      iv. 按照my.atlassian.com上显示的剩余提示输入服务器ID，然后升级您的Confluence许可。
   b. ** Procedure for upgrading a Confluence license associated with a Server ID:**
      i. 选择合适的Confluence许可证以扩展其详细信息。
      ii. 在您的许可证的右侧“info”注释下方，点击“更新您的许可密钥”链接（如图1所示）。完成这一步后，注释将更改为图2所示的内容。
Screenshot 1: License Key Upgrade Function

If you are using Confluence 3 or above, you will need to update your license key.

Screenshot 2: Upgraded License Key Note

This license key is compatible with Confluence 3 or above.

iii. Copy the new license from the text box above this message to your clipboard.

4. Ensure your upgraded Confluence installation has been started, enter your Confluence site's URL into a web browser and on the Confluence license upgrade screen, click the 'page' link in the 'Description' field to begin updating Confluence with your upgraded Confluence license to open the 'Update Confluence License' page.

Screenshot: Confluence License Upgrade Screen

Confluence

You cannot access Confluence at present. Look at the table below to identify the reasons.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
<th>Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>upgrade</td>
<td>Thank you for upgrading Confluence. The license format for this new version has changed. In order to complete your upgrade and continue using Confluence, you will need to upgrade your current Confluence license. This upgrade does not incur any additional costs and does not change Confluence's functionality in any way. You can upgrade your license here or for step-by-step instructions please refer to our documentation. If you cannot upgrade your existing Confluence license, please generate a temporary evaluation license. This will allow you to proceed with the upgrade and give you time to generate a compatible license. Once you have an upgraded license (or a temporary one), please enter it on this page and restart.</td>
<td></td>
</tr>
</tbody>
</table>

5. On the 'Update Confluence License' page, paste your new license details into the 'License' field.

6. Enter the Confluence administrator account's username and password details and click the 'Save' button.

Screenshot: Update Confluence License Page

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
If your license update was successful, you will be prompted to restart Confluence.

Screenshot: Successful Confluence License Update Screen

Custom layouts must be re-implemented after upgrading Confluence

If you have customised your Main Layout on either the space or the global level, or if you have a custom theme plugin, the new Link to this Page, Page Restrictions and 'Move Page' dialog box features in Confluence 3.1 will not immediately work for you.

To resolve these issues, you will need to re-implement your custom layouts or reset these custom layouts back to the Confluence default settings.

Other Issues:

The following other issues may occur prior to resolving these issues:

- The Atlassian Confluence footer may appear fixed on the page and obscure content that extends below the length of the web page.
- Some pages may not render at all.

Depending on the version of Confluence you upgraded from and the customisations that had been implemented, other user interface problems or problems with Confluence's functionality may be found.

Re-implementing custom layouts:
To re-implement your custom layouts, please refer to Upgrading Customised Site and Space Layouts for details on retrieving the customisations made to your layouts and re-implementing them into your upgraded version of Confluence.

**Customers running Confluence on Weblogic are required to specify the prefer-web-inf-classes element in the weblogic.xml file prior to upgrading Confluence**

If you are a customer running Confluence on Weblogic, then before upgrading to Confluence 3.1, you must ensure that the prefer-web-inf-classes element in the weblogic.xml file has been specified with the content value of true. For more information, please refer to Installing Confluence EAR-WAR on Weblogic.

To do this:

1. Ensure that Confluence and Weblogic have been stopped.
2. Open the weblogic.xml file in a text editor. (This file is located in the `<confluence install directory>` directory.)
3. Ensure that `<prefer-web-inf-classes>true</prefer-web-inf-classes>` has been added as a child element of the `<container-descriptor>` element, such that your `<container-descriptor>` element looks something like:

   ```xml
   <container-descriptor>
   <prefer-web-inf-classes>true</prefer-web-inf-classes>
   </container-descriptor>
   ```

   Your particular weblogic.xml may have other child elements of the `<container-descriptor>` element, so leave these intact.
4. Save any changes made to the weblogic.xml file.
5. Follow the upgrade procedure.

**The Drag-and-Drop feature disables the ability to drag and drop links or text in Firefox 3.0**

Some browsers like Firefox and Safari allow Confluence users to create links easily by dragging and dropping hyperlinks from other web pages directly into the rich text editor window. This browser-specific feature also allows the rearrangement of text when editing Confluence wiki page content, by highlighting text and dragging and dropping it elsewhere.

However, the Confluence 3.1 Drag-and-Drop feature is not compatible with these link creation and text rearrangement features of Firefox 3.0 and setting up Confluence's Drag-and-drop feature will disable these Firefox 3.0 features.

To allow the Confluence 3.1 Drag-and-Drop feature to work together with these link creation and text rearrangement features of Firefox, upgrade your Firefox browser to version 3.5.

**Clarification of supported user management configurations in Confluence**

In Confluence 3.1, Atlassian is clarifying our support for user management configurations and code-level customisations. This is being done so that we can deliver significant improvements in our user management performance and configuration in a future release.
Confluence is fully supported with the following configurations provided and documented by Atlassian:

- Built-in user management with Atlassian-User Hibernate managers ("default user management")
- Built-in user management, with OSUser LDAP authentication (deprecated since 2.7, moving to Atlassian-User LDAP is recommended)
- External user management with read-only JIRA JDBC providers ("JIRA delegated user management")
- External user management with Atlassian-User LDAP providers ("standard LDAP user management")
- External user management with Atlassian Crowd.

Unfortunately, we cannot offer complete support for code-level customisations in our user management system. The following caveats apply to customers who are using extensions to our user management systems:

- Custom implementations of Atlassian-User managers are supported for problems which are not related to user management.
- Custom Seraph authenticators are supported for problems which are not related to user management or authentication.
- Custom implementations of OSUser providers are not supported with Confluence. The OSUser APIs required for implementing custom providers were deprecated in Confluence 2.7, so customers with custom OSUser implementations will need to migrate their code to the Atlassian-User API to have support for their Confluence instance.

Advance warning: In Confluence 3.2, Atlassian will be removing functionality required for custom OSUser providers. From this point, custom OSUser providers will not work correctly with Confluence 3.2, so we recommend porting any custom OSUser providers to the Atlassian-User interfaces as part of your Confluence upgrade process.

Upgrade Procedure

⚠️ Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.0.x, then please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.) Furthermore:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:
Check for known issues. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

Did you encounter a problem during the Confluence upgrade? Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will assist you through the process.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

RELATED TOPICS

Confluence 3.1 Release Notes

Issues Resolved in Confluence 3.1

Below are the top 100 issues resolved in Confluence 3.1, ordered by number of votes. For the full list of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 3.1 Release Notes for the new features in Confluence 3.1.

<table>
<thead>
<tr>
<th>JIRA Issues (0 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
</tbody>
</table>

Above are the issues resolved in Confluence 3.1, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker.

Confluence 3.2.1 Release Notes

This release fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

4 May 2010

Confluence 3.2.1 is a recommended upgrade which fixes some security flaws and other bugs.

As part of the security update we have made changes to Confluence functionality, including some parts of the Administration Console. Please refer to the security advisory for a summary of changed behaviour. We have updated the documentation where relevant.

We have also fixed a bug that caused an out of memory error when attempting to display an Excel spreadsheet on a Confluence page. Before this fix, the error might occur if the spreadsheet has a large number of empty cells. Confluence now limits the number of spreadsheet cells it will display. By default, the maximum is 10000 cells. The Confluence administrator can adjust this value in the Office Connector configuration screen, as described in the documentation.

Purging items from a space's trash can was very slow and blocked all other database updates. This is now fixed.
A bug introduced in Confluence 3.2 prevented people from adding a page when using the Left Navigation theme. We have fixed this too.

In Confluence 3.2, we mistakenly introduced the words ‘Needs to be updated’ into the French and German translations of the UI text in the left navigation theme. We have now removed the extra text. The UI wording is still in English, not translated into French or German, but at least it no longer calls attention to this fact.

**Don’t have Confluence 3.2 yet?**

Take a look at the new features and other highlights in the Confluence 3.2 Release Notes.

![Download Latest Version](image)

**Upgrading from a Previous Version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the Confluence 3.2.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

### JIRA Issues (30 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-19441</td>
<td>XSS in page renderer</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19404</td>
<td>XSS vulnerability in some JSPs under admin section</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19403</td>
<td>XSS vulnerability in Advanced Macros plugin</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19382</td>
<td>XSS vulnerability in search</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19381</td>
<td>XSS Bookmark vulnerabilities</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19402</td>
<td>Only strings are encoded</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19398</td>
<td>SOAP and XML-RPC APIs return too much information</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19397</td>
<td>Path for daily backup is configurable through WEB UI</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19388</td>
<td>Possible XSS injection in attachment upload</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19384</td>
<td>XSS vulnerability in Colour Scheme settings</td>
<td>![ ]</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19331</td>
<td>Allow write configuration of certain fields in administration section</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19416</td>
<td>Semi-colon separator used to work for image properties, but doesn't in 3.2.1 which causes broken images on CAC</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19401</td>
<td>BootstrapManager exposed in layout templates should be read only</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19395</td>
<td>The list of Confluence administrators is accessible via a URL</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19393</td>
<td>Remove the download link for XML site backups</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19142</td>
<td>Can't add pages while using Left Nav theme in Confluence 3.2</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-18972</td>
<td>Searching for a link using auto-complete replaces your link text with the search result</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-18626</td>
<td>UWC Link in Confluence Administration is broken</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17718</td>
<td>Downloading a .docx file in IE7/WinXP gives it a .zip extension (technically true but the average end-user wouldn't know that).</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-15946</td>
<td>I18NBean</td>
<td>![ ]</td>
<td>Resolved</td>
<td></td>
</tr>
</tbody>
</table>
## Confluence 3.2.1 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.2.1**. Confluence 3.2.1 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the [Confluence](http://www.atlassian.com/software/confluence).
3.2.1 Release Notes.

On this page:

- Upgrade Notes
- Upgrade Procedure
- Useful Plugins

Upgrade Notes

As part of the security update we have made changes to Confluence functionality, including some parts of the Administration Console. Please refer to the security advisory for a summary of changed behaviour. We have updated the documentation where relevant.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database.**
   - The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.2 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.2 Release Notes

24 March 2010

With great pleasure, Atlassian presents the seemingly omniscient, drop dead gorgeous Confluence 3.2.

Highlights of this Release:

- Autocomplete for Inserting Links
- Autocomplete for Embedding Images and Documents
- A Link Browser that's Smarter, Smoother, Faster
- New Documentation Theme
- New Easy Reader Theme
- Template Bundles
- Reordering while Moving a Page
Responsive to your Feedback:
🌟 100+ votes satisfied

Thank you for all your issues and votes. Keep logging issues to help us keep improving!
Below is a list of the highlights in this release.
Attached is the full list of issues resolved in this release.

Upgrading from a previous version of Confluence
- Upgrading Confluence should be fairly straightforward. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.
- Please refer to the Confluence 3.2 upgrade notes for further essential information about plugins and other factors affecting your upgrade.

Highlights of Confluence 3.2

1

Autocomplete for Inserting Links

Wouldn't it be awesome to have the WYSIWYG ease of a rich text editor combined with the speed of a wiki markup editor? We're working towards that sweetness. In the rich text editor you can now enter a trigger character to call up a list of suggested links to add to your page. A keyboard shortcut does it too.

Quick guide:

- Enter '[' and start typing to see the suggested links that match your text.
- Or press Ctrl+Shift+K to convert text to a link.
Autocomplete for Embedding Images and Documents

The new autocomplete also offers a quick way of adding images and documents to your page.

In the rich text editor:

- Enter '!' and start typing, to see a matching list of images and documents.
- Or press Ctrl+Shift+M immediately after a word or highlighted phrase.
A Link Browser that’s Smarter, Smoother, Faster

Do you think the autocomplete is sweet? Good, because it’s in the new link browser too. We’ve also made it easier and faster to link to images, attachments and recently-viewed pages. The link browser pops up when you click the ‘Insert Link’ icon in the editor toolbar.
New Documentation Theme

Want an inbuilt table of contents for your wiki space? Lusting after a configurable header and footer? Hankering for sophisticated styling? You got it!

Features in a nutshell:

- Configurable left-hand panel. By default, the panel contains a search box and a table of contents (page tree).
- Resizable panels. People viewing the page can drag the thick bar between the left-hand panel and the content. They can also remove the panel altogether, by clicking the sidebar icon at top right.
- Customisable page header and footer.
- Text styles designed to enhance the content typically found in a documentation space.
- The [Space Jump macro](http://confluence.36x.group/pages/viewpage.action?pageId=12345) for linking from a page in one wiki space to a page with the same name in another space.
- Easy upgrade path from now on. Because the left-hand panel is part of the theme, it will be upgraded whenever Confluence is upgraded. There is no need to remove and then re-apply your customisations on each upgrade, as you would do if you added your own left-hand navigation bar.
New Easy Reader Theme

With today's huge monitors, it can become hard to read text that spans the width of the screen. Confluence 3.2 introduces the Easy Reader theme that uses only a portion of the screen, to make reading easier. Many websites are formatted this way. The Easy Reader theme is a fixed-width variation of the default Confluence theme. Its larger fonts, smooth gradient background and comfortable line length make it ideal for displaying and reading longer documents.
Template Bundles

Confluence page templates make it easy for people to collaborate, yet maintain a consistent document format. We've extended the template functionality in this release so that you can import templates from template bundles via the Confluence Administration Console. Confluence administrators will be able to preview templates before importing them to a specific space or as global templates.

Template bundles are built as plugins, so developers should find it easy to whip up a new template bundle. Confluence 3.2 also ships with a default template bundle. Just import the templates from the default template bundle and your users will have access to a number of handy page templates.
Reordering while Moving a Page

You can now move a page and position it sequentially amongst its siblings at the same time. In earlier versions of Confluence this was only possible on the space's page tree view, accessed via the browse pages menu. The page tree is problematic in big spaces, so some people could not reorder pages at all. Now you can select the new ‘Reorder’ option when moving a page, and then drag a horizontal bar to put your page in the right spot amongst the other child pages.
New Keyboard Shortcuts and Editor Hints

We’re on a mission to improve your editing experience. We’ve added a number of new keyboard shortcuts for the rich text editor in this release. Format text into bulleted/numbered lists, manipulate tables, open the macro browser and more, with a few simple key presses. Check out the new keyboard shortcuts below:

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Action (Rich Text Editor)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+A</td>
<td>Opens the macro browser</td>
</tr>
<tr>
<td>Ctrl+Shift+B</td>
<td>Formats text as a bullet list</td>
</tr>
<tr>
<td>Ctrl+Shift+K</td>
<td>Autocomplete for links. Calls up a list of suggested pages or other locations to link to from your page. More...</td>
</tr>
<tr>
<td>Ctrl+Shift+M</td>
<td>Autocomplete for embedding images and files. Calls up a list of suggested images, documents and other files to embed in your page. More...</td>
</tr>
<tr>
<td>Ctrl+Shift+N</td>
<td>Formats text as a numbered list</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Formats text with a strike through</td>
</tr>
<tr>
<td>Ctrl+Shift+C</td>
<td>Copies a table row</td>
</tr>
<tr>
<td>Ctrl+Shift+X</td>
<td>Cuts a table row</td>
</tr>
<tr>
<td>Ctrl+Shift+V</td>
<td>Pastes a table row</td>
</tr>
<tr>
<td>Ctrl+Shift+I</td>
<td>Inserts a table</td>
</tr>
</tbody>
</table>

The rich text editor will also display handy hints along the bottom of the screen, including common keyboard shortcuts and autocomplete tips.

User Interface Enhancements

- **Image Previews in Search Results.** Confluence 3.2 helps you search more efficiently by displaying thumbnail image previews in your search results. You can also opt to display images attached to pages/blog posts in your search results. We’ve also made the rendering of search results in Confluence pluggable. If you are a developer, you may wish to write your own search result renderer to change how
the search results are displayed.

- **Improved page history.** We've redesigned the header for the page history to make it easier to use. Check it out!

- **Handling of oversized content.** Taking advantage of modern browsers, the new Easy Reader theme includes CSS to handle common types of oversized content. Specific sections of a page will now have a localised scroll bar instead of making the whole page scroll. You will see this in action in the code macro, for example.

- **Better RSS feeds.** We have improved and simplified the RSS feed builder. As before, you can choose to include either pages or blog posts or both in your feed. Now you can also choose to include comments from pages and/or comments from blog posts independently. Similarly, you can choose attachments from pages and/or blog posts. In addition, if you filter by label you can now track updates to labelled pages and
Fixed colour scheme issue. We have removed the hard-coded colours that prevented colour schemes from applying correctly.

Fixed editor issue. We’ve also fixed an issue that caused white space to overlap the right-hand side of the editor. This has now gone, making more space available to the editor.

And Even More Improvements

Hot installation of language packs. You can now install language packs without restarting the server. More...

Purging the trash is now incremental and logged. Purging the deleted items from the Confluence trash has caused problems for people with a large number of items in the trash. The operation is slow and prevents other database updates while in progress. Confluence now breaks the operation into separate transactions and tracks progress in the logs.

More REST resources. If you are a plugin developer or use our APIs in some other way, you’ll find the REST API improvements in this release useful. The previous release of Confluence introduced a prototype REST API. With Confluence 3.2, we have added the following REST resources: attachments, recently viewed pages, search and user history. There are other small improvements too. More...

Important Bug Fixes:

Custom PDF stylesheets are unique to spaces. We’ve addressed an issue that caused changes made in one space’s custom stylesheet to be reflected in the stylesheets for all other spaces. For more information, please see CONF-18843.

Full index rebuilds now work correctly. A Confluence bug caused a database exception to be thrown during full index rebuilds, which prevented further indexing jobs from being run correctly. This has now been fixed. For more information, please see CONF-18452.

Confluence now upgrades correctly when using Crowd integration. If you have integrated your Confluence instance with Atlassian’s Crowd, you can now upgrade to this version of Confluence without the manual workaround required for Confluence 3.1. For more information, please see CONF-18150.

Circular references are no longer possible with the {excerpt-include} macro. The {excerpt-include} macro could previously be used to create circular references that would crash Confluence. This has been fixed. For more information, please see CONF-15247.

Confluence upgrades do not disable enabled plugins. Plugins that are disabled by default would previously be disabled during a Confluence upgrade, even if they had been enabled prior to
the upgrade. This has been fixed. For more information, please see CONF-18417.

Known Issues in this Release

We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release and report any problems so that we can fix them quickly.

We value this feedback, which means that we can tell you about some minor known issues in Confluence 3.2. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the important technical advisories on the front page of the Knowledge Base.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

The Confluence 3.2 Team
Development

Bugfixing and Maintenance
Brian Nguyen
Andrew Lynch
Xu-Heng Tjhin
Ryan Thomas

Engine Room and REST APIs
Anatoli Kazatchkov
Matthew Jensen
Daniel Kjellin

New Links Dialog and Editor Enhancements
Agnes Ro
Ryan Ackley

Autocomplete
Dmitry Baranovskiy
David Taylor

Themes
Ben Buchanan
Jens Schumacher

Build and Release Engineering
Don Willis

Small Improvements
Gerry Claps

Plugin Updates
David Chui

Special Projects (not shipping in this release)
Matt Ryall
Paul Curren
Charles Miller
David Loeng
Chris Kiehl
Jonathan Gilbert

Team Lead
Per Fragemann
Support

**Kuala Lumpur**
Sashidaran Jayaraman
Zed Yap
Arie Murdianto
Azwandi Mohd Aris
Ming Giet Chong

**San Francisco**
Jeremy Largman
Maleko Taylor
Tim Wong
Vincent Chang
Peter White
Marian Finch

**Sydney**
Partha Kamal
Gurleen Anand
Roy Hartono
Michael Seager
Ivan Benko

Others

**Design**
Stephen Russell

**Performance Engineering**
George Barnett

**Product Management**
Audra Eng
Jens Schumacher
Sherif Mansour

**Product Marketing Management**
Bill Arconati
Matthew Hodges

**Quality Assurance**
Mark Hrynczak
Penny Wyatt
Andrew Prentice

**Technical Writing**
Andrew Lui
Sarah Maddox

**Confluence 3.2 Upgrade Notes**

Below are some important notes on upgrading to Confluence 3.2. For details of the new features and improvements in this release, please read the Confluence 3.2 release notes.
Clickr Theme and Left Navigation Theme are now Deprecated

Confluence 3.2 introduces two new themes, the Documentation theme and the Easy Reader theme. At the same time, we are announcing the deprecation of the following two themes:

<table>
<thead>
<tr>
<th>Deprecated Theme</th>
<th>Description</th>
<th>Suggested Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clickr theme</td>
<td>This theme was inspired by the Flickr user interface, with Confluence content centred on the page. Please note that some features of Confluence 3.x are not fully supported by this theme.</td>
<td>Easy Reader theme</td>
</tr>
<tr>
<td>Left Navigation theme</td>
<td>This theme provides a navigation bar on the left hand side of the screen. Please note that some features of Confluence 3.x are not fully supported by this theme.</td>
<td>Documentation theme</td>
</tr>
</tbody>
</table>

We recommend that you move to a different theme as soon as possible. In the table above, we have suggested new themes that will give you similar and better-supported functionality.

⚠️ Advance Notice --- Clickr Theme and Left Navigation Theme will not be bundled with Confluence 3.3

Please note, the Clickr Theme and Left Navigation Theme will not be bundled with Confluence 3.3. We will not support these themes from Confluence 3.3 onwards.

End of Support for JBoss, Firefox 2 and Safari 2

As previously announced, we are no longer providing support for:

- JBoss (all versions) from this release onwards.
- Firefox 2 and Safari 2 from this release onwards.

Please see End of Support Announcements for Confluence for further details.

Advance Notice of End of Support for Oracle Weblogic,
IBM Websphere, Caucho Resin, DB2 8.2, Java Platform 5 (JDK/JRE 1.5) and Internet Explorer 6

As previously announced, we are planning on ending support for:

- Oracle Weblogic, IBM Websphere and Caucho Resin in Confluence 3.3.
- DB2 version 8.2 in Confluence 3.3. DB2 9.7 will still be supported.
- Java Platform 5 (JDK/JRE 1.5) in Confluence 3.3.
- Internet Explorer 6 in Confluence 3.3 or 13 July 2010, whichever is sooner.

Please see End of Support Announcements for Confluence for further details.

Link Browser will Remove Tooltips

In Confluence 3.2 and later, the link browser no longer offers the option to include a tooltip for your link. If you have existing links with tooltips, the tooltip will disappear if you edit the link with the link browser. The tooltip will remain if you edit the link using wiki markup. See issue CONF-18668.

Upgrade Procedure

⚠️ Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.1.x, then please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.) Also:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the upgrade guide.

Troubleshooting the Upgrade

This section lists some specific issues that may occur during or as a result of the upgrade process, and guidelines on fixing the problem if it does happen to you.

- **Left-hand navigation bar in Documentation theme is empty.** If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working...
correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

**Useful Plugins**

*Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.*

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

**RELATED TOPICS**

**Confluence 3.2 Release Notes**

**Issues Resolved in Confluence 3.2**

Below are the top 100 issues resolved in Confluence 3.2, ordered by number of votes. For the full list of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 3.2 release notes for the new features in Confluence 3.2.

**JIRA Issues (98 issues)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-11469</td>
<td>Improve usability of page tree for moving and ordering pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>65</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-7745</td>
<td>RSS Feed should include only comments of content included in feed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>22</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-16115</td>
<td>Confluence is extremely slow to load pages when network latency is significant</td>
<td>Resolved</td>
<td>Fixed</td>
<td>7</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-18180</td>
<td>RSS Feeds: Do not render computationally intensive macros in RSS Feeds due to frequent</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td>Key</td>
<td>Issue Number</td>
<td>Description</td>
<td>Resolution Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-16884</td>
<td>Connie needs pretty and functional clothes — Bundled Themes Require Attention</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-7496</td>
<td>livesearch returns no results for complete words — only part words</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-18774</td>
<td>Drag &amp; Drop does not work on Firefox 3.6</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-17971</td>
<td>'Move Page' dialog box cannot rearrange/reorder pages like the old page moving feature in 3.0 did.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-9312</td>
<td>RSS feeds that filter on labels should include comments of pages that match the label</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-18437</td>
<td>Macro browser and Preview tab appears to be broken for all themes EXCEPT shipped default theme</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-14435</td>
<td>Edit Link dialog does not handle accented characters correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-19422</td>
<td>Error when restoring version 3.2 XML backup</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-18881</td>
<td>Modz Detector is broken in 3.1.2</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-17341</td>
<td>After Draft Timed Out, user is stuck without being able to save their work</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-16540</td>
<td>Attachment view shows filenames with double spaces turned into single spaces</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-11551</td>
<td>Link Properties shows additional character in &quot;Alias&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-18751</td>
<td>PermittedSpacesScope may decrease the BooleanQuery maxClauseCount</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-18381</td>
<td>NPE setting up Demo content on a custom db</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-17311</td>
<td>Reword theme descriptions</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-15180</td>
<td>Class Cast Exception being thrown when error encountered during mail queue flushing</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-12134</td>
<td>Group templates together</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-3938</td>
<td>Linking to page's files within a comment</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-2545</td>
<td>Macros in #includePage calls cannot access the current HttpServletRequest object</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-21559</td>
<td>Auto filled link alias</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20375</td>
<td>Hard to escape links</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-19501</td>
<td>&quot;Cancel&quot; button name on &quot;Move Page&quot; dialog</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Conf Number</td>
<td>Issue</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Fixed</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>-------------</td>
<td>------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>CONF-19069</td>
<td>Children pages don't get returned in the correct order when requested through rest</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18647</td>
<td>UnsupportedOperationException thrown when saving a page edit after logging out in another tab when a draft already exists.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18630</td>
<td>Improve UI of &quot;Rss Feed Builder&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18607</td>
<td>Using Dashboard Actions before logging in can cause an IllegalArgumentException Exception</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18600</td>
<td>Improve usage of Atlassian-User APIs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18588</td>
<td>Move Page Dialog has a memory leak in IE on the browser tab</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18586</td>
<td>Add more keyboard shortcuts for the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18561</td>
<td>Allow language packs to be bundled plugins rather than in WEB-INF/lib</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18554</td>
<td>ChildPositionComparator deprecated without alternative</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18538</td>
<td>IE stylesheets defined in Themes don’t get served with</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
<td>Priority</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18536</td>
<td>Add service for getting i18n from plugins</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18489</td>
<td>The Download All as zip is using the wrong mime type</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18485</td>
<td>Webdavloadd x pi not compatible with FireFox 3.6</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18452</td>
<td>Site indexing stops when a db exception occurs</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18446</td>
<td>Display editor hints in the status bar of the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18417</td>
<td>Enabled plugins that are disabled by default don’t stay enabled after Confluence upgrades</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18399</td>
<td>Replace ReverseDatabin der with better factored import code</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18390</td>
<td>Rest Plugins have no Transactions</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18309</td>
<td>NPE when clicking ’PDF Stylesheet’ in space admin when not global administrator</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18303</td>
<td>Rest Search Service</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18284</td>
<td>Pressing tab on autcomplete drop downs (such as quick nav) in Firefox causes the text to go white</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18271</td>
<td>cachecontents.jsp page is broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18240</td>
<td>New Fixed Width Theme</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>------------</td>
<td>---------</td>
<td></td>
</tr>
<tr>
<td>CONF-18235</td>
<td>Left Nav Theme is not showing the correct text</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18216</td>
<td>(plugins-supported) macro is not working correctly after upgraded from 2.10 to 3.1</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18206</td>
<td>Need to remove hard-coded instances of blue</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18199</td>
<td>Dropdown doesn't work nicely with long usernames</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18195</td>
<td>Impossible to select a user using mouse from an autocomplete dropdown box in a search filter &quot;Who&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18194</td>
<td>viewxls macro in the macro browser does not work correctly when inserting attachments from a comment on a blog</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18150</td>
<td>Cannot upgrade to Confluence 3.1 when using Crowd integration</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18098</td>
<td>Fix license action requires authentication, can't be used if user migration fails</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18072</td>
<td>Improve caching of language preference when user is using site default language</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-18045</td>
<td>Make notification to display consistent display name</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Conf.</td>
<td>Problem Description</td>
<td>Status</td>
<td>Fixed</td>
<td>#</td>
</tr>
<tr>
<td>-----</td>
<td>-------</td>
<td>------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-18036</td>
<td>Add plugin extension point for search result rendering</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-18027</td>
<td>Missing internationalisation when number of user licenses is exceeded</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17898</td>
<td>Index Queue flush can miss entries</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17860</td>
<td>Extra white space on the right when adding a page @ 1024 x768</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17659</td>
<td>Excerpt generation misses first character</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17519</td>
<td>Inconsistent functionality between menus (themes)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17382</td>
<td>MacroMetadata Parser ignores all attributes for macros without parameters</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17281</td>
<td>Improve Page History Navigation UI</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17265</td>
<td>Improve Widget connector macro description wording</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17203</td>
<td>Extraneous <code>&lt;p&gt;</code> tag in space.vmd</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17153</td>
<td>Space on the end of a database connection URL during setup can cause connection to fail</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17077</td>
<td>Message about exceeding the number of licenced users contains a</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-17028</td>
<td>Email link should not appear for pages that the user is restricted from viewing</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-17024</td>
<td>Improve instructions on the Confluence error page (500.jsp)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-16578</td>
<td>When Confluence license is invalid in confluence.cfg.xml, Confluence fails with &quot;Upgrade failed&quot; in the browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-16389</td>
<td>Mail page plugin throws null pointer due to invalid LDAP membership</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-16058</td>
<td>CreateRssFeed Action doesn't handle multiple RSS types in request nicely</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15919</td>
<td>Disabled Users Can Be Followed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15915</td>
<td>Macro Browser - Chart Macro - &quot;X-axis&quot; and &quot;Y-axis&quot; labels are not immediately understood</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15756</td>
<td>Edit Attachment Storage page has escaped &lt;em&gt;&lt;/em&gt; tags</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15528</td>
<td>Spelling errors and missing information in the online documentation (i.e. the notation guide)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15317</td>
<td>Edit User Groups</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-15262</td>
<td>Add Keyboard shortcut for the macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15185</td>
<td>Control+i takes you to the page info when your trying to use the shortcut for italics in the RTE of a Page/Blog comment</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-15031</td>
<td>More useful filenames for PDF Exports</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14875</td>
<td>Link Browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14669</td>
<td>Tables don't initially look like tables when inserted in the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14636</td>
<td>On the search screen, add help text to &quot;Who&quot; field</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14565</td>
<td>In Browse Labels screen, Recent Labels and Popular Labels boxes on the right should be aligned with the current (future) styling.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-14558</td>
<td>Change &quot;Children&quot; to &quot;Child Pages&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13763</td>
<td>Moving attachments may silently fail to move the actual file</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13529</td>
<td>New &quot;Configure whitelist&quot; admin screen loses breadcrumbs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13423</td>
<td>Insert Link popup needs to be cleaned up</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-13392</td>
<td>Creating a page with RTE has</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
whitespace
where the
notation guide is
in wiki markup
mode

<table>
<thead>
<tr>
<th></th>
<th>CONF-13196</th>
<th>list of users includes options to view more users per page even if the number of users less than 10</th>
<th>Resolved</th>
<th>Fixed</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-12179</td>
<td>Link a page in the rich-text editor.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-5805</td>
<td>Add keyboard shortcut for preview tab</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-4475</td>
<td>Removing the last item in a dynamic task list don’t work properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>CONF-2577</td>
<td>Auto-completion of likely words in edit dialogs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>

Above are the issues resolved in Confluence 3.2, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker.

Confluence 3.3.1 Release Notes

17 August 2010

Confluence 3.3.1 is a recommended upgrade which fixes some security flaws and other bugs.

We have fixed a security flaw in this release that compromised the Secure Administrator Sessions (WebSudo) feature that was introduced in Confluence 3.3. Read the security advisory for more details.

Don't have Confluence 3.3 yet?

Take a look at the new features and other highlights in the Confluence 3.3 Release Notes.

Download Latest Version

Release Notices

Security Advisory

This release fixes a security flaw. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 3.3.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
## Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (32 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>Issue Number</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>CONF-20181</td>
</tr>
<tr>
<td>CONF-20127</td>
</tr>
<tr>
<td>CONF-20027</td>
</tr>
<tr>
<td>CONF-20021</td>
</tr>
<tr>
<td>CONF-20012</td>
</tr>
<tr>
<td>CONF-19932</td>
</tr>
<tr>
<td>CONF-19694</td>
</tr>
<tr>
<td>CONF-19285</td>
</tr>
<tr>
<td>CONF-19157</td>
</tr>
<tr>
<td>CONF-17414</td>
</tr>
<tr>
<td>CONF-16876</td>
</tr>
<tr>
<td>CONF-12421</td>
</tr>
</tbody>
</table>
Confluence 3.3.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.3.1. Confluence 3.3.1 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the Confluence 3.3.1 Release Notes.

On this page:

- Upgrade Notes
- Upgrade Procedure
- Useful Plugins

Upgrade Notes

- We have fixed a security flaw in this release that compromised the Secure Administrator Sessions (WebSudo) feature that was introduced in Confluence 3.3. Read the security advisory for more details.

- There is known issue in this release where you will not be able to add permissions to a page when copying it. We are addressing this issue. In the meantime, you can work around this by creating a new page, copying the wiki markup from the page that you want to copy and applying permissions to the new page. See CONF-20584 for more information.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database.
   - The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.3, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.3 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.3.3 Release Notes

21 September 2010
Confluence 3.3.3 is a recommended upgrade which fixes some security flaws and other bugs. Note that Confluence 3.3.2 was an internal release only.

- **Security fixes in Confluence 3.3.3.** Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

- **Office Connector temporary storage location.** When configuring the temporary storage location for the Office Connector's View File macro, you can no longer enter a specific file location via the Confluence Administration Console. Instead, the Administration Console offers three options, as described below. If you have previously entered a specific file location, the location will still be valid. However, if you want to change the location you will need to choose one of the three options described below, to hold the temporary file:
  - In memory.
  - In your Confluence Home directory.
  - In a file location that you can specify in the directories.properties file, located in the Office Connector JAR. Instructions are in the documentation.

- **Preview pane now shows full content.** When previewing a wiki page in Firefox, the preview pane will now show the entire content of the page. This fixes a problem experienced with Firefox 3.6.7 and later, caused by a change in Firefox.

- **Other noteworthy fixes.** The complete list of bug fixes is at the bottom of this page. Highlights:
  - You can now set page restrictions when copying a page.
  - Confluence will retain your setting when you turn on the 'Did You Mean' feature in the search.
  - When you edit a wiki page in Word, your changes are now saved.

**Don't have Confluence 3.3 yet?**

Take a look at the new features and other highlights in the Confluence 3.3 Release Notes.

[Download Latest Version]

**Release Notices**

- **Security advisory:** This release fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

- **Upgrading from a previous version of Confluence:** Upgrading Confluence should be fairly straightforward. Please read the Confluence 3.3.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

### JIRA Issues (20 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![icon]</td>
<td>CONF-21905</td>
<td>CLONE - Editor preview doesn't expand to show complete content</td>
<td>![icon]</td>
<td>![Resolved]</td>
<td>Tracked Elsewhere</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20671</td>
<td>XSSR vulnerability in the Mail Page plugin</td>
<td>![icon]</td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20670</td>
<td>XSS vulnerability in the Office Connector</td>
<td>![icon]</td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20669</td>
<td>Confluence</td>
<td>![icon]</td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>Conf #</td>
<td>Issue Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20668</td>
<td>Path traversal vulnerability in various Confluence actions</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20441</td>
<td>Editor preview doesn't expand to show complete content</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20584</td>
<td>Cannot set page restrictions when copying a page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20487</td>
<td>Did You Mean option not retained in 3.3</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20339</td>
<td>Edit in &quot;Page&quot; word feature causes nullpointer exception.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19738</td>
<td>bootstrapPlugin Manager is still available to plugins system - is not thrown away.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20738</td>
<td>Ziputility adds files with wrong name</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20616</td>
<td>Edit in Word does not work when a custom authenticator is configured</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20298</td>
<td>NullPointerException error logged by scheduled office connector cleanup job at 02:00</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12571</td>
<td>JIRA Issue Macro displays too wide, doesn't auto-scroll properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20754</td>
<td>License Details:</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>---------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20617</td>
<td>Cannot build REST documentation for Confluence 3.3.1</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20575</td>
<td>Update Jira Macros Plugin to version 2.8.20.2 issues fixed in this update</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20343</td>
<td>sudo is decorated with global decorator</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14628</td>
<td>pages/create(blogpost</td>
<td>page).action with a spaceKey containing the null character causes org.springframework.dao.DataIntegrityViolationException</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-25256</td>
<td>SCN &gt; Wiki: The mark and the description for the font options are intersected</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Confluence 3.3.3 Upgrade Notes**

Below are some important notes on upgrading to Confluence 3.3.3. Confluence 3.3.3 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the [Confluence 3.3.3 Release Notes](https://confluence.atlassian.com/display/CONF33/Confluence+3.3.3+Release+Notes).

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. **Before you upgrade**, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   **Tip:** Another term for 'Home directory' would be 'data directory'. Read more about [finding your Home directory](https://confluence.atlassian.com/display/CONFLUENCE/FAQ+for+Confluence+3.3).

2. **If your version of Confluence is earlier than 3.3**, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the [Confluence 3.3 Upgrade Notes](https://confluence.atlassian.com/display/CONF33/Confluence+3.3+Upgrade+Notes).
   - If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](https://confluence.atlassian.com/display/CONF22/Confluence+2.2+Release+Notes).

3. **Download** the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.3 Release Notes

7 July 2010

With great pleasure, Atlassian presents Confluence 3.3 now with more ways to integrate with JIRA and an even faster and simpler editor.

Highlights of this Release:

- Confluence Page Gadget
- Autocomplete for Inserting Macros
- Property Panels for Links
- Property Panels for Images
- Manage Watchers
- Email Notifications for Network Activity and Blogs
- Blog Improvements
- Context-Sensitive Help Links
- Security Features
- Infrastructure Changes
- Even More Improvements

More:

- Thank you for all your issues and votes. Keep logging issues to help us keep improving!
- Read the release notices for important information about this release.
- Attached is the full list of issues resolved in this release.

Video of What's New:

app.episodic.com

Responding to your Feedback:

🌟 Over 200 votes satisfied

Highlights of Confluence 3.3

1
**Confluence Page Gadget**

You wanted to display Confluence content in other applications and we’ve delivered. The Confluence Page Gadget is the newest addition to our suite of gadgets. You can specify a Confluence page or blog post to be shown in the gadget, which you can then add to your JIRA dashboard or even another Confluence site. The gadget also renders macros from your Confluence page or blog post, allowing you to embed rich content like tasklists, spreadsheets, videos and more, in your applications via the gadget.

More...

**Autocomplete for Inserting Macros**

Confluence 3.3 builds on the autocomplete for links and autocomplete for attachments features introduced in Confluence 3.2. You can now take advantage of the speed and convenience of autocomplete to insert macros via the rich text editor. Just enter ‘{’ and start typing to see the suggested macros that match your text.
Property Panels for Links

Keep common link functions at your fingertips with property panels for links. You no longer need to leave the rich text editor to see where a link is pointing to, or to remove the link. Click a link and a properties panel will appear. Simply click the appropriate button to view/go to the link location, edit the link or unlink it.

Property Panels for Images

Property panels have also been added for images. You no longer need to leave the rich text editor to resize an
image or add a border. You can easily perform these functions via the property panel.

**Rich Text**

Today's meeting was extremely productive, due in no small part to the chocolate on the table.

More...

5

**Manage Watchers**

Confluence 3.3 now allows you to manage the watchers for all pages and blog posts in a space, if you are a space administrator for that space. You can view, add and remove watchers of a page or blog post, as well as view all watchers of the space on a single screen.

More...
Email Notifications for Network Activity and Blogs

We've extended the email notifications functionality in Confluence. You can now subscribe to email notification for all blog activity in your Confluence site and all activity by people that you follow.

More....

Blog Improvements

A number of improvements have been made to Confluence blogs in this release.

- **Change Comments in Blog Posts** — We've implemented change comments on blog posts, so you can comment on the updates you make to blog posts, in the same way as you can for pages.

- **Blog Navigation Improvements** — The blog view has also been redesigned to present more informative with less clutter. The old calendar has been replaced with a new sidebar listing blog posts for the month and you can now see the profile pictures of the bloggers in posts.
Context-Sensitive Help Links

Context-sensitive help links are now available in Confluence. These links will redirect you to the appropriate online documentation for the version of Confluence that you are using. You can also use this feature to configure your own local Confluence documentation, e.g. if your deployment is in an environment without an Internet connection.

More...

Security Features

- **Confluence secure administrator sessions.** Confluence has another line of defence against hijackers of administrator sessions. All features in the Administration section of Confluence (and some in the Space Administration section) will require the user to validate their credentials before proceeding. After validating, a message at the top of each page reminds you of your temporary administrator session. The temporary session will expire after 10 minutes of administrator inactivity and can also be terminated manually.

  More...

- **Login CAPTCHA.** Confluence now requires the user to answer a CAPTCHA question after a given number of failed login attempts. This security mechanism protects not only the login page but the
RPC-interface as well. After a configurable number of failed login attempts via the RPC interface, the user is required to log in using the web interface which then presents the CAPTCHA image.

More...

- **XSRF protection on comment creation.** An XSRF token is now required to be present when adding a comment. Don’t worry though, a system is in place so that your session will not expire and you can take your time to write the perfect comment! All the bundled themes have been updated to use this feature, but you can disable it if you are using a custom theme.

More...

- **Login information.** Confluence now captures metadata about login attempts, including the dates of the last failed and successful login and the number of failed logins. A Confluence administrator can also reset the number of failed logins for a particular user.

More...

### Infrastructure Changes

We’ve made a number of infrastructure changes to aid plugin development:

- DWR deprecated. See the [Confluence 3.3 Upgrade Notes](https://confluence.atlassian.com/display/DOC/Confluence+3.3+Upgrade+Notes) for more details.
- Upgraded to Atlassian User Interface (AUI) 3.0.5. See the features in [AUI 3.0](https://confluence.atlassian.com/display/DOC/AUI+3.0).
- Upgraded to [Shared Access Layer (SAL) 2.1](https://confluence.atlassian.com/display/DOC/Shared+Access+Layer+(SAL)+2.1).
- Upgraded to Atlassian Events 2.0.1
- Upgraded to Atlassian REST Module 2.0.0
- Upgraded to Atlassian Plugin Framework 2.5.1. See the features in [Atlassian Plugin Framework 2.5](https://confluence.atlassian.com/display/DOC/Atlassian+Plugin+Framework+2.5), including:
  - New [web panel](https://confluence.atlassian.com/display/DOC/web+panel) and [web panel renderer](https://confluence.atlassian.com/display/DOC/web+panel+renderer) plugin modules, allowing you to add sections of HTML to a Confluence page.
  - Trigger control for your servlet filters, allowing you to specify the conditions under which your [servlet filter](https://confluence.atlassian.com/display/DOC/servlet+filter) plugin module is triggered.
  - Additional contexts in [web resources](https://confluence.atlassian.com/display/DOC/web+resources), so that Confluence now supports the standard contexts provided by the plugin framework as well as the existing Confluence contexts.
- Upgraded to Bandana 2.0. See our documentation on [persistence in Confluence](https://confluence.atlassian.com/display/DOC/persistence+in+Confluence), including:
  - Custom context objects.
  - Key enumeration.
  - Item removal.
  - Custom serialisation.

### Even More Improvements

- **Streamlined 'Import Word Document' wizard.** The screens in the 'Import Word Document' wizard have been redesigned to make this feature much more intuitive.

- **Redesigned default dashboard.** We’ve made a number of minor improvements to the default dashboard, including new buttons and a new welcome message.

- **Improved ‘General Configuration’ user interface.** The General Configuration screen in the Administration Console has been given a face lift.
• **Accessibility Improvements.** We've added labels, legends and skip links so that Confluence now complies with more of the [Section 508 Web Accessibility Standards](https://www.section508.gov/). We still have a long way to go, but these pages should now be more screen-reader friendly:
  • Dashboard
  • General pages
  • Profiles
  • Set your Password
  • Attachments
  • People Directory
  • User Status

**Release Notices**

Security advisory

This release fixes some security flaws. Please refer to the [security advisory](https://confluence.atlassian.com/release-notices/33-release-notes) for details of the security vulnerabilities, risk assessment and mitigation strategies.

Upgrading from a previous version of Confluence

• Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**
  • Please refer to the [Confluence 3.3 upgrade notes](https://confluence.atlassian.com/release-notices/33-release-notes) for further essential information about plugins and other factors affecting your upgrade.

**Known Issues**

We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release and report any problems so that we can fix them quickly.

We value this feedback, which means that we can tell you about some minor known issues in Confluence 3.3. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the [important technical advisories](https://confluence.atlassian.com/important-technical-advisories) on the front page of the Knowledge Base.

A big **thank you** to everyone who helps us ensure that Confluence keeps getting better and better.

**The Confluence 3.3 Team**

Development

**Bugfixing and Maintenance**

Matthew Jensen  
Daniel Kjellin  
Anna Dominguez  
Stefan Saasen

**Editor Improvements**

Agnes Ro  
Dmitry Baranovskiy  
David Taylor  
Jared Wyles

**Small Improvements**

Brian Nguyen  
Xu-Heng Tjin  
Gerry Claps  
Matthew Erickson  
Niraj Bhawnani
**Plugin Updates**
David Chui

**Build and Release Engineering**
Don Willis

**Special Projects** (not shipping in this release)
Matt Ryall
Paul Curren
Charles Miller
David Loeng
Ryan Thomas
Chris Kiehl
Jonathan Gilbert
Ben Buchanan
Andrew Lynch
Alan Davis

**Team Lead**
Per Fragemann

**Support**

**Amsterdam**
Sherali Karimov
Ajay Sridhar
Tony Atkins

**Brazil**
Rodrigo Adami
Jean Fabricius Bondan
Guilherme Heck
Luzia Mendes
Alyson Dos Reis
Marco Roman
Hugo Vares Vieira

**Kuala Lumpur**
Azwandi Mohd Aris
Heng Hwa
Husein
Sashidaran Jayaraman
Jack Low
Joachim Ooi
Henry CL Tiong
Zed Yap

**San Francisco**
Vincent Chang
Marian Finch
Adam Laskowski
Wayne Tombo
Timothy Wong

**Sydney**
Gurleen Anand
Confluence 3.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.3. For details of the new features and improvements in this release, please read the Confluence 3.3 release notes.

On this page:

- Upgrade Notes
  - End of Support for WebSphere, WebLogic, Resin, Internet Explorer 6 and Java Platform 5 (JDK/JRE 1.5)
  - DWR Deprecation Notice
- Upgrade Procedure
- Checking for Other Known Issues and Troubleshooting the Confluence Upgrade
- Useful Plugins

Upgrade Notes

End of Support for WebSphere, WebLogic, Resin, Internet Explorer 6 and Java Platform 5 (JDK/JRE 1.5)

As previously announced, we are no longer providing support for:

- IBM WebSphere (all versions) from this release onwards.
- Oracle WebLogic (all versions) from this release onwards.
- Cauch Resin (all versions) from this release onwards.
- Internet Explorer 6 from this release onwards.
- Java Platform 5 (JDK/JRE 1.5) from this release onwards.

Please see End of Support Announcements for Confluence for further details.
DWR Deprecation Notice

We have replaced DWR with XWork actions (returning JSON, implementing the Beanable interface). The DWR servlet still works, however the client-side JavaScript files are not embedded into pages anymore. Support for the client side Javascript proxies has been moved into the Confluence Legacy Web Resources plugin. This plugin is disabled by default.

If you need any of the following web resources you will need to enable the Confluence Legacy Web Resources plugin:

- DWR framework
- DWR Javascript proxies for label (add, remove, suggest) or editor operations (heartbeat, draft saving, editor preferences)

You will also need to make the following resource a required resource in your view template: `legacy.confluence.web.resources:dwr-confluence`

This will embed the DWR client-side JavaScript files in your plugin's view output.

Upgrade Procedure

⚠️ Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
2. If your version of Confluence is earlier than 3.2.x, then please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.) Also:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.
3. Download the latest version of Confluence.
4. Follow the instructions in the upgrade guide.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- **If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.**
Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

RELATED TOPICS

Confluence 3.3 Release Notes

Issues Resolved in Confluence 3.3

Below are the top 100 issues resolved in Confluence 3.3, ordered by number of votes. For the full list of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 3.3 release notes for the new features in Confluence 3.3.

**JIRA Issues (100 issues)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚀</td>
<td>CONF-3703</td>
<td>Assign page watches to individuals or groups.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>91</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-5032</td>
<td>Add the ability to view &amp; manage watchers of content</td>
<td>Resolved</td>
<td>Fixed</td>
<td>62</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-15946</td>
<td>I18NBean getText method spamming EAC logs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>35</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-18704</td>
<td>Cannot generate PDFs of pages with certain symbols in the title</td>
<td>Resolved</td>
<td>Fixed</td>
<td>25</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-16866</td>
<td>Page Restriction design does not scale well due to re-indexing of all sub-pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>18</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-13310</td>
<td>Support for Oracle 11g</td>
<td>Resolved</td>
<td>Fixed</td>
<td>17</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-8622</td>
<td>Minify JavaScript and CSS files</td>
<td>Resolved</td>
<td>Fixed</td>
<td>16</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-9889</td>
<td>Monospace text (</td>
<td>) is not rendered when next to macros, links or images</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-11416</td>
<td>Confluence help</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
</tr>
<tr>
<td>Issue Key</td>
<td>Title</td>
<td>Resolution</td>
<td>Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------</td>
<td>-------------</td>
<td>--------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18059</td>
<td>Page footer renders incorrectly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12779</td>
<td>Request to use 'Site Title' instead of 'Confluence' on Login page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-4076</td>
<td>Allow attaching of images or files when writing comments</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19435</td>
<td>Scrolling within Documentation Theme is broken for iPad</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17567</td>
<td>Search function cannot filter by special character (~, *, #, @, etc) in Who field.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12753</td>
<td>Some sections in the Space Admin page are broken in IE 6</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-3851</td>
<td>Last login date is not updated when Remember-me is used</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19675</td>
<td>Flying PDF plugin uses locale dependent names when creating files</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19425</td>
<td>Confluence automatic indexing fails</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19145</td>
<td>creates &quot;plugins-temp&quot; directory, fails to start if current directory is not writable</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15233</td>
<td>Purging Trash is Slow and Blocks DB Writes</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Summary</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-11554</td>
<td>Alternative 500page.jsp with minimal information</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-5000</td>
<td>Allow excerpts when listing content with a particular label</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-19209</td>
<td>Quicknav gadget has display problems</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-19065</td>
<td>First row of editor is hidden underneath wiki markup toolbar in IE7 and IE6</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-19038</td>
<td>Allow search-results to retain theme when paging through results</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-18949</td>
<td>Viewfile macro performance problems</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-19873</td>
<td>Plugin Repository is not working on QA-EAC</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-19229</td>
<td>livesearch macro doesn't work properly on IE6, IE7 and IE8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-19127</td>
<td>Templates with variables fails sometimes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-18551</td>
<td>Ability to edit existing images with the new image browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-15247</td>
<td>Java quits or exits - Seg Fault due to recursive ExcerptInclude Macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-12915</td>
<td>Allow user to enter change comment when editing news item/blog post</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-7063</td>
<td>Dynamic Tasklist Macro cannot be used while</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Key</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-20664</td>
<td>Macro Browser could not display search field when browser is minimized (and even after maximized later) in IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CONF-19856</td>
<td>Thumbnail Images: Only one image on a page can be viewed one time</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CONF-19562</td>
<td>Links to attachments from within comments work in preview and wysiwyg, but not when saved and displayed</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-19531</td>
<td>Broken &quot;Enable Profiling&quot; button if button value contains special characters</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONF-19217</td>
<td>Upgrade bundled plugins</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CONF-18951</td>
<td>Fix mime type for attachment file uploads</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CONF-18846</td>
<td>Getting java.lang.NullPointerException when tried to view a pptx file</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CONF-18442</td>
<td>{viewfile} error message</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>CONF-18292</td>
<td>Atlassian Plugin Repository keeps loading and never finishes</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>CONF-18110</td>
<td>Link to PAC Themes from Space admin choose theme screen</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>CONF-18082</td>
<td>Create MySQL tables using</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Count</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>CONF-17780</td>
<td>InnoDB engine by default</td>
<td>Replace welcome message for 3.1 and improve welcome message mechanism</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-17334</td>
<td>Keyboard shortcuts not working under Mac OSX (Snow Leopard)</td>
<td>Keyboard shortcuts not working under Mac OSX (Snow Leopard)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-16621</td>
<td>Error using Doc Import in News</td>
<td>Error using Doc Import in News.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-14928</td>
<td>System error when removing a username containing a space from a group in Manage Groups page</td>
<td>System error when removing a username containing a space from a group in Manage Groups page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-23149</td>
<td>contentbylabel macro does not sort ASCII characters properly</td>
<td>contentbylabel macro does not sort ASCII characters properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20229</td>
<td>Online help link in Setup Wizard leads nowhere</td>
<td>Online help link in Setup Wizard leads nowhere</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20206</td>
<td>Removing a page watcher in IE throws a javascript error</td>
<td>Removing a page watcher in IE throws a javascript error</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20182</td>
<td>Added a page watcher displays …</td>
<td>Added a page watcher displays …</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20164</td>
<td>Some text describing the web sudo setting would be helpful to have in the security config sidebar</td>
<td>Some text describing the web sudo setting would be helpful to have in the security config sidebar</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20155</td>
<td>For an email address link, clicking “go to link” from property panel generates a windows error</td>
<td>For an email address link, clicking “go to link” from property panel generates a windows error</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>#</th>
<th>Title</th>
<th>Status</th>
<th>Type</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-20144</td>
<td>Update French Language Pack to v1.21, 1 issue resolved</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20143</td>
<td>Update Office Connector to v1.10, 3 bugs fixed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20142</td>
<td>Office Connector 1.9 vendor name/description is incorrect</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20141</td>
<td>Update German Language Pack to v1.16, 2 issues resolved</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20140</td>
<td>Remove dotted border around image property panel buttons</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20132</td>
<td>Page Gadget: fields in Macro Browser are screwed up when using the gadget on IE8</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20126</td>
<td>XSS vulnerability in Clickr theme</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20125</td>
<td>XSS vulnerability in Contributors Summary macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20122</td>
<td>XSS vulnerability in Contributors macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20121</td>
<td>XSS vulnerability in PDF export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20119</td>
<td>XSS vulnerability in Tasklist macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20108</td>
<td>Autocomplete for links page title not appearing</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20090</td>
<td>Editor Properties Panel: Doesn’t handle email address well</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20079</td>
<td>Page Gadget cannot be authenticated after configuration</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-20073</td>
<td>Text &quot;All&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
</tr>
<tr>
<td>CONF-20070</td>
<td>Hard-coded help link on PDF Layout screen should use the new configurable linking design</td>
<td>Spaces should disappear when user focuses on the text box to type in a space name in Page Gadget</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20069</td>
<td>Special characters in resource urls are throwing errors</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20067</td>
<td>When user does not have a profile picture set blog post macro and browse space blogs log errors</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20058</td>
<td>Remove special pre-mysql 4.1 handling in query to fetch orphaned pages (which is really slow for large spaces)</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20055</td>
<td>Web sudo fails with NoSuchMethodException for constructor-injected plugin actions</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20020</td>
<td>Dropdown images are clipped in the Page gadget</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20018</td>
<td>The page gadget space picker is confusing</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20016</td>
<td>Errors appear in Safari console when using the Page Gadget</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20015</td>
<td>Edit Document link doesn't work in the Page</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>Issue</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20014</td>
<td>Viewing a long page in the Page Gadget resulted in &quot;Script stack trace quote is exhausted&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20010</td>
<td>Page Gadget failed to load in Safari</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20007</td>
<td>Upgrade ThreadDump plugin</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20002</td>
<td>Full screen mode cannot be toggled off in safari and IE7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19997</td>
<td>No way to add a link with links browser or autocomplete in Clickr 2.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19996</td>
<td>Update Confluence gadgets to 1.1-beta2 - 11 bugs fixed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19994</td>
<td>Update tasklist plugin to 3.3-beta2 - fixed 2 bugs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19986</td>
<td>Update Advanced Macros to v1.9, 2 issues fixed in this release</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19984</td>
<td>JavaScript error when selecting a macro in Macro Browser where the first parameter field is a select</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19980</td>
<td>Update Clickr Theme to v2.10, 2 issues fixed in this release</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19968</td>
<td>Create space javascript broken by CONF-19803</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19967</td>
<td>Exception viewing security</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Summary</td>
<td>Status</td>
<td>Votes</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-19966</td>
<td>Page gadget does not have a &quot;view&quot; button in Safari</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19959</td>
<td>Page Gadget space text box does not find my personal space or even any space named &quot;Home&quot; or &quot;home&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19952</td>
<td>Drag drop does not work in BETA-2</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19951</td>
<td>Upgrade page tree macro to 1.18</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19947</td>
<td>atlassian-plugin.xml: trim white spaces</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19931</td>
<td>Confluence page gadget edit link doesn't work for blogs</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19926</td>
<td>Page gadget dialog combo box for selecting a page does not have a bottom</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19921</td>
<td>Page gadget dialog &quot;you must select a page&quot; remains after page is selected.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19913</td>
<td>Closing links dialog with escape key causes IE Javascript error</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-19912</td>
<td>Links browser link text should not change when link is changed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>

Above are the issues resolved in Confluence 3.3, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker.

Confluence 3.4.1 Release Notes

1 November 2010
**Confluence 3.4.1** is a bug-fix release. The full list of fixes is at the bottom of this page. Here are the highlights:

- **Edit in Word on Windows 7.** This release fixes a problem where the 'Edit in Word' functionality did not work on Windows 7. Before this fix, opening a Confluence page as a Word document would cause the document to be loaded in read-only mode for users running Windows 7.

- **Word wrap for long words in PDF exports.** A bug caused long words, or text without spaces, to be cut off in PDF exports. This is now fixed, so that long words are wrapped onto the next line. This is particularly relevant for languages where text does not contain spaces, such as Chinese and Japanese.

**Don’t have Confluence 3.4 yet?**

Take a look at the new features and other highlights in the [Confluence 3.4 Release Notes](#).

### Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the [Confluence 3.4.1 Upgrade Notes](#). We strongly recommend that you back up your `confluence.home` directory and database before upgrading.

### Updates and Fixes in this Release

#### JIRA Issues (6 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-21084</td>
<td>Plugin Administration Page link should point to UPM rather than legacy plugin manager</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-21099</td>
<td>XSS vulnerability in Attachments macro</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-21098</td>
<td>XSS vulnerability in Code macro</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-18174</td>
<td>Edit in word read only in Windows 7</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-20712</td>
<td>Episodic Videos not working with widget connector</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>CONF-16833</td>
<td>Long words fail to wrap in PDF exports</td>
<td><img src="image" alt=" " /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

**Confluence 3.4.1 Upgrade Notes**

Below are some important notes on upgrading to **Confluence 3.4.1**. For details of the fixes in this release, please read the [Confluence 3.4.1 Release Notes](#).

**Upgrade Procedure**
If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory. 
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.4 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.2 Release Notes

15 November 2010

Confluence 3.4.2 is a bug-fix release. The full list of fixes is provided at the bottom of this page.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

Get the Latest Version

Release Notices

- Security advisory: This release fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.
- Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (3 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>🚀</td>
</tr>
<tr>
<td>🚀</td>
</tr>
</tbody>
</table>
Confluence 3.4.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.4.2. Confluence 3.4.2 is a recommended upgrade which fixes some security flaws as well as other bugs. For more details, please read the Confluence 3.4.2 Release Notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.4 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.3 Release Notes

29 November 2010

Confluence 3.4.3 is a bug-fix release. The list of fixes is at the bottom of this page.

In addition to releasing Confluence 3.4.3, we have also updated the code for the Expand user macro so that the body of the macro now visible in PDF exports. To take advantage of this improvement, please copy the macro ‘template’ from this documentation page: Writing the Expand User Macro. Note that you do not need to upgrade to Confluence 3.4.3 in order to use the updated macro. Simply updating your macro template is enough.

Don't have Confluence 3.4 yet?
Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

**Release Notices**

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.3 Upgrade Notes. We strongly recommend that you back up your `confluence.home` directory and database before upgrading.

**Updates and Fixes in this Release**

<table>
<thead>
<tr>
<th>JIRA Issues (10 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
Confluence 3.4.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.4.3. For details of the fixes in this release, please read the Confluence 3.4.3 Release Notes.

Upgrade Notes

We have updated the code for the Expand user macro, so that the body of the macro now visible in PDF exports. To take advantage of this improvement, please copy the macro ‘template’ from this documentation page: Writing the Expand User Macro.

Note that you do not need to upgrade to Confluence 3.4.3 in order to use the updated macro. Simply updating your macro template is enough.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   • Please read the Confluence 3.4 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin's information page to see
whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.5 Release Notes

15 December 2010

Confluence 3.4.5 is a bug-fix release. Please see the list of updates and fixes below.

Note that Confluence 3.4.4 was an internal release and was not made available to customers.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.5 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (13 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
### Confluence 3.4.5 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.4.5**. For details of the fixes in this release, please read the [Confluence 3.4.5 Release Notes](#).

---

#### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. **Before you upgrade**, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   ![Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.](#)

2. **If your version of Confluence is earlier than 3.4**, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the [Confluence 3.4 Upgrade Notes](#).
   - If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](#).

3. **Download** the latest version of Confluence.

---

<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Issue Description</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-20895</td>
<td>Some macros don't render in Macro browser or preview tab when using Internet Explorer ('AJSError' is undefined error)</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-21428</td>
<td>“Favourite Pages” section on the dashboard has missing “star” image</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-21376</td>
<td>AttachmentRend erSupport does lots of unnecessary work</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-21144</td>
<td>Copy and paste of emoticons is broken in the RTE</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-21325</td>
<td>“Page Level Permissions” headline is missing</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-20804</td>
<td>“Download All” fails with “Too many open files.”</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

---

[Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.](#)
4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.6 Release Notes

4 January 2011

Confluence 3.4.6 is a bug-fix release. Please see the list of updates and fixes below.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

[Download Latest Version]

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.6 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>(10 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21508</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21462</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21374</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21201</td>
</tr>
</tbody>
</table>
### Confluence 3.4.6 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.4.6**. For details of the fixes in this release, please read the [Confluence 3.4.6 Release Notes](#).

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the [Confluence 3.4 Upgrade Notes](#).
   - If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](#).
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

**Useful Plugins**

*Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.*

---

<table>
<thead>
<tr>
<th>Issue Number</th>
<th>Description</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-8118</td>
<td>Link Tip shows up as Undefined Pages</td>
<td>✅</td>
<td>Resolved</td>
</tr>
<tr>
<td>CONF-4962</td>
<td>Outgoing Link Bug for MouseOver Text</td>
<td>✅</td>
<td>Resolved</td>
</tr>
<tr>
<td>CONF-3935</td>
<td>Incorrect outgoing links when using mouse over text</td>
<td>✅</td>
<td>Resolved</td>
</tr>
<tr>
<td>CONF-21315</td>
<td>Body of the 'Expand' user macro is not included in the HTML export</td>
<td>✅</td>
<td>Resolved</td>
</tr>
<tr>
<td>CONF-21283</td>
<td>Plugin info can't be obtained if the vendor URL is invalid</td>
<td>✅</td>
<td>Resolved</td>
</tr>
<tr>
<td>CONF-13988</td>
<td>Incoming Links and Outgoing Links not picking up links with tooltip</td>
<td>✅</td>
<td>Resolved</td>
</tr>
</tbody>
</table>
Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.7 Release Notes

27 January 2011

Confluence 3.4.7 is a bug-fix release.

This release solves a problem that caused the Confluence index build to fail without reporting any errors. Symptoms of the problem included missing blog posts, and missing pages in the list returned by the Content by Label macro. This is now fixed.

We have also fixed some issues experienced when editing a page or document in Word.

- When using Firefox, editing pages in Word failed if the page title contained special characters.
- Editing pages in Word failed for long path names. This problem could occur when the combination of Confluence space name and page title exceeded a certain number of characters. (The exact number depended on your environment.) Editing attachments with long path names in Office also failed.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.7 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (9 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
</tbody>
</table>
## Confluence 3.4.7 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.4.7**. For details of the fixes in this release, please read the [release notes](#).  

**Upgrade Notes**

This release solves a problem that caused the Confluence index build to fail without reporting any errors. Symptoms of the problem included missing blog posts, and missing pages in the list returned by the Content by Label macro. This is now fixed.

If you experienced this problem, you should re-index Confluence after performing the upgrade. See [Content Index Administration](#) and [CONF-21500](#).

<table>
<thead>
<tr>
<th>Ticket</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-16594</td>
<td>Edit in Word with Firefox plugin fails with non-english page titles - WebDav launcher does not support nonenglish symbols in URL</td>
</tr>
<tr>
<td>CONF-21411</td>
<td>Edit in Office using Office 2010 will change Mime Type to Text/XML - causing attachment download problem</td>
</tr>
<tr>
<td>CONF-20886</td>
<td>Bookmarks macro gives a ClassCastException when used in a comment</td>
</tr>
<tr>
<td>CONF-21195</td>
<td>The 'Choosing a database configuration' screen in set up has a broken link to <a href="http://localhost:8080/confluence/setup/null">http://localhost:8080/confluence/setup/null</a> in the 'embedded database' section.</td>
</tr>
<tr>
<td>CONF-18135</td>
<td>Edit in office fail for attachments when page title contains certain alpha numeric characters</td>
</tr>
</tbody>
</table>
Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.4 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

Confluence 3.4.8 Release Notes

7 February 2011

Confluence 3.4.8 is a bug-fix release.

This release adds OpenOffice MIME type handling capabilities to Confluence file uploads. Hence, if you now upload any OpenOffice file to Confluence and then download it, the file will be downloaded with the correct file extension instead of .zip.

We also fixed a bug in the spaces list macro, which caused this macro to fail on Confluence instances with large numbers of spaces.

Finally, if your Confluence site was started with the password.confirmation.disabled system property set to false, a bug in Confluence prevented site administrators from saving configuration changes made to any of the fields on the Edit Security Configuration page. This bug, which has now been resolved, will most likely only affect Confluence sites configured with a custom authenticator.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.8 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Updates and Fixes in this Release

### JIRA Issues (4 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🧠</td>
<td>CONF-21706</td>
<td>Add OpenOffice mime type for attachment file uploads.</td>
<td></td>
<td>🧠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🧠</td>
<td>CONF-21766</td>
<td>XSS vulnerability in the action links of Confluence's attachments lists.</td>
<td></td>
<td>🧠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🧠</td>
<td>CONF-21414</td>
<td>Space macro broken on instances with large number of spaces and some databases</td>
<td></td>
<td>🧠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🧠</td>
<td>CONF-21692</td>
<td>Security configuration cannot be updated using custom authenticator or password confirmation disabled</td>
<td></td>
<td>🧠 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Confluence 3.4.8 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.4.8. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.4 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 3.4.9 Release Notes
21 February 2011

Confluence 3.4.9 is a bug-fix release.

Don't have Confluence 3.4 yet?

Take a look at the new features and other highlights in the Confluence 3.4 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.4.9 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (7 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>
Confluence 3.4.9 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.4.9**. For details of the fixes in this release, please read the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - **Tip**: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.4, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the **Confluence 3.4 Upgrade Notes**.
   - If you are upgrading from 2.1 or earlier, please also read the **2.2 release notes**.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

**Confluence 3.4 Release Notes**

**12 October 2010**

With great pleasure, Atlassian presents Confluence 3.4, with more ways to **extend** your wiki, **manage** your plugins and **go places quickly**.

**Highlights of this Release:**

- **New Keyboard Shortcuts, Mac-Friendly Too**
- **Keyboard Shortcut Dialog**
- **User Macros in Macro Browser and Autocomplete**
- **New Plugin Manager**
- **Improved Performance**
- **Other Improvements**
- **Infrastructure Changes**

More:

- Read the release notices for important information about this release.
- See the full list of issues resolved in this release.

**Responding to your Feedback:**

- Over 180 votes satisfied.
- Thank you for all your issues and votes. Keep logging issues to help us keep improving!

**Video of What's New:**

**Highlights of Confluence 3.4**
New Keyboard Shortcuts, Mac-Friendly Too

Confluence has a number of new keyboard shortcuts to aid both navigation and editing. If you are already using JIRA 4.1, you will notice that we have made an effort to be as consistent as possible. Confluence shortcuts now support the standard Mac 'Cmd' key.

Some examples of shortcuts to use when viewing a page or blog post:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Create a child page.</td>
</tr>
<tr>
<td>b</td>
<td>Create a blog post.</td>
</tr>
<tr>
<td>m</td>
<td>Comment on a page or a blog post.</td>
</tr>
<tr>
<td>e</td>
<td>Open the editor.</td>
</tr>
</tbody>
</table>

Try these from within the Rich Text Editor:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+s or C Cmd+s</td>
<td>Save the page.</td>
</tr>
<tr>
<td>Ctrl+Alt+7 or C Cmd+Alt+7</td>
<td>Apply the default paragraph style.</td>
</tr>
</tbody>
</table>

Read more about [keyboard shortcuts](#).

Keyboard Shortcut Dialog

Confluence has many useful keyboard shortcuts. Now it's easy to discover them. Select 'Keyboard Shortcuts' from the 'Browse' menu or just press '?' on your keyboard. The new keyboard shortcut dialog shows shortcut keys for the editor as well as for general use.
User Macros in Macro Browser and Autocomplete

Looking for a macro to add to your page?

- **User macros easy to find.** User macros are short pieces of code that perform an often-used function or add some custom formatting to a page. You can now choose which of your user macros are visible to everyone in the macro browser and autocomplete.

- **New options for writing user macros.** It’s easy to create a user macro. Just go to the Confluence Administration Console and enter the details. Confluence 3.4 offers new options for making your macro look good in the macro browser. Read all about writing user macros. You can specify the macro category, link to an icon, define the parameters that the macro browser will use to prompt the user for information, and more.

- **Working examples of user macros.** To help you get started, we have documented the Expand and Stat us user macros. These are working examples that you can add to your Confluence site.

Here is an example of a user macro, the Expand macro, appearing in the autocomplete dropdown:

```
{ expand
```

It looks like this in the macro browser:
### New Plugin Manager

Managing plugins and performing Confluence upgrades is now much easier with the brand new plugin manager. The Universal Plugin Manager (UPM) is now bundled with Confluence and will soon make its way into our other tools, including JIRA. With the UPM you can:

- Perform a plugin compatibility check before upgrading Confluence.
- Install new plugins from the Atlassian Plugin Exchange.
- Manage existing plugins.
- With just one click, upgrade all plugins that have updates available.
- View and track updates via the audit log.

### Confluence Upgrade Check

The Universal Plugin Manager allows you to view, manage and upgrade your installed plugins, as well as install new ones from the Atlassian Plugin Exchange.

The Plugin Exchange Manager can help you prepare for a Confluence upgrade. Choose one of the newer versions of Confluence below and click the "Check" button. The Plugin Exchange Manager will examine the compatibility of the plugins you have installed and let you know the steps you should perform to ensure Confluence and all the plugins you have installed are upgraded successfully.

**Check compatibility for:** 3.2.1  

**Incompatible**

These plugins have not yet been marked as compatible with Confluence 3.2.1. We recommend you perform your own testing or contact the plugins' authors before proceeding with the product upgrade.

**Compatible if upgraded**

These plugins have updates that are compatible with Confluence 3.2.1. To proceed with your product upgrade, you should first upgrade each of these plugins now.

See the documentation on managing plugins. Discover, download and install new plugins from the Atlassian Plugin Exchange without leaving Confluence.
Improved Performance

Confluence is faster in a couple of ways.

- **Loading of the dashboard.** If your Confluence site has a large number of spaces, you may notice that the dashboard now loads much faster. For details, see issue CONF-5446.
- **Daily email updates.** The performance of the job that sends the daily email updates has been improved significantly. The job may run up to 100 times faster depending on your configuration. For details, see issue CONF-13875.

Other Improvements

We have made a number of small improvements to Confluence screens and other functionality described below.

- **Space permissions.** A new dropdown menu on the space permissions screen enables you to select or deselect all the permission types at once.

![Permission dropdown menu](image)

- **Dashboard 'Recently Updated' section.** The list of recent updates on the dashboard now tells you what action the user performed (for example, created, updated or commented) and has a timestamp for each activity.

- **Permissions for PDF stylesheets.** Space administrators can now edit the PDF stylesheets and layouts. Previously, you had to be a system administrator to have access to these options in the space administration screen.

- **Space details and space exports.** The space details screen has a new, fresh look. Similarly, we have redesigned the screen for PDF, HTML and XML exports.

- **Database Support.** We have added support for the following database servers:
  - Microsoft SQL Server 2008.
  - PostgreSQL 8.4.
  
  See the page about supported platforms.

- **Improved security for users.** This release brings an improved workflow for resetting your password. Confluence now requires an additional confirmation check before allowing a password change. We have also tightened the security of the 'remember me' functionality. As an additional security measure, Confluence will prompt you for your password when you change your email address.
Infrastructure Changes

Plugin developers will find some improvements in this release too.

- **Atlassian User Interface (AUI).** We have upgraded to AUI 3.2, bringing jQuery live events and redesigned drop shadows. See [AUI 3.1 Release Notes](#) and [AUI 3.2 Release Notes](#).

- **Plugin Framework.** Now with the Atlassian Plugin Framework 2.6, you have easy access to plugin objects, the plugin module tracker, ChainingClassLoader and more. See [Plugin Framework 2.6 Release Notes](#). Confluence now also bundles the [Web Resource Transformer plugin module](#).

- **Shared Access Layer.** SAL 2.2 includes support for secure administrator sessions ('WebSudo') and a cross-application API for accessing user profiles. See [Shared Access Layer 2.2 Release Notes](#).

- **REST plugin module.** We have upgraded from version 2.0 to version 2.2 of the Atlassian REST Plugin. Now you have more reliable detection of automatic logout, the ability to include JSON examples in your documentation, and support for secure administrator sessions ('WebSudo'). See [REST Plugin 2.1 Release Notes](#) and [REST Plugin 2.2 Release Notes](#).

- **Atlassian Plugin Development Platform.** With Confluence 3.4 comes the first public announcement of the [Atlassian Plugin Development Platform](#). Using Atlassian's plugin development tools, developers can create plugins that extend the functionality of Atlassian applications such as JIRA, Confluence and others. The Atlassian Plugin Development Platform defines the set of tools a plugin developer can use. See [Plugin Development Platform 2.8 Release Notes](#).

Release Notices

- **Security advisory.** This release fixes some security flaws. Please refer to the [security advisory](#) for details of the security vulnerabilities, risk assessment and mitigation strategies.

- **Upgrading from a previous version of Confluence.** Upgrading Confluence should be fairly straightforward. We strongly recommend that you back up your Confluence Home directory and your database before upgrading. Please refer to the [Confluence 3.4 upgrade notes](#) for further essential information about plugins and other factors affecting your upgrade.

- **Known Issues.** We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release and report any problems so that we can fix them quickly. We value this feedback, which means that we can tell you about any minor known issues in Confluence 3.4. Please check the [important technical advisories](#) on the front page of the Knowledge Base.

    A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

The Confluence 3.4 Team

Development

- Bugfixing and Maintenance
  - Anna Dominguez
  - Joseph Clark
  - Don Willis
  - Craig Petchell
  - Niraj Bhawnani

Engine Room & Security

- Stefan Saasen
- Daniel Kjellin
Anatoli Kazatchkov
Richard Atkins

Editor Improvements
David Taylor
Jared Wyles
Matthew Erickson
Brian Nguyen

Small Improvements
Edith Tom

Plugin Updates
David Chui

Special Projects (not shipping in this release)
Agnes Ro
Alan Davis
Ben Buchanan
Charles Miller
Chris Kiehl
David Loeng
Matt Ryall
Paul Curren
Ryan Thomas

Team Lead
Jonathan Gilbert

Support

Amsterdam
Ajay Sridhar
Sherali Karimov
Tony Atkins

Brazil
Alyson Reis
Guilherme Heck
Hugo Vares Vieira
Jean Fabricius Bondan
Luzia Mendes
Marco Roman
Rodrigo Adami
Rafael Pereira de Sousa

Kuala Lumpur
Azwandi Mohd Aris
Heng Hwa
Henry CL Tiong
Husein Alatas
Joachim Ooi
Sashidaran Jayaraman
Zed Yap

San Francisco
Confluence 3.4 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.4. For details of the new features and improvements in this release, please read the Confluence 3.4 release notes.

On this page:

- Upgrade Notes
  - Visibility of User Macros in the Macro Browser
  - Crowd 2.0.7 Upgrade Required if your Confluence is Integrated with Crowd
  - Configuration Option for Disabling Password Confirmation (Useful if Using a Custom Authenticator)
  - Existing 'Remember Me' Cookies No Longer Valid
  - End of Support for Oracle 10g and Safari 3 and 3.1
  - Advance Notice of End of Support for PostgreSQL 8.1 and Firefox 3.0
  - Clickr Theme and Left Navigation Theme No Longer Bundled with Confluence
  - Plugin Repository Macros No Longer Work
  - Wiki Markup in Space Description No Longer Rendered
Upgrade Notes

Visibility of User Macros in the Macro Browser

As stated in the release notes, the Confluence Macro Browser and autocomplete can now show user macros as well as other macros. If your Confluence site already has some user macros, when you upgrade to Confluence 3.4 the upgrade task will set all existing user macros to be visible only to system administrators.

After upgrading, you will need to set each macro individually to be visible to all users, depending on your requirements. See the documentation on writing user macros.

Crowd 2.0.7 Upgrade Required if your Confluence is Integrated with Crowd

If your Confluence installation is integrated with Atlassian Crowd for user management and single sign-on, you will need to upgrade to Crowd 2.0.7 when upgrading to Confluence 3.4. Note also that for Confluence 3.4, there is a new Seraph authenticator to be specified in the CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml file.

```xml
<authenticator
class="com.atlassian.crowd.integration.seraph.v22.ConfluenceAuthenticator"/>
```

Please follow the Crowd integration guide for complete instructions, including the update to the Seraph authenticator configuration. See our knowledge base article for symptoms of the problem that occurs if Crowd is not upgraded. And here are the Crowd 2.0.7 release notes.

Configuration Option for Disabling Password Confirmation (Useful if Using a Custom Authenticator)

This section is relevant to Confluence installations that use a custom authentication mechanism. You may run into problems with the Confluence security measure that requires password confirmation for administrative actions, change of email address and actions.

If necessary, you can set the password.confirmation.disabled system property to disable the password confirmation functionality. See Recognised System Properties. We provide this configuration option as a workaround for issue CONF-20958.

Existing 'Remember Me' Cookies No Longer Valid

We have tightened the security of Confluence's 'remember me' functionality. As a result of this change, any existing 'remember me' cookies will be invalid after you upgrade your Confluence installation. When accessing Confluence for the first time after the upgrade, users will be prompted to log in as usual.

End of Support for Oracle 10g and Safari 3 and 3.1

As previously announced, we no longer offer support for:

- Oracle 10g from this release onwards.
- Safari 3 and 3.1 from this release onwards.

Please see End of Support Announcements for Confluence.

Advance Notice of End of Support for PostgreSQL 8.1 and Firefox 3.0

We are planning on ending support for:
Confluence 3.2 introduced two new themes, the Documentation theme and the Easy Reader theme. At the same time, we announced the deprecation of the following two themes:

<table>
<thead>
<tr>
<th>Deprecated Theme</th>
<th>Description</th>
<th>Suggested Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clickr theme</td>
<td>This theme was inspired by the Flickr user interface, with Confluence content centred on the page.</td>
<td>Easy Reader theme</td>
</tr>
<tr>
<td>Left Navigation theme</td>
<td>This theme provided a navigation bar on the left hand side of the screen.</td>
<td>Documentation theme</td>
</tr>
</tbody>
</table>

Please note the following:

- The Clickr theme and Left Navigation theme are no longer bundled with Confluence and are not supported from Confluence 3.4 onwards.
- When you upgrade your Confluence installation to Confluence 3.4, the upgrade process will automatically migrate your spaces to the following themes:
  - Spaces using the Left Navigation theme will be converted to the Documentation theme.
  - Spaces using the Clickr theme will be converted to the Easy Reader theme.
- If you do not wish your spaces to be migrated, you can start Confluence with the following JVM parameter to prevent the conversion of the space themes:

```
-Dconfluence.theme.skip.migration=true
```

During the upgrade, the Left Navigation and Clickr themes will be removed from your Confluence site but, if you specify the above parameter, your spaces will still expect to use those themes. After the upgrade, you will need to download and install the Left Navigation and Clickr themes from the Atlassian Plugin Exchange so that your spaces can continue to use them. If you do not reinstall those themes, the affected spaces will use the default theme.

- If the upgrade process converts your spaces to the new themes and you later decide to revert to the old themes, you can get some help from the Confluence logs written during the upgrade process. The logs contain a SQL query that you can run to revert the theme migration. The relevant part of the log file looks like this:
The words '-SPACE-KEY1', 'SPACE-KEY2', etc represent the keys of the spaces that were converted. If you run the SQL statements and install the Left Navigation and Clickr themes (see below), your spaces will be in the same state as before the upgrade task ran.

- If you restore a space from an XML backup at some time after upgrading to Confluence 3.4, the space will not be migrated to a new theme. You will need to apply a different theme manually. See Applying a Theme to a Space. Alternatively, you can download and install the Left Navigation and Clickr themes from the Atlassian Plugin Exchange if you wish to continue to use them.

### Plugin Repository Macros No Longer Work

Some macros were never intended for external use, and we have always recommended that you do not add them to a wiki page. Nevertheless, it is possible that some Confluence sites have these macros on some pages. Please note that these macros no longer work in Confluence 3.4 onwards. They were part of the Plugin Repository, which we have now replaced with a new plugin manager.

These macros no longer work:

- {repository-plugin}
- {recentlyupdated-plugins}
- {popular-plugins}
- {download-stat}
- {confluence-status}
- {plugin-status}
- {plugin-repository}
- {plugins-supported}

### Wiki Markup in Space Description No Longer Rendered

Please note that the space description no longer renders wiki markup. If your space descriptions include wiki markup, the markup will display as plain text.

### Upgrade Procedure
Upgrade a test environment first
As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.3.x, then please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.) Also:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.
4. Follow the instructions in the upgrade guide.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- Check for known issues. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- Did you encounter a problem during the Confluence upgrade? Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

Useful Plugins

**Before installing a plugin into your Confluence site, please check the plugin's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.**

- Appfire's Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

RELATED TOPICS

Confluence 3.4 Release Notes

Issues Resolved in Confluence 3.4

Below are the issues resolved in Confluence 3.4, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 3.4 release notes for the new features in Confluence 3.4.
## JIRA Issues (103 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚀</td>
<td>CONF-2294</td>
<td>User macros should self-document similar to Java macros</td>
<td>Resolved</td>
<td>Fixed</td>
<td>31</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-16876</td>
<td>“Expected ‘xref’ at start of table” when rendering PDF file version 1.4 and later in viewfile macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>27</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-12571</td>
<td>JIRA Issue Macro displays too wide, doesn’t auto-scroll properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>24</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-16655</td>
<td>Display user macros in the macro browser</td>
<td>Resolved</td>
<td>Fixed</td>
<td>16</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-16525</td>
<td>Errors indexing PDF documents</td>
<td>Resolved</td>
<td>Fixed</td>
<td>16</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-3322</td>
<td>Userlist online and offline status broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>16</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-20318</td>
<td>NetworkAndSite NotificationType UpgradeTask fails when upgrading to 3.3 on Oracle (and probably others)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-18892</td>
<td>Office Connector Freezes Confluence When Loading Excel 2007 File With Date Macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-16383</td>
<td>Dynamic Tasklist V2 fails in IE7</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-20496</td>
<td>Can’t uncheck Macro has a body in the user macro screen</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-20398</td>
<td>French translations for some of Rich Text Editor’s features are not reflected</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
</tr>
<tr>
<td>🚀</td>
<td>CONF-20765</td>
<td>Page gadget</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-16067</td>
<td>Restore fails with &quot;Too many open files&quot; error</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13875</td>
<td>Confluence Daily Mail Notification eats up CPU performance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9818</td>
<td>&quot;Forgot password&quot; function allows easy misuse</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7825</td>
<td>Create a Notation Guide section for User Macros</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20958</td>
<td>Confluence features that require password confirmation (websudo, captcha) do not work with custom authentication</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20633</td>
<td>Spaces cannot be unmarked as favourites</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19313</td>
<td>Cannot execute Tools -&gt; Restrictions from Personal Spaces of users with whitespace in their user name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18430</td>
<td>Usernames with spaces do not work with page restriction auto-complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17414</td>
<td>Doc Import allows empty title</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15594</td>
<td>Hover Profile and People Directory look rubbish when the Profile macro has been disabled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resolved Fixed 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conf Number</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------</td>
<td>--------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13082</td>
<td>Database Connection Transaction Isolation level is not displaying at all and the Database Driver Version for jtds-1.2.2.jar is incorrect in System Information page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-11475</td>
<td>Combine Left nav theme with default 2.8.0 looks</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-5446</td>
<td>Lots of spaces, particularly new or favourite spaces (&gt; 100) causes dashboard to be slow</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20288</td>
<td>Web Sudo: &quot;Drop access&quot; link does not work when language is set to german</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19285</td>
<td>[Doc import] Importing document of size bigger than attachment limit yields &quot;Page Not Found&quot; error</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19118</td>
<td>Keyboard Shortcuts Dialog</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14619</td>
<td>Gmail-like hotkeys for Confluence</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9077</td>
<td>Update Confluence Installation Guide - Support SQL Server 2005</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7075</td>
<td>Provide Keyboard Shortcut for adding a new page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-24022</td>
<td>Confluence</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20715</td>
<td>User link hovering does not work in the recent changes macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20400</td>
<td>Restoring a XML site backup into 3.3 fails with &quot;No enum const class...&quot; exception</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20339</td>
<td>Edit in &quot;Page&quot; word feature causes nullpointer exception.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20298</td>
<td>NullPointException error logged by scheduled office connector cleanup job at 02:00</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20274</td>
<td>Make real request and response objects available during Word export</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20060</td>
<td>Embed User Macros in Macro Autocomplete</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-19169</td>
<td>Word footnotes import in Doc Import is broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-6840</td>
<td>Override browser keyboard shortcuts to act like a desktop app (ex: Ctrl-S should save page on Windows)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-23149</td>
<td>contentbylabel macro does not sort ASCII characters properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-21455</td>
<td>Implement/configure HTTP only session cookies.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21157</td>
<td>Recently-Updated macro does not show user information when added to a page in Confluence 3.3 and 3.3.3</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21046</td>
<td>Upgrade to Confluence 3.4 throws NoSuchMethodError when using Crowd SSO</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21000</td>
<td>a link in the admin screen to the knowledge base regarding theServer Base Url change returns no result</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20991</td>
<td>The modification detection (Modz detector) is not working.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20964</td>
<td>XSS vulnerability in Tasklist macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20963</td>
<td>XSS vulnerability in Office Connector</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20898</td>
<td>Gadgets Malformed Security Token</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20831</td>
<td>IE8 and IE7 crash if you click Add Page and Add Blog too fast multiple times</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20793</td>
<td>Confluence logs a ClassCastException Tomcat 6.0.27 or later when accessing Oracle.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20740</td>
<td>XSS vulnerability in Confluence Space Names</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20738</td>
<td>Ziputility adds files with wrong</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue Number</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Count</td>
</tr>
<tr>
<td>-----</td>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>1</td>
<td>CONF-20726</td>
<td>Unable to search for word that is followed by a number for filenames separated by underscores</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>CONF-20683</td>
<td>Default Theme: Breadcrumbs hidden in IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>CONF-20616</td>
<td>Edit in Word does not work when a custom authenticator is configured</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>CONF-20575</td>
<td>Update Jira Macros Plugin to version 2.8.20. 2 issues fixed in this update</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>CONF-20526</td>
<td>Doc Theme is incompatible with Page Restrictions</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>CONF-20508</td>
<td>Secure Administrator Sessions feature can be bypassed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>CONF-20487</td>
<td>Did You Mean option not retained in 3.3</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>CONF-20483</td>
<td>Add new component for OSGi plugins to get the active Hibernate session</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>CONF-20424</td>
<td>Add warning in Mail Archive that adding mail account will delete email even for IMAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>CONF-20348</td>
<td>Reformat <a href="http://confluence.atlassian.com/display/DOC/Adding+SSL+for+Secure+Logins+and+Page+Security">http://confluence.atlassian.com/display/DOC/Adding+SSL+for+Secure+Logins+and+Page+Security</a></td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Key</td>
<td>ID</td>
<td>Description</td>
<td>Status</td>
<td>Method</td>
<td>Date</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20338</td>
<td>Upgrade Dashboard Macros plugin to 1.14</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20321</td>
<td>EmbeddedCrowd migration does not create directories in the correct order</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20311</td>
<td>Best Practice Code revisions</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20302</td>
<td>EmbeddedCrowd migration does not merge user and group DNs correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20301</td>
<td>ObjectQueue handles is not synchronized causing: ConcurrentModificationException</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20275</td>
<td>Setup footer contains the &quot;print-only&quot; message</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20266</td>
<td>Logging from plugin framework does not get sent to log file, instead goes to standard error with unusual format</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20264</td>
<td>Performance improvement: Lazy evaluation of Velocity context</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20255</td>
<td>Space details form improvements and minor changes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20218</td>
<td>TinyMceInsertMenuTest fails across builds</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20200</td>
<td>Macro Browser doesn't handle browser zooming well</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![icon]</td>
<td>CONF-20189</td>
<td>Logout Button /</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Details</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20181</td>
<td>Option Missing for some LDAP user accounts</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20068</td>
<td>Headings in Page Gadgets scroll sideways with the page</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20040</td>
<td>Widget Connector does not render all of Wufoo widget</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20021</td>
<td>Apostrophes are double escaped in the Page Gadget title</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19932</td>
<td>Confluence page gadget viewfile macro requires a refresh to re-size correctly</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19552</td>
<td>Remove group confirmation screen logs error when trying to display members</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19482</td>
<td>Restoring a personal space still gives user menu choice to create personal space causes collision of space keys</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19157</td>
<td>Graphs don't display properly when using sheet parameter in viewfile</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19060</td>
<td>Edit in Word function adds // for blank lines inside code and noformat macros, which are then visible in output</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18903</td>
<td>Why don't we make SQL</td>
<td>Resolved Fixed 0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Key</td>
<td>Issue Title</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-----</td>
<td>-------------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-18866</td>
<td>Upgrade standalone to use latest version of Tomcat 6.0.x</td>
<td>Default?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-18853</td>
<td>Doc Import stuck in loop when duplicate titles are included in the Word Document</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-17462</td>
<td>The Permission screen &quot;Cancel&quot;-button should be called &quot;Close&quot; until an actual change has been made</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-17231</td>
<td>Language pack related warning messages in logs when editing user preferences</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-17217</td>
<td>Left Navigation Theme does not include the &quot;Custom HTML : At end of the BODY&quot; in the output HTML</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-16686</td>
<td>Prevent administrators disabling macro plugins which are part of core application functionality</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-16490</td>
<td>Blog Posts macro - the Content Type parameter does not work as expected</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-16371</td>
<td>Keyboard shortcut for link to this page dialog</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolved</td>
<td>CONF-15122</td>
<td>Create a</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Resolution Count</td>
</tr>
<tr>
<td>-----</td>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>------------------</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-14667</td>
<td>In the RTE, Shortcut keys aren't intuitive for Mac users.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-14628</td>
<td>pages/create(blogpostpage).action with a spaceKey containing the null character causes org.springframework.dao.DataIntegrityViolationException</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-14515</td>
<td>Change the &quot;My&quot; Spaces tab on the dashboard to say &quot;Favourite&quot; and &quot;All&quot; to &quot;Global&quot;.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-13836</td>
<td>Plugin Repository's &quot;Installed Plugins&quot; filter shows non-installed plugins</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-13819</td>
<td>Compound database index missing for ATTACHMENTDATA table</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-12421</td>
<td>Don't use distributed cache for storing Captcha's in a cluster</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-7896</td>
<td>Reinstate original version of bundled plugin when an</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>
Confluence 3.5 Release Notes

16 March 2011

With great pleasure, Atlassian presents Confluence 3.5. Discover what's happening to your content and share with your colleagues. Let people see for themselves what's new after a Confluence upgrade. Get cosy with LDAP and intimate with JIRA. Love that HTML5 drag-and-drop and more!

Highlights of this Release:

- Easy, Powerful Connections to Active Directory, LDAP and Crowd
- Improved JIRA Integration
- Drag-and-Drop for HTML5 Browsers
- Autowatch and Improved Notification Settings
- Sharing Pages and Blog Posts
- Enhanced Code Macro
- More Administrative Improvements
- "What's New" Feature Tour
- Categories, a New Way of Organising Spaces
- Embedding Audio and Video with the Multimedia Macro
- Other Improvements
- Infrastructure Changes

More:

- Read the release notices for important information about this release.
- See the full list of issues resolved in this release.

Responding to your Feedback:

- More than 1,000 votes satisfied.
- Thank you for all your issues and votes. Keep logging issues to help us keep improving!

Video of What's New:

Previous Releases:

- Confluence 3.4
- Confluence 3.3
- Release Summaries

Highlights of Confluence 3.5
Easy, Powerful Connections to Active Directory, LDAP and Crowd

Connecting Confluence to an external user directory used to be painful, whether it was Active Directory, other LDAP servers or Atlassian Crowd. You had to edit XML files, and the configuration options were limited. Confluence 3.5 brings a simple, powerful and flexible directory management interface:

- Choose from a list of supported directory types, including Microsoft Active Directory and ten other popular LDAP schemas.
- Add as many directory servers as you need. Connect directory servers of different types, including the internal directory (default), LDAP, Crowd and/or JIRA.
- Configure all your LDAP settings via the Confluence Administration Console: Permissions, server and schema settings. We pre-populate the fields with default values depending on your choice of directory type. Choose the LDAP permissions to suit your needs: Read/write, read only, local groups or authentication only. Make use of the caching and copy-as-required configurations to optimise the performance of your LDAP searches. More...
- Turn on support for nested groups.
- Configure your LDAP connection pool.
- For larger and more complex installations, you may need to install Atlassian Crowd. If so, you will now enjoy the simple, quick setup via the Confluence and Crowd administration consoles. Clever synchronisation and caching ensure the best response times. More...
- Are your users already in JIRA? Confluence 3.5 offers a much improved integration with JIRA for user management. See below.

![Directory Management Interface]

Improved JIRA Integration

Integrating Confluence and JIRA has just become much easier. Watch a short overview video.

- Connect JIRA and Confluence via application links. It's now so much easier to set up a trust relationship between JIRA and Confluence, then share information across your applications. More...
• **Create, find and insert JIRA issues.** The new ‘Insert JIRA issue’ option in the editor toolbar offers a number of methods for displaying JIRA issues on a Confluence page or blog post. Insert individual issue within the text. Generate a list of issues using JIRA Query Language (JQL) or by specifying each issue individually on the page or blog post. You can also use this option to create an issue in JIRA and insert i within the text. [More...]

• **Connect to JIRA for user management.** JIRA 4.3 offers a powerful user management capability. JIRA now able to act as your directory manager, interacting with one or more user directories and ensuring that you have the same set of users and groups across both applications. Confluence 3.5 can connect direct to JIRA’s new directory management feature. Clever synchronisation and caching ensure the best response times for your directory searches. [More...]

---

Drag-and-Drop for HTML5 Browsers

Confluence’s drag-and-drop feature now supports HTML5 in preference to Google Gears. If your browser fully supports HTML5 and you no longer need the Google Gears browser add-on for anything else, you can uninstall this add-on without any loss of functionality in Confluence. The following browsers support HTML5-based drag-and-drop:

- Firefox 3.6
- Safari 5
- You can try it with Chrome too. (Official Chrome support coming soon!)
**Autowatch and Improved Notification Settings**

Confluence's new autowatch makes it easier than ever to keep track of pages and blog posts that interest you. Other improvements help you optimise your notifications. [Watch a short overview video.]

- **Watch your own content automatically.** With autowatch turned on, you will receive an email notification each time someone edits or comments on a page that you added or updated. You can turn autowatch on or off by editing the email settings in your user profile.
- **Adjust your settings directly from the email notification.** The notification email message has useful links to help you manage your notifications and watches.
- **Watch for new blog posts only.** If you have subscribed to all blog posts on the Confluence site, you will now receive notification for new blog posts only. Earlier versions of Confluence sent a notification for every change to existing blog posts, and for all comments on blog posts too. More...
- **Watch blog posts in a space.** Would you like to know when someone adds a blog post in a space, without having to see all other updates too? Now you can! More...
- **Configure the from address in email notifications.** Your Confluence administrator can configure the Confluence mail server so that the 'From' field of the email notification contains the full name or email address of the Confluence user who made the change. More...

---

**Sharing Pages and Blog Posts**

Want to email a Confluence page or blog post quickly? Simply visit that page or blog post, click the new 'Share' button and specify the people you want to share the page with. Add an optional note then click 'Share'. More...
Enhanced Code Macro

The code macro offers several new options.

- More language and environment support for syntax highlighting.
- Expandable code blocks.
- Wrap long lines of code into a new line.
- Sequential line numbering.
- Themed colour schemes.
- More...
More Administrative Improvements

- **Scheduled jobs.** Gone are the days of having to shut down your Confluence site to change a job's schedule! From the administration console you can execute jobs, configure job schedules, disable or re-enable jobs and view the execution history. More...

- **Log scanner and improved support request form.** The Support Tools plugin is now bundled with Confluence. It includes Hercules the Atlassian support bot, a superhero with extraordinary powers dedicated to protecting the public against known bugs. Hercules will scan your logs for error messages, matching them to existing bug reports and knowledge base articles. With the power of Hercules, you can find solutions in seconds. The plugin also provides a new, simple support request form with clear information about the details that will be sent to Atlassian when you submit a support request. More...
"What's New" Feature Tour

Managing change when rolling out a new software release can be a challenge. We've automated some of the work for you with the "What's New" feature tour in Confluence 3.5. The first time a user logs in after a major Confluence upgrade, the "What's New" window pops up showing screenshots, videos and links to documentation. We've designed this feature as a plugin, so you can change where the popup gets its information from or disable it altogether. More...

Categories, a New Way of Organising Spaces

Categorise your spaces then view and manage them in the new space directory. As an alternative to the dashboard, the space directory displays a list of all the global and personal spaces in the Confluence site that you have permission to see. You can choose to see all spaces, the spaces you have marked as favourite, or the spaces in a specific space category. (Space categories were previously known as 'team labels'.) You can further restrict the list to spaces containing a given word or words in the space name or description. More...
Embedding Audio and Video with the Multimedia Macro

Use the new Multimedia macro to display movies, videos and animations and embed audio files in a Confluence page. Before now, the only way to display multimedia content was using Wiki Markup. Now it’s simple – just drag and drop the multimedia file into the Rich Text Editor. Confluence will attach the file and add the Multimedia macro for you. Alternatively, add the Multimedia macro via autocomplete or the macro browser, and tell it which file to display.  

 Watch a short overview video. More...
Other Improvements

As always, we have made a number of small improvements to Confluence screens and functionality.

- **Keyboard shortcut and restricted search in the Documentation theme.** The Documentation theme offers a few new goodies for our technical documentation fans.
  - Press ‘[’ on your keyboard to show/hide the left-hand navigation bar.
  - Configure the Documentation theme to show quick search results from all spaces (default) or from the current space only. People can override this restriction when entering their search term.

- **Colour in panel titles.** The Panel macro has a new parameter, allowing you to choose the colour of the text in the title as well as the background colour.
• **Embedding blog posts into pages.** The Include Page macro now accepts blog posts as well as pages for embedding into other pages or blog posts.

• **Cool new avatars.** Take a look at the fresh design of the profile pictures that come standard with Confluence. Below are just a few of them. Of course, you can still upload your own picture too.

![Edit 'Panel' Macro](image)

- **Improved filtering on the Confluence dashboard.** The list of recent updates on the right of the dashboard now offers separate tabs, allowing you to view recent content updates from all spaces you have permission to see, your favourite spaces only, or spaces belonging to specific space categories. The list of spaces on the left is no longer tied to your list of recent content updates on the right. You can now use these dashboard features independently of one another.

- **Automatic language detection.** Flummoxed by a Confluence site in a foreign language? Confluence will now detect your language preference from your browser and offer you UI text and messages in that language. Alternatively, you can click the handy new option on the Confluence login screen to set your personal default language. Once you have logged in, Confluence will look at the language preference in your user profile too.
Infrastructure Changes

This release includes a number of improvements in the APIs and under the covers too.

- **Support for Safari 5.** We now offer support for Safari 5 in Confluence 3.5. See the [upgrade notes](#) for more information about browser support.

- **HTML5, character encoding and IE rendering.** Confluence's DOCTYPE declaration has been switched from 'HTML 4.01 Strict' to 'HTML5', which is automatically strict. In addition, 'X-UA-Compatible' is now explicitly set to 'EDGE', to ensure that Internet Explorer attempts to render the page in the latest standards mode. (If the browser is set to 'Compatibility View', that will override the 'X-UA-Compatible' setting.) Character encoding is now set at the document level, based on the encoding setting in the General Configuration section of the Confluence Administration Console.

- **Additions to the remote API.**
  - Trash management. Confluence's [RPC API](#) offers new space management methods (`getTrashContents`, `purgeFromTrash`, `emptyTrash`) and data objects (`ContentSummaries`, `ContentSummary`). These make purging trash across a large number of spaces much easier. You can list trash items for a given space, purge a given page, and purge all pages from a space's trash.
  - Watching and managing watchers. New notification methods in the remote API mimic the watch functionality exposed through the UI: `watchPage`, `watchSpace`, `watchPageForUser`, `getWatchersForPage`, `getWatchersForSpace`. You can watch a page, blog post or space, or add a watch on behalf of another user. You can check whether a user is watching a page or space, and return the watchers for a page or space.
  - Blog post retrieval. The new method `getBlogEntryByDateAndTitle` allows you to look up a blog post by specifying its date and title.

- **New WebDAV Resource plugin module.** Plugin developers can use the [WebDAV Resource module](#) to define new kinds of content that can be accessed remotely via the [Confluence WebDAV plugin](#). Expose your own custom entities over WebDAV, or expose existing Confluence content that is not currently accessible via WebDAV. This plugin module is available in Confluence 3.4 too, but we forgot to let you know about it until now.

- **Search engine upgraded.** We have upgraded from Lucene 2.2.0 to 2.9.3.

- **New version of the Atlassian User Interface.** Confluence 3.5 ships with AUI 3.3.1. See the [AUI 3.3 release notes](#).

Release Notices

- **Upgrading from a previous version of Confluence.** Upgrading Confluence should be fairly straightforward. [We strongly recommend that you back up your Confluence Home directory and your database before upgrading](#). Please refer to the [Confluence 3.5 upgrade notes](#) for further essential information about plugins and other factors affecting your upgrade.

- **Known issues.** We have an enthusiastic and dedicated group of testers and customers who jump in there, try out the new Confluence release and report any problems so that we can fix them quickly. We value this feedback, which means that we can tell you about any minor known issues in Confluence 3.5. Please check the [important technical advisories](#) on the front page of the Knowledge Base.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

The Confluence 3.5 Team
Development

**Bugfixing and Maintenance**
Ben Buchanan  
Don Willis  
Matthew Erickson  
Stefan Saasen

**Editor Improvements**
Agnes Ro  
Brian Nguyen  
Craig Petchell  
Daniel Kjellin  
Jared Wyles

**User Management**
Anna Dominguez  
David Taylor  
Matt Ryall  
Niraj Bhawnani  
Richard Atkins

**Small Improvements**
Edith Tom  
Jaiden Ashmore

**Plugin Updates**
David Chui  
Kai Fung Chong

**Build and Release Engineering**
Adrián Deccico

**Architecture**
Charles Miller

**Special Projects** (not shipping in this release)
Chris Darroch  
Chris Kiehl  
David Loeng  
Paul Curren  
Ryan Thomas

**Development Manager**
Jonathan Gilbert

**Support**

**Amsterdam**
Dennis Kromhout van der Meer  
Sherali Karimov  
Tony Atkins

**Brazil**
Alyson Reis  
Guilherme Heck  
Rodrigo Adami  
Tiago Kolling Comasseto
Kuala Lumpur
Heng Hwa Loi
Husein Alatas
Joachim Ooi
Kah Loun Foong
Sashidaran Jayaraman
Septa Cahyadiputra

San Francisco
Adam Laskowski
Brad Mallow
David Chan
Marian Finch
Rick Bal
Robert Chang
Timothy Wong
Ty Davis
Wayne Tombo

Sydney
Donna McGahan
Michael Seager
Partha Kamal
Renan Battaglin
Roy Hartono
Vincent Choy

Others

Design
Kevin Tham
Stephen Russell

Performance Engineering
George Barnett

New Code Macro
Alex Gorbachev, author of SyntaxHighlighter.
Jeroen Benckhuijsen

Product Management
Bill Arconati
Sherif Mansour

Product Marketing Management
Matthew Hodges
Ryan Anderson

Quality Assurance
Mark Hrynczak
Marlena Compton
Federico Silva Armas

Technical Writing
Andrew Lui
Giles Gaskell
Sarah Maddox

Integration Development
Confluence 3.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5. For details of the new features and improvements in this release, please read the Confluence 3.5 release notes.

On this page:

- Upgrade Notes
  - Autowatch Turned On by Default
  - New Profile Pictures
  - Team Labels (Now Called ‘Space Categories’) May Need Tidying Up
  - New Support Tools Plugin
  - Changes to User Management in Confluence
    - For Customers with Internally Managed Users
    - For Customers using LDAP for User Management
    - For Customers Using JIRA for User Management
    - For Customers Using Crowd for User Management and SSO
    - For Customers Using Custom Authenticators
    - For Customers Using Custom Directory Connectors
  - Trusted Apps and OAuth Superseded by Unified Application Links
  - Upgrade Task Will Reindex Confluence Automatically
  - Changes to Recognised System Properties
  - Connections to MySQL Databases
  - Deprecation of Functionality
    - Converting a Global Space to a Personal Space
    - The ‘Mail Page’ Feature
  - Notes about Supported Platforms and Libraries
    - End of Support for PostgreSQL 8.1, Firefox 3.0
    - Advance Notice of End of Support for MySQL 5.0, Firefox 3.5, Safari 4, Internet Explorer 7
    - Added Support for Safari 5
    - Lucene Upgraded – Some Methods Now Deprecated
    - Scriptaculous and Prototype JavaScript Libraries Removed
    - X11 Dependencies/Libraries No Longer Required

- Upgrade Procedure
- Checking for Other Known Issues and Troubleshooting the Confluence Upgrade
- Useful Plugins
Autowatch Turned On by Default

This release includes the new 'autowatch' feature, as described in the release notes. With autowatch turned on, you will receive an email notification each time someone edits or comments on a page that you added or updated.

Note that autowatch is enabled by default for all new and existing users on upgrade. We recommend that you let all Confluence users know that autowatch will be turned on for their usernames when you upgrade to Confluence 3.5. People can turn autowatch off by editing the email settings in their user profile.

New Profile Pictures

This release brings a fresh set of profile pictures. After you have upgraded to Confluence 3.5, the old set will no longer be available for selection. Users who have already chosen one of the old pictures will keep that picture. If they later choose a new picture or upload their own picture, they will not be able to go back to the old picture again.

Team Labels (Now Called 'Space Categories') May Need Tidying Up

In Confluence 3.5, we have changed the term 'team labels' to the more descriptive term 'space categories'. These are keywords that you can apply to spaces, in order to group logically-related spaces.

Confluence 3.5 also introduces a new space directory that displays a list of spaces and offers them grouped by space category.

If your Confluence site has a number of team labels (now called space categories) already applied to the spaces, you may want to tidy up the categories to optimise your space directory.

More information:

- The Confluence 3.5 release notes describe the new space directory.
- The documentation explains how to use space categories.

New Support Tools Plugin

As mentioned in the release notes, the Atlassian Support Tools plugin is now shipped with Confluence. If you installed the earlier version of the plugin, you will need to uninstall it before upgrading Confluence.

Changes to User Management in Confluence

The way Confluence stores, accesses and manages users and groups is completely different in Confluence 3.5. You will notice many improvements, as described in the release notes. When you upgrade to Confluence 3.5, the upgrade process will automatically migrate your data by doing the following:

- Copying the configuration data from the existing OSUser or Atlassian User XML files into the Confluence database.
- Migrating your user and group data into the new database tables. It will not destroy the old data. The old tables remain in the database.
- Migrating internal and external user preferences. So if an LDAP user has logged in to Confluence before, all the same preferences will be there on next login after upgrade.

The sections below describe the upgrade considerations for each supported configuration type.

For Customers with Internally Managed Users

If your Confluence installation currently manages its users and groups in the Confluence database then there are no actions required on upgrade. This applies to Confluence sites that are not connected to Crowd, JIRA, LDAP or a custom directory for user management.

For Customers using LDAP for User Management
If your Confluence currently uses the standard method of connecting to an LDAP server for authentication and user management then the upgrade process will migrate the configuration.

To ensure that the upgrade process can migrate your configuration, please follow the Confluence upgrade guide. In particular, make sure that you:

- Copy the following files from your old Confluence installation to your new Confluence installation:

  `<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml`
  `<Installation-Directory>/confluence/WEB-INF/classes/osuser.xml`

Please follow these steps after the upgrade is complete:

- Ensure that the LDAP connection is correctly configured. See Connecting to an LDAP Directory and Connecting to an Internal Directory with LDAP Authentication.
- Ensure that the directory order is set to match your environment and requirements. See Managing Multiple Directories.
- Enable nested groups, if required in your organisation. To understand the performance ramifications of this, see Managing Nested Groups.
- Note that people will need to wait until the automatic synchronisation task has copied their user and group information from the LDAP directory to the internal cache before they can log in. The synchronisation task will start automatically in the background when the directory is configured. If someone tries to log in to Confluence before the synchronisation task has finished, the user authentication will fail. See Synchronising Data from External Directories.

If you are using a legacy LDAP configuration (such as OSUser with LDAP authentication only), you'll need to reconfigure your LDAP support as covered on Connecting to an LDAP Directory and Connecting to an Internal Directory with LDAP Authentication. In case you encounter an issue, please refer to Upgrade to Confluence 3.5 with OSUser LDAP Authentication Fails for more details.

For Customers Using JIRA for User Management

If you are already using JIRA to manage your Confluence users, via the JDBC connection to the JIRA database, you must upgrade Confluence to version 3.5 before upgrading JIRA to version 4.3.

JIRA 4.3 has a significantly different database schema and exposes a new REST interface, which Confluence will depend on for continued JIRA user management. If you upgrade to JIRA 4.3 before upgrading to Confluence 3.5, your Confluence users will no longer be able to log in once you upgrade to Confluence 3.5.

Confluence 3.5 does not ship with an OSUser migrator, and it will not recognise the OSUser definition in your `atlassian-user.xml` file. When upgrading Confluence:

1. Do not copy the modified `atlassian-user.xml` and `osuser.xml` to your Confluence 3.5 installation directory.
2. Ensure that previous Confluence's `server.xml` file is copied to your Confluence 3.5 installation directory, in order to retain the JIRA datasource.
3. Upgrade to Confluence 3.5.

Please follow these steps after the upgrade is complete:

- Log in to Confluence 3.5.x using the administration username and password you used prior to configuring JIRA user management in Confluence. (Confluence is not yet configured to point to JIRA, so your JIRA credentials will not work.)
  - If you cannot remember or do not have a password which allows you to log in, reset the administrator's password in the database and restart Confluence to log in.
Ensure that the JIRA connection is correctly configured:
- If you plan to connect to JIRA 4.2 or earlier, set up the ‘Legacy JIRA Database Connector’. See [Connecting to JIRA 4.2 or Earlier for User Management](#).
- When you upgrade to JIRA 4.3 or later, set up the new JIRA server connection. See [Connecting to Crowd or JIRA for User Management](#).
- Ensure that the directory order is set to match your environment and requirements. See [Managing Multiple Directories](#).

**For Customers Using Crowd for User Management and SSO**

If you are using Confluence with Atlassian Crowd for user management and SSO:

- You will need to upgrade to Crowd 2.1 or later, before upgrading to Confluence 3.5. Earlier versions of Crowd are not compatible with Confluence 3.5. Confluence 3.4 and earlier will work with Crowd 2.1.
- Copy the following files from your old Confluence installation to your new Confluence installation:

```
<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml
```

- You no longer need to copy the Crowd integration JAR files into Confluence's `WEB-INF/lib/` directory.
- If you are using `com.atlassian.crowd.integration.seraph.v22.ConfluenceAuthenticator` for SSO (defined in `$CONFLUENCE$/WEB-INF/classes/seraph-config.xml), please use the newer version instead: `com.atlassian.confluence.user.ConfluenceCrowdSSOAuthenticator`. Specifically, change this:

```
<authenticator class="com.atlassian.crowd.integration.seraph.v22.ConfluenceAuthenticator"/>
```

to this

```
<authenticator class="com.atlassian.confluence.user.ConfluenceCrowdSSOAuthenticator"/>
```

- After the upgrade, you may notice a difference when first connecting Confluence to Crowd: People will need to wait until a synchronisation task has copied their user and group information from Crowd to the internal cache before they can log in. If someone tries to log in to Confluence before the synchronisation task has finished, the user authentication will fail.
- Ensure that the directory order is set to match your environment and requirements. See [Managing Multiple Directories](#).

See [Connecting to Crowd or JIRA for User Management](#).

**For Customers Using Custom Authenticators**

Custom authenticators, as defined in `seraph-config.xml`, are not affected and should work in the same way as in earlier versions of Confluence.
For Customers Using Custom Directory Connectors

Custom directory types are not possible and not supported in Confluence 3.5 and later. If you have custom providers defined in OSUser or in Atlassian-User, thus defining your own storage for users and groups, the upgrade procedure will prevent you from starting Confluence.

Please see if one of the following solutions will work for you:

- If you have written a custom provider to support an LDAP schema not natively supported by Confluence 3.4 or earlier, you may no longer need your custom directory connector. Please check the supported LDAP schemas to see if you can use the new LDAP connectors supplied with Confluence 3.5.
- If you have written a custom provider to support nested groups, you can now use the new directory connectors supplied with Confluence 3.5. See Managing Nested Groups.
- If you have written a custom provider to connect to your own database, please consider loading the data into Confluence via the database instead. You will then need to flush the relevant caches in the application.

If you need to keep the custom directory connection, please consider whether Atlassian Crowd meets your requirements. See the documentation on developing a custom directory connector for Crowd.

Trusted Apps and OAuth Superseded by Unified Application Links

Confluence 3.5 includes the Unified Applications Link (UAL) plugin which manages trust relationships. Authentication for trust relationships, such as Trusted Apps and OAuth, is now configured via Application Links in your administration console. When you first navigate to the Application Links screen, you will be prompted to upgrade your existing Trusted Apps and OAuth trust relationships to application links.

For instructions on how to upgrade your links, see Upgrading an Application Link.

Please note, there is a known issue with the upgrade dialog. This will affect you if you have set up two different types of authentication (e.g. Trusted Apps and OAuth) to the same remote server. The upgrade message displayed on your Application Links screen will prompt you to upgrade two application links. However, you actually only need to have one application link with two authentication types configured, i.e. upgrade one application link and then configure the missing authentication type on that upgraded link.

Upgrade Task Will Reindex Confluence Automatically

We have upgraded the Confluence search engine from Lucene 2.2.0 to 2.9.3. As a result, a reindex is highly recommended when you upgrade. The search will continue to work after upgrade even without a reindex, but you will see exceptions in the logs and reduced capabilities.

When you upgrade to Confluence 3.5, an upgrade task will run automatically to rebuild the index. During the rebuild task, the upgrade process will require three times the size of the index on disk in order to perform the upgrade task. This space will be freed up when the upgrade process has finished.

If you would prefer to rebuild your index later, you can pass the following argument to Confluence when starting up after the upgrade:

```
-Dconfluence.skip.reindex=true
```

The initial startup will show an error message from ConfluenceSearcherInitialisation in the logs, because the warming query is run before the upgrade task. This is not a problem.

Changes to Recognised System Properties

We have removed the following system property: confluence.import.use-legacy-importer. Specifying...
this property will no longer have any effect in Confluence. See Recognised System Properties. (See the Confluence 3.3 documentation for the behaviour in earlier versions of Confluence.)

Connections to MySQL Databases

If your Confluence installation is connected to a MySQL database, please ensure that this database uses the ‘READ-COMMITTED’ transaction isolation level. MySQL's default transaction isolation mode:

- will cause issues with missing LDAP and other remote directory user permissions.
- is no longer supported in Confluence 3.5.

See the last step of the MySQL server installation procedure for details.

Deprecation of Functionality

This section provides advanced warnings of features in Confluence 3.5 that will be deprecated in Confluence 4.0 (a future release of Confluence).

Converting a Global Space to a Personal Space

Confluence 4.0 will no longer support the ability to convert a global space to a personal space. Our research has shown that this feature is used very little. Hence, we have decided to remove this feature as part of our ongoing mission to simplify Confluence where possible.

The 'Mail Page' Feature

In Confluence 4.0, the 'Mail Page' plugin will no longer be bundled with Confluence. This means that the 'Mail Page' feature for e-mailing a page will not be available in Confluence (out of the box) and the Share button will be the recommended method for e-mailing pages to others.

Notes about Supported Platforms and Libraries

End of Support for PostgreSQL 8.1, Firefox 3.0

As previously announced, from this release onwards we no longer offer support for:

- PostgreSQL 8.1.
- Firefox 3.0.

Please see End of Support Announcements for Confluence.

Advance Notice of End of Support for MySQL 5.0, Firefox 3.5, Safari 4, Internet Explorer 7

We are planning to end support for the following database and browsers in Confluence 4.0:

- MySQL 5.0.
- Firefox 3.5.
- Safari 4.
- Internet Explorer 7 (IE7).

Please see End of Support Announcements for Confluence.

Added Support for Safari 5

We now offer support for:

- Safari 5 in Confluence 3.5.
Lucene Upgraded – Some Methods Now Deprecated

This section is of interest to plugin developers. As stated above, we have upgraded the Confluence search engine from Lucene 2.2.0 to 2.9.3. A number of Lucene methods are now deprecated. These methods will be listed when you compile your plugin. We recommend that you consult the Lucene documentation and replace these methods as soon as possible. They will no longer be available when Confluence upgrades to Lucene 3. This further upgrade is not yet scheduled, but we plan to do it sometime.

Scriptaculous and Prototype JavaScript Libraries Removed

jQuery is the supported JavaScript library for plugin developers.

We first announced the deprecation of other JavaScript libraries with Confluence 2.8. Please note that we have now removed the following libraries from Confluence:

- Prototype
- Scriptaculous

X11 Dependencies/Libraries No Longer Required

X11 dependencies/libraries on Unix-/Linux-based operating systems are no longer required by Confluence 3.5 or later. Hence, these libraries do not need to be installed for your Confluence 3.5 upgrade or when installing a new instance of Confluence 3.5 or later.

Upgrade Procedure

Upgrade a test environment first

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 3.4.x, then please read the Upgrade Notes Overview and the Upgrade Notes for each version of Confluence listed on that page. (There are hyperlinks to each one.) Also:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.x first, confirm the upgrade was successful, then upgrade again from version 2.7.x to the latest. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the upgrade guide.

Checking for Other Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- Check for known issues. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the
Knowledge Base and follow the instructions to solve the problem.

- Did you encounter a problem during the Confluence upgrade? Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

Useful Plugins

Before installing a plugin into your Confluence site, please check the plugin’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on plugin support.

- Appfire’s Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

RELATED TOPICS

Confluence 3.5 Release Notes

Issues Resolved in Confluence 3.5

Below are the issues resolved in Confluence 3.5, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. Please also take a look at the Confluence 3.5 release notes for the new features in Confluence 3.5.

**JIRA Issues** (179 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>CONF-17150</td>
<td>Support nested groups</td>
<td>Resolved</td>
<td>Fixed</td>
<td>317</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-6478</td>
<td>News watching</td>
<td>Resolved</td>
<td>Fixed</td>
<td>112</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-9993</td>
<td>Prevent multimedia attachments from autoplaying when embedded in a Confluence page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>52</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-1646</td>
<td>Support for More Languages via the (code) macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>50</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-6794</td>
<td>Add titleColor to panel macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>43</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-1747</td>
<td>Link to single JIRA issue macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>39</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-17366</td>
<td>ConfluenceGroupJoiningAuthenticator does not add users to confluence-users group, if they already have</td>
<td>Resolved</td>
<td>Fixed</td>
<td>37</td>
</tr>
<tr>
<td>#</td>
<td>Code</td>
<td>Description</td>
<td>Status</td>
<td>Type</td>
<td>Resolution</td>
</tr>
<tr>
<td>-----</td>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>37</td>
<td>CONF-10697</td>
<td>Code macro should wrap</td>
<td>Resolved</td>
<td>Fixed</td>
<td>37</td>
</tr>
<tr>
<td>34</td>
<td>CONF-21980</td>
<td>Support <code>memberOf</code> attribute on LDAP users for group membership</td>
<td>Resolved</td>
<td>Fixed</td>
<td>34</td>
</tr>
<tr>
<td>33</td>
<td>CONF-10654</td>
<td>The ability to translate local membership into external membership for initial LDAP integration</td>
<td>Resolved</td>
<td>Fixed</td>
<td>33</td>
</tr>
<tr>
<td>30</td>
<td>CONF-19508</td>
<td>Google Gears is no longer supported so we need to Migrate to HTML 5</td>
<td>Resolved</td>
<td>Fixed</td>
<td>30</td>
</tr>
<tr>
<td>29</td>
<td>CONF-6029</td>
<td>Automatically add LDAP users to <code>confluence-users</code> (or other database-stored group)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>29</td>
</tr>
<tr>
<td>28</td>
<td>CONF-14104</td>
<td>Deleting users from LDAP, does not remove their ‘Can-Use’ permission</td>
<td>Resolved</td>
<td>Fixed</td>
<td>28</td>
</tr>
<tr>
<td>27</td>
<td>CONF-12882</td>
<td>Allow users to create Jira issues from Confluence pages.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>27</td>
</tr>
<tr>
<td>17</td>
<td>CONF-11926</td>
<td>LDAP performance degrades the more LDAP groups a user belongs to</td>
<td>Resolved</td>
<td>Fixed</td>
<td>17</td>
</tr>
<tr>
<td>16</td>
<td>CONF-8925</td>
<td>Multiple LDAP User Lookups during Login</td>
<td>Resolved</td>
<td>Fixed</td>
<td>16</td>
</tr>
<tr>
<td>14</td>
<td>CONF-20811</td>
<td>Printing a Confluence page using the Documentation</td>
<td>Resolved</td>
<td>Fixed</td>
<td>14</td>
</tr>
<tr>
<td>Jira Number</td>
<td>Issue Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19431</td>
<td>Crowd+Confluence nested groups fail</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19039</td>
<td>Drag and drop upload doesn't work in Google Chrome</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14444</td>
<td>Default authors to watch the pages they author</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-6559</td>
<td>Sort LDAP groups and users alphabetically on administrative pages</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13420</td>
<td>LDAP users can be cached as non-existant / not permitted to login if the LDAP repository is not available</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9326</td>
<td>Code macro: Syntax-highlight C++ code</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-10557</td>
<td>LDAP queries are submitting too many bind / unbind requests to the LDAP server.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8441</td>
<td>Rich Text Editor messes up formatting of pages that use the (html) tag</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-733</td>
<td>Grouped/Classified spaces</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14484</td>
<td>Manipulation of Trash content via the Remote API</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-10785</td>
<td>Slow performance due to excessive calls to getUser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Key</td>
<td>Description</td>
<td>Status</td>
<td>Severity</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-6932</td>
<td>User interface for administering LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-16639</td>
<td>Officially provide support for postgresql 8.4 and 8.3</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-3593</td>
<td>Automatically watch pages I edit user preference</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-20475</td>
<td>Improve performance of DefaultSpacePermissionManager #hasPermission ViaGroups by reversing the way permissions are checked</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-9135</td>
<td>Searching for user with complete name in &quot;Full Name&quot; field doesn't work on LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-6560</td>
<td>Manage Groups lists groups from LDAP and Confluence in a meaningless way</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-18451</td>
<td>Offer support for POSIX Style LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-11207</td>
<td>Current Confluence version looks very ugly if a Helvetica font is installed</td>
<td>Closed</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-8675</td>
<td>Support for thousands of groups needs improvement</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-8404</td>
<td>Send email notification when new news item is released</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-21981</td>
<td>Group membership search breaks with Active Directory's automatic range limiting for large groups</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-20398</td>
<td>French translations for some of Rich Text Editor's features are not reflected</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-16198</td>
<td>Notify Feature</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-5365</td>
<td>Deactivate User link is not available in user profile</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-2459</td>
<td>Need to use NVARCHAR columns in SQL Server to support Unicode</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-21502</td>
<td>Users can log in with old and new password when using LDAP Integration</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-17991</td>
<td>Gadgets in the macro browser should always display their providers name/URL</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-16736</td>
<td>Long text is not wrapped in noformat and code macros inside a table</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-16144</td>
<td>Bundle new Code macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-12219</td>
<td>Implement paging for LDAP search requests</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-8477</td>
<td>Don't change my code, especially when it is within an (html) macro!</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-18723</td>
<td>Confluence failed with too many open files</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONF-17499</td>
<td>Diffs take too long to execute sometimes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td>---</td>
<td>------------</td>
<td>----------------------------------------</td>
<td>----------</td>
<td>-------</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>CONF-14864</td>
<td>LDAP Key should map automatically to ldap cache name</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-12131</td>
<td>Robust logging for SOAP and XML-RPC login requests</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-11739</td>
<td>Daily backup scheduler</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-6924</td>
<td>Allow users to change their password when using LDAP user management</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-5866</td>
<td>Create a method in the remote API which allows for watching a space or a page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-5307</td>
<td>Include page macro should be able to include blog posts/news, not just pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-3130</td>
<td>Thumbnailing of animated gifs is broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-2794</td>
<td>Support Bash script syntax highlighting in (code) macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>CONF-20712</td>
<td>Episodic Videos not working with widget connector</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>CONF-20489</td>
<td>Upgrades: Errors thrown by upgrade tasks should be reported to the end user, not ignored</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>CONF-20486</td>
<td>User Status updates have &quot;anonymous&quot; tags in</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>#</td>
<td>Ticket</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Fixversion</td>
</tr>
<tr>
<td>---</td>
<td>--------</td>
<td>-------------</td>
<td>--------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>1</td>
<td>CONF-20219</td>
<td>Fixversion column renders empty content if there are multiple Fix Version/s selected in JIRA</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>CONF-19286</td>
<td>Users of LDAP groups not shown</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>CONF-16875</td>
<td>Rename Doc Import to &quot;Import Word Doc&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>CONF-15812</td>
<td>Support python syntax highlighting in {code} macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>CONF-14853</td>
<td>IllegalTransactionStateException due to trying to rollback a transaction that has already been rolled back.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>CONF-14100</td>
<td>Adding &quot;copy to clipboard&quot; functionality into code macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>CONF-10301</td>
<td>LDAP authentication module does not iterate users/groups under CN-s</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>CONF-10002</td>
<td>Brackets in code leads to undefined pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>CONF-9116</td>
<td>Confluence LDAP (atlassian-user.xml) should support referral property</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>CONF-5305</td>
<td>Non-existent users in groups cause problems when using LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>CONF-5146</td>
<td>Links to an</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
</tr>
<tr>
<td>Ticket Number</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-3589</td>
<td>Configurable sender for notification emails</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-1294</td>
<td>Line numbering in code macro.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-21630</td>
<td>Lots of errors in server logs: Cannot generate thumbnail for SWF/PDF files</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-21138</td>
<td>List of attachments in Link Browser are not sorted</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20822</td>
<td>Add Support for Basic Unix Shell Scripting for 'code' Tag</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20812</td>
<td>jirai issues macro fails with confusing/invalid error message when trying to fetch restricted project</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-20586</td>
<td>Work around JIT compiler bug that causes OutOfMemory error</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-19515</td>
<td>Improve the queries used to fetch users via the Search Users screen to prevent Wiki threads from being blocked for long periods of time</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-18832</td>
<td>duplicate username in confluence and ldap causes confluence to read group membership from local user</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Conf-Number</td>
<td>Issue Description</td>
<td>Resolution Status</td>
<td>Fixed Status</td>
<td>Id Count</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-18347</td>
<td>Adding LDAP User to a large internal group (e.g., confluence-users) is slow</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-17001</td>
<td>Improve the ConfluenceGroupJoiningAuthenticator such that it only adds authenticated LDAP users to the confluence-users group</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-16737</td>
<td>Integrate 'automatically add users to confluence-users' as an option from the UI</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-14182</td>
<td>Code macro doesn't highlight &quot;order&quot; in SQL</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-12201</td>
<td>Race condition issue with DefaultHibernate User</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-9140</td>
<td>Simplify user management configuration by integrating it into Confluence administration area</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-8183</td>
<td>Distinguish between US and British English Language Pack</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-7590</td>
<td>Embedded Flash - cannot stop auto-play</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-7139</td>
<td>Group searches repeat the groupSearchFilter criteria</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-6903</td>
<td>Allow reactivation of deactivated users</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
</tr>
<tr>
<td>CONF-6631</td>
<td>Code macro doesn't correctly handle empty strings</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-5792</td>
<td>For watched page update notifications, set 'from' to user who did update.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-5463</td>
<td>Group filtering is case sensitive</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-5047</td>
<td>Images not working with templates</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-4816</td>
<td>Syntax highlighting in <code>{code:xml}</code> broken</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-3987</td>
<td>Support mail disable switches</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-3558</td>
<td>Reopening CONF-1324 about username with uppercase letters</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-1553</td>
<td>Better handling of java comments in code macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-814</td>
<td>Gate blog posts to mail address(es)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CONF-23149</td>
<td>contentbylabel macro does not sort ASCII characters properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22565</td>
<td>XSRF vulnerability in the Social Bookmarking plugin</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-22261</td>
<td>&quot;What's new in Confluence 3.5&quot; banner fails</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21939</td>
<td>In the search screen filtering for username first then add a search string generates an exception</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Vote</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>CONF-21930</td>
<td>Welcome message in dashboard is escaped</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21899</td>
<td>New Bookmark via the bookmarklet is not defaulting to my personal space</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21855</td>
<td>AD/Crowd authenticated administrators using Confluence-cont rolled password (not the AD one)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21832</td>
<td>Find a way of finding and purging all shadowed users from Confluence</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21823</td>
<td>PDF export can't export text inside code macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21807</td>
<td>UserInterfaceState.getDashboardTab() is removed in Confluence 3.5-beta1</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21791</td>
<td>Mac Evaluation installer: Log file in CONFLUENCE_HOME isn't created properly.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21754</td>
<td>Error when saving a page if parent page's title is changed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21724</td>
<td>404 on a missing resource /images/icons/view_16.png on the edit restrictions page</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21692</td>
<td>Security configuration cannot be updated using custom</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>Ticket</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Priority</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-------------</td>
<td>--------</td>
<td>------------</td>
<td>----------</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21682</td>
<td>Missing localization in the user settings</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21637</td>
<td>Wrong icons position while using space macro on IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21612</td>
<td>Log user who is executing RPC requests</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21516</td>
<td>Install &quot;Source-code Formatter&quot; Macro Plugin for C-Sharp</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21500</td>
<td>Index rebuild fails silently due to uncaught exceptions in the DefaultObjectQueueWorker</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21457</td>
<td>Behaviour of users with default profile pic varies between two implementations of ConfluenceUser Profile.getProfilePictureUri</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21439</td>
<td>Content must not be null error when uploading global logo</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21406</td>
<td>Improve client performance by enabling HTTP caching for i18n REST resources</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21376</td>
<td>AttachmentRendererSupport does lots of unnecessary work</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21350</td>
<td>Dropdown menu text colour is dark grey when using keyboard</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Issue</td>
<td>Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21342</td>
<td>Tooltips with more than 1 tip contain apple and windows commands</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21339</td>
<td>Breadcrumbs: Text in tooltip is messed up</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21323</td>
<td>Logging during rendering of items in an rss feed should say what item was being rendered</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21317</td>
<td>Demonstration space uses macros that are not included in a default install</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21258</td>
<td>Wrong error handling in FileSystemAttachmentDataDao.getDeleteErrorReason()</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21207</td>
<td>Disabling the global theme prevents users from logging in due to getThemeJsResources problem</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21195</td>
<td>The 'Choosing a database configuration' screen in set up has a broken link to <a href="http://localhost:8080/confluence/setup/null">http://localhost:8080/confluence/setup/null</a> in the 'embedded database' section.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21093</td>
<td>Make the TestNG report format more readable</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-21086</td>
<td>Confluence is including an old version of</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Title</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-21084</td>
<td>Plugin Administration Page link should point to UPM rather than legacy plugin manager</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21062</td>
<td>Sort caches by display name in cache config screen</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-21059</td>
<td>Date format in comments is misleading</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20914</td>
<td>Confluence user list shows duplicate 'native' and LDAP users with same username</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20886</td>
<td>Bookmarks macro gives a ClassCastException when used in a comment</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20804</td>
<td>&quot;Download All&quot; fails with &quot;Too many open files&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20734</td>
<td>Logging thread-local diagnostic context not cleared on Quartz threads</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20589</td>
<td>LDAP user details in LDAP group browser are incorrect if there is a mismatch on membership attribute DN and usernameAttribute</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-20452</td>
<td>Malformed labels always report</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Conf-ID</td>
<td>Issue Description</td>
<td>Resolution Status</td>
<td>Resolution Count</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-20214</td>
<td>Attaching an attachment directly after upload does not insert the link - in the link browser</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19688</td>
<td>Code macro inserts semi-colon</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19359</td>
<td>Configuring the time for daily backups is not possible through the GUI</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18375</td>
<td>When LDAP server is down, Confluence permission breaks</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18073</td>
<td>Cache result of isSuperUser check in permission handling</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17861</td>
<td>Wrong german translation in edit window: &quot;unter&quot; --&gt; &quot;um&quot;</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17774</td>
<td>Concurrent not synchronized access to hashmap in OgnlUtil class leads to infinite loop and high cpu</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17525</td>
<td>Powerpoint icon does not show up in the macro browser - but Word and Excel do</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17511</td>
<td>Bundled plugin loading mechanism leads to larger than necessary memory use</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17291</td>
<td>Emails from a watched page do not show diff</td>
<td>Resolved</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Title</td>
<td>Description</td>
<td>Resolution Status</td>
<td>Priority</td>
<td>Resolution Count</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td>CONF-16986</td>
<td>Wiki markup content is deleted when editing/saving an unsupported thumbnail format</td>
<td>Wiki markup content is deleted when editing/saving an unsupported thumbnail format</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-16201</td>
<td>Confluence 'allows' to delete a user from an LDAP group</td>
<td>Confluence 'allows' to delete a user from an LDAP group</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14921</td>
<td>(code)-formatted text nearly unreadable</td>
<td>(code)-formatted text nearly unreadable</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-14880</td>
<td>Unable to add user to LDAP group</td>
<td>Unable to add user to LDAP group</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-13284</td>
<td>Formatting lost with (code) element</td>
<td>Formatting lost with (code) element</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-13189</td>
<td>Strange group behaviour when user is member of groups Confluence cannot see</td>
<td>Strange group behaviour when user is member of groups Confluence cannot see</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-10948</td>
<td>Want to be able to list recently joined users, to identify when they joined</td>
<td>Want to be able to list recently joined users, to identify when they joined</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-10430</td>
<td>LDAP Integration on flat domains</td>
<td>LDAP Integration on flat domains</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-9483</td>
<td>error saving document in the Rich Text editor</td>
<td>error saving document in the Rich Text editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-8905</td>
<td>Need a method to &quot;Select All&quot; or &quot;Select None&quot; for multiple check boxes</td>
<td>Need a method to &quot;Select All&quot; or &quot;Select None&quot; for multiple check boxes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-8596</td>
<td>(toc) macro not working with double byte symbols in headings</td>
<td>(toc) macro not working with double byte symbols in headings</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-8262</td>
<td>Put a direct &quot;unwatch this</td>
<td>Put a direct &quot;unwatch this</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>Icon</td>
<td>Issue ID</td>
<td>Summary</td>
<td>Resolution</td>
<td>Status</td>
<td>Count</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-8174</td>
<td>On Firefox, Confluence table (using standard wiki markup) does not format column width when column contains <code>@code</code> macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-7199</td>
<td>Confluence should fall back to displaying username when no defined name attributes are available in LDAP</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-6802</td>
<td>Ability to use the e-mail address from the LDAP server (possibly imported when logging in?)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-6682</td>
<td>Username links exported wrong in HTML</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-6584</td>
<td>Individual user can be added as &quot;user group&quot; under &quot;permissioning&quot;</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-6290</td>
<td>Bucket's DefaultUserAccessor has dodgy error handling</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-5502</td>
<td>Browse groups throws ClassCastException if there are LDAP groups that have the same name as Confluence groups</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-5330</td>
<td>Auto-save links &quot;resume editing&quot; and &quot;discard&quot; do not work on copied pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td><img src="https://example.com/icon.png" alt="icon" /></td>
<td>CONF-5229</td>
<td>'Copy Page'</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>
### Confluence 3.5.1 Release Notes

**1 April 2011**

Confluence 3.5.1 is a bug-fix release. It includes fixes for LDAP and user management, with several improvements for customers upgrading from versions earlier than Confluence 3.5.

### Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

[Download Latest Version](#)

### Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.1 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

### Updates and Fixes in this Release

**JIRA Issues** (24 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-22314</td>
<td>Membership sync with LDAP can run twice in</td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>Issue</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22103</td>
<td>Validate upgrades before making any changes</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22090</td>
<td>Provide option to manually migrate LDAP-local group memberships if there is no atlassian-user.xml during upgrade to 3.5</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22047</td>
<td>Make user management upgrade errors meaningful</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22008</td>
<td>Support for anonymous bind to LDAP user management</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21371</td>
<td>Page move fails with deep page hierarchy</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21820</td>
<td>LDAP migration fails to set appropriate page limit for queries</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-19914</td>
<td>Removing a page permission triggers a page delete operation</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22085</td>
<td>When upgrading plugins that provide plugin points, the clients don't come up properly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21972</td>
<td>Nested Groups should not be given as an option for the Confluence Internal Directory</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-21955</td>
<td>JIRA user directory configuration page has incorrect title</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-17582</td>
<td>Missing</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| CONF-11507 | Syntax Error in build.xml  
Resolved  
Fixed |
| CONF-5729 | getUsersWithConfluenceAccess() is very slow  
Resolved  
Fixed |
| CONF-22029 | The What's New popup doesn't appear by default  
Resolved  
Fixed |
| CONF-22010 | Can't install plugin in Confluence with PostgreSQL 9.0  
Resolved  
Fixed |
| CONF-21998 | Re-add backup tip linking to schedule admin, as it could not be included in 3.5 as messages had been translated.  
Resolved  
Fixed |
| CONF-21993 | Schedule Admin error pages aren't fully i18n'd  
Resolved  
Fixed |
| CONF-21975 | Upgrade UAL to 3.3  
Resolved  
Duplicate |
| CONF-21967 | Confluence macro browser does not allow you to hide macros from macro autocomplete  
Resolved  
Fixed |
| CONF-21831 | Duplicate LDAP user gets counted towards the license even when they do not have a can use permission  
Resolved  
Fixed |
| CONF-21645 | Daily report stops functioning when user is removed directly from LDAP server  
Resolved  
Fixed |
| CONF-21553 | Some of the  
Resolved  
Duplicate |
Confluence 3.5.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.1. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.2 Release Notes

18 April 2011

Confluence 3.5.2 is a bug-fix release.

Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Download Latest Version

Release Notices
Upgrading from a previous version of Confluence should be fairly straightforward. Please read the [Confluence 3.5.2 upgrade notes](#). We strongly recommend that you back up your confluence.home directory and database before upgrading.

### Updates and Fixes in this Release

#### JIRA Issues (15 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![щик]</td>
<td>CONF-22293</td>
<td>Upgrade to Lucene 2.9.4</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-22143</td>
<td>Improve Log reporting for PartialResultsException after upgrade.</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-22122</td>
<td>Auto Group Adder should only add groups on first login from a user</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-22102</td>
<td>Failed upgrades lead to NullPointerException in ConfluenceGroupJoiningAuthenticator</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-22094</td>
<td>Site Default Language broken in Confluence 3.5</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-21973</td>
<td>Unhandled exceptions when performing operations on a Crowd server and it doesn't have permissions to execute</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-21970</td>
<td>UPM data can exceed database length limits for Bandana (UPM-1061)</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>![щик]</td>
<td>CONF-14199</td>
<td>Document added General Configuration option to limit the maximum number of RSS items in a feed</td>
<td></td>
<td>![Resolved]</td>
<td>Fixed</td>
</tr>
<tr>
<td>#</td>
<td>Key</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>CONF-11759</td>
<td>If directories associated with Confluence do not allow adding of users or groups, an UnsupportedOperationException is thrown</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-22246</td>
<td>List All Space Templates ... lo</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-22139</td>
<td>Duplicate Key Violates Unique Constraint 'os_propertyentry_pkey' exception is being thrown on Upgrade to 3.5.x</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-22123</td>
<td>Add database constraints to prevent duplicate content permission entries</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-22116</td>
<td>Build and release 3.5.1</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-21971</td>
<td>Unhandled exceptions when performing operations and LDAP server is down.</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-21968</td>
<td>Exception while trying to update my profile settings with Crowd and read-only LDAP</td>
<td>✅</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
</tbody>
</table>

**Confluence 3.5.2 Upgrade Notes**

Below are some important notes on upgrading to **Confluence 3.5.2**. For details of the fixes in this release, please read the [release notes](#).

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database
supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.3 Release Notes

5 May 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.3.

This release introduces the option to configure the synchronisation interval for Crowd and JIRA user directory types. The synchronisation interval is set to an hour by default. In previous releases of Confluence, you could change the default setting for LDAP directories only. Now you can set the interval for directories managed in Crowd and JIRA too. Details are in the documentation.

We have also fixed a number of bugs. The complete list of fixes is at the bottom of this page.

Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.3 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (11 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>CONF-22479</td>
</tr>
<tr>
<td>CONF-22402</td>
</tr>
<tr>
<td>CONF-22356</td>
</tr>
<tr>
<td>CONF-22157</td>
</tr>
<tr>
<td>CONF-22048</td>
</tr>
<tr>
<td>CONF-22014</td>
</tr>
<tr>
<td>CONF-22341</td>
</tr>
<tr>
<td>CONF-22318</td>
</tr>
</tbody>
</table>

**Confluence 3.5.3 Upgrade Notes**

Below are some important notes on upgrading to **Confluence 3.5.3**. For details of the fixes in this release, please read the [release notes](#).

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest...
version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

**Confluence 3.5.4 Release Notes**

17 May 2011

The Atlassian Confluence team is pleased to announce the release of **Confluence 3.5.4**, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

**Don't have Confluence 3.5 yet?**

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

[Download Latest Version]

**Release Notices**

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.4 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

<table>
<thead>
<tr>
<th>JIRA Issues (6 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>![ ] (1)</td>
</tr>
<tr>
<td>![ ] (1)</td>
</tr>
<tr>
<td>![ ] (1)</td>
</tr>
</tbody>
</table>
Confluence 3.5.4 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.4. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.5 Release Notes

1 June 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.5, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.
Don't have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.5 upgrade notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (11 issues)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-22455</td>
<td>Adding more logging around the upgrade process</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22528</td>
<td>Confluence 3.5.4 database setup fails if the server cannot reach the internet</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-15965</td>
<td>While viewing an old version of a page menu items have the old version's page id</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22487</td>
<td>Confluence 3.5.x upgrade failed for SQL Server with case sensitive collation during ContentPermissionConstraintsUpgradeTask</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22414</td>
<td>Dashboard is slow to display with nested groups and LDAP</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22342</td>
<td>Synchronising LDAP/Crowd can completely fail because transactions are not properly rolled back in</td>
<td>![ ]</td>
<td>⚙ Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 3.5.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.5. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.6 Release Notes

20 June 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.6, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.
Don't have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.6 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (10 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>📦</td>
</tr>
<tr>
<td>🌐</td>
</tr>
<tr>
<td>📦</td>
</tr>
<tr>
<td>🌐</td>
</tr>
<tr>
<td>📦</td>
</tr>
<tr>
<td>📦</td>
</tr>
<tr>
<td>📥</td>
</tr>
<tr>
<td>📦</td>
</tr>
</tbody>
</table>
Confluence 3.5.6 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.6. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.7 Release Notes

30 June 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.7. This release contains fixes for Atlassian JIRA Studio and hosted Confluence customers. It is a recommended upgrade for all Confluence customers.

Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.7 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
Updates and Fixes in this Release

### JIRA Issues (1 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕯️</td>
<td>CONF-15553</td>
<td>IE prompts for download instead of opening thumbnail images containing non-ASCII characters</td>
<td>🚪</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Confluence 3.5.7 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.7. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.9 Release Notes

27 July 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.9, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Note that Confluence 3.5.8 was not a public release, as problems were discovered with it during final testing. Issues marked as fixed in 3.5.8 are available for the first time in this release.

Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Download Latest Version

Release Notices
Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.9 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (22 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>CONF-22865</td>
</tr>
<tr>
<td>CONF-22863</td>
</tr>
<tr>
<td>CONF-22834</td>
</tr>
<tr>
<td>CONF-22793</td>
</tr>
<tr>
<td>CONF-22421</td>
</tr>
<tr>
<td>CONF-22151</td>
</tr>
<tr>
<td>CONF-22086</td>
</tr>
<tr>
<td>CONF-21985</td>
</tr>
<tr>
<td>CONF-21385</td>
</tr>
<tr>
<td>CONF-21031</td>
</tr>
<tr>
<td>CONF-19091</td>
</tr>
</tbody>
</table>
Confluence 3.5.9 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.9. For details of the fixes in this release, please read the release notes.
As of Confluence 3.5.9, the queue that backs the re-indexing workers has been improved to remove contention. This means two important changes.

1. Re-indexing is now more CPU-bound. This means that if you had previously adjusted the indexing thread count you may want to revisit that number as it can put significant load on your server if this number is too high.
2. Each thread will make use of a connection to the database. If the number of threads are configured to a high number this means that there will be a significantly bigger load on the database.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 3.5.11 Release Notes

25 August 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.11, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Note that Confluence 3.5.10 was not publicly released. Issues marked in JIRA as fixed in 3.5.10 are available for the first time in this release.

Don't have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Download Latest Version

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.11 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
## Updates and Fixes in this Release

### JIRA Issues (8 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>CONF-22910</td>
<td>Add remote API support to read and write user profile settings</td>
<td>🟠</td>
<td>🟠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-22463</td>
<td>Support migration of pre-3.5 groups and memberships of external users to 3.5+ &quot;Internal with LDAP authentication&quot; directory</td>
<td>🟠</td>
<td>🟠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21461</td>
<td>Selection of pages is not working for XML space export</td>
<td>🟠</td>
<td>🟠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-23028</td>
<td>Improve error handling when rebuilding index</td>
<td>🟡</td>
<td>🟡 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-23027</td>
<td>Simplify upgrades with Active Directory and a custom username attribute</td>
<td>🟡</td>
<td>🟡 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-22280</td>
<td>Unhandled exception when adding LDAP directory with the same name as existing</td>
<td>🟡</td>
<td>🟡 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-20435</td>
<td>Reindexing threads should use shorter transactions</td>
<td>🟠</td>
<td>🟠 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-18733</td>
<td>Exception thrown while indexing a .csv document</td>
<td>🟡</td>
<td>🟡 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

### Confluence 3.5.11 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.11. For details of the fixes in this release, please read the release notes.

**Upgrade Procedure**

---

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about [finding your Home directory](https).
2. If your version of Confluence is earlier than 3.5, read the [release notes and upgrade guides](https://) for all releases between your version and the latest version. In particular:
   - Please read the [Confluence 3.5 Upgrade Notes](https://).
   - If you are upgrading from 2.1 or earlier, please also read the [2.2 release notes](https://).
3. Download the latest version of Confluence.
4. Follow the instructions in the [Upgrade Guide](https://).

### Confluence 3.5.13 Release Notes

6 September 2011

The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.13, which is a bug-fix release.

Internal directories with LDAP authentication ("delegated LDAP authentication") can now update a user’s membership information when they log in, in addition to the user’s information. This is now our recommended configuration for connecting Confluence to LDAP servers with very large numbers of users, groups or memberships.

Note that Confluence 3.5.12 was not publicly released. Issues marked in JIRA as fixed in 3.5.12 are available for the first time in this release.

The complete list of fixes is at the bottom of this page.

**Don't have Confluence 3.5 yet?**

Take a look at the new features and other highlights in the [Confluence 3.5 Release Notes](https://).

**Download Latest Version**

### Release Notices

- **Warning**: If you are upgrading from Confluence 3.5.2 and using Microsoft SQL server, please refer to this [workaround](https://) to prevent errors in the upgrade progress.

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the [Confluence 3.5.13 Upgrade Notes](https://). We **strongly recommend** that you back up your `confluence.home` directory and database before upgrading.

### Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://).
<table>
<thead>
<tr>
<th>Key</th>
<th>Ticket</th>
<th>Description</th>
<th>Resolution Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>☢</td>
<td>CONF-22779</td>
<td>Allow configuration of Lucene search weighting.</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-22709</td>
<td>Add on the fly group sync for delegated LDAP authentication.</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-19124</td>
<td>Encountered NullPointerException due to dangling permission left after an LDAP group or user is deleted from the LDAP server</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-23115</td>
<td>Adding pages with a lot of sibling pages performs poorly.</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-23058</td>
<td>Constraint violation failure when importing on SQL Server due to content permission nulls</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-23040</td>
<td>XML import failed with ConstraintViolationException in SQL Server or Oracle</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-22884</td>
<td>Empty atlassian-gzipfilter HTTP response headers - does not conform to RFC2616</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-22242</td>
<td>Impossible to empty Additional User DN or Additional Group DN once filled in</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-23102</td>
<td>Null pointer when recording failures due to duplicate memberships while synchronising</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>☢</td>
<td>CONF-23093</td>
<td>SOAP</td>
<td>Resolved Fixed</td>
</tr>
</tbody>
</table>
### Confluence 3.5.13 Upgrade Notes

Below are some important notes on upgrading to **Confluence 3.5.13**. For details of the fixes in this release, please read the release notes.

#### Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   ☑ Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

#### Confluence 3.5.16 Release Notes

**17 May 2012**
**Confluence 3.5.16** is a bug-fix release. The full list of fixes is provided at the bottom of this page.

**Don't have Confluence 3.5 yet?**

Take a look at the new features and other highlights in the [Confluence 3.5 Release Notes](#).

---

Release Notices

- **Security advisory**: This release fixes some security flaws. Please refer to the [security advisory](#) for details of the security vulnerabilities, risk assessment and mitigation strategies.
- Upgrading from a previous version of Confluence should be fairly straightforward. Please read the [Confluence 3.5.16 Upgrade Notes](#). We strongly recommend that you back up your `confluence.home` directory and database before upgrading.

---

**Updates and Fixes in this Release**

*JIRA Issues* (2 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📜</td>
<td>CONF-25077</td>
<td>XML Vulnerability in Confluence</td>
<td>🚚</td>
<td>🚦 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📜</td>
<td>CONF-20631</td>
<td>Viewfile throws <code>ConversionException</code> when field has currency format</td>
<td>🚚</td>
<td>🚦 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

---

**Confluence 3.5.16 Upgrade Notes**

Below are some important notes on upgrading to Confluence 3.5.16. For details of the fixes in this release, please read the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   - Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

**Confluence 3.5.17 Release Notes**

25 June 2012
The Atlassian Confluence team is pleased to announce the release of Confluence 3.5.17. This release fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment, and mitigation strategies.

Note: This release contains the same fixes as Confluence 3.5.16. The difference is that we have backdated this release so that customers can upgrade even if their maintenance license has expired.

Don’t have Confluence 3.5 yet?

Take a look at the new features and other highlights in the Confluence 3.5 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 3.5.17 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (2 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
</tbody>
</table>

Confluence 3.5.17 Upgrade Notes

Below are some important notes on upgrading to Confluence 3.5.17. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
Please read the Confluence 3.5 Upgrade Notes.
If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence 3.5.x.
4. Follow the instructions in the Confluence 3.5 Upgrade Guide.

Confluence 2.x.x Releases

- Confluence 2.6.1 Release Notes
  - Confluence 2.6.1 Upgrade Guide
- Confluence 2.6.2 Release Notes
  - Confluence 2.6.2 Upgrade Guide
- Confluence 2.6.3 Release Notes
- Confluence 2.6 Release Notes
  - Confluence 2.6 Upgrade Guide
  - Issues resolved in Confluence 2.6
- Confluence 2.7.1 Release Notes
  - Confluence 2.7.1 Upgrade Guide
- Confluence 2.7.2 Release Notes
  - Confluence 2.7.2 Upgrade Guide
- Confluence 2.7.3 Release Notes
  - Confluence 2.7.3 Upgrade Guide
- Confluence 2.7.4 Release Notes
- Confluence 2.7 Release Notes
  - Issues Resolved in Confluence 2.7
  - Confluence 2.7 Upgrade Guide
- Confluence 2.8.1 Release Notes
  - Confluence 2.8.1 Upgrade Notes
- Confluence 2.8.2 Release Notes
  - Confluence 2.8.2 Upgrade Notes
- Confluence 2.8.3 Release Notes
- Confluence 2.8 Beta Release Notes
- Confluence 2.8 Release Notes
  - Issues resolved in Confluence 2.8
  - Confluence 2.8 Screen and Menu Changes
  - Confluence 2.8 Upgrade Notes
- Confluence 2.9.1 Release Notes
  - Confluence 2.9.1 Upgrade Notes
    - Enabling Contributor Filtering for Search
    - Restoring Inherited Page Permissions After 2.9 Upgrade
- Confluence 2.9.2 Release Notes
  - Confluence 2.9.2 Upgrade Notes
- Confluence 2.9.3 Release Notes
- Confluence 2.9 Release Notes
  - Issues resolved in Confluence 2.9
- Confluence 2.10.1 Release Notes
  - Confluence 2.10.1 Upgrade Notes
- Confluence 2.10.2 Release Notes
  - Confluence 2.10.2 Upgrade Notes
- Confluence 2.10.3 Release Notes
  - Confluence 2.10.3 Upgrade Notes
- Confluence 2.10.4 Release Notes
- Confluence 2.10 Release Notes
  - Confluence 2.10 Upgrade Notes
  - Issues resolved in Confluence 2.10
    - Workaround For Enabling MySQL 4.1.x with Confluence 2.10
- Release Notes 2.0
• Issues Resolved for 2.0
• Release Notes 2.0.1
  • Issues resolved for 2.0.1
• Release Notes 2.0.2
  • Issues resolved for 2.0.2
• Release Notes 2.0.3
  • Issues resolved for 2.0.3
• Release Notes 2.1
  • Issues Resolved for 2.1
• Release Notes 2.1.1
  • Issues resolved for 2.1.1
• Release Notes 2.1.2
  • Issues resolved for 2.1.2
• Release Notes 2.1.3
  • Issues resolved for 2.1.3
• Release Notes 2.1.4
  • Issues resolved for 2.1.4
• Release Notes 2.1.5
  • Issues resolved for 2.1.5
• Release Notes 2.2
  • Issues Resolved for 2.2
• Release Notes 2.2.1
  • Issues resolved for 2.2.1
• Release Notes 2.2.2
  • Issues resolved for 2.2.2
• Release Notes 2.2.3
  • Issues resolved for 2.2.3
• Release Notes 2.2.4
  • Issues Resolved for 2.2.4
• Release Notes 2.2.5
  • 2.2.5 Security Patch
• Release Notes 2.2.6a
  • Issues Resolved for 2.2.6a
• Release Notes 2.2.7
  • Issues Resolved for 2.2.7
• Release Notes 2.2.8
  • Issues Resolved for 2.2.8
• Release Notes 2.2.9
  • Issues Resolved for 2.2.9
• Release Notes 2.2.10
• Release Notes 2.3
  • FileAppender (log4j.properties)
  • Issues Resolved for 2.3
• Release Notes 2.3.1
• Release Notes 2.3.2
• Release Notes 2.3.3
• Release Notes 2.4
  • Changes to the Page Permission API in Confluence 2.4
• Release Notes 2.4.1
• Release Notes 2.4.2
  • Issues Resolved for 2.4.2
• Release Notes 2.4.3
• Release Notes 2.4.4
• Release Notes 2.4.5
• Release Notes 2.5
  • Issues Resolved for 2.5
• Release Notes 2.5.1
Atlassian is proud to announce the release of Confluence 2.6.1. This is a highly recommended upgrade from 2.6, because it fixes some security flaws which may affect Confluence instances in a public environment. We will release more details of the security fixes within a few days, giving our customers a chance to upgrade before the details are made public. This point release also includes more than 40 other fixes and improvements.

We're especially glad that anonymous comments will no longer show the profile picture of the previous commenter, and newly-created spaces no longer seem to have been created by an anonymous user. The {excerpt} and {excerpt-include} macros now behave better. And we've fixed some issues with internationalisation.

There's a complete list of fixes below.

You can download Confluence 2.6.1 from the download centre.

Security Advisory 19 November 2007

We have now published the details of the security vulnerabilities, which are fixed in Confluence 2.6.1. Please refer to the security advisory for more information.

Upgrading from a previous version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the upgrade instructions. We strongly recommend that you back up your confluence.home directory and database before upgrading!

Updates and fixes in this release

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Confluence 2.6.1 Upgrade Guide

Atlassian is proud to announce the release of Confluence 2.6.1. This is a highly recommended upgrade from 2.6, because it fixes some security flaws which may affect Confluence instances in a public environment. We will release more details of the security fixes within a few days, giving our customers a chance to upgrade before the details are made public. This point release also includes more than 40 other fixes and improvements.

We're especially glad that anonymous comments will no longer show the profile picture of the previous commenter, and newly-created spaces no longer seem to have been created by an anonymous user. The {excerpt} and {excerpt-include} macros now behave better. And we've fixed some issues with internationalisation.
Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your confluence.home directory and database.**

2. If your version of Confluence is earlier than 2.6.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from a version earlier than 2.6.0, please read the 2.6 upgrade notes.

3. **Download** the latest version of Confluence.

4. Follow the instructions in the **Upgrade Guide.**

Confluence 2.6.2 Release Notes

27 November 2007

Atlassian is proud to announce the release of Confluence 2.6.2. This is a **highly recommended** upgrade, because it fixes some security flaws which may affect Confluence instances in a public environment. These flaws are XSS (cross-site scripting) vulnerabilities in some of Confluence's macros and Wiki Markup, which potentially allowed a user to insert malicious HTML tags or script into a Confluence page. Please refer to the **Security Advisory** for details.

This point release also includes more than 20 other fixes and improvements.

As part of our drive to tighten up the security in Confluence, we have removed support for the 'style' attribute in the Wiki Markup for images. This was an undocumented feature, which is now no longer available. To help those who may have used the 'style' tag to add coloured borders, we have added a new 'bordercolor' attribute to the image markup.

The PDF and HTML space exports are now more reliable than in Confluence 2.6.0 and 2.6.1. We've fixed the failure to send daily digest email notifications. (This problem occurred when the Confluence instance contained draft pages.) This release also contains some improvements in the wiki's support of internationalisation. And you'll be delighted to see that the plus and minus buttons are back, next to the 'Recently Updated' section of the Dashboard – so you can now increase or decrease the number of items you see in that section.

There's a complete list of fixes below. You can download Confluence 2.6.2 from the **download centre.**

Upgrading from a previous version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the **upgrade instructions.** We **strongly recommend that you back up your confluence.home directory and database before upgrading!**

**Updates and fixes in this release**

**Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.**

Confluence 2.6.2 Upgrade Guide

27 November 2007

Atlassian is proud to announce the release of Confluence 2.6.2. This is a **highly recommended** upgrade, because it fixes some security flaws which may affect Confluence instances in a public environment. These
flaws are XSS (cross-site scripting) vulnerabilities in some of Confluence's macros and Wiki Markup, which potentially allowed a user to insert malicious HTML tags or script into a Confluence page. Please refer to the Security Advisory for details.

This point release also includes more than 20 other fixes and improvements.

As part of our drive to tighten up the security in Confluence, we have removed support for the 'style' attribute in the Wiki Markup for images. This was an undocumented feature, which is now no longer available. To help those who may have used the 'style' tag to add coloured borders, we have added a new 'bordercolor' attribute to the image markup.

The PDF and HTML space exports are now more reliable than in Confluence 2.6.0 and 2.6.1. We've fixed the failure to send daily digest email notifications. (This problem occurred when the Confluence instance contained draft pages.) This release also contains some improvements in the wiki's support of internationalisation. And you'll be delighted to see that the plus and minus buttons are back, next to the 'Recently Updated' section of the Dashboard – so you can now increase or decrease the number of items you see in that section.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.6.1, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from a version earlier than 2.6.0, please read the 2.6 upgrade notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

**Confluence 2.6.3 Release Notes**

**Confluence 2.6.3** is the standard edition version of Confluence 2.6.x. This version of Confluence is equivalent to Confluence version 2.6.2, but it does not include Oracle's Coherence technology. Due to licensing changes with Oracle over the Coherence clustering and distributed caching technology, Atlassian is no longer able to distribute this technology to customers without a Confluence clustered license.

Therefore, Atlassian has released 'standard editions' for each previous major version of Confluence back to 2.6, which includes Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3. Confluence 2.6.3 will be the only Confluence 2.6.x version available to customers with a non-clustered Confluence license.

For its caching functionality, Confluence 2.6.3 utilises Ehcache. This functionality was provided by the Coherence technology in previous Confluence 2.6.x versions.

For more information about the features, updates and fixes in Confluence 2.6.2, please refer to the Confluence 2.6.2 Release Notes.

**Upgrading from a Previous Version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.6.2 Upgrade Notes. However, if you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read the Confluence 3.0.1 Upgrade Notes for important information about transferring your caching layer customisations from Coherence to Ehcache.

We strongly recommend that you back up your confluence.home directory and database before upgrading.
Confluence 2.6 Release Notes

The Atlassian Confluence team is delighted to present Confluence 2.6.

Confluence 2.6 brings many popular features which save you time and improve the your wiki's usability. Upgrading to Confluence 2.6 is free for all customers with active Confluence software maintenance as at 27th September 2007.

A new theme brings a fresh, clean look and feel. This is for our customers who have asked for a friendlier interface and improved readability. We've included more social networking features, to enhance the sense of community in your wiki. For example, author photos are now shown in comments and in the 'Recent Updates' on the Dashboard. And the Social Bookmarking plugin is now shipped with Confluence, allowing you to share bookmarks with your team.

Other popular new features include default content for spaces, labels on templates, the ability to backdate or rename news items (blog posts), official MySQL 5.0 support and PDF export of images.

- Many thanks for your issues and votes. They help us keep improving our products.
- We've highlighted the main features of this release below.
- Attached is a full list of issues resolved in 2.6.

### Upgrading to Confluence 2.6

- Upgrading Confluence should be fairly straightforward. Please refer to the upgrade instructions and notes. We strongly recommend that you back up your confluence.home directory and database before upgrading!
- All draft pages will be destroyed during the upgrade process. Confluence administrators should warn users of the Confluence site that drafts will not survive the upgrade.
- If you are using any third-party plugins, please test them thoroughly before rolling 2.6 into production.

#### Responding to your feedback:

🌟 5 new feature requests implemented
🌟 275 votes satisfied

#### Highlights of this release:

- Fresh look for the Default theme
- Personalised comments and Dashboard
- Space description on Dashboard
- Labels on templates
- Default content for space home pages
- Social Bookmarking plugin now bundled with Confluence
- Back-dating and renaming news items
- Plus over 90 other fixes and improvements
- Special thanks

#### Highlights of Confluence 2.6

1

**Fresh look for the Default theme**

- Default font now Arial instead of Verdana.
- Fresh, clean look and feel - these release notes are an example of the new style.
- If you prefer the original Confluence look and feel, select the Confluence Classic Theme when creating...
a space.

- Improved layouts for email and RSS feeds, helping you to skim-read and classify information quickly.

**Demo of the new default theme**

<table>
<thead>
<tr>
<th>View</th>
<th>Edi</th>
<th>Attachments (0)</th>
<th>Info</th>
<th>EditLive</th>
</tr>
</thead>
</table>

Added by Sarah Maddox, last edited by Sarah Maddox on Aug 21, 2007
Labels: (None) EDIT

**This is a h1 heading**

Lorem ipsum dolor sit amet, consectetur adipisicing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.

**This is a h2 heading**

Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.
- Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
- Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

**This is a h5 heading**

Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.

1. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur.
2. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

**Comments**

<table>
<thead>
<tr>
<th>Sarah Maddox</th>
<th>All thatLorem ipsumstuff is a bit hard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aug 21, 2007 08:15</td>
<td>Edit</td>
</tr>
</tbody>
</table>

Add Comment

**Personalised comments and Dashboard**

- In the new themes (Confluence Default and Clickr), comments now include the user's profile picture. (See screenshot above.)
- 'Recently Updated' section on Dashboard includes profile picture and a summary of the change.

**Recently Updated - All Spaces**

<table>
<thead>
<tr>
<th>Anton Mazko</th>
<th>JIRA 3.11 Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 Jun</td>
<td>JIRA 3.11 Planning</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Jed Wesley-Smith</th>
<th>Mocking out Users and Groups in JIRA</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 Jun</td>
<td>Mocking out Users and Groups in JIRA We go to extraordinary lengths in JIRA to deal with the fact that in OSUser, the Us...</td>
</tr>
</tbody>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
**Space description on Dashboard**

- List of spaces on the Dashboard now includes a short description of the space.

<table>
<thead>
<tr>
<th>Spaces:</th>
<th>My</th>
<th>Team</th>
<th>New (1)</th>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Space</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>Administration &amp; HR Space</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>Atlassian Intranet</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>This is a company wide space</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>Atlassian University</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>atlassian-user</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>Space for the atlassian-user spec. implementation</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>Bamboo</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
<tr>
<td>The Bamboo continuous integration / build server project space</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
<td>![icon]</td>
</tr>
</tbody>
</table>

**Labels on templates**

- You can include labels when adding a page template.
- New pages based on the template will automatically include the labels.
- Read the documentation.

**Default content for space home pages**

- Confluence site administrators can define default content for a space.
- Home page for newly-added spaces will include the default content.
- Read the documentation.
Social Bookmarking plugin now bundled with Confluence

- Use Confluence to share bookmarks with your team.
- Plugin will be enabled by default.
- You can create a bookmark for any space in which you have 'create page' permission.
- To view your bookmarks, go to the ‘Bookmarks’ tab under ‘Browse Space’.
- Drag the bookmarklet from the ‘Bookmarks’ tab onto your browser toolbar to create bookmarks any time.
- Use the bookmarks macro to display a list of bookmarks anywhere in Confluence.
- Subscribe to an RSS feed for your bookmarks.
- Read the documentation.
Back-dating and renaming news items

- Rename a news item at any time.
- When creating a news item, you can now set the posting date to earlier than today.
- Backdating is also supported by the RPC interface - useful for migrating blog posts from other systems.

Plus over 90 other fixes and improvements

- MySQL 5.0 is officially supported, when used with Confluence 2.5 and above.
- Images generated by macro plugins will now export to PDF, .doc and .html formats.
- For plugin developers, the Joda-time library has been upgraded from 0.98 to 1.4 in Confluence 2.6. Plugins that use the date formatting or parsing functionality of Joda-time will need to be recompiled to work with Confluence 2.6.
- Administrators can configure a non-standard port for the Confluence outgoing mail server. The host address can now be specified as hostname:port.
• Improved **user migration** when integrating with LDAP: If you have existing Confluence users with the same usernames as LDAP users, you can now avoid duplicate users by configuring the LDAP repository before running the migration. The migration will then ignore users who have the same username as an LDAP user. Read the [documentation](#).

• And more.

**Special thanks**

We'd like to thank some of our valued community members whose contributions to the open source plugin library have made this version of Confluence even stronger:

• Shannon Krebs, for the [BloggingRPC plugin](#), the [Contributors plugin](#) and the [Social Bookmarking plugin](#).
• David Peterson and Bob Swift for the [Chart Plugin](#).
• David Peterson for the [IM Presence Plugin](#) and the [Table of Contents plugin](#).
• Dan Hardiker & [Adaptavist](#) for the [Plugin Repository Client](#).

**The Confluence 2.6 team**

**Development**

Paul Curren  
Tom Davies  
Matthew Jensen  
Anatoli Kazatchkov  
Samuel Le Berrigaud  
David Loeng  
Charles Miller  
Christopher Owen  
Agnes Ro  
Matt Ryall  
Don Willis

**UI**

Jason Taylor  
Stephen Russell

**Technical Writing**

Rosie Jameson  
Sarah Maddox

**Oversight & Management**

Mike Cannon-Brookes  
Scott Farquhar  
Soren Harner  
Per Fragemann

**Confluence 2.6 Upgrade Guide**

*Confluence 2.6* brings many popular features which save you time and improve the your wiki's usability. Upgrading to Confluence 2.6 is free for all customers with active Confluence software maintenance as at 27th September 2007.

A new theme brings a fresh, clean look and feel. This is for our customers who have asked for a friendlier interface and improved readability. We've included more social networking features, to enhance the sense of community in your wiki. For example, author photos are now shown in comments and in the 'Recent Updates' on the Dashboard. And the Social Bookmarking plugin is now shipped with Confluence, allowing you to share bookmarks with your team.

Other popular new features include default content for spaces, labels on templates, the ability to backdate or rename news items (blog posts), official MySQL 5.0 support and PDF export of images.
Upgrade Notes

Draft Pages

All draft pages will be discarded during the upgrade process. Confluence administrators should warn users of the Confluence site that drafts will not survive the upgrade.

Plugins

If you are using any third-party plugins, please test them thoroughly before rolling 2.6 into production.

For plugin developers: the Joda-time library has been upgraded from 0.98 to 1.4 in Confluence 2.6. Plugins that use the date formatting or parsing functionality of Joda-time will need to be recompiled to work with Confluence 2.6.

Custom Themes

Custom Confluence 2.5.x themes are expected to be compatible with 2.6 without authors needing to make any change to their existing themes. This is because Confluence will, by default, include all Confluence 2.5.x specific styles automatically. But if you would like to upgrade your theme to use the latest Confluence 2.6 style and typography, you will need to update the way you include stylesheets in your theme. You can read full instructions here.

Custom Page Layout

1. If a space uses a custom decorator page layout, the new Confluence 2.6 decorator is not applied. This may causes GUI oddities, such as:
   - On a page, the View, Edit, Info and Attachments tabs are shown as a vertical bulleted list instead of tabs.
   - Comments do not show properly.
   **Fix:** Apply the Default Page Layout, then re-insert the custom code.

2. In addition, if you are using pagetree navigation to form a table of contents on the left, you may find that your wiki text becomes italic after upgrading to Confluence 2.6.
   - Cause: To create the left-hand panel, you have probably inserted a chunk of HTML/CSS in the space’s page layout. The chunk of code may use a <blockquote> element to align the body of the page and draw a blue line on its left. Confluence 2.6 stylesheets apply the italic style to blockquotes.
   - Fix: Use a new format for your left-hand panel. One possible example is given here.

Steps in detail:

1. Go to the Space Admin screen and click ’Edit’ to view your customised Page Layout.
2. Copy the customised code.
3. Cancel the edit.
4. Click ’Reset Default’ to apply the new Confluence 2.6 default page layout.
5. If you are using the pagetree navigation panel, edit your customised code as described above.
6. On the Space Admin screen, click ’Create Custom’ to create a custom page layout.
7. Reinsert your customised code and click ’Save’.

Upgrade Procedure

Upgrading Confluence should be pretty easy. We strongly recommend that you backup your confluence.home directory and database before upgrading!

You can get the latest version of Confluence here.

If you are upgrading from Confluence 2.2.x or a later version, you can find instructions here.

If you are upgrading directly from 2.1 or earlier, you should also read the 2.2 Release Notes for warnings about...
the 2.1 -> 2.2 upgrade.

**Issues resolved in Confluence 2.6**

Below is the full list of issues resolved by Confluence 2.6. You can read the release notes [here](#).

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

**Confluence 2.7.1 Release Notes**

24 January 2008

Presented with pleasure by the Atlassian Confluence team: **Confluence 2.7.1** is a recommended upgrade which fixes a security flaw and other bugs, and brings a couple of improvements.

We have identified and fixed an XSS (cross-site scripting) security flaw which may affect Confluence instances in a public environment. For details, please refer to the [security advisory](#).

Recording of authorship and history for page attachments is improved, so that attachment history is now retained after operations such as editing the attachment or moving it to a new page.

A new option on the Export Space screen allows administrators to export all pages to XML even when page-restrictions deny the administrator access to some of the pages.

This release also fixes problems in the following areas:

- The SOAP API, which was broken in Confluence 2.7.0.
- Logging.
- Internationalisation (support for different languages).
- Case-sensitivity for usernames and group names when using LDAP integration, and problems with upper-case letters in usernames when applying space permissions.

There's a complete list of fixes below. Click a specific issue to see details of the fix, and to download any patches where relevant.

Confluence 2.7.1 is available from the [download centre](#).

**Upgrading from a previous version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the [upgrade instructions](#). We strongly recommend that you back up your confluence.home directory and database before upgrading!

**Updates and fixes in this release**

**Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.**

**Confluence 2.7.1 Upgrade Guide**

Confluence 2.7.1 is a recommended upgrade which fixes a security flaw and other bugs, and brings a couple of improvements. You'll find details of the fixes in the [release notes](#).
Upgrade Notes

As part of the fix for case-sensitivity in usernames and group names when using LDAP integration ([CONF-9469](#)), an upgrade task will consolidate permissions for the same user or groups where they differ only by case.

Depending on the size of your Confluence installation (number of spaces and the permissions applied to them) the upgrade task could result in a longer-than-usual delay when starting Confluence for the first time after the upgrade. Please be patient while this happens — it could take a few minutes.

During this process there will be regular progress reports in the log, something like this:

```
[atlassian.confluence.upgrade.ConsolidatePermissionsUpgradeTask]
doUpgrade Consolidating SpacePermissions for Space Monkeys in a Barrel
(key=MONBAR)
```

⚠️ Backup essential, because permissions will be modified

The upgrade task will modify permissions in your Confluence database. So that our usual 'strong recommendation' to back up the database becomes even stronger.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.7.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.7 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.7.2 Release Notes

6 March 2008

Confluence 2.7.2 is a recommended upgrade which fixes a security flaw and other bugs.

We have fixed a security flaw which allowed users who have 'View' permission (or higher) on a space to purge any page in that space. For details, please refer to the security advisory and related JIRA issue.

Other good fixes in this point release:

- The Rich Text editor no longer breaks links to pages in other spaces.
- Some customers have reported problems with permissions after upgrading to Confluence 2.7.1, where some space permissions or global permissions were lost if using a case-sensitive database. From Confluence 2.7.2, the space permissions and global permissions screens will display a message highlighting any case-sensitivity problems. We have also provided a routine to fix existing permissions affected by this issue — read the detailed instructions on running the routine.
- The JIRA Portlet macro now displays correctly when using trusted communication between JIRA and Confluence.
• Confluence 2.7.2 also clarifies the procedures around renewing your license before upgrading.

There's a complete list of fixes below. Click a specific issue to see details of the fix, and to download patches where relevant.

**Don’t have Confluence 2.7 yet?**

Take a look at the new features and other highlights in the Confluence 2.7 Release Notes.

![Download Latest Version](download-button)

**Upgrading from a Previous Version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.7.2 Upgrade Guide. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.

**Confluence 2.7.2 Upgrade Guide**

Confluence 2.7.2 is a recommended upgrade which fixes a security flaw and other bugs. You’ll find details of the fixes in the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.7.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.7 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

**Confluence 2.7.3 Release Notes**

19 March 2008

Confluence 2.7.3 is a recommended upgrade which focuses on fixing a number of security flaws. Please refer to the security advisory for details of the vulnerabilities, risk assessment and mitigation strategies.

There’s a complete list of fixes below. Click a specific issue to see details of the fix, and to download patches where relevant.

**Don’t have Confluence 2.7 yet?**

Take a look at the new features and other highlights in the Confluence 2.7 Release Notes.

![Download Latest Version](download-button)
Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.7.3 Upgrade Guide. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.

Confluence 2.7.3 Upgrade Guide

Confluence 2.7.3 is a recommended upgrade which focuses on fixing a number of security flaws. You'll find details of the fixes in the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.7.2, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.7 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.7.4 Release Notes

Confluence 2.7.4 is the standard edition version of Confluence 2.7.x. This version of Confluence is equivalent to Confluence version 2.7.3, but it does not include Oracle's Coherence technology. Due to licensing changes with Oracle over the Coherence clustering and distributed caching technology, Atlassian is no longer able to distribute this technology to customers without a Confluence clustered license.

Therefore, Atlassian has released 'standard editions' for each previous major version of Confluence back to 2.6, which includes Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3. Confluence 2.7.4 will be the only Confluence 2.7.x version available to customers with a non-clustered Confluence license.

For its caching functionality, Confluence 2.7.4 utilises Ehcache. This functionality was provided by the Coherence technology in previous Confluence 2.7.x versions.

For more information about the features, updates and fixes in Confluence 2.7.3, please refer to the Confluence 2.7.3 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.7.3 Upgrade Notes. However, if you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read the Confluence 3.0.1 Upgrade Notes for important information about transferring your caching layer customisations from Coherence to Ehcache.

We strongly recommend that you back up your confluence.home directory and database before upgrading.

Confluence 2.7 Release Notes

12 December 2007: With great pleasure, the Atlassian Confluence team presents Confluence 2.7.
Confluence 2.7 has improvements for administrators and end-users alike. Administrators can set up trusted communication between Confluence and JIRA. The result? The JIRA Issues and JIRA Portlet macros will show only the issues which the Confluence user is authorised to see. You no longer need to include a username and password in the markup code.

The two-tier administrator permissions allow system administrators to delegate some functions to team leaders or managers. Logging is simplified, and administrators can change logging levels at runtime. The improved user management framework speeds up your user searches.

Sorting of images is now possible in the Gallery macro. And when creating a page or news item, you can attach images or files immediately, without waiting until you have saved the page.

- Upgrading to Confluence 2.7 is free for all customers with active Confluence software maintenance as at 12 December 2007.
- Thank you for all your issues and votes. Keep on logging!
- We've highlighted our favourite bits of this new release below.
- And there's more.

### Upgrading to Confluence 2.7

Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your confluence.home directory and database before upgrading!** Please refer to the [upgrade instructions](#). There you will find instructions on upgrading, and details of the following:

- If you are using any third-party plugins, please test them thoroughly before rolling 2.7 into production.
- If you are using the Resin application server, you will need to configure Resin to use an XML parser that is XSD-aware.
- When upgrading, you should consider turning off the new JIRA/Confluence trusted communication feature and/or warnings.
- Your users will be automatically migrated to AtlassianUser during the Confluence upgrade process.
- All users and groups with the old ‘Administer Confluence’ permission will be converted to the new ‘System Administrator’ permission.
- By default, all installations of Confluence will now write log messages to the Confluence home directory instead of the application server’s log file.
- Java 1.4 will be deprecated after Confluence 2.8.
- Read [more information](#).

---

**Responding to your feedback:**

- ★ 4 new feature requests implemented
- ★ 380 votes satisfied

**Download latest version**

---

**Highlights of this release:**

- [JIRA Issues and Portlet macros use new trusted authentication](#)
- [Two-tier administrator permissions](#)
- [Inserting images and attaching files during page creation](#)
- [Sorting of images in Gallery macro](#)
- [Simplified and improved logging](#)
- [Performance, maintainability and administration](#)
- [Plus over 90 fixes and improvements](#)
Highlights of Confluence 2.7

1. JIRA Issues and Portlet macros use new trusted authentication

- The JIRA Issues macro and the JIRA Portlet macro allow you to display a list of JIRA issues on your Confluence page.
- Prior to Confluence 2.7, you had to include a username and password in the markup code if you needed to display issues with restricted viewing. This release and JIRA 3.12 solve the problem.
- Read more about trusted communication.

Example markup— User will see the issues they are authorised to see (provided trusted communication is enabled):

```
{jiraissues:url=CONTENT|columns=type;key;summary}
```

Example markup— User will see only the issues authorised for anonymous viewing:

```
{jiraissues:url=CONTENT|columns=type;key;summary|anonymous=true}
```

2. Two-tier administrator permissions

- The original 'Administer Confluence' permission is now called 'System Administrator'.
- A new permission level, called 'Confluence Administrator', is similar to 'System Administrator' but excludes the functions which may compromise the security of the Confluence system.
- You can delegate administrator privileges to project managers or team leaders while preserving the security of your Confluence site, by granting the managers the new 'Confluence Administrator'
Inserting images and attaching files during page creation

- You can now attach an image or other file during creation of new page – before you have saved the page.
- This applies to pages and news items.
- We have standardised the options for Wiki Markup mode and the Rich Text editor:
  - The 'Insert Image' popup allows you to select thumbnails and alignment.
  - The 'Insert Link' popup allows aliases and tooltips.
- Read more about inserting an image and attaching a file to a page.
Sorting of images in Gallery macro

- The new 'sort' argument allows you to order the images by file name, comment or date last modified.
- Read the documentation.

Example: Sorting the images by file name

```text
{gallery:title=Some office photos, and a waterfall|sort=name}
```

Example: Sorting the images by date and showing the most-recently-modified first
Simplified and improved logging

- Confluence now writes its logs to the Confluence home directory. Both the Confluence and Confluence EAR/WAR distributions behave in the same way. For more information, see the logging documentation.
- We have rationalised the reporting to the different levels (ERROR, INFO, WARN, etc) and removed many unnecessary exceptions and stacktraces from the logs.
- You can change the logging levels while Confluence is running. Read more information.

Performance, maintainability and administration

- If you are currently using the standard configuration for user management, your users will be automatically migrated to the AtlassianUser framework on upgrade to Confluence 2.7. See the upgrade notes. This will result in a dramatic increase in the speed of user searches.
- Confluence now supports Java 6, allowing you to take advantage of its performance improvements.
- A further set of improvements to the stability of your Confluence system.

Plus over 90 fixes and improvements

- You'll no longer see those annoying browser messages when you click the browser's 'Back' button, for example after viewing search results.
- We've fixed some problems with the image and file attachment popups, and made them behave in the same way for both the Rich Text Editor and Wiki Markup.
- See the list of features, improvements and bug fixes.

The Confluence 2.7 team

Development
Agnes Ro
Anatoli Kazatchkov
Samuel Le Berrigaud
Andrew Lynch
Charles Miller
Christopher Owen
Dave Loeng
David Taylor
Dmitry Baranovskiy
Don Willis
Matt Ryall
Matthew Jensen
Paul Curren
Sam Le Berrigaud

Oversight & Management
Adnan Chowdhury
Issues Resolved in Confluence 2.7

Below is the full list of issues resolved by Confluence 2.7. You can read the release notes here.

### JIRA Issues

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Confluence 2.7 Upgrade Guide**

Confluence 2.7 has improvements for administrators and end-users alike. Administrators can set up trusted communication between Confluence and JIRA. The result? The JIRA Issues and JIRA Portlet macros will show only the issues which the Confluence user is authorised to see. You no longer need to include a username and password in the markup code.

The two-tier administrator permissions allow system administrators to delegate some functions to team leaders or managers. Logging is simplified, and administrators can change logging levels at runtime. The improved user management framework speeds up your user searches.

Sorting of images is now possible in the Gallery macro. And when creating a page or news item, you can attach images or files immediately, without waiting until you have saved the page.
Plugins

If you are using any third-party plugins, please test them thoroughly before rolling 2.7 into production.

Configuring Resin

This note applies if you are using the Resin application server. Due to an upgrade to one of the core components of Confluence (namely Spring), it will no longer work against an out-of-box configuration of Resin. To resolve this, you will need to configure Resin to use an XML parser that is XSD-aware. More information:

- Troubleshooting a Resin configuration
- Spring Framework documentation

Trusted communication between JIRA and Confluence

Confluence 2.7 provides a new trusted communication protocol, to allow secure authentication for the JIRA Issues and JIRA Portlet macros.

When upgrading, consider whether to disable warning messages or turn off trusted communication altogether. You may like to do this if you have a number of existing JIRA Issues or JIRA Portlet macros in your Confluence pages, and you do not intend to set up trusted communications soon. Read more about configuring trusted communications.

By default, trusted communication will be enabled when you upgrade to Confluence 2.7. This will affect your existing macros as follows:

- If the macro markup contains a username and password, the functionality is unchanged.
- If you have already set up trusted communication with a JIRA instance, the macro output will be as described in the guide on trusted communication.
- If the macro markup does not contain a username and password and you have not set up trusted communication with a JIRA instance, your Confluence pages will show a warning message above the macro output. See more information on troubleshooting.

WebDAV attachment manager deprecated

The option to store Confluence attachments on a WebDAV server has never worked in a useful fashion, and has not been maintained for many versions.
The WebDAV attachment manager is deprecated from Confluence 2.7, and will be removed from a future version of Confluence. If you store attachments on external WebDAV servers, we recommend that you migrate to file-system or database-backed attachment storage immediately. Refer to CONF-9313 and CONF-2887.

This DOES NOT affect the operation of the WebDAV plugin.

User migration

Confluence 2.7 replaces OSUser with AtlassianUser as the underlying user management framework, greatly improving performance. Read more information about Managing Confluence Users.

When you upgrade from an earlier version of Confluence to release 2.7.0 or later, your users will be automatically migrated to AtlassianUser (but see the exceptions in the next paragraph). You may notice that your upgrade takes longer than usual, due to this migration process.

Automatic migration will not occur if any of the following is true:

- You have delegated user management to either JIRA or LDAP, or you have changed your user management from the standard configuration. If this is the case, you should upgrade as usual, ensuring that you retain your existing atlassian-user.xml or osuser.xml file.
- You have already migrated to AtlassianUser.

The progress of the migration will be shown in your log files. For example, a successful migration will show:

```
2007-10-08 21:33:07,979 INFO [main]
[atlassian.confluence.upgrade.OSUserToAtlassianUserMigrationUpgradeTask]
userMigrationStarted Starting user migration. 12288 users to migrate.
2007-10-08 21:33:09,784 INFO [main]
[atlassian.confluence.upgrade.OSUserToAtlassianUserMigrationUpgradeTask]
userMigrated 100 users migrated out of 12288.
...  
2007-10-08 21:36:18,304 INFO [main]
[atlassian.confluence.upgrade.OSUserToAtlassianUserMigrationUpgradeTask]
userMigrated 12100 users migrated out of 12288.
2007-10-08 21:36:20,112 INFO [main]
[atlassian.confluence.upgrade.OSUserToAtlassianUserMigrationUpgradeTask]
userMigrated 12200 users migrated out of 12288.
2007-10-08 21:36:21,562 INFO [main]
[atlassian.confluence.upgrade.OSUserToAtlassianUserMigrationUpgradeTask]
userMigrationComplete User migration complete.
```

System Administrator and Confluence Administrator
permissions

Confluence 2.7 brings two administrator-level permissions in place of one. The new permissions are 'System Administrator' and 'Confluence Administrator'. Refer to the documentation for details.

When you upgrade to version 2.7, all users and groups with the old 'Administer Confluence' permission will be converted to the new 'System Administrator' permission. The powers of the 'confluence-administrators' group remain unchanged.

Location of Confluence logs

Confluence’s default logging behaviour has changed with Confluence 2.7. Both the Confluence and Confluence EAR/WAR distributions follow the same default behaviour:

- When you start Confluence, log entries will be sent to the application server logs until Confluence has completed its initial bootstrap. Any log entries will be repeated into the \(<\text{confluence-home}\>\log\) described below.
- Once the initial startup sequence is complete, all logging will be to \(<\text{confluence-home}\>/\text{logs/atlassian-confluence.log}\). For example: \(c:/\text{confluence/data/}\text{logs/atlassian-confluence.log}\).

Note that the default location is now the Confluence \text{home directory} instead of the application server's log file.

Java versions

Confluence 2.7 supports Java 1.4, Java 5 and Java 6. We recommend Java 6 because of its increased performance and easier troubleshooting, due to enhanced memory dump and profiling capabilities.

Advance notice: Java 1.4 will be deprecated in a future release. Confluence 2.8 will be the last version that supports Java 1.4.

Upgrade procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your \text{confluence.home directory and database}.
2. If your version of Confluence is earlier than 2.6.x, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from a version earlier than 2.6.0, please read the 2.6 upgrade notes.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 2.8.1 Release Notes

21 May 2008

Confluence 2.8.1 is a recommended upgrade which fixes some security flaws as well as other bugs in Confluence 2.8. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

Two of the bug fixes resolve problems with rendering a wiki page in Internet Explorer 6. Additionally, these fixes will significantly improve performance in some configurations of Confluence 2.8.

We have created some performance testing scripts, which will be particularly useful for large or mission-critical
Confluence installations.

Using a custom space logo caused some problems, particularly with Resin application server, where the page would sometimes hang and then display incorrectly. This is now fixed. There's a complete list of fixes below. Click a specific issue to see details of the fix.

**Don't have Confluence 2.8 yet?**  
Take a look at the new features and other highlights in the [Confluence 2.8 Release Notes](#).

![Download Latest Version]

### Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the [Confluence 2.8.1 Upgrade Notes](#). We strongly recommend that you back up your `confluence.home` directory and database before upgrading.

### Updates and Fixes in this Release

**Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.**

Confluence 2.8.1 Upgrade Notes

Confluence 2.8.1 is a recommended upgrade which fixes some security flaws as well as other bugs. You'll find details of the fixes in the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your `confluence.home` directory and database.

2. If your version of Confluence is earlier than 2.8.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.8 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.8.2 Release Notes

**3 July 2008**

**Confluence 2.8.2 is a recommended upgrade which fixes some security flaws and other bugs. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.**

This release fixes the ‘remember me’ problem encountered when using Confluence with Tomcat 5.5.26 or Tomcat 6, where logins are not remembered.

Confluence administrators will see a new link on the user profile screen, allowing them to move directly to the user management screen for that user.
This release also addresses some performance bugs:

- Label links, as well as the label summary pages, now include the 'nofollow' attribute to prevent search engines like Google from indexing them.
- We have increased the size of the UI templates cache, which should reduce the number of times Confluence needs to load resources.
- CSS caching has been improved. (Refer to CONF-11755 if you’d like to know the details.)
- When generating a URL for the multiple label filter, Confluence now sorts the labels in the URL alphabetically, ensuring that there is just one URL for each filter instead of possible multiple URLs. This should reduce the load on the server when search engine crawlers visit the Confluence site, because the crawlers no longer need to index multiple URLs.

The JIRA Issues macro now has improved caching. When trusted communication was first introduced, Confluence did not cache results for anonymous users or results retrieved using trusted communications. With Confluence 2.8.2, caching is implemented for both those cases. This fix should improve the performance of your JIRA site, because Confluence no longer needs to access the JIRA site as often.

There’s a complete list of fixes below. Click a specific issue to see details of the fix.

**Don’t have Confluence 2.8 yet?**

Take a look at the new features and other highlights in the Confluence 2.8 Release Notes.

---

**Upgrading from a Previous Version of Confluence**

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.8.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

**Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.**

Confluence 2.8.2 Upgrade Notes

Confluence 2.8.2 is a recommended upgrade which fixes some security flaws as well as other bugs. You’ll find details of the fixes in the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database. See the documentation on backing up your Confluence site.

2. If your version of Confluence is earlier than 2.8.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.8 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.0 first, confirm the upgrade was successful, then upgrade again from version 2.7.0 to version 2.8.2. For more
details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.8.3 Release Notes

Confluence 2.8.3 is the standard edition version of Confluence 2.8.x. This version of Confluence is equivalent to Confluence version 2.8.2, but it does not include Oracle's Coherence technology. Due to licensing changes with Oracle over the Coherence clustering and distributed caching technology, Atlassian is no longer able to distribute this technology to customers without a Confluence clustered license.

Therefore, Atlassian has released 'standard editions' for each previous major version of Confluence back to 2.6, which includes Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3. Confluence 2.8.3 will be the only Confluence 2.8.x version available to customers with a non-clustered Confluence license.

For its caching functionality, Confluence 2.8.3 utilises Ehcache. This functionality was provided by the Coherence technology in previous Confluence 2.8.x versions.

For more information about the features, updates and fixes in Confluence 2.8.2, please refer to the Confluence 2.8.2 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.8.2 Upgrade Notes. However, if you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read the Confluence 3.0.1 Upgrade Notes for important information about transferring your caching layer customisations from Coherence to Ehcache.

We strongly recommend that you back up your confluence.home directory and database before upgrading.

Confluence 2.8 Beta Release Notes

28 March 2008

Confluence 2.8 will be launched in a few weeks' time. These release notes apply to Confluence 2.8 Beta, which is currently undergoing internal testing. These release notes show the highlights of the upcoming release, although we have not included all the enhancements and bug fixes. We'll publish the final and complete release notes with the release of Confluence 2.8.0.

If you are interested in trying out a developer's release, please take a look at the information and warnings in Confluence Development Releases.

What's Coming in Confluence 2.8

1. Page Ordering

- One of the most popular feature requests is now reality — Confluence allows manual page ordering.
- You can choose the order in which wiki pages are displayed.
- Use a dynamic tree view to drag and drop your pages into the right position.
• Page order is reflected in all tree views for a space or a page family, including the PageTree macro and exports to PDF, HTML and XML.
• Read the documentation.

2 Dynamic Menus and Simplified Editing

• Drop-down menus replace tabs and links.
• Grouping of functions is more intuitive.
• Features are more visible than before — you may even come across things you didn't know Confluence had!
• Simplified screen design allows you to focus on editing the page content.
• There is more space for entering text.
• See an overview of the new menu structure and what's changed.

3 Collapsible Comments

• We’ve beautified the display of comments on pages and news items.
• You can collapse comments to a single line — just click the subject line of a single comment, or 'Collapse All'.
• It's easier to keep track of multi-level comment threads.
• When collapsed, a comment shows a single-line excerpt.
• The time stamp is relative for recent comments — for example, it might say 'less than a minute ago'.
• The new 'permanent link' icon makes it easier to link directly to a comment from another page.

4 Multiple Label Filter

• Combine more than one label in your label searches.
• Use ‘+’ and ‘-’ links to add or subtract labels from your search.
• Browse labels simply by typing in a URL, such as:

  http://CONFLUENCE_HOSTNAME/label/ShipIt+ideas

• Read the documentation.

5 And Lots More

• Enhanced Dynamic Tasklist.
• An installation wizard for the Confluence distribution on Windows and Mac.
• Significant performance improvements.
• More administration, management and monitoring tools.
• Plenty of bug fixes to keep everyone happy.

Confluence 2.8 Release Notes

10 April 2008

The Atlassian Confluence team is delighted to present Confluence 2.8.

We have simplified the screen design to focus on content. There's a totally new menu structure for editing or adding content and many other actions. We've also grouped the menu functions so that they are easier to use and understand. This will help new users start using Confluence quickly. For our faithful customers, you may find existing features you didn't know Confluence had!

The much voted for page-ordering feature allows you to define the order of your wiki pages yourself — just drag and drop your pages into the right position.
We've beautified the display of comments on pages and news items. With the multiple-label filter, you can combine more than one label in your label searches and surf labels directly via a sensible URL. Getting Confluence up and running is easier than ever with our new installer. An enhanced task list is bundled with Confluence, bringing faster response times and a simple yet powerful user interface.

There are some great performance enhancements and a lot for administrators and developers too.

- Thank you for all your issues and votes. Keep on logging, to help us keep improving!
- Below is a list of the highlights in this release.
- Attached is the full list of issues resolved in this release.

### Upgrading to Confluence 2.8?

- Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**
- If you are using any third-party plugins, please test them thoroughly before rolling 2.8 into production.
- Please refer to the Confluence 2.8 Upgrade Notes for further essential information about upgrading.

### Responding to your feedback:

- ★ 14 new feature requests implemented
- ★ 300+ votes satisfied

### Highlights of this release:

- Dynamic menus and simplified screen design
- Page ordering
- Collapsible comments
- Multiple-label filter
- Confluence installer
- Task list
- Performance enhancements
- Administration, management and monitoring
- Highlights for developers
- Over 100 fixes and improvements
- Special thanks

### Highlights of Confluence 2.8

1

**Dynamic menus and simplified screen design**

- Drop-down menus replace tabs and links.
- Grouping of functions is more intuitive.
- Features are more visible than before — you may even come across things you didn't know Confluence had!
- A cleaner screen design lets you focus on the page's content.
- It's simpler than ever to edit a page.
- There is more space for entering text.
- See an overview of the new menu structure and what's changed.
Page ordering

- One of the most popular feature requests is now a reality — Confluence allows manual page ordering.
- You can choose the order in which wiki pages are displayed.
- Use a dynamic tree view to drag and drop your pages into the right position.
- Page order is reflected in all tree views for a space or a page family, including the PageTree macro and exports to PDF, HTML and XML.
- Take a look at the documentation to learn more.

Collapsible comments

- We’ve beautified the display of comments on pages and news items.
You can collapse comments to a single line.
It's easier to keep track of multi-level comment threads.
When collapsed, a comment shows a single-line excerpt.
The time stamp is relative for recent comments — for example, it might say 'less than a minute ago'.
The 'permanent link' icon is back, after a temporary absence in Confluence 2.6. Instead of lurking behind the date, it's now a link icon at the bottom right of each comment.

Multiple-label filter
- Combine more than one label in your label searches.
- Use the `-` link next to the label name to subtract a label from your multiple-label search.
- Browse labels simply by typing in a URL, such as:

```plaintext
http://CONFLUENCE_HOSTNAME/label/fedex+ideas
```

- Take a look at the documentation to learn more.
Confluence installer

- The installation wizard lets you install the Confluence distribution without fuss or bother.
- Your Java environment is automatically configured.
- Confluence starts up in your browser after installation and leads you straight into the Setup Wizard.
- You can choose to install Confluence as a Windows service.
- Confluence appears in your Windows Start Menu.
- Read the documentation.

Task list

- The enhanced task list plugin is now bundled with Confluence.
- Permissions in the task list match the permissions of the page containing it.
- New user and group pickers help you to choose the right person or group.
- The sophisticated visual design suits the Confluence look and feel — take a look at the borders, icons,
Confluence 4.3 Documentation

Performance enhancements

- You will notice significant performance improvements in this release.
- A new gzip compression filter speeds up the transfer of data from Confluence and uses far less memory than the earlier implementation.
- The PDF space export uses less server memory.
- And more for the technically-minded:
  - The commonly-accessed resources use permanent client-side caching.
  - We have optimised some operations that were performed on every request, decreasing the average time taken to load a page.
  - We have optimised the database access for labels and attachments.
  - Where users belong to many groups, the retrieval of groups from LDAP is faster.
  - Access to Confluence's data storage mechanism (Bandana) has been made more granular, so that we don't load the entire context when retrieving individual keys from large contexts.

Administration, management and monitoring

- Confluence now supplies statistics and other information via a Java Management Extensions (JMX) interface. A number of third-party consoles will allow you to view the information and monitor your Confluence instance. There's more information in the documentation.
- The Plugin Repository client shows you which plugins are officially supported.
- You can raise a support request via the Administration Console.
- Troubleshoot your LDAP user management directly from the Administration Console.
- A new field on the System Information page displays the current access latency to the Confluence database — useful for diagnosing database network problems.
Highlights for developers

- Install custom path-mapping as part of your plugin, using the new Path Converter plugin modules — prettify your URLs.
- Include your JavaScript and CSS resources neatly, using the Web Resource plugin type.
- The Velocity template engine has been upgraded to version 1.5.
- We have begun a cleanup of the HTML and CSS for viewing and editing a page, moving towards semantic markup and web standards.
- We are moving towards standardisation on a single JavaScript library, based on jQuery. This is the supported JavaScript library for plugin developers. The benefits? No more conflicts between libraries. jQuery is fast. And there's less to learn!

Over 100 fixes and improvements

- The People Directory uses the hCard microformat for simple integration with a variety of microformat-enabled tools.
- And more.

Special thanks

We'd like to thank Shannon Krebs, David Peterson and David Chui in particular for their continuing contributions to the open-source Confluence plugin library.

The Confluence 2.8 team

Development

Bugfixing and maintenance
Chris Broadfoot
David Loeng
Paul Curren

Engine room
Andrew Lynch
Charles Miller
Christopher Owen
Don Willis

Page ordering
Anatoli Kazatchkov
Matthew Jensen

Team lead
Per Fragemann

UI overhaul
Agnes Ro
David Taylor
Dmitry Baranovskiy
Matt Ryall

Design
Issues resolved in Confluence 2.8

Below is the full list of issues resolved by Confluence 2.8. You can read the release notes here.

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Confluence 2.8 Screen and Menu Changes

Can't find a menu item in Confluence 2.8? That's understandable, because the user interface (layout of the screens and menus) in Confluence 2.8 has changed dramatically. This page contains a quick summary of the changes. Please read on for a quick and easy introduction.

Refer to Using the Confluence Screens for an overview of the new Confluence menu structure.

On this page:

- What's on this page?
- Confluence 2.8 User Interface in Detail
- New Menu Structure in Confluence 2.8
Changes to Menu Items in Confluence 2.8

Some of the Confluence documentation will not immediately reflect the new user interface in Confluence 2.8. We are working to rectify the situation as quickly as possible. In the interim, please use this page as a guide.

What's on this page?

The image below shows a Confluence 2.8 screen, with numbers added to the image. The numbers relate to a table of menu commands below the image, showing the new menu structure. Finally, there is a comprehensive table of menu commands, their new locations and how to get there.

Confluence 2.8 User Interface in Detail

The following screenshot and numbered list show the new menu layout in Confluence 2.8.

Screenshot: Confluence 2.8 Annotated User Interface Changes

New Menu Structure in Confluence 2.8

The numbers in this list relate to the numbers added onto the image above.

<table>
<thead>
<tr>
<th></th>
<th>'Space Menu' containing Pages, News, Labels, Attachments, Bookmarks, Mail, Advanced and Space Admin.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>'User Menu' containing Personal Space, Preferences, History, Administration (Confluence Administrators only) and Log Out.</td>
</tr>
<tr>
<td>2</td>
<td>'Edit Button' which opens the current page for editing.</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>
There may also be other items in this menu, depending upon the plugins you have installed on your Confluence site. For example, Add Diagram (Gliffy plugin) and Add Spreadsheet (EditGrid plugin).

- **Tools Menu** containing Attachments, History, E-mail, Favourite, Watch, Info, View Wiki Markup, Export to PDF, Export to Word, Copy, Move and Remove.

- **Labels**. This line shows tags attached to the current page.

### Changes to Menu Items in Confluence 2.8

This table lists every change to the menu structure that has occurred in Confluence 2.8. Names for some commands have changed, so the old menu option names are listed, next to the new names, with instructions for finding them. (You can search the text on this page for the name of a menu item you used to use in an earlier version of Confluence – you'll find instructions next to it.)

<table>
<thead>
<tr>
<th>Old items, now under Space Menu</th>
<th>New instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Space — Pages</td>
<td>Click ‘Space’, ‘Pages’</td>
</tr>
<tr>
<td>Browse Space — News</td>
<td>Click ‘Space’, ‘News’</td>
</tr>
<tr>
<td>Browse Space — Labels</td>
<td>Click ‘Space’, ‘Labels’</td>
</tr>
<tr>
<td>Browse Space — Attachments</td>
<td>Click ‘Space’, ‘Attachments’</td>
</tr>
<tr>
<td>Browse Space — Bookmarks</td>
<td>Click ‘Space’, ‘Bookmarks’</td>
</tr>
<tr>
<td>Browse Space — Mail</td>
<td>Click ‘Space’, ‘Mail’</td>
</tr>
<tr>
<td>Browse Space — Advanced options</td>
<td>Click ‘Space’, ‘Advanced’</td>
</tr>
<tr>
<td>Space Admin</td>
<td>Click ‘Space’, ‘Space Admin’</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Old items, now under Add Menu</th>
<th>New instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Page</td>
<td>Click ‘Add’, ‘Page’</td>
</tr>
<tr>
<td>Add News</td>
<td>Click ‘Add’, ‘News’</td>
</tr>
<tr>
<td>Add Comment</td>
<td>Click ‘Add’, ‘Comment’</td>
</tr>
<tr>
<td>Attachments tab</td>
<td>Click ‘Add’, ‘Attachment’</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>Click ‘Add’, ‘Add Bookmark’</td>
</tr>
</tbody>
</table>
Add other items to the page, as provided by plugins such as Gliffy diagrams and spreadsheets

Add Spreadsheet

Old items, now under Tools Menu

Attachments tab

View Page History

Email the page to someone

Favourite button

Watch button

Info tab

View Wiki Markup

View a printable version of the current page

Export to PDF

Export to Word

Copy (page)

Move (page)

Remove (page)

Miscellaneous page element(s)

Labels

(moved to the bottom of page content)

RELATED TOPICS

Using the Confluence Screens

Take me back to Confluence User's Guide

Confluence 2.8 Upgrade Notes

Below are some essential notes on upgrading to Confluence 2.8. For details of the new features and improvements in this release, please read the Confluence 2.8 Release Notes.

On this page:

- Upgrade Notes
  - Crowd Integration
Confluence 2.8 introduces the ability to move pages into any order you choose.

As part of the above feature, we have changed the default page order in Confluence, from simple alphabetical ordering to a 'natural' ordering. The natural ordering handles numeric values correctly when doing string comparisons.

Impact:

- The new natural ordering is the same as the ordering already used by the PageTree plugin, which some customers use to create a left-hand navigation panel.
- The change to natural ordering should have little effect on most users because, under most situations, natural ordering and alphabetical ordering will produce the same results.
- For customers who have inserted chapter or page numbers to force the correct order, the new natural ordering will show the existing pages in the correct order.

⚠️ If you do find that the order of your pages is adversely affected, you can use the new page-ordering function to move the pages.

Plugins

Please check the following if you have added any plugins to Confluence:

- If you are using any third-party plugins, please test them thoroughly before rolling 2.8 into production.
- The PageTree plugin has been updated. If you are using this plugin, please download the latest version to ensure compatibility with Confluence 2.8.

Velocity Template Engine

Confluence’s Velocity template engine has been upgraded from 1.3 to 1.5. Please test carefully for compatibility problems with existing third-party themes and plugins. For developers, there’s more information about Migrating to Velocity 1.5.

Dynamic Tasklist 2

The Dynamic Tasklist 2 plugin is now bundled with Confluence. The new tasklist macro replaces the older tasklist and dynamicTasklist macros. What happens to existing tasklists?
• By default, the new macro will be enabled and the older macros disabled in your Plugin Repository.
• When someone views a page containing an older version of the task list, the display will show the new format but the page will not be updated.
• When someone first adds a task or changes anything in the task list, the data will be converted to the new format.

Customised Page Layouts

The Confluence Upgrade Guide includes instructions on re-applying your customisations after the upgrade. We’re repeating some of that information here, because it’s particularly important due to the UI changes in this release.

If a space uses a customised page layout, the new Confluence 2.8 layout will not be applied. This means that you will not see the new menu structure within that space. For example, this will happen if you are using page tree navigation to form a table of contents on the left.

Fix: Apply the Default Page Layout, then re-insert your custom code.

Steps in detail:

1. Go to the Space Admin screen and click ‘Edit’ to view your customised Page Layout.
2. Copy the customised code.
3. Cancel the edit.
4. Click ‘Reset Default’ to apply the new Confluence 2.8 default page layout.
5. On the Space Admin screen, click ‘Create Custom’ to create a custom page layout.
6. Reinsert your customised code and click ‘Save’.

JavaScript Libraries

jQuery is the supported JavaScript library for plugin developers.

Advance notice — deprecated libraries: We have decided to standardise on jQuery as the JavaScript library for Confluence. This library will eventually replace all others. For this reason, use of the following JavaScript libraries in Confluence is deprecated:

- The Yahoo! User Interface Library (YUI)
- Prototype
- Scriptaculous

Because there is a lot of legacy plugin code using Prototype and Scriptaculous, these will continue to be available for at least one more major release of Confluence.

Java Versions

Confluence 2.8 supports Java 1.4, Java 5 and Java 6. We recommend Java 6 because of its increased performance and easier troubleshooting, due to enhanced memory dump and profiling capabilities.

Advance notice — Java 1.4 will be deprecated in a future release. Confluence 2.8 will be the last version that supports Java 1.4. Please refer to the Java 1.4 Support Timeline for more information.

Upgrade Procedure

⚠️ As always please test your upgrades in your TEST environment before rolling into PRODUCTION.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence installation directory and
your Confluence home directory, as directed in the Upgrade Guide. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 2.7.x, read the release notes and upgrade guides for all releases between your version and the latest version.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.0 first, confirm the upgrade was successful, then upgrade again from version 2.7.0 to version 2.8. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

5. If you encounter a problem during the upgrade, please create a support ticket and one of our support engineers will assist you through the process.

RELATED TOPICS

Confluence 2.8 Release Notes

Confluence 2.9.1 Release Notes

8 September 2008

Confluence 2.9.1 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

This release also addresses an issue relating to contributor filtering with LDAP. In the previous version, the search function was not able to filter results by authors from an LDAP directory. This fix requires an upgrade action; see the Confluence 2.9.1 Upgrade Notes for more information.

There's a complete list of fixes below. Click a specific issue to see details of the fix.

Don't have Confluence 2.9 yet?

Take a look at the new features and other highlights in the Confluence 2.9 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.9.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

Error rendering macro 'jiraissues' : JIRA project does not exist or you do not have permission to view it.

Confluence 2.9.1 Upgrade Notes

Confluence 2.9.1 is a recommended upgrade which fixes some security flaws as well as other bugs. You'll find
details of the fixes in the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.8.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.9 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Fix for Contributor Filtering LDAP Users

An issue was fixed in this release relating to search functionality and filtering by contributor. Authors from LDAP directories are now taken into account, however you will need to carry out the instructions to make sure all users are included in this feature.

Enabling Contributor Filtering for Search

Confluence 2.9 includes an enhancement to the search functionality which allows the filtering of search results by author or contributor. Unfortunately an existing bug in Confluence prevented this functionality from being used on sites that use LDAP for their user management.

Monitoring the Upgrade Task in Confluence 2.9.1

Confluence 2.9.1 fixes this defect and also includes an upgrade task that should ensure any existing content contributors are properly indexed and therefore available in the contributor filter auto-complete box.

Enabling this functionality is simply a case of installing Confluence 2.9.1 and watching your log file during start up for specific messages, such as the following.

```
Beginning PersonalInformation repair.
Found <n> usernames that need to be retrieved.
Finished Personal Information repair.
```

On a large external directory of users, it is possible that this task may take many minutes to run. However, the processing of this task will not delay the startup of Confluence.

Enabling Detailed Progress Reporting during Upgrade

If you wish to see more detailed progress reporting during the upgrade, you will need to carry out the following steps.

To enable detailed progress reporting,
1. Enable **Debug** level logging for the logger called `com.atlassian.confluence.upgrade.PersonalInformationRepairTask`.

2. During startup of Confluence, you should also see additional progress reporting messages similar to the following:

   Created 10 from `<n>` missing Personal Information objects.
   Created 20 from `<n>` missing Personal Information objects.
   Created 30 from `<n>` missing Personal Information objects.

---

**Manually Instigating the Fix**

Should you discover any problems during the repair task (as reported in the logs), then a Confluence Administrator can manually rerun the task by visiting the following page.

```<confluence base URL>/admin/createMissingPersonalInfo.jsp```

That page presents a single button that will re-run the repair task. In addition to the logging noted previously, the same messages will be returned to the administrator's browser.

**Actions Taken when Running the Fix**

There is no functional cost to running this fix. Should you accidentally run it too frequently, there is no functional implication. It is worth being aware of what is happening in the back-end so you can schedule a relevant time to perform it. While the fix is running, the following occurs:

- Two database queries are run to find the missing contributors, each involving an inner join against the same table.
- Each missing user is requested from the LDAP server by username.
- Each missing user will lead to a row insert in the database (these are batched).

---

**Restoring Inherited Page Permissions After 2.9 Upgrade**

Confluence instances that were upgraded to Confluence 2.9 are affected by a vulnerability. Child pages under a page protected by permissions are not protected by inherited permissions, as they should be. Please note that new installs of Confluence 2.9 which were not an upgrade from an old version are **not** affected.

Carry out the steps below to rectify the situation.

**To Restore Inherited Page Permissions After Upgrading to Confluence 2.9,**
1. Log into Confluence as 'Administrator'.
2. Access this specific page in Confluence:

   CONFLUENCE_HOME/admin/permissions/pagepermsadmin.action

   (replace 'CONFLUENCE_HOME' with the domain name of your own Confluence instance).
3. On that page, a single button is visible, entitled 'Rebuild Ancestor Table'. Click that button. It will report its success.
4. Now, go to the 'Confluence Admin' page. Here, click 'Cache Statistics' from the left navigation bar. A long list appears.
5. Find 'Inherited Content Permissions' in the list. Now, click the 'Flush' button to the right of 'Inherited Content Permissions'.
6. Inherited permissions will now be applied.

Read more about this vulnerability in the Security Advisory.

Confluence 2.9.2 Release Notes

14 October 2008

Confluence 2.9.2 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

You can now view the Wiki Markup code for previous versions of a page as well as the current version. Open a previous version from the page history, then select 'View Wiki Markup' from the 'Tools' menu. Previously, a bug caused Confluence to show the Wiki Markup only for the current version of the page.

Another bug caused an error to occur when you copied a page and tried to add an attachment before saving the page. This is now fixed, along with a number of other issues.

Don't have Confluence 2.9 yet?

Take a look at the new features and other highlights in the Confluence 2.9 Release Notes.

Upgrade from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.9.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

Error rendering macro 'jiraissues': JIRA project does not exist or you do not have permission to view it.

Confluence 2.9.2 Upgrade Notes

Confluence 2.9.2 is a recommended upgrade which fixes some security flaws as well as other bugs. You'll find details of the fixes in the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest
1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.9.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.9 upgrade notes and the 2.9.1 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.9.3 Release Notes

Confluence 2.9.3 is the standard edition version of Confluence 2.9.x. This version of Confluence is equivalent to Confluence version 2.9.2, but it does not include Oracle’s Coherence technology. Due to licensing changes with Oracle over the Coherence clustering and distributed caching technology, Atlassian is no longer able to distribute this technology to customers without a Confluence clustered license.

Therefore, Atlassian has released 'standard editions' for each previous major version of Confluence back to 2.6, which includes Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3. Confluence 2.9.3 will be the only Confluence 2.9.x version available to customers with a non-clustered Confluence license.

For its caching functionality, Confluence 2.9.3 utilises Ehcache. This functionality was provided by the Coherence technology in previous Confluence 2.9.x versions.

For more information about the features, updates and fixes in Confluence 2.9.2, please refer to the Confluence 2.9.2 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.9.2 Upgrade Notes. However, if you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read the Confluence 3.0.1 Upgrade Notes for important information about transferring your caching layer customisations from Coherence to Ehcache.

We strongly recommend that you back up your confluence.home directory and database before upgrading.

Confluence 2.9 Release Notes

7 August 2008

With great pleasure, Atlassian presents Confluence 2.9.

First up is the Search. The new screen design focuses the eye on your search term and results. To help you find information more quickly, Confluence now searches all content types by default and puts the most relevant results at the top of the list. Because a wiki is all about people, Confluence treats personal information as the most relevant. With author filtering, you can now find content written by a specific person.

The macros bundled with Confluence have been treated to a major overhaul. The Chart and Gallery macros offer sophisticated new displays and more interactivity. The revised Pagetree macro is now included in the Confluence download. Try using the Pagetree to add a navigation panel to your pages. We have added some popular new features and fixed a number of much-voted-for bugs in other macros too.

When you are editing a page, Confluence now automatically saves your work and displays the time of the last auto-save. If something goes wrong, you can quickly retrieve your work by selecting 'Drafts' from the user menu.

Other features include resetting page order to alphabetical and some much-needed help in the ongoing battle
Highlights of this Release:

- Streamlined Search
- Auto Save
- Charts
- Page Tree
- Gallery
- New Tutorial
- More in the Menus
- Alphabetical Page Ordering
- Better Spam Prevention
- Plugin Repository
- Engine Room and Developers' Community
- More than 140 Fixes and Improvements
- Special Thanks

Responding to your Feedback:

⭐ 210 votes satisfied

Upgrading from a previous version of Confluence

- **Confluence 2.9 requires Java 5 at a minimum**, and will no longer work with Java 1.4. Before upgrading to Confluence 2.9, please refer to the [Confluence 2.9 Upgrade Notes](https://confluence.org) for more details on this change.
- Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**
- Please refer to the [Confluence 2.9 Upgrade Notes](https://confluence.org) for further essential information about plugins and other factors affecting your upgrade.

Highlights of Confluence 2.9

1

**Streamlined Search**

- The redesigned Search screen helps you to focus on the search term and results, by simplifying the filter box and other parts of the screen.
- By default, the search now includes all spaces and all content types: pages, news items, comments and so on.
- You can filter the search results by space, content type and date modified.
- If your Confluence site uses the standard out-of-the-box configuration for user management, you can also filter the search results by contributor.
- The search results are weighted to give personal information the highest relevance, followed by pages, news items and the other content types.
- When using the [Search macro](https://confluence.org) or the [Search API](https://confluence.org), you can now also filter by contributor.
- Take a look at our documentation for more details on the search and the ranking of search results.
### Auto Save

- Confluence automatically saves your work to a draft while you are adding or editing a page.
- Now with release 2.9, a message near the ‘Save’ button shows the time of the latest auto-save.
- If something goes wrong, retrieve the saved draft easily from the dropdown menu under your name.
- You can read more about drafts in the documentation.


## Charts

- The Chart macro presents a sophisticated new look.
- Below are some example charts displayed on a Confluence page.
- The [documentation](#) shows you how to add the macro to your page and choose different formats and types.

![My charts](image)

**Revenue and expenses**

**Fish sold**

**Customer satisfaction**

**Customer satisfaction**

---

## Page Tree

- The Pagetree macro is now bundled as part of your Confluence installation.
- It displays a dynamic, hierarchical list of pages which you can use as a table of contents or a navigation tool.
panel.
- You can choose to include a search box above the tree of pages or on its own.
- New links allow viewers to collapse or expand all branches in the tree at once.
- There are a number of options for specifying the root of the page tree. For example, you can show children of the current page, or children of the current page's parent, or all pages in the space.
- Take a look at the [documentation](#) to see the complete list of options.

### Gallery

- Use the Gallery macro to display a set of pictures on a page.
- Now you can include or exclude individual pictures, or simply display all the images at once.
- Choose pictures from the current page or another Confluence page.
- Take a look at the [documentation](#) for help on these and other options.

![My picture gallery](image)

**Add** by [Sarah Maddox](#), last edited by [Sarah Maddox](#) on Jul 23, 2008 (view change)

**Atlassian T-shirts**

- Viewers can click an image to zoom in and view the gallery as a slide show.
New Tutorial

- When you download Confluence and choose to include the sample content, you will receive a new Demonstration Space.
- There's a tutorial for those are new to Confluence or new to wikis.
- Other users will enjoy the advanced topics and links to more information.
- You can use the tutorial as a quick-start guide for new starters in your organisation.
More in the Menus

- The Space menu which appeared in Confluence 2.8 has now been renamed to ‘Browse’. Faithful Confluence users will recognise and welcome this old friend.
- The Browse menu now includes the People Directory, Space administration and Confluence administration for authorised users.
- You can now reach your personal labels, watches and drafts directly from the dropdown menu under your name on any Confluence page.

Alphabetical Page Ordering

- By default Confluence orders your pages alphabetically, but you can drag and drop them into any order you like.
- Now Confluence 2.9 allows you to reset the page order to alphabetical, just by clicking the icon next to the parent page.
- The documentation tells you more.
Better Spam Prevention

- A new link on the user profile screen allows administrators to jump directly to the user management screen — handy for dealing with those pesky spammers of the human variety.
- We have enhanced Confluence’s Captcha functionality to strengthen the barrier against non-human spammers such as bots or web spiders.
- Captcha is now active on user profile pages as well as other pages.
- The image which Captcha displays is now even more difficult for non-humans to read. Take a look at the word ‘brihter’ in the screenshot below.
- You can read the instructions on configuring Captcha behaviour.
Plugin Repository

- The Plugin Repository shows more consistent information about the plugins on your Confluence site, including the system and bundled plugins which are shipped with Confluence.

Engine Room and Developers' Community

- Confluence's request throughput has been improved, thanks to better class- and resource-loading strategies.
- Startup time has also been reduced. This is particularly good for developers and anyone who needs to restart Confluence often.
- The Search API now allows you to filter search results by contributor.
- As part of the ongoing work to make it easier for internal developers and plugin developers to work on Confluence, this release includes re-factorings of some web action classes.
- To improve Confluence's resistance to cross site scripting security vulnerabilities, we have added an experimental automatic HTML entity encoding feature. This is the first step to providing a more secure product by default.

More than 140 Fixes and Improvements

- Take a look at the complete list of issues resolved in Confluence 2.9.

Special Thanks

We'd like to say thank you to Zohar Melamed and Shannon Krebs, who wrote the original Pagetree and Pagetree Search plugins.

The Confluence 2.9 Team

Development

Bugfixing and maintenance
Anatoli Kazatchkov
Brian Nguyen
Chris Broadfoot
Chris Kiehl
Don Willis

Design
Jason Taylor
Stephen Russell

Editor and page tree improvements
Agnes Ro
David Taylor
Dmitry Baranovskiy
Matt Ryall

Engine room
Confluence 2.9 Upgrade Notes

Below are some essential notes on upgrading to Confluence 2.9. For details of the new features and improvements in this release, please read the Confluence 2.9 Release Notes.
Upgrade Notes

Plugins

Please check the following if you have added any plugins to Confluence:

- If you are using any third-party plugins, please test them thoroughly before rolling 2.9 into production.
- If you have installed the Gallery plugin onto your Confluence site, please remove it (or do not reinstall it after upgrading Confluence) in order to get the benefit of the new Gallery macro. The Gallery macro has been significantly improved in this release. It now incorporates features which were previously available only in the separate Gallery plugin.
- If you have installed the PageTree plugin or the Pagetree Search plugin onto your Confluence site, please remove them (or do not reinstall them after upgrading Confluence) in order to get the benefit of the new Pagetree macro. The Pagetree macro has been significantly improved in this release. It replaces the previous PageTree plugin, and incorporates the pagetree search option.
- If you are using the Blog Posts macro, be aware that invalid space keys will now be detected and cause the macro to fail. Previously they were ignored and blog posts from all spaces were returned.

Java Versions

Java 1.4 is not supported in Confluence 2.9 and later. Please refer to the Java 1.4 Support Timeline for more information.

Before upgrading to Confluence 2.9, you will need to ensure your environment is running at least Java 5.

Confluence 2.9 supports Java 5 and Java 6. We recommend Java 6 because of its increased performance and easier troubleshooting, due to enhanced memory dump and profiling capabilities.

You can check your current Java version in Confluence:

1. Choose Browse > Confluence Admin.
2. Select 'System Information' from the 'Administration' section in the left-hand panel.
3. Refer to 'Java Version'.
   - If the version is 1.5 or higher, you do not need to do anything.
   - If the version is 1.4, you need to upgrade your JDK before you can upgrade to Confluence 2.9.

If you are running the Confluence EAR-WAR edition against your own application server, you will need to check with your application server vendor about which JDK versions are supported.

Supported Databases and Application Servers Additions to Application Server Support

We have added the following versions to the list of officially supported application servers:

- Resin 3.0 and 3.1
- Tomcat 6 (see known issue with authenticated datasources)

Platforms No Longer Supported
The following platforms were on the ‘unsupported but working’ list for Confluence 2.8. They are not on that list as of Confluence 2.9. They probably still work, but we have not tested them. Please upgrade soon.

- MySQL 4.0 — please upgrade to MySQL 5
- SQLServer 2000 — please upgrade to SQLServer 2005
- Websphere 6.0 — please upgrade to Websphere 6.1
- Weblogic 8.1 — please upgrade to Weblogic 9.2

Please refer to the list of supported application servers and databases on our Supported Platforms topic for the updated matrix.

**Advance Notice — Changes to Supported Platforms in the Next Release**

The next major release of Confluence after 2.9 will **not** support the following platforms/versions any more. We will still test those platforms infrequently, and Confluence will probably still work fine with them for a while, but they will be not officially supported.

- MySQL 4.1 — please upgrade to MySQL 5
- Tomcat 5.0 — please upgrade to Tomcat 5.5 or 6
- Resin 2 — please upgrade to Resin 3
- JBoss 4.0.x — please upgrade to JBoss 4.2.x

**JavaScript Libraries**

**jQuery** is the supported JavaScript library for plugin developers.

**Advance notice — deprecated libraries:** We have decided to standardise on **jQuery** as the JavaScript library for Confluence. This library will eventually replace all others. For this reason, use of the following JavaScript libraries in Confluence is **deprecated**:

- **Prototype**
- **Scriptaculous**

Because there is a lot of legacy plugin code using Prototype and Scriptaculous, these will continue to be available for this release of Confluence.

The **Yahoo! User Interface Library (YUI)** has been removed from this release, following its deprecation in Confluence 2.8.

**Confluence Themes**

**Advance notice — The Confluence Classic Theme will be deprecated in a future release.** Confluence 2.9 will be the last version that supports the Confluence Classic Theme. This theme uses outdated typography and formatting, which was replaced by the new-look Default Theme in Confluence 2.6. At that time, we introduced the Classic Theme to minimise the impact on customers who relied on the older typography. After Confluence 2.9, the Classic Theme will no longer be supported.

**Upgrade Procedure**

**Upgrade a test environment first**

As always please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:
1. Before you upgrade, we strongly recommend that you back up your Confluence home directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.

2. If your version of Confluence is earlier than 2.8.x, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.8 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.7.0 first, confirm the upgrade was successful, then upgrade again from version 2.7.0 to version 2.8.2. For more details, please refer to CONF-11767.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

5. If you encounter a problem during the upgrade, please create a support ticket and one of our support engineers will assist you through the process.

RELATED TOPICS

Confluence 2.9 Release Notes

Issues resolved in Confluence 2.9

Below is the full list of issues resolved by Confluence 2.9. You can read the release notes here.

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Confluence 2.10.1 Release Notes

7 January 2009

Confluence 2.10.1 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

A bug was identified in Confluence version 2.10.0 that made the label parameter of the Content by Label Macro case-sensitive. This resulted in link breakages where differences existed in case usage between {contentbylabel} label parameter values and the page labels they referenced. However, this issue has now been fixed.

Another issue was identified in Confluence version 2.10.0 that prevented specific Confluence components (for example, those of the Rich Text Editor) from loading correctly when running Confluence behind certain proxy server configurations. For example, this may have become apparent when running Confluence behind an Apache HTTP Server using the mod_proxy connection module. This issue has also been fixed in Confluence version 2.10.1, along with a number of other issues.

There's a complete list of fixes below. Click a specific issue to see details of the fix.

Don't have Confluence 2.10 yet?

Take a look at the new features and other highlights in the Confluence 2.10 Release Notes.

Download Latest Version
Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.10.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (23 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>📖</td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>CONF-13969</td>
</tr>
<tr>
<td>CONF-13942</td>
</tr>
<tr>
<td>CONF-13934</td>
</tr>
<tr>
<td>CONF-13930</td>
</tr>
<tr>
<td>CONF-13900</td>
</tr>
<tr>
<td>CONF-13892</td>
</tr>
<tr>
<td>CONF-13865</td>
</tr>
<tr>
<td>CONF-13846</td>
</tr>
<tr>
<td>CONF-13702</td>
</tr>
<tr>
<td>CONF-13524</td>
</tr>
</tbody>
</table>
Confluence 2.10.1 Upgrade Notes

Confluence 2.10.1 is a recommended upgrade which fixes some security flaws as well as other bugs. You'll find details of the fixes in the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.10, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.10 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 2.10.2 Release Notes

18 February 2009

Confluence 2.10.2 is a recommended upgrade which fixes a security flaw and other issues.

Please refer to the security advisory for details of the security vulnerability, risk assessment and mitigation strategies.

Rich Text Editor fixes

A bug was identified in Confluence version 2.10, which affected the Rich Text Editor in Internet Explorer browsers. This bug prevented new content that was entered into a single line break between existing chunks of
Confluence 4.3 Documentation

text from being saved. For instance, if a user placed their cursor on a single blank line (or line break) between two existing sections of text, entered new text (consisting of any number of paragraphs) and saved it, the new text would not be saved. This issue has now been fixed.

Another issue was identified in the Rich Text Editor which made text appearing immediately under an image concatenate with the image's Wiki Markup when the page content was saved. This prevented the image from being displayed. While inserting an additional line break between the image and text provided a workaround, this issue has now been fixed and this workaround is no longer required.

Content by Label Macro fixes

A bug was identified in the Content by Label Macro that prevented its sort parameter from functioning correctly. However, this has now been fixed. Furthermore, the performance of the Content by Label Macro has been improved.

With the release of Confluence 2.10, the default behaviour of the Content by Label Macro's space parameter was modified to @self. Due to customer feedback and popular demand, however, we reverted this parameter's default behaviour back to @all.

Other fixes

A stability issue was identified in Confluence version 2.10 which has now been fixed. However, a minor side effect has been identified which can result in some superfluous non-breaking spaces not being removed from the end of lines, when either saving a page or switching from the Rich Text Editor to Wiki Markup modes.

A bug was identified in Confluence version 2.10 that prevented Confluence from playing SWF files with Flash Player 10 in Internet Explorer. This has now been fixed.

Some issues were identified with the Code Block Macro in Confluence 2.10, which resulted in the removal of white space within a code block when switching from Wiki Markup to Rich Text Editor modes. However, a fix was introduced to mitigate these issues.

An issue was identified when Viewing Pages Alphabetically, which prevented Confluence from listing pages by specific letters of the alphabet when 1,000 or more pages started with any one letter of the alphabet. This issue has now been fixed.

When writing content in Wiki Markup, URLs containing accented characters now render correctly into links. Additionally, Confluence's French and German product interface translations have been improved.

There's a complete list of fixes below. Click a specific issue to see details of the fix.

Don't have Confluence 2.10 yet?

Take a look at the new features and other highlights in the Confluence 2.10 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.10.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

<table>
<thead>
<tr>
<th>JIRA Issues (47 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>Issue</td>
</tr>
<tr>
<td>-------</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>![icon]</td>
</tr>
<tr>
<td>#</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>🔴</td>
</tr>
<tr>
<td>Ticket</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>CONF-14020</td>
</tr>
<tr>
<td>CONF-14018</td>
</tr>
<tr>
<td>CONF-14006</td>
</tr>
<tr>
<td>CONF-14002</td>
</tr>
<tr>
<td>CONF-13974</td>
</tr>
<tr>
<td>CONF-13965</td>
</tr>
<tr>
<td>CONF-13937</td>
</tr>
<tr>
<td>CONF-13825</td>
</tr>
<tr>
<td>CONF-13824</td>
</tr>
<tr>
<td>CONF-13707</td>
</tr>
<tr>
<td>Issue ID</td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>CONF-13694</td>
</tr>
<tr>
<td>CONF-13677</td>
</tr>
<tr>
<td>CONF-13588</td>
</tr>
<tr>
<td>CONF-13435</td>
</tr>
<tr>
<td>CONF-13119</td>
</tr>
<tr>
<td>CONF-13028</td>
</tr>
<tr>
<td>CONF-12809</td>
</tr>
<tr>
<td>CONF-12707</td>
</tr>
<tr>
<td>CONF-12475</td>
</tr>
<tr>
<td>Issue Key</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CONF-11795</td>
</tr>
<tr>
<td>CONF-10174</td>
</tr>
<tr>
<td>CONF-9715</td>
</tr>
<tr>
<td>CONF-9635</td>
</tr>
<tr>
<td>CONF-9213</td>
</tr>
<tr>
<td>CONF-8865</td>
</tr>
<tr>
<td>CONF-5322</td>
</tr>
</tbody>
</table>

Click [here](http://jira.atlassian.com) to open a report on [http://jira.atlassian.com](http://jira.atlassian.com) for Resolved or Closed issues in Confluence 2.10.2.

**Confluence 2.10.2 Upgrade Notes**

Confluence 2.10.2 is a recommended upgrade which fixes some security flaws as well as other bugs. You’ll find details of the fixes in the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.10, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.10 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Confluence 2.10.3 Release Notes

15 April 2009

Confluence 2.10.3 is a recommended upgrade which fixes some security flaws and other issues.

Please refer to the security advisory for details of the security vulnerabilities, risk assessments and mitigation strategies.

General Fixes

A bug was identified, whereby viewing or editing restrictions could not be assigned to a page, whose parent page contained an apostrophe in its title and also possessed existing page restrictions. This bug has now been fixed.

When a user is restricted from viewing a page, Confluence presents them with a more informative Access Denied error rather than a general Page Not Found error.

When the {gallery} macro is used on a page with no parameters or image attachments, it would render into an error in HTML or PDF exports. This issue has now been fixed.

An issue was identified whereby under certain circumstances, clicking on a page's or blog's thumbnail image to expand it would result in a Runtime Error in Internet Explorer versions 6 and 7. This issue has now been fixed.

Widget Connector Plugin

Several new features have been added to the Widget Connector Plugin packaged with Confluence 2.10.3, including support for new widget, video and micro-blogging sites. Other supported features include Google Calendar and the Wufoo HTML Form Builder. For more information on how to add these features to your Confluence page or blog, refer to Widget Connector Macro.

Episodic made changes to the format of IDs they designate for all new videos, allowing them to be alphanumeric rather than solely numeric. The Widget Connector plugin has been updated to support this new URL format.

Engine Room Fixes

An issue was identified in Confluence's PDF Export feature that could result in memory leaks. These in turn may have affected the performance and stability of Confluence instances. This issue has now been fixed.

A few other issues were identified which under certain or specific circumstances, could affect the stability of Confluence. However, these have now been fixed.

There’s a complete list of fixes below. Click a specific issue to see details of the fix.

Don’t have Confluence 2.10 yet?

Take a look at the new features and other highlights in the Confluence 2.10 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.10.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
## JIRA Issues (31 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📌</td>
<td>CONF-21022</td>
<td>Provide option to return unauthorized message rather than 404 when user does not have permissions for page</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Won't Fix</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-17439</td>
<td>Fix the 2.10 patch for link insertion point in IE.RTE</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-15541</td>
<td>Previewing a page does not display long content when Confluence is embedded in a frame</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Invalid</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14988</td>
<td>SAXParser memory leaks</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14922</td>
<td>com.sun.pdfview.font.Type1CFont.readCommand(Type1CFont.java:357) consumes 100% CPU, blocks all other pdf threads</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14849</td>
<td>Discarding a draft and refreshing the page results in an error</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14775</td>
<td>Add new filter and response wrapper to prevent header injection attacks</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14753</td>
<td>XSS vulnerability can be exploited with the Page Index macro</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14704</td>
<td>Improper sanitisation of attachment filenames allows header injection</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📌</td>
<td>CONF-14537</td>
<td>Can not alter the permissions on a</td>
<td><img src="image" alt="Resolved" /></td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14510</td>
<td>Fix upgrade tasks that access the database through a connection from the HibernateSession which is later garbage collected</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14493</td>
<td>Password is being logged for 500 errors</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14386</td>
<td>Empty gallery macro throws error in HTML and PDF export</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14337</td>
<td>XSS in the Widget Connector</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14326</td>
<td>Site search query box and submit button too small with Left Nav theme and Clickr theme</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14310</td>
<td>Studio plugins: Using components not available to plugins</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14178</td>
<td>System error when adding users to a group if the group name contains a space</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14127</td>
<td>New evaluation expiry message</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-14102</td>
<td>anti-XSS mode breaks RTE-by-default editing and view page source</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Ticket</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>-----</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>CONF-14092</td>
<td>AspectJ caused CAC crash 2008-12-31</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>CONF-13785</td>
<td>Errors when exporting demonstration space after migration to 2.10-m8</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>CONF-13771</td>
<td>HTML export results in NPE from requireResource velocimacro when used by plugins</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CONF-13494</td>
<td>SOAP calls break when trying to write (tasklist) macro in contents</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>CONF-13331</td>
<td>Search box display issue when not using default theme in IE and FireFox</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>CONF-13316</td>
<td>NullPointerException thrown if user cannot move attachments</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>CONF-13063</td>
<td>Confluence Advanced Search Pane search text box is flattened vertically in 2.91 using Left Navigation Theme</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>CONF-12835</td>
<td>Error in Java Script when adding an image thumbnail and clicking on it</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>CONF-12366</td>
<td>Image width and height are to 32 by wysiwyg editor for missing image files.</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>CONF-11552</td>
<td>height and width of embedded movies is</td>
<td>✅</td>
<td>Resolved</td>
<td></td>
</tr>
</tbody>
</table>
Click [here](http://jira.atlassian.com) to open a report on Conf-9239 for Resolved or Closed issues in Confluence 2.10.3.

**Confluence 2.10.3 Upgrade Notes**

Confluence 2.10.3 is a recommended upgrade which fixes some security flaws as well as other bugs. You'll find details of the fixes in the release notes.

**Upgrade Procedure**

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your confluence.home directory and database.

2. If your version of Confluence is earlier than 2.10, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.10 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

**Confluence 2.10.4 Release Notes**

Please skip this version and upgrade to Confluence 3.0 or later

Please be advised that there is a known bug in Confluence 2.10.4, whereby the ehcache.xml file is completely missing and there is no 'Cache Statistics' link on the Administration console. If the link http://.../admin/cachestatistics.action is directly accessed, a blank page is returned with no cache statistics details. Please upgrade to the latest version of Confluence 3.x, as indicated in the release notes. If you cannot upgrade to Confluence 3.x, please contact our support team.

**Confluence 2.10.4** is the standard edition version of Confluence 2.10.x. This version of Confluence is equivalent to Confluence version 2.10.3, but it does not include Oracle's Coherence technology. Due to licensing changes with Oracle over the Coherence clustering and distributed caching technology, Atlassian is no longer able to distribute this technology to customers without a Confluence clustered license.

Therefore, Atlassian has released 'standard editions' for each previous major version of Confluence back to 2.6,
which includes Confluence versions 2.10.4, 2.9.3, 2.8.3, 2.7.4 and 2.6.3. Confluence 2.10.4 will be the only Confluence 2.10.x version available to customers with a non-clustered Confluence license.

For its caching functionality, Confluence 2.10.4 utilises Ehcache. This functionality was provided by the Coherence technology in previous Confluence 2.10.x versions.

For more information about the features, updates and fixes in Confluence 2.10.3, please refer to the Confluence 2.10.3 Release Notes.

Upgrading from a Previous Version of Confluence

Upgrading Confluence should be fairly straightforward. Please read the Confluence 2.10.3 Upgrade Notes. However, if you have customised the cache settings in your installation of Confluence (e.g. for performance reasons), then please read the Confluence 3.0.1 Upgrade Notes for important information about transferring your caching layer customisations from Coherence to Ehcache.

We strongly recommend that you back up your confluence.home directory and database before upgrading.

Confluence 2.10 Release Notes

⚠️ Confluence 2.10 fixes some security flaws. Please refer to the security advisory for details of the security vulnerabilities, risk assessment and mitigation strategies.

3 December 2008

With great pleasure, Atlassian presents Confluence 2.10.

Confluence 2.10 is a major release which presents a number of new features and enhancements. With Confluence 2.10 we introduce the new Widget Connector, an easy way to embed multi-media content from all over the web directly into your Confluence page. Add Youtube videos, Flickr slide shows and Google Gadgets just to name a few. Now that the improved Office Connector is bundled with Confluence 2.10, you can also display the contents of attached documents, spreadsheets, presentations, and PDFs directly on any page. Also, with the new Office Connector, you can now view the contents of attachments using the new 'View' feature from the attachments page, or from a search.

In Confluence 2.10, finding all your content in Confluence is a lot easier. With Quick Navigation just start typing in the search box and immediately see suggested results. With OpenSearch autodiscovery, you can add Confluence search to your Firefox or IE7 search box with just one click. And with 'Did You Mean', you no longer have to worry about mistyping search terms since Confluence now suggests corrections to misspelled words. Take a look at the new search results page, you'll find the right page, attachment or person far more easily.

You can better control your avatar with new profile picture cropping and spruce up your personal space with custom stylesheets. Page editing has become more reliable through an upgrade to our rich text editor which now supports Safari and has a new styles dropdown. JIRA users will be delighted to use our new JIRA Issues Macro with drag and drop column sorting, paging and support for custom fields.

Confluence administrators will benefit from improved user management, a broader range of supported wikis for the Universal Wiki Converter and some good performance improvements.

Please see our overview video to see a demonstration of the new features in Confluence 2.10.

Highlights of this Release:

- Introducing the Widget Connector
- Improved Office Connector Now Bundled
- Introducing Quick Navigation
- 'Did You Mean', OpenSearch and More
- Custom Stylesheets for Confluence Spaces
- Updated JIRA Issues Macro with Custom Fields and Dynamic Display
• Enhanced User and Group Management
• Upgraded Rich Text Editor
• Universal Wiki Converter now with SharePoint Import and More
• Improved Activity Macros
• Plugin Framework 2
• More than 250 Fixes and Improvements

Responding to your Feedback:
🌟 720+ votes satisfied
🌟 11 new feature requests implemented

Thank you for all your issues and votes. Keep logging, to help us keep improving!
Below is a list of the highlights in this release.
Attached is the full list of issues resolved in this release.

Upgrading from a previous version of Confluence

• Upgrading Confluence should be fairly straightforward. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.
• Please refer to the Confluence 2.10 Upgrade Notes for further essential information about plug-ins and other factors affecting your upgrade.

Highlights of Confluence 2.10

1

Introducing the Widget Connector

Now you can embed multi-media content from other web sites into a Confluence page. Bring your wiki page to life with Google Gadgets, videos, slide shows, Twitter messages and more. Simply type the word '{widget}' and give it the web address of the content you want to embed.

• Gadgets: Google Gadgets.
• Videos: YouTube, MySpace Video, Google Video, Episodic, Vimeo, Metacafe, blip.tv, Viddler.
• Photos and images: Flickr, Skitch.com.
• Micro-blogging: Twitter, FriendFeed.
• Documents and presentations: SlideShare, SlideRocket, Scribd, presentations on Google Docs.
• Our documentation shows you what to do.
Improved Office Connector Now Bundled

The Office Connector is shipped as part of Confluence 2.10. There is no need to install it separately. Use the Office Connector to create and edit rich content for Confluence using Microsoft Office or OpenOffice.

- The new 'View' feature lets you view Office documents from the Search results, from the Attachments page and from a list of attachments displayed by the Attachments macro. You do not need to have Office installed on your machine to view an Office document in Confluence.
- We have also fixed a number of bugs in the Office Connector. See the list of fixes.
- See all the features of the Office Connector in our documentation.
Introducing Quick Navigation

Confluence's search box now offers a quick navigation feature, the fastest way to find content in Confluence.

- Start typing your search term. Confluence matches titles as you type, showing a quickly-adjusting list of pages, news items, personal profiles, attachments and so on.
- The matching items are grouped by content type so that you can quickly find the type you want.
- When the matching item is a person's name, their profile picture appears next to their name in the list.
- Still not found what you are looking for? Click the 'Search' option at the bottom of the list to do a full search.
'Did You Mean', OpenSearch and More

Confluence 2.10 includes a number of improvements to the Search functionality.

- Find what you're looking for even if you mistype your search term. Confluence's new 'Did you mean' feature analyses your search term and suggests an alternative spelling to give you more relevant search results.
- You can now search Confluence from the convenience of your browser's search box, if you are using Firefox or IE7. Just add your Confluence site as a search provider, via the dropdown menu next to the browser's search box. This is because Confluence now supports the autodiscovery part of the OpenSearch standard.
- We have also improved the layout of the Search screen so that it is easier to read. The titles now stand out more and a longer extract is shown.
- If the matching item is a person, the profile picture and other profile information appear in the search results.
- If the matching item is an attached Office document, a new 'View' link allows you to view the document online.
- There is a search box at the bottom as well as the top of the screen, so you do not need to scroll up to enter a new search term.
- The 'Clear Filter' link replaces the old 'Clear Search', and now just clears the filter criteria instead of the entire search.
- When ranking the search results, Confluence now gives slightly higher priority to pages created recently.
- Take a look at our documentation for full details of the new features.
Custom Stylesheets for Confluence Spaces

Change the look of your Confluence space by specifying your own CSS styles. Cascading Style Sheets (CSS) are the standard way of styling web pages.

- For example, you might choose to change the background for the header at the top of each Confluence page. See our tutorial.
- Or you might change the look of the tabs in your Space Admin screens, as described in this example.
- To get started, take a look at our documentation.
Updated JIRA Issues Macro with Custom Fields and Dynamic Display

The JIRA Issues macro now gives you more control both when viewing the output and when coding the macro.

- Specify any JIRA field as a column for display, including custom fields.
- Click the column headers to sort the output.
- Drag and drop the columns into a different order.
- Temporarily remove a column from the display.
- Click the triangle at top right of the issue table to collapse the table.
- Retrieve a page of issues at a time, rather than a huge list all at once.
- Take advantage of the improved performance of your JIRA site. The JIRA Issues macro now caches the results for anonymous users and for results retrieved using trusted communication. This should improve the performance of your JIRA site if you have set it up for trusted communication, because Confluence no longer needs to access the JIRA site as often.
- Our documentation tells you how to use the macro.
Enhanced User and Group Management

Searching for users and adding users to groups is now much easier.

- You can add and remove users directly from the group management screen. This allows you to manage the group membership for a number of users at the same time.
- The new user search offers a simple and an advanced option. With the simple option, just type all or part of the person's name, username or email address. If you want to restrict your search, use the advanced option to specify the field you want searched. Or you can search for users in a specific group.
- A new user picker lets you select the people you need from the list of matching users. This makes things much easier when adding members to a group, or when assigning page permissions and space permissions.
Upgraded Rich Text Editor

Confluence 2.10 brings many improvements to the Rich Text Editor and is a big step along the way to a great WYSIWYG experience.

- You can now use Safari to create and edit Confluence pages.
- The styles dropdown list now illustrates the format of each style, such as 'Heading 1', 'Heading 2' and so on.
- Tables are easier to insert and edit.
Universal Wiki Converter now with SharePoint Import and More

The Universal Wiki Converter (UWC) allows you to import content from other wikis into Confluence. Coinciding with the release of Confluence 2.10, there are some great improvements to this useful tool.

- You can now import pages from SharePoint wiki libraries, as well as other wikis, into Confluence.
- The UWC's enhanced user interface allows you to drag and drop wiki pages onto the UWC screen for conversion to Confluence.
- A new link on the Confluence Administration Console gives easy access to the Universal Wiki Converter documentation and download pages.
- There is a new command-line interface to the UWC.
- The UWC also offers a new converter for Vqwiki, improvements to the Swiki converter, and more.
Improved Activity Macros

The Blog Posts macro, Recently Updated macro and Content by Label macro now support a common set of parameters, making it easier to code the macros and display the content you need.

- Filter content by author, label, space or content type.
- Use a minus sign (-) to exclude specific values. For example, using the ‘author’ parameter you can specify author=-hpotter,hgranger,adumbledore. You will get content which has been created/updated by either ‘hgranger’ or ‘adumbledore’ (or both) but ‘hpotter’ has not touched.
- Sort the resulting list of items by title, date created or date modified, in ascending or descending order.

For the HTML Include macro and the RSS macro, you can now specify a ‘whitelist’ of allowed URLs. This will improve the security of your Confluence site, because it can be dangerous to include content from untrusted external sites. Our documentation shows you how to specify the whitelist.

Plugin Framework 2
Confluence 2.10 comes with Atlassian's new Plugin Framework 2.1, based on Spring Dynamic Modules using the embedded OSGi container. The new framework lays the groundwork for the following improvements:

- More robust Spring component plugins.
- The ability for plugins to depend on each other.
- Control over plugin load order.
- The ability for plugins to define their own extension points.
- More consistent plugin APIs between products.
- More consistent plugin behaviour across different versions of Confluence.

Take a look at our developer documentation. The new plugin framework is under development. Here are some guidelines on converting your existing plugins to the new framework. We'd be delighted to have your feedback via our JIRA project.

More than 250 Fixes and Improvements

- A new attachments icon 📂 on the first line under the title of a page tells you that there are files attached to the page, as well as how many attachments.
- A new lock icon 🔒 marks pages which have view or edit restrictions.
- The Demonstration Space included in the Confluence download now has more sample content. We have adapted pages from our own development, human resources and sales teams, to give some ideas on how your organisation might use Confluence.
- The default home page for a space now includes a list of recently updated content, a search input box and a tree view of the pages in the space. The default home page is created when you add a space. You can edit the home page to include or remove any content as required.
- You can now crop and tailor your profile picture and delete any profile pictures that you no longer want.
- There is no longer any need to re-create the database indexes manually during the upgrade procedure. From Confluence 2.10, the upgrade process will automatically re-create the indexes.
- Trusted authentication and other Seraph-based authentication methods are now available for calls to the Confluence RPC methods. This makes it practical to write front-end AJAX functionality which uses the remote API to retrieve or modify Confluence data.
- Take a look at the complete list of issues resolved in Confluence 2.10.

The Confluence 2.10 Team

**Development**

**Bugfixing and Maintenance**
Andrew Lynch
Brian Nguyen
Chris Kiehl
Matthew Jensen

**Engine Room**
Anatoli Kazatchkov
Charles Miller
Christopher Owen
Matt Ryall

**Plugins**
Ben Speakmon
Cheryl Jerozal
Jonathan Nolen
Nathan Dwyer

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Rich Text Editor and Office Connector
Agnes Ro
David Taylor
Don Willis
Ryan Ackley

Search: Quick Navigation, Did-You-Mean and UI
Chris Broadfoot
David Loeng
Dmitry Baranovskiy
Paul Curren

Team Lead
Per Fragemann

Widget Connector, Custom Stylesheets and User/Group Management
Jens Schumacher

Support

Kuala Lumpur
Arie Murdianto
Azwandi Mohd Aris
David Chui
Fennie Ng
Mei Yan Chan
Ming Giet Chong
Tony Cheah Tong Nyee

San Francisco
Jeremy Largman
Maleko Taylor
Tim Wong
Vincent Chang

Sydney
Gurleen Anand
Ivan Benko
James Fleming
Michael Seager
Renan Battaglin
Roy Hartono

Others

Design
Jason Taylor
Stephen Russell

Performance Engineering
George Barnett

Product Management
Adnan Chowdhury

Product Marketing Management
Bill Arconati

Quality Assurance
Confluence 2.10 Upgrade Notes

Below are some essential notes on upgrading to Confluence 2.10. For details of the new features and improvements in this release, please read the Confluence 2.10 Release Notes.

On this page:

- Upgrade Notes
  - Enabling the New Quick Navigation Feature on Customised Confluence Sites
  - Crowd and the User Search
  - RSS and HTML macro whitelists
  - Plugins
  - Java Versions
  - Platforms No Longer Supported
  - JavaScript Libraries
  - Confluence Themes
  - End of Life of SnipSnap Import
  - No Need to Re-Create Database Indexes Manually

- Upgrade Procedure

Upgrade Notes

Enabling the New Quick Navigation Feature on Customised Confluence Sites

If you have customised your Main Layout on either the space or the global level, or if you have a custom theme plugin, the new quick navigation feature will not work immediately for you.

To enable quick navigation, you need to add the following statement to your Main Layout anywhere before the #standardHeader() statement:

```
#requireResourcesForContext("main")
```

Crowd and the User Search

Confluence 2.10 includes a much-enhanced user search. (See the release notes.) If you are using Atlassian’s Crowd for user management, you will need Crowd 1.5.1 or later to use the ‘Simple’ option in the user search. If your version of Crowd does not support the simple user search, you will see only the ‘Advanced’ search form. Please consider upgrading your Crowd version, to take advantage of the advanced user search.

RSS and HTML macro whitelists

To improve the security of a default installation of Confluence, macros which display HTML from external sources now use a whitelist of URLs configured by the Confluence administrator. This affects the RSS and HTML include macros.
See [Configuring a URL Whitelist for Macros](#) for instructions on how to configure a list of allowed URL patterns for the RSS and HTML macros in Confluence 2.10.

## Plugins

If you are using any third-party plugins on your Confluence instance, please test them thoroughly before rolling 2.10 into production.

## Java Versions

**Java 1.4 is not supported in Confluence 2.9 and later.** Please refer to the [Java 1.4 Support Timeline](#) for more information.

Before upgrading to Confluence 2.10, you will need to ensure your environment is running at least Java 5. Confluence 2.10 [supports Java 5 and Java 6](#). We recommend Java 6 because of its increased performance and easier troubleshooting, due to enhanced memory dump and profiling capabilities.

You can check your current Java version in Confluence:

1. Choose **Browse > Confluence Admin**.
2. Select 'System Information' from the 'Administration' section in the left-hand panel.
3. Refer to 'Java Version'.
   - If the version is 1.5 or higher, you do not need to do anything.
   - If the version is 1.4, you need to [upgrade your JDK](#) before you can upgrade to Confluence 2.10.

If you are running the Confluence **EAR-WAR edition** against your own application server, you will need to check with your application server vendor about which JDK versions are supported.

### Platforms No Longer Supported

The following platforms were on the 'unsupported but working' list for Confluence 2.9. They are not on that list as of Confluence 2.10. We will still test those platforms infrequently, and Confluence will probably still work fine with them for a while, but they will not be officially supported.

- MySQL 4.1 — please upgrade to MySQL 5
- Tomcat 5.0 — please upgrade to Tomcat 5.5 or 6
- Resin 2 — please upgrade to Resin 3
- JBoss 4.0.x — please upgrade to JBoss 4.2.x

Please refer to the list of supported application servers and databases on our [Supported Platforms](#) topic for the updated matrix.

There is a [workaround](#) to enable MySQL 4.1.x.

## JavaScript Libraries

jQuery is the supported JavaScript library for plugin developers.

**Advance notice — deprecated libraries:** We have decided to standardise on jQuery as the JavaScript library for Confluence. This library will eventually replace all others. For this reason, use of the following JavaScript libraries in Confluence is deprecated:

- Prototype
- Scriptaculous

Because there is a lot of legacy plugin code using Prototype and Scriptaculous, these will continue to be available for this release of Confluence.
Confluence Themes

**The Confluence Classic Theme is no longer supported**, following its deprecation in Confluence 2.9. This theme uses outdated typography and formatting, which was replaced by the new-look Default Theme in Confluence 2.6. At that time, we introduced the Classic Theme to minimise the impact on customers who relied on the older typography.

When you upgrade to Confluence 2.10, an upgrade task runs to do the following:

- Any space with the Classic Theme configured will be migrated to use the Default Theme.
- If your Global Theme is set to use the Classic Theme, the Global Theme is also migrated to the Default Theme.
- The Classic Theme plugin is uninstalled. (The Classic Theme entry in the database is removed.)

End of Life of SnipSnap Import

**Advance notice — EOL SnipSnap import:** Confluence 2.10 is the last release which will include the SnipSnap option in the Confluence Administration Console. From the next release after Confluence 2.10, the SnipSnap import will no longer be available.

No Need to Re-CREATE Database Indexes Manually

In previous releases of Confluence, you needed to manually re-create the database indexes during the upgrade procedure. For this purpose, we provided a set of SQL statements as an attachment to the Upgrade Guide. From Confluence 2.10, the upgrade process will automatically re-create the indexes. Please refer to the Upgrade Guide.

Upgrade Procedure

⚠️ **Upgrade a test environment first**

As always, please test your upgrades in your test environment before rolling into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
2. If your version of Confluence is earlier than 2.9.x, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the 2.9 upgrade notes.
   - If you are upgrading from 2.1 or earlier, please read the 2.2 release notes.
   - If you are upgrading from 2.2 or earlier, you will need to upgrade to Confluence 2.5.8 first, confirm the upgrade was successful, then upgrade again from version 2.5.8 to the latest. For more details, please refer to CONF-11767.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.
5. If you encounter a problem during the upgrade, please create a support ticket and one of our support engineers will assist you through the process.

RELATED TOPICS

Confluence 2.10 Release Notes
Issues resolved in Confluence 2.10

Below are the issues resolved in Confluence 2.10, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. You can also take a look at the Confluence 2.10 Release Notes.

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Above are the issues resolved in Confluence 2.10, ordered by number of votes. For the full list of fixes, improvements and new features, please take a look at our issue tracker.

Workaround For Enabling MySQL 4.1.x with Confluence 2.10

With the release of Confluence 2.10, MySQL 4.1.x is no longer supported and will not work by default. See the Supported Platforms topic for further details.

However, there is a workaround to enable MySQL 4.1.x with Confluence 2.10.

To enable MySQL 4.1.x with Confluence 2.10:

1. When launching Confluence from the command line, add the following parameter:

   -Dmysql4Compatibility=true

2. This will enable MySQL 4.1.x to work with Confluence 2.10. Please note however, that use of this database will not be supported by Atlassian.

Release Notes 2.0

Atlassian Software is proud to present Confluence 2.0 (otherwise known as Yarra). Yarra is the result of five months of solid work by the Confluence team, and we're really glad to be able, finally, to share it with the world. Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days, can download Confluence from the Atlassian website: http://www.atlassian.com/software/confluence

Yarra is the fifth major update to Confluence. Among the improvements in Confluence 2.0 are an easy-to-use WYSIWYG editor for writing pages, labels for categorising them, and a powerful RSS builder for keeping track of what's new.

Confluence 2.0 is a free upgrade for any customer who purchased their Confluence license after November 16th, 2004. If the maintenance period of your license has expired, or is about to expire, why not contact our friendly sales staff and get it renewed? It's the only way to keep up with all the great new features we're adding.

A big thanks to everyone who reported bugs and offered suggestions over the last few months, especially everyone who helped by trying out our Confluence Development Releases. Also, congratulations to the Socceroos for getting Australia into the World Cup for the first time in 32 years. It almost makes up for losing the Ashes.
Upgrading From a Previous Version of Confluence

Upgrading Confluence should be pretty easy. **We strongly recommend that you backup your confluence.home directory and database before upgrading!**

⚠️ **Upgrades from 1.4.2 and earlier**

If you are upgrading from Confluence 1.4.2 or earlier, you may experience problems with some space-related functionality (see CONF-4765), such as adding a space as a favourite. To work around this, please restart the Confluence instance after the upgrade. This will be fixed in Confluence 2.0.2.

### Important Migration Notes

⚠️ **Macro/Plugin Compatibility**

Necessary changes were made to the Confluence rendering subsystem during the development of Confluence 2.0 that may render some third-party plugins (especially macros) inoperable. If you upgrade Confluence and find that macros or plugins are not operating correctly, try removing all files from `confluence-home`/plugins and restarting Confluence.

⚠️ **HSQL 1.8 Upgrade**

If you are using the embedded HSQL database, it is possible that Confluence will not be able to automatically upgrade your data. If this happens, Confluence 2.0 will refuse to start, and you will be directed to the following Confluence page which contains instructions on how to upgrade the database manually: [Upgrading From HSQL 1.7.1 to 1.8](https://confluence.atlassian.com/display/C20/Upgrading+From+HSQL+1.7.1+to+1.8).

⚠️ **SSO update**

If you are using some third-party Seraph authenticator with Confluence, or have written your own, you should read CONF-4581 before upgrading. Confluence now uses the Seraph defined login.link.url property to define its login link urls, which may cause issues with authenticators that relied on Confluence's previous, incorrect behaviour.

⚠️ **Weblogic Performance**

Confluence 2.0 may perform very badly under Weblogic. There is a workaround for this problem described in CONF-4634, and a full fix IS included in 2.0.1.

⚠️ **JDK 1.5**

If you are running Confluence 2.0 on the JDK 1.5, you will need to download some additional dependencies as described in CONF-4643. A full fix is included in a 2.0.1.
**MySQL 5**

If you are running Confluence 2.0 on the MySQL 5 database, you may encounter some problems. One fix is described [here](#).

---

**Upgrading from 1.4.4**

After upgrading to 2.0, administrators will need to rebuild the site's search-index to ensure all the new search features are enabled. Do this from the *Content Indexing* section of the global administration menu.

**Upgrading from 1.3.5 or Earlier**

Users upgrading from an earlier version of Confluence should check the release-notes of the other major Confluence releases:

- [Release Notes 1.4](#)
- [Release Notes 1.3](#)
- [Release Notes 1.2](#)
- [Release Notes 1.1](#)

---

**New Features**

The four major new features in Confluence 2.0 are:

- [Rich Text Editing](#)
- [Labels](#) for content
- New [Dashboard Features](#) for managing sites with large numbers of spaces.
- A dynamic [RSS Builder](#)

.. but there's a [lot more](#) on top of that.

---

**Rich Text Editing**

**Browser Compatibility**

The Confluence Rich Text editor is currently only compatible with Internet Explorer 6 on Windows, plus Mozilla and Firefox across platforms. Javascript must be enabled in the browser for the editor to function. Support for Safari under Mac OS X is currently not available. To track Safari compatibility, please follow this JIRA issue: [CONF-3864](#)

It almost goes without saying that the most highly requested feature in Confluence has been the ability to create pages without having to learn wiki markup. We're glad we can finally offer a powerful "what you see is (pretty much) what you get" rich text editor built into Confluence, making it easier for anyone to contribute to the site.

The WYSIWYG editor is enabled when you install or upgrade to Confluence 2.0. Global Administrators can disable the editor if they want to stick with pure wiki markup, and can also choose which editor users should be presented with by default. (The setting is under "General Configuration" in the administrative console). Users can also choose which editor they prefer simply by clicking on the "Make this my default editor" link that appears on the edit screen.

For the "feature mad" amongst us, here are some neat things you can do with the WYSIWYG editor:

- Full screen view - really useful for editing large pages. Click in the menu bar.
- Quickly switch between WYSIWYG and Wiki markup without a page refresh
Another highly requested feature was the ability to categorise content within Confluence beyond the rigid hierarchy allowed by spaces and parent-child relationships between pages. To this end we have introduced labels: simple one-word 'tags' that can be added to any page or blog-post the user has permission to edit. Labels can be used to categorise content, bookmark it, flag it for attention, or anything else you can think of.

A Tag By Any Other Name

Picking a name for labels wasn't easy. Google's GMail service calls them labels, while other collaborative categorisation systems such as del.icio.us and Flickr call them tags. We decided that 'label' was a more natural description. For more information about our choice, see Labels vs Keywords on our new Developer Blog and for more on the overall philosophy behind labels and tags, check out the Folksonomy page on Wikipedia.

Labels can be added to any page from the edit screen, or through a dynamic interface right when you're viewing a page.

Once a page is labeled, then clicking on the label's name allows you to browse other pages with the same label, or view related labels that commonly occur on the same pages. You can also view the space's most popular labels from the space browser, to get an idea of the most popular topics within the space.

Personal Labels

If you prepend my: to a label (for example, my:todo or my:favourite, then the label is a personal label - only visible to you. Personal labels allow you to tag content for your own purposes: for example to keep track of
pages you feel need your attention, or that contain information you refer to frequently. You can browse your personal labels from your user profile. Any user can add their personal labels to any page, even when they don't have editing permission.

---

**Favourites**

Favourites are a special personal label: `my:favourite` or `my:favorite`. Whenever you see the icon, it means you can label this content as being your favourite, and whenever you see the icon, it means that the content is currently in your list of favourites. You can view your favourites from the Labels tab of your user profile, or keep track of them on your dashboard.

**Label-Aware Macros**

Many existing macros have been improved to allow you to filter content based on labels: including the `{recent-pages}`, `{recently-updated}` and `{blog-posts}` macros. We've also added macros that provide more information about labels and labelled content:

- `{related-labels}` gives a list of labels that might be related to a page
- `{listlabels}` lists all the labels in a space
- `{contentbylabel}` lists content that has a particular label
- `{recently-used-labels}` lists labels that have been recently added or applied
- `{navmap}` draws a nice-looking table of links to pages with a particular label

**Dashboard Features**

The Confluence dashboard has been improved to make it easier for you to keep track of only those spaces you are interested in: a big improvement for Confluence sites with large numbers of spaces. The list of spaces is now divided into four tabs (although all four may not be visible):

- **All** shows you all spaces
- **My** shows you all spaces you have marked as your favourites (you can mark a space as your favourite from the **All** tab by clicking on the icon)
- **Team** shows you all the available 'teams', and the spaces that have been assigned to them
- **New** shows you any space that has been added in the last week

The recently updated content list on the dashboard will reflect the spaces in your chosen tab. So if you're looking at the **My** tab, the dashboard will only be showing you the recent updates in your favourite spaces.

**"Teams"**

A team label is used to group together a list of spaces relevant to a project team. You can display a team's spaces by selecting a label from below:

---

**View Spaces for Team:**

```
JIRA
JIRA Community Space
JIRA Extensions
```

Teams are a simple, and very wiki-like way to group spaces together. Space administrators can add "team labels" to a space, which are then used to group those spaces under the team tab on the dashboard. So if your
wiki has 100 spaces, but only five of them are of any interest to your sales team, just add a "sales" team label to those five spaces. That will group those spaces together on the dashboard under the 'team' tab, and your sales team need never look at the other 95 spaces.

**RSS Builder**

Confluence has always provided a brace of useful RSS feeds, but the problem is that for every feed we provided, users asked for half a dozen more. The obvious answer is to let users build RSS feeds based on their own chosen criteria. You can access the RSS builder from the Confluence dashboard.

Once in the builder, you can choose:

- Which spaces to include in the feed
- Which types of content should be tracked
- Which labels, if any, you are interested in
- How many items to include in the feed
- Whether you want a single RSS entry per page or one for each time the page is edited
- Whether you want an RSS 2.0 or Atom 0.3 feed
- Whether Confluence should require authentication to view the feed

Once you have decided what you want, Confluence will give you a URL to paste into your RSS reader. These URLs can be shared with other Confluence users, although they will only ever be allowed to see content that they have permission to view. If you have asked to authenticate, Confluence will require HTTP Basic Authentication, which is supported by most RSS readers.

We've also taken the opportunity to improve the presentation of our RSS feeds - including a lot more information in each feed so you can follow your Confluence site entirely from your newsreader.

⚠️ **The Atom Working Group has blessed the final Atom 1.0 standard, and are recommending that all applications remove support for Atom 0.3. However, as of the release of Confluence 2.0, there is no stable Atom 1.0 library from which we could generate feeds. In some future release of Confluence, Atom 0.3 support will be removed in favour of Atom 1.0.**

**Other New Features**

**Record "Change Comments" When Editing a Page**

There is now a field on the edit screen for recording a "change comment" when you edit a page. These comments are stored in the page history, and can be used to keep a more complete history of why a page has been edited.
Embed Flash and Movies
You can now embed Flash content or movies (Quicktime or Windows Media) into a page as easily as you can an image: just attach the Flash or movie file to the page, then include it as you would include an image (!filename.mov!).

Export Pages as Word Documents
You can now export pages straight into Word from the Info tab. This is extremely useful for emailing around content to non-Confluence users, printing a document or just creating a backup in Word.

Copy Pages
Also on the Info tab is a "Copy" link that allows you to clone a page in a single click - including making copies of any attachments.

Improved Search Interface
Results returned from Confluence's search engine now have:

- Improved contextual results, showing the most important text around where your query was matched in the page
- Contextual results for any attachment: see where a search was matched even inside PDF, Word, PowerPoint or Excel documents!
- Search results for attachments give you more (and clearer) information about what the attachment is, and where it's from!

Chart Plugin
The Chart Macro is now shipped with Confluence, allowing you to dynamically generate neat looking charts like this:

Fish Sold

![Fish Sold Chart](image.png)
Wiki Source

<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2004</th>
<th>2005</th>
</tr>
</thead>
<tbody>
<tr>
<td>Herring</td>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<td>Salmon</td>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<td>Tuna</td>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>

Improved Gallery Macro

The gallery macro has been spruced up, and now has a slideshow view:

My personal labels! Only for me!

View page label interface showing autocomplete.

Improved search showing fragments from attachments, file sizes and types.

Screenshot of the new 2.0 rich text editor

A very basic (quite boring - sorry, it's late) example
The new Dashboard space tabs, here showing the "jira" team tab and one favourite space.

Some release notes exported to Word (even on a Mac!) - great for printing too.

Popular labels for a given space.

Additions to the Remote API

Additions to the Confluence Remote API include:

- Comment manipulation
- Label manipulation
- Attachment uploading and editing
- Improved user- and permissions management

⚠️ Confluence now uses version 2.0 of the Apache XML-RPC library. Java XML-RPC clients using earlier versions of the Apache XML-RPC libraries (i.e. 1.3 or earlier) may experience problems with responses containing non-ASCII data.

Also...

- You can download all the attachments on a page in a single zip-file
- Import and restore now have progress indicators
- Backup and restore use significantly less memory
- The embedded database has been upgraded to HSQL 1.8, which should be significantly more reliable
- Collapsed breadcrumbs now expand with a single mouse click

Notable Bug Fixes

We resolved a lot of issues between Confluence 1.4.4 and Confluence 2.0. The best way to see what we've fixed is to ask JIRA, the world's best issue-tracker: Issues Resolved for 2.0
Outstanding Bugs

Some bugs were introduced during the Confluence 2.0 development cycle that we could not fix in time for the final release. Of note are:

- Some pernicious Javascript errors when changing styles in the rich text editor under Internet Explorer
- The rich text editor may not perfectly handle complex pages with structural macros
- Attachments containing high-bit characters in their filenames may not be correctly retrieved by Confluence

Once again, if you find any bugs in Confluence, or have any feature suggestions, you can report them online in JIRA.

The Confluence 2.0 Team

Development 😊
Tom Davies
Jeremy Higgs
David Loeng
Charles Miller
Daniel Ostermeier
Jens Schumacher

Documentation 😊
Vidya Madabushi

Oversight & Mis management 😊
Mike Cannon-Brookes
Scott Farquhar

Nerf Target-Practice 😊
Nick Faiz

Well that's all folks - if you're still reading - thank you for getting this far!

ℹ️ To keep up with all the latest developments in the next 2.1 release (codenamed: Bogan) - subscribe to our developer blog.

Issues Resolved for 2.0

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.0.1

Confluence 2.0.1 is a maintenance release that resolves some issues users may have encountered using Confluence 2.0. In particular, this includes issues relating to failures to upgrade and javascript problems.

2.0.1 is a free upgrade for all customers who purchased their Confluence license after November 28th, 2004.

Who should upgrade?
Confluence 2.0.1 is a recommended upgrade for all users who have not yet upgraded to 2.x and for those users of 2.0 that are encountering issues fixed in this release.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.4 or earlier of Confluence, please check the release-notes of the other major Confluence releases:

- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

**Changes in 2.0.1**

See also: Issues resolved for 2.0.1

- Javascript failing with a class not found. (CONF-4643)
- Confluence 2.0 hangs on weblogic. (CONF-4634)
- Disabling WYSIWYG editor causes AJAX error in Preview mode. (CONF-4745)
- Ancestors table hangs on to foreign key relationships if it can't be deleted. (CONF-4700)

**Issues resolved for 2.0.1**

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><img src="authenticate.png" alt="Authenticate to retrieve your issues" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Release Notes 2.0.2**

Confluence 2.0.2 is a maintenance release that resolves a security issue, along with various issues users may have encountered using Confluence 2.0.1.

⚠️ A security flaw as described by the Confluence Security Advisory 2005-12-05 has been identified to exist in Confluence 1.4.x and 2.0.x. This has been fixed in 2.0.2. We recommend to all customers that they either upgrade to 2.0.2 or follow the instructions provided on the Confluence Security Advisory 2005-12-05 to patch there installation.

⚠️ The release of Firefox 1.5 resulted in new bugs and issues with the Rich Text editor. Therefore every version of Confluence up to 2.0.2 isn't very compatible with this browser in terms of Rich Text editing.

Confluence 2.0.3 will feature an updated version of the editor which will solve most of the problems with Firefox 1.5 (CONF-4809).

2.0.2 is a free upgrade for all customers who purchased their Confluence license after December 5th, 2004.
Who should upgrade?

Confluence 2.0.2 is a recommended upgrade for all users as it contains a security patch for the Confluence Security Advisory 2005-12-05. If you are unable to upgrade to 2.0.2, then please see Confluence Security Advisory 2005-12-05 for details on how to patch your installation.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.0, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.4.4 or earlier of Confluence, please check the release-notes of the other major Confluence releases:

- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3

Changes in 2.0.2

See also: Issues resolved for 2.0.2

- Search results page needs to XML encode the query string provided by the user (CONF-4825).
- Recently updated does not list any items (CONF-4770).
- CamelCase linking interferes with rendering of attachment link (CONF-3447).
- Umlaute in links are causing encoding problems with the Rich Text editor (CONF-4775).
- Disabled accounts still receive (blank) daily reports (CONF-4802).

Issues resolved for 2.0.2

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>JIRA Issues</td>
</tr>
</tbody>
</table>

Release Notes 2.0.3

Confluence 2.0.3 is a maintenance release. It contains a upgrade of the WYSIWYG editor and numerous bug fixes.

2.0.3 is a free upgrade for all customers who purchased their Confluence license after December 12th, 2004.

Who should upgrade?

Confluence 2.0.3 is a recommended upgrade for all users who are having problems with the WYSIWYG editor. This release contains an upgrade to the WYSIWYG module that contains numerous bug fixes.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.0, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!
If you are upgrading from Confluence 1.4.4 or earlier of Confluence, please check the release-notes of the other major Confluence releases:

- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3

Changes in 2.0.3

See also: Issues resolved for 2.0.3

- Upgrade to TinyMCE 2.0.1 (CONF-4808)
- Backup restore progress monitor does not refresh during restore, making it look like the backup is hanging (CONF-4895)
- Information leak when accessing url directly (CONF-4794)
- Personal labels showing up on the {contentbylabel} macro (CONF-4894)

Issues resolved for 2.0.3

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.1

Atlassian is happy to offer our customers an early Christmas present: Confluence 2.1 (otherwise known as Bogan). Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days, can download Confluence from the Atlassian website: http://www.atlassian.com/software/confluence

Bogan is the Sixth major update to Confluence, offering vastly improved LDAP integration through our new atlassian-user library, as well as introducing the much-requested autosave feature to protect you from losing your precious edits.

Upgrading from 2.0

Upgrading Confluence should be pretty easy: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Plugin Compatibility

Any plugin written for Confluence 2.0 and earlier that interfaces with the User system will need to be updated for Confluence 2.1. Plugin developers can find more information on the Atlassian developer blog.

LDAP Integration Configuration Changes

Customers who have already integrated Confluence with LDAP through the OSUser LDAP providers will need to make changes to their osuser.xml file before upgrading. You can find full details in step 3 of LDAP Authentication with OSUser.
**OSUSer or Seraph Customisations**

Customers who have performed their own customisations on OSUser or Seraph within Confluence must be sure to test their changes with Confluence 2.1 before upgrading any production system. While we have tried to maintain backwards compatibility, the integration of atlassian-user may adversely affect existing customisations.

Upgrading from 1.4 and earlier

Users upgrading directly from 1.4 or earlier should also read the 2.0 Release Notes for caveats regarding the 1.4 -> 2.0 upgrade.

Contents

1. New Features
2. Improvements
3. Notable Bug-fixes

See also: Issues Resolved for 2.1

**New Features**

**Autosave**

If you’ve used wikis for long enough, you know the pain of losing a long, involved editing session to a browser crash, session timeout, or just not thinking and clicking on a link to another page. As of Confluence 2.1, this is no longer a problem: the most you’ll lose is half a minute of your work.

Every thirty seconds (this interval is configurable by the global administrator), the browser will save your unfinished edit to the server. This autosave will hang around until you either hit the "Save" or "Cancel" button yourself, even if the server is restarted. So if you lose your changes, all you have to do is navigate back to the edit page, and will be given the chance to begin editing again where you left off.

You can view your outstanding autosaved documents from your profile under the "Drafts" tab.

**Concurrent Edit Warnings**

A useful side-effect of autosave is that now Confluence has an accurate way of measuring who is editing which page. If two people start editing the same page at the same time, Confluence will display a warning message telling you who else is editing the page. You can then negotiate between yourselves who gets to save first.
Even better, Confluence will let you know how long it was since the other editor made any changes to the page, so if somebody has just left their browser open on the edit page for a couple of hours, you'll know you can sneak your changes in while they're asleep.

**User Management**

Confluence 2.1 sees the landing of our new `atlassian-user` user management library. Most Confluence customers will not see any significant change from this move, but for anyone looking to integrate Confluence with an external user-base (especially LDAP), `atlassian-user` is a big step forward.

Confluence can now integrate fully with an LDAP directory server, without the previously annoying practice of having to mirror the users and groups locally on Confluence: [Confluence LDAP Documentation Index](#).

**Improvements**

**Performance**

A lot of work was done improving the performance of the Confluence dashboard and edit pages, especially for customers who may have thousands of spaces and hundreds of thousands of pages in their Confluence installation. Both of these pages should now respond significantly faster.

**Other**

- You can now manually set the MIME type under which embedded objects should be served – [CONF-490](#).
- The system info and error pages include more information about your database configuration – [CONF-4957](#).
- Email attachments no longer show up on the recently updated list (this seems to have regressed in the final release) – [CONF-4684](#).
- Added an icon mapping for sub-tasks in the jiraissues macro – [CONF-4921](#).
- Allow attached Windows Bitmap files to be displayed as embedded resources – [CONF-4922](#).

**Notable Bug-fixes**

Confluence 2.1 includes all bug-fixes that were made up to Confluence 2.0.3, and also includes fixes for the following issues:

- Preview now works correctly when rich text editor is disabled – [CONF-4935](#).
- Info tab no longer shows incoming links from pages in the trash – [CONF-4815](#).
- Trying to set a page as its own parent now presents a validation error instead of a system error – [CONF-4941](#).
- Confluence no longer removes every second character from the filenames of email attachments – [CONF-4938](#).
- JiraJdbcProfileProvider problems reliably accessing profile information from JIRA resolved – [CONF-4933](#).
- Unresolved images now replaced with placeholders in WYSIWYG editor – [CONF-4929](#).
- Removing the {excerpt} macro from a page now deletes the excerpt – [CONF-4918](#).

**The Confluence 2.1 Team**

**Development**

- Tom Davies
- Jeremy Higgs
- David Loeng
Release Notes 2.1.1

Confluence 2.1.1 is a maintenance release that resolves some issues users may have encountered using Confluence 2.1, including issues related to user management, the editing UI and email notifications.

2.1.1 is a free upgrade for all customers who purchased their Confluence license after December 24th, 2004.

Who should upgrade?

Due to the severity of the issues that it resolves, Confluence 2.1.1 is a recommended upgrade for all Confluence customers.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.1, you can find instructions here. We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

If you are upgrading from Confluence 2.0.3 or earlier, please check the release-notes of the other major Confluence releases:

- [Release Notes 2.1](#)
- [Release Notes 2.0](#)
- [Release Notes 1.4](#)
- [Release Notes 1.3](#)
- [Release Notes 1.2](#)
- [Release Notes 1.1](#)

Changes in 2.1.1

See also: [Issues resolved for 2.1.1](#)

- Users can not change their passwords [CONF-5005](#)
Cursor jumps to the beginning of the rich text editor periodically [CONF-4993]
Change comments not being displayed correctly [CONF-4979]
Email notifications do not correctly report the user who made the change [CONF-4973]
Pages cannot be created or saved in some custom atlassian-user or OSUser configurations [CONF-4978]

Issues resolved for 2.1.1

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>--------</td>
</tr>
</tbody>
</table>

- [Authenticate](#) to retrieve your issues

Release Notes 2.1.2

Confluence 2.1.2 is a maintenance release that resolves some issues users may have encountered using Confluence 2.1.1 or earlier, including issues related to page editing, Javascript errors in Firefox and Safari and PDF exports.

2.1.2 is a free upgrade for all customers who purchased their Confluence license after January 12th, 2005.

Who should upgrade?

Confluence 2.1.2 fixes a number of bugs found in Confluence 2.1.1 and earlier. Customers are recommended to upgrade if they are experiencing any of the issues fixed in this release.

Upgrade Procedure

> If you are using MySQL, please apply the patch detailed in this bug report [http://jira.atlassian.com/browse/CONF-5153](http://jira.atlassian.com/browse/CONF-5153). That is, please download 2.1.2, extract it, and copy the above mentioned patch into the unpacked 2.1.2 distribution and then go about your upgrade. We will be releasing a version with this patch bundled soon.

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.1 or 2.1.1, you can find instructions here. We strongly recommend that you backup your [confluence.home](#) directory and database before upgrading!

If you are upgrading from Confluence 2.0.3 or earlier, please check the release-notes of the other major Confluence releases:

- [Release Notes 2.1](#)
- [Release Notes 2.0](#)
- [Release Notes 1.4](#)
- [Release Notes 1.3](#)
- [Release Notes 1.2](#)
- [Release Notes 1.1](#)

Changes in 2.1.2

See also: Issues resolved for 2.1.2

Improvements

- JiraPortlet macro now has an optional "baseUrl" parameter for when Confluence accesses JIRA from a
different URL to regular users – CONF-4897
• Children listed at the bottom of pages are now sorted alphabetically – CONF-4878
• Confluence warns space administrators when they permit anonymous access to a space, but global anonymous access is disabled – CONF-4898

Bugs Fixed

• NS_ERROR_NOT_AVAILABLE popup no longer appears when editing certain pages in Firefox – CONF-5038
• "Error converting parameters" popup no longer appears when editing certain pages in Safari – CONF-4976
• Edit page no longer returns NoSuchElementException error under some circumstances – CONF-5007
• "Last week" and "Last month" searches no longer fail when time period spans the new year – CONF-5056
• News items marked as favourites are now listed on the dashboard – CONF-4998
• Mail attachments no longer show up in recent changes on dashboard – CONF-4684
• PDF Export no longer fails with error parsing background-color attributes – CONF-4976
• Anonymous users do not cause a crash when exporting a space – CONF-5129
• Disabling a servlet plugin no longer causes a NullPointerException – CONF-5021
• Notification emails no longer prepend the site's context path twice to certain URLs – CONF-5024
• It is now possible to move a page between spaces and change its parent in the same operation – CONF-5103
• Dashboard favourite selection now works in Opera 8.5 – CONF-5012
• Username links no longer cause a NullPointerException in certain configurations – CONF-5028

Issues resolved for 2.1.2

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.1.3

Confluence 2.1.3 is a maintenance release that resolves some issues users may have encountered using Confluence 2.1.2 or earlier, including issues related to Rich Text editing, LDAP user management, restoring to MySQL, and Unicode on MS SQL Server

2.1.3 is a free upgrade for all customers who purchased their Confluence license after January 23rd, 2005.

Who should upgrade?

Confluence 2.1.3 fixes a number of bugs found in Confluence 2.1.2 and earlier. Customers are recommended to upgrade if they are experiencing any of the issues fixed in this release.

Confluence is a recommended upgrade for all customers using Confluence's new atlassian-user LDAP user management with dynamic group mappings. For more information see USER-95

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.1 to 2.1.2, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!
If you are upgrading from Confluence 2.0.3 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.1.3

See also: Issues resolved for 2.1.3

Improvements

- You can now suppress camel-case linking with \{nl:CamelCaseWord\} – CONF-3700
- Confluence RSS macro is now compatible with Google News RSS – CONF-4892
- The \{contentbylabel\} macro supports a wider range of options – CONF-5137

Bugs Fixed

- Many fixes related to Rich Text editing, and switching between Rich Text and Wiki Markup editing.
- Further PDF export fixes – CONF-4930
- The upload option in the attachments macro works – CONF-5127
- Fixed a bug where Word exports would open in the wrong application – CONF-5163
- Handling of situation where site exceeds its licensed user limit and then removes users is improved – CONF-5208
- Restoring a site to MySQL now properly removes and re-creates database tables – CONF-5153
- Confluence now uses correct NVARCHAR type for multibyte text in MS SQL Server – CONF-5204

Issues resolved for 2.1.3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.1.4

Confluence 2.1.4 is a maintenance release that resolves some issues users may have encountered using Confluence 2.1.3 or earlier. Confluence 2.1.4 fixes more than 55 issues, including bugs related to space import/export, the WYSIWYG editor, page breadcrumbs, and many more

2.1.4 is a free upgrade for all customers who purchased their Confluence license after February 16th, 2005.

Who should upgrade?

Confluence 2.1.4 fixes a number of bugs found in Confluence 2.1.3 and earlier. Customers are recommended to upgrade if they are experiencing any of the issues fixed in this release.

Confluence is a recommended upgrade for all customers using Confluence's new atlassian-user LDAP user management, as it fixes important issues related to user login validation.
Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from an earlier Confluence 2.1 release, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

⚠️ If you are running a Sybase or Microsoft SQL Server database, please replace confluence/WEB-INF/classes/com/atlassian/confluence/upgrade/UpgradeUtils.class with this version before upgrading.

You should also install this if your upgrade fails with the message: Session is currently disconnected

If you are upgrading from Confluence 2.0.3 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.1.4

More than 55 issues were resolved between 2.1.3 and 2.1.4. For the complete list, see: Issues resolved for 2.1.4

Note about markup for embedded content

A bug was fixed in 2.1.4 that previously allowed spaces as attribute separators in embedded content wiki markup (CONF-5406). This means !image.jpg|alt=Great pic! now works correctly, but !image.jpg|border=1 alt=test! doesn't. The correct and documented way to write the latter continues to be !image.jpg |border=1,alt=test!.

Improvements

- {livesearch} macro results can now be limited to a particular space – CONF-3432
- A setting was added to General Configuration to control the maximum number of attachments that can be uploaded at once – CONF-5447
- A setting was added to General Configuration to enable or disable GZip content encoding – CONF-5257
- "Insert Link" and "Insert Image" now work correctly on Safari in OS X 10.4.4 and later – CONF-5435
- A draft is automatically saved when moving from 'Edit' to 'Preview' – CONF-5366
- A getPermissionsForUser method was added to the remote API to allow administrators to retrieve the permissions of particular users – CONF-5439

Notable Bugs Fixed

- Many fixes related to the maintenance of the ancestors table while moving or renaming pages, which may have resulted in the misplacing of page breadcrumbs or inherited page-level permissions – CONF-5104, CONF-5243, CONF-5244
- Many fixes related to Rich Text editing, including the handling of tables and whitespace – CONF-5299, CONF-5231, CONF-5492, CONF-5294, CONF-5324, CONF-5247, CONF-5362, CONF-5265
- Space import no longer overwrites part of global configuration – CONF-5370
- Confluence no longer tries to create indexes with names bigger than DB2 can handle – CONF-5316
- "Insert Link" and "Insert Image" no longer erase contents of edit field in Safari on OS X 10.4.4 and later – CONF-5329
- Links from the {labels} macro are now space-relative – CONF-5346
- Emoticons no longer mistaken for embedded image markup – CONF-3369
- "Profile:" no longer mistaken as the start of a file: URL
# Issues resolved for 2.1.4

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td><img src="image" alt="Authenticate to retrieve your issues" /></td>
</tr>
</tbody>
</table>

## Release Notes 2.1.5

Confluence 2.1.5 is a maintenance release that resolves some issues users may have encountered using Confluence 2.1.4 or earlier.

Confluence 2.1.5 fixes around 50 issues, including a number of fixes for LDAP support, the WYSIWYG editor, and other areas.

2.1.5 is a free upgrade for all customers who purchased their Confluence license after March 16th, 2005.

⚠️ Confluence 2.1.5 has a problem which disables the rich text editor link dialog. Please replace the file WEB-INF/classes/com/atlassian/confluence/user/actions/PagePickerAction.properties with this file: PagePickerAction.properties

This is fixed in 2.1.5a.

### Known Issues in 2.1.5a

Anonymous users may get a Javascript error under some circumstances. See CONF-5765 for details and a patch.

When using LDAP user management, changing passwords for local users won't work. See CONF-5775 for details and a patch.

### Who should upgrade?

Confluence 2.1.5 fixes a number of bugs found in Confluence 2.1.4 and earlier. Customers are recommended to upgrade if they are experiencing any of the issues fixed in this release.

Confluence is a **recommended upgrade** for all customers using Confluence's new atlassian-user LDAP user management, as it fixes important issues related to LDAP integration.

### Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from an earlier Confluence 2.1 release, you can find instructions here. **We strongly recommend that you backup your confluence.home directory and database before upgrading!**

If you are upgrading from Confluence 2.0.3 or earlier, please check the release-notes of the other major Confluence releases:

- [Release Notes 2.1](#)
- [Release Notes 2.0](#)
- [Release Notes 1.4](#)
- [Release Notes 1.3](#)
Changes in 2.1.5

More than 48 issues were resolved between 2.1.4 and 2.1.5. For the complete list, see: Issues resolved for 2.1.5

Improvements

- LDAP queries are cached to improve performance - CONF-5288
- Administrators can insert custom HTML on every Confluence page, see Administration, Custom HTML - CONF-5350
- Tables created in the rich text editor don't have non-breaking spaces added to each cell - CONF-5044
- News improvements - Info tab available including list of version, News can be exported as PDF - CONF-1989, CONF-5582, CONF-5594

Notable Bugs Fixed

- Anchor, user profile and attachment links now round-trip properly in the rich text editor - CONF-5678
- Paging of LDAP users works properly - CONF-5438
- Servlet plugins can be disabled - CONF-5598
- Forgotten username emails work again - CONF-5530
- User profiles fixes with LDAP - CONF-5225, CONF-5549

Issues resolved for 2.1.5

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.2

Atlassian is proud to announce the release of Confluence 2.2, otherwise known as Shoalhaven Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days, can download Confluence from the Atlassian website: http://www.atlassian.com/software/confluence

Shoalhaven is the seventh major update to Confluence (in two years!). It introduces 'personal spaces', support for localisation/internationalisation, CAPTCHA spam protection, a multitude of new extension points for plugin developers, a simpler LDAP configuration syntax, and more.

Upgrading from 2.1

Upgrading Confluence should be pretty easy: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

MySQL Driver Support

For users using MySQL with Confluence 2.2 (or higher), please ensure that you are using the latest (3.1.12) MySQL Java Connector. Earlier versions of the MySQL connector have a bug which may prevent Confluence from upgrading successfully. (more information below)
LDAP Authentication

If you are currently using LDAP authentication through OSUser (that is, you adjusted your osuser.xml file), please do not upgrade to 2.2. This feature is currently unavailable and an issue has been filed for it here. This issue has been resolved in Confluence 2.2.1.

User Management Bug

You must apply the patch attached on this bug report to be able to create users in this version. This issue has been resolved in Confluence 2.2.1.

Index Rebuilding

Upgrading to 2.2 will trigger a rebuild of Confluence’s search index. This will cause certain features such as search, the dashboard and RSS feeds to behave unpredictably for up to a few minutes after upgrading.

LDAP Integration Configuration Changes

The configuration file syntax for atlassian-user has changed. Customers who configured Confluence 2.1 to use AtlassianUser LDAP integration must follow the instructions on this page.

Anonymous Permission Changes

The way that anonymous permissions are applied to users who have logged in has changed. Administrators should understand how they have changed below before upgrading.

Plugin Loading Changes

Prior to Confluence 2.2, it was possible for an outdated plugin, or a plugin with unsatisfied dependencies, to break the entire plugin subsystem. Confluence 2.2 is much more careful about loading plugins, and isolating them if they break. This may, however, cause Confluence to refuse to load an entire plugin, simply because one of its contained plugin modules will not load.

Upgrading from 2.0 and earlier

Users upgrading directly from 2.0 or earlier should also read the 2.1 Release Notes for caveats regarding the 2.0 -> 2.1 upgrade.

Contents

1. New Features
2. Improvements
3. Notable Bug-fixes
4. Important note for MySQL users

See also: Issues Resolved for 2.2

New Features

Personal Spaces

Two of the most frequent questions we get from Confluence customers have been: "How do I give my users their
own wiki?” and “How do I give my users their own blog?” It seems everybody needs a little Personal Space.

Personal spaces belong to particular users, and rather than being listed on the dashboard, are available from the user’s profile. (Future versions of Confluence will feature a ‘people browser’ to make it easier to discover the interesting personal spaces on your server). They can contain pages and news items like any other space, be searched and browsed. They can be kept private, or opened up so the whole world can view and edit them, just like global spaces.

Who can contribute to your personal space?
You can customize these permissions once the space is created.

<table>
<thead>
<tr>
<th>Choose who can view content:</th>
<th>Choose who can contribute (create and edit) content:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Me</td>
<td>Me</td>
</tr>
<tr>
<td>Registered users - anyone logged into Confluence</td>
<td>Registered users - anyone logged into Confluence</td>
</tr>
<tr>
<td>Anonymous - anyone, logged in or not</td>
<td>Anonymous - anyone, logged in or not</td>
</tr>
</tbody>
</table>

Choose Theme
To change the theme of this space, select one below.

- **Default Theme**
  Use the globally configured look and feel. You can customise colour schemes and layouts manually.

- **Left Navigation Theme**
  Provides a navigation bar on the left-hand side of the screen.

Confluence’s search and RSS builder interfaces have been updated to make it easy to choose whether you’re interested in personal spaces or not.
Oh, and if you create a personal space, don't forget to upload (or choose) your own profile picture, so people can see who you are.

Confluence now supports drop-in language packs to change the language of the user interface. The global administrator can select a default language for the entire site, while individual users can set their preferred language in their preferences.

No language packs are currently available, but we are currently working with our global partners so we can begin to provide translations. If you are interested in translating Confluence into another language, you can find instructions on building a language pack here: Language Module.

CAPTCHA Support
Many of the more public Confluence wikis have been suffering at the hands of spammers. CAPTCHA support adds the familiar 'type in this word' question to signup, edit and comment forms, to defeat automated spamming bots. You can turn on CAPTCHA from the global administrative console, and also choose which users will, or will not be subject to the spam check.

**Exclusions**

By default, captchas are shown to only anonymous users. This streamlines the editing process for trusted, signed in users.

Exclude from captchas:

- No one (everyone will see captchas)
- Signed in users
- Members of the following groups

**Plugin Improvements**

Each version of Confluence is more customisable than the last. One of the most exciting things to come from our recent plugin competition was learning just how creative our plugin developers are, and discovering more ways we can help them add features to Confluence.

- **Job Module** and **Trigger Module** allow you to schedule periodic tasks to run within Confluence
- **Web UI Modules** allow plugin developers to add new links, buttons and tabs to the Confluence interface, and make it easier for theme developers to stay up to date with changes to the Confluence UI.
- **Code Formatting Module** allow you to plug support for new languages into the {code} macro (or override the existing language support with something better).

We've also made a number of improvements to the plugin system, including:

- Making sure that a single 'rogue' plugin can't bring down the whole plugin subsystem.
- Enabling 'conditional get' for plugin resources, so browsers don't download them again and again.
- Fixing problems that may occur when a servlet or component plugin is reloaded or upgraded. (With many thanks to Dan Hardiker of Adaptavist.)

**New atlassian-user Configuration Syntax**

As promised, we have cleaned up the configuration file syntax for our atlassian-user user management library. This should make it much easier to configure Confluence to use external user repositories such as LDAP. You can find details of the new configuration file format here: [Connecting to an LDAP Directory](http://confluenceforge.org/display/Confluence/Connecting+to+an+LDAP+Directory)

**Permissions Changes**
In Confluence 2.1 and earlier, permissions that were assigned to Anonymous users were not automatically assigned to logged-in users, leading to the confusing situation where you could view a page when not logged in, but not view it when you were logged in.

In Confluence 2.2 and later, permissions that are assigned to the Anonymous user are also assigned to all logged in users. The sole exception to this rule is the global Use Confluence permission, which must still be explicitly granted to any user who wishes to log in. (This exception is necessary due to licensing restrictions).

### Search

With help from Kelvin Tan, we've overhauled much of the underlying infrastructure of Confluence's search engine. Search in Confluence should now be more efficient, and some searches that were problematic before (such as wildcard* searches) now work as you would expect them to.

### LDAP Performance

Confluence's performance against external LDAP user repositories should now be significantly faster.

### Other

- The General Configuration screen is much better organised
- You can choose a space's initial permissions and theme when you create it
- The left-navigation theme has improved
- Themes may now be packaged with icons that will be displayed in the theme selector (see the screenshot of the "create personal space" screen above for an example)
- Confluence Standalone is now packaged with Tomcat 5.5
- Atom feeds are now generated to the Atom 1.0 standard
- The back-end storage of attachment files has been changed to resolve a number of problems that were caused when the underlying filesystem did not support the character-set of the attachment filename

### Important note for MySQL users

For users using MySQL with Confluence 2.2 (or higher), please ensure that you are using the latest (3.1.12) MySQL Java Connector. Earlier versions of the MySQL connector have a bug which is triggered by improvements in Confluence 2.2. These earlier connector versions will result in an error being recorded in your logs on upgrade (and will result in unstable operation of Confluence)

```
ERROR [hibernate.tool.hbm2ddl.SchemaUpdate] execute could not complete schema update
```

You can download the latest MySQL connector from the [MySQL Java Connector 3.1 download page](https://mariadb.com/downloads/mysql/mysql-connector-java/). Please be sure that you remove any older versions of the connector from your application server.

### The Confluence 2.2 Team

**Development and Support 😊**

Tom Davies  
Jeremy Higgs  
David Loeng  
Charlie Miller  
Daniel Ostermeier  
Christopher Owen  
Matt Ryall  
Jens Schumacher

**Oversight & Mief management 😒**

Mike Cannon-Brookes  
Scott Farquhar
Issues Resolved for 2.2

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td><img src="authenticate.png" alt="Authenticate to retrieve your issues" /></td>
</tr>
</tbody>
</table>

Release Notes 2.2.1

Confluence 2.2.1 is a maintenance release that resolves some issues users may have encountered using Confluence 2.2, including issues related to LDAP user management, i18n, personal spaces and drafts.

2.2.1 is a free upgrade for all customers who purchased their Confluence license after May 18th, 2004.

Who should upgrade?

Confluence is a recommended upgrade for all customers using Confluence with external LDAP user management. All other customers should consult the list of issues resolved, and determine if this release is necessary for their own deployments.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

⚠️ Draft Table Upgrade

Upgrading Confluence to 2.2.1 will cause all autosaved 'drafts' to be deleted from the database. Be sure everyone has saved their work before upgrading!

⚠️ Confluence 2.2.1 and 2.2.1a

The current version available for download is 2.2.1a. 2.2.1 was originally released with an old version of the atlassian-plugins library, which caused the plugin fixes listed below not to be included in the release. Confluence 2.2.1a resolves that problem.

⚠️ PageChildrenMacro IndexOutOfBoundsException error

Customers who downloaded 2.2.1 or 2.2.1a before the official announcement may encounter an error when using the {children} macro to view the children of other pages in the same space. There is a patch for this issue attached to CONF-6197

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
Changes in 2.2.1

For a complete list, see: Issues resolved for 2.2.1

External User Management

- Creating a new user will no longer cause a primary key violation on some Confluence installations. CONF-6092
- Fixed a regression where authentication against an external LDAP server via the old OSUser integration layer did not function. CONF-6052
- Fixed a possible ClassCastException on viewing a user's profile. CONF-6021

Plugins

Note: Due to a scheduling error, these fixes were not included in Confluence 2.2.1, but are in the supplementary 2.2.1a release.

- Component plugins are now correctly unregistered when they are removed. CONF-4041
- Plugins may now contain and reference dependent jar files. Thanks to Dan Hardiker of Adaptavist for the patch. PLUG-8
- Installing an older version of an already-installed plugin no longer causes an error. PLUG-12
- Removing an uploaded plugin no longer causes it to be deactivated the next time it is installed. PLUG-13

General Stability

- Confluence can now store drafts for spaces with long (>20 character) keys. CONF-6010
- Attachments stored in MySQL databases will no longer be silently truncated to 64KB. CONF-6120
- Global language setting is now saved correctly. CONF-6027
- Missing attachment data no longer causes PDF export to crash. CONF-6063
- Misleading “attachment missing” errors are no longer logged after a space import. CONF-6026

Improvements

- A Javascript alert warns users if they have left the CAPTCHA field blank. CONF-5984
- A link to the logged-in user’s personal space is included on every page (from their full name). CONF-6056
- The {children} macro can now show the children of pages in another space. CONF-5986

Issues resolved for 2.2.1

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.2.2

Confluence 2.2.2 is a maintenance release that resolves some issues users may have encountered using Confluence 2.2, including issues related to PDF generation, internationalisation, backup/restore and more.

2.2.2 is a free upgrade for all customers who purchased their Confluence license after May 31st, 2005.
Who should upgrade?

Confluence 2.2.2 resolves CONF-6237, a bug related to the backup and restore of personal spaces. As such it is a recommended upgrade for customers wishing to restore or import data containing personal spaces. Other users should consult the list of resolved issues, and determine if the upgrade is necessary for their installation.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 or 2.2.1, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.2.2

Over 25 issues were resolved between Confluence 2.2.1 and 2.2.2. For a complete list, see: Issues resolved for 2.2.2

Backup/Restore

- An issue was resolved that could cause personal spaces to be imported incorrectly from backups. Existing backup files are still valid, the error was only during the re-importing process – CONF-6237

PDF Export

- PDF exports can now be generated for pages containing non-latin characters. To enable these exports you will need to provide Confluence with the correct font – CONF-1457
- PDF exports created in Confluence are now properly searchable, both in Confluence (CONF-1360) and in Adobe Acrobat (CONF-4529)

Other

- (UI) Fixed a Javascript error when saving a page with CAPTCHA disabled – CONF-6221
- (User management) Resolved an error when deleting a non-empty group – CONF-6082
- (i18n) Resolved issues with hard-coded English text in various places – CONF-6202
- (i18n) Resolved issues with internationalisation keys showing up in the permissions guide – CONF-6053

Issues resolved for 2.2.2

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>
Release Notes 2.2.3

Confluence 2.2.3 is a maintenance release that resolves some issues users may have encountered using Confluence 2.2, including issues related to LDAP user management, installation, backup/restore and more. This release also includes a patch for a serious security issue regarding global permissions.

2.2.3 is a free upgrade for all customers who purchased their Confluence license after June 8th, 2005.

Who should upgrade?

Confluence 2.2.3 resolves a security bug related to unauthorised modification of global permissions. As such this release is a recommended upgrade for all customers.

For users of older versions of Confluence who do not wish to upgrade, a patch for this issue will be available shortly.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2, 2.2.1 or 2.2.2, you can find instructions here. We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- [Release Notes 2.2](#)
- [Release Notes 2.1](#)
- [Release Notes 2.0](#)
- [Release Notes 1.4](#)
- [Release Notes 1.3](#)
- [Release Notes 1.2](#)
- [Release Notes 1.1](#)

Changes in 2.2.3

As part of a new process for pushing out bug fix releases more quickly, this release follows just a week after the release of 2.2.2. Six issues were resolved between Confluence 2.2.2 and 2.2.3. For a complete list, see: [Issues resolved for 2.2.3](#)

Global Permissions

- A security problem was identified where unauthorised users could modify global permissions. For more information, including details on how to patch previous Confluence versions, please see [the security advisory](#)

Backup/Restore

- An issue was resolved where attachments were not imported from space exports. Existing backup files are still valid, the error was only during the re-importing process – [CONF-6286](#)

External user management

- Queries to LDAP repositories are now correctly escaped, so user and group names may contain commas – [USER-106](#)

Other

- (UI) Fixed parent link in preview of new page – [CONF-6275](#)
- (authentication) Fixed incorrect redirect from login when base URL contained an extra slash – [CONF-6261](#)
- (installation) Improved error handling during Confluence setup – [CONF-6276](#)
Issues resolved for 2.2.3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.2.4

Confluence 2.2.4 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2.

2.2.4 is a free upgrade for all customers who purchased their Confluence license after June 22nd, 2005.

Who should upgrade?

Confluence 2.2.4 is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 - 2.2.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.2.4

We are currently trialling a process of more frequent bugfix releases, to make fixes available as soon as possible to those people who want them. 2.2.4 resolves six issues:

See also: Issues Resolved for 2.2.4

User Interface

- The "Space Admin" tab is no longer displayed to non-administrators. (Even though the tab was visible, non-administrators could still not access any of the administrative functions) CONF-6385
- Personal spaces are no longer listed in the space picker in the feed builder CONF-6830
- Attempts to create news items with invalid characters now fail with the correct error message CONF-6358
Performance

- The velocity manager is no longer loaded twice, saving memory. [CONF-6355]
- The velocity cache now expires templates that have not been recently used, potentially saving memory. [CONF-6339]

Developer API

- Putting pages into, and removing them from the trash now trigger the correct events within Confluence [CONF-6353]

Issues Resolved for 2.2.4

**JIRA Issues**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.2.5

⚠️ Release notes are to follow ...

Issues Resolved

**Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.**

**2.2.5 Security Patch**

This patch fixes a minor security vulnerability regarding the administration of space mail accounts. It affects only Confluence 2.2.5.

To install this patch please download the three files attached to this page, stop Confluence and copy them to your WEB-INF/classes/com/atlassian/confluence/mail/actions directory, where they will replace the existing files. Then start Confluence.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddMailAccountAction.class</td>
<td>5 kB</td>
<td>Tom Davies</td>
<td>Jul 12, 2006</td>
</tr>
<tr>
<td>EditMailAccountAction.class</td>
<td>6 kB</td>
<td>Tom Davies</td>
<td>Jul 12, 2006</td>
</tr>
<tr>
<td>RemoveMailAccountAction.class</td>
<td>1 kB</td>
<td>Tom Davies</td>
<td>Jul 12, 2006</td>
</tr>
</tbody>
</table>

**Release Notes 2.2.6a**

Confluence 2.2.6a is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2.

2.2.6a is a free upgrade for all customers who purchased their Confluence license after June 22nd, 2005.
Who should upgrade?

Confluence 2.2.6a is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading. Customers running Confluence 2.2.5 should upgrade, as 2.2.6a fixes a security problem which could allow an unauthorised user to modify space mail box configuration. Only version 2.2.5 is affected by this vulnerability. Customers running 2.2.5 who don’t wish to upgrade can follow these instructions to patch the vulnerability.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 - 2.2.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.2.6a

We are currently trialling a process of more frequent bugfix releases, to make fixes available as soon as possible to those people who want them. 2.2.6a resolves 20 issues.

A few of the issues are noted below, see Issues Resolved for 2.2.6a for a complete list.

User Interface

- The rich text editor allows underlining to be removed, and lists in tables are better behaved. CONF-6450, CONF-6508
- Users with capital letters in their names can watch pages and spaces. CONF-6489

LDAP

- LDAP users can be removed from local Confluence groups. CONF-6131
- The ‘Change Password’ link is no longer shown when LDAP is enabled. CONF-6360

Performance

- Indexing performance has been improved. CONF-6465

Issues Resolved for 2.2.6a

| JIRA Issues |
|-------------|-------------|-------------|-------------|-------------|
| Type        | Key         | Summary     | Status      | Resolution  |
|             |             |             |             |             |
|             |             |             |             | Authenticate to retrieve your issues |

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Release Notes 2.2.7

Confluence 2.2.7 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2.

2.2.7 is a free upgrade for all customers who purchased their Confluence license after July 28th, 2005.

Who should upgrade?

Confluence 2.2.7 is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 - 2.2.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.2.7

We are currently trialling a process of more frequent bugfix releases, to make fixes available as soon as possible to those people who want them. 2.2.7 resolves 23 issues.

A few of the issues are noted below, see Issues Resolved for 2.2.7 for a complete list.

Task List Macro

- Tasks with the same name in different lists are now distinguished. CONF-5809

User Management

- The manage groups page can now display an unlimited number of groups. CONF-6458
- Users that belong to more than 100 groups are now always able to login. CONF-6292

PDF Export

- Exporting pages to PDF which include other pages will now have correct links and not lose images. CONF-1155

Internationalisation

- Tree view of page hierarchy will not be truncated when using multi-byte character sets. CONF-5872

Issues Resolved for 2.2.7

JIRA Issues
Confluence 2.2.8 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2.

⚠️ Confluence 2.2.8 has slower indexing than previous versions. There is a fix for that regression here: CONF-6908

2.2.8 is a free upgrade for all customers who purchased their Confluence license after August 8th, 2005.

Who should upgrade?

Confluence 2.2.8 is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 - 2.2.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

- Release Notes 2.2
- Release Notes 2.1
- Release Notes 2.0
- Release Notes 1.4
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Changes in 2.2.8

We are currently trialling a process of more frequent bugfix releases, to make fixes available as soon as possible to those people who want them. 2.2.8 resolves 22 issues.

A few of the issues are noted below, see Issues Resolved for 2.2.8 for a complete list.

- Exporting a space as HTML now creates an index page which includes all the pages in the export. CONF-6670
- Timeouts can be set for HTTP requests made from Confluence to RSS feeds and JIRA instances. CONF-6697
- RSS Autodiscovery works in Safari. CONF-4607
- When a group is deleted, space permissions for the group are now correctly removed. CONF-6733
- Change default background colour from grey to white. CONF-6733

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
• Non-breaking spaces are handled correctly when indexing. CONF-6685
• Rich text editor respects leading spaces in noformat macro. CONF-6527

Issues Resolved for 2.2.8

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.2.9

Confluence 2.2.9 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2. 2.2.9 resolves an indexing performance regression introduced in 2.2.8, and includes fixes for external user management, and MaxDB and Sybase compatibility.

2.2.8 is a free upgrade for all customers who purchased their Confluence license after September 9th, 2005.

Who should upgrade?

Confluence 2.2.9 is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading.

If you are running Confluence 2.2.8, but do not wish to upgrade to 2.2.9, we strongly recommend installing the patch attached to CONF-6908 instead to resolve an issue related to re-indexing performance.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 2.2 - 2.2.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

• Release Notes 2.2
• Release Notes 2.1
• Release Notes 2.0
• Release Notes 1.4
• Release Notes 1.3
• Release Notes 1.2
• Release Notes 1.1

Changes in 2.2.9

2.2.8 resolves approximately 25 issues. See Issues Resolved for 2.2.9 for a complete list. A few of the issues are noted below.

External user management:

• LDAP users are no longer given the option to change their passwords in Confluence – CONF-6144
• External users belonging to more than 100 groups can log in successfully – CONF-6292
• External users can be removed from local groups – CONF-6832

Database Compatibility
• 'Review restricted pages' report now succeeds on MaxDB – CONF-6849
• Fixed Sybase error when removing a space – CONF-6715

Indexing
• A re-indexing performance regression introduced in 2.2.8 has been resolved – CONF-6908
• Advanced search queries for specific index fields now work as expected – CONF-6714
• Errors in text extractors no longer cause index queue flushing to fail – CONF-6857

Issues Resolved for 2.2.9

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td><strong>Authenticate</strong> to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.2.10

Confluence 2.2.10 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.2. 2.2.10 resolves an assortment of issues that were reported by customers.

2.2.10 is a free upgrade for all customers who purchased their Confluence license after November 30th, 2005.

*Who should upgrade?*

Confluence 2.2.10 is a minor bugfix release. Customers should consult the list of issues resolved in this release to determine if it is worth their while upgrading.

If you are running Confluence 2.2.8, but do not wish to upgrade to 2.2.10, we strongly recommend installing the patch attached to CONF-6908 to resolve an issue related to re-indexing performance.

Customers still running Confluence 2.2.2 or earlier are recommended to upgrade, as a significant security vulnerability was resolved in Confluence 2.2.3

*Upgrade Procedure*

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x version, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.1.5 or earlier, please check the release-notes of the other major Confluence releases:

• Release Notes 2.2
• Release Notes 2.1
• Release Notes 2.0
• Release Notes 1.4
• Release Notes 1.3
• Release Notes 1.2
• Release Notes 1.1

Changes in 2.2.10

2.2.10 resolves over 40 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.3

After much hard toil from the Confluence developers we are happy, nay ecstatic, to announce the availability of Confluence 2.3 (known affectionately as Snowy). Snowy is the eighth major update to Confluence. It supports clustered deployment as 'Confluence Massive', and introduces a people directory, activity statistics plugin, personal timezone preferences, and the ability to access Confluence via the Metaweblog and WebDAV APIs. Confluence 2.3 is a free upgrade for any customer who purchased Confluence after January 4th, 2006.

Upgrading from Confluence 2.2.x

Upgrading Confluence should be fairly straightforward: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Installation Notes

Known Issues and Patches

Please read the Release Notes 2.3 section of the release-notes before installing Confluence 2.3.
These issues were resolved with a new maintenance release of Confluence 2.3.1

Contents

1. New Features
2. Improvements

See also: Issues Resolved for 2.3

New Features

Confluence Massive

Confluence is now a clusterable application. This means that it is possible to run multiple Confluence servers behind a load-balancer, to provide high availability, and to scale Confluence beyond the capacity of a single server.

Confluence Massive uses Tangosol Coherence to share data between nodes (and many other things besides).
If you are thinking of running Confluence in a cluster, and need to know what is required and how it works, you can read Technical Overview of Clustering in Confluence.

You can find instructions for installing a Confluence cluster here: Confluence cluster installation.

**Cluster Licensing**

Confluence Massive clustering is only enabled if you have a clustered licence. For information on purchasing clustered Confluence licences, please check our pricing page, or contact our friendly sales team.

**The People Directory**

In version 2.2 (Shoalhaven), we added personal spaces to Confluence. Because of the potential for the proliferation of personal spaces we kept them off the Dashboard and search results by default, but this made it quite hard to find people in a Confluence site.

The People Directory, which you can find linked from the bottom of the Dashboard, gives you a way to browse through the other people who use a Confluence instance, their profiles and personal spaces.

If you find people whose personal spaces you want to follow, you can mark them as favourites from the people directory. This will add their personal spaces to your 'My' tab on the Dashboard, and will also make sure they're included when you search or make RSS feeds from your favourite spaces.
Activity Tracking

The activity plugin lets you know what's happening in Confluence: how many pages are being visited or edited in each space or across the whole site, which spaces or pages are the busiest, who are the most prolific editors.

You can view activity statistics for a space in Browse Space, or globally from the administration console.

The plugin also provides macros that allow you to embed usage data into a Confluence page: \{usage\}, \{popular\} and \{topusers\}.

Activity tracking does not work in a cluster, and will be disabled for clustered deployments. We're working on making the activity tracker clusterable in a future release. You can follow this issue in JIRA: CONF-7520

Blogger and MetaWeblog API Support
Confluence 2.3 bundles the [Blogging RPC Plugin](#). This allows users to manage their News in Confluence using one of the many available blogger-compatible desktop clients.

You can read more about this plugin, including instructions for setting up various blogging clients for use with Confluence, on the [plugin information page](#).

**WebDAV Client Support**

The Confluence WebDAV plugin allows users to mount Confluence as a shared drive, using the WebDAV protocol.

This provides a familiar interface for anyone who uses Confluence as a repository for files: you can browse your wiki straight from Windows Explorer or the Mac Finder; view Word or PDF versions of pages; upload attachments and edit attachments in place; create, edit and move pages.
For more information on the WebDAV plugin, check out: WebDAV Plugin

WebDAV is supported natively in Windows XP (as “Web Folders”) and Mac OS X, although there are third-party clients that may provide different functionality or compatibility. We have a compatibility matrix if you’re interested.

⚠️ Experimental

WebDAV client support is currently experimental, and is disabled by default. You can turn it on from the Plugin management page in the global administration console.

Improvements

Plugins

- Adaptivist's fantastic Plugin Repository Client is bundled with Confluence.
- User Macro Module allow you to share user macros more easily.
- Lifecycle Module allow you to hook into Confluence startup and shutdown.
- Events are now produced when themes are applied, or colour-schemes modified.
- Confluence now ships with 'bundled' plugins that are installed when Confluence is installed, but are not hard-coded into the application (so they can be upgraded without upgrading Confluence).
- Plugin resources now set Last-Modified and ETag headers properly, so they can be conditionally retrieved by browsers.
- Confluence is now built entirely using Maven 2. More on this soon.

Other Changes

- Users can now choose to have dates and times displayed in their own timezone instead of the server’s - CONF-1026.
- Most Confluence configuration data has been moved from the filesystem into the database.
- The Clickr Theme is bundled with Confluence.
- HTML exports are more reliable for sites with non-ASCII page titles - CONF-4862.
- You can now get users from multiple LDAP repositories at the same time (or different search paths in the same LDAP repository) - CONF-6034.
- Shortcut links can now have the substitution string in the middle of the URL (CONF-3246), and have
custom display text and titles (CONF-514).

- User macros are more flexible: you can configure how macro bodies are pre-rendered (CONF-2293), and you can also specify that a user macro generates wiki markup instead of HTML (CONF-3780).
- Pages with large numbers of attached images no longer eat up too many database connections - CONF-6393.
- When creating an RSS feed with the feed builder, you can choose whether to see full content, diffs, or both - CONF-6321.
- Searches now default to AND rather than OR for combining search terms - CONF-5874.
- The login page no longer prompts you to log in when you're already logged in. - CONF-6843.
- Support for the Nintendo Wii.
- Various improvements to performance that should result in a faster display of pages, and fewer problems for servers with large numbers of space permissions.
- Many static resources in Confluence are cached more effectively, so browsers have to retrieve CSS and Javascript files significantly less often - CONF-7212.

**Known Issues and Patches**

- Confluence 2.3 was originally accidentally shipped with three testing-only language packs. Since Sunday January 14th, the language packs have been removed from the distribution, but if you downloaded Confluence before that date they will be present. These language packs are machine translations, and are not intended for use on production systems (unless you’re a native German speaker and really want a good laugh). If you downloaded an affected copy of Confluence and want to remove these packs, delete de_DE-1.0.jar, ja_JP-1.0.jar and ru_RU-1.0.jar from confluence/WEB-INF/lib.
- You need to apply this patch to enable LDAP user integration: CONF-7585.
- If you have problems restoring backups please apply the patch included in this issue: CONF-7584.
- Due to class name changes, if you're upgrading from an existing system running:
  2. DB2 - you need to edit confluence.home/confluence.cfg.xml and replace bucket.dialect.DB2Dialect with com.atlassian.hibernate.dialect.DB2Dialect. More information in this issue: CONF-7690
- Log file atlassian-confluence.log is not presently generated. Please see these instructions for enabling it.

**The Confluence 2.3 Team**

**Development**
Tom Davies
Samuel Le Berrigaud
David Loeng
Charles Miller
Christopher Owen
Agnes Ro
Matt Ryall
Jens Schumacher
Don Willis

**Maven Mavens**
Michael Mekaail
Tony Truong

**Oversight & Mie** management
Mike Cannon-Brookes
Scott Farquhar

| And one was there, a stripling on a small and weedy beast, |
He was something like a racehorse undersized,
With a touch of Timor pony — three parts thoroughbred at least —
And such as are by mountain horsemen prized.
He was hard and tough and wiry — just the sort that won't say die —
There was courage in his quick impatient tread;
And he bore the badge of gameness in his bright and fiery eye,
And the proud and lofty carriage of his head.

- The Man from Snowy River, A. B. 'Banjo' Paterson

FileAppender log4j.properties

The 2.3 log4j.properties file doesn't specify a file for the FileAppender (because the necessary lines haven't been uncommented). Hence the log files normally generated via the file appender, logs/atlassian-confluence.log, is presently missing?

If you experience this situation and see errors in the logs such as:

```
log4j:WARN File option not set for appender [confluencelog].
log4j:WARN Are you using FileAppender instead of ConsoleAppender?
log4j:ERROR No output stream or file set for the appender named [confluencelog].
```

- Please uncomment the following lines in the `log4j.properties` file located under `confluence/WEB-INF/classes` and restart Confluence
  (ie remove the #'s)

```
#log4j.appender.confluencelog.File=${catalina.home}/logs/atlassian-confluence.log
#log4j.appender.confluencelog.MaxFileSize=20480KB
#log4j.appender.confluencelog.MaxBackupIndex=5
```

Relevant resources

Confluence 2.3 Release Notes

Issues Resolved for 2.3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>
Release Notes 2.3.1

Confluence 2.3.1 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.3.

2.3.1 is a free upgrade for all customers who purchased their Confluence license after January 23rd, 2006.

Who should upgrade?

Confluence 2.3.1 is a bugfix release which resolves some significant issues in Confluence 2.3. Customers running Confluence 2.3 should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.3 and wishing to upgrade should use this version also.

Significant issues for customers upgrading to Confluence 2.3

- **LDAP integration**: Confluence 2.3 shipped with a broken user migration script for customers wishing to integrate LDAP servers with their Confluence installation. 2.3.1 ships with a fixed version of this script which can also be obtained from CONF-7585.

- **Upgrading with MySQL**: Customers using Confluence with MySQL may have had difficulty upgrading their instances to Confluence 2.3. This issue has been resolved in 2.3.1.

Significant issues for existing Confluence 2.3 users

- **Backup import**: Confluence 2.3 users wishing to import backups into their Confluence instance should upgrade to 2.3.1 or apply the patch listed against CONF-7584.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.3.1

2.3.1 resolves 20 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td><img src="Authenticate" alt="Authenticate" /> to retrieve your issues</td>
</tr>
</tbody>
</table>
Release Notes 2.3.2

Confluence 2.3.2 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.3.1

⚠️ Warning for LDAP users
Confluence 2.3.2 has a serious bug that prevents it from working with LDAP servers. Please use Confluence 2.3.3 instead.

2.3.2 is a free upgrade for all customers who purchased their Confluence license after February 12th, 2006.

Who should upgrade?

Confluence 2.3.2 is a bugfix release which resolves some significant issues in Confluence 2.3.1 Customers running Confluence 2.3.1 and 2.3 should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.3 and wishing to upgrade should use this version also.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.3.2

2.3.2 resolves 22 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.3.3

Confluence 2.3.3 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.3.2

2.3.3 is a free upgrade for all customers who purchased their Confluence license after February 14th, 2006.

Who should upgrade?

Confluence 2.3.3 is a bugfix release which resolves some significant issues in Confluence 2.3.2 Customers running Confluence 2.3.2, 2.3.1 and 2.3 should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.
Customers running releases older than 2.3 and wishing to upgrade should use this version also.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.3.3

2.3.3 resolves 4 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.4

The Atlassian Confluence team is proud to present to you Confluence 2.4.2! What happened to 2.4 and 2.4.1? Let’s just say we gave them a good workout. Confluence 2.4 is the ninth release of Confluence. It introduces much awaited support for editable comments, the ability to mail a page to groups of users and includes the usual slew of fixes since the last stable release.

Confluence 2.4 is the first in a series of frequent, small releases planned for the first half or 2007, that will help us get the functionality you want from Confluence, faster. For more information on our new release schedule, you might want to read this blog post.

Confluence 2.4.2 is a free upgrade for any customer who purchased Confluence after March 13th, 2006.

Upgrading from Confluence 2.2.x and 2.3.x

Upgrading Confluence should be fairly straightforward: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.
1. **New Features**
2. **Improvements**

See also: *Issues Resolved for 2.4.2*

**New Features**

**Editable Comments**

Say *so long!* to those annoying typos and ill-structured sentences as comments in Confluence are now editable. Comments may be edited by the original author or the administrator for the space in which the comment was posted.

Confluence has a ten minute grace period after the comment is posted in which updates will not be flagged in the user interface. This is in acknowledgment of the fact that most edits within this period are for correcting minor typos and formatting which will not impact the flow of conversation.

For more information, see the Confluence user guide: [Editing a Comment](#)

**Page Mailing**

Confluence 2.4 ships with the Mail Page plugin allowing users to conveniently send the contents of a Confluence page to other interested parties. You can easily specify who you want the page mailed to by using a combination of:

- Email addresses
- Confluence user names
- Confluence group names

For security reasons, the Mail Page plugin is disabled by default. If you want to use this feature, an administrator will have to [enable it](#). There must also be a mail server configured in the Confluence instance for this operation to be available.
This operation is reached via a page's Info tab.

For more information, see the Confluence user guide: E-mailing a Page

Improvements

- The People Directory no longer shows inactive users (CONF-7771)
- Log messages now have more context such as the URL of the page being displayed and the name of the logged in user (CONF-7878)

The Confluence 2.4 Team

Development
Tom Davies
Matthew Jensen
Samuel Le Berrigaud
David Loeng
Charles Miller
Christopher Owen
Agnes Ro
Matt Ryall
Don Willis

Oversight & Mis management
Mike Cannon-Brookes
Scott Farquhar

Changes to the Page Permission API in Confluence 2.4

Confluence 2.4 contains changes to the Confluence API that will affect any plugins that modify Page Permissions (aka ContentPermissions). Some methods have been deprecated, some new methods have been created, and one method now behaves differently from before.
Confluence 2.4 does not support having multiple view and edit permissions on a page. The Content Permission API allows such a state, but it should be avoided. For example, if a Page has multiple permissions set on it, these permissions will not be displayed properly via the user interface, and the pages may not be returned appropriately in a search.

### Summary of Changes

<table>
<thead>
<tr>
<th>Deprecated methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContentPermissionManager.getInheritedViewContentPermissions(Page)</td>
</tr>
<tr>
<td>ContentPermissionManager.getInheritedContentPermissions(ContentEntityObject contentEntityObject)</td>
</tr>
<tr>
<td>ContentEntityObject.getPermissions()</td>
</tr>
<tr>
<td>ContentEntityObject.getContentPermission(String permissionType)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Changed methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContentPermissionManager.addContentPermission(ContentPermission permission, ContentEntityObject content)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Added methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContentPermissionManager.setContentPermissions(List contentPermissions, ContentEntityObject content, String type)</td>
</tr>
<tr>
<td>ContentPermissionManager.getInheritedContentPermissionSets(ContentEntityObject contentEntityObject)</td>
</tr>
<tr>
<td>ContentEntityObject.getContentPermissionSet(String type)</td>
</tr>
<tr>
<td>ContentEntityObject.hasPermissions(String type)</td>
</tr>
<tr>
<td>ContentEntityObject.removeContentPermissionSet(ContentPermissionSet set)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Removed methods</th>
</tr>
</thead>
<tbody>
<tr>
<td>ContentPermissionManager.saveContentPermission(ContentPermission permission)</td>
</tr>
<tr>
<td>ContentPermissionManager.getContentUserPermission(ContentEntityObject contentEntityObject)</td>
</tr>
<tr>
<td>ContentPermissionManager.onContentContextChanged(ContentEntityObject contentEntityObject)</td>
</tr>
<tr>
<td>ContentEntityObject.setPermissions(List permissions)</td>
</tr>
<tr>
<td>ContentEntityObject.clearPermissions(ContentPermissionManager permissionManager)</td>
</tr>
</tbody>
</table>

The change most likely to cause problems is:

ContentPermissionManager.addContentPermission(ContentPermission permission, ContentEntityObject content)

This method now adds a ContentPermission to the ContentEntityObject as one would expect. Previously if a ContentPermission already existed on the ContentEntityObject, then any existing ContentPermission would be
removed. That is, the method really behaved as one would expect "setContentPermission" to behave. As a result, any code that used addContentPermission in Confluence 2.3 or earlier, should now use setContentPermissions with a single entry list.

<table>
<thead>
<tr>
<th>Example conversion of old addContentPermission usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>replace ContentPermissionManager.addContentPermission(p, c) with ContentPermissionManager.setContentPermissions(java.util.Collections.singletonList(p), c, p.getType())</td>
</tr>
</tbody>
</table>

Most methods that used to return a ContentPermission have been replaced with methods that return a ContentPermissionSet. In some places we have used deprecation to point to the new method and reimplemented the old method to extract the first ContentPermission from the ContentPermissionSet.

As usual, the methods on the ContentPermissionManager should be used rather than those on the ContentEntityObject. The only ContentEntityObject method that should be used is getContentPermissionSet. Even that method should be used only to display the existing Permissions. All writes to the ContentPermissionSets should be performed via the ContentPermissionManager.

The onContentContextChanged method of the ContentPermissionManager was previously used to notify a ContentPermissionManager that cached permissions on a ContentEntityObject may be invalid. This is now accomplished by publishing a ContentPermissionEvent. That event is published automatically when changing ContentPermissions via the ContentPermissionManager.

No changes have been made yet to the the XML RPC API. It does not currently allow modification of ContentPermissions.

**Release Notes 2.4.1**

The Atlassian Confluence team is proud to present to you Confluence 2.4.2! What happened to 2.4 and 2.4.1? Let’s just say we gave them a good workout. Confluence 2.4 is the ninth release of Confluence. It introduces much awaited support for editable comments, the ability to mail a page to groups of users and includes the usual slew of fixes since the last stable release.

Confluence 2.4 is the first in a series of frequent, small releases planned for the first half of 2007, that will help us get the functionality you want from Confluence, faster. For more information on our new release schedule, you might want to read this blog post.

Confluence 2.4.2 is a **free upgrade** for any customer who purchased Confluence after March 13th, 2006.

**Upgrading from Confluence 2.2.x and 2.3.x**

Upgrading Confluence should be fairly straightforward: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

**Upgrading from Confluence 2.1 and earlier**

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.
Contents

1. New Features
2. Improvements

See also: Issues Resolved for 2.4.2

New Features

Editable Comments

Say *so long!* to those annoying typos and ill-structured sentences as comments in Confluence are now editable. Comments may be edited by the original author or the administrator for the space in which the comment was posted.

Confluence has a ten minute grace period after the comment is posted in which updates will not be flagged in the user interface. This is in acknowledgment of the fact that most edits within this period are for correcting minor typos and formatting which will not impact the flow of conversation.

For more information, see the Confluence user guide: Editing a Comment

Page Mailing

Confluence 2.4 ships with the Mail Page plugin allowing users to conveniently send the contents of a Confluence page to other interested parties. You can easily specify who you want the page mailed to by using a combination of:

- Email addresses
- Confluence user names
- Confluence group names

For security reasons, the Mail Page plugin is disabled by default. If you want to use this feature, an administrator will have to enable it. There must also be a mail server configured in the Confluence instance for this operation to be available.
This operation is reached via a page's Info tab.

For more information, see the Confluence user guide: E-mailing a Page

Improvements

- The People Directory no longer shows inactive users (CONF-7771)
- Log messages now have more context such as the URL of the page being displayed and the name of the logged in user (CONF-7878)

The Confluence 2.4 Team

Development
Tom Davies
Matthew Jensen
Samuel Le Berrigaud
David Loeng
Charles Miller
Christopher Owen
Agnes Ro
Matt Ryall
Don Willis

Oversight & Mis management
Mike Cannon-Brookes
Scott Farquhar

Release Notes 2.4.2

The Atlassian Confluence team is proud to present to you Confluence 2.4.2! What happened to 2.4 and 2.4.1? Let's just say we gave them a good workout.

**Confluence 2.4 is the ninth release of Confluence. It introduces much awaited support for editable comments, the ability to mail a page to groups of users and includes**
the usual slew of fixes since the last stable release.

Confluence 2.4 is the first in a series of frequent, small releases planned for the first half or 2007, that will help us get the functionality you want from Confluence, faster. For more information on our new release schedule, you might want to read [this blog post](#).

Confluence 2.4.2 is a **free upgrade** for any customer who purchased Confluence after March 13th, 2006.

**Upgrading from Confluence 2.2.x and 2.3.x**

Upgrading Confluence should be fairly straightforward: you can find instructions here. **We strongly recommend that you backup your confluence.home directory and database before upgrading!**

**Upgrading from Confluence 2.1 and earlier**

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

**Contents**

1. New Features
2. Improvements

See also: [Issues Resolved for 2.4.2](#)

**New Features**

**Editable Comments**

Say *so long!* to those annoying typos and ill-structured sentences as comments in Confluence are now editable. Comments may be edited by the original author or the administrator for the space in which the comment was posted.

Confluence has a ten minute grace period after the comment is posted in which updates will not be flagged in the user interface. This is in acknowledgment of the fact that most edits within this period are for correcting minor typos and formatting which will not impact the flow of conversation.

For more information, see the Confluence user guide: [Editing a Comment](#)

**Page Mailing**

Confluence 2.4 ships with the Mail Page plugin allowing users to conveniently send the contents of a Confluence page to other interested parties. You can easily specify who you want the page mailed to by using a combination...
of:

- Email addresses
- Confluence user names
- Confluence group names

For security reasons, the Mail Page plugin is disabled by default. If you want to use this feature, an administrator will have to enable it. There must also be a mail server configured in the Confluence instance for this operation to be available.

For more information, see the Confluence user guide: E-mailing a Page

**Improvements**

- The People Directory no longer shows inactive users (CONF-7771)
- Log messages now have more context such as the URL of the page being displayed and the name of the logged in user (CONF-7878)

**The Confluence 2.4 Team**

**Development**
Tom Davies
Matthew Jensen
Samuel Le Berrigaud
David Loeng
Charles Miller
Christopher Owen
Agnes Ro
Matt Ryall
Don Willis

**Oversight & Management**
Mike Cannon-Brookes
Scott Farquhar
Issues Resolved for 2.4.2

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.4.3

Confluence 2.4.3 is a maintenance release that resolves an assortment of issues users may have encountered using Confluence 2.4.2

2.4.3 is a free upgrade for all customers who purchased their Confluence license after March 22nd 2006.

Who should upgrade?

Confluence 2.4.3 is a recommended upgrade release which resolves some significant issues in Confluence 2.4.2. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.4 and wishing to upgrade should use this version also.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here.

We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.4.3

2.4.3 resolves 15 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.4.4

Confluence 2.4.4 is a recommended upgrade release that resolves issues users may have encountered using
Confluence 2.4.3 or earlier.

2.4.4 is a free upgrade for all customers who purchased their Confluence license after March 30th 2006.

Who should upgrade?

Confluence 2.4.4 is a recommended upgrade release that resolves issues users may have encountered using Confluence 2.4.3 or earlier. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.4 and wishing to upgrade should upgrade directly to 2.4.4.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here.

We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Source Release

Please note that the source release for 2.4.4 is currently unavailable. We have scheduled a fix for this which should be included in 2.4.5. Please see CONF-8007 for more details.

Changes in 2.4.4

2.4.4 resolves 17 issues. All these issues are listed below:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Authenticating to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.4.5

Confluence 2.4.5 is a maintenance release that resolves issues users may have encountered using Confluence 2.4.4 or earlier.

2.4.5 is a free upgrade for all customers who purchased their Confluence license after April 12th 2006.

Who should upgrade?

Confluence 2.4.5 is a recommended upgrade release which resolves some significant issues in Confluence 2.4.4. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.4 and wishing to upgrade should upgrade directly to 2.4.5.

Upgrade Procedure
Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or Confluence 2.3 version, you can find instructions here.

We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.4.5

2.4.5 resolves these issues:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.5

The Atlassian Confluence team is proud to present Confluence 2.5. Confluence 2.5 is the tenth release of Confluence. It introduces more flexible page restrictions, and also includes a number of minor fixes.

Confluence 2.5 is a free upgrade for any customer who purchased Confluence after April 27th, 2006.

Upgrading from Confluence 2.2 and later

Upgrading Confluence should be fairly straightforward: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Introducing flexible page restrictions

Page restrictions give you the ability to choose who may read and/or edit any given page.

By popular request, page restrictions have been enhanced and can now be assigned to multiple people and/or groups.
Other significant issues resolved

**Dynamic task list JRE incompatibilities**

Many customers have been prevented from upgrading the Java runtime hosting their Confluence instance due to [CONF-4082](https://jira.atlassian.com/browse/CONF-4082), an issue which would prevent existing dynamic task lists from working with the new JRE. This issue has been resolved in Confluence 2.5 allowing dynamic task list users to upgrade and downgrade between Java versions without experiencing conversion exceptions.

**contentbylabel macro supports AND condition**

You may now use the `operator=AND` parameter with the `contentbylabel` macro to select pages that have all of the supplied labels. ([CONF-4969](https://jira.atlassian.com/browse/CONF-4969))

**The Confluence 2.5 Team**

**Development**
Tom Davies  
Matthew Jensen  
Samuel Le Berrigaud  
David Loeng  
Charles Miller  
Christopher Owen  
Agnes Ro  
Matt Ryall  
Don Willis

**Oversight & Mie** management  
Mike Cannon-Brookes  
Scott Farquhar

**Issues Resolved for 2.5**

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

**Release Notes 2.5.1**
Confluence 2.5.1 is a maintenance release that resolves issues users may have encountered using Confluence 2.5 or earlier.

2.5.1 is a free upgrade for all customers who purchased their Confluence license after May 7th 2006.

Who should upgrade?

Confluence 2.5.1 is a bugfix release which resolves some significant issues in Confluence 2.5. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.5 and wishing to upgrade should upgrade directly to 2.5.1.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or a later version, you can find instructions here.

We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.5.1

2.5.1 resolves these issues:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.5.2

Confluence 2.5.2 is a maintenance release that resolves issues users may have encountered using Confluence 2.5 or earlier.

2.5.2 is a free upgrade for all customers who purchased their Confluence license after May 22nd 2006.

Who should upgrade?

Confluence 2.5.2 is a bugfix release which resolves some significant issues in Confluence 2.5. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.5 and wishing to upgrade should upgrade directly to 2.5.2.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or a later version, you can find instructions here.
We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.5.2

2.5.2 resolves these issues:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 2.5.3

Confluence 2.5.3 is a maintenance release that resolves issues users may have encountered using Confluence 2.5 or earlier.

2.5.3 is a free upgrade for all customers who purchased their Confluence license after May 30th 2006.

Who should upgrade?

Confluence 2.5.3 is a bugfix release which resolves some significant issues in Confluence 2.5. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

In particular, 2.5.3 fixes a problem which could cause indexing to fail when extracting text from unprintable encrypted PDF files.

Customers running releases older than 2.5 and wishing to upgrade should upgrade directly to 2.5.3.

Shared Mode Removed

This release removes the ‘Shared Mode’ setting from General Configuration. If you have shared mode enabled you should disable it before upgrading.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or a later version, you can find instructions here.

We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.5.3

2.5.3 resolves these issues:
Release Notes 2.5.4

Confluence 2.5.4 is a maintenance release that resolves issues users may have encountered using Confluence 2.5 or earlier.

2.5.4 is a free upgrade for all customers who purchased their Confluence license after June 13th 2006.

Who should upgrade?

Confluence 2.5.4 is a bugfix release which resolves some significant issues in Confluence 2.5. Customers running older versions of Confluence should review the list of resolved issues below, and upgrade if this release fixes any problems with their current Confluence installation.

Customers running releases older than 2.5 and wishing to upgrade should upgrade directly to 2.5.4.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from another Confluence 2.2.x or a later version, you can find instructions here.

We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from Confluence 2.1 and earlier

Users upgrading directly from 2.1 or earlier should also read the 2.2 Release Notes for caveats regarding the 2.1 -> 2.2 upgrade.

Changes in 2.5.4

2.5.4 resolves these issues:

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Release Notes 2.5.5

Confluence 2.5.5 is a recommended upgrade that resolves issues you may have encountered in Confluence 2.5.4 or earlier. Confluence 2.5.5 resolves two security bugs, related to space permissions and invalid...
characters in space names and keys.

As such this release is a recommended upgrade for all customers.

Confluence 2.5.5 is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after July 26th 2006.

Upgrading to Confluence 2.5.5

Upgrading Confluence should be fairly straightforward. You can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Changes in 2.5.5

Patch for security issues

Confluence 2.5.5 resolves two security bugs, related to:

- space permissions
- invalid characters in space names and keys.

For more information, please see the security advisory.

Server ID

Starting with release 2.5.5, Confluence will generate a server ID for you. Server ID has replaced License ID on the License Details page. You will find the server ID useful when contacting Atlassian support.

Server ID:

- is generated when you install Confluence for the first time
- exists for the life of the Confluence instance
- survives an upgrade
- is held in the database
- is not bound to a specific licence
- is the same for all servers in a cluster.

Translations for rich text editor now compatible with Confluence language pack plugins

⭐ Thank you to everyone who voted for this popular fix.

The rich text editor in Confluence shows text in tooltips, warnings and other messages. If you are using Confluence in a language other than English, you will want to translate these messages as well as the standard Confluence text.

With Confluence 2.5.5:

- The translations for the rich text editor can be part of a Confluence language pack plugin.
- If your language pack does not contain translations for the rich text editor, the text will show in English. (Before 2.5.5, it showed the 'key' value rather than English.)
- Partial translations of rich text editor messages are already included in the professional French and German language packs. Full translation is under construction.

This makes things much simpler!

You will find more information here:

- Overview of language pack translations
- Technical overview of language pack plugins
Specific information on translating the rich text editor

**Other fixes in 2.5.5**

2.5.5 resolves these issues:

Errors were reported by the JIRA trusted connection.

- APP_UNKNOW; Unknown Application: {0}; "confluence:4557196"

### JIRA Issues (19 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Assignee</th>
<th>Reporter</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-8917</td>
<td>XSS vulnerability: space name and key not validate nor escaped</td>
<td>Samuel Le Berrigau</td>
<td></td>
<td></td>
<td>Resolved</td>
<td>Fixed</td>
<td>Jul 16, 2007</td>
<td>Sep 07, 2010</td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Title</td>
<td>Description</td>
<td>Reporter</td>
<td>Assignee</td>
<td>Status</td>
<td>Created</td>
<td>Updated</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----</td>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------</td>
<td>---------------------------------</td>
<td>------------</td>
<td>---------------</td>
<td>---------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>864</td>
<td>feed doesn't filter personal labels</td>
<td>Miller [old account, do not assign issues]</td>
<td>Miller</td>
<td>Ived</td>
<td></td>
<td>2007</td>
<td>2008</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8860</td>
<td>Naming a page with a single dot locks page or space</td>
<td>Charles Miller [old account, do not assign issues]</td>
<td>François Nonnenmacher</td>
<td>Resolved</td>
<td>Fixed</td>
<td>Jul 06, 2007</td>
<td>Feb 27, 2008</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8855</td>
<td>Page title length is not being validated, leading to errorpage for titles longer than 255 characters</td>
<td>Samuel Le Berrigaud [Atlassian]</td>
<td>Igor Minar</td>
<td>Resolved</td>
<td>Fixed</td>
<td>Jul 05, 2007</td>
<td>Aug 20, 2008</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8846</td>
<td>Input for Labels is not properly validated</td>
<td>Christoper Owen [Atlassian]</td>
<td>Igor Minar</td>
<td>Resolved</td>
<td>Fixed</td>
<td>Jul 05, 2007</td>
<td>Jul 17, 2007</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8830</td>
<td>Stand alone tomcat server.xml has Unassigned</td>
<td>Tom Davies [Atlassian]</td>
<td>Unassigned</td>
<td>Resolved</td>
<td>Fixed</td>
<td>Jul 03, 2007</td>
<td>Jul 05, 2007</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Subject</td>
<td>Description</td>
<td>Assignee</td>
<td>Resolution</td>
<td>Fix Date 1</td>
<td>Fix Date 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>---------</td>
<td>-------------</td>
<td>----------</td>
<td>------------</td>
<td>------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8770</td>
<td>Email address exposure - email hiding option is ignored in user lookup</td>
<td>Don Willis [Atlassian]</td>
<td>Igor Minar</td>
<td>Resolved</td>
<td>Jun 26, 2007</td>
<td>Jul 19, 2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-8703</td>
<td>content label operator =AND performs like an OR</td>
<td>Unassigned</td>
<td>Fennie Ng [Atlassian]</td>
<td>Resolved</td>
<td>Jun 14, 2007</td>
<td>Dec 16, 2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-6987</td>
<td>Simplify Rich</td>
<td>Unassigned</td>
<td>Don Willis</td>
<td>Resolved</td>
<td>Sep 14, 2006</td>
<td>May 12, 2008</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Upgrade Guide 2.5.5

Who should upgrade?

Confluence 2.5.5 is a recommended upgrade that resolves issues you may have encountered in Confluence 2.5.4 or earlier. Confluence 2.5.5 resolves two security bugs, related to space permissions and invalid characters in space names and keys.

As such this release is a recommended upgrade for all customers.

Confluence 2.5.5 is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after July 26th 2006.

If you are running a release older than 2.5 and you want to upgrade, you should upgrade directly to 2.5.5. Refer to the upgrade procedure below.

Upgrade Procedure

Upgrading Confluence should be pretty easy. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.2.x or a later version, you can find instructions here.

If you are upgrading directly from 2.1 or earlier, you should also read the 2.2 Release Notes for warnings about the 2.1 -> 2.2 upgrade.

Release Notes 2.5.6

Confluence 2.5.6 is a recommended upgrade that resolves a number of security bugs and other issues you may have encountered in Confluence 2.5.5 or earlier.

As such this release is a recommended upgrade for all customers.

Confluence 2.5.6 can be downloaded from http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa, and is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after August 8th 2006.

Upgrading to Confluence 2.5.6

Upgrading Confluence should be fairly straightforward. You can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!
Changes in 2.5.6

- For details about the security fixes, please see the security advisory.
- CONF-8944 resolves a Crowd integration issue for Confluence 2.5.6 and later.
- The Crowd integration fix will be ported to previous Confluence versions in the near future - please see CONF-9122.

Here's a complete list of the bug fixes in Confluence 2.5.6:

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Upgrade Guide 2.5.6

Who should upgrade?

Confluence 2.5.6 is a recommended upgrade that resolves a number of security bugs and other issues you may have encountered in Confluence 2.5.5 or earlier.

As such this release is a recommended upgrade for all customers.

Confluence 2.5.6 can be downloaded from http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa, and is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after August 8th 2006.

If you are running a release older than 2.5 and you want to upgrade, you should upgrade directly to 2.5.6. Refer to the upgrade procedure below.

Upgrade Procedure

Upgrading Confluence should be fairly straightforward. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 2.2.x or a later version, please see the Confluence Upgrade Instructions.

If you are upgrading directly from 2.1 or earlier, you should also read the 2.2 Release Notes for warnings about the 2.1 -> 2.2 upgrade.

Release Notes 2.5.7

Confluence 2.5.7 is a recommended upgrade that resolves two issues you may have encountered in Confluence 2.5.6:

- Indexing errors claiming 'too many open files', caused by duplicate libraries in the Confluence web application.
- Caching should be enabled by default for the LDAP configuration in atlassian-user.xml.

Confluence 2.5.7 can be downloaded from http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa, and is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after 30 August 2006.

If you don't wish to upgrade to 2.5.7, but do want a fix for issue CONF-9251 ("Too many open files" error during index operations), you can manually remove the duplicate libraries shipped in the Confluence web application. Please follow the instructions on the JIRA issue.

Upgrading to Confluence 2.5.7

Upgrading Confluence should be fairly straightforward. You can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Changes in 2.5.7
Here is a complete list of the bug fixes in Confluence 2.5.7:

**Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.**

**Upgrade Guide 2.5.7**

**Who should upgrade?**

Confluence 2.5.7 is a recommended upgrade that resolves two issues you may have encountered in Confluence 2.5.6:

- Indexing errors claiming 'too many open files', caused by duplicate libraries in the Confluence web application.
- Caching should be enabled by default for the LDAP configuration in `atlassian-user.xml`.

Confluence 2.5.7 can be downloaded from [http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa), and is a free upgrade for all customers who purchased their Confluence license or maintenance renewal after 30 August 2006.

If you are running a release older than 2.5 and you want to upgrade, you should upgrade directly to 2.5.7. Refer to the upgrade procedure below.

**Upgrade Procedure**

Upgrading Confluence should be fairly straightforward. *We strongly recommend that you backup your `confluence.home` directory and database before upgrading!*

If you are upgrading from Confluence 2.2.x or a later version, please use the [Confluence Upgrade Instructions](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa).

If you are upgrading directly from 2.1 or earlier, you should also read the [2.2 Release Notes](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa) for warnings about the 2.1 -> 2.2 upgrade.

**Release Notes 2.5.8**

Confluence 2.5.8 is a **highly recommended** upgrade that resolves some issues in the user management framework and a memory leak in Confluence 2.5.x.

You can download Confluence 2.5.8 from [http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa). This upgrade is free for all customers with active Confluence software maintenance as at 3 October 2007.

⚠️ This release has been made available after the [Confluence 2.6 release date](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa). This 2.5.8 version is for customers who want to fix the issues listed below, but do not want all the new functionality and theme changes in Confluence 2.6 yet.

**Upgrading to Confluence 2.5.8**

Upgrading Confluence should be fairly straightforward. You can find instructions here. *We strongly recommend that you backup your `confluence.home` directory and database before upgrading!*

**Changes in 2.5.8**

Here is a complete list of the bug fixes in Confluence 2.5.8:

**Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.**

**Upgrade Guide 2.5.8**

**Who should upgrade?**
Confluence 2.5.8 is a highly recommended upgrade that resolves some issues in the user management framework and a memory leak in Confluence 2.5.x.

You can download Confluence 2.5.8 from [http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa](http://www.atlassian.com/software/confluence/ConfluenceDownloadCenter.jspa). This upgrade is free for all customers with active Confluence software maintenance as at 3 October 2007.

If you are running a release older than 2.5 and you want to upgrade, you should upgrade directly to 2.5.8, referring to the upgrade procedure below.

**Upgrade procedure**

Upgrading Confluence should be fairly straightforward. **We strongly recommend that you back up your confluence home directory and database before upgrading!**

If you are upgrading from Confluence 2.2.x or a later version, please use the [Confluence Upgrade Instructions](http://confluence.atlassian.com/display/DOCS/Confluence+Upgrade+Instructions).

If you are upgrading directly from 2.1 or earlier, you should also read the [2.2 Release Notes](http://confluence.atlassian.com/display/DOCS/Release+Notes+2.2) for warnings about the 2.1 -> 2.2 upgrade.

**Confluence 1.x.x Releases**

- [Release Notes 1.0](#)
  - [Release Notes 1.0rc5](#)
    - Issues Resolved for 1.0rc5
  - [Release Notes 1.0b1](#)
  - Issues Resolved for 1.0b4
    - [Release Notes 1.0b4](#)
  - [Release Notes 1.0rc2](#)
    - Issues Resolved for 1.0rc2
  - [Release Notes 1.0rc6](#)
    - Issues Resolved for 1.0rc6
  - [Release Notes 1.0a3](#)
  - [Release Notes 1.0b2](#)
    - Feature List
  - [Release Notes 1.0rc1](#)
    - Issues Resolved for 1.0rc1
  - [Release Notes 1.0b3](#)
    - Issues Resolved for 1.0b3
  - [Release Notes 1.0a2](#)
  - [Release Notes 1.0.1](#)
    - Issues Resolved for 1.0.1
  - [Release Notes 1.0.3](#)
    - Issues Resolved for 1.0.3
  - [Release Notes 1.1](#)
    - Issues Resolved for 1.1
  - [Release Notes 1.1.1](#)
    - Issues Resolved for 1.1.1
  - [Release Notes 1.1.2](#)
  - [Release Notes 1.2](#)
    - Issues Resolved for 1.2
    - [Permissions Changes in 1.2](#)
  - [Release Notes 1.2.1](#)
    - Issues Resolved for 1.2.1
  - [Release Notes 1.2.2](#)
Ring the bells. Break out the champagne. Paint the town red. Dance naked in the streets. Or at least that’s what we’ll be up to tonight, because we’re finally releasing Confluence 1.0!

Confluence 1.0 represents the hard work and dedication of quite a few people. Obviously there’s the development team: Ara, Armond, Charles, Dave, Mike and Ross, but there’s also the JIRA team and the rest of the guys at Atlassian who have offered support, advice, and loud music. A huge thanks also goes out to everyone involved in the beta-testing program. Your real-world use of Confluence gave us invaluable suggestions and bug-reports, and we apologise for the times we’ve messed up your databases on the way.

We’re pretty proud of all the cool stuff we’ve managed to fit into Confluence already, and we’re looking forward to making it even better in forthcoming versions (Remember, a license entitles you to a year of upgrades).

The only sad moment for the day is that for the 1.0 release, we had to lose emoticons. The regular expression responsible for turning 😊 into a smiley-face was causing pages to take ten seconds to render. Commenting out the filter lowers the rendering time of even highly complex pages to a few hundred milliseconds. We promise, the smileys will return in a future version, faster and stronger than ever! Or if you don’t mind the cost, you can re-enable them by uncommenting the emoticonFilter line in wikiSubsystemContext.xml

Users of late Release Candidate builds will notice a substantial improvement in performance as a result.
New Features

For once, we managed to resist the urge to add any new features this week, since we were busy cleaning everything up for today’s release.

Notable Bug-fixes

- We have verified that you can now use Confluence's internal datasources with MySQL (for users of RC5 or earlier, see the upgrade section below for information on how to change to the production-ready datasources)
- Fixed the database transaction problems that were causing problems with user/group management, page renaming and commenting
- [-user] links no longer place the context path in the link twice
- Fixed a rendering regression that caused text to be spaced incorrectly within panels
- The 404 error page no longer causes a NullPointerException
- The 'diff' link now works in HTML edit notification emails when Confluence is installed in a non-root context.

Outstanding Issues

- The Emoticon filter is currently shipped disabled, because it was causing page-load times to go through the roof CONF-963
- You can not complete the Confluence setup process if you have external user-management enabled. Set up Confluence before setting up external user-management. CONF-950
- It is possible to make a "create page" link to a page with invalid characters in its title (which will thus fail to be created) CONF-810
- If you are using PostgreSQL, please make sure you use the JDBC3 version of the Postgres JDBC drivers. Some users have encountered problems with the JDBC2 drivers.
- Links to images that are page-attachments are broken in email notifications CONF-878
- There continue to be problems with high-bit characters in pages when Confluence is deployed on Resin CONF-569

Upgrading from RC6

We haven't made any changes to the database schema, so you should just be able to install the new version of Confluence, point it at your existing confluenceHome directory, and carry on as before. I would, however, recommend making a backup before you upgrade, just in case.

If you:

1. have not gone through the Confluence database setup steps since Confluence 1.0RC5
2. are running the embedded HSQL database, or are connecting to a database directly (not through an Application Server Datasource)

Then you will need to add a few connection pooling properties to confluence.cfg.xml file in your confluenceHome directory. Edit the file, and insert the following somewhere in the <Properties> section:

If you do not fall into the category described above, or if you find these lines are already in the file, you do not need to do this!

```
<property name="hibernate.c3p0.max_statements">0</property>
<property name="hibernate.c3p0.min_size">0</property>
<property name="hibernate.c3p0.timeout">30</property>
<property name="hibernate.c3p0.max_size">4</property>
```
This will enable c3p0 connection-pooling, which is far more reliable than the default pooling that we were using previously.

Notable Features from Previous Releases

Here’s a quick retrospective of some of the cool things we have added to Confluence during the beta- and RC-releases. It is by no means comprehensive, but you can follow the links to the original release notes for an idea of just how busy we’ve been in recent months.

Confluence 1.0a2 (November 6, 2003)
- Shortcut links allow you to create special URL Shortcuts to point to existing web services: i.e. CONF-195
- Undefined and Orphaned Pages reports
- Revert page to previous version

Confluence 1.0a3 (December 5, 2003)
- Comments for pages
- Links in exported PDFs are internal links if the destination page has also been exported, external links otherwise
- Personal History popup keeps track of the pages you have visited
- Page Information screen lists all the incoming and outgoing links on a page
- Printable version of every page

Confluence 1.0b1 (December 19, 2003)
- Pages that have changed since your last login are highlighted in the ‘recent changes’ list
- Pages can be organised in parent-child hierarchies, allowing for clearer organisation of pages within a space
- Page renaming refactors links to the page, wherever they may appear in the site
- Search works across all content in the site, including comments, space descriptions and user information
- A new permission was added for creating comments
- {color} macro for coloured text
- Parameters allowed on image links

Confluence 1.0b3 (January 19, 2004)
- Beta2 was released a few days earlier, but we'd prefer not to talk about it.
- Searching works across PDF, HTML, XML and Word attachments
- The colour-scheme and page decorators can be configured across the site
- The site homepage is configurable
- Emoticons 😊
- New macros: {include}, {include-html}, {rss}, {search}, {jiraissues}, {junitreport}
- User profiles can be longer than 255 characters
- Much better handling of anonymous contributions

Confluence 1.0b4 (January 26, 2004)
- FatCow, our acceptance-testing framework was introduced to the world
- Confluence now supports chronologically organised content: blog posts
- You can now move pages between spaces, and have their links updated accordingly
- en — and em — dashes are supported
- You can link directly to attachments
- New macros: {blog-posts}, {anchor}, and an improved {rss} macro

Confluence 1.0rc1 (February 6, 2004)
- XML-RPC and SOAP APIs allow you to programatically interact with Confluence
- Trackback allows Confluence to notify other sites of links, and be notified by them
- User notifications on page and space editing were overhauled
- Look and Feel configuration was enabled individually for each space
• Linking to space descriptions and user profile pages directly is now possible: Confluence User Community, Mike Cannon-Brookes
• History popup tracks more than just pages

**Confluence 1.0rc2 (February 13, 2004)**

• Improvements to the remote API
• RSS and HTML macros now use HTTP proxies if configured to

**Confluence 1.0rc5 (February 20, 2004)**

• RC3, RC4 and RC5 were released within days of each other, in a flurry of mad bug-fixing
• Page templates can now be filled in in-line
• If a page is moved or renamed and you go to the URL it used to inhabit, Confluence will try to direct you to its new location
• Exported PDFs now incorporate the site's stylesheet

**Confluence 1.0rc6 (March 5, 2004)**

• You can prevent people signing up, for private Confluence installations
• You can configure Confluence to mask user email addresses
• User management can now be shared with JIRA
• Page templates can now contain drop-down menus and text areas
• New macro: {{html}}

**Release Notes 1.0rc5**

**Confluence 1.0rc5**

It's time to release Confluence 1.0rc5 into the wild: it's the fourth Release Candidate since last Friday, and we're definitely getting close here. The last two release-candidates did not have their own release-notes, so these notes will also include things that were fixed for those versions.

**Contents**

1. **New Features**
2. **New Macros**
3. **Improvements**
4. **Notable Bug-fixes**
5. **Outstanding Issues**

See also: **Issues Resolved for 1.0rc5**

**New Features**

In keeping with our promise to not add any features during the Release Candidate process, we have been very restrained, and only added two new features 😊

**Template Preview**

Page templates have been given an overhaul: when filling in your template variables, you are presented with a template of the rendered page, with input fields where the variables will be inserted. If you have the same variable used in several places, the form will take care of keeping them all in synch.
Step 2: Fill in template variables

Choose values for the variables in this template. These values will be automatically inserted into the template for you in the correct locations.

New template (title)

By David Loeng (author)

February (month) 20th (day), 200[ ] (year)

After a week of frantic bug-fixing, we have released Confluence 1.0 Release Candidate 2. Thanks everyone for reporting all the bugs they found in RC1. While we really hope you’ll keep reporting anything you find that doesn’t work, we’re also hoping that there’s a lot less to report now.

(from) - (to)

(from) - (to)

(from) - (to)

We have released RC2 because it’s a lot more stable than RC1. We know a lot of you are already using Confluence in some kind of production capacity, and we don’t want to keep you waiting for the important fixes that we put in this week.

Since we’re in the middle of a feature freeze, there obviously aren’t any new major features in this release, but there are a number of incremental improvements, and a lot of fixes.

Regards.

David Loeng (author)

Page Redirection

When you rename or move a page, the page’s old URL will attempt to give users some clue as to where they should be looking: checking which pages have had this name in the past, or redirecting users to pages in another space with the same name.

In This Space

The page you were looking for may have been renamed to one of the following:

- *Ridiculous* (Fish Space)
  And yet another page to add to the confusion

- *Before* (Fish Space)
  Lorem ipsum dolor sit amet, consectetur adipiscing elit. Integer euismod tellus et sem. Aliquam ullamcorper hendrerit arcu. Sed lacinus odio, mattis ut, sollicitudin a, tincidunt vitae, magna. Integer aliquam nibh sed libero...

In Other Spaces

The page you were looking for may have moved to another space:

- *Cows* (Bouncy Space)
  This is the page before it was renamed.

New Macros

- (weblogs) is a synonym for (blog-posts)

Improvements
The user signup screen has a more friendly UI
Exported PDFs now incorporate the site's stylesheet, and thus look a lot better.
Confluence now has a useful "404" error page that gives the user some suggestions of how to find what they were looking for.
An Administrators page, linked from the footer of each page, lists those users in the "confluence-admin" group. (If you don't want your address to be made public on this page, create an administrative group with some other name)
The error you receive when you exceed your licensed user limit is more informative, and no longer directs users to email Atlassian.
The SnipSnap importer converts SnipSnap blog posts to Confluence blog posts.
Several methods added to the XML-RPC and SOAP APIs for managing users and spaces. (See Conf Remote API Additions)
The Daily Report email is more informative and more readable
Page comments and Parent/child relationships are maintained during HTML and PDF exports
news: and nntp: URL schemes are now recognised in bracketed links

Notable Bug-fixes

Since RC2
- Links between pages now work when you have a context path other than / (oops!)
- The daily report email is no longer sent every minute (oops!)
- You can no longer download attachments without being logged in (OOPS!)
- Search results no longer highlight words that were terms in previous searches

Since RC3
- Page redirects now work properly under Orion 2.0.2

Since RC4
- Removing a user no longer causes their notifications to hang around and crash things
- Removing a blog post works, too
- Many fixes to PDF rendering and exporting
- Many fixes to handling of Latin character set (See outstanding issues below)
- Invalid macros now give a more informative error than "no group 3"
- The 404 error page no longer requires you to log in to view it
- Macros that generate HTML (page include, HTML include, JIRA, RSS, FatCow) bypass the remainder of the page processing, and so should have far fewer formatting errors now.
- User browser filter remembers your search across pages

Plus, of course, innumerable fixed to annoying crashing bugs across all three releases.

Outstanding Issues

Latin Characters under Resin

We've tested creating pages with non-ASCII titles and content across several different browsers and several different operating systems, and they seem to be working reliably now... except on Resin. This will be quite noticeable since confluence.atlassian.com itself is running under Resin, but we have so far been unable to come up with a solution that works on this application server.

For users who need this functionality, we suggest running under Tomcat.
- On MySQL, the "orphaned pages" report may include the space's homepage CONF-766
- Combining block macros with lists is dangerous CONF-756
- Under some circumstances, paragraph tags will not be closed CONF-746

Issues Resolved for 1.0rc5
**Release Notes 1.0b1**

*Confluence 1.0b1*

Confluence 1.0b1 was released 19th December 2003.

That's right - we finally got it out the door! *cheers from around the room erupt as developers across in the Atlassian offices crack open a beer.*

**New Features**

- It's soooo much faster as we've implemented caching at multiple levels - trust me, it now *flies* in development. Here's hoping it flies for you too. (For those with a development bent, turn on profiling via the URL to see a beautiful profiling stack trace on stdout)
- The last login date is now tracked, pages and spaces changed since your last login are highlighted in green (as these are presumably pages you want to view), you can see a diff of the currently viewed page against the date you last logged in and there are various related reports of spaces/pages changed since your last login.
- Parent/child page hierarchies have been implemented. You can specify the parent for any pages and the ancestry is reflected in the breadcrumbs list. The full hierarchy is shown (including the current page's position) on the Page Information screen, and there is a related macro to show the children in various different types of trees (see the Notation Guide for details)
- Search has been completely overhauled - search now works across pages, comments and space descriptions and the results now display descriptions with highlighted search terms (this is really cool!)
- Page renaming and link refactoring now works across comments, space descriptions and pages - neat!
- The Notation Guide has been significantly improved with more useful examples, a list of the available macros and a tabbed interface. Also the edit/create pages now have a 'quick notation guide' to the most commonly used operations
- There is a new 'Create Comment' permission - so that you can make spaces which are publicly viewable/commentable, but not editable.
- The UI of the 'create link' and 'external link' links within a rendered page have been improved with subtle icons
- Page comments now have a sexy icon of their own, and can be shown/hidden at will. You can also permalink to any given comment and comments are fully indexed.
- Undefined and orphaned pages reports have been tightened significantly so that they now report truly undefined/orphaned pages
- You can create a list of URLs ignored from external referrers - this is useful where your server is known by multiple IP / domain name combinations, or you want to ignore all internal referrers (Admin / General configuration)
- `{color}` macro to colour blocks of text
- Logging in to Confluence now takes you to your intended destination, not the Dashboard
- There is an option to choose whether the default link for a space goes to the space homepage or the space summary (people internally and externally seem to be divided about which it should go to - so you can choose for yourselves)
- You can now edit and add SMTP servers through the web interface
- The administration interface has been completely overhauled and tightened
• Added a Mail Queue administration page
• Added a View System Information page
• Added a pretty error page, and the ability to submit but reports (including exports) directly to us
• The permissions viewing and editing pages have been greatly simplified and improved across the application
• Confluence now has a licensing system, so you will need a license key to evaluate (these can be generated online as with JIRA).
• Image embedding can now include parameters (such as height, width, alignment etc) - see the Notation Guide for details.
• https:// links are now treated just like ftp:// and http:// external links
• Various rendering bugs have been fixed.
• Many other minor fixes, improvements and performance tweaks

Issues Resolved for 1.0b4

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.0b4

Confluence 1.0b4

To belatedly ring in the Year of the Code-Monkey, it’s time for Confluence 1.0 beta 4. We’ve had some great feedback on the last few betas, thanks to everyone for submitting bugs, and contributing to Atlassian Answers and the discussion space.

Contents

1. FatCow
2. New Features
3. New Macros
4. Improvements
5. Notable Bug-fixes
6. Outstanding Issues

See also: Issues Resolved for 1.0b4

Atlassian FatCow

Along with 1.0b4, we’re also releasing FatCow: Functional Acceptance Testing for the Confluence Wiki. Styled after Ward Cunningham’s Fit and Bob Martin’s Fitnesse, FatCow allows you to define web-based acceptance tests in wiki notation, and then run them from inside Confluence. Here’s a tutorial showing how to write a quick FatCow test suite that makes sure Confluence shows up on Google. 😊

FatCow is Open Source, and also serves as example code for anyone who wants to extend Confluence by writing their own macros (something that we’ll be looking to make easier in future releases).
New Features

Blog Posts

Each space can now host a "blog" of pages that are organised by date, rather than just by title. This is pretty useful if you want to attach some kind of updating news to a space. The "create blog post" button can be found on the right-hand toolbar.

Blogging support is pretty basic right now: you can create posts, and you can include the most recent posts in a page using the {blog-posts} macro. Rest assured, we'll be piling on the features in the next few releases.

Move Pages Between Spaces

A much requested feature, our newest refactoring lets you move pages cleanly from one space to another. We're using this already to maintain a private space where we stage documentation waiting to be transferred to the main documentation space.

Configurable Site Description

You can now change the text in the site description that appears on the user's dashboard: somewhere to put welcome messages or MOTDs. And, of course, it understands Confluence markup.

#includePage("Page") Velocimacro

For the decorator-editors, you can use this render the contents of a page anywhere inside a decorator. The page has to be in the space that the user is looking at, and if the page does not exist, nothing will be rendered.

New Macros

- {blog-posts} displays the most recent blog posts for a space.
- {rss} macro now has maxEntries and titleBar parameters.
- {anchor} macro allows you to create named anchors in a page (link to them with [SPACE:page#anchor])

Improvements

- You can now draw en – and em — dashes.
- mailto: links are now drawn as just the email address, like so user@example.com
- the {search} macro now excludes the page it was included in from the search results
- you can also link to attachments using #-anchors [SPACE:page#attachment.pdf]
- you are given the opportunity to pick a template when creating a page from a link, and any entered page title survives picking a page template

Notable Bug-fixes

- Spurious error message about editing a stale version of a page have been squashed.
- No longer crashes when you add a user to certain groups.
- Some database queries have been rewritten to work around the fact that MySQL doesn't understand sub-selects.
- Diffs more reliably highlight changed words
- Several minor rendering problems to do with deeply nested lists have been fixed.
- and many more...

Outstanding Issues

- You should restart Confluence immediately after finishing the initial setup steps, to avoid data loss CONF-493
- New-lines may not be drawn if the next line starts with whitespace CONF-475
Issues Resolved for 1.0

Release Notes 1.0rc2

Confluence 1.0rc2

After a week of frantic bug-fixing, we have released Confluence 1.0 Release Candidate 2. Thanks everyone for reporting all the bugs they found in RC1. While we really hope you'll keep reporting anything you find that doesn't work, we're also hoping that there's a lot less to report now.

We have released RC2 because it's a lot more stable than RC1. We know a lot of you are already using Confluence in some kind of production capacity, and we don't want to keep you waiting for the important fixes that we put in this week.

Since we're in the middle of a feature freeze, there obviously aren't any new major features in this release, but there are a number of incremental improvements, and a lot of fixes.

But first, a...

WARNING

If you are upgrading from Confluence 1.0rc1, do not perform a backup of your data from within Confluence. There was a serious bug with RC1 that caused user permissions to be corrupted during data exports.

There have been no database changes between RC1 and RC2, so you should simply be able to run RC2 against your existing data without performing a backup/restore.

If you wish to back your data up safely before the upgrade, you will need to do so manually: shut down Confluence, make a copy of your Confluence home directory (as defined in `confluence-init.properties`, and if you are storing your data in something other than HSQL, use your database's native backup procedure.

h4. Contents

1. Improvements
2. Other Bug Fixes
3. Other Outstanding Issues

See also: Issues Resolved for 1.0rc2

Improvements

* Remote XML-RPC and SOAP APIs now have a `{{getPermissions()}}` method
* `{noformat}` macro accepts a title parameter
* Page view and create links are no longer displayed if the user does not have permission to view or create the destination page.
* When you create a page from viewing a previous page, you are given another chance to make that page the new page’s parent.
* RSS and HTML include macros use HTML proxies if they are defined using the standard Java {{http.proxyHost}} and {{http.proxyPort}} system properties.
* Default session timeout is now 60 minutes
* Improvements to user browser and user profile page UI
* Shortcut link definitions are now backed up and restored

**Notable Bug-fixes**

**Stability**

We've done a lot of work tracking down the source of any exception and page error that has been reported to us, and fixing their causes. We've also made one or two improvements to the error reporting page, but we're hoping you won't see it nearly as often (if at all) any more.

**Page Templates**

The creation, editing and deletion of page templates should now be a lot more reliable and provide a smoother user experience.

**Also**

* You no longer have to restart Confluence after its initial setup [http://jira.atlassian.com/browse/CONF-493](http://jira.atlassian.com/browse/CONF-493).
* Performing a full data export no longer corrupts users' group membership data: [http://jira.atlassian.com/browse/CONF-645](http://jira.atlassian.com/browse/CONF-645).
* You can now link to profiles of users with an @ symbol in their usernames: [http://jira.atlassian.com/browse/CONF-639](http://jira.atlassian.com/browse/CONF-639).
* Trying to create a page with illegal characters in its name no longer loses your page content on some browsers: [http://jira.atlassian.com/browse/CONF-713](http://jira.atlassian.com/browse/CONF-713).
* Trackback pings are now sent for URLs that are not surrounded by square brackets: [http://jira.atlassian.com/browse/CONF-708](http://jira.atlassian.com/browse/CONF-708).
* And, of course, many more.

**Outstanding Issues**

The two major areas we still need to work on are the PDF export and the use of non-ASCII characters in pages (especially page titles). Handling of both are much better than they were a week ago, but there's still some work to do before they're completely reliable.

**Issues Resolved for 1.0rc2**

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>----</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.0rc6
Confluence 1.0rc6

Confluence 1.0rc6 fixes more bugs. Lots of them. There aren't many new and interesting features to report, although we have implemented the much-requested ability to mask email addresses and prevent public signup. Mostly, we've been toiling away fixing the lots of little problems that are getting in the way of us calling Confluence truly worthy of the 1.0 label.

Contents

1. New Features
2. New Macros
3. Improvements
4. Notable Bug-fixes
5. Outstanding Issues

See also: Issues Resolved for 1.0rc6

New Features

Private Confluence Configuration

In private mode, the only way to add users to Confluence is through the administrative interface: users can not sign up on their own. This way, you can prevent random passers-by from signing on to your Confluence installation. The site administrator can configure this in the general administration settings.

Email Address Privacy

Another much-requested feature, the site administrator has three options for email-address privacy:

- Public: just like pre-rc6, users email addresses are displayed publicly.
- Masked: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- Private: only site administrators can see users' email addresses.

Administrators should be aware that even in private mode, anyone in the confluence-admin group will still be listed (with their email address) on the administrators page, although their addresses will be masked.

Share User Management with JIRA

For sites with both a Confluence and a JIRA installation, Confluence can be set up to delegate its user-management to JIRA.

Template Field Types

Templates now support drop-down menus and text-input areas.

@variablenametextarea(5,10)@ will give you a 5 x 10 text-area called ‘variablename’.
@variablename|list(one,two,three,four)@ will give you a drop-down list called ‘variablename’, with options one, two, three and four.
Step 2: Fill in template variables

Choose values for the variables in this template. These values will be automatically inserted into the template for you in the correct locations.

<table>
<thead>
<tr>
<th>Name of software:</th>
<th>postfix (name)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed on:</td>
<td>mail (server)</td>
</tr>
<tr>
<td>Installed by:</td>
<td>Charles Miller (installer)</td>
</tr>
</tbody>
</table>

Configuration Notes

Follow the instructions for installing SASL authentication from [here](http://ezine.daemonnews.org/200306/postfix-sasl.html)

New Macros

- The `{html}` will allow you to insert arbitrary HTML code into a page. This macro is turned off by default, as it is a security-risk on public systems. We only recommend you enable it on private or intranet-based Confluence installations where you trust your users not to write malicious HTML code. Here's a trivial example of its use:

  ```html
  <p>This HTML is <b>inserted</b> into the page</p>
  ```

- The `{junitreport}` macro has an option: "reportdetails=failuresonly" that will cause it to only show details of tests that have failed. For example: `{junitreport:directory=file://var/tests|reportdetails=failuresonly}

Improvements

- Users are now taken to their preferred homepage rather than the dashboard after logging in
- Text-fields in a template are disabled during preview and viewing
- Orphaned and Undefined page reports are now paginated
- Macros such as `{code}` or `{noformat}` are now made part of a list if they are placed adjacent to them

Notable Bug-fixes

- User->Group relationships should no longer disappear during manual or scheduled backups
- Search results no longer allow people to see content they might not be allowed to see
- Comments should no longer appear out of order on a page
- Moving a page between spaces no longer breaks #anchor links
- Many rendering fixes, some subtle, some not so
- Many stability fixes, especially regarding import and export

Outstanding Issues

Random MySQL Disconnections
If you are running Confluence against MySQL using Confluence's built-in datasource, the connection with the database server may be lost after long periods of inactivity. We are pretty sure we have a fix for this, but since the bug takes several hours to manifest, we were not able to test the fix before the release of rc6.

The good news is that if we are right, it will only require a quick edit of your configuration file to implement the fix. Further announcements will be made both on confluence.atlassian.com, and the confluence-user mailing-list.

In the meantime, the workaround is to not use Confluence's built-in datasource, but to configure Confluence to use your application-server's JNDI datasources instead. Instructions for doing this with Tomcat can be found here, and if you need more help, don't hesitate to contact us at confluence-support@atlassian.com.

Latin Characters under Resin

We've tested creating pages with non-ASCII titles and content across several different browsers and several different operating systems, and they seem to be working reliably now... except on Resin. This will be quite noticeable since confluence.atlassian.com itself is running under Resin, but we have so far been unable to come up with a solution that works on this application server.

For users who need this functionality, we suggest running under Tomcat.

Also..

- On MySQL, the "orphaned pages" report may include the space's homepage CONF-766
- You can create a link to a page with an illegal title: prompting the user to create a page that can not exist CONF-810
- Trackbacks are not sent for shortcut links CONF-888

Issues Resolved for 1.0rc6

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.0a3

Confluence 1.0a3

Confluence 1.0a3 was released December 5 2003

New Features

- Completely rearchitected around the spring framework
- Page comments (CONF-235) - users can now attach comments to a page.
- Email notification for new comments.
- Supports non-ASCII characters in page names (CONF-297)
- Improved handling of internal and external links in exported PDFs
- Editing popup to help with inserting links (internal and external) into pages (CONF-129)
- Personal history (CONF-196) - a popup window containing your recently visited pages.
- Page information screen (CONF-270) lists all the incoming and outgoing links for a page, and all attachments
- User profile UI has been enhanced (CONF-172)
- Dashboard and Space summary pages have had a big UI overhaul
• Brief help on Wiki notation now available on create and edit pages. (CONF-295)
• Improved available help on various pages.
• Enhanced mail-server administration.
• All pages have a printable version accessible from the icon at the top-right of the page (CONF-338)
• HTML and text email notifications have been greatly improved and are now much more useful. Links in HTML emails work seamlessly with online Confluence version.
• Many other minor fixes, improvements and performance tweaks

Release Notes 1.0b2

I see dead pages!

Confluence 1.0b2 was released on Friday January 16, 2004 with a major bug in its search indexing that caused it to index pages that no longer existed. It was replaced by 1.0b3 the next Monday.

See also: Release Notes 1.0b3 and Issues Resolved for 1.0b3

Feature List

The features listed on this page refer to Confluence version 1.0 beta1.

Content Management

• Content is organised into discrete spaces in which users can create and edit pages.
• Easy-to-learn, easy-to-read but powerful notation for designing pages and linking between them, based on the popular textile markup.
• Arbitrary files can be attached to pages.
• Comments can be left on pages.
• Page templating allows rapid creation of boiler-plate pages.
• Pages can be organised into hierarchies.

Update Tracking

• Each page has a full change history, accessible as coloured diffs highlighting each change made.
• Simple Reports which pages have been updated since you last logged in.
• Email subscription informs you of pages that have been added or updated, or comments left.
• RSS feeds available for new and updated pages across the site, or in individual spaces.

Searching

• Full-text searching of all content, including pages, comments and space descriptions

Site Management

• Smart page-renaming updates links across the entire site, even in comments or space descriptions.
• Pages or spaces can be imported from plain text files, or exported to PDF or HTML.
• Simple backup and restore to XML files.
• Automatic daily backup feature.
• Reports of "orphaned" pages that exist but are not linked to, and of links that point to pages that do not yet exist.

User Management and Security

• Flexible security, from a public site, to a personal space.
• User- and group-based permissions.
• Separate viewing, commenting, editing and administration permissions for each space.

Deployment and Compatibility

• Available on a wide variety of platforms, either as a stand-alone server, or as a web-archive deployable into a compatible Java application server.
• Compatible with a large number of databases
Support

- Confluence is under full-time development, with licensees entitled to a year of free updates.
- Atlassian's Legendary Service.

Release Notes 1.0rc1

Confluence 1.0rc1

It's Friday again, and that means it's time for us to release Murray; Confluence 1.0 Release Candidate 1.

RC1 marks the start of the feature-freeze as we plunge headfirst towards a stable 1.0 release. From now until 1.0-final we will be concentrating on fixing up the remaining bugs and polishing the interface. We are hoping that we won't need to send out a second release candidate, but we can't really make any promises until we've had a chance to go through the inevitable deluge of new issues that will follow this release.

Of course, this means that there are features you want to see in Confluence that won't make it into 1.0-final. [Keep those ideas and suggestions coming|DISC:]. Confluence isn't going to stop at 1.0 -- we just had to draw a line _somewhere_ or we'd end up perpetually in beta. We have no plans to slow down development after the first major release. Your Confluence licence includes a year of upgrades, and if you think Confluence is way cool now, it's just going to get better.

As always, before upgrading an existing Confluence installation, be sure to back up your data.

As you can see below, we've been busy the last two weeks. A hard-earned thirst needs a good cold beer.

Contents

1. New Features
2. New Macros
3. Improvements
4. Notable Bug Fixes
5. Outstanding Issues
6. Database Changes from Beta

See also: Issues Resolved for 1.0rc1

New Features

Remote API

![Confluence can now be browsed and edited remotely via SOAP or XML-RPC.](http://blogs.atlassian.com/rebelutionary/images/screeshots/conf-cocoa-client-shot-thumb.gif) Confluence can now be browsed and edited remotely via SOAP or XML-RPC. [There are more details of the XML-RPC API here](http://developer.atlassian.com/display/CONFDEV/Confluence+XML-RPC+and+SOAP+APIs), while the SOAP WSDL can be downloaded from `{$your_confluence_root$/rpc/soap/confluenceservice-v1.wsdl}`). Throwing together a GUI client for Confluence is now [pretty](http://blogs.atlassian.com/rebelutionary/archives/000385.html) [easy](http://fishbowl.pastiche.org/2004/02/05/a_confluence_gui_client_in_200_lines_of_code), so feel free to embed Confluence support into your favourite editor, web browser or IDE.

Blogging Enhancements

The sketchy blogging support from Beta4 has been upgraded and overhauled. Enhancements include:

- The look and feel of blog pages has been greatly improved.
- A "recent blog posts" list available from the Space Summary page.
- Daily and monthly views for blog posts.
- Blog posts can now be edited and deleted.
- You can now link to blog posts using the internal link syntax. Blog posts are addressed by their
posting-date and title, like so: \{SPACEKEY:/2004/01/03/Blog Post Title\}.

- You can link to the daily views, too: \{SPACEKEY:/2004/01/03/\.
- RSS feeds are available for new blog posts, both globally (from the dashboard), and for each space (from the space summary page).

Also, anonymous users are no longer allowed to post blog entries. We couldn't really think of a use-case where anonymous blog-posts would be wanted, but if you can, let us know!

### Configurable User Notification

With any knowledge-sharing application, it's important to keep informed as to what has changed. One way to do this is by subscribing to any of the RSS feeds offered by Confluence. Another is to have Confluence email you directly whenever there has been a change. Up 'til now, users have had to make do with the ad-hoc regular-expression based notifications that were put in for developers. With RC1, we now have a more fine-grained and user-friendly way to choose how you find out about changes to the site.

- Each day, Confluence can email you a summary of any changes that have been made to the site in the past 24 hours. You can activate this feature in your user preferences.
- You can subscribe to "watch" a page from the option in the right-hand operations menu. Whenever the page is modified, commented on, or a new attachment is added, you will receive an email. When you no longer want to watch the page, you can click the icon again to unsubscribe.
- You can subscribe to watch an entire space from the option on the space summary page. This subscribes you to all pages in that space, and also notifies you when new pages are created.

Each user can now also choose whether or not they will be notified of changes they make themselves.

### Trackbacks

While Confluence has always tracked links between pages within the Confluence site, it now has a way to track links to and from external sites: the Trackback API. In this way, a Confluence page can be informed when another site has mentioned it, and inform other sites that it has linked to them.

We have implemented the [Trackback](http://www.movabletype.org/docs/mttrackback.html) and [Trackback auto-discovery](http://www.movabletype.org/docs/mttrackback.html#autodiscovery%20of%20trackback%20ping%20urls) APIs across pages and blog-posts. Trackback is a widely implemented API that allows web pages to notify each other of links. You can enable (or disable) trackbacks from the Confluence general administration page.

When Trackbacks are enabled, each Page and Blog Post within Confluence is set up to receive trackback pings, and contains the auto-discovery code to allow clients to automatically find out how to send those pings. Trackbacks that are received are listed in the right-hand sidebar of the page.

Also when Trackbacks are enabled, Confluence will perform auto-discovery on each outgoing link from a page to see if the destination is equipped to receive trackbacks, and send its own trackback ping.

Look forward to future versions of Confluence making _very_ interesting use of this feature. :)

### Per-Space Look and Feel

The template-- and colour-scheme editing features that were available on a global basis in previous versions of Confluence can now be configured separately for each space, allowing you to apply a different look and feel to the various spaces within your Confluence site.

### New Macros

- [Panel Macro](#) allows you to draw a shaded box containing some content.
Improvements

- Import and Export should now be much faster, and use significantly less memory.
- The user browser now has a search function, to make it possible to manage large numbers of users effectively.
- Incoming links are no longer displayed on a page if the user is unable to view the page being linked from.
- The \{anchor\}, \{blog-posts\}, \{index\} and \{quote\} macros are now documented properly.
- You can escape smileys by putting a backslash before their last character, to cause them not to be rendered as images :).
- You can now link to peoples' user profile pages with \{~username\} (e.g. \{~cmiller\}).
- You can now link to space homepages with \{SPACEKEY:} (e.g. \{TEST:}.
- mailto: links have a nifty icon: mailto:user@example.com.
- The History popup now tracks your visits to blog posts, space summaries and user profile pages.
- Recent changes listings on the dashboard, user profile and space summary pages now includes changes to all content, not just pages.
- New Emoticons! (well, icons really)

| (y') | (n') | (i') | (') | (x') | (') |
| (y) | (n) | (i) | () | (x) | () |

Notable Bug-fixes

- Added HTML headers to detect and prevent RSS, HTML-Include and FatCow macros from being made to loop in on themselves. [CONF-525@JIRA]
- The \{anchor\} macro, and \{DOCPRIV:|null\} links now work as advertised. [CONF-616@JIRA], [CONF-605@JIRA]
- Fixed a divide-by-zero error in page diffs. [CONF-584@JIRA]
- Included \{javax.transaction\} libraries with release, to allow the WAR to run under Tomcat 5 [CONF-613@JIRA].
- And many more rendering and stability fixes...

Outstanding Issues

- Still some problems with character encoding in page titles. [CONF-569@JIRA]
- HTML include macro interacts badly with other Radeox filters. [CONF-549@JIRA]

Database Changes from Beta4

New Tables

TRACKBACK and NOTIFICATION tables were introduced. These tables should be generated automatically when you first start RC1.

New column in the EXTRNLINKS table

- alter table EXTRNLINKS add column CONTENTTYPE varchar(255);
- Constraint Change on LINKS Table*

The "not null" constraint was removed from the DESTPAGETITLE column of the LINKS table. Consult your database documentation on how to alter your database for this change. For example:

- _MySQL 3.23:_ alter table LINKS modify DESTPAGETITLE VARCHAR(255);
- _PostgreSQL 7.3.2:_ alter table LINKS alter DESTPAGETITLE drop not null;

Issues Resolved for 1.0rc1

JIRA Issues
Release Notes 1.0b3

Confluence 1.0b3

1.0b3 was released on January 19th, 2004. It replaces the short-lived 1.0b2 release, after 1.0b2 managed to escape into the wild with a bug in the search index that made it see pages that weren't there any more. Since 1.0b2 only existed for one weekend, the release-notes for both versions have been folded into a single document.

This is a massive release. Over 90 issues (new features, improvements and bug-fixes) were resolved between beta-1 and beta-3, with even more improvements made below the issue-tracking radar.

Contents

1. New Features
2. New Macros
3. Improvements
4. Notable Bug-fixes
5. Outstanding Issues

See also: Issues Resolved for 1.0b3

New Features

Search Attachments

Attachments are now indexed for searching just like any other content in the Confluence space. Alongside text, HTML and XML attachments, Confluence will also index Word, RTF and PDF documents.

Configurable Look and Feel

The site administrators can now customise the colour-scheme of the Confluence installation. More advanced configuration can be done by [editing the site's templates] through a web interface, changing the appearance of the whole site.

Site Homepage

The site administrator can now set the site homepage for users who have not logged in: choosing from either the dashboard (the default behaviour in beta1 and before), or any of the Space homepages within the site.

Users who have logged in can choose their own site homepage in their user profile.

RSS Feed for New Comments

You can subscribe to all new comments added to a space using an RSS newsreader. (The link to the RSS feed can be found on the Space Summary page)

Emoticons
New Macros

- **Include Page Macro** include the contents of one Confluence page within another.
- **HTML Include Macro** include the contents of an HTML document within a Confluence page (turned off by default. See [Enabling the html-include Macro](#) for more information).
- **RSS Feed Macro** include an external RSS feed
- **Search Results Macro** include the results of a Confluence search
- **JIRA Issues Macro** integrate Jira issue reports with your Confluence site
- **JUnit Report Macro** include JUnit test result data

Improvements

- Users' login names and full names are indexed for searching.
- Users' profiles may now be longer than 255 characters, and are also indexed for searching.
- Usernames are no longer case-sensitive.
- Anonymous contributions are clearly labeled.
- Users are warned if they are editing or commenting without having logged in.
- Notification emails now link to the appropriate "diff" page, so you can quickly see what has changed.
- Page diffs now highlight precisely what changed within each line: very useful when just one or two words change in a long paragraph.
- Lists of child pages and links are sorted alphabetically.
- Long lists of pages or search results are paginated.
- Shortcut links can be given different link text in the same way as other links.
- Incoming links and "hot referrers" are listed in the sidebar of the page view.
- Child pages are listed below the page contents in the page view.

Notable Bug-fixes

- You no longer get the old page (or don't see the comment) immediately after editing or commenting on a page [http://jira.atlassian.com/browse/CONF-453](http://jira.atlassian.com/browse/CONF-453).
- Persistent login cookies no longer conflict with a JIRA installation on the same server [http://jira.atlassian.com/browse/CONF-440](http://jira.atlassian.com/browse/CONF-440).
- Persistent login cookies no longer fail for users with certain characters in their username [http://jira.atlassian.com/browse/CONF-387](http://jira.atlassian.com/browse/CONF-387).
- Users who are not logged in no longer see strange table titles [http://jira.atlassian.com/browse/CONF-422](http://jira.atlassian.com/browse/CONF-422).
- And many more.

Outstanding Issues

- You should restart Confluence immediately after finishing the initial setup steps, to avoid data loss [http://jira.atlassian.com/browse/CONF-493](http://jira.atlassian.com/browse/CONF-493).
- New-lines may not be drawn if the next line starts with whitespace: [http://jira.atlassian.com/browse/CONF-475](http://jira.atlassian.com/browse/CONF-475).
- Emoticons are rendered inside \{noformat\} blocks: [http://jira.atlassian.com/browse/CONF-502](http://jira.atlassian.com/browse/CONF-502).
- If you put a \{children\} macro after an \{include\} macro, it will list the children of the included page: [http://jira.atlassian.com/browse/CONF-504](http://jira.atlassian.com/browse/CONF-504).

Issues Resolved for 1.0b3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>
Issues resolved for 1.0b2

1.0b3 was a quick bug-fix release for 1.0b2, so here are the issues resolved in 1.0b2:

### JIRA Issues

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-195 &amp; CONF-247</td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 1.0a2

**Confluence 1.0a2**

Confluence 1.0a2 was released November 6, 2003.

**New Features**

- Shortcut links ([CONF-195 & CONF-247](#)) - shortcut links enable you to easily make links to any 'web service' from within the syntax of a Confluence page. Simply specify your shortcut and the URL to link to (e.g. "google", "http://www.google.com/search?q=$1") to add your own links. You could use this to link directly to JIRA installations, Google, intranets, searches or anything that has a 'URI' based interface.
- Revert page to a previous version ([CONF-32](#)) - revert to a previous version of any given page from the list of previous versions.
- Forgot password function ([CONF-88](#)) - retrieve your password if you happen to have forgotten it.
- Report: undefined pages ([CONF-197](#)) - list of all pages which are linked to from other pages, but not defined.
- Report: orphaned pages ([CONF-198](#)) - shows all the pages which are never linked to (ie have content but no way to get to them).
- Interstitial help page after creating a space ([CONF-251](#))
- 'Notify me', and HTML/text email preferences, with HTML email content
- Links to non-exported pages are now maintained in exported PDFs (the links point back to the online Confluence installation)
- Custom Radeox macros can now be used within Confluence - this enables you to write your own macros to produce custom content
- XML import/export of a single space ([CONF-199](#)) - useful for porting spaces between installations
- XML import/export of a single page ([CONF-200](#)) - useful for creating pages automatically, or sync'ing pages between installations.
- Many other minor fixes, improvements and performance tweaks

Release Notes 1.0.1

**Confluence 1.0.1**

Over the course of the last month of supporting Confluence 1.0, there are a number of patches that we have...
been distributing to fix specific problems our users have encountered. Confluence 1.0.1 is a maintenance release into which all these patches have been integrated.

Who Should Upgrade?

All the issues that were resolved for this release are listed below. We have not snuck in any other changes: what you see here in the release notes is precisely what you will get. If you find something on the list that directly affects you, or that you feel justifies the effort of an upgrade, then do so. Otherwise, feel free to stick with 1.0.

Upgrade Procedure

If You Have Customised osuser.xml

If you have customised Confluence’s user-management, for example to integrate it with LDAP or JIRA, you will have to integrate your changes to account for the caching OSUser providers we introduced in Confluence 1.0.1. See this document for more details: Confluence Caching OSUser Provider. Updated instructions for integrating with JIRA user management are here: Delegate user management to use JIRA logins.

Otherwise

To avoid the possibility of data-loss, you should back up your ConfluenceHome directory and your database before upgrading, and perform a full backup from within the application.

Changes in 1.0.1

See also Issues Resolved for 1.0.1

Direct Attachment Links

In response to a loud demand from users, links to attachments using the \^[attachment.jpg] syntax will download the attachment file directly, instead of linking to an anchor in the destination page.

Sybase ASE Support

Confluence 1.0.1 resolves the following problems that were causing Confluence not to work with Sybase ASE 12.5.1:

- ORDER-BY mappings failing on Sybase (CONF-1021)
- Can’t add users under Sybase (CONF-1022)
- Weird datatype error under Sybase (CONF-1024)
- Sybase doesn’t like complicated distinct selects (404 page fails) (CONF-1025)
- Backup import fails under Sybase (CONF-1063)

These bug-fixes may also improve Confluence’s compatibility with other untested databases. They will not, however, have any effect on Confluence’s operation against PostgreSQL, MySQL or HSQL.

Microsoft SQL Server Dialect in Setup Page

The Microsoft SQL Server database dialect was missing from the database setup page. It has now been added to the list. Confluence has not yet been tested on Microsoft SQL Server, and the usefulness of this option is not yet guaranteed. However, since the Sybase issues above are now resolved and SQL Server belongs to the same family as Sybase, it would be well worth a try.

JIRA User Provider Caching

Users who were linking their user management to JIRA’s using the supplied provider were experiencing significant performance problems as a result. 1.0.1 introduces caching to the user provider, which should speed up these installations significantly.

Global Reports Visibility
Under Confluence 1.0, the global "undefined pages" and "orphaned pages" reports did not properly filter out pages that the user could not see. The user could not see the content of any page they did not have access to, but they could learn of the existence of (and names of) pages and spaces they were not permitted to see. This bug is fixed in 1.0.1

Locale-Independent Dates in Backup/Restore

In Confluence 1.0, dates were written into backup files using a localised representation of the month. As such, if you exported Confluence data from a server in one locale it might not import successfully into a server with a different Locale setting. Confluence 1.0.1 still recognises the 1.0 export format, but its own exports will write out dates in a locale-independent format.

As noted above, this means that data exported from Confluence 1.0.1 can not be imported successfully into Confluence 1.0.

Fix Browser Crash on Viewing Some Templates

Previously, if you created a template containing no variables, then anyone attempting to preview or use that template would have their browser hang in an infinite Javascript loop. Confluence 1.0.1 fixes this bug.

Typo Fixed on User Group Editing Page

A single-character change from "privilage" to "privilege".

Issues Resolved for 1.0.1

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authentciate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes_1.0.1

Confluence 1.0.1

Over the course of the last month of supporting Confluence 1.0, there are a number of patches that we have been distributing to fix specific problems our users have encountered. Confluence 1.0.1 is a maintenance release into which all these patches have been integrated.

Who Should Upgrade?

All the issues that were resolved for this release are listed below. We have not snuck in any other changes: what you see here in the release notes is precisely what you will get. If you find something on the list that directly affects you, or that you feel justifies the effort of an upgrade, then do so. Otherwise, feel free to stick with 1.0.

Upgrade Procedure

If You Have Customised osuser.xml

If you have customised Confluence's user-management, for example to integrate it with LDAP or JIRA, you will have to integrate your changes to account for the caching OSUser providers we introduced in Confluence 1.0.1. See this document for more details: Confluence Caching OSUser Provider. Updated instructions for integrating...
with JIRA user management are here: [Delegate user management to use JIRA logins](#)

**Otherwise**

To avoid the possibility of data-loss, you should back up your ConfluenceHome directory and your database before upgrading, and perform a full backup from within the application.

## Changes in 1.0.1

See also [Issues Resolved for 1.0.1](#)

### Direct Attachment Links

In response to a loud demand from users, links to attachments using the \[^attachment.jpg\] syntax will download the attachment file directly, instead of linking to an anchor in the destination page.

### Sybase ASE Support

Confluence 1.0.1 resolves the following problems that were causing Confluence not to work with Sybase ASE 12.5.1:

- ORDER-BY mappings failing on Sybase ([CONF-1021](#))
- Can't add users under Sybase ([CONF-1022](#))
- Weird datatype error under Sybase ([CONF-1024](#))
- Sybase doesn't like complicated distinct selects (404 page fails) ([CONF-1025](#))
- Backup import fails under Sybase ([CONF-1063](#))

These bug-fixes may also improve Confluence's compatibility with other untested databases. They will not, however, have any effect on Confluence's operation against PostgreSQL, MySQL or HSQL.

### Microsoft SQL Server Dialect in Setup Page

The Microsoft SQL Server database dialect was missing from the database setup page. It has now been added to the list. Confluence has not yet been tested on Microsoft SQL Server, and the usefulness of this option is not yet guaranteed. However, since the Sybase issues above are now resolved and SQL Server belongs to the same family as Sybase, it would be well worth a try.

### JIRA User Provider Caching

Users who were linking their user management to JIRA’s using the supplied provider were experiencing significant performance problems as a result. 1.0.1 introduces caching to the user provider, which should speed up these installations significantly.

### Global Reports Visibility

Under Confluence 1.0, the global “undefined pages” and “orphaned pages” reports did not properly filter out pages that the user could not see. The user could not see the content of any page they did not have access to, but they could learn of the existence of (and names of) pages and spaces they were not permitted to see. This bug is fixed in 1.0.1

### Locale-Independent Dates in Backup/Restore

In Confluence 1.0, dates were written into backup files using a localised representation of the month. As such, if you exported Confluence data from a server in one locale it might not import successfully into a server with a different Locale setting. Confluence 1.0.1 still recognises the 1.0 export format, but its own exports will write out dates in a locale-independent format.

As noted above, this means that data exported from Confluence 1.0.1 can not be imported successfully into Confluence 1.0.
Fix Browser Crash on Viewing Some Templates

Previously, if you created a template containing no variables, then anyone attempting to preview or use that template would have their browser hang in an infinite Javascript loop. Confluence 1.0.1 fixes this bug.

Typo Fixed on User Group Editing Page

A single-character change from "privilage" to "privilege".

Release Notes 1.0.3

Confluence 1.0.3

Confluence 1.0.3 is another maintenance release, hopefully the last maintenance release we will need on the 1.0 branch before moving full steam ahead towards version 1.1. It fixes some bugs regarding the remote SOAP/XML-RPC API, the display of the 404 error page under Postgresql, and the display of the site's stylesheet under certain versions of Internet Explorer.

The Confluence development team are now working hard on 1.1, which will contain significant improvements and new features. Remember, a Confluence license entitles you to a year of upgrades, so if you buy 1.0.3 today, you'll be able to upgrade to 1.1 for no extra charge when the time comes.

See also: Issues Resolved for 1.0.3

Who should upgrade?

Confluence users should be running at least Confluence 1.0.2. Versions prior to 1.0.2 contain a bug that will cause their licenses to expire a month after the build date listed in the page footer, regardless of the true expiry date of the license. Versions 1.0.2 and later do not contain this bug. (Note: In the absence of this bug, only trial licenses ever expire. Purchased licenses for Confluence do not expire.)

All the issues that were resolved for this release are listed below. We have not snuck in any other changes: what you see here in the release notes is precisely what you will get. If you find something on the list that directly affects you, or that you feel justifies the effort of an upgrade, then do so. Otherwise, feel free to stick with 1.0.2

Upgrade Procedure

Confluence 1.0.3 contains no database or configuration file changes, so you should just be able to unpack it on top of your existing Confluence installation:

1. Shut down the Confluence server
2. Back up conflicense/WEB-INF/classes/confluence-init.properties, and if you have customised it, conflicense/WEB-INF/classes/osuser.xml
3. Unpack Confluence 1.0.3 in the same location as your existing Confluence installation
4. Restore the two files you backed up in step 1 to the 1.0.3 installation.
5. Start Confluence

To avoid the possibility of data-loss, you should back up your ConfluenceHome directory and your database before upgrading, and perform a full backup from within the application.

Changes in 1.0.3

Global RSS Feed Fixes

The global RSS feeds found on the Dashboard page were not being generated correctly: an extra ')' was being added to the end of links. This has been fixed in 1.0.3

Page Not Found Fix for Postgresql

Users running Confluence against a Postgresql database were encountering a system error whenever someone attempted to visit a page that did not exist. This has been fixed.
Remote API Fixes

Several outstanding issues with the remote API that were holding back the TimTam client have been fixed. In addition a getVersion method has been added to allow client authors to determine which version of Confluence a server is running, and adjust their features to match. The full description of Confluence's remote API is here: Confluence XML-RPC and SOAP APIs

- The WSDL file now respects the server's configured base URL, so SOAP can be used on servers that are behind a proxy.
- getVersion now recognises when a user is in the confluence-administrators super-user group.
- storePage handles re-parenting a page correctly
- storePage will now allow a page to be renamed (all links to the page are automatically redirected)

Other Fixes

- You can now comment on a blog post when the title contains non-US-ASCII characters
- The bug that was causing some versions of Internet Explorer 6 to not display the site's stylesheet has been fixed

Issues Resolved for 1.0.3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.1

Nymboida, Nym to his friends, is Confluence 1.1. He wants to be your friend.

Confluence 1.1 is the first major update to Confluence. It's faster, more reliable, and packed with new features. Thanks to our policy of a year's free upgrades, any current Confluence customer will be able to upgrade to 1.1 at no cost.

Current customers, or new users who wish to try out Confluence for 30 days can download either the standalone or WAR distributions from the Atlassian website: http://www.atlassian.com/software/confluence

Upgrading from 1.0.3a

Upgrading Confluence should be pretty easy: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

- Users who have enabled external user-management by customising their osuser.xml file will need to read this document also.
- Users who have used MySQL or Postgresql with Confluence 1.0 should read this document which explains how to get rid of any extraneous triggers or indexes that might have been created.

Contents

1. New Features
2. New Macros
3. Improvements
4. **Notable Bug-fixes**
5. **Outstanding Issues**

See also: [Issues Resolved for 1.1](#)

**New Features**

*Macro Management*

The biggest Nymboida new feature from an end user point of view is going to be the rewritten macro support.

**Management** - You can now enable and disable macros from this convenient (and very attractive) console. Macros are now grouped into libraries to make the management and creation of related macros simpler. Libraries can be installed, activated or deactivated as a single entity.

**Macro Libraries**

Use this page to enable and disable macros and libraries below.

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Basic Macros</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Macros</strong></td>
<td>This library includes basic macros for linking and formatting content.</td>
</tr>
<tr>
<td>6 of 7 macros enabled</td>
<td></td>
</tr>
<tr>
<td>Compatibility Macros</td>
<td>Disable library</td>
</tr>
<tr>
<td>All macros enabled</td>
<td></td>
</tr>
<tr>
<td>Advanced Macros</td>
<td>Disable</td>
</tr>
<tr>
<td>All macros enabled</td>
<td></td>
</tr>
<tr>
<td>HTML Macros</td>
<td>Enable</td>
</tr>
<tr>
<td>Library disabled</td>
<td></td>
</tr>
</tbody>
</table>

**User Macros** - We've also had a lot of requests from users for simple formatting macros: people who wanted their code snippets or notes to be formatted in a certain way. Confluence 1.1 contains a simple way for administrators to create new macros from within the application without a restart: defining a template that the macro will apply to its arguments or content. User macros are very handy for providing consistent formatting and layouts across your pages.

**User Macros**

This library contains user created template macros for formatting content.

<table>
<thead>
<tr>
<th>Name:</th>
<th>alert</th>
</tr>
</thead>
</table>
| Template: | `<div class="errorbox">
# if ($param1)<div class="title">$param1</div># end
$body
</div>` |

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
**Custom Macros** - Installation of new macro libraries is a breeze: simply drop the library .jar file inside the web application, restart Confluence, and your new macros will appear in the management console. Confluence 1.1 also includes a custom macro toolkit (with Task List example shown below) to help users build their own complex macros easily using Java.

![Task List Example](image)

More information:

- [Guide to Confluence Macros](#) - a guide to the Macro Management console
- [Writing User Macros](#) - how to write User Macros
- [Custom Java Macros - obsolete](#) - a guide (and worked example) for writing and distributing your own Java macros for Confluence

**Attachments: versioning, comments and WebDAV support**

**Versioning** - The number one feature request for Confluence 1.0 was versioned attachments. You ask, we deliver! 😊 Confluence can now have multiple versions of the same file attached to a page. It will keep a history of different versions of attachments, expandable dynamically.

**Comments** - Each attachment can now be accompanied with a comment describing why it is there, what it's about or the reason for it being attached. This is useful for tracking the differences between attachment versions, as well as for informing users as to why they should be interested in a particular file.

![Attachment Example](image)

**WebDAV** - You can configure Confluence to store attachments in an external WebDAV server. This allows companies with an existing WebDAV infrastructure to give users alternative ways of accessing attachments and attaching files to Confluence pages.

**Improvements to Page and Space Exports**

- Exporting pages and spaces to PDF should be a great deal more reliable now. Whereas in Confluence 1.0, the export was likely to fail if the pages contained questionable markup, we now dynamically clean up each page before we export it.
- You can choose whether or not page comments are exported. Often you want to exclude comments if you want to send out a PDF of a page or publish a space as a website.
- The templates used to publish pages and spaces to HTML can be customised on a global and per-space basis. This makes it easy to publish a static website from the contents of a Confluence space: customise your templates, choose which pages to export, and voila.

**Customise Display of Blog Posts**
The templates used to display blog posts (both individually and in lists) can be edited either globally, or on a per-space basis, in the same way as the site's main decorators are editable. Also, the interface for editing templates has improved and will continue to do so in future releases.

**Page Locking**

If you want to prevent another user from editing, deleting or renaming a page, you can now lock it. You may want to do this because certain pages in an otherwise public space (for example, front pages, disclaimers or copyright notices) must remain un-edited, or just because you're working on the page and don't want anyone else to interfere just yet.

Locking a page restricts editing to a single user (yourself), or members of a particular group. Anyone with the space administrative permission can override or delete a lock.

**Oracle and Weblogic Support**

We have made a concerted attack on the various issues that were making Confluence unreliable on Oracle and Weblogic, and we're pleased to report that both have been running just fine in testing. Most importantly, the bug that was preventing pages being saved to Oracle when they were over 4Kb in length has been fixed.

For details of what precisely was fixed, see:

- [The Weblogic support super-issue in JIRA](#)
- [The Oracle support super-issue in JIRA](#)

**Search Powerpoint and Excel Attachments**

Confluence already searches across attached Word, PDF and RTF documents, XML, HTML and any plain text file. This search support has now been expanded in Nymboida to include searching and indexing of all text within Microsoft Powerpoint presentations and Excel spreadsheets.

In addition, the new attachment comments are also searchable.

**TinyURL**

Every page has a unique, short URL displayed at the top of its Page Information page. This makes it easier to send colleague's the URLs for pages with long titles via email, instant message or IRC.

**New and Improved Macros**

**New**

- \{excerpt\} allows you to mark a portion of the page as its "excerpt". This has no effect on the page itself, but other macros (such as \{blog-posts\} and \{children\}) can use the excerpt as a short summary of the content of the page.
- \{excerpt-include\} includes one page's excerpt in another page.

**Improved**

- \{code\} macro supports coloured highlighting for several more languages: JavaScript, ActionScript, XML and SQL.
- \{code\} macro can have its title and border customised in the same way as the \{panel\} macro.
- \{blog-posts\} takes an optional \texttt{time} parameter to indicate how far back it should look for blog posts. For example, \{blog-posts:time=7d\} will show all blog-posts within the last seven days.
- \{blog-posts\} takes an optional \texttt{content} parameter to change the way the blog-posts are displayed. \texttt{content=excerpts} displays excerpts instead of the full content of the blog entry (using the \{excerpt\} macro if available, otherwise extracting the first few hundred characters of the post). \texttt{content=titles} displays the entries as a list of titles.
- \{children\} takes an optional \texttt{excerpts=true} parameter: if any of the children have an excerpt available, the first line will be displayed in the list.
### Improvements to the Markup Engine

Many improvements have been made to the Confluence markup parser, fixing niggling inconsistencies, and allowing many more combinations of effects. If you want to produce something like the following, you can:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
</table>
| Some code| ```public static void main(String[] args)
  {
    System.out.println("Hello World");
  }```                                                                 |
| A list   | • Item 1
• Item 2
• Item 3
• Item 4                                                                 |
| A panel  | ![I like cheese](image.gif)                                             |
|          | • Brie
• Camembert
• Gruyere
• Cheddar                                                                 |

You can also center an image using ![image.gif](image.gif)\_align=center!

### Improvements to Linking

- You can specify a link title (which appears in the mouse-over tooltip) by adding another section to the link: [Link Body Text|Page Name|Link Title]
- ![//foo/bar/baz.html](link) will create a relative URL link to /foo/bar/baz.html on the same server as Confluence is running
- file: URL links work
- UNC-style links: ![\SERVER\share\directory\file.doc](link) will create a file:// link to the file on an external share

**Note:** Some web browsers (specifically Mozilla) consider file: URLs to be a security hazard, and do not follow them.

### And a whole lot more...

Here’s the quick fire version of some of the other improvements we’ve made in this release:

- You can resize the recent changes lists on the dashboard and space summary pages. This change is persisted in your user preferences.
- UI state (whether comments or attachments are open, size of recent changes lists) persists between sessions for registered users.
- The maximum attachment size can be configured from the General Configuration administration page.
- Going to ![http://yoursite.example.com/display](link) now brings up a list of spaces instead of an error page.
- The display of the space summary page is significantly faster.
- Newly created users don’t show up on the dashboard recent changes list unless they edit their profiles.
- The word "Confluence" has been moved to the end of page titles instead of the beginning, making them...
easier to distinguish in tabs and bookmarks.

- There are more ways to navigate to the "recent blog posts" page for a space.
- Removing a user is significantly faster.
- Headings in pages are automatically turned into anchors with the same name.
- Creating a space now creates an index page as well as a home-page.

Notable Bug-fixes

It's hard to know where to start. We've fixed a lot of bugs across the whole application. If you want to know what's been fixed, you're probably best off looking for yourself.

Two areas, however, have been improved enough to deserve special mention.

- **PDF Export** - as mentioned above, we've made the PDF export much, much more reliable than it once was. Where before a page or space may have confused the PDF converter into not working, it should now be able to handle any markup you throw up at it.
- **International characters** - Many issues related to the use of non-ASCII characters in page titles, links, page contents and RSS feeds have been resolved since Confluence 1.0. Our users in non-English-speaking countries should find Confluence a much more pleasant and seamless experience now than they may have before.

Issues Resolved for 1.1

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>-</td>
</tr>
</tbody>
</table>

Release Notes 1.1.1

Confluence 1.1.1 is a maintenance release that fixes some bugs regarding attachments, page links and notifications. Remember, a Confluence license entitles you to a year of upgrades, and this upgrade along with future updates will be free of charge.

**Who should upgrade?**

This release mainly fixes the bugs discovered in our recent 1.1 release. The major issues resolved are listed below, or you can see the full list here. As some of the issues resolved have a significant impact on the user experience of Confluence, we recommend that anyone currently running 1.1 upgrade to 1.1.1.

**Upgrade Procedure**

1. Shut down the Confluence server
2. Back up confluence/WEB-INF/classes/confluence-init.properties, and if you have customised it, confluence/WEB-INF/classes/osuser.xml
3. Unpack Confluence 1.1.1 in the same location as your existing Confluence installation
4. Restore the two files you backed up in step 1 to the 1.1.1 installation.
5. Start Confluence

To avoid the possibility of data-loss, you should back up your ConfluenceHome directory and your database before upgrading, and perform a full backup from within the application.

**Changes in 1.1.1**
Attachment fixes

- Attachment versioning introduced a new table in Confluence that had a column whose name conflicted with some databases like Sybase
- Links to older version of attachments could not be accessed if the webapp was deployed with a context path
- Attaching files that contained '+' and '&' symbols caused certain pages in Confluence to break

These have been fixed in 1.1.1.

Notification fixes

Users opting to receive html formatted email received emails with the correct subject but no content. In addition, the "View Changes" link in the daily change email was broken. These are now fixed.

Email Server fixes

An upgrade to an email component used in Confluence in 1.1, caused an error to be displayed when users attempted to modify their email server settings. An upgrade has been added in 1.1.1 that will fix this problem to save users from having to perform the fix manually.

Export to PDF fix

Spaces labelled with names containing an ' &' symbol could not be exported to PDF. This has been fixed.

Wiki Notation fix

The notation for a horizontal ruler was changed to five dashes (up from 4) in 1.1. This stopped the ruler from showing. This has been changed back in 1.1.1.

Issues Resolved for 1.1.1

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Release Notes 1.1.2

This fixes an upgrade problem in 1.1.1 where users attempting to upgrade from 1.0.x directly to 1.1.1 encountered an "Upgrade Failed" error. Therefore, if you are still using a version older than 1.1, and am planning to upgrade, please upgrade to 1.1.2 to avoid this problem.

If you have already upgraded to 1.1.1 from 1.0.3a and cannot start Confluence due to the upgrade error, simply download 1.1.2 and upgrade to it. This should fix the problem.

If you have already upgraded successfully to 1.1.1 from 1.1 then you may safely ignore this upgrade.

Useful tips when upgrading from 1.0.3a

Upgrading Confluence should be pretty easy: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

- Users who have enabled external user-management by customising their osuser.xml file will need to read this document also.
- Users who have used MySQL or Postgresql with Confluence 1.0 should read this document which explains how to get rid of any extraneous triggers or indexes that might have been created.

Release Notes 1.2

Atlassian is proud to present Confluence 1.2, otherwise known as Swan, to the world. Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days can download either the standalone or WAR distributions from the Atlassian website: http://www.atlassian.com/software/confluence
Swan is the second major update to Confluence, and once again all existing customers can upgrade for free, thanks to the provision for one year of free upgrades in your license. You will find that Swan contains significant new features in the areas of user management, search and space browsing, as well as the usual raft of enhancements, bug fixes and things we just couldn’t resist throwing in at the last minute.

In all, 109 issues were resolved between 1.1.2 and 1.2. You can see the full list here: [Issues Resolved for 1.2](#).

Looking towards the future, we are going to attempt to increase the frequency of releases. While having one release every three months makes for impressively long release notes, it also means that customers are often left waiting longer than might be necessary for important enhancements or bug-fixes.

Upgrading from 1.1.2

Upgrading Confluence should be pretty easy: you can find [instructions here](#). We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

You will need to reindex your site after upgrading to enable some of the new site search features. You can do this from the "Rebuild Search Index" link on the Administration Console.

Site administrators upgrading from 1.1.2 or earlier should take particular note of the changes to global and space permissions. Confluence should automatically upgrade old permissions to the new scheme when upgrading from or importing data from earlier versions, but it is a good idea to check that your spaces are still secure and accessible after the upgrade, just in case.

Upgrading from 1.0.3a

Users upgrading directly from 1.0.3a should also read the [Nymboida Release Notes](#) for caveats regarding the 1.0 -> 1.1 upgrade.

Contents

1. New Features
2. Improvements
3. Notable Bug-fixes

See also: [Issues Resolved for 1.1](#)

New Features

Page List Views

The old "list pages" screen has been enhanced, almost to the point of being unrecognisable. In its place, we now offer three ways to browse the contents of a space.

The **Alphabetical View** looks like the "list pages" screen from 1.1 and earlier, but it has been enhanced to allow you to find pages quickly by the first letter of their title.

The **Directory View** presents the contents of a space as a tree, allowing you to drill down the hierarchy of parent and child pages (You will need Javascript turned on to use this view).

The **Search View** presents Swan's enhanced search interface, already focused on the space you are looking at.

Image Thumbnails and Thumbnail Galleries
You can now display a thumbnail of any image attached to a page. Clicking on the thumbnail will pop up a window containing the full-sized image. For example, the nice picture of the waterfall from my holiday in California was generated by the following wiki-markup.

```
!waterfall.jpg|align=right thumbnail!
```

In addition, the {gallery} macro will create a thumbnail gallery of all the images that are attached to the page the macro is included in. You can see an example of this macro in action here: Thumbnail and Gallery Example.

The maximum sizes for thumbnails are configured in the General Configuration section of the Administrative Console.

**Threaded Comments**

Bowing to public demand, we have added the ability to arrange comments by thread: users may respond to a particular comment, and the comments will be arranged in accordance with who responded to what.

The default is still for comments to be presented as a flat list, but you can enable comment-threading in the General Configuration section of the Administrative Console.

**Improvements**

**Enhanced Search**
The site-search functionality of Confluence has been enhanced, both subtly behind the scenes, and quite obviously in front of them.

Behind the scenes, we now index more information such as attachment comments and filenames. We have improved the indexing of Powerpoint presentations so that more text is extracted from the Powerpoint file. We have also tweaked the ranking algorithms behind the search so that you are more likely to find the page (space, comment, blog post, attachment, user...) you are looking for.

More obviously, we have given the user a lot more control over searching with an intuitive user interface that allows you to limit searches by space, type of content, or date last modified, and to group search results by type and space.

The (search) macro has also been updated to take advantage of the new search features (the options are described more fully in the notation guide linked from Confluence's edit page):

```
{search:query=Confluence|maxLimit=5|spacekey=DISC|type=page}
```

New Permissions Interface
Two of the biggest issues users have been having with permissions in Confluence were:

- The interface for setting permissions was confusing.
- It was hard to keep sites that allowed anonymous access below the workgroup license 25-user limit, especially if they used external user management.

Both of these issues have been fixed in Swan, but it has involved a slight change in the way permissions are checked. This should not be a problem for new Confluence users: the new system is easier to use than the old. However, if you are upgrading from 1.1.2 or earlier, you should read this document to see what’s different.

And a whole lot more...

Here’s the quick fire version of some of the other improvements we’ve made in this release:

- The "double-click to edit" feature has been removed.
- Blog views now come with a monthly calendar showing nearby posts
- Macro libraries can now include images, or any other content the macro needs to serve over the web: look out for new example code in the macro documentation soon.
- Users can set their profile page to be their site homepage
- You can delete all referrer links that match your exclusion list (in General Configuration), to rid the site of referrer spam
- The site's administrative, search and editing pages are served with robots exclusion meta tags so that only the site's main content will be indexed by well-behaved search engines
- Restoring backups should be significantly faster for installations with many users
- Administrators can choose to restore backups from the filesystem instead of uploading them (important if your backup is quite large)
- Confluence now serves files with a proper Content-Length header, so browsers can display the download accurately
- CSS stylesheets are hidden in emails so they don’t mess up Lotus Notes
- Export and backup filenames use a neater yyyymmdd date format

Notable Bug-fixes

- Exports created on Windows can now be imported on Unix-like operating systems without having to fix the path separators
- Hyphens in page headings or anchors will no longer render strangely
- Restoring a backup during setup now properly generates the search indexes
- Page "short links" now respect the configured site URL, regardless of which URL the user is accessing the site from
- Strange Powerpoint files no longer choke the indexer
- Users with Admin privileges can now see the link to the Administration Console without being in the 'confluence-administrators' superuser group
- Space administrators can modify space templates without having global administrator privileges.
- User macros are now lower-cased by default
- It is now possible to change the case of a page title by renaming the page

Issues Resolved for 1.2

JIRA Issues
Permissions Changes in 1.2

For Swan, changes were made to the way Confluence manages and checks permissions. This document is a guide for anyone migrating from Confluence 1.1.2 or earlier describing why the changes were made, and what this means to existing Confluence installations.

Why Change?

There were two goals behind changing permissions in Confluence:

1. Fix a significant problem whereby users with external user management enabled could not also enable Confluence anonymous access without blowing out their 25-user workgroup license.
2. Make the user interface for assigning and viewing permissions easier to use and understand.

What Changed?

"Anyone" User Removed

In Confluence 1.1.3, there was an "Anyone" user, who represented anyone using the system, whether logged in or not.

This user was the source of the licensing problem, and no longer exists in Confluence 1.2

Anonymous Permissions Added

Confluence 1.2 has explicit permissions for anonymous users. These permissions are only granted to users who are not logged in.

There is nothing stopping an administrator granting some permission to anonymous users, but not granting it to logged-in users. This results in the slightly bizarre possibility that a user might be able to do more before logging in than they can after. Luckily, this is a pretty easy situation for administrators to avoid.

Enabling anonymous access has no effect on Confluence’s user count for licensing purposes.

Guard Permissions Added

The roles of the "Use Confluence" and "View Space" permissions have been expanded so that now they are required permissions before a user or group can be granted any more rights.

Before a user has access to anything in the Confluence server, they must first have "Use Confluence" permission, and likewise before a user has access of any kind to a space, they must first have the "View Space" permission.

For licensing purposes, your number of users is equivalent to the number of non-anonymous users with the "Use Confluence” guard permission.

Migrating from 1.1 to 1.2

Migrating Automatically

Authenticate to retrieve your issues
When you upgrade from Confluence 1.1, or when you restore a backup created in 1.1 into Confluence 1.2, an upgrade task will run to automatically migrate your permissions to the new scheme, while keeping them consistent with your 1.1 security settings. The task will make the following changes:

- All "Anyone" permissions will be converted into two separate permissions: one for Anonymous access, and one for the **confluence-users** group. (If the **confluence-users** group does not exist, this step will be skipped)
- Any user or group with some global or space permission will also be granted the equivalent guard permission.

After starting up with the new version of Confluence, we suggest that you check that the permissions have migrated successfully. While we have tested the migration code, maintaining your site's security is important enough to warrant a double-check, just in case.

### Migrating Manually

If the automatic migration does not complete successfully, which would most likely happen if you have removed the "confluence-users" group, you will need to perform the above steps manually, through the user administration interface.

### Release Notes 1.2.1

Confluence 1.2.1 is a maintenance release that fixes some bugs that users may have encountered using Confluence 1.2. It incorporates improvements to performance for large Confluence installations, and fixes bugs related to the remote API, over-use of disk space, and a few annoying errors users were experiencing when setting up a new Confluence instance.

1.2.1 is a free upgrade for all existing Confluence customers.

**Who should upgrade?**

The issues resolved below are all either fixes to problems that have affected small numbers of users, or improve areas of Confluence that may not be used in your installation. As such, we recommend you read through the release notes and decide whether this upgrade is necessary.

If 1.2 is working fine, and none of the issues below are bothering you, there is no need to upgrade.

### Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2, you can find instructions here. **We strongly recommend that you backup your confluence.home directory and database before upgrading!**

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

### Changes in 1.2.1

See also: [Issues Resolved for 1.2.1](#)

### Remote API Fixes

- `getBlogEntries()` will no longer erroneously return SQL Timestamps instead of date objects — [CONF-175](#)
- `getPage()` will now successfully retrieve a previous page version — [CONF-1721](#)
- `renderContent()` can now successfully render a page containing the `{blog-posts}` macro — [CONF-1717](#)

### Setup Fixes

- Some users were encountering the following error during setup: "Unable to store Trigger with name:
'backupTrigger' and group: 'DEFAULT', because one already exists with this identification.” This should no longer occur — CONF-1760

- Some users were encountering a NullPointerException in org.apache.lucene.store.FSDirectory.create() during setup when connecting to an external datasource. This should no longer occur — CONF-1767

Performance and Efficiency Fixes

- Installations with large search indexes will no longer experience a performance degradation when saving content — CONF-1759
- Backups will no longer leave a redundant exploded copy of the files being backed up in the temp directory — CONF-1752
- Deleting a space was not deleting its attachments from the confluence home directory. This is now fixed — CONF-1765
- Thumbnails are now stored in their own directory, so they won’t be included unnecessarily in backups — CONF-1785

Other Issues Resolved

- Confluence now generates significantly higher-quality image thumbnails (Thanks to Mike Aizatsky for the tip) — CONF-1725

Note

Unless you are running JDK 5.0 (which we do not recommend as it is still in pre-release), this improvement will only be visible if you are running Confluence on Mac OS X

- URLs longer than 255 characters will no longer cause an exception when saving a page — CONF-1743
- Pages with titles containing quotes no longer break PDF exports — CONF-1719
- Internet Explorer 6 SP2 will no longer corrupt zip-files downloaded from Confluence — CONF-1669

Issues Resolved for 1.2.1

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticated to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.2.2

Confluence 1.2.2 is a maintenance release that fixes some bugs that users may have encountered using Confluence 1.2 and 1.2.1. It fixes problems with attachment downloading, text file imports and text-only emails.

1.2.2 is a free upgrade for all existing Confluence customers.

Who should upgrade?

Confluence 1.2.2 includes a fix for CONF-1810. This bug will cause serious problems for anyone who attaches multiple versions of the same file to a Confluence page, corrupting subsequent downloads.

As such, Confluence 1.2.2 is a recommended upgrade for anyone running 1.2 or 1.2.1.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or 1.2.1, you can find ins.
We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the [Confluence 1.2 release notes](#).

### Changes in 1.2.2

See also: [Issues Resolved for 1.2.2](#)

- The correct file size will now be stored for multiple versions of the same attachment, fixing a serious download corruption bug – CONF-1810
- Long (excerpt) blocks no longer overrun their database field – CONF-1705
- The code macro will no longer garble XML – CONF-1829
- Page diffs now escape HTML tags correctly – CONF-1830
- Fixed Postgresql error when you try to import text files that contain the nul (\0) character – CONF-1739
- "New Blog Post" icon in Page Operations URL now goes to the correct URL – CONF-1848
- "Next" link at the bottom of the alphabetical page listing now works – CONF-1797
- Text-formatted Confluence daily emails are now sent as text – CONF-1724
- The search input box on the "404 Not Found" page has been fixed – CONF-1800

### Issues Resolved for 1.2.2

**JIRA Issues**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Authenticate</strong> to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Release Notes 1.2.3**

Confluence 1.2.3 is a maintenance release that fixes some bugs that users may have encountered using the 1.2 series of Confluence. It fixes problems with Oracle support on Weblogic, thumbnail display, errors moving pages between spaces.

1.2.2 is a free upgrade for all existing Confluence customers.

**Who should upgrade?**

The issues resolved below are all either fixes to problems that have effected small numbers of users, or improve areas of Confluence that may not be used in your installation. As such, we recommend you read through the release notes and decide whether this upgrade is necessary.

Of particular note should be CONF-1911 which might effect customers trying to use Confluence with Oracle under Weblogic, and CONF-1914, a security issue where users may determine the names of attachments that they can not access.

If Confluence 1.2.2 is working fine for you, feel free to stick with it.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find [upgrade instructions here](#). We strongly recommend that you backup your `confluence.home` directory and database before upgrading!
If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

Changes in 1.2.3

See also: Issues Resolved for 1.2.3

- Oracle LOB handler now works correctly under Weblogic – CONF-1911
- Attachments are no longer listed in search results if the user is not permitted to download them – CONF-1914
- Tomcat no longer hijacks Confluence's logging – CONF-1934
- Incoming page links no longer listed multiple times – CONF-1928
- Comments in daily update report are now linked properly – CONF-1904
- Thumbnails and the gallery macro no longer draw images with width and height of 0 – CONF-1861
- Fixed a system error moving pages between spaces when they are linked to from a comment – CONF-1851
- Fixed a system error when removing an attachment – CONF-1861

Issues Resolved for 1.2.3

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>

Release Notes 1.3

Atlassian Software is proud to present Confluence 1.3 (otherwise known as Murrumbidgee). Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days can download either the standalone or WAR distributions from the Atlassian website: http://www.atlassian.com/software/confluence

Murrumbidgee is the third major update to Confluence (in less than nine months!), and once again we've raised the bar of what you should expect from a professional wiki. Confluence 1.3 looks better, performs better, installs more easily and does far more than it ever has before.

A big thanks to everyone who reported bugs, and offered suggestions over the last few months, especially everyone who helped by trying out our Confluence Development Releases.

Upgrading from 1.2.3

Upgrading Confluence should be pretty easy. We strongly recommend that you backup your confluence.home directory and database before upgrading!

You will need to reindex your site after upgrading to enable some of the new site search features. You can do this from the "Rebuild Search Index" link on the Administration Console.

Also, we've added a bunch of space-level permissions since 1.2. While our upgrade process should make sure everyone has the same permissions after the upgrade as they did before, it's a good idea to check to make sure nothing has been missed.

Upgrading from 1.1.2 or Earlier

Users upgrading from an earlier version of Confluence should check the release-notes of the other major
Confluence releases:

- Release Notes 1.2
- Release Notes 1.1

Contents

- New Features
- New Macros
- Improvements
- Notable Bug-fixes

See also: Issues Resolved for 1.3

New Features

Many of the features added to Confluence 1.3 are of interest only to site administrators. To get an idea of what's changed from the perspective of a user, you should read What's New in 1.3

Mail Archiving

| Location: Dashboard > BUGTRAQ > Mail Archive > MySQL Authentication Bypass |
|---|---|
| Subject: **MySQL Authentication Bypass** |
| From: NGSSoftware Insight Security Research |
| Date: Oct 22, 2004 |

NGSSoftware Insight Security Research Advisory

- Name: MySQL Authentication Bypass / Buffer Overflow
- Systems Affected: MySQL 4.1 prior to 4.1.3, and MySQL 5.0.
- Severity: High
- Vendor URL: http://www.mysql.com
- Author: Chris Anley [ chris@ngssoftware.com ]
- Date of Advisory: 1st July 2004

Confluence is a collaboration tool. When communication happens through Confluence, it gets archived, indexed and interlinked so the whole team can benefit from the information. But what happens to communication that happens via email? At best it gets hidden away in the corner of one team member’s inbox, at worst it just falls into nowhere.

Now, you can put that mail into Confluence as well.

Each Confluence space has a mail archive. You can import mail directly by uploading an mbox file, or you can have Confluence regularly poll a POP mailbox for new mail. Once mail is imported into Confluence it can be browsed chronologically or by thread, and searched using Confluence's powerful full-text search functionality.
The threading and searching functionalities within Confluence are more powerful, and more useable than most dedicated mail archives that you will find online! For more information about Confluence’s mail support, read the Mail Archiving FAQ.

**Themes**

It is now possible to package a particular Confluence look and feel into a theme. Themes can be dropped into a Confluence installation, after which they will be available for global or space administrators to customise the look and feel of the site.

Themes are built using the new plugin architecture that has been built into Confluence: for more details on how to create your own theme, see Theme Module.

The Trash Can
One of the most popular feature-requests, it is now possible to undelete pages, mail and blog-posts. When content is deleted from a space it is moved to that space’s trash can. Space administrators can restore deleted pages, or consign them to oblivion.

More Granular Space Permissions

Another of our most popular feature-requests, we've divided up the space permissions so administrators have more control over what users can and can not do.

New Emoticons

<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Name</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>☀️</td>
<td>add</td>
<td>(+)</td>
</tr>
<tr>
<td>🚫</td>
<td>forbidden</td>
<td>(-)</td>
</tr>
<tr>
<td>🤔</td>
<td>help</td>
<td>(?)</td>
</tr>
<tr>
<td>🌟</td>
<td>idea on</td>
<td>(on)</td>
</tr>
<tr>
<td>🌟</td>
<td>idea off</td>
<td>(off)</td>
</tr>
<tr>
<td>✩</td>
<td>star</td>
<td>(*)</td>
</tr>
<tr>
<td>🔴</td>
<td>red star</td>
<td>(*r)</td>
</tr>
<tr>
<td>🟢</td>
<td>green star</td>
<td>(*g)</td>
</tr>
<tr>
<td>🟡</td>
<td>blue star</td>
<td>(*b)</td>
</tr>
<tr>
<td>🟠</td>
<td>yellow star</td>
<td>(*y)</td>
</tr>
</tbody>
</table>

Because you can never have enough neat-looking graphics.

Macros

- {note}, {information}, {warning} and {tip} macros let you add coloured notes to your page.
- The {section} and {column} macros give you an alternative to wiki-markup tables
- The {jiraportlet} macro allows you to embed a JIRA 3 portlet into a Confluence page
- The {excerpt} macro has an optional hidden=true parameter to hide the contents of the excerpt within the page
- The {excerpt-include} macro has an optional nopanel=true parameter to display the excerpt without any decoration
The \{jiraissues\} macro has an optional `count=true` parameter to display only the number of issues found, not the details of those issues. It also has an optional `cache=off` parameter to ensure that a list of Jira issues will refresh on each request.

The \{blog-posts\} macro consistently displays blog-posts in reverse chronological order.

The \{search\} macro can be limited to particular types of content.

The notation guide has been reorganised to be more friendly to users who don’t know what a macro is.

**Improvements**

**Referrer Management**

For public sites, referrer management has been vastly improved in Confluence 1.3, with a new management screen, the ability to block unwanted referrers right from where they are displayed, and the ability to turn off referrer tracking with a single click.

**Setup Wizard**

The Confluence setup wizard has been rewritten from the ground up. We’ve made it task-oriented, and stripped it back to just the stuff you need to get Confluence running. The result is a much smoother, much faster installation.

**User Interface**

We’ve made a lot of improvements to Confluence’s user interface. You’ll notice some improvements on the Dashboard, making it easier to see exactly what’s changed recently. You’ll notice some huge changes to the space summary/space administration section of the site.

**Backups**

- You can now exclude attached files from your backups. Of course, this means you have to back up your attachment directory separately, but if you already have a good backup regime for your filesystem (and can thus restore attachments separately), it means your Confluence data backups will take a lot less space.

- We now include important system configuration in your backups, so that when you restore a site from backup, it will work the same way as it did when you backed it up.

**Indexing**

We have improved the way we index content within Confluence, which means your searches are even more likely to find the right result.

If the primary language of your Confluence site is not English, you should change the "Indexing Language" preference in Confluence’s General Configuration.

**Site Performance**
We've identified a number of places that were slowing down the performance of Confluence sites, from the dashboard to the spaces list page, to the search indexer, to the storing of referrers. Confluence should now perform faster than ever.

Also...

- Pages in an export are now in alphabetical, not creation order.
- The remote API can be accessed by anonymous users (this must be turned on in General Configuration)
- When previewing a page, you can continue editing without having to go back to the edit page
- You can link to anything in Confluence if you know its ID in the database (currently this is how you must link directly to mail) using the following link format: [$1234]
- You can link to anything relative to the root of the Confluence installation (useful for pointing to parts of the site that can't otherwise be linked) using three leading slashes: [///pages/editpage.action?pageId=1234]
- A whole lot more that we've forgotten...

Notable Bug Fixes

We resolved a lot of issues between Confluence 1.2.3 and Confluence 1.3. The best way to see what we've fixed is to ask JIRA, the world's best issue-tracker: Issues Resolved for 1.3

Confluence Presentation

This presentation was relevant to Confluence 1.3, so it was rather outdated.

We have removed it from this documentation space. You can find a copy of it here.

Issues Resolved for 1.3

JIRA Issues

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

What's New in 1.3

Many of the changes between Confluence 1.2 and 1.3 are really of interest only to Confluence administrators. Here we detail the changes that will be important to all Confluence users.

The Trash

Previously, when you deleted a page or blog post, it was unrecoverable. In 1.3, deleting a page moves it to the Trash. Space administrators can retrieve pages from the trash, or purge them forever. If a page has been deleted (or you have deleted a page by mistake), contact a space administrator to get it back.

Note Macros

There are new macros for inserting coloured notes into a page:

{note}:
Mail Archiving

Confluence now includes the capability to store email. This allows you to store mailing-list archives, or records of conversations amongst your team inside Confluence. Mail archiving must be set up by a space administrator.

All mail is indexed, but by default we exclude it from search results because the volume of email can often overwhelm the content of the Confluence site. When you do a search, you might see a reminder that there could be an answer to your question in the email archives.

To link to an email from a Confluence page, you must find the numeric ID of that mail from the end of its URL, and put that in your link like so: [$12572], which Confluence will draw like this: 12572

Improved JIRA Macros

The {jiraissues} macro has two new optional parameters:
- count=true makes the macro only return the number of issues matched by your filter, not the whole list of issues
- cache=off makes the macro retrieve the filter results from JIRA every time the page is loaded, ensuring the results are accurate. (Be careful if the filter returns a lot of results, though, you don't want to overload your servers)

There is a new {jiraportlet} macro that allows you to retrieve any portlet from a server running JIRA 3, and display it in a Confluence page, like so:

Unknown macro: 'jiraportlet'
Easy Column Layout

You can use the {section} and {column} macros to organise your page into columns. This is especially useful when you combine it with the {jiraportlet} macro: you can arrange a Confluence page just like a JIRA dashboard!

Here's a simple two-column layout:


For more information, check the notation guide

Other Things

- Take a look at how the space summary page has been reorganised
- If you hit alt-E on any wiki page or blog post (ctrl-E if you're using a Mac), you'll be taken to the edit page.
- If you start a link with three slashes, you can link to something relative to the root of the Confluence installation. This is useful for creating links to pages that are part of Confluence, such as the dashboard ([/]) or the space list ([/spaces/listspaces.action]).
- The {excerpt} macro can take a hidden=true parameter to hide the contents of the excerpt within the page.
- The {excerpt-include} macro can take a nopanel=true parameter to display the excerpt without any decoration or tables.

Release Notes 1.3.1

Confluence 1.3.1 is a maintenance release that fixes some bugs that users may have encountered using Confluence 1.3.

1.3.1 is a free upgrade for all existing Confluence customers.

Who should upgrade?

Confluence 1.3.1 fixes a number of bugs that were found in Confluence 1.3. However, none of the bugs that were fixed were considered critical or likely to cause data-loss. Administrators should only upgrade Confluence if they are affected by (or feel they would be affected by) one of the issues resolved by this release.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.
Changes in 1.3.1

See also: [Issues Resolved for 1.3.1](#)

- Preferences for hiding or masking email addresses are no longer ignored on some screens – [CONF-2352](#)
- The plugin manager will no longer fail with an error when trying to return a plugin to its default state after activating or deactivating it – [CONF-2396](#)
- Disabling hot referrers in the referrer manager screen now works as expected – [CONF-2397](#)
- The save option has been restored to the comment preview screen – [CONF-2321](#)
- Deleting a blog post or a page no longer leaves possible orphaned comments in recent changes lists – [CONF-2323](#)
- Also, some edge cases in the setup wizard were fixed, the demonstration content was tidied up, and a few minor UI issues were resolved.

Issues Resolved for 1.3.1

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 1.3.2

Confluence 1.3.2 is a maintenance release which includes 30 bug fixes and improvements that users may have requested using Confluence 1.3.

1.3.2 is a free upgrade for all existing Confluence customers.

Who should upgrade?

We recommend that all 1.3.x users upgrade to Confluence 1.3.2. It includes, among other things, the fix of a memory leak which had been occurring in our error monitoring (see below or [CONF-2540](#)); if you have been encountering performance issues within Confluence, this could be of benefit.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or 1.3.1, you can find instructions here. **We strongly recommend that you backup your `confluence.home` directory and database before upgrading!**

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Changes in 1.3.2

See also: [Issues Resolved for 1.3.2](#)

We've closed 30 issues, so we will not name them all. Among the most prominent in the list are:

- A memory leak in our collection of logging events as a threadlocal, see [CONF-2540](#).
- Consistent UI handling for editing and previewing blogs and comments, see [CONF-2479](#) and [CONF-2470](#).
- Improved IO handling when building exports, see [CONF-2510](#).
- Better cleaning up attachments when pages are removed, see [CONF-2567](#).
- etc ...
Release Notes 1.3.4

Confluence 1.3.4 is a maintenance release which includes a few important bug fixes for anyone running Confluence. These release-notes include information about the (briefly available) 1.3.3 version of Confluence, which 1.3.4 has superseded.

1.3.4 is a free upgrade for all existing Confluence customers.

Who should upgrade?

We recommend that all 1.3.x users upgrade to Confluence 1.3.4. For customers running 1.3.2 and earlier, it includes a fix to the security issue described in Confluence Security Advisory 2005-02-09, and it thus an important upgrade for anyone who is still running an un-patched system.

For customers running 1.3.3, the upgrade is also recommended as this version fixes CONF-2740, a regression in 1.3.3 which could cause referrer and trackback data to disappear.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or 1.3.1, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Changes in 1.3.4

See also: Issues Resolved for 1.3.4

Since only five bug-fixes were made for this release, here is a quick run-down.

- The patch for the security issue described in Confluence Security Advisory 2005-02-09 has been applied to 1.3.4
- A regression in 1.3.3 that caused trackback and referrer data to be lost has been fixed – CONF-2731
- An intermittent ClassCastException when viewing blog-posts has been fixed – CONF-1671
- The image cache for Apache FOP is now cleared between exports, preventing a case where the wrong version of an attachment may end up in a PDF export – CONF-2647
- A spurious "Connection already closed" log message in the JIRA user management bridge no longer occurs CONF-2656

Issues Resolved for 1.3.4

Issues resolved for 1.3.3
Release Notes 1.3.5

Confluence 1.3.5 is a maintenance release which fixes a number of bugs found in earlier 1.3.x Confluence releases. Some areas improved in this release are space export/import, search and LDAP user management. 1.3.5 is also the first Confluence version to be successfully tested against Resin 3.0: see below for the special steps you need to take to get it running.

1.3.5 is a free upgrade for all existing Confluence customers.

Who should upgrade?

We recommend that all 1.3.x users upgrade to Confluence 1.3.5. For customers running 1.3.2 and earlier, it includes a fix to the security issue described in Confluence Security Advisory 2005-02-09, and it thus an important upgrade for anyone who is still running an un-patched system.

For customers running 1.3.4, the upgrade is also recommended as this version fixes CONF-2750, a regression in 1.3.4 that made it impossible to page through search results.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 – 1.3.4, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Changes in 1.3.5

Resin 3.0 Compatibility

Confluence 1.3.5 is the first Confluence version to be successfully tested against Resin 3.0.12. Customers wishing to run Confluence under Resin 3 should read the special instructions at Known Issues for Resin 3.x

Issues Resolved
• Paging through search results no longer results in an error. CONF-2750
• Space export and import now performs much more reliably. CONF-2678
• Setup wizard no longer complains about an incomplete setup if you restore a backup from disk. CONF-2637
• Special characters in search no longer cause parser to explode. CONF-2527, CONF-2532, CONF-2728, CONF-2735...
• Attachment filenames containing spaces are no longer truncated when downloading using Firefox. CONF-2739
• For the full list of fixes, see Issues Resolved for 1.3.5

Issues Resolved for 1.3.5

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
<td>Summary</td>
<td>Status</td>
<td>Resolution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Authenticate to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 1.3.6

Confluence 1.3.6 is a special maintenance release for customers who are using Confluence with an Oracle database. It contains a number of fixes, originally developed for Confluence 1.4, to Confluence's behaviour against Oracle databases.

1.3.6 is available as a free upgrade for all existing Confluence customers from the archive download page.

Who should upgrade?

We recommend that customers skip Confluence 1.3.6 and upgrade to Confluence 1.4. Confluence 1.4 includes a great many new features and bug-fixes that are not included in 1.3.6. We do, however, recognise that 1.4 is a significant upgrade and some customers wish to continue with Confluence 1.3 for the time being.

Confluence 1.3.6 is recommended only for Confluence customers who:

• are not yet ready to upgrade to Confluence 1.4, and
• are running Confluence with an Oracle database

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 – 1.3.4, you can find instructions here. *We strongly recommend that you backup your confluence.home directory and database before upgrading!*

Changes in 1.3.6

Confluence 1.3.6 addresses a number of situations in which Confluence could lock up, consume additional resources, or fail to perform backup or restore operations against an Oracle database.

Release Notes 1.4

Atlassian Software is proud to present Confluence 1.4 (otherwise known as Hunter). Existing customers who wish to upgrade, or new users who wish to try out Confluence for 30 days can download either the standalone or WAR distributions from the Atlassian website: [http://www.atlassian.com/software/confluence](http://www.atlassian.com/software/confluence)
Hunter is the fourth major update to Confluence, and the biggest yet in terms of new features and improvements both visible to the user or hidden "under the hood". Between 1.3.5 and 1.4, we resolved a massive 480 issues.

A big thanks to everyone who reported bugs, and offered suggestions over the last few months, especially everyone who helped by trying out our Confluence Development Releases.

See also: Issues Resolved for 1.4

Contents
- Upgrading
- Migration
- New Features
- Notable Bug Fixes
- Outstanding Bugs

Upgrading From a Previous Version of Confluence

Upgrading Confluence should be pretty easy: you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

Upgrading from 1.3.5

Because of the significant UI changes between 1.3 and 1.4 (see below), we highly recommend disabling any themes or UI customisations before upgrading Confluence.

After upgrading to 1.4, administrators will need to rebuild the site's search-index to ensure all the new search features are enabled. Do this from the Content Indexing section of the global administration menu.

⚠️ Upgrade Migration

The database migration tasks that must be run to upgrade Confluence from 1.3 to 1.4 may take several minutes to run. During this time, Confluence will be unavailable.

埂 Confluence License Expiration

A commercial Confluence license entitles you to a year of free upgrades. As such, Confluence 1.4 is the first release of Confluence to which some customers may not be able to upgrade.

If you were issued your Confluence license before May 24th 2004, you will not be able to upgrade to Confluence 1.4. Confluence 1.4 will refuse to run with any license issued before this date, and you will be required to downgrade to a previous Confluence version.

Upgrading from 1.2.3 or Earlier

Users upgrading from an earlier version of Confluence should check the release-notes of the other major Confluence releases:
- Release Notes 1.3
- Release Notes 1.2
- Release Notes 1.1

Migration

The best place to find out about the new features available in Confluence 1.4 is by checking out our What's New in Confluence 1.4 pages. However, there are a few features of specific interest to Confluence administrators that will be mentioned here:

v2Renderer
The engine by which Confluence converts wiki-text to HTML has been rewritten from scratch for Confluence 1.4. This was necessary, as the complexity of Confluence's markup was overwhelming the capabilities of the previous engine and leading to an increasing number of bugs, some of which had the potential to bring down the entire server.

v2Renderer is in every way more powerful (and better, more predictable) than the previous engine, and has undergone a lot of testing to make sure that it renders wiki pages the same way as its predecessor. However, pages that made use of bugs or undocumented features in the original engine may no longer render the same in 1.4 as they did in 1.3. If you come across something that is a bug or a missing feature in the new renderer, please file an issue in JIRA.

One side-effect of the new renderer is that custom Java macros written for Confluence 1.3 and earlier may not be compatible with Confluence 1.4 (although most should continue to function). For more information, macro authors should read this document.

New User Interface

In response to a lot of feedback from customers and users of Confluence, the User Interface has undergone a major overhaul between Confluence 1.3 and 1.4. While the changes are mostly self-explanatory, and we believe the new interface is significantly easier for everyone to use and understand than its predecessor, it may be a good idea to make the following resource available to your users as part of the transition: 1.4 Interface - Where Did Everything Go?

Because of the substantial changes to the interface, themes and UI customisations made for Confluence 1.3 and earlier are not compatible with Confluence 1.4, and should be disabled before you upgrade.

Blogs have become News

Also in response to a lot of feedback, blogs in Confluence have now been renamed to news. We feel this makes it a lot easier to explain them to new and non-technical Confluence users. None of the functionality of blogs has been changed, just the name.

New Features

Confluence 1.4 has a lot of cool new stuff. Over the next week we'll be releasing a new section of the Confluence website that will examine the new features in detail. Stay tuned.

Notable Bug Fixes

We resolved a lot of issues between Confluence 1.3.5 and Confluence 1.4. The best way to see what we've fixed is to ask JIRA, the world's best issue-tracker: Issues Resolved for 1.4

Outstanding Bugs

Some bugs were introduced during the Confluence 1.4 development cycle that we could not fix in time for the final release. Of note are:

- Index rebuilding may fail on multi-processor systems (for a workaround, see CONF-3168)
- You can not install an XWork plugin by uploading through the web interface, it must be copied into WEB-INF/lib (CONF-3184)
- Uploading a malformed plugin through the web interface may make other plugins cease to function (CONF-3183)
- Under certain circumstances, the mbox mail import may fail against Oracle databases (CONF-3284)
- The Insert Image and Insert Link popups jump the cursor to the top of the text input area on browsers other than Internet Explorer (CONF-3232)

Once again, if you find any bugs in Confluence, or have any feature suggestions, you can report them online in JIRA.

Issues Resolved for 1.4
Release Notes 1.4.1

Confluence 1.4.1 is a maintenance release that resolves some issues users may have encountered using Confluence 1.4. Issues include an occasional failure to display Confluence pages, Oracle and MySQL database issues, and a slow memory-leak.

1.4.1 is a free upgrade for all customers who purchased their Confluence license after June 2nd, 2004.

Who should upgrade?

Confluence 1.4.1 is a recommended upgrade for all users of Confluence 1.4, as it addresses a memory-leak which, while slow, would progressively degrade Confluence's performance and ultimately cause the server to exhaust available memory.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4, you can find instructions here. **We strongly recommend that you backup your confluence.home directory and database before upgrading!**

If you are upgrading from Confluence 1.3.6 or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

Changes in 1.4.1

See also: Issues Resolved for 1.4.1

- A slow memory leak has been fixed. ([CONF-3347](#))
- An issue where Confluence pages would intermittently only display their header when loading has been resolved. ([CONF-3295](#))
- Confluence will now deploy reliably on MySQL 4.1 with UTF-8 encoding. ([CONF-3306](#))
- Several issues regarding Confluence's use of the Oracle database have been resolved.
- A recurring bug preventing PNG images from being exported to PDF on some application servers has been fixed. ([CONF-731](#))
- Inconsistencies with custom colour-schemes have been resolved ([CONF-3314](#))

Issues Resolved for 1.4.1

---

**JIRA Issues**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Authenticate</strong> to retrieve your issues</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---
**Release Notes 1.4.2**

Confluence 1.4.2 is a maintenance release that resolves some issues users may have encountered using previous Confluence 1.4 releases. 1.4.2 introduces Websphere and DB2 compatibility, and fixes issues related to content indexing and the mail queue.

1.4.2 is a free upgrade for all customers who purchased their Confluence license after June 30th, 2004.

**Who should upgrade?**

Confluence 1.4.2 is a bugfix release. Customers should consult the list of issues resolved for this release to decide whether it is worth their while upgrading. Since this release includes a number of important performance and reliability fixes for content indexing, anyone who relies on Confluence’s search functionality should consider upgrading.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 or 1.4.1, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.6 or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

**Database Connection Pool Changes**

Dependent on the size of your Confluence installation, the new re-indexing task may use up to 10 database connections simultaneously. As such, you may need to increase the size of your database connection pool in order to allow Confluence to continue to operate during and after rebuilding the search index.

If Confluence has been set up to use direct JDBC connections, then you will find the setting for Confluence's connection pool size in confluence.cfg.xml in your confluence home directory. Confluence should update this value automatically when you upgrade, so after starting up Confluence 1.4.2 for the first time, you should check to make sure it has been updated to 15 connections, as seen below:

```
<property name="hibernate.c3p0.max_size">15</property>
```

If Confluence has been configured to use a datasource supplied by the application server, you should ensure the application server is configured to supply Confluence with sufficient connections to run.

**Changes in 1.4.2**

See also: Issues Resolved for 1.4.2

- Confluence has now been tested on Websphere 5.1.1.3 (see Known Issues for Websphere)
- Confluence has now been tested against DB2 8.1 (Linux and Windows)
- The mechanism by which Confluence rebuilds its full-text search index has been rewritten to be significantly less memory-intensive (but may be 10-15% slower). CONF-3340
- An issue that could cause comments or attachments to be removed from the search index when a page was edited has been resolved. CONF-3349
- An issue that could cause index rebuilding to fail (especially on multi-processor systems) has been resolved. CONF-3168
- Issues related to the size and reliability of the mail queue were resolved. CONF-3334 CONF-3474
- An exception when creating global templates was fixed. CONF-3386
- Some Javascript errors that were being flagged on Internet Explorer no longer occur. CONF-3422, CONF-3424

**Database Connection Pool Changes**

Dependent on the size of your Confluence installation, the new re-indexing task may use up to 10 database connections simultaneously. As such, you may need to increase the size of your database connection pool in order to allow Confluence to continue to operate during and after rebuilding the search index.

If Confluence has been set up to use direct JDBC connections, then you will find the setting for Confluence's connection pool size in confluence.cfg.xml in your confluence home directory. Confluence should update this value automatically when you upgrade, so after starting up Confluence 1.4.2 for the first time, you should check to make sure it has been updated to 15 connections, as seen below:

```
<property name="hibernate.c3p0.max_size">15</property>
```

If Confluence has been configured to use a datasource supplied by the application server, you should ensure the application server is configured to supply Confluence with sufficient connections to run.

**Changes in 1.4.2**

See also: Issues Resolved for 1.4.2

- Confluence has now been tested on Websphere 5.1.1.3 (see Known Issues for Websphere)
- Confluence has now been tested against DB2 8.1 (Linux and Windows)
- The mechanism by which Confluence rebuilds its full-text search index has been rewritten to be significantly less memory-intensive (but may be 10-15% slower). CONF-3340
- An issue that could cause comments or attachments to be removed from the search index when a page was edited has been resolved. CONF-3349
- An issue that could cause index rebuilding to fail (especially on multi-processor systems) has been resolved. CONF-3168
- Issues related to the size and reliability of the mail queue were resolved. CONF-3334 CONF-3474
- An exception when creating global templates was fixed. CONF-3386
- Some Javascript errors that were being flagged on Internet Explorer no longer occur. CONF-3422, CONF-3424

**Database Connection Pool Changes**

Dependent on the size of your Confluence installation, the new re-indexing task may use up to 10 database connections simultaneously. As such, you may need to increase the size of your database connection pool in order to allow Confluence to continue to operate during and after rebuilding the search index.

If Confluence has been set up to use direct JDBC connections, then you will find the setting for Confluence's connection pool size in confluence.cfg.xml in your confluence home directory. Confluence should update this value automatically when you upgrade, so after starting up Confluence 1.4.2 for the first time, you should check to make sure it has been updated to 15 connections, as seen below:

```
<property name="hibernate.c3p0.max_size">15</property>
```

If Confluence has been configured to use a datasource supplied by the application server, you should ensure the application server is configured to supply Confluence with sufficient connections to run.

**Changes in 1.4.2**

See also: Issues Resolved for 1.4.2

- Confluence has now been tested on Websphere 5.1.1.3 (see Known Issues for Websphere)
- Confluence has now been tested against DB2 8.1 (Linux and Windows)
- The mechanism by which Confluence rebuilds its full-text search index has been rewritten to be significantly less memory-intensive (but may be 10-15% slower). CONF-3340
- An issue that could cause comments or attachments to be removed from the search index when a page was edited has been resolved. CONF-3349
- An issue that could cause index rebuilding to fail (especially on multi-processor systems) has been resolved. CONF-3168
- Issues related to the size and reliability of the mail queue were resolved. CONF-3334 CONF-3474
- An exception when creating global templates was fixed. CONF-3386
- Some Javascript errors that were being flagged on Internet Explorer no longer occur. CONF-3422, CONF-3424
-3482

- Exporting a space to HTML via XML-RPC now succeeds. CONF-3401
- Creating a blog post via XML-RPC now succeeds. CONF-3412
- ALL CAPS WORDS are no longer linked when CamelCase linking is activated. CONF-3361
- The display of user attachments does not break when the user has not yet set a profile. CONF-3420

Issues Resolved for 1.4.2

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Authenticate to retrieve your issues</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 1.4.3

Confluence 1.4.3 is a maintenance release that resolves some issues users may have encountered using previous Confluence 1.4 releases. 1.4.3 introduces a new SOAP service provider, and fixes issues related to incoming link tracking, notifications management, serving resources from dynamically loaded plugins, and much more.

1.4.3 is a free upgrade for all customers who purchased their Confluence license after August 17th, 2004.

Who should upgrade?

Confluence 1.4.3 is a bugfix release. While Atlassian recommends customers always run the most recently available stable Confluence release, customers should consult the list of issues resolved to decide whether it is worth their while upgrading.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 to 1.4.2, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.6 or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

Changes in 1.4.3

See also: Issues Resolved for 1.4.3

Remote API Changes

Confluence now ships with an second SOAP provider running Apache Axis, alongside the existing Glue SOAP provider. This is the first step towards migrating entirely to Axis as our sole SOAP provider over the next few major Confluence releases. If you use Confluence's SOAP API, you should read this document for information about the migration process and timeframe.

⚠️ All SOAP clients that worked with Confluence 1.4.2 will continue to work with Confluence 1.4.3 with no change.

Other changes made to the remote API:
A condition under which SOAP faults could be masked by HTML error pages on some application servers was resolved. (CONF-3043)
Deleting a page via the remote API now places that page in the trash. (CONF-3403)
Adding space level permissions to a user through the remote API now works as expected. (CONF-3596)

Other Changes and Fixes

A bug that would cause a page's most recent editor to change when the page was previewed has been fixed (CONF-3424)
A bug that could cause a page's incoming links not to be displayed has been fixed (CONF-3509)
A bug that could cause "Watch this space" not to function has been fixed (CONF-3510)
A bug that could cause Confluence to run out of available file descriptors when exporting a space has been fixed (CONF-3517)
A bug that could cause an email notification to be sent regarding a page that was restricted by page-level permissions has been fixed (CONF-3553)
The attachment upload form in the "Insert Image" is more robust against error (CONF-3677, CONF-3676)
Searching for a page in the Parent Page Picker Popup now functions as expected (CONF-3364)
Deleting a user now correctly deletes their email notifications (CONF-3619)
Restoring a page from the trash now re-adds that page's comments to the search index (CONF-3564)
Attachment links are now not rendered if the user can not view the attachment due to page level permissions (CONF-3553)
The list of recently edited pages in a user's profile is now more accurate (CONF-2430)
Plugins uploaded through the web interface can now correctly serve downloadable resources (CONF-3387)
The {recently-updated} macro and recent blogs pages now work under JDK 1.5 (CONF-3528, CONF-3601)
The {section} macro's "border" property now works correctly (CONF-3736, CONF-3433)
The {noformat} macro now has a "nopanel" parameter that will suppress drawing a background or border (CONF-3656)
Several issues regarding the {tasklist} macro were fixed (CONF-3622, CONF-3633, CONF-3632)
The {dynamictasklist} macro no longer breaks PDF exports (CONF-3513)
The informational macros no longer center their text when viewed in Internet Explorer (CONF-3537)
Links are now parsed in the title of a (panel) macro (CONF-3560)
The string ?!!? is no longer interpreted by the Wiki/HTML renderer as a broken image

See also: Issues Resolved for 1.4.3

Confluence SOAP Provider Migration

Starting with the release of Confluence 1.4.3, and stretching through the next three major releases, Confluence will be transitioning from using the Glue library to provide a SOAP remote API, to using Apache Axis. Unfortunately, while the SOAP services will stay the same, the WSDL that these libraries generate to interact with the same services will change, so SOAP applications that interact with Confluence will need to migrate with us.

The migration should be relatively painless. Since the underlying objects represented by the WSDL are still the same, the process should involve regenerating your SOAP stubs, and a few cosmetic code changes.

The XML-RPC API is unaffected by this change.

Current Status

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.4.3 and 1.5/2.0</td>
<td>Deploy Axis SOAP service alongside Glue</td>
<td>✔️ Completed</td>
</tr>
<tr>
<td>(unscheduled)</td>
<td>Allow configuration of default SOAP provider, the default at installation being Axis</td>
<td>✗ Incomplete</td>
</tr>
</tbody>
</table>
Progress on these issues can also be tracked via [CONF-3141](#).

### The Plan

As of version 1.4.3, Confluence ships with three SOAP endpoints:

<table>
<thead>
<tr>
<th>Endpoint</th>
<th>WSDL URL</th>
<th>Provider</th>
</tr>
</thead>
<tbody>
<tr>
<td>/rpc/soap/confluencesoapservice-v1</td>
<td>/rpc/soap/confluenceservice-v1.wsdl</td>
<td>Glue</td>
</tr>
<tr>
<td>/rpc/soap-glue/confluencesoapservice-v1</td>
<td>/rpc/soap-glue/confluenceservice-v1.wsdl</td>
<td>Glue</td>
</tr>
<tr>
<td>/rpc/soap-axis/confluencesoapservice-v1</td>
<td>/rpc/soap-axis/confluenceservice-v1?wsdl</td>
<td>Axis</td>
</tr>
</tbody>
</table>

⚠️ The Axis and Glue providers produce slightly different WSDL URLs

💡 Third-party SOAP [RPC Plugins](#) deployed in Confluence will be similarly deployed in three locations

Over the next three major Confluence releases we will:

1. Make the provider of /rpc/soap/confluenceservice-v1 configurable, then
2. Change the default provider to Axis (but leave it configurable), then finally
3. Remove the Glue provider entirely

### What This Means for SOAP Clients

Confluence major releases occur every three or four months. Thus, authors of SOAP clients should keep in mind this timeline, starting with the release of Confluence 2.0 (November 2005)

<table>
<thead>
<tr>
<th>0-3 months</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• All existing SOAP clients written against the Glue provider will continue to function normally.</td>
<td></td>
</tr>
<tr>
<td>• New clients should be written to the Axis provider in /rpc/soap-axis</td>
<td></td>
</tr>
<tr>
<td>• Existing clients should change their SOAP endpoints to point to /rpc/soap-glue (or, better still, move directly to Axis)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3-6 months</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Confluence will require configuration to work with any client of the Glue provider that has not changed its endpoint</td>
<td></td>
</tr>
<tr>
<td>• New clients should be written to the Axis provider in /rpc/soap-axis</td>
<td></td>
</tr>
<tr>
<td>• Existing clients will need to migrate to the Axis provider</td>
<td></td>
</tr>
</tbody>
</table>
6+ months

- Confluence will no longer work with clients written against the Glue provider
- Both /rpc/soap and /rpc/soap-axis endpoints will continue to be served by the Axis provider

**Issues Resolved for 1.4.3**

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><strong>Authenticate</strong> to retrieve your issues</td>
</tr>
</tbody>
</table>

**Release Notes 1.4.4**

Confluence 1.4.4 is a maintenance release that resolves some issues users may have encountered using previous Confluence 1.4 releases. 1.4.4 fixes a number of issues, including many related to the reliability of uploaded plugins.

1.4.4 is a free upgrade for all customers who purchased their Confluence license after September 23rd, 2004.

**Who should upgrade?**

Confluence 1.4.4 is a bugfix release. While Atlassian recommends customers always run the most recently available stable Confluence release, customers should consult the list of issues resolved to decide whether it is worth their while upgrading.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence versions between 1.4 and 1.4.3, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.6 or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

**Changes in 1.4.4**

**Uploaded Plugin Fixes**

Prior to Confluence 1.4.4, plugins containing Spring components, XWork actions or velocity templates could not be uploaded through the web interface, and needed to be installed manually in WEB-INF/lib. Confluence 1.4.4 fixes these issues.

**Database Indexes**

Confluence 1.4.4 now correctly creates database indexes on a clean installation. If you are upgrading an existing Confluence instance, you should consult Performance Tuning for information on indexes that can improve Confluence’s performance significantly.

**Other Changes and Fixes**

See: Issues Resolved for 1.4.4
Confluence Development Releases

Development releases are interim builds of Confluence that we make available so that interested customers can try out new features, especially those features that you may have been waiting for, and don't want to wait another month for the next official release. Development releases are also called early access program (EAP) releases.


Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Current Development Release Cycle

The links below show the latest development releases:

- [Confluence 4.3-RC1 Release Notes](#) – 1 August 2012
- [Confluence 4.3-Beta1 Release Notes](#) – 6 July 2012
- [Confluence 4.3-m11 EAP Release Notes](#) – 31 May 2012

Previous Development Release Cycles

4.2 development

- [Confluence 4.2-Beta3 Release Notes](#) – 27 March 2012
- [Confluence 4.2-Beta2 Release Notes](#) – 16 March 2012
- [Confluence 4.2-Beta1 Release Notes](#) – 13 March 2012

4.1 development

- [Confluence 4.1-rc1 Release Notes](#) – 5 December 2011
- [Confluence 4.1-m5 ("Milestone 5") Release Notes](#) – 15 November 2011
4.0 development

- Confluence 4.0-beta2 ("Beta 2") Release Notes – 18 August 2011
- Confluence 4.0-m36 ("Milestone 36") Release Notes – 1 August 2011
- Confluence 4.0-m29 ("Milestone 29") Release Notes – 27 June 2011
- Confluence 4.0-m27 ("Milestone 27") Release Notes – 3 June 2011

3.5 development

- Confluence 3.5-rc1 ("Release Candidate 1") Release Notes – 9 March 2011
- Confluence 3.5-beta3 ("Beta 3") Release Notes – 4 March 2011
- Confluence 3.5-beta2 ("Beta 2") Release Notes – 4 March 2011
- Confluence 3.5-beta1 ("Beta 1") Release Notes – 10 February 2011
- Confluence 3.5-m4 ("Milestone 4") Release Notes – 22 December 2010
- Confluence 3.5-m3 ("Milestone 3") Release Notes – 17 December 2010
- Confluence 3.5-m2 ("Milestone 2") Release Notes – 7 December 2010
- Confluence 3.5-m1 ("Milestone 1") Release Notes – 22 November 2010

3.4 Development

- Release Notes 3.4-m4 ("Milestone 4") 2/SEP/2010
- Release Notes 3.4-m2 ("Milestone 2") 8/AUG/2010
- Release Notes 3.4-m1 ("Milestone 1") 20/JUL/2010

3.3 Development

- Release Notes 3.3-m3 ("Milestone 3") 18/MAY/2010
- Release Notes 3.3-m1 ("Milestone 1") 8/APR/2010

3.2 Development

- Release Notes 3.2-beta ("Beta") 1/MAR/2010
- Release Notes 3.2-m4 ("Milestone 4") 22/FEB/2010
- Release Notes 3.2-m3 ("Milestone 3") 5/FEB/2010

3.1 Development

- Release Notes 3.1-rc1("Release Candidate 1") 27/NOV/2009
- Release Notes 3.1-m7 ("Milestone 7") 5/NOV/2009
- Release Notes 3.1-m6 ("Milestone 6") 26/OCT/2009
- Release Notes 3.1-m5 ("Milestone 5") 8/OCT/2009
- Release Notes 3.1-m4 ("Milestone 4") 22/SEPT/2009
- Release Notes 3.1-m3 ("Milestone 3") 10/SEPT/2009
- Release Notes 3.1-m1 ("Milestone 1") 22/JULY/2009

Other Resources for 3.1:

- Confluence 3.1 Deprecated Code Cleanup
- Prototype REST API
- Confluence 3.1 Newly Deprecated Code

3.0 Development

- Release Notes 3.0-m9 ("Milestone 9") 28/APRIL/2009
- Release Notes 3.0-m8 ("Milestone 8") 20/APRIL/2009
- Release Notes 3.0-m7 ("Milestone 7") 31/MARCH/2009
- Release Notes 3.0-m6 ("Milestone 6") 16/MARCH/2009
- Release Notes 3.0-m5 ("Milestone 5") 24/FEVERARY/2009
2.10 Development

- Release Notes 2.10-rc1 ("Release Candidate 1") 23/NOV/2008
- Release Notes 2.10-m8 ("Milestone 8") 13/NOV/2008
- Release Notes 2.10-m7 ("Milestone 7") 12/NOV/2008
- Release Notes 2.10-m5 ("Milestone 5") 23/OCT/2008
- Release Notes 2.10-m4 ("Milestone 4") 2/OCT/2008
- Release Notes 2.10-m3 ("Milestone 3") 18/SEPT/2008
- Release Notes 2.10-m2 ("Milestone 2") 08/SEPT/2008
- Release Notes 2.10-m1 ("Milestone 1") 22/AUGUST/2008

2.9 Development

- Release Notes 2.9-rc1 ("Release Candidate 1") 31/JULY/2008
- Release Notes 2.9-m5 ("Milestone 5") 9/JULY/2008
- Release Notes 2.9-m3 ("Milestone 3") 11/JUNE/2008
- Release Notes 2.9-m2 ("Milestone 2") 27/MAY/2008

2.8 Development

- Release Notes 2.8-m9 ("Milestone 9") 26/MAR/2008
- Release Notes 2.8-m7 ("Milestone 7") 11/MAR/2008
- Release Notes 2.8-m6 ("Milestone 6") 05/MAR/2008
- Release Notes 2.8-m4 ("Milestone 4") 08/FEB/2008
- Release Notes 2.8-m3 ("Milestone 3") 30/JAN/2008
- Release Notes 2.8-m2 ("Milestone 2") 16/JAN/2008

2.7 Development

- Release Notes 2.7-rc1 ("Release Candidate 1") 05/DEC/2007
- Release Notes 2.7-m5 ("Milestone 5") 26/NOV/2007
- Release Notes 2.7-m4 ("Milestone 4") 06/NOV/2007
- Release Notes 2.7-m2 ("Milestone 2") 10/OCT/2007

2.6 Development

- Release Notes 2.6-dr1
- Release Notes 2.6-dr2

2.3 Development

- Release Notes 2.3-DR1
- Release Notes 2.3-DR2

1.5 - 2.0 Development

- 1.5-DR1 was not released
- Release Notes 1.5-DR2
- Release Notes 2.0-RC1
- Release Notes 2.0-RC2

1.4 Development

- Release Notes 1.4-DR1
- Release Notes 1.4-DR2
- Release Notes 1.4-DR3
- Release Notes 1.4-DR4
- 1.4-DR5 was not released
- Release Notes 1.4-DR6
Confluence 4.3-RC1 Release Notes
1 August 2012

With great pleasure, Atlassian presents Confluence 4.3 Release Candidate 1 (RC1). This EAP (early access program) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. Feel free to comment on the page if you want to provide any feedback or ask any questions. EAP releases also give plugin developers an opportunity to test and fix their plugins in advance of an official release.

What's in this release?

Please see the new features of Confluence 4.3 described in the Confluence 4.3-Beta1 Release Notes. For plugin developers, please see our developer's guide to preparing for Confluence 4.3.

This release candidate is primarily a bug-fix release. These are the changes in Confluence 4.3 RC1:

- Changes to drafts functionality
- Image zoom and table scrolling in Confluence mobile
- Mentions now available via the 'Insert' menu
- Existing templates now migrated on upgrade
- Other items of interest

Downloading Confluence

The Confluence 4.3 RC1 release is available at the download site. When upgrading, please follow the upgrade notes below.

Please note the following

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Changes in this release
Changes to drafts functionality

Confluence 4.3 offers the same draft-handling capabilities as Confluence 4.2, with one improvement: You can now have more than one draft of a new page or blog post in the same space. In earlier versions, you could have multiple drafts of existing pages, but only one new draft.

(You may have noticed that the beta release offered you the option to save a draft when creating or editing a page or blog post. This was a new, experimental way of handling drafts. After usability testing, we decided that this feature is not yet ready for release. For that reason, the ability to explicitly save drafts will not be in the final release of Confluence 4.3.)

Image zoom and table scrolling in Confluence mobile

Have you tried viewing Confluence 4.3 content on your iPhone, iPod touch or Android device?

- You can now tap an image to zoom in, then pinch and expand the image using the standard mobile gestures.
- When a page includes a wide table, you can tap and drag to scroll horizontally.

See the beta release notes for a full description of the new mobile interface in Confluence 4.3.

Mentions now available via the 'Insert' menu

In Confluence 4.0 we introduced @mentions, a handy way of mentioning someone in a page or comment. If you type '@' and someone’s name, Confluence sends that person an email notification. Now we have added the user mention option to the editor’s ‘Insert’ menu to help new users discover this useful feature.
Existing templates now migrated on upgrade

As you know from the beta release notes, Confluence 4.3 introduces a rich text editor for templates. When we released the beta, we had not yet included an upgrade task to migrate your existing templates from wiki markup to the new storage format required by the rich text editor. That upgrade task is now present in the RC1 release. This process is automatic, and you should not need to take any action. For more details about the upgrade process, see Migration of Templates from Wiki Markup to XHTML-Based Storage Format.

Other items of interest

- **Comment and edit alerts not in Confluence 4.3.** The Confluence 4.3 Beta 1 release contained a feature that popped up a message when a new comment arrived or someone updated the page you were viewing. This feature is not in the final release of Confluence 4.3, as it needed more work to make it shippable.
- **Discoverable space administrators not in Confluence 4.3.** The beta release included a feature that listed space administrators in the space directory and on the 'Advanced' tab of the space. This feature requires more performance tuning, and is not in the final release.

Upgrade notes

These notes assist you in upgrading your test site to this EAP release.

1. **The JIRA Portlet macro is no longer supported.**
   Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1. We deprecated the use of JIRA portlets in Confluence 4.2 (see the Confluence 4.2 upgrade notes) and have removed the portlet code in Confluence 4.3. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in How to Migrate from JIRA Issues and JIRA Portlets to Gadgets.

2. **Active Objects is now bundled.**
   Confluence 4.3 ships with the Active Objects plugin. If you have previously installed Active Objects into your Confluence 4.2 site, you will need to uninstall it before upgrading to Confluence 4.3. This is because user-installed plugins override bundled plugins.

Follow the usual upgrade instructions to upgrade your test site to this release.

Confluence 4.3-Beta1 Release Notes

6 July 2012

With great pleasure, Atlassian presents Confluence 4.3 Beta 1. This EAP (early access program) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. Feel free to comment on the page if you want to provide any feedback or ask any questions. EAP releases
also give plugin developers an opportunity to test and fix their plugins in advance of an official release.

Highlights of Confluence 4.3 Beta 1:

- Confluence mobile
- In-app notifications
- Personal tasks
- Tasks on the page
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Table sorting and highlighting
- Simpler space creation
- Draggable images and macros
- Other improvements
- Infrastructure changes
- A note about changes to drafts – not in Confluence 4.3 final release
- Upgrade notes

⚠️ Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

## Highlights of Confluence 4.3 Beta 1

1

### Confluence mobile

Introducing a new, super-responsive interface optimised for iPhone and Android (currently with beta support) devices. With Confluence mobile you can:
- Browse popular content, recent blog posts and network activity.
- Like pages, blog posts and comments.
- Add comments to pages and blog posts.
- Search Confluence for content and people.
- View the profiles of your colleagues. Tap to call, SMS or email them directly from your mobile device.
- Manage your personal tasks and notifications.

In-app notifications

Now you can manage your notifications, mentions and shares all in one place – the new notifications dialog in Confluence. Use the handy inline actions to like and watch pages, and reply to comments. Want to track the items you need to take action on? Convert a notification to a personal task.
Personal tasks

Personal tasks help you stay focused on the task at hand and plan your day's work. You can create tasks, prioritise them by dragging them into order, and manage them entirely within Confluence.
Tasks on the page

It’s now really simple to track team tasks inside your pages – project tasks, meeting action items and checklists.

- **Create task lists**
  
  Click the new task icon in the editor to start a new task list.

- **Assign tasks using mentions**
  
  You can @mention a user within a task to assign it to them. These tasks then appear in the personal task list.

- **Receive instant notifications**
  
  Users receive a notification when a task has been assigned to them. Page watchers will be notified when tasks in a page are marked as complete.

- **Track tasks from anywhere**
  
  View all your assigned tasks in your personal tasks list where you can add notes, prioritise them, and mark them as complete.

Rich text templates

You can now create templates using the rich text editor, so you no longer need to use wiki markup to make and update your templates. This means that you can now convert an existing page to a template.
Space archiving

You can archive a space, so that its content is less visible but still available on your Confluence site. When a space is archived, the pages and other content do not appear in the Confluence search results, activity streams, or dropdown menus. In the space directory, the archived space will appear on a new archive tab.

Improved user invitations and signup options

If you want to invite people to sign up to Confluence, you can send an invitation via email directly from the
Confluence user administration screen, inviting people to join the site. To further encourage people to sign up, the login screen includes a signup option too.

If you choose to add users manually, Confluence can send them an email message informing them of their new account.

If you want to allow only people from within your organisation to sign up, use the new domain restriction option. People will only be able to sign up if their email address belongs to one of the domains specified. Confluence will send the person an email message, asking them to click a link to confirm their email address.

Table sorting and highlighting

Enjoy your tables even more!

- **Column sorting**
  When viewing a page, just click the header to sort on any column.

- **Cell highlighting**
  Fill table cells with a custom background colour to highlight important information.
Simpler space creation

The quick ‘Add Space’ option at the top of the dashboard leads you into the new, simplified dialog for adding global spaces, shown below. Adding a personal space is even simpler.

Confluence administrators can now set the default permissions that will be applied to new spaces. The default permissions are configurable for groups only, not for individual users or anonymous users.
Draggable images and macros

You can now drag and drop images and macros anywhere on a page that you’re editing. This is often a lot faster and definitely feels more natural than using cut/paste to move things around. Please note that this feature is not supported in Internet Explorer 8.

Other improvements

- **Comment and edit alerts.** You don't want to miss out on comments and updates just because you've been sitting on the page for a while. Now Confluence will pop up a message when a new comment arrives or someone updates the page you're busy with.

- **Removing attachment versions.** You can now delete a specific version of an attachment.

Infrastructure changes

Here are some points of interest for plugin developers.

- **JIRA Portlets gone.** We have removed the JIRA Portlet code from Confluence. We deprecated the use of JIRA portlets in Confluence 4.2 (see the [Confluence 4.2 upgrade notes](#)) and the JIRA Portlet plugin is no longer bundled in Confluence 4.3.

- **Active Objects bundled.** Confluence 4.3 ships with the [Active Objects](#) plugin. Active Objects is a new...
ORM (object relational mapping) layer into Atlassian products, implemented as a plugin. It enables easier, faster, and more scalable data access and storage than the existing Bandana and PluginSettings APIs. Active Objects in Confluence is still under rapid development, and is currently used by only a few plugins. If you would like to experiment with it, we would love to hear your feedback.

- **API changes.** Please see our [guide to preparing for Confluence 4.3](#).
- **Experimental API for in-app notifications and tasks.** Confluence 4.3 introduces a new in-app notifications and tasks feature. We have an [experimental API](#) available and we’re requesting your feedback! Here is your chance to help us shape the notifications and tasks API. Details are in our [guide preparing for Confluence 4.3](#).

### A note about changes to drafts – not in Confluence 4.3 final release

You may notice that this beta release offers you the option to **Save Draft** when creating or editing a page or blog post. This is a new, experimental way of handling drafts. After usability testing, we have decided that the drafts feature is not yet ready for release. For that reason, it will not be in the final release of Confluence 4.3.

Confluence 4.3 will therefore have the same draft-handling capabilities as Confluence 4.2.

### Upgrade notes

These notes assist you in upgrading your test site to this EAP release.

1. **The JIRA Portlet macro is no longer supported.**
   Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1. We deprecated the use of JIRA portlets in Confluence 4.2 (see the [Confluence 4.2 upgrade notes](#)) and have removed the portlet code in Confluence 4.3. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in [How to Migrate from JIRA Issues and JIRA Portlets to Gadgets](#).
2. **Active Objects is now bundled.**
   Confluence 4.3 ships with the [Active Objects](#) plugin. If you have previously installed Active Objects into your Confluence 4.2 site, you will need to uninstall it before upgrading to Confluence 4.3. This is because user-installed plugins override bundled plugins.

Follow the [usual upgrade instructions](#) to upgrade your test site to this release.

### Confluence 4.3-m11 EAP Release Notes

31 May 2012

With great pleasure, Atlassian presents Confluence 4.3 Milestone 11 EAP. This is our first public EAP in Confluence 4.3.

This EAP (early access program) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. Feel free to comment on the page to provide any feedback or ask any questions. EAP releases also give plugin developers an opportunity to test and fix their plugins in advance of an official release.
Highlights of Confluence 4.3 Milestone 11 EAP:

- **Confluence mobile**
- **In-app and mobile notifications**
- **Personal tasks**
- **Tasks in pages**
- **Table improvements**
- **Other improvements**
- **Infrastructure changes**
- **Upgrade notes**

### Downloading Confluence

The Confluence 4.3 Milestone 11 EAP release is available at the [download site](#). When upgrading, please follow the upgrade notes below.

### Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

### Highlights of Confluence 4.3 EAP

We recommend that you use Chrome when testing features in this milestone.

**1**

**Confluence mobile**

Introducing a new, super-responsive interface optimised for iPhone and Android devices. With Confluence mobile you can:

- Browse popular, recent blog posts and network activity.
- Like pages, blog posts and comments
- Add new comments to pages and blog posts.
- Search Confluence for content and people.
- View the profiles of your colleagues - tap to call, SMS or email them directly from your mobile device.
In-app and mobile notifications

Now you can view and take action on all your important notifications in one place, including:

- Shares and mentions
- Comments and likes
  Note: In order to be able to comment and reply inline, the Confluence remote API must be enabled (see Enabling the Remote API).
- JIRA comments, shares and mentions
  Note: For JIRA notifications to appear, you must create a trusted apps link between JIRA and Confluence and install plugins in JIRA to push notifications to Confluence (see Confluence 4.3 EAP only - JIRA Integration with Confluence Notifications).
On the run? Confluence Mobile supports in-app notifications too.

Personal tasks
Personal tasks help you stay focused on the task at hand and plan your day's work.

Tasks in pages

It's now really simple to track team tasks inside your pages – project tasks, meeting action items and checklists

1. **Create task lists**
   
   Click the new task icon in the editor to start a new task list.

2. **Assign tasks using mentions**
   
   You can mention a user within a task to assign it to them.

3. **Receive instant notifications**
   
   Users receive a notification when a task has been assigned to them. Page watchers will be notified when tasks in a page are marked as complete.

4. **Track tasks from anywhere**
   
   View all your assigned tasks in your personal tasks list where you can add notes, prioritise them, and mark them as complete.
Table improvements

1. **Column sorting**
   When viewing a page, just click the header to sort on any column.

2. **Cell highlighting**
   Fill table cells with a custom background colour to highlight important information.

![Table with column sorting and cell highlighting](image)

Other improvements

1. **Send user invitations from Confluence**
   Now Confluence can send emails directly to people inviting them to create an account.

2. **Add spaces quickly and simply**
   A new ‘Add Space’ button in the top right of the dashboard opens a simplified dialog for adding global spaces.

Infrastructure changes

Here are some points of interest for plugin developers.

1. **JIRA Portlets removed**
   We have removed the JIRA Portlet code from Confluence. We deprecated the use of JIRA portlets in Confluence 4.2 (see the Confluence 4.2 upgrade notes) and the JIRA Portlet plugin is no longer bundled in Confluence 4.3. Portlets have been superceded by gadgets. Refer to Adding JIRA Gadgets to a Confluence Page for more information.

2. **Active Objects bundled**
   Confluence 4.3 ships with Active Objects. Active Objects is a new ORM (object relational mapping) layer implemented as a plugin. It enables easier, faster, and more scalable data access and storage than the existing Bandana and PluginSettings APIs. Active Objects in Confluence is still under rapid development.
and is currently used by only a few plugins. Please see the [Active Objects documentation](#) for more information.

3. **API changes.** Please see our [guide to preparing for Confluence 4.3](#).

## Upgrade notes

These notes assist you in upgrading your test site to this EAP release.

1. **The JIRA Portlet macro is no longer supported.**
   Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1. We deprecated the use of JIRA portlets in Confluence 4.2 (see the [Confluence 4.2 upgrade notes](#)) and have removed the portlet code in Confluence 4.3. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in [Migrating from JIRA Issues and JIRA Portlets to Gadgets](#).

2. **Active Objects is now bundled.**
   Confluence 4.3 ships with the [Active Objects](#) plugin. If you have previously installed Active Objects into your Confluence 4.2 site, you will need to uninstall it before upgrading to Confluence 4.3. This is because user-installed plugins override bundled plugins.

Follow the [usual upgrade instructions](#) to upgrade your test site to this release.

### Confluence 4.3 EAP only - JIRA Integration with Confluence Notifications

**Note:** This page does not apply to the Confluence 4.3 production release.
The information on this page relates to the [Confluence 4.3-m11 early access (EAP) release](#) only. In-app notifications in Confluence 4.3 do not support JIRA integration.

You can try JIRA integration with Confluence in-app notifications by installing the notification provider plugin on a test JIRA site.

1. Create a [Trusted Apps application link](#) between your Confluence 4.3 EAP site and a test site running the last release of JIRA. In order to create a Trusted Apps link, you will need to make sure you have the same userbase in JIRA and Confluence.
2. Download and install the notifications client plugin in JIRA: [myworkday-client-0.9.1426.1.jar](#)
3. Download and install the notifications provider plugin in JIRA: [myworkday-jira-provider-0.9.1426.1.jar](#)
4. Test in-app notifications in JIRA by commenting an issue that a user is watching. The user should then receive the notification in Confluence.

Keep in mind that in-app notifications is an EAP feature and comes with the standard caveats for EAP builds. Do not install the client/provider plugins on a production JIRA site.

### Confluence 4.2-Beta3 Release Notes

**27 March 2012**
With great pleasure, Atlassian presents **Confluence 4.2 Beta 3**.

This beta release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. This also provides Atlassian with useful feedback. Beta releases also give plugin
developers an opportunity to test and fix their plugins in advance of an official release.

**In this release**

This release contains minor fixes only. In particular, we have fixed the LabelManager API, so that is is now backwards compatible. (We broke backwards compatibility in beta 1.) Details are in this issue:

[CONF-24902 - Authenticate](#) to see issue details

Please see the new features of Confluence 4.2 described in the [Confluence 4.2-Beta1 Release Notes](#).

**Upgrade notes**

Upgrading from a previous version of Confluence

Follow the [usual upgrade instructions](#) to upgrade your test instance to this release. *We strongly recommend that you back up your Confluence Home directory and your database before upgrading.*

A big **thank you** to everyone who helps us ensure that Confluence keeps getting better and better!

---

### Downloading Confluence 4.2 Beta 3

The Confluence 4.2 Beta 3 release is available at the [download centre](#). When upgrading, please follow the [upgrade notes](#) below.

---

### Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

---

### Confluence 4.2-Beta2 Release Notes

**16 March 2012**

Confluence 4.0 Beta 2 is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. This also provides Atlassian with useful feedback. Beta releases also give plugin developers an opportunity to test and fix their plugins in advance of an official release.

This release contains minor fixes only. Please see the fixes and improvements reported in the [Confluence 4.2-Beta1 Release Notes](#).

---

### Downloading Confluence 4.2 Beta 2

The Confluence 4.2 Beta 2 release is available at the [download centre](#). When upgrading, please follow the [upgrade notes](#) below.
Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Upgrade Notes

Upgrading from a previous version of Confluence

Follow the usual upgrade instructions to upgrade your test instance to this release. *We strongly recommend that you back up your Confluence Home directory and your database before upgrading.*

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better!

**Confluence 4.2-Beta1 Release Notes**

12 March 2012

With great pleasure, Atlassian presents Confluence 4.2 Beta 1.

Confluence 4.0 Beta 1 is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. This also provides Atlassian with useful feedback. Beta releases also give plugin developers an opportunity to test and fix their plugins in advance of an official release.

**Highlights of Confluence 4.2 Beta 1:**

- Page Layouts
- Likes
- Quick Comments
- Popular Content on the Dashboard
- Personalised Summary Email
- Attachment Labels
- Share Notifications Showing All People Notified
- Gadget Subscriptions
- Other Improvements
- Infrastructure Changes
- Upgrade Notes
Downloading Confluence 4.2 Beta 1

The Confluence 4.2 Beta 1 release is available at the [download centre](#). When upgrading, please follow the [upgrade notes](#) below.

Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

**Highlights of Confluence 4.2 Beta 1**

1

**Page Layouts**

Page layouts offer a quick and easy way to add sections and columns to a page. Choose a predefined layout, add the content to each section, and you're done. It's a great way of creating a common page structure, so that readers know where to find the information on each page. Don't worry, the Section and Column macros are still available too.
A two-column page layout in edit mode

**Likes**

Has someone written a mind-blowingly cool post on Confluence? Click the **Like** button to them know. It's quick and easy to make their day! Confluence has like buttons on every page, blog post and comment. If enough people like your post, it will show on the dashboard's new popular tab. The information in your personalised summary email is based on the number of people in your network who have liked the content.
Quick Comments

Showing people a picture of themselves is a great way to encourage them to say something! We want to encourage people to comment on Confluence pages and blog posts, so we have added an inviting empty comment, showing the user's avatar, at the bottom of the page. This replaces the rather uninviting Add Comment button in earlier versions. And here's what we are really proud of: When you click the box to write a comment, the full editor loads instantly. Boom! No page refresh required.
All about chocolate

Chocolate is inevitable.

So let's talk about chocolate

Two penguins find themselves together on an ice floe, drifting helplessly into warmer waters. The penguins are very fond of each other. Suddenly, craaaaack, the ice floe splits in half. Right between the penguins. As they drift apart, one penguin sadly waves a flipper and calls out, "Chocolate milk!"

Popular Content on the Dashboard

Want to see what's trending? The new Popular tab on the dashboard shows the pages and blog posts that attracting most attention, based on the number of comments and likes.
New popular content tab on the dashboard

5

Personalised Summary Email

Confluence sends out a weekly summary of the news that interests you. Each email message is tailored according to the spaces you follow and your network. This is a great way of drawing people into the wiki discussions even if they are infrequent users of Confluence. You can opt in or out of the recommended update summary via an option on the email settings page of your user profile.
6

Attachment Labels

You can now label attachments, just as you can label pages and blog posts. Using the Attachments macro, you can filter to show documents or other attachments with a specific label. The Content by Label macro also displays attachments (alongside pages, blog posts and spaces) with a given label.

7

Share Notifications Showing All People Notified

If someone shared a page with you, it's nice to know who else they shared it with. We introduced sharing of pages and blog posts in Confluence 3.5. Just click Share and follow the prompts. Confluence sends an email message to the people that you have specified. In this release, when someone shares a page with you, the email message shows the other people they shared it with too.
Other people sharing the page

Gadget Subscriptions

Confluence 4.2 includes Atlassian Gadgets 3.2, with gadget subscriptions. This means that you can quickly add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory, for easy addition to your Confluence pages. To subscribe to another site's gadget go to Confluence Admin > External Gadgets and click the new Gadget Feeds tab.
Other Improvements

- We have fixed the following bug: CONF-6246 - Authenticate to see issue details
- The permissions for personal spaces are now more in line with Confluence's philosophy of encouraging collaboration. When you create a personal space, the option that allows registered users to update content is selected by default. You will also be assigned as a watcher of your new personal space.
- Blog comments now include an 'author' lozenge to allow you to quickly scan a page for comments from the author.

John Masson  AUTHOR
Mar 01, 2012
I think since 100% is out we need to keep it narrower. I didn't think it was that bad before, but right now it looks odd because it's "almost" 100% but not quite... Perhaps 50% looks better? Seems more intentional?

Infrastructure Changes

- Confluence now uses version 2.0 of the Universal Plugin Manager (UPM).
- Confluence 4.2 includes Atlassian Gadgets 3.2
- From this release of Confluence, we support PostgreSQL 9.0 as well as 8.2, 8.3 and 8.4.
- The implementation of quick comments required some pretty significant changes to the editor's initialisation code. This will have consequences for some Confluence plugins. Details are in this blog post: JavaScript Changes Required for Confluence 4.2 Compatibility.

Upgrade Notes

Upgrading from a previous version of Confluence

Follow the usual upgrade instructions to upgrade your test instance to this release. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better!

Confluence 4.1-rc1 Release Notes

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in
subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

⚠️ Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

⚠️ Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

Upgrade Procedure

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.
Important information for plugin developers

If you are a plugin developer testing for compatibility against Confluence 4.1, it is very important that you read the information at the bottom of these release notes about Velocity templates and deprecation.

Highlights of this Release

1. Image Effects

After inserting an image, you can now apply one of five effects to the image by clicking the new Effects button and choosing from one of the following:

- Taped,
- Instant Camera,
- Curl Shadow,
- Snapshot,
- Drop Shadow.
The images above are displayed using the 'Snapshot' Image Effect.

2. Autoconvert Pasted Links

Linking to things in Confluence is much too hard. Sometimes you already have the URL from some other tab and just want to paste it in. If it's a link to a system Confluence knows about, why should you have to mess around with doing it "properly" by looking it up in the link dialog or the issue dialog just because you want it to get refactored later?

For example, if you paste in https://jira.atlassian.com/browse/CONF-23567 then some people will give you grief for not using the insert JIRA issue link to make it

| CONF-23567 | Authenticate | to see issue details | . The new Autoconvert feature will automatically convert pasted links into a useful macro. You have to see it to believe it. It works for:

- Pasting Links to JIRA issues
- Pasting JIRA JQL links
- Pasting Youtube URLs
- Most widget connector URLs (like Skitch links)
- Any shortcut link

3. Editor Find & Replace

This will be a welcomed feature to users who used to copy wiki markup out into another text editor to do a find replace then paste it back in. Now everyone will be able to do it right from the editor.

4. Dashboard Network Tab

Having a difficult time finding relevant content in the dashboard activity stream? This allows you to see recent updates from just the people you follow in Confluence. As part of this work there were some changes made in the background to the way the Dashboard works meaning

- a lot less DB queries
- the dashboard recent updates macro now accepts a 'users' parameter (which drives the Network tab)
- adding any new tabs will be a lot easier for the developers
5. Editor Copy / Paste Improvements

Copy / Paste Multiple Rows or Whole Tables

We've spent time focusing on a number of editor efficiency issues, most recently being the ability to easily copy and paste multiple table rows or whole tables within a page, across pages, across Confluence installs or even from other sources (eg: HTML tables on the web). Additionally (which didn't happen in Wiki Markup where users could previously copy/paste rows fairly simply) you can now overwrite existing cells by pasting into them and where the clipboard contents are bigger than the existing table, it will automatically be adjusted with additional columns to fit. This is a big usability improvement.

Oh and one more thing, you can now use Alt+Up Arrow or Alt+Down Arrow to add a new row above or below your current one, which works beautifully with the new easy to copy/paste rows.

CONF-23408
CONF-23929

Copy / Paste list items

Fixing another similar pain point, we also spent some time working on the pasting of list items into existing lists, making this more consistent with what you'd expect. If you copy a couple of list items from one part of a list, or another one, and paste them into the middle of a list, they are added at the same level, not indented. This is the first of a number of tweaks to the way lists work which will be a big usability improvement.

CONF-23842

6. Favourites Page

The concept of a personal label has been removed and you'll now see a newly named and cleaner Favourites tab in your personal space. Additionally the list of favourites is now paginated and uses AJAX to un-favourite pages on the page.
7. Global Stylesheets

Now a custom PDF stylesheet can be set at the global level, just like custom layouts, so where there is no specific individual space stylesheet defined when a PDF space export is done it will fall back to this global stylesheet, meaning users won't have to apply the same stylesheet to all their individual spaces if they want the same behaviour.

8. (No More) Page Title Character Restrictions

You can now use "special" characters such as : or @ or % in your page titles, as in the screenshot below. Various new features like this are now possible, thanks to the move to the new Confluence editor.
9. Global plugin & macro timeout setting

CONF-9344, CONFDEV-27

There is now a globally configurable timeout setting which will stop pages going into a permanent loading state leaving users no easy way to edit them to sort out the offending macros or plugins. In the worst case scenario this had the potential to bring down Confluence itself before.
10. New Logo and Icons

As you may know, Atlassian introduced a new logo in October. Now, Charlie 2.0 has made it to Confluence.

You’ll also notice a bunch of new icons to give some of your favourite features in Confluence a fresh look. Here are some examples of the new page and blog post icons.
8 Child Pages

- 2011-11-29 - Confluence - Find & Replace Blitz - Joey Corea
- David Taylor's findings – Find & Replace Blitz
- Don Willis's findings -- Find & Replace Blitz
- Edwin Dawson's findings -- Find & Replace Blitz
- Henry Tapia's findings -- Find & Replace Blitz
- John Masson's Findings
- Nabeelah's Findings - IE8
- Zhuang's observations

Blog Posts

- Confluence 4.1 Release Notes - Build 1130-1176 created by John Masson
- Confluence Desynchronisation created by Jonathan Gilbert
- Confluence 4.1 Release Notes - Build 1109-1129 - Page Layouts! created
- Confluence 4.1 Release Notes - Build 1055-1109 created by John Masson
- Confluence 4.1 Release Notes - Build 1016-1055 created by John Masson

Important note for plugin developers

As of Confluence 4.1, Confluence will now log a warning every time a Velocity template makes a call to a deprecated Java class or method. Under Confluence's deprecation policy, deprecated code is likely to be removed in future releases of the product, and plugin developers are strongly advised to stop using it as early as possible.

When you run Confluence in Developer Mode, these warnings will instead cause an exception to be thrown and the processing of the template to be aborted. This is to give plugin developers much more immediate (and harder to ignore) feedback about potentially dangerous code. Developer Mode is turned on by the Atlassian SDK, so if you use the SDK to build or test your plugin you should know right away if there's something dangerous going on in your Velocity files.

If you want to switch this behaviour back to just logging a warning, you should start Confluence with the -Dconfluence.velocity.deprecation.strictmode=false system property set.

Confluence 4.1-rc1 Upgrade Notes

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.0.x.
3. If your version of Confluence is earlier than 4.0, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.0 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.1-m5 EAP Release Notes

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

Upgrade Procedure
If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Highlights of this Milestone

Image Effects

After inserting an image, you can now apply one of five effects to the image by clicking the new Effects button and choosing from one of the following:

- Taped,
- Instant Camera,
- Curl Shadow,
- Snapshot,
- Drop Shadow.
The images above are displayed using the 'Snapshot' Image Effect.

(No More) Page Title Character Restrictions

You can now use "special" characters such as : or @ or % in your page titles, as in the screenshot below. Various new features like this are now possible, thanks to the move to the new Confluence editor.
Confluence 4.0-beta2 ("Beta 2") Release Notes

18 August 2011

With great pleasure, Atlassian presents Confluence 4.0, Beta 2.

Confluence 4.0 Beta 1 was an internal release. This beta release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance. This also provides Atlassian with useful feedback. Beta releases also give plugin developers an opportunity to test and fix their plugins in advance of an official release.

Highlights of Confluence 4.0 Beta 2:

- Brand New Editor
- Simplified Editing Experience
- New Macros
- Faster Editing Experience
- Introducing @mentions
- Improved Page Comparison Functionality
- Email Notification Improvements
- New Confluence Installer and Guided Upgrades
- New Editor Plugin Points for Developers
- Other Improvements
- Helping You Transition to Confluence 4.0
- We Welcome Your Feedback
Upgrading from Confluence 3.x

More:

- Read the Upgrade Notes for important information about this release.
- See the full list of issues resolved in this release.

### Downloading the Confluence 4.0 Beta

The Confluence 4.0 Beta release is available [here](#). When upgrading, please follow the Upgrade Notes below.

Got Questions? Want to learn more?
We have a lot of resources available for Administrators, Plugin Developers and End Users to help you transition to Confluence 4.0. Checkout our Planning for Confluence 4.0 page for resources.

### Do not use in production

- **EAP releases are not safe** — EAP releases are snapshots of the ongoing Confluence development process. As such:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because EAP releases represent work in progress, we can not provide a supported upgrade path between EAP releases, or from any EAP to the eventual final release. Thus, any data you store in a Confluence EAP release may not be able to be migrated to a future Confluence release.

### Highlights of Confluence 4.0

1

#### Brand New Editor

We've rebuilt the Confluence editor from the ground up, bringing you an editing experience that's simpler, faster and more intuitive.
The new Confluence editor delivers many advantages:

- Just one editor!
- Align left, centre or right, without using macros.
- Indent paragraph blocks and lists from the toolbar.
- A new colour picker.
- A new, streamlined user interface.

Simplified Editing Experience

Confluence 4.0 introduces macro placeholders, a visual representation of your macros while editing. Create rich content with new and existing macros, without the tools getting in the way.

Simplified Macro Editing

Makes macros easier to manage when editing.

- **A more visual experience**
  Making it easier to visualise what the page will look like when you publish it.

- **Macro properties panel**
  Every macro has a properties panel. The property panels for particular macros, such as the Status and View File macros have additional functionality, described below.

- **Quick access to macro editing**
  Double-click the macro to open the Macro Browser for parameter editing. Contents of some macros can be modified directly from the editor.
Improved Image Handling

- **Paste Images From Clipboard (Firefox and Chrome only)**
  Just copy any image to your clipboard and hit CTRL-V in the editor. The image will get attached and embedded directly into your page. There's nothing to install on your desktop, it just works!

- **Turn Images into Links**
  Now you can turn images into links. This is especially handy for turning images into a button like the Atlassian Documentation team is known to do. Previously, this was only available in wiki markup but can now be done in the shiny new Confluence 4.0 editor via the properties panel. We're still working on the link icon.

- **New Default Image Sizes**
  We've received a lot of feedback indicating that there isn't much difference between the preset image sizes. So, we've tweaked the sizes so that you can choose from a wider range of options. The small option remains the same at 100 pixels, medium has increased slightly to 300 pixels and large has changed to 500 pixels.

- **Custom image sizes**
  If you don't like the preset image sizes, you can now specify an exact image width.

- **Search Images**
  You can now embed and search images through a new "Search" tab in the image browser. Previously, this could only be done through Autocomplete (!).
Advanced Table Editing

We've made table operations better in Confluence 4.0 with the following features:

- **Drag to Insert Tables**
  Inserting tables is now easier and truly "WYSIWYG" with this new feature. Just click on the New Table dropdown and drag your mouse to choose the number of rows and columns you'd like in your new table. Oh, and don't worry if you like inserting tables with your keyboard, you can still use autoformatting or CTRL+SHIFT+I to insert a table.

- **New In-Context Table Toolbar**
  The new table toolbar removes the need for a context menu and only appears when you add a table to the page.

- **Merge and Split Table Cells.**
- **Highlight cells, rows or columns.**
- **Cut, copy and paste table rows.**
New Macros

We've bundled more macros with Confluence, and made some of the existing macros better, to help you easily include and present relevant content:

- **Status Macro**
  The Status macro displays a coloured lozenge in the editor, so you can see the status directly. You can use the properties panel to change the status while editing, without having to use the Macro Browser.

- **Expand Macro**
  The Expand macro allows you to add a dynamically expandable section of text to your page.

- **Profile Picture Macro**
  The Profile Picture macro displays a users profile picture on a page. Useful for creating Team Pages.
Faster Editing Experience

Write Wiki Markup ... Fast!

Many of Confluence's biggest fans are avid wiki markup users. For you aficionados, we wanted to give you the fastest editing experience possible, while preserving the speed and efficiency of your existing wiki markup skills. So, we present you with Autoformatting!

Autoformatting lets you type wiki markup into the editor this new feature will "auto-format" your text on the fly. To learn more, click on the "?” help button in the editor and select the Wiki Markup tab.

Try these and see what you think:

- **Font Formatting**
  Bold, underline, strikethrough, italic, superscript, subscript – just type the markup, such as "**Bold**", and watch it convert to **Bold** on the fly!

- **Basic Tables**
  Try typing |||||, or || **Heading 1** || **Heading 2** ||, then hit enter to to instantly see this:

<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
</table>

- **Emoticons**
  All of our emoticons convert on the fly. Try typing (:) in the editor to instantly see this: 😊.

- **Lists**
  For numbered lists, type # and a space at the start of each line.
  For bulleted lists, type * and a space at the start of each line.

- **Headings**
  Type h4, then some heading text to see a level 4 heading.

**Instant Links, Media and Macros**

Introduced in a previous release of Confluence (see details in this blog post), adding links, media and macros
can be quickly added by typing [, ! or { in the editor to add various kinds of content to your page. There’s also some small improvements added onto previous autocomplete functionality:

- The first item in the list is pre-selected to make editing faster,
- The macro autocomplete list now loads much faster,
- The macro autocomplete list now inserts most macros directly, without launching the Macro Browser, unless the macro requires a parameter.

**New Page Links**

Quickly insert a link to create a page with Autocomplete for links. Simply type ’[’ in the editor and as you type, Confluence will display a Create Page link if a page with that title does not already exist in your current space.

---

**Introducing @mentions**

Confluence 4.0 includes the new @mentions feature. This allows you to easily bring collaborators into a conversation: if you are mentioned in any Confluence content (a page, blog, comment or status update), you will be notified by email.

To mention someone, type @ and their name, when editing. Mentions will instantly suggest people you are following in your network, so you can quickly find and involve your friends.
Improved Page Comparison Functionality

We've got a better way to view changed content in Confluence.

Improved Page Diffs

We've simplified page diffs to make them easier to read. Additionally, page diffs now show changes to both formatting and macros.
Diffs in Email

Where possible, email notifications now show page differences exactly as they appear in Confluence. These are now rendered in your email view with the correct diff colour coding.
Email Notification Improvements

New Email Design

All email notifications in Confluence now have a new design. This works in major email clients as well as on the iPhone.

Follow Notifications

Confluence now sends email when someone follows you.
New Confluence Installer and Guided Upgrades

Much to the delight of any sysadmins that are installing any new instances of Confluence, the Windows (.exe) and Linux (.bin) guided installers are now available.

Simplified Installation Process

- **Guided installer**: The guided install wizard has been implemented for Confluence 4.0 on both Windows and Linux operating systems. Installing a new instance is a breeze.
- **Windows UAC support**: You will be prompted for elevated privileges in order to permit the full array of install options.
- **New instance vs Upgrade selection**: You can choose to install a new instance or upgrade an existing instance.
- **Install & Home directory selection**: Default folders are provided depending on the user being an admin/root or standard user (based on respective OS write permissions).
- **Port selection**: Choose your ports during the guided install process. Also, the ports in Confluence have changed! Take note: The default running port is now 8090 with the control port at 8009.
- **Install as a service**: Assuming you have elevated privileges, you have the option on both Windows and Linux to install Confluence as a service. This is practical for production instances.
- **Evaluation license generation**: As a recap, we added a simplified workflow in Confluence 3.5 to assist in generating licenses for evaluators.

Easy JIRA Integration

- **Setup wizard process improvements**: Hook Confluence up with JIRA, right within the in-application setup wizard.

New Guided Upgrades

The new Linux and Windows Installers from our EAP release now include an option that allows you to upgrade an existing Confluence 3.5.x or later installation. This upgrade automates the following tasks for you:

1. Backs up the Installation and Home Directories of the existing Confluence installation to be upgraded,
2. Installs Confluence 4.0.x whilst migrating the following from your existing Confluence installation to the new installation:
   - TCP port values in your existing Confluence installation's server.xml file,
   - The upgrade feature detects and notifies you of any other files in the confluence subdirectory of your existing Confluence Installation Directory, which had been deleted, added or modified from a ‘default’ Confluence installation. This informs you of any customisations you will need to migrate manually over to your upgraded Confluence installation directory.

New Editor Plugin Points for Developers
We've added more editor plugin points for developers. Notable improvements include:

**Extend the Macro Property Panel**

Plugin developers can add buttons to the Macro Property Panel in the editor. For example, insert a Gliffy diagram or see the tutorial on how to do this.

**Render an Image in the Macro Placeholder**

A plugin developer can now render an image instead of a placeholder for bodyless macros. For more information, check out the tutorial on how to do this.

**Custom Parameter Rendering in Placeholders**

You can choose to display any parameter in the macro placeholder in the editor, instead of having the placeholder automatically show the first few parameters.

**New Pluggable Format Menu**

Plugin developers can add items to the editor's Format menu. See this tutorial for details.

**View Storage Format**

To assist with plugin developers and help with developer issues, developers running in Dev mode and Confluence administrators can view the page storage format form the "Tools" menu in Confluence.

**New API Changes**

We have disabled the getPage() and getBlogEntry() read methods in the XML-RPC/SOAP API. If you have a script that primarily reads or appends to existing pages, it will break. Creating pages and overwriting existing pages will still work.

**Plugin Developer Resources**

We have created a landing page for Confluence 4.0 planning. This includes resources for plugin developers to help you create new plugins and make use of the new plugin points available as well as upgrade your existing plugins.

```
Learn more about Confluence 4.0
```

**Infrastructure Changes**

This release includes a number of improvements in the APIs and under the covers as well.

- **Anti-XSS Mode**
  Anti-XXS mode is now enabled by default for plugins.

- **Alignment and Border Parameters**
  The alignment and border properties in the macro definition template have been removed.

- **Thumbnail Settings**
  The 'Thumbnail maximum height' and 'Thumbnail maximum width' settings have been removed from the General Configuration page.

- **Link Browser**
  The Link browser is no longer built in GWT and is now built in core JavaScript.

- **Integration Platform 2.12.0**

- **Upgrade to AUI 3.5.0**

**Other Improvements**

As always, we have made various small improvements to Confluence screens, functionality and supported
platforms.

- **Microsoft Office 2010 support**
  The Office Connector now supports Microsoft Office 2010.

- **Chrome and Internet Explorer 9 Support**
  See the [upgrade notes](#) for more information about browser support.

- **Administrator's task list in the Admin Console**
  This new task list in the Admin Console helps administrators get started after a new install.

- **New keyboard shortcuts:**
  - CMD+S to save a page from the change comment field.
  - CMD+SHIFT+e to preview when you are in the editor; hit 'e' to get back to the editor.
  - CMD+SHIFT+d to display the Wiki Markup dialog.

- **Option to disable the "secure" cookie**
  When using HTTPS, you can disable the "secure" cookie, just for the login page.

- **Help tips in the administration screens**
  The help tips have been moved into the field descriptions.

- **Backup and Restore page**
  The Backup and Restore page has been redesigned.

- **404 page**
  The 404 page now has a dashboard breadcrumb.

- **Quicknav Improvements**
  Quicknav now indicates the space the page is coming from. This helps you find a page that might have the same title across multiple spaces, as well as selecting the first search result by default, making it quicker to open the link.

- **New Emoticons**
  Confluence 4.0 comes with a shiny new set of emoticons.

- **Remember Last Tab**
  Some of the feedback you gave us:
  "...I find it frustrating that "add a web link" is an extra click away after I open the link dialog. I use that at least as often as I link to another Confluence page..."
  We've taken some of the pain out of this process, by having the link browser remember the last tab you clicked. So if always use web links, it will always open to the web links tab for you. We're investigating taking this a step further, by allowing users to insert a web link from the "search tab as well."

- **Advanced Linking**
  We've updated the Link dialog to cater for these link types: shortcut links, anchor Links, and undefined links (which you can do via Autocomplete).
  To round out this improvement, we've implemented an "Advanced" tab in the Links Dialog. This basically covers the "remaining link types" that were available in Wiki Markup.

- **Improved Conflict Merging**
  Make this one sentence: Now if you're editing a page at the same time as someone else, Confluence will intelligently merge your changes with the other person's change when you save. This means you'll be seeing the "another user has made changes to this page since you started editing" warning a lot less often. In the cases where Confluence cannot merge the changes, it will show the diffs and prompt you to either overwrite or discard your changes. We've also made merging table conflicts much more reliable.

---

**Helping You Transition to Confluence 4.0**

We've created a set of resources to help you manage the transition away from wiki markup. We know your people have become experts with using wiki markup in Confluence, but we think you'll really appreciate the new editor, and we want to make it as easy as possible for you to make the change. The [change management resources](#) are listed under the current documentation.
Support for Macros that are not yet Confluence 4.0 Compatible
You can upgrade to Confluence 4.0 with macros that are not yet 4.0 compatible. If you upgrade and a macro is not yet 4.0 compatible, wiki markup will be maintained for that macro. Once these plugins are 4.0 compatible, an administrator will receive a new task in the administration console to run an update. We will have some more information on this shortly.

Copy and Paste Wiki Markup

Many people tell us they like to take notes in wiki markup, then paste them into Confluence. We've also spoken to customers who have lots of scripts that produce wiki markup and are manually inserted into pages. For these folks, we present the Insert Wiki Markup dialog. Simply select 'Wiki Markup' from the 'Insert' menu to launch the Wiki Markup dialog. From there you can insert any wiki markup, even macros.

"View Source" for the new editor

Some of you might be thinking, "what about the view wiki markup?". A lot of people used the View Wiki Markup option to see how pages were made and to copy the underlying markup. We've implemented "view source" (accessible from the Tools menu) so that you can see what macros were used to create the selected page and copy them to your own page.

We Welcome Your Feedback

To make it easy for you to provide EAP feedback we've created a simple "Got Feedback" button in the Confluence navigation bar:

Let the Confluence team know what you think of the EAP by providing feedback!

Upgrade Notes

Upgrading from a previous version of Confluence

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.

When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in Cache Performance Tuning) then you may run into memory problems during the wiki to XHTML migration. We are working to fix this in a later release, but in the meantime you can revert your ehcache.xml to the default version.

- If you still experience problems, try reducing the 'maxElementsInMemory' attribute on each cache to a very small value such as 50.
- Note that any cache changes you make to work around migration problems should only be considered temporary. You should restore caching to it's original settings again after migration has been successful.

Removed Functionality

Features removed from Confluence
The **Edit Page in Word** functionality
This is being removed in Confluence 4.0. **Note:** This is a different feature to "Edit attachment in Word".

**Mail Page Plugin**
The Mail Page plugin is no longer bundled in Confluence. With the introduction of the "Share Page" feature in 3.5 this is no longer needed.

**Social Bookmarking Plugin**
The Social Bookmarking plugin is no longer bundled in Confluence but is still supported.

**SnipSnap importer** has been removed from the admin console.

**Settings removed from Confluence**
- The **CamelCase Links** setting, from general configuration.
- The **Number of Ancestors to Show in Breadcrumbs** setting.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better!

**Confluence 4.0-m36 EAP Release Notes**

1 August 2011

Today we are happy to announce our third public EAP build for Confluence 4.0. An Early Access Preview (EAP) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance and provide us with some useful feedback. It also gives plugin developers an opportunity to test and fix their plugins in advance of an official release.

Please see previous 4.0 EAP release notes for the complete list of 4.0 changes:

- [Confluence 4.0-m27](#)
- [Confluence 4.0-m29](#)

**Highlights of Confluence 4.0 EAP:**

- [New Confluence Installer](#)
- [Improved Image Handling](#)
- [Links Dialog: Remember My Tab](#)
- [Improved Conflict Merging](#)
- [Set Page Location On Save](#)
- [Infrastructure changes](#)
- [We Welcome Your Feedback](#)

**More:**

- Read the [upgrade notes](#) for important information about this release.
- See the full list of [issues resolved in this release](#).

**Downloading the Confluence 4.0 EAP**

The Confluence 4.0-m36 EAP Release is available [here](#). When upgrading, please follow the [upgrade notes](#) below.
Warning: Do not use in production

- **EAP releases are not safe** — EAP releases are snapshots of the ongoing Confluence development process. As such:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because EAP releases represent work in progress, we can not provide a supported upgrade path between EAP releases, or from any EAP to the eventual final release. Thus, any data you store in a Confluence EAP release may not be able to be migrated to a future Confluence release.

## Highlights of this Milestone

### New Confluence Installer

Much to the delight of any sysadmins that are installing any new instances of Confluence, the Windows (.exe) and Linux (.bin) guided installers are now available.

### Simplified Installation Process

- **Guided installer**: The guided install wizard has been implemented for Confluence 4.0 on both Windows and Linux operating systems. Installing a new instance is a breeze.
- **Windows UAC support**: You will be prompted for elevated privileges in order to permit the full array of install options.
- **New instance vs Upgrade selection**: You can choose to install a new instance or upgrade an existing instance (the upgrade capability will be available in a subsequent release)
- **Install & Home directory selection**: Default folders are provided depending on the user being an admin/root or standard user (based on respective OS write permissions)
- **Port selection**: The ports in Confluence have changed! Take note: The default running port is now 8090 with the control port at 8009
- **Install as a service**: Assuming you have elevated privileges, you have the option on both Windows and Linux to install Confluence as a service. This is practical for production instances.
- **Evaluation license generation**: As a recap we added a simplified workflow in Confluence 3.5 to assist generating licenses for evaluators.

Sample screenshots below:
Easy JIRA Integration

- **Setup wizard process improvements**: Hook up Confluence with JIRA right within the in-app setup wizard (huge thanks to the Integration team for taking this work on)

Improved Image Handling

**Turn Images Into Links**

Now you can turn images into links. This is especially handy for turning images into a button like the Docs team is known to do. (Previously this was only available in wiki markup but can now be done in the shiny new Confluence 4.0 editor via the properties panel.) - We're still working on the link icon.
New Default Image Sizes
We've gotten a lot of feedback that there isn't much difference between the pre-set image sizes. So we've tweaked the sizes so you can choose from a wider range of options. Small remains the same at 100px, medium has increased slightly to 300px and large is now 500px.

Custom image sizes
If you don't like the pre-set image sizes you can now specify an exact image width:

Links Dialog: Remember My Tab
Some of the feedback you gave us:
...I find it frustrating that "add a web link" is an extra click away after I open the link dialog. I use that at least as often as I link to another confluence page...

We’ve taken some of the pain out of this by having the link browser remember the last tab you clicked. So if always use web links, it will always open to the web links tab for you. We’re investigating taking this a step further by allowing users to insert a web link from the “search tab as well.”

Improved Conflict Merging

This feature is back into Confluence 4.0. Now if you’re editing a page at the same time as someone else, Confluence will intelligently merge your changes with the other person’s change when you save. This means you’ll be seeing the “another user has made changes to this page since you started editing” warning a lot less often. We’ve also made merging table conflicts much more reliable.

Set Page Location On Save

We’ve heard a lot of feedback from new users that understanding where their page fits in the Confluence page hierarchy is not very intuitive. To help solve this problem when you create a new page and save it, users will be prompted and asked where they would like to save the page.

Infrastructure changes

- Remove ‘Thumbnail maximum height’ and ‘Thumbnail maximum width’ settings from the General Configuration page
- Update upgrade task to blow away thumbnails directory
- Link browser is no longer build in GWT and is in core JavaScript
- Upgrade Plugins to 2.8.0
- Integration Platform 2.12
- Update personal sidebar preference to use browser local storage instead of cookies
We Welcome Your Feedback

To make it easy for you to provide EAP feedback we've created a simple "Got Feedback" button in the Confluence navigation bar: 🎈<strong>GOT FEEDBACK?</strong> Let the Confluence team know what you think of the EAP by providing feedback!

Important Note - Comments Editor

You will notice in this milestone we have a new, simplified comments design. Please note - this design was experimental for internal dogfooding and will not be shipping in Confluence 4.0. It will be removed in the next EAP release.

Upgrade Notes

- **Upgrading from a previous version of Confluence.** Follow the normal upgrade instructions to upgrade your test instance to this release. **We strongly recommend that you back up your Confluence Home directory and your database before upgrading.**

- When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in Cache Performance Tuning) then you may run into memory problems during the wiki to XHTML migration. We are working to fix this in a later milestone release but in the meantime you can revert your `ehcache.xml` to the default version:
  - If you still experience problems you should try reducing the 'maxElementsInMemory' attribute on each cache to a very small value such as 50.
  - **Note** that any cache changes you make to work around migration problems should only be considered temporary. You should restore caching to it's original settings again after migration has been successful.

- Note that the 'Edit Page in Word' functionality of Confluence is being removed in Confluence 4.0.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

**Confluence 4.0-m29 EAP Release Notes**

**27 June 2011**

Following our first public EAP milestone of Confluence 4.0 earlier this month, we present you with our 2nd public EAP build. An Early Access Preview (EAP) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance and provide us with some useful feedback. It also gives plugin developers an opportunity to test and fix their plugins in advance of an official release.

**Highlights of Confluence 4.0 EAP:**

- Paste images into the editor (Firefox and Chrome)
- Drag to Insert Tables
- New "View Source" for pages and blogs
- Other Features and Improvements
- We Welcome Your Feedback

More:
• Read the upgrade notes for important information about this release.
• See the full list of issues resolved in this release.

Downloading the Confluence 4.0 EAP

The Confluence 4.0-m29 EAP Release is available here. When upgrading, please follow the upgrade notes below.

Default Port Number Change

The default port for the Confluence installer has changed from 8080 (http) and 8005 (shutdown) to 8880 and 8805 respectively. If you are upgrading from the previous EAP you may have to update your deployment configuration to reflect this change.

Do not use in production

- **EAP releases are not safe** — EAP releases are snapshots of the ongoing Confluence development process. As such:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because EAP releases represent work in progress, we can not provide a supported upgrade path between EAP releases, or from any EAP to the eventual final release. Thus, any data you store in a Confluence EAP release may not be able to be migrated to a future Confluence release.

Highlights of this Milestone

Paste images into the editor (Firefox and Chrome)

Just copy any image to your clipboard and hit CTRL-V in the editor. The image will get attached and embedded directly into your page. There's nothing to install on your desktop...it just works!

This is turned off by default at the moment. You'll need to turn it on from the Universal Plugin Manager.
Drag to Insert Tables

Inserting tables got even more "WYSIWYG" and easier with this feature. Just click on the new Table dropdown and drag your mouse to choose the number of rows and columns you want in your new table. Oh, and don't worry if you like inserting tables with your keyboard, you can still use autoformatting or CTRL+SHIFT+I to insert a table.

New "View Source" for pages and blogs
A lot of people used the "view wiki markup" option to see how pages were made and to copy the underlying markup. Now that wiki markup is gone, we've implemented "view source" (accessible from the Tools menu) so that you can see what macros were used to create the selected page and copy them to your own page.

Other Features and Improvements

- HTML Diffs can display a macro's icon
- Allow administrators to specify the number of reindexing threads at reindex time
- Render tables inside a wrapping DIV to make them easier to style in themes
- Implement end of link markers as a dark feature
- Expose image uploader in drag and drop plugin so it can be used by paste plugin

We Welcome Your Feedback
To make it easy for you to provide EAP feedback we've created a simple "Got Feedback" button in the Confluence navigation bar:

Let the Confluence team know what you think of the EAP by providing feedback!

Upgrade Notes

- **Upgrading from a previous version of Confluence.** Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.

- When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in Cache Performance Tuning) then you may run into memory problems during the wiki to XHTML migration. We are working to fix this in a later milestone release but in the meantime you can revert your ehcache.xml to the default version.
  - If you still experience problems you should try reducing the 'maxElementsInMemory' attribute on each cache to a very small value such as 50.
  - **Note** that any cache changes you make to work around migration problems should only be considered temporary. You should restore caching to its original settings again after migration has been successful.

- Note that the 'Edit Page in Word' functionality of Confluence is being removed in Confluence 4.0.

A big thank you to everyone who helps us ensure that Confluence keeps getting better and better.

Confluence 4.0-m27 EAP Release Notes

3 June 2011

With great pleasure, Atlassian presents our first public milestone of Confluence 4.0.

An Early Access Preview (EAP) release is a snapshot of our work in progress, primarily focused on allowing Confluence users to see the new features in advance and provide us with some useful feedback. It also gives plugin developers an opportunity to test and fix their plugins in advance of an official release.

Highlights of Confluence 4.0 EAP:

- Simplified Editing Experience
- Introducing Macro Placeholders and New Macros
- Autoformatting – Write Wiki Markup In the Editor
- New Wiki Markup Dialog
- Autocomplete Improvements
- Introducing Confluence Mentions
- Improved Table Operations
- Improved Page Comparison Functionality
- New Email Design
- New Editor Plugin Points for Developers
- Other Improvements
Infrastructure Changes
Helping You Transition to Confluence 4.0
We Welcome Your Feedback

More:
• Read the upgrade notes for important information about this release.
• See the full list of issues resolved in this release.

Downloading the Confluence 4.0 EAP

The Confluence 4.0-m27 EAP Release is available here. When upgrading, please follow the upgrade notes below.

Do not use in production
• EAP releases are not safe — EAP releases are snapshots of the ongoing Confluence development process. As such:
  • While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  • Features in development releases may be incomplete, or may change or be removed before the next full release.
• No upgrade path — Because EAP releases represent work in progress, we can not provide a supported upgrade path between EAP releases, or from any EAP to the eventual final release. Thus, any data you store in a Confluence EAP release may not be able to be migrated to a future Confluence release.

Highlights of Confluence 4.0

Simplified Editing Experience

We've rebuilt the Confluence editor from the ground up, to bring you an editing experience that's simpler, faster and more intuitive.

Below is some of the artwork proposed for the Angry Nerds website:

ANGRY NERDS
THIS DEV TEAM DON'T STAND FOR NO BUGS
• Just one editor!
• Left, Centre, Right align, without any macros.
• Indent paragraph blocks and lists from the toolbar.
• New Colour Picker.
• The user interface has been streamlined.

Introducing Macro Placeholders and New Macros

Confluence 4.0 introduces macro placeholders, a visual representation of your macros while editing. Create rich content with existing and new macros, but without them getting in the way.

Easy Macro Management

To make macros easier to manage when editing, the editor now uses macro placeholders. Placeholders offer the following advantages:

• Quick access to macro editing
  Edit the content of a macro directly in the editor, or double-click the placeholder to open the Macro Browser for parameter editing.

• Macro placeholder properties panel
  Every macro placeholder has a properties panel. The properties panels for particular macros, such as the Status and View File macros, have additional functionality, as described below.

New and Improved Macros

We've bundled more macros with Confluence, and made some of the existing macros better, to help you easily include and present relevant content:

• New: Status Macro
  The Status macro displays a coloured lozenge in the editor, so you can see the status directly. You can use the properties panel to change the status while editing, without having to use the Macro Browser.

• New: Expand Macro
  The Expand macro allows you to add a dynamically expandable section of text to your page.
  ```
<table>
<thead>
<tr>
<th>Expand</th>
</tr>
</thead>
<tbody>
<tr>
<td>This text in the body of this macro placeholder can be dynamically expanded when viewing the page...</td>
</tr>
</tbody>
</table>
  ```

• Improved: Include Page Macro
  The properties panel for the Include Page macro has a ‘Go to included page’ button that allows you to quickly check the page you have included, while still in the editor.
• **Improved: JIRA Issues Macro**
You can quickly open up the JIRA issue or filter, right from the editor, using the new 'View in JIRA' button in the properties panel.

• **Improved: View File Macro**
The placeholder for the View File macro displays an image according to the file type (for example PDF or Word file). And you can easily download the file while you are editing the page, using the new 'Download file' button in the properties panel.

**Autoformatting – Write Wiki Markup In the Editor**
Many of Confluence’s biggest fans are avid wiki markup users. For you aficionados, we wanted to give you the fastest editing experience possible, while preserving the speed and efficiency of your existing wiki markup skills. So, we present you with Autoformatting!
Autoformatting lets you type wiki markup into the editor and "auto-formats" your text on the fly. To learn more, click on the "?” help button in the editor and select the "Wiki Markup" tab.

Try these and see what you think:

- **Font Formatting**
  Bold, underline, strikethrough, italic, superscript, subscript – just type the markup, such as *Bold*, and watch it convert to **Bold** on the fly!

- **Basic Tables**
  Try typing |||||, or || Heading 1 || Heading 2 ||, then hit enter to get a table header like this:

<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
</table>

- **Emoticons**
  All of our emoticons convert on the fly. Try typing (/) in the editor to instantly see this: 😊.

- **Lists**
  For numbered lists, type # and a space at the start of each line.
  For bulleted lists, type * and a space at the start of each line.

- **Headings**
  Type h4. then some heading text to see a level 4 heading.

---

**New Wiki Markup Dialog**

Many people tell us they like to take notes in wiki markup, then paste them into Confluence. We've also spoken to customers who have lots of scripts that produce wiki markup and are manually inserted into pages. For these folks, we present the Wiki Markup dialog. Simply select 'Wiki Markup' from the 'Insert' menu to launch the Wiki Markup dialog. From there you can insert any wiki markup, even macros.
Autocomplete Improvements

Autocomplete uses wiki markup syntax to quickly link to content, embed images and other media and insert macros into the page. If you haven’t experienced autocomplete, you should see this blog post. Be sure to try the following:

New Page Links

 Quickly insert a link to create a page with Autocomplete for links. Simply type ‘[]’ in the editor and as you type, Confluence will display a Create Page link if a page with that title does not already exist in your current space.

Instant Link, Media and Macro Creation

Type [, ! or { in the editor to add various kinds of content to your page:

- The first item in the list is pre-selected to make editing even faster.
- The macro autocomplete list now loads much faster.
- The macro autocomplete list now inserts most macros directly, without launching the Macro Browser, unless the macro requires a parameter.

Introducing Confluence Mentions

Confluence 4.0 includes the new Mentions feature. This allows you to easily bring in collaborators to a conversation: if you are mentioned in any Confluence content (a page, blog, comment or status update), you will be notified by email.

To mention someone, type @ and their name, when editing. Mentions will first suggest people you are following in your network, so you can quickly find and involve your friends.
Improved Table Operations

We've made table operations better in Confluence 4.0 with the following features:

New In-Context Table Toolbar

The new table toolbar removes the need for a context menu and only appears when you add a table to the page.

New Table Operations

New table manipulation buttons are available for highlighting discrete cells, rows or columns and for copying or pasting rows.

Merge and Split Table Cells

You can now merge and split cells in a table. This feature satisfies the single most popular issue on our issue tracker!
**Improved Page Comparison Functionality**

We've got a better way to view changed content in Confluence.

**Improved Page Diffs**

We've simplified page diffs to make them easier to read. Additionally, page diffs now show changes to both formatting and macros.

**Diffs in Email**

Where possible, email notifications now show page differences as they appear in Confluence. These come through with the diff colour coding.

---

**Versions Compared**

<table>
<thead>
<tr>
<th></th>
<th>Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paul Watson</td>
<td>less than a minute ago</td>
</tr>
</tbody>
</table>

**Key**

- This line was added.
- This line was removed.
- Formatting was changed.

---

**Improved Page Diffs**

We've simplified page diffs to make them easier to read. Additionally, page diffs now show changes to both formatting and macros.

**Diffs in Email**

Where possible, email notifications now show page differences as they appear in Confluence. These come through with the diff colour coding.

---

**New Email Design**

All email notifications in Confluence now have a new design. This works in major email clients as well as on the iPhone.
New Editor Plugin Points for Developers

We've added more editor plugin points for developers. Notable improvements include:

Extend the Macro Property Panel

Plugin developers can add buttons to the Macro Property Panel in the editor. For example, insert a Gliffy diagram or see the tutorial on how to do this.

Render an Image in the Macro Placeholder

A plugin developer can render an image instead of a placeholder for bodyless macros. Here is an example, showing a Gliffy image rendered inside the editor:

For more information, check out the tutorial on how to do this.
Custom Parameter Rendering in Placeholders

You can choose to display any parameter in the macro placeholder in the editor, instead of having the placeholder automatically show the first few parameters.

New Pluggable Format Menu

Plugin developers can add items to the editor's Format menu. See this tutorial for details.

Other Improvements

As always, we have made various small improvements to Confluence screens and functionality.

- **Administrator's task list in the Admin Console**
  This new task list in the Admin Console helps administrators get started after a new install.

- **New keyboard shortcuts:**
  - CMD+S to save a page from the change comment field.
  - CMD+SHIFT+e to preview when you are in the editor; hit 'e' to get back to the editor.
  - CMD+SHIFT+d to display the Wiki Markup dialog.

- **Better Image Handling**
  In the Insert Image dialog, we've introduced the Search tab so you can insert images from other pages. And all images now embed as clickable thumbnails.

- **Option to disable the "secure" cookie**
  When using HTTPS, you can disable the "secure" cookie, just for the login page.

- **Help tips in the administration screens**
  The help tips have been moved into the field descriptions.

- **Backup and Restore page**
  The Backup and Restore page has been redesigned.

- **404 page**
  The 404 page now has a dashboard breadcrumb.

Infrastructure Changes

This release includes a number of improvements in the APIs and under the covers as well.

- **Support for Chrome**
  We now offer support for Chrome in Confluence 4.0. See the upgrade notes for more information about browser support.

- **API Changes**
  We have disabled the getPage() and getBlogEntry() read methods in the XML-RPC/SOAP API. If you have a script that primarily reads or appends to existing pages, it will break. Creating pages and overwriting existing pages will still work.

- **Upgrade to AUI 3.4**
  Confluence 4.0 uses AUI 3.4.

- **Anti-XSS Mode**
  Anti-XSS mode is now enabled by default for plugins.

- **Mail Page Plugin**
The Mail Page plugin is no longer bundled in Confluence.

- **Alignment and Border Parameters**
  The alignment and border properties in the macro definition template have been removed.

### Helping You Transition to Confluence 4.0

We've created a set of resources to help you manage the transition away from wiki markup. We know your people have become experts with using wiki markup in Confluence, but we think you'll really appreciate the new editor, and we want to make it as easy as possible for you to make the change. The change management resources are listed under the current documentation.

### Upgrade Notes

- **Upgrading from a previous version of Confluence.** Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you back up your Confluence Home directory and your database before upgrading.

- When upgrading from a previous version of Confluence, if you have customised your cache settings (as documented in [Cache Performance Tuning](#)) then you may run into memory problems during the wiki to XHTML migration. We are working to fix this in a later milestone release but in the meantime you can revert your `ehcache.xml` to the default version.
  - If you still experience problems you should try reducing the 'maxElementsInMemory' attribute on each cache to a very small value such as 50.
  - **Note** that any cache changes you make to work around migration problems should only be considered temporary. You should restore caching to it's original settings again after migration has been successful.

- Note that the 'Edit Page in Word' functionality of Confluence is being removed in Confluence 4.0.

A big **thank you** to everyone who helps us ensure that Confluence keeps getting better and better.

### Confluence 3.5-rc1 ("Release Candidate 1") Release Notes

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official
release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

⚠️ Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

Upgrade Procedure

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a
separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Previous Betas and Milestones

- **Confluence 3.5-beta3 ("Beta 3") Release Notes** – 4 March 2011
- **Confluence 3.5-beta2 ("Beta 2") Release Notes** – 4 March 2011
- **Confluence 3.5-beta1 ("Beta 1") Release Notes** – 10 February 2011
- **Confluence 3.5-m4 ("Milestone 4") Release Notes** – 22 December 2010
- **Confluence 3.5-m3 ("Milestone 3") Release Notes** – 17 December 2010
- **Confluence 3.5-m2 ("Milestone 2") Release Notes** – 7 December 2010
- **Confluence 3.5-m1 ("Milestone 1") Release Notes** – 22 November 2010

Bugs fixed

- **Scheduled jobs administration bug fixes**
- **Editor bug fixes**
- **Dashboard bug fixes**
- **User management bug fixes**
- **Other bug fixes**

Scheduled jobs administration bug fixes

- Fixed an unhandled exception in the scheduled jobs administration screen when Gliffy is installed.
- Removed the daily backup job from the scheduled jobs administration screen. It can still be controlled via the backups screen.
- Made wording changes in the scheduled jobs administration screen.

Editor bug fixes

- Fixed drag and drop not working properly in the editor in Internet Explorer.
- Fixed position of the comment editor, which was showing below the notation guide when using the Easy Reader theme.
- Fixed JavaScript error thrown by drag and drop in IE8 when native XMLHttp support is disabled.

Dashboard bug fixes

- Added backwards compatibility with 3.4 for dashboard-recently-updated macro parameters.
- Fixed problem: Unable to select certain category labels with special characters on the dashboard spaces and updates lists.

User management bug fixes

- Improved incremental license counting, so the licensed user count is now accurate immediately after adding or removing users.
- The old-style seraph group joining authenticators will now work with the new user management system, so users don’t have to edit their seraph-config.xml to get Confluence 3.5 working. We still recommend customers use the standard Confluence (or Crowd SSO) authenticators, and configure whether users from their directories should join groups when they log in through the User Directories administration console.
- Fixed migration of local groups with LDAP users.

Other bug fixes

- The "what's new" dialog will no longer show for milestone and beta development releases.
• Comments are back to being correctly imported during a site or space restore.
• Better handling of failure to create unique constraint in DB2.
• Fixed: Mail servers configured before Confluence 2.8 trigger ClassCastException when extracting email from name.
• French and German translations have been updated for 3.5.
• Space directory filter no longer removes search results on every keystroke.
• Space Directories will now show in two-column layout on screens with a resolution as low as 1024x768.
• Upgraded to Social Bookmarks plugin 1.3.8, to resolve sort ordering issues.
• Reduced memory footprint when loading bundled plugins and the demo site.

Known Issues
• The bundled Support Tools plugin does not start up and outputs a stack trace to the server logs at startup. This will be fixed in the final release.

Confluence 3.5-beta3 ("Beta 3") Release Notes

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

⚠️ Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.
Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

**Upgrade Procedure**

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Previous Betas and Milestones**

- [Confluence 3.5-beta2 ("Beta 2") Release Notes](#) – 4 March 2011
- [Confluence 3.5-beta1 ("Beta 1") Release Notes](#) – 10 February 2011
- [Confluence 3.5-m4 ("Milestone 4") Release Notes](#) – 22 December 2010
- [Confluence 3.5-m3 ("Milestone 3") Release Notes](#) – 17 December 2010
- [Confluence 3.5-m2 ("Milestone 2") Release Notes](#) – 7 December 2010
- [Confluence 3.5-m1 ("Milestone 1") Release Notes](#) – 22 November 2010

**New Features and Improvements**

**Highlights of this release:**

- Improved Crowd SSO configuration
- Bugs fixed

**Improved Crowd SSO configuration**

Confluence 3.5 now ships with everything you need to configure SSO when using a Crowd server for centralised user authentication. To enable this, administrators just need to:

1. Ensure the Crowd directory is configured in the User Directories administration console
2. Configure crowd.properties with the details for the Crowd server (including the application name and
password)

3. Configure seraph-config.xml with the new SSO authenticator:

```xml
<authenticator
    class="com.atlassian.confluence.user.ConfluenceCrowdSSOAuthenticator"/>
```

Customers with an existing Confluence 3.4 SSO configuration should not need to change anything for this to work, but we recommend all customers using SSO switch to use this new authenticator.

### Bugs fixed

- JIRA Issues macro can now show on a single line when it shows a single issue.
- Resolved issues migrating user configurations with multiple LDAP directories configured.
- Crowd System Password Encoders is now properly listed in the System Plugins section of the plugins administration console.
- Upgraded to Share plugin 1.5, to resolve javascript errors in IE7.
- Upgraded to Drag and Drop plugin 1.0.16, to resolve more corner cases.
- Fixed font sizes and colours in the Macro Browser and Preview dialogs.
- Fixed square buttons on dialogs on Mac OSX
- Insert image dialog shows previews once again
- Added migration for mail server configurations so customers with mail settings unchanged since Confluence 2.7 will still be able to send emails.
- Fixed invalid HTML markup for dashboard updates with profile pictures disabled

### Confluence 3.5-beta2 ("Beta 2") Release Notes

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

⚠️ Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

### Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

**Upgrade Procedure**

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Previous Betas and Milestones**

- [Confluence 3.5-beta1 ("Beta 1") Release Notes](#) – 10 February 2011
- [Confluence 3.5-m4 ("Milestone 4") Release Notes](#) – 22 December 2010
- [Confluence 3.5-m3 ("Milestone 3") Release Notes](#) – 17 December 2010
- [Confluence 3.5-m2 ("Milestone 2") Release Notes](#) – 7 December 2010
- [Confluence 3.5-m1 ("Milestone 1") Release Notes](#) – 22 November 2010

**New Features and Improvements**

**Highlights of this release:**

- [Support Tools Plugin](#)
- [Improved Share Button](#)
- [Improved Delegated LDAP User Directory Configuration](#)
- **Bugs fixed**
  - [Space Directory bug fixes](#)
  - [Other bug fixes](#)
- [Improvements for developers](#)
- [Known issues](#)

**Support Tools Plugin**
Support’s Support Tools Plugin is now bundled into Confluence. It provides a log analyser to help sysadmins identify known issues with their instance, and a new improved support request feature.

**Improved Share Button**

We’ve improved the new "Share" button introduced in Confluence 3.5. Notable changes:

- **Share with email**
  You can now easily share a page with someone by entering just their email address.

  ![Share Button Screenshot](image)

- **Share for blog posts**
  The Share button now works for blog posts as well as pages.

- **New email style and short link in email**
  We’ve been using the Share button as an opportunity to explore some new email notification designs.

  ![Email Notification Screenshot](image)

We hope to follow this format for all the other email notifications in the near future. Additionally, to make sure your link doesn’t break we now email users the "short link" for a Confluence page instead of the full page URL.

**Improved Delegated LDAP User Directory Configuration**

We have added an option to copy users automatically from the LDAP server to Confluence when they authenticate for the first time. Copied users can also be assigned automatically to default groups.
Users in directories marked as “Read Only, with Local Groups” can also automatically be added to default groups.

Bugs fixed

**Space Directory bug fixes**

- Search filters now fire more reliably, and results are now sorted by the DB, reducing result rendering time
- Only team categories are shown for each space, rather than personal labels or favourites.
- We now show personal space icons rather than the generic space icon.
- Pagination fixes

**Other bug fixes**

- Performance results are much improved across the board.
- Probably the last ever WYSIWYG round-trip bug fix: the HTML macro now safely round-trips its content ([CONF-8441](#)).
- The demonstration space (example site) has been updated with content for Confluence 3.5
- Reshuffled administration console entries, so that security is no longer the top of the list.
- Fixed a bug with watch all blog posts for space receiving notifications for any change, not just blog posts. Also fixed who is listed as watching the space, rather than watching just the blog posts on that space.
- Fixed notification emails showing the wrong unsubscribe links for space blog watches.
- The username for anonymous users can now be translated for email notifications.
- Notifications are now sent using the right locale.
- Global logo descriptions will now be autogenerated, if none was found.
Errors from the old lucene index format should now be much less verbose or worrying.

Child page lists are now loaded via AJAX, rather than on initial page render. Users no longer have to wait for a page refresh to expand this list.

Fixed a bug where malformed label names were always reported as being too long.

Upgraded to Tomcat 6.0.32 in the Confluence distribution.

Upgraded to Social Bookmarks Plugin 1.3.7.

Upgraded to Drag and Drop Plugin 1.0.15.

Upgraded to Plugin Framework 2.7.1, to reduce the amount of logging for some minor issues.

**Improvements for developers**

- Added support for EventPublisher @EventListener style listeners to the listener plugin module descriptor. Developers can now configure their listeners in their atlassian-plugin.xml using the standard:

  ```xml
  <listener name="Something Happened Listener" key="SomethingHappenedListener" class="com.example.SomethingHappenedListener">
    <description>Listener for something happened events</description>
  </listener>
  ```

**Known issues**

**Local users cannot log in when using Crowd or Delegated LDAP**

Whatever directories appear after a Crowd or Delegated LDAP directory in the User Directories admin UI will not be consulted, as these two directories currently throw an authentication-failed error, rather than a user-not-found error for users they do not contain. This is being fixed in Crowd now, and will be included in the next build.

**Migration error when importing from backup ([CONFDEV-3172](#))**

The performance fix for caching crowd Application objects introduced this issue. It's fixed in Crowd now, and will be included in the next build.

**What's New showing for beta software**

The What's New dialog should not be enabled on a beta install of Confluence, but it is. We're investigating why, and will have a fix before we build another beta/milestone.

**Local groups are not imported when doing in place upgrades or restoring from backup**

Users currently have to be manually reassOCIated with their old groups. We're working on fixing it!

**Note about CONFDEV issues**

The Confluence team is using an internal JIRA project for tracking development with GreenHopper. The CONFDEV issues refer to our internal tracking numbers for user stories or bugs discovered and fixed within the scope of a release.

**Confluence 3.5-beta1 ("Beta 1") Release Notes**

Confluence versions marked "Milestone", "Beta" or
"Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.
Upgrade Procedure

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Previous Milestone(s)

- [Confluence 3.5-m4 ("Milestone 4") Release Notes](#) – 22 December 2010
- [Confluence 3.5-m3 ("Milestone 3") Release Notes](#) – 17 December 2010
- [Confluence 3.5-m2 ("Milestone 2") Release Notes](#) – 7 December 2010
- [Confluence 3.5-m1 ("Milestone 1") Release Notes](#) – 22 November 2010

New Features and Improvements

Highlights of this release:

- "What's New"
- Revised Dashboard Layout
- New Insert JIRA Issue dialog
- Improved JIRA issues macro
- Share a Page
- More Notification Improvements
  - One-click 'stop watch' links
  - Even more improvements
  - Space Blog Watches
- Drag-and-Drop Improvements
- New (code) macro
- Space Directory Improvements
- Scheduled Job Administration
- Applinks
- Performance / Stability
- Security
- Other improvements
- Small Improvements Gallery

"What's New"

When a user first logs in to Confluence 3.5, they'll be presented with an AUI dialog box promoting new product features. (We aim to eventually work this feature into all our products.)

The content on this dialog is retrieved from Atlassian's web servers - the following screenshot is a mockup of what the final dialog box might look like.
Like other products that encourage you to actually read their release notes before continuing, the What's New dialog will keep appearing on login until the user clicks "Don't show again". However, you can always access this dialog box again from the Browse Menu:

Revised Dashboard Layout

Previously in Confluence, you could filter the "Recently Updated" section on your dashboard by selecting a tab in the spaces list. For example, clicking on the Favourite tab in the spaces list on the left would limit recent updates on the right to your favourite spaces only).

This was a source of confusion for many users not expecting a tab change on the bottom left to update the recent updates on the top right.

To address the issue, the recent updates section has been given its own set of tabs (which now function independently of the spaces list). In the process, the tabs were also given a face lift and the recent updates section now takes up the entire right hand side of the dashboard.

New Insert JIRA Issue dialog

If you have configured one or more application links (aka 'applinks') to a JIRA server, you can insert a JIRA Issue link into your Confluence page while you're editing the page. You can access this feature via a new JIRA
button on the editor toolbar.

When you click it or press Ctrl + Shift + J, you get:

From here you can:
- Embed recently viewed issues
- Create a new issue
- Search for issues

Improved JIRA issues macro

Completely overhauled to support applinks, the JIRA issues macro now supports a single issue key, multiple comma separated issue keys or a JQL query. We’ve also changed the macro to use the name “jira” (although “jiraissues” will still work).

Finally, the macro now supports OAuth-based authentication from Confluence to JIRA. Note that all new features of the JIRA issues macro require a JIRA application link to be configured.

Here are some examples of using the improved JIRA issues macro:

<table>
<thead>
<tr>
<th>What you type</th>
<th>What you get</th>
</tr>
</thead>
<tbody>
<tr>
<td>{jira:JRA-9}</td>
<td></td>
</tr>
<tr>
<td>{jira:assignee=currentUser()}</td>
<td>a table with all issues assigned to you</td>
</tr>
<tr>
<td>{jira:JRA-9,JRA-10,JRA-12}</td>
<td>a table containing the individual issue keys listed</td>
</tr>
</tbody>
</table>

Share a Page

How many times have you copied a page link, pasted it into an email and sent it off to someone with a little note? The new "Share a page" feature makes this common activity super quick.
More Notification Improvements

One-click ‘stop watch’ links

- **Ask and you shall receive** - Clicking the ‘Stop watching this page’ link in email notifications now automatically removes the watch for you without requiring a confirmation. You can still undo this if you clicked the link by accident.

Even more improvements

- **Straight to edit mode** - Clicking the ‘Change notification preferences’ link now takes you directly to edit mode for your email preferences.
- **More information** - We've added more information at the bottom of email notifications for when you're watching all blogs.
- **Links in Plain text** - The stop watch links have been made available for those of you receiving emails in plain text.

**Space Blog Watches**

**CONF-6478** is a highly voted for issue, with over 100 votes. The idea is that blog posts are newsworthy updates so you might want to get email notifications for new blog posts without getting emailed for all other activity in the space.
Drag-and-Drop Improvements

**Powered by HTML 5** - Drag-and-drop is now powered by HTML5. That means:

- Drag-and-drop works in all browsers, including Chrome!
- If you use a browser that fully supports HTML 5, you'll never get that annoying prompt to install Gears again. It just works.

**Drag-and-drop multimedia files** - Confluence 3.5-m4 introduced the Multimedia Macro. In this release we added drag and drop - Dragging a multimedia file onto a page will automatically insert the multimedia macro for you.

**New {code} macro**

The newcode macro project has now been bundled into Confluence, replacing the original code macro in atlassian-renderer. The new code macro has a number of improvements over the original macro (wider syntax support, copy/paste without getting line numbers in the clipboard).

Space Directory Improvements

We've improved the Space Directory since last milestone. Notable additions since then are:

- Clicking on the space category now switches tabs to that category
- Partial name search in space directory

Scheduled Job Administration

A new Confluence administration screen to monitor, and manage scheduled jobs. This is available through the "Scheduled Job Administration" link in the Confluence admin console. Here are some screenshots:
Applinks

The first cut of applinks has been integrated into Confluence. We will use this as the basis for delivering deeper JIRA integration later in this release.

Performance / Stability

A cache has been added to store page diffs. This should prevent the situation where RSS feeds with diffs can slow down Confluence.

Security

The underlying user management code has been updated so that it now enforces permissions on directories at a low level. This means remote API calls that create or modify users or groups on read only directories will fail and no longer write to the directory as they did in previous 3.5 milestones.

Other improvements

- Fix CSS vendor prefix antipattern
- Multimedia macro UX/UI improvements
- Media items in the image/media autocomplete now display an appropriate icon
- Change Team Labels to Space Categories
- Change blue collapsing arrows to grey
- Display the default welcome message on the General Configuration Admin page
- Display default contact administrator message on General Configuration admin page
- Fix for broken fonts on Windows
- Upgrade to AUI 3.3
- Fix and improve printing DOC theme in IE7
- Log in and Sign up links misaligned
- Capitalise the first letter of category labels in the spaces list and recently updated dashboard macros

Small Improvements Gallery

Bugs fixed
**MySQL Configuration Change Required**

The default transaction isolation mode of MySQL will cause issues with missing LDAP and other remote directory user permissions, and is no longer supported. Users must reconfigure their MySQL instances to use READ_COMMITTED instead. See MySQL Crowd configuration for instructions.

---

**User management bug fixes**

- CONFDEV-2404 - Fix migration of crowd user directories
- CONFDEV-2068 - Infinite redirect during login for users with confluence admin but not system admin permission
- CONFDEV-1638 - Fix duplicate initialisation of application object
- CONFDEV-1414 - User Directories menu option should only appear for system administrators

**Drag and drop bug fixes**

- CONFDEV-2711 - Drag and Drop should indicate multiple file uploads
- CONFDEV-2155 - Drag and drop produces incorrect file size if the file already exists

**Other bug fixes**

- CONFDEV-2678 - Blog comment links contain {0}

**Improved Thumbnail Rendering**

- Thumbnails for transparent images (PNG & GIF) now render properly.
- Thumbnail rendering does not cause OOM errors even if the image is very large by delegating to a stream based renderer (this should solve the problem mentioned in Studio Multi-Tenant Reliability Proposal)

---

**Improvements for developers**

- CONFDEV-2730 - Bump AUI version from 3.3.0 to 3.3.1
- CONFDEV-2359 - Crowd upgraded to 2.2.0-m4. Embedded Crowd upgraded to 1.0-alpha26

**Known Issues**

- Insert JIRA issue dialog does not work if you are running confluence on the root context path. For example, http://servername, instead of http://servername/confluence. You can download a new version [here](http://servername/confluence) that fixes it
- Imports from XML site backups may not work under certain circumstances if running an Oracle database.
- Installers for Mac and Windows have not been released for this version. They will be released for beta 2.

**Note about CONFDEV issues**

The Confluence team is using an internal JIRA project for tracking development with GreenHopper. The CONFDEV issues refer to our internal tracking numbers for user stories or bugs discovered and fixed within the scope of a release.

**Confluence 3.5-m4 ("Milestone 4") Release Notes**

*For testing use only*

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.
Who should upgrade?

⚠️ Please note the following
- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](https://confluence.atlassian.com) to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the [development releases page](https://confluence.atlassian.com) on the Atlassian website.

**Previous Milestone(s)**

- [Confluence 3.5-m3 (“Milestone 3”) Release Notes](https://confluence.atlassian.com)

**Features**

**Notification Improvements**

We have continued work further notification improvements in this milestone. Notifications about changes are now sent with From address of the email including the name of the user who made the change. This behaves the same as in JIRA and should make it a lot easier to decipher Confluence notifications in your inbox.
The format of the From address used in emails can be customised by Confluence administrators under the Mail Servers configuration, using the same formats as in JIRA. The default format is "<user’s full name> (Confluence)".

**Automatic Language Detection**

This milestone includes the ability to select a user's preferred language automatically, by respecting the Accept-Language header which the user's browser sends. Unless a language preference has been made in the profile settings, the closest matching language to the one suggested by the browser will be used.

**New Space Directory**

One of the biggest problems facing customers with large installations of Confluence is the scalability of the dashboard. It's a well-known problem that the list of spaces on the dashboard doesn't scale for sites with more than a few dozen spaces. We've added a new screen called the Space Directory where you can browse every space without having to use the Dashboard.

The Space Directory will eventually make the 'All' list of spaces on the dashboard obsolete, and make the performance of the dashboard much better for our large customers.

**Multimedia Autocomplete**

We have also continued work on editor improvements for Confluence 3.5. In this milestone, you can now embed multimedia files into your page via autocomplete. Try it out by hitting “!” in the editor and entering the name of a movie file attached in Confluence.

**Remote API for Watching and Managing Watchers**

We've added a bunch of new methods into the Confluence SOAP and XML-RPC APIs for watching and
managing watchers. The new methods in the remote API mimic the watch functionality exposed through the UI:

- `boolean watchPage(String token, long pageld)` – watch a page or blog post, returns false if a space, page or blog is already being watched
- `boolean watchSpace(String token, String spaceKey)` – watch a space, returns false if the space is already watched
- `boolean watchPageForUser(String token, long pageld, String username)` – add a watch on behalf of another user (space administrators only)
- `boolean isWatchingPage(String token, long pageld, String username)` – check whether a user is watching a page (space administrators only, if the username isn't the current user)
- `boolean isWatchingSpace(String token, String spaceKey, String username)` – check whether a user is watching a space (space administrators only, if the username isn't the current user)
- `RemoteUser[] getWatchersForPage(String token, long pageld)` – return the watchers for the page (space administrators only)
- `RemoteUser[] getWatchersForSpace(String token, String spaceKey)` – return the watchers for the space (space administrators only).

There's also a very obscure old method called `getBlogEntryByDayAndTitle` which only allowed you to look up a blog post in the current month. We've added a new method to look up any blog post by date and title:

- `RemoteBlogEntry getBlogEntryByDateAndTitle(String token, String spaceKey, int year, int month, int dayOfMonth, String postTitle)` – retrieve a blog post by specifying the date it was published and its title.

**Small improvements**

- CONFDEV-1792 - Change edit-page "comment" to "what did you change? (user testing showed that "comment" was confusing)
- CONFDEV-1614 - Change link styling in Confluence
- CONFDEV-1409 - New set of avatars
- CONFDEV-977 - Add tips at the bottom of all dialogs for which there's a keyboard shortcut

**Bug fixes**

**Multimedia Macro bug fixes**

- CONFDEV-1955 - Fixed the help link in the multimedia macro

**User management bug fixes**

- CONFDEV-1682 - Attempting to remove an LDAP group in Confluence UI throws an unhandled exception
- CONFDEV-1499 - Update the message shown to users when there are more users than the license allows

**Other bug fixes**

**Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.**
• CONFDEV-1936 - Removed the BundleUserMacrosUpgradeTask upgrade task as it wasn't needed
• CONFDEV-1924 - Fixed broken personal sidebar layout in documentation theme
• CONFDEV-1855 - (attachments) macro ordering reversed
• CONFDEV-1840 - Support zip should no longer be created when atlassian-user.xml doesn't exist
• CONFDEV-1805 - External gadget urls don't work for https
• CONFDEV-1742 - LuceneUtils has very verbose warnings when index is using old format

Improvements for developers
• CONFDEV-1896 - Updated AUI to 3.2.1
• CONF-21462 - Plugin authors can now sign their plugins
• CONFDEV-1877 - Fix Confluence in IDEA 10: webapp has compile dependency on confluence core

Known issues
• CONFDEV-2112 - Spaces with custom decorators built after 3.5-m3 fail with an error
• CONFDEV-2120 - Logos don't work in the Space Directory

Note about CONFDEV issues
The Confluence team is using an internal JIRA project for tracking development with GreenHopper. The CONFDEV issues refer to our internal tracking numbers for user stories or bugs discovered and fixed within the scope of a release.

Confluence 3.5-m3 ("Milestone 3") Release Notes

⚠️ For testing use only
Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following
• Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  • While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  • Features in development releases may be incomplete, or may change or be removed before the next full release.
• No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.
However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the [development releases page](#) on the Atlassian website.

**Previous Milestone(s)**

- Confluence 3.5 Milestone 2

**Features**

*HTML5, character encoding and IE rendering mode*

A bundle of small markup improvements have been made for Confluence 3.5-m3:

- Confluence's DOCTYPE declaration has been switched from HTML 4.01 Strict to HTML5, which is automatically strict as well.
- X-UA-Compatible is now explicitly set to EDGE, to ensure IE always renders in latest standards mode
- Character encoding is now set at the document level according to the encoding setting in General Configuration

**Multimedia Macro**

The new multimedia macro has been expanded to support many more file types. You can now embed MP3, MOV, AVI files and many more. Try it out by searching for 'multimedia' in the macro browser.

**User management improvements and bug fixing**

- CONFDEV-1642 - Membership caching handles nested groups correctly
- CONFDEV-1636 - Build against Crowd 2.1.0 release version
- CONFDEV-1441 - Test migration of user preferences when upgrading
- CONFDEV-1318 - Handle exception when removing a directory that is synchronising

**Notifications bug fixing**

- CONFDEV-1819 - Unwatching a page via email no longer says "Stopped watching 'null'"

**Administrative improvements**
• **CONF-3987** - Confluence now respects `atlassian.mail.senddisabled` and `atlassian.mail.featuredisabled`, as in JIRA
• **CONF-21323** - Improved RSS feed contextual logging information (also in 3.4.5)

**Small improvements**

• CONFDEV-977 - Tips displayed for dialogs with keyboard shortcuts
• CONFDEV-1023 - Title colour attribute added to panel macro
• CONFDEV-1013 - Include page macro is now able to render blog posts
• CONFDEV-1409 - New set of standard profile pictures

**Small improvement screenshots**

![Small improvement screenshot](image)

**Bug fixes**

• **CONF-21144** - Copy and paste of emoticons is working again (also in 3.4.5)

**Performance Fixes**

• **CONF-21376** - Improve performance of attachments in RSS feeds (also in 3.4.5)

**Known issues**

• CONFDEV-1924 - Personal sidebar looks broken in documentation theme

**Note about CONFDEV issues**

The Confluence team is using an internal JIRA project for tracking development with GreenHopper. The CONFDEV issues refer to our internal tracking numbers for user stories or bugs discovered and fixed within the scope of a release.

**Confluence 3.5-m2 ("Milestone 2") Release Notes**

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

**Who should upgrade?**
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the [development releases page](#) on the Atlassian website.

**Previous Milestone(s)**

- [Confluence 3.5 Milestone 1](#)

**Features**

*Improved Notifications*

_Autowatch your content_

How many times have you created a page or blog post and then forgot to watch it? Confluence now lets you automatically watch any pages you add, edit or comment on. This is turned on by default for all new users and upgraded users (yes, that means you!), and you can turn off autowatch via your Email Settings page.
Enabling this setting will improve your ability to keep track of your contributions on the wiki:

- Automatically watch any page/blog post that you add
- Automatically watch any page/blog post that you edit
- By default, have the 'watch this page' checkbox ticked when you write a new comment.

**Easier to stop watching content**

Getting too many emails from Confluence? In this milestone, we've made it much easier to stop watching pages, spaces and users. When you get a notification email now, (most of the time) there's a handy link at the bottom allowing you to quickly unsubscribe from your existing watches. The link will change depending on why you got the email in the first place (e.g. whether you were watching the space, page or network).

The link takes you straight to your Manage Watches page (for space and page watches) or to your network page (for users you follow) and gives you a prompt to easily remove the appropriate watch:

These notification improvements are the result of a 20% project by Anna Katrina Dominguez, who joined our team earlier this year. The project is still a work-in-progress, so please let us know what you think as per the Feedback section below.

**Multimedia Macro**

Previously, the only way to embed multimedia items (videos and audio) in Confluence was through Wiki Markup. This milestone introduces a new *multimedia macro* so you can embed multimedia using the macro browser, eliminating the dependency on wiki markup. The first cut of this macro only supports SWF files but we will be adding support to more formats and advanced settings in later milestones. This macro is available via Autocomplete for Macros and the Macro Browser.
Small Improvements

- Previously, it was not possible to differentiate between two gadgets with the same name and description. We’ve now updated the macro browser to show a gadget’s URL so users can more easily distinguish between gadgets with the same name and description (CONF-17991):

Note: This style will change slightly in a later milestone.

- Minor UI tweaks:
  - Black headings on the dashboard for consistency with other Atlassian applications
  - All dialog close and cancel buttons have now been changed to links

- When adding a new user macro, the template field is shown pre-populated with a simple example
• Prototype and Scriptaculous libraries have been removed. This can lead to a minor improvement in page load time.
• The number of images requested on the dashboard have been reduced leading to a small improvement in dashboard load time.

**Performance Fixes**

• Re-enabled caching of PropertySet results. This will allow high performance lookups of UserPreferences once again.
• Added caching for plugin module descriptors inside the plugin framework. All callers of the PluginAccessor methods that return these objects should see a noticeable improvement in lookup time.

With these fixes, page rendering is now much faster than m1 – more than 100ms in our own testing – and roughly on par with 3.4.x. Work continues to make performance even better.

**Bugfixes**

• [CGP-153](#): Gadget security token is "malformed" when page is open for a long time
• [CGP-155](#): Gadget dialog close button should be a link

**Known issues**

• [CONFDEV-1742](#): Lots of error messages generated until reindex is completed
• [CONFDEV-1752](#): Card and deck macros no longer work properly
• [CONFDEV-1686](#): Unless you've come from an email link, the Watches page always shows 'You have already stopped watching "null".'

**Feedback**

We'd love to hear any feedback you have from testing this milestone of Confluence. Please raise any issues you discover in [our issue tracker](#) against the Confluence project with affects-version "3.5 (EAP)", or comment on this page.

**Confluence 3.5-m1 ("Milestone 1") Release Notes**

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use [the latest official release](#).

This release is a public development release ("milestone") leading up to the next Confluence major release.
Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following
- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the development releases page on the Atlassian website.

**Previous Milestone(s)**

This is the first milestone in Confluence 3.5 development.

**Features**

*Improved user management – better LDAP support and more*

This milestone includes the first release of the new improved user management in Confluence trunk bringing a number of significant user management improvements to Confluence:

- **Support for nested groups in LDAP, the most highly-voted issue for Confluence** ([CONF-17150](#))
- Much improved support for LDAP integration, with configuration UI for administrators and many bug fixes
- Predefined configuration settings for all LDAP servers supported by Confluence and Crowd
- Improved performance and consistent behaviour across all remote directory types – LDAP, Crowd and
JIRA – through a new database-backed storage and periodic synchronisation system

- New, faster database schema for user management with improved foreign keys, constraints and indexes
- Integrated support for JIRA as a user management system, supporting JIRA 4.2 and earlier via read-only JDBC access, and JIRA 4.3 and later via read-write REST API
- Integrated support for Crowd as a user management system, offering a new faster REST API with Crowd 2.1 and later
- Improved permission checking performance (CONF-20475)
- Improved user management caching, with fewer bugs and better performance
- Read-write LDAP support for most LDAP servers
- In-application testing of LDAP configuration before saving
- Consistent UI for user management configuration in JIRA 4.3+ and Confluence
- Automatic migration from `atlassian-user.xml` and `crowd.properties` configuration into the new administration UI for all supported configurations (not yet complete)
- Data migration for users, groups, memberships and user preferences into the new database schema (not yet complete).

That said, there is still a bit of work to get this ready for release. Outstanding work on user management for Confluence 3.5 includes:

- Further work on performance improvement
- Completion of work on testing and documenting the upgrade process for all the supported existing user management configurations
- Improving a few areas of our user management with the new search and management APIs
- Writing automated tests to verify several of the new features are actually fixed and working correctly. (All are automatically tested in isolation, but not in Confluence.)

**Feedback welcome.** If you can test an upgrade of Confluence in your test environment and Confluence does not correctly upgrade your user management configuration or data, we would love to hear from you. Please raise an issue as covered in the **Feedback** section below.

**Screenshots**

**Documentation theme improvements**

We have added a neat improvement to the [Documentation theme](http://example.com) where you can configure the search box to limit searches to the current space by default. We think this will be really useful for knowledge base or documentation spaces, where searching in the current space is the most common use case.

- You configure the search setting in the theme configuration screen:
To override the space-specific search when entering your search terms, you can prefix the search with 'all:' or just change the filter setting when you arrive at the search page.

**Keyboard shortcut improvements**

Building on top of the Confluence 3.4 keyboard shortcut improvements:

- 'I' – New keyboard shortcut added to show/hide the Documentation theme's sidebar. This shortcut is the same as the one used in the Issue Navigator in JIRA 4.2, and is handy for getting a quick glimpse of the full content of a page.
- 'k' – When you open the 'Link to this page' dialog, the 'Tiny Link URL' is now automatically selected in Chrome and Safari. Previously, it only worked this way in Firefox and Internet Explorer.

![Link to this Page](image)

**Other improvements**

The dashboard icons now use CSS sprites, which should make for faster initial and subsequent load times when viewing the Confluence dashboard.

**API changes**

The user management changes have results in significant API changes in this area of the application. Specifically, the following change has broken some of our plugin test code:

- To modify an existing user, you need to create a new `com.atlassian.user.impl.DefaultUser` instance to call `setFullName()` or `setEmail()` because these methods are no longer on the `com.atlassian.user.User` interface.

We aim to preserve complete backwards-compatibility for plugins where possible, so please raise an issue if your plugin is broken in a way that cannot be backwards-compatible.

**Feedback**

We'd love to hear any feedback you have from testing this milestone of Confluence. Please raise any issues you discover in [our issue tracker](#) against the Confluence project with affects-version 3.5.

**Release Notes 3.4-beta1 ("Beta 1")**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Previous Milestone(s)

Previous milestones in the 3.4 release:

- Release Notes 3.4-m4 ("Milestone 4")
- Note: 3.4-m3 was not released due to some critical bugs.
- Release Notes 3.4-m2 ("Milestone 2")
- Release Notes 3.4-m1 ("Milestone 1")

Features

There are no new features in this release, it's mostly improvements and bug fixes to prior releases.

Other Improvements

- Universal Plugin Manager has been upgraded and minor issues addressed
- Browse > Advanced > PDF/HTML/XML Export page layouts updated for spaces.
- Dropdown menu containing 'select all' and 'deselect all' options added to Edit Space Permissions form. (CONF-7817)

- New AUI version includes new, redesigned shadows (now true drop shadows rather than the old three-side shadow effect)

Known issues

- AUI drop shadows disabled in IE while a Confluence bug is resolved (this means no shadows on dropdowns and dialogs in IE for beta1)
- IE renders some JavaScript errors for the new keyboard shortcuts

Improvements

<table>
<thead>
<tr>
<th>Improvements in 3.4-beta1 (6 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>![ ]</td>
</tr>
<tr>
<td>Child Page with the Same Page as a Parent</td>
</tr>
<tr>
<td>------------------------------------------</td>
</tr>
<tr>
<td>CONF-2020 4</td>
</tr>
<tr>
<td>The URL context and source IP (and headers?) should be logged when an login fails</td>
</tr>
<tr>
<td><a href="#">Resolve</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Slimmer Blog Pushes Long Titles Down in Global Spaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-19279</td>
</tr>
<tr>
<td>Slimmer blog pushes long titles down in global spaces</td>
</tr>
<tr>
<td><a href="#">Resolve</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Browse &gt; Advanced &gt; Export Page Layouts Lack Elegance</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-16013</td>
</tr>
<tr>
<td>Browse &gt; Advanced &gt; Export page layouts lack elegance</td>
</tr>
<tr>
<td><a href="#">Resolve</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Provide Select-All and Deselect-All Options in Edit Space Permissions Dialogue (or &quot;Remove User&quot;)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-7817</td>
</tr>
<tr>
<td>Provide select-all and deselect-all options in Edit Space Permissions dialogue (or &quot;remove user&quot;)</td>
</tr>
<tr>
<td><a href="#">Resolve</a></td>
</tr>
</tbody>
</table>

## Bug Fixes

### Bugs Fixed in 3.4-beta 1 (6 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="https://example.com" alt="bug" /></td>
<td>CONF-2084 1</td>
<td>Update Advanced Macros to 1.11, two issues fixed in this release</td>
<td><a href="#">Resolve</a></td>
</tr>
</tbody>
</table>

| ![bug](https://example.com) | CONF-2075 4 | License Details: Links in error message are broken. | [Resolve](#) |

<p>| <img src="https://example.com" alt="bug" /> | CONF-2036 | A user can                                | <a href="#">Resolve</a> |</p>
<table>
<thead>
<tr>
<th>#</th>
<th>Issue ID</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>CONF-2029</td>
<td>Dropshadow missing from dashboard dropdown</td>
<td>Resolve d</td>
</tr>
<tr>
<td>9</td>
<td>CONF-2019</td>
<td>Property Panels, Autocomplete have lines in the corners that shouldn't be there in IE</td>
<td>Resolve d</td>
</tr>
<tr>
<td>9</td>
<td>CONF-1389</td>
<td>Tooltip showing number of attachments is showing for all items in the Browse menu</td>
<td>Resolve d</td>
</tr>
</tbody>
</table>

**Release Notes 3.4-m4 ("Milestone 4")**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Previous Milestone(s)

Previous milestones in the 3.4 release:

- Note: 3.4-m3 was not released due to some critical bugs.
- Release Notes 3.4-m2 ("Milestone 2")
- Release Notes 3.4-m1 ("Milestone 1")

Features

Keyboard shortcuts dialog

Confluence now has a keyboard shortcuts dialog. This dialog is accessible by pressing '?' on your keyboard or going to Browse > Keyboard Shortcuts.

![Keyboard Shortcuts dialog](image)

New Keyboard shortcuts

- 'e' to edit
- 'm' to comment
- 'l' to label
- '/' to quick search
- 'g' then 'd' to go to the dashboard
- ... and lots more. Go to Browse > Confluence Keyboard Shortcuts to discover more of them...

Note: There are some known issues with Safari for Mac, but we are ironing them out and they should be fixed next release. Some of these keyboard shortcuts are likely to change.

Notable Bug Fixes

- Preview in FireFox now works
- Move page dialog now works

Other Improvements

- Recently updated on dashboard now tells you what the user did (eg updated, commented) and has a timestamp for each activity.
  Note: The space description no longer renders wiki markup
- UPM has been upgraded to the latest milestone
- Browse > Advanced > Space details form has been converted to AUI style forms

**Improvements**

<table>
<thead>
<tr>
<th>Improvements in 3.4-m4 (5 issues)</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
<td>Summary</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2074</td>
<td>Improve sitesmeh decoration performance</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2068</td>
<td>Update Confluence Dashboard Macros to version 1.16, 2 issues fixed in this release</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2060</td>
<td>websudo annotation backwards compatibility (Confluence 3.3)</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2057</td>
<td>Add timestamp to the end of every item in the dashboard recently updated macro</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2050</td>
<td>Update add and subtract icons</td>
</tr>
</tbody>
</table>

**Bug Fixes**

<table>
<thead>
<tr>
<th>Bugs Fixed in 3.4-m4 (6 issues)</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Key</td>
<td>Summary</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2190</td>
<td>CLONE - Editor preview doesn't expand to show complete content</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2061</td>
<td>Cannot build REST documentation</td>
</tr>
<tr>
<td>Ticket</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>CONF-2060</td>
<td>Page gadgets fail with an internal server error</td>
<td></td>
</tr>
<tr>
<td>CONF-2044</td>
<td>Editor preview doesn't expand to show complete content</td>
<td></td>
</tr>
<tr>
<td>CONF-2034</td>
<td>sudo is decorated with global decorator</td>
<td></td>
</tr>
<tr>
<td>CONF-1973</td>
<td>bootstrapPluginManager is still available to plugin system - is not thrown away</td>
<td></td>
</tr>
</tbody>
</table>

Release Notes 3.4-m2 ("Milestone 2")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Previous Milestone(s)

Previous milestones in the 3.4 release:

- Release Notes 3.4-m1 ("Milestone 1")

New Features

Universal Plugin Manager

Confluence is now bundled with Universal Plugin Manager (UPM). The UPM allows you to see and manage the plugins that you have installed in Confluence, and it allows you to discover, download and install new plugins from the Atlassian Plugin Exchange. You can read more about the UPM here.

User Macros in the Macro Browser

User macros are now available in the Macro Browser and can have the same amount of metadata as existing plugin macros. The current default is to hide user macros from browse/search in the Macro Browser until the admin updates them. Below is a screenshot of what the user macro form looks like (Note: This will slightly change in a later milestone)

Confluence administrators and user macro developers can enter macro and parameter meta-data via the admin console. This meta-data will reflected in the macro browser. Below is an example snippet of the new syntax that is available in a user macro:
More detailed User Macro API docs will be provided later, explaining how to enable user macros in the macro browser and how to develop user macros for the macro browser.

**Improvements**

### Improvements in 3.4-m2 (4 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-2048</td>
<td>Add new component for OSGi plugins to get the active Hibernate session</td>
<td>Resolve d</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2042</td>
<td>Replace default avatar and add avatar images</td>
<td>Resolve d</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-2027</td>
<td>Make real request and response objects available during Word export</td>
<td>Resolve d</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-1665</td>
<td>Display user macros in the macro browser</td>
<td>Resolve d</td>
</tr>
</tbody>
</table>

**Bug Fixes**

**Bugs Fixed in 3.4-m2 (8 issues)**
<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗓️</td>
<td>CONF-2232</td>
<td>CLONE - Global Theme is incompatible with Page Restrictions</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-2045</td>
<td>Doc Theme is incompatible with Page Restrictions</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-2044</td>
<td>User options menu is unaligned</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-2042</td>
<td>The &quot;Server Base URL must be set to the same URL&quot; message on editgenconfig.vm uses the doc macro to generate a link to the knowledge base, which doesn't work</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-1896</td>
<td>Some pdf files don't get correctly indexed</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-1840</td>
<td>Users with a whitespace in username cannot add favourites or apply page restriction</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-1091</td>
<td>PDF Extractor unable to index Chinese and Japanese characters</td>
<td>Resolveled</td>
</tr>
<tr>
<td>🗓️</td>
<td>CONF-5825</td>
<td>Confluence can't index certain</td>
<td>Resolveled</td>
</tr>
</tbody>
</table>
Release Notes 3.4-m1 ("Milestone 1")
Milestone release advisory

- For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

Who should upgrade?

- Development releases are not safe—Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Improvements

Faster

Confluence 3.4-m1 contains some performance boosts (CONF-20264). The green bar below highlights current performance.

![Average Response Times (ms)](chart)

Supportability

Database Support

Confluence 3.4 now has support for:

- SQL Server 2008 (CONF-12879)
- Postgres 8.4 Support (CONFDEV-28)

Lots of bug fixes

### Bugs resolved in 3.4-m1 (90 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="bug" alt="bug" /></td>
<td>CONF-24022</td>
<td>Confluence password regex does not match the password regex set in Crowd</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="bug" alt="bug" /></td>
<td>CONF-23149</td>
<td>contentbylabel macro does not sort ASCII characters properly</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="bug" alt="bug" /></td>
<td>CONF-21157</td>
<td>Recently-Updated macro does not show user information when added to a page in Confluence 3.3 and 3.3.3</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td><img src="bug" alt="bug" /></td>
<td>CONF-21046</td>
<td>Upgrade to Confluence 3.4 throws NoSuchMethodError</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>Issue</td>
<td>Summary</td>
<td>Status</td>
<td>Type</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------</td>
<td>---------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>CONF-21000</td>
<td>a link in the admin screen to the knowledge base regarding the Server Base Url change returns no result</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20991</td>
<td>The modification detection (Modz detector) is not working.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20964</td>
<td>XSS vulnerability in Tasklist macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20963</td>
<td>XSS vulnerability in Office Connector</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20958</td>
<td>Confluence features that require password confirmation (websudo, captcha) do not work with custom authentication</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20898</td>
<td>Gadgets Malformed Security Token</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20831</td>
<td>IE8 and IE7 crash if you click Add Page and Add Blog too fast multiple times</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20793</td>
<td>Confluence logs a ClassCastException Tomcat 6.0.27 or later when accessing Oracle.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20765</td>
<td>Page gadget doesn’t render preview or content</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20740</td>
<td>XSS vulnerability in Confluence Space Names</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20738</td>
<td>Ziputility adds files with wrong name</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20726</td>
<td>Unable to search for word that is followed by a number for filenames separated by underscores</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20720</td>
<td>toggleStar in favourite.js uses</td>
<td>Resolved</td>
<td>Duplicate</td>
<td></td>
</tr>
<tr>
<td>CONF-20715</td>
<td>User link hovering does not work in the recent changes macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20683</td>
<td>Default Theme: Breadcrumbs hidden in IE</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20633</td>
<td>Spaces cannot be unmarked as favourites</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20616</td>
<td>Edit in Word does not work when a custom authenticator is configured</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20526</td>
<td>Doc Theme is incompatible with Page Restrictions</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20508</td>
<td>Secure Administrator Sessions feature can be bypassed</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20496</td>
<td>Can't uncheck Macro has a body in the user macro screen</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20487</td>
<td>Did You Mean option not retained in 3.3</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20400</td>
<td>Restoring a XML site backup into 3.3 fails with &quot;No enum const class...&quot; exception</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20398</td>
<td>French translations for some of Rich Text Editor's features are not reflected</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20339</td>
<td>Edit in &quot;Page&quot; word feature causes nullpointer exception.</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20338</td>
<td>Upgrade Dashboard Macros plugin to 1.14</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20322</td>
<td>EmbeddedCrowd migration always creates an internal directory</td>
<td>Resolved</td>
<td>Duplicate</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Title</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------</td>
<td>----------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>CONF-20321</td>
<td>EmbeddedCrowd migration does not create directories in the correct order</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20318</td>
<td>NetworkAndSiteNotificationTypesUpgradeTask fails when upgrading to 3.3 on Oracle (and probably others)</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20311</td>
<td>Best Practice Code revisions</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20308</td>
<td>Update atlassian renderer to 6.1</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20302</td>
<td>EmbeddedCrowd migration does not merge user and group DNs correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20301</td>
<td>ObjectQueue handles is not synchronized causing: ConcurrentModificationException</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20298</td>
<td>NullPointeException error logged by scheduled office connector cleanup job at 02:00</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20288</td>
<td>Web Sudo: &quot;Drop access&quot; link does not work when language is set to german</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20275</td>
<td>Setup footer contains the &quot;print-only&quot; message</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20266</td>
<td>Logging from plugin framework does not get sent to log file, instead goes to standard error with unusual format</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20254</td>
<td>Null PE from plugin-status macro</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20218</td>
<td>TinyMceInsertMenu Test fails across builds</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20200</td>
<td>Macro Browser doesn't handle browser zooming well</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Title</td>
<td>Status</td>
<td>Resolution</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------</td>
<td>------------</td>
<td></td>
</tr>
<tr>
<td>CONF-20189</td>
<td>Logout Button / Option Missing for some LDAP user accounts</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20186</td>
<td>On IE7 &quot;followers&quot; have small lines between thumbnail pictures</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20184</td>
<td>When editing a comment on a page, the right side is chopped off</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20181</td>
<td>Headings in Page Gadgets scroll sideways with the page</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20167</td>
<td>Overlapping Text in Browse menu for French Admin users</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20150</td>
<td>View file macro dialog does not allow a file to be uploaded</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20044</td>
<td>Page Gadget tools menu grows white space and is not styled correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20040</td>
<td>Widget Connector does not render all of Wufoo widget</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20021</td>
<td>Apostrophes are double escaped in the Page Gadget title</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-20012</td>
<td>The gadget tools menu and the scrollbar overlap in Safari</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-19956</td>
<td>Page Gadget error message for inaccessible content needs to be tidied up</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-19932</td>
<td>Confluence page gadget viewfile macro requires a refresh to re-size correctly</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-19552</td>
<td>Remove group confirmation screen logs error when trying to display members</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-19482</td>
<td>Restoring a personal</td>
<td>Resolved</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19453</td>
<td>Turkish locale causing System Error when Global Permission is edited</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19313</td>
<td>Cannot execute Tools -&gt; Restrictions from Personal Spaces of users with whitespace in their user name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19285</td>
<td>Importing document of size bigger than attachment limit yields &quot;Page Not Found&quot; error</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19169</td>
<td>Word footnotes import in Doc Import is broken</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19157</td>
<td>Graphs don't display properly when using sheet parameter in viewfile</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19148</td>
<td>Can't use value names which have a double-bytes numeric character</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19060</td>
<td>Edit in Word function adds // for blank lines inside code and noformat macros, which are then visible in output</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-19032</td>
<td>Move Page dialog: Text is too long and wraps incorrectly in German</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18892</td>
<td>Office Connector Freezes Confluence When Loading Excel 2007 File With Date Macro</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-18853</td>
<td>Doc Import stuck in loop when duplicate titles are included in the Word Document</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#</td>
<td>Conf</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
</tr>
<tr>
<td>-----</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>---------</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-18430</td>
<td>usernames with spaces do not work with page restriction auto-complete</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-17414</td>
<td>Doc Import allows empty title</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-17231</td>
<td>Language pack related warning messages in logs when editing user preferences</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-17217</td>
<td>Left Navigation Theme does not include the &quot;Custom HTML : At end of the BODY&quot; in the output HTML</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16897</td>
<td>Labels List macro gives misleading parameter info in the Macro Browser</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16876</td>
<td>&quot;Expected 'xref' at start of table&quot; when rendering PDF file version 1.4 and later in viewfile macro</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16525</td>
<td>Errors indexing PDF documents</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16490</td>
<td>Blog Posts macro - the Content Type parameter does not work as expected</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16383</td>
<td>Dynamic Tasklist V2 fails in IE7</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16368</td>
<td>ClassCastException after upgrading plugins when trying to click on &quot;Configure&quot;</td>
<td>🔄 Resolved</td>
<td>Obsolete</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-16067</td>
<td>Restore fails with &quot;Too many open files&quot; error</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-15594</td>
<td>Hover Profile and People Directory look rubbish when the Profile macro has been disabled</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-14628</td>
<td>pages/create(blogpost</td>
<td>page).action with a spaceKey containing the null character causes</td>
<td>🔄 Resolved</td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13875</td>
<td>Confluence Daily Mail Notification eats up CPU performance</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13836</td>
<td>Plugin Repository’s “Installed Plugins” filter shows non-installed plugins</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13819</td>
<td>Compound database index missing for ATTACHMENTDAT A table</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-13082</td>
<td>Database Connection Transaction Isolation level is not displaying at all and the Database Driver Version for jtds-1.2.2.jar is incorrect in System Information page</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12571</td>
<td>JIRA Issue Macro displays too wide, doesn’t auto-scroll properly</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-12421</td>
<td>Don’t use distributed cache for storing Captcha’s in a cluster</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-11818</td>
<td>‘view wiki markup” menu item produces error in IE6 on XP</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-4805</td>
<td>Reusable show more/less component for content lists</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-4182</td>
<td>NPE in SpaceHelper borks page....</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-3322</td>
<td>Userlister online and offline status broken</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Release Notes 3.3-beta3 ("Beta3")**

**Beta release advisory**

---

*Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

Upgrade Procedure
If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Welcome to the Confluence 3.3 Beta program

The Confluence team is really excited to share with you the Confluence 3.3 Beta 3 release. We still have a few bugs to fix, but overall we feel that most of the features below will be ready to ship by the final 3.3 release later this month.

New Features

Highlights of this release:

- **Confluence Page Gadget**
- **Editing Features**
  - Image Properties Panel
  - Link Properties Panel
  - Macro Autocomplete
- **Notification Features**
  - Email Notification for Network and Blogs
  - Manage Page Watchers
  - Change Comments on Blog Posts
- **Engine Room**
  - Secure Administrator Sessions ('Web Sudo')
  - Login Captcha
  - XSRF Protection on Comment Creation
  - Login Information
  - Infrastructure Changes
  - Deprecation Notice
- **General Improvements**
  - General Configuration UI
  - Accessibility Improvements
  - Improvements to Importing Word Documents
  - Version-Specific Help Links
  - Library Upgrades
  - New Dashboard Actions
  - New Welcome Message
  - Slimmer Blog View

Confluence Page Gadget

Confluence now provides a gadget many have been requesting: the Page Gadget. This allows the display of any Confluence page within a gadget, with optional 'View' and 'Edit' links. You can embed this gadget into your JIRA dashboard or another Confluence instance.

Page gadget configuration
With autocomplete for space names and page titles:

Rendering macros in the gadget

The gadget renders macros that occur in the page. Most major macros work within the Confluence Page gadget, such as the Content by Label and the Recently Updated macros:

Additionally, you can embed rich content with the View File macro within a Page gadget:

There are still a few minor issues with the Confluence Page gadget. At present the gadget supports most bundled macros within Confluence, but not all. We will publish the full details of the supported macros in the next release. Additionally, iGoogle/Gmail integration requires further testing.

Editing Features
Image Properties Panel

Introducing a new image properties panel! Manipulating images is now possible in the Rich Text Editor. Simply click (or select via keyboard with shift and arrow keys) an existing image and the image property panel will be available.

You can resize an image into small, medium and large preset sizes as well as add a border to an image without having to leave the Rich Text Editor.

Link Properties Panel

Editing links in the Rich Text Editor is now easier with the new properties panel. You can easily see the link and edit or unlink existing links on the page. Just place your cursor somewhere inside the link.

google

Macro Autocomplete

We have extended the autocomplete feature introduced in Confluence 3.2 to include macros. You can now type '{' in the Rich Text Editor to trigger macro autocomplete. Just continue typing to search for a particular macro and open it in the macro browser.
Notification Features

Email Notification for Network and Blogs

For their Atlassian FedEx 14 project, Don Willis and David Taylor enhanced email notifications for blogs and networks. The 'Subscribe to all Blog Posts' option gives you notifications for all the blogs in the system, subject to permissions. If you select 'Subscribe to Network', you will get notifications when anyone you are following edits content or changes their status, also subject to permissions. You can configure these options in your email settings:

Manage Page Watchers

An implementation of Matt Ryall's FedEx 14 project is available in this version of Confluence: a dialogue to view and manage watchers on pages and blog posts, as well as view all watchers of a space. This option is only currently available to space administrators. It addresses CONF-5032 and most of CONF-3703 for approximately 150 votes. Screenshots below:

New menu option
A few minor issues with icons, keyboard navigation, displaying usernames and wrapping of long names will be fixed in the next release.

**Change Comments on Blog Posts**

You can now comment on the updates you make to blog posts, in the same way as you can for pages.
Engine Room

**Secure Administrator Sessions ("Web Sudo")**

Confluence has another line of defence against hijackers of administrator sessions. All features in the Administration section of Confluence (and some in the Space Administration section) will require the user to validate their credentials before proceeding.

After validating, a message at the top of each page reminds you of your temporary administrator session. The temporary session will expire after 10 minutes of administrator inactivity and can also be terminated manually.

The secure administrator settings are configurable via the Confluence Administration Console.

**Login Captcha**

As another important security improvement Confluence now requires the user to answer a Captcha question after a given number of failed login attempts.

This security mechanism protects not only the login page but the RPC-interface as well. After a configurable number of failed login attempts via the RPC interface, the user is required to log in using the web interface which then presents the Captcha image.

This feature is enabled by default but can be disabled in the Confluence Administration Console. The configuration options include the number of failed login attempts. The default threshold for login attempts is three.

**XSRF Protection on Comment Creation**

This security mechanism requires an XSRF token to be present when adding a comment. Don't worry though, a system is in place so that your session will not expire and you can take your time to write the perfect comment!

All the bundled themes have been updated to use this feature. There is also an option in the new Security Configuration screen to disable this feature if you need to keep using a theme that does not yet support the feature.

**Login Information**
Confluence now captures metadata about login attempts, including the dates of the last failed and successful login and the number of failed logins.

In addition, a Confluence administrator can now reset the number of failed logins for a particular user.

Infrastructure Changes

Various changes to aid plugin development:

- All ContentEntityObjects can now be commented on
- UserStatus now optionally belongs to a space
- Custom space types are available
- Upgrade to Bandana 2.0
  - Custom context objects
  - Key enumeration
  - Item removal
  - Custom serialisation

Deprecation Notice

DWR has been deprecated as of 3.3-m1. Support for the client side JavaScript proxies has been moved into the Confluence Legacy Web Resources plugin which is going to be disabled by default. If you need any of the following web resources you will need to enable this plugin:

- DWR framework
- DWR JavaScript proxies for label operations (add, remove, suggest) or editor operations (heartbeat, draft saving, editor preferences)

You will also need to make the following resource a required resource in your view template: legacy.confluence.web.resources:dwr-confluence

This will embed the DWR client-side JavaScript files in your plugin's view output.

General Improvements

General Configuration UI

The General Configuration screen in the Administration Console has finally been given a face lift. It now uses an AUI form style.

Accessibility Improvements

We've added labels, legends and skip links so that Confluence is now more 508-compliant. We still have a long way to go, but these pages should now be more screen-reader friendly:

- Dashboard
- General pages
- Profiles
- Set your Password
- Attachments
- People Directory
- User Status

Improvements to Importing Word Documents
The structure of the ‘Tools’ > ‘Import Word Document’ feature has been improved to make it more intuitive.

**Version-Specific Help Links**

Confluence now follows the Atlassian Help Link specification. All help links will now redirect to the version of the Confluence documentation that matches the version of the Confluence application that you are using.

If you wish, you can configure the redirecting of the help links by editing the `help-paths.properties` file. You could do this if you need to point Confluence help links to an internal documentation site.

**Library Upgrades**

- AUI 3.0-m3
- Atlassian Plugins 2.5

**New Dashboard Actions**

The dashboard actions are now buttons. On mouse-over, the text turns blue. When clicked, the button is indented. They have also been moved – they appear above ‘Spaces’.

**New Welcome Message**

The dashboard welcome message has been updated.

**Slimmer Blog View**

The blog view has been modified as shown in the screenshot below.

Changes shown in the screenshot:

- The old calendar has gone. It has been replaced by a sidebar that simply lists the month and all the blog posts for that month. You can scroll through the months that have blog posts in them.
- The view has been streamlined. We have removed some unnecessary information on the page.
- In a global space, the view you see via ‘Browse’ > ‘Blogs’ has the blogger's picture attached to the blog for easier identification.
Other changes not visible:

- The dates have been internationalised. Until now they were restricted to English.
- The 'Browse' > 'Blogs' view allows you to see older and newer posts, no longer restricted to the most recent 15.

**Release Notes 3.3-m3 ("Milestone 3")**
### Milestone release advisory

- **For testing use only**

  Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

### Who should upgrade?

**⚠️ Please note the following**

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we **can not** provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

### Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. **We strongly recommend that you backup your Confluence home directory and database before upgrading!**

### Downloads

All development releases are available from the development releases page on the Atlassian website.
Back after a month of silence...

Hello everyone! As you might have noticed, we went dark for a whole month, skipping Milestone 2. Why is that, you wonder? To be quite honest with you, M2 was considered too rude. What was supposed to be an easter-egg went berserk, telling its unassuming user to ... well, we can't print that here. So we decided to not publish M2, and waited until M3 was complete. We have since then washed Connie's mouth with soap, and Confluence 3.3 Milestone 3 presents itself shiny, friendly and non-abusive as ever. :-)

We're currently planning to go Beta in about 2 weeks, just in time for Atlassian Summit, and to ship in mid to late June.

New Features

Macro Autocomplete

You can now type '{' in the Rich Text Editor to trigger macro autocompletion! Just continue typing to search for a particular macro and open it in the macro browser.

Known issue: The searching/ordering is not ideal yet, and you get quite unspecific search results at time (as
seen above). Sometimes it's good to be fuzzy, sometimes not. We'll probably disable searching by description (and just do that in the macro browser). Watch (and provide feedback on) CONF-19598.

**Link Properties Panel**

Editing links in the RTE is now easier with the new properties panel. You can now easily see the link, edit and unlink existing links on the page. Simply place your cursor somewhere inside the link!

![Link Properties Panel](image)

There's a known issue (CONF-19608) in IE where the "Unlink" button is deleting the link text as well; this will be fixed for the next milestone.

The next two weeks we'll be applying property panels to images as well. If you have any feedback on this panel already, please tell us so we can fix it up before the Beta.

BTW, we're planning to make the UI between Autocomplete and Property Panel a bit more consistent in the next milestone, and we will display the URL that the link points too as well. It's just a beta, after all.

**General Improvements**

**General Configuration UI**

The Admin General Configuration screen has finally been given a face lift! It has been converted over to use an AUI form style.

![General Configuration](image)

**Accessibility Improvements**

We've added labels, legends and skiplinks so that Confluence is now more 508-compliant. We still have a long way to go but these pages should now be more screen-reader friendly:

- Dashboard
- General pages
- Profiles
- Set your Password
- Attachments
Import Word Improvements

The ‘Tools’ > ‘Import Word Document’ feature structure has been improved to make it more intuitive.

Login CAPTCHA

As another important security improvement Confluence now requires a CAPTCHA after 3 failed login attempts.

This security mechanism not only protects the login page but the RPC-interface as well. After 3 failed login attempts via the RPC interface the user is required to log in using the web interface which then presents the
CAPTCHA image.

This feature is enabled by default but can be disabled in the admin panel. The configuration options include the number of failed login attempts. The default threshold is 3.

Login information

Confluence now captures login meta information. This includes the dates of the last failed and successful login and the number of failed logins.
The administrator is now able to reset the number of failed logins for a particular user.

| Login: CAPTCHA required at next login |
| Last Login: May 18, 2010 16:29 |
| Last Failed Login: May 18, 2010 16:30 |
| Total Failed Login Count: 6 |
| Current Failed Login Count: 6 |
| (Reset Failed Login Count) |

View Profile | Edit Groups | Edit Details |

Version-Specific Doc Links

Confluence now follows the Atlassian Help Link spec and all help links will now redirect to the version of the Confluence Documentation that matches the version that you are using.

Users can edit where the links are directed by editing help-paths.properties.

Library Upgrades

- AUI 3.0-m3
- Atlassian Plugins 2.5

New dashboard actions

The dashboard actions are now buttons, which on mouse over the text turns blue and when clicked is indented. They have also been moved to be above 'Spaces'.

Old:

Create a space - share information with your team.
Feed Builder - create your custom RSS feed.
People Directory - browse users and personal spaces.

New:

Add Space Feed Builder People Directory

New welcome message

The dashboard welcome message has been updated.

Old:
Welcome to Confluence

Confluence is the enterprise wiki designed to make it easy for you and your team to share information with each other, and with the world.

Where do I start?

All content in Confluence is organised into spaces. So to start browsing content, simply click on one of the spaces listed below.

New:

Welcome to Confluence

Confluence combines powerful online authoring capabilities, deep Office integration and an extensive plugin catalog to help people work better together and share information effortlessly.

Get started by creating a new space and adding users to join you.

You can change this message to whatever you like.

Change comments on blog posts.

Don W changed 1 line of vm and wrote some tests so that change comments are enabled on blog posts.

All Implemented Issues

XSRF Protection on Comment Creation

This security mechanism requires an XSRF token to be present when adding a comment. Don't worry though, a system is in place so your session will not expire and you can take your time to write the perfect comment!

All the bundled themes have been updated to use this feature, and an option in the new Security Configuration screen to disable it if you still can't live without an old theme.

Release Notes 3.3-m1 ("Milestone 1")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Overview

Milestone 1 is a fairly minor step from a user perspective, but since there are a number of changes that could potentially impact plugin development we wanted to get it to you as soon as we could. Read on for the changes as described directly by the developers.

Infrastructure Changes

Various changes to aid plugin development

- All ContentEntityObjects can now be commented on
- UserStatus now optionally belongs to a space
- Custom space types
- Bandana 2.0
  - Custom context objects
  - Key enumeration
  - Item removal
  - Custom serialisation

Deprecation notice

DWR has been deprecated as of 3.3-m1. Support for the client side Javascript proxies has been moved into the Confluence Legacy Web Resources plugin which is going to be disabled by default (it currently isn't - automatically disabling the DWR web resources when updating Confluence will be in Milestone 2). If you need any of the following web resources you have to enable this plugin:

- DWR framework
- DWR Javascript proxies for label (add, remove, suggest) or editor operations (heartbeat, draft saving, editor preferences)

Slimmer Blog View

The blogs view has been modified as shown in the screenshot below.

Changes shown in the screenshot:

- The old calendar has gone. It's been replaced by a sidebar that simply lists the month and all the blogposts for that month, and allows you to scroll between the months that have blogposts in them.
- The view's been streamlined - we've gotten rid of some of the unnecessary information on the page.
- In a global space, the view you get in Browse > Blogs has the user's picture attached to the blog for easier identification.

And the additional changes not visible:
- The dates have been internationalised - until now they were stuck in English.
- The Browse > Blogs view allows you to see older/newer posts, not just the most recent 15.

### All Implemented Issues

<table>
<thead>
<tr>
<th>Issue Implemented in 3.3-m1 (0 issues)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Summary</td>
</tr>
</tbody>
</table>

### Confluence 3.2 Beta Release Notes

⚠️ **These are not the release notes you are looking for! The final Confluence 3.2 Release Notes are over here.**
Milestone release advisory

⚠️ For testing use only
Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Welcome to the Confluence 3.2 Beta program

With great pride we bring to you the Confluence 3.2 Beta release. We still have a few bugs to fix, but overall, this is how 3.2 will get rolled out to customers in mid March. And we want your feedback.

Note to partners and translators: The preliminary translation diff files can be found as a subpage of this overview page: Translations for Confluence Releases

Advance warning

This release is the last one to officially support Internet Explorer 6. Read the upgrade notes and the original announcement over here.

This release is the last one to officially support application servers other than Tomcat. From the next release on, Websphere and Weblogic and JBoss will not be supported anymore. For further information on this, please see the end of support announcements page

Autocomplete in the editor

We are adding a new feature called Autocomplete to the Rich Text Editor. In this beta it only works in Firefox and Safari, but the goal is to make it work on Internet Explorer as well by the time the 3.2 release ships. You can type "I" at the start of a line to display your browsing history and link to those pages, and if you keep typing you'll get recommendation for pages that match what you types:

If you type "I" you'll see the attached images to the current page, and if you keep typing you'll be able to link to any image in your deployment.
This feature’s goal is to make the RTE even faster than using wiki markup. Try it out and tell us what you think!

**Note:** May require a re-index of your system to show attachments

**Known issues**

- [CONF-18281](CONF-18281) - doesn't work in IE yet

**New Links Dialog**

We have rewritten the way you add links in Confluence. The new links dialog is faster, better looking, and more powerful.
New "Documentation Theme"

Confluence now comes bundled with our hugely successful "Documentation Theme". See https://plugins.atlassian.com/plugin/details/16393 for details about the theme.

This theme replaces the old "Left Navigation Theme". We are still shipping the Left Nav theme, but it is deprecated and will stop shipping in a later release.

New "Easy Reader" Theme

With today's huge monitors, it can become hard to read large amounts of text that spans the whole screen. We are introducing a new theme which, like most websites, only uses a portion of the screen, to facilitate readability.
This theme replaces the old "Clickr Theme". We are still shipping the Clickr theme, but it is deprecated and will stop shipping in a later release.

Bundled templates and new template marketplace

The Bundled Templates 20% project is actually a framework to allow customers and Atlassian to deploy bundles of templates to a Confluence instance.

3.2 includes the framework plugin and a bundle of default templates[1]; these are available to the administrator to import into their instance as either space templates or global templates.

The templates import framework allows the administrator to preview a template before importing it as well as view the associated wiki-markup.

[1] Current default template bundle will be changed, pending list from Matt and Bill.

Documentation on how to write your own template plugin can be found here: Creating A Template Bundle.

Please visit PAC for the new category. TODO: add link
Better Move Page Dialog

We introduced a new page move dialog in Confluence 3.1 but the ability to change the order of pages fell out of scope. This has now been implemented and is accessed as shown -

And looks like -
**REST APIs**

**New REST Resources**

- Attachment Resource
  
  **Request:** [https://confluence.example.com/rest/prototype/1/attachment/161](https://confluence.example.com/rest/prototype/1/attachment/161)

```xml
<attachment niceType="Image" version="1"
comment="image of Sydney harbour"
fileName="harbour.jpg" type="attachment" id="161">
<ownerId>69518087748064278</ownerId>
<title>harbour.jpg</title>
<lastModifiedDate date="2004-11-21T23:20:18-0600" friendly="Nov 21, 2004"/>
<createdDate date="2004-11-21T23:20:18-0600" friendly="Nov 21, 2004"/>
</attachment>
```

*Some fields removed*

More in-depth documentation coming soon.

**Useful Improvements and Enhancements**

**Page History**
What used to look like this...

⚠️ You are viewing an old version (v. 7) of this page.
The latest version is v. 8, last edited on Feb 15, 2010 ([View differences] [restore this version])
<< View previous version | view page history | view next version >>

.. now is a bit more understandable:

RTE Shortcuts Added

The following RTE shortcuts have been added, please try them out!

- Ctrl+Shift+C Copy table row
- Ctrl+Shift+X Cut table row
- Ctrl+Shift+V Paste table row
- Ctrl+Shift+B Bullet lists
- Ctrl+Shift+N Numbered lists
- Ctrl+Shift+F Full screen mode
- Ctrl+Shift+S Strikethrough
- Ctrl+Shift+T Insert Table
- Ctrl+Shift+A Macro Browser

RTE Hints

At the bottom of the RTE, useful editor hints get displayed. This will help promote the new keyboard shortcuts and the autocomplete feature.

Images in search results

If an image is found, it will be displayed in the search results. The main point here is that we've made it possible to write plugins to spice up search results. You could write custom display for any kind of attachment types, or
even change what the regular pages look like.

A tutorial for how to write your own renderer is located over at the Confluence Dev space.

Bundled JDBC drivers

To improve the Evaluator experience, we're now bundling a few of the most common JDBC drivers.

Improved RSS feed builder screen

The RSS feed builder looks a bit more polished and less scary.

Bug fixes and stability improvements

A host of old bugs have been fixed. Most notable:

- it is now possible to install language packs without restarting the server.
- When adding new pages or posts, there used to be a white-space overlapping the right part of the editor. This is now fixed.
- Removed many instances of hard-coded colours (mostly blue) that prevented colour schemes applying correctly.
- Enhancement for modern browsers: added CSS to handle common forms of over-sized content, so it gets a localised scrollbar instead of making the whole page scroll
- Properly set backgrounds for email and editor popups, so they don't (incorrectly) pick up backgrounds from the main wiki window.

Release Notes 3.2-m3 ("Milestone 3")
For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ("milestone") leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Welcome back

it's been a while since we shipped Confluence 3.1 in December. Since then, we've been having heaps of fun at our second Lab Week, during which we experimented with all sorts of new technology and crazy ideas, mainly around the editor. We've been busy coding up new features over the last weeks, but also various back-end changes. Milestones 1 and 2 were internal only and didn't show much visual anyway, but now we're getting there.

The Confluence 3.2 development cycle is going to be a short one. We are currently aiming at shipping in Mid March. There will probably be one a M4 milestone in two weeks, but then we're in Beta mode already.

The features

New Links Browser

The new link browser is now available in the editor toolbar (the old one is still there as a backup).

Note: this funky icon is temporary

This new browser now has all the functionality present in the current link popup, except for the recently modified tab. You can now add links to attachments and recently viewed pages, which weren't available in m2. Please raise any bugs found against the linking component in Confluence.

Know issues

- quick search only returns pages
- error messages from the server aren't displayed yet
- usability work still to come (like cursor placement and keyboard navigation)

Documentation theme

We are going to bundle the new Documentation Theme,

Fixed Width Theme

We are introducing a theme that by default has sidebars. The main work here is behind the scenes, fixing up our HTML and CSS so that 3rd-party theme developers will benefit and be able to write such themes more easily.
If you’re wondering where the ‘sudden green’ has come from, it has originated from Confluence’s product colour on our website.

Naturally the colour scheme is customisable:

Known issues

- Space Admin screens still need work (site admin screens don’t get themes applied, but space admin does)
- There’s more polish to go into this theme - mostly small spacing and font size adjustments
- Our minimum resolution is 1024x768; content that doesn’t fit at that size won’t fit in the fixed width theme either.
- There is a certain discussion around the colours, and whether we should be a bit more conservative in terms of the background. We will keep discussing.
- The main point here is that many bugs have been fixed, and that 3rd-party theme developers will benefit from many under-the-hood bugfixes to our html and css.

Anatoli’s 20% project: RSS improvements

- CONF-18372 : changed the feed builder UI so that now you can choose comments/attachments for either pages, blogs, both or none. The new UI will generate slightly different parameters so that they don’t interfere with old RSS query format.
There are plans to further improve the UI.

- **CONF-9312**: changed the behavior of rss feed when filtering by label. Now when you ask for comments and pages with a particular label you will get the labeled pages and comments on those pages.

**Backend changes**

The Engine Room has upgraded plenty of libraries:

- Many common modules were upgraded.
- Migrated our [Sal Plugin](http://example.com) into Confluence
- REST Service for retrieving Recently Viewed pages
- Start of REST service for Confluence searches

More documentation about REST will soon follow.

**Next steps**

There are still heaps of improvements that will make it into 3.2, so stay tuned for M4 and Beta1, both due this month.

Cheers,
The Confluence Development Team

**Release Notes 3.2-m4 ("Milestone 4")**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- Development releases are not safe—Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path—Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
With great pride we bring to you the best milestone of this release cycle. We are now more or less feature-complete. There are a few usability issues which we still want to fix, and yes, there are still plenty of bugs. We didn't manage to bundle a few of our new great plugins yet, and have large chunks of code to review. That's why we didn't call this Beta yet, but named it M4.

But overall, this is how 3.2 will get rolled out to customers. We want your feedback: Speak now or forever hold your peace.

Note to partners and translators: The preliminary translation diff files can be found as a subpage of this overview page: [Translations for Confluence Releases](#).

### Engine Room

**New REST Resources**

- Attachment Resource
  - **Request:** [https://confluence.example.com/rest/prototype/1/attachment/161](https://confluence.example.com/rest/prototype/1/attachment/161)

```xml
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<attachment niceType="Image" version="1"
  comment="image of Sydney harbour"
  fileName="harbour.jpg" type="attachment" id="161">
  <ownerId>69518087748064278</ownerId>
  <title>harbour.jpg</title>
  <lastModifiedDate date="2004-11-21T23:20:18-0600" friendly="Nov 21, 2004"/>
  <createdDate date="2004-11-21T23:20:18-0600" friendly="Nov 21, 2004"/>
</attachment>
```

Some fields removed

More in-depth documentation coming soon.

**Other News**

- Integrate auto-complete and Link Browser to use REST search and attachment resources
- Bug Fixes

### Autocomplete

We are adding a new feature called Autocomplete to the Rich Text Editor, which currently only works in Firefox and (try your luck!) Safari. You can type "I" at the start of a line to display your browsing history and link to those pages, and if you keep typing you'll get recommendation for pages that match what you types. If you type "I" you'll see the attached images to the current page, and if you keep typing you'll be able to link to any image in your deployment.
This feature's goal is to make the RTE even faster than using wiki markup. Try it out and tell us what you think!

**Note:** May require a re-index of your system to show attachments

### Known issues

- [CONF-18281](#) - doesn't work in IE yet
- [CONF-18584](#) - when both the RTE and outer frames are scrolled the dropdown location is incorrect
- Plenty of small niggly bugs.

### New Links Browser

The Links Browser is now feature complete and has been enabled as the default insert link button in the editor.

The breadcrumbs in the search panel of the dialog is new in this milestone. This is particularly helpful when editing existing links.
Know issues

- CONF-18589 IE 6 caches responses for recently viewed and attachments tabs
- CONF-18575 Pressing enter on the search field leaves the page in IE7
- CONF-18455 After viewing a user profile, the recently viewed tab displays no pages

New Theme

Our new Fixed Width Theme (proper name still tba) now has

- new fancy gradient
- soothing blue colour scheme
- personal sidebar folds away neatly
  - we tried floating it over content, but people weren’t so keen on that.
- tidier grid than last milestone
- comment threading now far more robust, comments RTE toolbar collapses or scrolls instead of truncating (this solution will be migrated to core code after trial use in fixed width - the problem can also happen in default)
- key bugfixes: space admin screens and RTE spacing

![Dashboard Image]

Known issues

- The header nav dropdowns don't line up with the bottom of the header yet
- Personal info sidebar has some bugs to resolve after final design change (mainly: IE6 breaks, sidebar overlaps "navigate space" in some browsers)
- Attachments page is getting truncated in some circumstances
- Some RTE messages wrap poorly

Note for bug tracking: bugs that also occur in the default Confluence at 1024x768 are not theme bugs per se, even if they're being investigated at the same time.
### Bugfixes

Errors were reported by the JIRA trusted connection.

- **APPUNKNOWN; Unknown Application: (0); ["confluence:4557196"]**

<table>
<thead>
<tr>
<th>JIRA Issues (11 issues)</th>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Assignee</th>
<th>Reporter</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>CONF-1 8489</td>
<td>The Downlo ad All as zip is using the wrong mime type</td>
<td>Andrew Lynch [Atlassian]</td>
<td>Brad Baker [Atlassian]</td>
<td>Low</td>
<td>Reolved</td>
<td>Fixed</td>
<td>Feb 04, 2010</td>
<td>Feb 16, 2010</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONF-1 8195</td>
<td>Impossible to select a user using mouse from an autocomplete dropdown box in a search filter &quot;Who&quot;</td>
<td>Xu-Hen Tjin [Atlassian]</td>
<td>Vincent Chang</td>
<td>Low</td>
<td>Reolved</td>
<td>Fixed</td>
<td>Jan 07, 2010</td>
<td>Mar 27, 2010</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONF-1 6629</td>
<td>Uploading large fonts for</td>
<td>Ryan Thomas [Atlassian]</td>
<td>Igor Minar</td>
<td>Critical</td>
<td>Reolved</td>
<td>Won't Fix</td>
<td>Aug 12, 2009</td>
<td>Feb 17, 2010</td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Assigned to</td>
<td>Fixed By</td>
<td>Date Resolved</td>
<td>Date Fixed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>----------</td>
<td>---------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-15180</td>
<td><strong>ClassCastException being thrown when error encountered during mail queue flushing</strong></td>
<td>Brian Nguyen [Atlassian]</td>
<td>Tim Wong [Atlassian]</td>
<td>Apr 13, 2009</td>
<td>Aug 27, 2010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Description</td>
<td>Assignee</td>
<td>Priority</td>
<td>Resolution</td>
<td>Assigned To</td>
<td>Date Resolved</td>
<td>Date Fixed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>----------</td>
<td>----------</td>
<td>------------</td>
<td>-------------</td>
<td>---------------</td>
<td>-------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-7473</td>
<td>Confluence uses the server's locale for dates and not the default language</td>
<td>Xu-Heng Tjhin [Atlassian]</td>
<td>Agnes Ro [Atlassian]</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
<td></td>
<td>Dec 18, 2006</td>
<td>Feb 23, 2010</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Daniel's 20% project: Images in search results**

If an image is found, it will be displayed in the search results. **The main point here is that we've made it possible to write plugins to spice up search results.** You could write custom display for any kind of attachment types, or even change what the regular pages look like.

A tutorial for how to write your own renderer is located over at the [Confluence Dev space](#).
Paul's 20% project: Finishing the page move dialog

We introduced a new page move dialog in Confluence 3.0 but the ability to change the order of pages fell out of scope. This has now been implemented and is accessed as shown -

![Move Page Dialog](image)

And looks like -

![Move Page Dialog](image)
Small (yet awesome) Improvements

Page History

You are viewing an old version (v. 7) of this page.
The latest version is v.8, last edited on Feb 15, 2010 (view differences | restore this version )
<< View previous version | view page history | view next version >>

Say Hi to the new and (largely) improved Page History navigation.

RTE Shortcuts Added

The following RTE shortcuts have been added, please try them out!

- Ctrl+Shift+C Copy table row
- Ctrl+Shift+X Cut table row
- Ctrl+Shift+V Paste table row
- Ctrl+Shift+B Bullet lists
- Ctrl+Shift+N Numbered lists
- Ctrl+Shift+F Full screen mode
- Ctrl+Shift+S Strikethrough
- Ctrl+Shift+T Insert Table
- Ctrl+Shift+A Macro Browser

RTE Hints

At the bottom of the RTE, useful editor hints get displayed. This will help promote the new keyboard shortcuts and the autocomplete feature.
Confluence 3.1 Release Candidate 1 Release Notes
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**—Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**—Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
While you were away...

You can see all the feature details in the beta 2 announcement. This update about the Release Candidate is just for developers and evaluators who want to know what changed between the Beta 2 and the Release Candidate. Not much! 😊

Changes in RC1

It's should come as no surprise that we have mainly been bugfixing since the Beta 2.

Faster Editor

But, in order to make our Selenium builds pass more reliably, Agnes had to spend some time on making the editor faster. And she did! 😊

UI tweaks

Matt came up with a better widget connector icon, we've added the table-of-content which had been forgotten, and Stephen came up with a great fullscreen icon that really grabs your attention and means something.

Office file preview has a more prominent edit button

A common complaint at Atlassian Summit was that people didn't realize that you could launch your editor directly from the file preview so we've made it more obvious.

Road ahead

We aim at turning the RC into the Final Release and ship it on Thursday the 3rd December.
Confluence 3.1 Beta 2 Release Notes

Confluence 3.1 Beta 2 is a public development release ("Beta") leading up to the official release of Confluence 3.1, which we aim to ship in Q4, 2009.

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

⚠️ Do not use in production

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

Upgrade Procedure

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a
separate copy of your current Confluence production installation first and using that copy, follow the normal upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Known Issues

Below are some known issues associated with Confluence 3.1.

On this page:

- JIRA/Crowd and Confluence deployment
- JIRA Gadgets in Confluence
- Bamboo integration
- PDF exports only render gadgets as links
- Problematic Confluence Gadgets window when running Confluence on Java 6
- Other issues

JIRA/Crowd and Confluence deployment

Confluence will not start up or will display strange behaviour (drop down menus not working) if JIRA 4.0/4.0.1 or Crowd 2.0.x is running on the same application server installation, for example, by attempting to run Confluence and JIRA 4.0 in the same Apache Tomcat server installation. This problem results from a bug in JIRA (tracked as JRA-19894) that is scheduled to be fixed in JIRA 4.0.2. Crowd will be fixed in the 2.1 release. In the meantime, please read our KB article on how to resolve this issue.

In the meantime, you can run JIRA or Crowd and Confluence in different 'instances' of the same application server, for example two separate Apache Tomcat server installations. If you already do so, or have installed both the Confluence distribution and JIRA 4.0 distribution, or Crowd 2.0.x, you can ignore this known issue.

JIRA Gadgets in Confluence

As of Confluence 3.1, users can embed gadgets into Confluence pages. When integrating JIRA gadgets into Confluence pages, you may encounter UI problems like a missing "Login"-button which is required to make the gadget authenticate with the JIRA server. This problem can be circumvented by setting up JIRA and Confluence to use Trusted Apps communication (since it removes the need for manual authentication). See KB article for details.

Bamboo integration

Our continuous integration product Bamboo exposes gadgets which can be embedded into Confluence pages. However, some of these exhibit problems once embedded onto a Confluence page:

- BAM-4900 : Unable to edit Bamboo gadgets in Confluence
- BAM-4890 : Bamboo gadget added in JIRA dashboard is not saving the preferences

These bugs are being fixed in Bamboo 2.5, which will ship in January 2010.

PDF exports only render gadgets as links

If you place any gadget on a Confluence page and export the page to PDF, the gadget output will not be rendered in the PDF output. Instead, each gadget is rendered on a page as a box containing the name of the gadget, the latter of which is hyperlinked. Clicking this hyperlink, opens the gadget contents itself in a new browser window or tab.

Problematic Confluence Gadgets window when running Confluence on Java 6
The [Confluence Gadgets](#) window may indicate that ‘**An error has occurred while trying to load the Gadget Directory**’ and prevent you from accessing the URLs of your Confluence gadgets. This problem can occur if you are running Confluence on Java 6. After you install Confluence 3.1 or upgrade an existing Confluence installation to this version, please check the Confluence Gadgets window immediately after starting the Confluence server.

If you see this error message and cannot access your Confluence gadgets, it can be resolved by restarting Confluence. (You may need to do this more than once.)

For more information about this issue, please refer to [CONF-17417](#).

**Other issues**

Refer to our JIRA site for a [list of Confluence 3.1-specific bugs](#).

**Highlights of Confluence 3.1**

**Highlights of this Release:**

- JIRA/Crowd and Confluence deployment
- JIRA Gadgets in Confluence
- Bamboo integration
- PDF exports only render gadgets as links
- Problematic Confluence Gadgets window when running Confluence on Java 6
- Other issues

**Introducing Gadgets**

**Drag & Drop**

**Office 2007 Support**

**New ‘Move Page’ Feature**

**Enhanced Image Browser**

**Draft Comparisons**

**Page Restrictions Dialog Box**

**Web Browser Version Support**

**Other Editor Enhancements**

- Edit Mode Exit Notification
- New Rich Text Editor Insert Menu
- Macro Browser Smart Fields
- Editor speed

**Other Improvements**

- Add Pages or Blog Posts from the Dashboard
- New ‘Link to this page’ feature
- ‘More’ option on Activity Streams
- User Interface Performance Improvements
- Other Small Enhancements and Improvements to Confluence

**Introducing Gadgets**

Gadgets are small objects that offer dynamic content and functionality which may be served by any OpenSocial-compliant web application, such as JIRA 4.0+, Confluence or non-Atlassian applications such as iGoogle and Gmail.

- Confluence supports the use of [gadgets in pages and blog posts](#), which are accessible through the [macro](#).
Confluence can also serve its own gadgets, for use in any other OpenSocial-compliant web application. Two such gadgets are bundled with Confluence:

- **Activity Stream** — This gadget shows a list of recent activities that have occurred on the Confluence server, such as the addition of new pages, blog posts or comments, content edits, status updates and so on.
- **Quick Navigation Aid** — This gadget provides heading and content search capabilities on a Confluence server.

Your Confluence installation can also serve these gadgets in any of its own pages or blog posts.

### Inserting a JIRA Gadget onto a Confluence Page

![Confluence gadget](image)

**Drag & Drop**

The new 'drag and drop' feature allows you to drag one or more file(s) which are accessible from your computer and drop them directly into a Confluence page or blog post.

- Files can be attached to a page or blog post by dropping them directly onto the page view or the 'Attachments' list associated with the page.
- Image files can be attached to a page or blog post by dragging them from your computer directly onto the Image Browser.
- Image and Office files can be added directly into your Confluence page or blog post content by dropping them into the rich text editor's editor window.

**Download Video**

For more information about this feature and on how to set it up, refer to the Using Drag-and-Drop in Confluence documentation.

**Screenshots: Attaching an Image to the Image Browser**
Office 2007 Support

Confluence now provides full support for the new Office 2007 file formats, allowing you to view and edit content from Microsoft Word 2007 (.docx and .dotx), PowerPoint 2007 (.pptx and .potx) and Excel 2007 (.xlsx) files.

- Along with existing Microsoft Office versions, Confluence now fully indexes Microsoft Office 2007 files and their content can be searched by Confluence.
- Using Confluence’s Office connector macros, you can insert Word, PowerPoint or Excel 2007 files directly into your Confluence page or blog post.
- Office files can be edited directly from any page or blog post or their list of attachments.

⚠️ If you use the Firefox browser to work with Confluence, don’t forget to reconfigure the Firefox add-on (WebDAV Launcher options) to handle the new Office 2007 file extensions. Otherwise, you will not be able...
New 'Move Page' Feature

Confluence introduces a new page moving feature, that easily allows you to move the page you are currently viewing, adding or editing to another page elsewhere in the same or another space of your Confluence site. This feature is available through a new 'Move Page' dialog box, which provides the following flexible methods for moving pages:

- **Known Location** – Allows you to type the name of a space and within that space, the 'parent' page under which to move your page.
- **Search** – Allows you to search for a 'parent' page (within a selected space or set of spaces) under which to move your page.
- **Recently Viewed** – Allows you to select one of your recently viewed pages to be the 'parent' of your page to be moved.
- **Browse** – Allows you to select a space and page (within the tree of pages in the space) that will be the 'parent' of your page to be moved.

For more information, refer to [Moving a Page](#).

Enhanced Image Browser
A new ‘Image Browser’ has been introduced to replace the old ‘Insert Image’ window. The image browser provides a less-cluttered and enhanced interface that allows you to:

- Preview an image in detail before inserting it into a page. This is done by hovering over any image in the browser and clicking the ‘magnifying glass’ icon in the lower-right corner.
- Preview an image elsewhere on the web via its URL before inserting it into a page.

**Draft Comparisons**

Confluence’s drafts features have been enhanced, such that you can now view any of your unsaved draft changes before deciding to resume editing them. This nifty feature comes in handy, particularly when other people have made subsequent changes to a page or blog post in your drafts list and you need to merge changes or resolve a conflict.

<table>
<thead>
<tr>
<th>Title</th>
<th>Last Saved Date</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page with Partial Content</td>
<td>less than a minute ago</td>
<td>Resume Editing</td>
</tr>
<tr>
<td>Page with Content to Merge</td>
<td>2 minutes ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Page with a Conflict</td>
<td>12 minutes ago</td>
<td>View Changes</td>
</tr>
</tbody>
</table>
Page Restrictions Dialog Box

Confluence's page restrictions feature has been incorporated into a convenient and accessible dialog box that is now easier to use than before.

- The page restrictions dialog box can be accessed from the padlock icon or the 'Tools' -> 'Restrictions' menu item whilst viewing any Confluence page. From this dialog box, you can see all viewing and editing restrictions associated with the current page. You no longer need to view the page's associated 'Info' page to see the page's restrictions.
- You no longer have to edit a page to modify its page restrictions. You can edit all page restrictions from this easily accessible dialog box.
- The page restrictions dialog box is still accessible when a page is in edit mode.
- In addition to user and group names, the name field also accepts a user's full name. Full names are 'auto-completed' to help you find the relevant person more rapidly.

Web Browser Version Support

Confluence 3.1 now fully supports the following recent web browser versions:

- Internet Explorer 8
- Safari 4
- Firefox 3.5
**Other Editor Enhancements**

**Edit Mode Exit Notification**

Whenever you add or edit a page, comment or blog post and then click onto another Confluence feature that navigates away from your unsaved content, a message box appears, warning that your content will be saved as a draft (if it is a page) or lost (if a comment). This allows you to cancel out of this action if it was accidental.

**New Rich Text Editor Insert Menu**

Confluence’s rich text editor now combines a number of its commonly used editing features into a new convenient 'Insert' menu.

- The Horizontal line, Insert Symbol and Insert Emoticon Toolbar icons have been moved into the new insert menu.
- The functionality to insert images, links or attachments into a page can now also be accessed from this menu.
- The macro browser, as well as a number of commonly-used macros are conveniently accessible from this menu too.

**Macro Browser Smart Fields**

When using the macro browser, an 'auto-complete' feature is now provided on any parameters that require the
entry of a single item, such as a page title, username or space key. This greatly facilitates the customisation of macros and minimises the need to know the exact item names in advance.

Editor speed

Thanks to many individual technical improvements, the Rich Text Editor opens up a lot faster than in previous Confluence releases. On a local network it appears almost instantly, and even when accessing a Confluence server on a different continent (in our case, accessing a Confluence server in the US from Australia) it takes less than 3 seconds to start editing a page.

Other Improvements

Add Pages or Blog Posts from the Dashboard

You can now add pages or blog posts directly from the Dashboard without having to browse to a specific space first. To do this, click on either the 'Add Page' or 'Add Blog Post' buttons to open the pop-up balloon, which allows you to choose the space in which to add the new page or blog post and in the case of pages, a template on which to base the page content.

New 'Link to this page' feature
If you wish to link to a Confluence page from any other location on the web, use the convenient 'Link to this Page' feature (available from any page's or blog post's Tools menu). Upon selecting this feature, the 'Link to this Page' dialog box opens, from which you can copy three versions of the link to embed elsewhere:

- **Link** – Standard URL which should work from any other accessible location on the web.
- **Tiny Link** – A reduced-length version of the 'Link', which can be used in text fields of limited length, such as tweets or Confluence Status Updates.
- **Wiki Markup** – A wiki markup version of the link, which can be used in any other location within your Confluence site.

"More" option on Activity Streams

A 'More' option has been added to various activity streams throughout the Confluence interface, including the profile sidebar, a user's profile page and via the recently updated macro. Clicking 'More' expands the list of results, providing a convenient means of accessing progressively more distant user activities.
User Interface Performance Improvements

Most JavaScript and Cascading Style Sheet (CSS) files are now downloaded in one batch, greatly improving the performance of Confluence’s editing features and general page rendering.

Other Small Enhancements and Improvements to Confluence

- Support for OAuth — With the introduction of gadgets (above) in this release, Confluence 3.1 now allows you to establish OAuth relationships with other web applications such as JIRA 4.0+, iGoogle, Gmail etc., thereby allowing them to share resources via gadgets.
- New Log In and Log Out screens.
- In an aim to minimise confusion, ‘News Items’ are now consistently called ‘Blog Posts’ throughout the Confluence interface and a list of blog posts is collectively referred to as a ‘Blog’.
- Macro developers are now able to specify whether the macro body should or should not be displayed in Rich Text editor. For more information, please refer to CONF-12149.
- Other minor interface improvements.

Confluence 3.1 Beta 1 Release Notes

⚠️ Confluence 3.1 Beta 2 has been released!

Please refer to the Confluence 3.1 Beta 2 Release Notes for updated information on the enhancements available in this version.

Confluence 3.1 Beta 1 is a public development release (“Beta”) leading up to the official release of Confluence
3.1, which we aim to ship in Q4/2009.

Confluence versions marked "Milestone", "Beta" or "Release Candidate" (RC) are development releases, which are preliminary releases leading up to the official release of a major Confluence version. They are a snapshot of our work in progress and provide an advance preview of new features to our customers and the general public. Confluence plugin developers can also use development releases to test and fix their plugins in advance of an official release.

The main distinction between a beta and a milestone release is that milestone releases typically acquire new features with each subsequent milestone version, whereas beta releases are predominantly feature-complete. Beta releases still undergo bug fixing and occasionally, existing features may be enhanced or added in subsequent beta versions. Release candidates are close to being ready for final release, but may still undergo changes before the final release.

![Do not use in production]

Development releases should not be used in production environments as they are not officially supported.

For all production use and testing of Confluence, please use the latest official release.

Who should try this out?

With development releases, the Confluence development team aims to provide plugin developers with an opportunity to see the latest changes in the code.

Furthermore, if you are a Confluence customer who is eager to see the new features and provide us with feedback on our upcoming major release, we encourage you to try out our development releases.

![Please note the following]

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Each development release has passed all our automated tests, has undergone some performance testing and has been used for one week on our official internal Confluence server. Furthermore, most of the solved issues have been reviewed.

Be aware that our development releases are still undergoing final performance and compatibility testing for databases and application servers. Hence, we recommend that you use development releases on installations with small (as opposed to full production-level) user bases.

**Upgrade Procedure**

If you wish to upgrade your existing Confluence installation with this version, ensure you have created a separate copy of your current Confluence production installation first and using that copy, follow the normal
upgrade instructions to upgrade it to this development release. If you have also implemented customised site- or space-specific layouts, you will need to re-implement them after the upgrade. Otherwise, some of the new features in Confluence (or possibly existing features) may not function correctly.

Downloads

All development releases are available from Development Releases on the Atlassian website.

Known Issues

There are several bugs outstanding which will be resolved before the official release. Some bugs you are most likely to come across are:

- **Page Preview** — When editing a page or blog post and you click the 'Preview' tab, only the first section of content is shown. You will not be able to scroll down to view the remaining content on a page.
- **Widget Connector Icon** — The current icon has not yet been finalised and will change before the official release of Confluence 3.1.
- **Quick Navigation Aid** — The Quick Navigation Aid does not work in Internet Explorer 6.0.

Refer to our JIRA site for a list of Confluence 3.1-specific bugs.

Highlights of Confluence 3.1

Highlights of this Release:

- Introducing Gadgets
- Office 2007 Support
- New 'Move Page' Feature
- New Image Browser
- Draft Comparisons
- New Page Restrictions Dialog Box
- New Rich Text Editor Insert Menu
- Other Editor Enhancements
  - Macro Browser Smart Fields
  - Edit Mode Exit Notification
- Other Improvements

Introducing Gadgets

Gadgets are small objects that offer dynamic content and functionality which may be served by any OpenSocial-compliant web application, such as JIRA 4.0+, the same or another Confluence installation, or non-Atlassian applications such as iGoogle and Gmail.

- Confluence supports the use of gadgets in pages and blog posts, which are accessible through the macro browser.
- Confluence can also serve its own gadgets, for use in any other OpenSocial-compliant web application including the same or another Confluence installation. Two such gadgets are bundled with Confluence:
  - **Activity Stream** — This gadget shows a list of recent activities that have occurred on the Confluence server, such as the addition of new pages, blog posts or comments, content edits, status updates and so on.
  - **Quick Navigation Aid** — This gadget provides heading and content search capabilities on a Confluence server.

Inserting a JIRA Gadget onto a Confluence Page

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence now provides full support for Office 2007 files, allowing you to view and edit content from Microsoft Word 2007 (.docx and .dotx), PowerPoint 2007 (.pptx and .potx) and Excel 2007 (.xlsx) files.

- Along with existing Microsoft Office versions, Confluence now fully indexes Microsoft Office 2007 files and their content can be searched by Confluence.
- Office files can be edited directly from any page's or blog post's list of attachments.
- Using Confluence's Office connector macros, you can insert Word, PowerPoint or Excel 2007 files directly into your Confluence page.

New ‘Move Page’ Feature

Confluence introduces a new page moving feature, that easily allows you to move the page you are currently viewing, adding or editing to another page elsewhere in the same or another space of your Confluence site. This feature is available through a new ‘page move’ dialog box, which provides the following flexible methods for moving pages:
- **Known Location** – Allows you to type the name of a space and within that space, the 'parent' page under which to move your page.
- **Search** – Allows you to search for a 'parent' page (within a selected space or set of spaces) under which to move your page.
- **Recently Viewed** – Allows you to select one of your recently viewed pages to be the 'parent' of your page to be moved.
- **Browse** – Allows you to select a space and page (within the tree of pages in the space) that will be the 'parent' of your page to be moved.

For more information, refer to [Moving a Page](#).

---

**New Image Browser**

A new 'Image Browser' has been introduced to replace the old 'Insert Image' dialog box. The image browser provides a less-cluttered and enhanced interface that allows you to:

- Hover over any image in the browser and expand the image (to preview it in detail) by clicking its 'magnifying glass' icon in the lower-right corner, before inserting it onto a page.
- Add a link to an image elsewhere on the web via the image's URL.
5 Draft Comparisons

Confluence's drafts features have been improved, such that you can now view any of your unsaved draft changes before deciding to resume editing them. This nifty feature comes in handy, particularly when other people have made subsequent changes to a page or blog post in your drafts list and you need to merge changes or resolve a conflict.

<table>
<thead>
<tr>
<th>Title</th>
<th>Last Saved Date</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page with Partial Content</td>
<td>less than a minute ago</td>
<td>Resume Editing</td>
</tr>
<tr>
<td>Page with Content to Merge</td>
<td>2 minutes ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Page with a Conflict</td>
<td>12 minutes ago</td>
<td>View Changes</td>
</tr>
</tbody>
</table>

Unpublished Changes for 'Working with Drafts Overview'

At regular intervals, Confluence will automatically save the page you are editing and maintain a copy of it as a draft. If some system failure or error prevents you from saving your changes, you can retrieve the draft and continue working on it.

A draft is a snapshot version of a page which Confluence saves automatically at regular intervals while you are editing the page. Confluence saves these interim versions even if you do not save the page yourself. This is a useful feature that minimises loss of work if your Confluence site experiences a problem.

At regular intervals, Confluence will automatically save the page you are editing and maintain a copy of it as a draft. If some system failure or error prevents you from saving your changes, you can retrieve the draft and continue working on it.

* Drafts are created while you are adding and editing a page or blog post.

...
Confluence’s page restrictions feature has been incorporated into a convenient and accessible dialog box that is now easier to use than before.

- The page restrictions dialog box can be accessed from the padlock icon or the ‘Tools’ → ‘Restrictions’ menu item on any Confluence page. From this dialog box, you can view all viewing and editing restrictions associated with the page you are viewing. You no longer need to view the page’s associated ‘Info’ page in order to view these restrictions.
- It is no longer necessary for a page to be in edit mode in order to modify its page restrictions. You can edit all page restrictions from this dialog box.
- The page restrictions dialog box is still accessible when a page is in edit mode.

New Rich Text Editor Insert Menu

Confluence’s rich text editor now combines a number of its commonly used editing features into a new convenient ‘Insert’ menu.

- The Horizontal line, Insert Symbol and Insert Emoticon Toolbar icons have been moved into the new insert menu.
- The functionality to insert images, links or attachments into a page can now also be accessed from this menu.
- The macro browser, as well as a number of commonly-used macros are conveniently accessible from this menu too.
Other Editor Enhancements

Macro Browser Smart Fields

When using the Macro Browser, an 'auto-complete' feature is now provided on any parameters that require the entry of a single item, such as a page title, username or space key. This greatly facilitates the customisation of macros and minimises the need to know the exact item names in advance.

Edit Mode Exit Notification

Whenever you add or edit a page, comment or blog post and then click onto another Confluence feature that navigates away from your unsaved content, a message box appears, warning that your content will be saved as a draft (if it is a page) or lost (if a comment). This allows you to cancel out of this action if it was accidental.
Other Improvements

Other small enhancements and improvements to Confluence include:

- Support for Internet Explorer 8 — Confluence 3.1 now fully supports Internet Explorer 8, released around mid-2009.
- Support for OAuth — With the introduction of gadgets (above) in this release, Confluence 3.1 now allows you to establish OAuth relationships with other web applications such as JIRA 4.0+, iGoogle, Gmail etc., thereby allowing them to share resources via gadgets.
- New 'Link to this page' feature — If you wish to link to a Confluence page from any other location on the web, use the convenient 'Link to this Page' feature (available from any page's or blog post's 'Tools' menu). Upon selecting this feature, the 'Link to this Page' dialog box opens, from which you can copy three versions of the link to embed elsewhere:
  - Link — Standard URL which should work from any other accessible location on the web.
  - Tiny Link — A reduced-length version of the 'Link', which can be used in text fields of limited length, such as tweets or Confluence Status Updates.
  - Wiki Markup — A wiki markup version of the link, which can be used in any other location within your Confluence site.
- 'More' links on activity streams — 'More' links have been added to various activity streams throughout the Confluence interface, including the profile sidebar, a user's profile page and via the recently updated macro. Clicking on a 'More' link expands the list of results, providing a convenient means of accessing progressively more distant user activities.
- New Log In and Log Out screens.
- In an aim to minimise confusion, 'News Items' are now consistently called 'Blog Posts' throughout the Confluence interface and a list of blog posts is collectively referred to as a 'Blog'.
- Other minor interface improvements.

Confluence 3.1 Newly Deprecated Code

This page should show all the code that was deprecated (not deleted!) during the Confluence 3.1 release cycle.

This is work in progress, and may not be a complete summary. As always, the truth is in the code. This page is more for explaining and discussing our decisions.

Release Notes 3.1-m7 (“Milestone 7”)
For testing use only
Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

Please note the following

- **Development releases are not safe**—Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**—Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Not quite a beta yet!

While this release is almost feature complete there are still one major technical improvement (superbatching) and one feature (the dashboard-widget) outstanding, so we can't call it beta just yet. Apart from that though, M7 is feature complete. Anything that you don't see here, you won't see in the final product. We will keep fixing bugs (yes, there are still quite a few unfortunately), but if something else in the functionality really annoys you, please raise it with us now! You can add a comment, or you can send us a mail, or of course raise JIRA issues.

Files are not available for download at the moment, they will be added on Thursday. This page is a teaser, and for use by our translators.

Gadgets & Office Team

Indexing and Searching of Office 2007 files

The contents of Confluence attachments created by PowerPoint 2007, Excel 2007, and Word 2007 are now fully searchable inside Confluence. This includes files with pptx, xlsx, and docx extensions as well as other extensions like potx (PowerPoint template) and dotx (Word template).

PowerPoint 2007 previews

You can now preview PowerPoint 2007 files directly in Confluence. We're proud to say that this completes the goal of supporting the new 2007 file formats for the three main Microsoft Office products (Word, Excel, and PowerPoint) in Confluence 3.1. This is in addition to already supporting the legacy binary format.

Keyboard navigation of full-screen PowerPoint and PDF slideshows

If you are using Flash player 10 or higher, you will no longer see any controls when previewing Powerpoint or PDF files in full screen mode. Instead, you must use the spacebar or the arrow keys to move between the slides. Press escape to exit full screen mode.
Launch Microsoft Office from the Attachments screen.

Previously, you had to preview a file to get the option to edit it. We've added a new 'Edit' option to each attachment that will launch the appropriate desktop editor for that attachment. The old 'Edit' option has been renamed to 'Properties'.

Editing user preferences of OpenSocial gadgets in the Macro Browser

As promised in the last release notes we moved the editing of non hidden user preferences to the usual location for macro parameters on the right hand side:

Activity Stream Gadget

We've added an activity stream gadget for Confluence. This means you can now have your Confluence Activity on your JIRA dashboard or on a Confluence page! You can also directly comment from the activity stream.
Dialogs Team

Page move dialog

We've added new tabs and improved the design of the new Move Page dialog based on feedback from earlier iterations. Some key improvements:

- A quick way of specifying a known location in the wiki using space and page title autocomplete (quick-nav style)
- Search and Recently Viewed tabs for locating a parent page in different ways
- An improved tree component which gives better loading feedback
- Fixed description panels so helpful text doesn't disappear when you scroll the tree
- A new location panel in the dialog so you know where you're moving a page from and to
- Immediately highlight problems with the new location, such as attempting to move a page beneath itself or its children.

The move dialog is feature-complete for this release, but we still have a few remaining improvements to make. In particular, scrolling the tree to the correct location when it opens and making the tree completely undraggable will be fixed for the next release.

Image browser

The new image browser dialog now supports uploading files. The upload proceeds faster than before (because the entire window doesn't need reloading), and you'll get a thumbnail of your image preselected, ready to insert.

We've fixed the bugs with image borders that prevented them working properly in the rich text editor, and enabled borders by default for newly inserted images. The dialog also includes some simple keyboard navigation that should make it more intuitive to interact with. All features of the image dialog have been tested with all our supported browsers.
We also spent some time on improved validation of uploaded attachments and thumbnail generation. The old insert image window is now disabled, so please let us know if you have any problems with the new functionality.

![Insert Image Dialog](image.png)

The image dialog is feature-complete for this release, but also has a few issues which will be fixed before the final release. Better handling of server outages and not being able to attach due to permissions is coming in the next release.

**Page "Permissions" dialog**

We have reverted to the two row layout to avoid permission-restriction-inconsistencies, and fixed a few bugs along the way. Most notably, inherited restrictions are now displayed separately from the current level's restrictions, and hidden by default. This avoids cluttering the page with stuff you usually know about already (when working in restricted page hierarchies).

![Page Restrictions](image.png)

**Engine Room**

Nothing big went into M7, the super-batching work is ongoing and will mean faster page loads from 3.0-beta1 onwards.

**Small Improvements**

The footer is now always at the bottom at the viewport, rather than the bottom of the content. This makes the layout a lot cleaner on short pages:
Open bugs

Plenty.

What's next?

Beta 1 is due next week

Release Notes 3.1-m6 ("Milestone 6")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Overview

We are pretty close to Beta now, so if you are a plugin author and haven't checked out the latest milestones of 3.1, you should do it now. The API won't change much anymore, from now on it's mainly bugfixing.

Gadgets & Office Team

Editing user preferences of OpenSocial gadgets in the Macro Browser

You can now edit user preferences of OpenSocial gadgets directly in the Macro Browser. Let's take our all time favourite Hamster gadget as an example:

![Hamster Macro UI](image)

The UI will be slightly different in the next milestone, as we are going to move the form fields in the center of to the right hand side and make them part of the normal macro parameters.

Gadget Directory

You can now discover which gadgets are exposed by Confluence and can be used in other OpenSocial containers like JIRA 4 or iGoogle. There is a new "Gadget Directory" menu item in the browse menu which allows you to browse through the list of available gadgets.

Dialogs Team
There's a new "Insert" menu in the editor that helps you insert links, attachments, images and some default macros without having to already know which little button you’re meant to press. (On IE the macro icons look odd, that’s a bug and will be addressed soon)

**Help us choose the right macros!**

We picked a few macros that we thought users should know about, which are simple enough to use right away, and which represent a decent spread across a range of macros to stimulate your interest in the "add more" button. Our constraint is 5 macros max, since the menus gets too long on stupid good old IE6 on a 1024x768 screen.

Apart from the edit menu, some bug fixes of note: Problems with links in the RTE have been fixed; pressing escape in the new image dialog doesn't prevent it working next time; and move page works in IE8.

A lot of work has gone into the new page move dialog but it's not quite ready, so we didn't put it into M6.

**Engine Room**

A setting (under General Config) to serve the Javascripts back in the header has been introduced. This has been disabled by default for this milestone but will eventually be turned on as the default for 3.1. Reasoning behind this is that quite a few plugins have been broken and unusable by moving the scripts to the bottom of the page.

Work has been continued on the REST API however these were purely back end changes and the API itself has not changed since m5.

**Bugfix Team**

CONF-17171 - made selecting a page version on a page history view easier
General bug fixing.

**Small Improvements**

New Login Screen design, which looks more consistent with other products like JIRA. Another step forward in terms of making Confluence look better
Known Issues

Errors were reported by the JIRA trusted connection.

- APPUNKNOWN; Unknown Application: {0}; ["confluence:4557196"]

<table>
<thead>
<tr>
<th>JIRA Issues</th>
<th>(5 issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Key</strong></td>
</tr>
<tr>
<td>📋</td>
<td>CONF-1 7444</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-1 7332</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-1 7235</td>
</tr>
<tr>
<td>Issue</td>
<td>Data</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
</tr>
</tbody>
</table>

**Release Notes 3.1-m5 ("Milestone 5")**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Gadgets & Office Team

Gadgets in the Macro Browser

Want to embed one of those fancy new JIRA gadgets into your page? This has become really easy with the new Macro Browser integration. Just have a look in the “External Content” category to find available gadgets. Confluence comes with the Confluence QuickNav gadget by default, but the administrator can add as many gadgets as you like.

Configure your JIRA gadgets in the Macro Browser

You can now configure your JIRA gadgets using the macro browser. Just pick a JIRA gadget from the Macro Browser, configure it and add it to your Confluence page or blog post.

Office 2007 support

We've fixed a couple of minor issues with the Word 2007 integration. But the really good news is that we've started working on PowerPoint 2007 support! Nothing to see yet, but stay tuned.

Dialogs Team

The new image browsing dialog has been restyled and as a bonus now works in new pages and blogs.

Engine Room

The Confluence REST plugin (prototype API) has now been enabled for this milestone. In addition to spaces (in previous milestone) we now have an API for viewing Confluence content (pages, blogs, comments) with page children expansion supported.

Some very basic documentation can be found here: Prototype REST API

Bugfix Team

Fixed multiple bugs.
Misc

Faster editor load

With a few improvements we have made to the way we load TinyMCE, it should appear faster across all the browsers.

This is an Agnes Ro 20% production

Prototype REST API

This page documents the Prototype REST API supported for Confluence 3.1.

Space

Getting a List of Spaces

Resource: `/space`
Description: List all spaces (maximum page size of 50) visible to the current user
Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>start-index</td>
<td>start offset of the list</td>
</tr>
<tr>
<td>max-results</td>
<td>maximum number of results to return</td>
</tr>
<tr>
<td>type</td>
<td>space type e.g. personal, all</td>
</tr>
<tr>
<td>expand</td>
<td>use 'space' to expand the spaces details of each space listed</td>
</tr>
</tbody>
</table>

Result:

```
<spaceEntityList expand="space">
  <space name="FOO" key="FOO">
    <link rel="self" href="http://localhost:8080/confluence/rest/prototype/1/space/FOO"/>
    <rootpages size="1"/>
  </space>
  <space name="Test Space" key="TST">
    <link rel="self" href="http://localhost:8080/confluence/rest/prototype/1/space/TST"/>
    <rootpages size="2"/>
  </space>
</spaceEntityList>
```

Looking up Details of a space

Resource: `/space/{key}`
Description: Displays the details of the space identified by {key}
Parameters:
Content

Getting Content

Resource: /content/{id}
Description: Gets confluence content by id
Parameters:

```
| expand | use 'children' to list all the child pages of the page |
```

Result:

```
<content type="page" id="1180211" expand="children">
  <link rel="self" href="http://localhost:8080/confluence/rest/prototype/1/content/1180211"/>
  <title>Home</title>
  <spaceKey>FOO</spaceKey>
  <children size="1"/>
  <body>This is the home of the FOO space.</body>
</content>
```

Release Notes 3.1-m4 ("Milestone 4")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Features!

As you may know, we have started a major hiring campaign, and this has slowed us down a little in the past few weeks. M4 however is back with a vengeance, boasting quite a few improvements. See for yourself

Editor Team

Move Page

We are reworking the way you can move pages around. It is now possible to move pages without editing the page, and you don't drag&drop anymore, you simply pick your parent in the tree. The next Milestones will allow you to search for a parent, and to use your recently viewed pages to move. At the moment, you can not re-order while moving the page (is this a problem though? What do you think?)

Macro Browser

David Taylor's "Smart Fields" 20% project has been included in the Macro Browser although only for macro parameters that take single entries. i.e. if a macro takes a single username, space, or page then a suggestion drop down will be presented (See the screenshot). If a macro takes multiple usernames or spaces or pages then there will be no assistance.

Displays the excerpted contents from another page within the same space. Documentation

Page Containing the Excerpt

David's "Smart Fields" work also included some custom fields for the Office Connector viewfile macros to provide assistance with referencing the MS Office document you are trying to view. Instead of separate fields for
space and page name these have been combined into a singe field with a suggest drop down. The file name field has been converted to a select box showing the appropriate attachments for the selected page.

Embeds an Office Excel document (.xls) into your Confluence page. Documentation

**Page Name**

Monkey Trousers

Confluence page containing the attached .xls file. If not specified, the current page is assumed.

**File Name**

editorteamtracking.xls

Name of the attached .xls file to view in a page.

**Show Grid?**

✔

Shows or hides grid lines.

**Worksheet Name**

Name of worksheet to show. If not specified, the first worksheet is shown.

**Last Row**

Number of last row to show, where the first row starts at 0. Example: to show the first 2 rows, use 1. If not specified, all rows are shown.

**Image Browser**

Some further progress has been made on the second "insert image" button on the RTE and wiki editor toolbars. You can now view and insert images that are already attached to the page.

This dialog is still missing some obvious functionality such as image configuration options and image upload hence the reason the original dialog is still present for now.

**Known Issue:** You should also note that in the current milestone this new dialog is only working correctly when editing pages, not when creating new pages.

**Engine Room**

**JS/CSS rearrangements**

As you saw on our previous milestone notes, we have rearranged CSS to the top and JS to the bottom of the page, making the rendering experience better. This might have consequences for your macros/plugins, so DO have a look, and tell us what you think.

**REST**

The Confluence REST plugin (prototype API) has been added, however it will be disabled for this release. Hopefully we will be able to enable this in next milestone when the plugin is a bit more stable.

Some space level resources have been implemented.

**Getting a List of Spaces**

**Resource:** /space
Description: List all spaces (maximum page size of 50) visible to the current user

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>start-index</td>
<td>start offset of the list</td>
</tr>
<tr>
<td>max-results</td>
<td>maximum number of results to return</td>
</tr>
<tr>
<td>type</td>
<td>space type</td>
</tr>
</tbody>
</table>

Result:

```xml
<spaces>
  <space name="Demonstration Space" key="ds">
    <link rel="self" href="http://localhost:8080/rest/prototype/1/space/ds"/>
  </space>
</spaces>
```

Looking up Details of a space

Resource: `/space/{key}`

Description: Displays the details of the space identified by `{key}`

Parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>expand</td>
<td>set expansion options for children elements</td>
</tr>
</tbody>
</table>

Result:

```xml
<space name="Demonstration Space" key="ds" expand="children">
  <link rel="self" href="http://localhost:8080/rest/prototype/1/space/ds"/>
  <children size="2"/>
  <home>
    <id>32799</id>
    <link rel="self" href="http://localhost:8080/rest/prototype/1/content/32799"/>
    <type>page</type>
    <title>Home</title>
    <url>/display/ds/Home</url>
    <children size="6"/>
  </home>
</space>
```

⚠️ Some of the names of the elements in the space details example are subject to change. The `children` element for example will likely be changed to something more appropriate (it refers to the top level pages of a space).

Small Improvements Team

Driving on the left shouldn't be so hard, so we've updated the left hand navigation panel.
Bugfix Team

Fixed multiple bugs. Most notably:
CONF-12864 - improved performance of PageNotFound action
CONF-9575  - fixed concurrency issue that was breaking reindexing job

Gadgets & Office 2007 Team

Word 2007 & Excel 2007

We added Word 2007 support for document import and the view-file macro, as well as Excel 2007 support for the view-file macro. We don't support PowerPoint 2007 for the view-file macro yet and can't index any Office 2007 documents yet. Work in progress.
Support for importing other document formats

You can now import RTF and ODT files in addition to DOC and DOCX.

Gadget Macro

We are happy to introduce the new gadget macro! It's currently not very usable as we don't have any UI yet to change the user preferences for a gadget, which means you have to enter them manually.

Example Markup:

```
{gadget:url=[baseurl]/rest/gadgets/1.0/g/com.atlassian.confluence.plugins.gadgets:gadget-search/gadgets/gadget-search.xml}{gadget}
```

Jira chart gadget and Confluence QuickNav gadget on a Confluence page:

QuickNav gadget

We are also stoked to show off our first Confluence gadget which can be embedded in other gadget containers. The gadget URL is:

```
[baseurl]/rest/gadgets/1.0/g/com.atlassian.confluence.plugins.gadgets:gadget-search/gadgets/gadget-search.xml
```

Unfortunately you can't embed that gadget into iGoogle or GMail yet, because we have to upgrade to a newer version of the OAuth plugin first. This will work starting in 3.1-m5.
Gadget Directory

For every gadget you want to embed on a page, it needs to be added to the gadget directory first. This is to make sure you can’t just embed any third party gadgets because those might contain malicious JavaScript which will then be executed as coming from the same security domain as Confluence.

OAuth Integration

We have also integrated the OAuth admin plugin which allows you to configure your consumer information as well as adding OAuth consumers and service providers. Detailed documentation will be available on CAC in the future.

20% and miscellaneous

Thumbnail Dialogs

Thumbnail images previously opened the full image in a new popup window, when clicked. Now clicking on a thumbnail opens the image in a fancy dialog (same as the image gallery).

Sprite Image for Macro Browser

On the edit page, the macro browser is built up in the background with its pretty macro icons. Although the macro icons are cached, there are quite a number of requests made on a cold browser cache (we have 52 macro icons, so 52 requests are made just for the macro browser). This has been reduced to one request by generating a sprite image for all the icons and using it with css and background-image positioning.

hod has been added for macros to more clearly define their desire to be kicked out of paragraphs, and code macros do that. This change is still awaiting review, so it may be temporary.

AUI upgraded to 1.2.1!

Release Notes 3.1-m3 ("Milestone 3")
For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

Please note the following

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
**Maintenance mainly**

Milestones 2 and 3 don't have many feature-changes, because a lot of the development happens on branches and under the hood. We have been doing some UI polish, but nothing large is to be seen yet.

We did however split up resource-loading, so CSS is now at the top of the page, and JS is at the bottom, resulting in faster page views. If you are a plugin author using resource bundles and JS/CSS (which you should, obviously), then definitely check out this milestone to see if your plugin works as expected.

Stay tuned for M4 in about two weeks, which will show off some nice new feature improvements.

Cheers,
Per and the Confluence development team

**Confluence 3.1 Deprecated Code Cleanup**

This document contains information for Confluence plugin developers regarding changes to the Confluence codebase in the upcoming 3.1 release.

Confluence 3.1 Deprecation Cleanup

Every major Confluence release, we clean up the codebase by removing classes and methods that have been deprecated in previous releases. These changes were included in the Milestone 2 release of Confluence 3.1. We strongly encourage plugin developers to test their plugins against our milestone releases.

If the removal of these classes or methods causes you significant problems maintaining your plugins, please let us know. We will work with you to find a workaround, or possibly reinstate the code before the final release. (Note that the longer the code in question has been deprecated, the less inclined we will be to replace it. Some of the stuff we've removed here will have been giving you compiler warnings for years.)

More information on our guidelines for removing deprecated code: [Deprecation Guidelines](#)

Changes in Confluence 3.1 Milestone 2

For the sake of brevity, the `com.atlassian.confluence` part of package names has been omitted.

**Removed Classes**

<table>
<thead>
<tr>
<th>Class</th>
<th>Deprecated Since</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pages.BreadcrumbsManager .pages.DefaultBreadcrumbsManager</td>
<td>2.7</td>
</tr>
<tr>
<td>.plugin.descriptor.web.conditions.user.UserHasHistoryCondition</td>
<td>2.8</td>
</tr>
<tr>
<td>.util.VelocityUtils</td>
<td>2.0</td>
</tr>
<tr>
<td>.util.PageComparator</td>
<td>2.3</td>
</tr>
<tr>
<td>.util.ResourceManager com.atlassian.confluence.util.DefaultResourceManager</td>
<td>2.8</td>
</tr>
<tr>
<td>Class</td>
<td>Constant</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
</tr>
<tr>
<td>.search.lucene.extractor.PageContentEntityObjectExtractor</td>
<td>PAGE_REAL_TITLE</td>
</tr>
<tr>
<td>.security.SpacePermission</td>
<td>ADMINISTER_CONFLUENCE_PERMISSION</td>
</tr>
<tr>
<td>.setup.Bandana.ConfluenceDaoBandanaPersister</td>
<td>GLOBAL_BANDANA_CONTEXT</td>
</tr>
</tbody>
</table>

**Removed Methods**

<table>
<thead>
<tr>
<th>Class</th>
<th>Method</th>
<th>Deprecated Since</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>.core.ConfluenceActionSupport</td>
<td>ThemeHelper getGlobalHelper()</td>
<td>2.0</td>
<td>Support for pre-2.0 themes</td>
</tr>
<tr>
<td></td>
<td>ThemeHelper getSpaceHelper()</td>
<td>2.0</td>
<td>Support for pre-2.0 themes</td>
</tr>
<tr>
<td>.core.ContentEntityManager</td>
<td>Iterator getRecentlyModifiedEntities(int maxResults)</td>
<td>2.0</td>
<td>use the SearchManager for this kind of query</td>
</tr>
</tbody>
</table>

1 While the ResourceDownload class was only deprecated in 2.10, it could only ever be used in the context of the ResourceManager which was deprecated earlier. It is very unlikely that code exists that relies on one but not the other.

2 These Radeox macros were superseded by the equivalent V2Renderer macros in Confluence 1.4, but only marked as deprecated in the 2.7 release.

---

**Removed Constants**

Since Java inlines constant references during compilation, the removal of constants should not break binary compatibility with any plugin that references them.
<table>
<thead>
<tr>
<th>Class</th>
<th>Method</th>
<th>Since</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>.core.ContentEntityObject</td>
<td>String getRealTitle()</td>
<td>2.8</td>
<td>use getDisplayTitle() instead</td>
</tr>
<tr>
<td>.core.ContentPermissionManager</td>
<td>List getInheritedViewContentPermissions(Page page)</td>
<td>2.5</td>
<td></td>
</tr>
<tr>
<td>.core.persistence.ContentEntityObjectDao</td>
<td>Iterator getRecentlyModifiedEntitiesByType(ListQuery query, int firstResult)</td>
<td>2.8</td>
<td>use the SearchManager for this kind of query</td>
</tr>
<tr>
<td>.importexport.ExportContext</td>
<td>DateFormatter getDateFormatter()</td>
<td>2.8.2</td>
<td></td>
</tr>
<tr>
<td>.pages.AttachmentUtils</td>
<td>static File getOldContainingFolder(Attachment attachment)</td>
<td>2.2</td>
<td></td>
</tr>
<tr>
<td>.pages.actions.ViewPageAttachmentsAction</td>
<td>AttachmentHelper getTargetHelper(Attachment attachment)</td>
<td>2.8</td>
<td>use getWebInterfaceContext()</td>
</tr>
<tr>
<td>.plugin.editor.Editor</td>
<td>String getEditorSpecificCss()</td>
<td>2.8</td>
<td></td>
</tr>
<tr>
<td>.security.ContentPermission</td>
<td>String getGroup()</td>
<td>2.4</td>
<td>use getGroupName()</td>
</tr>
<tr>
<td>.security.PermissionManager</td>
<td>boolean isGlobalAdministrator(User user)</td>
<td>2.7</td>
<td>use isConfluenceAdministrator()</td>
</tr>
<tr>
<td>.setup.BootstrapManager</td>
<td>boolean isConfluenceHomeValid()</td>
<td>2.8</td>
<td>use SettingsManager</td>
</tr>
<tr>
<td></td>
<td>boolean isWebdavEnabled()</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>void setBaseUrl(String baseUrl)</td>
<td>2.8</td>
<td>use SettingsManager</td>
</tr>
<tr>
<td>.spaces.SpaceManager</td>
<td>boolean isValidSpaceKey(String key)</td>
<td>2.3</td>
<td>use Space.isValidGlobalSpaceKey()</td>
</tr>
<tr>
<td></td>
<td>boolean isValidPersonalSpaceKey(String key)</td>
<td>2.3</td>
<td>use Space.isValidPersonalSpaceKey()</td>
</tr>
<tr>
<td>Class/Method</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getPages(Space space, boolean currentOnly)</td>
<td>List getPagesStartingWith(Space space, String prefix)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getBlogPosts(Space space, boolean currentOnly)</td>
<td>List getMail(Space space, boolean currentOnly)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getSpaces()</td>
<td>List getSpacesCreatedOrUpdatedAtSinceDate(Date date)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.spaces.Space</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getPages()</td>
<td>2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getCurrentPages()</td>
<td>List getBlogPosts()</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getMail()</td>
<td>List getCurrentMail()</td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getSpaces()</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List getSpacesCreatedOrUpdatedAtSinceDate(Date date)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>.user.PersonalInformationManager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PersonalInformation getPersonalInformation(String username)</td>
<td>2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.user.SearchEntitiesManager</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SearchResult findGroups(TermQuery query)</td>
<td>2.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SearchResult findGroups(TermQuery query, boolean filter)</td>
<td>2.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SearchResult findUsers(Query query)</td>
<td>2.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.util.GeneralUtil</td>
<td>String format(Date date)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>formatTime(Date date)</td>
<td>2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>formatBlogDate(Date date)</td>
<td>2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>formatDateTime(Date date)</td>
<td>2.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>isGlobalAdministrator(Object notUsedAnyMore, User user)</td>
<td>2.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>use PermissionManager or $permissionHelper</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Release Notes 3.1-m1 ("Milestone 1")

ℹ️ Outdated page

These are not the release notes you are looking for

This page is outdated, but has high Google ranking 😞

Please refer to the official Confluence 3.1 release notes over here.
For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

Please note the following

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Yay, we are back!

After 3.0 came out, we spent some time in bugfix-mode, then we had a 20% week, 2 devspeed weeks, and the last week was mainly spent planning the next release. So that’s why there has not been much visible progress recently lately. Development on core 3.1 features has started, but in this milestone we mainly ship all the bugfixes we did for 3.0.1, some small improvements, and three 20% projects.

New Webstart Installer

We are trying something new. While we will provide the downloadable files too, we encourage you to try our webstart based evaluation installer. Visit http://webstart.atlassian.com/confluence-3.1-m1-r2/confluence.jnlp for a snappy installation experience.

New Native Mac Installer

When you go to the download section, you will notice a new DMG file. This contains our new native experimental Mac installer. Give it a try and tell us what you think. Instructions coming soon!

And here are all the cool features in M1 you will get.

1

Interactive "Get more"

Recently updated macros are now interactive. You will get a little "More" link to load new updates dynamically within the page. This small but awesome feature can also be found on your network page, and in the space’s recent update tab. It doesn’t screenshot too well, so try it out for yourself. Anyway here is what the macro looks like:

And here is what the network tab looks like:
Caveats:

- We feel that the link is a bit small and can be mistaken for a normal link. Especially on the static pages (network, updates in space) it makes sense to make the button much larger and more prominent. We will work with Design to find a solution.
- The link also needs to go into the profile page (so you can see more updates on everyone’s stream), and into the status tab. Dave will add that soon.

This is a Dave Loeng 20% production

Draft diffs and visibility

Always wondered what your old drafts were about? Or when a draft is being saved, what part of that huge document you’re editing has actually changed? Well, now you can, thanks to DraftDiffs.

View the diff right from the edit page:
View what your old drafts are about from the drafts overview page:

<table>
<thead>
<tr>
<th>Title</th>
<th>Last Saved Date</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is my sample page</td>
<td>less than a minute ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Links Browser Spec</td>
<td>19 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Promote your blogpost</td>
<td>25 days ago</td>
<td>Resume Editing</td>
</tr>
<tr>
<td>secret test page</td>
<td>20 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Leave planning Confluence</td>
<td>35 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>RTE Placeholder Alternatives</td>
<td>104 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Community for Confluence 3.0</td>
<td>113 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Confluence 3.0-milestone Notes</td>
<td>121 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Problems with specific macros</td>
<td>155 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Secondments - Confluence</td>
<td>162 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Email? That is so 1995…</td>
<td>238 days ago</td>
<td>View Changes</td>
</tr>
<tr>
<td>Home</td>
<td>240 days ago</td>
<td>View Changes</td>
</tr>
</tbody>
</table>

Which takes you to this screen:
Known issues: Annoying Javascript alert when there are no changes at all. This feature unfortunately also highlights our roundtripping bugs... ahem...

This is a Brian Nguyen 20% production

Small Improvements

Edit loss warning

Whenever you are in edit mode and decide to leave the page or close it, you will now get a warning popup. This is especially useful when writing comments (no drafts...) and for technically challenged people who don’t understand drafts in the first place. As raised in the JIRA issue, we may have to provide a setting to disable these warnings (it can be a bit annoying if you like to change your mind often), so watch CONF-16075 for updates. The idea has been raised that we may only want this feature for comments when no drafts are being saved. We will dogfood this over the next few weeks, and see how we like it or not.
Gradient

This is just an experiment, probably not shipping as a default for 3.1, but worth a look. Do you like it?

Dashboard › People › Per Fragemann › Network

Per Fragemann

More options to search for by time

We added two more options to filter by time: Last 6 months, Last year, Last 2 years, and fixed the calculation for today/yesterday by making it work by 24h instead of what the server thinks is midnight. 48h obviously encompasses the last 24 hours two, which was awkward in the old system, where yesterday would really just mean yesterday, but not today.

Plugin points in the editor

We were approached by a developer who wants to write a spellchecker plugin for Confluence, so Agnes volunteered to pluginpointinize the editor. You won’t see anything right now, but it will make many plugin authors
happy. Read the documentation for how to write plugins for the editor.

This is an Agnes Ro 20% production

"Link to this page" Dialog

In order to make Tiny Links more accessible, we added a new Menu option which opens a new dialog, which shows the three ways to link to a page. Full URL, TinyURL, and Wiki Link. Probably the Full URL is not as important, but the dialog looked a bit unbalanced, and it makes it clearer that both URL’s are equivalent.

Selecting the menu opens up this dialog, with the Tiny Link conveniently selected.
We didn't rename Tiny Links to Permalinks, as has been suggested. What do you think, should we?

This is the final Chris Broadfoot 20% production.

**Release Notes 3.0-rc1 ("Release Candidate 1")**

Hi everyone,

we are approaching the 3.0 release date. We have built our first release candidate, and we hope to turn this into the final release unchanged soon.

There have been a few changes since the last two betas: The translations are now up to date, more icons have been added to the macro browser, and we have tweaked a few screens, like the profile page. And of course we have fixed dozens of bugs (see JIRA URLs below). We are very pleased with the quality of the release and we are currently not aware of any showstoppers or critical issues. Chances are that the final release will be just a rebranded RC, however you should still not use the RC on production systems, since we still have some final testing planned. We encourage you to use it for staff training purposes and for your upgrade testing though, since no more UI changes or changes to the upgrade process are scheduled.
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.

Thanks for your feedback so far, it has helped us track down a few bugs, which will result in a smoother upgrade for everyone!

Cheers,
The Confluence Team

**Release Notes 3.0-beta2 ("Beta 2")**

**Welcome to our Beta Phase**

The Confluence team is proud to present the first public beta release of our upcoming Confluence 3 release. It contains all the features we intend to ship. We will be publishing Beta 3 next week, and then a rapid succession of Release Candidates in two weeks. We aim at shipping Confluence 3.0 in (very) early June.

So, calling all plugin developers: If you want to make sure your plugin plays nicely with 3.0 on the launch date, and if you maybe even want to use our new features from within your plugin, this is really the last chance to get started. Download the Beta right now

Note: This is still not a stable release, it is not meant for production use. So our normal Milestone disclaimer still applies:
**Milestone release advisory**

⚠️ **For testing use only**

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the [latest official release](#).

This release is a public development release ("milestone") leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

### Who should upgrade?

⚠️ **Please note the following**

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we **can not** provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

### Upgrade Procedure

Follow the [normal upgrade instructions](#) to upgrade your test instance to this release. *We strongly recommend that you backup your Confluence home directory and database before upgrading!*

### Downloads

All development releases are available from the [development releases page](#) on the Atlassian website.
What is in it?

All the features we intend to ship are available in this beta. Unfortunately, the official documentation is not ready yet, so until we get a more official summary of the new features, please refer to our recent Milestone release notes, and try the beta out yourself.

Improvements

Since publishing Milestone 9, we have focussed on polishing our existing features. Here is a rundown on the changes since then:

Community features

Some important bug fixes:

Some IE issues: CONF-15497, CONF-15137, CONF-15474, CONF-15421, CONF-14593
Improvemnets to User Follow: CONF-15335, CONF-15279, CONF-15427, CONF-15286, CONF-15016
Removed the annoying page reload when following a user, CONF-15290

Macro Browser

Preview button removed and replaced by a refresh icon:

Old:

![Old refresh button]

New:

![New refresh button]

Some important bug fixes:

CONF-14720 Inserting a macro via the macro browser would always scroll to the top, which is very annoying if you are editing the end of the page.

CONF-15487 It is now possible to insert more than one macro in Safari via the macro browser!

Office Connector

CONF-14798 Performance improvements on the backend for the viewfile macro.

Also, the initial loading of the Flash front end should be a little snappier. There was a default “pre-load” screen that added 1-2 seconds to the load time. We also changed the background color to white so it also adds the impression of not appearing until it’s loaded.

<table>
<thead>
<tr>
<th>old</th>
<th>new</th>
</tr>
</thead>
</table>

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
**Engine Room**

Confluence has been upgraded to the latest releases of Plugins 2 and SAL.

We did a small performance improvement by caching PersonalInformation objects by user name ([CONF-15484](#)), which will in particular speed up the rendering of profile pictures.

As part of this release cycle we fixed a lot of smaller bugs, but the most notable ones were related to content indexing:

- **CONF-15352** Fixed a race condition during content indexing which would result in leaked file handles, which had been introduced in M9
- **CONF-15483** Fixed a problem with a reindex being started before the plugin system was loaded. This would result in empty documents in the index.

**Random**

**CONF-14322** was fixed, so change comments containing ampersands and angle brackets will no longer affect the system.

**Known Issues**

The Flash preview is broken in Office Connector that is bundled with beta 2. See [CONF-15612](#). It's already fixed and it will be bundled in Beta 3 next week.

**Release Notes 3.0-m9 ("Milestone 9")**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Summary

We are one week away from feature freeze, so this is the last major milestone before we enter beta next week. We are still working on some wording, on some plugin upgrades, and a few UI tweaks, but M9 is pretty much how Confluence 3 will look like. From now on, it's mainly about fixing up non-critical bugs and doing code reviews. Many Code reviews! 😊

Enjoy:

Community

Followed Users and Favourite Spaces

The terminology has been cleaned up and made consistent across the application. If you want to see what a user is doing you follow them, if you want to see what happens in a space, you mark that space as favourite. You can mark a personal space as favourite, and this is independent of following the user who owns the space.

One area we still want to improve is the 'User Follow' menu item and profile tab, which needs a better name.

Follow Tab RSS and Design Improvements

You can now get an RSS feed on any user's 'User Follow' tab. This feed will include all activity of the users followed by that person. This is a great new way of monitoring content on the Extranet.

We've redesigned the follow tab to highlight the activity information more and handle large lists of followers. We also added some clarifying text to this tab to better describe the different sections of this page.

There is now a maximum number of followers shown on this page, and separate pages to show the complete list. This addresses the performance and usability problems discovered in the previous milestone when you had a large number of followers or people following you.

Profile Page Updates

The layout of the profile page has been changed to try to improve the visibility of the activity. This puts the user's personal information over on the right hand side of the page.

On the left hand side, we now have new links to follow a user and favourite their space.
Update User Status Permission

A new global permission was introduced to give system administrators control over who can use the user status feature.

If the permission is turned off for a user (or their group) then they will not have the ability to set their user status, nor will they have an 'Status Updates' tab in their profile.

Macro Browser

Macro Browser in the RTE

The Macro Browser is now finally available in the Confluence rich text editor (RTE)! It will assist you in inserting and editing macros, without having to understand the wiki markup.

Editing a macro can be done by placing the cursor in the start or end tags of the macro wiki markup. If you have context menus enabled, you will also see a new option for insert/editing macros.

Upgraded Macro Icons

Thanks to Stephen, we have even better icons for the macros in the macro browser. Check 'em out!

AUI 1.0

Confluence is now using the first release of AUI, 1.0.
PDF Export

Many bug fixes have been done for the new PDF export:

- **CONF-15220** - PDF Export converts a bulleted sublist into a numbered sublist
- **CONF-15148** - Follow macro should not include the 'Add' action when exported to PDF
- **CONF-15042** - PDF Space Export text uses US spelling instead of Australian
- **CONF-15038** - PDF Export from a page with non-default theme is trying to use the old method, and so it fails with an error
- **CONF-14909** - column and section macros render differently in PDF export when they have borders
- **CONF-14904** - IM presence macro shows a roque nbsp when exporting to PDF
- **CONF-14901** - The PDF export doesn't recognize all literal colors when used in the color macro
- **CONF-14889** - PDF Export from the Info pages is trying to use the old method, and so it fails with an error

Engine Room

Confluence has been upgraded to the latest releases of Plugins 2 and SAL.

Release Notes 3.0-m8 ("Milestone 8")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Summary

The Confluence team is excited to bring you our latest milestone release: Confluence 3.0-m8, "Milestone 8". This release includes a huge amount of improvements to the community features, additional performance improvements and many bug fixes.

Community

Be sure to check out the great improvements in Confluence's new community features:

- Improved Activity list on Profile Page - The user status list has been moved to its own tab and the new Recently Updated Macro has been put in its place. It's also been given a face lift and fits nicely into the profile page. Facebook eat your heart out.

- Status list moved to separate tab with pagination - The user status list now has a proper location, it's own tab. This tab is the central place where you manage and view your historical status updates. Links to delete old status updates will be found on this tab.

- Each status item has its own page so you can link to a status - You can now create links to old status objects allowing for historical references as each status can be displayed on its own page.

- Personal space sidebar has been updated to include an activity list and your follower information - The personal space sidebar is coming along nicely and looks great with the new recently updated macro and the follow information.

- Adding a follower on your Favourite People tab (or using the hover) will refresh the page and update the list immediately - We changed how the follower information was looked up as to not use the lucene index and hooked into the hover so most changes on this page will trigger a refresh and the updates will be seen immediately! No more wondering if your new follower actually worked

- Those extra fields on your User Profile page are now run through the wiki renderer allowing links and simple formatting
**Macro Browser**

The macro browser team spent the past two weeks working behind the scenes on placeholders for the rich text editor. Unfortunately, this change is too complex and risky to get into 3.0, so we have just a few small improvements in the macro browser this milestone:

- More parameters and documentation are available for macros in the macro browser. We now have 100% of the bundled macros with documented parameters, and will be just fine-tuning the documentation for the remainder of the release.
- The Office Connector (viewfile) macro shows up in the macro browser as separate macros for Word, Excel, PDF and Powerpoint documents.

**PDF Export**

Balsamiq Mockups and several other complex macros now export to PDF correctly ([CONF-14792](https://{0})).

🌟 Why don't you try out the new PDF export right now? On any page, go to Tools, Export as PDF.

**Engine Room**

The Engine Room team implemented several important performance improvements for this milestone. Specifically:

- Searching should be faster and not blocked by index updates every minute. This should also make the dashboard and macros that use the search index slightly faster. ([CONF-7749](https://{0}), [CONF-14803](https://{0})).
- Image attachments embedded in a page are now cached by your web browser. This should make pages with lots of images faster to load and reduce the load on the server. ([CONF-8034](https://{0})).
- Upgraded the WebDAV plugin to 2.0-beta2. This plugin has been released to the community for a while now, to very positive response. It should be more compatible with more clients now, though there is still some special configuration needed for Windows Clients. Read the documentation about client-configuration in order to test it.

**20% Projects**

Administrators can now customise the size of Confluence's caches from the web interface. Previously, you needed to edit an XML file and restart Confluence whenever you wanted to adjust the caches. This addresses one of the most popular supportability feature requests in the Confluence JIRA project, with 34 votes: ([CONF-12836](https://{0})).

**Bugs Fixed**

Several macros which were broken in M7 are now fixed: `{flowchart}`, `{rsvp}` and `{pagetree}`. ([CONF-14615](https://{0}), [CONF-14829](https://{0}), [CONF-14581](https://{0})).

The Gliffy plugin and Beanshell macros now work with Confluence 3.0; previously customisation was required to get them to work properly with our latest development versions.

Below is a complete list of issues resolved in Confluence 3.0-m8.

Errors were reported by the JIRA trusted connection.

- APP_UNKNOWN; Unknown Application: (0); ["confluence:4557196"]
### JIRA Issues (1 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Assignee</th>
<th>Reporter</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>✚</td>
<td>CONF-1 5102</td>
<td>Allow macro Body Text label to be overridden and add a description</td>
<td>David Taylor [Atlassian]</td>
<td>David Taylor [Atlassian]</td>
<td>⬤</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
<td>Apr 05, 2009</td>
<td>May 16, 2009</td>
<td></td>
</tr>
</tbody>
</table>

**Release Notes 3.0-m7 ("Milestone 7")**
Milestone release advisory

ℹ️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Summary
The Confluence team is proud to present another incremental milestone, called M7. We are currently aiming at shipping M8 in two weeks and M9 in four weeks. M9 will be almost feature-complete and therefore similar to a beta release. After a couple of betas and release candidates we intend to ship Confluence 3 in late May. As always, things can still change a little, so there is no fixed date. But if you are a plugin developer, you want to have your plugin tested well before the big marketing buzz kicks in. We try to remain as backward-compatible as we can for Confluence 3, but if something slipped through the cracks we need your feedback, and we need it now. So do have a look at this milestone release and tell us what you think.

Macro Browser and Rich Text Editor
You can now choose the kind of right-click context menu you want in the Rich Text Editor. A new button on the toolbar, handily called "Toggle context menu", toggles between the browser's default context menu and our TinyMCE one.

You can also tell the TinyMCE context menu that it isn't wanted via the "Disable context menu" option.

Macro Browser search has been improved and now accepts multiple words (order not important) and camel-casing (matches either case in consecutive words). The filtering logic has been added to AUI as a new commented method of AJS, "filterBySearch" - feel free to use it.

Community Improvements
This milestone shows a number of improvements from the Community Team.

Profile Layout
In the spirit of making the profile page actually page you want to visit, it's been given a facelift and has now come closer in line with out standard UI.

It also includes your current status is clearly visible at the top of the profile page.

For now you have a Status Updates section on the right hand side of the profile page, the next milestone will see this will be replaced with the new Recently Updated Macro (see below) so it will include other kinds of activity as well. It's here now because otherwise you wouldn't have anywhere to delete or clear your status, eventually will be moved to another tab and/or page.

User Status Updates

- **Delete And Clear Status**
  You can delete status entries from the list on the right. Someone hacks in your status, you can now always delete it. You can also clear your current status, so any location showing your current status will show nothing. This won't remove it from your history but your current status will now be considered cleared.

- **Status Icon**
  A new status Icon was introduced by the Design team. The lightbulb has been replaced with some sexy quotes (""").

- **Immediate Updates**
  Updating your status will use Javascript-Magic to update your status on the current page, giving you immediate feedback, with no need to refresh the page.
Recently Updated Macro

This is the first milestone that shows the hard work that David Loeng and Chris Broadfoot have been doing with our Recently Updated Macro.

To build up activity in the old recently updated macro the process would simply query the lastModified date of all the relevant content, then sort it accordingly. The side effect of this was, if two people edited the same page, you would only see the one edit in your list. Not only that, if you wanted to follow a certain user’s activity and someone edited a page after them, you wouldn’t see any update!

We’ve worked very hard on this and changed the way Confluence stores changes to documents and now tracks all changes every time a document, page, profile, status, anything, is updated.

This screen shot shows two edits from two different people on the same document, something that wasn’t previously possible. These changes were critical for implementing a proper follow feature for 3.0.

Bug Fixes

A number of bugs have been fixed by the community team, here are a list of some of the main ones:

- CONF-14773 Expanding and collapsing the personal sidebar will no longer affect the comments on that page/blogpost.
- CONF-14870 Delete links for user status items are now properly integrated with the new XSRF protection and actually work.
- CONF-14778 Printing pages from a personal space no longer includes the sidebar

Other bug fixes:
- CONF-14689 Comment edits now send notifications

Plus a number of other fixes.

PDF export team

Removed the PDF Export++ option. The new PDF export is what you get when you select just PDF Export. The old PDF export was removed.
Added javascript to the space export tree that will select/deselect all descendants of the clicked node. This change applies to all export formats not just PDF. This should save hours for the Atlassian Techwriting team.

Bugs fixed

CONF-14906 - Fonts are too large in the page index macro when exported to PDF
CONF-14905 - Note macro missing colored background in PDF export
CONF-14902 - content by label macro looks ugly when exported to PDF
CONF-14900 - Bookmarks macro is producing really large font when exported to PDF
CONF-14899 - Attachments macro is showing velocity junk when exported to PDF
CONF-14898 - Panel macros (warning, note, info) could use some extra padding in PDF export
CONF-14897 - Spaces macro renders as a single bullet item list when exported to PDF
CONF-14895 - Recently-used-labels macro with a table style doesn't look like a table at all
CONF-14894 - Blockquote text too large in pdf export

Release Notes 3.0-m6 ("Milestone 6")
Milestone release advisory

⚠️ For testing use only
Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following
- Development releases are not safe—Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Summary

This milestone is mainly about polishing features that were introduced previously, and a bit of back-end work for security and performance. We have fixed plenty of bugs of M5 too, and will keep fixing for M7.

Known issues

Given the recent work that has been done to improve "recent updates" (CONF-14434), updates shown on the dashboard will be affected shortly after the upgrade. You may notice that only changes made _after_ the upgrade will show. This will be rectified as soon as the index is rebuilt.

Improvements and new Features

New PDF Export

- This milestone contains the first cut of the Improved PDF export, which also give you more control over the conversion process by allowing you to use CSS. Please find the [detailed documentation](#) on CAC. [CONF-2079]

There are still plenty of known bugs with the new PDF, we included it a bit early to be able to get feedback on the CSS-styling process, not for beta-testing purposes...

Engine Room

The ER team has implemented several more important fixes and improvements in this milestone:

- **supportability** - integrated thread-dump tool in the administration screen ([CONF-12395](#))
- **security** - editing comments in wiki markup is no longer double-HTML-escaped in anti-XSS mode ([CONF-14601](#))
- **cluster performance** - avoid unnecessary updates to distributed cache to improve cluster performance ([CONF-14657](#))
- **general performance** - improve performance of retrieving many attachments, like on the attachments page ([CONF-14422](#))
- **front-end performance** - add caching headers to attachments rendered with a "?version=x" parameter ([CONF-8034](#)).

Office Connector

- When launching an external editor from Confluence, you don't have to login again. [CONF-14705](#)
- You can now monitor what is in the conversion queue and what is actually being converted [CONF-14707](#)

Macro Browser

The following bugs have been fixed:

Errors were reported by the JIRA trusted connection.

- APP_UNKOWN; Unknown Application: (0); ["confluence:4557196"]

### JIRA Issues (0 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Assignee</th>
<th>Reporter</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
</tr>
</thead>
</table>

Status and Follow

The following bugs have been fixed:

Errors were reported by the JIRA trusted connection.

- APP_UNKOWN; Unknown Application: (0); ["confluence:4557196"]
Bugfix-team

- It's safe to use Sections and Columns in the RTE again. ([CONF-13823](CONF-13823), [CONF-14282](CONF-14282))

Release Notes 3.0-m5 ("Milestone 5")
For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- No upgrade path — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

Downloads

All development releases are available from the development releases page on the Atlassian website.
Issues resolved or improved in this milestone since Milestone 3

Macro Browser (in Markup Editor)

The Macro Browser is now available in the wiki markup editor! Features are listed below.

Browse Macros

You can now browse through a list of categorised macros and select a macro to insert. Macros that do not have categories define can be found in the 'All' categories tab. To insert a macro, you can either double click on the macro or click it once and then click the 'Next' button.

Insert Macro

For macros that have parameter metadata defined, you will see parameter labels and descriptions with the appropriate input fields. So far we are handling boolean and select-one-from-list type parameters. Everything else is considered a string. Please note that there is no field validation.

For macros that don't have the parameter metadata defined, you will see a single input field for the macro parameters and its notation guide help (if any) below.

Preview Macro

A default preview will be loaded only if the macro doesn't have required parameters. The preview can be updated by clicking on the 'Preview' button. This button location will change in the future.

Edit Macro

You can also edit a macro by placing your cursor in the start tag of a macro and then clicking the Macro Browser icon. It should display the 'Insert X Macro' page with it's parameters populated.

Known Issues

- Macro summary and parameter descriptions are currently under review by the tech writing team, so please ignore grammar/spelling/crappy English for this milestone.
- The macro icons (displayed in browse macros) are temporary. Hopefully we will be able to get much sexier icons.
- Some macros falsely declare they have bodies (e.g. gallery) so you may see some unnecessary body text areas

Community

Several major community features have their debut in this milestone.

Status

This milestone, we are releasing the first version of the Status feature. There is still a lot of work to be done, it's
not particularly polished but we want your feedback.

First of all, set your status from the user menu, where you’ll get a dialog box allowing you to enter your new status.

You can see your status and others' statuses from user hover, under the "Status List" option in user profiles, the "Favourite People" tab (see below), personal space sidebar (see below).

Follow

Marking another user as "favourite" is now meaningful. In milestone 5, you'll be able to get a list of statuses from the people you follow.

Check out the "Favourite People" tab in your user profile – you can get there via your user menu.

It will show you who you're following, and who's following you. You can also quickly follow someone with the user search, and see a list of status updates from the people you follow.

Personal Space Sidebar

With this release, we now have some structured form of a user profile for every user. On the right of any personal space*, there'll be a sidebar with various details of the person's space you're viewing. Don't worry, you can easily collapse the sidebar and it'll shift out of sight. Once you collapse the sidebar, it will stay collapsed for all personal spaces for the duration of your login session.

Here's what it looks like:
We plan to put more information on the sidebar, at the moment it looks a little silly if the user doesn’t have a status set and hasn’t filled out any of the extra profile fields we added last milestone.

This only works in the Default Theme.

**Known Issues**

- There are a few known issues with the Community work, the biggest thing is what you see at the moment is a first cut of the functionality, we plan to "sexy" it up a bit and make the status and profile pages look a lot nicer.
- You will also notice that when you favourite another user you will need to wait for the index to be flushed for your changes to be applied. This will be improved in a future milestone.

**Bugfixes**

There are two relevant bug fixes in this milestone:

- Configuration to prevent anonymous users accessing user profile information ([CONF-13276](#))
- Cannot insert links with Unicode characters in the URL ([CONF-12707](#)).

**Engine Room**

The Engine Room team has delivered one more performance improvement and a significant security improvement this milestone:

- Attachment retrieval should cache attachment IDs ([CONF-14422](#))
- Anti-XSS mode is now enabled by default ([CONF-12573](#)).

We also fixed the regression in the previous milestone (M4) where pages with thousands of attachment versions brought all attachment retrievals to a grinding halt.

**Release Notes 3.0-m4 (“Milestone 4”)**
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release ('milestone') leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Issues resolved or improved in this milestone since Confluence 3.0 Milestone 3

Experimental Macro Browser

The Macro Browser is now available in the wiki markup editor, however it is currently not in a state for proper use. It is quite buggy and has been included for QA and the dev team, so please do not raise any issues against it yet.

Community

User Hover Fixes

A lot of outstanding issues with User Hover were fixed for m4.

First Cut of User Profiles

The profile tabs have been rearranged into a more intuitive order, with general and email preferences moved to a separate "Settings" tab:

![Profile Tabs](image)

Additional fields have now been added to your user profile.

Performance Improvements

We did the following small performance improvements:

- Caching/Queries optimized for page lookups ([CONF-14273](CONF-14273))
- Adjusted cache sizes ([CONF-14294](CONF-14294))
- Optimized access to attachments ([CONF-14342](CONF-14342))
- Less cache replication in a cluster ([CONF-14339](CONF-14339))

Although the performance improvement hasn’t been as dramatically as in M2, but we still see a solid trend towards shorter and less varying response times. The overall performance improvement is around 10%-15% with more to come in the next milestones.

Known issues

- Performance issues with frequently updated attachments. One of the performance tweaks in M4 can cause issues if you have attachments with thousands of versions. ([CONF-14422](CONF-14422))
- The Macro Browser is very fresh and contains many bugs.

Check out [JIRA](https://jira.atlassian.com) for the full list of known bugs

Release Notes 3.0-m3 ("Milestone 3")
Milestone release advisory

⚠️ For testing use only

Do not use this release to upgrade your production systems.

For all production use and evaluation of Confluence, please use the latest official release.

This release is a public development release (‘milestone’) leading up to the next Confluence major release. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we can not provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

In supplying milestone releases, our aim is to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and all of our milestone releases even have been performance tested for a while.

However, since our milestones releases are timeboxed (that is, they are released every two weeks, no matter how far we have come implementing features and bugfixes) there is always a chance that we have new known bugs that are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, we have not completed our performance testing and compatibility testing for all supported databases and user management systems. So, for example, a milestone release may behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade your test instance to this release. We strongly recommend that you backup your Confluence home directory and database before upgrading!

**Downloads**

All development releases are available from the development releases page on the Atlassian website.
Issues resolved or improved in this milestone since Confluence 2.10

**User Hover**

The first cut of User Hover has made it into m3. This mainly provides Confluence with the stepping block for features like Status. At present, it's only really useful to e-mail someone, or visit their user profile (both are notoriously difficult pre-m3).

Just hover over any user’s name or profile picture, you should see the following information:

Performance

The Engine Room Team has started attacking general performance and also cluster performance. Our loadtests already show a significant improvement for high loads, and we hope it will show on EAC too.

In particular we made the following changes:

- Remove blocking in OGNL ([CONF-14121](#))
- Rely on Coherence to do locking instead of using sychronized methods ([CONF-14093](#))
- Remove unncessary sychronization on Hibernates UpdateTimestampsCache ([CONF-14098](#))

More backend improvements related to caching and retrieval of macros have been done, which should make rendering long pages faster.

Overall we have seen a significant performance improvement under light to mid-level load, even more so on the clustered version of Confluence. This is mostly due to [CONF-14093](#).

**Rich Text Editor**

Context menus are now available in the RTE (Agnes' Fedex 9 project). Just right click in the editor! They are especially useful for table editing.
Notifications which show just relevant changes

When watching a page in Confluence, you normally get all the content whenever something changes. This isn't so useful, so we've added the option to get just the changes to the content emailed to you.

Just check the "Show changed content" box in Email Preferences. If enough people find this useful we are considering enabling it by default.

Viewing changes for content has also been similarly improved. By default, unchanged content is hidden and you can click the ellipsis to expand it.

Both improvements rely on 20% work done by David Taylor to dramatically improve the diffing algorithm used for Confluence content.

20% projects

Batching web resources

Confluence is now using Atlassian Plugins 2.2. beta4, which supports batching of web resources. This should result in a performance improvement, with fewer requests to the server for jss/css files.

See here for more details.

Roundtrip bugs

Yes, it's lame, but DonW fixed a couple of particularly annoying round-trip RTE bugs in his 20% time:

- Images no longer get attached to the previous paragraph
- Emoticons can all be escaped in wiki markup, and will automatically be escaped when going from Rich Text to wiki markup.

Known issues

Plenty of known bugs. Check out JIRA.

Release Notes 2.10-rc1 ("Release Candidate 1")

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10. This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we're up to.

Who should upgrade?
Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

We are now reaching the end of the 2.10 release cycle.

We have released our first release candidate RC1 today, you can see it on our public Confluence installation at http://confluence.atlassian.com. There should be no more code changes made to Confluence from this point on unless any important issues are found in this release candidate.

While this is not the final release, and the official release notes will be unveiled next week, you should definitely have a look now to confirm everything still works fine with your plugins.

The RC1 is functionally almost equivalent to M8 which was announced in early November, but has a number of additional bugfixes. Check out our roadmap in the JIRA project

Known problems

The Edit Grid plugin doesn't work with this version of Confluence. See the Jira issue for more details.

Release Notes 2.10-m8 ("Milestone 8")

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.9.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

**Downloads**

All development releases are available from [Development Releases](#) on the Atlassian website.

**Issues resolved or improved in this release**

**Writer**

Bug fixes:

- CONF-13670 : fixed bug when Html Export used to fail on recently updated macro displaying an attachment.

**Office Connector**

- CONF-13613 : fixed several bugs in the pdf preview
- CONF-13643 : fixed previewing viewfile macro gives error on a new page with attachments
- Numerous other bugs. See the [Office Connector release notes](#)

**Discovery**

- Added recentness boosting to QuickNav.
- Added the space name to the tooltips for QuickNav results.
- Fixed bug preventing Did-You-Mean feature being enabled via the admin console.
Plugins

- Upgraded to Jira Macros Plugin v2.8.7, which contains several bugfixes (m7 contained v2.8.6)

Bug Fixing

Significant bug fixes since M7 include:

- CONF-13580: a blocker bug when editing pages with certain types of macros.
- CONF-13543: a blocker bug causing drafts to not be saved in certain situations
- CONF-13521: a serious issue with the RTE forcing the use of the base url.
- Several bugs (CONF-13338) fixed relating to the escaping of attachment filenames.
- Fixed the HTML around the quick search box that was causing a large right hand margin on some browsers.

Release Notes 2.10-m7 ("Milestone 7")

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

**Please note the following**

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure
Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

Office Connector
- Changed the preview link to just "View". Previously it was "View Online" or "View as HTML". It will always be on the right of the actions links. This makes the alignment of the other links nicer.
- The slide viewer will always be downloading a few slides ahead of the current slide. This should make it appear to be loading slides faster when you advance the slides.
- Other minor refinements of the slide viewer UI.

RTE
- Keyboard shortcuts added for insert link/image (ctrl+k and ctrl+m)
- Keyboard shortcuts fixed for headings (ctrl+1 for heading one and so on)
- Links pasted into the rich text editor will work (for most browsers and to some extent for all browsers)
- Initial indent within a code macro is now displayed properly.
- Extra newlines are no longer added to bodies of most macros Eg {note}inline body(note) will be left alone by round-trip.
- Less extra whitespace will be added to wiki markup by going to rich text.
- Draft saving should now work in all browsers again.
- Editor tabs are now rounded in safari and firefox.

QuickNav
- A faulty optimisation that was causing problems with multi-word searches has been fixed.

Search
- Increased range of data boosting to cover a full year (instead of one month)

Did-you-mean

The administration screens for the did-you-mean configuration have been substantially improved.

Default Space Content

The default content used for the home page in a newly created space or personal space has been improved to show recently updated content, and a pagetree of the space.

Plugins

Included most recent bug-fix versions of:
- LeftNav Theme
- Userlister plugin
- ToC Plugin
- Social Bookmarking Plugin
- Email Page Plugin
- Live Search Plugin
- IM Presence Plugin
- Dashboard Macros Plugin
- Contributors Plugin
- Attachments Plugin
- JIRA Plugin
- Advanced Macros
Multiple bug fixes.

**Release Notes 2.10-m5 ("Milestone 5")**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestone releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved or improved in this release**

**Office Connector**

- View Online" or "View as HTML" link for supported file types on the Attachments screen, Attachments.
Confluence 4.3 Documentation

New look for the PPT and PDF flash viewer with a download button, and an improved fullscreen.
• Conversion Queue for managing performance when you may have a lot of users using the Office Connector.

**Rich Text Editor**

• Tab & Shift+Tab in lists are now shortcuts for indent/outdent
• Lots of bug fixes (especially around table editing)
• Round tripping bugs around links were fixed (shortcut links, using colors & images in links)
• The format dropdown is now styled properly
Quick nav improvements
- Is now at least twice as fast since we have reduced the pause by half.
- More page results! 6 in fact.
- See more of each search result. You can see the whole title (just hover!), and more letters with better truncation.
- People should not be getting weird timeout messages anymore
- New administrative feature to limit the number of simultaneous quick nav searches, or to turn it off.

Open Search
- You can now search Confluence from the convenience of the search box in your browser (for FF and IE7). Just add the search provider from the search provider menu dropdown on the top right of your browser.

Site Search improvements
- Normal search is at least 5 times faster than it use to be.
Better relevancy algorithm relevant

### Miscellaneous Small Improvements

- Cleaner, sweeter breadcrumbs and 10 more rounded corners.

### Plugins

- New version of Dynamic Task List (3.1.1)
  - Fixes TASK-108
- New version of Chart Plugin (1.12)
  - Fixes CONF-12792
- SNAPSHOT version of JIRA Issues Macro
  - Fixes lots of stuff
- 1.5-SNAPSHOT version of Advanced Macros
  - removed RSS macro
  - upgrade content-by-label
  - upgraded blogposts
  - upgraded recently-updated
  - Fixed Gallery Macro: ADVMACROS-39, ADVMACROS-48, ADVMACROS-49
- 1.5-SNAPSHOT version of Dashboard Macros
  - renamed recently-updated to recently-updated-dashboard to make way for new code in Advanced Macros
- New version of HTML Macros (1.5)
  - Includes RSS Macros now to take advantage of shared whitelist

### atlassian-plugins upgrade to v 2.1.0.rc1

- added filter plugin type
- added standard decorators that are available to plugins
- added support for xml plugin artifacts

### Release Notes 2.10-m4 ("Milestone 4")

⚠ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (D R) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we're up to.

Who should upgrade?
Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

TinyMCE upgrade complete

- Colour Text, Insert Emoticons and Custom Character are now back in the editor!
- Fullscreen mode is also back and even better. It no longer pops up in a new window, but enlargens the editor in the current page you are editing.

Quick Navigation polish and performance improvements

- performance significantly better than m3
- can handle concurrent requests up to 30 users without breaking a sweat (on medium datasets) - this should address the timeout issues people have been having

Plugins

- New build of JIRA Issues macros. Bug-fixes, but new feature: all RSS and Email version of the macro will be static, and not require javascript or Ajax.
- Content Filtering Macros: contentbylabel and blogposts have a new, SearchAPI v2 backend.
  - All existing parameters should continue to work
- **New, standard set of parameters** for various kinds of filtering
  - Content Filtering macros: new `{recently-changed}` macro, which is a reimplementation of `{recently-updated}`. All existing recently-updated params should work, with the addition of the new standard params listed above. Will eventually replace `{recently-updated}`.
  - Added an optional whitelist for the RSS macro and the HTML-include macro.

**Release Notes 2.10-m3 ("Milestone 3")**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

**Who should upgrade?**

⚠️ Please note the following
- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we **cannot** provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. **We strongly recommend that you backup your confluence-home directory and database before upgrading!**

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved or improved in this release**
TinyMCE 3 is in

This milestone contains the long-awaited TinyMCE 3 upgrade. It comes at a cost (we had to disable the emoticons, special characters, colour-pickers and fullscreen mode) to make it into M3, but they will be back in M4, and this gives us a much more stable Rich Text Editor two weeks earlier than expected. Please note: we have **not** yet started working on roundtripping bugs (e.g. stuff that breaks when switching from RTE to WikiMarkup and back). We will start attacking bugs those towards the end of the release cycle and during the 3.0 cycle. But the improvements in the RTE itself are extremely valuable already, including **support for safari**. If you encounter problems please don’t hesitate to ask or raise issues. We want to make this a really solid experience.

Oh, and the new RTE starts up much faster too! Kudos to the relentless work of the Writer-Team (especially David T and Agnes), who have been working for many hours over the past months to get us here.

**Quick Navigation**

- Matches titles as you type
- Shows 3 pages, 3 news items, 2 attachments, 3 people, 2 spaces. If no titles are matched the category isn’t shown.
- People’s profile photos are shown
- Use your keyboard to navigate
- Now with % more rounded corners
Clear Search

- Improved search result page and results
  - Lighter ‘Showing ...’ line
  - Better fit with a grid, softening of filter panel corners and better spacing
  - Emphasis of the titles
  - Clearer, simpler result format
  - Real profile pictures of real people
- Clear filter instead of clear search
- Search field at the bottom of the page
Small improvements

Per's first 20% project displays a lock-icon next to documents that have restricted access.

Notes on deploying to your test-instance

With the TinyMCE upgrade, we have renamed the TinyMCE plugin key to match the Confluence version. Hence, you may find that there are two TinyMCE plugins installed which can cause errors when editing (e.g. the pop-ups not working). If so, you will need to disable both and then re-enable the 2.10-m3 version of TinyMCE. This will be fixed for the final 2.10 release with an upgrade task to uninstall the old plugin.

Release Notes 2.10-m2 ("Milestone 2")
Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following
- Development releases are not safe — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

“Did you mean?”

Dave Loeng’s auto-suggest feature is the first major 20%-project to make it into Confluence. Try it out by mistyping a search, and you will find a link suggesting more relevant searches. This is an actual example of me typing way too fast: 😄
Try misspelling someone’s difficult surname, like say, ‘fraggeman’.

**User management**

Confluence Hosted developer Jens Schumacher has been very busy hacking on Confluence again, this time he improved the user-management a lot - so much more convenient than before.

- Improved Search
- Adding and removing users when viewing a group
- New table styles
- Improved User Picker

<table>
<thead>
<tr>
<th>User</th>
<th>Full Name</th>
<th>E-Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>A. D. Ministrator</td>
<td><a href="mailto:admin@example.com">admin@example.com</a></td>
</tr>
</tbody>
</table>
Avatar cropping and deletion

Another, smaller 20%-project also made it into this release: Charles Miller and Dmitry baranovskiy enabled Confluence to allow cropping of uploaded avatar-images, and while they were at it the highly desired "delete images you never intended to upload in the first place" issue got solved too in order to make another 23 voters happy.
Backend changes

The Engine Room team has implemented several important backend changes in this milestone:

- Integrated the first version of Plugins 2.0, including an initial migration the Confluence plugin repository to Plugins 2. An updated version of this plugin and a converted dynamictasklist are planned for the next milestone.
- Trusted authentication and other Seraph-based authentication methods are now available for calls to the Confluence RPC methods (CONF-8680). This makes it practical to write Confluence gadgets which use the remote API to retrieve data. Tom Davies is using this to implement his Crucible Confluence review plugin.

Release Notes 2.10-m1 ("Milestone 1")

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.10 ("Two Ten"). This is a public development release (DR) leading up to Confluence 2.10. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?
Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.9.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved or improved in this release**

It's all about small improvements this time.

During the last weeks we have fixed a whole bunch of bugs, worked on major functionality, and done a lot of planning. Therefore the M1 is a rather small release - it contains the bugfixes, but no major work yet. We have developed a new feature and two great smaller improvements which are almost done, but didn't make it into this Milestone, so expect a lot more in M2 in two weeks.

But wait, there is one small new feature that might have a big impact on EAC. Jens Schumacher, developer on Confluence Hosted, has been working on a top secret mission, and his new feature means you now can store CSS per space and for the whole installation.

Inside Atlassian we now have a small competition going with developers competing for the nicest/coolest/weirdest CSS-based design to be delivered within the next two weeks.

The competition only started yesterday, but there are some funky screenshots available already 😎. Obviously Confluence still has areas that are completely hardwired and not styleable yet, but we are working on this as we go.
Release Notes 2.9-rc1 ("Release Candidate 1")

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.9. This is a public development release (DR) leading up to Confluence 2.9. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.8.x to this release. We strongly
recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

We are now at the end of the 2.9 release cycle.

We have released our first release candidate RC1 today, you can see it on our public Confluence installation at http://confluence.atlassian.com. We are aware of one remaining major bug that we want to fix (JIRA-issues macro not working in preview mode), but apart from that and some minor fixes we will not change the code anymore.

While this is not the final release, and the official release notes will be unveiled next week, you should definitely have a look now if everything still works fine with your plugins, if you haven’t done so yet. We made some changes to the plugin subsystem and to the action class hierarchy (please refer to the other milestone release notes), and we are aware of some plugins (such as the Gliffy plugin) which had to get changed a bit to be compatible with 2.9.

The RC1 is functionally almost equivalent to M5/M6 which was announced in early July, but has a big amount of additional bugfixes, check out our roadmap in the JIRA project at http://jira.atlassian.com/browse/CONF?report=com.atlassian.jira.plugin.system.project:roadmap-panel for more details.

Known problems

Jira-issues macro does not work in preview mode.

Release Notes 2.9-m5 ("Milestone 5")

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.9. This is a public development release (DR) leading up to Confluence 2.9. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.
Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.8.x to this release. **We strongly recommend that you backup your confluence-home directory and database before upgrading!**

**Downloads**

All development releases are available from [Development Releases](#) on the Atlassian website.

**Issues resolved or improved in this release**

We are rapidly approaching the end of the 2.9 release cycle. There will be a really small M6 later this week, and then that's it, we are going into bugfix and compatibility-testing mode, so we can release on the 29th of July.

**Plugins**

We have done a significant amount of work in the area of plugin loading (and the plugin classloaders) to improve performance. There are no API changes, but it is very possible that these changes may expose bugs. While we tried to remain backwards compatible, it is **crucial** that you test for compatibility of your plugins.

**Editor**

The **preview** in the editor is now capable of rendering content exactly as it appears on the page. However, to do this, we have had to disable interaction with the preview. You will no longer be able to follow links or interact with the preview in any other way.

When **drafts are saved** automatically to the server, this will be shown to you at the top of the editor.

**Engine room**

Whisper the words "Action class hierarchy" anywhere close to a Confluence developer and he or she will cringe. Not anymore as of this Milestone. Plenty of inheritance trees have been cut, and miraculously Confluence still works. This will enable us to work faster and more efficiently in the future.

**Page tree and UI**

We had a few nasty UI bugs recently where plugin JavaScript code would interfere with our menus and other JavaScript code, and we had a few Pagetree bugs. The most important ones have been fixed in this release.

**Discovery Team**

Author auto-complete field added to the search result screen to allow filtering searches by contributor (author or editor).

The 'new search' (or reset search) link on the search screen filter left the building somewhere around milestone 3. This has now been re-instated.

A couple of 2.9 specific bug fixes are also included.
Known problems

Several small bugs, specifically around the new author-search.

**Release Notes 2.9-m3 (“Milestone 3”)**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.9. This is a public development release (DR) leading up to Confluence 2.9. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.8.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved or improved in this release**

Milestone 3 is all about the UI: It features major parts of the new search UI, and we have added two more menu...
items to the "Browse" menu.

Some effort was spent on making the page tree more stable, and we have spent more time on internal code improvements (which did however not ship in this milestone)

Known problems

Several small bugs. And a slowdown of search performance by 50%, which will be addressed in a later milestone release.

Release Notes 2.9-m2 ("Milestone 2")

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release. This release is a milestone development release for 2.9. This is a public development release (DR) leading up to Confluence 2.9. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we're up to.

Who should upgrade?
**Please note the following**

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too, and usually milestone releases even have been load- and performance-tested for a while.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Additionally, our performance-testing and compatibility testing for databases and application servers is not done to the full extent. So, for example, a milestone release might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.8.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

**Downloads**

All development releases are available from [Development Releases](#) on the Atlassian website.

**Issues resolved or improved in this release**

Page Ordering: We have been improving the page-tree a bit, fitting in some work that was intended for Confluence 2.8 but didn't make it. The tree now has a “revert to alphabetical mode” button which will revert manually ordered nodes back to the original alphanumeric ordering. Additionally we added one small improvement which will help to battle spam: administrators will see two additional buttons on the page tree that enable easy deletion and preview of pages. We are not entirely sure yet whether (and how) these two buttons will ship, so don't raise improvement issues for those two buttons yet. (If they ship with 2.9, then we will put in some more polish of course)

Unfortunately there are a few known (uncritical) bugs related to the revert-to-alphabetic-mode in edge-cases, which will be addressed by M3.

Search: The Search has improved internally (the ranking should be a bit more relevant than before), and also what is being searched has changed: mail and personal spaces are searched by default, and using the space key in the search boosts hits within that space.

**Known problems**
Some small issues, mainly with the UI, but nothing serious.

**Release Notes 2.8-m9 (“Milestone 9”)**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.8-m9 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

**Who should upgrade?**

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases may not have not been load- or stress-tested, or maybe they have but some performance problems still persist. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.7.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved or improved in this release**

All functional changes are now complete. We are only fixing some remaining bugs now.

**Known problems**

- We found a major performance problem during our loadtests. Confluence works exactly like before under
low load, but once you go above a request per second you will notice a much load than acceptable. We will fix that for the final release.

- a few glitches when viewing with IE6&7, and when using the new page tree. Will be fixed for the final version

Outlook

We are in bugfix-mode now. While a few icons and CSS-styles will still change, the main priority is now to iron out all our bugs during the next one or two weeks.

Release Notes 2.8-m7 (“Milestone 7”)

* Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.8-m7 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases may not have not been load- or stress-tested, or maybe they have but some performance problems still persist. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.7.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

Downloads
All development releases are available from Development Releases on the Atlassian website.

Issues resolved or improved in this release

This page describes the changes you can expect from Confluence 2.8 Milestone 7. M7 is a "small" milestone that delivers some features that just didn't make it into M6, but which can't wait for M8 nor RCs either because we need your feedback as soon as possible!

End-user improvements

User Interface improvements:

- Matt Ryall's ShipIt project: improved comment threading, with dynamic collapsing

  Not to be too picky but why is "View Source" listed under the actions list. That list seems like very valuable real estate and could not the same results be gotten by using the bro

  The "View source" action actually pops up a window with the wiki-markup of the current page, as I think this is a brilliant idea, but perhaps a term other than "View source" would be less confusing

  I like "View Wiki Source". It's cleaner and won't take up extra

  Thanks for the suggestion, guys.

  Funnily enough, this feature has existed since Confluence 1.0, and always be notice.

  We'll definitely have a look at the naming based on this discussion. Putting it

- Edit page title change

  The title is not duplicated anymore, you simply edit the title directly

- Put PDF, Watch and Favourite icons on Tools menu

- Replace printable view with an improved print stylesheet for better printing directly from the page
- Improved editor caching
- Fixed editor layout bug in Safari
- Menus appear on hover
- Move command in Tools menu
Page Ordering:

- Included the page ordering tree into the edit-page, ironed out some bugs

Misc:

- Our student developer Chris Broadfoot added a few missing links into our user-management section, and incorporated a pretty slick way to change the size of the pagination window. Well done!

API changes

For plugins which configure Confluence's web interface, Condition implementations which depend on GlobalHelper are now deprecated, and should be converted to use the new WebInterfaceContext interface. The easiest way for most plugins to do this is to extend BaseConfluenceCondition rather than the now-deprecated AbstractConfluenceCondition. (Javadoc links to come once this is published.)

Known problems

- We found a severe performance problem during our loadtests. Confluence works exactly like before under low load, but once you go above a request per second you will notice a much higher load than
acceptable. We will fix that for the final release.

- Upgrade issue for clustered deployments. Don’t use this Milestone on a Cluster.
- A few glitches when viewing with IE6&7, and when using the new page tree in a browser without FireBug installed.

Outlook

We are in bugfix-mode now. While a few icons and CSS-styles will still change, the main priority is now to iron out all our bugs during the next two weeks.

Release Notes 2.8-m6 (“Milestone 6”)

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.8-m6 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

Who should upgrade?

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the normal upgrade instructions to upgrade from Confluence 2.7.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

Downloads

All development releases are available from Development Releases on the Atlassian website.
**Issues resolved or improved in this release**

Milestone 6 incorporates Milestone 5 changes (which were released but never publicly documented, sorry)

**Milestone 5 (the missed one)**

The user interface improvements include the most drastic changes to be done for Confluence 2.8. After adding a new Actions menu to the page, we have removed the unnecessary tab navigation. This completes our migration to a menu-based user interface. The content of the page is now the most important aspect of the page, as all the editing and modification features are now out of the way when reading a page. The UI has also been improved in other small ways in this milestone, and we have fixed many bugs with the printable view and the default themes.

Plugin components that expect to be injected with the old, deprecated CacheManager interface will now work again. This means plugins such as the JIRA issues macro will be useable once more. Plugins that use the ContainerManager.getComponent method of obtaining the cache manager will continue to malfunction; there is no plan to support this usage. More commentary about this at CONF-10602.

The Page Ordering feature mostly contains bug fixes. The majority of changes are done in the back end as we prepare to remove extJS library and substitute the page tree widget with a custom component.

**Milestone 6 (the current one)**

User Interface improvements:

- performance improvements through better clientside-caching on the edit-page
- user menu has been included. The only thing missing to wrap up the UI changes is to move the remaining icon-buttons (PDF, watch pages, etc) to menu items as well. This will be delivered in two weeks.
- New and improved Tree component, that lets you drag more comfortably than before
- Added the ability to cancel a page move by pressing 'esc' after the user starts dragging a page
- Added automatic scrolling functionality. If a user drags a page to the top/bottom of the screen in an attempt to reach a page that is currently outside of the screen, it will automatically scroll up/down.
- Known problem: No indication of subnodes being loaded
- bugfixes

Technical improvements and API changes

- JMX has been added to the list of Confluence capabilities for improved monitoring
- Raising a support case is now possible directly from the admin console. This will attach logs and other relevent system information automatically.
- JQuery now default JS library. We have removed ExtJS as a Javascript-dependency, and will standardize on JQuery in all of Confluence
- Coherence cache lease duration has been set at 10 minutes to support system recovery when threads do not release their leases properly. A warning message will be logged detailing that a lease has timed out to help with tracking down errant lease management.

**Known problems**

- We found a severe performance problem during our loadtests. Confluence works exactly like before under low load, but once you go above a request per second you will notice a much higher load than acceptable. We will fix that for the final release.
- Upgrade issue for clustered deployments. Don't use this Milestone on a Cluster.
- a few glitches when viewing with IE6&7

**Release Notes 2.8-m4 ("Milestone 4")**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use [the latest official release](#).
Confluence 2.8-m4 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we're up to.

Who should upgrade?

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we **cannot** provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](http://confluence.atlassian.com/display/DEVCON/Getting+Started) to upgrade from Confluence 2.7.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from [Development Releases](http://confluence.atlassian.com/display/DEVCON/Development+Releases) on the Atlassian website.

**Issues resolved or improved in this release**

This release mainly fixes bugs and glitches of the previous milestone, and extends the functionality slightly. You will notice that a new dropdown-menu has been added which allows you to access the browse-space actions easier, and that most macros now honor the new page ordering that can be set in recently added page-reorder-component.

We had forgotten to release the source code of the previous milestones, this has been taken care of now, thanks Alain from Adaptavist for pointing this out! 😊

The coolest improvement however is that we are able to deliver the first Shipt 7 project in this milestone - less than two weeks since the actual event! (see [http://blogs.atlassian.com/developer/2007/09/atlassian_ShipIt_day_vi.html](http://blogs.atlassian.com/developer/2007/09/atlassian_ShipIt_day_vi.html) for an overview of Shipt 6 last year). Use the new drop-down menu to "Browse Labels", select one of the most popular ones, and you will now be able to filter by multiple labels - just increase or decrease the
number of labels by using the plus- and minus-signs next to the related labels. Admittedly the UI still needs some finishing touches, but it works fine already and it will make 21 voters happy once released officially (http://jira.atlassian.com/browse/CONF-4577). More ShipIt-projects can be expected to make it into M5 and M6.

You can view the complete list of fixes and newly implemented features in JIRA. They contain all the issues resolved during development of 2.8, not just the ones fixed since the previous milestone.

**Known problems**

There are still a few known bugs in this release, most noticeably the broken printable view (CONF-10583) which will be fixed soon. Please continue reporting problems through JIRA, your feedback has been very helpful and a lot of it has been incorporated already.

The CacheManager API has changed in milestone 4, and all plugins that use the old CacheManager interface will be broken (CONF-10602). In milestone 5, Confluence has a workaround for plugins that get the cacheManager injected. That is, the following code will work correctly in 2.8-m5 (but is currently broken in 2.8-m4):

```java
import com.atlassian.user.impl.cache.CacheManager;

public class MyClass {
    private CacheManager cacheManager;

    public void setCacheManager(CacheManager cacheManager) {
        this.cacheManager = cacheManager;
    }
}
```

Plugins that access the CacheManager not via dependency injection, but statically through the ContainerManager will fail at runtime with a ClassCastException. These plugins should be rewritten to use dependency injection, or use the new com.atlassian.cache.CacheManager interface. The following code is broken in 2.8-m4, and will continue to be broken for the final release of 2.8:

```java
CacheManager cacheManager = (CacheManager) ContainerManager.getComponent("cacheManager");
```

Plugins that wish to avoid using the deprecated CacheManager interface should change to use com.atlassian.cache.CacheManager.

**Release Notes 2.8-m3 (“Milestone 3”)**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.8-m3 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

**Who should upgrade?**
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we **cannot** provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.7.x to this release. **We strongly recommend that you backup your confluence-home directory and database before upgrading!**

**Downloads**

All development releases are available from [Development Releases](#) on the Atlassian website.

**Issues resolved or improved in this release**

- First draft of UI improvements: We are working hard on moving the HTML and CSS delivered by Confluence towards standards-compliance and accessibility. We are at the same time reworking our UI structure. We feel that the UI has been growing a bit too organically over the past years, resulting in somewhat confusing navigation like the "remove page"-button only available when you are editing a page, for example. We have implemented an initial dropdown-menu for adding content, thus already cleaning up the UI a bit. All the navigation-changes we make are targetted at the default theme, however some HTML&CSS changes may also affect the other themes.
  
  In the future our changes will enable plugin-developers to hook into Confluence easier than before, and skinning Confluence will be considerably easier. However, plugin-developers should be aware of the changes we are making, and check (by examining this Milestone release) whether they have to schedule some maintenance work for their plugins. More changes will be made, so don't rush it - but plan for it.

- First draft of Page Reordering. We are working on implementing a highly anticipated feature that will dramatically improve the quality of content generated from a Confluence space. So far the PDF files you generate from Confluence have been alphabetically ordered - which for example makes even the Confluence User Manual quite awkward to read. With the new page ordering feature it will be able to structure your Wiki exactly as you like - or of course leave it in alphabetic mode if you prefer that. Our goal is to deliver a really useful solution, and this Milestone only shows you the first 50% of the feature.
  
  We are currently busy implementing all the feedback and bug-reports we get from Sarah (our documentation queen) and the next Milestone releases will deliver further improvements and bugfixes.
You can view the complete list of fixes and newly implemented features in JIRA. They contain all the issues resolved during development of 2.8, not just the ones fixed since the previous milestone.

**Known problems**

No major known problems, but plenty of smaller to medium sized bugs, mainly related to page reordering. They will get tackled in M4.

**Release Notes 2.8-m2 ("Milestone 2")**

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.8-m2 is a milestone development release for 2.8. This is a public development release (DR) leading up to Confluence 2.8. Development releases are a snapshot of our work in progress, allowing our customers and especially plugin-developers to see what we’re up to.

**Who should upgrade?**

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path**— Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.7.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved in this release**

- Velocity template engine upgrade
Confluence’s velocity template engine has been upgraded from 1.3 to 1.5. This shouldn't mean too much to end users however there could be some compatibility problems with existing themes and plugins. Check this upgrade guide that we use internally as well: http://confluence.atlassian.com/display/DOC/Migrating+to+Velocity+1.5

- File upload component upgrade

Pell multipart has been replaced with the Jakarta Commons Fileupload component to handle web browser file uploads. Again this won’t have much impact on the Confluence experience but could cause some odd problems when attaching files to Confluence.

- PDF space export

There has been some optimizations made the space PDF export which should result in less server memory usage during export

- New GZIP compression filter

Confluence team have integrated a new GZIP compression filter to achieve more efficient downloads and page views. This is not currently enabled by default, so to test this with your plugin you need to turn it on in the management console. We are using it internally at Atlassian, and the performance improvement while browsing pages is quite substantial.

You can view the complete list of fixes and newly implemented features in JIRA. They contain all the issues resolved during development of 2.8, not just the ones fixed since the previous milestone.

**Known problems**

There are a few cosmetic UI problems related to space logos and to the login screen, none of them impact productivity. Notification mails are empty because of a Velocity macro bug.

**Release Notes 2.7-rc1 ("Release Candidate 1")**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.7-rc1 is a release candidate for 2.7. This is a public development release (DR) leading up to Confluence 2.7. Development releases are a snapshot of our work in progress, allowing our customers to see what we're up to.

**Who should upgrade?**

⚠️ Please note the following

- Development releases are not safe— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- No upgrade path — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestones and release candidates aim to provide plugin developers with an opportunity to see the latest
changes in the code.

Each milestone/release candidate has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones and release candidates re timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bug fixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases and release candidates have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.6.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Issues resolved in this release**

View the list of fixes and newly implemented features in JIRA. They contain all the issues resolved during development of this release, not just the ones fixed since the previous milestone.

**Known problems**

None.

You should really download this Release Candidate and check if your plugin works with it. If not, use the last few days before the official 2.7.0 release to fix it 😊

**Release Notes 2.7-m5 ("Milestone 5")**

⚠️ Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.7-m5 is a milestone development release for 2.7. This is a public development release (DR) leading up to Confluence 2.7. Development releases are a snapshot of our work in progress, allowing our customers to see what we're up to.

**Who should upgrade?**
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the [normal upgrade instructions](http://confluence.atlassian.com/display/CONFNET/Upgrade+Instructions) to upgrade from Confluence 2.6.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from [Development Releases](http://confluence.atlassian.com/display/CONFNET/Development+Releases) on the Atlassian website.

**Issues resolved in this release**

View the list of fixes and newly implemented features in [JIRA](http://jira.atlassian.com/). They contain all the issues resolved during development of 2.7, not just the ones fixed since the previous milestone.

**Known problems**

For some reason, an outdated version of the new Dynamic Tasklist 2 was included in this milestone. Since Milestones are not real customer releases, we do ship them with bugs like this. If you want to see the latest and greatest Dynamic Tasklist 2 in action, please simply upgrade to the latest version using the plugin repository from the administration console.

Also, there is an annoying (2.7-specific) bug in this release that causes warnings for all colours used by the colour-macro: [http://jira.atlassian.com/browse/CONF-10001/](http://jira.atlassian.com/browse/CONF-10001/). It will be resolved by the time the next milestone gets released.

Apart from that, M5 is a nice Milestone release and definitely worth a look for all plugin developers - especially now that we are getting closer and closer to the end of the release cycle, and fewer and fewer major architectural changes will be made.

**Release Notes 2.7-m4 (“Milestone 4”)**
Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.

Confluence 2.7-m4 is the second milestone development release for 2.7. (Milestone 3 has been skipped because of stability concerns.) This is a public development release (DR) leading up to Confluence 2.7. Development releases are a snapshot of our work in progress, allowing our customers to see what we’re up to.

Who should upgrade?

Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone, or completely new bugs unknown even to us.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

Upgrade Procedure

Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.6.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

Downloads

All development releases are available from [Development Releases](#) on the Atlassian website.

Issues resolved in this release

View the list of fixes and newly implemented features in [JIRA](#). They contain all the issues resolved since 2.6.x, not just the ones fixed since the previous milestone.

Release Notes 2.7-m2 (“Milestone 2”)

Do not use this release to upgrade your production systems.

For all production use and testing of Confluence, please use the latest official release.
Confluence 2.7-m2 is the first milestone development release for 2.7. This is a public development release leading up to Confluence 2.7. Development releases are a snapshot of our work in progress, allowing our customers to see what we're up to.

**Who should upgrade?**

⚠️ Please note the following

- **Development releases are not safe** — Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Our milestone releases aim to provide plugin developers with an opportunity to see the latest changes in the code.

Each milestone release has passed all our automatic tests, and has been used for one week on our official internal Confluence server. Most of the issues solved have been reviewed too.

However, since our milestones releases are timeboxed (i.e. they get released every two weeks, no matter how far we have come implementing features and bugfixes), there is always a chance that we have new known bugs, which are scheduled to be fixed in the next milestone.

Milestone releases have not been load- or stress-tested. So, for example, they might behave well on a small installation but show severe problems when subjected to many users.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.6.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Bugs fixed in this release**

View the list of fixes in JIRA.

**Release Notes 2.6-dr1**

Confluence 2.6-dr1 is a public development release leading up to Confluence 2.6. Development releases are a snapshot of our work in progress, allowing our customers to see what we're up to.

**Who should upgrade?**
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.
- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

This development release is being made available specifically for Confluence plugin developers to test their existing plugins against the significant style changes that have been made.

For all production use and testing of Confluence, please use the latest official release.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.5.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Note about themes**

Confluence 2.5.x themes are expected to be compatible with 2.6 without authors needing to make any change to their existing themes. This is possible because Confluence will, by default, include all Confluence 2.5.x specific styles automatically.

However, if you would like to upgrade your theme to use the latest style and typography changes in Confluence 2.6, you will need to update the way you include stylesheets in your theme. Full instructions on how to do so can be found here.

**Including Cascading Stylesheets in Themes for Confluence 2.6**

Firstly, you will need to disable the inclusion of Confluence 2.5.x styles. These were included by default to allow 2.5.x themes to remain compatible in Confluence version 2.6 and after.

To disable 2.5.x styles, add the following to your theme's `atlassian-plugin.xml`:

```xml
...<theme key="aqua" i18n-name-key="com.atlassian.confluence.themes.aqua.name" name="Aqua Theme" class="com.atlassian.confluence.themes.BasicTheme">
  <description key="com.atlassian.confluence.themes.aqua.desc"/>
  ...<param name="includeClassicStyles" value="false"/>
  ...
</theme>
...```

Note the flag `includeClassicStyles` is set to `false`. You will have to set this explicitly as the default is `true`.
Secondly, you will need to declare your custom theme style sheet in `atlassian-plugin.xml` like this:

```
...<theme key="aqua" i18n-name-key="com.atlassian.confluence.themes.aqua.name" name="Aqua Theme" class="com.atlassian.confluence.themes.BasicTheme">
  <description key="com.atlassian.confluence.themes.aqua.desc"/>
  ...
  <resource type="stylesheet" name="my.css" location="styles/my-css.vm"/>
  ...
</theme>
...
```

**Differences from Confluence 2.5.x**

- You no longer have to include your theme stylesheet in the main decorator using `#pluginStylesheet` anymore. Confluence will load your theme's stylesheet automatically provided that it's the active theme.
- The resource is declared in the `theme` module instead of the `layout` module.
- You need to start your custom style sheet (say `my-css.vm`), by copying over the latest styles from `http://yourhost/contextPath/styles/main-action.css`. This step is necessary as Confluence now includes either your theme stylesheet or the default stylesheet, **not both**. This implies:
  - you can no longer rely on the default styles being there to style parts of the Confluence you are not directly theming
  - you are no longer overriding styles with your plugin style sheet. It is now the primary stylesheet
  - you will need to merge any new styles in later versions of Confluence into your theme's style sheet

**Multiple style sheets**

It is possible to configure your theme to use multiple style sheets. This feature may useful if you want to break up your main style sheet into a few smaller style sheets with more defined purposes. You can declare these like so:

```
...<theme key="aqua" i18n-name-key="com.atlassian.confluence.themes.aqua.name" name="Aqua Theme" class="com.atlassian.confluence.themes.BasicTheme">
  <description key="com.atlassian.confluence.themes.aqua.desc"/>
  ...
  <resource type="stylesheet" name="my1.css" location="styles/my-css1.vm"/>
  <resource type="stylesheet" name="my2.css" location="styles/my-css2.vm"/>
  <resource type="stylesheet" name="my3.css" location="styles/my-css3.vm"/>
  ...
</theme>
...
```

These style sheets will be included in the order in which they are declared.

**Release Notes 2.3-DR2**

Confluence 2.3-DR2 is the second public development release leading up to Confluence 2.3. Development releases are a snapshot of our work in progress, allowing our customers to see what we're up to.

**Who should upgrade?**
Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual full release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

This development release is being made available specifically for Confluence plugin developers. The changes to the Confluence API discussed below mean that many plugins will need to be updated to work with Confluence 2.3.

For all production use and testing of Confluence, please use the latest official release.

This release should not be used for testing a clustered deployment; the clustering user interface is not yet complete.

**Upgrade Procedure**

Follow the normal upgrade instructions to upgrade from Confluence 2.2.x to this release. We strongly recommend that you backup your confluence-home directory and database before upgrading!

If you are upgrading from Confluence 2.1.x or earlier, be sure to read the upgrade instructions in the Confluence 2.2 release notes.

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**Things to look out for**

- The Tangosol Coherence jars included in this DR are now fully licensed.
- The API for retrieving historical versions of content has changed.

**Architecture changes between Confluence 2.3-DR1 and 2.3-DR2**

**Content history API changed**

The getPreviousVersions method of ContentEntityObject has been removed, because it was insanely inefficient as soon as a piece of content started having lots of versions. It has been replaced with the following methods on the ContentEntityManager:
Confluence 4.3 Documentation

ContentEntityObject getPreviousVersion(ContentEntityObject ceo);
ContentEntityObject getNextVersion(ContentEntityObject ceo);
ContentEntityObject getOtherVersion(ContentEntityObject ceo, int version);

/**
 * Get a VersionHistorySummary for all previous versions of a
 * ContentEntityObject, starting with the current
 * @param ceo the entity object to return the version history of
 * @return the full version history of that object, as VersionHistorySummary
 * objects.
 */
List getVersionHistorySummaries(ContentEntityObject ceo);

The VersionHistorySummary class defines a limited set of Content data that is relevant to viewing version histories.

Release Notes 2.3-DR1

Confluence 2.3-DR1 is the first public development release leading up to Confluence 2.3. Development releases are a snapshot of our work in progress, allowing our customers to see what we’re up to.

⚠️ Please note the following

- **Development releases are not safe**— Development releases are snapshots of the ongoing Confluence development process. For that reason:
  - While we try to keep these releases stable, they have not undergone the same degree of testing as a full release.
  - Features in development releases may be incomplete, or may change or be removed before the next full release.

- **No upgrade path** — Because development releases represent work in progress, we cannot provide a supported upgrade path between development releases, or from any development release to the eventual final release. Thus, it is possible that you will not be able to migrate any data you store in a Confluence development release to a future Confluence release.

Who should upgrade?

This development release is being made available specifically for Confluence plugin developers. The changes to the Confluence API discussed below mean that many plugins will need to be updated to work with Confluence 2.3.

For all production use and testing of Confluence, please use the latest official release.

⚠️ The bundled Tangosol library with this development release has a license which expires on August 31, 2006. This release will not operate after that date.

This release should not be used for testing a clustered deployment; the clustering user interface is not yet complete.

Upgrade Procedure

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Follow the [normal upgrade instructions](#) to upgrade from Confluence 2.2.x to this release. *We strongly recommend that you backup your confluence-home directory and database before upgrading!*

If you are upgrading from Confluence 2.1.x or earlier, be sure to read the upgrade instructions in the [Confluence 2.2 release notes](#).

**Downloads**

All development releases are available from [Development Releases](#) on the Atlassian website.

**New features in Confluence 2.3**

In short, the new features of Confluence 2.3 are:

- Clustering support (not available in 2.3-DR1)
- People directory
- Bundled [Plugin Repository Client](#)

**Architecture changes between Confluence 2.2 and 2.3-DR1**

Summarised below are architectural changes that might be relevant to plugin developers. Please add a comment below if there is anything else that should be listed here.

*We've kicked the Bucket!*

Most of the functionality of Confluence’s biggest internal library, bucket, has been split into three new components: atlassian-config, atlassian-spring and atlassian-event.

Where practical, the old interface is still available as deprecated classes and methods. **However, some plugins will not compile unless modified to use the new package names.**

Please refer to the source code or [Javadoc](#) for details on the new interface.

**Tangosol Coherence replaces EhCache**

Tangosol Coherence is now the caching library used by Confluence, both in clustered and non-clustered mode. To facilitate this, some of the caching APIs have been updated.

As mentioned above, the Tangosol license included with this release is specifically for testing purposes and will expire on August 31, 2006.

**Bandana configuration stored in database**

The Bandana Confluence configuration files previously stored in confluence-home are now stored in the database. An upgrade from a previous version will automatically move existing configuration settings to the database.

**Release Notes 2.0-RC2**

Confluence 2.0-RC2 is the second release candidate for Confluence 2.0 (previously known as Confluence 1.5). It resolves almost 80 issues since the 1.5-RC1 release.

**Who should upgrade?**

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features. Developer releases are not suitable for running on production systems.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.
Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.x or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

Important Notice

If, after you have upgraded Confluence, the "Recent Changes" list on the dashboard is empty, this may be because you need to re-build your site's search index. You can do this under Administration  Content Indexing  Rebuild Search Index

Important Notice 2

If, after you have upgraded Confluence and you find the page breadcrumbs do not show the page's parents correctly, log into your site as administrator, then visit http://yoursite.example.com/admin/permissions/rebuild_ancestor_table.action (substituting your own site's URL, obviously) to rebuild the ancestor table (this will be fixed for the final release.

Downloads

All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 2.0-RC2

The 2.0-RC2 has largely concentrated on fixing bugs and polishing existing features. If you are upgrading from Confluence 1.4 or earlier, you should read the 1.5-DR2 Release Notes for a description of the major new features in Confluence 2.0.

Consult JIRA for the full list of issues resolved for 2.0-RC2.

Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.

Release Notes 2.0-RC1

Confluence 2.0-RC1 is the first release candidate for Confluence 2.0 (previously known as Confluence 1.5). It resolves almost 150 issues since the 1.5-RC2 release.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features. Developer releases are not suitable for running on production systems.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.x or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.
1.4 release notes.

**Important Notice**

If, after you have upgraded Confluence, the "Recent Changes" list on the dashboard is empty, this may be because you need to re-build your site's search index. You can do this under Administration Content Indexing Rebuild Search Index.

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**New Features in Confluence 2.0-RC1**

The 2.0-RC1 has largely concentrated on fixing bugs and polishing existing features. If you are upgrading from Confluence 1.4 or earlier, you should read the 1.5-DR2 Release Notes for a description of the major new features in Confluence 2.0.

Consult JIRA for the full list of issues resolved for 2.0-RC1.

**Notable Features and Improvements**

- You can now place markup such as bold or italics within a word if you are using the WYSIWYG editor
- The following characters are now permitted in page titles: ! & ( ) * ~ $ _ Pages can not, however, start with ~ or $.
- The most recent change comment for a page is now included in the page's searchable text
- rel="nofollow" added to links to printable versions of pages, to prevent them from being indexed by search engines
- The Recent Changes list on the dashboard now correctly reflects whether you are viewing all spaces, a team, or your favourite spaces
- Further improvements to the edit page UI including:
  - Improved label editing
  - Inline page previewing
  - Hiding of lesser-used functions such as moving a page or editing page permissions
- Attachment downloads now support HTTP conditional get
- Space exports now include that space's labels and page-level properties
- Support for labels in the SOAP and XML-RPC remote APIs has been completed
- Determining if a user exists via the remote API is now supported

**Release Notes 1.5-DR2**

Confluence 1.5-DR2 is the first public development release leading up to Confluence 1.5. (Confluence 1.5-DR1 was an internal release only). Developer releases are a snapshot of our work in progress, allowing our customers to see what we're up to, and provide feedback

**Who should upgrade?**

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features. Developer releases are not suitable for running on production systems.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.
Macro Compatibility

Incompatibilities exist that may cause Confluence not to start if custom macros are deployed. When upgrading to Confluence 1.5-DR2, be sure to remove any custom Macro plugins from your $confluencehome/plugins and WEB-INF/lib directories. These incompatibilities should be resolved before the final, stable release.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.3.x or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

Downloads

All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 1.5-DR2

We've been pretty busy, but the four major new features you can find in 1.5-DR2 are:

- WYSIWYG Editing
- Labels for content
- A dynamic RSS Builder
- Change summaries

Consult JIRA for the full list of issues resolved for 1.5-DR2. 1.5-DR2 also incorporates all the bug-fixes that were made between TestTest.

WYSIWYG Editing

Browser Compatibility

The Confluence WYSIWYG editor is currently only compatible with Internet Explorer 6 on Windows, plus Mozilla and Firefox across platforms. Javascript must be enabled in the browser for the editor to function. Support for Safari under Mac OS X is currently not available. To track Safari compatibility, please follow this JIRA issue: CONF-3864

The WYSIWYG editor allows for Confluence pages to be edited directly through an editing GUI embedded in the web browser, without having to remember Confluence's wiki markup. It almost goes without saying that this has been our number one most requested features, and we're glad we can finally offer it!

Global administrators can enable WYSIWYG editing in the General Configuration screen of the site's preferences. They can also choose whether users are presented with the WYSIWYG editor by default, or whether users default to the old wiki markup text-field.
If WYSIWYG markup is enabled, but an individual user does not like the default set by the administrator, they are free to override it via a "make this my default" link that will appear on whichever editor is currently not your default.

For the “feature mad” amongst us, here are some neat things you can do with the WYSIWYG editor:

- Full screen view - really useful for editing large pages. Click in the menu bar.
- Quickly switch between WYSIWYG and Wiki markup without a page refresh
- Change the size of your editing window to suit your browser. Your size preference is remembered across sessions. To change it, drag the handle in the bottom right hand corner of the editor.
- Undo and redo!

**Labels for content**

Another highly requested feature was the ability to categorise content within Confluence beyond the rigid hierarchy allowed by spaces and parent-child relationships between pages. To this end we have introduced labels.

Labels are simple one-word ‘tags’ that can be added to any page or blog-post the user has permission to edit. Labels can be used to categorise content, bookmark it, flag it for attention, or anything else you can think of.

A Tag By Any Other Name

Picking a name for labels wasn't easy. Google's GMail service calls them labels, while other collaborative categorisation systems such as del.icio.us and Flickr call them tags. We decided that 'label' was a more natural description. For more information about the philosophy behind labels and tags, check out the Folksonomy page on Wikipedia

Labels can be added to any page from the edit screen, as a space-separated list of words. If you are browsing the site with a modern, Javascript-enabled browser, you’ll also be able to use the dynamic web UI to add labels while viewing the page through an interactive interface.

Once a page is labeled, then clicking on the label's name allows you to browse other pages with the same label, or view related labels that commonly occur on the same pages.

You can also view the space's most popular labels from the space browser, to get an idea of the most popular topics within the space.
Many other Confluence features interact with labels: they can be searched for through the search interface, the new RSS builder can filter pages by their label, and we’re looking forward to building label support into Confluence's packaged macros, and even the dashboard.

**Personal Labels**

If you prepend `my:` to a label (for example, `my:todo` or `my:favourite`), then the label is a personal label – only visible to you. Personal labels allow you to tag content for your own purposes. You can browse your personal labels from your user profile. Any user can add their personal labels to any page, even when they don't have editing permission.

---

**Personal Label Privacy**

It is possible in Confluence 1.5-DR2 to see other people's personal labels in various views through the system. This is a known issue and in the final release, personal labels will be private to the user. (sharing personal labels at the user's discretion is also planned for the future)

---

**Favourites**

Favourites are a special personal label: `my:favourite` or `my:favorite`. Whenever you see the ![heart](heart.png) icon, it means you can label this content as being your favourite, and whenever you see the ![check](check.png) icon, it means that the content is currently in your list of favourites. You can view your favourites from the Labels tab of your user profile, but they come in handy for...

---

**Labels and the Dashboard**

Labels can be used on the Dashboard to create different views of the Confluence site. The list of spaces now offers the following tabs:

- **My** shows you spaces that you have labelled as a Favourite. You can label any space you see on the dashboard by clicking its ![heart](heart.png) icon.
- **Team** allows space admins to dynamically create lists of spaces on particular topics (see below. This tab only appears if there are teams that the user can see)
- **New** shows any spaces that have been created in the last week (This tab only appears if there are new spaces)
- **All** shows all the spaces in the Confluence site
A "team" is a group of spaces that share a common team label. Spaces can be labeled from the Advanced tab of Browse Space.

As of Confluence 1.5-DR2, anyone can add space-level labels. This will be fixed in the final release.

The Recent Changes list on the dashboard will show only content that has been changed in the spaces that are currently listed in the space view. So if you are currently viewing the 'My' tab, only updates in your favourite spaces will be shown on the dashboard.

If you are logged in, Confluence will remember your most recently selected tab and team on the dashboard.

Dynamic RSS Builder

A third highly-requested feature. Confluence has always provided a brace of useful RSS feeds, but the problem is that for every feed we provided, users wanted half a dozen more. The obvious answer is to let users build RSS feeds based on their own chosen criteria. You can access the RSS builder from the Confluence dashboard.

Once in the builder, you can choose
- Which spaces to include in the feed
- Which types of content should be tracked
- Which labels, if any, you are interested in
- How many items to include in the feed
- Whether you want a single RSS entry per page or one for each time the page is edited
- Whether you want an RSS 2.0 or Atom 0.3 feed
- Whether Confluence should require authentication to view the feed

Once you have decided what you want, Confluence will give you a URL to paste into your RSS reader. These URLs can be shared with other Confluence users, although they will only ever be allowed to see content that they have permission to view. If you have asked to authenticate, Confluence will require HTTP Basic Authentication, which is supported by most RSS readers.

We've also taken the opportunity to improve the presentation of our RSS feeds - including a lot more information in each feed so you can follow your Confluence site entirely from your newsreader.
Change summaries

In a very late addition (added during our recent FedEx Day 2), Confluence now has change summaries. These allow you to add a comment to each edit that will appear in change histories, allowing you to keep a more complete record of how and why a particular page has been modified.

There is also a `{change-history}` macro to enable you to display a page's history within its body if you so desire.

Other Things to Check Out

Embed Flash and Movies

You can now embed Flash content or movies (Quicktime or Windows Media) into a page as easily as you can an image: just attach the Flash or movie file to the page, then include it as you would include an image (`!filename.mov!`).

Export Pages as Word Documents

You can now export pages straight into Word from the Info tab. This is extremely useful for emailing around content to non-Confluence users, printing a document or just creating a backup in Word.

Improved Search Interface

Results returned from Confluence's search engine now have:

- Improved contextual results, showing the most important text around where your query was matched in the page
- Contextual results for any attachment: see where a search was matched even inside PDF, Word, PowerPoint or Excel documents!
- Search results for attachments give you more (and clearer) information about what the attachment is, and where it's from!

Improved Gallery Macro

The gallery macro has been spruced up, and now has a slideshow view:
Alphabetically organised labels for a given space.

Popular labels for a given space.

A very basic (quite boring - sorry, it's late) example of change summaries.

The new RSS builder lets you construct RSS feeds of exactly the content you want.

These release notes exported to Word (even on a Mac!) - great for printing too.

Improved search showing fragments from attachments, file sizes and types.

Spaces:
- A start
- Alphabetic
- Popular
- View
- #1a
- #1b
- #1c
- #2a
- #2b
- #2c

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Screenshot of the new 1.5 WYSIWYG editor.

Also:

- Additions to the Confluence Remote API including:
  - Comment manipulation
  - Label manipulation
  - Attachment uploading and editing
  - Improved user- and permissions management
- Import and restore now have progress indicators
- Backup and restore use significantly less memory
- The embedded database has been upgraded to HSQL 1.8, which should be significantly more reliable
- Collapsed breadcrumbs now expand with a single mouse click

Known Bugs

Confluence 1.5-DR2 is a preview, not a full Confluence release, and as such there are a number of known bugs included in the release (at no extra cost!). Important bugs include:

- The left-navigation theme is currently broken
- The "make this my default editor" link does not always appear (try switching back and forth between views)
- The Info page may cause a Hibernate exception when its parent has page level permissions
- The space export may be unreliable, and does not properly back up labels.
- Incoming Trackback pings are not recognised
- Various WYSIWYG round-trip inconsistencies

Release Notes 1.5-DR1

Confluence 1.5-DR1 is the first development release leading up to Confluence 1.5. Developer releases are a snapshot of our work in progress, allowing our customers to see what we're up to, and provide feedback.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features. Developer releases are not suitable for running on production systems.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

⚠️ DB2 Compatibility

At the time of release, there were a number of issues performing database queries for labels or RSS feeds against DB2 databases. These issues will be fixed for the next release. For now, though, we do not recommend testing this release on DB2.
Macro Compatibility

Incompatibilities exist that may cause Confluence not to start if custom macros are deployed. When upgrading to Confluence 1.5-DR1, be sure to remove any custom Macro plugins from your `$confluencehome/plugins` and `WEB-INF/lib` directories. These incompatibilities will be resolved before the final, stable release.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.4 or higher, you can find instructions here. We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

If you are upgrading from Confluence 1.4.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.4 release notes.

Downloads

All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 1.5-DR1

The three major features we've been working on are:

- **WYSIWYG Editing**
- **Labels** for content
- **A dynamic RSS Builder**

Consult JIRA for the full list of issues resolved for 1.5-DR1

1.5-DR1 also incorporates all the bug-fixes that were made between Confluence 1.4 and Confluence 1.4.3.

WYSIWYG Editing

⚠️ Browser Compatibility

The Confluence WYSIWYG editor is currently only compatible with Internet Explorer 6 on Windows, plus Mozilla and Firefox across platforms. Javascript must be enabled in the browser for the editor to function. Support for Safari under Mac OS X is currently not available. To track Safari compatibility, please follow this JIRA issue: [CONF-3864](https://jira.atlassian.com/browse/CONF-3864)

The WYSIWYG editor allows for Confluence pages to be edited directly through an editing GUI embedded in the web browser, without having to remember Confluence's wiki markup. It almost goes without saying that this has been our number one most requested features, and we're glad we can finally offer it!
Global administrators can enable WYSIWYG editing in the General Configuration screen of the site's preferences. They can also choose whether users are presented with the WYSIWYG editor by default, or whether users default to the old wiki markup text-field. If WYSIWYG markup is enabled, but an individual user does not like the default set by the administrator, they are free to override it in their preferences.

Labels for content

Another highly requested feature was the ability to categorise content within Confluence, beyond the rigid heirarchy allowed by spaces and parent-child relationships between pages. To this end we have introduced labels. Labels are simple one-word 'tags' that can be added to any page or blog-post that the user has permission to edit. Labels can be used to categorise content, bookmark it, flag it for attention, or anything else you can think of.

### A Tag By Any Other Name

Picking a name for labels wasn't easy. Google's GMail service calls them labels, while other collaborative categorisation systems such as del.icio.us and Flickr call them tags. We decided that 'label' was a more natural description. For more information about the philosophy behind labels and tags, check out the Folksonomy page on Wikipedia.

Labels can be added to any page from the edit screen, as a space-separated list of words. If you are browsing the site with a modern, Javascript-enabled browser, you'll also be able to use the dynamic web UI to add labels directly from the page itself. Once a page is labeled, then clicking on the label will enable you to browse other pages that have been similarly tagged, or browse other labels that commonly occur on the same page. You can also view the space's 200 most popular labels from the space browser, to get an idea of the most popular concerns within the space. Many other Confluence features interact with labels: they can be searched for through the search interface, the new RSS builder can filter pages by their label, and we're looking forward to building label support into Confluence's packaged macros, and even the dashboard.

### Personal Labels

If you prepend my: to a label (for example, my:todo or my:favourite, then the label is a personal label – only visible to you. Personal labels allow you to discreetly tag content for your own purposes. You can browse your personal labels from your user profile. Any user can add their personal labels to a page, even if they don't have permission to edit it.
A third highly-requested feature. Confluence has always provided a brace of useful RSS feeds, but the problem is that for every feed we provided, users wanted half a dozen more. The obvious answer is to let users build RSS feeds based on their own chosen criteria. You can access the RSS builder from the Confluence dashboard.

Once in the builder, you can choose

- Which spaces to include in the feed
- Which types of content should be tracked
- Which labels, if any, you are interested in
- How many items to include in the feed
- Whether you want a single RSS entry per page or one for each time the page is edited
- Whether you want an RSS 2.0 or Atom 0.3 feed
- Whether Confluence should require authentication to view the feed

Once you have decided what you want, Confluence will give you a URL to paste into your RSS reader. These URLs can be shared with other Confluence users, although they will only ever be allowed to see content that they have permission to view. If you have asked to authenticate, Confluence will require HTTP Basic Authentication, which is supported by most RSS readers.

We've also taken the opportunity to improve the presentation of our RSS feeds - including a lot more information in each feed so you can follow your Confluence site entirely from your newsreader.

The Atom 1.0 draft has just been accepted as an IETF standard. Future versions of Confluence will be phasing out use of Atom 0.3 in favour of Atom 1.0.

Known Bugs

Confluence 1.5-DR1 is a preview, not a full Confluence release, and as such there are a number of known bugs included in the release (at no extra cost!). Important bugs include:

- Label and RSS database queries do not work on DB2
- WYSIWYG editor adds extra information to browser history on Firefox
- Going to a page when not logged in will present you with a 404 error page, instead of giving you the chance to log in
- Various WYSIWYG round-trip bugs

Release Notes 1.4-RC2

Confluence 1.4 Release Candidate 2

1.4-RC2 is now available for download here.

Confluence 1.4-RC2 is (barring some absolute disaster) the final public developer build for Confluence 1.4. It incorporates all the changes that were deployed in the private DR7 build, as well as around 60 new bug fixes and improvements.

Confluence 1.4-RC2 is being released to give Confluence customers the opportunity to test the upgrade path for their existing Confluence installation. By testing your migration with this pre-release, you can ensure that any problems you may experience will be fixed before the final 1.4 release, rather than having to rely on ad-hoc patches or wait for 1.4.1.

Who should upgrade?

While 1.4-RC2 is still pre-release software, and we do not recommend upgrading production Confluence sites until the release of 1.4-final, we would recommend any existing Confluence customer install this release on a test server, and try to import their existing Confluence data into it.

Upgrade Procedure
Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

When you first start Confluence 1.4-RC2 after upgrading, the server may take a few minutes to become fully functional. This is because Confluence is rearranging information in the database so that it can be looked up more efficiently. This will only be done the first time Confluence is started after upgrading.

New Features in Confluence 1.4-RC2

The changes made between DR7 and RC2 are mostly correctness and polish issues - major feature development on Confluence 1.4 has been completed. A few notable changes however are:

- You can upload attachments while editing a page – from the "Insert Link" popup
- The dynamic content-tree degrades gracefully on unsupported browsers
- Many bugs related to PDF export (and images included in PDF exports) have been fixed
- Ü characters in page titles no longer confuse the database
- Text properties set via the contentPropertyManager can now be longer than 255 characters, fixing related bugs in the {tasklist} and {excerpt} macros
- The {attachments} macro can display the list of attachments inline within a page
- New XML-RPC and SOAP plugin types allow you to deploy web services dynamically into Confluence
- A potential connection leak that has been causing problems for Oracle users has been fixed.

And much much more.

Release Notes 1.4-DR7

Confluence 1.4-DR7

Confluence 1.4-DR7 is the first release-candidate build of Confluence 1.4. In 1.4-DR7 we have resolved over 120 issues: mostly related to fixing bugs and polishing up the application for a stable release. We anticipate that DR7 will be the last major build before the stable 1.4 release.

DR7 is not a public release. It has been built and deployed onto http://confluence.atlassian.com as part of our internal quality-control process, but we have decided that the developer time required to make this a public beta release would be better directed towards continuing the push towards a final, stable 1.4 build.

Who should upgrade?

Since Confluence 1.4-DR7 is not publicly available, nobody should upgrade. The upgrade note below is just for completeness, so when we come to gather all these release notes together into a single note for 1.4, we don’t miss the warning.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.
When you first start Confluence 1.4-DR7 after upgrading, the server may take a few minutes to become fully functional. This is because Confluence is rearranging information in the database so that it can be looked up more efficiently. This will only be done the first time Confluence is started after upgrading.

New Features in Confluence 1.4-DR7

The changes made between DR6 and DR7 are mostly correctness and polish issues - major feature development on Confluence 1.4 has been completed. A few notable changes however are:

- The space content tree is now updated dynamically, leading to much faster page-load times and much less load on the server (for large spaces, this page was turning into a reliable way to DOS Confluence). However, you must have a modern web browser with Javascript enabled for the tree to work. (A non-Javascript fallback will be included in 1.4-final - CONF-3098)
- You can now customise the site's name alongside the logo
- The display and navigation of page history diffs has been improved significantly
- Webdav configuration has been reinstated to the same functionality as 1.3.5
- An "insert image" popup has been added to the page editing screen, that can select images from the page's attachments. There is also an Attachments tab in the "insert link" popup. Allowing file upload from these popups has not yet been implemented (CONF-3099)
- Many improvements and fixes to email notifications
- Marking your change as a "minor edit" will prevent email notifications being sent
- The new Component plugin module adds new beans to the Spring context
- You can now uninstall plugins via the web interface
- The default theme has various keyboard shortcuts (see the tabs on this page)
- The Include Page Macro can now include pages from other spaces
- For developers, macros can now decide whether or not they have a body
- Report showing all attachments to pages in a space (check it out!)
- Generally improved notifications including a much more usable "File Attached" notification
- “View wiki source” link, for all those source junkies...

And much much more.

Release Notes 1.4-DR6

Confluence 1.4-DR6

Confluence 1.4-DR6 is the next development release in the cycle leading up to Confluence 1.4. In 1.4-DR6 we:

- introduce page-level view permissions,
- make Confluence radically more themeable,
- further improved the overall user interface and usability,
- add several interesting new plugin types,
- add file attachments to blog posts and user profile pages,
- let you customize Confluence logos at a space and global level, and
- help you keep track of all the email watches you might have set up in Confluence.

Phew! Got all that?

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.
Note for Oracle Users

Confluence 1.4-DR6 is currently not recommended for Oracle users, as it has not passed our test-suite against the Oracle database. This will (obviously) be fixed before we release Confluence 1.4.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

If you upgrade to Confluence 1.4-DR6 you will need to rebuild your search indexes before search will function correctly. Look for "Rebuild Search Index" on the global Administration page.

Downloads

All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 1.4-DR6

See also: Issues Resolved for 1.4-DR6

Page Level Permissioning

A highly-requested feature, and the reason this DR took so long to get out, you can now hide pages from other users. The option for hiding pages can be found at the bottom of the page's "Edit" screen.

- You can hide a page so it is only visible to yourself, or only visible to members of groups you belong to.
- Once a page is hidden, all its child pages (and their children, and so on) are also hidden.
- A new space-level permission has been introduced to determine which users are permitted to hide pages.

Please note that it may be possible for users to learn the names of hidden pages, even if they can't see their content. So don't make a page called "We Hate Bob Smith" if Bob Smith has access to your wiki. Just make a page called "We hate..." and put Bob's name in the body.

Improved Themes

While the overwhelming reaction to the User Interface changes we have made in the 1.4-DR series has been positive, it has sparked continuing discussions on the user mailing list about various aspects of the presentation of a Confluence site. From these discussions we have determined:

- Everyone wants something slightly different.
- Some people want something completely different.

In response, we've moved to vastly improve the level of themeability that Confluence offers. Almost all of the user interface elements have been pushed into customisable decorators, so if you don't like the tabs, you will be able to install a theme that removes them entirely! We're hoping to bring out some example themes with the 1.4 release that do just this, but for now you can read the documentation for the new decorators in the Theme Module documentation.

Plugin Improvements

To make Confluence more flexible, we're introducing more ways for advanced users to extend the system:
Uploadable Plugins

Confluence administrators can now upload new plugins through the administrative interface, and have them installed without restarting the server.

Search Extractor Plugins

Extractor plugins allow you to add custom information to Confluence's full-text index when Confluence content is saved or updated. The most obvious application for this plugin type is to allow you to index attachment formats that Confluence does not yet support, but more creative plugin authors might make use of this as a sneaky way to store and retrieve metadata about any content in the Confluence system. Documentation for Extractor plugins is coming soon.

XWork Plugins

XWork plugins allow you to add new XWork (Webwork 2) actions to Confluence. Advanced programmers can add entirely new behaviours to the application: take a look at the examples in [XWork-WebWork Module](#), in which we've implemented a rudimentary "Google Suggest"-like live search entry box for Confluence:

Servlet Plugins

Servlet plugins allow you to deploy servlets into Confluence dynamically – perfect for integrating Confluence with some legacy application that is only available as a servlet. See [Servlet Module](#) for an example.

Attachments for Blog Posts and User Profiles

You can now upload attachments to blog posts and user profiles, both frequently requested features. Users have the option to nominate one picture attached to their profile as their "profile picture", but we haven't quite decided what to do with this information yet. 😊

There is a new global permission to determine if users can attach files to their profile. This permission is not assigned by default, so you will need to explicitly give it to users if you want to enable this feature.

Customizing Logos at a Space and Global Level

Space and global administrators may now easily configure the image displayed as the Confluence logo. This can be done for each space, or at a global level, without having to actually edit a single file.

Keeping track of your Email Watches

A Notifications link on your profile displays a list of all currently configured email watches you might have set up on various spaces or pages. You can now delete them in one, central, place or simply visit them.

Bug fixes

All bugs fixes made between Confluence 1.3.2 and Confluence 1.3.5 have been merged into the developer release branch, fixing many annoying bugs including the crash on selecting "Next" in search results. See also: [Issues Resolved for 1.3.4](#), [Issues Resolved for 1.3.5](#).

Issues Resolved for 1.4-DR6

<table>
<thead>
<tr>
<th>JIRA Issues</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>Authenticate to retrieve your issues</td>
</tr>
</tbody>
</table>
Confluence 1.4-DR4 is the fourth development release in the cycle leading up to Confluence 1.4. In 1.4-DR4 the user interface continues to improve, and our new wiki->HTML renderer lands, fixing a large number of bugs (but probably introducing a few more)

1.4-DR4a

One of the bugs that was introduced in 1.4-DR4 caused the edit option to disappear completely from the Confluence interface for anyone who was not a global administrator. Because that issue rendered Confluence mostly unusable, 1.4-DR4a has been released including a fix to that problem. 1.4-DR4a also includes the patch for Confluence Security Advisory 2005-02-09.

We would like to remind everyone who downloads the developer releases that they are not fully stable.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find in instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Downloads
All development releases are available from Development Releases on the Atlassian website.

**New Features in Confluence 1.4-DR4**

**User Interface Enhancements**

The user interface of Confluence continues to improve. A big thankyou to all the users who contributed feedback on DR3. While the changes between DR3 and DR4 aren't as radical as the last release, we've been able to polish up a lot of the edges, and make Confluence even easier and more pleasant to use.

We're still gathering feedback on the UI changes, add your input here: 1.4 UI Discussion

**Mail Archives**

- You can now bulk-delete all mail within a space (mail deleted this way does not go to the trash, and can not be recovered later!)
- Pagination on the mail archives is a bit more sane: it doesn't try to tell you about every single page of mail in the archives.
- The mbox importer detects if you're trying to import something that isn't an mbox file, making you much less likely to break anything if you upload the wrong file.

**Nofollow Support**

As part of the effort to combat spam on wikis and blogs (Confluence being both), Google came up with some markup that will cause search-engines not to follow links. By removing the main benefit of wiki-spamming (increased search-engine PageRank), it's hoped that the noxious practice will stop being cost-effective, and eventually die out.

By default, all URLs inserted in a page (or in comments) will be given the nofollow tag. Inter-page links or shortcut links (i.e. CONF-2622) will not be tagged. If your wiki doesn't support public editing or commenting, or you just disapprove of nofollow on principle, the site administrator can turn the feature off in General Configuration.

**V2Renderer**

Over the last few releases of Confluence, it has become apparent that the engine we were using to convert wiki text to HTML was starting to cause us problems. There were a growing number of bugs that we simply couldn't fix, because the nature of the engine meant that fixing one bug would cause ten worse bugs to spring up in its place. After a few false starts, we can now introduce 'v2Renderer', which fixes quite a few of these problems already, and promises to make fixing the rest of them much easier:

**Error rendering macro 'jiraissues' : Unable to determine if sort should be enabled.**

Because this is the first public release of v2Renderer, it's likely that there are some situations in which the markup of pages may change. We've been pretty careful, but users who have been making heavy use of undocumented (or accidental) features of the old markup may encounter situations in which the page displays differently to before. Please, please report these problems to us, so that we can fix the renderer for the final release, or perhaps provide you with a script to painlessly convert your pages to a markup that works.

**Renderer Bugs**

If you file a bug about the v2Renderer, PLEASE make sure you put it in the Wiki/XHTML component: this makes finding all the relevant bugs so much easier for me. – Charles Miller

**Macros**

There is a new macro API that we will be rolling out for 1.4. However, there's a compatibility layer in place to
make sure that most 1.3 macros will continue to function properly. Most macros written for Confluence 1.3 will continue to work in 1.4-DR4. Most of our macros are running without any changes at all, and many of the ones we did migrate were changed over in order to use the capabilities of the new engine to fix bugs.

We suggest that macro authors who are worried about compatibility test their macros with 1.4-DR4 and contact us as soon as possible to discuss how we can improve the compatibility layer before the final release, or help you migrate to the new API.

**Known Bugs**

The renaming of links when a page is moved or renamed is currently unreliable. This is a side-effect of the change in renderers, and will be fixed before the final version of 1.4 is released.

**Release Notes 1.4-DR3**

Confluence 1.4-DR3 is the third development release in the cycle leading up to Confluence 1.4. It is the first step in a process of making the Confluence User Interface simpler, and easier to navigate.

**Who should upgrade?**

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your `confluence.home` directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

**Downloads**

All development releases are available from Development Releases on the Atlassian website.

**New Features in Confluence 1.4-DR3**

**User Interface Enhancements**
Some of the most frequent feedback we get about Confluence is that while users like the wealth of features on offer, the interface is often overwhelmed by too much information and too many options, making Confluence difficult to navigate, and difficult to introduce to non-technical users. Confluence 1.4-DR3 is the first step in an attempt to present a cleaner, more useable design for Confluence, while still providing a powerful interface for experienced users.

1.4-DR3 is a developer release. As such, some of the changes to the interface are incomplete, and some may not make it into the final version. Please offer your feedback on 1.4 UI Discussion.

While the obvious way to get a look at the new interface is just to explore this site, here are a few screenshots that might help:
I'm also compiling a page to help people who are used to Confluence Classic, and might be a little lost in the new interface: 1.4 Interface - Where Did Everything Go?

Known Bugs

A page has been created in the Discussion space to gather comments, suggestions, compliments and complaints about the new interface: 1.4 UI Discussion

1.4 Interface - Where Did Everything Go?

If you’re used to the Confluence Classic interface, the new 1.4 interface might be a little hard to navigate at first. We think that the new design is a vast improvement, but it's inevitable that people who have used the application since its release will be wondering where some of the buttons they were used to have gone...

Where Did They Go...

- Blogs?
- Rename Page?
- Move Page?
- Create Child Page?
- Page Locks?

Like it? Don’t? Join the discussion.

Blogs?

By incredibly popular demand, blogs have been renamed to "News" across the site. While blogs are all the rage at the moment (or, as my brother would say, very zeitgeisty), it's still far easier to explain "News" to someone familiar with blogs, than it is to explain blogs to someone who is familiar with news.

Rename Page?

Rename page is no longer a separate function. Just edit the page and change the page title, and Confluence will rename all the links to the page for you.
Move Page?

Move page is no longer a separate function. Just edit the page and change its space, and Confluence will move the page to the new space for you, renaming any links to the page. If the page has children, you will be given the option to move all the children as well.

Create Child Page?

Whenever you select the "Add Page" link from the top of the page, your current page will be automatically inserted into the Parent Page box. We've found that this is the way most people use Confluence anyway.

Page Locks?

Page locks have been renamed "Permissions" and moved to the bottom of the edit page. We found that most people didn't understand (or couldn't find) locks, and thus didn't understand that Confluence has page-level edit security.
Release Notes 1.4-DR2

Confluence 1.4-DR2 is the second development release in the cycle leading up to Confluence 1.4. Seeing as the DR2 development fortnight straddled Christmas it's not quite as feature-laden as some previous releases, but we thought we'd give you a few new toys to play with for the New Year.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Downloads

All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 1.4-DR2

Consult JIRA for the full list of issues resolved for 1.4-DR2

Export Page Hierarchy

When you export a page to PDF or HTML, you have the option to include its children in the export.
**Popup Page Picker**

We now have a popup that can be used to select pages for inserting links, or choosing a page's parent. The picker lets you choose from your recently visited pages, the list of pages that link to the current page, or you can perform a search within the picker itself.

![Page Picker](image)

**New Macros**

As part of the process of making Confluence more flexible, we have implemented the various functions of the Confluence dashboard and space summary pages as macros. These macros are currently disabled by default, but if you're interested in using them within regular pages, you can enable them from your global plugin configuration.

This currently has no effect on the dashboard itself - but will become useful in the future when the dashboard becomes customisable. For example, the `{spaces-list}` macro will reproduce the list of spaces that appears on the dashboard:

**Spaces:**  All  Favourite  Category  New (2)

<table>
<thead>
<tr>
<th>Application Links 1.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for AppLinks version 1.x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application Links 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for AppLinks 2.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application Links 2.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for AppLinks 2.1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application Links 3.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for AppLinks 3.0</td>
</tr>
<tr>
<td>Atlassian User Group</td>
</tr>
<tr>
<td>----------------------</td>
</tr>
<tr>
<td><strong>Atlassian User Management 1.0</strong></td>
</tr>
<tr>
<td>Documentation for version 1.0 of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Atlassian User Management 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for version 2.0 of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Atlassian User Management 3.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documentation for the latest version of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Atlassian Webinars</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bamboo 1.0</strong></td>
</tr>
<tr>
<td>Documentation for Bamboo 1.0</td>
</tr>
</tbody>
</table>

| **Bamboo 1.1** |
| Documentation for Bamboo 1.1 |

| **Bamboo 1.2** |
| Documentation for Bamboo 1.2 |

| **Bamboo 2.0** |
| Documentation for Bamboo 2.0 |

| **Bamboo 2.1** |
| Documentation for Bamboo 2.1 |

| **Bamboo 2.2** |
| Documentation for Bamboo 2.2 |

| **Bamboo 2.3** |
| Documentation for Bamboo 2.3 |

| **Bamboo 2.4** |
| Documentation for Bamboo 2.4 |

| **Bamboo 2.5** |
| Documentation for Bamboo 2.5 |

| **Bamboo 2.6** |
| Documentation for Bamboo 2.6 |

| **Bamboo 2.7** |
| Documentation for Bamboo 2.7 |

| **Bamboo 2.7 Archive Backup** |
| Archived Documentation for Bamboo 2.7 (supersedes BAMBOO027 space) |

| **Bamboo 3.0** |
| Documentation for Bamboo 3.0 |

| **Bamboo 3.1** |
| Documentation for Bamboo 3.1 |

| **Bamboo 3.2** |
| Documentation for Bamboo 3.2 |
Confluence 2.10
Complete documentation for Confluence version 2.10

Confluence 2.5
Complete documentation for Confluence versions 2.0 to 2.5.3.

Confluence 2.5.6
Complete documentation for Confluence versions 2.5.4 to 2.5.8.

Confluence 2.6
Complete documentation for Confluence version 2.6

Confluence 2.7
Complete documentation for Confluence version 2.7

Confluence 2.8
Complete documentation for Confluence version 2.8

Confluence 2.9
Complete documentation for Confluence version 2.9

Confluence 3.0
Complete documentation for Confluence version 3.0

Confluence 3.1
Complete documentation for Confluence version 3.1

Confluence 3.2
Complete documentation for Confluence version 3.2

Confluence 3.3
Complete documentation for Confluence version 3.3

Confluence 3.4
Complete documentation for Confluence version 3.4

Confluence 3.5
Complete documentation for Confluence version 3.5

Confluence 4.0
Complete documentation for Confluence version 4.0

Confluence 4.1
Complete documentation for Confluence version 4.1

Confluence 4.2
Complete documentation for Confluence version 4.2

Confluence 4.3
Complete documentation for Confluence version 4.3

Confluence Extensions

Confluence Homepage Image

Confluence Knowledge Base
Troubleshooting and support tips for Confluence

Confluence Latest
### Confluence SharePoint Connector 1.0
Documentation for version 1.0.x of the Confluence SharePoint Connector.

### Confluence SharePoint Connector 1.1
Documentation for version 1.1.x of the Confluence SharePoint Connector.

### Confluence SharePoint Connector 1.2
Documentation for the Confluence SharePoint Connector 1.2. This product integrates Confluence with Microsoft SharePoint.

### Confluence SharePoint Connector 1.3
Documentation for the Confluence SharePoint Connector 1.3. This product integrates Confluence with Microsoft SharePoint.

### Confluence SharePoint Connector 1.4
Documentation for the Confluence SharePoint Connector 1.4. This product integrates Confluence with Microsoft SharePoint.

### Confluence SharePoint Connector 1.5
Documentation for the Confluence SharePoint Connector 1.4. This product integrates Confluence with Microsoft SharePoint.

### Confluence SharePoint Connector 1.5
Documentation for the Confluence SharePoint Connector 1.4. This product integrates Confluence with Microsoft SharePoint.

### Confluence User Community
This space is for discussing ideas, new features and suggestions for Confluence.

### Crowd 1.0
Documentation for Crowd version 1.0.x

### Crowd 1.1
Documentation for Crowd version 1.1.x

### Crowd 1.2
Documentation for Crowd version 1.2.x

### Crowd 1.3
Documentation for Crowd version 1.3.x

### Crowd 1.4
Documentation for Crowd version 1.4.x

### Crowd 1.5
Documentation for Crowd version 1.5.x

### Crowd 1.6
Documentation for Crowd version 1.6.x

### Crowd 2.0
Documentation for Crowd version 2.0.x

### Crowd 2.1
Documentation for Crowd version 2.1.x

### Crowd 2.2
Documentation for Crowd version 2.2.x

### Crowd 2.3
<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crowd 2.4</td>
<td>Documentation for Crowd version 2.4.x</td>
</tr>
<tr>
<td>Crowd 2.5</td>
<td>Documentation for the latest version of Crowd single signon and identity management</td>
</tr>
<tr>
<td>Crowd Extension</td>
<td></td>
</tr>
<tr>
<td>Crowd Knowledge Base</td>
<td>Troubleshooting and support tips for Crowd</td>
</tr>
<tr>
<td>Crucible 1.1</td>
<td>Documentation for Crucible 1.1</td>
</tr>
<tr>
<td>Crucible 1.2</td>
<td>Documentation for Crucible 1.2</td>
</tr>
<tr>
<td>Crucible 1.5</td>
<td>Documentation for Crucible 1.5</td>
</tr>
<tr>
<td>Crucible 1.6</td>
<td>Documentation for Crucible 1.6</td>
</tr>
<tr>
<td>Crucible 2.0</td>
<td>Documentation for Crucible 2.0</td>
</tr>
<tr>
<td>Crucible 2.1</td>
<td>Documentation for Crucible 2.1</td>
</tr>
<tr>
<td>Crucible 2.2</td>
<td>Documentation for Crucible 2.2</td>
</tr>
<tr>
<td>Crucible 2.3</td>
<td>Documentation for Crucible 2.3</td>
</tr>
<tr>
<td>Crucible 2.4</td>
<td>Documentation for Crucible 2.4</td>
</tr>
<tr>
<td>Crucible 2.5</td>
<td>Documentation for Crucible 2.5</td>
</tr>
<tr>
<td>Crucible 2.6</td>
<td>Documentation for Crucible 2.6</td>
</tr>
<tr>
<td>Crucible 2.7</td>
<td>Documentation for Crucible 2.7</td>
</tr>
<tr>
<td>Crucible 2.8</td>
<td>Latest documentation for Crucible 2.8</td>
</tr>
<tr>
<td>Crucible Knowledge Base</td>
<td>Troubleshooting and support tips for Crucible</td>
</tr>
<tr>
<td>Demonstration Space</td>
<td>A space which demonstrates Confluence functionality.</td>
</tr>
<tr>
<td>Doc Sprint</td>
<td></td>
</tr>
<tr>
<td>Enterprise Hosting</td>
<td></td>
</tr>
</tbody>
</table>
Documentation and resources for Enterprise Hosted versions of Confluence and JIRA

**Evaluator Resources**

**FishEye & Crucible Knowledge Base**
Troubleshooting and support tips for FishEye & Crucible

<table>
<thead>
<tr>
<th>Version</th>
<th>Documentation for FishEye</th>
</tr>
</thead>
<tbody>
<tr>
<td>FishEye 1.3</td>
<td></td>
</tr>
<tr>
<td>FishEye 1.4</td>
<td></td>
</tr>
<tr>
<td>FishEye 1.5</td>
<td></td>
</tr>
<tr>
<td>FishEye 1.6</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.0</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.1</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.2</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.3</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.4</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.5</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.6</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.7</td>
<td></td>
</tr>
<tr>
<td>FishEye 2.8</td>
<td>Latest documentation for FishEye</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version</th>
<th>Documentation for Gadgets and Dashboards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gadgets and Dashboards 1.0</td>
<td>Documentation for version 1.0.x of Atlassian Gadgets and Dashboards</td>
</tr>
<tr>
<td>Gadgets and Dashboards 2.0</td>
<td>Documentation for version 2.0.x of Atlassian Gadgets and Dashboards</td>
</tr>
<tr>
<td>Gadgets and Dashboards 3.0</td>
<td>Documentation for the latest version of Atlassian Gadgets and Dashboards</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Version</th>
<th>Documentation for GreenHopper</th>
</tr>
</thead>
<tbody>
<tr>
<td>GreenHopper 3.8</td>
<td>Documentation archive for GreenHopper 3.8</td>
</tr>
<tr>
<td>GreenHopper 4.0</td>
<td>Documentation for GreenHopper 4.0</td>
</tr>
<tr>
<td>GreenHopper</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td></td>
</tr>
<tr>
<td><strong>4.1</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 4.1</td>
<td></td>
</tr>
<tr>
<td><strong>4.2</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 4.2</td>
<td></td>
</tr>
<tr>
<td><strong>4.3</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 4.3</td>
<td></td>
</tr>
<tr>
<td><strong>4.4</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 4.4</td>
<td></td>
</tr>
<tr>
<td><strong>5.0</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.0</td>
<td></td>
</tr>
<tr>
<td><strong>5.1</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.1</td>
<td></td>
</tr>
<tr>
<td><strong>5.10</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.10</td>
<td></td>
</tr>
<tr>
<td><strong>5.2</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.2</td>
<td></td>
</tr>
<tr>
<td><strong>5.3</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.3</td>
<td></td>
</tr>
<tr>
<td><strong>5.4</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.4</td>
<td></td>
</tr>
<tr>
<td><strong>5.5</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.5</td>
<td></td>
</tr>
<tr>
<td><strong>5.6</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.6</td>
<td></td>
</tr>
<tr>
<td><strong>5.7</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.7</td>
<td></td>
</tr>
<tr>
<td><strong>5.8</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.8</td>
<td></td>
</tr>
<tr>
<td><strong>5.9</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.9</td>
<td></td>
</tr>
<tr>
<td><strong>6.0</strong></td>
<td></td>
</tr>
<tr>
<td>Documentation for GreenHopper 6.0</td>
<td></td>
</tr>
</tbody>
</table>

**GreenHopper Knowledge Base**

**Integrating with JIRA**
Documentation for the latest version of the JIRA integration interface

**JIRA 4.0**
Documentation for JIRA 4.0

**JIRA 4.1**
Documentation for JIRA 4.1

**JIRA 4.2**
Documentation for JIRA 4.2
<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA 4.3</td>
<td>Documentation for JIRA 4.3</td>
</tr>
<tr>
<td>JIRA 4.4</td>
<td>Documentation for JIRA 4.4</td>
</tr>
<tr>
<td>JIRA 5.0</td>
<td>Documentation for JIRA 5.0</td>
</tr>
<tr>
<td>JIRA 5.1</td>
<td>Documentation for JIRA 5.1</td>
</tr>
<tr>
<td>JIRA Community Space</td>
<td></td>
</tr>
<tr>
<td>JIRA Download Evaluator Resources</td>
<td></td>
</tr>
<tr>
<td>JIRA Extensions</td>
<td></td>
</tr>
<tr>
<td>JIRA Hosted Evaluator Resources</td>
<td></td>
</tr>
<tr>
<td>JIRA Knowledge Base</td>
<td>Troubleshooting and support tips for Jira</td>
</tr>
<tr>
<td>JIRA Latest</td>
<td>Documentation for JIRA OnDemand and JIRA Early Access Program only</td>
</tr>
<tr>
<td>JIRA Studio</td>
<td>Documentation for the current version of JIRA Studio.</td>
</tr>
<tr>
<td>JIRA Studio Evaluator Resources</td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>Security documentation starting point</td>
</tr>
<tr>
<td>SMIG</td>
<td></td>
</tr>
<tr>
<td>SourceTree Knowledge Base</td>
<td></td>
</tr>
<tr>
<td>Stash 1.0</td>
<td>Documentation for Stash 1.0</td>
</tr>
<tr>
<td>Stash 1.1</td>
<td>Documentation for Stash 1.1</td>
</tr>
<tr>
<td>Stash 1.2</td>
<td>Documentation for the latest version of Stash</td>
</tr>
<tr>
<td>Stash Knowledge Base</td>
<td></td>
</tr>
<tr>
<td>Summit 2011 Speaker Guidelines</td>
<td></td>
</tr>
<tr>
<td>Summit 2012 Sponsorship</td>
<td>Learn about becoming a sponsor for Atlassian Summit 2012</td>
</tr>
<tr>
<td>Support</td>
<td>Atlassian's legendary support team's projects and policy.</td>
</tr>
<tr>
<td>Team Calendars</td>
<td>Documentation for Team Calendars for Confluence, where people, projects and content meet.</td>
</tr>
<tr>
<td>Test space</td>
<td></td>
</tr>
</tbody>
</table>
The Confluence Test Space
This is a space dedicated to testing and playing around with Confluence features. Everyone is invited to experiment.

Universal Plugin Manager 1.0
Documentation for the Universal Plugin Manager 1.0

Universal Plugin Manager 1.2
Documentation for the Universal Plugin Manager 1.2

Universal Plugin Manager 1.3
Documentation for the Universal Plugin Manager 1.3

Universal Plugin Manager 1.4
Documentation for the Universal Plugin Manager 1.4

Universal Plugin Manager 1.5
Documentation for the Universal Plugin Manager 1.5

Universal Plugin Manager 1.6
Documentation for the latest version of the Universal Plugin Manager

Universal Plugin Manager 2.0 archive
Documentation for the Universal Plugin Manager 2.0

Universal Plugin Manager 2.X
Documentation for the latest version of the Universal Plugin Manager

Universities

User Group Sponsorship

Spaces: All Favourite Category New (2)

Application Links 1.x
Documentation for AppLinks version 1.x

Application Links 2.0
Documentation for AppLinks 2.0

Application Links 2.1
Documentation for AppLinks 2.1

Application Links 3.0
Documentation for AppLinks 3.0

Application Links 3.2
Documentation for AppLinks 3.2

Application Links 3.3
Documentation for AppLinks 3.3

Application Links 3.4
Documentation for AppLinks 3.4

Application Links 3.5
Documentation for the latest version of AppLinks.
<table>
<thead>
<tr>
<th>Application Links 3.5 Archive</th>
<th>Documentation for AppLinks 3.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>AtlasCamp 2010</td>
<td></td>
</tr>
<tr>
<td>AtlasCamp 2012</td>
<td></td>
</tr>
<tr>
<td>Atlassian Bonfire</td>
<td>Documentation for the latest version of Bonfire</td>
</tr>
<tr>
<td>Atlassian Customer Resources</td>
<td></td>
</tr>
<tr>
<td>Atlassian Development</td>
<td>Atlassian Developers. Because they're just too good to be kept hidden in an office in Sydney.</td>
</tr>
<tr>
<td>Atlassian Documentation</td>
<td>Information about and links to the Atlassian product documentation, including downloadable documentation</td>
</tr>
<tr>
<td>Atlassian Events</td>
<td></td>
</tr>
<tr>
<td>Atlassian Guides</td>
<td>Guides to make your Atlassian applications work better and work together</td>
</tr>
<tr>
<td>Atlassian IDE Connectors</td>
<td>Documentation for the Atlassian Connectors for Eclipse and IntelliJ IDEA</td>
</tr>
<tr>
<td>Atlassian KnowledgeBase</td>
<td></td>
</tr>
<tr>
<td>Atlassian OnDemand</td>
<td>The current documentation for Atlassian OnDemand</td>
</tr>
<tr>
<td>Atlassian OnDemand Knowledge Base</td>
<td></td>
</tr>
<tr>
<td>Atlassian OnDemand Test Space</td>
<td>Documentation for the current version of JIRA Studio.</td>
</tr>
<tr>
<td>Atlassian Partner Wiki</td>
<td></td>
</tr>
<tr>
<td>Atlassian Presentations</td>
<td></td>
</tr>
<tr>
<td>Atlassian Training</td>
<td></td>
</tr>
<tr>
<td>Atlassian Translations</td>
<td></td>
</tr>
<tr>
<td>Atlassian t-shirt Competition</td>
<td></td>
</tr>
<tr>
<td>Atlassian University</td>
<td></td>
</tr>
<tr>
<td>Atlassian User Group</td>
<td></td>
</tr>
<tr>
<td>Atlassian User Management 1.0</td>
<td>Documentation for version 1.0 of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
<tr>
<td>Atlassian User Management 2.0</td>
<td>Documentation for version 2.0 of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
<tr>
<td>Atlassian User Management 3.0</td>
<td>Documentation for the latest version of the Atlassian user management interface, as used in Confluence and JIRA.</td>
</tr>
</tbody>
</table>
Atlassian Webinars

Bamboo 1.0
Documentation for Bamboo 1.0

Bamboo 1.1
Documentation for Bamboo 1.1

Bamboo 1.2
Documentation for Bamboo 1.2

Bamboo 2.0
Documentation for Bamboo 2.0

Bamboo 2.1
Documentation for Bamboo 2.1

Bamboo 2.2
Documentation for Bamboo 2.2

Bamboo 2.3
Documentation for Bamboo 2.3

Bamboo 2.4
Documentation for Bamboo 2.4

Bamboo 2.5
Documentation for Bamboo 2.5

Bamboo 2.6
Documentation for Bamboo 2.6

Bamboo 2.7
Documentation for Bamboo 2.7

Bamboo 2.7 Archive Backup
Archived Documentation for Bamboo 2.7 (supersedes BAMBOO027 space)

Bamboo 3.0
Documentation for Bamboo 3.0

Bamboo 3.1
Documentation for Bamboo 3.1

Bamboo 3.2
Documentation for Bamboo 3.2

Bamboo 3.3
Documentation for Bamboo 3.3

Bamboo 3.4
Documentation for Bamboo 3.4

Bamboo 4.0
Documentation for Bamboo 4.0

Bamboo 4.1
Documentation for Bamboo 4.1

Bamboo 4.2
Documentation for the latest version of Bamboo

**Bamboo Extensions**

**Bamboo Knowledge Base**
Troubleshooting and support tips for Bamboo

**bitbucket**
Documentation for Atlassian bitbucket

**Bitbucket Knowledge Base**
Troubleshooting and support tips for Bitbucket

**Bonfire Knowledge Base**

**Clover 2.0**
Documentation for Clover 2.0

**Clover 2.1**
Documentation for Clover 2.1

**Clover 2.3**
Documentation for Clover 2.3

**Clover 2.4**
Documentation for Clover 2.4

**Clover 2.5**
Documentation for Clover 2.5

**Clover 2.6**
Documentation for Clover 2.6

**Clover 3.0**
Documentation for Clover 3.0

**Clover 3.1**
Documentation for the latest version of Clover

**Clover Knowledge Base**
Troubleshooting and support tips for Clover

**Confluence 1.4 User Guide**
User Guide for Confluence 1.4

**Confluence 2.0**
User Guide for Confluence version 2

**Confluence 2.10**
Complete documentation for Confluence version 2.10

**Confluence 2.5**
Complete documentation for Confluence versions 2.0 to 2.5.3.

**Confluence 2.5.6**
Complete documentation for Confluence versions 2.5.4 to 2.5.8.

**Confluence 2.6**
Complete documentation for Confluence version 2.6

**Confluence 2.7**
Complete documentation for Confluence version 2.7

Confluence 2.8
Complete documentation for Confluence version 2.8

Confluence 2.9
Complete documentation for Confluence version 2.9

Confluence 3.0
Complete documentation for Confluence version 3.0

Confluence 3.1
Complete documentation for Confluence version 3.1

Confluence 3.2
Complete documentation for Confluence version 3.2

Confluence 3.3
Complete documentation for Confluence version 3.3

Confluence 3.4
Complete documentation for Confluence version 3.4

Confluence 3.5
Complete documentation for Confluence version 3.5

Confluence 4.0
Complete documentation for Confluence version 4.0

Confluence 4.1
Complete documentation for Confluence version 4.1

Confluence 4.2
Complete documentation for Confluence version 4.2

Confluence 4.3
Complete documentation for Confluence version 4.3

Confluence Extensions

Confluence Homepage Image

Confluence Knowledge Base
Troubleshooting and support tips for Confluence

Confluence Latest

Confluence SharePoint Connector 1.0
Documentation for version 1.0.x of the Confluence SharePoint Connector.

Confluence SharePoint Connector 1.1
Documentation for version 1.1.x of the Confluence SharePoint Connector.

Confluence SharePoint Connector 1.2
Documentation for the Confluence SharePoint Connector 1.2. This product integrates Confluence with Microsoft SharePoint.

Confluence SharePoint Connector 1.3
Documentation for the Confluence SharePoint Connector 1.3. This product integrates
<table>
<thead>
<tr>
<th>Confluence 4.3 Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence with Microsoft SharePoint.</td>
</tr>
<tr>
<td><strong>Confluence SharePoint Connector 1.4</strong></td>
</tr>
<tr>
<td>Documentation for the Confluence SharePoint Connector 1.4. This product integrates Confluence with Microsoft SharePoint.</td>
</tr>
<tr>
<td><strong>Confluence SharePoint Connector 1.5</strong></td>
</tr>
<tr>
<td>Documentation for the Confluence SharePoint Connector 1.4. This product integrates Confluence with Microsoft SharePoint.</td>
</tr>
<tr>
<td><strong>Confluence User Community</strong></td>
</tr>
<tr>
<td>This space is for discussing ideas, new features and suggestions for Confluence.</td>
</tr>
<tr>
<td><strong>Crowd 1.0</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.0.x</td>
</tr>
<tr>
<td><strong>Crowd 1.1</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.1.x</td>
</tr>
<tr>
<td><strong>Crowd 1.2</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.2.x</td>
</tr>
<tr>
<td><strong>Crowd 1.3</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.3.x</td>
</tr>
<tr>
<td><strong>Crowd 1.4</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.4.x</td>
</tr>
<tr>
<td><strong>Crowd 1.5</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.5.x</td>
</tr>
<tr>
<td><strong>Crowd 1.6</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 1.6.x</td>
</tr>
<tr>
<td><strong>Crowd 2.0</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 2.0.x</td>
</tr>
<tr>
<td><strong>Crowd 2.1</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 2.1.x</td>
</tr>
<tr>
<td><strong>Crowd 2.2</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 2.2.x</td>
</tr>
<tr>
<td><strong>Crowd 2.3</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 2.3.x</td>
</tr>
<tr>
<td><strong>Crowd 2.4</strong></td>
</tr>
<tr>
<td>Documentation for Crowd version 2.4.x</td>
</tr>
<tr>
<td><strong>Crowd 2.5</strong></td>
</tr>
<tr>
<td>Documentation for the latest version of Crowd single signon and identity management</td>
</tr>
<tr>
<td><strong>Crowd Extension</strong></td>
</tr>
<tr>
<td><strong>Crowd Knowledge Base</strong></td>
</tr>
<tr>
<td>Troubleshooting and support tips for Crowd</td>
</tr>
<tr>
<td>Version</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td><strong>Crucible 1.1</strong></td>
</tr>
<tr>
<td><strong>Crucible 1.2</strong></td>
</tr>
<tr>
<td><strong>Crucible 1.5</strong></td>
</tr>
<tr>
<td><strong>Crucible 1.6</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.0</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.1</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.2</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.3</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.4</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.5</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.6</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.7</strong></td>
</tr>
<tr>
<td><strong>Crucible 2.8</strong></td>
</tr>
<tr>
<td><strong>Crucible Knowledge Base</strong></td>
</tr>
<tr>
<td><strong>Demonstration Space</strong></td>
</tr>
<tr>
<td><strong>Doc Sprint</strong></td>
</tr>
<tr>
<td><strong>Enterprise Hosting</strong></td>
</tr>
<tr>
<td><strong>Evaluator Resources</strong></td>
</tr>
<tr>
<td><strong>FishEye &amp; Crucible Knowledge Base</strong></td>
</tr>
<tr>
<td><strong>FishEye 1.3</strong></td>
</tr>
<tr>
<td><strong>FishEye 1.4</strong></td>
</tr>
<tr>
<td>Application</td>
</tr>
<tr>
<td>----------------------</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>FishEye</td>
</tr>
<tr>
<td>Gadgets and Dashboards</td>
</tr>
<tr>
<td>Gadgets and Dashboards</td>
</tr>
<tr>
<td>Gadgets and Dashboards</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>GreenHopper</td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.0</td>
</tr>
<tr>
<td>-----------------------------------</td>
</tr>
<tr>
<td><strong>GreenHopper 5.1</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.1</td>
</tr>
<tr>
<td><strong>GreenHopper 5.10</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.10</td>
</tr>
<tr>
<td><strong>GreenHopper 5.2</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.2</td>
</tr>
<tr>
<td><strong>GreenHopper 5.3</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.3</td>
</tr>
<tr>
<td><strong>GreenHopper 5.4</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.4</td>
</tr>
<tr>
<td><strong>GreenHopper 5.5</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.5</td>
</tr>
<tr>
<td><strong>GreenHopper 5.6</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.6</td>
</tr>
<tr>
<td><strong>GreenHopper 5.7</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.7</td>
</tr>
<tr>
<td><strong>GreenHopper 5.8</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.8</td>
</tr>
<tr>
<td><strong>GreenHopper 5.9</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 5.9</td>
</tr>
<tr>
<td><strong>GreenHopper 6.0</strong></td>
</tr>
<tr>
<td>Documentation for GreenHopper 6.0</td>
</tr>
<tr>
<td><strong>GreenHopper Knowledge Base</strong></td>
</tr>
<tr>
<td><strong>Integrating with JIRA</strong></td>
</tr>
<tr>
<td>Documentation for the latest version of the JIRA integration interface</td>
</tr>
<tr>
<td><strong>JIRA 4.0</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 4.0</td>
</tr>
<tr>
<td><strong>JIRA 4.1</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 4.1</td>
</tr>
<tr>
<td><strong>JIRA 4.2</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 4.2</td>
</tr>
<tr>
<td><strong>JIRA 4.3</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 4.3</td>
</tr>
<tr>
<td><strong>JIRA 4.4</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 4.4</td>
</tr>
<tr>
<td><strong>JIRA 5.0</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 5.0</td>
</tr>
<tr>
<td><strong>JIRA 5.1</strong></td>
</tr>
<tr>
<td>Documentation for JIRA 5.1</td>
</tr>
</tbody>
</table>
JIRA Community Space

JIRA Download Evaluator Resources

JIRA Extensions

JIRA Hosted Evaluator Resources

JIRA Knowledge Base
Troubleshooting and support tips for Jira

JIRA Latest
Documentation for JIRA OnDemand and JIRA Early Access Program only

JIRA Studio
Documentation for the current version of JIRA Studio.

JIRA Studio Evaluator Resources

Security
Security documentation starting point

SMIG

SourceTree Knowledge Base

Stash 1.0
Documentation for Stash 1.0

Stash 1.1
Documentation for Stash 1.1

Stash 1.2
Documentation for the latest version of Stash

Stash Knowledge Base

Summit 2011 Speaker Guidelines

Summit 2012 Sponsorship
Learn about becoming a sponsor for Atlassian Summit 2012

Support
Atlassian's legendary support team's projects and policy.

Team Calendars
Documentation for Team Calendars for Confluence, where people, projects and content meet.

Test space

The Confluence Test Space
This is a space dedicated to testing and playing around with Confluence features. Everyone is invited to experiment.

Universal Plugin Manager 1.0
Documentation for the Universal Plugin Manager 1.0

Universal Plugin Manager 1.2
Documentation for the Universal Plugin Manager 1.2

Universal Plugin Manager 1.3
Known Bugs

There is a known bug that occurs whenever you enable or disable a plugin in Confluence 1.4-DR2. The error will appear to be 'null', but the following will appear in the logfiles:

```
[ERROR] Tue Jan 04 18:01:20 CST 2005
[com.atlassian.core.util.DateUtils]
java.util.MissingResourceException: Can't find resource for bundle
java.util.PropertyResourceBundle, key core.dateutils.minutes
```

This is issue CONF-2513 and will be fixed in the next DR.

Release Notes 1.4-DR1

Confluence 1.4-DR1 is the first development release in the cycle leading up to Confluence 1.4. On the surface, we have implemented one of Confluence's most requested features. Under the hood, there's a whole new event system to play with.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.3 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.2.3 or earlier, be sure to read the upgrade instructions in the Confluence 1.3 release notes.

Downloads
All development releases are available from Development Releases on the Atlassian website.

New Features in Confluence 1.4-DR1

Consult JIRA for the full list of issues resolved for 1.4-DR1 (Note, this list doesn't include all the 1.3.1 fixes that were also merged into the development release)

Move Page Hierarchy

When you move a page between spaces, you now have the option to include all children of that page in the move. With 13 votes, this was one of Confluence's most requested features.

(Note, as of DR1, you can not both move a hierarchy of pages and rename the root page at the same time. This bug is filed as CONF-2452)

Attach Multiple Files

Another commonly requested feature, you can now attach multiple files to a page at once. By default, you can attach a maximum of five at a time, but this maximum is configurable.

GZip Content Encoding

Pages are served with GZip content encoding, which means less bandwidth consumption and faster page downloads.

Events and Listeners

We have implemented the beginnings of a pervasive system of events within Confluence.

By the final release of 1.4, all major actions within Confluence will trigger an event. These events can be listened for, and reacted to by a new plugin module type: "listener". This will allow Confluence to be further customised, as extensions can react to anything that happens within the system.

Creating an event listener plugin is insanely easy. Step one, implement this interface:
package com.atlassian.confluence.event;

import com.atlassian.confluence.event.events.ConfluenceEvent;

/**
 * Defines a listener for Confluence events.
 */
public interface EventListener {
    /**
     * Perform some action as a response to a Confluence event. The EventManager will
     * ensure that this is only called if the class of the event matches one of the
     * classes returned by getHandledEventClasses
     * @param event some event triggered within Confluence
     */
    void handleEvent(ConfluenceEvent event);

    /**
     * Determine which event classes this listener is interested in.
     * The EventManager performs rudimentary filtering of events by their class.
     * If you want to receive only a subset of events passing through the system,
     * return an array of the Classes you wish to listen for from this method.
     * For the sake of efficiency, only exact class matches are performed.
     * Sub/superclassing is not taken into account.
     * Returning an empty array will allow you to receive every event.
     * @return An array of the event classes that this event listener is
     * interested in, or an empty array if the listener should receive all events. Must
     * not return null.
     */
    Class[] getHandledEventClasses();
}

Step two: Package it as a plugin module with a descriptor like this:

```xml
<listener name="My Listener" key="mylistener"
    class="com.example.listeners.MyListener">
    <description>Listens for stuff.</description>
</listener>
```

And that's about it. We'll be adding information about the events that are being produced in Confluence over the next couple of days (We would have had them documented today, but Nick, who wrote most of them, was sick).
All bugs that were fixed in Confluence 1.3.1 are also fixed in Confluence 1.4-DR1.

Release Notes 1.3-final

Confluence 1.3-final is the stable release of Confluence 1.3. Woohoo! We made it! The full release-notes for Confluence 1.3 are located here, this page documents only the changes made since the 1.3-DR4 development release.

1.3-final contains over 100 improvements over 1.3-DR4, mostly focused around fixing bugs, polishing the interface, and making Confluence ready for a stable release.

Who should upgrade?

Confluence 1.3 is the new stable release of Confluence. It contains a huge raft of enhancements and fixes made since 1.2.3. If you are running Confluence (and not using Oracle, see below), you should upgrade to Confluence 1.3. If you are not running Confluence, you should install 1.3 immediately, regardless of your database.

Current users of Confluence on Oracle databases users may wish to delay upgrading.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

Note: You will need to rebuild the search index after you upgrade for certain features (including mail threading) to work properly.

New Features in Confluence 1.3-final

New Demonstration Content

As part of the DR4 setup improvements, users were given the option to install an example space, but the demonstration content that was loaded was pretty uninspiring. For the final release, the demonstration space now contains a suite of demonstration pages, examples of what Confluence can do, and a few pictures of the Sydney Opera House. This should make it much easier to get Confluence up and running quickly.

Referrer Performance Improvement

We discovered (from monitoring the http://confluence.atlassian.com site) that our recording of HTTP referrers was causing some serious performance problems for public Confluence sites. Upgrading to Confluence 1.3-final should make Confluence a lot more responsive, especially under heavy load.

Improved Notation Guide

The notation guide has been reorganised to be more user-focused, making it easier to find the markup or macro you are looking for.

It is also now possible for macro plugins to insert themselves into the notation guide. Just write your macro description as a two-column HTML table row, put it in a vm file, and include the following in your atlassian-plugin.xml file:

```xml
<resource type="velocity" name="help" location="/path/to/your/helpfile.vm">
  <param name="help-section" value="tables"/>
</resource>
```
The help section can be one of: texteffects, headings, breaks, links, lists, images, tables, advanced, confluence, external or miscellaneous. If you don't include a help section, it will be put in the 'macros' section.

**Improved Search Indexing**

We've updated the way we index content within Confluence. A lot of searches that came up empty before will now find something. In addition, you can now set your primary language for indexing under General Configuration, so that the indexer can better optimise itself for non-English content.

**Also**

- By popular demand (it was our most highly voted-for bug), pages are now exported in alphabetical order, not in order of creation.
- The Remote API can be accessed anonymously, if you wish (anonymous remote access must be turned on in the general configuration).
- When previewing a page, you can continue to edit on that screen, instead of having to go back to the edit page.
- The thread view on a mail page has been improved, and the full-thread view is no longer a pop-up.
- You no longer need to be in the confluence-admin group to access the administration pages, you just need global administrative privileges.
- You can link to anything in Confluence if you know its ID in the database (currently this is how you must link to email): [$1234]
- You can link to anything relative to the root of the Confluence site (useful for pointing to parts of the site that can't otherwise be linked): [///pages/editpage.action?pageId=1234]
- New macros: {jiraportlet}, {note} {tip}, {information} and {warning}
- A lot more...

**Issues Resolved for 1.3-final**

In all, over 130 issues were resolved between DR4 and 1.3-final. Unfortunately, merging all the versions together in JIRA means the list of precisely what went into those 130 has been lost, but if you sort this list by last-modification date, you'll get some idea... [Issues Resolved for 1.3]

**Release Notes 1.3-DR4**

Confluence 1.3-DR4 is the fourth development release in the cycle leading up to Confluence 1.3. We're on the home stretch! The final, stable 1.3 isn't far away.

Confluence 1.3-DR4 includes a raft of improvements to mail archiving, a redesigned setup wizard, significant improvements to the way we back up and restore your system configuration, and a truck-load of bug fixes.

**Who should upgrade?**

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

**Upgrade Procedure**

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find [instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!](http://confluencelassian.com)

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the [Confluence 1.2 release notes](http://confluencelassian.com).

**Note:** You will need to rebuild the search index after you upgrade for certain features (including mail threading)
to work properly.

New Features in Confluence 1.3-DR4

Setup Improvements

Confluence's setup wizard was badly in need of an overhaul, so that's exactly what we've done. Among the improvements, we have:

- Improved the ordering of steps. For example, if you are importing straight from a backup, you no longer need a redundant administrative user.
- Added a quick, two-step setup process to get Confluence running straight away
- Made the database setup much more robust, and much better at reporting errors
- Removed those steps that weren't really necessary to get Confluence running

Hopefully this will make it a lot easier to get Confluence up and running, or show off Confluence to your friends and family.

Mail Archive Improvements

(CONF-2050)

We've been working hard to build on the basic mail-archiving features included in 1.3-DR3. Included in the new version are:

- Improved indexing of mail senders, message-ids and subjects
- Improved integration of mail with search
- The ability to delete mail (if you have been assigned the delete mail permission)
- Direct access to mail archives from the dashboard
- Display of mail attachments in the "view mail" page
- The ability to link to a single message by its internal Confluence ID ( [$1234] will link to message 1234)
- The ability to navigate forward and back through mails chronologically
- Email addresses are displayed or masked in accordance with your global preferences

We still have a few things to do (date based views, a calendar), but the mail archive is now very useable. Especially when you take into account...

Mail Threading

(CONF-2059)

Of course, it's important for your mail archive to be able to represent conversation threads. How you present thre ads, though, is just as important.

Here's how most mail-based web archives present your thread at the bottom of each message:

```
Follow-Ups:
  RE: DateModified
    From: Bob Wyman

References:
  RE: DateModified
    From: Tim Bray
```

Not very helpful, is it. Here's how that same bottom-of-the-message view looks in Confluence:
At a glance, you can see exactly where the message sits in a conversation.

Backup Improvements

(CONF-1090 and CONF-2046)

Confluence 1.3-DR4 contains two significant improvements to backing up and restoring the system.

- You can now exclude attached files from your backups. Of course, this means you have to back up your attachment directory separately, but if you already have a good backup regime for your filesystem (and can thus restore the attached files separately), it means that your Confluence data backups will take up far less room.
- We now include important parts system configuration in your backups. This means that colour-schemes and plugin preferences are now saved, and fixes a large number of issues that users have filed due to the restore process not bringing the system back up in the same state as when they saved it.

Library Upgrades

We have continued the process of upgrading to the most recent stable versions of those libraries Confluence is built on, which should result in improved stability and performance.

Bugs fixed for 1.3-DR4

We've also fixed a lot of bugs, as we ramp up for the stable 1.3 release. Take a look in JIRA for the full list.

Release Notes 1.3-DR3

Confluence 1.3-DR3 is the third development release in the cycle leading up to Confluence 1.3 - and a momentous day in the history of Confluence.

We've finally made it to that special point in every applications life.

Confluence has evolved.

1.3-DR3 is best summed up by Jamie Zawinski's Law of Software Envelopment:

Every program attempts to expand until it can read mail. Those programs which cannot so expand are replaced by ones which can.
That's right - Confluence now has more content than ever before. It reads, stores and indexes email. Oh, and as a nifty little bonus - it also indexes Word documents, PDF documents, RTF documents, Excel spreadsheets, PowerPoint files, text files, source files etc... attached to your mail!

Have we got your interest? How does all this magic happen you ask? Read on to pull back the curtain.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

Note: Because we have made significant changes to permissions in 1.3-DR2, you should check that your user permissions have been correctly migrated. The upgrade manager should ensure permissions remain consistent between versions, but as with anything related to security, it’s best to double-check.

New Features in Confluence 1.3-DR2

Mail Archiving

(CONF-1965)

Confluence is a collaboration tool. When communication happens through email instead of through Confluence, information will get lost in the depths of someone's mail folders, instead of shared with the team, archived, interlinked and indexed.

While we would love to see all collaboration within a group to happen through Confluence, it's often not possible to change the way people work. So instead of finding new ways to force people to use Confluence instead of email, why not route all the relevant email into Confluence?

It is now possible to archive email within a Confluence space. The support for mail is only just getting started in DR3, but we believe this is an incredibly useful direction for Confluence to go, and will be expanding and improving the mail integration in future releases.
Confluence spaces can retrieve mail periodically from a POP mailbox (this will delete all mail from that POP account, so don't try it on an account you want to keep mail on), or space administrators can import mail directly from a standard mbox-format mail file.

Once mail is imported into Confluence, it can be browsed chronologically from the Content pane of the Space Summary page, and can be searched through Confluence's search interface.

In the future, we will be adding new ways to link to and between email (bringing the email closer to the other content of the wiki), proper representation of email threads, more flexible search, and much, much more.

Read the Mail Archiving FAQ for more information

Want to play with it now?

We love to play with features right now, so here's how you can:

- Testing mail search is a snap.
- Testing mailing content into Confluence is also easy. It will also be indexed.

Improved Indexing Performance

We now make much more efficient use of resources by batching updates to full-text search index. This should lead to improved performance for many tasks within Confluence, but will mean that it may take up to a minute for a change in the site to be reflected in the site's index. (CONF-2029)

In addition, we have made a number of improvements to the indexing of large PDFs, including fixing some cases where a PDF might cause indexing to freeze indefinitely. (CONF-1953, CONF=1954)

Library Upgrades

Many of the libraries Confluence is dependent on have been upgraded for this release, which should result in improved stability and performance.

Bugs fixed for 1.3-DR3

We've fixed a handful of issues specifically for 1.3-DR3, take a look in JIRA for the full list.

Release Notes 1.3-DR2

Confluence 1.3-DR2 is the second development release in the cycle leading up to Confluence 1.3. For DR2, we have made space-level permissions a lot more fine-grained, and added a new plugin manager which should open the way to making it easier for people to write extensions to Confluence:

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

Note: Because we have made significant changes to permissions in 1.3-DR2, you should check that your user
permissions have been correctly migrated. The upgrade manager should ensure permissions remain consistent between versions, but as with anything related to security, it’s best to double-check.

New Features in Confluence 1.3-DR2

New Space-Level Permissions

(CONF-1375, CONF-1764 and their linked issues)

We've been getting a lot of requests for more fine-grained control over who can do what in a space, so as a result, we've added a whole raft of new permissions at the space level:

<table>
<thead>
<tr>
<th>Object</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>create/edit, remove, export</td>
</tr>
<tr>
<td>Blog Post</td>
<td>create/edit, remove</td>
</tr>
<tr>
<td>Comment</td>
<td>create, remove</td>
</tr>
<tr>
<td>Attachment</td>
<td>create, remove</td>
</tr>
<tr>
<td>Space</td>
<td>export, administer</td>
</tr>
</tbody>
</table>

Create space permission is still managed at the global level.

The permissions editing screens have been changed a little, too, taking into consideration the feedback we received from the last DR. All editing functions are now firmly on the edit screen, and we have introduced a user-picker to avoid having to find users in a massive drop-down list.

New Plugin Architecture

(CONF-1877)

Confluence now incorporates the plugin architecture that was written for JIRA 3.0 (which in turn was adapted from Confluence's macro management. Who said code reuse was dead?). Right now, there’s not much you can do with it, but plugins pave the way to making Confluence a great deal more flexible and extensible.

See: Writing Confluence Plugins

New Macro Descriptor Format

(CONF-1878)

Macro libraries are now implemented as plugins, which means that if you have written a macro library, you will need to convert your macro-library.xml files to atlassian-plugin.xml files.
Themes

(CONF-1856)

It is now possible to package a colour-scheme and a set of customised decorators into a portable Confluence plugin. Just drop the theme jar into your server's classpath, restart the server and space administrators will be able to select the theme from the space administration console.

DR-2 comes with two very simple themes (look under themes/ in your Confluence directory), but we will have more (and more useful) themes available by the time 1.3.0 is released. In addition, we're hoping that users will continue to share their Confluence modifications in the Confluence Extensions Space, and that themes will help you continue to share neat things you've done with Confluence.

Bugs fixed for 1.3-DR2

All the bug-fixes that were part of the Confluence 1.2.3 release have also been incorporated into 1.3-DR2. In addition, we've fixed a handful of issues specifically for 1.3-DR2, take a look in JIRA for the full list.

Release Notes 1.3-DR1

Confluence 1.3-DR1 is the first development release in the cycle leading up to Confluence 1.3. In it, we have rewritten the Space Summary/Space Administration pages to be more useable, adn implemented a much-requested feature: the ability to undelete pages.

Who should upgrade?

Development releases are snapshots of the ongoing Confluence development process. We make them available for customers who are willing to risk an unpolished release in order to have early access to new features.

If you want to be running the most stable and most reliable version of Confluence, you should stick with the official, numbered releases.

Upgrade Procedure

Upgrading Confluence should be pretty easy. If you are upgrading from Confluence 1.2 or higher, you can find instructions here. We strongly recommend that you backup your confluence.home directory and database before upgrading!

If you are upgrading from Confluence 1.1.2 or earlier, be sure to read the upgrade instructions in the Confluence 1.2 release notes.

New Features in Confluence 1.3-DR1

Space Summary
The Space Summary page has been the dumping-ground for every space-related operation and report since Confluence's early alpha releases. As such, it had become confusing to navigate and hard to find anything on.

For 1.3-DR1, we have rewritten the space summary to be a suite of tabbed pages, making that whole area of Confluence easier to navigate, more self-explanatory, and much better-looking.

The Trash Can

When a page or blog post is deleted, it is no longer removed completely, but is placed in a space-wide trash can. The trash can be found in the Administration tab of the newly rearranged Space Summary pages. Space Administrators can choose to restore pages from the trash, or purge them so they are unrecoverable.

New Emoticons

Just because.

Bug Fixes

All the bug-fixes that were part of the Confluence 1.2.2 release have also been incorporated into 1.3-DR1. In addition, we've fixed one or two issues specifically for 1.3-DR1, take a look in JIRA for the full list.

Troubleshooting Problems and Requesting Technical Support

This document tells you how to troubleshoot problems in Confluence and how to obtain technical support from Atlassian.

Troubleshooting a Problem

If you have a problem with Confluence, please follow the steps below.

To diagnose a problem and search for a solution:

1. If you are not a Confluence administrator, report your problem to the person in charge of your Confluence site and ask them to follow up on the issue.
2. Use the inbuilt log scanner (see below) to check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker.
3. Check our knowledge base for solutions to known issues.
4. Check our issue tracker for known bugs.
5. If your problem may be related to a plugin, you can enter plugin safe mode by temporarily disabling any third party plugins.
6. If you are having problems configuring a feature, please take a look at the appropriate guides:
   - Confluence Installation Guide
   - Confluence Setup Guide
   - Confluence Administrator's Guide
   - Configuring Confluence
   - Database Configuration
7. Check the following guides for troubleshooting specific problems:
   - Issues related to your database server: Known Issues For Supported Databases.
   - Issues related to user management: Requesting Support for External User Management.
8. If the above tools and documentation do not solve your problem, please create a support request and attach your support zip file. If you believe you have found a bug, you may wish to create a bug report instead. Instructions for both are given below.
On this page:

- Troubleshooting a Problem
- Scanning your Confluence Logs to Match Known Issues
- Raising a Support Request with a Plugin Author
- Raising a Support Request with Atlassian
  - Method 1: Using the Support Request Form via the Confluence Administration Console
  - Method 2: Raising a Support Request via the Internet
- Creating a Support Zip File via the Confluence Administration Console
- Logging a Bug Report

Scanning your Confluence Logs to Match Known Issues

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker.

The log scanner is known as Hercules, or the Atlassian support bot. It uses a set of patterns that we have discovered in our knowledge base and issue tracker.

To use the Confluence log scanner:

1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose Browse > Confluence Admin.
3. Click ‘Atlassian Support Tools’ under ‘Administration’ in the left-hand panel.
4. Click the ‘Log Scanner’ tab.
5. Click ‘Scan’ to scan the Confluence log file in its default location, or change the location if necessary then click ‘Scan’.
6. The log scanner will return a list of links, pointing to articles in our knowledge base and/or bug reports in our issue tracker.
   - The latest-reported problems are displayed first. By default only the most recent 10 matches are displayed. If you have more than 10 matches and want to display all results, click the ‘Show All’ link that appears on the top of the results page.
   - Click a link to read the reported problem and possible solutions or workarounds.

Screenshot above: The log scanner

Raising a Support Request with a Plugin Author

If you have a plugin-related issue, please check whether the plugin is supported by Atlassian or by the plugin developer.

- Visit the plugin’s home page in the Atlassian Plugin Exchange.
- Check the ‘Supported By’ entry under ‘Plugin Details’ on the right-hand side.
• If the plugin is not supported by Atlassian, you will need to contact the plugin author directly.

You can read more about [Atlassian support for plugins](https://confluence.atlassian.com/display/ATL/Atlassian+support+for+plugins).

### Raising a Support Request with Atlassian

There are two ways to raise a support request with Atlassian:

- **Method 1:** *(Recommended)* Complete the support request form via your Confluence Administration Console, as described below. A possible problem with this method is that your mail may not be forwarded correctly, due to restrictions imposed by your mail server. For example, the zip of your log files might be too large for your mail server to forward.
  
- **Method 2:** Raise a support request via our support site on the Internet, as described below. Create a support zip file via your Confluence Administration Console, as described below, and attach the zip file to the support request.

### Method 1: Using the Support Request Form via the Confluence Administration Console

The advantage of this method is that it is convenient. The disadvantage is that your mail may not be forwarded correctly due to a problem (for example, the zip file is too large) or due to a security restriction on your mail server.

You can also use this method to append system information to an existing support request.

**To submit a support request via the Confluence Administration Console:**

1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose [Browse > Confluence Admin](https://confluence.atlassian.com/display/CONFL/Confluence+Administration).
3. Make sure that [SMTP email](https://confluence.atlassian.com/display/CONFL/SMTP+Email) is set up on your Confluence site and your mail server allows zip files.
4. Click *Atlassian Support Tools* under *Administration* in the left-hand panel.
5. Click the *Support Request* tab.
6. Provide as much information as possible, following these guidelines:
   - *'Contact Email'* – This will default to the email address of the logged-in user.
     
     **Note:** This email address will be used to find your support account on the [Atlassian Support System](https://confluence.atlassian.com/display/ATL/Atlassian+support+system). If no matching account is found, a new account will be created. Confluence will also send all further notifications and updates to this address.
   - *'Summary'* – Enter a short and meaningful description of the problem.
   - *'Description'* – Enter as much information as possible, including any error messages that are appearing and any steps the support team can take to reproduce the problem.
7. In the section titled *'Support Data to Attach'*; select the types of additional information you would like to be included in a zip file that will be attached to your support request.
8. Click the *Send* button.
9. Confluence will submit your request via email to the Atlassian support site. If you do not already have a support account, Confluence will automatically request one for you. The submitted request will include all the system and environment information which you see on the support request form. It will also include a zipped copy of your Confluence log file. Refer to [Working with Confluence Logs](https://confluence.atlassian.com/display/CONFL/Working+with+Confluence+Logs) for information about the log files.

   | Log files can be very big. It is possible that your email server may bounce the message if it is too large. With the default log4j configuration, the log file could be up to 20Mb in size. If you have customised the log settings, the maximum size could be even larger. Please check whether the email message has been successfully sent, and consult your email administrator if you need special provisions for this email message.

10. Once you have submitted your support request, you will receive email updates about its progress. These emails will give you the support request number.

You can view the status of your support request and add any additional information required by visiting the [Atlassian Support Tools](https://confluence.atlassian.com/display/ATL/Atlassian+Support+Tools) page.
Method 2 Raising a Support Request via the Internet

If your Confluence instance is not configured with SMTP mail or your Confluence instance is not running, you can raise a support request via the Atlassian Support System on the Internet.

To raise a support request via the Internet:

1. If you do not already have a free Atlassian support account, create one here.
2. Log in to https://support.atlassian.com and select 'Create New Issue'.
3. Lodge a detailed description of your problem in the new support request.
4. Fill in all applicable information about your system, such as application server, database, etc.
5. If Confluence is running, go to the 'System Information' screen in your Administration Console and copy the text of your system information into the request.
6. Create a support zip file, as described below to attach to the request. If your instance does not start up, refer to Working with Confluence Logs for information about the log files.
7. If your problem concerns user management or performance, please take a look at the additional requirements in Requesting Support for External User Management or Requesting Performance Support.
8. Once your request is lodged, wait to be notified by email of updates.

Creating a Support Zip File via the Confluence Administration Console

We recommend that you attach a support zip file to every interaction with the Atlassian support team. You can use this method to append system information to an existing support request. The tool described below will also dump your system information to the logs before zipping them.
To create a support zip file via the Confluence Administration Console:

1. Log in as a user with System Administrator or Confluence Administrator permissions.
2. Go to the Administration Console and click ‘Atlassian Support Tools’ under ‘Administration’ in the left-hand panel. Click ‘Support Zip’. Ensure that everything is checked, then click the ‘Create’ button.
3. Confluence will create the support zip file and display its location on the screen. Log in to the Confluence server to retrieve the file.
4. Attach the zip file to the support case you raised on our support system, as described above.

Logging a Bug Report

If you have found a bug, the easiest way to report it is to:

- Create numbered instructions on how to reproduce the bug.
- Log it as a support request, as described above.
- The Atlassian support team will confirm your bug and lodge a bug report.

Alternatively, you can check to see if anyone else has reported the bug, then log a bug report yourself.

To log a bug report:

1. Go to the Confluence issue tracker.
2. Type keywords for your problem into the search box on the left under ‘Query’.
3. Click ‘Search’ to find any existing bug reports that match your problem.
4. Read through the summaries of the bugs shown. If any summary describes your problem, you may wish to set a watch to be notified of updates.
5. If there are no existing bug reports that match your problem, log the new bug in the issue tracker. Include information on how to duplicate the problem.
6. Sometimes it may be useful to include the result of the 500 error page, which you will find at this location:

   https://<domain><host>:<port>/500page.jsp

7. Once your issue is lodged, wait to be notified by email of updates.

RELATED TOPICS

- Requesting Support for External User Management
Content Anonymiser for Data Backups

Atlassian may request a copy of the entities.xml file from a customer's exported zip file (backup file), in order to diagnose database corruption or to find a bug in Confluence.

If your data is confidential, you can run an anonymiser program over your entities.xml file to remove all your data and leaving only the structure of the export.

Usage

To run the Content Anonymiser on your backup file:

1. Download the anonymiser JAR (attached to this page).
2. Extract the entities.xml file from your zipped backup file to the same directory as the JAR.
3. Use the command prompt to go to the directory where all three files are located.
4. To create cleaned.xml, run the command

   ```
   java -jar confluence-export-cleaner-1.1-jar-with-dependencies.jar
   entities.xml cleaned.xml
   ```

5. Re-ZIP cleaned.xml with its exportDescriptor.properties to ensure we (eg. Atlassian Support) knows exactly which version of Confluence does the XML backup exported from.

How it works

The Content Anonymiser program replaces all the text content in file entities.xml with ‘x’ characters. For example, the word “Atlassian” will be transformed to “xxxxxxxxxx”. The resulting cleaned.xml file is expected to have the same size as the original file.

This release of the Content Anonymiser uses STX, a fast and efficient XML transformation technology. It should not require a lot of memory to run, even for a large backup.

Development

For Atlassian developers:

- Source code.
- Maven repository.

Enabling Detailed SQL Logging

Confluence uses the open source persistence framework Hibernate. This page tells you how to configure Confluence’s logging to report individual SQL requests that are sent to the database by Hibernate. It is useful for troubleshooting the following events:
- **XML site backups** that fail to import.
- Exceptions caused by an illegal database operation.

### Enable SQL logging via the Administration Console

Since the 2.7 release, you can also enable SQL logging at runtime via the Administration Console — read the [instructions](#). This runtime option does not allow you to enable logging of SQL parameter values.

To enable detailed SQL logging in Confluence, you need to modify `log4j.properties`, located in `confluence/WEB-INF/classes`.

- After you have enabled hibernate logging, please replicate the action that is causing the error in the first place. This is the best way to ensure that the Confluence log file contains relevant SQL logging.

- **If you require support assistance with a database related problem, it is advisable to enable detailed SQL logging before sending us the log files. This will assist us in determining what SQL queries were running during the reported problem.**

- **If the entries mentioned below are not defined in the `log4j.properties` file, you can manually add the entries to the file in the 'Hibernate Logging' section.**

#### To Log SQL Queries

Stop Confluence, then change the following lines in `log4j.properties` from `ERROR` to `DEBUG`:

```
## log hibernate prepared statements/SQL queries (equivalent to setting 'hibernate.show_sql' to 'true')
## DEBUG, TRACE or ALL is required to see query strings
log4j.logger.net.sf.hibernate.SQL=DEBUG
```

#### To Log SQL Queries with Parameters

1. Stop Confluence
2. Uncomment the following lines in `log4j.properties`:

```
## log hibernate prepared statement parameter values. Note: due to caching in net.sf.hibernate.type_NullableType, requires restart to take effect
## TRACE or ALL is required to see parameter values
## Note that log4j.appender.confluencelog.Threshold (or other appenders) also must be TRACE or ALL to see any trace messages in the logs
log4j.logger.net.sf.hibernate.type=TRACE
```

3. Change the following lines in `log4j.properties` from `DEBUG` to `TRACE`:

```
log4j.appender.confluencelog.Threshold=TRACE
```

4. Restart Confluence
This needs to be done along with the changes to log SQL queries above (whether by the UI or by modifying the properties file).

To Disable Batched Updates for Simpler Debugging

Stop Confluence, then edit `databaseSubsystemContext.xml`:

- In Confluence 2.5.x and earlier, the `databaseSubsystemContext.xml` file is at `confluence/WEB-INF/classes/databaseSubsystemContext.xml`
- From Confluence 2.6.x, the `databaseSubsystemContext.xml` file is available in the `confluence-2.6.0.jar` file located in the `<confluence-install>/WEB-INF/lib` directory.

Uncomment the `<prop>` line in the following location:

```xml
<!-- it can be useful to disable batching during debugging, as HSQLDB doesn't report the exact statement which fails in batch mode -->
<prop key="hibernate.jdbc.batch_size">0</prop>
```

RELATED TOPICS

- [Troubleshooting SQL exceptions](#)
- [Working with Confluence Logs](#)

Generating a Heap Dump

Sometimes you may see that Confluence is holding onto a chunk of memory over a period of time (for example, tenured space is increasing close to Xmx). In such a situation, it is useful to find out what is stacking up in the memory by analysing the heap dump.

On this page:

- Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error
- Manually Generating a Heap Dump when Confluence Stops Responding
- Submitting a Heap Dump to Atlassian Support

Tips when getting a heap dump

If you have a large Xmx size, please limit your Xmx size to 1024m. This will help to keep Confluence heap dump smaller while still containing sufficient information to analyse it.

Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error

Typically, we would like to analyse the heap dump produced when Confluence died from an OutOfMemory Error. For this, you can add additional JVM parameters like below:

```sh
-XX:+HeapDumpOnOutOfMemoryError -XX:HeapDumpPath=<path to this heap dump file>
```

If you do not set the HeapDumpPath parameter, by default the heap dump will be saved in the folder where Tomcat is run from.

- If you are setting these parameters in the Windows registry (when running Confluence on Windows as a service), be sure that each parameter is on its own line.
Manually Generating a Heap Dump when Confluence Stops Responding

It is also possible to get a heap dump manually using a JDK bundled tool called `jmap`, although we recommend that you use the automatic method above for best result.

**For Linux/Solaris-based Operating Systems:**
Please execute the following command on Linux OS:

```
$JAVA_HOME/bin/jmap -dump:format=b,file=heap.bin <pid>
```

**For Windows:**
Please find your Confluence process ID (see below) and then execute the command below on a Windows command line:

```
%JAVA_HOME%\bin\jmap -dump:format=b,file=heap.bin <pid>
```

To find out the process ID for your Java process in Windows, you can use [Process Explorer](https://processexplorer.net/) from Microsoft. This is what it looks like:

Using Process Explorer to find your Tomcat process ID

![Tomcat process ID](image)

Tomcat run from startup.bat script  Tomcat run as Windows Service

**Submitting a Heap Dump to Atlassian Support**

Please zip the file and then send it to Atlassian Support.

**RELATED TOPICS**

- Getting Java Crash Log File
- Memory usage and requirements
- Garbage Collector Performance Issues
- Generating a Thread Dump
- How to Fix Out of Memory Errors by Increasing Available Memory

**Generating a Thread Dump**

- [Stack Traces and Security](#)
- **Method 1:** Generating a Thread Dump Externally
- **Method 2:** Generating a Thread Dump via the Administration Console

If Confluence is performing poorly, behaving unexpectedly or stops responding and you can generate a thread
dump to help diagnose the cause of the problem. Furthermore, if you wish to contact Atlassian Support for assistance about it, you should include a thread dump in your support enquiry to help the Support team determine the cause of the problem.

A thread dump will show the state of each thread in the JVM, including a stack trace. Thread dumps are only useful if they are taken at the appropriate time. They normally need to be taken at or close to the time when the application is experiencing problems.

Information about what locks are being held and waited upon by a thread are not produced by Confluence's Thread Dump tool. If you require this information, then generate a thread dump externally.

Stack Traces and Security

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

Method 1: Generating a Thread Dump Externally

If Confluence stops responding or you require information on locks being held and waited upon by threads, then use one of methods described in Generating a Thread Dump Externally.

Atlassian support may ask you to use this method if a thread dump generated using method 2 does not include enough information to diagnose the problem.

Method 2: Generating a Thread Dump via the Administration Console

To generate a Thread Dump from the Administration Console,

1. Choose Browse > Confluence Admin.
2. Select 'Thread Dump' in the left-hand panel.
3. Click the 'Generate Now' button in the centre of the page. The output is displayed in a new text box that appears just below the button.
4. Copy the contents of the thread dump in the text box and save it to a text file.

Screenshot: Example of a generated thread dump from the Confluence administration console
Scheduling Thread Dumps via the Administration Console

If you were asked by Atlassian Technical Support to generate regular thread dumps, please set the Thread Dump Scheduler to take 2 to 3 thread dumps with a 30 seconds time interval in between so the Support team can observe any important patterns that may assist with the diagnosis of the problem. Attach the log file to the support ticket.

Example: Scheduling thread dumps from the Confluence administration console

Generating a Thread Dump Externally

If Confluence stops responding and you cannot access its integrated Generate Thread Dump feature, it is possible to create thread dumps outside the application. External thread dumps are also useful if you require information on locks being held or waited upon by threads.

Take Multiple Thread Dumps

Typically you'll want to take several dumps about 10 seconds apart, in which case you can generate several dumps and output the stack traces to a single file as follows:

Generating a Thread Dump on Linux, including Solaris and other Unices

1. Identify the java process that Confluence is running in.: This can be achieved by running a command
similar to:

```
ps -ef | grep java.
```

2. Find the process ID of the JVM and use the `ps` command to get list of all processes:

```
kills -3 <pid>
```

⚠️ This will not kill your server (so long as you included the "-3" option, no space in between).

The thread dump will be printed to Confluence’s standard output (catalina.out).

**Generating Thread Dumps on Windows**

**From the console**

If you are running Confluence through a console, rather than as a service, you can click on the console and press <CTRL> + BREAK

**Using jstack**

The JDK ships with a tool named `jstack` for generating thread dumps.

1. Identify the process. Launch the task manager by, pressing Ctrl + Shift + Esc and find the Process ID of the Java (Confluence) process. You may need to add the PID column using View -> Select Columns ...

2. Run `jstack <pid>` to Capture a Single Thread Dump. This command will take one thread dump of the process id <pid>, in this case the pid is 22668:

```
adam@track:~$ jstack -l 22668 > threaddump.txt
```

This will output a file called threaddump.txt to your current directory.

⚠️ Common issues with jstack:

- You must run jstack as the same user that is running Confluence
- If the jstack executable is not in your $PATH, then please look for it in your
  `<JDK_HOME>/bin` directory
- If you receive `java.lang.NoClassDefFoundError:
  sun/tools/jstack/JStack check that tools.jar is present in your JDK’s lib
directory. If it is not, download a full version of the JDK.

**Output**

Standard logging for Confluence Stand-alone is sent to the `atlassian-confluence.log`, in the confluence-home directory, not in the confluence-install directory. Thread dumps are an exception since they dump the threads of the entire application server - they’ll appear in the catalina.out file in the application directory’s logs folder. You can search for the term "thread dump" in the log file for the beginning of the dump. Submit this along with the atlassian-confluence.log in your support ticket.

**Thread Dump Analysis Tools**
Confluence 4.3 Documentation

- Samurai
- Thread Dump Analyzer TDA TDA 1.0 Final can be obtained from the java.net

**Getting Java Crash Log File**

If you discovered that Confluence died without manual intervention, there may be something goes wrong during a local Java session. Java will produce a log file that looks like the following: `hs_err_pid20929.log`.

The location of this log file is usually in the directory where Tomcat is run eg. `/bin` folder. For Windows Services, it should be located in where Windows Services are run, eg. `c:\Windows\System32` if you are on 32 bit.

**Useful VM Option**

If using Java 6, it's possible to define the path to the `hs.err_pid` file.

Add the following JVM Parameter to your existing ones:

```
-XX:ErrorFile=./hs.err_pid<pid>.log
```

**RELEVANT TOPICS**

- Generating a Heap Dump
- Java Crashes
- Profiling using the YourKit Plugin

**Profiling using the YourKit Plugin**

There is a plugin for Confluence 2.2 and later which allows easy profiling using the YourKit profiler. No license is required to generate a memory or CPU snapshot, but you will need at least an evaluation license to analyse the results.

**On this page:**

- Configuring YourKit in your JVM
  - Windows Configuration
  - Linux/Mac OS X Configuration
- Performance Impact
- Installing the YourKit Plugin
- Why would I do this?
- Plugin Source Code

**Configuring YourKit in your JVM**

Download YourKit 6.0 for your platform and follow the installation instructions to install it.

⚠️ Note: YourKit version 7 is not compatible with the Confluence yourkit plugin.

The following instructions apply to Confluence and Tomcat installations with the Oracle (previously Sun) JDK. They should be easily applicable to other application servers and JVMs, however. The YourKit documentation covers this in more detail.

**Windows Configuration**

On Windows, add to your PATH environment variable the `bin/win32/` directory underneath the YourKit installation directory. For example, you might add "C:\Program Files\YourKit Java Profiler 6.0.12\bin\win32" to your PATH, via Control Panel, System, Advanced, Environment Variables.
To configure Confluence's JVM to use the YourKit agent, you need to add a parameter to JAVA_OPTS in the bin/setenv.bat file in your Confluence application directory. This file controls the startup parameters for Tomcat, so you'll need to restart it after making the changes.

Add the 'agentlib' parameter to the end like this:

```
set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx256m -agentlib:yjpagent
```

**Linux/Mac OS X Configuration**

On Unix-based systems, include the installation directory in the library path environment variable, as shown below:

- For the Mac: `export DYLD_LIBRARY_PATH=$DYLD_LIBRARY_PATH:/path/to/yourKitAgent`
- For other Unix-based systems: `export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/path/to/yourKitAgent`

In general, to configure the JDK, you add the `agentlib` parameter:

```
java -agentlib:yjpagent ...
```

You can add this to Tomcat's `bin/setenv.sh` like this:

```
JAVA_OPTS="-Xms128m -Xmx256m $JAVA_OPTS -Djava.awt.headless=true -agentlib:yjpagent ">
```

**Performance Impact**

Running YourKit can have detrimental effects on performance.

To minimize performance problems use the following modifications to the `agentlib` parameter:

```
-agentlib:yjpagent=disablecounts,disablealloc,disablej2ee
```

See also [Profiling overhead: how to reduce or avoid](#) in the YourKit documentation.

**Installing the YourKit Plugin**

[Download the plugin](#) and upload it into Confluence through the Administration, Plugins page.

A new menu option will appear under the 'Administration' heading. Click it and you should see the options to take a memory or CPU snapshot.
Screenshot above: YourKit Profiling menu item

This profiler dump will be saved to a local temp directory, and the path shown once it is complete. For the CPU snapshot, this will take at least 30 seconds. For the memory snapshot, 10-15 seconds.

Screenshot above: You can take either a memory or CPU snapshot

Why would I do this?

Analysing a profiler dump enables Atlassian Support (or you, if you are interested) to see exactly what is happening in your application: what classes are using the memory, what is using CPU and so on. This can help us debug tricky performance problems which would otherwise be impossible to analyse remotely.

Take a CPU snapshot if:

- Confluence is sometimes unresponsive
- Pages take a long time to load
- Confluence's CPU usage is peaking.

Take a memory snapshot if:

- Confluence's memory usage is higher than you expect
- You are getting OutOfMemoryError's in your logs.

If you run into situations where Confluence is unresponsive and you are not able to trigger a memory snapshot, please ensure that you start Confluence with the onexit=memory parameter in the JVM options (as in the example below) and simply shut down Confluence. Before shutting down a memory snapshot will be created.

```
-agentlib:yjpagent=onexit=memory
```

Plugin Source Code
The source code for this Confluence plugin is available from Subversion and browseable in Fisheye. The JAR produced by 'mvn package' includes a copy of the YJP redistributable bundled in META-INF/lib/.

Confluence Resources

Resources for evaluators
- Trying Confluence on a demonstration site
- Free trial
- Feature tour

Resources for administrators
- Confluence knowledge base
- Guide to installing an Atlassian integrated suite
- The big list of Atlassian gadgets

Resources for developers
- Atlassian Developers site
- Developer topics on Atlassian Answers

Downloadable documentation
- Confluence documentation in PDF, HTML and XML formats
- Setting up local online Confluence documentation

Plugins
- Documentation for the Confluence SharePoint Connector
- Atlassian Plugin Exchange

Support
- Atlassian Support
- Support policies

Training
- Atlassian training

Answers
- Confluence at Atlassian Answers

Mailing lists
- Visit http://my.atlassian.com to sign up for mailing lists relating to Atlassian products, such as technical alerts, product announcements and developer updates.

Feature requests and bug reports
- Issue tracker for Confluence

Trying Confluence in a Demonstration Site or Demo Space

Atlassian have set up a demonstration Confluence site called the Confluence Sandbox so that you can try out Confluence for yourself.

The Confluence Sandbox has been configured so that anyone can create or edit pages within it. When using it, you should keep the following in mind:

- This server may not be running exactly the same version of Confluence as is available for purchase. While we try to keep the two in sync, there may be differences between the Confluence Sandbox and the...
downloadable version of Confluence. The version that the Confluence Sandbox is running can be found at the bottom of each page.

- Because the Confluence Sandbox is open for anyone to edit, Atlassian cannot be responsible for the content on it. Do not rely on anything you read in the sandbox.
- The contents of the Confluence Sandbox may be edited or deleted at any time. Atlassian will restore the Confluence Sandbox from backup periodically (usually every night), deleting everything that visitors have been added to it.
- The Confluence Sandbox contains a demonstration space with a tutorial and some sample content.

For a full demonstration of Confluence, including its administrative features, you should download and install an evaluation version of Confluence instead.

- Get an evaluation version from our download site.
- Once you have set up your evaluation installation, you will see a demonstration space (with a space key of 'DS') in your Confluence site. This is your own version of the demo space, including a tutorial and some sample content.
- If you have any questions, contact us and we will be happy to answer them.

Screenshot above: The demonstration space. (Click the image to expand it.)

RELATED TOPICS

Confluence Resources
Confluence User's Guide

Confluence Tutorial Videos

This page contains videos giving tutorials on some of the Confluence functionality. The videos are intended to supplement, not replace, the online Confluence documentation.

⚠️ Videos and Confluence version number

The Confluence tutorial videos below are all recorded in Confluence 4.x. While there are commonalities between different versions of Confluence, you may find that the example scenarios in the tutorials differ from your Confluence site.

Watch a full product demonstration of Confluence on Atlassian's website

On this page:

- Confluence Overview
  - Content Structure
  - Space Directory
• Editor Features
  • Autocomplete for Links, Media, and Macros
  • Autoconvert for Pasted Links
  • Autoformatting of Wiki Markup
  • Drag and Drop File Sharing
  • How to Build a Kick Ass Confluence Wiki Page in 10 minutes
  • Inserting Links
  • Image Effects
  • Table and Image Editing
  • Using Macros
  • Autosave and Versioning
  • Commenting

• Sharing and Notifications
  • Share Button
  • Watch Content
  • Build a Network

• Search
  • Quick Navigation
  • Advanced Search

• Permissions
  • Global
  • Space
  • Page

• JIRA Integration
• Administration
  • Managing Groups
  • Installing Plugins
  • Importing and Exporting Content

Confluence Overview

Content Structure

Space Directory

Editor Features

Autocomplete for Links, Media, and Macros

Autoconvert for Pasted Links

Autoformatting of Wiki Markup

Drag and Drop File Sharing

How to Build a Kick Ass Confluence Wiki Page in 10 minutes
Inserting Links

Image Effects

Table and Image Editing

Using Macros

Autosave and Versioning

Commenting

Sharing and Notifications

Share Button

Watch Content

Build a Network

Search

Quick Navigation

Advanced Search

Permissions

Global

Space

Page

JIRA Integration

Administration

Managing Groups
Installing Plugins

Importing and Exporting Content

Local Confluence Documentation

This page tells you how to set up a copy of the Confluence documentation on your own local Confluence site.

On this page:

- Reasons for Setting up your own Local Documentation
- Setting up your Local Online Documentation
  - Additional Documentation Spaces Required
- Redirecting Confluence's Help Links to your Local Documentation
  - Changing the Base URL for your Help Links
  - Changing the Links for Individual Help Pages
  - Example of the Help Property File
  - Example of a Help Link
  - More Notes about Help Links

Reasons for Setting up your own Local Documentation

You may wish to run the documentation locally. In addition, you may want to point Confluence's links at your local documentation.

- If you are working in an environment without an internet connection, you will need a local copy of the documentation.
- If you have customised Confluence, you may wish to update the documentation to reflect your changes.
- You may want to change the look and feel of the documentation to integrate into your company's intranet.

Confluence's interface contains links to help pages in the online documentation on confluence.atlassian.com. You may wish to point these help links to a different destination. Possible reasons include:

- You want to point the help links to a destination behind your firewall.
- You may want to link to a translated version of the documentation.

Setting up your Local Online Documentation

To set up your own Confluence site with a copy of our Confluence documentation:

1. Install Atlassian Confluence, if you have not already installed it. (If you do not already have Confluence, ask for a free evaluation license or a starter license. You can use 'Anonymous' access to allow your users to view the documentation.)
2. Download the XML source code for the Confluence documentation. Note that the Confluence version of the XML source needs to be the same major Confluence version as your local Confluence site. For example, if the Confluence version in the XML is 3.0, you can import it into a Confluence site running version 3.0, 3.0.1 or 3.0.2. But you cannot import it into Confluence 2.9 nor into Confluence 3.1.
3. Import the XML file into your Confluence site. This will create a new space with key 'DOC'. Note: If there is already a 'DOC' space in your Confluence site, it will be overwritten. For detailed instructions, see the Confluence documentation on Restoring a Space.
4. Remove or adjust the customised header, footer and left-hand navigation bar in your new space. Explanation: When you create your new space from our XML source code, the space will inherit the Confluence 'Documentation' theme. The XML source code also includes the customisations we have made to the header, footer and left-hand navigation bar. These customisations include references to our Atlassian Documentation space. Since your Confluence site does not have that space, you will see errors like this in the left-hand navigation bar, header and footer in your new space:
Unable to render {include} Couldn't find a space with key: ALLDOC

To fix these errors, take one of the following steps:

- Customise the navigation, header and footer sections to suit your Confluence site or environment. See our documentation on configuring the Documentation theme.
- Or restore the default left-hand navigation bar, by removing all content from the navigation, header and footer sections and selecting the 'Page Tree' check box. See our documentation on configuring the Documentation theme.
- Or change the theme of your space to the Confluence default theme or another theme of your choice.

5. Download the XML source code for the additional documentation spaces listed below and import them into your Confluence site too.

6. (Optional) Follow the steps in the next section if you want to redirect Confluence's help links to point to your local documentation.

Additional Documentation Spaces Required

Why You Need the Additional Documentation Spaces

The Confluence documentation shares some content with other Atlassian products, such as JIRA. For the sake of efficiency, we reuse the same content across documentation spaces. You will notice that some of our pages contain an (include) macro that draws in content from another space.

For example, the following macro includes content from the Application Links (APPLINKS) space into the Confluence documentation space:

```
{include:APPLINKS:_securityTrustedApps}
```

You will need to import those documentation spaces into your Confluence site, to ensure that the reused content is accessible in your Confluence documentation.

Determining the Version Required

We supply different versions of the documentation, for each version of the software or plugin concerned. To see which version you need, take a look at the space key in the {include} macro concerned.

- If the space key has a number at the end, that number indicates the version. For example, 012 means version 1.2, and 011 means version 1.1.
- If the space key does not include a number, you need the latest version of the documentation.

Here is an example of an include macro that requires version 1.2 of the Application Links documentation:

```
{include:APPLINKS012:_securityTrustedApps}
```

This example requires the latest version of the Application Links documentation:

```
{include:APPLINKS:_securityTrustedApps}
```
List of Spaces Required

Retrieve the relevant version of the XML backups from these pages:

- Application Links
- Universal Plugin Manager
- User Management

Redirecting Confluence’s Help Links to your Local Documentation

In some parts of the Confluence user interface, you will see hyperlinks that point to the documentation for detailed information. These hyperlinks are Confluence's help links. You can redirect Confluence's help links to point to your local documentation.

There are two types of configuration changes you can make to the help property file:

- Change the base URL that determines the destination website of all your help links.
- Change the page name for each individual help link.

Changing the Base URL for your Help Links

You can set the base URL via the Confluence Administration Console.

To change the base URL for your help links:

1. Choose Browse > Confluence Admin.
2. Click 'General Configuration' in the left-hand navigation bar.
3. Click 'Edit'.
4. Change the 'Documentation Url Pattern' to determine the destination website for all your help links. This value forms the first part of the destination URL. For example, if you want to point your help links the 'DOC' space in your local Confluence site, your URL prefix will look like this:

   help.prefix=http://confluence.mycompany.com/display/DOC/

   In addition, you can use the following special characters in the URL:
   - {0} – Optional. This value will be replaced with the version of Confluence running on your site.
   - {1} – Optional. This value will be replaced with the page name from the configuration file.

Changing the Links for Individual Help Pages

If necessary, you can also change the individual page names to point to specific pages in your local documentation. You may want to do this if you are using a translated version of the documentation, for example, or your own custom guide rather than a copy of the Atlassian documentation.

The help links are contained in a property file. In summary, you will need to do the following:

- Make a copy of the property file that Confluence uses to control the help links.
- Place the copy in a given directory where it will override the default property file.
- Update the copy with your own values.

To change the destination of your Confluence help links:

1. Copy the confluence-x.x.x.jar file from your {CONFLUENCE-INSTALLATION}\confluence\WEB-INF\lib directory and place it in a temporary location.
   Note: Do not remove the JAR, just make a copy of it.
2. Unzip the confluence-x.x.x.jar file into your temporary location and copy the help-paths.prope
3. Put the copy of the help-paths.properties file into your {CONFLUENCE-INSTALLATION}\confluence\WEB-INF\classes directory.

   Note: The property file will override the file in the JAR.


5. Change the individual page names to point to specific pages in your local documentation. In our example file below, the first key-value pair looks like this:

   help.restore.site=Restoring+a+site

You could change it to something like this:

   help.restore.site=My+page+about+Restoring+Confluence


Example of the Help Property File

Below is an example of part of the Confluence help-paths.properties file.

```
help.prefix=http://docs.atlassian.com/confluence/docs-{0}/{1}

## Page Names
help.restore.site=Restoring+a+site
help.manually.backup.site=Manually+Backing+Up+The+Site
help.configure.server.URL=Configuring+the+Server+Base+URL
help.configure.time.date.format=Configuring+Time+and+Date+Formats
help.edit.user.details=Editing+User+Details
```

The first line (help.prefix) shows the destination website of the help links. This value forms the first part of the destination URL.

- {0} – Optional. This value will be replaced with the version of Confluence running on your site.
- {1} – Optional. This value will be replaced with the page name from the configuration file.

Below the description '## Page Names' there are a number of key-value pairs.

- The key (such as help.restore.site) is an identifier used by Confluence to find the help link for a specific screen or dialogue.
- The page name (such as Restoring+a+site) is the URL-encoded page name that forms the last part of the destination URL.

Example of a Help Link

Here is an example of a Confluence screen with two help links, one on the words 'our online documentation' and another on 'More about daily backups':

Screenshot: Example of help links in Confluence
More Notes about Help Links

- The ability to configure the destination of the help links is available only in Confluence 3.3.x and later.
- Make sure that you keep all the key-value pairs for the page names in the `help-paths.properties` file. If you want to point them all to the same location, you should retain all the keys and replace all the page names with the same name. For example:

```properties
help.prefix=http://myguide.mycompany.com
## Page Names
help.restore.site=My+guide
help.manually.backup.site=My+guide
help.configure.server.URL=My+guide
help.configure.time.date.format=My+guide
help.edit.user.details=My+guide
```

- In the above instructions on configuring help links, we assume that you want to host your local documentation on your own Confluence site. Instead, you could choose to point the Confluence help links to an entirely different set of documentation, on a website or intranet. After reading through the instructions above, you will have an idea of how to adapt them for your own purposes.
- The `help-paths.properties` file is currently in the `confluence-x.x.x.jar` in the `WEB-INF/lib` directory. Instead, it should be a config file in the `WEB-INF/classes` directory. This will make it easy for people to change the values in the file and repoint their help links. It will also standardise the help design with that of JIRA and other Atlassian applications. This issue is tracked at CONF-20105.

Confluence SharePoint Connector

- Latest version of the Confluence SharePoint Connector

Confluence SharePoint Connector 1.5.5 has now been released. See the [SharePoint Connector 1.5.5 Release Notes](#).

With the [Confluence SharePoint Connector](#) you can combine Confluence's free-form, easy to edit wiki with the document management and workflow strengths of SharePoint.

- Display SharePoint document libraries, calendars, links, discussions and more on your Confluence wiki
pages. Edit SharePoint's Office documents directly from Confluence and save them back to SharePoint.

- Embed Confluence pages and Confluence page trees into a SharePoint page. Click through from SharePoint to Confluence.
- Enjoy automatic login (single sign-on) between Confluence and SharePoint.
- Search Confluence and SharePoint content together, retrieving a unified set of results

Please refer to the SharePoint Connector documentation for more information.

**Support Policies**

Welcome to the support policies index page. Here, you'll find information about how Atlassian Support can help you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find out more.

- Bug Fixing Policy
- How to Report a Security Issue
- New Features Policy
- Patch Policy
- Security Advisory Publishing Policy
- Security Patch Policy
- Severity Levels for Security Issues

To request support from Atlassian, please raise a support issue in our online support system. To do this, visit support.atlassian.com, log in (creating an account if need be) and create an issue under Confluence. Our friendly support engineers will get right back to you with an answer.

**Bug Fixing Policy**

**Summary**

- Atlassian Support will help with workarounds and bug reporting.
- Critical bugs will generally be fixed in the next maintenance release.
- Non critical bugs will be scheduled according to a variety of considerations.

![Report a Bug](image)

**Raising a Bug Report**

Atlassian Support is eager and happy to help verify bugs — we take pride in it! Please open a support request in our support system providing as much information as possible about how to replicate the problem you are experiencing. We will replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if they're possible.

Customers and plugin developers are also welcome to open bug reports on our issue tracking systems directly. Use http://jira.atlassian.com for the stand-alone products and http://studio.atlassian.com for JIRA Studio and Atlassian OnDemand.

When raising a new bug, you should rate the priority of a bug according to our JIRA usage guidelines. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

**How Atlassian Approaches Bug Fixing**

Maintenance (bug fix) releases come out more frequently than major releases and attempt to target the most critical bugs affecting our customers. The notation for a maintenance release is the final number in the version (ie the 1 in 3.0.1).
If a bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) then it will be fixed in the next maintenance release provided that:

- The fix is technically feasible (i.e. it doesn’t require a major architectural change).
- It does not impact the quality or integrity of a product.

For non-critical bugs, the developer assigned to fixing bugs prioritises the non-critical bug according to these factors:

- How many of our supported configurations are affected by the problem.
- Whether there is an effective workaround or patch.
- How difficult the issue is to fix.
- Whether many bugs in one area can be fixed at one time.

The developers responsible for bug fixing also monitor comments on existing bugs and new bugs submitted in JIRA, so you can provide feedback in this way. We give high priority consideration to security issues.

When considering the priority of a non-critical bug we try to determine a ‘value’ score for a bug which takes into account the severity of the bug from the customer’s perspective, how prevalent the bug is and whether roadmap features may render the bug obsolete. We combine this with a complexity score (i.e. how difficult the bug is). These two dimensions are used when developers self serve from the bug pile.

Further reading

See [Atlassian Support Offerings](http://jira.atlassian.com) for more support-related information.

### How to Report a Security Issue

#### Finding and Reporting a Security Vulnerability

If you find a security bug in the product, please open an issue on [http://jira.atlassian.com](http://jira.atlassian.com) in the relevant project.

- Set the priority of the bug to ‘Blocker’.
- Provide as much information on reproducing the bug as possible.
- Set the security level of the bug to ‘Developer and Reporters only’.

All communication about the vulnerability should be performed through JIRA, so that Atlassian can keep track of the issue and get a patch out as soon as possible.

> If you discover a security vulnerability, please attempt to create a test case that proves this vulnerability locally before opening either a bug or a support issue. When creating an issue, please include information on how the vulnerability can be reproduced; see our [Bug Fixing Policy](http://jira.atlassian.com) for general bug reporting guidelines. We will prioritise fixing the reported vulnerability if your report has information on how the vulnerability can be exploited.

Further reading

See [Atlassian Support Offerings](http://jira.atlassian.com) for more support-related information.

### New Features Policy

#### Summary

- We encourage and display customer comments and votes openly in our issue tracking system, [http://jira.atlassian.com](http://jira.atlassian.com).
- We do not publish roadmaps.
- Product Managers review our most popular voted issues on a regular basis.
- We schedule features based on a variety of factors.
- Our [Atlassian Bug Fixing Policy](http://jira.atlassian.com) is distinct from our Feature Request process.
Atlassian provides consistent updates on the top 20 feature/improvement requests (in our issue tracker systems).

**How to Track what Features are Being Implemented**

When a new feature or improvement is scheduled, the 'fix-for' version will be indicated in the JIRA issue. This happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because these roadmaps are often pre-empted by changing customer demands, we do not publish them.

**How Atlassian Chooses What to Implement**

In every major release we aim to implement highly requested features, but it is not the only determining factor. Other factors include:

- **Direct feedback** from face to face meetings with customers, and through our support and sales channels.
- **Availability of staff** to implement features.
- **Impact** of the proposed changes on the application and its underlying architecture.
- **How well defined** the requested feature is (some issues gain in popularity rapidly, allowing little time to plan their implementation).
- **Our long-term strategic vision** for the product.

**How to Contribute to Feature Development**

**Influencing Atlassian’s release cycle**

We encourage our customers to vote on feature requests in JIRA. The current tally of votes is available online in our issue tracking system, [http://jira.atlassian.com](http://jira.atlassian.com). Find out if your improvement request already exists. If it does, please vote for it. If you do not find it, create a new feature or improvement request online.

**Extending Atlassian Products**

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in extending Atlassian products and can do this work for you. If you are interested, please contact us.

**Further reading**

See Atlassian Support Offerings for more support-related information.

**Patch Policy**

**Patch Policy**

Atlassian will only provide software patches in extremely unusual circumstances. If a problem has been fixed in a newer release of the product, Atlassian will request that you upgrade your instance to fix the issue. If it is deemed necessary to provide a patch, a patch will be provided for the current release and the last maintenance release of the last major version only.

Patches are issued under the following conditions:

- The bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions).
- A patch is technically feasible (i.e., it doesn't require a major architectural change)
  OR
- The issue is a security issue, and falls under our Security Patch Policy.

Atlassian does not provide patches for non-critical bugs.

Provided that a patch does not impact the quality or integrity of a product, Atlassian will ensure that patches
supplied to customers are added to the next maintenance release. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

Patches are generally attached to the relevant http://jira.atlassian.com issue.

Further reading

See Atlassian Support Offerings for more support-related information.

Security Advisory Publishing Policy

Publication of Security Advisories

When a security vulnerability in an Atlassian product is discovered and resolved, Atlassian will inform customers through the following mechanisms:

- We will post a security advisory in the latest documentation of the affected product at the same time as releasing a fix for the vulnerability. This applies to all security advisories, including severity levels of critical, high, medium and low.
- We will send a copy of all security advisories to the 'Technical Alerts' mailing list for the product concerned.
  
  Note: To manage your email subscriptions and ensure you are on this list, please go to my.atlassian.com and click 'Email Prefs' near the top right of the page.
- If the person who reported the vulnerability wants to publish an advisory through some other agency, such as CERT, we will assist in the production of that advisory and link to it from our own.

Early warning of critical security vulnerabilities:

- If the vulnerability is rated critical (see our criteria for setting severity levels), we may send an early warning to the 'Technical Alerts' mailing list approximately one week before releasing the fix. This early warning is in addition to the security advisory itself, described above.
- However, if the vulnerability is publicly known or being exploited, we will release the security advisory and patches as soon as possible, potentially without early warning.

Further reading

See Atlassian Support Offerings for more support-related information.

Security Patch Policy

Product Security Patch Policy

Atlassian makes it a priority to ensure that customers' systems cannot be compromised by exploiting vulnerabilities in Atlassian products.

Scope

This page describes when and how we release security patches and security upgrades for our products. It does not describe the whole of disclosure process that we follow. It also excludes JIRA Studio, since JIRA Studio will always be patched by Atlassian without additional notifications.

Critical vulnerabilities

When a Critical security vulnerability is discovered by Atlassian or reported by a third party, Atlassian will do all of the following:

- Issue a new, fixed release for the current version of the affected product as soon as possible, usually in a few days.
- Issue a binary patch for the current release.
- Issue a binary patch for the latest maintenance release of the previous version of the product.
Patches for older versions or releases normally will not be issued. Patches will be attached to the relevant JIRA issue. You can use these patches as a "stop-gap" measure until you upgrade your installation in order to fully fix the vulnerability.

**Non-critical vulnerabilities**

When a security issue of a **High, Medium or Low** severity is discovered, Atlassian will do all of the following:

- Include the fix into the next scheduled release, both for the current and previous maintenance versions.
- Where practical, provide new versions of plugins or other components of the product that can be upgraded independently.

You should upgrade your installation in order to fix the vulnerability.

**Other information**

Severity level of vulnerabilities is calculated based on [Severity Levels for Security Issues](https://confluence.atlassian.com/display/AtlassianPatchPolicy/Severity+Levels+for+Security+Issues).

Visit our general [Atlassian Patch Policy](https://confluence.atlassian.com/display/AtlassianPatchPolicy/Atlassian+Patch+Policy) as well.

**Examples**

**Example 1:** A critical severity vulnerability is found in a (hypothetical current release) JIRA 5.3.2. The last bugfix release in 5.2.x branch was 5.2.3. In this case, a patch will be created for 5.3.2 and 5.2.3. In addition, new bugfix releases, 5.3.3 and 5.2.4, which are free from this vulnerability, will be created in a few days.

**Example 2:** A high or medium severity vulnerability is found in the same release as in the previous example. The fix will be included into the currently scheduled releases 5.3.3 and 5.2.4. Release schedule will not be brought forward and no patches will be issued. If the vulnerability is in a plugin module, then a plugin upgrade package may still be supplied.

**Further reading**

See [Atlassian Support Offerings](https://www.atlassian.com/support) for more support-related information.

**Severity Levels for Security Issues**

**Severity Levels**

Atlassian security advisories include a severity level. This severity level is based on our self-calculated CVSS score for each specific vulnerability. CVSS is an industry standard vulnerability metric. You can learn more about CVSS at [FIRST.org](https://www.first.org) web site.

CVSS scores are mapped into the following severity ratings:

- Critical
- High
- Medium
- Low

An approximate mapping guideline is as follows:

<table>
<thead>
<tr>
<th>CVSS score range</th>
<th>Severity in advisory</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 – 2.9</td>
<td>Low</td>
</tr>
<tr>
<td>3 – 5.9</td>
<td>Medium</td>
</tr>
</tbody>
</table>
Below is a summary of the factors which illustrate types of vulnerabilities usually resulting in a specific severity level. Please keep in mind that this rating does not take into account details of your installation.

**Severity Level: Critical**

Vulnerabilities that score in the critical range usually have most of the following characteristics:

- Exploitation of the vulnerability results in root-level compromise of servers or infrastructure devices.
- The information required in order to exploit the vulnerability, such as example code, is widely available to attackers.
- Exploitation is usually straightforward, in the sense that the attacker does not need any special authentication credentials or knowledge about individual victims, and does not need to persuade a target user, for example via social engineering, into performing any special functions.

For critical vulnerabilities, is advised that you patch or upgrade as soon as possible, unless you have other mitigating measures in place. For example, if your installation is not accessible from the Internet, this may be a mitigating factor.

**Severity Level: High**

Vulnerabilities that score in the high range usually have some of the following characteristics:

- The vulnerability is difficult to exploit.
- Exploitation does not result in elevated privileges.
- Exploitation does not result in a significant data loss.

**Severity Level: Medium**

Vulnerabilities that score in the medium range usually have some of the following characteristics:

- Denial of service vulnerabilities that are difficult to set up.
- Exploits that require an attacker to reside on the same local network as the victim.
- Vulnerabilities that affect only nonstandard configurations or obscure applications.
- Vulnerabilities that require the attacker to manipulate individual victims via social engineering tactics.
- Vulnerabilities where exploitation provides only very limited access.

**Severity Level: Low**

Vulnerabilities in the low range typically have very little impact on an organisation's business. Exploitation of such vulnerabilities usually requires local or physical system access.

**Further reading**

See [Atlassian Support Offerings](#) for more support-related information.

**Contributing to the Confluence Documentation**

Would you like to share your Confluence hints, tips and techniques with us and with other Confluence users? We welcome your contributions.

**On this page:**

- [Tweeting your Hints and Tips — Tips via Twitter](#)
- [Blogging your Technical Tips and Guides — Tips of the Trade](#)
- [Contributing Documentation in Other Languages](#)
• Updating the Documentation Itself
  • Getting Permission to Update the Documentation
  • Our Style Guide
  • How we Manage Community Updates

Tweeting your Hints and Tips – Tips via Twitter
Do you have hints and tips about Confluence wiki to share with the world? Even more, would you like to see your tips appear on a page in the Atlassian documentation? Just tweet with the hash tag "#ConfluenceTips" and see your hint appear in our documentation. Then grab a badge for your blog! More...

Blogging your Technical Tips and Guides – Tips of the Trade
Have you written a blog post describing a specific configuration of Confluence or a neat trick that you have discovered? Let us know, and we will link to your blog from our documentation. More...

Contributing Documentation in Other Languages
Have you written a guide to Confluence in a language other than English, or translated one of our guides? Let us know, and we will link to your guide from our documentation. More...

Updating the Documentation Itself
Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add yourself rather than asking us to do it? You can update the documentation page directly.

Getting Permission to Update the Documentation
Please submit the Atlassian Contributor License Agreement.

Our Style Guide
Please read our short guidelines for authors.

How we Manage Community Updates
Here is a quick guide to how we manage community contributions to our documentation and the copyright that applies to the documentation:
  • Monitoring by technical writers. The Atlassian technical writers monitor the updates to the documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that needs some attention from us, we will make the necessary changes.
  • Wiki permissions. We use wiki permissions to determine who can edit the documentation spaces. We ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows us to verify that the applicant is a real person. Then we give them permission to update the documentation.
  • Copyright. The Atlassian documentation is published under a Creative Commons CC BY license. Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can copy, distribute and adapt our documentation provided they acknowledge the source of the documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes to our documentation knows that their contribution falls under the same copyright.

RELATED TOPICS
Tips via Twitter
Tips of the Trade
Author Guidelines

Created in 2012 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Tips of the Trade

Below are some links to external blog posts, videos and articles containing technical tips and instructions on setting up and using Confluence. This page presents an opportunity for customers and community authors to share information and experiences.

The references here are specific to Confluence wiki and are technical 'how to' guides written by bloggers who use Confluence. For general information on wiki comparisons, wiki adoption, best practices and business cases, please refer to the Atlassian website and to our evaluator resources.

⚠️ Please be aware that these are external blogs and articles.

Most of the links point to external sites, and some of the information is relevant to a specific release of Confluence. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of Confluence. Unless explicitly stated, Atlassian does not offer support for third-party extensions or plugins. The information in the linked blog posts has not been tested or reviewed by Atlassian. We recommend that you test all solutions on a test server before trying them on your production site.

On this page:

- DGC IV: Confluence Upgrades
- Tracking Atlassian Confluence usage with Google Analytics
- Moving Confluence from Windows to (Ubuntu) Linux
- Plugging Memory Leaks in Confluence
- Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format
- Using a wiki for technical documentation
- Wiki docs --- release management
- Using a wiki for online help
- Content re-use on a wiki
- Starting out with your technical documentation on a wiki
- Universal Wiki Converter - Now with SSL Support
- Confluence wiki to Eclipse Help (and DocBook, PDF) the easy way – Scroll FTW
- Playing with DITA2Confluence part 1 and part 2
- Converting from FrameMaker to Confluence
- The Confluence Reporting HOWTO
- Drawing diagrams on a wiki page
- Organisation is Key
- Creating FAQs
- Styling Tabs in Confluence 2.10
- How to determine the context your macro is being rendered in
- Video: Confluence overview
- Video: Macro browser
<table>
<thead>
<tr>
<th>Administration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DGC IV: Confluence Upgrades</strong></td>
</tr>
<tr>
<td>- By: Igor Minar, on ‘Igor Minar’s Blog’</td>
</tr>
<tr>
<td>- About: Upgrading Confluence, on relatively large public-facing Confluence sites</td>
</tr>
<tr>
<td>- Date: 25 July 2010</td>
</tr>
<tr>
<td>- Related documentation: <a href="#">Upgrading Confluence</a></td>
</tr>
</tbody>
</table>

**Tracking Atlassian Confluence usage with Google Analytics**

And [Using the Google Analytics Javascript API to show pageviews from Atlassian Confluence](#)

- By: David Simpson, on blog ‘david simpson’
- About: Setting up Google Analytics for Confluence
- Date: 18 March 2009 and 11 September 2009
- Related documentation:
  - [How Do I Get More Statistics from Confluence?](#)
  - [How to Enable User Access Logging](#)

**Moving Confluence from Windows to (Ubuntu) Linux**

- By: Ricky Sheaves, on blog ‘flimflam’ (calebscreek)
- About: Moving Confluence to its own dedicated environment: Ubuntu 8.04 with a MySQL backend
- Date: 19 October 2008
- Related documentation: [Migrating Confluence Between Servers](#)

**Plugging Memory Leaks in Confluence**

- By: Don Willis, on blog ‘Atlassian developer blog’
- About: Identifying memory leaks in Confluence and fixing them
- Date: 1 October 1007
- Related documentation: [Performance Tuning](#)
Confluence for Technical Documentation

**Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format**
- By Graham Hannington, on wiki 'Confluence, Tech Comm, Chocolate'
- About: The Confluence 4 editor, wiki markup and the XML storage format, and information about Wikifier, a tool for converting Confluence XML to wiki markup, and for converting Confluence rich text to wiki markup
- Date: July 2012
- Related documentation:
  - Using the Editor
  - Confluence Storage Format
  - Confluence Wiki Markup

**Using a wiki for technical documentation**
- By: Sarah Maddox, on blog 'ffeathers'
- About:
  - Overview — what a wiki is and does.
  - Workflow — draft, review, publish.
  - Tracking — page history, notification of updates, reverting to a previous version.
  - Permissions.
  - Adding structure to your documentation — table of contents, left-hand navigation bar, logical page ordering, content re-use.
  - Release management on a wiki.
  - Using spaces for version control.
  - How a wiki is useful in agile development.
- Date: 21 November 2009

**Wiki docs -- release management**
- By: Sarah Maddox, on blog 'ffeathers'
- Date: 17 November 2007
- About:
  - Using spaces for version control
  - Release management on a wiki
  - Archiving documentation on a wiki
- Related documentation: The Copy Space plugin

**Using a wiki for online help**
- By: Sarah Maddox, on the 'Atlassian Blog'
- About: Pointing online help links to version-controlled wiki documentation spaces
- Date: 13 December 2007

**Content re-use on a wiki**
- By: Sarah Maddox, on blog 'ffeathers'
- About: Content reuse and defining an inclusions library
- Related documentation:
  - Excerpt Macro
  - Excerpt Include Macro
  - Include Page Macro
- Date: 29 July 2008

**Starting out with your technical documentation on a wiki**
- By: Sarah Maddox, on blog 'ffeathers'
- About: Choosing your wiki and planning your documentation
- Date: 4 November 2007
<table>
<thead>
<tr>
<th>Content Conversion</th>
</tr>
</thead>
</table>
| **Universal Wiki Converter - Now with SSL Support**  
  - By: Laura Kolker, on the 'Atlassian Blog'  
  - About: Configuring the UWC for two new features:  
    - A Trac Converter module  
    - SSL support  
  - Date: 6 March 2009  
  - Related documentation: Importing Content from Another Wiki |
| **Confluence wiki to Eclipse Help (and DocBook, PDF) the easy way – Scroll FTW**  
  - By: Sarah Maddox, on blog 'ffeathers'  
  - About: Using the Scroll Wiki Exporter plugin to convert Confluence content to Eclipse Help, DocBook XML and PDF  
  - Date and Confluence version: 8 May 2010; Confluence 3.2.1  
  - Related documentation: The Scroll Wiki Exporter plugin |
| **Playing with DITA2Confluence part 1 and part 2**  
  - By: Sarah Maddox, on blog 'ffeathers'  
  - About: Using the DITA2Confluence tool to convert documentation from DITA XML to Confluence pages  
  - Date and Confluence version: October 2008; Confluence 2.9  
  - Related documentation: The DITA2wiki project on SourceForge |
| **Converting from FrameMaker to Confluence**  
  - By: David Stephensen, in the Confluence User Community wiki space  
  - About: Converting content from native FrameMaker format to Confluence wiki using Mif2Go, FrameScript and Far.  
  - Date and Confluence version: 3 June 2010; Confluence 3.1 |
Usage Tips

The Confluence Reporting HOWTO
- By: Jim Severino and John Rotenstein, Atlassian Internal Systems, on the 'Atlassian Blog'
- About:
  - Using Confluence as a reporting and business intelligence tool
- Date and Confluence version: August 2009; Confluence 3.0
- Related documentation: The Confluence Reporting HOWTO

Drawing diagrams on a wiki page
- By: Sarah Maddox, on blog 'ffeathers'
- About:
  - Using the Gliffy plugin to draw diagrams on a Confluence page
  - Links to other tools for displaying flowcharts, graphs etc based on editable content in the wiki page
- Date and Confluence version: 4 July 2009; Confluence 3.0
- Related documentation: The Gliffy plugin

Organisation is Key
- By: Matt Hodges, on the 'Atlassian Blog'
- About: Designing the structure of a Confluence space using an inclusions library, macros and tabbed pages
- Date and Confluence version: 17 March 2009; Confluence 2.10

Creating FAQs
- By: Matt Hodges, on the 'Atlassian Blog'
- About: Designing the FAQ (frequently asked questions) section of your Confluence space
- Date and Confluence version: 2 April 2009; Confluence 2.10

Styling and Customisation

Styling Tabs in Confluence 2.10
- By: Jens Schumacher, on the 'Atlassian Blog'
- About: Using CSS to change the look of the tabs in Confluence
- Date and Confluence version: 12 January 2009; Confluence 2.10
- Related documentation: Styling Confluence with CSS

Development

How to determine the context your macro is being rendered in
- By: Cheryl Jerozal, on the 'Atlassian Blog'
- About: Discovering find out the current render context (including PDF document, feed reader, email notification, etc) from within your macro
- Date and Confluence version: 25 June 2009; Confluence 3.0
- Related documentation: Macro Module
To speed up the loading of the page and ensure correct export to PDF, HTML and XML formats, we will just link to the videos rather than including them into the wiki page.

**Video: Confluence overview**
- By: Matt Hodges, on the Atlassian website
- About:
  - Confluence Overview
  - Create and edit
  - Tracking updates and blogs
  - Security and permissions
  - Attachments and the Office Connector
  - Search and discover
  - Plugins
- Date and Confluence version: July 2009; Confluence 3.0
- Related documentation: [Confluence documentation](#)

**Video: Macro browser**
- By: David Cook, on the 'Atlassian Blog'
- About: Using the new Confluence macro browser in Confluence 3.0
- Date and Confluence version: 18 June 2009; Confluence 3.0
- Related documentation: [Working with Macros](#)

---

**Have you written a technical tip for Confluence?**

Add a comment to this page, linking to your blog post or article. We will include it if the content fits the requirements of this page.

**Feedback?**

Your first port of call should be the author of the linked blog post. If you want to let us know how useful (or otherwise) a linked post is, please add a comment to this page.

---

**Other Sources of Information**

- [Confluence Documentation](#)
- [Evaluator Resources](#)
- [Atlassian Website](#)
- [Atlassian Answers](#)
- [Atlassian Blog](#)
- [Confluence Plugins](#)

**Tips via Twitter**

This page displays a continuously-updated list of tweets from Atlassians and others, giving hints and tips about Confluence wiki. Anyone can write a tip and have it show on this page. The live Twitter stream shows recent tweets containing the word 'ConfluenceTips' or the tag '#ConfluenceTips'. We also include tweets from or to '@ConfluenceTips'.

Want to join in? Just tweet with the word '#ConfluenceTips' somewhere in the text. Then grab a badge for your blog.

- Viewing the Tweets in Twitter
- Adding a Confluence Tweets Badge to your Blog
- Adding your own Tip
Please be aware that anyone can tweet anything.

Atlassian does not monitor the tips in this Twitter stream. Anyone can tweet anything they like. We display these tips because we believe most people will do the right thing and tweet good tweets. Please check that a tweet is relevant to you before following its advice.

Viewing the Tweets in Twitter

If you prefer, you can view the search in Twitter itself.

Adding a Confluence Tweets Badge to your Blog

Would you like to let other people know that you tweet your Confluence tips? Use the code samples below to add a badge to your blog or another social site.

Choose one of these options to add the badge:

- **Badge only**
  Copy the code below and paste it into your blog to include just the badge with a link to this documentation page:

  ```html
  ```

  This is what you will get:


- **Badge and words**
  Copy the code below and paste it into your blog to include the badge and some words encouraging other people to tweet too:

  ```html
  ```
Got a Confluence tip? Tweet it now then see it in the Confluence docs.

Adding your own Tip

Quick guide to tweeting a tip

Just tweet with the word '#ConfluenceTips' somewhere in the text. Your tweet will appear in the Twitter stream on this page.

Would you like to share your information and experiences via Twitter and have your tweet appear on this page? Awesome! Here are the full instructions.

To tweet a Confluence tip,

1. Go to Twitter.com in your browser.
2. If you already have a Twitter username, sign in to Twitter now. If you do not have a Twitter username, sign up for one and follow the Twitter instructions to confirm your account details.
3. Enter your tip into the Twitter text box labelled 'What's happening'. Note that your tip can contain a maximum of 140 characters:
   - Type the words for your tip.
   - If you want people to click through to a web page to see more details about your tip, enter a web address. If the web address is long, you can convert it to a shortened address at bit.ly or one of the other web services that offer URL shortening.
   - Include the key word #ConfluenceTips somewhere in your tweet. This will ensure that your tip appears in the Twitter stream on this documentation page.
4. Click 'Tweet' to send your tweet.
5. Refresh this documentation page to see your tweet appear. It may take a few minutes, depending on the volume of tweets that Twitter is handling.
Confluence Documentation in Other Languages

Below are some links to Confluence documentation written in other languages. In some cases, the documentation may be a translation of the English documentation. In other cases, the documentation is an alternative guide written from scratch in another language. This page presents an opportunity for customers and community authors to share documentation that they have written in other languages.

⚠️ Please be aware that these are external guides.

Most of the links point to external sites, and some of the information is relevant to a specific release of Confluence. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of Confluence. The information in the linked guides has not been tested or reviewed by Atlassian.

On this page:

- [Tutoriel – Travailler avec des images dans Confluence](#)
- [Deutsches Handbuch für Confluence](#)
- [Confluence](#)

### French

**Tutoriel – Travailler avec des images dans Confluence**

- **By:** Yann Debonnel on the TechSolCom blog
- **Topic:** Overview of using images in Confluence, a translation of a guide developed during our doc sprint
- **Confluence version:** Based on Confluence 3.4
- **Date added:** 9 December 2010
- **Latest related English documentation:** [Displaying Images](#)
### German

**Deutsches Handbuch für Confluence**

- **By:** //SEIBERT/MEDIA
- **Topic:** //SEIBERT/MEDIA hat ein deutsches Handbuch für Confluence ab 3.3 aufwärts erstellt, das kostenfrei online mit vielen Anleitungen mit Screenshots und Videos versehen ist. //SEIBERT/MEDIA has created a German Handbook for Confluence 3.3 and later versions. It is publicly available for free and includes step-by-step inscriptions with screenshots and videos.

Das Handbuch kann für die Nutzung offline im eigenen Confluence-Wiki auch gekauft werden. Das kann sinnvoll sein, wenn nicht alle Mitarbeiter Zugriff auf's Internet haben. Hier findet sich eine Preisliste für den Kauf aller Inhalte im eigenen Wiki. The documentation is also available for offline use in environments where employees do not have web access, for a fee. See the price list for offline use.

Darüber hinaus gibt es zahlreiche deutsche Confluence-Video-Tutorials. In addition, there are numerous German Confluence video tutorials:

- **Confluence version:** Confluence 3.3 and later
- **Date added:** 13 December 2010
- **Latest related English documentation:** Confluence User's Guide and Confluence Administrator's Guide

### Japanese

**Confluence**

- **By:** Go2Group and Atlassian, on the Atlassian Japan wiki
- **Topic:** Confluence user's guide, administrator's guide and developer's guide
- **Confluence version:** Confluence 3.0
- **Date added:** 14 December 2010
- **Latest related English documentation:** Confluence Latest

### Adding Your Own Guide to this Page

Have you written a guide for Confluence in another language? Add a comment to this page, linking to your guide. We will include it if the content fits the requirements of this page.

### Giving Feedback about One of the Guides

If you have feedback on one of the guides listed above, please give the feedback to the author of the linked guide.

If you want to let us know how useful (or otherwise) one of these guides is, please add a comment to this page.

### Other Sources of Information

- Confluence documentation
- Atlassian website
- Atlassian blog
- Confluence plugins